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Take a Guided Tour
If you are new to Topic-Based Authoring, watch these short videos to get the hang of the basics
quickly.

Creating Topics and Publications

Editing Topics in Paligo

Working Easily with Lists
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Quick Start Tutorial

Abstract
This tutorial will go through the basics of topic-based structured authoring in Paligo, and show you
how to create publications and publish to multiple output formats.

If you are completely new to topic-based authoring, it might be a bit confusing to know exactly
what you are supposed to do to create your content.

The first important thing to know is that you don't write your publication as one big document,
as you might have done in Word or other traditional authoring tools. Instead, you create small
"topics" or building blocks of content, and then reuse them in a project/publication.

Go through this tutorial, and you'll soon get the hang of it!

Basic Workflow
Before you start creating content in Paligo, let's look at the basic workflow of a simple Paligo
project. 

1. Publication - This is where you create your structure, which acts like a map or table of
contents for your finished document. You do not write content in the publication. You use it to
organise the content and define the settings for the finished output. For this tutorial, you are
going to create the publication first, but when you work on your own projects, you may choose
to create your topics first instead. 

NOTE
Sometimes people refer to publications as projects. This is because you can
use a publication for anything from a complete publication (such as a manual
or online help) to sub-structures, like a chapter.

2. Topics/Components - After creating your publication, you will create topics (and some
components that are added to the topics). This is where you write your content, add images,
and videos etc. You can think of a topic as quite closely corresponding to what you would
think of as a section (anything with a heading) in a traditional document. The difference is, in
topic-based authoring, each of these 'sections' is a separate object.

3. Published output - When you have organized your topics into a 'table of contents' in the
publication, you can generate the end result (output). The project is then published to different
output formats, such as PDF, HTML, Mobile, etc.
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Create Topics and Publications
The content in Paligo consists of topics and publications. The term publication refers to any
collection of topics, like a chapter, and not just the entire publication forming a manual or an
online help etc.

This video also shows the process:

Creating Topics and Publications

1. Start by creating the publication component itself. It will hold the topics created later. Click
the options menu next to any folder where you want to create the publication. Select Create
content.

2. In the dialog, give the publication a name, and select the type Publication.
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NOTE
You rarely need to open a publication in the editor. Usually you should
just open it in the Structure View. You often don't need to write anything in
this document. It is just a structure where you build references to a collection
of topics.

There are cases when you do want to open it in the Editor, however. For
example to add a subtitle. When you need to do that, specifically choose to
open it in the Editor through the context menu that appears on hover.

3.  Click Ok.

4. Use the context menu to the right in the file browser to create a new folder, e.g named
"Topics". Either as a nested folder under any existing, or directly under the Documents. library.

NOTE
You can use any folder to keep your topics, but it is recommended to use a
separate folder.

5. Select Create content again.

6. In the dialog, leave the pre-selected Topic type selected.

7. Give it a name, for example "Introduction", and then check the box Create another. Click Ok.

8. The dialog stays open so you can give the next one another name, for example "Safety
Information". Create as many as you want for this tutorial. Think of typical titles of sections
and subsections you might use in your documentation.

9. When you are done, close the dialog.

You have now created one publication and a number of topics.

Now see The Basics of Topic Editing [13] and Build a Publication and Reuse Content [18] for
actually creating the content.

The Basics of Topic Editing
The Paligo editor is made to be as easy to use as possible, more or less like a word processor. But
in fact it is an XML editor. The structure of the underlying XML is what enables a lot of the power
for single-sourcing and reuse.

This means, that although Paligo does not clutter the interface with lots of XML tags, there is still
a strict structure underneath the surface. So if you haven't authored in a structured environment
before, you need to at least get used to the basic concepts of adding and using "elements". The
following procedure shows you how to do that.
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NOTE
Paligo's content model is based on DocBook, but a customized topic-based
version of it. But even with the customization, it is close enough so you can in
most cases refer to this reference for a list of the elements, and what they are
used for: Element reference.

You can also check out this video showing the basics of editing topics:

https://www.youtube.com/embed/p_ZapWXrSiQ

IN-CONTEXT EDITING
Sometimes you may be working on topics in a specific publication (for example for
a certain product), and may prefer to be able to browse it in context while editing
the various topics.

You can do that, and do simple editing, in the Contributor Editor [1306]. While
mainly intended for Reviewers and Contributors, Authors also have access to it
of course. And it provides a very convenient way to browse and edit content in
context.

1. In the Content manager, open a topic in one of the following ways:

• Click on the topic name

• Select Open in editor in the options menu of the topic

The topic is opened in the editor.

2. By default, you get a title (same as the topic name) and an empty paragraph (para element)
to start with.
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NOTE
Note that in most cases you should only have one title/heading in a
topic. Subheadings are created automatically by the nesting when you
build your publication structure in the Structure View. See Headings and
Subheadings [163] for more details on this.

3. In the editor, place the cursor where you want to add content (insert an element) and do one
of the following:

• Use the toolbar icons to insert the type of content (element) you want.

• Press Alt/Cmd+Enter to show a list of available elements (types of content) at that place.

TIP
Start typing to narrow down the list of elements. E.g if you start typing
"par"... you will see the element para only, which will create a paragraph.

4. To add a new element of the same kind that you just inserted, e.g a paragraph (para),
listitem or step in a procedure, just press Enter.

TIP
See Keyboard Shortcuts [576] for more tips on speeding up your authoring in
the editor.

5. To delete an element:

a. Place the cursor in the document element you want to delete.
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b. The Element structure menu (also called "breadcrumbs") at the top of the editor, shows
hierarchic in which element you are. Place the cursor over the element name you want to
delete and click to open a pop-up-menu.

c. Place the cursor (without clicking) over the Delete menu item. Result: The element to be
deleted is highlighted with yellow background and text that is crossed with red bars.

d. Click Delete to delete the selected element.

6. Use the Element structure menu in a similar way to manipulate your content with full control,
for example:

• Highlight elements in the Editor

• Cut, copy and paste elements

• Move elements up and down (needs to be elements on the same level in the structure)

SPLITTING ELEMENTS
If you have started writing content into a para or a step, for example, and you
want to turn that content into two separate elements, just place the cursor where
you want to split the element, and press Enter. This splits the element into two
elements of the same type. A paragraph for instance will then be split into two
paragraphs at the place where you had the cursor.
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REMOVING BOLD OR ITALIC
If you have used the bold or italic elements to format text, and you want to change

it, simply place the cursor in the formatted text and click the Eraser icon, or use

the keyboard shortcuts. You can also toggle the common ones just using the

same shortcut again (like Ctrl B  to toggle bold)

Making comments in your topics
There are two ways to make comments in your topics:

• Use the review widget or the review sidebar in Review Mode or in the Contributor Editor.

Use this type of commenting when you want each comment to be part of a "conversation"
between writers, contributors, and reviewers.
To find out more about review comments, see Feedback in Review View [1287] and Feedback in
Contributor Editor [1332].

• Use the remark element.
This comment is more like a comment in code, where the comment is part of the topic but is not
displayed to your end users. Remark comments have no relation to the comments in reviews
and are not part of the review "conversation".
By default, remark comments are not shown in your published output. But if you want end
users to see them. there is a way to include them in your PDF outputs - in the PDF Layout, select
General> Drafts and then set Show Comments to Enabled.
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NOTE
You can show remarks (comments) with Draft mode set to Yes, Default, or No.
The Draft mode setting has no effect on whether remarks are visible in the
output.

Build a Publication and Reuse Content
In Paligo, you create a Publication and then you simply select components (topics) and drag and
drop them to build the structure you need, just like creating a table of contents. We use the term
reuse, since one of the central ideas behind XML-based topic-based authoring, single-sourcing and
Paligo, is the reuse of content as building blocks, irrespective of whether the content is used in one
or in several locations.

This section describes how to build a publication, using a number of topics already created.

1. Select the options menu of a Publication component and open it in the Structure View.

The Structure View opens next to the Content manager:
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2. Then just drag and drop topics in the Structure View to add them to the Publication.

TIP
You can select multiple topics at a time, just hold down the Shift key to select
a range, or the Ctrl/Cmd key to select them individually.

To simplify dragging and dropping from separate parts of the Content
manager, just select Floating Content Panel :

The Floating Content Panel opens, making it easy to drag topics into the
Structure View:

3. Drag and drop the topics into the Structure View, and then again drag and drop them to the
structure level you want in the structure.
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4. Save the publication before closing the Structure View.

NOTE

• If someone else should be editing the structure at the same time, you will get
a notification that it has changed. You should then do as the alert says and
"revert" the structure. This means that it will reload the structure to the current
state with the changes of the other user.

• There is a bug in Google Chrome for displaying the numbering of topics when
you drag and drop them. It may initially show the wrong numbering.
However, the numbering will immediately be corrected in Chrome too as soon
as you hit Save.

Publish your Content
You can publish individual topics or entire publications in various formats, including HTML5 and
PDF. Typically, Paligo users create a publication and add various topics to it to create the structure
of a user guide. Then they add content to the topics, get the content reviewed, and then publish it
in one or more formats.

To publish, you need to use a Layout [1054]. There are different Layouts for each type of output
and they contain settings for controlling how Paligo prepares your content for publication. For
example, with a PDF layout, you can set the styling of your headings, tables, etc., and with an
HTML layout, you can upload a CSS file that contains the styling. Paligo has a set of built-in Layouts
that you can use or you can create your own.

For this tutorial, you will use one of the built-in Layouts that are included with Paligo.

To publish your content:

a. Select the type of output you want to create, for example, HTML5.

b. Choose a layout from the list of available layouts.

c. Choose the languages that you want to include in your publication.

d. For this tutorial, ignore the Profiling attributes, Variables, Upload output, and Output
filename settings. These are only for use if you have used profiling (filtering) or variables in
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your content, are publishing to another system, or need to control the filename of the output.
You can also ignore the Optional parameters.

1. Select the Dotted menu (...) for the topic or publication in Content Manager [34].

2. Select Publish. 

Paligo displays the Publish document dialog.

3. Select Publish Document to start publishing. Paligo will then process your content and apply
your layout and publishing settings. The time that this takes can vary depending on how much
content you are publishing (the more content there is, the longer it takes).
A progress bar shows you how much of the processing Paligo has completed and how much is
left to do. When the processing is complete, a notification is shown.

Paligo provides your published output as a zip file that downloads in the browser. You can find
it in the downloads folder on your computer (unless you have altered your browser's settings
to store downloaded files somewhere else).
To make the content available online, first unzip the file. You can then use the file locally or
you can use an FTP client, such as Filezilla, to upload the unzipped content to a web server.

To learn more about publishing Paligo content, see Publishing Process [1068].
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System Requirements and
Recommendations

Paligo works on most modern browsers and all major operating systems. However, there are
some minimum requirements, as well as some recommendations for the best experience.

Browser Recommendations

NOTE
Some browser extensions and add-ons can interfere with Paligo (see Performance
Issues [23]).

• Chrome - Very good support, regardless of operating system. This is the browser most
recommended if you are a Windows user.

• Edge (Chromium-based versions) - Very good support.

• Edge (versions before Chromium) - Good support. Minor problems may occur.

• Firefox - Good support. Minor problems may occur. For example, placing the cursor in elements
may need to be done outside of placeholder text, and some shortcuts do not always work as
expected either due to the browser overriding them.

• Internet Explorer - Not supported.

• Opera - Very good support.

• Safari - Very good support (Mac). This or Chrome are the most recommended browsers on Mac.

Internet Connection
Since Paligo is a web based application, you will normally need to have an internet connection
of course. It is possible to check out topics in the (optional) offline Oxygen editor with the Paligo
plugin, work on them and then save them when back online. But it is recommended that you
normally have a connection when working.

The minimum internet connection speed we support is 2 Mbit/s. But this is unsuitable if you work
with large image files. A fast internet connection will provide the smoothest experience.

Set Up Your Paligo Instance
The first step when using Paligo is to set up your instance. This involves applying some
recommended settings and choosing your preferences for certain interfaces and features.

Some settings are system-wide and so will affect all users. You can find out how to use them in
Initial Settings [24].

Other settings, such as many of the editor preferences, are mostly user-specific and can be set by
each user. To learn how to apply these, see Editor Settings [600].
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NOTE
We also recommend that you read the System Requirements and
Recommendations [22].

Performance Issues
In the unlikely event that you experience slow performance or unexpected behavior when
working in Paligo try the tricks below. If you have tried all the below and continue to experience
performance issues, please contact customer support.

• Empty your browser's cache The process for clearing the cache varies, depending on which
browser you use. Refer to the browser's support documentation for instructions.

• Try using Paligo in the browser's incognito mode or private mode. In incognito mode,
browser plug-ins do not run and plug-ins can sometimes interfere with Paligo. If Paligo works as
expected in incognito mode, you can disable your plug-ins one at a time until you identify which
one is causing the problem. You can then disable it when working in Paligo.

NOTE
Browser plug-ins are also known as add-ons. Some are known to cause
interference, especially grammar and writing tools such as Grammarly.

• If the search is not working in your HTML outputs, edit the HTML layout and enable the
Avoid cached JS and CSS when republishing option. It is in the CSS, JS, Logos and other assets
settings.
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Initial Settings

Before you start authoring, we recommend that you set up your Paligo instance. There are various
settings that we recommend that you put in place. We categorise these settings as:

• System settings that affect the entire instance [24] - Typically an administrator-level user
applies these when they first set up a Paligo instance.

• Layout settings [24] that apply whenever you publish using a particular layout. Many layout
settings are optional and you can alter them to suit your own requirements. But a small number
of them are recommended as best practice, so it is a good idea to put them in place.

• Settings that only affect your particular user account [25], such as your Editor preferences.
Typically, each user sets these preferences when they first start using Paligo.

NOTE
We do not apply these settings by default as we need to ensure backwards
compatibility with previous versions of Paligo.

Recommended System Settings
You will need an admin user account to change the consecutive branching, persistent image
filenames and multi-factor login (2FA) settings.

Paligo has some system-wide settings that affect your entire instance. For these, we recommend
that you:

• Check the Source Language [1880].

• Manage Consecutive Branching [28]

• Control the Image Filenames [29] in the system settings.

• Choose your preferred deletion strategy [31]

• Set the Automatic Logout [29]

• Control Importing Translations into the Source Language [30].

When you have applied the recommended system settings, move on to setting the Recommended
Layout Settings [24] and Preferences for Individual Users [25].

NOTE
If you are on the Paligo Enterprise plan, we also recommend that you set up
two-factor authentication [1819].

Recommended Layout Settings
Paligo uses layouts to store all of your preferences for publishing. There are built-in layouts for
the various different types of Paligo output, including PDF, HTML, and HTML5. You can also create
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your own custom layouts for the different output types. To learn more, see Layouts [1054]. For each
layout that you intend to use for publishing, we recommend that you:

• Choose your Filtering Strategy [25] . This determines whether you can use Scoped
filtering [1144] and you enable or disable it in the layout settings.

• Control the Custom CSS Filename [26] in the layout settings.

• Set Up SEO-Friendly and Reader-Friendly URLs [27] in the layout settings. This only applies to
HTML-based layouts.

Layouts have many other settings that you can use to customize your outputs to suit your
requirements.

TIP
To enable the usage of more than 9 subsections in a topic, the checkbox Save
can be cleared under Paligo Recommended Rules in the Editor Settings [600].
However the best way is to Use Components to Create Subsections [169].

Preferences for Individual Users
We recommend that each user sets their own time zone and also chooses their own preferences
for the Paligo editor. To make your choices, see:

• Set Time Zone [1848]

• Editor Settings [600].

Choose your Filtering Strategy
Paligo has two different filtering strategies for controlling whether content is included or excluded
when you publish. The strategies are known as "normal" filtering and "scoped filtering" and you
need to choose which strategy to use before you publish.

To choose the strategy for a publication, use the layout editor.

1. Select Layout and edit the layout you are going to use for publishing.

2. Locate the Enable scoped profiling/filtering option.
For PDF layouts, you can find the setting in General > Filtering and taxonomies.
For HMTL layouts, it is in the Classes and Attributes settings.

3. Choose the strategy that will be used when you publish.

• Set Enabled scoped profiling/filtering to No to use normal filtering.

• Set Enabled scoped profiling/filtering to Yes to use scoped filtering.

IMPORTANT
We recommend that you set Enabled scoped profiling to No unless you have
a specific requirement for scoped filtering. Scoped filtering is designed for when
you reuse filtered content in the same publication, but want different values to
apply. To find out more, see Scoped Filtering [1144]
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Control the Custom CSS Filename
You can upload your own CSS file to an HTML layout to customize the styles that are used in your
HTML output. The filename for the CSS can be:

• Persistent
With the Persistent custom CSS filename feature enabled, Paligo will set the CSS filename to
"layout-custom-style.css". This is fixed and will be used every time you publish.

• Variable
With the Persistent custom CSS filename feature disabled, Paligo will use a different, unique
name for the CSS every time you publish.

We recommend that you enable persistent CSS filenames, unless you have a specific need for a
different CSS filename each time you publish.

NOTE
The Persistent custom CSS filename feature also applies to XML outputs.

1. Select Layout and edit the layout you are going to use for publishing.

2. Select CSS, JS, logos and other assets.
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3. Set Persistent Custom CSS Filename to Enabled.

4. Select Save.

Set Up SEO-Friendly and Reader-Friendly URLs
If you are publishing to HTML, you will need to use one or more HTML layouts. The layouts have
default settings in place that are designed to provide a good starting point.

By default, the HTML layouts have the "SEO-friendly URLs" and "Reader-friendly URLs" features
disabled, as this is needed for long-term Paligo customers. But on new Paligo instances, it is better
to have these settings enabled.

To set up SEO-friendly and reader-friendly URLs:

1. Select Layout and edit the layout you are going to use for publishing.

2. Enable the SEO-friendly output file names feature.

NOTE
The "reader-friendly" features require the SEO-friendly output file names
feature to also be enabled.

3. In the General section, enable or disable the Reader-friendly fragment identifiers (hash
links) setting.
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Set to Enable to use text URLs.
Set to Disable if you prefer to use the UUIDs for hashtag identifiers.

NOTE
Reader-friendly fragment identifiers is disabled by default, so that it does
not affect any Paligo customers who want to continue using UUID in hash
links.

4. Select Save.

NOTE
If you have a publication that contains multiple topics or sections with the
same title, you would get duplicate hash fragment identifiers.

If you have such duplicates, Paligo will add a suffix to differentiate them. The
suffix is generated from the id of the second topic/section. But you can avoid
using suffixes by manually providing a reader-friendly fragment identifier. To
do this, use the xinfo:outname attribute on the section element of each
duplicate topic/section.

When you use the layout to publish your content, your chosen settings will be applied to the HTML
output.

Manage Consecutive Branching
Paligo has a branching feature that is designed for creating and managing different versions of
your content. You can find out about how it works in Branching [1638].

Depending on how you want to use branching, you can set Paligo to:

• Only allow a branch to be made from an unbranched publication or topic. With this approach,
you cannot make a branch of another branch.
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• Allow branches to be made from other branches.
For example, you could create a branch of version 1.0 of a publication to create a version 2.0.
When you enable the consecutive branching feature, it means you can create a new branch
from an existing branch.

To enable or disable consecutive branching:

1. Select your profile name in the upper right corner to display a menu, and then select Settings.

2. Select the System Settings tab.

3. Enable the Consecutive Branching feature.

Control the Image Filenames
With persistent image filenames, Paligo uses a UUID (universally unique identifier) as the filename
for each image. This UUID will always remain the same, so even if the name of the image would
change in Paligo, the filenames in the outputs would always stay consistent.

We recommend that you enable the Persistent image filenames feature. If you disable it, Paligo
will generate random filenames for the images each time you publish.

1. Select your profile name in the upper right corner to display a menu, and then select Settings.

2. Select the System Settings tab.

3. Enable the Persistent image filenames feature.

Set the Automatic Logout
Paligo can automatically log out inactive users. This can be important for complying with security
policies and reducing the risk of unauthorized users gaining access to Paligo and your content.

1. Select your profile name in the upper right corner to display a menu. Select the Settings
option.
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2. Select the System Settings tab.

3. Set the Auto-Logout time. You can choose 1 hour, 2 hours, or 6 hours. If a user is inactive for
the time period that you select, Paligo will log them out.

Control Importing Translations into the Source
Language
Paligo has a Source Language Translation Import feature that, in most cases, should be
disabled. It is designed for use in unusual scenarios where multiple languages are used for
authoring.

To check that it is disabled (or to enable it, if you have been advised to by Paligo customer
support):

1. Select your profile name in the upper right corner to display a menu. Select the Settings
option.

2. Select the System Settings tab.

3. Use the Enable source language import switch to turn the feature on or off.
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CAUTION
Only enable the Source Language Translation Import feature if advised to do so
by Paligo customer support.

Allow Users to Delete or Force them to Send to Trash
Paligo has two deletion strategies and you can choose which one you want to use.

• Users can delete content directly from the Documents section of the Content Manager.
This content is immediately deleted from the database. It can be restored from the Activity
Feed if needed.

• Users do not have access to the delete option in the Documents section. They can only move
content to the trash. Once the content is in the trash, they can either restore it or they can
delete it. You may prefer this two-step process as it can be quicker and easier to restore from
the trash rather than finding the deletions in the Activity Feed.

To choose the deletion strategy for your Paligo instance:

1. Select your profile name in the upper right corner to display a menu, and then select Settings.

2. Select the System Settings tab.

3. Use the Enable deleting content option to choose your deletion strategy.

• Enable the option to allow users to use the Delete option directly from the Documents
section of the Content Manager

• Disable the option to deny access to the Delete option in the Documents section. Users
can only send the content to the trash (but they can delete it from there, if needed).

NOTE
For instructions on deleting content and moving content to the trash, see:

• Delete Content [469]

• Move to Trash [465]
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Set the Default Filename for PDF and ZIP Files
Administrators [1834] can create a template to define the structure of filenames. Paligo will use the
template by default when it generates filenames for the PDF and ZIP files it publishes.

NOTE
When users publish content in Paligo, they can use publish document dialog to
set a different filename structure. If they do this, Paligo will use the publishing
settings instead of the default system settings. To find out more, see Publishing
Process [1068].

To define the default filename structure:

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select the System settings tab. 

4. Use the Output filename template setting to control the filename of the output. Default is:
ID-Title-Format.

You can set it to include various values:

• ID - The ID of the document.

• Title - The title of the publication or topic that you are publishing.

• Format - The name of the output format, for example, PDF or HTML5.

• Edit date - The date that the publication or topic was last edited.
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• Branch label - The text from the branch label for the publication or topic. This only applies
if your content has been branched and it has a branch label. For details, see Add or Edit
Branch Labels [1648].

• Unique value - A random string of characters, generated by Paligo, that is added to the
filename to make it unique. This can stop the file from being overwritten by later publishes
of the same document.

TIP
If you type @ into the field, Paligo displays a list of the available values and
you can select from the list. To remove a value, click in it and use the delete
key or backspace key to remove all of its characters.

5. Select Save template.
The next time a user starts the publishing process, Paligo will use this template as the
default for naming the output files. If a user enters different filename syntax in the publishing
settings, Paligo will use those instead.
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Paligo Interfaces

Paligo has many different user-friendly interfaces that are designed to make it easy for you to
create, edit, review, manage, and translate your content.

We recommend that you take some time to learn the basics of the various interfaces, so that when
you start to create and publish your content, you can work more efficiently.

Paligo has many interfaces, including the dashboard (left) and the editor (right).

Content Manager
Use the Content Manager to create and organize your content. It feels similar to a regular file
browser, but with very big differences. The content is stored in a database and among other things
Paligo keeps track of all the relationships between the resources, where they are used and reused,
what topics have links to others and so on. This means that you don't have to worry about moving
things around in different folders, as links will not be broken.

NOTE
Images are stored in the Media folder.  When an image is added to a topic, you
only see a reference to it rather than the actual image.
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Content Types in Content Manager
The Content Manager holds a variety of content, all designated by different icons. Different items
should sometimes be stored in different areas too, explained below.

Type of
content

Icon Description

Content
Library

The Content Library holds all textual content - i.e topics, safety message components,
etc, as well as the Publications.

Folder The Folder object works just like a folder in any file browser - i.e you use it to organize
your content. You can create as many folders as you want and nest them, just like you
are used to.

The difference compared to a regular file browser is that Paligo keeps track of
everything, so it doesn't matter if you move content. Paligo will know if there are
links or other relationships, and keep them intact no matter how you move content
around.

Publication The Publication type (doesn't have to be an entire publication, but also a chapter or
similar smaller structure) is like a container where you insert and reuse your topics.

Normally you don´t open a Publication in the Editor, only in the Structure View to build
your publications reusing your topics there.

Topic A Topic is the basic building block you author - a small chunk of information, such as
an instruction, a warning, or a small description.

Media Library The Media Library is where you store your images. You can create folders here too, to
keep things organized.

Image Images, stored in the Media Library, can be of most types. You only need to store one
version of each image. For instance, you can store e.g a Photoshop (.psd) or Illustrator
(.ai) image, with layers and everything, and Paligo will take care of converting it into
the appropriate output formats, such as low res .png for web and high res .tif for print

Templates You can create templates, i.e topics with predefined structure, and store them in the
Templates Library. You can then use these templates to create new topics.

User Library The User Library holds all users registered in your Paligo installation.

User Each individual user. You can drag and drop topics or publications on a specific user,
and this creates an assignment for that user.

Variable Set
Library

This icon designates the Variable Set Library, holding any number of Variable Sets.

Variable Set A Variable Set holds variables, that can be used in topics. 

Taxonomy
Browser

This is really another type of content browser, where you organize your content by
tagging it by category. You can create any number of taxonomies here.
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Type of
content

Icon Description

Taxonomies The root taxonomy tag holds all your various taxonomies. You can have one for
product families for instance, one for subject matter, etc.

Colors and Status in the Content Manager
The publications and topics shown in the Content Manager can have color-coded symbols that
indicate status. The status can relate to the production workflow, being checked-in or out, and also
branches.

Icon Color Description

Purple dot The content is in the In review stage of the production workflow [1209].

Blue dot The content is in the In translation or In translation review stage of the production
workflow [1209].

Green dot The content is in the Released stage of the production workflow [1209].

Solid green
checkmark

You have the content checked out.

To find out about checking content in and out, see Check-in and Check-out [136].

Faded green
checkmark

Another user has the content checked out. If you hover the cursor over it, Paligo
shows details of who has the content checked out.

To find out about checking content in and out, see Check-in and Check-out [136].

White branch icon The content is the original version, but has branched versions too.

To find out about branches, see Branching [1638].

Blue branch icon The content is a branch of another component. The number indicates whether it is the
first branch, second branch, third branch, and so on.

To find out about branches, see Branching [1638].

Organize Components in the Content Manager
By creating folders, you can organize your content any way you want. You can add folders inside
other folders, if needed, to create a hierarchy of your main content components (publications,
topics, informal topics, admonitions).

We recommend that you think carefully about your content organization from the start, and
consider where new content will be added. You will need a structure that is logical and makes it
easy for you and other authors to find and reuse topics.

It is a good idea try and keep the number of components down in each folder. Keeping few
components in the same folder will give you better performance, and it will also be easier to get an
overview.

Try to think of this in conjunction with taxonomies if you have that feature in your plan.
Taxonomies give you the opportunity to organize your content in multiple ways.
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NOTE
You can also organize your content by categorizing it, using the Taxonomies.

• To create folders to organize your content: open the options menu (the three dots next to an
item in the Content Manager) and select Create folder.

• To move a component, just drag and drop it in the location you want to move it to. Either in the
same browser or open a Floating Content Panel.

TIP
To move multiple components at once, select them holding down the Shift key
to select many at once, or the Cmd (Mac)/Ctrl (Windows) key to select/deselect
individual items, just like in most file browsers you may be used to. Then drag
and drop them where you want to move them.

Sort Content in Content Manager
By default, each folder in the Content Manager has its contents listed by folder first, then
publication, then topic, with each of those listed alphabetically. But you can change the order,
if required.

In the Content Manager, select the options menu ( ...) for the folder that contains the components
you want to sort. Then select Sort and choose an option from the menu:
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• Folder - Sorts the selected folder so that folders are shown at the top, then publications, then
topics.

• Publication - Sorts the selected folder so that publications are shown at the top, then folders,
then topics.

• Topic - Sorts the selected folder so that topics are shown at the top, then folders, then
publications.

• Alphabetic - Sorts the selected folder in alphabetical order, and ignores the type of content.

Resize the Content Manager Sidebar
To change the size of the Content Manager sidebar, use the arrow icon that appears on its edge.
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• Drag the icon left and right to increase or decrease the width of the Content Manager sidebar.

• Select the icon to toggle the Content Manager sidebar between minimal size and its previous
size.

• Press and hold Shift  and then select the icon to return the Content Manager sidebar to its

default size.

Use Floating Content Panels
Floating content panels work in a similar way to the Content Manager, but they are not tied to the
left side of the user interface. You can move them to any position on your screen.

There are two main benefits of using floating content panels:

• You can open multiple panels at the same time. This can make it easier to manage your content,
for example, dragging and dropping between folders.

• You can select any part of your content as the "root" of a floating panel.
For example, you could create a floating panel for the Media Library or a specific folder in the
Content Manager. This is a convenient way to focus on a particular area of your content without
having to navigate the entire Content Manager.

1. To access one or more Floating Content Panels, select the options menu ( ... ) next to the
component you want to browse.

2. Select Floating content panel.
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A floating content panel appears.

You can open up to five floating panels at the same time and can drag and drop content:

• From the Content Manager to a floating content panel

• From a floating content panel to the Content Manager

• From a floating content panel to another floating content panel.
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You can also move content around in a floating content panel. For example, you can move topics
into a folder and move folders into other folders. The changes you make in a floating content
panel are applied automatically to the content in the Content Manager.

Contributor Editor
The Contributor Editor is where non-technical writers review, comment, edit content and compare
snapshots with the Timeline [1350]. It has two views with different features and the Assignment
Types [1212] control which of them you can access:

• Review - In this view, you can provide feedback on content.

• Edit - In this view, you can edit live content, create snapshots and also enter feedback
comments.

Review View
 The Review View is where reviewers carry out their review assignments and provide feedback

on content. It's made to be as simple and intuitive as possible, so there is a short learning curve.

Authors can also use this view to go through feedback and open topics to fix issues directly from
here. Authors also have the same comment features available directly in the editor, so there can
be a two-way communication between authors working in the editor and reviewers working in the
review view.

To be able to access the Review View, you have to be a reviewer (or higher) and you have received
an email invitation to take part in a Paligo review assignments or have content shared with you.
Learn more, see Review Assignment Instructions [1272] and Working in Review View [1278]
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Edit View
 The Edit View is where contributors carry out their contribution assignments. It has a simpler

interface than the main Paligo editor. You can edit live content, create snapshots and also enter
feedback comments.

To be able to access the Edit View, you have to be a contributor (or higher) and you have received
an email invitation to take part in a Paligo contribution assignments or have content shared with
you. Learn more, see Contribution Assignment Instructions [1300], Working in Edit View [1306] and
Edit Content in Edit View [1315].

Dashboard
When you first log in to Paligo, the Dashboard is shown. It provides you with an overview of your
Paligo instance and the assignments you need to work on. The Dashboard contains several panels
described below.
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If you have navigated away from the Dashboard, you return to it by selecting the Dashboard tab
in the top menu.

NOTE
Content Manager [34] is shown in the left sidebar. You will use the
Content Manager when creating and organizing your content. The Taxonomy
Manager [79] is also in the left sidebar.

Activity Feed
The Activity Feed panel shows a history of recent events that have occurred on your Paligo
instance. These include activities such as users logging in, creating topics, editing topics and
deleting topics.

By default, the Activity Feed shows the five most recent events. To see more, select the down
arrow icon at the bottom of the Activity Feed panel.
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Filter your Activity Feed
The dashboard has an activity feed where you can see a record of recent events in your Paligo
instance. By default, the activity feed shows all traceable events, the time of each event, and the
users that were involved. But you can filter the activity feed so that it only shows events that are of
interest to you.

NOTE
All boxes are cleared by default and this has the same effect as all boxes being
checked - no filters are applied. But when you have a mix of cleared and checked
boxes, the cleared events are not shown in the activity feed, the checked events
are shown.

1. Select the Dashboard tab in the top menu.

2. Select the filter icon in the Activity Feed section. 

3. Check the boxes for the users you want to include in your activity feed.
Clear the boxes for the users to be excluded from your activity feed.
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NOTE
All boxes are clear by default and this has the same effect as all boxes being
checked - no filters are applied. But when you have a mix of cleared and
checked boxes, the cleared users are not shown in the activity feed, the
checked users are shown.

4. Check the boxes for the Events you want to include in your activity feed.
Clear the boxes for the events to be excluded from your activity feed.

The events are organized into categories to make it easier to find what you are looking for.

NOTE
Paligo immediately updates the activity feed to show the selected the content.

Users Online
The Users Online panel shows you which users are currently logged in to your Paligo instance. You
can see the profile image for each logged in user and the total number of logged in users is shown
in a circle in the top corner.
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Shared Documents
You can share a document, such as a topic or publication, with other users so that they can make
a contribution. The Shared Documents panel has two tabs, With You and By You.

The With you tab shows you who has shared a document with you, and provides a link to the
document. You can also send a reply to the user who shared the document.

The By you tab shows the documents you have shared with other users. You have the option to
cancel the share (Unshare) or to edit the share. When you edit the share, you can change the
timescale, add a different message, etc.

For more information on sharing documents, see Share Content (without assignments) [1347].

Assignments Panel
In Paligo, you can create assignments for Reviews, Contributions, Translations and Translation reviews.
Each assignment is a request to work on content and usually has a timescale and a message
explaining what needs to be done. When an assignment is created an email notification is sent
to the assignee. Once the assignee finishes the assignment, by using the Assignment button, an
email notification is sent to the author. 

The Assignments panel to the right of Dashboard [42] shows your assignments and the
assignments that you have invited others to work on. You can follow the progress both from
the Assignment Panel and the Planner [66], see Track the Assignment Progress [1246].

If you are an author, the assignments are sorted under the tabs: For You, By You or Done ,
depending on whether it is allocated to you, created by you or has been completed by the
assignees.
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TIP
The assignment link is sent to the assignee as an email notification and is also
available in the Assignment Panel. If there is a need to copy an assignment link,
you can right-click the assignment and choose Copy Link Address.

By selecting an assignment, Review View [41], Translation View [79] or Working in Edit View [1306]
opens up, depending on the assignment type.

A symbol shows the progress for each assignment:

Paligo Documentation

47



Question mark The user has not approved or rejected the assignment content

Green checkmark The user has approved the assignment content

Red Minus symbol The user has rejected the assignment content as it needs more
work before it is suitable for publishing.

TIP
To find out more about assignments, see Assignments [1208].

Checked Out Documents
Paligo has a built-in checking in and out system. When you edit a topic, it is checked out
automatically, so that other users cannot edit it at the same time. The Checked Out Documents
panel gives you a list of documents that are currently checked out.
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You can use the Checked Out documents panel to view only the documents you have checked
out yourself (My documents) or All documents by all users. You can check in your own
documents on an individual basis, or you can select the checkboxes and then use the Check-in
button to check in all selected documents at once.

To find out more about checking in and checking out documents, see Check-in and Check-
out [136].

Statistics
The Statistics panel provides an overview of your Paligo instance. It shows the total storage usage,
with storage broken down into segments for database, images, files, and free (available space).
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On the Professional plan and higher, you can select More statistics to display the Statistics
page. The Statistics page provides more data about your Paligo instance. You can also display the
Statistics page by selecting the Statistics icon at the top-right of the dashboard, above the Users
Online panel.
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Editor
The content is created and edited by the author in the Editor. To find out how to use the various
editor features, see Authoring in Paligo [93].

Areas surrounded by a blue dotted line shows that Variables [1186] are applied.

1. Navigation Menu [52]

2. Toolbar [52]

3. Element Structure Menu [52]

4. Currently Selected Element [54]

5. Element Context Menu [54]

6. Element Attributes Panel [55]

7. XML Tree View [54]

8. Reuse Text [56]

9. Documentation [57]

Display the Editor
A topic or component is by default opened in the Editor. There are two ways to display the Editor:

• By clicking the name of the topic or component in the Content Manager [34].

• Using the menu option Open in editor.

TIP
You can open multiple Paligo windows in the same web browser, but be careful
when editing and saving, because there is potential to overwrite changes you
have made.

• Select a topic or component in Content Manager [34].
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Paligo opens the content in the Editor [51].

Navigation Menu
The Navigation Menu is located between the top menu and the Toolbar [52] in the Editor [51].
It shows the folder structure with the topmost folder to the left. The currently displayed topic is
grayed out and shown to the right. You can navigate in the folder structure by selecting any part of
it to display it in the Resource View [68].

Toolbar
The Toolbar has been divided in three tabs to make it easier to overview. The Edit and Insert tab
contain most of the elements and actions you need for creating and reusing content. The Preview
tab shows how your content will look when it is published. You can choose to preview the output
as PDF, HTML or HTML5.

To find out how to use the various editor features, see Authoring in Paligo [93].

TIP
Find useful keyboard shortcuts, see Keyboard Shortcuts [576]

Element Structure Menu
The Element Structure Menu is shown at the top of Editor [51] below the Toolbar [52]. It shows the
content hierarchy and provides access to options for working with specific elements.
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In the image above, the currently selected element is a para. You can see this by looking at the
Element Structure Menu, which shows: section > note > itemizedlist > listitem >
para. This means the cursor is currently on a para that is inside a listitem. The listitem is
inside an itemizedlist which is inside a note. The note is inside the section element, which
represents the topic as a whole.

Menu Commands
By selecting an element in the Element Structure Menu, you access a list of options. The options
vary depending on the currently selected element in the topic and also which element you
selected in the Element Structure Menu.

Menu Command Description

Go to element Moves your cursor to the element you select in the Element Structure menu. This
gives you great control over the underlying element structure.

Move element up Moves an element up in the topic structure, at the same level as the element selected.
For example, a para element inside a section can be moved up above a para element
at the same level in the section. But it cannot be moved into a subsection i.e. at a
different level in the hierarchy.

Move element down Works in the same way as move element up, except that it moves the element down
in the structure.

Generate ID Generates a unique and persistent id for the selected element.

NOTE
Some elements will generate unique and persistent ids by
default. You can select which ones, and add more in the Editor
settings.

Lock content Locks content so that it cannot be edited without first being unlocked. This is very
useful if you have written something that you know should not change. For example if
you have content that could be reused as a text fragment, you might want to protect it
from further editing.

Disable element translation This is useful if you have content you know should not be translated. Such content
will then be marked as untranslatable when you create a translation package for your
translation provider.

Text Reuse and history of a text element:

• Show history: Shows the revision history of a single text element.

• Usage information: Shows where the text element is reused (if the Reuse text
feature has been used).

• Compare translations: View the text element in different languages (if applicable).

Copy Copies the element you select. This should always be preferred to just copying by
selecting directly in the editor, which is prone to mistakes. Remember that this is
"structured authoring", and the document structure should be carefully controlled to
give you the power of structured authoring.
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Menu Command Description

Cut Cuts out exactly the element that you select. If you place the cursor in a valid location
for this element, the Structure Element Menu has an option to insert the cut content.

Paste before/after, Insert/Insert
as reuse

Different ways of pasting elements, as reuse text or not, depending on your choice
and the context.

Delete Removes selected content. The editor highlights the content that will be deleted and
shows its text in red.

Currently Selected Element
The cursor location is what determines what is the currently selected element. When you move
the cursor and select another part of the topic, you will see that the Element Structure Menu [52]
changes to show you the structure.

The Element Structure Menu also provides a list of options for working with specific elements.
If you select an element in the Element Structure Menu, the options that are available for that
element are shown.

Element Context Menu
The Element Context Menu contains all of the elements that you can insert at the current location.

You open it by pressing Alt  Enter  on Windows or ⌘  Enter  on Mac.

You can customize the element context menu so that certain elements appear in a favorites
section at the top. This can make it quicker and easier to apply regularly used elements. For
details, see Working with the Element Context Menu [568].

To find out more about using the element context menu to add content, see Add Content to
Topics [142]

XML Tree View
The XML tree view shows the structure of the topic that you have open in the main Paligo editor.
For writers, it is especially useful as it means you can see the elements you have in place all at
once, and it also makes it much easier to move blocks of content to new positions. You can drag
an element from one position in the XML tree to another and your topic will update automatically
to match.
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To find out more about the XML Structure view, see Move Content [153].

Element Attributes Panel
Each element, such as a para, has its own properties, which are called attributes. When you add
an attribute to an element and set its value, it only affects the specific element you selected. For
example, if you add a filter element such as xinfo:country to a paragraph, it only applies to that
paragraph and will not affect any other para elements.

The Element Attributes Panel shows the attributes that are in place for the currently selected
element. It is used to add, remove, edit and profile / filter an attribute and set its value.

It is only possible to choose attributes that are valid for the type of element selected, for example,
an imagedata element can have a width attribute. By adjusting the value of the width attribute,
the size of the image is set. By using a percent sign (%) after the value, the image can be scaled. A
width attribute cannot be set on a para element.
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Reuse Text
The Reuse Text section is where you can search for existing text fragments in the database. So if
you are writing a paragraph or an instruction that you think may exist, you can search for it and
reuse the existing version.

For example, in software documentation, it is quite common to have a "Select Save" step that is
used in many procedures. Rather than repeatedly recreate that text fragment, you write it once
and reuse it wherever needed. Then, if the text ever needs to change, you can make the change
once and it will apply to every instance of "Select Save" automatically.

Another more stable alternative, if there are several writers and publications, is to Create an
Informal Topic [1109].

You can enter a term and Paligo will find any close matches. You can then select a result and
choose to insert it or you can select the cog icon to access more information about the text
fragment.

TIP
To find learn more, see Find Reusable Content [1131] and Reuse Text
Fragments [1113].
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Documentation
The Documentation panel provides information about the currently selected element. It shows a
list of Common Attributes that are often used with that element, with a brief description of each
attribute. There is also a Description of the selected element, which is shown at the bottom of the
documentation section.

Layout Editor
A layout [1054] is a collection of settings that you apply to your content at the time of publication.
Paligo uses the layout settings to determine how to style and process your content when creating
the published output. These settings vary depending on the type of layout.

You reach the Layout Editor from the Layout tab in the top menu. The initial page is where you
create new layouts and access existing layouts. The list is empty if no layouts have been created.
When you access a layout, the settings page appears.
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To the left the layout tab. To the right the settings page.

Math Editor
If you need to use mathematics in your Paligo content, use one of the supported math editors.

Paligo supports two different math editors:

• MathQuill is the default built-in math editor in Paligo. To learn how to use it, see Use the Built-In
Math Editor [390].

• MathType provides more advanced mathematical features and requires a Wiris MathType
subscription. This is available on the Enterprise plan . To learn how to access the it, see Use the
MathType Editor [392].
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See Mathematics [387] to find out how to:

• Choose which math editor to use

• Set up Paligo to use MathType

• Access and use the math editors.

Oxygen XML Editor
Paligo is made for easy authoring and the Paligo Editor [51] is normally the first choice for most
editing. However, the focus on user-friendliness in Paligo also means that the Paligo editor is
intentionally kept as uncluttered and easy to use as possible, and targets the most common
editing functionality. If you find yourself needing to perform something that you cannot find a way
to do in the Paligo editor, you have the option of using the Oxygen XML Editor.

Recommended use of the Oxygen XML Editor

• Publishing to web help if you want a different kind of HTML output than the default HTML or
HTML5 Responsive Design, you have the option of publishing to web help in Oxygen. This is very
similar to the traditional kind of "three-pane help" used in software. See Publish to Web Help
from Oxygen XML Editor [64] for more information.

• Advanced XML editing if you need to manipulate the XML more directly than the Paligo editor
is intended for.

• Advanced imports of certain formats, read more in the Importing section.
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NOTE
Note that you will need an Oxygen license (3rd party) if you want to use it. The
plugin for integration to Paligo is however included in your Paligo license.

Paligo supports integration with both Oxygen XML Author and Oxygen XML Editor.
The difference between these is that both work for topic editing, but Oxygen XML
Editor also works for development of XSLT and more.

If you have no need to do advanced XSLT development, Oxygen XML Author is
more than enough, and you should choose that if you just need to use it to edit
topics in Paligo offline.

Since both are supported, we use the terms interchangeably below.

Install the Oxygen XML Editor

1. Download the Oxygen Author (the one with the red icon) from the Oxygen web site: Oxygen
Author.

NOTE
If you are on Mac OS X, you should scroll down on the page and select the
version that includes Java SE 8 or later, or click this link: Mac version for Java
SE 8).

2. Install the Oxygen Author by following the installation wizard.

3. The first time you open Oxygen Author you will get the option to register it.
If you haven't purchased it yet, you can get a trial license from Oxygen.

Install the Paligo Plugin for Oxygen XML Editor

1. Start Oxygen XML Editor.

2. Go to Help - Install new add-ons...

3. Paste the url https://resources.paligo.net/paligo-oxygen-addon.xml in the field Show add-ons
from:

4. The Paligo plugin and the Configuration add-on will appear. Check the boxes next to these two
installations.

5. Check the box to accept the License Agreement, and click Finish.

6. A panel called Content Manager should have appeared on the left. If it doesn't, go to Window -
Show view - Content Manager.

7. Restart Oxygen.

When running the plugin for the first time, the Content Manager panel will ask you for hostname,
username, and password. Do the following:
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1. Type in companyname.paligoapp.com as the hostname (no https://), your username and your
password. (Of course, replace the companyname part with your actual domain name, usually
the same as your company name.

2. Click Test (Connection succeeded should appear).

3. Click Save to save the plugin configuration. Nothing appears to happen, but the configuration
will be saved.

4. Restart Oxygen.

NOTE
When you restart, if the Content Manager view isn't open, open it by Window - Show
View - Content Manager. It will show you a view similar to the Content Manager in
the Paligo web interface.

Open Topics in Oxygen XML Editor
1. Start the Oxygen client on your computer. Make sure you have already installed the Oxygen

Paligo plugin.

2. If it's not already open, open the Content Manager view under Window > Show View > Content
Manager.

3. Browse to the folder and the topic that you want to open, and double-click to open it.

4. After you are done editing, save the topic and close it. If you need to check it in, go to Paligo to
do so.

Add Images in Oxygen XML Editor
Besides opening and editing Paligo topics in Oxygen, you can also browse, preview, and insert
images in topics, right from your Paligo image library.

To browse for images in the Paligo image library, simply use the file browser and preview any
image by double-clicking it:
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To insert images, do as follows:

1. Open a Paligo topic in Oxygen, using the Paligo file browser.

2. Put the cursor in a valid position where you want the image.

3. Click the image icon in the toolbar: 

4. In the image dialog, you will see that Paligo is available as a place to find images. Click to select
the image.

Note that you must select the image from the Paligo library. Local hard drive images will not
work, and if you have local images you want to use, you need to upload them to Paligo first.

5. Select the image you want from the Paligo library.

6. The image will be inserted as a figure element. If you just want a mediaobject, just select
the mediaobject element and drag it to where you want it outside of the figure element,
and then delete the figure element.
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7. Set the width for the element using the Attributes view.

Paste from Word, Excel or HTML in Oxygen XML Editor
If you have content in Word, Excel or HTML, you can easily get it into a Paligo topic by opening the
topic in Oxygen XML Author, using the Paligo plugin file browser.

This can be quite convenient, especially if you have long tables or Excel sheets that you want to
turn into tables in a topic.

NOTE
Please note that this procedure presumes you have Oxygen XML Author client,
and that you have the Paligo plugin installed for it. 

1. Open a Paligo topic in Oxygen using the file browser.

2. Open the Word or Excel document, or open a web page in a browser.

3. Copy the content you want to insert in your topic.

4. Paste it anywhere it would be valid, e.g directly inside a section element. If it's not a valid
position, Oxygen will alert you to this, and give you the option to insert it in a valid position.

Your content will automatically be converted to the correct XML structure, and you can save the
topic to Paligo.
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Publish to Web Help from Oxygen XML Editor

NOTE
To create a very modern type of web help in HTML5, you can publish directly
to that just using the HTML5 format available directly in the publishing dialog.
The below alternative is just an option in case you prefer more traditional 3-pane
format in standard XHTML.

Using the Oxygen XML Editor, you can create standard XHTML web help output. The first time you
do this, you may want to customize the output a bit. Although this can get a bit technical, this is
something you normally only have to do once, and if you follow the instructions here it should not
be a problem. If you do need help, please contact support and we'll walk you through it.

1. Start by publishing to XML.

2. Download the finished result, and go to the folder. Open the Publication XML file (It will have
publication in its name) in Oxygen XML Editor. You need to have this file open before you
can do the next step.

3. Create a Transformation Scenario:
Either use the toolbar:

Or the menu:

4. The Transformation Scenario dialog opens. We will use the DocBook webhelp scenario (since
Paligo exports to DocBook format). Create a duplicate by clicking Duplicate.
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5. A new dialog is opened for your new scenario. Give it any suitable name you wish ("WebHelp -
Paligo" e.g.

6. If you want to customize the styling of your web help, do the following:

a. Select the tab <emphasis xmlns="http://docbook.org/ns/docbook">Parameters</
emphasis>. Then type "css" in the filter text field. That will narrow down the choice of
parameters.

b. Select the one called html.stylesheet. Double-click the Value field.

c. Type the full path, or browse to the custom css file you want to use. There is an example
css with some basic customization in the Getting Started area of the Paligo support site.
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7. Click Ok, make sure your new scenario is checked, and then Save and close.

8. Run the publishing process (Transformation Scenario) by clicking the little "play" button in the
toolbar, or select Document > Transformation > Apply Transformation Scenario(s)...

Next time you need to transform to web help, you just need to publish to XML from Paligo as
in step 1, and then select your saved scenario and run the publishing directly.

Planner
The Planner is a built-in project planning tool, much like a Gantt chart for planning your technical
documentation assignments. It is a convenient view for creating assignments and monitoring
them.
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1. Time period selector - choose what period to work with.

2. Filter settings - choose what type, assignee, status, etc to view.

3. Tools to create or delete assignments, and settings.

4. Documents with assignments.

5. Calendar/Gantt view showing the assignments and their status.

6. Workload widgets showing how many assignments different users have at the moment.

7. Settings for the Planner, assignments, and workflow.

TIP
Learn more about how to work with assignments, see Assignments [1208].

Profiling Tab
When using variables and / or filters, you can configure settings to view specific variants of your
content via the Profiling tab. You can reach the Profiling tab from Editor [51], Review View [41] and
Translation View [79]. The filters you set in the Profiling tab will also apply when you preview
content in PDF, HTML5 or HTML from within the editor. This is a very useful way to see how the
profiled content will actually come out.

TIP
In the Options tab under Profile Settings, you can select whether to completely
hide filtered content or to show it as a placeholder only (as in the image below). 
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In Editor [51] you set the profiling by clicking the Profile Settings under the Preview tab. 

Example of variant view of a topic in the Editor with variable value filled in and profiled content filtered
out.

In Review View [41] and Translation View [79] you set the profiling by clicking the cog icon at the
top right corner. 

To the left - Profile settings in Review view. To the right - Profile settings in Translation view.

Resource View
With the Resource view, you can find useful information about the content of a folder, including
details of existing translations, assignments and versions. You can also use the Resource view to
change the status of your content, for example, to set it to "In translation".

To display the Resource view, select a folder in the Content manager. Paligo opens the Resource
view for the selected folder.
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There are two different modes for viewing the resources:

• List View - provides an overview of the resources and also provides access to the Resource
Detail Panel.

• Grid View - provides an overview of the resources, but does not have the Resource Detail Panel.

You can switch between the two modes by using the buttons at the top-right.

Here, we are going to show you the information and options that are available in List View. The
Grid View is more of a summary and does not provide access to the same level of information or
options.

In List View, Paligo lists all of the components in the selected folder. There are columns that show:

• Name - the name of the component, such as the name of a topic.

• Taxonomies - the taxonomy tags that have been applied to the component.

• Status - the status of the component, for example, work in progress or in translation.

• Editor - the name of the person who last edited the component.

• Last Edited - the date and time that the component was most recently edited and saved.

• Languages - the languages that have been set for the component, shown as two letter codes,
for example, en for English, fr for French.

To the far right, there is a dotted menu ( ... ) which contains options for the different actions you
can perform on the component. The options vary depending on your permissions, the type of
component, its status, translations, etc.
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In front of each component, there is a chevron icon.

Select the chevron icon to reveal the Resource Detail Panel:

This panel provides lots of useful information about:

• Existing translations - Shows how much text of the project that has been translated to selected
languages.

• Related resources - Information about:
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• Reused content, that is if the component includes other components and if the component
itself is used elsewhere.

• Languages added shows languages added, and also if a language is missing (i.e if a topic is
missing a language that is set on a publication it is reused in).

• Related images, images included in the component.

• Saved Output - When publishing content you can select to check Save output in Paligo. The
published version is stored in the Saved Output section in the Resource Detail Panel. Select
the link or the Download file button to download the output file in your browser.

• Branches - Shows if there are any existing branches of the component.

• Versions - Release versions saved when a document goes through the release workflow.

• Assignments - If there are any assignments for this particular document, they will be shown
here.

• News feed - Any activity concerning this document will be displayed here.

Source Code Editor
While the Paligo Editor [51] is made to make structured authoring as natural as possible, there
may be times when you need to edit the actual source XML. You can also Search and Replace with
Source Code Editor [639].

WARNING
Please note that while convenient editing XML directly in plain code view, it
requires that you are sure of what you are doing. As long as you have the auto-
validation turned on, Paligo will prevent you from saving invalid XML. However
you still have to be careful not make unintentional changes.

If you are not absolutely sure of what the result will be, you should be especially
careful not to edit attributes such as @xinfo:text and @xml:id, since these are
Paligo id:s.

Use the Source Code Editor
To edit the XML in Paligo, you have to open the Source Code Editor.
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TIP
This can also be done during an assignment in the Contributor Editor, see Edit the
Source Code [1329].

1. Select Edit source code under the Edit tab in the toolbar. 

2. Edit the source XML.

3. Select Update to save the changes or Cancel to ignore the changes.

IMPORTANT
Note that this does not save the topic, it just updates the content just as if
you had made any regular edit directly in the main editor view.

You can still undo any changes back in the main editor. The changes to the
source code will be saved when you save the topic.

4. Close the Source Code Editor with the X in the top right corner.

Copy Elements in the Source Code Editor
If you copy an element in the code editor and paste it in another place, you will by default get the
text content as "Reuse text". The same as if you had used the Reuse text search feature or used
the Copy as reuse keyboard shortcut.

If you do not want the text reused, this is one time where it can be useful to touch the
@xinfo:text attribute. To not have the text reused, simply remove the xinfo:text attributes:
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WARNING
If you do this, it only changes it on the copied element, not the original. Otherwise
you will create a completely new text fragment for the original text as well. If you
for example have translated it before, that translation will be lost.

Set Source Code Editor Theme
By default, the Source Code Editor uses the Monokai theme, a dark theme easy on the eyes. It
has a black background with cerise, green, yellow and white color-coding for the XML elements,
attributes, values and text.

You can set the source code editor to use a different theme. For example, the Chrome theme has
a white background with red, blue, cerise and black color-coding.

But you can use any of a number of themes for the look and feel of the Source Code Editor,
whatever is more comfortable for you. Just click the cog wheel icon in the toolbar, and select Code
Editor.

To the left, the Monokai theme. To the right, the Chrome theme.

To change the theme for the source code editor:

1. Select the Dotted menu ( ... ) for a topic in the Content Manager [34].

2. Select Edit and choose Open in editor.

3. Select Settings in the Toolbar. 
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4. Select the Code editor tab.

5. Select a theme from the dropdown menu in the Theme for the code editor section.

6. Select Save Settings.
The next time you open the source editor in the main editor, it will use the theme you have
chosen.

Statistics and Metrics
To access the statistics and metrics view, select Dashboard in the top menu to display your
dashboard and then select the statistics icon.

The statistics and metrics view gives you valuable information about your progress, how many
topics and images you have, how many are orphaned (not used anywhere, making it easy to clean
up your repository), how much reuse you have, and which topics are the most reused / reusable.
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Topic reuse and image reuse shows the ratio between the number of unique topics / images you
have that are actually used anywhere compared to the number of times these are reused.

Note that while for topic and image reuse, the higher the number the better the reuse. But for text
fragments, even a relatively modest percentage can be an indicator of good reuse due to the large
number of text fragments any database will have.

Structure View
Use the Structure View to add content (topics or subpublications) to your publication, view the
metadata and get a quick preview of your content. The Structure view contains three sections:
Structure, Metadata and Preview.

Display Section View

TIP
You can also reach the Structure View by selecting the publication in the Content
Manager [34].

1. Select the Dotted Menu (...) for the publication in Content Manager [34].
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2. Select Edit and choose Open structure. 

Paligo displays the Structure View , which consists of three sections: Structure, Metadata and
Preview.

3. Close the Structure View with the X in the top right corner.

Structure Section
The Structure is the top section of the Structure View and is mostly used for Publications. This
is where you create the structure of your publications by adding and reusing topics and other
components. Think of building your publication structure as creating a table of contents for your
publication. You drag and drop the topics you want to include and then organize them into a
hierarchy to create the structure you want.
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The Structure section, showing the structure of a publication. The publication has topics nested inside it.

The Structure View has options for Organize a Publication [100] and Remove Content from a
Publication [106] and Create a Topic from the Publication Structure [134].

TIP
You can use a keyboard shortcut to expand the structure to show all lower-level
topics under a topic, no matter how deeply nested:

• Press Shift ⇧  + Option ⌥  and then select the arrow  next to the parent

topic. (Mac)

• Press Shift ⇧  + Alt  and then select the arrow  next to the parent topic.

(Windows)

Metadata Section
The Metadata is the middle section of the Structure View and shows information (metadata)
about the publication, topic, or component, including:

• The author of the component

• The creation date

• The workflow status (Work in Progress, Released, etc.)

• Used in (where the component is used, whether it is reused there or being linked to by a
cross-reference)

• Which publications a component is reused in (Related Publications)

• The location of the component.
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The location widget shows the full path, with a link. You can select the link to open the location.

Preview Section
The Preview is the bottom section of the Structure View and it provides you a convenient way to
view the content of a topic, without having to open it in the editor.
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NOTE
The preview feature is not available for certain components, such as informal
topics. To preview an informal topic, add it to a regular topic as a component and
then preview the regular topic. (Select Insert and choose Component to add the
informal topic.)

Taxonomy Manager
The Taxonomy Manager provides a powerful way to categorize, organize and finding content.
The first step is to create the categories called taxonomies. The second step is to tag your
content (topics, images, publications) with the taxonomies. You can categorize the content with
any number of tags. Once the content is categorized, you can use the taxonomies to find and list
content provided with a certain tag.

The difference with taxonomies is that they are organized in a tree structure in the Content
Manager [34]. This makes it is easier to keep track of the tags because they have a logical
structure. But they also provide more intelligence, since you can tag a component with a high
level tag and find anything tagged with categories below it as well. This means that you easily
find the all content tagged with the same taxonomy in one place instead of searching through all
available content. Learn more, see Taxonomies [1356].

Example 1. Combine taxonomy tags

Consider a topic that is a description of how to repair the engine on an ACME Model X1000
automobile. You could choose to create very different folder names for the location of this topic,
for instance "Model X1000", "Maintenance and Repair", "Engine topics", etc.

• What if the topic is reusable for not only X1000, but also for 3 or 4 other models, like the X2000,
X3000?

• What if you think the most intuitive way is to organize it by subject matter (such as "Maintenance
and Repair"), but your colleagues disagree and would rather organize it by product model or
type of product component?

With taxonomies you don't have to choose. You can tag it with any or all of these as categories.
And the great thing about it is that you can also find it by any of these tags. Either way, the tagging
will all lead to the same topic.

Translation View
Paligo has its own built-in translation environment called the Translation View. You can use it to
edit translations and manage translation assignments.
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TIP
To find out how to use this translation feature, see Working in Translation
View [1752].
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About Structured Authoring

Abstract
Structured authoring is an XML-based approach to technical documentation that simplifies
consistency, content reuse, and team collaboration. Pre-defined rules in a DTD or Schema controls
the content and structure.

Paligo is a structured authoring tool, which uses a topic-based customization of the DocBook 5.1
XML standard. If you are completely new to structured authoring and topic-based authoring, the
following sections are recommended to in order to grasp some basic concepts that will help you
get the most out of Paligo.

What is structured authoring?
Structured authoring is a standardized approach to writing technical documentation where the
content is controlled by pre-defined rules. The technical writer is not concerned with styling or
formatting, but instead marks up the content according to what it semantically represents.

Structured authoring is defined by the following characteristics:

• The structured content is usually based on XML.

• The content and structure are controlled by rules. These rules are enforced in software using
a DTD or Schema. Such rules can specify that a section must contain a title, a procedure
must contain steps, and so on.

• The structured content is tagged/categorized using semantic tags that reflect what kind of
content it represents rather than how it should be styled.

If you write a an instruction, for example, it can be represented by the very appropriate
semantic tag procedure rather than a simple numbered list, and so on.

• In structured authoring, content and layout/formatting are separated. The technical writer is not
concerned with formatting, which is applied separately using stylesheets (XSLT and CSS).

• The structure and semantic tagging enables and simplifies content reuse, increasing both
consistency and efficiency in technical documentation.

• Structured authoring also enables and simplifies the automation of publishing technical content
and applying formatting separately and dynamically.

• The structure is hierarchical/nested in nature. So, for example, a figure element can represent
a unified block of content that can hold a title, an image, and a caption (etc) as child content.

• Structured authoring also simplifies team collaboration, and the consistency it provides is a
prerequisite for robust component content management.
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Structured Content
In Paligo, you will create structured content. This is content that contains structural elements as
well as the text, images, etc., that your readers will see. The structure helps to make sure that the
underlying code of your content is consistent, so that it is easier to control, manage and convert
into different formats. It is also easier for other systems to process.

Structured content is written in XML, but you do not need to understand XML in great detail. Paligo
hides much of the code in the background and provides user-friendly tools that make it easy to
write structured content. However, you will find it easier if you understand the basic principles:

1. You write content in topics and organize them in publications. When you publish, the content
is converted into an output format, such as HTML, HTM5, or PDF.

2. To create content, you need to add elements for the structure and then add your text,
images, etc., inside the elements. You can think of elements as "building blocks" that define the
type of content you are adding.

3. There are rules that govern where each element can be used. You do not need to know the
rules as Paligo will guide you.
Everybody who writes in Paligo uses the same set of elements and so follows the same rules.
So you can have lots of different writers working on your projects and they will all produce
content that has the same underlying structure.

4. Content and styling are separate. Your topics only contain structure and content. The Paligo
content model has semantic elements that describe what the element is for, like a procedure
is intended for procedures/instructions.
By utilizing the semantically tagged content, the styling can then be applied to the content
separately, and this means you can apply different styling to the same content in different
outputs.

5. You can reuse topics, groups of elements, or individual elements.
This can save you a lot of time when creating and updating your documentation. The idea
with content reuse is that you write content once, in one place, and then reuse that content
wherever it is needed. When you need to update your content, you make the change once and
it applies wherever that topic or element is used.

6. You can move entire blocks of content or individual elements, depending on your
requirements.
To find out more, see Move Content [153].

Example 2. Structure of a Simple Topic

The following image shows how a simple piece of structured content appears in the Paligo editor.
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The underlying code (XML) of this content is shown below. You can see that there are elements
that define the structure and each element indicates the type of information. For example, title
is for the heading, procedure is for the procedure, and for each step there is a step element
and para element to contain the text in the step. The section element is a container for the
other elements. Every topic has a section element and the other elements have to be inside the
section.

<section>
<title>Using Elements</title>
<para>This paragraph uses a para element.</para>
<para>This paragraph also uses a para element.</para>
<procedure>
<step><para>This is a step element inside a procedure element.</para></step>
<step><para>This is also a step element inside a procedure element.</para></
step>
</procedure>
</section>

Understanding Content Structures
When you create content in Paligo, it is important that you understand that the content is
structured. There are elements for different types of content, and these are organized into
structures. For example, if you add a note to a topic, it has this structure:

<note>
    <para>Text of note.</para>
</note>

Here, the note is the "parent" structure and the para is the "child" structure, as the para is inside
the note (it comes after the opening <note> and before the closing </note>.

When working with content inside a topic, the parent-child relationship is important. Any time you
move, copy, or delete a parent element, then that action also applies to the "child" elements inside
it. So, using the simple note example again, if you copied the note element, Paligo would create a
copy of the note element and also a copy of the para element inside it.

NOTE
When you copy, move, or delete a "parent" element, the same action applies to its
"children".

If you copy, move, or delete a "child", the same action only applies to the "child"
(and any of its children). The action does not apply to the parent.

This hierarchical "parent-child" structure has some useful advantages for technical writers—it
means you can move, copy, and delete entire structures at once, rather than having to manage
them separately. It is especially useful with more complex structures, such as lists, as it can make
it much easier to change the list order, move content, etc. The following example [84] shows the
parent-child relationships in a procedure.
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TIP
If you are unsure about the hierarchy of elements and how the parent-child
relationships work, create a test topic and experiment with it. We recommend
that you add a mix of regular paragraphs and more complex structures like
lists and tables and then try copying, moving, and deleting the parent and child
elements.

Example 3. Parent and Child Relationships of Elements in a Topic
For example, let's look at a more complex structure, such as a procedure. (This image is taken
from the XML Tree View, which is available in the side panel of the main editor. It shows the
structure of the topic you are working on).

Here, we can see that the top-level element in the topic is the section. Every topic has a section
element at the top, and these are the main "container" in the topic. If you had a topic with
subsections, you could have lower-level sections too (although it is often preferable to insert these
as components rather than as sections).
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Inside the section, we have all of the other elements. These too are arranged in a hierarchy. Title
is a second-level element and it does not have any other elements inside it (so has no "children").
Procedure is also a second-level element. It has a plus icon + to show that it is expandable and has
elements inside it (its "children").

Inside the procedure, there are two steps. The steps are "children" of the procedure.

Inside the first step, there is a para. This is a "child" of the step and a "grandchild" of the
procedure.
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Inside the second step, there is a para and a note. These are "children" of the second step.

The note also has a para inside it. The note is a "parent" to this para, and the para is a child of the
note, a grandchild of the second step, and a great-grandchild of the procedure.

When you work with content inside a topic, it is important that you understand that there are
parent-child relationships between the different elements. Because when you move, copy, or
delete an element, the action applies to its children too.

So if you select the second step and move it above the first, Paligo will:
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• Move the second step above the first step in the procedure

• Move all of the descendants of the second step (children, grandchildren, etc.) as well.

This means you can quickly and easily move, copy, and delete multiple elements or individual
elements with a single action.

Topic-Based Authoring
Paligo is designed for "topic-based authoring", which is a more efficient way of producing and
managing documentation. If you are new to topic-based authoring, this section explains the basic
principles.

About Topics
With topic-based authoring, you create each section of your content in separate "containers"
called topics. So instead of creating your entire document in one place, as you would in a Microsoft
Word file, you create lots of separate topics. As a general rule, you should create a topic for each
section of your content that needs a heading.

For example, the following page has two sections with headings, so to create that content in
Paligo, you could add one topic for section 1 and another topic for subsection 2.
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1 = Section, 2 = Subsection

Writing content in topics has many benefits. They are easier to manage and translate, and you
can reuse them in different publications. This can significantly reduce the cost of updating your
content, as when you change a topic, the changes apply wherever that topic is used.

NOTE
If you have each section and subsection as separate topics, they are easier to
reuse in different contexts. But there are ways to add sections and subsections in
the same topic. To find out more see Headings and Subheadings [163].

TIP
You can easily make a separate topic of a subsection, by selecting the section in
the Element Structure Menu [52] and choosing the option Convert to reusable
component.

About Publications
A Publication represents a collection of topics that you want to publish as an output, such as an
HTML5 help center. Think of them as a table of contents, where you choose what topics to include
and what order to present them in.

The following image shows a publication for a "Mars Travel Manual". You can see that the
publication's structure looks like a table of contents and it has various sections. Each of those
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sections is a separate topic (so there is a topic for "About Space Travel", a topic for "Space Safety",
a topic for "The Mission Control Center" and so on).

A publication called "Mars Travel Manual" which contains many topics, including "About Space Travel",
"Space Safety", and "The Mission Control Center".

You can add a topic to more than one publication. This is one of the main benefits of topic-
based authoring, as it means you can write a topic once, and then use that same topic in many
publications.

A topic can be added to many publications.

You can also publish part of a publication rather than the entire publication. This is useful if you
have sections of a publication that could work as a separate output.

To learn how to create publications and topics, see: Create a Topic [131] and Publications [95].

Elements
When you write in Paligo, you will use elements to create the structure in your topics and add
meaning to selected parts of your content.

Elements are tags that contain your content, and there are many different types of element that
you can use, for example, there is a para element for paragraphs and a procedure element for
process lists. Paligo uses a customization of the DocBook 5.1 XML standard and you can use any
element included in that standard.

The elements that you use to build the structure are "block elements". There are also "inline
elements" which you can use to mark up content inside a block element.
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NOTE
To find out about the elements you can use, see Common General Elements [1891]
and Basic Element Reference [1886].

Block Elements
In a topic, you will add block elements to define the structure, and then you can add your content
inside the elements. Think of the block elements as "building blocks" that represent different types
of information.

The following images show how block elements form the flow and structure of a topic. The first
image shows how the topic looks in the Paligo editor. The second image shows the underlying
code of the topic, and we have color-coded the elements to show you the block structure (for
illustration purposes only).

There is a block element for each different type of content and the elements are arranged in a
hierarchy. For example, the procedure tag contains all of the steps in the procedure list, and for
each step, there is a para element for the paragraph text.

<para> The closing paragraph goes here. </para>

<section>

<title>Title text goes here </title>

<para>The introduction paragraph goes here. </para>

<procedure>

</step>

<step>

</step>

<step>

</procedure>

</section>

</step>

<step>

<para> The text for step 1 goes here.</para>

<para> The text for step 2 goes here.</para>

<para> The text for step 3 goes here.</para>

There are rules about where you can add each element, and this is how Paligo makes sure your
content has a consistent structure. You do not need to know the rules as Paligo will advise you if
you add an element in an invalid position.

TIP
To learn how to add block elements to a topic, see Add Content to Topics [142].
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Inline Elements
Inline elements allow you to add meaning to content that is inside a block element. For example,
if you are writing about software, you might want to use the guilabel inline element on the
names of user interface options in your text. Another common example of an inline element is the
emphasis element, which you can use to italicize one or more words.

</step>

<step>

<para>Click <guilabel>Save</guilabel>.</para>

There are many different inline elements available for use. We recommend that you look at the
full list and identify the ones that are most useful for your content and then agree to use them
consistently. You do not have to use them all.

To view a list of the inline elements, select a position inside a para element. Then use the element
context menu to display a list of all the inline elements that are valid at the selected position.

NOTE
To access the element context menu, press Alt  and Enter  (Windows) or

Option ⌥  and Enter  (Mac).

TIP
For information about the purpose of each element, refer to the DocBook
documentation.

To learn how to add inline elements to a topic, see Add Content to Topics [142].
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Element Attributes
Every element has a set of attributes, which are properties that define the element's
characteristics. For each attribute, there is a value, and by changing the value, you can control
how Paligo uses the element.

Some common examples of how you can use the element attributes are:

• Set the width attribute of an imageobject to control its size in the output, for example, width:
50%

• Set the role attribute of a section to accordion so that the section appears as a collapsible
section in the output

• Set the audience attribute of para to developer so that the paragraph only appears in
content aimed at developers.

You can see an element's attributes by selecting the element and then looking at the Element
attributes panel in the Editor:

The Element attributes panel shows the attribute values that are currently applied to the
element (1).

You can add extra attributes from the Add attribute drop-down menu (2). If you add an attribute,
you need to set its value in the field next to the attribute name in the Element attributes widget
(1). You can also use the fields to change any existing attribute values.

To find out more, see Add Element Attributes [144].

There are many different element attributes available, see Basic Element Reference [1886].
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Authoring in Paligo

When you author in Paligo, you mainly work with two different kinds of content, publications and
topics. Also see Create a Topic [131] and Publications [95].

Authoring Workflow

The typical workflow for authoring in Paligo is:

1. Create a Publication [96] This represents the output you will create and you use it to build
the structure, like a table of contents.

2. Create a Topic [131] Each topic should cover one subject or task.

3. Add Content to Topics [142] Add elements and content to the topics. You use the elements to
build the structure of a topic and then add your content to them.

4. Add Content to a Publication [99] Add the topics to the publication.

5. Assignments [1208] Send for review.

6. Translation Management [1683] Send for translation (if applicable).

7. Style and Customize your Outputs [654] Set up one or more Layouts [1054]. You use the Layout
to define what type of output you want and what settings should be in place. For some
outputs, such as PDF, you apply the styling directly in the Layout Editor [57] options. For HTML
outputs, it's a combination of options to set, as well as the possibility to upload and use
custom CSS to style the content, see Branding your HTML Outputs with CSS [654].

8. Publishing Process [1068] When the content is approved, publish the publication.

Editing topics
To create and change topics in Paligo, you use the built-in XML Editor. When you click a topic in the
Content Manager [34] , it automatically opens the topic in the Editor.
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To learn more about the various parts of the Editor, see Editor [51].

When you create or edit a topic, add elements to create the structure and then add your content
inside the elements. For example, if you want to add a new paragraph, create a new para element
and then add your text to it.

You can add some of the commonly used elements by using the Edit and Insert Toolbar [52]
options. You can also add elements by using the Element Context Menu [54].

You can display the Element Context Menu by using these shortcuts:

Windows: Alt  + Enter

Mac: Command ⌘  + Enter

To learn more about using the Element Context Menu, see: Add Content to Topics [142].

Editing publications
Publications can be opened in the Editor as well, but the default behavior when clicking a
publication is to open it in Structure View [75], since you will mainly work with the structure of
topics in a publication.

Example of a multi-level structure in a publication.
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Authoring Workflow

The typical workflow for authoring in Paligo is:

1. Create a Publication [96] This represents the output you will create and you use it to build
the structure, like a table of contents.

2. Create a Topic [131] Each topic should cover one subject or task.

3. Add Content to Topics [142] Add elements and content to the topics. You use the elements to
build the structure of a topic and then add your content to them.

4. Add Content to a Publication [99] Add the topics to the publication.

5. Assignments [1208] Send for review.

6. Translation Management [1683] Send for translation (if applicable).

7. Style and Customize your Outputs [654] Set up one or more Layouts [1054]. You use the Layout
to define what type of output you want and what settings should be in place. For some
outputs, such as PDF, you apply the styling directly in the Layout Editor [57] options. For HTML
outputs, it's a combination of options to set, as well as the possibility to upload and use
custom CSS to style the content, see Branding your HTML Outputs with CSS [654].

8. Publishing Process [1068] When the content is approved, publish the publication.

Publications
The publication is where you assemble a collection of content and decide the order it appears in
the published output.

You do not write anything in the publication, except from the Publication Topic - "Front
Matter" [109], where you enter the title, copyright and similar information. The actual content
is written as individual sections of information, called Topics [130].

A publication is created for each user guide or help center that you want to publish. But a
publication does not have to represent an entire user guide or help center, it can be a smaller
collection of topics, such as chapters.
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TIP
If you have many related publications that you want to publish in the same
help center called a super publication, see Multiple Publications in the Same
Portal [729].

NOTE
Branching is for creating different versions and it works by creating a copy that
exists alongside the original.

The difference between a branched version and a regular copy is that the
branched version can be merged back into the original, if needed. To find out
more, see Branching [1638].

Create a Publication
To create a new publication that you can use to build the structure ( "table of contents") for a
document:

1. Select the options menu ( ... ) for the folder that is going to contain the publication.
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2. Select Create content.
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3. In the Document Title field, enter the title for your publication.

NOTE
The characters you can use for titles are: numbers, language characters,
punctuation characters, and spaces. The punctuation characters are:

! " # $ % / &amp; ' ( ) * + , - . : ; &lt; = &gt; ? @ [ \ ] ^ _ ` { | } ~

4. In the Document Type section, select Publication.

5. (Optional) Choose any additional languages that you want to translate to later, and then select
OK.
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Paligo creates the publication and adds it in the Content Manager. It is shown with a briefcase
symbol.

When you have a publication, you can open it in structure view and from there, you can add
content to it [99] and organize the topics [100].

When your publication is ready for release, you can publish it [1068].

Add Content to a Publication
Use a publication in Paligo to create the "table of contents" that you want to publish. Open the
publication's structure view and drag and drop content to it. Every topic or publication that you
want to appear in the published output must be included in the publication. But it is also possible
to Exclude Content from a Publication's TOC [102].

To add content to a publication:

1. Select the publication in the Content Manager [34]. 

Paligo displays the publication's structure.

2. Now you can:

• Drag and drop topics from the Content Manager [34] into the publication structure.
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• Drag and drop other publications from the Content Manager [34] into the publication
structure. When a subpublication is added to a super publication [729], the entire
subpublication including its topics is added.

• Create new topics that are added to the publication structure automatically by selecting
the New Topic button at the bottom of the structure view and enter the topic's name.

3. Use the arrow buttons to arrange your topics and reused publications into the order you
want. You can set them to display as a flat structure or you can "nest" topics and publications
so they have a more complex structure, with multiple levels of content. To learn more, see
Organize a Publication [100].

4. Select Save to confirm the publication changes. 

NOTE
Paligo does not create new topics in a publication structure until you select Save.

Organize a Publication
When you have a publication and you have added topics or other components to it [99], you can
organize them into a logical order. When you publish, the structure of the publication is what the
reader will see as the table of contents or navigation menu. You can create a hierarchy of content
so that there are sections and subsections. Use Chunking to Control Subsections [167] to control
how many levels of the content are shown in the table of contents.

To organize the content in a publication:

1. Select the publication in the Content Manager [34]. 

Paligo displays the publication's structure.

2. Select the topic or subpublication to be reorganized.

Press and hold Shift  to select and move several topics or subpublications at the same time.

3. Use the arrows to move content up or down in the structure and also to different levels in the
structure hierarchy.
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TIP
You can also:

• Drag and drop the content in the structure.

• Use keyboard shortcuts to move content in the structure hierarchy.

• Move left use Shift  and Tab

• Move right use Tab

• Move up use Alt  + ↑  (Windows) and Option ⌥  + ↑  (Mac)

• Move down use Alt  + ↓  (Windows) and Option ⌥  + ↓  (Mac)

4. Select Save to confirm the publication changes. 

Example on How to Reorganize a Publication
Let's say you have a publication and you add a "Pair with another device" topic and a "Turn
Bluetooth on/off" topic. When you add the topics to the publication structure, they appear at the
bottom of the structure. You want to move them so that they are subsections of a "Connecting via
Bluetooth" topic.

To move them, you press and hold the Shift  key and then select both topics in the structure.

Next, you use the up arrow icon on the "Pair with another device" topic to move both topics up

until they are directly below the "Connecting via Bluetooth" topic.
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With the topics still selected, select the right arrow icon (or press Tab ) to move the topics so that

they are sub-sections of the "Connecting via Bluetooth" topic.

With the topics now arranged in the structure you want, select Save to store the changes.

Exclude Content from a Publication's TOC
On some projects, you may want to include topics in a publication, but stop them from appearing
in the table of contents (TOC). For example, if you have a high number of topics, that could result
in a large TOC that becomes a little overwhelming for people who are using your help center. So
you might want to prevent some topics from being in the TOC, but still have them in the help
center so that people can search for them.

To hide topics so that they are not in the publication's TOC, but are still searchable in the help:

1. Edit the topic that you want to exclude from the TOC.

2. In the Element Structure Menu, select the top section element and then select Go to
element.
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3. In the Element attributes, add the role attribute.

4. Set the value of the role attribute to: notintoc

5. Use the arrow buttons to arrange your topics and reused publications into the order you
want. You can set them to display as a flat structure or you can "nest" topics and publications
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so they have a more complex structure, with multiple levels of content. To learn more, see
Organize a Publication [100].

When you publish the content, topics with role = notintoc are included in the publication, but will
not appear in the table of contents.

Revert a Publication to a Different Revision
Each time you save changes to a publication's structure, Paligo stores a record of the publication
at that point in time. These records are the "revisions" and you can revert back to any available
revision. For example, let's say you make changes to the structure of a publication on July 1st, but
you then change your mind and want to revert back to how it used to be. By using the Revisions
feature, you can change the publication's structure back to how it was on an earlier date.

When you use the Revisions feature, it is only the structure of the publication that changes. Paligo
does not revert the content in the publication's topics.

NOTE
It is possible that you could revert back to a revision of a publication that links
to topics that no longer exist, as they have been deleted. In this scenario, Paligo
will recreate those topics, and try to add as much of the metadata as possible,
including the ID. If the metadata ID is added to the topic, you may be able to use
Revert a Topic to a Previous Revision [1674] to restore the topic's content. If not,
you will need to add the content manually.

To revert back to an earlier publication revision:

1. Select the publication in the Content Manager [34]. 

Paligo displays the publication's structure.

2. Select the Revisions button at the bottom of the Structure view. 
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3. Select the link in the date column to preview the publication structure for a certain revision in
the Preview panel.

4. Select Revert to restore a revision.
Paligo will restore the publication revision that you selected.

TIP
Two useful features in the Revisions view:

To delete a revision from the Revisions view, select Remove revision at the
bottom of the Preview panel.

To manually save the latest structure update, select Create a revision at the
bottom of the Revisions view.

Copy a Publication
You can copy an existing publication and then use the copy as a starting point for a new
publication. The copy will contain the same links to topics ("forks") as the original publication,
and you can add and remove them without affecting the original. But be aware that if you make
changes inside the topics, those changes will affect the original publication and the copy.

If you are new to copying publications, we recommend that you start by reading What Happens
When You Copy a Publication? [105]. This section explains what happens when you make a copy of
a publication so that you know what to expect.

You can then make your own copies by following the instructions inCopy a Publication and its
Structure [106].

TIP
To make different versions of a publication, you may prefer to use the branching
feature. Branching is designed for creating multiple versions and allows you to
make a copy that can later be merged back into the original. To find out more, see
Branching [1638].

What Happens When You Copy a Publication?
When you copy a publication, Paligo creates a duplicate of the publication. It gives the copy a
unique name, based on the original name, and a unique ID. But it does not make copies of the
topics that are included in the publication. Your publication copy contains links, called forks, to the
same topics as the original publication.

For example, let's say you have an "Acme 100X User Guide" publication and it has links to
the topics "Introduction", "Quick Start", "Connections", and "Troubleshooting". These links in the
publication are called "forks".

Paligo Documentation

105



A publication contains links to topics. It does not contain the actual topics. The links in a publication are
called forks.

When you copy the publication:

• Paligo makes a copy of the publication and its structure. The publication has a new, unique ID.
Paligo does not copy the topics.

• The publication copy contains forks to the same topics as the original publication.

• If you make changes to the topics, your changes will affect both the original publication and the
copy, as they both have forks to the same topics.

• You can delete forks from either publication without affecting the other publication.

• You can add forks to different topics without affecting the other publication.

• You can change the order of topics in a publication without affecting the order in the other
publication.

To have a copy of a publication with forks to copies of the topics, you would need to copy the
topics and then add them to the copy of the publication. That way, the copy will have different
forks to the original.

Copy a Publication and its Structure
To copy a publication:

1. In the Content Manager, select the dotted menu ( ... ) for the publication that you want to
copy.

2. Select Copy.
Paligo creates a copy of the publication. To rename the copy, select its dotted menu ( ...),
select Rename, and then enter the new name.
You can then edit the publication copy to meet your requirements. For more information, see:

• Add Content to a Publication [99]

• Organize a Publication [100]

• Remove Content from a Publication [106].

Remove Content from a Publication
To remove a topic, reused publication or other component from a publication's structure:

1. Select the publication in the Content Manager [34]. 
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Paligo displays the publication's structure.

2. Position the cursor over the component that you want to remove from the publication.
Paligo highlights the component and displays icons to the right of the component's name.

3. Either:

• Press Backspace to remove the component

• Select the X to the right of the component to remove it

4. Select Save to confirm the publication changes. 

NOTE
When you remove a component from the publication structure, you only remove
it from the publication.

The component still exists in Paligo and you can find it by searching or navigating
the content in the Content Manager [34].

If the content has taxonomy labels, you can also use the About Taxonomy
Manager [1363] to find it.

Forks
A fork is a special type of link between a publication and a topic or subpublication. Paligo uses the
forks when content is added to a publication.
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The fork is just a reference from the publication to its content, which is stored elsewhere. This
means that when you change the order of the topics in a publication, arrange them at different
levels or remove content, you are just reorganizing a list of references and the order the content
appear in the published output.

In many ways, it is similar to how cross-references work. When a cross-reference is added from
one topic to another, you are adding a link between the topics. Paligo knows that the link leads
from the current topic to another specific topic. It is a similar concept when you add content to a
publication.

TIP
To learn how to add topics to a publication, see Add Content to a Publication [99].

Topic or Fork
The cross reference dialog shows the targets both as part of the publication (fork) and outside
the publication tree (topic or subpublication). When you insert a cross-reference in topics, you
can link to either a topic or a fork. It is important that you understand the difference, as it will
produce different results.

• Topic 
If the target topic for the link only appears once in the publication, then you can link to the
topic. This creates a link that uses the xml:id of the topic. To add a topic reference, select the
topic with the black icon. Paligo recommends this approach because the links will work when
content is reused in other publications and also for topic branches.

• Fork 
If the target topic appears multiple times in the same publication, you should link to the fork
instead. By linking to the "fork" you link to the position of the topic in the publication structure
by using the fork:id. To add a "fork" reference, expand the publication and select the "fork"
with the grey icon. It is important to know that fork links only work within the publication they
originate from.
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Paligo adds a cross-reference to the title of the selected topic or fork.

TIP
For more details, see Add Cross-References to Other Topics [248] and Manually
Create a Fork Link [266].

Publication Topic - "Front Matter"
Every publication in Paligo automatically gets its own "front matter" called Publication Topic. This
topic is used for the front cover, publication date, version number and author details. You can add
and delete elements according to own needs.

• For PDF publications, the "front matter" provides some or all of the content that is on the front
cover and any pages that come before the table of contents. Learn more, see Design Covers for
PDFs [848] .

A publication could have a background image, title, and logo to create a front cover for a PDF.

• For HTML outputs, the "front matter" is content that appears on a web page. You can access
the page by selecting the link to the publication in the breadcrumb at the top of the topic. Learn
more, see Themes for HTML5 Help Centers [698] .
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The HTML output front matter

TIP
Learn more about styling the publication, see Style and Customize your
Outputs [654].

NOTE
For reused publications, there are settings in the HTML layout that you can use to
control the publication topics.

Define the "Front Matter"
As a Paligo author, you can edit the publication topic to control what information that appears in
the "front matter". To display or edit a publication topic, see Display a Publication Topic [120] and
Edit a Publication Topic [121].

A publication topic has article as the top-level element instead of section. Inside the article
element is an info element. The "front matter" elements need to go inside the info element. We
use the term "info elements" to describe these elements collectively.
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By default, Paligo includes the title, subtitle, mediaobject, volumenum, pubdate,
copyright, legalnotice, and abstract elements inside the info element.

You can enter values for these elements, add other info elements, and remove any info elements
you do not want to use.

NOTE
The mediaobject is set to have a role attribute with the value set to titleimage.
This role and value is needed to make the image a cover image.

When you have set up your publication topics, you can use the layouts and CSS to control how
Paligo processes them and styles them in the output.

• For PDF output use the settings in the PDF layout, see Style the Info Elements [881].

• For HTML5 output use the settings in the HTML5 layout and CSS. To learn how to view the
styles in the HTML, make changes and upload CSS, see Branding your HTML Outputs with
CSS [654].

Supported Info Elements in Publication Topics
A publication topic has article as the top-level element instead of section. Inside the article
element is an info element. The "front matter" elements need to go inside the info element. We
use the term "info elements" to describe these elements collectively.

By default, Paligo includes the title, subtitle, mediaobject, volumenum, pubdate,
copyright, legalnotice, and abstract elements inside the info element.

You can see this structure in the XML tree panel:

There are also other elements that you can add, depending on your requirements. To learn how
to access the various elements that are available, see Edit a Publication Topic [121]. You can also
remove any unwanted info elements [124] as long as they are optional elements.
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NOTE
By default, Paligo presents the info elements in a fixed order. This may not match
the order of the elements in your publication topic. But you can set the published
version to match the order shown in the editor. To find out more, see Order of
Info Elements [118]

TIP
To find out more about each of the elements, refer to the DocBook standard,
where you can find descriptions and information about the structure.

Title
The name of the publication. This is a required element that is included by default and supported
in PDF and HTML outputs.

Example 4. Title structure

In publication topics, the top-level element is article rather than section (regular topics have
section as the top-level element). Then it has the info element, and inside this, the title
element.

The following example shows the structure when title is the only info element being used.

<article>
    <info>
        <title>Acme 100X user guide</title>
    </info>
</article>

Typically, you would set up a publication topic to include many other info elements, including
copyright, publish date, and edition. These would all be at the same level as title inside
the info element.

Subtitle
A secondary heading for the publication, often used for describing the purpose of the document
or for a strapline. For example, the document title could be "Acme Series 100X" and the subtitle
could be "Developer Guide". This is an optional element that is included by default and supported
in PDF and HTML outputs.

Example 5. Subtitle structure

To use the subtitle element, add it inside an info element in a publication topic. Typically, it
is used immediately after a title element (so both the title and subtitle are inside info). If
other info elements are also included, those are also added inside the info element.

<info>
    <title>Acme 100X user guide</title>
    <subtitle>Operation and maintenance</subtitle>
</info>
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Mediaobject
Use to add a foreground image. It is intended for use as a product image, but it can be any image.
This is an optional element that is included by default and supported in PDF and HTML outputs.

To find out more about adding images for the front pages, see Cover Foreground Images [900] and
Cover Background [906] .

NOTE
If you have a foreground image in the publication topic, it takes priority over any
product image that is set in a layout.

Volumenum
This is designed to identify the volume number of the publication in a set of publications. It is a
"container" element for other bibliographical elements (which you can add manually). This is an
optional element that is included by default and supported in PDF output.

TIP
For adding information about the name or number of a publication, we
recommend that you add the edition element and use that instead of the
volumenum.

Pubdate
Use to add the date of publication to a document. You can enter the date manually, use a variable,
or set Paligo to insert the date automatically. This is an optional element that is included by default
and supported in PDF and HTML outputs.

Example 6. Publication date structure

The following example shows the date entered as text inside the pubdate element. The pubdate
element has to be inside the info element in the publication topic. Typically, there will also be
other elements inside the info element too, such as title and subtitle.

<info>
    <title>acme 100X user guide</title>
    <subtitle>Operation and maintenance</subtitle>
    <pubdate>May 17 2022</pubdate>
</info>

Here, the text is typed in manually, but you could use a variable for the date if you prefer.

You can also set Paligo to add the date of publication automatically. For this, make sure that the
pubdate element is in the publication topic and also that it is empty (has no text or variable value).

<info>
    <title>acme 100X user guide</title>
    <subtitle>Operation and maintenance</subtitle>
    <pubdate></pubdate>
</info>
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Paligo will add the publication date automatically as long as you add a date value to:

• General > Today's date for publication date in your HTML layout

• Front page > Info elements > Today's date for publication date in your PDF layout.

If the pubdate element contains a value, that value is shown and the layout settings are ignored.
If there is no date in the pubdate or the layout settings, the publication date is excluded from the
output.

Copyright
Use to add copyright details to the publication. This is an optional element that is included by
default and supported in PDF and HTML outputs.

Example 7. Copyright structure
The following code shows the correct structure for a copyright entry. Note that the copyright
element has to be inside an info element, along with other info elements such as title. The
year and holder are inside the copyright element.

<info> 
    <title>Acme 100X user guide</title>
    <copyright>
      <year>2022</year>
      <holder>Acme Enterprises</holder>
    </copyright>
</info>

In the output, the copyright part appears as:

Legalnotice
Use to add legal information such as disclaimers and statements regarding liability. This is an
optional element that is included by default and supported in PDF and HTML outputs.

Example 8. Legal notice structure
The following example shows the correct structure for a legal notice. When you add the
legalnotice element, it has to be inside an info element, along with any other info elements
such as title. Also, you need to add another element inside it to contain the text, such as a para
element.

<info>
    <title>Acme 100X user guide</title>
    <legalnotice>
        <para>All pertinent state, regional, and local safety regulations \
must be observed when installing and using this product. For reasons of \
safety and to help ensure compliance with documented system data, only the \
manufacturer shall perform repairs to components. Failure to observe this \
information can result in injury or equipment damage.</para>
        <para>All rights reserved. No part of this publication may be \
reproduced, distributed, or transmitted in any form or by any means, \
including photocopying, recording, or other electronic or mechanical \
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methods, without the prior written permission of the publisher. For \
permission requests, write to the publisher, addressed “Attention: \
Permissions Coordinator,” at the address below.</para>
    </legalnotice>
</info>

Abstract
Use to add a summary of a publication and or topic. The abstract is also used as the meta
description for the publication in HTML outputs. This is important for Search Engine Optimization
(SEO) if you are making your HTML content available to Internet search engines.

This is an optional element that is included by default and supported in PDF and HTML outputs.
You can also add it to individual topics (inside an info element) to provide meta descriptions for
each topic.

Example 9. Abstract structure

To use an abstract element in a publication topic, add it inside the info element (alongside
other info elements, such as title). Then add an element inside the abstract element to
contain the text, for example, a para element.

<info>
    <title>Acme HomeHub User Guide</title>
    <abstract>
        <para>Learn how to use the Acme SmartHome hub to manage your \
household devices from your phone.</para>
    </abstract>
</info>

Address
Use to add the address of an organization. This is a verbatim element, so any formatting you
apply, such as line breaks, is kept in the output. You can enter the entire address directly in the
address element or you can add its "child" elements, such as street and city to create a more
structured address.

This is an optional element that is supported in PDF output.

Example 10. Address structure

To use the address element and its child elements for each part of the address, add them in a
structure inside the info element. The address element is at the same level as other info elements,
such as title.

The following code shows an example:

<info> 
    <address>
        <street>1A Main Street Business Estate</street>
        <city>Randomtown</city>
        <state>NY</state>
        <postcode>12345</postcode>
        <country>USA</country>
    </address>
</info>

The benefit of this approach is that, if needed, you can reference each part of the address in other
topics.
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If you enter the address as regular text, the structure is much simpler:

<info>
    <title>Acme 100X user guide</title>
    <address>
        1A Main Street Business Estate
        Randomtown
        NY
        12345
        USA
    </address>
</info>

With this simpler approach, you can only reference the entire address in other topics.

NOTE
The address element is a verbatim element and so preserves any formatting and
line breaks. But if it is referenced by a dynamic variable, the dynamic variable will
insert the address content as plain text with no formatting.

Authorgroup
Use as a container for author elements when you want to list more than one author. You can
then add multiple author elements inside the authorgroup. This is an optional element that is
supported in PDF and HTML outputs.

Example 11. Authorgroup, author, and orgname structure

The following code shows an example of the structure needed if you are using authorgroup to
contain details of multiple authors. The authorgroup element has to be inside the info element,
at the same level as other info elements such as title. The author elements are then nested
inside the authorgroup element.

<info>
<title>Acme 100X user guide</title>
<authorgroup>
    <author>
        <personname>Richard Greenwood</personname>
    </author>
    <author>
        <personname>Leanne Matthews</personname>
    </author>
</authorgroup>
</info>

If there is only one author, there is no need to use authorgroup:

<info>
    <title>Acme 100X user guide</title>
    <author>
        <personname>Richard Greenwood</personname>
    </author>
</info>
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To name an organization as the author rather than an individual, use the orgname element:

<info>
    <title>Acme 100X user guide</title>
    <author>
        <orgname>Acme Enterprises</orgname>
    </author>
</info>

Author
Use to add the name of the author to a document. You can enter the name manually or use a
variable. This is an optional element that is supported in PDF and HTML outputs.

For examples of the structure for author elements, see Authorgroup [116].

Edition
Use to add information about the version of the document. We recommend that you use edition
instead of volumenum for this type of information. This is an optional element that is supported in
PDF output.

Example 12. Edition structure

Use the edition element inside the info element, along with any other info elements such as
title. The structure should look like this and you can enter the edition information directly into
the edition element.

<info>
    <title>Acme 100X user guide</title>
    <edition>Acme 100x/PBD-10003</edition>
</info>

By default, when you publish to PDF, the edition is shown with the word "Edition" after it. The
"Edition" is an auto-label and you can remove it by changing the auto-label setting in the PDF
layout (see Set Auto-Labels for Info Elements [884]).

Othercredit
Use to credit a person other than the author or editor. This is an optional element that is
supported in HTML output.

Example 13. Other credit structure

To use the othercredit element, add it inside the info element alongside other top-level info
elements such as title. Inside the othercredit element, add a child element to contain the
credit information, for example, you could add personname (other child elements are available).

The structure should look like this:

<info>
    <title>Acme 100X user guide</title>
    <othercredit>
        <personname>Sara Card</personname>
    </othercredit>
</info>
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Releaseinfo
Use to provide a brief description of a publication release. For example, the release information
may explain that the document is for a particular version of a product. This is an optional element
that is supported in PDF and HTML outputs.

Example 14. Release info structure

To use the releaseinfo element in a publication topic, add it inside the info element alongside
any other info elements such as title. You can then add the release details directly inside the
releaseinfo element.

<info>
    <title>Acme 100X user guide</title>
    <releaseinfo>Documentation update to include added humidity controls.</
releaseinfo>
</info>

Revhistory
Use to add a table that contains a row for each revision to the document. You can add revisions to
the list manually, and include information about the changes you have made. This is an optional
element that is supported in PDF and HTML outputs.

Although revhistory is an "info" element, you should not use it in the publication topic. Instead,
you should create a regular topic for the revision history and add an info element to it, and then
add the revhistory and revision elements inside that. For details see Create Revision History
Topics [138].

Order of Info Elements
By default, Paligo uses a fixed order for the elements in publication topics. When you publish,
Paligo will present the elements in this order:

1. title

2. subtitle

3. mediaobject

4. authorgroup

5. author - This is added as a child of the authorgroup element.

6. volumenum

7. pubdate

8. edition

9. abstract

10. copyright

11. legalnotice

12. address

13. releaseinfo

Any other info elements that you add will appear in the same order that they are shown in the
publication topic. Child elements are shown in order after their parent, for example, personname
will appear as a child of the author element, so will appear before volumenum.
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To change the order for an HTML output, create a custom JavaScript that will move the elements.
Then upload the JavaScript file to your HTML layout and publish again (see Add a Custom
JavaScript to a Layout [768]).

For PDF outputs, you can set Paligo to use a free order instead of fixed (see Set the Order of
Info Elements [882]). With a free order, the info elements are shown in the same order that they
appear in the publication topic .

Example Publication Topic Structure
To help you understand the correct structure for the info elements, we have included a sample
publication topic. The example shows the underlying XML so that you can see how the various
info elements, such as copyright and pubdate, are structured and positioned inside the info
element.

To learn how to add and remove info elements in your own publication topics, see Edit a
Publication Topic [121].

Example 15. Publication topic example
Here is an example of an entire publication topic. Note that we have removed the XML IDs so that
the structure is clearer to view. When you create your own publication topic, you will have XML IDs
included as well as other XML data.

<?xml version="1.0"?>
<article>
    <info>
        <title>Acme HomeHub User Guide</title>
        <subtitle>The smarter way to manage your home</subtitle>
        <mediaobject role="titleimage">
            <imageobject>
                <imagedata fileref="UUID-4352d337-29fd-6ee2-e88c-
e04bed3ce898" xinfo:image="UUID-4352d337-29fd-6ee2-e88c-e04bed3ce898"/>
            </imageobject>
        </mediaobject>
        <volumenum>ACME-SH-123456-A1</volumenum>
        <edition>ACME 100X PBD-10003</edition>
        <pubdate>May 17 2022</pubdate>
        <copyright>
            <year>2022</year>
            <holder>Acme Enterprises</holder>
        </copyright>
        <legalnotice>
            <para>All pertinent state, regional, and local safety \
regulations must be observed when installing and using this product. For \
reasons of safety and to help ensure compliance with documented system \
data, only the manufacturer shall perform repairs to components. Failure \
to observe this information can result in injury or equipment damage.</para>
            <para>All rights reserved. No part of this publication may be \
reproduced, distributed, or transmitted in any form or by any means, \
including photocopying, recording, or other electronic or mechanical \
methods, without the prior written permission of the publisher. For \
permission requests, write to the publisher, addressed “Attention: \
Permissions Coordinator,” at the address below.</para>
        </legalnotice>
        <address>Acme Enterprises
            <street>1A Main Street</street>
            <city>Generic City</city>
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            <postcode>123 456</postcode>
            <country>USA</country>
        </address>
        <authorgroup>
            <author>
                <personname>Richard Greenwood</personname>
            </author>
            <author>
                <personname>Leanne Matthews</personname>
            </author>
                 <orgname>Acme Enterprises</orgname>
            <author>
            </author>
        </authorgroup>
        <releaseinfo>v16.1 release includes documentation for humidity \
monitoring and controls, extended range of supported lighting systems, and \
how to order replacement parts.</releaseinfo>
        <abstract>
          <para>Learn how to use the Acme SmartHome hub to manage your \
household devices from your phone.</para>
        </abstract> 
</info>
</article>

Display a Publication Topic
By default, the publication contains an article element, an info element, and then inside that,
several other elements, including subtitle, copyright, and publication date. We use the
term "info elements" to refer to these lower-level elements collectively, as these type of elements
must all be inside the info element. Learn about the info elements, see Supported Info Elements
in Publication Topics [111].

You can make changes to the publication topic so that it meets your requirements, see Edit a
Publication Topic [121] and Images in a Publication Topic [125].

To display the publication topic for one of your publications:

1. Select the Dotted Menu (...) for the publication in Content Manager [34].

2. Select Edit and choose Open in editor.
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Paligo opens the publication topic.

Edit a Publication Topic
When you create a publication, Paligo adds some commonly used "info elements" to the
publication topic, such as copyright and pubdate. There are other elements that you can add
too, including authorgroup, author and edition.

TIP
To help you understand the correct structure for a publication topic, we have
included a sample (see Example Publication Topic Structure [119]). The sample
shows the XML for a valid publication topic and includes many of the available
info elements.

To edit a publication topic:

1. Establish which elements you want to include or exclude, see Supported Info Elements in
Publication Topics [111].

2. Select the Dotted Menu (...) for the publication in Content Manager [34].

3. Select Edit and choose Open in editor.

Paligo opens the publication topic.

4. Remove elements not needed.

5. Position the cursor where the new element is to be inserted inside the info element.

6. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].
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7. Scroll down the menu and add needed elements.
The menu provides access to all of the valid elements for the selected position. While the
elements are valid, Paligo does not make use of them all and some may be excluded from the
output. You should only use the elements that are supported (see Supported Info Elements in
Publication Topics [111]).

NOTE
For some elements, you will need to apply a certain structure, for example, if
you want to credit multiple authors, you will need to use authorgroup and
author elements. Other elements, such as copyright, have additional child
elements, such as year and holder. See the examples for details.

8. When you add an element, it is empty by default. You need to define the value that is going to
be shown in the output. This could be:

• Regular text - This is known as "hard coding" as the text is added to the topic and to change
it, you would need to edit the topic.

• Variable - These are containers for text that is defined elsewhere (in a variable set). The
benefit of this approach is that you can use a variable set to modify or change multiple
publications from one place. There is no need to edit each publication separately. To find
out more, see Variables [1186].

• Dynamic variable - These are special types of variable that take their value from either
the client session or from other elements in your content. For example, you could set the
copyright year to always use the year that the publication was published. To find out more,
see Dynamic Text Variables [1203].

• An image file (for mediaobject structure).

NOTE
For the pubdate element, you can set Paligo to insert the date automatically.
For details, see Set the Publication Date and Time Format [885].

9. Select Save. 
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10. If you are publishing to PDF, check that the element(s) are set to be included in the output
when published.

TIP
Alternatively, you can create a new PDF layout and edit that.

a. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

b. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab
in your browser. This can be useful if you need to frequently switch
between your Paligo content and the layout settings.

c. Select Front Page and choose Info Elements.

d. Make sure that the appropriate Render XXX element on this side of the front cover
setting has a value of recto (front page) or verso (reverse side).

NOTE
Some elements are set to none by default, meaning that they will not be
included in the output unless you change them to recto or verso.

e. Select Save.
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TIP
When you publish your publication, it will include the info elements. To learn how
to style the info elements, such as setting font colors and positioning content on
the front cover or on the reverse side, see:

• Style the Info Elements [881]

• Branding your HTML Outputs with CSS [654] - For HTML outputs, create a
custom CSS file with styles to define the look and feel that you want, then
upload it to the HTML layout and publish it again.

Remove Info Elements
Most of the elements in a publication topic are optional, so you can add [121] and remove
elements to design a publication topic to meet your requirements. For any elements that you do
not want to use, select the element in the main flow of the text, and then select it in the element
structure menu. From the menu that appears, select Delete.
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NOTE
If you remove an element that is required, Paligo will warn you about this when
you save the topic. You will see the message in a pop-up dialog and also in the
Validation panel. You will only get the invalid content message if validation is
enabled in your editor (see Validation [623]).

Images in a Publication Topic
By default, the publication topic contains the structure for a single image. The image will
automatically be used as the the Product Image on the front page, as its mediaobject has a
role attribute with titleimage as the value. Only the structure for the image is in place, so you
will see a red question mark.

The image structure consists of:

<mediaobject role=“titleimage”>
    <imageobject>
        <imagedata/>
    </imageobject>
</mediaobject>
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NOTE
Only one image in the publication topic should be set to role: titleimage. If
multiple images have this role, they will appear stacked on top of each other in
the same position in PDF output.

To set the role, select the image's mediaoject element in Element
Structure Menu [52] and then use the Element Attributes Panel [55] to add the
role attribute and the value.

TIP
You can turn a foreground image into a background image for the cover by giving it
a role attribute with the value bg-image, see Methods for Adding a Background
Image to a Cover [907].

To insert an image into the existing structure:

1. Select the Dotted Menu (...) for the publication in Content Manager [34].

2. Select Edit and choose Open in editor.

Paligo opens the publication topic.

3. Right-click the Question mark in the image holder and then select Image Browser.
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1 = Upload new image, 2 = Search in the media library

4. Upload a new image (1) OR choose an image from the media library (2) .

5. Select Save. 

TIP
You can also insert additional images [310] in the publication topic, either by
using the Insert > Image option or by dragging and dropping an image from your
desktop onto the topic.

When you add new images, they use the regular mediaobject > imageobject
> imagedata structure and do not have a role set. They will appear after the
product image, in the order they appear in your topic. They are not affected by
the product image styles in the layout or any CSS.

If you have deleted the default mediaobject structure, you can make another
image the product image by giving its mediaobject element the role attribute
and setting the value to titleimage.

When you have added an image and set it as the product image, you can control
its styling in the output by using the layout settings (PDF) or CSS (HTML). For
details, see:

• Style a Product Image for a Front Cover [903]

• Branding your HTML Outputs with CSS [654].

Paligo Documentation

127



Publication Topics for Subpublications
Every publication in Paligo has a Publication Topic - "Front Matter" [109] that acts as a container
for the front page. It is usually set up to include an image for the front cover, details about the
author, copyright information and similar content, see Supported Info Elements in Publication
Topics [111]. This also applies to subpublications, which are publications reused as sections inside
a super publication.

In the image shown below, there is the main publication named "ACME Smart Home" and it
contains a mixture of topics and subpublications. Each publication and subpublication has its own
"publication topic".

• For PDF outputs, Paligo only includes a publication topic for the top-level publication (the
main publication). It excludes the publication topics for any subpublications so that the "front
matter" only exists at the start of the PDF file.

• For HTML outputs, you can choose whether the output includes publication topics for both the
top-level publication and the subpublications OR only for the top-level publication.

NOTE
A reused publication (subpublication) gets a different symbol in the publication
structure. 

Choose Publication Topic Behavior
For HTML outputs, you can choose whether the output include publication topics for both the
top-level publication (main publication) and the subpublications OR only include a publication topic
for the top-level publication.

Before you can adjust the layout settings, you have to Create a Layout [1059].

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.
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2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select General.

4. Use Create a title topic for reused publications to control whether publication topics are
included for subpublications for HTML5.

• Choose Enable to include a publication topic for both the main publication and each sub-
publication

• Choose Disable to only include a publication topic for the main publication. The publication
topics for subpublications will be excluded.

NOTE
For HTML this setting is called Create a topic for reused publications.

5. Use Only create topic for reused publications if no top-level topic to include or exclude
the publication topics.

• Choose Enable to use the top-level topic as a publication topic for the subpublications.
If enabled, you must remember to link to a topic in the subpublication, not to the subpublication
itself.

• Choose Disable to use the regular publication topic for the subpublications.
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NOTE
Paligo ignores this setting if your content does not match the criteria for the
scenario. This setting requires that you have:

• Enabled Create a title topic for reused publications.

• Reused a publication that contains one top-level topic and the rest are
nested low-level topics.

Example shows "Acme Smart Home" publication has a subpublication. The
subpublication has a single top-level topic called "Lighting". The other topics
in the subpublication are nested at a lower level.

6. Select Save.

Topics
A topic is a container for your content and building blocks for your output. You create content
inside a topic by adding elements for paragraphs, images, procedures, bullet lists, tables and
more.

Instead of writing all sections in one large file, you write each section in a separate topic. For best
practice, each topic should focus on one subject or task.

To create the output, you assemble a collection of topics in Publications [95]. The publication
represents the entire user guide or help center. Its structure is the order the content will appear in
the published output

The topics are your building blocks that you can choose to include or exclude from as many
different publications as you like. This is why topics are so important for Content Reuse [1098]. They
allow you to use the same piece of information in many different publications, without having to
create copies of it. There is one "single source of truth".

Paligo Documentation

130



To the left a topic called "The mission control center". To the right the same topic included in a
publication.

Create a Topic
We recommend that you create a new topic for each section of content that needs a heading
(either a top-level heading or a subheading). By having your content in separate topics, it becomes
more versatile. For example, you could have a topic as a subsection in one publication but as a
top-level topic in another publication.

When you create a topic, you can either:

• Create a Topic in Content Manager [131]. It will not be associated with any publications.

• Create a Topic from the Publication Structure [134] that will automatically to associated with a
publication. It can still be used in other publications as well, if needed.

NOTE
For an introduction to topics and publications, see Topic-Based Authoring [87].

Create a Topic in Content Manager
There are two ways to create a topic from the Content Manager [34]:

1. Either:

• Select the menu at the top of the Content Manager and then select Topic.
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• Select the dotted menu ( ...) for a folder and then select Create Content.

2. Use the Create content dialog to set the properties for the new component:
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• Make sure that the Document Type is set to Topic.

• Enter a name for the new topic in the Document Title field.

NOTE
The characters you can use for titles are: numbers, language characters,
punctuation characters, and spaces. The punctuation characters are:

! " # $ % / &amp; ' ( ) * + , - . : ; &lt; = &gt; ? @ [ \ ] ^ _ ` { | } ~

• Use the Language section to choose which languages Paligo should include for the topic.
You can select individual languages or check the Select all languages box to include all
languages.

NOTE
You can only choose from those languages that are enabled on
your Paligo instance. To learn about adding languages, see Language
Management [1872].

• Use Open in editor to choose whether you want Paligo to display the new topic in the
editor.

• Check the box if you want Paligo to display the topic in the editor

• Clear the box if you do not want Paligo to display the topic in the editor
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• Use Create another to choose whether you want Paligo to leave the Create content dialog
open, ready for you to add another topic.

• Check the box if you want Paligo to leave the Create content dialog open

• Clear the box if you do not want Paligo to leave the Create content dialog open

3. Select OK.
Paligo creates the new topic.

Depending on your selections, Paligo may open the new topic in the editor automatically.
Alternatively, you can select the topic in the Content Manager to display it in the editor.

To learn about the structure that is included in a new topic by default, see Structure of a New
Topic [135].

TIP
Remember that your new topic is not included in any publications. To learn how
to add it to a publication, see Add Content to a Publication [99].

Create a Topic from the Publication Structure
It is possible to create new topics from the publication structure. The two benefits of this method
is that:

• The topic is automatically included in the publication.

• The topic can instantly be moved to the intended position in the publication structure

TIP
At the top of the Content Manager [34], you also have the option to create
content. This will however not automatically end up in the publication.

1. Select the publication in the Content Manager [34]. 

Paligo displays the publication's structure.
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2. Select the arrow next to the New topic button to choose where to save the new topic.

NOTE
If not done, the topic will by default be saved in the same folder as the
topmost publication or topic.

3. Select New topic. 

4. Name the new topic.

5. Move the topic to its intended position in the publication structure.

6. Select Save to confirm the publication changes. 

NOTE
The new topic is created at the chosen location and can now be edited.

Structure of a New Topic
When you create a new topic, Paligo automatically adds some structural elements to it. By default,
a new topic consists of a section element, a title element, and a para element:

1. section is the container for the topic's other elements.

2. title is the topic's heading.

3. para is the first paragraph in the topic.

To add content to a topic, you need to add suitable elements to form the structure. You can then
add your content inside the elements. For example, if you wanted to have two paragraphs and an
image, you would need to add two para elements and also the mediaobject, imageobject, and
imagedata elements that are needed for an image. Paligo has toolbar options that make it easy to
add commonly used structures in just a few clicks. There is also an element context menu [54] that
you can use to build structures one element at a time.

To learn about adding content to a topic, see Add Content to Topics [142].

Maximum Topic Size
You can add as many block elements and inline elements as you need, but the maximum
permitted size for a topic is 1MB.
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Copy a Topic
You can make a copy of a topic and then use the copy as the starting point for a different topic.

When you copy a topic:

• Paligo creates a new topic. It is given the same name as the original, with "copy" and a number
added at the end. The copy topic has its own unique ID and is a completely separate topic to the
original.

• The content inside the new topic is a copy of the content in the original topic. The copied
content has a different ID. For example, if your original topic contains a paragraph with ID 2245,
the copy version will have a paragraph with the same text, but a different ID, for example ID
2248. There is no content reuse with a copy, the same content is recreated.

• You can edit the copy and the content inside it without affecting the original topic.

NOTE
If you want to create different versions of a topic, the branching [1638] feature
may be a better option. With branching, you can create a copy that can later be
merged back into the original if needed.

To copy a topic:

1. In the Content Manager, select the options menu ( ... ) for the topic you want to copy.

2. Select Copy.

Paligo creates a copy of the topic.

3. To change the name of the copy, select its options menu ( ... ), select Rename, and then enter
the new name.

Check-in and Check-out
Every time you open a topic in Paligo for editing, the topic is automatically checked out. This
means that you have ownership of the topic and other users cannot edit it. This helps to avoid
conflicts, where two users might try to change each other's work at the same time.

When a topic is checked out, you will see this both in the Content Manager and in the Resource
View. Paligo uses a check mark to show the checked-out status.
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If a topic is checked-out by you, you can open it in the editor. If it is checked-out by someone
else, it is locked and you cannot open it unless you check it in. By default, Paligo is not overly
restrictive about checkouts - a user can check in someone else's documents if needed. This is to
stop check-outs hampering your work, for example, in case someone forgets to check in before
going on vacation or is otherwise unavailable.

You can set Paligo to automatically check in a document whenever you close the editor
(recommended). To set this up, use the Editor Settings. These are available from the toolbar menu
in the Editor (select the cog icon):

In the Resource View you can hover your cursor over the checkmark to see who has checked an
item out:

You can also see a list of checked-out topics in the Checked out documents section on your
dashboard:
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Create Revision History Topics
A revision history is a list with a summary of the changes made to a document. They are useful
as they provide an audit trail of the changes made to a document, with details of who made the
changes, what the changes were, and when they were added.

For a PDF output, a revision history looks like this:

TIP
To view revision history, see View Revision History [1667].

To create a revision history topic:

1. Create a new topic. Give it a suitable name, such as "Revision History" and then open it in the
editor.
There are many ways to create a new topic, including:

• Select New Topic from a publication's structure view

• Select Create Content from a folder's options menu ( ... ) and then choose Topic.
For details, see Create a Topic [131].

2. Use the element context menu to add an info element to the topic.

To access the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).
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3. Select the info element and then use the element context menu to add a revhistory
element.
When you add a revhistory element, Paligo adds child elements to it automatically.

The child elements are:

• revision

This is a container element for the revnumber, date, authorinitials and revremark
elements. You need the revision for the structure, but do not enter any information directly
into it.

• revnumber

Enter the number of the revision, for example, 6 if this is the sixth revision to the content.

• date

Paligo inserts the date automatically, by default. You can overwrite it with a different date if
you wish.

• authorinitials

Paligo inserts the name of the person who adds the revision element, by default. You can
overwrite it with a different name or initials if you wish.

• revremark

Enter a brief description of the changes that have been made. This will help other users to
understand what each revision included and why the changes were made.

TIP
You can delete an element if you do not want to include that information in
the revision history, for example, you could delete the date element.

4. To add more revisions, select the revhistory element and then use the element context
menu to add a revision element inside it. Paligo adds the revision element and its
revnumber, date, authorinitials, and revremark.

NOTE
You can add multiple revision elements inside a revhistory element.

5. Select Save.

6. If your revision history topic is not already in a publication, add it by editing the publication
structure. Typically, the revision history is added as the first topic so that it appears before
the main documentation, but you could add it to any position in the publication. You may also
want to put an output filter on the section element so that the revision history is not included
in outputs but remains in the publication for internal use. To learn how to filter content, see
Filtering / Profiling [1141]).
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When you publish your content, the revision history topic is included as part of the output (unless
you have filtered it out). For HTML outputs, you can use CSS to control the styling of the revision
history details (see Branding your HTML Outputs with CSS [654]). For PDF outputs, only the default
styling is available, although it is possible to change the styling as part of a customization project
(contact customer support for details).

Example 16. Revhistory and revision structure

The following code shows the XML for a valid revision history topic. We have removed the XML IDs
and attributes for clarity. When you create your own revision history, the elements will have XML
IDs and attributes added when you save.

<?xml version="1.0"?>
<section>
    <title>Revision History</title>
    <info>
        <revhistory>
            <revision>
                <revnumber>2</revnumber> 
                <date>24 May 2022</date> 
                <authorinitials>CW</authorinitials> 
                <revremark>Added information on recycling and ordering \
replacement parts.</revremark>
            </revision>
            <revision>
                <revnumber>1</revnumber> 
                <date>20 May 2022</date> 
                <authorinitials>CW</authorinitials>
                <revremark>Added legal information in front matter.</
revremark>
            </revision>
        </revhistory>
    </info>
</section>

Topic File Names (HTML)
For HTML5 outputs, HTML file names are normally generated automatically, but it is also possible
to set it individually.

Paligo has a number of options for how the HTML output file name is auto-generated. It uses
either the UUID (Universal Unique Identifier), the title of a topic, or the name of the resource to
generate the HTML file name, depending on your settings in the Layout Editor.

However, you can also set the output file name individually for particular topics if needed. This
can be useful if you are using the option to create the file name from the topic title, for instance,
and then need to change the title. By setting the output file as below, you can then make sure it
doesn't change even though you change the title.

To manually set the file name for a topic:

1. Open the topic in Paligo.

2. In the Element Structure Menu, select the top section element and then select Go to
element.

3. In the Element attributes section, give the section element the xinfo:outname attribute.
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4. Set the value of the xinfo:outname attribute to the name you want for the published file.
You only need to enter the file name.

NOTE
Do not include the file extension at the end.

5. Select Save.

When you publish to HTML, the file name for the topic is set to the value you defined for the
xinfo:outname attribute.

Exclude a Topic from Search (HTML)
You can set up topics so that they are included in your help center, but do not appear as results
in the search. For example, you could use this feature to exclude release notes from the search
results. This is a common requirement, because while the release notes are useful to have in your
documentation, they rarely provide enough detail. So you could make your search more useful by
only including those longer, more detailed topics that give your users the level of information they
need.

NOTE
You can also exclude topics from the navigation sidebar [102] (also known as the
TOC).

To exclude a topic from the search results:

1. Open the topic in the editor and select the section element in the Element Structure Menu.
Then select the Go to element option.
Alternatively, you can click at the very top of the topic, above the title, to select the section
element.

2. In the Element attributes section, add a role attribute and set its value to notinsearch.
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NOTE
The role attribute is not inherited. If you have different levels of topics, you
need to add the role to all of the sections that you want to exclude from the
search, not just the section of the top-level topic.

3. Select Save.

When you publish the topic to your help center, the search will not include the topic in its results.

Add Content to Topics
Writing in Paligo XML is different to writing content in a word processing program, such as
Microsoft Word. That's because:

• In Paligo, you write content as separate pieces of information. You write these in topics (see
Topic-Based Authoring [87]).

• Paligo XML is structured. When you author in Paligo, you add the underlying structure as well
as the text, images, etc., that form your content.

To add the structure, you insert elements. These are containers for specific types of information.
For example, a paragraph with a procedure after it looks like this in the underlying code:

<para>This is a paragraph.</para>
<procedure>
    <step><para>This is step 1.</para></step>
    <step><para>This is step 2.</para></step>
    <step><para>This is step 3.</para></step>
</procedure>
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The Paligo editor is designed so that the code for the elements is hidden so that it is less obtrusive
when you are writing. You can still see the structure if you want to, by looking at the element
structure menu, the XML tree view, or the source code editor.

Paligo editor (left) shows the structure in the element structure menu. The XML tree view (right) shows the
structure of a topic.

There are many different types of element that you can add (and most are defined in DocBook
5.1). But they can all be categorized as either:

• Block elements: Use these to build the structure of your topics. Think of them as "building
blocks" that define a type of content. For example, to add a paragraph, you add a para element.

• Inline elements: Use these to add meaning to parts of content inside a block element. A
common example of an inline element is emphasize, which you can use to italicize one or more
words in a paragraph.

You can add as many block elements and inline elements as you need, but the maximum
permitted size for a topic is 1MB.

In the following sections, we explain how to add block elements and inline elements in your topics,
We also explain how to move, copy, and delete elements.

NOTE
Elements can also have attributes, which are properties that have certain values.
For example, a paragraph element <para> can have an xinfo: product
attribute, which is a type of filter that allows you to include or exclude the
paragraph in different scenarios. To find out more about attributes, see: Element
Attributes [92].

TIP
You can find out more about the basics of block elements and inline elements in
Elements [89].
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Add Element Attributes
Every element has a set of attributes, which are properties that define the element's
characteristics. For each attribute, there is a value, and by changing the value, you can control
how Paligo uses the element.

Attributes are used for many different purposes in Paligo, including applying filters to your
elements so that you can include or exclude content in different scenarios. Many of the attributes
come from the DocBook standard, but there are some Paligo-specific ones too.

To add attributes to an element:

1. Open a topic in the Paligo editor and select the element you want to use.

2. In the element structure menu, make sure the element you want to use is shown at the end
on the right. You can select the element there and select Go to element to be sure that the
correct element is selected.

3. In the Element attributes section, the top field shows the currently selected element. Use
the Add attribute field to search for the attribute you want to give to the currently selected
element. You can only add attributes that are valid for the selected element.
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4. When you add an attribute, you need to give it a value. The way to do this varies, depending
on the type of attribute. Some, like filters, have a dialog where you choose the value from a list
(and you can add your own values), whereas others are text-entry fields where you enter the
value manually.

Some attributes. such as profiles (filters) give you a list of values to choose from, and you can add
your own.

Other attributes have text-entry fields, where you can type in the value. Here, the role attribute,
which is used to create a class in HTML outputs, has been given the value: highlight_step.

5. Repeat this process for any other elements that need attributes.
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6. Select Save.

To remove an attribute that has already been set for an element, see Delete Attributes [476].

NOTE
To change the value for an attribute, select the element that has the attribute and
then change the value in the element attributes section. When you save the topic,
the new attribute value is used.

Add Author Remarks
The remark element is a regular DocBook Element  and works like an internal comment (author
notes) inside the topic. For example it can be used as a tip, an internal instruction or a reminder
for other authors. It will only be visible to authors working in the Editor View and not displayed to
the end users.

The remark element is not handled via the Element Attributes Panel [55] since it has no profiling
values. It is visualised with the enclosing "box" highlighted in yellow with a lock and a green speech
bubble.

By default, the remark element comments are not shown in published output. But there is a way
to include them in the PDF output, see The Basics of Topic Editing [13]. However it cannot be made
to appear in an HTML output.

NOTE
A remark element has no relation to the Review or Contribution assignments
and will not be a part of those.

1. Place the cursor where the remark element is to be inserted.

2. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].
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3. Enter Remark and select it from the Element Context Menu.

4. Enter the internal comment.

5. Select Save. 

NOTE
If you click on an area outside the remark element, the editor will highlight the
enclosing "box" in yellow.

Remove Author Remarks
This section describes how to remove a remark.

1. Select the Remark element in the topic.

2. Place the cursor in the Element Structure Menu below the tool bar.

3. Select the element and choose Delete.
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4. Select Save. 

Add Block Elements
To add structural "block" elements to a topic:

1. Open your topic in the editor.

2. Position the cursor (also known as the caret) where you want to add a block element. You can
position the cursor manually or you can select an element in the element structure menu and
choose Go to element. (The element structure menu is immediately below the toolbar, and it
shows the position of the currently selected element).

The position of the cursor is important as there are rules that govern where each type of
element can be used. For most types of block element, you can place the cursor on the next
line, just like you would in a word processing program. But there are some exceptions, for
example, you cannot add a table inside a para element.
Paligo will advise you if you try to add an element in a position that is not permitted.

3. Add the element for the type of content you want to insert. There are several ways to add
elements:

• Use the Edit toolbar and Insert toolbar to add commonly used block and inline elements,
including paragraphs, images, tables, italicized text, and underlined text.

• Use keyboard shortcuts.

• To display the Element Context Menu, press:

• Windows: Alt  + Enter ⏎

• Mac: Command ⌘  + Enter ⏎
At the top of the element context menu, there is a search field that you can use to find
an element by name. When you start to type in the field, the list updates to show those
elements that are a close match to your entry and are valid at the current position.
Alternatively, you can select one of the most commonly used elements from the top section
of the list or scroll down the entire list to find the element you want.
The element context menu only shows the elements that are valid at the position you have
selected in the content structure. If you cannot see the element you want, it is because it is
not valid at that position. Try selecting a different position.
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NOTE
You can choose your own favorite elements and have those appear at
the top of the element structure menu. For details, see Working with the
Element Context Menu [568].

4. Add your content inside the block element. For paragraphs, list items, etc., enter your text. For
some types of block element, Paligo prompts you to choose an image, enter a video url, etc.

Add Inline Elements
To add inline elements to the text in a topic:

1. Open your topic in the editor.

2. Highlight the content that you want to apply the inline element to.

3. Add the element for the type of content you want to insert. There are several ways to add
elements:

• Use the Edit toolbar and Insert toolbar to add commonly used block and inline elements,
including paragraphs, images, tables, italicized text, and underlined text.

• Use keyboard shortcuts.

• To display the Element Context Menu, press:

• Windows: Alt  + Enter ⏎

• Mac: Command ⌘  + Enter ⏎
At the top of the element context menu, there is a search field that you can use to find
an element by name. When you start to type in the field, the list updates to show those
elements that are a close match to your entry and are valid at the current position.
Alternatively, you can select one of the most commonly used elements from the top section
of the list or scroll down the entire list to find the element you want.
The element context menu only shows the elements that are valid at the position you have
selected in the content structure. If you cannot see the element you want, it is because it is
not valid at that position. Try selecting a different position.

NOTE
You can choose your own favorite elements and have those appear at
the top of the element structure menu. For details, see Working with the
Element Context Menu [568].

Add a Sequence of UI Options

Abstract
Learn how to use the menuchoice element to add a sequence of options inside a single
instruction. For example, "select File → Save".

When you are writing instructions, you may want to tell readers to select several options in a
sequence. Paligo XML includes elements that are designed especially for this purpose.

You can either:
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• Insert a menuchoice element as a container and then add the various user interface elements
inside it.
With this approach, Paligo will automatically insert an arrow symbol between the user interface
elements in the sequence. For example:

• Insert the user interface elements directly into a para, without using menuchoice. Paligo will
not generate an arrow icon, so you will need to add text between the user interface elements,
for example:

NOTE
Inserting user interface elements directly into a para, without using menuchoice,
can give a better user experience for screen reader users. (If you use
menuchoice, screen readers may read out the user interface options and also
the arrow symbol).

There are several user interface elements that you can use, including elements for menus, menu
items, and keyboard shortcuts. We describe them in the following procedure. But it is up to you to
decide how detailed you want your structure to be. You can take a purist approach and use all of
the elements as intended, or a simpler approach where you use one element, such as guilabel,
to represent all user interface options.

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Find or add the paragraph that will give the instructions to select a sequence of options. Click
in the paragraph at the position where you want the sequence to appear.
If you are going to use the menuchoice element so that Paligo automatically includes an
arrow icon between UI elements, continue from step 4.
If you are not going to use the menuchoice element and are going to insert the UI elements
directly into the paragraph instead, continue from step 5.

3. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].
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4. Enter menuchoice element and add it.

5. Click in the "parent" element:
If you are using the menuchoice element, click in the menuchoice element you added in step
4.
If you are not using the menuchoice element, click in the para element you selected in step 3.

6. Use the element context menu to add one or more of the following user interface elements:

• guilabel

Use to contain the name of a label. When you have added the element, enter the name
inside it.

• guibutton

Use to contain the name of a button. When you have added the element, enter the name
inside it.

• guiicon

Use to contain the name of an icon. When you have added the element, enter the name
inside it.

• guimenu

Use to contain the name of a menu. When you have added the element, enter the name
inside it.

• guimenuitem

Use to contain the name of a menu option. When you have added the element, enter the
name inside it.

• guisubmenu

Use to contain the name of a submenu. When you have added the element, enter the name
inside it.

• shortcut

Use to contain keyboard shortcut details. When you add the shortcut element, you can
add keyboard shortcut elements inside it, including keycap, keycombo, and keysym for
keyboard keys and mousebutton for mouse actions.
To learn more about these elements, see the DocBook 5.2 standard (they are listed as
children of shortcut).

7. Repeat the previous step until you have created the structure for every option in the
sequence.
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8. Select Save. 

You can then publish your content.

NOTE
To style the user interface elements, use CSS for HTML outputs and the PDF
layout editor options for PDF.

For details, see:

• Branding your HTML Outputs with CSS [654]

• Inline Elements for PDF [962].

Example 17. A sequence of UI options and an alternative keyboard shortcut
Let's say you want to add an instruction that tells users to select a File menu and then a Save
option inside that menu. You also want a paragraph that tells them how to use a keyboard
shortcut as an alternative.

When you publish, it will look something like this:

Paligo adds the arrow between File and Save automatically, as the structure is set up to use the
menuchoice element.

The underlying XML for this is as follows:

<para>When you have completed your design, select 
    <menuchoice>
        <guimenu><emphasis role="bold"><emphasis>File</emphasis></guimenu>
        <guimenuitem><emphasis role="bold"><emphasis>Save</emphasis></
guimenuitem>
    </menuchoice>.
</para>
<para>Alternatively, use the keyboard shortcut: 
    <menuchoice>
        <shortcut>
            <keycombo>
               <keycap>Alt</keycap>
               <keycap>S</keycap>
            </keycombo>
        </shortcut>
    </menuchoice>
</para>

So to create it in a topic, you add two para elements for each paragraph.
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Inside the first para, you add the text that comes before the menu name and menu option. You
then add the menuchoice element as the container and inside that, the guimenu and guimenu
item elements. You enter "File" in the guimenu and "Save" in the guimenuitem. As these are not
styled as bold automatically by Paligo, you also use the bold toolbar icon on "File" and "Save". In
the code, this adds emphasis role=bold to those words.

Inside the second para, you add the text that comes before the keyboard shortcut. You then add
the menuchoice element as the container. Inside menuchoice, you add a shortcut element, and
inside that keycombo. Inside the keycombo, you add two keycap elements, one for each key that
needs to be pressed. Finally, you enter the text for the keys inside the keycap elements, in this
case, Alt and S.

Move Content
Being able to move content quickly is one of the benefits of structured authoring in Paligo. When
you move a block element, you move the selected element and all of its "child" elements too.
A good example is a procedure, where if you move the procedure element, you move the
procedure element and all of its "child" step and para elements in one action.

Table rows are different as you can only move those by using keyboard shortcuts and the XML
Tree (see Move Table Rows [157]).

To learn about the parent-child relationship and how it affects moving, copying and deleting, see
Understanding Content Structures [83].

TIP
It's worth taking the time to learn the keyboard shortcuts. When you master
those, you will be able to move your block elements around very quickly.

Move Block Elements with XML Tree View
One of the easiest ways to move most types of block elements is to use the XML Tree View. You
can access this by opening a topic in the main Paligo editor—it is shown in a section in the panel
on the right. Select the XML Tree View header to expand the structure.
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The XML Tree View shows the structure of the topic you are viewing, with the block elements
shown as blue tags. To move content, select a block and drag it to the required position (the tag
has to be on the dark line to complete the move).

NOTE
When you move an element, you also move the elements that are inside it (its
"child" elements). To learn about the parent-child relationship between elements
in a topic, see Understanding Content Structures [83].

You can move a block up and down at the same level in the structure, or you can move it left and
right to place it at a lower level in the structure. For example, you could drag a paragraph into a
step in a procedure.
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When you position the cursor over a blue tag in the XML Tree View, that element is also
highlighted in the main Editor. For example, in the following image, the cursor is over the
procedure tag, so the procedure is highlighted in the main editor.
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Paligo checks that the elements are in a valid position while you are editing, so you cannot place
an element where it is not allowed. If you try to do this, a red line is shown in the main editor and a
red tag is shown in the XML Tree View.

TIP
You can move entire tables in the same way as other block elements. But for table
rows, you can only use the XML Tree View or keyboard shortcuts (see Move Table
Rows [157]).

Move Block Elements with the Element Structure Menu
To use the Element Structure Menu to move a block element up or down:

1. Select the element you want to move.
You can see which element is currently selected by looking at the Element Structure Menu.
The element furthest to the right is the currently selected element. If you want to select one of
its "parent" elements, select it in the Element Structure Menu and then select Go to Element.

2. Select the name of the element in the Element Structure Menu and choose Move up or Move
down, depending on the direction you want to move the element.

When you are moving block elements, it's important to note that you can only move an element
up or down at the same level in the overall topic structure. This is by design, as it ensures that you
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do not move elements into positions where they are not allowed. For example, you can move a
step in a procedure up or down in the procedure order, but you cannot move the step outside
of the procedure.

Move Block Elements with Keyboard Shortcuts
To use keyboard shortcuts to move block elements:

1. Select the element you want to move in the topic.

2. Use the keyboard shortcuts to move the element.

Move up is Alt Shift ↑  on Windows and Option ⌥  Shift ⇧  ↑  on Mac.

Move down is Alt Shift ↓  on Windows and Option ⌥  Shift ⇧  ↓  on Mac.

When you are moving block elements, it's important to note that you can only move an element
up or down at the same level in the overall topic structure. This is by design, as it ensures that you
do not move elements into positions where they are not allowed. For example, you can move a
step in a procedure up or down in the procedure order, but you cannot move the step outside
of the procedure.

Move Table Rows
Table rows are slightly different to other block elements.

Move Table Rows with the XML Tree View
You can use the XML Tree View to move rows in a table. Note that you can only use the XML Tree
View to move rows, you cannot move columns or individual cells.

You can move a row:

• To another position in the same table

• Into a different table (in the same topic).

To move a table:

1. Open a topic in the editor and select the XML Tree View in the side panel.
The XML Tree View shows the main elements in your topic as blue boxes, arranged in a
hierarchy that matches the structure. Any box with a white cross has lower level content. If
you select the white cross icon, the tree expands to show the lower levels.
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2. Expand the tree to locate the table block and then expand that until you can see the table
rows (tr).

3. To move a table row, select it and then drag it to a new location in the XML Tree View. Paligo
will only let you move it to another valid position, so you can move it to another position in the
current table or you can move it into a different table.

Keyboard Shortcuts for Moving Table Rows
You can use keyboard shortcuts to move table rows up or down.

1. Place the cursor in a table cell in the row you want to move.
It is important that the cursor is in the td element of the cell and not in a para or other
element inside the cell. Check the Element Structure Menu to see that you have the cursor in
the correct place (the td element should be the last element on the right):

2. Use the keyboard shortcuts to move the element.

Move up is Alt Shift ↑  on Windows and Option ⌥  Shift ⇧  ↑  on Mac.

Move down is Alt Shift ↓  on Windows and Option ⌥  Shift ⇧  ↓  on Mac.

When you are moving block elements, it's important to note that you can only move an element
up or down at the same level in the overall topic structure. This is by design, as it ensures that you
do not move elements into positions where they are not allowed. For example, you can move a
step in a procedure up or down in the procedure order, but you cannot move the step outside
of the procedure.

Copy Content
You can make copies of text, single elements, and also entire structures in Paligo. This can make
it easier and quicker to create content that is similar to content that already exists. Instead of
creating the content from scratch, you can make a copy and then edit the copy to meet your
requirements. This is similar to how you might work in word processors and text editors.

But Paligo also has content reuse features, where you can reuse the same piece of content (block
element) wherever you need it. So before you start copying your content, you should consider
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which approach is best for you, copying or content reuse. If you intend to have the exact same
content in multiple places, it is usually better to reuse the content rather than make copies. To find
out more, see Content Reuse [1098].

Copy Content with Keyboard Shortcuts
You can use the following keyboard shortcuts for copying and inserting content:

Command Description Windows Mac

Copy (element) Copies the selected element. Alt  C Option ⌥  C

Copy (text) Copies the highlighted text, not the entire
element.

Ctrl  C Command ⌘  C

Cut (element) Removes the selected element and copies it to the
clipboard.

Alt  X Option ⌥  X

Cut (text) Removes the highlighted text, not the entire
element, and copies it to the clipboard.

Ctrl  X Command ⌘  X

Insert Inserts a copy as a new element, with its own ID. Alt  V Option ⌥  V

Insert as reuse Inserts copy as a reused element.

Any changes you make to the "copy" will also
affect the original as they have the same ID.

Alt  Shift  V Option ⌥  Shift ⇧  V

Copy and Insert Text
To copy parts of the text inside an element, such as words in a paragraph, select the words and
use a keyboard shortcut to copy and paste.

• On Windows, use Ctrl  and C  to copy and Ctrl  and V  to insert.

• On Mac, use Command ⌘  and C  and Command ⌘  and V .

When you copy text, there is no reuse. Reuse only applies when you copy an entire element.

Copy Elements with the XML Tree View
You can use the XML Tree View to make a copy of an element in a topic. Paligo adds the copy
directly after the original version, and then you can move the copy in the structure if needed.

When you copy an element, Paligo makes a duplicate of:

• The element

• Any text or other content inside the element

• Any "child" elements inside the element

• Any text or other content from inside the "child" elements.

All of the copies are new versions that reproduce the content and structure of the original
versions. They have unique IDs and so are separate to the original versions. If you use the XML
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Tree View to make a copy, and then you edit the copy, the changes will only apply to the copy.
They will not apply to the original version (the XML Tree View copy is not content reuse).

To copy an element using the XML Tree View:

1. Open a topic in the editor and select the XML Tree View in the side panel.
The XML Tree View shows the main elements in your topic as blue boxes, arranged in a
hierarchy that matches the structure. Any box with a white cross has lower level content. If
you select the white cross icon, the tree expands to show the lower levels.

2. Expand the hierarchy until you can see the element that you want to copy.

3. Position the cursor over the element you want to copy.
Paligo displays a copy icon and a delete icon.
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NOTE
For tables, you can only copy the table element or a table row (tr).

4. Select the copy icon (overlapping files).

Paligo creates a copy of the selected element. It places the copy directly after the element you
selected.

NOTE
If you copy an element that has elements inside it ("children"), Paligo will
make copies of the "child" elements too. For example, if you copy a procedure
with three steps, Paligo will create a duplicate procedure that also has three
steps. The procedures and steps all have unique IDs so that if you change
them, they do not affect the original version.

To learn more about the parent-child relationships between elements in a
topic, see Understanding Content Structures [83]

5. If you need to move the copy to a new position in the structure, select it in the XML Tree View
and drag it to the new position.
To learn more about moving elements, see Move Block Elements with XML Tree View [153].

Copy Elements using the Element Structure Menu
You can use the Element Structure Menu to create a copy of an element. You can then add the
copy to the same topic or a different topic, either as a unique piece of content or as a reused
element.

To use the Element Structure Menu to copy content:

1. Click inside the block element you want to cut or copy.

2. Select the same element in the Element Structure Menu. For example, if you wanted to copy a
paragraph, select para#text.
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3. Select Copy.

Paligo creates a copy of the element. The copy is stored in your computer's clipboard so that
you can paste it into your content.

4. Place the cursor in the position where you want to add the copied/cut element. It is important
that you position the cursor at a position where the element is valid. For example, if you have
cut or copied a listitem, you can place the cursor in an itemizedlist.

NOTE
If you want to add the copy to a different topic, open the other topic in
the editor. But make sure you do not copy anything else to your computer's
clipboard or you will lose the copy.

5. Select the element in the Element Structure Menu. (The element for the position in the
structure that you selected in the previous step).

6. Select one of the following options:

• Paste before
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Paligo will reuse the original content above the selected position. If you edit this "copy", your
changes will also affect the original too.

• Paste after
Paligo will reuse the original content below the selected position. If you edit this "copy", your
changes will also affect the original too.

• Insert
Paligo will insert the copy into the selected element. The copy has a unique ID. If you make
changes to it, those changes will not affect the original version.

• Insert as reuse
Paligo will reuse the original content inside the selected element. If you edit this "copy", your
changes will also affect the original.

NOTE
The Insert and Insert as reuse option is only shown if the copied element is
valid in the new position. For example, if you copy a step element and try to
insert it into a para element, Paligo will not show the Insert option. (A step is
not valid inside a paragraph).

7. Select Save.

Headings and Subheadings
In Paligo, each topic has a section element and a title element. The section represents the
topic as a whole and the title element acts as the main heading for the topic.

When you first create a topic, it has its title set to match the topic name. You can change the title
text, but be aware that when you make changes to the title, it can affect the URL of the topic in
HTML outputs. But it is possible to change the title and keep the existing URL, to find out more see
Topic File Names (HTML) [140].

You can of course also have subheadings, so that the contents of a topic are in separate sections.
These help to break up pages that contain lots of information, so that they are easier to read.
There are several ways to do this, as described in Subsections [164].
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Example of a page in the Paligo help that has subheadings (subsections).

NOTE
Some other elements also have titles , such as tables and examples. These
titles are included by default but you can remove them if you wish.

TIP
For some types of output, you may want to have numbered headings. For
example, legal documentation often has numbered headings. See Numbered
Headings [181].

Subsections
To make a text easier for the reader to consume, you can use subsections to divide your content
into smaller pieces of information, see Create Subsections [165].

Benefits of using subsections:

• Readers can quickly scan the main title and the subtitles to get a feel for what the page is
about.

• Subsections makes the writer focus on the information needed for the subsection rather than
the topic as a whole.

• Smaller sections of content are more visually appealing. A long page of text can be off-putting.
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This example shows the "Topic Templates" page that contains a subsection called "Create a Topic
Template".

Create Subsections
Subsections is a great way to make your content easier to read, as you can use them to break up a
page into separate, but related pieces of information. There are several ways to create subsections
in Paligo, each with their own pros and cons. If you know that you will need to reuse your main
sections and subsections separately, you can create each section as a separate topic and then:

• Use the Publication Structure to Create Subsections [166]

• Use Chunking to Control Subsections [167] (HTML only)

But the downside of this is that when you are editing, you can only see one section at a time. (In
the output, your readers will see the content as a main section with a subsection on the same
page, if space allows). If you want to be able to see the main section and the subsection in the
same topic while editing, use of these methods:

• Use Components to Create Subsections [169]

• Use the Section Element to Create Subsections [170]

NOTE
With these two methods, the subsections are shown inside the "main" topic. But
this also means that if you reuse the "main" topic, you will also reuse the sections
inside it.

Paligo Documentation

165



Use the Publication Structure to Create Subsections
You can use the publication structure to create subsections. When you publish, Paligo will
automatically create the same structure in the output.

Watch the video or see the text below,

https://player.vimeo.com/video/335110464

1. Create all of your sections and subsections as separate topics. For example, if you have an
Introduction topic and you want it to contain a References subsection, create one topic for
Introduction and one topic for References.

2. Open the publication structure.

3. Drag your topics into the structure. You can create subsections by dragging the topics left and
right below other topics.

4. For HTML outputs only, select Layouts and edit the layout you will use for publishing. In
the Toc and chunking settings, use Chunk section depth to control whether topics become
subsections. The default setting is 3, which means any topics at level 4 or below in the
publication structure will become subsections of the level 3 topics.

NOTE
If a topic is set to have xinfo:chunk=yes, it will always be on its own page,
even if it is at a lower level than the Chunk section depth. (see Use Chunking
to Control Subsections [167])

5. Publish your content.

For PDF outputs, the subsections are shown on the same page as the main section, where space
allows. They are set as subsections with lower heading levels automatically.

For HTML outputs, Paligo displays each topic on its own page until the Chunk section depth is
reached. Topics at a lower level then become subsections, unless they are specifically set to be
separate chunks (see Use Chunking to Control Subsections [167]).

Example 18. Subsections in a PDF Output

In this example, we have three topics. To keep the explanation simple, we have named them
"Heading 1", "Heading 2" and "Heading 3".

In the publication structure, "Heading 1" is set as the top-level topic and "Heading 2" and "Heading
3" are nested as subsections below "Heading 1".
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We publish to PDF.

Paligo detects the hierarchy of topics in the publication and recreates it in the PDF output. The
"Heading 2" and "Heading 3" topics appear as subsections of the "Heading 1" topic.

Use Chunking to Control Subsections
You can use Paligo's chunking feature to control whether a topic can be used as a subsection or to
appear as a separate web page in the HTML / HTML5 output. The term "chunk" means that a topic
has to be on its own. So if a topic is set to xinfo:chunk with the value set to:

• Yes - the topic cannot be a subsection inside another topic and will always be on a separate
page when published. It cannot be a subsection on another page.

• No - the topic can be a subsection inside another topic.

NOTE
Learn more about chunking settings, see Chunking [780].

To set a topic's chunk value:

1. Open the topic.

2. In the Element Structure Menu, select the section element and then select Go to Element.
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3. In the Element attributes section, add the xinfo:chunk attribute and set its value.

• Yes to prevent the topic from being a subsection.

• No to allow the topic to be a subsection.

4. Select Save. 

IMPORTANT
The xinfo:chunk value takes priority over the Chunk section depth setting
in the layout editor. For example, if you set the Chunk section depth to 3, it
normally means that any topics at level 4 or below will become subsections of
the "parent" level 3 topic. However, if your level 4 topic has xinfo:chunk = yes,
the level 4 topic will not be included as a subsection of its "parent" level 3 topic.
Instead, it will be a separate topic.

There are two ways to use chunking (and they can be combined):

• Set the default level at which you want topics to become a chunk under "TOC and chunking" in
the Layout Editor.

• Add the xinfo:chunk attribute to the section element in a topic via the Element Attributes
Panel [55].

Example 19. Chunk section depth and xinfo:chunk used in combination
If you have a publication called "Mars Travel Manual" and you have organized it so that there are
topics at different levels.
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You are going to publish to HTML5 and your layout has Chunk section depth set to 2.

When you publish, the output has the top-level and second-level topics as separate pages. The
third-level pages and lower are subsections.

So if we look at the "The Mission Control Center" topic and its lower-level topics, the output will
work like this:

1. "The Mission Control Center" is a top-level topic. It is higher than the Chunk section depth
setting of 2, so it has its own page in the output.

2. "Command Center" is a second-level topic. It is at the same level as the Chunk section depth
setting of 2, so it has its own page in the output.

3. "Controls System" and "Control Room" are third-level topics. They are below the Chunk
section depth setting of 2, and so they do not get their own page. Instead, they are
subsections on the "Command Center" topic, as that is their immediate "parent" in the
publication structure.

NOTE
The green dotted line in the image represents the Chunk section depth setting
of 2.

But what if you wanted "Controls System" to be a subsection of "Command Center" and "Control
Room" to have its own page? To do that, you would set the "Control Room" topic to have the
attribute:

xinfo:chunk = yes

With this in place, Paligo will give the "Controls System" topic its own page in the published output,
as xinfo:chunk takes priority over the Chunk section depth setting. So the result is that the
output has:

• "The Mission Control Center" and "Command Center" topics have their own pages as they are at
a higher level than the Chunk section depth.

• "Control Room" has its own page as it has xinfo:chunk=yes. The Chunk section depth does
not apply to this topic.

• "Controls System" is a subsection of "Command Center" as it does not have xinfo:chunk=yes
and so the Chunk section depth does apply.

Use Components to Create Subsections
If you like to be able to see the subsections inside topics while editing, using components for
subsections is a good choice. With this technique, you create your main section and subsections as
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separate topics, and then import the subsections into the main topic. You can then view the main
topic and subsections all inside the same topic. This can make it easier to check the flow of your
content and that you have covered all of the points you need to make.

To learn how to use components for subsections, watch the video or read the instructions below.

https://player.vimeo.com/video/333991364

1. Create all of your sections and subsections as separate topics. For example, if you have an
Introduction topic and you want it to contain a References subsection, create one topic for
Introduction and one topic for References.

2. Open a topic that will be a main section that contains subsections.

3. Select Insert > Component and choose the topic that you want to add as a subsection.
The topic is added as an import element and you can see it as a subsection in your topic.

4. Repeat steps 2 and/or 3 for each of the subsections you want to add and save each topic.

5. When you have finished adding topics as components, publish to HTML.

Use the Section Element to Create Subsections
A quick and easy way to create a subsection is to add a section element inside another section
element. You will then be able to see the main section and the subsection in the same topic while
you are editing. However, there are some limitations with this technique that makes it better to
use an inserted component instead:

• Reusability - You cannot reuse the subsection in other topics, unless you Convert Subsections
into Separate Topics [172] and import them as components, see Use Components to Create
Subsections [169].

• Number of subsections - The Paligo validation recommends a limit of10 sections per topic
(a main section with 9 subsections) and enforces this via the "Paligo Recommended Rules" in
the Editor Settings [600] when validating / saving a topic. Note that there is no limitation when it
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comes to subsections that are inserted as components. However, if you know that a subsection
is only needed in one topic, you can create it as a section inside a section. Read about possible
settings in Editor Settings [600].

• Searchability - Subsections not being inserted as components can be more difficult to find
in the web search than topics. They can also be harder for the writer to via the Content
Manager [34].

To add a second section element as a subsection:

1. Position the cursor at a valid position for a subsection.
You can only insert a section for a subsection at a position that is both:

• A direct descendant of a section element (either the section for the main topic or a section
for a subsection). It cannot be inside another element.

• Immediately followed by another section element or a closing section element (</
section>).
You cannot have content "floating" between subsections or between a subsection and
the end of the main topic. Your content must be inside the main topic and before the
subsections or inside one of the subsections.

CORRECT: The cursor is positioned outside the other
elements, and is a direct descendant of the section element
of the main topic. The element that follows the position is
the closing element for the main topic, and so is </section>.
A subsection can only be followed by a section or closing
section element.

INCORRECT: The cursor is positioned inside an element. The
selected position is not a direct descendant of the section
element of the main topic.

NOTE
In a topic, all of the content, including your subsection section elements, must
be inside the main <section> and </section> tags of the topic.

2. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].
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3. Enter section and select it from the menu.
A new section element is added to the topic. As it is inside the main section element, the
new section appears as a subsection.

4. Enter the title for the new subsection. You can then add content to the subsection in the same
way as any other topic.

NOTE
You cannot add para elements and other block elements between subsections.
The only valid content after the end of a subsection is another subsection.

Convert Subsections into Separate Topics
Long topics that contain many subsections can be difficult for people to use, because there's too
much information provided in one place. To avoid this "cognitive overload", you can convert the
subsections into separate topics, so that there are lots of shorter topics instead of one long topic.
You can then use cross-references to guide people from one topic to another.

TIP
Accordions [176] are another way to help avoid "cognitive overload" on long
pages. They allow a subsection to be collapsed, so that the subsection content is
only visible when the reader selects the subsection heading.

To convert a topic's subsections into separate topics, you can use Paligo's Convert reusable
component feature.

1. Select the title of the subsection you want to convert and then, in the Element Structure
Menu, select the section element for the subsection. Make sure that you select the
subsection's section element and not the main section element for the topic.
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2. Select the Convert reusable component option.

3. On the Convert to reusable component dialog, enter the title for the new topic (it will
default to having the same title as the existing subsection). Also, choose the folder that the
new topic will be stored in.

If you want the new topic to be embedded in the topic that currently contains the subsection,
check the Reuse the component at position checkbox.
Some technical communicators argue that sections and subsections should always be
separate topics as this makes them more reusable. You can then create subsections by
embedding a topic inside another topic.

When you select OK, Paligo converts the subsection into a topic. The subsection is removed from
the topic. If you checked the Reuse the component at position checkbox, the new topic is
embedded in place of the subsection.
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In the image above, the subsections have been converted into separate topics and they are embedded in
the main topic.

TIP
If you need a topic to contain several subsections, you can make the content less
overwhelming for the reader by using accordions [176].

Reader-Friendly URLs for Subsections

NOTE
Reader-friendly URLs for subsections is only supported by HTML5 help centers.

With Paligo's Reader-friendly fragment identifiers (hash links) feature, you can have
subsections that use a text URL instead of a unique ID (UUID). The text URLs are easier for people
to understand, and so are better for when you need to share links to your HTML pages.

For example, if the UUID is used for creating the URL of a subsection, you get a URL like this:

Where the link targets the subsection by using the hashtag (#) followed by the UUID of the
subsection's section element.

But if you enable the Reader-friendly fragment identifiers feature, the URL will use the text of
the title element instead of the UUID, like this:

NOTE
URLs for subsections are also known as "hash links", as there is a hashtag # in the
structure of the URL.

To set up SEO-friendly and reader-friendly URLs:

1. Select Layout and edit the layout you are going to use for publishing.

2. Enable the SEO-friendly output file names feature.
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NOTE
The "reader-friendly" features require the SEO-friendly output file names
feature to also be enabled.

3. In the General section, enable or disable the Reader-friendly fragment identifiers (hash
links) setting.
Set to Enable to use text URLs.
Set to Disable if you prefer to use the UUIDs for hashtag identifiers.

NOTE
Reader-friendly fragment identifiers is disabled by default, so that it does
not affect any Paligo customers who want to continue using UUID in hash
links.

4. If you have previously shared links that used the UUID in the URL, you can choose to continue
supporting them. The URLs with UUIDs will still work, even though the URL for the subsection
will use reader-friendly text instead of the UUID.
Use Preserve legacy anchors if using reader-friendly fragment identifiers to choose
whether links with UUIDs will continue to work.
Set to Enable to preserve the UUIDs so that links will continue to work.
Set to Disable to lose the UUID, so that only links to the new reader-friendly text version of
the link will work.

NOTE
If you preserve the UUID, it does not mean that the UUID is used in the URL
(the UUID is still in the topic, hidden in the code, but it is not part of the URL).
The URL will use the new reader-friendly version. If you use the copy to link
feature, the copy will also use the reader-friendly URL.

5. Select Save.

When you use the layout to publish your content, your chosen settings will be applied to the HTML
output.

NOTE
If you have a publication that contains multiple topics or sections with the same
title, you would get duplicate hash fragment identifiers.

If you have such duplicates, Paligo will add a suffix to differentiate them. The
suffix is generated from the id of the second topic/section. But you can avoid
using suffixes by manually providing a reader-friendly fragment identifier. To do
this, use the xinfo:outname attribute on the section element of each duplicate
topic/section.
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Accordions (Collapsible Sections)

NOTE
Accordions are currently supported for HTML5 and Zendesk outputs.

Accordions are sections of content that can be expanded or collapsed. They are useful when:

• You have long, complex procedures. You can break the procedure down into sub-sections, and
make each sub-section an accordion. The reader can then expand/collapse each section in turn.

• You have content that is useful, but not essential, such as examples. If you make them into
accordions, your readers can choose whether they want to see that information.

You can use accordions on sidebar elements and section elements. But for sections, the
accordion only appears when that topic is inserted into another topic as a subsection, for example,
if a topic is inserted as a component.

To create an accordion:

1. Select a section element or a sidebar element.
You can select a section element for a sub-section in a topic (a section inside another section).
Alternatively, you can select the section at the top-level of a topic, and the topic will appear as
an accordion section whenever it is included inside another topic.

2. In the Element attributes, select Add attribute and choose Role.
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3. Give the Role attribute the value:
accordion

4. Select Save.

When you publish to HTML5 or Zendesk, the section or sidebar will appear as expandable/
collapsible accordions.

TIP
You can use a keyboard shortcut to quickly apply the accordion role to sections

inside a topic (but not the main section for the topic). Select the section element

or the sidebar element and then use Alt  Shift  Y  on Windows or Option

⌥  Shift ⇧  Y  on Mac.This shortcut adds the role:accordion to the element

automatically.

Example 20. Accordions

Select the example below to expand and collapse content.

Example
This is an example of an accordion, expanding when you click it. Of course the accordion can be
styled just the way you want it by applying your own CSS, if you want to have a background color
for the header instance, or anything you like.
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.panel-default > .panel-heading { background-color: #fafafa; padding: 1em; }
        

Nesting
Accordion sections can also be nested if needed, although it is not recommended to overuse this.

Change Heading Titles and URLs
If you want to change the title text for a topic, you should first think about how it will affect your
published output.

• For PDFs, a change to a heading does not affect the output, so you can make changes as
needed.

• For HTML, Paligo uses the title to generate the URL (address) of the webpage for each topic. So if
you change the title, the URL will also change when you publish.

Paligo detects changes to titles automatically, and updates your content to use the new URL. But
Paligo cannot change any links that come from external systems. For example, if your website links
to a page in the help and the URL of the page has changed, the link will no longer work. To avoid
this problem, you can:

• Use the xinfo:outname attribute to keep the existing URL, even though the text in the title has
changed [178]

• Set your HTML publications to use the topic name for URLs instead of the topic title [180].

Keep Existing URLs for HTML Pages
One way to change the title of a topic without affecting its URL is to use the xinfo:outname
attribute. This attribute is available for the section element.

When you set an xinfo:outname value, that value is used for the URL of the HTML page for that
topic. The xinfo:outname takes priority over all other URL settings, so will be used even if you set
the HTML layout to use topic names instead of titles.

To keep the existing URL of an HTML page:

1. Open the topic in the editor.

2. Change the text in the title element.

3. In the Element Structure Menu, select the top section element and then select Go to
element.

4. In the Element attributes section, add the xinfo:outname attribute.
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5. In your existing help output, browse to the page that has the URL you want to keep. Copy the
page part of the URL. For example, if the page has the URL:
https://acmehelp/docs/en/6083-introduction.html

You would copy 6083-introduction as that is the page part of the URL. Do not include
the .html file extension, you only need the page name.

6. Paste the page part of the URL into the value box for the xinfo:outname attribute.

7. Select Save.

When you publish to HTML, Paligo will use the xinfo:outname value for the page part of the URL.
It will not use the title or the topic name, the xinfo:outname takes priority.

Example 21. Using xinfo:outname to keep existing URL

For example, let's say you have a topic and it's title is "Introduction". When this was first published,
Paligo set the URL to:

https://acmehelp/docs/en/introduction.html

Paligo Documentation

179



Your customer support team then used links to that page when they replied to customer queries.

Some time later, you need to update the page title to "Introduction to ACME 100" but you do not
want to break the links that customer support sent out.

You change the title text of the topic to "Introduction to ACME 100" and then add the
xinfo:outname attribute to the section of the topic. You set the attribute's value to: introduction.

You publish the content to HTML. Paligo uses the xinfo:outname value (introduction) to
create the page part of the URL, instead of the new title text. So in the output, the page has this
URL:

https://acmehelp/docs/en/introduction.html

If you did not set the xinfo:outname, the page would have the new URL based on the change to
the title text, and it would have been:

https://acmehelp/docs/en/introduction-to-acme-100.html

Topic Names Instead of Titles for the URLs of HTML Pages
You can set Paligo to use topic names instead of titles for the filenames and URLs for HTML pages.
The topic names are then used instead of the title text for the page part of the URLs. For example,
if a topic is named "IoT Controls" and has a title of "Controls for IoT System", the URL for the page
in the HTML output will look like this:

https://acmehelp/docs/en/iot-controls.html

Note that the page part of the URL uses the name of the topic ("IoT Controls") and not the title text
("Controls for IoT System").

To set Paligo to use topic names instead of title text for URLs:

1. Select Layout and then edit the HTML5 layout you are going to use for publishing.
Alternatively, you can create a new HTML5 layout and edit that.

2. In the General section, find the Use resource name instead of title for the HTML output
filename setting. You can use this to control whether topic names are used for URLs:

Set it to Enabled to use topic names.
Set it to Disabled to use the text in the topic title element.

3. Select Save.
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If you enabled the Use resource name instead of title for the HTML output filename setting,
Paligo will use the topic names for the filenames and URLs. This means you can now change your
topic title text without affecting the URLs for the pages.

Numbered Headings
By default, Paligo uses text-only headings, but you can use numbered headings instead.
Numbered headings have numbers as a prefix.

To enable or disable numbered headings, edit the layout that you use for publishing.

1. Select Layout and then edit the layout that you are going to use for publishing.

2. Find the Section numbering settings.
On PDF layouts, the Section numbering settings are in Section titles > All sections.

For HTML layouts, the Section numbering settings are in Toc and chunking.
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3. Use Section numbering to control whether your headings use numbers. Select Enabled for
numbered headings, Disabled for text-only headings.

4. Use Section numbering maximum depth to control what heading levels have numbering.
The default is 3, which means the top-three heading levels will be numbered, but level 4
onwards will be text-only.

5. Select Save.

You can choose whether your headings use a number prefix.

Admonitions
You can add notes, warnings, tips and other "admonition" elements to make parts of your content
stand out. Admonitions is the term for collectively describing all of the notes, warnings and tips. 

The admonition elements include Note, Caution, Warning, Danger, Notice , Important and
Tip. You can add them from the Insert tab in Toolbar [52] and some of them can be added with
keyboard shortcuts, see Keyboard Shortcuts [576].

You can use the admonition elements in most types of block content, including paragraphs and
tables. Paligo does not restrict how you use the elements, but you need to be aware that some
industries have rules about how they are used. For example, in some industries, you must use a
warning if there is a risk of injury.
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Admonition Types
Admonitions also called "safety messages" or "hazard statements" is an umbrella term used for
note, important, notice, caution, warning, danger and tip elements.

Paligo includes a variety of admonition elements that you can use:

NOTE
This is a note element

The note is normally used for general information that you want to stand out.  

CAUTION
This is a caution element

The caution element can be used however you need, but has a certain
significance in some industry standards.

WARNING
This is a warning element

The warning element can be used however you need, but has a certain
significance in some industry standards.

DANGER
This is a danger element

Danger is a custom Paligo element. It is actually a warning element with its Role
attribute set to Danger. It can be used for any purpose, but is designed for
content that describes situations that could result in physical injury or death. 

TIP
This is a tip

Tips are designed for giving readers helpful advice and suggestions.
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IMPORTANT
This is an important element

The important element is for adding extra emphasis to general information. 

NOTICE
This is a notice element

"Notice" is a variant of note used in certain industry standards (especially
manufacturing). If used, it is generally regarded as being of more importance than
a regular note. 

Add Admonitions
To add a note, warning, tip or other type of admonition to your content:

https://player.vimeo.com/video/316172097

1. Select the Insert tab.

2. Select the Admonitions option (the warning icon) .

3. Choose the type of admonition you want to create from the list.

The appropriate admonition is added to your content, ready for you to add your message.
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Alternatively, you can use this technique to add an admonition:

1. Place your cursor where you want to add the admonition.

NOTE
If you want to place an admonition after a paragraph, you must place the
cursor after the paragraph and before the next element.

2. Press Alt  and Enter  (Windows) or Command  and Enter  (Mac) to access the Element list.

3. Select the type of admonition that you want to add, for example, Warning. (You can search for
the admonition by name, if required).

NOTE
You can add most types of element inside an admonition element. For example,
you can add text, images, tables, etc.

Convert Admonitions
You can quickly change one type of admonition to another. 

https://player.vimeo.com/video/316172332

1. Select the admonition element that you want to change into a different type of admonition.
For example, select the note element. 
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TIP
Use the Element Structure Menu (1) to make sure that you have the
admonition element selected. The admonition element should be the last
element shown.

2. Select the Insert tab.

3. Select the Admonitions option (the warning icon) .

4. Choose the type of admonition you want to create from the list.

Style Admonitions
You can change the appearance of your notes, warnings, and tips to meet your needs. 

For HTML/HTML5 outputs, you can use CSS to customise the appearance.

For PDF outputs, you can set the colours and icons in the PDF layout. 

1. Select Layout.

2. Select the PDF layout that you use for publishing the content.

3. In the Layout Editor, use the Annotations options (1 and 2 in the following image) to define
the appearance. There are settings for adjusting the font size, colour, icons, and spacing.

4. Select Save.

Admonition Titles
By default, Paligo creates a label for each admonition element and does not include a title. The
label adds the name of the element in the published content, for example, if you add a tip, the
word "tip" is used as the label (shown as 1 in the following image).
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The labels that Paligo generates, such as "tip" and "warning" are translated automatically for most
languages.

If you prefer, you can add a title. Paligo will then use your title instead of generating a label (but
your title will not be translated automatically).

https://player.vimeo.com/video/316172231

To add a title:

1. Select the admonition element that you want to give a title.

2. To display the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

3. Select the Title option.

4. Enter the text for the title.

5. Select Save.
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Lists and Procedures
Paligo has many different types of lists and procedures that you can use in your content. Each
type of list has a different purpose and underlying structure, for example, there are bullet lists,
procedures, numbered lists, and specialized lists for questions and answers and much more.

To get started with lists, we recommend that you learn about the commonly used Types of
Lists [188]. You can then refer to the relevant help articles to learn how to create lists, and order,
reuse, and convert them.

You can also check out this video for some tips on working with lists.

https://www.youtube.com/embed/olBkmjgb72Y?rel=0

Types of Lists
The most commonly used list types are available under the Edit tab in the Toolbar.

• Unordered lists 
Also known as bullet lists or itemized lists gives each list item has a disc prefix by default. Use
these for lists where the order of the list items is not important.

Example of unordered list

• Ordered lists 
Also known as numbered lists gives each list item a number prefix. Use these for lists where the
order is important, but it is not related to step-by-step instructions. For example a topic with
chart positions, such as a "Top 10 reasons to recycle the battery" then the order is important,
but the sequence is not step-by-step instructions.

Example of ordered list

• Procedures 
Use procedures for step-by-step instructions. Each list item is a step and the structure of the
elements is designed specifically for a process.
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Example of procedure

• Checklists 
Also known as to-do lists gives each list items a checkbox prefix. For PDF, the boxes are blank so
that they can be checked. For HTML, the boxes are selectable.

To find out how to add checklists, see Checklists [222].

Other available types of lists
For other types of lists, use the Element Context Menu to add the appropriate list element, for
example variablelist or qandaset.

• Tasks
Tasks are more formal versions of procedures that have additional elements available that
cannot be used with regular procedures, see Tasks [211].

• Question-and-Answer Lists
Use these lists for frequently-asked-questions lists with a series of questions and answers. To
find out how to create question-and-answer lists, see Question and Answer Lists (FAQs) [226].

• Callout Lists
Callout lists are designed for adding annotations to code samples in your content. You can
use them to add "hotspots" to your code example with explanations for those markers shown
below.
For example, the following image shows a code sample that has two "hotspots" in the code.
Below the code sample, there are text descriptions to provide the reader with more information
To find out more, see Annotate Code Blocks [492].
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• Variable Lists
Also known as description lists, these lists look like borderless tables and are for describing
terms. To find out more, see Variable List (Description List) [236].

Create a List or Procedure
You can add procedures and different types of lists to your topics. The most commonly used Types
of Lists [188] are available under the Edit tab in the Toolbar.

• Unordered list also known as a bullet list.

• Ordered list also known as numbered list or itemized list. Do not confuse it with a procedure,
see Types of Lists [188].

• Procedure used for step-by-step instructions.

• Checklist used for To-Do lists with checkboxes.

For other types of lists, use the Element Context Menu to add the appropriate list element, for

example, variablelist or qandaset. To access the element context menu, press Alt  + Enter

⏎ (Windows) or Command ⌘  + Enter  ⏎ (Mac).

TIP
To speed up your work in Paligo, see Keyboard Shortcuts [576].

1. Position the cursor where the list is to be added. 
The cursor has be to placed in a valid position, such as inside an empty para element or
immediately after a para.
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2. Select a type of list from the toolbar.

When the list is added, Paligo creates the first list item or step automatically.

3. Enter the text for the first list item or step.

4. Press Enter to add new list items or steps. ⏎

5. Select Save. 

TIP
More useful tips when working with lists and procedures:

• To reuse parts of a list, see Reuse a Sequence of Items in a List [1117]

• To copy lists or specific list items, see Copy Content [158]

• To move lists or specific list items, see Move Content [153]

• To add extra content inside a list, see Add Content Inside a List Item or
Step [203]

• To remove a list, a specific list item or step, see Delete Content Inside
Topics [470].

Convert a List
This section describes how to convert a list into a different list type.

1. Select the list or procedure in the Element Structure Menu [52].

2. Select a list type from the toolbar.

3. Select Confirm to change into a new list type.

4. Select Save. 

Set Starting Number
By adding attributes, you can control the numbering of an ordered list. You can set it to start at a
specific number or continue the numbering from a previous list.
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1. Select the ordered list in the Element Structure Menu [52].

2. Select Go to element.

3. Add one of these attributes in the Element Attributes Panel [55]:

• Startingnumber to specify the first number the ordered list will use. Add the starting
number.

• Continuation and set the value to continues to make the list continue the numbering
from a previous list.

4. Select Preview to see the changes to the numbering.

5. Select Save. 

Select Numeration Type
By adding the numeration attribute, you can adjust the numeration type for the ordered list. You
can choose between:

• arabic 1, 2, 3 (default)

• upperalpha A, B, C

• loweralpha a, b, c

• upperroman I, II, III

• lowerroman i, ii, iii

1. Select the ordered list in the Element Structure Menu

2. Select Go to element.

3. Add the numeration attribute in the Element Attributes Panel [55].

4. Select desired numeration type from the menu.
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5. Select Save. 

Move a List Item or Step
There are several ways to change the order of the list items / steps in your lists and procedures.

• Use the XML Tree View to see the list structure, and then drag and drop each list item / step to a
different position.

• Select the listitem/step, then select the listitem or step element in the element structure menu.
Use the Move Up and Move Down options to change the position of the list item / step.
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• Select the list item / step and then use the keyboard shortcuts to move it up or down.
The keyboard shortcuts for Mac OS are:

Option ⌥  ↓  for down

Option ⌥  ↑  for up

The keyboard shortcuts for Windows are:

Alt Shift ↓  for down

Alt Shift ↑  for up

Split a List
To split a list into two separate lists:

1. Select the area between the list items/steps where you want the split to take place.
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2. Select the Split icon on the Edit toolbar.

Paligo splits the list at the selected listitem/step. You now have two separate lists of the same
type.
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The second list is completely separate to the first list, with new numbering (if it is a numbered
list). You can Convert a List [191] or set attributes on the list without affecting the first list.

Merge Two Lists
You can merge two adjacent lists of the same type into one list. This is useful if you have:

• Imported content that was perhaps not formatted correctly in the original version, resulting in
lists being broken down into smaller separate lists.

• Two lists that were previously separated by paragraphs or other content that has now been
deleted.

To merge two adjacent lists:

1. Select any listitem or step in the first list that you want to merge. The first list is the list that is
closest to the top of the topic.

2. In the element structure menu, select the element that represents the list as a whole, and
then select Go to element. For example, if in step 1 you selected a step, then you should
select the procedure element in the element structure menu.
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3. Select the Merge toolbar icon.
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Paligo will merge the list with the next list as long as:

• The current list and the next list are of the same type

• There is no content between the current list and the next list.
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4. Select Save.

Convert a List into Paragraphs
To "undo" a list so that it becomes a series of paragraphs instead:

1. Select a listitem/step in the list.

2. In the element structure menu, select the element that represents the list as a whole, and
then select Go to element. For example, if in step 1 you selected a step, then you should
select the procedure element in the element structure menu.

3. Select the icon for the type of list that you want to undo. For example, if you have a procedure
list that you want to turn into paragraphs, select the procedure icon.
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When you select the icon, Paligo converts the list into a series of para elements.
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Convert a Group of Paragraphs into a List
You can quickly convert paragraphs into popular types of list by using the toolbar icons (or their
keyboard shortcut equivalents). This can be useful when you have content that is written as
paragraphs, but should really be procedures or lists. For example, if you have copied content from
a plain text editor into para elements.

1. Select any part of the paragraph.

2. Select the toolbar icon for the type of list you want to create. For example, select the
procedure icon to turn a paragraph into the first step of a procedure.
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3. Repeat step 2 for any subsequent paragraphs.

NOTE
When you turn a paragraph into a list or procedure, Paligo automatically
moves the cursor to the next paragraph. So if you have a group of
paragraphs, you can keep selecting the toolbar icon to turn each subsequent
para into a step.

Reuse Content in Lists
When you are creating lists or procedures, you may find that there are opportunities for content
reuse. A common example is if you are documenting software and you have a "Select Save" option
that appears over and over again. To follow best practices, rather than create multiple versions of
that, you should write it once and reuse it in your various procedures.

To reuse text fragments (individual paragraphs) in your lists, position the cursor inside a list step,
where the para element is valid. This could be inside the para that is added automatically for
each step, or it could be after the first para inside the step, but before the next step. Then use the
Reuse text feature to search for reusable text fragments, and insert one at the cursor position. To
find out more, see Reuse Text Fragments [1113].

Valid cursor positions for reusing text fragments in a list.
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To reuse an entire list, create an informaltopic and add the structure of the list into that. You
can then insert the informaltopic into other topics, wherever it is needed. But remember to
organize your informal topics into a logical folder structure in the Content Manager, so that other
writers will be able to find them more easily. To find out more, see Create an Informal Topic [1109].

To reuse parts of a list in another list, see Reuse Items in a List [1114].

Add Content Inside a List Item or Step
When you are writing lists and procedures, it is likely that you will need to add some extra content
inside the step. This could be an extra paragraph, an image, or an admonition. In this article, we
will explain how to do that. If you are looking for help on how to have a sublist inside another list,
see Sublists [207].

To add content inside a list item or step:

1. Position the cursor so that it is outside the para element in the list item or step. (But still inside
the list item or step).

2. You can now add other elements, such as images, admonitions, and other paragraphs. To
add these, you can use the toolbar menu or the element context menu, just like when you
add elements outside a list. The elements that you add will appear indented, so that they are
aligned with the paragraph inside the list item or step.

NOTE
To access the element context menu, press Alt  and Enter  (Windows) or

Option ⌥  and Enter  (Mac).

3. To add a list item or step after the content inside the step, position the cursor so that it is
outside the list item or step. Then press Enter to display the element context menu and select
listitem or step, depending on the type of list you are using.
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4. To end the list, select a position outside the list, after the last step. You can then add other
elements, such as paragraphs if needed.

Check out this video as an example of how to add an image (the same principle applies if you want
to add a table or anything else):

Adding an image to a procedure step

Optional and Required Steps in Procedures
Abstract

You can mark up steps so that they are optional or required. To do this, you use the performance
attribute. Paligo then gives the steps an optional or required class that can be styled differently in
HTML outputs by using CSS.

When you are writing step-by-step procedures, you may have some steps that are optional and
some that the user must complete. To make these steps stand out, you may want to style them
differently, and this requires the steps to be marked up differently in Paligo XML.

You can use the performance attribute to set a step to optional or required. When you publish to
HTML, the step will have a class name for optional or required, so that it can be styled differently
using CSS.

NOTE
Optional and required steps can only be styled differently for HTML outputs. If
you need different styling for PDFs, a customization is required.
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To use the performance attribute:

1. (Optional) Create a procedure with steps.

2. Select a step. In the element structure menu, select the step element and then select Go to
element.

3. In the Element attributes section, search for the performance attribute and then add it.
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NOTE
If the performance attribute is not shown, check that you have selected the
step element and not the para element that is inside the step.

4. Set the value of the performance attribute to:

• Optional for steps that are not a requirement. The user can choose whether they want to
complete these steps.

• Required for steps that the user must complete.

5. Select Save.

6. Create a custom CSS file and add the styling for the optional and required steps to it. The
classes you need to style are .step.optional and .step.required. For example, the following
code adds "(Optional)" or "(Required)" before the paragraph in the step and also sets the font
to bold.

.step.optional p:first-child:before { 
    content: '(Optional) '; 
    font-weight: bold; 
}  

.step.required p:first-child:before { 
    content: '(Required) '; 
    font-weight: bold; 
}

This example only works for English. But it is possible to have multi-lingual support with CSS:

/* For supporting multiple languages: */  

html[lang="sv"] .step.optional p:first-child:before { 
    content: '(Valfritt ) '; font-weight: bold; 
}  
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html[lang="en"] .step.required p:first-child:before { 
    content: '(Required) '; font-weight: bold; 
}  

html[lang="sv"] .step.required p:first-child:before { 
    content: '(Obligatoriskt ) '; 
    font-weight: bold; 
}

7. Upload your CSS file to your HTML layout.
To find out more about creating custom CSS files and uploading them to your HTML layouts,
see Branding your HTML Outputs with CSS [654].

8. Publish to HTML [1068], using the HTML layout from the previous step.

Sublists
When you are writing lists and procedures, you may find that you want to have a series
of substeps inside a main step. For example, you might have a procedure with step-by-step
instructions, and inside step 2 you want to have a bullet list of the options a user can choose from.

To create these "indent" lists, you can use the Indent option on the toolbar. Alternatively, you can
use the element context menu to add the relevant elements.

The following sections explain how to work with indented sublists.

Create an Indented Sublist
To indent list items or steps:

1. Create the your main list or procedure. When you get to the position where you want to add
an indented list, add the first step/listitem as though it was part of your main list.
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2. Select the listitem/step that is going to be in your indent list. Then select the Indent icon on
the toolbar. Paligo indents the step. For most of the list types, the indented step is now part
of another sublist. Procedures are slightly different as they become steps inside a substeps
element.
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3. To continue the sublist, select the end of the the sublist step/listitem and press Enter.
Paligo will create extra indented listitems/steps for you.

4. Add content to the sublist in the same way that you would add content to the main list.

5. To exit the sublist and return to the main list, position the cursor after the last step in the
sublist and outside the sublist structure. Then press Enter to display the element context
menu. Select the option for the next type of listitem/step in the main list.

6. Select Save.

Convert a Sublist into a Different Type of List
If you want to change the type of sublist:

1. Select a listitem/step in your sublist.

2. Look at the element structure menu.
There is a main list element (1) and a sublist element (2).

The name of the sublist element will vary, depending on the type of the main list. For example,
for an orderedlist, the sublist is another orderedlist, but for procedures, the sublist is
called substeps.

3. Select the element for the sublist and then select Go to element.

4. Select the toolbar icon for the type of list you want, such as an itemized list. At the prompt,
confirm that you want to change the type of list.

Convert a Sublist into Items in the Main List
To convert a sublist into listitems/steps in the main list:
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1. Select any step/listitem in the sublist.

2. Select the Outdent toolbar icon.

Alternatively, you can use the keyboard shortcut.
For Mac OS it is:

Option ⌥  Shift ⇧  T

For Windows it is:

Alt  Shift  T

Outdent a Sublist
To convert a sublist into listitems/steps in the main list:

1. Select any step/listitem in the sublist.

2. Select the Outdent toolbar icon.
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Alternatively, you can use the keyboard shortcut.
For Mac OS it is:

Option ⌥  Shift ⇧  T

For Windows it is:

Alt  Shift  T

Tasks
Tasks are a more formal structure for step-by-step procedures. They have a title and a procedure
by default, and you can also add other task-exclusive elements to them, including:

• tasksummary

Use to add a summary of the task, typically before the task's procedure. This gives readers an
understanding of what they will achieve.

• taskprerequisite

Use to add information about the things that need to be in place before the user starts the
procedure. This could involve information about licenses, types of user account, subscription
plans, or confirmation that other tasks have already been completed.

• taskrelated

Use to add links to related tasks. This is usually added before or after the task's procedure.

Should you use tasks instead of the regular procedures? It depends on the structure you want for
your step-by-step instructions. If you want your procedures to have a title and any of the other
task-related structural elements, use a task. But some people find this to be too structured, and
they prefer to have no title and just the list of steps that comes with a regular procedure.

NOTE
Some of the task elements may require a customization for styling in PDF outputs.
For HTML outputs, you can style the elements with CSS (see Branding your HTML
Outputs with CSS [654]).

To learn how to add tasks to your topics, see Create a Task [211].

Create a Task
Use task elements to create a more formal structure for step-by-step procedures, where there is
a task title as well as the procedure. You can also add other task-related elements.

To create a task:

1. Create a new topic [131] or edit an existing one by selecting it in the Content Manager.
Alternatively, you can create or edit an informaltopic (see Create an Informal Topic [1109]).

2. In the topic, position the cursor so that it is at a valid position for a task element. This is similar
to other types of list, where the cursor has to be between block elements, for example, after a
para element but before the next para element.
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3. Use the element context menu to add a task element.

To access the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

Paligo adds a task element. It has a title element and a procedure element with a step
inside it.

4. Enter the text for the task title and the procedure steps. To add another step, press Enter
at the end of the currently selected step.
You can also add other elements, for example, you might want to add a para element for
some text between the task title and the procedure. To do this, place the cursor at the
end of the title and press Enter. You can then use the element context menu to add other
elements.

5. To add a tasksummary element, position the cursor so that it is inside the task structure,
between two block elements. Then use the element context menu to add a tasksummary
element.
If the tasksummary element is not available in the element context menu, the cursor is not in
the correct position.

6. Select inside the tasksummary element, and then use the element context menu to add
elements. This could be one or more para elements for text, or you could add other types of
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content structure such as itemizedlist for a bullet list. Enter the content for the summary
in the elements.

7. To add prerequisites, position the cursor so that it is inside the task structure, between two
block elements. Then use the element context menu to add a taskprerequisites element.
Paligo adds a taskprerequisites element, and inside that there is a para element. Enter
text in the para. You can also use the element context menu to add other elements inside the
taskprerequisites element, such as an itemizedlist.

8. To add taskrelated elements, position the cursor so that it is inside the task structure,
between two block elements. Then use the element context menu to add a taskrelated
element.

9. Select inside the taskrelated element. Then use the element context menu to add other
types of content structure, such as para elements or an itemizedlist. Typically, you would
use these to add text and you can then add links by using the Insert > Link menu in the
toolbar.
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10. Select Save.
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NOTE
The tasksummary, taskprerequisites, and taskrelated elements are all
optional. You can also add other types of content structure inside a task, such
as an example. The element context menu provides access to those elements
that are valid at the cursor's current location.

Here, we have covered the elements that are only available for use in a task.

Task Example
In this example, we'll guide you through the steps for creating a task in an informaltopic. The task
will have a task summary, prerequisites, and related tasks. You will learn how to add the various
task elements and then you can apply the same techniques when creating your own tasks.

Example 22. Create a task that has a task summary, prerequisites, and
related tasks

1. Create an informaltopic. You could use a regular topic instead if you prefer. The
informaltopic has a para element inside it by default. That's not needed for the task, so
delete the para element.

2. Next, use the element context menu to add a task element.

To access the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).
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When you add the task element, Paligo adds a task, and a title and a procedure inside
the task element.

3. Enter the text for the title.

4. Position the cursor after the task's title element but before the next element (procedure,
in this case). Then use the element context menu to add the tasksummary element.
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5. Select the tasksummary element and then use the element context menu to add an element
for your summary content. There are many different types of element that you could use
here, as explained in the DocBook schema, see DocBook task summary.
For this example, use the para element and enter your summary text in that.

6. For prerequisites, place the cursor after the tasksummary but still inside the task element. In
the element structure menu, you should see that task is the last element shown.
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Then use the element context menu to add the taskprerequisite element.

7. Select the taskprerequisite element and use the element context menu to add the
elements you want to use. There are many possibilities here, including different types of list
and paragraph elements too.
For this example, add a paragraph with the text "Prerequisites" followed by an itemized list.
Add the prerequisites as list items.

8. Enter the text for your procedure steps. Press Enter at the end of a step to create the next
step in the procedure, or you can manually add a step and a para element for each one if
you prefer.

9. For related tasks, add the taskrelated element. For this example, add it after the
procedure and use it to add links to other related tasks. Then select the taskrelated
element and use the element context menu to add the elements for a paragraph and an
itemized list. Insert links to other topics as list items.
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10. Select Save.
You should now have a complete and valid task. In the underlying code, which you can see in
the source code editor, the task should look something like this:

<?xml version="1.0"?>
<sidebar xmlns="http://docbook.org/ns/docbook" xmlns:xinfo="http://
ns.expertinfo.se/cms/xmlns/
1.0" xml:id="UUID-9fa6db45-2e2d-09b6-11f5-2bda3215f17b" version="5.0" \
xml:lang="en" \
xinfo:resource="UUID-9fa6db45-2e2d-09b6-11f5-2bda3215f17b" \
xinfo:resource-id="110111" xinfo:resource-type="component" \
xinfo:resource-subtype="informaltopic" xinfo:resource-title="Replace \
ACME 100 Battery" xinfo:resource-titlelabel="" xinfo:version-major="1" \
xinfo:version-minor="0">
  <task>
    <title xinfo:text="110123">Replace ACME 100 battery</title>
    <tasksummary>
      <para xinfo:text="110124">How to replace the battery in an ACME \
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100 device.</para>
    </tasksummary>
    <taskprerequisites>
      <para xinfo:text="110125">Prerequisites:</para>
      <itemizedlist>
        <listitem>
          <para xinfo:text="110126">ACME 100 replacement battery</para>
        </listitem>
        <listitem>
          <para xinfo:text="110127">ACME 100 unit key</para>
        </listitem>
      </itemizedlist>
    </taskprerequisites>
    <procedure xml:id="procedure-idm4679030963721632366065195995">
      <step>
        <para xinfo:text="110128">Use the ACME 100 unit key to unlock \
the 4 corner locks on the rear panel of the ACME 100. Turn the key \
anticlockwise to unlock.</para>
      </step>
      <step>
        <para xinfo:text="110129">Press the release latch and then \
gently pull the cover towards you.</para>
      </step>
      <step>
        <para xinfo:text="110130">Remove the battery from the ACME 100 \
device.</para>
      </step>
      <step>
        <para xinfo:text="110131">Insert the replacement battery, \
making sure that the positive and negative terminals of the battery are \
positioned correctly. The battery compartment has plus (positive) and \
minus (negative) markings to show the appropriate connections.</para>
      </step>
      <step>
        <para xinfo:text="110132">Close the hatch and make sure the \
latch clicks into place.</para>
      </step>
      <step>
        <para xinfo:text="110133">Use the ACME 100 unit key to lock the \
corner locks.</para>
      </step>
    </procedure>
    <taskrelated>
      <para xinfo:text="110152">See also:</para>
      <itemizedlist>
        <listitem>
          <para xinfo:text="110153">
            <link xmlns:xlink="http://www.w3.org/1999/xlink" \
xlink:href="http://RANDOM">Recharge ACME 100 battery</link>
          </para>
        </listitem>
        <listitem>
          <para xinfo:text="110154">
            <link xmlns:xlink="http://www.w3.org/1999/xlink" \
xlink:href="http://RANDOM">Mains power for ACME 100</link>
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          </para>
        </listitem>
      </itemizedlist>
    </taskrelated>
  </task>
</sidebar>

NOTE
The XML ids will be different in your topic.

Checklists
Use the checklists feature to add a list of checkboxes to your HTML5 help center, Zendesk, or PDF
publications. The checklists work differently, depending on the type of publication.

In this article, we explain:

• How the checklists work in the different types of output, see Checklists in HTML5 Help Center
and Zendesk [222] and Checklists in PDF [223].

• How to create checklists, see Create a Checklist [224].

• How to set up your checklist so that it is pre-checked in PDF outputs, see Create a
Checklist [224].

NOTE
Checklists are only supported when publishing to PDF, HTML5 help centers, and
Zendesk. They are not supported when publishing to other types of output,
including other types of HTML.

Checklists in HTML5 Help Center and Zendesk
In HTML5 and Zendesk publications, each list item has a container with a clickable checkbox and a
close option that removes the step from view.
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Where (1) is the clickable checkbox, (2) is the close option, and (3) is the refresh option. The refresh
option returns the list to its original state, with all boxes unchecked and every checkbox in the list
made visible.

The following video shows how checkboxes are presented in HTML5 help centers and Zendesk.

https://paligo.wistia.com/medias/eahbpa8yfm

To find out how to make your own checklists, see Create a Checklist [224].

NOTE

• Make sure that your checklist has an xml:id attribute and value for the
itemizedlist root element. It will only work properly if it has an id. To find
out how to generate an id, see IDs for Cross-References [244]. You can also use
the Editor Settings [600] to set Paligo to generate ids for all lists automatically.

• This feature uses JavaScript that, in some browsers like Safari, will only run if
published on a web server. So if you test it locally, you may need to try another
browser first. But once published, it will work on all modern browsers.

• If you are publishing to Zendesk, make sure that in Zendesk's Guide Admin
settings, the Display unsafe content option is turned on. The HTML tags
needed for checklists are not included in Zendesk's list of "safe tags".

Checklists in PDF
In PDF publications, checklists appear as a list with a checkbox for each item. The checkbox is clear
by default, so that if your readers print out the PDF, they can physically check the boxes as they
complete each item. But if you prefer, you can set the boxes to be pre-checked, which can be a
good idea if you only want to indicate a checklist symbolically.
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To find out how to create a checklist and pre-set the checkboxes for PDF, see Create a
Checklist [224].

Create a Checklist
Use the checklist toolbar to create a checklist in a topic.

When you select the checklist toolbar icon, Paligo adds the first item in a checklist. You can add
text to that item and when you press Enter at the end, it will automatically create the next checklist
item. The checklist is actually an itemizedlist with a role attribute of checklist. So you could
also make one by adding an itemized list (i.e. bullet list or undordered list) and giving it a role
attribute with checklist as the value.
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To set the list to have pre-checked checkboxes for PDF outputs, select the itemizedlist element in
the element structure menu. Then add the value checked to the role attribute. Use a semicolon
as a separator, for example:

A checklist would usually be on the first level only, but it is possible to have nested checklists too.
Each checklist item can also contain any other content just like a regular list, such as images, other
lists, tables, etc. For these, add the block element, such as a list, inside the listitem.

To end the list, position the cursor outside the the itemizedlist and then you can add another block
element, such as a para. This approach is common to all lists.

You can then add extra content after your checklist, if needed. Save your topic when you have
finished.

NOTE
The checklist functionality only works if the itemizedlist element for the
checklist has an xml:id. To find out if it does, select the itemizedlist element in
the element structure menu and then look at the element atttibutes.

If there is an xml:id with a value, the list is fine. If there is no xml:id, you
can add one. To do this, we recommend that you select itemizedlist in the
elementstructure menu, then select the Generate id option.
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Question and Answer Lists (FAQs)
With question and answer lists, you can provide your readers with answers to popular questions,
all in one topic. These are useful for FAQ-style topics (Frequently Answered Questions).

TIP
If there are a high number of questions and answers, it can make your FAQ
difficult for readers to use. For this reason, it is a good idea to limit your FAQs
to popular questions only, and cover more specific questions elsewhere in your
content.

Of course, you could take that approach to all of your "customer questions" and
make sure they are answered in your regular content. Then there may be no need
for an FAQ at all.

Create a Question and Answer List (FAQs)
To create a topic containing a question and answer list (FAQs):

1. Create a new topic [131] or edit an existing one by selecting it in the Content Manager [34].

2. In the topic, use the element context menu to add the qandaset element. This is the
"container" element for all of your questions and answers.
When you add a qandaset element, Paligo automatically adds some of the "child" elements
that it needs for your questions and answers.

The structure is:

 <qandaset>
    <qandaentry>
      <question>
        <para><?placeholder Insert text?></para>
      </question>
      <answer>
        <para><?placeholder Insert text?></para>
      </answer>
    </qandaentry>
  </qandaset>

The important things to note here are that:

Paligo Documentation

226



• The qandaset is the "container" element for all of the questions and answers

• Each question and answer pair go inside a qandaentry element

• Each question consists of a question element and a para element inside it. You add your
text inside the para element.

• Each answer consists of an answer element and a para element inside it. You add your text
inside the para element.

3. Enter your text for the question and the answer.

4. To add another question and answer in the same list, you need to position the cursor
carefully. It has to be below the answer and at the position where qandaset is the last
element shown on the element structure menu.

5. Use the element context menu to add the qandaentry element.

To access the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

Paligo adds an extra question and answer pair.
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NOTE
If the element context menu does not allow you to search and find the
qandaentry element, it is because the cursor is not in the correct position.
Go back to step 4 and make sure that the cursor is in the correct place.

6. Repeat steps 3-5 inclusive to add all of the questions and answers for your list.

7. Select any part of the list and then select the qandaset element in the element structure
menu.

8. In the Element attributes section, add the defaultlabel element and set its value to either:

• none
The questions and answers will have no prefix. The question text is bold and the answer is
regular text.

• number
The questions are numbered.

• qanda
The questions have a Q: prefix and the answers have an A: prefix.

9. Select Save.
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When you publish your topic, the list will appear as a question and answer list. The questions will
use the formatting that you set for the defaultlabel attribute.

TIP
When publishing to HTML5, Paligo adds a list of links before the Q and As. The
links have the same text as the questions.

Add the below code string at the end of the layout CSS [654] to:

• Hide the links before the Q and As.

• Add a space between the Q and A labels and the text.

• Add spaces between the Q and As.

/* Styling for Q&A sets*/
div.qandaset ul
{display:none;  /* hides links Q-title */
}
div.qandaset
{margin-bottom:15px; /* space between Q&A set */
}
div.qandaset tr td p
{margin-bottom:5px; /* space between Q & A rows */
}
div.qandaset tr td:first-child 
{padding-right:5px; /* space after labels (e.g. "Q:")*/
} 

Control Numbering on Question and Answer Lists (FAQs)
By default, question and answer lists (FAQs) are numbered, as defined in DocBook XML. If you
prefer, you can set your question and answer lists to have no numbering or to use Q: and A:
prefixes instead.

To control the numbering:

1. Edit the topic that contains the qandaset list. Select any part of the list and then select the
qandaset element in the element structure menu.
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2. Use the Element attributes section to give it the defaultlabel attribute, and set the value of
the attribute:

• none
The questions and answers will have no prefix. The question text is bold and the answer is
regular text.

• number
The questions are numbered.

• qanda
The questions have a Q: prefix and the answers have an A: prefix.

3. Select Save.

When you publish the topic, the qanda list will use the formatting you have selected.

Add Sections and Titles to Question and Answer Lists (FAQs)
If you have lots of questions and answers, you may want to group them into different categories
rather than have one long list. To do this, use the qandadiv element.

NOTE
If you decide to use qandadiv sections, you need to use them for all of your
questions. You cannot have a mix of some questions inside a qandadiv and some
not (this is because it is not supported by the content model).

To add sections and titles in your question and answer lists:
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1. Create a Question and Answer List (FAQs) [226].
Your qandaset list should have a structure where qandaset is a parent element, with
qandaentry as a child. Your questions and answers should be children of the qandaentry.

NOTE
In this procedure, we explain how to add qandadiv sections to an existing
qandaset. But if you are creating a qandaset from scratch, you can insert
the qandadivs as you go along instead.

2. Select any part of the question and answer list and then select the qandaset element in the
element structure menu. Then select Go to element from the menu.
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3. Use the element context menu to add the qandadiv element inside the qandaset element.

To access the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

If the qandadiv option is not available in the list, then the cursor is in the wrong position. Go
back to the previous step and make sure you have selected the qandaset element.
When you add a qandadiv element, you can add a range of other elements inside it, as well
as the qandaentry elements. Typically, you will want to use a title inside the quandadiv
to give the section a heading, and then you can also add other elements if needed, such as a
para.
Paligo's element context menu provides a list of the elements that are valid at the currently
selected position. To find out more about the individual elements, refer to the Basic Element
Reference [1886].

4. Use the XML tree view to drag and drop the elements you want to be inside the qandadiv
part of your list. Your qandaentry elements need to be inside a qandadiv, as well as any
additional elements you want inside the qandadiv, such as a title and para.
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NOTE
When using qandadiv elements, all qandaentry questions and answers
need to be inside a qandadiv.

5. Repeat steps 2-4 for any further qandadivs.

6. Select Save.

When you publish the topic, it will look something like this (HTML version shown):
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Where you get:

1. A list of all the qanda sections and the questions in those sections

2. Sections of questions, where each section is a qandadiv element. In the image shown, the
sections also have titles.

3. A list of the questions in that section

4. The questions and answers in that section

For PDF outputs, you do not get the extra lists, only the sections and the questions and answers.

NOTE
To set numbering or letting for the questions and answers, see Control
Numbering on Question and Answer Lists (FAQs) [229]. To control the numbering
and/or styling of the qandadivs and their lists, use CSS. For PDFs, a customization
may be required, please contact customer support for details.

Example 23. Sample topic showing valid XML structure for qandaset that
uses qandadiv elements
The following XML shows valid structure for a qandaset that uses qandadivs, each with a title
and a single question and answer. Note that we have removed the XML ids from the code. If
you use the source code editor and then copy and paste this into a Paligo topic , when you save it,
Paligo will generate the XML ids automatically.

In the structure, note that every question and answer is inside a qandaentry. Each
quandaentry is inside a qandadiv, and all of the qanda-related elements are inside the
qandaset element, which acts as a "container".

<?xml version="1.0"?>
<section>
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  <title>ACME 100 Troubleshooting</title>
  <para>This article provides answers to some of the most common questions \
about ACME 100. To find an answer, go to the section that relates to your \
type of problem and then look to see if your question has been answered.</
para>
    <qandadiv>
      <title>Battery Troubleshooting</title>
      <qandaentry>
        <question>
          <para>How long is the battery life?</para>
        </question>
        <answer>
          <para>With normal use, the battery should last around 10 hours \
before it needs recharging.</para>
        </answer>
      </qandaentry>
      <qandaentry>
        <question>
          <para>When will I need to replace the battery?</para>
        </question>
        <answer>
          <para>Typically, batteries last around 2 years with normal \
usage.</para>
        </answer>
      </qandaentry>
      <qandaentry>
        <question>
          <para>How do I get a replacement battery?</para>
        </question>
        <answer>
          <para>Batteries and chargers are available on our website.</para>
        </answer>
      </qandaentry>
    </qandadiv>
    <qandadiv>
      <title>Controls Troubleshooting</title>
      <qandaentry>
        <question>
          <para>How do I change the temperature controls?</para>
        </question>
        <answer>
          <para>Go to Controls &gt; Temp &gt; Limits to change the \
temperature limits for the automatic temperature controls. For manual \
temperature controls, go to Controls &gt; Temp &gt; Manual.</para>
        </answer>
      </qandaentry>
      <qandaentry>
        <question>
          <para>How do I control the vents?</para>
        </question>
        <answer>
          <para>Go to Controls &gt; Vents &gt; to open or close the vents. \
Note that you cannot control the vents if they are set to be automatically \
controlled (see Auto &gt; Vents).</para>
        </answer>
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      </qandaentry>
    </qandadiv>
    <qandadiv>
      <title>Monitor Troubleshooting</title>
      <qandaentry>
        <question>
          <para>How do I monitor the temperature differences over a day?</
para>
        </question>
        <answer>
          <para>Go to Dashboard &gt; Temp to view the temperature charts. \
You can set the charts for 1 day, 1 week, 1 month, or 1 year of data.</para>
        </answer>
      </qandaentry>
      <qandaentry>
        <question>
          <para>How do I monitor the effects of cooling?</para>
        </question>
        <answer>
          <para>Go to Dashboard &gt; Cooling to view the cooling charts. \
You can set the charts for 1 day, 1 week, 1 month, or 1 year of data.</para>
        </answer>
      </qandaentry>
    </qandadiv>
  </qandaset>
</section>

Variable List (Description List)
A variable list is a list where each entry has one or more terms and a description. They have many
potential uses, but are often used for explanations of technical terms or jargon. When published,
they are shown in rows and columns, so they look like a borderless table, but they do not have the
underlying structure of a table. For HTML outputs, they use description list HTML tags (<dl>, <dt>
and <dd>).

Example of a variable list in PDF output.

NOTE
Variable lists have no relation to variable sets or variable content. The term
variable list comes from the DocBook specification, where variablelist is the
name of the element for this type of list.

To find out about variable sets and variable content, see Variables [1186].
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Create a Variable List
The variablelist element is a "container" for all of your terms and descriptions.

 <variablelist>
    <title></title>
    <varlistentry>
      <term></term>
      <listitem>
        <para></para>
      </listitem>
    </varlistentry>
  </variablelist>

• The variablelist has a title. This is optional and if you do not want it, you can remove it and the
variablelist will still be valid.

• Each term(s) and description pair go inside a varlistentry element

• Each term consists of a term element. You add the term text directly inside this element, there
is no para.

• Each description consists of a listitem element and a para element inside it. You add your
description text inside the para element.

To create a variable list (description list):

1. Create a new topic [131] or edit an existing one by selecting it in the Content Manager [34].

2. Position the cursor where the variable list is to be inserted.

3. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

4. Enter variablelist and select it from the menu.
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Paligo automatically adds a title for the variable list, one term and one description.

5. Enter a text for the title (or remove it).

6. Enter a text for the term and listitem (its description).

7. Position the cursor at the end of the description and press Enter to add another term.

Paligo adds another pair (term and description) to the list.

8. To end the list, position the cursor after the variablelist.

From this position, you can, if needed, use the element context menu to add additional content.

9. Select Save. 

Inline Elements and Symbols
There are many elements that you can use on parts of your text inside a paragraph, for example,
you can make a word appear italicized by using the emphasis element. These elements are inside
a block element, and so are known collectively as "inline elements".
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You can also insert special characters, such as symbols like @ and ©. Technically, these are not
inline elements, but they are similar as you can include them inside a block element such as a
para.

To find out about some of the common inline elements, see:

Emphasis [239]

NOTE
DocBook 5.1 has many other inline elements you can use in Paligo.

To find out about special characters and symbols, see Insert Symbols and Special Characters [241].

Emphasis
You can add emphasis (italic, bold or underline) to text in various elements, including para,code
and parameter. Italicization is used for gentle emphasis and bold is used for heavier emphasis.
Underline is a line drawn under the text, often used to create a blank to be filled in by hand or to
create a horizontal line.

It is possible to use italic, bold and underline on the content at the same time. However, if using
the emphasis attribute, the role value replace the default italicization. The solution is to use the
emphasis attribute in combination with the toolbar buttons or keyboard shortcuts.

In Paligo, you can add emphasis in three different ways by using:

• The buttons in the Editor Toolbar [52]

• Keyboard Shortcuts [576]

• The emphasis attribute

Add Emphasis
You can use Keyboard Shortcuts [576] or the buttons in the the Editor Toolbar [52] to add
emphasis (such as italic bold and underline) to the content.

1. Highlight the text that you want to be bold, italic or underline.

1 = Bold, 2 = Italic, 3 = Underline

2. Select the relevant toolbar buttonOR use keyboard shortcuts:

• Bold: Ctrl  + B  (Windows) OR Command ⌘  + B  (Mac)

• Italic: Ctrl  + I  (Windows) OR Command ⌘  + I  (Mac)
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• Underline: Ctrl  + U  (Windows) OR Command ⌘  + U  (Mac)

3. Select Save. 

Add Emphasis Attribute
You can use the Emphasis attribute to make the content bold, italic or underline. When adding
the emphasis attribute, the text becomes italicized by default. If adding a role, the value (bold or
underline) replace the default italicization.

If you want to use another emphasis when using the emphasis attribute, the solution is to use it
in combination with the Toolbar [52] buttons or Keyboard Shortcuts [576].

IMPORTANT
You can use emphasis on text that already has an inline element, such as code.
But it is important that the emphasis element is outside the inline element, for
example:

 <para><emphasis><code>code snippet content goes here</code></
emphasis></para>

1. Highlight the text that you want to be bold, italic or underline.

2. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

3. Enter emphasis and select it.
By default the text becomes italicized.

4. To make it bold or underlined, select the emphasis element or highlight the text that uses it.
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5. Add the role attribute and set its value to bold or underline in the element attributes
section.
The italicization will be replaced with the chosen value.

6. Select Save. 

Remove Emphasis
There are two ways to remove content formatting such as italic, bold or underline, either use the
button in the Editor Toolbar [52] or use Keyboard Shortcuts [576].

1. Highlight the text that you want to remove the formatting from.

2. Select Remove format in the Toolbar [52]. 

OR use the keyboard shortcut:

• Alt  + Shift ⇧  + F  (Windows)

• Option ⌥  + Shift ⇧  + F  (Mac)

3. Select Save. 

Insert Symbols and Special Characters
To insert symbols and special characters in your topics, you can use the toolbar:

If the character you need is not available in that map, you can also insert any character available
using the standard method for your operating system, as described e.g here: How to Quickly Type
Special Characters on Any Computer, Smartphone, or Tablet.

If the special characters you need are actually part of an equation, you should use an equation or
inlineequation element instead, and use the built-in Math Editor [58].

Cross-References and Links
Links and cross-references are used for different purposes in Paligo:

• a Cross-reference is usually a type of link that points inside the publication. Which means
that the source topic and the target topic are both included in the publication. However a
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cross-reference can also reference Paligo content outside the publication (cross-publication
links) when supported by outputs like Zendesk or Fluid Topics.

• a Link points outside the publication, like a website or documents stored on the web.

We recommend that you only use cross-references where necessary. This is because with cross-
references, you create dependencies. If one topic links to another, both of those topics need to be
included in a publication, otherwise the link will not work. As a result, the topics are dependent on
each other and this makes it more difficult to reuse them independently.

In your topics, you can add cross-references or links to Other topics [248], Elements in the same
topic [253], Elements in other topics [250], Web sites or documents [254] that are stored on the
web, Files that are stored locally, such as PDFs [255] (for HTML outputs) and Email addresses [255].

You can also use images as links [266] and use links to embed GoogleDoc and OneDrive
documents [262].

TIP
If you already have a cross-reference and you need to change it, see Edit a Cross-
Reference Link [262].

Change Default Link Behavior
By default, external links are opened in a new browser window in HTML / HTML5 output. To
change the default value for all external links the layout settings have to be updated. There are
four available options:

• _blank - Will open the link in a new browser window. Default setting

• _self - Will open the link in the same browser window.

• _parent - If the link is nested inside other frames, it will open the closest frame (one level up) in
the browser window.

• _top - If the link is nested inside other frames, it will open the initial webpage (the topmost /
outermost frame) in the browser window.

The following instruction describes how to change the default link behavior for external links to be
opened in the same browser window.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.
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2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Cross-references in the left menu.

4. Scroll down to Open external website links in new tab or window section.

5. Select _self from the menu.

6. Select Save.

Update Individual Link Behavior
It is possible to override the default link behavior for individual links by adding the attribute
xlink:show. The following values can be selected for this attribute:

• New - Will open the link in in a new browser window. This is similar to the effect achieved when
using _blank in the Layout settings.

• Replace - Will open the link in the same browser window. This is similar to the effect achieved
when using _self in the Layout settings.

• Embed - This value specifies that instead of linking to the resource, it will be loaded and shown
within the document. This is similar to the effect achieved by an HTML Image tag. Only for
customizations

• Other - This value indicates that other markup is present in the link, which means that
the target attribute determines its behavior. Only for customizations

• None - This value specifies that there is no indication for how to refer to the linked resource.
Only for customizations
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The following instruction describes how to change an individual link to be opened in a new
browser window.

1. Select the link in the topic.

2. Add the xlink:show in the Element Attributes Panel [55].

3. Select new from the menu.

4. Select Save. 

IDs for Cross-References
Paligo content is stored in a database and each element can have its own unique ID. Certain types
of content, such as paragraphs, images and variables have a special type of ID called xinfo and
this is always generated by Paligo. Other elements can have an optional ID called xml:id and
these can be generated automatically by Paligo or manually by you.

Cross-references in Paligo use the id to identify the target of the cross-reference. Paligo creates
the id automatically for some types of cross-reference, primarily those to components that can
have a title. It is added as an xml:id attribute. But you may need to add an xml:id attribute
manually for cross-references to other types of content. This applies to cross-references between
topics and also cross-references to content inside the same topic, for example, to a subsection.

In most cases, we recommend that you cross-reference to a:

• Section

• Subsection - a section inside another section

• A structure that can have a title, such as a table.

NOTE
If you want to cross-reference to a different type of content, that is only possible
if that content has an xml:id. So you may need to Manually Generate IDs for
Cross-references [244] before you can link to it.

It's also possible to set Paligo to auto-generate xml:ids , see Auto-Generate IDs
for Cross-References [246] .

Manually Generate IDs for Cross-references
You can only add cross-references to elements that have an xml:id. If the element you want to
reference does not have an xml:id, you can generate one manually. Paligo has a feature in the
editor that generates a suitable id for you. It's not a good idea to make up your own id values, as
ids should be unique.
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TIP
You can set Paligo to auto-generate the xml:ids, see Auto-Generate IDs for
Cross-References [246].

To generate a unique xml:id for an element:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select the target element In Element Structure Menu [52] and choose Generate ID.
For example, if you want to link to a procedure, select the procedure element.

Paligo generates an xml:id for the element in the Element Attributes Panel [55]

3. Select Save. 

NOTE
You should now be able to add a cross-reference to the element, see:

• Add Cross-References to Elements in the Same Topic [253]

• Add Cross-References to Elements In Other topics [250]
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Auto-Generate IDs for Cross-References
When you save a topic, Paligo can give automatically-generated IDs to new elements. This is a
useful feature as IDs are needed for cross-references. This will save you the time and effort of
having to add the xml:ids manually.

You can use the editor settings to control which types of element will get auto-generated IDs. The
settings that you choose will apply to all topics and all users of your Paligo instance. Typically,
we find that auto-generating xml:ids for the following elements is sufficient for most users (if
needed, you can add more elements to the list):

section figure table example equation procedure bridgehead sidebar note \
warning caution tip important

NOTE
A new element is an element that has been added to a topic since the last time
the topic was saved. Paligo only creates auto-generated IDs for new elements, any
elements that already existed in the topic do not get auto-generated IDs.

To choose which elements get auto-generated ids:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select the cog icon in the Toolbar [52]. 

3. Select the Global settings tab in the Editor Settings [600].
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4. Add the names of elements that should get auto-generated xml:ids in the Autogenerate ID
field.
Use a space to separate each element name and make sure to add the element names in
lower case.

NOTE
We recommend not remove any of the default elements and only add to
them if needed. In many cases, linking to a section element is sufficient to
guide the reader to the relevant information.

CAUTION
If you change the default settings for which elements should get an auto-
generated id, we recommend you only include the larger block element
structures.

Do not include elements such as para and title, as that could cause issues
with duplicate ids when you reuse text fragments.

5. Select Save Settings.

TIP
It is also possible to manually generate xml:ids via Element Structure Menu [52],
see Manually Generate IDs for Cross-references [244]
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Add Cross-References to Other Topics
In a publication, there is a structure that references all of the topics (and sub-publications) that
exist in the publication. Each reference to a topic or sub-publication is called a "fork" and has its
own fork:id. This is just for identifying the connection between the publication and the topic /
sub-publication and point out its position. It is not the same as the topic's own xml:id.

For example, if you have a "Safety" topic that appears three times in the same publication, you
can link to the fork for the second instance and the link will go to the second "Safety" topic. If you
linked to the topic instead of the fork, the link would always go to the first instance of that topic.

NOTE
It is possible to add cross-references to elements inside other topics, see Add
Cross-References to Elements In Other topics [250].

1. Open the topic you want to add a cross-reference in.

2. Position the cursor at the insertion point.

3. Select the Insert tab in the Toolbar [52].

4. Select Link and choose Cross-reference.

TIP
Or skip step 3 and 4 and use the keyboard shortcut Alt  + R  (Windows) or

Option ⌥  + R  (Mac) to add the cross-reference.

5. You can enter your own text in the Link Label field or leave it blank if you want Paligo to use
auto-text.
To find out more, see Auto-Text for Cross-References [257].

6. Locate the target in the tree structure or use the quick search.
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TIP
Make your search more efficient by selecting which resource types to search
for.

7. Select whether to make the cross-reference towards the topic or a fork.

• Topic 
If the target topic for the link only appears once in the publication, then you can link to the
topic. This creates a link that uses the xml:id of the topic. To add a topic reference, select
the topic with the black icon. Paligo recommends this approach because the links will work
when content is reused in other publications and also for topic branches.

• Fork 
If the target topic appears multiple times in the same publication, you should link to the
fork instead. By linking to the "fork" you link to the position of the topic in the publication
structure by using the fork:id. To add a "fork" reference, expand the publication and
select the "fork" with the grey icon. It is important to know that fork links only work within
the publication they originate from.

Paligo adds a cross-reference to the title of the selected topic or fork.

8. Select Save. 

Paligo Documentation

249



NOTE
If you want to change the cross-reference text or apply auto-text, select it
to display the cross-reference editor. You can use that to enable or disable
auto-text and change the text of the label. For details, see Auto-Text for Cross-
References [257].

Add Cross-References to Elements In Other topics
You can use Insert > Link > Cross-reference to add a cross-reference to a specific element in
another topic. But this is only possible if the element being linked to has an XML ID. If it does not
have an XML ID, you will need to edit the target topic and give the element an XML ID.

TIP
We recommend that you use cross-references between topics only where
necessary, to avoid dependencies. Cross-references only work if the source topic
(that contains the cross-reference) and the target topic are both included in the
publication. For this reason, using cross-references between topics can affect the
reuse possibilities for your topics.

To add a cross-reference to an element in another topic:

1. Open the "target" topic in the Paligo editor. The "target" topic is the topic that contains the
element that you want to cross-reference.

2. Select the element that you want to cross-reference and look in the Element attributes
section.

If the element has an xml:id value, you can cross-reference it from another topic.
If the element does not have an xml:id, you need to get Paligo to generate one. Select the
element in the Element Structure Menu and then select Generate ID. Paligo will create an
xml:id for the element.
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For more details, see IDs for Cross-References [244].

3. Select Save.

4. Open the "source" topic in the Paligo editor. The "source" topic is the topic that will contain a
cross-reference to the "target" topic element.

5. Select Link and choose Cross-reference.

6. You can enter your own text in the Link Label field or leave it blank if you want Paligo to use
auto-text.
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To find out more, see Auto-Text for Cross-References [257].

7. Select whether to make the cross-reference towards the topic or a fork.
Select the arrow next to the topic to expand it and reveal its elements.

8. Select the element you want to cross-reference.
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NOTE
Cross-references to listitem elements inside bullet lists and ordered lists
(numbered lists) may produce unusual results or be excluded from your
published output completely. For these, we recommend that you reference
a title element instead and explain which step you are referring to.

Paligo does support cross-references to steps in procedures, and these will
come out as "Step n" in the published output. We recommend that you also
add some text with a cross-reference to the title of the target topic, so that
your readers have more context. For example, "see Step 4 in Installing the
battery", where "Step 4" is a cross-reference to the step and "Installing the
battery" is a cross-reference to the target topic's title.

Paligo adds the cross-reference to your topic.

NOTE
Cross-references to procedure steps do not show as "Step n" in the editor.
The link to the target topic and element is converted into "Step n" when you
publish.

9. Select Save.

If you want to change the cross-reference text or apply auto-text, select it to display the cross-
reference editor. You can use that to enable or disable auto-text and change the text of the label.
For details, see Auto-Text for Cross-References [257].

Add Cross-References to Elements in the Same Topic
To add a cross-reference to an element that is elsewhere in the same topic:

1. Select Insert> Link > Cross-reference to display the New Cross-Reference dialog.

For a cross-reference, you can also use the keyboard shortcut ( Alt  R  on Windows, Option

⌥  R  on Mac).

2. In the Link Label field, enter the text that you want to be shown for the link. This is what the
reader will see as the text for the link in the topic. You only need to enter a label if you want
the link text to be different to the title of the topic.
If you want the link text to be the same as the topic title, leave the Link Label field empty
(blank).
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NOTE
If you are adding a link to a step in a procedure, leave the Link Label field
empty. Auto-text is needed for referencing the number of a step.

Also note that when you add the cross-reference, it will appear as a code
reference. When you publish, this will be replaced by the step number.

3. Use the Internal tab to choose the element you want to link to.
The Internal target tab contains a list of all of the elements inside your topic that currently
have an XML ID. Any elements that do not have an ID are not listed.
If the element you want to link to does not have an XML ID, you can generate an ID manually
(see IDs for Cross-References [244]).

NOTE
To link to a subsection heading in a topic, choose the section element of the
subsection. Do not choose the title element as the link should be to the
section as a whole, not just the title.

Add Cross-References to Websites and Documents
You can add cross-references to websites and documents that are hosted on the web. These
cross-references use the address (URL) of the website/document.

1. Select Insert> Link > External Website to display the New Website Link dialog.
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2. In the Link Label field, enter the text that you want to be shown for the link. This is what the
reader will see as the text for the link in the topic. You only need to enter a label if you want
the link text to be different to the URL of the website or document.
If you want the link text to be the same as the URL, leave the Link Label field empty (blank).

3. In the Link Target field, enter the URL for the link.

TIP
By default, external links to other web sites open in a new browser tab in
HTML/HTML5 output. If you want an external link to open in the same tab,
add an attribute called @xlink:show in the Attributes panel. Set the value to
"replace".

Add Links to Email Addresses
You can add a link to an email address in your content. When the reader selects the link, their
default email application will open and a new email is created, with the link email as the address in
the To: field.

1. In a topic, enter the email address or other text that will act as the email link.

2. Highlight the text and then select Insert> Link > Email address.

3. Enter the Email address that will be added to the To: field in a new email.

4. The Label shows the link text you have entered and highlighted in your topic. If you want to
change it, you can edit it in the Label field.

5. Select Insert to add the link.

Add Links to Local Files from HTML Output
When you are writing your topics in Paligo, you can add links to external files that will be stored
locally, rather than stored on the web. For example, you might want to link to a PDF file that you
store in a folder that is added to your output files after publishing.

To link to a local file, use the external website link feature and edit the link:
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1. Create or edit the topic [131] that is going to contain the link to the PDF file (or other local file).

2. Select Insert> Link > External Website to display the New Website Link dialog.

3. In the Link Label field, enter the text that you want to be shown for the link. This is what the
reader will see as the text for the link in the topic. You only need to enter a label if you want
the link text to be different to the URL of the website or document.

4. In the Link Target field, enter the location and name of the file you are linking to. For
example, "mypdfs/my-local-file.pdf".
You do not have to include a folder name. We have included "mypdfs" here as an example to
show that folder names can be included.

NOTE
If you want to use a relative link, edit your Layout so that the Use a short
and flat URL structure for output files option is enabled. This will create an
output with a flat structure, where all HTML files are in one folder.

5. In the element attributes for the link, you will see that Paligo has added an xlink:href attribute.
It's value is the link target you entered in the previous step, with http:// automatically added as
a prefix. Remove the http:// prefix as you want to link to a local file, not a web address.

xlink:href with http:// prefix. This should be removed for links to local files.
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xlink:href with http:// prefix removed, so that the link will go to a local file.

6. Save the topic and then publish it.

7. After publishing, add the local files (PDF etc.,) to the location that you defined as the link
target.

Auto-Text for Cross-References
With cross-references, you can enter your own text (referred to as a label) or, for some elements,
you can use Paligo's auto-text feature. The auto-text that Paligo adds varies depending on the type
of element you are cross-referencing.

If you cross-reference any of the following elements, the auto-text uses the text from the title of
the element:

• table

• equation

• example

• procedure

• figure

If these elements do not have a title element, enter your own text and do not use the auto-text
feature for the cross-reference.

For most other elements, the auto-text will use the title of the parent section. For example, if
you cross-reference a paragraph in a topic, the auto-text will use the title for the topic.

If you cross-reference a step in a procedure, auto-text will come out as "Step n", where n is the
number. We recommend that you also add a cross-reference to the target topic's title so that
the user has more context about where the step is located.

NOTE
The text shown in the Paligo editor is not necessarily what you will see in the
published output. For example, cross-references to a step in a procedure appear
as a link to the target topic in the editor but are converted to "Step n" as part of
the publishing process.

To change the text for a cross-reference, select it to display the cross-reference editor. There, you
can edit the label in the field and use the Auto checkbox to enable or disable auto-text. You can
only edit the label if Auto is disabled.
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TIP
You can customize the auto-text generated for cross-references and links,
see Cross-Reference Styling (PDF and HTML5) [669].

Automatic Links to Related Topics
You can set Paligo to create automatic links to other related topics. The links appear at the bottom
of a topic and help readers to find other relevant information. Using automatic links is much easier
and quicker to set up and manage than using manually-entered links.

There are two types of automatic links:

• TOC-based automatic links, which, by default, appear below an "In this section" heading. These
are links to topics that are "children" of the topic.

• Taxonomy-based automatic links, which give you control over the relationships between topics.
By default, these links appear below a "See also" heading.

To learn how to set up both types of automatic links, see the sections below.

TOC-Based Automatic Links (In this Section Links)
In HTML5 outputs, Paligo automatically adds links to related topics at the bottom of certain pages.
They are shown below an "In this section" heading and they link to any topics that are "children"
of the current topic.

In the following images, the contents sidebar shows that "The Mission Control Center" is the
currently displayed page and it has three "child" topics, which are "Command Center", "Guidance
System" and "Ground Segment". As the page has "child" topics, Paligo automatically adds an "In
this section" to the bottom of the topic, and it contains links to the three child topics.
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If you want to stop the "In this section" links from appearing, you can hide them using CSS:

1. Use a CSS editor to create a CSS file, and add the following CSS to it:

section-toc section-toc-after {
display:none;
}

2. Save the CSS file and upload it to your HTML5 Layout.

1. In Paligo, select Layout and then select the Layout that you want to use for your HTML5
output.

2. In the Layout Editor, select CSS, JS, logos and other assets.

3. In the CSS field, upload your CSS file and then select Save.

When you publish your content using the HTML5 Layout, the CSS is included in the output and the
"In this section" heading and links will no longer appear. If you want to make them appear, upload
a CSS file that does not contain the CSS you added in step 1 and republish.

Taxonomy-Based Related Topic Links (See Also Links)
Taxonomy tags are labels that you can add to any topic. You can use them to categorize your
topics and also to get Paligo to create automatic links between topics in HTML5 outputs. The
automatic links appear in a "See also" section at the bottom of a topic.

For example, if you have several topics about batteries, you might create a "Battery" taxonomy tag
and add it to each of the battery-related topics. Then you can set Paligo to create automatic links
between the topics. Each of the topics will have a "See also" section at the bottom with links to the
other topics that have the "Battery" tag.
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To learn how to create taxonomy-based links, watch the video or refer to the instructions below.

https://player.vimeo.com/video/333695199

1. In the Content Manager, open the Taxonomy Manager and then open the Taxonomies
branch.

2. Select the option button ( ... ) for the Taxonomies branch, and then select Create taxonomy
tag.

3. Enter a name for your taxonomy tag. This can be any name, and it is going to be the top-level
taxonomy tag, also known as the "parent". We recommend that you call this tag "See Also
Links" or something similar.

4. Select the option button ( ... ) for the "parent" taxonomy tag you created in steps 2 and 3, and
then select Create taxonomy tag.

5. Enter a name for your new taxonomy tag. This tag is a "child" of the "parent" tag in the
taxonomy hierarchy, as it has a direct relationship with the "parent" tag but is at a lower level.
Give the "child" tag a meaningful name that categorizes the type of content. For example, if
you were creating tags for mobile phone documentation, you might have a tag for "Battery".
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6. Repeat steps 4 and 5 to create as many "child" taxonomy tags as you need. Each "child"
taxonomy tag will be used to define a relationship between your topics. For example, imagine
you have a "Battery" taxonomy tag and you add it to 5 topics. In your output, each of those
5 topics will have a "See also" section with automatic links to the other 4 topics that have the
"Battery" tag.
You now have a "parent" tag and one or more "child" tags.

7. Select the option button ( ... ) for the "parent" tag and then select Floating Content Panel.

8. Drag your "child" tags from the Floating Content Panel on to the relevant topics in the Content
Manager. Do not drag the top level "parent" tag on to a topic as this will stop the "see also"
links from working.

NOTE
You can find out which topics are associated with a taxonomy by double-
clicking on a taxonomy tag. Paligo displays details for that taxonomy tag,
including the names of the topics that use it.

9. Select Layout and then choose the Layout that you will use to publish your content.

10. In the Layout Editor, select Classes and attributes.

11. Set Output taxonomies to Enable.

12. In the Relationship taxonomy section, enter the name of the "parent" taxonomy tag. If you
want to include several taxonomy tags, separate each taxonomy tag name with a semicolon.
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When you publish, Paligo will search in the "parent" taxonomy tag for any "child" tags. It
will then find any topics that use these "child" tags and create "see also" links for them
automatically. The links that are added will be to other topics that also use the same
taxonomy label.

13. Set Output role attribute as class names to Enable.

14. In the TOC and chunking section, make sure that Use section TOC is set to Default, Before
or After.

15. Select Save.

16. Publish your content [1092] using the layout you edited. Paligo will create the "see also" links
automatically and add them to the bottom of the relevant topics.

Edit a Cross-Reference Link

1. When you have inserted the link, you have a popup toolbar to edit it when the link is selected:

If auto is checked (default), the link will automatically get the target topics's title as link text. If
you want another link text, just uncheck it and type directly in the link.

2. To edit the target of the link, just click the blue pen icon to the right. This opens a Content
Manager browser widget that shows you the currently selected target, and you can select
another one.

3. If you want to go to the target topic, just click the icon on the left.

TIP
You can customize the auto-text generated for cross-references and links,
see Cross-Reference Styling (PDF and HTML5) [669].

Embed Google Doc or OneDrive Documents
You can embed a Google Doc or OneDrive document by using a special type of link.

1. You need to make your document available for embedding. The way to do this varies
depending on the type of document:
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• For a Google Doc, select File > Publish to the web in your Google Doc. Next, copy the
Link URL.

• For Google Slides, select File > Publish to the web in your Google Slides. Next, copy
the Embed link. You will need to edit this link before you use it in step 4. When editing,
remove the frame information. For example, let's say your embed link looks like this:

<iframe src="https://docs.google.com/presentation/d/e/
long_string_of_characters/embed?
start=false&loop=false&delayms=3000" frameborder="0" width="960" \
height="569" allowfullscreen="true" mozallowfullscreen="true" \
webkitallowfullscreen="true"></iframe>

You should remove <iframe src=" at the start and everything after /embed, so that the link
looks like this:

https://docs.google.com/presentation/d/e/long_string_of_characters/
embed

• For OneDrive:

a. Pick the file you want to embed by selecting the check box in the upper-right corner
of the file.

b. Select Embed at the top of the page, and then choose Generate.

NOTE
This feature is only suitable for documents and cannot be used for
images.

2. Insert a link element in your topic where you want to embed the document. It needs to be in
a para, but the para should only contain that link.

TIP
You can add link text to make it easier to see what it links to, but that text will
not be used in the output.

3. Add a @role attribute. For a Google Doc, set it to gdoc, and for a OneDrive document, set it to
onedrive.

4. Add an @xlink:href attribute and set the value to the embed URL.

NOTE

• The document will not be embedded in the topic inside the editor, it will only
show that there is one embedded. The embedding itself happens when you
publish.

• Embedding is only available for HTML5 or Zendesk output. For other formats a
regular link will be created.
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Reference an Info Element in a Regular Topic
There may be times where you want to edit a regular topic and add information that is stored in a
publication topic. For example, you may want to add the copyright year and holder to a topic.

One way to do this is to use a dynamic variable. This is a reference to another element.

1. Edit your regular topic.

NOTE
The topic needs to be part of at least one publication. When you publish,
Paligo will take the information from the publication's topic and insert it into
the dynamic variable.

2. Use the keyboard shortcut to add a dynamic variable.
The keyboard shortcut is:

• Windows:

Ctrl Alt  Shift  I

• MacOS:

Control ^ Option ⌥  Shift ⇧  I

Alternatively, you can add a phrase element and give it the role attribute with a value of:
dyntextvar

For more details, see Insert a Dynamic Text Variable [1205].

3. Enter the reference in the dynamic text variable. For a reference to the publication topic, use
this syntax:

${//d:article/d:info/d:<element>/d:<child element>}$

This structure applies for referencing the various info elements in a publication topic.

• d:article references the article element in the publication topic

• d:info references the info element inside it

• d:<element> references an info element, for example, d:pubdate

• d:<child element> references a child element of the previous element, for example,
d:copyright/d:year is a reference to the year element that is a child of the copyright element.

For example:

${//d:article/d:info/d:copyright/d:year}$

You can add text as well, for example, a common use of dynamic variables is to include the
copyright information. That could be a dynamic variable with text at the start and then the
reference to the copyright year and copyright holder elements.

Copyright © ${//d:article/d:info/d:copyright/d:year}$ ${//d:article/
d:info/d:copyright/d:holder}$
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NOTE
The information from the publication topic does not appear when you view
a topic in the Paligo editor. It is added when the topic is processed during
publishing.

4. Select Save.

When you publish the publication, Paligo will find the referenced elements and insert the values
from those into the dynamic variables.

Topic Search for Cross-References
When you add a cross-reference, you can use the New Cross Reference dialog to browse to the
topic or elements you want to link to. Alternatively, you can use its search feature.

1. Position the cursor where you want the cross-reference and then select Insert > Link to display
the New Cross Reference dialog. You can then use the External target tab to browse to the
topic you want to link to or you can use the Search field.

2. Select the arrow button on the search field to display the search filters.
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3. Use the checkboxes to filter your search.

• Document - If you check the box, Paligo will only search in topics, informaltopics, and other
"documents". If you clear the box, Paligo will search in "documents" and also folder names,
which is useful if you know the name of the folder that contains the content, but not the
name of the "document".

• Content - Check the box to search in the main body content of your topics. Clear it to
exclude the content from your search.

• Title - Check the box to search in the title element of your topics. Clear it to exclude the title
elements from your search.

• Filename - Check the box to search for the topic name or the publication name, rather than
its title.

• Enable autosearch - Check the box to turn on the autosearch feature. When you start
typing in the search field, Paligo will automatically find matches as you type. Clear the box to
disable this feature.

• Wildcard search - Check the box to allow wildcard characters such as * in the text that you
will enter in the search field. Wildcard characters can represent any other character. Clear
the box if you want Paligo to match by specific characters only.
Use an asterisk (*) to represent one or many characters, or use a question mark to
represent any single character. You can use these symbols anywhere in the search string.
For example, automati* would find both "automation" and "automatic", and automo?i?e
would find both "automobile" and "automotive".

4. Enter the text you want to search for in the Search field. Paligo will find the nearest matching
results and you can choose which one you want to link to.

Turn Images and Other Elements into Links
You can also make images work as links. There is however no selection dialog to insert that type of
link. You do it by adding the link target as an attribute on the image itself:

1. Select the mediaobject or inlinemediaobject element.

2. Add an @xlink:href attribute.

3. Add the target value using the following syntax:
urn:resource:component:31214.
The first part is always the same, and the last part (the numbers) is the id of the target topic.

TIP
You can get the id of the target topic by opening the Structure View for that
topic, where you find it at the top of the metadata.

Another way to get the entire link value is to simply make a regular ("dummy")
cross-reference, and then copy the value from there and then delete the
dummy cross-reference.

Manually Create a Fork Link
If an element is reused several times in a publication and you want to link to the element in a
specific topic to provide context to the reader, you have to manually create a fork link for your
PDF output.
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You can add cross-references to Elements [89] (images, paras, procedures, tables) reused in
components or topics, but it will point to where the element was initially created, see Cross-
References and Links [241].

When a topic or component is included in a publication, it gets a unique fork:id for that specific
instance in the publication. By adding the element xml:id to the fork:id, you get a fork link
that leads to the element in the reused position. The fork link will by default show the page
number within square brackets for PDF output. To style the cross-reference, see Cross-Reference
Styling (PDF and HTML5) [669].

NOTE
A manually created fork link only works in the publication it originates from.

To manually create a fork link:

1. Generate an xml:id for the target element, see Manually Generate IDs for Cross-
references [244].

2. Open the topic that will have the cross-reference.

3. Select Link and choose Cross-reference in the toolbar. 

4. Enter a Link label. (Optional).

5. Navigate to the publication.

NOTE
The cross reference dialog shows the targets both as part of the publication
and as topic (outside the publication tree). It is important to select the one in
the publication tree to get the fork link!

Learn the difference between topics and forks, see Topic or Fork [108].

6. Select the arrow in front of the topic to see linkable elements.
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7. Select the element to make it appear as a link in the topic. It will lead directly to the element
origin.

8. Copy the element xml:id (from the front slash "/" and forward) from the created link.

9. Redirect the cross-reference to point to the topic containing the reused component.
In our example it is "Battery disposal".

NOTE
The cross reference dialog shows the targets both as part of the publication
and as topic (outside the publication tree). It is important to select the one in
the publication tree to get the fork link!

Learn the difference between topics and forks, see Topic or Fork [108].

10. Paste the element xml:id after the topic fork:id in the Element Attributes Panel [55].
In our example, the Battery disposal fork:id is "urn:resource:fork:37742".

This fork link will now show the table in the reused position.

11. Select Save. 

12. Publish the topic as PDF to test the link. 
The preview is not able to visualize fork links.

Tables
Tables are a good way of presenting data and small pieces of information to your audience. In
Paligo, you can add tables to your topics and they can have multiple columns and rows, with
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optional titles, headers, footers, and footnotes. You can also create complex tables that have
merged cells that span across multiple rows or columns.

To learn about using tables in Paligo, first make sure you understand the difference between
Tables and Informal Tables [269]. You can then learn how to Create a Table [270], edit them so
that they have the appropriate rows and columns and also to Style a Table [1065].

By using Variables [1186] the same topic can be used for multiple products.

TIP

• To add or remove a table title, see Change the Table Type [288].

• Add footnotes to tables in the same way as you add them to regular
paragraphs. The footnotes will appear immediately after your table. To learn
how to set up them up in your topics, see Footnotes [394].

NOTE
Larger tables, especially wide tables, can be difficult to use. This is especially true
on smaller devices such as smart phones and tablets, but it also applies to larger
displays and printed documents. So when you are creating tables, consider your
audience and how they will use the information.

If you have large tables, you could consider breaking the tables up into a series
of smaller tables. These can make it easier for your readers to find and compare
the information. In some cases, it may be better to present the information in
different way, such as in a list format.

Tables and Informal Tables
Tables are useful for presenting data, such as specifications and comparison values. You can add
them to your Paligo topics, and the structure for the table will vary depending on whether you
want the table to have a title.

There are two different elements for table structures:

• table - A table with a title that appears in a caption element.

• informaltable - A table with no title.

When you Create a Table [270], you can choose to include or exclude a title. Paligo will then use
the appropriate element for the type of table you have created.
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NOTE
By adding or removing the caption element, you can:

• Convert Informal Tables to Tables [289]

• Convert Tables to Informal Tables [289].

A common use for these conversions is after an import from another format, such
as a Word document. The way the table is set up in the other format can affect
how Paligo recognizes it as a table or informal table.

Create a Table
This topic describes how to create a table via the Toolbar [52].

TIP
You can also create a default table by adding the table element or
informaltable element from the element context menu.

To display the Element Context Menu, press:

• Windows: Alt  + Enter ⏎

• Mac: Command ⌘  + Enter ⏎

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Position the cursor at a valid position for a table.

3. Select the Insert tab in the Toolbar [52] and choose Table to display a menu.

4. Select Insert table to display the table wizard.
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5. Use the table wizard to design the table. You can set:

• Table title
To give the table a title that will appear above the title, check the Insert a table title box.
Enter the text for the title in the Table title field.
To have a table without a title, clear the Insert a table title box.

NOTE
Paligo adds:

• Tables with a title as table elements.

• Tables without a title as informaltable elements.

• Table size
Enter the number of rows in the left field and the number of columns in the right field.

• Generate table header rows
If you want the table to have a header row, where you can enter a label for each column,
check the box. If you want a table with no header, clear the box.

• Generate table footer rows
If you want the table to have a footer row at the bottom, check the box. If you want a table
with no footer, clear the box.

• Table border (frame)
Set the type of border for the outside edge of the table. Choose from:

• void - No frame border.

• above - The top edge of the table frame will have a border.

• below - The bottom edge of the table frame will have a border.

• hsides - The horizontal sides of the table frame will have a border (top/above and
bottom/below).
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• vsides - The vertical sides of the table frame will have a border (left and right edges of the
table).

• lhs - The left edge of the table frame will have a border.

• rhs - The right edge of the table frame will have a border.

• box - All 4 edges of the table frame will have a border. This does the same as the border
option.

• border - All 4 edges of the table frame will have a border. This does the same as the box
option.

• Table border (rules)
Set the type of border for the cells inside the table. Choose from:

• none - No inner borders.

• groups - There will be a border line between each group. The groups are the table
header, the table body and the table footer.

• rows - There will be a border line for each row.

• cols - There will be a border line for each column.

• all - All groups, rows, and columns will have a border.

6. Select Insert.
Paligo adds the table to the topic.

7. Select Save. 

NOTE
If you need to change a table that you have created, see Edit a Table [282].

Merge and Split Table Cells
To create more complex tables, use the Merge and Split features.

• With Merge, you can convert two or more adjacent cells into a single cell that spans multiple
rows or columns. For example, you could merge a cell with the cell directly above it in a column.
This results in a single cell that spans two rows.

• With Split, you can turn a single merged cell back into separate cells. Using the same example,
you could select the merged cell in Column C and then split it. Paligo will divide the merged cell
back into two cells.
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To the left a merged table cell. To the right separate table cells.

Merge Table Cells
This instruction describes how to merge adjacent table cells.

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Position the cursor in one of the table cells that you want to merge.

3. Hold down the Shift  and the left mouse button. Drag the cursor over the cells you want to

merge.

Paligo adds a yellow highlight to the selected cells.

4. Right-click to display a table context menu and select Merge cells.
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Paligo merges the selected cells so that they become a single cell that spans multiple rows or
columns.

TIP
To divide a merged cell back into many separate cells, see Split Table Cells [274].

Split Table Cells
This instruction describes how to divide a merged table cell back into multiple separate cells.

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].
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2. Right-click in the merged cell that you want to split and select Split cells from the table
context menu.

Paligo divides the merged cell so that it becomes multiple cells again.

NOTE
You can only split cells that have been previously merged.

Sort a Table
Use the Sort options in the table context menu to change the order in a table column.

1. Right-click in the column that you want to re-sort to display the Table Context Menu.

TIP
If you only want to sort a few rows, hold down Shift and left mouse button,
drag the cursor over the rows to be selected. Release the buttons and right-
click the selected area.

2. Select Sort followed by Sort ascending or Sort descending depending on the order you
want.
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NOTE

• If the column contains any cell that starts with an alphabetical character, Paligo
will sort the table alphabetically.

• If every cell in the column starts with a number, Paligo will sort the column
numerically.

• Paligo cannot sort cells that are merged over rows.

Sorting Automatically in Different Languages
While the sort command in the editor will sort the table in your source language, that order may
not be suitable for translated content.

For example, if you were to sort a column that only contains numbers, the sort order would work
regardless of translations. But if the column contains words, then the alphabetical order could be
correct for the source language, but incorrect for the translations. This is because some languages
have different orders of the alphabet due to special characters.

To avoid this issue, Paligo will reapply the sort order during the publishing process. It re-sorts any
table that has sorting in place, by default. If you prefer, you can disable the automatic re-sorting in
the Layout Editor [57] settings.

NOTE
Auto-sorting works for PDF, HTML, HTML5 and most help desk outputs.

Set Up Table Headers
A table header is a row, usually at the top of a table, that is styled differently to the other rows.
Typically, header rows are where you categorize each column, so that your readers know what
information is shown in the table. For example, if you had a table for temperatures over a week,
you might have a table header with "Day" in one column, "Min Temp" in the next column, and
"Max Temp" in the last column.

When you use the table editor to create a table [270], Paligo gives you the option to add a header.
But you might create a table with no header and then later decide you need to add one [276].
Alternatively, you may decide that you need a different type of header, for example, a header
inside the table [278] or the first column as the header [279].

The following sections explain the various ways of setting up table headers to meet your
requirements.

Add a Table Header to a Table
To add a header row to a table, use the table context menu:
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1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Right-click in the table to display the Table Context Menu.

Paligo displays the Table Context Menu.

3. Select Header, footer and title and choose Insert table head.
Paligo adds a table header row to your table.

4. Select Save. 

TIP
You can only add one header to a table, but it is possible to Make a Column Look
Like a Table Header [279].
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CAUTION
Alternatively, you could use the Source Code Editor [71] and manually change
cells (td element) into table header cells (th). But if you take this approach, you
need to be careful when changing the start and end tags, otherwise you could
make the XML invalid.

Make a Cell Look Like a Table Header
You can make any individual table cell look like table header cell. This can be useful if you want a
complex table where cells inside the table also look like header cells.

NOTE
Although you can set Paligo to make a table cell look like a table header cell, it
is still a regular cell in the structure. It does not change to use the th element
instead of the td element.

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select a cell that you want to look like a table header cell.

3. Select the td element for the cell in the Element Structure Menu [52] and choose Go to
element.

4. Add class attribute in the Element Attributes Panel [55].

Paligo Documentation

278



5. Set the value to tableheader.

6. Repeat steps 2 to 4 for each cell that you want to look like a table header cell.

7. Select Save. 

When you publish, Paligo will style the cell in the same way as a table header cell.

Make a Column Look Like a Table Header
You can make the first column of a table look like a table header. This is useful if you want a table
with the header running vertically down the side, instead of the standard header row across the
top.

To make the first column in a table look like a table header:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select a cell in the table.

3. Select the table or informaltable element and choose Go to element in the Element
Structure Menu [52].
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4. Add the tabstyle attribute and in the Element Attributes Panel [55].

5. Set the value to rowheader-firstcol .

6. Select Save. 

When you publish, Paligo will style the cells in the first column in the same way as table header
cells.

NOTE
If your table already contains a header row, adding a table header column will
make it look like it has both vertical and horizontal headers.

To remove the table header row, select any cell in the table header. Select the
thead element in the Element Structure Menu [52]. From the menu, select Cut to
remove the thead element.
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Background for individual cells
In single-sourcing, you should really not apply any styling to your source content, but rather keep
content and layout separately. Instead you can apply a generic value that can be set in the Layout
Editor [57] 'bg1', 'bg2', or 'bg3'. This way you can determine what the color should be and change it
everywhere you have used it.

NOTE
In some rare cases you may still find the need to give a certain cell a different
background color. But if you were to apply a specific color and doing this in
multiple places, it would be hard to change it later.

1. Select the table cell you want to make into a header (td).

2. Add a @style attribute and set the value to background-color:bg1 (or 'bg2' or 'bg3')
depending on which ones you will set in the Layout Editor [57].

3. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

4. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

5. Select Tables, Tabstyle1 and General.

NOTE
This is only necessary for PDF layouts. In HTML layouts you will get the value
as a class name and can use that in your CSS to style it.

6. Choose the color for Background color for the table body.

7. Select Save.

NOTE
Should you still want to set a specific background color as a one-off, that's also
possible.
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Edit a Table
For many of the table editing options there are also Keyboard Shortcuts [576] that make table
editing much faster. To learn about the editing options, see the article that describes that feature.
For example, to learn about Insert row before, see Add a Row or Column [291].

To edit a table, you can:

• Use the Insert tab's Table menu in the Toolbar [52]

• Right-click in a table and use the Table context menu options, such as Edit table settings and
Insert column left.

NOTE
In Paligo, styling is separate to content and structure. This is so that you can reuse
tables and apply different styling for your various outputs. For example, you could
reuse the same table in two different PDF user guides and set the tables to use
different colors in each guide.

For more details, see Style a Table [1065].
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Set the Table Width
To set the total width of a table:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Place the cursor inside the table.

3. Select the table or informaltable element in the Element Structure Menu [52] and choose
Edit table settings.

Paligo displays the Table settings dialog.

4. Use the Table width setting to control the width of the table. Enter a number in the field and
then use the drop-down menu on the right to choose the units of measurement. They are set
to % by default.
When setting the width, it is important to consider the amount of width that is available. For
example, 100% is 100% of the body region of the page, not 100% of the entire page.

5. Select Apply settings.

6. Select Save. 
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NOTE
If a table does not have a width, it will use the default table width. This can be set
in the PDF layout for PDF outputs, see Set the Default Table Width [980].

For HTML / HTML5 outputs, you can use CSS to control the width. For that, you
will need to create a custom CSS file and upload it to your HTML / HTML5 layout,
see Branding your HTML Outputs with CSS [654].

Set the Table Column Widths
To set the widths of each column in a table:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Place the cursor inside the table.

3. Select the table or informaltable element in the Element Structure Menu [52] and choose
Edit table settings.

4. Use the Table columns (values in %) setting to control the width of the table columns. For
each column, there are two fields. The top field is for setting the width and the bottom field is
for setting the alignment.
To set the width, enter a percentage value for the column in the top field. Note that the total
percentage of all of the columns should equal 100%. For example, if you have a two-column
table, you can set each column to any amount, such as 50 and 50 or 20 and 80 as long as the
total is 100%.
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5. Select Apply settings.

6. Select Save. 

You can also use the Table settings dialog to Set the Table Width [283] and Set the Table Cell
Alignment [286].

Set the Table Column Alignment
This topic describes how to set the alignment of each column in a table.

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Place the cursor inside the table.

3. Select the table or informaltable element in the Element Structure Menu [52] and choose
Edit table settings.

4. Use the Text alignment setting to control the the horizontal alignment for the column.
Paligo will automatically align any content in the column to match your choice.
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For each column, you can choose from:

• Left - Aligns content to the left of the column.

• Right - Aligns content to the right of the column.

• Center - Aligns content to the middle of the column.

• Justify - Adds space between the characters in a column. The first character of the first
word is on the left boundary and the last character of the last word is on the right boundary.

• Char - In DocBook XML, char can be used for aligning content to a specific character, usually
a decimal point. Char is only included as part of our support for DocBook imports is not
intended for use in Paligo.

5. Select Apply settings.

6. Select Save. 

NOTE
Any alignment you set for the table in a topic will take priority over the alignment
settings in the PDF layout, see Table Styles for PDF [976].

You can also use the Table settings dialog to Set the Table Width [283] and Set the
Table Column Widths [284].

Set the Table Cell Alignment
You can control the horizontal and vertical position of content in table cells.

To the left - Vertical alignment. To the right - Horizontal alignment

Set the Horizontal Table Cell Alignment
To set the horizontal alignment in a cell, you can either:

• Set the horizontal alignment of an entire column, see Set the Table Column Alignment [285].
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• Set the horizontal alignment for individual cells as described below.

To set the horizontal alignment of an individual table cell:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Place the cursor in table cell that you want to align.

3. Select the td element (it represents the cell) In the Element Structure Menu [52] and choose
Go to element.

4. In the Element attributes panel, add the align attribute and choose its value. The value
options are:

• Left - Aligns content to the left of the column.

• Right - Aligns content to the right of the column.

• Center - Aligns content to the middle of the column.

• Justify - Adds space between the characters in a column. The first character of the first
word is on the left boundary and the last character of the last word is on the right boundary.

• Char - In DocBook XML, char can be used for aligning content to a specific character, usually
a decimal point. Char is only included as part of our support for DocBook imports is not
intended for use in Paligo.

5. Repeat for each cell that needs a different horizontal alignment.

6. Select Save. 

Set the Vertical Table Cell Alignment
To set the vertical alignment in a table cell:
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1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Place the cursor in table cell that you want to align.

3. Select the td element (it represents the cell) In the Element Structure Menu [52] and choose
Go to element.

4. In the Element attributes panel, add the valign attribute and choose its value. The value
options are:

• Top - Positions the content at the top of the cell.

• Middle - Positions the content in the center of the cell.

• Bottom - Positions the content at the bottom of the cell.

• Baseline - Positions the content at a common baseline position for that row. The baseline is
the invisible line that text characters "sit" on. This setting applies to the first line of text in a
cell, but can affect all cells in a single row.

5. Repeat for each cell that needs a different vertical alignment.

6. Select Save. 

Change the Table Type
In Paligo, you can have tables:

• With titles - That use the table element.

• Without titles - That use the informaltable element.
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TIP
You can choose to include a title when you first Create a Table [270], but if you
later change your mind, you can convert one type of table into the other.

Convert Tables to Informal Tables
To convert a table into an informaltable:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select the table that you want to convert.

3. Select the caption element in the Element Structure Menu [52] and choose Cut. 

Paligo removes the title (caption) from the table.

4. Select Save. 

When you save the topic, Paligo detects that there is a table with no title (no caption). It then
converts the table element into an informaltable element automatically.

Convert Informal Tables to Tables
To convert an informaltable into a table:

1. Select a topic or component in Content Manager [34].
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Paligo opens the content in the Editor [51].

2. Position the cursor in one of the table cells.

3. Right-click in the table to display the Table Context Menu.

Paligo displays the Table Context Menu.

4. Select Header, footer and title and choose Insert table title.

Paligo adds a table title above the table. The caption element represents the table title.

5. Add content to the table title.

6. Select Save. 

When you save the topic, Paligo detects that the table now has a title (caption). It converts the
informaltable element into a table element automatically.
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Add a Row or Column
To add a row or a column to a table:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Position the cursor in the row or column that is next to where you want the new row / column
to be.

3. Right-click in the table to display the Table Context Menu.

Paligo displays the Table Context Menu.

4. Select:

• Insert column left - To add a column to the left of the currently selected column.

• Insert column right - To add a column to the right of the currently selected column.

• Insert row before - To add a row above the currently selected row.

• Insert row after - To add a row below the currently selected row.
Paligo adds a new row or column.

5. Select Save. 
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TIP
To add many rows or columns at once, use the keyboard shortcuts:

• Ctrl  + Alt  + arrow key  (Windows)

For example, Ctrl  + Alt  + →  to add a column to the right of the currently

selected column.

• Ctrl  + Option  + arrow key  (Mac)

For example, Ctrl  + Option  + ↓  to add a row after the currently selected row.

Copy a Row or Column
To make a copy of a row or column, use the duplicate options. Depending on your requirements,
you can create a copy that:

• Reuses the text, so that the original and duplicate contain exactly the same para element. If
you edit the para element, the changes will affect the original and the duplicate.

• Copies the text, so that the original and duplicate contain the same words, but they have
unique IDs. You can edit the text in the duplicate and it will not affect the text in the original.
Similarly, you can edit the original text and it will not affect the duplicate.

To make a copy of a table row or column:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Position the cursor in the row or column that you want to copy.

3. Right-click in the table to display the Table Context Menu.
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Paligo displays the Table Context Menu.

4. Select Move or duplicate and choose:

• Duplicate column (reuse text) - To create a copy of the column and reuse the text.

• Duplicate column (copy text) - To create a copy of the column and its text. The text has its
own unique ID so that you can edit it without affecting the original text.

• Duplicate row (reuse text) - To create a copy of the row and reuse the text.

• Duplicate row (copy text) - To create a copy of the row and its text. The text has its own
unique ID so that you can edit it without affecting the original text.

NOTE
With the (reuse text) options, the duplicate's text is the same text as the
original. It has the same ID and any changes you make will affect the original
and the duplicate.

Paligo adds a duplicate row or column.

5. Select Save. 

Move a Row or Column
To move a table row or column:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].
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2. Position the cursor in the row or column that you want to move.

3. Right-click in the table to display the Table Context Menu.

Paligo displays the Table Context Menu.

4. Select Move or duplicate and choose:

• Move column right

• Move column left

• Move row up

• Move row down
Paligo moves the row or column.

5. Select Save. 

Select Multiple Rows or Columns in a Table
To select a group of adjacent rows or columns in a table:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Position the cursor in the first row or column that you want to select.

3. Hold down Shift  and the left mouse button and drag the cursor over the other rows or

columns that you want to select.
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As you drag the cursor, Paligo highlights the selected cells in yellow.

4. Release the Shift  and the left mouse button to complete the selection.

Add a Footer
Footer rows are often used to summarize the information in the columns, for example, to show
total amounts. You can add them to your tables in Paligo, or remove them if you prefer.

If you create a table by using the Insert Table dialog (also known as the "table wizard"), you can
choose to add a footer row to your table (for details, see Create a Table [270] ).

If you already have a table and it does not have a footer, you can add one:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Right-click in the table to display the Table Context Menu.

Paligo displays the Table Context Menu.

3. Choose Header, footer and title and choose Insert table foot.
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Paligo adds a table footer after the last regular row in the table. The tfoot element
represents the table footer.

4. Add content to the table footer.

5. Select Save. 

Delete Parts of a Table
As table structures are made up of many different elements, you can delete various parts without
affecting the rest of the table structure.

Delete a Table
This topic describes how to delete an entire table.

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Position the cursor inside the table.
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3. Select the table or informaltable element (represents the entire table) in the Element
Structure Menu [52].

4. Select Delete. 

Paligo removes the table and all of its content.

5. Select Save. 

Delete a Table Header
To delete a table header:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Position the cursor in the header row and right-click to display the Table Context Menu.

3. Select Delete row.

NOTE
The selected header gets a red highlight and a red line runs through its
content. This is to show that Paligo is going to remove this structure and
content from the table.
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Paligo removes the header row and all of the header row's content.

4. Select Save. 

NOTE
Alternatively, you can select the header row and then select the thead element in
the Element Structure Menu [52]. From the menu, select Cut.

Delete a Single Row
To delete one row in a table:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Position the cursor in the row that you want to remove and right-click to display the Table
Context Menu.

3. Select Delete row.
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NOTE
The selected row gets a red highlight and a red line runs through its
content. This is to show which row Paligo will remove from the table.

Paligo removes the row and all of the row's content.

4. Select Save. 

Delete Multiple Rows in a Table
This topic describes how to delete multiple adjacent rows in a table.

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Position the cursor in the first row that you want to select.

3. Hold down Shift  and left mouse button and drag the cursor to over the rows that you want

to delete.

Paligo adds a yellow highlight to the selected rows.
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4. Right-click to display the Table Context Menu.

5. Select Delete Row and choose Delete selected rows.

Paligo removes the selected rows and the content inside them.

6. Select Save. 

Delete a Column
This topic describes how to delete a column in a table.

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Position the cursor in the column that you want to remove and right-click to display the Table
Context Menu.

3. Select Delete Column.

Paligo removes the column and all of the column's content.
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4. Select Save. 

Delete a Footer
To delete a table footer:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Position the cursor in the footer row and right-click to display the Table Context Menu.

3. Select Delete row.

NOTE
The selected footer gets a red highlight and a red line runs through its
content. This is to show that Paligo is going to remove this structure and
content from the table.

Paligo removes the footer row and all of the footer row's content.

4. Select Save. 
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NOTE
Alternatively, you can position the cursor in the footer row. Select the tfoot
element in the Element Structure Menu [52] and choose Cut from the menu.

Images
With Paligo, you can add and manage all of the images that you need to use in your
technical communication. This includes images in the source language and also images for your
translations.

There are different image types that you can use, depending on your requirements, and they
use different structures in the XML. So if you are new to working with images in Paligo, it is a
good idea to learn about the image types [303] first. Once you are familiar with those, refer to
the various Image topics to learn about adding and managing images, applying effects such as
thumbnails [361], and setting alt descriptions for accessibility [341].

The following sections cover the basics for adding and managing your images:

• Add a Figure to a Topic [318]

• Add an Image to a Topic [310]

• Add an Inline Image to a Topic [322]

• Add Side-By-Side Images to a Topic [326]

• Upload Images to the Media Library [329]

• Image Sizing [345]

• Replace an Image [337].

Supported Image Files
Paligo supports a wide range of image file formats, including:

• jpg

• jpeg

• png

• gif and animated gif

• pdf

• psd
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• tif

• tiff

• ai

• svg

• eps

• ps

Image Types
Adding an image in Paligo requires some extra structure to be added to the XML of your content.
Paligo creates this structure for you automatically, but there are different structures depending on
what type of image you want to use. Here, you can learn about the different types of images and
the structures that Paligo will create.

Image
Use a Image if you want to use a picture that has no title.

When you add an image [310], Paligo adds the necessary structure for you. All you need to do
is choose which image to use. By default, an image has no caption, but you can add your own
caption element if you prefer.

The structure for an image is:

mediaobject > imageobject > imagedata

For example:

<mediaobject>
    <imageobject>
      <imagedata fileref="UUID-84c422a3-c8dd-1522-
ed35-919b168f873f" xinfo:image="UUID-84c422a3-c8dd-1522-ed35-919b168f873f"/>
    </imageobject>
  </mediaobject>

Where the imagedata element is the reference to the image file.
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Figure
Use a figure when you want an image that has a title and a caption.

In the output, the figure title is numbered automatically by default. If you leave a title empty, then
the image will use just the word "Figure" followed by the figure number, for example "Figure 3".

When you add a figure [318], Paligo adds the structural elements for the figure to your topic
automatically. All you need to do is choose the image that you want to use and enter the text for
the title and caption.

Here is an example of the structure Paligo adds for a figure:

 <figure xml:id="figure-idm4650264082761632281569246364">
    <title xinfo:text="931664">SPACEX Module</title>
    <mediaobject>
      <imageobject>
        <imagedata fileref="UUID-49641102-0174-ceeb-6547-
f32581461aea" xinfo:image="UUID-49641102-0174-ceeb-6547-f32581461aea"/>
      </imageobject>
      <caption>
        <para xinfo:text="931665">The SPACEX module above the earth.</para>
      </caption>
    </mediaobject>
  </figure>

The caption is optional, but is included by default. You can remove it if you prefer.

Inline Image
An inline image is a small picture that appears in the flow of the text, for example, an icon that
appears inside a paragraph. In the following image, a save icon has been added as an inline image
in a step in a procedure.

Paligo Documentation

304



When you add an inline image [322], Paligo creates the necessary structure for you automatically.
All you need to do is choose the image you want to use.

Here is an example of the structure that Paligo adds to a topic for an inline image:

 <para xinfo:text="931661">Select the <emphasis role="bold">save as</
emphasis> icon <inlinemediaobject><imageobject><imagedata \
fileref="UUID-25aa4f06-9f19-0875-70d5-343f5ba68460" \
xinfo:image="UUID-25aa4f06-9f19-0875-70d5-343f5ba68460"/></imageobject></
inlinemediaobject>.</para>

The inlinemediaobject > imageobject > imagedata structure is needed, and this can only be
used inside other block elements such as para.

Side-By-Side Images
With Side-by-side images, you can have two images next to each other on the same line, rather
than stacked one above the other. To create this effect, Paligo adds the images inside a table, but
you cannot see the table in the published output.
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When you add a side-by-side image [326], Paligo inserts all of the necessary structure for you. The
structure includes an informaltable, which is only visible in the Paligo editor. When you publish,
the table is not shown, so you only see two images next to each other on the page. The images are
contained in the imagedata elements. The caption is optional, but is included by default. You
can remove it if you prefer.

Here is an example of the structure that Paligo uses for the side-by-side images:

 <informalfigure>
    <informaltable frame="void" rules="none" width="100%" role="sidebyside">
      <col width="50%"></col>
      <col width="50%"></col>
      <tbody>
        <tr>
          <td>
            <mediaobject>
              <imageobject>
                <imagedata fileref="UUID-49641102-0174-ceeb-6547-
f32581461aea" xinfo:image="UUID-49641102-0174-ceeb-6547-f32581461aea"/>
              </imageobject>
            </mediaobject>
          </td>
          <td>
            <mediaobject>
              <imageobject>
                <imagedata fileref="UUID-51feab7f-acb9-96e3-740d-
be6d0a35dd02" xinfo:image="UUID-51feab7f-acb9-96e3-740d-be6d0a35dd02"/>
              </imageobject>
            </mediaobject>
          </td>
        </tr>
      </tbody>
    </informaltable>
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    <caption>
      <para xinfo:text="931666">The SPACEX module and command center.</para>
    </caption>
  </informalfigure>

Image Resolution
Use the Image Size setting to control the resolution of the images in your published HTML5
output. For example, you may want to reduce the resolution so that the image file size is smaller
and so the page will load more quickly. The Image Size setting is available when you edit an
HTML5 layout.

NOTE
The Image Size setting affects the resolution (image quality and file size) of the
image. It does not change the physical size of the image on the page. For that,
you can use the width and contentwidth attributes, which can be set on the
mediaobject element of an image.

1. Select Layout and then edit the HTML5 layout you are going to use for publishing.
Alternatively, you can create a new HTML5 layout and edit that.

2. Select Images.

3. Set the resolution of the images in your published output. You can choose from:

• Do not include images (removes all images from your output)

• Use original images, which keeps the original resolution of the image file

• Fullsize (2500 x 2500px, 120 dpi)

• Large (800 x 800px, 72dpi)

• Medium (400 x 400px, 72dpi)

• Small (400 x 400px,72dpi).

4. Select Save.

Download an Image from Paligo
You can download an image from Paligo so that it can be used elsewhere. This feature is especially
useful if you have lost the original image file that you uploaded to Paligo. For example, let's
say you have a screenshot that you upload to Paligo. You later later realise it contains sensitive
information, but you have lost the original file. Rather than take an entirely new screenshot, you
can download the image from Paligo, block out the sensitive information, and then upload it again.

To download an image from Paligo:
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1. Access the Image Details [309] for the image file. You can do this from the image's options
menu in the Media library - select the Edit Image option. Alternatively, right-click on an image
in a topic and select Edit Properties.

2. On the Image Details dialog, select the link in the Filename entry.

The browser shows the image at maximum size in a new tab.

3. Right-click on the image and use the browser's features to save the image to your computer.
The options for saving the image can vary, depending on which browser you use. Here, we are
showing the options in Google Chrome.
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Image Details
You can view information about an image by displaying its properties on the Image Details dialog.
The details you see there are the settings for the source image, but you can see previews of
variant images for different languages too.

To display the Image Details dialog:

1. Either:

• Find the image in the Media library, select its options menu ( ... ) and then select Edit Image.

• Right-click on the image in a topic and then select Edit Properties.
Paligo displays the Image details.

2. Use the Image details dialog to:

• View information about the image, such as its filename and dimensions

• Preview the image

• Change its title

• Find out which folder contains the image in the Media library

• See which taxonomy tags it has (if any)

• Find out where the image is reused

• Add alternative versions of the image for different languages (see Translate Images [1736])

• Add alt text [341] (image description)

• Upload a replacement image [337]

• Replace the image with an image from the media library [337].

NOTE
To set the width of an image, use the image attributes (see Image Sizing [345]).
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Add an Image to a Topic
In this section, we explain how to add an image to a topic. An image is a picture without a title or
caption, although you can add a caption manually if you prefer.

NOTE
There are separate sections that explain how to add an image with a title
(figure) [318], inline images [322], and side-by-side images [326]. To find out more
about the different types of image structures, see Image Types [303].

There are several ways to add an image:

• Select Insert > Image and browse to the image you want to use, or upload an image file.
For details, see: Use the Insert Menu to Add an Image [311]

• Drag and drop an image from your computer on to the topic. This will add the image and
upload it into the Media library at the same time.
For more details, see: Drag and Drop an Image into a Topic [312]

• Use the element context menu to add the mediaobject element and then search for the
image you want to use.
For more detail, see Use the Element Context Menu to Add an Image [317].
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TIP
You can also use the keyboard shortcuts:

On Mac:

Option ⌥  Control ^  I

On Windows:

Alt  I  or Alt  Ctrl  I

Use the Insert Menu to Add an Image
When you edit a topic, you have access to the Insert menu. You can use it to add any of the Image
Types [303] (figure, image, inline image, or side-by-side images).

1. Place your cursor where you want to add an image. The position of the cursor is important,
as you can only add an image where it is valid. For example, if you are inserting an image
or figure, you could place the cursor after a para element. But if you are inserting an inline
image, you would need to place the cursor inside the para element.

2. Select the Insert menu.

3. Select Image and then select the type of image you want to add:

Paligo adds the image elements that are needed for the structure.

4. In the dialog that opens, browse or search for the image in your Media library.

NOTE
If the dialog does not open automatically, right-click on the placeholder icon
for the image and select Image browser.
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NOTE
If the image is not in the Media library yet, you can upload it directly in this
dialog by using the upload icon in the top-right.

To find out more about uploading images, see Upload Images to the Media
Library [329].

5. Select the image to insert it into your topic.

NOTE
To use alt text in PDF outputs, it is important that you do not use tagged
PDFs as images. For PDFs to use alt text, the layout has to have Generate
tagged PDF enabled. The PDF processor cannot complete the publishing if
your content contains tagged PDFs as images and Generate tagged PDF is
enabled. You will need to use untagged PDFs as images or use different types
of image files.

If you try to publish content that has a tagged PDF embedded as an image
and the Generate tagged PDF enabled, you will get a "production failed"
error.

6. Select Save.

Drag and Drop an Image into a Topic
"Drag and drop" is a quick way to add an image to a topic and upload it into your media library at
the same time.

Paligo Documentation

312



1. Place your cursor where you want to add an image. The position of the cursor is important,
as you can only add an image where it is valid. For example, if you are inserting an image
or figure, you could place the cursor after a para element. But if you are inserting an inline
image, you would need to place the cursor inside the para element.

2. On your computer, find the image file that you want to add to your topic and drag it on to the
topic.

Paligo adds the elements for an image to your topic structure and opens the Upload images
dialog. The file that you have dragged on to the topic is listed.

3. Select the blue icon next to "in folder" at the top of the dialog to display a hierarchical view of
your media library folders. Select the folder that you want your new images to be uploaded
into.
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4. Decide whether you want Paligo to compare your new images to images in the selected folder
only, or images in child folders too.
When you upload an image, Paligo compares the image filename to the images that already
exist in the media library. Then, if there are images with matching filenames, you can choose
to update them or add the new images as well as the existing ones.
Clear the Update in any existing folder checkbox to set Paligo to look only in the root of the
selected folder.
Check the Update in any existing folder box to set Paligo to look in the selected folder and
also any of its descendant folders (child folders).
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Paligo then compares the names of the files you are uploading to the files that already exist in
the media library. What happens next, depends on the files you are uploading.

• If there are no matching files, your new files are listed and a green icon shows that they will
be added as new image files.

• If there are matching files, Paligo shows Update checkboxes. You can use these to replace
the existing images (see the next step).
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NOTE
If you are uploading files that have a hyphen and language code suffix, such
as battery-fr.jpg, Paligo will look for source language versions of the same
image. If it finds a match, you get the option to update the language variant.
For more details, see Translate Images [1736].

5. Decide whether you want your new files to update any existing files of the same name.

• Check the Update box to replace an existing image with your new image.

• Clear the Update box to upload the new image in addition to the existing image.
This will mean you have multiple images with the same name. You can rename the images
in the Content Manager to make them easier to manage.

TIP
You may be able to save time by selecting the Update all existing box, which
automatically selects all of the update boxes at once.

6. Check the Remove whitespace box if you want Paligo to automatically remove any
unnecessary white space (empty areas) from the edges of your image. This only applies if
your image is AI. EPS, or PDF.

7. Select Upload.
Paligo uploads your image file to the media library and adds it to your topic. You can close the
Upload Images dialog.
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Use the Element Context Menu to Add an Image
If you prefer, you can add the elements for an image individually, and for this, you can use the
element context menu.

1. Place your cursor where you want to add an image. The position of the cursor is important,
as you can only add an image where it is valid. For example, if you are inserting an image
or figure, you could place the cursor after a para element. But if you are inserting an inline
image, you would need to place the cursor inside the para element.

2. Access the element context menu.

To access the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

3. Add the mediaobject element.
Paligo adds the mediaobject element and also adds the imageobject and imagedata elements
that are needed for an image.

4. Right-click on the placeholder for the image and select Image browser.

5. In the dialog that opens, browse or search for the image in your Media library.

NOTE
If the dialog does not open automatically, right-click on the placeholder icon
for the image and select Image browser.
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NOTE
If the image is not in the Media library yet, you can upload it directly in this
dialog by using the upload icon in the top-right.

To find out more about uploading images, see Upload Images to the Media
Library [329].

6. Select the image to insert it into your topic.

NOTE
To use alt text in PDF outputs, it is important that you do not use tagged
PDFs as images. For PDFs to use alt text, the layout has to have Generate
tagged PDF enabled. The PDF processor cannot complete the publishing if
your content contains tagged PDFs as images and Generate tagged PDF is
enabled. You will need to use untagged PDFs as images or use different types
of image files.

If you try to publish content that has a tagged PDF embedded as an image
and the Generate tagged PDF enabled, you will get a "production failed"
error.

7. Select Save.

Add a Figure to a Topic
In this section, we explain how to add a figure to a topic. A figure is a picture with a title and
a caption, and it can support some DocBook elements that are unavailable for regular images.
However, at the moment, most of these additional elements, such as calloutlist do not have
any functionality in Paligo.
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NOTE
There are separate sections that explain how to add an image without a title
(image) [310], inline images [322], and side-by-side images [326]. To find out more
about the different types of image structures, see Image Types [303].

There are several ways to add a figure:

• Select Insert > Figure and browse to the image you want to use, or upload an image file.
For details, see: Use the Insert Menu to Add a Figure [319]

• Use the element context menu to add the figure element and then select the image
placeholder and search for the image you want to use.
For more detail, see Use the Element Context Menu to Add a Figure [320].

Use the Insert Menu to Add a Figure
When you edit a topic, you have access to the Insert menu. You can use it to add any of the Image
Types [303] (figure, image, inline image, or side-by-side images).

1. Place your cursor where you want to add an image. The position of the cursor is important,
as you can only add an image where it is valid. For example, if you are inserting an image
or figure, you could place the cursor after a para element. But if you are inserting an inline
image, you would need to place the cursor inside the para element.

2. Select the Insert menu.

3. Select Image and then select the type of image you want to add:

Paligo adds the image elements that are needed for the structure.

4. In the dialog that opens, browse or search for the image in your Media library.

NOTE
If the dialog does not open automatically, right-click on the placeholder icon
for the image and select Image browser.
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NOTE
If the image is not in the Media library yet, you can upload it directly in this
dialog by using the upload icon in the top-right.

To find out more about uploading images, see Upload Images to the Media
Library [329].

5. Select the image to insert it into your topic.

NOTE
To use alt text in PDF outputs, it is important that you do not use tagged
PDFs as images. For PDFs to use alt text, the layout has to have Generate
tagged PDF enabled. The PDF processor cannot complete the publishing if
your content contains tagged PDFs as images and Generate tagged PDF is
enabled. You will need to use untagged PDFs as images or use different types
of image files.

If you try to publish content that has a tagged PDF embedded as an image
and the Generate tagged PDF enabled, you will get a "production failed"
error.

6. Select Save.

Use the Element Context Menu to Add a Figure
If you prefer, you can add the elements for a figure manually, and for this, you can use the
element context menu.
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1. Place your cursor where you want to add a figure, for example, inside a step element or after
a para.

2. Access the element context menu.

To access the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

3. Add the figure element.
Paligo adds the figure element and also adds the title, caption, imageobject and
imagedata elements that are needed for a figure.

4. Right-click on the placeholder for the image and select Image browser.

5. In the dialog that opens, browse or search for the image in your Media library.

NOTE
If the dialog does not open automatically, right-click on the placeholder icon
for the image and select Image browser.

NOTE
If the image is not in the Media library yet, you can upload it directly in this
dialog by using the upload icon in the top-right.

To find out more about uploading images, see Upload Images to the Media
Library [329].

6. Select the image to insert it into your topic.
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NOTE
To use alt text in PDF outputs, it is important that you do not use tagged
PDFs as images. For PDFs to use alt text, the layout has to have Generate
tagged PDF enabled. The PDF processor cannot complete the publishing if
your content contains tagged PDFs as images and Generate tagged PDF is
enabled. You will need to use untagged PDFs as images or use different types
of image files.

If you try to publish content that has a tagged PDF embedded as an image
and the Generate tagged PDF enabled, you will get a "production failed"
error.

7. Enter the text for the figure title in the title element.

8. Enter a caption for the figure in the caption element. You can delete the caption element if
you do not want a caption.

9. Select Save.

Add an Inline Image to a Topic
An inline image is a small picture that appears in the flow of the text, for example, an icon that
appears inside a paragraph. In the following image, a save icon has been added as an inline image
in a step in a procedure.

NOTE
There are separate sections that explain how to add an image without a title
(image) [310], image with a title (figure) [318], and side-by-side images [326].
To find out more about the different types of image structures, see Image
Types [303].

There are several ways to add an inline image to a topic:
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• Use the Insert Menu to Add an Inline Image [323]

• Drag and Drop an Inline Image [324]

Use the Insert Menu to Add an Inline Image
When you edit a topic, you have access to the Insert menu. You can use it to add any of the Image
Types [303] (figure, image, inline image, or side-by-side images).

1. Place your cursor where you want to add an image. The position of the cursor is important,
as you can only add an image where it is valid. For example, if you are inserting an image
or figure, you could place the cursor after a para element. But if you are inserting an inline
image, you would need to place the cursor inside the para element.

2. Select the Insert menu.

3. Select Image and then select the type of image you want to add:

Paligo adds the image elements that are needed for the structure.

4. In the dialog that opens, browse or search for the image in your Media library.

NOTE
If the dialog does not open automatically, right-click on the placeholder icon
for the image and select Image browser.
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NOTE
If the image is not in the Media library yet, you can upload it directly in this
dialog by using the upload icon in the top-right.

To find out more about uploading images, see Upload Images to the Media
Library [329].

5. Select the image to insert it into your topic.

NOTE
To use alt text in PDF outputs, it is important that you do not use tagged
PDFs as images. For PDFs to use alt text, the layout has to have Generate
tagged PDF enabled. The PDF processor cannot complete the publishing if
your content contains tagged PDFs as images and Generate tagged PDF is
enabled. You will need to use untagged PDFs as images or use different types
of image files.

If you try to publish content that has a tagged PDF embedded as an image
and the Generate tagged PDF enabled, you will get a "production failed"
error.

6. Select Save.

Drag and Drop an Inline Image
"Drag and drop" is a quick way to add an image to a topic and upload it into your media library at
the same time.
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1. Place your cursor where you want to add an inline image, for example, inside a para element.

2. On your computer, find the image file that you want to add to your topic and drag it on to the
topic.

Paligo adds the elements for an image to your topic structure and opens the Upload images
dialog. The file that you have dragged on to the topic is listed.

3. Select the blue icon next to "in folder" at the top of the dialog to display a hierarchical view of
your media library folders. Select the folder that you want your new images to be uploaded
into.
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4. Decide whether you want your new files to update any existing files of the same name.

• Check the Update box to replace an existing image with your new image.

• Clear the Update box to upload the new image in addition to the existing image.
This will mean you have multiple images with the same name. You can rename the images
in the Content Manager to make them easier to manage.

TIP
You may be able to save time by selecting the Update all existing box, which
automatically selects all of the update boxes at once.

5. Check the Remove whitespace box if you want Paligo to automatically remove any
unnecessary white space (empty areas) from the edges of your image. This only applies if
your image is AI. EPS, or PDF.

6. Select Upload.
Paligo uploads your image to the media library and inserts it as an inline image in your topic.
You can close the Upload Images dialog.

Add Side-By-Side Images to a Topic
With Side-by-side images, you can have two images next to each other on the same line, rather
than stacked one above the other. To create this effect, Paligo adds the images inside a table, but
you cannot see the table in the published output.
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NOTE
To find out about the elements that are used for a side-by-side table, and also the
other types of image structures you can add, see Image Types [303].

To add side-by-side images to a topic:

1. Place your cursor where you want to add an image. The position of the cursor is important,
as you can only add an image where it is valid. For example, if you are inserting an image
or figure, you could place the cursor after a para element. But if you are inserting an inline
image, you would need to place the cursor inside the para element.

2. Select the Insert menu.

3. Select Image and then Side by side images.

NOTE
As an alternative to steps 2 and 3, you can use the keyboard shortcut.

On Mac:

Option ⌥  J

On Windows:

Alt  J

4. Right-click on the placeholder for the image and select Image browser.
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5. In the dialog that opens, browse or search for the image in your Media library.

NOTE
If the image is not in the Media library yet, you can upload it directly in this
dialog by using the upload icon in the top-right.

To find out more about uploading images, see Upload Images to the Media
Library [329].

6. Select the image to insert it into your topic.

7. Repeat steps 4-6 inclusive for the other image.

8. Enter a caption for the figure in the caption element. You can delete the caption element if
you do not want a caption.

9. Select Save.
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TIP
By default, images will come out two in a row in HTML5 output. But you can easily
change how these come out. For example, if you want more than two images to
still appear in one row, and shrink to fit, you can do so with this in your custom
CSS:

.flex-container{
    display: flex;
    width: 100%;
    justify-content: space-between;
    flex-wrap: wrap;
}.informalfigure .flex-item{
    width: auto !important;
    margin: 0px;
}.informalfigure .flex-item:last-child{
    margin-right: 0px;
}@media (min-width : 480px){
    .informalfigure .flex-item{
        width: 49% !important;
    }
}@media (min-width : 992px){
    .flex-container{
        flex-wrap: nowrap;
    }
    .informalfigure .flex-item{
        margin-right: 10px;
    }
}

This would make the side-by-side images use up the entire space, and all in one
row. But if viewed on smaller devices, it will change to only two in a row for
medium-sized, and finally to only one, so they are stacked on top of each other,
for mobile devices.

Upload Images to the Media Library
Paligo has an image library that contains all of the images you upload. To add images to the library
you can:

• Add images directly in the Content Manager [329]

• Add images to your topics. Paligo adds them to the library automatically when you upload [333].

When you upload images to the library, Paligo manages the image formats and translated images
automatically. We call this Smart Image Management [337]

Upload Images to the Library from the Content Manager
You can add images to the library directly from the Content Manager. The images that you add are
then available to select when you add a figure, image, inline image, or side-by-side images.

1. In the Content Manager, open the Media section.

2. Select the options menu ( ... ) for a folder or create a new folder and select the options menu
for that.
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3. Select Upload Images.

4. Decide whether you want Paligo to compare your new images to images in the selected folder
only, or images in child folders too.
When you upload an image, Paligo compares the image filename to the images that already
exist in the media library. Then, if there are images with matching filenames, you can choose
to update them or add the new images as well as the existing ones.
Check the Update in any existing folder box to set Paligo to look in the selected folder and
also any of its descendant folders (child folders).
Clear the Update in any existing folder checkbox to set Paligo to look only in the root of the
selected folder.

5. Drag and drop your image files from your computer into the box. Alternatively, select Add
Files and browse to the files you want to upload.
Paligo then compares the names of the files you are uploading to the files that already exist in
the media library. What happens next, depends on the files you are uploading.
If all the image files you are adding are new, and there are no image files with matching
names already in the media library, your new files are listed. Next to each image name there is
a green icon to show that the image will be uploaded as a new file in the library.
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If there are images with matching names already in the media library, the new images are
listed, but they also have an Update checkbox.
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NOTE
If you are uploading files that have a hyphen and language code suffix, such
as battery-fr.jpg, Paligo will look for source language versions of the same
image. If it finds a match, you get the option to update the language variant,
for example, Update (fr) for a French variant. For more details, see Translate
Images [1736].

6. Decide whether you want your new files to update any existing files of the same name.

• Check the Update box to replace an existing image with your new image.

• Clear the Update box to upload the new image in addition to the existing image.
This will mean you have multiple images with the same name. You can rename the images
in the Content Manager to make them easier to manage.

TIP
You may be able to save time by selecting the Update all existing box, which
automatically selects all of the update boxes at once.
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7. Check the Remove whitespace box if you want Paligo to automatically remove any
unnecessary white space (empty areas) from the edges of your image. This only applies if
your image is AI. EPS, or PDF.

8. Use the Open parent folder box to choose whether Paligo will show you the folder that
contains the images when they have finished uploading.

9. Select Upload.
Paligo uploads your image files to the media library. If you have updated any of the image
files, the topics that use those images are automatically updated with the new images.

Upload Images to the Library from a Topic
When you are editing a topic, you can insert a figure, image, inline image, or side-by-side images.
When you do this, you can choose one of the existing images from the library or you can upload a
new image to the library and insert that.

NOTE
It is also possible to upload an image to a topic by using the image details [309]
dialog. But that approach does not include checking the filenames against existing
images in the library or language variants.

To add images to the library from a topic:

1. Edit a topic and add a figure [318], image [310], inline image [322], or side-by-side
images [326].
Paligo displays a browse dialog that you can use to browse the media folders. But here, you
want to upload a new image, not use an existing image. So browse to the folder where you
want to store the new image, and then you will add the image in the next step.

2. Select the upload icon to display the Upload Images dialog.
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3. Select the blue icon next to "in folder" at the top of the dialog to display a hierarchical view of
your media library folders. Select the folder that you want your new images to be uploaded
into.

4. Decide whether you want Paligo to compare your new images to images in the selected folder
only, or images in child folders too.
When you upload an image, Paligo compares the image filename to the images that already
exist in the media library. Then, if there are images with matching filenames, you can choose
to update them or add the new images as well as the existing ones.
Check the Update in any existing folder box to set Paligo to look in the selected folder and
also any of its descendant folders (child folders).
Clear the Update in any existing folder checkbox to set Paligo to look only in the root of the
selected folder.
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5. Drag and drop your image files from your computer into the box. Alternatively, select Add
Files and browse to the files you want to upload.
Paligo then compares the names of the files you are uploading to the files that already exist in
the media library. What happens next, depends on the files you are uploading.
If all the image files you are adding are new, and there are no image files with matching
names already in the media library, your new files are listed. Next to each image name there is
a green icon to show that the image will be uploaded as a new file in the library.

If there are images with matching names already in the media library, the new images are
listed, but they also have an Update checkbox.
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NOTE
If you are uploading files that have a hyphen and language code suffix, such
as battery-fr.jpg, Paligo will look for source language versions of the same
image. If it finds a match, you get the option to update the language variant,
for example, Update (fr) for a French variant. For more details, see Translate
Images [1736].

6. Decide whether you want your new files to update any existing files of the same name.

• Check the Update box to replace an existing image with your new image.

• Clear the Update box to upload the new image in addition to the existing image.
This will mean you have multiple images with the same name. You can rename the images
in the Content Manager to make them easier to manage.

TIP
You may be able to save time by selecting the Update all existing box, which
automatically selects all of the update boxes at once.

7. Check the Remove whitespace box if you want Paligo to automatically remove any
unnecessary white space (empty areas) from the edges of your image. This only applies if
your image is AI. EPS, or PDF.

8. Use the Open parent folder box to choose whether Paligo will show you the folder that
contains the images when they have finished uploading.

9. Select Upload.
Paligo uploads your image files to the media library. If you have updated any of the image
files, the topics that use those images are automatically updated with the new images.

10. Paligo uploads your image files to the media library. If you have updated any of the image
files, the topics that use those images are automatically updated with the new images.
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Smart Image Management
Paligo takes care of the complexity of managing different versions of images for you:

• Automatic image formats: You can upload an image in just one format, for example the
highest resolution version, or an original source file in Photoshop (PSD), or Illustrator (AI). Paligo
will automatically handle the conversion to suitable output format for print, web, etc, so you
don't have to keep track of multiple format versions of the same image.

• Images in multiple languages: You can also upload the same image translated into multiple
languages (such as screen shots for localized software). Paligo will automatically select the right
language version when you publish to different languages. Read more about that in Translate
Images [1736].

Replace an Image
When you are updating your technical documentation, you will most likely need to replace some
of your images. For example, if you document software, you may need to add new screenshots.
Content reuse [1098] applies to images as well as text in Paligo, so you can update an image once,
in one place, and the change will apply wherever that image is used. This can save you a lot of time
and effort.

In this section, we explain how to replace your "source language" images. These are the images
that you add and use in the content for your default language. If you translate your content into
different languages, and have "language variant images", you can find out how to update those in
Translate Images [1736].

There are two different approaches to replacing "source language" images:

• Replace an image with another image that you will upload to Paligo [337]

• Replace an image with another image that is already in your Paligo media library [338].

NOTE
If you need to replace an image in one topic only, add the updated image as a
new image (or figure, inline image, etc.). Then remove the previous image and its
related elements, such as figure, mediaobject, from the topic.

Replace an Image with a New Image
To replace an image with a new image that you will upload to Paligo:

1. Access the Image Details [309] for the image file. You can do this from the image's options
menu in the Media library - select the Edit Image option. Alternatively, right-click on an image
in a topic and select Edit Properties.
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2. Select Upload Image to replace the current image with a new one.

3. Use the Upload Image dialog to add the replacement image and then select Upload. Close the
dialog when the upload is complete.

Every topic that used the previous image will now use the new one instead.

Replace an Image with Another Image from the Media Library
To replace an image with another image from the media library:

1. Access the Image Details [309] for the image file. You can do this from the image's options
menu in the Media library - select the Edit Image option. Alternatively, right-click on an image
in a topic and select Edit Properties.

2. Select Replace with existing to replace the current image with another image from the media
library.
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3. Use the Media dialog to find and select the alternative image that you want to use. When you
have selected the image, close the Image Details dialog.

NOTE
If the replacement image is not in the media library, you can upload it. To find
out more, see Upload Images to the Media Library [329].

All topics that used the original image are now updated. They will use the alternate image that you
selected instead of the original image.

Captions
A caption is included by default if you add a figure or side by side images, but not if you add an
image. You can add the caption manually by using the caption element.

In the image below, you see a figure where both the title and caption is used.
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IMPORTANT
The validation will fail if the caption is positioned above the image. To move a
misplaced caption, select it in the Element Structure Menu [52] and choose Move
down.

Add a Caption
A caption is included by default if you add a figure or side by side images, but not if you add an
image.
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To manually add a caption to an image:

1. Position the cursor on the right side of the image.

2. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

3. Select Caption from the menu.

4. Enter a text inside the caption element.

5. Select Save. 

Remove a Caption
If you have added a figure, side by side images or manually added a caption that you need to
remove:

1. Select the image that has the caption.

2. Select the caption element in the Element Structure Menu [52].

3. Select Delete.

4. Select Save. 

Alt Text for Images
We recommend adding "alt text" to your images. Alt text is a text description of the image that is in
the code of the page, but is not visible to the reader. It is useful for:
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• Search Engine Optimization (SEO)

• Accessibility for people with certain disabilities. The alt text description can be read out by a
screen reader.

In Paligo, you can add:

• Alt text that applies to an image everywhere that image is used [342]

• Alt text that applies to an image in one topic only [343]

If you are publishing to PDF, we recommend that you also read Alt Text for Images in PDFs [344].
For alt text in PDFs, you will need to set Paligo to publish a tagged PDF.

NOTE
If you are going to have other versions of an image for different languages, use
the alt element for alt text [343]. The alt element content can be translated,
whereas the image description is always in the default language and is not
translated.

Alt Text that Applies to an Image in All Topics
To add alt text that applies to an image everywhere that image is used:

1. Add the image to a topic and then right-click on it and select Edit properties. Alternatively,
find the image in the Media section of the Content Manager, select its options menu ( ... ) and
then select Edit Image.
Paligo displays the Image details.
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2. Enter a description. This is the alt text for the image and will be used wherever that image
appears, unless the image has an alt element. (Alt elements take priority over the description).
Aim to provide a text description of the image, as if you were explaining what it shows to
someone with a visual impairment.

3. Select Update description to save.

NOTE
If an image does not have a description or an alt element, the title is used
instead. If there is no title, the filename of the image is used.

Alt Text that Applies to an Image in One Topic
If you want an alt text description to only apply to an image when it is used in one specific topic,
use the alt element. This approach is useful when you reuse an image in many topics, but you
want the description to be different, depending on the context of the topic.

You should also use the alt element if you have language variants of your images and want text
descriptions in different languages.

1. Add the image to the topic and then select the image.

2. In the Element Structure Menu, select the mediaobject element and choose Go to element
from the menu.

3. To display the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

4. Select the alt element.
Paligo adds an alt element above the image (but inside the mediaobject element in the
topic structure).
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5. Enter the text description in the alt element.

If you add an alt element, it is used instead of any description that is set for the image (in the
image properties). But the alt element only applies to the topic where you have added it. The
image will not have the alt element in any other topics where the image is used.

Aim to provide a text description of the image, as if you were explaining what it shows to someone
with a visual impairment. Try to include a keyword or synonym for your page. Do not use images
for "keyword stuffing".

NOTE
If an image does not have a description or an alt element, the title is used
instead. If there is no title, the filename of the image is used.

Alt Text for Images in PDFs
Your images in PDF outputs can use alternative text too, and it appears in a "hover pop-up" when
you position the cursor over an image. For accessibility, the alt text can also be detected by the
"Read Out Loud" feature in Adobe Reader .
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To use alt text in PDF outputs:

1. Add the alt text to the image. There are two ways to do this, depending on what you need,
see:

• Alt Text that Applies to an Image in All Topics [342]

• Alt Text that Applies to an Image in One Topic [343]

2. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

3. In the Layout Editor for the PDF layout, select General > Misc.

4. Set Generate tagged PDF to Enabled.

5. Select Save.

When you publish using this layout, the PDF will be tagged and will include the alt text you have set
for your images.

NOTE
To use alt text in PDF outputs, it is important that you do not use tagged PDFs
as images. For PDFs to use alt text, the layout has to have Generate tagged
PDF enabled. The PDF processor cannot complete the publishing if your content
contains tagged PDFs as images and Generate tagged PDF is enabled. You will
need to use untagged PDFs as images or use different types of image files.

If you try to publish content that has a tagged PDF embedded as an image and
the Generate tagged PDF enabled, you will get a "production failed" error.

Image Sizing
There are several image attributes that you can use to control the size of images in your Paligo
topics. You can add the attributes to the imagedata element, and the following sections explain
how to set the size values and what results to expect.
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NOTE
What would commonly be called the "height" of an image is called depth as
an attribute in Paligo. This is a legacy from DocBook, which Paligo uses as the
foundation for the Paligo content model.

Image Sizing Attributes
For vector images, such as SVG, you should only use contentwidth and contentdepth. These
can also be used for certain other use cases, such as if you want spacing around an image, see
Examples of Image Sizing [348].

In most cases, it is better to use the width and depth attributes as they are easier to predict. The
contentwidth and contentdepth can produce unexpected (but accurate) results with bitmap
images. This is because it is not always possible to determine the intrinsic image size of a bitmap
image when processing the output.

Define the image size by using one of the following attributes to the imagedata element:

• width - sets the width value in relation to the viewport.

• depth - sets the depth (height) value in relation to the viewport.

• contentwidth - sets the width value of the image and has no effect on the viewport.

• contentdepth - sets the depth (height) value of the image and has no effect on the viewport.

• scalefit - allows an image to be scaled up or down to fit within available space. If
scalefit="1" the image is scaled (with the same factor in both dimensions) so that the graphic
will just fit within the available height or width (whichever is more constraining). If any other
image size attribute is specified, those attributes determine the graphic size and scalefit will
be ignored.

The viewport is the available space for the imageobject on the page. Depending on which
element that is used on the imagedata element the result will differ. If you set the image:

• width to 50% - the image will be sized so that it takes up half of the available space on the
page.

• contentwidth to 50% - the image will be reduced to 50% of its original size.

To the left - The image (2) uses 50% of the viewport (1) To the right - The image (2) is reduced to 50% of
its original size (1)
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Set the Image Sizing Attributes
When you publish your content [1068], the images will be sized based on the values and attributes
you added. You can use the preview [482] to see what the sizing will look like in your different
outputs.

There are several other attributes to control width, height and so on. If you want to learn more
about the possibilities, see DocBook image sizing reference.

TIP
For HTML5 output, you can use the thumbnail [361] and lightbox [360] features to
add small versions of an image to a page. When a user selects the image, a larger
version is displayed.

To set the image sizing attributes:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select the image that you want to size.

3. Select the imagedata element in Element Structure Menu [52] and choose Go to element.

4. Add the sizing attribute(s) and set the value(s) in the Element Attributes Panel [55].
Typically, you should only set the width (or contentwidth) of an image. The depth (height)
is then calculated automatically, so that the image dimensions keep the same ratio as the
original image file.
If you do set height and width, the smallest value of the two is used, and the image is scaled
according to that.
When you set the value, you can use any of the Measurement Units for Image Sizing [348]. By
default, the sizes are in pixels.

TIP
For SVG images, use contentwidth and contentdepth instead of width and
depth.
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5. Select Save. 

Measurement Units for Image Sizing
When you set the value for a width, depth, contentwidth, or contentdepth attribute, you can
use any of these units:

px Pixels (the default unit if none is specified)

pt Points (1/72 of an inch)

c
m

Centimeters

m
m

Millimeters

pc Picas (1/6 of an inch)

in Inches

e
m

Ems (the font size of the current surrounding element)

% Percentage (of intrinsic image size for @contentwidth and @contentdepth, of the available
page area for @width  and @depth).

Examples of Image Sizing
Here are some examples of different image sizing combinations, designed to show you the
different effects the sizing attributes can have:

Attribute @contentwidth = 400px. Sets the width of the image itself.

(The value could be 400 or 400px, as "px" is the default if no unit is set.)
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Attribute @contentdepth = 400px. Sets the height of the image itself.

Attribute @width = 400px. Sets the width of the viewport of the image, which scales to fit to that
area. (The border is not added normally, it is just added here to illustrate the viewport.)

This is the most commonly used attribute for image size.
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Attribute @contentdepth = 400px, @width = 420px. If the @contentdepth or @contentwidth is
set, and a @width or @depth attribute is also set, with a higher value, it creates an area around the
image.

Align an Image
Use the align attribute to set the alignment for images.

1. Edit a topic that contains the image. Alternatively, add an image [310] or figure [318] to a topic.

2. Select the image.

3. In the element structure menu, select the imagedata element.

4. In the Element attributes section, add the align attribute and set its value.
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You can choose from:

• Left

• Center

• Right

5. Select Save.

For example, with the following image, we have given its imagedata element the align attribute.
The value of the attribute is set to center.
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Image File Names in HTML Output
When you publish HTML content in Paligo, any images in the output are given a file name. The file
name can be either:

• A unique ID that is based on the UUID of the image. This file name remains the same every time
you publish and is known as a "persistent" file name.

• A unique ID that is automatically generated by Paligo each time you publish. This file name will
be different each time you publish.

In most cases, the "persistent" file name is preferable, especially if you use GitHub or similar for
version control. For example, let's say that you have a publication with 200 topics and they all
contain images. You publish the publication several times, without changing the content at all.
Each time you publish, it is going to appear that all 200 topics and all the images have changed,
because all of the images have had new file names generated. But if you had "persistent" file
names, there would be no updates, which is correct.

However, if you have a particular need for the image file names to change each time you publish,
you can disable "persistent" file names.

To enable or disable "persistent" file names, use the System Settings [1817].

NOTE
The reason that we use IDs for file names is that the IDs are unique and are
supported for translations, imports, exports, etc. If we only used regular text file
names, there could be problems with special characters not being recognized by
other systems, or multiple files all having the same file name.

Set Image Class Names for Styling in CSS
If you publish HTML outputs, you may want to style your images, for example, you could add a
border around all of your images. To style images in HTML, use CSS to create the styling, upload
the CSS file to your HTML layout, and then republish.

For the CSS, you will need the image class names. There are default class names, which you can
use to style all images at once, or you can add your own custom class names. With your own
custom class names, you can style an individual image or multiple images of your choice.

NOTE
It is beyond the scope of the Paligo documentation to cover all of the possibilities
for styling images with CSS. There are many online resources for learning about
styling images with CSS, including www.w3schools.com.

TIP
To find out how to upload a CSS file that you have created, see Branding your
HTML Outputs with CSS [654].
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Default Class Names for Images in HTML
All images in your published HTML content have a class name. You will need the class name to
style the images with CSS.

By default, the class names are:

• mediaobject for block images

• inlinemediaobject for inline images.

In the published HTML, the mediaobject is the class name for a container <div> element, and the
image is inside the <div>.

Similarly, the inlinemediaobject class name is for a span element that contains the inline image.

You can use a CSS selector to style the image inside the mediaobject and inlinemediaobject
"containers". For example, to put a border around all mediaobjects, you could create a CSS file
containing the following styling:

.mediaobject img {
border: blue;    
border-style: dashed;
}

You would then upload that CSS file to your CSS layout and publish using that layout. The block
images in your published output would then have a blue dashed line as a border.
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If you apply styling to mediaobject or inlinemediaobject, it will apply to all images that
have that class name. So if the default settings are in place and none of your images have
a custom class name, styling mediaobject will affect all of your block images and styling
inlinemediaobject will affect all of your inline images.

If you only want to style specific images, you can give those images their own class names. There
are two ways to do this: you can Custom Class Names for Images - Role Attribute [354] or Custom
Class Names for Images - Taxonomy Tag [357] .

Custom Class Names for Images - Role Attribute
To style an individual image or perhaps a selection of images, you need to give the image(s) a
class name. The class name has to be different to the general mediaobject or inlinemediaobject
that is assigned to all images by default. When the class name is in place, that class can be styled
separately in your CSS.

One way to give an image a class name is to use the role attribute. You can set it on the image's
mediaobject element, and then set its value as the class name you want to use.

1. In Paligo, open the topic that contains the image you want to style once it is published.

2. Select the image and then, in the element structure menu, select the mediaobject element.
From the menu, select Go to element.
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NOTE
For inline images, use the inlinemediaobject element instead.

3. In the Element attributes section, use the Add attribute field to add a role attribute. For the
role attribute's value, enter the name you want to use as the class name. Use lower case.
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4. Select Save.

5. Use a code/text editor to create a custom CSS stylesheet file (or edit an existing CSS file that
you use for Paligo).
When Paligo publishes your content, the role is added to the "container" mediaobject <div>
or <span> inlinemediaobject for the image. For example, if you have a block image and add a
role with the value diagram-large, this will appear like this in the HTML:

<div class="mediaobject diagram-large">
    <div class="material-placeholder">
        <img src="image/1602519409130b.png" style="" alt="image2-
transparent.png" class="materialboxed">
    </div>
</div>

If you have an inline image and add a role with the value diagram-small, it will appear in the
HTML like this:

<span class="inlinemediaobject diagram-small">
    <img src="image/16025194086577.jpg" alt="large-version-
screenshot2.jpg">
</span>

To style the image rather than the container <div> or <span>, use a CSS selector to target the
image inside the container, for example:

.mediaobject.diagram-large img {
    border: blue;    
    border-style: dashed;
}

or for an inline image:

.inlinemediaobject.diagram-small img {
    border: blue;    
    border-style: dashed;
}
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6. Upload your CSS file to your HTML layout.
For more information on uploading CSS to HTML layouts see Branding your HTML Outputs
with CSS [654].

7. Publish your content using the HTML layout [1068] that contains the CSS file with the image
styling.

Paligo publishes the content and the output includes your CSS. The styles in your CSS take
precendence over the other CSS provided by Paligo, and the styling is applied to your images.

Custom Class Names for Images - Taxonomy Tag
To style an individual image or perhaps a selection of images, you need to give the image(s) a
class name. The class name has to be different to the general mediaobject or inlinemediaobject
that is assigned to all images by default. When the class name is in place, that class can be styled
separately in your CSS.

One way to add a class name for an image is to use taxonomy tags:

1. Select Layout and then edit the HTML5 layout you are going to use for publishing.
Alternatively, you can create a new HTML5 layout and edit that.

2. In the Classes and Attributes settings, set Output taxonomies as class names to Enable.

3. Select Save.

4. Select the Taxonomy Manager in the Content Manager [34] to open the structure. 

5. Either:

• Find an existing taxonomy tag and drag it on to the image in the Media section of the
content manager.
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• Create Taxonomies [1368] and Add Taxonomy Tags [1370] by dragging it on to the image in
the Media section of the content manager.

TIP
It can be easier to use the floating content panel when dragging taxonomy
tags on to images. To display the floating content panel, select the options
menu ( ... ) for the taxonomies tag and then select Floating content panel.

6. Publish your content using the HTML layout [1068] you edited in step 2.

7. View the published output in a browser. Use the browser's inspection tool to find the image in
the HTML. You should see that it has a class name that matches the taxonomy tag.

8. Use a code/text editor to create a custom CSS stylesheet file (or edit an existing CSS file that
you use for Paligo).
In the CSS, style the class that has been added for the image. For example, if you added a
taxonomy tag called "battery", the image in your HTML output would have these elements:

<div class="mediaobject taxonomy-product-battery">
    <div class="material-placeholder">
        <img src="image/
1602a53b445615.jpg" style="" alt="battery.jpg" class="materialboxed">
    </div>
</div>

So you could style the image by using a CSS selector to select the image inside the
class .taxonomy-product-battery. For example, to give the image a blue dashed border, you
could use:

.mediaobject.taxonomy-product-battery img {
    border: blue;    
    border-style: dashed;
}

9. In Paligo, select Layout and edit the layout that you used for publishing in step 6.

10. Upload your CSS file to your HTML layout.
For more information on uploading CSS to HTML layouts see Branding your HTML Outputs
with CSS [654].

11. Select Save.

12. Publish your content using the HTML layout [1068] that contains your custom CSS.
In the HTML output, the image should now be using the custom styling you defined in your
CSS.
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Hover Text using the Image Title
You can use the Image Title Attribute setting to add a title to an image in your HTML5 output.
The title is shown as text in a tooltip when you position the cursor over the image.

1. Set the text that you want to appear as the title. To do this, edit the topic that contains the
image and then right-click on it. Select Edit Properties and then select the edit icon for the
Title field. Enter the text that you want to use as the title, and then close the dialog.

NOTE
Image titles can only be in one language.

2. Select Save.

3. Select Layout and then edit the HTML5 layout you are going to use for publishing.
Alternatively, you can create a new HTML5 layout and edit that.

4. Select Images.

5. Set Image title attribute to Enable.
If you set Image title attribute to Disable, the hover tooltip will not appear on the image in the
published HTML5 output.

6. Select Save.
When you publish to HTML5 using this layout, the image in your output will have a tooltip that
shows the title text.
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Lightbox for Images
In your HTML5 output, you can have small images that are shown at a larger size when they are
selected. The larger version of the image is shown in a "lightbox", which is a separate display that
overlays your content. The lightbox feature is especially useful when you have large images that
take up too much space on the page, and would provide a better experience for users if they were
smaller (shown as a thumbnail [361]).

Thumbnail images are shown at a smaller size on the page If lightbox is enabled, a user can select a thumbnail image to
view it at a larger size
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TIP
The lightbox feature is also available for Zendesk outputs, but it is set up
differently. For Zendesk, Paligo has asset files that are included in the zip file that
is downloaded in your browser when you publish. You can upload those asset
files to the Assets section in Zendesk guide, and then add the following code to
the Document head section:

<link href="{{asset 'lightbox.min.css'}}" rel="stylesheet" \
type="text/css" />
<script src="{{asset 'lightbox.min.js'}}"></script>
<script src="{{asset 'paligo-zd-lightbox.js'}}"></script>

You only need to do this once, the first time you publish to Zendesk.

For more details, see Customize Zendesk Articles Using Javascript [1592].

To enable or disable the lightbox feature for all of the images in your HTML5 output:

1. Select Layout and then edit the HTML5 layout you are going to use for publishing.
Alternatively, you can create a new HTML5 layout and edit that.

2. Select Images.

3. Set the Use lightbox for images to Enable if you want all block images to use the lightbox
feature. Set it to Disable to turn off the lightbox feature.

NOTE
If you enable the lightbox feature, you can either set all block images to use
thumbnails or you can set thumbnails individually. To find out more, see
Thumbnail Images [361].

4. Select Save.

Thumbnail Images
You may have content that needs to have large images, but these images take up too much space
on the page and make it more difficult to read the text. One way to handle this for HTML5 outputs
is to use "thumbnails". This is where large images are shown at a much smaller size on the page.
If you also enable the lightbox feature [360], readers can click on the thumbnail image to display a
larger version.
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Thumbnail images are shown at a smaller size on the page If lightbox is enabled, a user can select a thumbnail image to
view it at a larger size

In Paligo, you can Set All Images as Thumbnails [362] from the HTML5 layout or you can Set
Thumbnails for Individual Images [363].

Set All Images as Thumbnails
If you want all block images to appear as thumbnails in your HTML5 output, use the Use
thumbnails for all mediaobject (block) images setting. This is in the HTML5 layout. This can
be useful when you have large images that take up too much space on the page. By setting them
as "thumbnail" images, they will appear much smaller. You should also enable the lightbox feature
so that end users can select the images to display a larger version.

When you enable the setting and publish, the images will appear as smaller "thumbnail" images.
We recommend that you also enable the lightbox feature [360] so that your readers can select the
"thumbnail" images to display a larger version.

The default width for thumbnails is 250px. You can use custom CSS to change the width if needed.

TIP
If you only want certain images to appear as thumbnails, set Use thumbnails for
all mediaobject (block) images to Disable. Then follow the instructions in Set
Thumbnails for Individual Images [363].

1. Select Layout and then edit the HTML5 layout you are going to use for publishing.
Alternatively, you can create a new HTML5 layout and edit that.

2. Select Images.

3. Set the Use thumbnails for all mediaobject (block) images to Enable if you want all block
images to appear as thumbnails. Set it to Disable if you do not want all block images to be
thumbnails.
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4. Select Save.

Set Thumbnails for Individual Images
You can set the thumbnail feature for individual images rather than for all block images at once.
This is useful if you only want the thumbnail feature for certain images, for example, if most of
your images are fine at their regular size but you have a small number of unusually large images to
include too.

To use the thumbnail feature for individual images:

1. Select Layout and then edit the HTML5 layout you are going to use for publishing.
Alternatively, you can create a new HTML5 layout and edit that.

2. In the Images settings, set Use thumbnails for all mediaobject (block) images to default or
Disable.

To allow users to click on your thumbnail image to display it at a larger size, you should also
set Use Lightbox for images to Enable.
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3. In the Classes and attributes settings, set Output 'role' attribute as class names to Enable.

4. Select Save.

5. Open the topic that contains the image and then select the image.

6. In the Element Structure Menu, select the image's mediaobject element and then select Go
to element.

7. In the Element attributes section, add the role attribute and set its value to img-thumbnail.

8. Select Save.

By default the thumbnail will get a rounded border and a max width and height of 200 pixels. This
can be customized in your CSS. 
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NOTE
If you are publishing to other outputs, such as PDF, you may need to have
a specific width on the image too. For this, use the @contentwidth attribute
instead of @width, otherwise the thumbnail feature may not work as intended.

TIP
If you want most, but not all, images to use thumbnails it may be quicker to set all
images to use thumbnails in the HTML layout [362]. You can then exclude some
images from using thumbnails by adding a role attribute to the mediaobject
element and setting its value to img-thumbnail-reset.

Borders for Images (HTML)
For HTML outputs, you can use CSS to add borders around images and sections that contain
images. For example, you could add a pink dotted line around your images, like this:

To create the pink dotted line border, we used this CSS:
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.mediaobject img {
    border: 3px dotted #FF1493; padding:1em;
}

Our sample CSS styling works like this:

• The .mediaobject img defines the class we are going to style. There are different classes for the
different image types, as explained in Borders on All Images (HTML) [366].

• border: defines the start of the border styling.

• 3px is the width of the border line

• dotted is the style of the border line

• #FF1493 is the color

• padding: defines the start of the padding styling. The padding is the space between the image
and the border.

When you style your own borders, you can use similar CSS. There are other border styles you
could apply too, and if you want to find out more, we recommend the w3schools website as a
resource.

Your next step is to decide how and where you want to use image borders:

• To add borders to all images (based on type), see: Borders on All Images (HTML) [366].

• To add borders to selected images, see:Borders on Selected Images Only (HTML) [369].

• To exclude some images from the border settings, see:Exclude an Image from the Border Styles
(HTML) [372].

NOTE
For information on setting image borders for PDF outputs, see Borders for Images
(PDF) [373].

Borders on All Images (HTML)
You can use CSS to add borders around all images, based on the image type. For example, you
could add borders around all block images, but leave inline images to have no borders.

With images that are inside figures and informalfigures, you also have the option to add a border
around the entire figure/informalfigure section. So you could have a border around the section,
but not the image. Or you could have different borders around both.
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To use CSS to style image borders for HTML ouputs, follow the steps below. Note that for the
examples provided, we have used a pink dotted border that is 3px wide. There is 1em padding
(internal margin) on each image too. You can change the sizing, style, and padding as required.

TIP
For information on using CSS for border styles, we recommend the w3schools
website.

1. Use a code editor or text editor to create a CSS file. Give it a name and save it with the .css
extension.

NOTE
If you already use a custom CSS for your layout, you should edit that CSS file
instead.

2. Enter the CSS for the border styles you want.
To style block images, add your border styling for the .mediaobject img class. For example:

.mediaobject img {
    border: 3px dotted #FF1493; padding:1em;
}

To style figure sections, add your border styling for the .figure class. For example:

.figure {
    border: 3px dotted #FF1493; padding:1em;
}
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To style informalfigure sections, add your border styling for the .informalfigure class. For
example:

.informalfigure {
  border: 3px dotted #FF1493; padding:1em;
}

To style inline images, add your border styling for the .inlinemediaobject class. For
example:

.inlinemediaobject {
  border: 3px dotted #FF1493; padding:1em;
}

NOTE
The figure and informalfigure classes are for styling the figure and
informalfigure sections, not the images inside them. The images inside the
sections are either block images that you can style with mediaobject img or
inline images that you can style with inlinemediaobject.

3. Save your CSS file.

4. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

5. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

6. Select CSS, JS, logos and other assets.

7. Upload your CSS file in the CSS section.

IMPORTANT
When you upload a CSS file, it will replace any CSS file that is currently
associated with the layout.
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NOTE
If you are using an HTML layout rather than an HTML5 layout, the CSS upload
feature is in the General category.

8. Select Save. 

When you publish with that layout, the CSS styles will be applied to your published output.

Borders on Selected Images Only (HTML)
If you only want to apply borders to specific images, follow these steps:

1. Open a topic that contains the image and then select the image.

2. In the Element Structure Menu, select the "parent" element for the content that you want to
style.
For a block image, the element is mediaobject
For an inline image, the element is inlinemediaobject
For a figure, the element is figure
For an informal figure, the element is informalfigure

3. Select Go to element.

Paligo Documentation

369



4. In the Element attributes section, use the Add attribute field to give the element the role
attribute. Give the attribute a name as the value. We recommend that you use a name that is
easy to recognize, for example, specialborder.

5. Select Save.

6. Use a code editor or text editor to create a CSS file. Give it a name and save it with the .css
extension.
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If you already use a custom CSS for your layout, you should edit that CSS file instead.

7. To add borders that will only be used by images that have the defined role, add this code to
your CSS:

.specialborder img {
    border: 3px dotted #FF1493; padding:1em;
}

Where:
specialborder is the name of the value you gave to the role attribute in step 4.

NOTE
You can change the border style and color to meet your own requirements.
The values used here are just examples.

8. Save your CSS.

9. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

10. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

11. Select CSS, JS, logos and other assets.

12. Upload your CSS file in the CSS section.

IMPORTANT
When you upload a CSS file, it will replace any CSS file that is currently
associated with the layout.
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NOTE
If you are using an HTML layout rather than an HTML5 layout, the CSS upload
feature is in the General category.

13. Select Save. 

When you publish with that layout, the CSS styles will be applied to your published output.

Exclude an Image from the Border Styles (HTML)
You may find that you want most of your images to have borders, but there are some exceptions
and these need to have no borders. Rather then set up every image border independently, you
can apply borders to all images and then set your "exception" images to use different styling.

1. Set the border styles that you want to apply to those images that are to have borders. For this,
follow the instructions in Borders on All Images (HTML) [366].

2. Open a topic that contains one of the images that are to have no borders.

3. Select the mediaobject element for the image.

4. In the Element attributes section, add the role attribute and give it a value of:
noborder

5. Select Save.

6. Use a code editor or text editor to create a CSS file. Give it a name and save it with the .css
extension.
If you already use a custom CSS for your layout, you should edit that CSS file instead.

7. To disable borders on those images with the role you created in step 4, add this code to your
CSS:

.mediaobject.noborder img {
    border: none;
}

8. Save your CSS file.

9. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

10. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

11. Select CSS, JS, logos and other assets.
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12. Upload your CSS file in the CSS section.

IMPORTANT
When you upload a CSS file, it will replace any CSS file that is currently
associated with the layout.

NOTE
If you are using an HTML layout rather than an HTML5 layout, the CSS upload
feature is in the General category.

13. Select Save. 

When you publish with that layout, the CSS styles will be applied to your published output.

Borders for Images (PDF)
For PDF outputs, you can add borders around images. For example, you could add a pink dotted
line around your images, like this:

It's also possible to add borders around the space that contains the image on a page.

When setting the image borders for PDFs, you can use the:

• PDF layout to set the default image borders that will apply to all images, inline images, figures,
and informal figures.

• role attribute to define specific image border styles that will only apply to one specific image.

Your next step is to decide what types of image should have borders.

To add borders to:

• All block images, see: Borders on Block Images (PDF) [374].
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• All figures or all informalfigures, see: Borders on Formal Figures and Informal Figures
(PDF) [376].

• Inline images, see: Borders on Inline Images (PDF) [377].

• Selected images only, see: Borders on Selected Images Only (PDF) [377].

NOTE
For information on adding borders for HMTL outputs, see Borders for Images
(HTML) [365].

Borders on Block Images (PDF)
The PDF layout editor has settings for adding borders around your block images. These settings
are the borders that will apply to all block images by default.

Block image with a dotted pink border.

To set a border that will apply to all block images in your PDF layout:

1. Make sure that all of the images you want to style have a width attribute and a value for the
width. This has to be set on the imagedata element.
To add a width attribute, select the image and then select its imagedata element in the
Element Structure Menu. Select Go to element, and then in the Element attributes section,
add the width attribute and value.
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2. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

3. Select General > Images.

4. Set the Default border for images.
This setting adds a border around block images (images that are on a new line). When you set
the default border, include the size, the style, and the color. The syntax for this is: size, style,
color. For example:
0.5pt dotted #FF1493
The styles you can use are none, hidden, dotted, dashed, solid, double, groove, ridge, inset,
and onset.

5. Set the Default border radius for images.
This setting gives borders rounded corners.
When setting a rounded corner, it is important to consider the style of the border too. To get
rounded corners, you can use padding to get it as a frame. Alternatively, you can "cut" the
corners of the image, and to do this, you will need to experiment with setting the border color
to match the background color of the page, for example, white. Usually, a ratio of 3 provides a
good result, for example, border = 3pt solid white and border radius = 9pt.

6. Use Default padding for images to set the amount of space between the image and the
border (the "inner" margin).

7. Select Save.

When you publish to PDF using this layout, your block images will have a border that matches the
styles you have set.
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NOTE
To define borders that only apply to one specific image, see Borders on Selected
Images Only (PDF) [377].

Borders on Formal Figures and Informal Figures (PDF)
If you have a figure or informalfigure in your content, you can apply borders to the figure/
informalfigure element. These settings do not affect the border around the actual image, they only
affect the border of the figure/informalfigure "container".

A figure "container" with a green ridge border and gray background. Note that the pink dotted border
around the image is the border set for block images.

To define the default border settings that will apply to all figures/informalfigures:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select Formal elements > Figure.

3. Use the border settings to define the styles for the border. There are settings for width,
border line style, border color, background color, and padding (internal margin).
These settings will apply to any formal elements in your content.

4. Select Formal elements > Informalfigure.

5. Use the border settings to style the informalfigure border.
These settings work in the same way as the formal figure options in step 3, except that they
apply to the informalfigure element instead of the figure element.

6. Select Save.

When you publish to PDF using this layout, your figure and informalfigure "containers" have
a border that matches the styles you have set.

NOTE
To define borders that only apply to one specific image, see Borders on Selected
Images Only (PDF) [377].
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Borders on Inline Images (PDF)
You can set borders that will apply to all of your inline images by default. For this type of border,
your inline images need to be inside a guiicon element, which you can add from the element
context menu.

Inline image with pink dotted border.

To define the default border settings that will apply to all inline images, follow the steps below.

1. Make sure the inline images are inside a guiicon element. The inlinemediaobject
element has to be inside a guiicon element.
Use the element context menu to add the guiicon element. You can select Insert > Image >
Inline image to add the inlinemediaobject.

TIP
To display the element context menu, press Alt  and Enter  (Windows) or

Option ⌥  and Enter  (Mac).

2. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

3. Select Inline elements > guiicon.

4. Use the border settings to style the width, line style, color, background color, and padding
(internal margin).

5. Select Save.

When you publish to PDF using this layout, your inline images will have a border that matches the
styles you have set.

NOTE
To define borders that only apply to one specific image, see Borders on Selected
Images Only (PDF) [377].

Borders on Selected Images Only (PDF)
You can set borders on individual images and these borders will override any borders that are
set in the PDF layout. For example, if your PDF layout sets all images to have a black dashed
border, you could set one image to have a dotted red border. That image's own settings (dotted
red border) take priority over the border settings in the layout.

To set the borders on a specific image:

1. Open a topic that contains the image you want to have borders.
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2. Select the image and then in the Element Structure Menu, select the imagedata element and
Go to element.

3. Make sure that your image has a width attribute and a value. This has to be set on the
imagedata element.
To add a width attribute, select the image and then select its imagedata element in the
Element Structure Menu. Select Go to element, and then in the Element attributes section,
add the width attribute and value.

4. Use the Add attribute field to give the imagedata element the role attribute.

5. For the role attribute value, enter the border settings, for example:
border: 0.25pt solid silver; border-radius: 3pt; padding: 15pt;

The syntax here is similar to that used for CSS and HTML [365], but only border, border-radius,
and padding properties are supported.
Use semi-colons to separate the settings. The example above shows a border that is 0.25pt
wide, solid line, and silver. It has a border radius of 3pt (rounded corners) and interior spacing
(padding) of 15pt.

6. Select Save.

When you publish to PDF, the image will have the border settings that you applied specifically to
that image, rather than those defined in the PDF layout.

Inserting 3D models
You can insert fully interactive 3D models in your HTML5 Help Center output, which you can
rotate, zoom in and out, and have interactive callouts in.
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Paligo supports the same formats as SketchFab for embedding 3D models in HTML. This includes
most common 3D formats, such as formats for Solidworks, 3D Studio Max, Rhino, and many more.

Inserting a 3D model works very similar to how you insert a video, and in fact you use the same
element, i.e a mediaobject with a videoobject (most easily inserted through the toolbar menu
command Insert video).

NOTE
Currently, the 3D hosting platform supported for inserting 3D models is
SketchFab (https://sketchfab.com/). There are different accounts available from
free to Business with private access.

Should you be interested in support for another 3D hosting platform, please
submit a request to support.

1. Create an account on Sketchfab, if you don't already have one.

2. Upload 3D models to the platform.

3. Open the embed code on a 3D object you want to add in Paligo. Get only the value in the @src
attribute.

4. Paste the @src attribute value in the widget for the videoobject element, or in the
@fileref attribute in the Element attributes widget on the right (with the videodata
element selected).
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Audio
Abstract

You can add links to audio files in your topics so that they can be played in published HTML
outputs. The audio files must be hosted elsewhere, for example, in a repository.

You can add links to external audio sources in your topics (these must be audio files hosted
elsewhere, you cannot upload audio files to Paligo). When you publish to HTML, the page for the
topic will include a player that you can use to play the audio file.

NOTE
If you publish to PDF, the page will include a link to the audio file.

To add a link to an external audio source:

1. Create a new topic [131] or edit an existing one by selecting it in the Content Manager.

2. Position the cursor at a valid position for a mediaobject element. For example, on the next
line after a para element.

3. Use the Element Context Menu to add a mediaobject element.
To display the Element Context Menu, use the shortcuts:

Windows: Alt  + Enter

Mac: Command ⌘  + Enter

When you add a mediaobject element, it contains an imageobject by default.
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4. In the Element Structure Menu, select the imageobject element and then select Delete.

You are left with just the mediaobject element.

5. Select the mediaobject element and then use the Element Context Menu to add the
audioobject element.

6. Select the audioobject element and then use the Element Context Menu to add the
audiodata element.

7. Select the audiodata element and then use the Element Context Menu to add the
multimediaparam element.
You should now have a structure like this: mediaobject > audioobject > audiodata >
multimediaparam

The mediaobject, audioobject, and audiodata are the elements that are needed for the
audio link. The multimediaparam element is needed to provide the audio player.

8. Select the multimediaparam element and then use the Element attributes section to add
these attributes and values:

• name: controls

• value: true
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NOTE
There are other multimediaparam attributes and values that you can use. For
details, see Autoplay, Mute, and Download for Audio [384].

9. Select the audiodata element and then use the Element attributes section to add the fileref
attribute. Set the value of the fileref attribute to the URL for the audio file, for example,
https://file-examples-com.github.io/uploads/2017/11/file_example_MP3_700KB.mp3.

10. Select Save.

When you publish this content to HTML, the page for the topic will contain an embedded audio file
player that you can use to play the audio file (as long as there is an Internet connection available).

Example 24. Audio file stored in GitHub

Here is a sample of an entire topic. It contains a link to an audio file, and the link is part of step 2 in
a procedure list.

Paligo Documentation

382



The source code of this topic looks like this:

<?xml version="1.0"?>
<section xmlns="http://docbook.org/ns/docbook" xmlns:xinfo="http://
ns.expertinfo.se/cms/xmlns/1.0" xml:id="UUID-75e269ad-3848-623e-3f4d-
aadec221fac4" version="5.0" xml:lang="en" \
xinfo:resource="UUID-75e269ad-3848-623e-3f4d-aadec221fac4" xinfo:resource-
id="14240" xinfo:resource-type="component" xinfo:resource-title="Audio \
file is stored in GitHub" xinfo:resource-titlelabel="" xinfo:version-
major="1" xinfo:version-minor="0">
  <title xinfo:text="14241">Audio file is stored in GitHub</title>
  <para xinfo:text="14242">This topic contains instructions for playing an \
audio file.</para>
  <procedure>
    <step>
      <para xinfo:text="14243">Open the page that contains the audio \
content. The audio is embedded in the page, but is actually stored in \
GitHub.</para>
    </step>
    <step>
      <para xinfo:text="14244">Use the media player to play the audio.</
para>
      <mediaobject>
        <audioobject>
          <audiodata fileref="https://file-examples-com.github.io/uploads/
2017/11/file_example_MP3_700KB.mp3">
            <multimediaparam name="controls" value="true"></multimediaparam>
          </audiodata>
        </audioobject>
      </mediaobject>
      <mediaobject></mediaobject>
    </step>
    <step>
      <para xinfo:text="14245">Stop the audio.</para>
    </step>
  </procedure>
</section>

The published HTML version of the topic has a media player that plays the audio file that is stored
in GitHub.
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Autoplay, Mute, and Download for Audio
You can use the attributes for the multimediaparam element to control whether the audio file
plays automatically, is muted, and how it downloads. The following table shows the attributes you
can use.

Table 1. List of supported multimediaparam attributes for audio links

Name Description

controls If set to true, this adds controls to your audio object.

Example:

<multimediaparam name="controls" value="true"></multimediaparam>

autoplay If set to true, it automatically plays the audio when the page loads.

Example:

<multimediaparam name="controls" value="true"></multimediaparam>
<multimediaparam name="autoplay" value="true"></multimediaparam>

loop If set to true, the audio will repeat indefinitely.

Example:

<multimediaparam name="controls" value="true"></multimediaparam>
<multimediaparam name="loop" value="true"></multimediaparam>

muted If set to true, the audio is muted. To hear the audio, the user has to adjust the volume on the player.

Example:

<multimediaparam name="controls" value="true"></multimediaparam>
<multimediaparam name="muted" value="true"></multimediaparam>
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Name Description

preload If set to none, the browser will download the audio the file when the playback starts.

If set to auto, the browser can download the audio file in advance, even if the user does not play the audio.

If set to metadata, the browser will only download the audio file's metadata in advance.

If preload is not included, most browsers will only download metadata about the file.

Example:

<multimediaparam name="controls" value="true"></multimediaparam>
<multimediaparam name="preload" value="auto"></multimediaparam>

NOTE
To remove an effect, delete that attribute and value for the multimediaparam
element. For example, if a multimediaparam has loop set to true and you do not
want it to play repeatedly, remove the loop attribute and its true value.

Insert a Video
If you are publishing to HTML or HTML5, you can add links to videos to your topics. When you
publish your content to a web server, the videos will appear on your pages as embedded content.

Paligo supports videos on YouTube, Vimeo, Wistia, or Microsoft Stream. If you want to use another
video service, it may be possible, but could require a customization (contact support for advice).

(Microsoft Stream videos require that the user has an account to view the video.)

TIP
If you also publish to PDF, the video will appear, but as a hyperlink to the
video. By default, the link text will display the url, but you can add a caption
in your mediaobject element, an alternative image to display, or the alt or
textobject elements (if you don't want a caption in HTML output).

1. Select the video icon in the toolbar: .
A video frame appears.

2. Select the frame to display a popup toolbar, and insert the link to the video.

• For YouTube, use the share link.

• For Vimeo use the embed link.

• For Wistia, you can use either the regular Inline embed, or the iFrame (fallback) embed link:
Only get the url from the @src attribute in the script tag (ending with .jsonp), or the @src
attribute in the iframe element for the iFrame fallback version. Read more about the types
here: Inline embed,  Fallback (iframe) Embed.
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NOTE
The Wistia video embed is by default responsive, adapting to the size of the
screen. But it has a default @max-width value set to 620px. If you want to
change that default width, override this property in your CSS:

.video-container.wistia{
    max-width: 620px; 
}

If you want it to utilize the entire screen space, just set the value to none.

3. Save, and the preview of the video appears for YouTube and Vimeo videos.
Microsoft Stream and Wistia currently do not show you the preview in the editor, but will work
just fine when you publish.

When you publish to HTML or HTML5 you should now see the video embedded in your content.

NOTE
If you are publishing videos to Zendesk, but cannot see them, you need to enable
videos in the Zendesk settings: Why are videos not displaying in Help Center?

Autoplay, Start Time, and Other Video Options
It is also possible to set options for your video, for some of the available video formats. For
example if you want the video to start playing as soon as the page is viewed, or if you want it to
start at a particular time into the video. This is done a bit differently depending on what video
platform you use:

YouTube

1. Add a "querystring" at the end of the embedcode, e.g ?autoplay=1 to autoplay the video.

2. To add more than one option, add them with an ampersand after the first option, e.g ?
autoplay=1&start=34. Note that the start time option does not use any unit, just specify it
as the number of seconds.
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TIP
See YouTube Embedded Players and Player Parameters for a complete list of
possible options.

Vimeo

• Set options the same way as for YouTube videos, with the exception that start time uses a
hash (#) instead of a question mark or ampersand (for example, #t=1m2s)

TIP
See Using Player Parameters for a complete list of possible options.

Wistia

1. Add an autoplay attribute.
(Note that it is used for more options than just autoplay)

2. Set the options according to the format specified by Wistia, but separated with semicolons,
e.g autoPlay=true;time=0m34s to set it to autoplay and start at 34 seconds in. Take care to
use the correct capitalization of the properties.

TIP
See Embed Options and Plugin for a complete list of possible options.

Labels
If you have text content that you want to stand out in a certain way, it's possible to create
something we call "labels". This is very similar to bootstrap labels (see Bootstrap badges and
labels), and in fact the HTML5 output creates just such labels. However, it works in PDF as well.

Example 25. Example labels

Default label  Primary label  Success label  Info label  Warning label  Danger label

These can be used for any purpose you need, and the names are only markers that will create a
label of the designated color. You should not use these instead of proper admonitions (warning,
caution, etc).

To create a label:

1. Add a phrase element with the text content you want for your label.

2. Add the @role attribute and give it one of these values, depending on which label you want:
"label-default", "label-primary", "label-success", "label-info", "label-warning", or "label-danger".

Mathematics
To add mathematics, such as equations, there are two available math editors in Paligo. Learn how
to switch between them, see Choose a Math Editor [388].

Paligo Documentation

387

https://developers.google.com/youtube/player_parameters
https://vimeo.zendesk.com/hc/en-us/articles/360001494447-Using-Player-Parameters
https://wistia.com/support/developers/embed-options
https://www.w3schools.com/bootstrap/bootstrap_badges_labels.asp
https://www.w3schools.com/bootstrap/bootstrap_badges_labels.asp


• MathQuill is the default built-in math editor in Paligo. To learn how to use it, see Use the Built-In
Math Editor [390].

• MathType provides more advanced mathematical features and requires a Wiris MathType
subscription. This is available on the Enterprise plan . To learn how to access the it, see Use the
MathType Editor [392].

Choose a Math Editor
Paligo's built-in editor MathQuill is the default math editor. It is free to use and you can use it
to create simple equations. If you need to use more complex equations, you can switch to the
MathType editor instead, although this does require a Wiris MathType subscription.

NOTE
The MathType editor is backwards-compatible with the built-in editor, so you can
switch between them if needed.

To choose which math editor to use:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select Editor settings in the toolbar. 

3. Paligo displays the Editor Settings dialog.
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The editor settings are global and will apply to all the topics and publications that you work with.
The settings will only be applied to your user account.

4. Select the Editing tab.

5. Scroll down to the MathType Editor section.

6. Select Use the Mathtype editor for editing math expression box to choose the math editor
you want to use for your topics:

• Check the box if you want to use MathType.

• Clear the box if you want to use Paligo's built-in math editor.

7. Select Save Settings.
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Use the Built-In Math Editor
The default enabled built-in math editor is a customized version of MathQuill. It has less features
than the MathType editor, but is free to use in Paligo.

Enter commands, such as fraction and multiplication, by using commonly used keys, such as / and

*. The editor will generate proper math display of these. Remember to type a space  after each

"backslash command".

Enter commands, such as fraction and multiplication, by using commonly used keys, such as / and

*. The editor will generate proper math display of these. Remember to type a space  after each

"backslash command".

NOTE
Note that if you are going to publish to help desk, you cannot use math
expressions there, as the HTML tags are not allowed on those platforms. You
may then have to make a special version of that content for publishing there.

1. Open a topic via the Content Manager [34].

2. Position the cursor where the equation is to be added.

3. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

4. Enter Equation and select it from the menu.

5. Double-click the added equation element to display the math editor.
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NOTE
If you see a more complex math editor, then the MathType editor is enabled
for your topic.

6. Use the math editor's features to create the equation. Below are some examples of
commands you can use.
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TIP
For a more complete list of commands, see this web site: List of math
commands

There are also many videos on YouTube showing the basics of these
commands: YouTube introduction videos for compatible math commands

7. Select Insert to add your mathematic equation to your content.

8. Repeat this process for each equation that you need.

9. Select Save. 

Use the MathType Editor
The MathType editor has more features than the default built-in math editor MathQuill. To be able
to use the MathType editor, you need:
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• Paligo Enterprise plan

• A Wiris MathType subscription.

• To provide Wiris with the URL of your Paligo instance. Wiris need this to set up the integration
with Paligo in their system. You cannot use the MathType editor until Wiris have set up the
integration for you and confirmed the integration.

• To enable the MathType editor in Paligo, see Choose a Math Editor [388].

NOTE
Note that if you are going to publish to help desk, you cannot use math
expressions there, as the HTML tags are not allowed on those platforms. You
may then have to make a special version of that content for publishing there.

1. Open a topic via the Content Manager [34].

2. Position the cursor where the equation is to be added.

3. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

4. Enter Equation and select it from the menu.

5. Double-click the added equation element to display the math editor.
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6. Use the math editor's features to create the equation. To learn how to use the MathType
editor, see the official MathType documentation.

7. Select Insert to add your mathematic equation to your content.

8. Repeat this process for each equation that you need.

9. Select Save. 

Footnotes
Footnotes are useful for adding citations or references to notes or in your text. When you add a
footnote, a number appears in the text and it is a reference to a note that appears at the bottom
of the page or table.

In Paligo, you can create as many footnotes as you need in each topic. If you need to refer to the
same footnote several times in the same topic, you can create the footnote once, and then use
footnote references to refer back to it.

Create a Footnote
To create a footnote in a topic:

1. Edit a topic and select the position in your text where you want the first reference to the
footnote to appear.

NOTE
For example, if you have a topic where three paragraphs all need to reference
the footnote, select a position in the first of these paragraphs.

2. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].
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3. Enter footnote and select it from the menu.

NOTE
Paligo adds a footnote and it appears below the selected text. This is so that
there is plenty of space for you to enter the footnote text. When you publish
the content, the footnote will not appear here, it will be in the footnotes at
the bottom of the page.

If you add a footnote in a table cell, Paligo adds the list of footnotes after the
table.

4. Enter the text for the footnote in the para element that appears below the footnote element.

5. Select Save. 

TIP
If you need to refer to the same footnote again, see Refer to Existing
Footnote [396].
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Refer to Existing Footnote
To refer to a footnote that already exists in your topic, use the footnoteref element. For this to
work, the footnote needs to have an ID and you also need to use the linkedto attribute.

When you publish the topic, both the footnote and the footnoteref will have references to the
same footnote.

1. Open the topic that contains the footnote.

2. Select the footnote in the text.

3. Look in the Element Attributes Panel [55].

• If the footnote does not have an xml:id, you need to generate an ID, see step 4.

• If the footnote has an xml:id, skip step 4 and continue with step 5 to copy the xml:id.

4. Select the footnote element in the Element Context Menu [54] and choose Generate ID.

Paligo creates an ID for the footnote element.

5. Copy the entire value of the xml:id including the footnote-idm prefix in Element Attributes
Panel [55].
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6. Select the position for the next footnote to appear.

7. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

8. Enter footnoteref and select it from the menu.

9. Select the footnoteref element in the text.

10. Paste the xmlid of the footnote as the value for linkend element in Element Attributes
Panel [55].

11. Select Save. 

Create Revision History Topics
A revision history is a list with a summary of the changes made to a document. They are useful
as they provide an audit trail of the changes made to a document, with details of who made the
changes, what the changes were, and when they were added.

For a PDF output, a revision history looks like this:
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TIP
To view revision history, see View Revision History [1667].

To create a revision history topic:

1. Create a new topic. Give it a suitable name, such as "Revision History" and then open it in the
editor.
There are many ways to create a new topic, including:

• Select New Topic from a publication's structure view

• Select Create Content from a folder's options menu ( ... ) and then choose Topic.
For details, see Create a Topic [131].

2. Use the element context menu to add an info element to the topic.

To access the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

3. Select the info element and then use the element context menu to add a revhistory
element.
When you add a revhistory element, Paligo adds child elements to it automatically.

The child elements are:

• revision

This is a container element for the revnumber, date, authorinitials and revremark
elements. You need the revision for the structure, but do not enter any information directly
into it.

• revnumber

Enter the number of the revision, for example, 6 if this is the sixth revision to the content.

• date
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Paligo inserts the date automatically, by default. You can overwrite it with a different date if
you wish.

• authorinitials

Paligo inserts the name of the person who adds the revision element, by default. You can
overwrite it with a different name or initials if you wish.

• revremark

Enter a brief description of the changes that have been made. This will help other users to
understand what each revision included and why the changes were made.

TIP
You can delete an element if you do not want to include that information in
the revision history, for example, you could delete the date element.

4. To add more revisions, select the revhistory element and then use the element context
menu to add a revision element inside it. Paligo adds the revision element and its
revnumber, date, authorinitials, and revremark.

NOTE
You can add multiple revision elements inside a revhistory element.

5. Select Save.

6. If your revision history topic is not already in a publication, add it by editing the publication
structure. Typically, the revision history is added as the first topic so that it appears before
the main documentation, but you could add it to any position in the publication. You may also
want to put an output filter on the section element so that the revision history is not included
in outputs but remains in the publication for internal use. To learn how to filter content, see
Filtering / Profiling [1141]).

When you publish your content, the revision history topic is included as part of the output (unless
you have filtered it out). For HTML outputs, you can use CSS to control the styling of the revision
history details (see Branding your HTML Outputs with CSS [654]). For PDF outputs, only the default
styling is available, although it is possible to change the styling as part of a customization project
(contact customer support for details).

Example 26. Revhistory and revision structure
The following code shows the XML for a valid revision history topic. We have removed the XML IDs
and attributes for clarity. When you create your own revision history, the elements will have XML
IDs and attributes added when you save.

<?xml version="1.0"?>
<section>
    <title>Revision History</title>
    <info>
        <revhistory>
            <revision>
                <revnumber>2</revnumber> 
                <date>24 May 2022</date> 
                <authorinitials>CW</authorinitials> 
                <revremark>Added information on recycling and ordering \
replacement parts.</revremark>
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            </revision>
            <revision>
                <revnumber>1</revnumber> 
                <date>20 May 2022</date> 
                <authorinitials>CW</authorinitials>
                <revremark>Added legal information in front matter.</
revremark>
            </revision>
        </revhistory>
    </info>
</section>

Glossary Topics and References
Abstract

Learn how to make a glossary topic in Paligo and then add references to your glossary in your
content.

Technical documentation often includes a glossary, where technical terms are listed alphabetically
with a brief explanation. They act as a quick reference for terms that may not be commonly
understood outside of your organization or industry.

To create a glossary in Paligo:

1. Create a Glossary [401]. This is where you add your glossary terms and their definitions.
When you are creating your glossary, you should consider whether you want to use an
automatic glossary title [418]. You can also sort the glossary [424] so that the entries appear in
alphabetical order.

2. If you want terms in your glossary to reference other terms in your glossary, you can use
"see" [410] and "see also" [414] links. These need to be set up in the glossary topic.

3. This is an optional step. If you want your topics to contain hyperlinks to the explanations in
the glossary, you need to add references in your content [403].
Alternatively, you can use the glossary topic without any references in your content. This will
give you the glossary topic and the definitions you add, but there will be no links from your
topics to your glossary.

4. If you are publishing to PDF, you can set the glossary to only include those terms that are used
in your publication [422]. This is useful when you have a single glossary topic that you reuse in
several different publications.

5. If you are publishing to an HTML5 help center, you can choose whether your references to the
glossary have "popovers" [425] that appear when you hover the cursor over the term.

6. Add your glossary topic to a publication [99] in the same way as you would add any other
topic to a publication. Typically, the Glossary topic is placed at the end of the publication.

When you publish your content, the glossary is included. It contains a list of the glossary terms
you have defined. If you have included references to the glossary in your content, those references
appear as links. There are also popovers that appear if you publish to a HTML5 help center.
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Create a Glossary
To create a glossary for your publication, a glossary element must be added to a topic. When
added, Paligo adds the basic structure that is required for a glossary. Some of the elements are
optional and can be deleted if not needed. The use of glossterm in topics allows you to change
the formatting of terms in the publication and generates a link to the corresponding definitions on
the glossary page.

Consider how you want the glossary to appear in the published output:

• Glossary as a topic with the glossary entries to follow it.
This is the most common approach for glossaries. To set this up, use "Glossary" as the topic's
title. When you add a glossary element, it has its own title. You can delete the glossary's
title element, so that only the topic's title is used.

• Glossary as a subsection with the glossary entries to follow it.
To create this, give the topic the title that you want to use. When you add the glossary
element, it has its own title. You can set the glossary title to "Glossary" or any other name
that you want.

TIP
If you want to sort the glossary entries in alphabetical order, see Sort the
Glossary [424].

You can also add references, so that the terms in your topics contain links to the
explanations in your glossary, see Glossary References [403].

1. Create a new topic [131] or open an existing topic.

2. Position the cursor at a valid position for the glossary element.
For example, after the topic title, but before the first para element.

3. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].
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4. Enter Glossary and select it from the menu.
Paligo adds the basic structure for a glossary.

5. Add a glossary title and an introduction text in the para(both elements are optional).

6. Add the glossterm (the name of the term).

7. Add an acronym for the glossary term (optional).
For example, if the glossary term is Extensible Markup Language, you could add the acronym
XML.

<glossentry>
    <glossterm>Extensible Markup Language</glossterm>
    <acronym>XML</acronym>
    <glossdef><para>A self-
descriptive language used to store and transfer data.</para></glossdef></
glossentry>

8. Add a glossdef that explains what the term means.

9. Use the Element Context Menu [54] to add one glossentry per glossary term.

10. Select Save. 

11. Add your glossary topic to your publication, see Add Content to a Publication [99].
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Glossary References
Abstract

Learn how to add references to glossary terms and definitions in your regular topics. The
references can be the same text as the glossary term, different text, or you can have a "see"
or "see also" reference.

When you have created a glossary topic [401] that contains the glossary terms and definitions,
you can reference those terms in your topics. For example, if you have a glossary definition of
"XML", you can reference it when you mention "XML" in your content. In your published output,
the reference guides the reader to the glossary (PDF) or displays the definition (HTML).

Example of a hover popover showing a glossary definition in HTML output.

There are several types of glossary reference that you can use:

• Exact match to the term in the glossary [403], for example, you have "Intake" in your content
and the glossary term is also called "Intake"

• Text that is different to the glossary term [405], for example, you might have "wireless" in your
content but you want to link that to a glossary term called "WiFi".

• "See" references [410], where there is no glossary term definition, only a "see" reference to
another entry in the glossary.

• "See also" references [414], where there can be a glossary term definition as well as a "see also"
reference to another entry in the glossary.

Topic Term is Same as Glossary Term
You can associate terms in your topics with definitions in a glossary. If the term in your topic is
an exact match for the term in the glossary, follow the steps below. This approach is suitable for
content that is in a single language and content that is going to be translated.

1. Open the topic that will reference a term in your glossary.

2. Highlight the text that you want to reference the term in the glossary. This text has to be an
exact match of the text for a glossary term in your glossary topic.
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3. Use the element context menu to add the glossterm element.

4. Select Save.

When you publish, Paligo will automatically detect the references in your content and will match
them to the terms in your glossary.

NOTE
As long as your term in the topic text and the glossary term are the same, you can
use this technique for as many languages as you need. Because in the underlying
XML, the code will be <glossterm>text-term<glossterm>, where text-term is
the word you want to use. As long as the text-term exists in the glossary
for the same language, it will work. For example, if you have an English topic
with <glossterm>valve</glossterm>, your English glossary needs to contain a
glossary term called "valve", and in the French version, your topic would contain
<glossterm>vanne</glossterm> and the French glossary would need a term
called "vanne".
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Topic Term is Different to Glossary Term
In a topic, you may have text that needs to refer to the glossary, but it does not match the glossary
term. For example, you could have "configurable" in your topic, but you want it to reference a
"Configure" glossary term.

There are two different ways to create this type of glossary reference:

• Use the linkend attribute and reference the glossary term by its xml:id [405]
If you have translations or are going to translate your content in the future, you should use
references by xml:id.

• Use the baseform attribute to reference the glossary term [408].
This is only suitable if your content is only going to be written and published in one language. If
you have translations, this technique will only work on the source language.

Reference Glossary Entry by xml:id
If you are going to translate your content, you will most likely want to refer to glossary terms that
are also translated. For example, if you have English and French content, you probably want the
French topics to reference French glossary terms. To do this, use an xml:id reference.

With an xml:id reference, the underlying code is the same for all language versions. So if you
have a glossary entry with an xml:id of N5f84b058951b3 in your English content, that same id is
also used for the glossary entry in any other languages.

If you used a baseform reference instead, the glossary term would only work for one language.
This is because the baseform term is language-specific. For example, let's say you have English
content and you use baseform: valve for a glossary reference. Paligo will look for valve in the
English glossary, and will find it (assuming it exists). But for the French glossary, Paligo will still look
for baseform:valve, and valve will not exist in the French glossary as it is translated to vanne.

TIP
You can use xml:id references for content in a single language too. This is a good
idea if you do not translate your content now, but may need to translate it in the
future.

To use the xml:id to reference a glossary entry:

1. Open your glossary topic. This is the topic that contains your glossary and the entries and
definitions.

2. Select a glossentry element. Check that it does not have an xml:id entry in the Element
attributes section. If it does, check the other glossentry elements too. If they all have
xml:ids, ignore step 3 and continue from step 4. If any glossentry does not have an
xml:id, you will need to add one (see step 3).
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3. Select the glossentry element on the Element Structure Menu and then select Generate ID.
This gives the glossentry a unique ID (xml:id).

When all of the glossentry elements have an xml:id, you can reference them from your
topics.
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TIP
You can manually change an xml:id to something that is more meaningful,
if you wish. This can make it easier to work with xml:ids for glossary
references.

When changing an xml:id, there are some rules to follow:

• The xml:id must start with a letter

• There is a 36 character limit

• You cannot use spaces, so use an underscore instead. For example, glid
valve is not allowed, but you could use glid_valve.

It is a good idea to have a consistent xml:id naming strategy for your
glossary entries.

4. Open a topic and select the text that you want to reference a glossary term.

5. Use the element context menu to apply the glossterm element.
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6. Select the glossterm element and then add the linkend attribute in the Element attributes
section.

7. Set the value of the linkend attribute to match the xml:id of the glossary entry you want to
reference.

8. Repeat steps 4-7 inclusive for each reference.

9. Select Save. 

When you publish, Paligo will automatically detect the references in your content and will match
them to the terms in your glossary.

Reference with Baseform and Term Name
One way to reference a glossary term that does not match the text in your content is to use
the baseform attribute. But this is only suitable if you write and publish your content in a single
language.
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IMPORTANT
If you have translations or are going to translate your content, use the xml:id to
reference your glossary [405].

To use the baseform attribute to reference a glossary term that does not match the text in your
content:

1. Open a topic and select the text that you want to reference a glossary term.

2. Use the element context menu to add the glossterm element.
To find out more about using the element context menu to add content, see Add Content to
Topics [142]

3. Select the glossterm element and then use the Element attributes section to add the
baseform attribute.

4. Set the value of the baseform attribute to the name of the term in the glossary. This has to be
an exact match for the term in the glossary.

5. Repeat this process for other references, as needed.

6. Select Save. 

When you publish, Paligo will automatically detect the references in your content and will match
them to the terms in your glossary.
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See Glossary Reference
If you want a glossary term to refer to another glossary term, you can use a "see" reference. For
example, if you have a glossary term for "Coolant" you could use a "see" reference to guide the
reader towards a related term, such as "See refrigeration".

TIP
You can also use a "see also" reference [414].

To use a "see" reference:

1. Edit your glossary topic. Alternatively, you can create a new glossary [401].

2. Click inside the glossary element and then use the element context menu to add a
glossentry element. Paligo adds a glossentry element and it contains a glossterm,
acronym, glossdef, and para element (the para is in the glossdef).

3. Click after the glossterm element but before the acronym element. This selects the
glossentry element, which you can see in the element structure menu and in the Element
attributes section.
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4. Use the element context menu to add the glossee element:
To learn more about using the Element Context Menu, see: Add Content to Topics [142].

5. Delete the acronym, glossdef, and para elements for the glossary entry. You should now be
left with the glossentry and glosssee elements.

NOTE
You can have either a glossee element or a glossdef element in a
glossentry, but not both.

6. In your glossary definitions, find the glossary term that you want to reference. For example,
if you want to have a "See Refrigeration" reference, find the glossary definition for
"Refrigeration".

7. Select the glossentry element for the term that you want to reference.

8. In the Element attributes section, copy the xml:id attribute for the glossentry.
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NOTE
If the glossentry does not have an xml:id, select the glossentry element
in the element structure menu, and then select Generate ID. Paligo will
create an xml:id for the glossentry element.

9. Select the glosseealso or glossee element that you added in step 4.

10. In the Element attributes section, add the Otherterm attribute and paste in the xml:id from
step 7 as the value.

The Otherterm attribute links the glossee element with the other glossary term that you
are referencing. The xml:id is what Paligo needs to identify the other glossary term.

11. Select Save.

When you publish your content (including your glossary), you will get a "See" reference to the
glossary term you chose in step 4.

Example 27. "See" reference in a glossary

For this example, imagine you have a glossary term for "Profiling" and instead of a description, you
want a reference to show "See Filters".

In your glossary topic, you already have a "Filters" glossary entry that has this structure:

<glossentry xml:id="N5fa17485ec783">
      <glossterm xinfo:text="14442">Filters</glossterm>
      <glossdef>
        <para>Filters are also known as profiles or conditional text. You \
can use them to markup your topics so that when you publish, you can \
choose whether to include of exclude parts of your content.</para>
      </glossdef>
    </glossentry>

The first step is to create a new glossary entry, so you add a new glossentry element and name
the entry "Profiling".
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You delete its acronymn and glossdef elements as there is no need for an acronym and you
cannot have a definition and a "see" reference in the same glossary term.

You add the glossee element.

You select the glossentry element for the glossary term you want to reference, in this case,
"Filters". Then you copy its xml:id value from the Element attributes section.

You select the glossee element for the "Profiling" glossary entry, and then add the Otherterm
attribute in the Element attributes section.

You copy the xml:id of the "Filters" glossary entry into the value field for the Otherterm attribute.
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You save the glossary and publish it as part of a publication. In the output, the entry for Profiling
shows "See Filtering".

See Also Glossary Reference
For some glossary terms, you may want to include a "see also" reference as well as the definition
of the glossary term. For example, if you have a glossary term for "coolant" you could have a
definition and a "see also" reference to another related term, such as "see also refrigeration".

TIP
You can also use a "see " reference [410].

To use a "see also" reference:

1. Edit your glossary topic. Alternatively, you can create a new glossary [401].
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2. Click inside the glossary element and then use the element context menu to add a
glossentry element. Paligo adds a glossentry element and it contains a glossterm,
acronym, glossdef, and para element (the para is in the glossdef).

NOTE
You can have either a glossee element or a glossdef element in a
glossentry, but not both.

3. Click below the glossdef "Definition". The glossseealso element has to be inside the
glossdef, but after the para that is inside the glossdef.

4. Use the element context menu to add the glosseealso element:
To learn more about using the Element Context Menu, see: Add Content to Topics [142].

5. In your glossary definitions, find the glossary term that you want to reference. For example,
if you want to have a "See also Refrigeration" reference, find the glossary definition for
"Refrigeration".

6. Select the glossentry element for the term that you want to reference.

7. In the Element attributes section, copy the xml:id attribute for the glossentry.
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NOTE
If the glossentry does not have an xml:id, select the glossentry element
in the element structure menu, and then select Generate ID. Paligo will
create an xml:id for the glossentry element.

8. Select the glosseealso element that you added in step 4.

9. In the Element attributes section, add the Otherterm attribute and paste in the xml:id from
step 7 as the value.

The Otherterm attribute links the glosseealso element with the other glossary term that
you are referencing. The xml:id is what Paligo needs to identify the other glossary term.

10. Select Save.

When you publish your content (including your glossary), you will get a "See also" reference to the
glossary term you chose in step 4.

Example 28. "See Also" reference in a glossary

For this example, imagine you want a glossary term for "Profiling" and you need it to provide a
definition and also to guide readers to also see the term "Filters".

In your glossary topic, you already have a "Filters" glossary entry that has this structure:

<glossentry xml:id="N5fa17485ec783">
      <glossterm xinfo:text="14442">Filters</glossterm>
      <glossdef>
        <para>Filters are also known as profiles or conditional text. You \
can use them to markup your topics so that when you publish, you can \
choose whether to include of exclude parts of your content.</para>
      </glossdef>
    </glossentry>

The first step is to create a new glossary entry, so you add a new glossentry element and name
the entry "Profiling".
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You delete its acronym element as that is not needed in this case.

You enter a definition for "Profiling".

You add the glossseealso element.

You select the glossentry element for the glossary term you want to reference, in this case,
"Filters". Then you copy its xml:id value from the Element attributes section.

You select the glosseealso element for the "Profiling" glossary entry, and then add the
Otherterm attribute in the Element attributes section.

You copy the xml:id of the "Filters" glossary entry into the value field for the Otherterm attribute.

You save the glossary and publish it as part of a publication. In the output, the entry for Profiling
shows the definition for profiling and it has a "See also Filtering" reference.
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Glossary Title
Abstract

Learn how to add a glossary title element and set it to be auto-generated or manually generated.
You can also control if a glossary title is bookmarked for PDF and whether it appears in HTML
outputs.

When you create a glossary, you add a glossary element, and by default, this includes a title
element inside it. You can use the glossary title to name the glossary. But depending on how
you have set up your glossary, you may decide that you do not want a title at all.

One of the most common ways to set up a glossary is to create a topic called "Glossary" and then
add a glossary element to it. In this scenario, the topic's title is glossary, so there is no real need
for a glossary title as well. That's not a problem - you can delete the glossary title and the glossary
will still work as expected. In the following image, "Glossary" is the topic's title and then the actual
glossary has no title of its own.

But it is also possible to add a glossary to a topic that is not called "Glossary". For example, you
could add a glossary to a topic called "Reference". In this scenario, it can be a good idea to include
a glossary title as well. The title will make it easier for your readers to find your glossary, seeing
as there is no "Glossary" topic. In the following image, a glossary has been added to a "Reference"
topic, and the glossary has a title called "Glossary".

If you are going to use a glossary title, you should consider:

• Do you want Paligo to automatically generate the title?
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You can Add a Glossary Title [419] yourself or you can get Paligo to generate a glossary title for
you.
To use an automatically generated glossary title, see Automatic Glossary Title for PDF
Outputs [420] and Glossary Title for HTML5 Output [422].

• If you publish to PDF, do you want the bookmarks to have a link to the glossary title?
If yes, you can set Paligo to include the glossary title as a bookmark [421], if needed.

• For HTML5 outputs, do you want the glossary title to be shown?
They are hidden by default, but you can use custom CSS to display them [422] if you prefer.

Add a Glossary Title
By default, when you add a glossary element, it also contains a title. You can enter the text for
your title inside the title element.

If you have removed the glossary title and later decide that you do want a title, you can either:

• Add a glossary title manually, by adding the title element

• Set Paligo to generate a glossary title automatically.
To use an automatically generated glossary title, see Automatic Glossary Title for PDF
Outputs [420] and Glossary Title for HTML5 Output [422].

To manually add a glossary title:

1. Open the topic that contains your glossary in the Paligo Editor.

2. Select the glossary element.
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3. Use the element context menu to add the title element.

4. Enter the text for your glossary title inside the title element.

5. Select Save.

Automatic Glossary Title for PDF Outputs
Paligo can automatically add a title to your glossary. The automatic title has the text "Glossary" and
if you publish to other languages, a translation of "Glossary" is provided as well.

To use an automatic glossary title for PDF outputs:

1. Create a PDF layout [1059]. Alternatively, you can edit an existing PDF layout [1061].

2. Select General and choose Glossary and Index.

3. Set Glossary auto title to Enable.
When you publish, Paligo will check to see if your glossary has a title.

• If the glossary already has a title, Paligo will use that title. It will not generate an automatic
title.

• If the glossary does not have a title, Paligo will add a title element with "Glossary" as the
title text.

If you set Glossary auto title to Disable, Paligo will not create an automatic glossary title.

4. Select Save.

When you publish to PDF with this layout, the output will include or exclude the automatic glossary
title.

Paligo Documentation

420



Glossary Title included in PDF Bookmarks
PDFs can have bookmarks that act like a table of contents in a side panel, where your topics are
shown in order. If you have a glossary, it's likely that you will want a link to the glossary to appear
here.

If your glossary is inside a topic called "Glossary", you will not need to take any action. The
"Glossary" topic will appear in the bookmarks by default.

But if your glossary is inside a topic with a different title, there will be no obvious way for the
reader to access the glossary. For example, let's say you have added your glossary to a topic called
"references" and you have removed the title for the glossary. In the published PDF, the bookmarks
will only show "References", which makes it harder for your readers to find the glossary.

To fix this, you can set Paligo to include the glossary's title in the bookmarks as well. If
your glossary does not have a title, you can add one or you can set Paligo to generate one
automatically [420].

1. Create a PDF layout [1059]. Alternatively, you can edit an existing PDF layout [1061].

2. Select General and choose Glossary and Index.

3. Enable the Glossary title or auto title in bookmarks setting to get Paligo to include the title
of the glossary element in the bookmarks.

NOTE
This setting will only work if your glossary has a title, or you have set Paligo to
generate a title automatically.

4. Select Save.

When you publish to PDF with this layout, the output will include or exclude the automatic glossary
title.

When you publish to PDF with this layout, Paligo includes the glossary title in the bookmarks. It is a
subsection of its parent topic.
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Glossary Title for HTML5 Output
By default, Paligo includes a glossary title for HTML5 outputs, but it is hidden from view. The title
varies, depending on how your glossary is set up:

• If your glossary contains a title element, Paligo includes that title in the HTML5 output

• If your glossary has no title element, Paligo creates an automatic title for the HTML5 output.
The automatic title is called "Glossary" (or a translation of Glossary for other languages).

To display the glossary title in your HTML5 help center, you need to add some custom CSS:

1. Create or edit an existing custom CSS file and add the following code:

.glossary .titlepage{
    display: block;
}

To learn more about creating custom CSS, see Branding your HTML Outputs with CSS [654].

2. Create an HTML5 Help Center layout [1059]. Alternatively, you can Edit a Layout [1061].

3. Upload your custom CSS to the HTML5 layout.

4. Select Save.

When you publish to HTML5 using this layout, the glossary title is shown.

Filter Out Unused Glossary Terms
Abstract

Learn how to filter out glossary terms so that the glossary in your PDF output only includes terms
that are used in that publication.

For PDF outputs, you can control your glossary so that it only includes those terms that actually
appear in your published output. This is useful when you use the same glossary topic for different
publications.

For example, let's say you have a range of publications for a single product, such as an industrial
fan:

• A user guide aimed at customers who will use the fan controls in a factory.

• An installation guide aimed at electricians who will fit the fan in the factory.

• A firmware guide that is used by your service engineers who can visit the factory and apply
updates to the fan.

Rather than create separate glossaries for all of these publications, you create a single glossary
that is used in all three. But it contains some terms that you do not want to appear in the
customers' user guide, as they are technical terms that are not intended for that audience. To
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achieve this, you can set the glossary to only include those terms that appear in the output you
have published. So the customers' user guide will have a glossary that only contains the terms that
appear in the customers' user guide, the installation guide will only have terms that appear in the
installation guide, and so on.

To set your glossary to only include terms that appear in a publication:

1. Create a glossary topic [401] and add glossary terms and definitions. You can also mark up
your topics so that they contain Glossary References [403].

2. Open your glossary topic and click in the glossary.

3. Select the glossary element in the element structure menu, and then select Go to element.

4. In the Element attributes section, add the role attribute. Set its value to auto.
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5. Select Save.

When you publish to PDF [1090], Paligo will look for the references in your publication. It will
then filter the glossary so that it only includes those terms that are actually referenced in your
publication. Any other terms are excluded from your output.

NOTE
The automatic filtering of glossary terms only applies to a glossary that has the
role attribute set to auto. If you have a topic that contains multiple glossaries,
those that do not have role="auto" will include all of their glossary terms, even if
those terms do not appear in the publication's content.

NOTE
HTML outputs do not support the role="auto" functionality. So if you publish to
both PDF and HTML, add the role="auto" attribute when you publish to PDF and
remove it when you publish to HTML. If role="auto" is in place for HTML outputs,
you will get a glossary that contains no glossary terms.

Sort the Glossary
You can sort the glossary entries so that they are listed in alphabetical order in the Paligo editor.

1. Open the glossary topic and position the cursor inside the glossary element but before the
first glossterm element.
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2. Use a keyboard shortcut to sort the entries:

• On Mac, use:

Control ^ Option ⌥  Shift ⇧  G

On Windows, use:

Ctrl Alt  Shift  G

Glossary Popovers
Abstract

Learn how to set up glossary popovers. These are panels that appear when you hover the cursor
over a glossary term in HTML5 Help Center outputs. The panel contains the glossary term and its
definition.

Glossary popovers are panels that appear when you hover the cursor over a term that is linked
to the glossary. They contain the glossary term and definition from the matching term in your
glossary, and are only available in HTML5 help center outputs.

Paligo creates glossary popovers for you automatically. But if you prefer, you can disable them so
that your glossary references only have a link to your glossary topic.

To control whether glossary popovers are used:

1. Create an HTML5 Help Center layout [1059]. Alternatively, you can Edit a Layout [1061].

2. Select Classes and Attributes and use the Glossary Popovers setting to enable or disable
them.

3. Select Save.
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When you publish to HTML5 using this layout, your output will have glossary popovers if you
enabled them. You can test it by hovering the cursor over text that references a term in your
glossary. If you disabled popovers, the glossary references will appear as links only.

Glossaries and Translations
Abstract

Learn how to manage glossaries when your content is going to be translated. You can have a
glossary in multiple languages, but you need to reference the terms by their xml:id.

Glossaries, like any other topic, can be in multiple languages. You add each required language to
the topic, and then the topic can contain the content for the source language and the translations
for each additional language (see Working in Translation View [1752]).

For a glossary in multiple languages, you need:

• A "glossary" topic to contain the glossary term definitions.
This topic will be translated into different languages, so you have a single glossary topic with
versions in English, French, German, Spanish, etc. To find out more, see Create a Glossary [401].

• Regular topics that contain text that references your "glossary" topic.
These topics will also be translated into different languages. For the glossary references, Paligo
will look in the version of the glossary that matches the language of the topic. For example, if the
French version of a regular topic references "vanne", Paligo will look for "vanne" in the French
version of the glossary topic.

Most types of glossary reference will work in all languages (see Glossary References [403]), but
there is one exception. If you want a term in your text to refer to a glossary entry, but the text
does not match the glossary term, you will need to use an xml:id reference. To find out more, see
Topic Term is Different to Glossary Term [405].

When your content is translated, it is important that only the text is translated. Do not translate
element names, attribute names, or attribute values.

Glossary Terms in the Translation Editor
If you translate your content manually using the Translation Editor, make sure to follow these
steps for any content that has a glossary term (or any other inline XML element):

1. In the Translation Editor, select the part that you want to translate. The translation dialog
appears.

2. If the source content that you are translating contains a glossary term element, select Copy
Source Text. This copies the entry in the original source language version into the translation
dialog. Importantly, it copies the inline elements, such as glossterm too. The inline element
is highlighted in the translation dialog.
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3. Translate the content into the relevant language, including the highlighted content, and then
save.

NOTE
If you do not use Copy Source Text, the text you enter in the translation dialog
will not include the elements that are needed for glossary terms. It will only be
regular text.

Index
Abstract

Learn how to set up an index in Paligo and add index references to your topics.

Paligo has several index-related elements that you can use to create an index with references to
your topics. These are especially useful in PDF outputs, where users are more likely to need to
refer to an index to find out where certain subjects are explained in a document. With HTML and
other outputs that will be read digitally, the index is often less useful as there is a search tool to
use instead. However, you may still decide to include an index in your online content too.

To set up an index for your Paligo content:

1. Create an Index Topic [428] and add it to your publication.

2. Add Index References [433] to your content.
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3. Edit your PDF layout [1054] to set the number of columns for the index and the column spacing
(PDF outputs only).

4. Publish your content, see Publishing Process [1068].

NOTE
Paligo can generate and sort your index automatically, if you Create an Index
Topic [428] and there are index references added in your content.

Create an Index Topic
Abstract

Learn how to create an index in Paligo. The index will contain a list of terms with a reference to the
relevant parts of the content.

An index topic is a regular topic where an index element has been added. When you add the
index topic to your publication, Paligo will automatically gather all index references from the
topics. The index references will be categorized by letter and sorted alphabetically and each has a
page reference or a link.

If the publication does not contain any index references, the index will be empty. You need to add
index references to your topics before you publish, see Add Index References [433].

Consider how you want your index to appear in the published output:

• The index used as a main topic. This is the most common approach for an index.

• The index used as a subsection inside a main topic (for example References).

To the left - The index as a main topic. To the right - The index as a subsection.

NOTE
The index element will automatically add a title named Index. This means that if
you have a main topic called Index, the subsection will also be called Index. This
extra title can be hidden, see Hide Index Title for HTML5 Output [432] or Enable
or Disable Index Auto Title for PDF Output [430].
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TIP
To find out more about using the Element Context Menu [54] to add content, see
Add Content to Topics [142]

To create an index topic:

1. Create a new topic [131].

2. Position the cursor at a valid position for the index element.
For example, after the section title, but before the first para element.

3. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

4. Enter index and select it in the menu.

5. Delete the para element that is included by default, if not needed.

6. Select Save. 

7. Add your index topic to your publication, see Add Content to a Publication [99].

When you publish your publication, Paligo will automatically gather the index references.

Index Title
Abstract

Learn how to add a title element to an Index in Paligo. Typically, index titles are used when you
what to give the index topic a different name than "Index".
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When you Create an Index Topic [428] the index element includes an extra title named Index. It is
possible to hide this title for both PDF and HTML5 output or include them in PDF bookmarks.

To the left - the index as a main topic. To the right - the index as a subsection.

Enable or Disable Index Auto Title for PDF Output
Paligo can automatically add a title to your index for PDF output. The automatic title will be "Index"
and if you publish to other languages, a translation of "Index" is provided as well.

To include or exclude the automatically generated index title:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select General and choose Glossary and Index.

4. Set Index auto title to Enable or Disable.
If enabled during publish, Paligo will check to see if your index has a title:

• If the index already has a title, Paligo will use that title. It will not generate an automatic
title.

• If the index does not have a title, Paligo will add a title element with "Index" as the title
text.

If disabled Paligo will not create an automatic index title.

5. Select Save.

When you publish to PDF with this layout, the output will include / exclude an automatic index
title.
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Include Index Title in PDF Bookmarks
PDFs can have bookmarks that act like a table of contents in a side panel, where your topics are
shown in order. If you have an index, it's likely that you will want a link to the index to appear here.

If your index is inside a topic called "Index", you will not need to take any action. The "Index" topic
will appear in the bookmarks by default.

But if your index is inside a topic with a different title, there will be no obvious way for the
reader to access the index. For example, let's say you have added your index to a topic called
"references". In the published PDF, the bookmarks will only show "References", which makes it
harder for your readers to find the index.

To fix this, you can set Paligo to include the index's title in the bookmarks as well. If your index
does not have a title, you can add one or you can set Paligo to generate one automatically.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select General and choose Glossary and Index.

4. Enable the Index title or auto title in bookmarks setting to get Paligo to include the title of
the index element in the bookmarks.
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NOTE
This setting will only work if your index has a title, or you have set Paligo to
generate a title automatically.

5. Select Save.

When you publish to PDF with this layout, Paligo includes the index title in the bookmarks. It is a
subsection of its parent topic.

Hide Index Title for HTML5 Output
Your HTML5 output will show your index title by default if your index:

• Contains a title element

• Has no title element, but your HTML5 layout is set to generate an index title automatically.
The automatic title is called "Index" (or a translation of Index for other languages).

This can mean that your HTML index has two "Index" titles, one for the topic and one for the index
element. To hide the title for the index element, use CSS:

1. Create or edit an existing custom CSS file and add the following code:

.index .titlepage{
    display: none;
}

To learn more about creating custom CSS, see Branding your HTML Outputs with CSS [654].

2. Create an HTML5 Help Center layout [1059]. Alternatively, you can Edit a Layout [1061].

3. Upload your custom CSS to the HTML5 layout.

4. Select Save.

When you publish to HTML5 using this layout, the index element's title is hidden.

NOTE
If you want to show the index title again, change the CSS to:

.index .titlepage{
    display: block;
}
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Add Index References
Abstract

Learn how to add index references to your topics in Paligo. The references tell Paligo what terms
should appear in the index and what type of reference should be used.

To get index entries to appear when you Create an Index Topic [428], you need to markup
the topics with index references. These references tell Paligo what terms should appear in the
index topic and what type of reference should be used. If your content does not contain any
index references, your index topic will be empty when you publish. There are four types of index
references that you can use depending on which information to be included in the index topic.

Appearance Type Description

Primary Index
References

The index topic will only show the main terms in alphabetical
order with page numbers. Learn more, see Add a Primary Index
Reference [433].

Secondary Index
References

The index topic will show both main terms and subterms in
alphabetical order with page numbers. Learn more, see Add a Secondary
Index Reference [435].

See Index
References

The index topic will show the main terms in alphabetical order without
page numbers with a link within brackets to another term. Might be
that you want to include terms that could be used for the same thing and
refer the reader to the proper term instead. Learn more about how to
add these extra references, see Add a See Index Reference [438].

See Also Index
References

The index topic will show the main terms in alphabetical order with
page numbers including a link within brackets to an additional term.
Learn more about how to add these extra references, see Add a See Also
Index Reference [441].

NOTE
If you publish to HTML or HTML5 there will be hyperlinks instead of page
numbers.

Add a Primary Index Reference
If you use a primary index reference, the index topic will only show the main terms in
alphabetical order with page numbers. If you publish to HTML, there is a hyperlink to the page
instead of a page number.

The index topic will look like this with primary index references.
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TIP
To find out more about using the Element Context Menu [54] to add content, see
Add Content to Topics [142].

To add a primary index reference to your content:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Position the cursor immediately before the text for the term that you want to use.

3. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

4. Enter indexterm and select it from the menu.
Paligo adds an indexterm element with an primary element inside it.

5. Enter the main term inside the primary element to make it appear in the index.
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NOTE
You should now have a structure like that shown in the example below. Here,
we have used "temperature" as an example of a primary term.

<para>If the sensor detects that the room is too hot or \
too cold, the system will raise a \
<indexterm><primary>Temperature</pr

6. Select Save. 

When you publish, Paligo will automatically add your index entries to your index topic. If you do
not have an index topic, see Create an Index Topic [428].

Add a Secondary Index Reference
If you use a secondary index reference, the index topic will show both main terms and subterms
in alphabetical order with page numbers. If you publish to HTML, there is a hyperlink to the page
instead of a page number.

The index topic will look like this with secondary index references.

TIP
To find out more about using the Element Context Menu [54] to add content, see
Add Content to Topics [142].

To add a secondary index reference to your content:

1. Select a topic or component in Content Manager [34].

Paligo Documentation

435



Paligo opens the content in the Editor [51].

2. Position the cursor immediately before the text for the term that you want to use.

3. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

4. Enter indexterm and select it from the menu.
Paligo adds an indexterm element with an primary element inside it.

5. Enter the main term inside the primary element to make it appear in the index.
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NOTE
You should now have a structure like that shown in the example below. Here,
we have used "temperature" as an example of a primary term.

<para>If the sensor detects that the room is too hot or \
too cold, the system will raise a \
<indexterm><primary>Temperature</pr

6. Position the cursor after the primary reference, but before the end of the indexterm.

TIP
Move the cursor with the keyboard arrows to easier position it between the
chevrons.

7. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

8. Enter secondary and select it from the menu.

9. Enter the subterm inside the secondary element to make it appear in the index.
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NOTE
You should now have a structure like this (where we have used "alarm" as an
example of a secondary term):

<para>If the sensor detects that the room is too hot or \
too cold, the system will raise a \
<indexterm><primary>Temperature</primary><secondary>alarm</
secondary></indexterm>temperature alarm.</para>

10. Select Save. 

When you publish, Paligo will automatically add your index entries to your index topic. If you do
not have an index topic, see Create an Index Topic [428].

Add a See Index Reference
If you use a see index reference, the index topic will show the main terms in alphabetical order
without page numbers with a link within brackets to another term. Might be that you want
to include terms that could be used for the same thing and refer the reader to the proper term
instead.

A see index reference is a combination of a primary element for the main term and a see
element for the link to the additional term.

The index topic will look like this with see index references.

NOTE
It is also possible to use a see element for a secondary term, but these entries
can become complicated. It is usually better to keep your index entries as simple
as possible, so that your readers can find the information they need quickly.

To add a see index reference:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Position the cursor immediately before the text for the term that you want to use.
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3. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

4. Enter indexterm and select it from the menu.
Paligo adds an indexterm element with an primary element inside it.

5. Enter the main term inside the primary element to make it appear in the index.

NOTE
You should now have a structure like that shown in the example below. Here,
we have used "temperature" as an example of a primary term.

<para>If the sensor detects that the room is too hot or \
too cold, the system will raise a \
<indexterm><primary>Temperature</pr

6. Position the cursor after the primary reference, but before the end of the indexterm.
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TIP
Move the cursor with the keyboard arrows to easier position it between the
chevrons.

7. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

8. Enter see and select it from the menu.

9. Enter the term inside the see element that is to appear as link within brackets in the index.
The entered term must be an existing index term.

NOTE
You should now have a structure like that shown below, where we have used
"Temperature" as the "see" index entry.

<para>If the sensor detects that the room is too hot or \
too cold, the system will raise a \
<indexterm><primary>Thermal</primary><see>Temperature</
see></indexterm>temperature alarm.</para>

10. Select Save. 

When you publish, Paligo will automatically add your index entries to your index topic. If you do
not have an index topic, see Create an Index Topic [428].
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Add a See Also Index Reference
If you use a see also index reference, the index topic will show the main terms in alphabetical
order with page numbers including a link within brackets to an additional term. If you publish
to HTML, there is a hyperlink to the page instead of a page number.

A see also index reference is a combination of a primary element for the main term and a
seealso element for the link to the additional term.

The index topic will look like this with see also index references.

NOTE
It is also possible to use a seealso element for a secondary term, but these
entries can become complicated. It is usually better to keep your index entries
as simple as possible, so that your readers can find the information they need
quickly.

To add a see also index reference:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Position the cursor immediately before the text for the term that you want to use.

3. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].
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4. Enter indexterm and select it from the menu.
Paligo adds an indexterm element with an primary element inside it.

5. Enter the main term inside the primary element to make it appear in the index.

NOTE
You should now have a structure like that shown in the example below. Here,
we have used "temperature" as an example of a primary term.

<para>If the sensor detects that the room is too hot or \
too cold, the system will raise a \
<indexterm><primary>Temperature</pr

6. Position the cursor after the primary reference, but before the end of the indexterm.

TIP
Move the cursor with the keyboard arrows to easier position it between the
chevrons.
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7. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

8. Enter seealso and select it from the menu.

9. Enter the term inside the seealso element that is to appear as a link within brackets in the
index.
The entered term must be an existing index term.

NOTE
You should now have a structure like that shown below, where we have used
"Thermal" as the "seealso" index entry.

<para>If the sensor detects that the room is too hot or \
too cold, the system will raise a \
<indexterm><primary>Temperature</primary><seealso>Thermal</
seealso></indexterm>temperature alarm.</para>

10. Select Save. 

When you publish, Paligo will automatically add your index entries to your index topic. If you do
not have an index topic, see Create an Index Topic [428].

Search for Index References
Use the Advanced Search [642] to find topics that include index references. Depending on what
you want to find, you can choose to:
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• Include all topics with index references by using the indexterm element in the search.

• Narrow down the search by specifying the type of index reference (primary, secondary, see
or seealso).

To search for index references:

1. Select Quick Search in the top menu. 

2. Select Advanced Search. 

3. Select the Search tab.

4. Enter indexterm or specify a particular index reference type (primary , secondary, see or
seealso) in the Contains field.

To the left search for content with the indexterm element. To the right search for content with
the seealso element.

5. Select the Content checkbox and clear the others in the Search in field.

6. Select Search.

7. All topics that match the search criteria will be presented below the search area.
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HTML Metadata
Abstract

Learn how to add HTML meta tags to your Paligo content.

For HTML outputs, you can add HTML meta tags to your topics. The meta tags are extra
information about each topic and they are included in the code of each published HTML page.
They are not visible on a published HTML page, but you can see them if you view the source
HTML. They are often used by search engines for search engine optimization (SEO) and analytics.
For example, the meta description may be used to add information about a topic below its link in
search engine results.

You can learn how to add HTML meta tags to your Paligo content in the following sections:

• HTML Meta Description for Topics [446]

• HTML Meta Keywords for Topics [448]

• Metadata for All Topics in a Publication [450]
This section explains how to add the same meta tag name and content pair to every topic in
your publication.

• HTML Meta Tags for Individual Topics [453]
This section explains how to add a meta tag name and content pair to individual topics.
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NOTE
If you add the same meta tag to every topic in your publication, you may need to
change Paligo's separator and terminator characters [451]. This only applies if the
value for the name or content in the metadata contains a colon or semi-colon.

HTML Meta Description for Topics
Abstract

Learn how to add an HTML meta description to your Paligo topics so that each topic has a
description in search engine results.

For search engine optimization (SEO), it is good practice to add a description to each topic's
metadata. When your topic appears in a search engine result, the search engine may use the
description to provide more information about the page. The description usually appears below
the page link in search results, but we cannot guarantee that the search engines will use it.

To add an HTML meta description, use the info, abstract, and para elements, so that they are
in a structural hierarchy like this:

<info>
    <abstract>
              <para>Your description</para>
    </abstract>
</info>

We recommend that you add the info, abstract, and para immediately after the title in your
topics.

1. Open a topic in the Paligo editor.

2. Select a valid position for the info element, for example, immediately after the title but before
the first paragraph.

3. Use the element context menu to add the info element.

To access the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).
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NOTE
If you already have an info element, you can add an abstract inside that. For
example, you may already have an info element to contain keywords [448].
In which case, you can add the abstract and para elements inside the same
info element, before or after the keywordset.

4. Use the element context menu to add the abstract element inside the info element.

5. Use the element context menu to add a para element inside the abstract element.
Enter the description for the topic in the paragraph. Be aware that search engines have
recommendations for the description length. For example, ideally, Google descriptions should
be between 50 and 150 characters.

6. Add the rest of the topic's content after the info element.

7. Select Save.

8. By default, the abstract will be visible in your HTML output. But you can use CSS to hide it from
readers but still make it available to search engines.
The CSS to use is:

.abstract {
    display:none;
}

You can either add that to your existing CSS file or you can use a CSS editor to create a new
one. If you create a new CSS file, you will also need to add any other CSS that you want to
apply to your content. When you have the CSS file ready, upload it to your HTML layout and
save the layout. When you publish with that layout, your meta descriptions will be included,
but hidden from view on your web pages.
To learn more about using CSS, see Branding your HTML Outputs with CSS [654].
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HTML Meta Keywords for Topics
Abstract

Learn how to add HTML meta keywords to your Paligo topics.

You can add HTML meta keywords to your topics. Google no longer uses keywords for search
engine optimization (SEO), but they may still be used by other search engines or applications. If
you use keywords, you should add words and phrases that are relevant to the subject matter of
the topic.

To add an HTML meta keyword, use the info, keywordset, and keyword elements, so that they
are in a structural hierarchy like this:

<info>
    <keywordset>
              <keyword>First keyword</keyword>
              <keyword>Second keyword</keyword>
    </keywords>
</info>

We recommend that you add the info, keywordset, and keywords immediately after the title in
your topics.

1. Open a topic in the Paligo editor.

2. Select a valid position for the info element, for example, immediately after the title but before
the first paragraph.

3. Use the element context menu to add the info element.

To access the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

NOTE
If you already have an info element, you can add keywords inside that. For
example, you may already have an info element to contain an abstract
for a meta description [446]. In which case, you can add the keywordset
and keyword elements inside the same info element, before or after the
abstract.

4. Use the element context menu to add the keywordset element inside the info element.
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5. Use the element context menu to add the keyword element inside the keywordset element.

6. Enter the keyword or key phrase in the keyword element.

7. Repeat steps 5 and 6 inclusive to add more keywords as required.
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8. Add the rest of the topic's content after the info element.

9. Select Save.

10. Publish your content to HTML and use the browser's inspection tool to view the source code
of the page. The keywords are added as HTML meta tags inside the <head> section of the
page, for example:

<meta name="keywords" content="control, automation, remote control">

Metadata for All Topics in a Publication
Abstract

Learn how to add a custom meta name and content pair to the metadata of all topics.

With Paligo's HTML5 layout, you can add HTML meta elements (name and content) to every page
in your HTML5 output. The HTML meta tag is often used for adding metadata that is required by
other applications such as search engines.

When you publish to HTML5, Paligo takes the metadata information from the HTML5 layout. It
then generates the HTML5 output, and adds the metadata to every page. Each metadata name
and content pair will appear as:

<meta name="name of metadata" content="value of metadata" />

If you want to add a metadata name and pair to some, but not all, of your topics, see HTML Meta
Tags for Individual Topics [453].

NOTE
Paligo only supports metadata name and content pairs. It does not support other
metadata attributes such as property.

To add custom metadata to all of the pages in your HTML5 output:

1. Select Layout and then edit the HTML5 layout you are going to use for publishing.
Alternatively, you can create a new HTML5 layout and edit that.

2. Select General.
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3. In the Custom meta tags field, enter the meta tags that you want to to all of the pages in your
HTML5 output. Use the following syntax:

name separator value terminator

For example:

robots:noindex, follow;

Where:

• robots is the value

• colon ( : ) is the separator

• noindex, follow is the value

• semi-colon ( ; ) is the terminator.
Another example is for location metadata, like this:

geo.position:latitude,longitude;

NOTE
To include a colon or semi-colon as part of the name or value, you will first
need to change the separator and/or terminator characters for Paligo (see
Separator and Terminator for HTML Meta Tags [451]).

When entered correctly, the metadata will come out as a metadata name and content pair in
the HTML5 output. For example:

<meta name="geo.position" content="59.334591, 18.063240" /> 

4. Select Save.

5. Publish your content using the layout you edited in steps 1-4.

6. Check that the meta name and content pair(s) are included in your output. Unzip the output
file and open index.html in a browser. Navigate to a page that should have the meta tag and
then use the browser's inspect feature to view the source code. You should see that the meta
tag is included inside the <head> element.
If the meta tag is missing, check that you have used the correct syntax in the layout and that
you are publishing with that layout. Also, if there is a colon or semi-colon in the name or value,
make sure that you have set alternative separators and terminators.

Separator and Terminator for HTML Meta Tags
Abstract

To use a colon or semi-colon in an HTML meta tag, change Paligo's separator and/or terminator
characters in the HTML layout.

When you enter an HTML meta tag, use the following syntax:

name separator value terminator

For example:

robots:noindex, follow;

By default, Paligo uses the:
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• Colon ( : ) character as the separator
The separator tells Paligo where the name ends and the value begins.

• Semi-colon ( ; ) character as the terminator
The terminator tells Paligo where the meta tag ends.

If you need to enter a name or value that contains a colon or semi-colon, set Paligo to use different
separator or terminator character. There are settings for changing the separator and terminator
characters on the HTML5 layout that you use for publishing.

1. Select Layout and then edit the HTML5 layout you are going to use for publishing.
Alternatively, you can create a new HTML5 layout and edit that.

2. Select General.

3. To change the separator character, enter the alternative character in the Custom meta tag
separator field.

NOTE
Do not use quotes or angle brackets as the separator. If you use a semi-colon
( ; ), you will also need to change the Custom meta tag terminator setting,
as that uses a semi-colon ( ; ) by default.

4. To change the terminator character, enter the alternative character in the Custom meta tag
pair terminator field.

NOTE
The custom meta tag pair terminator character must be different to the
custom meta tag separator character.

5. Select Save.

You can now create meta tags that use the characters you defined instead of the colon and
semi-colon (see Metadata for All Topics in a Publication [450]).
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HTML Meta Tags for Individual Topics
Abstract

Learn how to add a custom meta name and content pair to an individual topic.

You can add HTML name and content metadata pairs to any topic. HTML name and content pairs
are often used by other applications that need to access your published content, for example,
Google Analytics.

To add HTML metadata to an individual topic, use Paligo's taxonomy feature. You will need to
create a "parent" taxonomy tag for the name value and then one or more "child" taxonomy tags
for the content value. When you publish to HTML5, Paligo will add the HTML metadata to the topic
when it processes the output. The HTML metadata will appear as:

<meta name="name of metadata" content="value of metadata" />

NOTE
Paligo only supports metadata name and content pairs. It does not support other
metadata attributes such as property.

NOTE
This article explains how to add a custom metadata name and pair to one specific
topic. To create an HTML meta description for a topic, see HTML Meta Description
for Topics [446], and if you want to add a meta name and content pair to all topics
at once, see Metadata for All Topics in a Publication [450].

To add a custom HTML metadata name and content pair to a topic:

1. In the Content Manager, expand the Taxonomy Manager section.

2. Select the options menu ( ... ) for Taxonomies and then select Create Taxonomy Tag.

3. Give the taxonomy tag a name. The name will be used as the value for the name part of the
metadata. For example, if you enter "Monitor" as the name, the HTML metadata will use it like
this:
<meta name="Monitor" content = <not defined yet!> />
The taxonomy tag you have created in this step is the "parent" taxonomy tag.

4. Select the options menu ( ... ) for the "parent" taxonomy tag and then select Create
Taxonomy Tag. Paligo creates a new tag, and it is a "child" of the "parent" tag you created
in the previous step. This hierarchy is important, as "child" tags are used for the content
values in the metadata.

5. Give the child taxonomy tag a name. The name will be used as a value for the content part of
the metadata. For example, if you enter "Temperature" as the name, Paligo will add this to the
HTML metadata:
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<meta name="Monitor" content="Temperature" />

NOTE
You need one tag for each value, so if you want the content metadata to have
multiple values, create one "child" tag for each value.

6. Repeat steps 4 and 5 to create any additional values for the content part of the metadata.
For example, you could create a "child" tag for "Humidity" and then Paligo will add this HTML
metadata:
<meta name="Monitor" content="Temperature, Humidity" />

7. Select the options menu ( ... ) for the Taxonomies tag and then select Floating Content
Panel. Paligo opens the taxonomy tag hierarchy in a "floating" dialog.

8. Drag and drop the "parent" and "child" tags for your name/content pair onto the topics that
you want to use them.
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TIP
To check that the tags have been applied, select the folder that contains the
topic to display Resource View. There, you can see what taxonomy tags are
applied to the topics in that folder.

9. Publish the content using an HTML5 layout that has the following settings in place:
These are in the Classes and attributes settings:

• Output taxonomies set to Enable

• Value structure for taxonomy class names set to Descendants

• Underscore delimiter in taxonomy class names set to Enable

• Create HTML meta tags from taxonomies set to Enable.

NOTE
To use the HTML meta tag for Google Analytics, you will also need to set up
the property id. You can find it in the layout's settings at: Analytics and other
integrations > Google analytics property id (tracking id) or container id.

10. Check that the meta name and content pair(s) are included in your output. Unzip the output
file and open index.html in a browser. Navigate to a page that should have the meta tag and
then use the browser's inspect feature to view the source code. You should see that the meta
tag is included inside the <head> element.
If the meta name and content is not included, check that you have all of the required layout
settings in place and that you correctly applied the taxonomy tag to your topic.

Templates
With Paligo's templates feature, you can create a "model" of a publication, and use this as the
basis for other "real" publications that you will publish as PDF, HTML5, or any of Paligo's other
outputs. This is a great way to:

• Save time when setting up the structure of publications (that need to use the same structure)

• Apply consistent structure to your publications and topics across a range of different projects.
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The idea is that when you use templates when you want multiple publications to have the same
(or similar) structure. Instead of recreating that structure for each publication, you create it once
as a template, and then create new publications based on the template. The new publications will
automatically inherit the structure and content from the template they are based on.

NOTE
We strongly recommend that you only use templates when there is a clear need
to use the same structure repeatedly in your content. If it is the actual content
that needs to be repeated, rather than the structure, you can use Paligo's content
reuse features instead. These will give you more control over how and where the
content is reused.

But templates are not only for publications. It's also possible to create a template for a topic, so
that you can create individual topics that contain the same structure. For example, you might want
to have a "Specifications" topic that contains a table that is designed in a particular way. By adding
that table to a topic template, you can create it once in one place, and then you can create new
topics based on the template. The new topics will automatically contain the table.

To find out how to create templates and understand the rules that apply, see:

• Publication Templates [456]

• Create a Publication Template [458]

• Create a New Publication Based on a Template [460]

• Topic Templates [462]

• Create a Topic Template [462]

• Create a New Topic Based on a Template [464].

Publication Templates
Publication templates let you create a "model" publication that can be used as a starting point for
other publications. This is especially useful if you need to create many similar publications, as it
reduces the amount of repeat work and helps to make your content more consistent.

To create a publication template, you make the template and then add topics to it. These can be:

• Regular topics that you create in the Documents section of the Content Manager.

• Topics based on a template. These are topics that you create in the Templates section and add
to the publication template.

When you have created a publication template, you can create new "real" publications that are
based on the template. The "real" publications automatically contain:

• The same structure as the publication template.

• New topics for the topics based on a template. These contain the same elements and content
as the topic templates, but have unique ids so that you can edit them without affecting other
topics.

• The regular topics, which are are reused. If you make changes to these, those changes will affect
the content wherever it is used, just like content reuse [1098] elsewhere in Paligo.

The following example shows how this works:
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Example 29. Publication template for user guides

Let's say you have a range of products called "Acme 100", "Acme 200", and "Acme 300". You want
all of these products to have user guides with this structure:

To ensure consistency, you create a publication template. You already have regular topics for
"Warranty" and "Customer Support", so you drag-and-drop those into the publication template
structure. You then add new template topics for "Introduction", "Quick Start", "Monitoring",
"Controls", and "Troubleshooting". This provides the template structure that you want all of the
"Acme" user guides to follow.

Then, for each user guide, you create a new publication that is based on the template.

Paligo creates your new publications and each one automatically contains the same structure as
the template.

There are new topics for "Introduction", "Quick Start", "Monitoring", "Controls", and
"Troubleshooting" in each publication, each with unique ids so that you can edit them
independently.

The "Warranty" and "Customer Support" topics were added as regular topics in the template, so
they are reused. Any changes you make to those will affect those topics wherever they are used.
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The template (1) is used as the basis for regular publications that you can add content to and
publish as PDF, HTML5 help centers and other outputs. The regular publications (2, 3, and 4)
inherit the structure from the publication template. Paligo creates new publications, new topics,
and reused topics inside the publications so that their content matches the template.

To find out how to create your own publication templates and use them as the basis for new
publications, see:

• Create a Publication Template [458]

• Create a New Publication Based on a Template [460].

Create a Publication Template
Before you create a publication template, we recommend that you read the Publication
Templates [456] article, so that you are familiar with the concept and expected result.

To create a publication template:

1. Find the Templates section in the Content Manager. You need to create new templates in the
Templates section.
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2. Select the options menu ( ... ) for the Templates section and select Create Content.

3. Enter the settings for the publication template:

• Enter a name

• Select the Publication option

• Add the Languages you want the template to support.

4. Select OK to confirm.
Paligo creates your publication template. It goes in the Templates section of the Content
Manager.
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TIP
You can add folders in the Templates section by selecting the options
menu ( ... ) for Templates, and then Create folder. The folders are useful for
organizing your templates.

5. Select the publication template in the Templates section of the Content Manager. Paligo
opens the structure view.

6. Select New topic to create a new topic inside the publication template. Give the topic a
suitable name. Repeat this step until you have added all of the new topics that you want to be
included in the template. These new topics are "topic templates".

NOTE
You can also create topic templates from the options menu ( ... ) in the
Templates section. Select Create content and then choose to create a topic.
Any content that you create in the Templates section is a template.

7. If you want to reuse "regular" topics in your publication template, drag-and-drop them from
the Content Manager into the publication template structure. The topic is added, and when
you base a new publication on this template, it will reuse the topic.

8. Select Save.

Your template is now ready to be used as the basis for new "real" publications. To find out how to
do that, see Create a New Publication Based on a Template [460].

Create a New Publication Based on a Template
If your Paligo instance contains publication templates [456], you can create a new publication that
is based on one of those templates. When you create the publication, Paligo will:

• Create a new publication with the same structure as the template.
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• Create new topics to match the topic templates that are in the publication template structure.

• Reuse any regular topics that are in the publication template structure.

You can then work on the new topics and publications, adding and reusing content where needed,
until it is ready to publish.

NOTE
When you create a publication based on a template, the new publication only
matches the template structure at the time of creation. If the template is changed
at a later date, those changes will not apply to publications that have already been
created.

To create a publication that is based on a publication template:

1. In the Content Manager, select the options menu ( ... ) for the folder that is going to contain
your new publication. Then select Create content.
If your content is not in a folder, select the Documents section at the top of the Content
Manager instead. Documents is the top-level "parent" folder for any content that is not inside
another folder.

2. On the Create Content dialog:

• Enter a name for your new publication

• Select the Languages it should support

• Select From template as the document type. When you select From template, a browse
dialog appears. Use it to select the publication template that your new publication will be
based on.
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3. Select OK to confirm your choices.
Paligo creates a new publication and topics in the selected folder. The publication's structure
matches that of the publication template, and its forks link to the new topics and any reused
"regular" topics.

Topic Templates
Topic templates provide a quicker and easier way to create new topics that have a consistent
structure. With a topic template, you create the template and add the structure and content that
you want. Then, when you create a new topic, you can base the topic on the template. The new
topic will automatically inherit the content from the template, and you can add to it or change it as
needed.

Example 30. Topic template for "Troubleshooting" topic

Let's say you need to produce "Troubleshooting" topics for many different user guides, and you
want them to have a consistent structure that includes a paragraph and a table. Instead of
creating these topics individually, you can use a template.

You create a new template and then edit it. In the template, you add a table and a paragraph.

Next, you create new topics based on the template. The new topics automatically contain the table
and paragraph from the template, so there's no need to add them to each topic individually. In the
new topics, the table and paragraph are given new ids, so that you can edit them without affecting
the template or other topics.

To learn how to use topic templates, see:

• Create a Topic Template [462]

• Create a New Topic Based on a Template [464].

Create a Topic Template
If your Paligo instance contains topic templates [462], you can create new topics that are based on
those templates. This is useful if you have particular topic structures that should be used in many
places, but with different content in place.

When you create a new topic from a topic template, the new topic automatically includes the same
structure and content that exists in the topic template. But the content is given new ids, so that
you can edit it without affecting the template or other topics that are based on the template.

To create a topic template:

1. Find the Templates section in the Content Manager. You need to create new templates in the
Templates section.
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2. Select the options menu ( ... ) for the Templates section and select Create Content.

3. Give the template a name and choose the Topic document type. Then set the language for the
topic template and select OK.

NOTE
You can create templates for other document types too, if needed.

Paligo adds your new template to the Templates section.
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TIP
You can create folders in the Templates section and use them to organize
your templates. Select the option button ( ... ) for the Templates section and
select Create Folder.

4. Select a template to open it in the editor. Add the elements and content that you want to
be included in all topics that are based on your template. For example, you could add a
paragraph and a table.

5. Select Save.

You can now create new topics based on the topic template [464].

Create a New Topic Based on a Template
If you have topic templates [462] available, you can create new topics that are based on them.
These topics will contain:

• The same elements (structure) as the topic template they are based on

• The same content that exists in the topic template, but with new ids so that you can edit them.

To create a new topic based on a template:

1. In the Content Manager, select the options menu ( ... ) for the folder that you want to contain
your new publication. If a suitable folder does not already exist, you can create a new one
(Create Folder).

2. Select Create content.

3. Use the settings on the Create Content dialog to create the new topic:
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• Enter a name for the topic

• Select the Languages that you want the new topic to support.

• Select From template to display a browse dialog for topic templates. Select the topic
template that you want the new topic to be based on.

4. Select OK to confirm your choices.
Paligo creates a new topic that is based on your chosen topic template. It contains new
versions of the elements and content that were present in the topic template. You can make
changes to the new topic without affecting the topic template or any other topic that is based
on that topic template.

Move to Trash
To remove content from Paligo, you can either:

• Delete the content.
Deleting removes the content from your database (although it can be restored). To find out
about deleting content, see Delete Content [469].

• Move the content to the trash.
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Move to trash places the content in the trash folder, where you can see it, but it is no longer a
piece of "live" content that you can work with. You can restore it if needed, so that it becomes
"live" content again.

Both approaches will remove the content, but there is an advantage to using Move to Trash -
the trash folder is visible in the Content Manager, so you can easily see what content has been
removed.

In the following sections, you can find out how to use the Move to Trash feature:

• Move Content to the Trash [466]

• Restore Content from Trash [467]

• Empty the Trash [468].

Move Content to the Trash
To move content to the Trash folder:

1. Find the topic or other component in the Content Manager, and then select its options menu
( ... ).

2. Select the Move to trash option.
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TIP
You can move multiple components to the trash at once. Hold down Ctrl  on

Windows or Command ⌘  on Mac, and then select all of the components that

you want to delete. Then select Move to trash from the options menu ( ... ).

NOTE
If a topic is in the trash, but it is still used in a publication, this is shown in both the
publication's structure view and the sub-tree in the Content Manager. In those,
the topic is shown as "grayed out" and in italic.

Restore Content from Trash
If you place content in the Trash and later decide you need to move it back into your "live"
content, you can restore it. Once restored, the content is available in the Content Manager.

1. In the Content Manager, open the Trash folder and find the component(s) that you want to
restore.
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2. Select the options menu ( ... ) for the component(s) and then select Put back.
The Put back option is only available if the folder that originally contained the trashed content
still exists. If there is no Put back option, you can restore the component by dragging it from
the trash into a folder in the Content Manager.
When you restore, Paligo turns the "trashed" component back into a "normal" component.

TIP
You can select multiple components at once. Hold down Ctrl  on Windows or

Command ⌘  on Mac, and select all of the components that you want to restore.

Then select Put back from the options menu ( ... ).

Empty the Trash
If you are sure that you do not want to keep the content in the trash folder, you can delete it
by "emptying the trash". However, you cannot empty the trash if it contains content that has
dependencies.

A dependency is when a topic or publication is used elsewhere, either as content reuse or as the
target of a link. For example, if you have an "Introduction" topic in your trash, you cannot delete it
if a "live" topic contains a link to it. The "live" topic is dependent on the topic in the trash, as its link
will not work if the topic in the trash is permanently deleted.

To empty the trash:

1. In the Content Manager, open the Trash folder and find the components that you want to
delete.

2. Select the options menu ( ... ) and then select Delete.
Paligo will check to see if the content follows the rules for emptying the trash [469]. If it does,
Paligo will delete the content.

TIP
You can select multiple components at once. Hold down Ctrl  on Windows or

Command ⌘  on Mac, and select all of the components that you want to delete.

Then select Delete from the options menu ( ... ).
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Rules for Emptying the Trash
You can move any component to the trash, even if that component is reused. But you will not be
able to empty the trash if it contains components that have dependencies, such as:

NOTE
If content in the trash has dependencies, but only to other content in the trash,
then it can be deleted. Paligo will only stop a component from being deleted from
the trash if it has a dependency to "live" content i.e. content that is not in the
trash.

• A topic that is reused in other topics that are not in the trash

• A topic that is the target of links in other topics that are not in the trash

• A publication that is reused in another publication

• A publication that is the target of links in topics that are not in the trash.

To empty the trash, you must first deal with the dependencies. This may mean removing links to
the topic or removing the topic from inside other topics. To find out more, see Find Out Where
Content is Used [1136].

Delete Content
Abstract

Learn how to delete content in Paligo or move it to the trash. You can also restore trashed or
deleted content.

To remove content from Paligo, you can either:

• Delete the content - If you delete the content, it is removed completely. But it is possible to
restore deleted topics and publications, if needed.

• Move the content to the trash - Moving content to the trash means you can view the "deleted"
content more easily, as you can see what is in the trash folder. You can restore content from
the trash folder if needed. To learn about the move to trash feature, see Move to Trash [465].

If you have content that is reused, Paligo may prevent you from deleting it. This is so that you
do not accidentally delete a topic or publication that is needed elsewhere. To find out about
the checks Paligo makes and how you can delete reused content, see Rules for Deleting Reused
Content [477] and Find and Remove Dependencies [477].

Delete Topics, Folders, and Other Components
You can use the Content Manager to delete components, such as topics, informaltopics, and
images.

1. In the Content Manager, browse to the component that you want to delete.

2. Select the options menu ( ... ) for the component and then select Delete.
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Paligo will check to see if the component has any dependencies. Your content has a
dependency if it is reused in another topic or publication or if another topic links to your
content. If there is a dependency, Paligo will either ask you if you want to proceed with the
deletion or it will tell you the component cannot be deleted (see Rules for Deleting Reused
Content [477]).

3. If you want to proceed with the deletion, select Delete Items.
Paligo deletes the component from the database.

NOTE
If you have accidentally deleted a publication or topic, you can restore it from
the dashboard (see Restore Deleted Content [478]).

Delete Content Inside Topics
As Paligo uses structured content, you have more control over deleting your content. With a
single action, you can delete entire structures, individual elements, or only the content inside an
element. This is one of the benefits of structured content. Depending on what you want to achieve,
you can:
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TIP
If you are unfamiliar with the concept of "parent" and "child" elements, see
Understanding Content Structures [83].

• Delete text and leave the structural elements in place

• Delete an element but leave its content in place (this only applies for inline elements, such as
emphasis and guilabel).

• Delete an element to remove the content of the element. When you delete an element,
Paligo will remove:

• The selected element

• Any text or other content inside the element

• Any "child" elements inside the element

• Any text or other content inside the "child" elements.

You can view the structure by looking at the XML Tree View.

The structure from the top-level section to the currently selected element is also shown in the Element
Structure Menu.

NOTE
As Paligo uses structured content, you cannot just highlight multiple sections of
a page and press delete. That's not how structured content works. Your content
elements are in a hierarchy and so need to be deleted as structures, either as
individual elements or as "parent" plus "child" elements.
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TIP
If you want to delete an inline element, such as emphasis, rather than an entire
block of text, see Delete Inline Elements [475].

If you accidentally delete a paragraph, there is a way to restore it. You can
use Reuse Text Fragments [1113] to search for the paragraph and then insert it
again. However, this is only possible for a limited time period after the deletion
took place (approximately one day). Alternatively, you could use Revert a Text
Fragment to a Previous Revision [1675].

Delete Elements with the XML Tree View
This section describes how to delete an element using the XML Tree View.

CAUTION
If you delete an element, you will also delete its "child" elements. If you are
unfamiliar with the concept of "parent" and "child" elements, see Understanding
Content Structures [83].

TIP
If you need to move the copy to a new position in the structure, select it in the
XML Tree View and drag it to the new position.

1. Open a topic in the Editor [51].

2. Select the XML Tree View in the side panel.

3. Expand the hierarchy until you can see the element that you want to delete.
The XML Tree View shows the main elements in your topic as blue boxes, arranged in a
hierarchy that matches the structure. Any box with a white cross has lower level content. If
you select the white cross icon, the tree expands to show the lower levels.
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4. Position the cursor over the element you want to delete.
Paligo displays a copy icon and a delete icon.

5. Select the X to the right of the element to delete it

6. Select Confirm. If you are unsure, select to keep the content and abort the deletion.

NOTE
If you are unsure, select Cancel to keep the content and abort the deletion.

Delete Elements with the Element Structure Menu
You can use the Element Structure Menu to delete an element.

1. Click inside the block element you want to delete.

2. Select the same element in the Element Structure Menu. For example, if you wanted to delete
a paragraph, select para.
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3. Select Delete.

Paligo deletes the element.

4. Select Save. 

Delete Elements with Keyboard Shortcuts
To use keyboard shortcuts to delete elements inside a topic:

1. Click in the element you want to delete.

2. Use the following keyboard shortcuts:

Mac: Option ⌥  + Shift ⇧  + D

Windows: Alt  + Shift  + D

Paligo removes the element and the content inside the element, including any "child"
elements.
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Delete Inline Elements
To delete inline elements, such as guilabel, tag, and emphasis without deleting the content
inside them:

1. Click on the inline element you want to delete.

Paligo shows the element in the Element Structure Menu.

2. Select the Remove Formatting button in the toolbar.

Paligo deletes the inline element without deleting the content inside the inline element.

NOTE
Alternatively, you can delete the inline element and the content inside it. To do
this, click on the inline element and then either use a keyboard shortcut:

Mac: Option ⌥  + Shift ⇧  + F

Windows: Alt  + Shift  + F

OR

Select the element in the Element Structure Menu and then select Delete.
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Delete Attributes
Each element in Paligo can have attributes, which are properties. For example, a paragraph could
have a role attribute with the value "example-style" so that it can be styled differently to other
paragraphs by using CSS [654]. If an attribute is no longer needed, you can delete it.

1. Select the element in the topic.

2. Place the cursor in the Element Structure Menu below the tool bar.

NOTE
When you select an element in the Element Structure Menu, Paligo
highlights that element in the topic. The highlight is yellow.

3. From the element, select Go to element to show the attributes chosen for this particular
element.

4. Place the cursor over the attribute in the Element Attributes Panel and select the X to
remove it.

5. Select Save. 

Remove Element Profiling
Paligo uses a blue filtering symbol to show that content has a profiling attribute, see Filtering /
Profiling [1141].

This section describes how to remove one of multiple profiling values.

1. Select the element in the topic.

2. Place the cursor in the Element Structure Menu below the tool bar.

3. Select the attribute value to be removed.
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4. Clear the checkbox for the profiling value to be removed.

5. Select Apply.

6. Select Save. 

Rules for Deleting Reused Content
When you try to delete content, Paligo will check how the deletion will affect your remaining
topics. If the remaining topics will be broken by the deletion, Paligo will either:

• Prevent you from deleting the content

• Ask you if you want to go ahead with the deletion, even though the content will break links in
other topics.

To do this, Paligo has some internal rules that involve checking your content for "dependencies". A
dependency is when a topic or some other component needs to reference another component.

The checks that Paligo runs include:

• Do any topics link to the component you are trying to delete?

• Do any publications contain the component you are trying to delete?

• Do any topics contain the component you are trying to delete?

• Are there any components with dependencies inside the folder (this only applies to folders)?

If the answer is yes, there is a dependency. Depending on the scenario, Paligo will either ask you if
you want to proceed with the deletion or it will tell you that the component cannot be deleted.

If you choose to proceed with a deletion, the component will be deleted, but this will result
in broken links and missing content from other topics. It is a good idea to remove these
dependencies before you delete, so that other topics do not have missing content.

If Paligo will not allow you to delete the component, you can Find and Remove
Dependencies [477], and then try again. When there are no dependencies, Paligo will let you
delete the component.

Find and Remove Dependencies
If Paligo will not allow you to delete content because of dependencies, you will either need to keep
the content or remove the dependencies.

You can use the Metadata information to find the dependencies, and then you will need to
delete those manually in each topic, publication, or other component. To access the Metadata
information, select the options menu ( ... ) for the reused publication or topic you want to delete,
and then select Edit > Open Structure.

Paligo Documentation

477



The dependencies information is in the Used in, Uses, and Related publications categories. To
find out more, see Find Out Where Content is Used [1136].

Restore Deleted Content
Have you accidentally deleted a publication or topic? Don't worry, you can recover them from the
Activity Feed on your dashboard.

NOTE
You can only restore deleted topics and publications.

NOTE
If you moved content to the trash rather than deleted it, see Move to Trash [465].
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1. Select Dashboard in the top menu in Paligo.

Paligo displays your dashboard.

2. In the Activity Feed section of your dashboard, find the activity record that was made when
you deleted the content.

3. Select the Restore Document option.

Paligo displays the Restore Document dialog.

4. Use the Restore Document dialog to choose where the restored content should go.

5. Select Restore.
Paligo recovers the deleted content and places it in the folder you selected in step 4.

Convert a Component
Abstract

Discover how to convert a component, such as a topic, into a different type of component, such as
an informal topic or an appendix.

Use the metadata panel to convert a component into a different type of component. This is
much quicker than creating a new component and then moving the required content into it. For
example, let's say you have created a topic but you later realise that it would be more useful as an
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informal topic. By using the Subtype option in the topic's metadata, you can quickly convert it into
an informal topic.

NOTE
Only administrators and authors can convert a component into a different type of
component.

To convert a component into a different type of component:

1. In the Content Manager, select the dotted menu ( ... ) for the component and then select Edit
and then Open structure.
Paligo displays the metadata panel for the component.

2. Use the Subtype dropdown list to change the component type. You can choose from any of
the components in the list. Other components are not supported.

3. Select Update to apply the change.
Paligo converts your component.

Preview Topics Before Publishing
You can use Paligo's preview feature to see how a topic will appear in PDF, HTML, and HTML5
outputs.

We recommend that you preview each topic that you create or edit, so that you can see if images
need to be resized, if there's too much information, whether accordions would make the topic
more usable, etc.
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Here, we explain how to set the Layout that will be used for a preview and also how to view a
preview.

NOTE
The preview feature is not available for certain components, such as informal
topics. To preview an informal topic, add it to a regular topic as a component and
then preview the regular topic. (Select Insert and choose Component to add the
informal topic.)

Set the Layouts for the Previews
You can choose which Layout is used for each type of preview. For example, if you create your own
HTML5 help center Layout, you can choose to use that instead of the default HTML5 Layout.

To set the Layouts for the previews:

1. Select the Editor Settings icon (cog).

2. On the Editor Settings dialog, select the Preview tab.

3. Choose a Layout for each type of preview (PDF, HTML, HTML5).
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4. Select Save Settings.

Preview a Topic
You can see a preview of how your topic will look when it is output to different formats. The
preview is useful for seeing how your content will look to readers, so that you can change image
sizes, consider reducing the amount of text or use accordions, etc.

To preview a topic:

1. Open the topic you want to preview.

2. Select Preview.

3. If your topic uses profiling (conditional content) or variables, select Profile Settings. Choose
the Variables [1186] and filter profiles [1141] that you want to be used for the preview. Select
Apply and then close the Profile settings dialog.
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TIP
You can save the variables and profiling settings so that they are the default
preview settings for the topic. Select the Options tab and select Remember
Filter Settings.

4. Choose the format that you want to preview. You can choose from PDF, HTML, or HTML5.
Paligo loads your topic into a preview version of the output you selected. The preview is
shown in a new tab and it uses the default Layout for each type of output. This gives you a
good idea of what your topic will look like when it is published.
Here's an example of an HTML5 preview:

If you make changes to your topic, you will need to generate a new preview. Refreshing the
existing preview in the browser will only reload the preview that was previously generated.

NOTE
To learn more about filtering/profiling, see Filtering / Profiling [1141].
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Preview a Publication for PDF
The PDF layout editor has a preview feature that you can use to preview individual topics
or an entire publication. It is especially useful when you are designing front covers and back
covers [848], as you can see the effect of changes you make in the layout settings. For example,
you can see how the alignment of an "info element" affects the look of a front cover.

To preview a publication for PDF:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Choose document and then choose the publication you want to preview.

Paligo loads the publication, including its covers into the preview pane.

4. Use the layout settings to make styling adjustments that will apply to the PDF output. For a
list of the settings and references to documentation that explains how to use them, see PDF
Layout Editor Options [799]. When you have made the changes, select Update preview and
Paligo will refresh the preview so that you can see the effect of the changes.
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Paligo shows the preview (1). Make your changes in the settings (2) and then select Update Preview
(3) to see the effect.

5. Select Save. 

Follow a Topic or Publication
With the Follow feature, you can get Paligo to send you a notification whenever another user
makes a change to a component, such as a topic, publication, or admonition. This is a great way to
keep up-to-date with work that is taking place on particular pieces of content.

To use the Follow feature, you first need to set up your profile so that you receive follow
notifications [485]. When that is in place, you can follow a component [486], and then you will
receive notifications when another user:

• Changes the component in the Paligo editor

• Changes the structure of the component, for example, changes the order of topics in a
publication structure

• Renames the component.

When you are no longer interested in the component, you can unfollow it [488]. Paligo will then
stop sending you notifications about that component.

Choose the Type of Notifications to Receive
To choose the type of notifications you will receive when you follow a component, use the My
Profile settings.

1. Select your profile name in the upper right corner to display a menu, and then select My
Profile.

2. Select the Notifications tab.

3. In the Followed documents section, check the box(es) for the type(s) of notification you want
to receive. There is a box for email and a box for Slack. The Slack notifications will only work if
you have set up the Paligo-to-Slack integration [1516].
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4. Select Save.

Follow a Component
When you have set up your profile so that you will receive notifications when you follow a
component, you can start following topics, publications, admonitions, etc. You can follow these
without setting up your profile, but you will not receive any notifications.

To follow a component:

1. In the Content Manager, find the component you want to follow. This could be a topic,
publication, note, warning, informaltopic, etc.

2. Select the options menu ( ... ) for the component and then select Follow.
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Paligo will send you a notification when another user makes changes to the followed component.

NOTE
You will only receive notifications if you have set up follow notifications in your
profile settings [485]. You only get notifications if other users make changes, there
are no notifications if you make changes yourself.
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If you want to stop receiving notifications, see Unfollow a Component [488]

Unfollow a Component
Use the Unfollow feature to stop following a topic, publication, or other component. When you
unfollow a component, you will stop receiving notifications when another user makes changes to
it.

To unfollow a component:

1. In the Content Manager, find the component you want to stop following. This could be a topic,
publication, note, warning, informaltopic, etc.

2. Select the options menu ( ... ) for the component and then select Unfollow.
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If you decide that you want to start receiving notifications about the component again, you can
follow it [486].

Software and Code Documentation
The content model of Paligo has very good support for documenting software and code snippets.
There are many elements you can use for marking up UI elements and code elements, and we
describe the most commonly used ones in General software elements [491]. Refer to the standard
DocBook Element Reference for the full set of elements available.
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An example containing a code block as it appears in the published output. This code block has
annotations.

In your Paligo content, you can add:

• Code blocks for multi-line examples of code [491]

• Annotations [492] to add "hot spot" to parts of a code block that link to explanatory text.

• Inline code elements [494] for when you want smaller amounts of code inside a paragraph.

You can also embed code from external sources [495], including Swagger content [527].

TIP
It's also possible to import Swagger/Open API content [1806] into Paligo. With an
import, the content is in Paligo, just like your other content. This is different to
embedding content, where the content is inserted into a Paligo topic during the
publishing process and only for the published output.

For publishing, there is also the HTML5 API layout, which is specially designed for documenting
APIs. It has a three-panel layout, with navigation on the left, content in the center, and
code examples on the right, with language tabs for switching between examples in different
programming languages.

To find out more about the API layout, see API Documentation Layout [565]
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General software elements
Even if you are not documenting much code, if you document software you'll often have to refer
to parts of the software product, such as UI components, file names, tags, keyboard shortcuts, etc.
Here are some common elements to use:

Example 31. UI components
The easiest way to refer to UI components (buttons, menus, toolbars, etc) is to use one element as
a generic UI element: guilabel. Here's an example:

Click on the Ok button.

Since this is so common (and recommended practice instead of using bold or italic for such terms),

there is also a keyboard shortcut for it: Alt G .

If you want to be more granular, you can use very specific elements instead, using guilabel only
for labels, guibutton for buttons, guimenu and its sub elements for menus, etc.

Another common need is to write file names and paths, and for this you have the element
filename.

Example 32. Keyboard shortcuts
To write keyboard shortcuts properly, and give you the option for how to style them now or
change it later, or use different styling for different outputs, use the keycap element:

Hit Alt K  to add a keycap element.

As you can see, this element can be styled, and here it is styled as keyboard keys, and as the
example shows this element has a keyboard shortcut itself for convenience.

If you want, you can use it separately, or in combination with the keycombo element. If keycap
elements are wrapped in a keycombo element, by default it will output a "+" symbol between the
keys (which can be customized in stylesheets if needed).

Code Blocks in your Content
One of the most common needs when documenting software is to write code blocks. The main
element for this is programlisting.

To add a programlisting element:

1. Position the cursor at the start of the line where you want to add the code block.

2. To display the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

3. Search for the programlisting element and select it.
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When you add a programlisting element, a code snippet box appears in the topic.

4. Add your code inside the code snippet box.

The programlisting element is sometimes referred to as "verbatim", as the code you add inside
the element will be rendered exactly how it appears in the editor. For example, it will keep spaces
and line breaks to represent the code properly. Some other elements also work like this, such as
screen and literallayout.

Example 33. Programlisting sample

Here, a javascript function has been added inside a programlisting element. This is how the
code looks in the output.

function myFunction() { 
    var x = "", i;
    for (i=0; i<5; i++) {
        x = x + "The number is " + i + "<br>";
    }

    document.getElementById("demo").innerHTML = x; 
}

This is a javascript function
This sets a value to an element using the DOM model.

In the sample shown , a code block is added inside the programlisting element. The javascript
function contains (1) on the first line and (2) on the last line. These are callouts, which you can use
to annotate code blocks [492].

Annotate Code Blocks
You can annotate code blocks by using the calloutlist element and co elements. In the
published output, the callouts act as clickable "hotspots" that highlight parts of the code. When
someone selects a "hotspot", they are taken to the callout text explanation for that "hotspot".

For example, in the image below, the code sample has two callout "hotspots" labelled 1 and 2.
Below the code sample, there are numbers that match the hotspots, and next to each number is
an annotation that explains the purpose of the corresponding code.
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To annotate code using calloutlist:

1. Select a position in the code block where you want a callout "hotspot" to appear.

2. To display the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

3. Select the co element and give it an xml:id value in the Element attributes section. Each co
element has to have an xml:id value that is unique in that specific topic. For example, you
could give the first co element the xml:id id_1, the second co element the xml:id id_2 and
so on.

4. Add a calloutlist element after the programlisting element that contains your code
block.

TIP
It can be a good idea to include the programlisting and calloutlist
elements inside an example element, so that they are all in a single
"container" (the example element).

5. Give each callout in the calloutlist an @xml:id as well, different from the ones in the co
elements, e.g "callout_1", "callout_2". Again, these ids need to be unique.

6. Associate the co elements with the callout elements:

a. For each co element, add a @linkends attribute. Set the value of the linkends attribute
to the xml:id value of the callout that you want to associate it with.

b. For each callout element, add the @arearefs attribute. Set the value of the arearefs
attribute to the xml:id value of the co that you want to associate it with.
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Code in a Paragraph (Inline Code)
If you want to include a small snippet of code in a paragraph rather than as a full block of code,
you can use an inline element. There are several elements you can use for this purpose, but
perhaps the most commonly used is code.

But there are other elements you can use too. For example, for terminal commands, you
might want to use the command element. There are also elements like synopsis, cmdsynopsis,
userinput, varname, replaceable, constant, and many more that you can read more about in
the standard Element Reference. The important thing is to be consistent when choosing elements
for marking up code samples.

To add a code element (or any other inline element):

1. Highlight the text to which you want to apply an element.

2. To display the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

3. Select the element that you want from the list.
For example, choose code.

4. Enter your code inside the element.
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Example 34. Inline code sample

Let's say you wanted to add the code ssh -1 username remote-address to a paragraph in
your content. To do that, you place the cursor at the appropriate position in the para element,
and then add the inline code element.

You type the ssh -1 username remote-address code inside the code element and when you
publish, the paragraph contains a mix of regular text and code, like this:

To log into another machine type ssh -l username remote-address and hit Enter.

Embed Code from an External Source
You can set your help content to use the latest code samples from a repository, such as GitHub
or BitBucket. Once set up, your HTML5 help will be able to update code samples automatically,
without being republished.

NOTE
The code samples need to be in an "https" URL.

NOTE
For embedding Swagger/Open API code, see Embed Swagger OpenAPI [527].

To set up your HTML5 help to use "live" code snippets from a repository, use dynamic code
snippets.

1. Select Layout and then edit the HTML5 layout you are going to use for publishing.
Alternatively, you can create a new HTML5 layout and edit that.

2. Edit the HTML5 layout and select the Classes and attributes category. Enable the Output
role attribute as class names setting and save the layout.

3. Create or edit a topic that you want to contain code from an external source.

4. Select the position where you want the code to appear and then:

1. Press Alt  and Enter  (Windows) or Command  and Enter  (Mac) to access the Element

list.

2. Add a code block element, either programlisting or screen.

5. Select the programlisting or screen element in the topic.

TIP
You can add a programlisting element with these attributes added by the

shortcut Alt , . Then you just need to add the URL value.
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6. In the Element attributes section, add these attributes and values:

• A @role attribute with the value embedcode

• An @xlink:href attribute with the URL to the code snippet in your repository.

7. Optional: If you want or need fallback code for other output formats, add the code snippet in
the programlisting or screen element as well.

When you publish, your code will be fetched from the repository and will be automatically updated
if that code changes.

NOTE
If you also publish to other outputs such as PDF, the embedded code will still be
fetched dynamically at publish time. But if you change the code samples in your
repository, you will need to republish the PDF output to have Paligo fetch the
latest changes.

Syntax Highlighting
Abstract

Syntax highlighting is when code samples use color-coding and indentations to make it easier to
differentiate between parts of the code.

Syntax highlighting is when code samples use color-coding and indentations to make it easier to
differentiate between parts of the code. In the following code extract, syntax highlighting is used
to apply different colors to elements. The background is dark and different colors are used to
highlight the different types of code element, for example, var declarations are light blue and the
var names, such as icon1, are green.

Syntax highlighting works differently for HTML5 [497] and PDF [506], but there are some common
characteristics:

• You can enable and disable syntax highlighting on the layout you use for publishing.

• You choose the theme to use for syntax highlighting on the layout. There are many themes, each
offering different colors and syntax highlighting.

• Paligo can usually detect a code language in a verbatim element, such as programlisting,
automatically. But if it is not recognizing your code sample, you can apply a language attribute
and set the language there.
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Syntax Highlighting for HTML5

Abstract
You can set up syntax highlighting for HTML5 outputs so that code samples use colors for the
syntax.

To set up syntax highlighting for HTML5 outputs, use the settings on an HTML5 layout, and add
attributes to the code sample if required:

1. Select Layout and then edit the HTML5 layout you are going to use for publishing.
Alternatively, you can create a new HTML5 layout and edit that.

2. On the Layout Editor, open the Verbatim (code and software) settings.

3. Use the settings to set up syntax highlighting:

• Highlight verbatim elements - Set the syntax highlighting feature to Enable (on) or
Disable (off).

• Highlight theme - Choose a theme. Each theme provides a different color scheme for
syntax highlighting and may highlight different parts of the code. There are many different
themes to choose from and we recommend that you experiment until you find the theme
that best meets your requirements.

4. Paligo will usually be able to recognize the language in a code sample automatically and will
apply the chosen theme for syntax highlighting. If Paligo is not recognizing your code sample,
you can give the sample a language attribute. Paligo will then be able to identify the sample
by the value that's set for the language attribute.
To set the language for a code sample:

a. Edit the topic that contains the code sample and select the verbatim element for the
sample, for example, the programlisting element.

b. In the Element attributes section, add the language attribute and enter a supported
language as the value. For example, javascript. To find out what values are acceptable, see
Syntax Highlighting Languages for HTML5 [498].

Paligo Documentation

497



5. Select Save.

Syntax Highlighting Languages for HTML5
You can use the language attribute to give code samples a specific programming language. For
example, you could give a programlisting element the language attribute and set its value to
javascript.

To find out how to add the language attribute, see Syntax Highlighting for HTML5 [497].

The following table shows the values that you can set for the language attribute. For some
languages, you can use one of several values, and these are separated by a comma in the table.
You should only enter one of the values, for example, for JavaScript you can enter either js or
javascript or jsx.

Programming language Value for the language attribute

1C 1c

4D 4d

ABNF abnf

Access logs accesslog

ActionScript actionscript, as

Ada ada

Alan alan, i

AngelScript angelscript, asc

Apache apache, apacheconf
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Programming language Value for the language attribute

AppleScript applescript, osascript

Arcade arcade

ARM assembler armasm, arm

AsciiDoc asciidoc, adoc

AspectJ aspectj

AutoHotkey autohotkey

AutoIt autoit

AVR assembler avrasm

Awk awk, mawk, nawk, gawk

Axapta axapta

Bash bash, sh, zsh

Basic basic

BNF bnf

Brainfuck brainfuck, bf

C h

C# csharp, cs

C++ cpp, hpp, cc, hh, c++, h++, cxx, hxx

Cache Object Script cos, cls

C/AL cal

Cap’n Proto capnproto, capnp

Clojure clojure, clj

CMake cmake, cmake.in
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Programming language Value for the language attribute

CoffeeScript coffeescript, coffee, cson, iced

Coq coq

Crmsh crmsh, crm, pcmk

Crystal crystal, cr

CSP csp

CSS css

Cypher (Neo4j) cypher

D d

Dart dart

Delphi delphi, dpr, dfm, pas, pascal, freepascal, lazarus, lpr, lfm

Diff diff, patch

Django django, jinja

DNS Zone file dns, zone, bind

Dockerfile dockerfile, docker

DOS dos, bat, cmd

dsconfig dsconfig

DTS (Device Tree) dts

Dust dust, dst

Dylan dylan

EBNF ebnf

Elixir elixir

Elm elm
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Programming language Value for the language attribute

Erlang erlang, erl

Excel excel, xls, xlsx

Extempore extempore, xtlang, xtm

F# fsharp, fs

FIX fix

Fortran fortran, f90, f95

Gams gams, gms

GAUSS gauss, gss

G-Code gcode, nc

GDScript godot, gdscript

Gherkin gherkin

GN for Ninja gn, gni

Go go, golang

Golo golo, gololang

Gradle gradle

Grammatical Framework gf

Groovy groovy

Haml haml

Handlebars handlebars, hbs, html.hbs, html.handlebars

Haskell haskell, hs

Haxe haxe, hx

HTML, XML xml, html, xhtml, rss, atom, xjb, xsd, xsl, plist, svg
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Programming language Value for the language attribute

HTTP http, https

Hy hy, hylang

Inform7 inform7, i7

Ini, TOML ini, toml

IRPF90 irpf90

Java java, jsp

JavaScript javascript, js, jsx

JSON json

Kotlin kotlin, kt

Lasso lasso, ls, lassoscript

LaTeX tex

LDIF ldif

Leaf leaf

Less less

Lisp lisp

LiveCode Server livecodeserver

LiveScript livescript, ls

Lua lua

Makefile makefile, mk, mak

Markdown markdown, md, mkdown, mkd

Mathematica mathematica, mma, wl

Matlab matlab
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Programming language Value for the language attribute

Maxima maxima

Maya Embedded Language mel

Mercury mercury

mIRC Scripting Language mirc, mrc

Mizar mizar

Mojolicious mojolicious

Monkey monkey

Moonscript moonscript, moon

N1QL n1ql

Nginx nginx, nginxconf

Nim nimrod

Nix nix

NSIS nsis

Objective C objectivec, mm, objc, obj-c

OCaml ocaml, ml

OpenGL Shading Language glsl

OpenSCAD openscad, scad

Oracle Rules Language ruleslanguage

Oxygene oxygene

Parser3 parser3

Perl perl, pl, pm

PF pf, pf.conf
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Programming language Value for the language attribute

PHP php, php3, php4, php5, php6, php7

Plaintext plaintext, txt, text

Pony pony

PostgreSQL & PL/pgSQL pgsql, postgres, postgresql

PowerShell powershell, ps, ps1

Processing processing

Prolog prolog

Properties properties

Protocol Buffers protobuf

Puppet puppet, pp

Python python, py, gyp

Python profiler results profile

Q k, kdb

QML qml

R r

Razor CSHTML cshtml, razor, razor-cshtml

ReasonML reasonml, re

RenderMan RIB rib

RenderMan RSL rsl

Roboconf graph, instances

Robot Framework robot, rf

RPM spec files rpm-specfile, rpm, spec, rpm-spec, specfile
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Programming language Value for the language attribute

Ruby ruby, rb, gemspec, podspec, thor, irb

Rust rust, rs

SAS SAS, sas

Scala scala

Scheme scheme

Scilab scilab, sci

SCSS scss

Shape Expressions shexc

Shell shell, console

Smali smali

Smalltalk smalltalk, st

Solidity solidity, sol

SQL sql

Stan stan, stanfuncs

Stata stata

STEP Part 21 p21, step, stp

Structured Text iecst, scl, stl, structured-text

Stylus stylus, styl

SubUnit subunit

Supercollider supercollider, sc

Swift swift

Tcl tcl, tk
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Programming language Value for the language attribute

Terraform (HCL) terraform, tf, hcl

Test Anything Protocol tap

Thrift thrift

TP tp

Twig twig, craftcms

TypeScript typescript, ts

Vala vala

VB.Net vbnet, vb

VBScript vbscript, vbs

Verilog verilog, v

VHDL vhdl

Vim Script vim

x86 Assembly x86asm

XL xl, tao

XQuery xquery, xpath, xq

YAML yml, yaml

Zephir zephir, zep

Syntax Highlighting for PDF

Abstract
You can set up syntax highlighting for PDF outputs so that code samples use colors for the syntax.

Use a PDF layout to set up syntax highlighting for PDF:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. On the Layout Editor, open the Verbatim (code and software) settings and select Syntax
Highlight. Paligo displays the syntax highlighting settings.
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3. Use the settings to set up syntax highlighting for your PDF output:

• Turn syntax highlight on - Set the syntax highlighting feature to Enabled (on) or Disabled
(off).

• Default language when no language attribute has been set - If the code samples in
your topics do not have a language set, Paligo will usually be able to identify the language
automatically. But if it cannot identify the language, it will assume the code sample is in the
default language. Use this setting to define the default language.

• Default style for syntax highlight - Choose a theme. Each theme provides a different
color scheme for syntax highlighting and may highlight different parts of the code.
We recommend that you experiment until you find the theme that best meets your
requirements.

NOTE
The default language and default style are only used if a code sample does
not have its own attributes set for language and style.

4. You can use the language attribute to give a code sample its own language and style settings
that will be used instead of the defaults. This is useful if Paligo is unable to recognize the
language automatically.

a. Edit the topic that contains the code sample and select the verbatim element for the
sample, for example, the programlisting element.

b. In the Element attributes section, add the language attribute and enter a supported
language as the value. For example, javascript. To find out what values you can use, see
Syntax Highlighting Languages for PDF [509].
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c. Add the role attribute and enter a supported theme name as the value. For example,
role: fruity. This is an optional step. Typically, you would want all code samples to use
the same theme for consistency, and so would set a default theme on the layout and not
use the role attribute on individual code samples.

NOTE
You can set the value to any theme that is listed in the Default style for
syntax highlight setting on the PDF layout editor.

5. Select Save.

When you publish to PDF using the layout you edited, the PDF output will use syntax highlighting.
If a code sample has its own language and role set, Paligo will apply those. If a code sample does
not have its own language and role set, Paligo will attempt to identify the language automatically
and will use the default theme. If Paligo cannot identify the language automatically, it will use the
default language that is set in the layout.
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Syntax Highlighting Languages for PDF
You can use the language attribute to give code samples a specific programming language. For
example, you could give a programlisting element the language attribute and set its value to
javascript.

To find out how to add the language attribute, see Syntax Highlighting for PDF [506].

The following table shows the values that you can set for the language attribute. For some
languages, you can use one of several values, and these are separated by a comma in the table.
You should only enter one of the values, for example, for JavaScript you can enter either js or
javascript.

Language Value for the language attribute

ABAP abap

ABNF abnf

ActionScript as, actionscript

ActionScript 3 as3, actionscript3

Ada ada, ada95, ada2005

ADL adl

Agda agda

Alloy alloy

AmbientTalk at, ambienttalk, ambienttalk/2

ANTLR antlr

ANTLR with ActionScript Target antlr-as, antlr-actionscript

ANTLR with CPP Target antlr-cpp

ANTLR with C# Target antlr-csharp, antlr-c#

ANTLR with Java Target antlr-java

ANTLR with ObjectiveC Target antlr-objc

ANTLR with Perl Target antlr-perl

ANTLR with Python Target antlr-python
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Language Value for the language attribute

ANTLR with Ruby Target antlr-ruby, antlr-rb

ApacheConf apacheconf, aconf, apache

APL apl

AppleScript applescript

Arduino arduino

AspectJ aspectj

Aspx-cs aspx-cs

Aspx-vb aspx-vb

Asymptote asy, asymptote

Autohotkey ahk, autohotkey

AutoIt autoit

Awk awk, gawk, mawk, nawk

Basemake basemake

Bash bash, sh, ksh, shell

Bash Session console, shell-session

Batchfile bat, batch, dosbatch, winbatch

BBCode bbcode

BC bc

Befunge befunge

BlitzBasic blitzbasic, b3d, bplus

BlitzMax blitzmax, bmax

BNF bnf
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Language Value for the language attribute

Boo boo

Boogie boogie

Brainfuck brainfuck, bf

Bro bro

BUGS bugs, winbugs, openbugs

C c:

C# csharp, c#

C++ cpp, c++

CA65 Assembler ca65

cADL cadl

CAmkES camkes, idl4

CBM BASIC V2 cbmbas

Ceylon ceylon

CFEngine3 cfengine3, cf3

Cfstatement cfs

ChaiScript chai, chaiscript

Chapel chsprl, chpl

Cheetah cheetah, spitfire

Cirru cirru

Clay clay

Clojure clojure, clj

ClojureScript clohurescript, cljs
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Language Value for the language attribute

CMake cmake

C-Objdump c-objdump

COBOL cobol

COBOLFree cobolfree

Coffee-script coffee-script, coffeescript, coffee

Coldfusion CFC cfc

Coldfusion HMTL cfm

Common Lisp common-lisp, cl, lisp

Component Pascal componentpascal, cp

Control, Debian Control control, debcontrol

Coq coq

Cpp-Objdump cpp-objdump, c++-objdumb, cxx-objdump

CPSA cpsa

Crmsh crmsh, pcmk

Croc croc

Cryptol cryptol, cry

Csound Document csound-document, csound-csd

Csound Orchestra csound, csound-orc

Csound Score csound-score, csound-sco

CSS css

CSS+Django, CSS+Jinja css+django, css+jinja

CSS+Erb, CSS+Ruby css+erb, css+ruby
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Language Value for the language attribute

CSS+Genshitext, CSS+Genshi css+genshitext, css+genshi

CSS+Lasso css+lasso

CSS+Mako css+mako

CSS+Mozpreproc css+mozpreproc

CSS+Myghty css+myghty

CSS+PHP css+php

CSS+Smarty css+smarty

CUDA cuda, cu

Cypher cypher

Cython cython, pyx, pyrex

D d

Dart dart

Debian Sourcelist sourceslist, sources.list, debsources

Delphi delphi, pas, pascal, objectpascal

DG dg

Diff diff, udiff

Django/Jinja django, jinja

D-Objdump d-objdump

Docker dockerfile, docker

Dpatch dpatch

DTD dtd

Duel duel, jbst, jsonml+bst
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Language Value for the language attribute

Dylan dylan

DylanLID dylan-lid, lid

Dylan Session dylan-console, dylan-repl

Earl Grey earl-grey, earlgrey, eg

Easytrieve easytrieve

EBNF ebnf

eC ec

ECL ecl

Eiffel eiffel

Elixir elixir, ex, exs

Elixir iex session iex

Elm elm

EmacsLisp emacs, elisp, emacs-lisp

ERB erb

Erlang erlang

Erlang ERL Session erl

Evoque evoque

Ezhil ezhil

Factor factor

Fancy fancy, fy

Fantom fan

Felix felix, flx
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Language Value for the language attribute

Fish fish, fishshell

Fortran fortran

FortranFixed fortranfixed

FoxPro, VFP, Clipper, XBase foxpro, vfp, clipper, xbase

FSharp fsharp

GAP gap

GAS gas, asm

Genshi genshi, kid, xml+genshi, xml+kid

Genshi Text genshitext

Gettext Catalog pot, po

Gherkin cucumber, gherkin

GLSL glsl

Gnuplot gnuplot

Go go

Golo golo

GoodData-CL gooddata-cl

Gosu gosu

Gosu Template gst

Groff groff, nroff, man

Groovy groovy

Haml haml

Handlebars Handlebars
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Language Value for the language attribute

Haskell haskell, hs

Haxe hx, haxe, hxsl

Hexdump Hexdump

HTML html

HTML+Cheetah html+cheetah, html+spitfire, htmlcheetah

HTML+Django/Jinja html+django, html+jinja, htmldjango

HTML+Evoque html+evoque

HTML+Genshi html+genshi, html+kid

HTML+Handlebars html+handlebars

HTML+Lasso html+lasso

HTML+Mako html+mako

HTML+Myghty html+myghty

HTML+PHP html+php

HTML+Smarty html+smarty

HTML_Twig html+twig

HTML+Velocity html+velocity

HTTP http

HXML haxeml, hxml

Hy hylang

Hybris hybris, hy

IDL idl

Idris idris, idr
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Language Value for the language attribute

Igor igor, igorpro

Inform 6 inform6, i6

Inform 6 template i6t

Inform7, i7 inform7, i7

INI ini, cfg, dosini

Io io

Ioke ioke, ik

IRC logs irc

Isabelle isabelle

J j

Jade jade

JAGS jags

Jasmin jasmin, jasminxt

Java java

JavaScript js, javascript

JavaScript+Cheetah js+cheetah, javascript+cheetah,
js+spitfire, javascript+spitfire

JavaScript+Django/Jinja js+django, javascript+django, js+jinja,
javascript+jinja

JavaScript+Genshitext, js+genshitext, js+genshi,
javascript+genshitext, javascript+genshi

JavaScript+Lasso js+lasso, javascript+lasso

JavaScript+Mako js+mako, javascript+mako

Javascript+Mozpreproc javascript+mozpreproc
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Language Value for the language attribute

JavaScript+Myghty js+myghty, javascript+myghty

JavaScript+PHP js+php, javascript+php

Javascript+Ruby js+erb, javascript+erb, js+ruby,
javascript+ruby

JavaScript+Smarty js+smarty, javascript+smarty

Java Server Page jsp

JCL jcl

JLCON Julia Console jlcon

JSON json

JSON-LD jsonld, json-ld

Julia julia, jl

Kal kal

Kconfig kconfig, menuconfig, linux-config, kernel-
config

Koka koka

Kotlin kotlin

Lasso lasso, lassoscript

Lean lean

LessCSS less

Lighttpd configuration lighty, lighttpd

Limbo limbo

Liquid liquid

Literate Cryptol lcry, literate-cryptol, lcryptol

Literate-Haskell lhs, literate-haskell, lhaskell
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Language Value for the language attribute

Literate Idris lidr, literate-idris, lidris

Literate Lagda lagda, literate-agda

Live-Script live-script, livescript

LLVM llvm

Logos logos

Logtalk logtalk

LSL lsl

Lua lua

Makefile make, makefile, mf, bsdmake

Mako mako

MAQL maql

Mask mask

Mason mason

Mathematica mathematica, mma, nb

Matlab matlab

Matlab session matlabsession

MiniD minid

Modelica modelica

Modula-2 modula2, m2

MoinMoin/Trac Wiki markup trac-wiki, moin

Monkey monkey

MOOCode moocode, moo

Paligo Documentation

519



Language Value for the language attribute

MoonScript moon, moonscript

Mozhashpreproc mozhashpreproc

Mozpercentpreproc mozpercentpreproc

MQL mql, mq4, mq5, mql4, mql5

Mscgen mscgen, msc

MSDOS Session doscon

MuPAD mupad

MXML mxml

Myghty myghty

MySQL mysql

NASM nasm

Nemerle nemerle

nesC nesc

NewLisp newlisp

Newspeak newspeak

Nginx configuration nginx

Nimrod nimrod, nim

Nit nit

Nix nixos, nix

NSIS nsis, nsi, nsh

NumPy numpy

Objdump objdump
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Language Value for the language attribute

Objdump-nasm objdump-nasm

Objective-C objective-c, objectivec, obj-c, objc

Objective-C++ objective-c++, objectivec++, obj-c++, objc+
+

Objective-J objective-j, objectivej, obj-j, objj

OCaml ocaml

Octave octave

ODIN odin

Ooc ooc

Opa opa

OpenEdge ABL openedge, abl, progress

PacmanConf pacmanconf

Pan pan

Parasail parasail

Pawn pawn

Perl perl, pl

Perl6 perl6, pl6

PHP php, php3, php4, php5

Pig pig

Pike pike

PkgConfig pkgconfig

plpgsql PL/pgSQL

PostgreSQL postgresql, postgres
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Language Value for the language attribute

PostgreSQL console psql, postgresql-console, postgres-
console

PostScript postscript, postscr

POVRay pov

PowerShell powershell, posh, ps1, psm1

PowerShell Session ps1con

Praat praat

Prolog prolog

Properties properties, jproperties

Protocol Buffer protobuf, proto

Puppet puppet

Python 3 python3, py3

Python 3.0 Traceback py3tb

Python console session pycon

QBasic qbasic, basic

QML qml, qbs

QVTO qvto, qvt

Racket racket, rkt

Ragel ragel

Ragel - Embedded ragel-em

Ragel in C Host ragel-c

Ragel in CPP Host ragel-cpp

Ragel in D Host ragel-d
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Language Value for the language attribute

Ragel in Java Host ragel-java

Ragel in Objective C Host ragel-objc

Ragel in Ruby Host ragel-ruby, ragel-rb

Raw token data raw

RConsole rconsole, rout

Rd rd

REBOL rebol

Red red, red/system

Redcode redcode

Reg registry

ResourceBundle resource, resourcebundle

reStructuredText rst, rest, restructuredtext

Rexx rexx, arexx

RHTML rhtml, html+erb, html+ruby

Roboconf Graph roboconf-graph

Roboconf Instances roboconf-instances

RobotFramework robotframework

RPMSpec spec

RQL rql

RSL rsl

Ruby rb, ruby, duby

Ruby irb session rbcon, irb
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Language Value for the language attribute

Rust rust

S splus, s, r

Sass sass

Scala scala

Scalate Server Page ssp

Scaml scaml

Scheme scheme, scm

Scilab scilab

SCSS scss

Shen shen

Slim slim

Smali smali

Smalltalk smalltalk, squeak, st

Smarty smarty

Snobol snobol

SourcePawn sp

SPARQL sparql

SQL sql

sqlite3con sqlite3

SquidConf squidconf, squid.conf, squid

Stan stan

Standard ML sml
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Language Value for the language attribute

SuperCollider sc, supercollider

SWIG swig

systemverilog systemverilog, sv

TADS 3 tads3

TAP tap

Tcl tcl

Tcsh tcsh, csh

Tea tea

Termcap termcap

Terminfo terminfo

Terraform terraform, tf

TeX tex, latex

Text only text

Thrift thrift

Todotxt todotxt

TrafficScript rts, trafficscript

Treetop treetop

Turtle turtle

Twig twig

TypeScript ts, typescript

UrbiScript urbiscript

Vala vala, vapi
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Language Value for the language attribute

VB.net vb.net, vbnet

VCTreeStatus vctreestatus

Velocity velocity

Verilog, v verilog, v

VGL vgl

vhdl vhdl

VimL vim

X10 x10, xten

XML xml

XML+Cheetah xml+cheetah, xml+spitfire

XML+Django/Jinja xml+django, xml+jinja

XML+Evoque xml+evoque

XML+Lasso xml+lasso

XML+Mako xml+mako

XML+Myghty xml+myghty

XML+PHP xml+php

XML+Ruby xml+erb, xml+ruby

XML+Smarty xml+smarty

XML+Velocity xml+velocity

XSLT xslt

xsltXQuery xquery, xqy, xq, xql, xqm

Xtend xtend
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Language Value for the language attribute

XUL+mozpreproc xul+mozpreproc

YAML yaml

YAML+Jinja yaml+jinja, salt, sls

Zephir zephir

Embed Swagger OpenAPI
To use Swagger Open API content in Paligo, you can either embed it or import it. The best
approach for you will depend on your requirements.

• Embedding is useful if your Swagger Open API content exists elsewhere on the internet,
external to Paligo. By embedding it, you add a "live" version of the content to a Paligo topic.
However, there are some limitations with how you can format the content, as it is not in the
Paligo database and so cannot be processed by Paligo during publishing.

• Importing is useful if you need to be able to format the Swagger Open API content in Paligo.
With an import, you bring the Swagger Open API content into the Paligo database, where you
have more control over the formatting, just like regular Paligo content. But you will need to
import the content manually each time it is updated.

In this section, we explain how to embed Swagger/Open API content. To find out about importing,
see Import Swagger OpenAPI [1806]

To embed Swagger content in a topic and then publish to Zendesk:

1. In your HTML5 Help Center layout, enable the Swagger embed option, under "Analytics and
other integrations".

2. Select Layout in the top menu and either create a new HTML5 help center layout or edit an
existing HTML5 help center layout.

3. Edit the layout:

• Select Analytics and other integrations and then enable the Swagger embed option.

• Consider where the topic that will contain the embedded Swagger content is going to be
positioned in the publication structure (table of contents).
If the topic is going to be at the second-level or lower, select the General category of
settings and then enable the Use a short and flat URL structure for output files option.
If the topic is going to be at the top-level, do not enable the Use a short and flat URL
structure for output files option.

4. Select Save.

5. Create a Topic [131] that will contain the embedded Swagger content.

6. In the element structure menu, select the top section element and then select Go to
element. Then, in the Element attributes section, make sure the section element is selected
and add a role attribute with the value: swagger-topic.
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7. In the topic add a para element (or use an existing empty para element).

Press Alt  and Enter  (Windows) or Option ⌥  and Enter  (Mac) to display the Element

context menu. Then search for the element you want to add or select it from the list.

8. Inside the para element, add a link element.

Add a @role attribute to the link, with the value swagger-ui.

9. In the element structure menu, select the link element. Then add these attributes and values
in the Element attributes section:

• role and set its value to swagger-ui
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• xlink:href and set its value to the URL of the JSON or YAML file of your Swagger content.

TIP
If you don't have your Swagger content available yet, but want to test the
integration, you can use the standard Swagger "Pet Store" example, using
the URL https://petstore.swagger.io/v2/swagger.json.

10. Publish the publication, making sure to use the layout where you made the above settings.
The output should look something like this:

You should have a sub navigation menu on the left for each of the endpoints in your Swagger
content, and all of the interactivity of the Swagger content should work.
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NOTE
If you get an error saying "No API definition provided", this is not an error on
the Paligo side. It usually means that you have a "CORS" (cross-origin resource
sharing) issue, which is a security setting on your server.

You can test if this is the issue by bypassing CORS. There are CORS bypass
extensions that you can add to your browser for this purpose. Please note that
Paligo takes no responsibility for how you test CORS issues. If you are uncertain,
please consult your development team.

If your testing shows that CORS is causing a problem, ask your developers to
enable CORS on the server where you host your Swagger content.

eLearning
Abstract

Learn how to use Paligo to create single-source eLearning content that you can publish to a
Learning Management System.

With Paligo's eLearning support, you can author content in Paligo and publish it as an eLearning
package. You can then upload the package to your Learning Management System (LMS).

An LMS containing a course that was created in Paligo.

There are many benefits to this approach to creating and managing eLearning content:

• Your documentation and eLearning content is stored in one place as one "source of truth"

• Avoid unnecessary duplication with Paligo's content reuse features. There's no need for content
creators to make multiple versions of the same content for different outputs. Instead, you can
easily reuse your documentation content in your eLearning content.

• You can use Paligo's advanced authoring features with your eLearning content, such as
variables, profiling (filters), and branching.

• Paligo content is pure XML (Paligo XML) so is more future proof.

To create eLearning content in Paligo, you will need to set up:

• A publication to organize the topics (see Create a Publication for your eLearning [531])
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• Information topics to provide users with information ( see Add Information Topics for
eLearning [535]).

• Quiz topics to test users' knowledge (see Create a Quiz [536]).

• An eLearning layout to define the publishing settings (see Create an eLearning Layout [554]).

With these in place, you will be able to publish an eLearning output and then upload it to your
LMS.

eLearning Workflow
To create an eLearning course in Paligo that you can use in a Learning Management System (LMS):

1. Create a publication [531].
The publication acts as a "table of contents" for your eLearning course.

2. Create information topics [535] and add them to your eLearning publication.
You can create new topics and reuse topics that already exist in Paligo. When you edit your
topics, you can also reuse structures that already exist in Paligo, such as informal topics,
admonitions, and text fragments such as paragraphs.

3. Create quiz topics [536] and add them to your eLearning publication.
Your quiz topics can contain questions with a numerical answer or questions with multiple-
choice answers. There are several variations of multiple-choice questions, including trick
questions.

4. Organize your eLearning publication [553] so that the course topics and quizzes are in the
correct order.

5. Create an eLearning layout [554] and set your publishing preferences.

6. Publish your eLearning publication [563] using your eLearning layout.

7. Use CSS and JS to style your eLearning and modify its behavior, if required (see Elearning
Styling [556].)

8. Republish your eLearning publication with your custom CSS and JS in place.

9. Upload the eLearning output to your LMS [565].

Create a Publication for your eLearning
To set up an eLearning course in Paligo, we recommend that you start by creating a publication.
The publication acts like a "table of contents" for your eLearning topics and is where you will
choose which topics are included and what order they should appear in.

1. Create a publication for your eLearning. To do this, select the options menu ( ... ) for a folder in
the Content Manager and then select Create Content. On the create content dialog, choose
Publication.
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For details, see Create a Publication [96] .

2. In the Content Manager, select the options menu ( ... ) for the publication and then select Edit
> Open Structure.
Paligo opens the publication structure.

3. Select Save.

You now have an eLearning publication to contain your course. The next step is to add information
topics [535] and quiz topics [536] to it.

Set a Minimum Passing Score
The default minimum passing score in Paligo is set to 70 % correct answers, regardless if they are
distributed into multiple quizzes or a single quiz.

This can be adjusted in two different ways:

• Publication level lets each quiz publication have its own settings.

• Layout level will result in a general setting for all quizzes.

Override Passing Score on Publication Level
On the publication level it is possible to set a basic passing score or to profile [1141] it with
different minimum scores depending on for example user level, product or market. This can be set
when the publication is created or adjusted afterwards.
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TIP
By including questions for different user levels and profiling them, you will only
need one publication.

1. Select the Dotted Menu (...) for the publication in Content Manager [34].

2. Select Edit and choose Open in editor.

Paligo opens the publication topic.

3. Use the keyboard down arrow ⬇ to position the cursor at the bottom of the article.

4. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

5. Enter Remark and select it from the menu.
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6. Enter the minimum passing score in percentage, but exclude the percent sign.

7. Add the attribute Role in the Element Attributes Panel [55].

8. Add the value elearning.min.score.
This value collects the minimum passing score stated in the Remark element.

NOTE
The three following steps shows how to separate different passing scores
depending on user level.

Read more about profiling information, see Filtering / Profiling [1141].

9. Add the attribute userlevel and select a filtering to a specific group of questions (for
example Basic user).

10. Add an extra remark, below the first one, with a different minimum passing score.

11. Add the attribute userlevel and select a filtering to a different group of questions (for
example Advanced user).

12. Select Save. 
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Override Passing Score on Layout Level
If you want to have a general passing score, that overrides the Paligo default value, it must be
adjusted on a layout level. At this level there is no possibility to use profiling / filtering. Using this
method will also override any values set on the publication level.

To do this the following line must be added to your custom JavaScript file:

...
var minScore = 65;
...

Add Information Topics for eLearning
eLearning courses usually consist of a series of "information topics" followed by a quiz. The
information topics provide facts and explain concepts, and the quiz topics test the user's
knowledge.

Here, we are going to focus on the information topics. These are regular topics, and are no
different to the topics you might create for HTML help centers or PDFs. Each topic has a title and
you can add paragraphs, images, notes, and other types of content as needed.

Example of an information topic. It contains text and images.

For your information topics, you can create new topics and/or reuse topics that already exist. For
example, let's say you have an "Introduction to Acme 100" topic that was created for a PDF output.
Rather than duplicating the same content for your eLearning course, you can reuse the same
topic.

To create new topics for your eLearning:

1. Open your eLearning publication's structure.
Select the options menu ( ... ) for your publication and then select Edit > Open structure.

2. Select New topic.

Paligo Documentation

535



Paligo adds a new topic. It is added to the publication structure automatically and is also
added as a topic in the Content Manager.

3. Enter a name for the new topic.

4. Select Save.

NOTE
Alternatively, you could add a new topic in the Content Manger and then manually
drag and drop it into the publication structure. To learn more, see Create a
Topic [131].

To reuse topics that already exist in Paligo:

1. Open the structure of your eLearning publication.
To open the structure, select the publication's options menu ( ... ) and then select Edit > Open
Structure.

2. Find the topic that you want to reuse in the Content Manager. You can explore the folders
manually or use the search at the bottom to find topics by name.

3. Drag and drop the topic into the structure of the publication.

4. Select Save.

You can edit new and existing information topics in the same way as other Paligo topics. For
details, see Add Content to Topics [142] and Content Reuse [1098].

To learn how to add quiz topics to your eLearning publication, see Create a Quiz Topic [538].

Create a Quiz
Quizzes are a fun way to test your audience's knowledge at various stages of your eLearning
course. You can create your quizzes in Paligo and add questions with numerical answers and
multiple choice questions. When you upload your eLearning to a Learning Management System
(LMS), users will be able to take the quizzes and the LMS will track their progress and scores.
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Example of a multiple choice question with multiple correct answers.

To create a quiz:

1. Make sure that you understand what different types of quiz question [537] Paligo supports.
This will help when you plan your quiz questions.

2. Create a topic for the quiz [538]and add the structure for the quiz (qandaset element, which
automatically includes one qandaentry, one question, and one answer).

3. Add the structure for additional questions [540].

4. Add the answers to your questions, see:

• Set Up a Numerical Question/Answer [542]

• Set Up a Multiple Choice Question/Answer [542]

5. Save the quiz topic.

If you did not create the quiz topic from the publication structure, you will need to manually add
the topic to the publication (see Organize your eLearning Course [553]).

Question Types
Before you add a question to your quiz, consider what type of answer formats are available. Paligo
supports answers that require the user to:

• Enter a numerical value into a field

• Choose one answer from a list of potential answers

• Choose several answers from a list of potential answers.
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It is also possible to create a "trick" multiple choice question. This is where the question looks like
a multiple choice question with multiple correct answers, but there is only one correct answer. The
"trick" question has checkboxes.

To learn how to set up these types of questions and answers, see:

• Set Up a Numerical Question/Answer [542]

• Set Up a Multiple Choice Question/Answer [542].

Create a Quiz Topic
To create a quiz in Paligo, you need a topic to contain the quiz elements. When you create a topic,
you will need to give the topic's section element a role attribute with the value set to: quiz.
With those in place, you can then add a qandaset element to contain the quiz structure.

1. Create a new topic.

a. Open your eLearning publication's structure.
Select the options menu ( ... ) for your publication and then select Edit > Open structure.

b. Select New topic.

Paligo adds a new topic. It is added to the publication structure automatically and is also
added as a topic in the Content Manager.

c. Enter a name for the new topic.

d. Select Save.

NOTE
Alternatively, you could add a new topic in the Content Manger and then
manually drag and drop it into the publication structure. To learn more, see
Create a Topic [131].

2. Open the topic in the editor and select the section element in the Element Structure Menu.
Then select the Go to element option.
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3. In the Element attributes panel, give the section element the role attribute. Set the value
to:
quiz

4. In the topic, use the element context menu to insert a qandaset element.

To access the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

The qandaset element is a container for all of the questions and answers you include in your
quiz. When you add a qandaset, Paligo automatically adds some extra structure for the first
question and one potential answer.

The structure consists of:

• qandaentry

Each question has to be inside its own qandaentry element. For example, if you have a
quiz with 5 questions, the quiz is represented by the qandaset element and inside that you
will have 5 qandaentry elements (1 for each question).

• question and para and/or other content structures
The question element represents a question in the quiz and it has to be inside a
qandaentry element.
The para inside the question is where you enter the text for the question.

• answer and para and/or other content structures
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The answer element represents a possible answer to the question. It has to be inside the
same qandaentry element as the question.
The para inside the answer is where you enter the text for the answer.

TIP
You can add extra para elements inside a question or answer to create
multi-paragraph questions and answers. Add any extra para elements after
the previous para element, inside the question or answer.

If you have multiple para elements, the first one will be styled like a heading
in the output. The other para elements will be styled as regular text.

You can also insert other content structures inside a question or answer,
such as mediaobject for an image and programlisting for code.

In the XML tree view, the structure looks like this:

You now have the basic structure for a quiz, with one question and a single answer. This
will be a numerical question and answer unless you add additional answers to turn it into a
multiple-choice question/answer.
To learn about setting up different types of questions and answers, see:

• Set Up a Numerical Question/Answer [542]

• Set Up a Multiple Choice Question/Answer [542]
To learn how to add more questions, see Add More Questions to a Quiz [540].

TIP
We have included an example of a complete quiz topic [550] that contains
multiple questions and answers. You can use this example to see how the
question and answers need to be structured in your quiz topic.

Add More Questions to a Quiz
To add more questions to a quiz topic:

1. Make sure your topic contains the structure for a quiz (as described in Create a Quiz
Topic [538]).

2. Position the cursor so that it is after the previous qandaentry element but inside the
qandaset element. Then use the element context menu to add another qandaentry
element.
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To access the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

NOTE
If you cannot find the qandaentry element in the element context menu, it
is because the cursor is in an incorrect position. Try repositioning the cursor
so that the selection point is after the previous qandaentry element but still
inside the qandaset element.

When the cursor is in the correct position, the Element Structure Menu shows
section > qandaset. You will then be able to add qandaentry from the
element context menu.

You have now added the structure for an additional question. By default, the structure
contains one answer element. You can add more answer elements to turn it into a multiple-
choice question. Alternatively, you can use a single answer for a numerical question.
To learn how to set up the answers, see:
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• Set Up a Numerical Question/Answer [542]

• Set Up a Multiple Choice Question/Answer [542].

3. Repeat step 2 for as many questions as you need.

4. Select Save.

Set Up a Numerical Question/Answer
Numerical question/answers are quiz questions that require the user to enter a number for the
answer. There is a question in text and below it, a field for entering the answer.

To set up a numerical answer for a quiz:

1. Make sure your topic has the qandaset structure that is needed for a quiz (see Create a Quiz
Topic [538]). You also need to add the question structure for your numerical question (see
Add More Questions to a Quiz [540]).

2. Enter the body text of the question inside the para that is inside the question element.

3. Enter the correct answer (a number) inside the para element that is inside the answer
element.

4. Select Save.

When you publish your eLearning, Paligo will detect that this is a numerical answer and make it a
question with a text-entry field in the output.

Set Up a Multiple Choice Question/Answer
There are three types of multiple choice question that you can create:
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• A multiple choice question with one correct answer. The user is presented with a list of options
and each one has a radio button.

• A multiple choice question with more than one correct answer. The user is presented with a list
of options and each one has a check box.

• A trick multiple choice question. It presents the user with a list of options that have check boxes
so it appears as if there are multiple correct answers. But there is only one correct answer.

The following instructions explain how to create all three types:

1. Make sure your topic has the qandaset structure that is needed for a quiz (see Create a Quiz
Topic [538]). You also need to add the question structure for your numerical question (see
Add More Questions to a Quiz [540]).

2. Enter the body text of the question inside the para that is inside the question element.
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3. Enter the text for a possible answer inside the para element that is inside the answer
element.

4. Position the cursor after the previous answer element but still inside the qandaentry
element.

5. Use the element context menu to add an answer element.
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NOTE
If the answer element is not available in the list, then the cursor is in
an incorrect position. Check that it is after the question but inside the
qandaentry element. The correct structure should look like this in the XML
tree:

6. Enter the text for a possible answer in the para inside the answer element that you have
added.
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TIP
You can add extra para elements inside a question or answer to create
multi-paragraph questions and answers. Add any extra para elements after
the previous para element, inside the question or answer.

If you have multiple para elements, the first one will be styled like a heading
in the output. The other para elements will be styled as regular text.

You can also insert other content structures inside a question or answer,
such as mediaobject for an image and programlisting for code.

7. Repeat steps 6 and 7 to add more possible answers, including the correct answer(s). The
completed structure should look something like this in the XML tree:

Notice how the question and the potential answers are all inside the qandaentry element.
Each question should have its own qandaentry element, with the question and potential
answers inside it.

8. Select a correct answer in the editor and then select its answer element in the Element
Structure Menu at the top. Select Go to element from the menu.
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9. In the Element attributes side panel, give the answer element the role attribute. Set the
value of the role attribute to:

correct

When you set an answer to correct, a green box and check mark appear for that answer in the
Paligo editor.
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10. If a question has multiple correct answers, repeat steps 8 and 9 for each correct answer.

11. This step only applies if you want to make your multiple choice question a "trick" question. A
trick question is where it looks like there is more than one correct answer but actually only
one answer is correct.
To turn a multiple choice question into a trick question:

a. Select the question element for the trick question.

b. Use the Element attributes side panel to give the question element the role attribute. Set
the value of the role attribute to:

multi-choice

12. Select Save.

When you publish your eLearning, Paligo uses the role attributes to determine what type of
multiple-choice questions you have added. It then creates those in the published output.

Remove a Question from a Quiz
To remove a question and its answers from a quiz:

1. Open the quiz topic in the editor.

2. Select the question that you want to remove.

3. In the Element Structure Menu, select the qandaentry element and then select Delete.
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Paligo removes the structure for the question and its answers (qandaentry, question and
para, and each answer and para pair).

4. Select Save.

Remove an Answer from a Quiz
To remove an answer from a question in a quiz:

1. Open the quiz topic in the editor.

2. Select the answer that you want to remove.

3. In the Element Structure Menu, select the answer element and then select Delete.
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4. Select Save.

Example Quiz Topic
This example shows the underlying structure of a Paligo quiz topic called "Quiz - Creating Content
in Paligo". It contains multiple choice questions with single correct answers, multiple choice
questions with several correct answers, a trick multiple choice question, and a numerical question
too.

By looking at the code, you can see the valid structure for the quiz and the various question types.
If you have problems setting up your own quiz, referring to this example may help you spot any
structural problems.

NOTE
We have removed the database IDs to make the code simpler, but in your topics
the IDs will be included in the code, for example, xinfo:text="1169436".

Example 35. Quiz structure

The following source code shows the structure for a valid quiz.

<?xml version="1.0"?>
<section xmlns="http://docbook.org/ns/docbook" xmlns:xinfo="http://
ns.expertinfo.se/cms/xmlns/1.0" version="5.0" \
xinfo:resource="UUID-9921a762-7cd2-093a-3583-c1f8206fcf0d" xinfo:resource-
id="1169399" xinfo:resource-type="component" xinfo:resource-title="Quiz -
 Creating Content in Paligo copy 1" xinfo:resource-titlelabel="" \
xinfo:version-major="1" xinfo:version-minor="0" role="quiz" \
xml:id="UUID-9921a762-7cd2-093a-3583-c1f8206fcf0d" xml:lang="en">
  <title>Quiz - Creating Content in Paligo</title>
  <qandaset>
    <qandaentry>
      <question>
        <para>When you check out a topic in Paligo, can another Author \
edit that topic at the same time?</para>
      </question>
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      <answer>
        <para>Yes, Paligo supports simultaneous editing by multiple \
authors.</para>
      </answer>
      <answer role="correct">
        <para>No, the topic is locked for editing by others when it is \
checked out.</para>
      </answer>
    </qandaentry>
    <qandaentry>
      <question>
        <para>What is an informal topic?</para>
      </question>
      <answer>
        <para>A selection of content or images that must have a title</para>
      </answer>
      <answer role="correct">
        <para>A selection of content or images that do not need a title</
para>
      </answer>
      <answer>
        <para>A special type of admonition that the user can select to \
ignore</para>
      </answer>
    </qandaentry>
    <qandaentry>
      <question>
        <para>What is a fork?</para>
      </question>
      <answer>
        <para>A container where you organize your topics into a table of \
contents</para>
      </answer>
      <answer role="correct">
        <para>A reference to a source topic, reused in a publication</para>
      </answer>
      <answer>
        <para>A building block for a section of content</para>
      </answer>
    </qandaentry>
    <qandaentry>
      <question>
        <para>What interface is shown when you open a publication?</para>
      </question>
      <answer>
        <para>The Editor View</para>
      </answer>
      <answer role="correct">
        <para>The Structure View</para>
      </answer>
    </qandaentry>
    <qandaentry>
      <question>
        <para>To open a topic and work on it, which interface would you use?
</para>
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      </question>
      <answer role="correct">
        <para>The Editor View</para>
      </answer>
      <answer>
        <para>The Structure View</para>
      </answer>
    </qandaentry>
    <qandaentry>
      <question role="multi-choice">
        <para>What is a topic?</para>
      </question>
      <answer>
        <para>A container where you organize your topics into a table of \
contents</para>
      </answer>
      <answer>
        <para>A reference to a source topic, reused in a publication</para>
      </answer>
      <answer role="correct">
        <para>A building block for a section of content</para>
      </answer>
    </qandaentry>
    <qandaentry>
      <question>
        <para>Which of the following statements are true?</para>
        <para>Topic-based authoring ...</para>
      </question>
      <answer>
        <para>... is similar to document writing and formatting in \
Microsoft Word</para>
      </answer>
      <answer role="correct">
        <para>... encourages breaking down documents into smaller pieces \
of content</para>
      </answer>
      <answer role="correct">
        <para>... makes it possible to reuse content as building blocks in \
multiple publications</para>
      </answer>
      <answer role="correct">
        <para>... enables you to update content in one place, and the \
update applies wherever the content is used</para>
      </answer>
      <answer>
        <para>... does NOT encourage the reuse of content</para>
      </answer>
    </qandaentry>
    <qandaentry>
      <question>
        <para>What is the correct order (from largest to smallest, left to \
right) of the following Paligo structures?</para>
      </question>
      <answer>
        <para>Topic, Publication, Element, Section</para>
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      </answer>
      <answer>
        <para>Section, Publication, Element, Topic</para>
      </answer>
      <answer role="correct">
        <para>Publication, Topic, Section, Element</para>
      </answer>
      <answer>
        <para>Publication, Section, Topic, Element</para>
      </answer>
    </qandaentry>
    <qandaentry>
      <question>
        <para>How many floating content panels can you have open at once?</
para>
      </question>
      <answer>
        <para>4</para>
      </answer>
    </qandaentry>
  </qandaset>
</section>

Notice that:

• The entire quiz is inside one qandaset element

• Each question is inside a qandaentry element

• Each question has a question element with a para element for its text

• Each answer is in an answer element with a para element for its text

• role="correct" is added to the answer element for each correct answer. Paligo does this
automatically when you give an answer element the role attribute and set its value to correct.

• role="multi-choice" is added to the question element for a trick question. This tells Paligo
to make this multiple choice question look like it has several correct answers (it presents the
options as check boxes) but it actually only has one correct answer. Paligo applies this code
when you give a question element the role attribute and set its value to multi-choice.

• The answer element for a numerical question contains the answer in the para element. Paligo
detects that this is a numerical question/answer automatically. When you publish, the question
will have a text box for the user to enter a number. They will not see the correct answer.

Organize your eLearning Course
When you have added your information topics [535] and quiz topics [538] to your publication, you
can organize them to create the flow of your course. Typically, eLearning courses consist of several
information topics followed by a quiz.

To organize your eLearning course:

1. Open your eLearning publication's structure.
To open the structure, select the publication's options menu ( ... ) and then select Edit > Open
Structure.

2. In the structure, select a topic and drag-and-drop it into a new position.
Alternatively, select a topic and use the directional arrows to move the topic in the structure.
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3. To add other topics to your publication, find the topics in the Content Manager. Then drag-
and-drop the topics from the Content Manager into the publication structure.

4. To remove a topic from the publication, select the topic and then select the cross icon X.

5. Use the arrow buttons to arrange your topics and reused publications into the order you
want. You can set them to display as a flat structure or you can "nest" topics and publications
so they have a more complex structure, with multiple levels of content. To learn more, see
Organize a Publication [100].

When you have finished organizing your eLearning course, and it contains all of the content you
need, you can publish it [563].

Create an eLearning Layout
To publish content that you can import into a learning management system (LMS), you need to use
an eLearning layout. The layout contains "publishing settings" that Paligo applies to your content
when it builds your eLearning content.

Paligo has a built-in eLearning layout that you can use, but we recommend that you create your
own layout. You can then make changes to the layout settings and use it as the basis for other
layouts too.

To create an eLearning layout, follow the steps in Create a Layout [1059] and make sure to select
the appropriate eLearning option. Currently, there is an eLearning option for SCORM, but other
eLearning standards may be supported in future releases.
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When you have created an eLearning layout, you can use its settings to:

• Add a Logo [557]

• Set a Logo to Link to a Web Page [558]

• Upload Custom CSS to an Elearning Layout [558]

• Set Paligo to Keep the Same CSS Filename [559]

• Upload Custom JavaScript to an Elearning Layout [560].

When you have set your layout preferences, you can use the layout to publish an output that you
can upload to your LMS [563].

eLearning Layout Options
eLearning layouts have a single category:

• CSS, JS, logos, and other assets

This category contains the following settings:

Category Description

Logotype Add your logotype to replace the Paligo logo in the output. Use CSS to style it.

Logo link Use to set the logo in the top corner of the eLearning output to act as a hyperlink. When a user selects
the logo, the browser will display the webpage that you define here.

Enter the URL of the web page that will be the target of the hyperlink, for example, the URL of your
company's webpage.

Leave this field empty if you do not want the logo to act as a hyperlink.
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Category Description

CSS Upload your own CSS to modify the default layout.

Persistent
custom CSS
filename

By default, your custom CSS file will get a unique name, everytime you upload a new update. The unique
name is generated when you publish.

To keep the same CSS file name and prevent it from changing, set Persistent custom CSS filename to
Enabled. The CSS file name will then be set to 'layout-custom-style.css' and it will not change.

Default: disabled.

Custom
javascript

You can upload your own javascript to add functionality to your eLearning output.

Elearning Styling
To change the styling of the eLearning content that Paligo creates, use a third-party code editor to
create your own custom CSS and JavaScript (JS) files. You can then upload these to an eLearning
layout in Paligo. When you publish with that layout, the CSS and JS are included in the output and
apply to the HTML files.

To create your custom CSS and/or JS file(s) and add them to your Paligo publication, we
recommend that you:

1. Publish your eLearning content in Paligo, using the default eLearning layout (see Publish
eLearning Content [563]).

2. Unzip the output and open its index.html file in a browser.

3. Use the browser's inspect features to view the existing HTML and test any changes you want
to make to the CSS and JS.

4. When you have the changes you want, use a third-party tool, such as BBEdit, to create a
custom CSS and/or JS file.

5. In Paligo, create a new eLearning layout or edit an existing one (see Create an eLearning
Layout [554]).

6. Use the settings on the eLearning layout to:

• Add a Logo [557]

• Set a Logo to Link to a Web Page [558]

• Upload Custom CSS to an Elearning Layout [558]

• Set Paligo to Keep the Same CSS Filename [559]

• Upload Custom JavaScript to an Elearning Layout [560]

7. Publish your eLearning content again, this time using the layout that has your custom CSS/JS.

8. Upload the output to your Learning Management System.

We recommend that you begin by publishing your eLearning content with the default eLearning
layout. Then
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TIP
To learn more about using the browser's inspect tool, see Branding your HTML
Outputs with CSS [654]. The article is written with HTML5 help center outputs in
mind, but it also applies to the eLearning output.

Add a Logo
By default, the eLearning output includes the Paligo logo in the top corner, above the table of
contents. To replace it, you can upload your own logo image to your eLearning layout. When you
publish that layout, the output will use your custom logo instead.

Elearning output with custom logo in place.

To add a custom logo:

1. Select Layout and then edit the layout that you are going to use for publishing.

2. In the Layout Editor, select CSS, JS, logos and other assets.

3. Use the Logotype field to upload a logo image. You can upload an image in any of these
formats: ai, svg, pdf, png, tif, gif.

4. Select Save.

When you publish using this layout, Paligo will generate an eLearning layout that uses your
uploaded image as the logo.

NOTE
You can set up the logo to act as a hyperlink to another web page such as
your company homepage. To find out more, see Set a Logo to Link to a Web
Page [558].
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Set a Logo to Link to a Web Page
If you have added a custom logo, you can set it to work as a hyperlink in the published eLearning.
When a user selects the logo, the browser will navigate to the web page of your choice, such as the
home page for your organization. The linked web page will always open in a new tab or window.

To set up a logo so that it acts as a hyperlink and links to a particular web page:

1. Select Layout and then edit the layout that you are going to use for publishing.

2. In the Layout Editor, select CSS, JS, logos and other assets.

3. Enter the URL for the target web page in the Logo Link field. For example, http://paligo.net.

NOTE
If you clear the field, the logo will not act as a hyperlink.

4. Select Save.

Upload Custom CSS to an Elearning Layout
You can use a third-party text or code editor to create a custom CSS file that alters your eLearning
output. For example, you could use CSS to change the appearance of headings and the font styles
used by regular text. You can then upload your CSS file to Paligo so that when you publish your
content, the CSS is included (and referenced).

TIP
To create a custom CSS, we recommend that you publish an output with the
default settings in place. Then open that content in a browser and use the
browser's inspection tools to view the existing styles and experiment with new
ones. When you have worked out what styles you want to use, use a code editor
to write the CSS and then upload that file to Paligo and re-publish your content.

This is the same approach we recommend for HTML5 outputs. You can find out
more about accessing the browser's inspect features in Branding your HTML
Outputs with CSS [654].

To upload a custom CSS file to a Paligo layout:

1. Make sure your custom CSS file is valid and has the .css file extension. There are many online
tools for validating JavaScript, such as https://beautifytools.com/css-validator.php.

2. Select Layout and then edit the layout that you are going to use for publishing.

3. In the Layout Editor, select CSS, JS, logos and other assets.

4. In the CSS section, select Upload to display a file upload dialog.
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5. Drag your custom CSS file from your computer's file system onto the file upload dialog.
Paligo uploads the CSS file to the Paligo server.

NOTE
You should only upload validated CSS files that have the .css file extension.

6. Select Save.

When you publish with this layout, Paligo will include your custom CSS in the output. When your
content is opened in a browser, the browser will use your custom styles in preference to any styles
that are included in the default Paligo CSS.

Set Paligo to Keep the Same CSS Filename
If you upload a CSS file to your eLearning layout, Paligo gives it a unique ID. This happens each
time you upload a CSS file. For example, let's say you upload a file and Paligo gives it a unique
ID. You then decide you need to make more changes, so you update the file outside Paligo and
upload it again. This second upload is given a completely different ID to the first upload, and so,
when you publish, the CSS file will have a different name. If you prefer, you can set Paligo to use a
consistent file name (layout-custom-style.css) so that the CSS file name does not change.

To set Paligo to keep using the same CSS file name:

1. Select Layout and then edit the layout that you are going to use for publishing.

2. In the Layout Editor, select CSS, JS, logos and other assets.

3. Set Persistent custom CSS filename to:

• Enable
Sets Paligo to keep the same file name for the CSS file. Paligo uses this file name:

layout-custom-style.css

• Disable

Paligo Documentation

559



Sets Paligo to generate a new ID and file name each time you add a CSS file to the layout. If
you select Disable, the CSS file in the output will have a randomly generated file name. The
file name will change each time you replace the CSS file in the layout.

4. Select Save.

When you publish, Paligo will apply the setting you have chosen. If there is a custom CSS file in
your output, it will be called 'layout-custom-style.css' if you chose Enable or it will have a random
file name if you chose Disable.

Upload Custom JavaScript to an Elearning Layout
You can use a third-party text or code editor to create a custom JavaScript file that alters your
eLearning output. For example, you could use JavaScript to manipulate the published HTML or to
provide extra functionality. You can then upload your JavaScript file to Paligo so that when you
publish your content, the JavaScript is included (and referenced).

To upload a custom JavaScript file to a Paligo layout:

1. Make sure your custom JavaScript file is valid and has the .js file extension. There are
many online tools for validating JavaScript, such as https://beautifytools.com/javascript-
validator.php.

2. Select Layout and then edit the layout that you are going to use for publishing.

3. In the Layout Editor, select CSS, JS, logos and other assets.

4. In the Custom JavaScript section, select Upload to display a file upload dialog.

5. Drag your custom JavaScript file from your computer's file system onto the file upload dialog.
Paligo uploads the JavaScript file to the Paligo server.

Paligo Documentation

560

https://beautifytools.com/javascript-validator.php
https://beautifytools.com/javascript-validator.php


NOTE
You should only upload validated JavaScript files that have the .js file
extension.

6. Select Save.

When you use this layout to publish your eLearning, Paligo will include your JavaScript file in the
published package and set the HTML pages to reference it. Note that in the published output, your
JavaScript is renamed to:

layout-custom-script.js

Style the Progress Indicator
If a quiz renders the questions one by one, a progress indicator is shown in the upper left corner
of the slide. By default the progress indicator is shown in a language neutral way (1 / 3).

This instruction shows how to override the default setting with a textual content (Question 1 of 3)
for English and Swedish. You can add more or other language variants to the CSS, if using other
languages than Swedish and English.

1. Add the follwing code to the CSS:

html[lang='en'] #quiz .quiz-progress .progress-current:before {
    content : 'Question ';
}

html[lang='en'] #quiz .quiz-progress .progress-divider:before {
    content: ' of ';
}

html[lang='en'] #quiz .quiz-progress .progress-max:after {
    content: ' : ';
}

html[lang='sv'] #quiz .quiz-progress .progress-current:before {
    content : 'Fråga ';
}

html[lang='sv'] #quiz .quiz-progress .progress-divider:before {
    content: ' av ';
}

html[lang='sv'] #quiz .quiz-progress .progress-max:after {
    content: ' : ';
}
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2. This will update the progress bar to show:

• English: "Question 1 of 3"

• Swedish: "Fråga 1 av 3"

Always Show Progress Indicator
By default only quizzes that renders the questions one by one, shows a progress indicator. To
override the default setting and get a progress indicator in all types of quizzes, add this code to the
CSS:

#quiz.show-all .quiz-progress {
    display: block;
}

Style the Question Rendering
The default layout setting for quizzes in Paligo, is to show the questions one by one. It is also
possible to show them all at once. This can be styled in the eLearning layout configuration.

TIP
You can override the default setting (or a LE configured setting) for an individual
quiz topic, by adding the role quiz-show-all or quiz-show-single to the
qandaset element.

1. Select the Layout tab from the top menu.

2. Select the Elearning configuration to be updated.

3. Select Quizzes in the left menu.
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4. Select One by one or All from the menu.

5. Select Save.

Publish eLearning Content
When your eLearning content is ready for release, you can publish it. Paligo will then generate an
eLearning output that downloads as a zip file in your browser. You can then upload that zip file to
your Learning Management System (LMS).

Example of a Paligo eLearning course in an LMS.

There are two stages to complete:

1. Publish using an Elearning Layout [563].

2. Upload your Elearning Output to your LMS [565].

Publish using an Elearning Layout
Paligo includes an eLearning layout that you can use for publishing. The layout contains a variety
of settings that affect how Paligo processes your content when it converts it from Paligo XML into
the eLearning output.

You can also create your own eLearning layouts [554].

To publish eLearning:

1. Prepare your content in Paligo, making sure you add your topics to a publication.
For details, see:

• Create a Publication for your eLearning [531]

• Add Information Topics for eLearning [535]

• Create a Quiz Topic [538]

• Organize your eLearning Course [553].

2. Edit the MS Word layout.
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3. Select Elearning.

4. Select the Elearning layout you want to use for publishing. This can be the default Elearning
layout or a custom Elearning layout that you have created in Paligo.

5. Set the:

• Languages
Choose which languages to publish to SCORM. Paligo will create a separate zip file output
for each language.

• Profiling attributes
If you have used profiling (filters), choose which filters and values to include in the output.

• Variables
If you have used variables in your content, choose which variable set to use and which
variants (values) to include in the output.

• Upload output
If you have Paligo set up to use a publishing integration, choose the service that Paligo will
upload the output to, for example, GitHub.

• Optional parameters
Use to choose whether Paligo saves the output, includes a log file and link report, and
notifies you via email.

For more details on these settings, see Publishing Process [1068].
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TIP
You can also save your publishing settings [1076] so that you can select the
saved version instead of re-applying all the filters, variables, etc., each time.
Any settings you save can also be used for Batch Publishing [1073].

6. Select Publish Document to start publishing. Paligo will then process your content and apply
your layout and publishing settings. The time that this takes can vary depending on how much
content you are publishing (the more content there is, the longer it takes).
When the publishing process is finished, Paligo creates a zip file that downloads in your
browser.

NOTE
There is a separate zip file for each language.

The next step is to upload the output to your LMS [565].

TIP
You can open the Paligo output in a browser to get an idea of how your eLearning
content will work in a Learning Management System (LMS). Unzip the file and
browse to the index.html file (for example, if you have an English SCORM output,
look in the out>scorm-en folder). Open the index.html file in a browser. You will
be able to preview your content, including any quizzes, but your score is not
recorded like it would be if you ran the course in an LMS.

Upload your Elearning Output to your LMS
The zip file that Paligo produces for eLearning outputs is designed to be uploaded to a
learning management system (LMS). There are many different LMS applications available and the
procedure for uploading course content to them can vary. We recommend that you refer to the
documentation for your LMS for details on how to upload courses.

If you are unable to find suitable information and need further assistance, please contact Paligo
customer support.

API Documentation Layout
Paligo has an API-style output that is designed especially for developer documentation. It provides
a modern, appealing API documentation output, that includes navigation, your content and code
examples that are tabbed by language in a sidebar on the right.
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TIP
Learn more, see Paligo REST API [1471] and Paligo API.

How to use the API style output
To use the API-style output, you need to markup your content with certain elements, such as
programlisting and code. You also need to publish to HTML5 and use an HTML5 API Style
layout.

Programlisting and example elements on the top level (directly under the root section
element) are automatically placed in the sidebar to the right and synced to the text in the main
body.

TIP
As code samples and example elements are placed next to each section, it works
best when the examples are not too long, and with separate sections or topics for
each main example.

1. For code elements (programlisting and code) there is the built-in DocBook attribute
@language. Use that to set which programming language the code is for.

2. For any other elements, there is a specialized Paligo attribute called xinfo:proglang. You
can use that on any element for filtering content, with the exception of table rows. You can
also use it for switching example and informalexample elements in the sidebar.

3. If you need to exclude a specific example from the sidebar and show it inline in the body
content, you can do so either by:

a. Putting it anywhere, but on the first level under section
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b. Adding the @role attribute on an example or informalexample, and set it to "inline-
example". For this to work, you also need to enable outputting @role attribute as class
names in your HTML5 layout in the Layout Editor.

4. If you have one programming language in your examples, the code switcher navigation bar
will automatically be hidden.

5. Disable the code switcher if you want to display all language options.
Even if you have multiple languages in your examples, you may want to disable the code
switcher and show all examples for all content.
This could be the case if what you are documenting is not an API with multiple versions
for different languages, but developer or other software documentation where different
programming languages are used for different features and all should be shown. This can
be done by setting the parameter Use code switcher for API style output to 0 (disabled) in the
Layout Editor under "Verbatim (code elements)".

NOTE
If you have more language options than the HTML5 Single page API style sidebar can
fit, a dropdown menu is displayed with the languages not shown.

When a language is selected from the dropdown menu, the selected language is
shown as a label above the dropdown menu.

TIP
If you do not have your own API content, but want to experiment with the API
layout, you can use Swagger / Open API content from:

https://petstore.swagger.io/v2/swagger.json

Put the Swagger/Open API content in a folder on your computer and then zip it.
Then import the zip file into Paligo using the import Open API feature [1806].

Alternatively, you can import this sample project that we have made:

https://paligo.zendesk.com/hc/en-us/articles/360007352034-Download-API-
Sample-Content.

You will need to Import the sample project [1771] as a Paligo export file.
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Working with the Element Context Menu
The element context menu is one of the features of the Paligo editor. It is a pop-up menu that you
can access when you are creating or editing a topic and it provides access to the various Paligo
XML elements that you can use.

Display the Element Context Menu
To display the element context menu:

1. Edit a topic and select the position where you want to add the new element.

2. Use a keyboard shortcut to display the element context menu:

• Press Alt  and Enter  (Windows)

• Press Option ⌥  and Enter  (Mac).

Paligo displays the element context menu. It contains a list of the elements that are valid at the
current position.

By default, the element context menu has two sections: a section that contains commonly used
elements and a section that contains all of the other valid elements. It also has a search feature at
the top, so that you can search for an element by name.

You can mark elements as your favorites and these are shown in a "favorites" section. The
"favorites" section is only shown if you have set up your favorites (see Mark Elements as Favorites
for the Element Structure Menu [568]).

Mark Elements as Favorites for the Element Structure Menu
If you use certain elements a lot, you can add them as favorites and make them easier to access
on the element structure menu. Any element that you mark as a favorite is shown with a black
star next to its name, in a section at the top of the element context menu. It appears above the
"commonly used elements" section and the section for all of the other elements.
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To mark elements as your favorites:

1. Edit a topic and position the cursor at the position where your favorite element could appear.

2. Display the Element Context Menu [568].

To access the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

3. Find the element of interest and position the cursor over it to reveal a star icon. Select the star
icon to change its status:

• Set the star to black to add the element to your favorites

• Set the star to clear to remove the element from your favorites.

4. Close the element context menu.

5. Display the element context menu again and the favorites section updates with your choices.
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NOTE
The favorites section can only contain elements that are valid at the position you
have selected. You can set up different favorites for different positions in the
structure. See the example [570] for details.

Example 36. Different favorites for different structures

Let's say that you are going to use the guilabel element for UI names in your content. As you will
be using it a lot, you want to add it to your element context menu favorites. To do that:

1. Position the cursor inside a para element or any other element where guilabel is valid.

2. Display the element context menu.

3. Search for guilabel.
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4. Position the cursor on the guilabel option to display its favorites star.

5. Select the star so that it goes black.

6. Close the element context menu and re-open it. Now the guilabel is shown at the top, in
your favorites.
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You continue to work on your content. Every time you need to use the guilabel, you position the
cursor in a valid position, access the element context menu, and select the guilabel from your
favorites.

You then select a position between two paragraphs.

You access the element context menu and guilabel is not shown in your favorites. This is
because guilabel is not valid at the selected position.

You decide to add the itemizedlist element as a favorite. The itemizedlist element is valid
at the selected position. You access the element context menu, search for itemizedlist and set
its favorite star to black.

You then close and reopen the element context menu. It now shows the itemized list element
in your favorites, as it is valid at the selected position.
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You select a word inside a para element and display the element context menu. The guilabel is
shown in your favorites, as it is valid at the selected position. The itemizedlist favorite is not
shown as it is not valid at the selected position.

Why is Element Missing from Element Context Menu?
The element context menu only shows elements that are valid at the currently selected position in
the topic structure.

If the element you want is not included in the element context menu, make sure that you are
selecting a valid position for that element. Typically, some elements are valid inside a structure,
such as inside a paragraph or list, and others have to be a the top level, directly inside the section
for the topic.

This also applies for any favorites you have set up. Paligo can show different favorites for different
parts of a topic's structure. For details, see the example in Mark Elements as Favorites for the
Element Structure Menu [568].

Spellchecker
Paligo has a built-in spellchecker that highlights any spelling errors that it finds in your content.
It checks the spellings based on language and also any terms that are stored in the spellchecker
dictionary.

For example, if you have the spellchecker language set to English (United States) but have content
written in British English, then words like colour will be highlighted as incorrect spellings.

You can choose to work with the spellchecker on or off [574], and you can also choose the
language that you want the spellchecker to use [574].

In technical communication, there are often words that a spellchecker may highlight as incorrect,
but they are actually correct. For example, brand names, obscure technical terms, terms for new
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technology, etc. To stop the spellchecker from highlighting these terms, you can add them to the
spellchecker dictionary [575].

Turn the Spellchecker On or Off
To turn the spellchecker on or off, use the ABC slider that is shown at the top of the Paligo editor:

When the slider is to the right and shows a green background, the spellchecker is on. When it is to
the left and shows a white background, the spellchecker is off.

Change the Language for the Spellchecker
You can change the language that the spellchecker uses:

1. Select the arrow icon next to the spellcheck slider to display a menu.

2. Select Spell-checker settings to display a language selection dialog.

3. Choose a language and select Save to confirm.
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Add Terms to the Spellchecker Dictionary
The spellchecker will check your content for the spelling of standard words. But in technical
communication, you will often need to use specialist words, such as technical terms, product
names, and words that are specific to your industry. If you want the spellchecker to stop
highlighting such words as incorrect spellings, you can add the terms to the spelling dictionary.
Once the terms are in there, the spellchecker will ignore them in your content (unless you spell
them incorrectly, in which case, the spellchecker will not recognize them).

You can also edit any terms that have previously been added to the dictionary.

1. Select the arrow icon next to the spellcheck slider to display a menu.

2. Select Dictionary to display the spelling dictionary.
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3. Make your changes to the dictionary: To edit an existing term, Use the search field to search
for the term you want to edit.

• To add a term, enter it in the text field at the bottom and then select Add.

• To edit a term, use the search to find it or scroll down the list of existing terms. Then select
its edit icon (pencil) and enter your changes in the dialog.

• To remove a term, use the search to find it or scroll down the list of existing terms. Then
select its delete icon (cross) and confirm the deletion.

Keyboard Shortcuts
Paligo has many keyboard shortcuts, to make working with structured content as fast and efficient
as possible. The action of a key combination depends on the context, as described below. Almost
all of the Toolbar commands can be activated with shortcuts.

TIP
Also check out this video for using keyboard shortcuts and working with lists
easily:

https://www.youtube.com/embed/olBkmjgb72Y

NOTE
It's possible to have browser plug-ins that clash with the keyboard shortcuts that
Paligo uses. If a keyboard shortcut doesn't work, try to remove or disable the
browser plug-ins. Alternatively, try to use a different browser without plugins.

Toolbar icon Action Mac Windows Description

Edit tab

Insert a new para
element

Option ⌥  + P Alt  + P Where para is
available to select.
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Toolbar icon Action Mac Windows Description

N/A New para, new
step, etc.

Enter  ⏎ Enter  ⏎ At the end of
a paragraph, a
procedure step, or a
list item, creates a
new element of the
same kind.

For example if
the cursor is at
the end of a
paragraph element,
Enter creates a new
paragraph, but in
a list item or step
it creates new list
items or steps. You
can also split the
text in a paragraph
or list by placing the
cursor in the middle
of the text.

At the end
of titles (or
bridgehead), a
new para is created.
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Toolbar icon Action Mac Windows Description

Toggle title on
figures, tables,
examples.

Option ⌥  +

Shift ⇧  + H

Alt  + Shift ⇧  +

H

On figure/
informalfigure,
table/
informaltable,
example/
informalexample.
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Toolbar icon Action Mac Windows Description

e
r
o
n
e
.
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u
r

e becomes an informalfigure if you toggle to remove the title and vice versa.

Toggle bold text. Command ⌘  +

B

Ctrl  + B With text selected.

Toggle italic text. Command ⌘  + I Ctrl  + I With text selected

Toggle underlined
text.id

Command ⌘  +

U

Ctrl  + U With text selected

Superscript N/A N/A Raise the selected
text

Subscript N/A N/A Lower the selected
text
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Toolbar icon Action Mac Windows Description

Create (or convert
to) an Unordered
list also called
itemizedlist. 

Option ⌥  + L Alt  + L Depending on the
context:

1. Where
itemizedlist i
s valid: Creates
a
new Unordered
list (bullet list).

2. With a list of any
other type
selected:
Converts to an
itemizedlist.

3. Inside a
separate para:
Converts to an
itemizedlist

(the para
becomes a
listitem).
The cursor will
automatically
move to a
subsequent
para if there is
one, so you can
easily turn a
number of
paragraphs into
an
itemizedlist.

Create (or convert
to) an Ordered list. 

Option ⌥  +

Shift ⇧  + L

Alt  + Shift ⇧  +

L

Depending on the
context:

1. Where
orderedlist is
valid: Creates a
new Ordered
list.

2. With a list of any
other type
selected:
Converts to a
orderedlist.

3. Inside a
separate para:
Converts to an
orderedlist

(the para
becomes a
listitem).
The cursor will
automatically
move to a
subsequent
para if there is
one, so you can
easily turn a
number of
paragraphs into
an
orderedlist.
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Toolbar icon Action Mac Windows Description

Create (or convert
to) a procedure.

Option ⌥  +

Shift ⇧  + P

Alt  + Shift ⇧  +

P

Depending on the
context:

1. Where
procedure is
valid: Creates a
new Procedure.

2. With a list of any
other type
selected:
Converts to a
procedure.

3. Inside a
separate para:
Converts to a
procedure (the
para becomes a
step).
The cursor will
automatically
move to a
subsequent
para if there is
one, so you can
easily turn a
number of
paragraphs into
a procedure.

Split list N/A N/A Splits a list in two
lists of the same
kind.

Merge list N/A N/A Merges one list into
the next one.

Indent the
listitem or step

Option ⌥  + T Alt  + T In a listitem of
an itemizedlist
or orderedlist, or
in a step in a
procedure

Outdent the nested
list (of any of the
named types)

Option ⌥  +

Shift ⇧  + T

Alt  + Shift ⇧  +

T

In a nested
itemizedlist

or orderedlist,
or in a
nested procedure
or substeps

Remove formatting/
inline tags.

Option ⌥  +

Shift ⇧  + F

Alt  + Shift ⇧  +

F

Inside an inline
element. Will
remove common
inline formatting
tags like bold and
italic, but also any
other inline tag
available.
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Toolbar icon Action Mac Windows Description

Copy "formatting"
(inline element but
without content)

Option ⌥  +

Control ^  + C

Alt  + Ctrl  + C This is a function
similar to a "format
painter" in word
processors, but
copies the inline
element without its
text content, so that
it can be pasted
onto another text
string.

N/A Paste "formatting"
(inline element but
without content)

Option ⌥  +

Control ^  + V

Alt  + Ctrl  + V Paste (or "paint")
the format/inline
element copied
with the command
above.

Edit Source Code N/A N/A Open the Source
Code Editor to edit
the XML directly.

Insert tab

Insert a table. Option ⌥  +

Shift ⇧  + A

Alt  + Shift ⇧  +

A

Where a table or
informaltable is
valid.

The toolbar icon
opens a menu with
table editing choices
as well.

Reuse a component. Option ⌥  +

Shift ⇧  + R

Alt  + Shift ⇧  +

R

Where the type
of component is
valid (e.g a section,
warning, etc).

You can reuse
other topics,
informaltopics,
admonitions, and
more inside a topic.

Insert a cross-
reference or other
link.

Option ⌥  + R Alt  + R Current text
element where
cross-reference is
allowed.

The keyboard
shortcut opens
the cross-reference
dialog. The toolbar
menu also has
options for links to
external web sites
and email links.

Insert a variable. Option ⌥  +

Shift ⇧  + I

Alt  + Shift ⇧  +

I

Where the type of
variable is valid.
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Toolbar icon Action Mac Windows Description

Insert an image. Option ⌥  +

Control ^  + I

Alt  + I  or Alt

+ Ctrl  + I

Where image or
inlineimage is
available to select

If the cursor
is inside a text
element, such as a
para or a title, an
inlineimage will
be inserted.

Insert a side-by-side
image

Option ⌥  + J Alt  + J For inserting images
side by side.
The feature is
responsive for
HTML5, so if on a
smaller screen the
images will stack
vertically to fit.

Convert image to
thumbnail

Option ⌥  +

Shift ⇧  + Q

Alt  + Shift ⇧  +

Q

With
imagedata selected
(clicking on the
image itself).

Insert a video N/A N/A Where a video is
valid.

Insert character N/A N/A Inserts a special
character from
a character
map inside text
elements.

Insert (or convert
to) a Note.

Option ⌥  +

Shift ⇧  + N

Alt  + Shift ⇧  +

N

Where a note is
valid.

Converts the
admonition if
another admonition
type element is
selected.

Insert (or convert
to) a Warning.

Option ⌥  +

Shift ⇧  + W

Alt  + Shift ⇧  +

W

Where a warning is
valid.

Converts the
admonition if
another admonition
type element is
selected.

Insert (or convert
to) a Caution.

Option ⌥  +

Shift ⇧  + C

Alt  + Shift ⇧  +

C

Where a caution is
valid.

Converts the
admonition if
another admonition
type element is
selected.
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Toolbar icon Action Mac Windows Description

Insert (or convert
to) a Tip.

Option ⌥  +

Control ⌃  + T

Ctrl  + Alt  + T Where a tip is
valid.

Converts the
admonition if
another admonition
type element is
selected.

Danger, Notice
and Important

N/A N/A Do not have
keyboard shortcuts.
Must be inserted
with the toolbar
options.

Preview tab

Preview PDF N/A N/A Preview a PDF of
the currently open
topic.

You can select to
use your own layout
when previewing
content, in the
Editor settings.

Preview plain HTML N/A N/A Preview a plain
(X)HTML version of
the currently open
topic.

You can select to
use your own layout
when previewing
content, in the
Editor settings.

Preview HTML5 N/A N/A Preview an HTML5
version of the
currently open
topic.

You can select to
use your own layout
when previewing
content, in the
Editor settings.

Profile settings N/A N/A Set profile filter and
variable settings to
view the effect of
these directly in the
editor. 

These settings will
also be used
when previewing
in different output
formats.
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Toolbar icon Action Mac Windows Description

Other commands

N/A Toggle guilabel
tag.

Option ⌥  + G Alt  + G Element guilabel,
commonly used
for highlighting
UI components
when documenting
software.

N/A Toggle keycap tag. Option ⌥  + K Alt  + K Element keycap,
commonly used for
indicating keyboard
key combinations
(like the ones in this
topic).

N/A Show the Element
list. to insert
elements.

Command ⌘  +

Enter  or

Option ⌥  +

Enter

Alt  + Enter Valid anywhere in
the topic. This is
the main command
for viewing all
available elements
at a certain position
in your document.

N/A Move from one cell
to the next in a
table.

Tab Tab In tables

N/A Navigate between
elements.

↓ , ↑ , → , ← ↓ , ↑ , → , ← Anywhere

Save the topic. Command ⌘  +

S

Ctrl  + S Anywhere

Undo the last
action.

Command ⌘  +

Z

Ctrl  + Z Anywhere

Redo the last action. Command ⌘  +

Y

Ctrl  + Y Anywhere

Element
Structure Menu [52]

Copy element. Option ⌥  + C Alt  + C Copies the current
element the cursor
is in.

Element
Structure Menu [52]

Cut element. Option ⌥  X Alt  + X Cuts the current
element the cursor
is in.
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Toolbar icon Action Mac Windows Description

Element
Structure Menu [52]

Paste element. Option ⌥  + V Alt  + V Pastes a copied or
cut element in the
current element the
cursor is in.

Element
Structure Menu [52]

Paste element as
reuse.

Option ⌥  +

Shift ⇧  + V

Alt  + Shift  + V Pastes a copied or
cut element in the
current element the
cursor is in, reusing
any text fragment(s)
in the element.

The Table context
menu (right-click in

table)

Insert column right Option ⌥  +

Control ^  +  →

Alt  + Ctrl  + → Inserts a new
column to the
right of the column
where the cursor is.

See also Edit a
Table [282].

The Table context
menu (right-click in

table)

Insert row after Option ⌥  +

Control ^  + ↓

Alt  + Ctrl  + ↓ Inserts a new row
after the row where
the cursor is.

See also Edit a
Table [282].

The Table context
menu (right-click in

table)

Merge the selected
cells in a table.

Option ⌥  + M Alt  + M In a table, with
multiple table cells
selected using the
Shift key

See also Edit a
Table [282].

The Table context
menu (right-click in

table)

Split the cell into
two cells.

Option ⌥  +

Shift ⇧  + M

Alt  + Shift  +

M

In a table, with
cursor in previously
merged table cell

See also Edit a
Table [282].
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Toolbar icon Action Mac Windows Description

N/A Deletes the element
where the cursor is

Option ⌥  +

Shift ⇧  + D

Alt  + Shift  + D With any element
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Toolbar icon Action Mac Windows Description
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Toolbar icon Action Mac Windows Description
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Toolbar icon Action Mac Windows Description

Element
Structure Menu [52]

or the Table
context menu (for
moving table rows)

Move current
element down.

Option ⌥  +

Shift ⇧  + ↓

Alt  + Shift ⇧  +

↓

Current element
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Toolbar icon Action Mac Windows Description
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Toolbar icon Action Mac Windows Description
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Toolbar icon Action Mac Windows Description

Element
Structure Menu [52]

or the Table
context menu (for
moving table rows)

Move current
element up.

Option ⌥  +

Shift ⇧  + ↑

Alt  + Shift ⇧  +

↑

Current element
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Toolbar icon Action Mac Windows Description
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Toolbar icon Action Mac Windows Description

N/A Insert a
programlisting

or code element

Option ⌥  + . Alt  + . If your cursor
location is where
a block element
is valid, a
programlisting

will be inserted. If
it's inside text, like
a para, an inline
code element will
be inserted.

N/A Insert a tag (e.g the
name of an HTML or
XML tag)

Option ⌥  + E Alt  + E In a text element,
such as a para.

N/A Convert nested
section to accordion

Option ⌥  +

Shift ⇧  + Y

Alt  + Shift ⇧  +

Y

With a nested
section or
sidebar selected.
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Toolbar icon Action Mac Windows Description

N/A Convert bridgehead
to a section, nesting
the content after
the bridgehead in
the new section.

Control ^  +

Option ⌥  +

Shift ⇧  + W

Ctrl  + Alt  +

Shift ⇧  + W

With a bridgehead
selected.
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Toolbar icon Action Mac Windows Description
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s to convert, start with the last one.

N/A Insert dynamic text
variable.

Control ^  +

Option ⌥  +

Shift ⇧  + I

Ctrl  + Alt  +

Shift  + I

In a text element,
such as a para.

N/A Sort glossary terms
into alphabetical
order.

Control ^  +

Option ⌥  +

Shift ⇧  + G

Ctrl  + Alt  +

Shift  + G

Place the
cursor inside
the glossary
element before the
first glossentry
element.

Default Click Behavior
Default click behavior for topics and publications means that clicking on topics or publications will
cause different views to open:

1. Clicking a topic opens it in the Editor, since you are most likely to want to edit a topic most of
the time.

2. Clicking a publication opens it in the Structure View, since it is generally a much more
common task to build a publication by reusing topics in it in the Structure View, rather than
edit it in the editor.

If you need to open a topic in the Structure View, or a publication in the Editor, you always have
the commands in the options menu of the Content Manager.
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NOTE
Many of the keyboard shortcuts apply to the "current" or "selected" element, i.e
the one the cursor is located in.

You can check what the current element is in the Structure Menu at the top of the
editor. The last element in the hierarchical path is the current element:

Embed a Lucidchart Viewer
You can embed a viewer from Lucidchart with all its functionalities to a Paligo topic.

1. Position the cursor where the diagram or flowchart is to be positioned.

2. Select the Insert tab in the Toolbar.

3. Select Video. 

4. Click inside the grey box and paste the URL to the diagram or flowchart.

5. Select the checkmark to confirm the link.

6. Select Save. 

7. Select Preview in the Toolbar and choose HTML5 to see the diagram or flowchart.
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Editor Settings

The Editor Settings are global for the Paligo Editor [51] and will apply to all the topics and
publications that you work with. However, the settings will only be applied to your user account.
Other Paligo users can set up their own preferences.

Control which elements gets automatic IDs from Paligo, see Auto-Generate IDs for Cross-
References [246]. Change the color scheme for the source code editor, see Set Source Code Editor
Theme [73]. Select math editor, see Mathematics [387]. Enable or disable automatic validation
against the three different sets of validation rules, see Validation [623].

TIP
To enable the usage of more than 9 subsections in a topic, the checkbox Save
can be cleared under Paligo Recommended Rules. However the best way is to Use
Components to Create Subsections [169].

The Editor Settings dialog is divided in five tabs.

TIP
To learn how to:

• Control the highlights in the editor, see Enable or Disable Highlights [619].

• Hide parts of the editor so that it is more minimalistic, see Switch to Distraction-
Free Mode [621].
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Display Editor Settings
1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select Editor settings in the toolbar. 

3. Paligo displays the Editor Settings dialog.

The editor settings are global and will apply to all the topics and publications that you work with.
The settings will only be applied to your user account.

Enable or Disable Automatic Check-In
When you open a topic or publication in the editor, Paligo prevents other users from being able to
edit it. This is called "checking out". Other users can still view a checked-out document, but they
cannot edit it. When you have finished editing, you can check the document back in so that other
users can edit it if needed.

By default, Paligo is set to check in documents automatically when you:

• Open a different topic in the Editor [51]

• Navigate to a different display in Paligo, such as the Dashboard or Planner
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• Close the tab that is showing the document

• Close the browser

Depending on how you work, you may prefer to disable this behavior so that documents are only
checked in when you check them in manually.

To control the automatic check-in behavior:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select Editor settings in the toolbar. 

3. Paligo displays the Editor Settings dialog.

The editor settings are global and will apply to all the topics and publications that you work with.
The settings will only be applied to your user account.

4. Select the General tab.

5. Select Automatically check-in the current document box to control whether Paligo checks
in topics and publications.
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• Check the box to make Paligo automatically check in topics and publications.

• Clear the box to prevent automatic check-in of topics and publications. You will have to
check in your documents manually.

NOTE
The choice you make here applies to your user account only. Paligo may
still check in documents automatically for other users.

6. Select Save Settings.

Enable or Disable Correction of Element Structures
DocBook XML allows para elements to contain other block elements, such as other para elements,
procedures, and admonitions. This structure can cause problems when translating content.
To avoid these translation issues, Paligo can automatically convert your content so that block
structures are not positioned inside para elements.

NOTE
If your content has block structures inside para elements and it has been
translated previously, please contact customer support before enabling this
feature.

To turn the automatic fix feature on or off:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select Editor settings in the toolbar. 

3. Paligo displays the Editor Settings dialog.
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The editor settings are global and will apply to all the topics and publications that you work with.
The settings will only be applied to your user account.

4. Select the General tab.

5. Select Automatically fix problematic element structures box to control whether Paligo
adjusts your content structure.

• Check the box to set Paligo to automatically adjust your content structure so that para
elements do not contain other block elements.

• Clear the box to turn off the automatic structure fixing feature for the Editor [51] (and
Source Code Editor [71]).

NOTE
The settings you make here will only apply to your user account only.

6. Select Save Settings.

Enable or Disable Link Tools
When you edit topics that contain links, you can select a link to display the link tools. The link tools
is a pop-up that has options for:

• Opening the link target in the editor

• Making the link label (text) automatically use the title of the target topic

• Editing the link target
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The link tools pop-up is enabled in Paligo by default. But you can disable it if you prefer.

To enable or disable the link tools pop-up:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select Editor settings in the toolbar. 

3. Paligo displays the Editor Settings dialog.

The editor settings are global and will apply to all the topics and publications that you work with.
The settings will only be applied to your user account.

4. Select the Editing tab.
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5. Select Automatically show link tools in the editor box to control whether you can access
the link tools.

• Check the box to enable link tool access.

• Clear the box to prevent access to the link tools.

NOTE
The choice you make here only applies to you. Other Paligo users will still be
able to access the link tools (as long as they have the box checked in their
editor settings).

6. Select Save Settings.

Enable or Disable Autosave
Paligo has an autosave feature that stores your content automatically at regular intervals. The
autosaving is performed in the background without validation, to avoid interrupting your editing.
We recommend that you also save your content manually at regular intervals and also use the
validation feature to make sure your content is valid, see Validate Content Manually [632].

Via the Editor Settings you can set how often Paligo performs an autosave and to turn autosave on
or off.
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CAUTION
If you enable the autosave feature, do not open the same topic in multiple
browser windows. This is because it is possible to accidentally overwrite your
content.

For example, let's say you open an "Introduction" topic in two different tabs. You
edit the topic in tab 2 and so Paligo autosaves tab 2. You switch back to tab 1 to
see how the topic looked originally. If Paligo autosaves while you are on tab 1, the
content on tab 1 is saved to the topic in the database. As a result, you lose your
progress from tab 2 as the content from tab 1 overwrites it.

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select Editor settings in the toolbar. 

3. Paligo displays the Editor Settings dialog.

The editor settings are global and will apply to all the topics and publications that you work with.
The settings will only be applied to your user account.
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4. Select the Editing tab.

5. Select a setting from the menu In the Autosave Document section.

You can choose from:

• Turn off autosave - Disables the autosave feature. You will need to save your content
manually.

• 1 minute - Paligo saves your content automatically every minute.

• 5 minutes - Paligo saves your content automatically every five minutes.

• 10 minutes - Paligo saves your content automatically every ten minutes.

• 30 minutes - Paligo saves your content automatically every thirty minutes.

NOTE
The choice you make here only applies to you. Other Paligo users can set up
their own autosave preferences.

6. Select Save Settings.

Enable or Disable Restore Feature
When you are editing in Paligo, there may be a time where you close the Editor [51] without
saving. For example, you could have a power outage or the browser could crash. In these cases,
Paligo can restore most, if not all, of the content you were working on. It does this by using a
restore capability that is available in the most leading browsers.

To recover a topic that was closed without being saved, you need to have the restore unsaved
content feature enabled. It is enabled by default, in the Editor settings, but you can turn it off if
you prefer.

1. Select a topic or component in Content Manager [34].
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Paligo opens the content in the Editor [51].

2. Select Editor settings in the toolbar. 

3. Paligo displays the Editor Settings dialog.

The editor settings are global and will apply to all the topics and publications that you work with.
The settings will only be applied to your user account.

4. Select the Editing tab.
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5. Select Remember when content hasn't been saved box to enable or disable the restore
feature.

• Check the box if you want Paligo to present you with the option to restore unsaved
content.

• Clear the box if you do not want Paligo to restore unsaved content.

NOTE
The choice you make here only applies to you. Other Paligo users have
their own editor settings that control whether the restore content feature
is available.

6. Select Save Settings.

Set Topic Names to Match Topic Titles
By default, you can give your topics different names to their titles. For example, you could create
a topic in the Content Manager and name it "Introduction" but then when you edit the topic, you
could set its title to "Introduction to Acme 100". If you prefer, you can set Paligo to match the
topic names and titles so that they are the same.
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NOTE
We recommend that you disable the Autoupdate title feature if you have several
publications that need topics with the same name, but different content. For
example, if you have three different publications, each with their own unique
"Introduction" topic, then it is a good idea to disable Autoupdate title. This
is because if the title and topic name are the same, you would get three
"Introduction" topics and it could be confusing for authors.

With the Autoupdate title feature turned off, you can have three different topics
with "Introduction" as their title, but you can name the topics differently, such as
"Introduction Acme 100", "Introduction Acme 200", and "Introduction Acme 300".
If the feature is turned on, all three topics are named "Introduction".

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select Editor settings in the toolbar. 

3. Paligo displays the Editor Settings dialog.
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The editor settings are global and will apply to all the topics and publications that you work with.
The settings will only be applied to your user account.

4. Select the Editing tab.

5. Select Automatically update the document title on save box to enable or disable the topic
name and title matching.

• Check the box to set Paligo to change the topic name to match the topic title.
Paligo applies the name change when you open a topic in the editor and then save it. It does
not apply the name changes to all topics at once, you need to edit the topics manually.

• Clear the box if you want Paligo to allow topics to have names that are different from their
titles.

NOTE
The choice you make here only applies to you. Other users have their own
editor settings that control whether Paligo uses matching topic names and
titles.

6. Select Save Settings.

Use Guillemets instead of Quotes
If you write in French, you may find that Paligo inserts English double quotes when you are trying
to add guillemets. To avoid this issue, you can force Paligo to use guillemets instead.

1. Select a topic or component in Content Manager [34].
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Paligo opens the content in the Editor [51].

2. Select Editor settings in the toolbar. 

3. Paligo displays the Editor Settings dialog.

The editor settings are global and will apply to all the topics and publications that you work with.
The settings will only be applied to your user account.

4. Select the Editing tab.
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5. Select Force use guillemets instead of quotation marks box to control what happens when
you use your keyboard to insert a quotation mark.

• Check the box to make Paligo insert guillemets instead of quotes.
The guillemets are only used for new content that you add. They do not replace any
quotation marks that already exist.

• Clear the box to insert quotes instead of guillemets.

NOTE
The choice you make here only applies to you. Other users have their own
editor settings that control whether Paligo uses quotations or guillemets.

6. Select Save Settings.

Enable or Disable Keyboard Shortcut for Warnings
Paligo uses, by default, the keyboard shortcut Shift  ⇧ + Alt  + W  (Windows) or Shift  ⇧ +

Option  ⌥ + W  (Mac) for inserting a warning admonition. However, this shortcut is also used for

other purposes in some regions. To avoid a clash, you can stop Paligo from using this keyboard

shortcut for warnings.

To enable or disable the shortcut for warning admonitions:

1. Select a topic or component in Content Manager [34].
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Paligo opens the content in the Editor [51].

2. Select Editor settings in the toolbar. 

3. Paligo displays the Editor Settings dialog.

The editor settings are global and will apply to all the topics and publications that you work with.
The settings will only be applied to your user account.

4. Select the Editing tab.
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5. Select Disable the warning admonition keybind shortcut box to enable or disable the
shortcut.

• Check the box to stop using the keyboard shortcut to insert a warning admonition.

• Clear the box to start using the keyboard shortcut to insert a warning admonition

NOTE
The choice you make here only applies to you. Other Paligo users have their
own editor settings that control whether Paligo uses the shortcut for warning
admonitions.

6. Select Save Settings.

Set Preview Layouts
You can generate a preview of the content as PDF, HTML or HTML5 from the Toolbar [52]. For
example, you can preview it both as HTML5 and PDF output.

The preview initially uses the default layouts for each type of output and might differ from your
customized layout. But you can set Paligo to use your customized layouts instead. This will give
you a preview that is closer to how your content will look when you publish it using your own
layouts.

To choose the layouts that are used for your previews:

1. Select a topic or component in Content Manager [34].
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Paligo opens the content in the Editor [51].

2. Select Editor settings in the toolbar. 

3. Paligo displays the Editor Settings dialog.

The editor settings are global and will apply to all the topics and publications that you work with.
The settings will only be applied to your user account.

4. Select the Preview tab.

5. Use the menus to choose the layouts that Paligo should use when generating previews:
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• Preview option for PDF - Choose from any of the PDF layouts that exist in your Paligo
instance.

• Preview option for HTML - Choose from any of the HTML layouts that exist in your Paligo
instance.

• Preview option for HTML5 - Choose from any of the HTML5 layouts that exist in your
Paligo instance.

NOTE
The choice you make here applies to your entire Paligo instance. For example,
if you enable the feature, Paligo will remove white space whenever you or any
other user opens or saves a topic in Paligo.

6. Select Save Settings.

Enable Whitespace Removal
If you import content into Paligo from other systems, it can sometimes contain unwanted gaps in
the content called "whitespace". They are usually caused by consecutive spaces in the text or "soft
returns" for new lines. For example, you could have a badly formatted Word document where the
writer has used the spacebar repeatedly to move the text to the center of a page instead of using
Word's styles to align the text properly.

We recommend that you let Paligo automatically remove unnecessary whitespace. If you enable
automatic whitespace removal, Paligo will also remove any consecutive spaces that you may type
accidentally in the Paligo editor.

NOTE
Paligo will not remove white space from verbatim elements such as
programlistings (code) as in these cases, the extra spaces may be needed.

To set Paligo to remove white space:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select Editor settings in the toolbar. 
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3. Paligo displays the Editor Settings dialog.

The editor settings are global and will apply to all the topics and publications that you work with.
The settings will only be applied to your user account.

4. Select the Global settings tab.

5. Select Automatically normalize whitespace when opening or saving a topic box to control
whether Paligo removes consecutive spaces.

• Check the box to make Paligo automatically remove whitespace whenever a user opens
or saves a topic.

• Clear the box to make Paligo leave whitespace when a user opens or saves a topic. The
whitespace can be removed manually.

NOTE
The choice you make here applies to your entire Paligo instance. For example,
if you enable the feature, Paligo will remove white space whenever you or any
other user opens or saves a topic in Paligo.

6. Select Save Settings.

Enable or Disable Highlights
By default, Paligo highlights certain parts of your content to indicate comments, translation status,
profiling (filtering) and the currently selected element. You can enable or disable these highlights
individually or collectively via the Editor Highlight Settings.
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To update the Editor Highlight Settings:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select the arrow to the right of Distraction-free mode . 

3. Use the menu options to show or hide the various highlights.

4. Select the Focus element box to manage the highlight for the currently selected item.

• Check the box to show the light blue highlight for the currently selected element.

• Clear the box to hide the highlight.

5. Select the Comments box to manage the highlight for comments.

• Check the box to show the yellow highlight for elements that have a comment from
another user.

• Clear the box to hide the highlight.

6. Select Translation status box to manage the highlight for translated content.

• Check the box to show the light green highlight for elements that have been translated.
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• Clear the box to hide the highlight.

7. Select Profiled Elements box to manage the highlight for content with a filter condition
applied to it.

• Check the box to show the funnel icon next to elements that have a filter condition. 

• Clear the box to hide the funnel icon.

8. Select Switch all settings to check or clear all the checkboxes. 

Switch to Distraction-Free Mode
Paligo has a distraction-free mode which provides a more focused interface, where the Content
Manager [34] is hidden, the right side panels are minimized and the comments sidebar is shown.
You can toggle the distraction-free mode on and off as you choose.
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To switch to distraction-free mode:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select Distraction-free mode in the Toolbar [52] to toggle on or off. 

3. Select Show Comments in the Toolbar [52] to toggle the comments sidebar on and off. 

4. Select the sidebar panel icons to toggle between minimized and expanded view.

To the left - minimized side panels. To the right - expanded side panels.

Validation
One of the benefits of working in XML is that you can validate your content against established
Validation Rules [624]. So you can be confident that your topics have a valid XML structure that
is consistent and can be exported easily if needed. To find out how to choose what validation is
used, see Turn Validation On or Off [629].

Depending on your preferences, you can either:

• Set Paligo to validate your content automatically whenever you save a topic

• Manually validate your content by using the manual validation feature in the Toolbar [52].
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When you validate your content, Paligo examines the structure of your topic and checks that it
complies with the validation rules. If the content:

• Complies with the validation rules, you can save the topic.

• Breaks the rules, Paligo displays an error message and also provides information in the
Validation section in the side panel. You will need to fix the errors before the topic can be saved
(or disable the validation rules that are being broken). If you have tried to save a topic, but Paligo
has detected a problem and displayed a validation error message, see Invalid Content [626].

Validation Rules
Paligo has three different sets of rules that you can apply:

• The content must be valid XML and comply with the Paligo XML Schema Validation [624].
Always have this enabled as a minimum, as this will help to make sure your topics are valid XML
at least.

• The content must also comply with the Paligo Recommended Rules [625].

• The content must also comply with some Schematron Rules [625]. To use your own
Schematron file to apply extra validation rules, see Upload Schematron Files to Paligo [629].

By default, Paligo checks that a topic complies with the Paligo Recommended Rules [625] and
Paligo XML Schema Validation [624] before it saves the content.

You can choose to use all three sets of rules, any combination of the rules or no rules at all (not
recommended). The option to disable these features is designed for those occasions where you
need to save the content and will fix the validation problems later. For example, if an import
produces invalid content or the person who encounters the validation error is not the person who
will fix it.

If you have validation turned on, Paligo will not save the topic until it complies with the rules. To
choose which rules should be used and when they should apply, either when you try to save and /
or when you validate manually, see Turn Validation On or Off [629].

IMPORTANT
We strongly recommend that you have Paligo XML Schema Validation [624] and
Paligo Recommended Rules [625] enabled in your topics. Disabling them could
mean that features in Paligo do not work as intended and Paligo may run slowly.

Paligo XML Schema Validation
Paligo XML is based on DocBook 5.1 XML, which is a well-established XML standard for technical
documentation. You can find out about it, and its rules, at www.docbook.org. There is a reference
section where you can look up elements and find out where they can be used. However, be aware
that Paligo XML is not identical to DocBook XML.

The Paligo XML schema rules specify what elements can be used, where they can be used, and
what order they need to appear in. For example, they define that a <step> element has to be
a child (descendant) of a list element, such as <itemizedlist>. There are also rules about the
element attributes.

The Paligo editor is designed to guide you so that you only insert elements where they are valid.
For example, you cannot add a table inside a paragraph. However, if you turn validation off, it is
possible to create invalid structures that will break the Paligo XML rules.
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Typically, if you have a topic that will not save due to a Paligo XML validation error, it is because the
structure of the topic is invalid or there are Invalid Content [626]. To save the topic, you will need
to either:

• Edit the topic and fix the problems

• Turn off Paligo XML schema validation (not recommended).

Paligo Recommended Rules
The Paligo recommended rules are an extra set of validation rules that you can use. They are
enabled by default, and are designed to help writers avoid creating topics that are too long. This
is more in line with best practice for topic-based authoring. But the Paligo recommended rules are
not hard rules and you can disable them if needed (see Turn Validation On or Off [629]).

However, please be aware that topics containing an excessive amount of content in one topic
could result in performance issues in the browser.

The Paligo recommended rules are:

• A topic should contain a maximum of 10 sections.
This rule helps to ensure best practice for topic-based authoring, as well as browser
performance issues if you were to create extremely long topics.

NOTE
This rule only applies to section elements created directly in the topic. If you
create subsections by inserting other topics as embedded components, they do
not count against these rules.

If you have the Paligo recommended rules turned on, and your content breaks the rules, Paligo
will display an error message when you try to save the topic. You will only be able to save your
topic if you:

• Edit your topic so that it complies with the rules

• Turn the Paligo recommended rules validation off. You can also do this temporarily and then
turn them back on later. But if your topic breaks these rules, it is a sign that your content
could be better structured by nesting smaller components in the structure view or as embedded
components.

Schematron Rules
Schematron is a language that you can use to create customized validation rules for your Paligo
topics. This is useful when you want to add extra rules, for example, you could create a rule that
each topic can only contain one procedure.

So the rules of Schematron are up to you! You can define the rules to suit your content
requirements, and you can use them in addition to, or instead of, the Paligo XML schema rules and
Paligo recommended rules.

To find out about creating a Schematron file, uploading it to Paligo, and enabling Schematron
validation, see Custom Validation Rules with Schematron [628].

If you are trying to save a topic and get a Schematron error, it means the topic's content is
breaking the rules set in a Schematron file. You can either:

• Edit your topic and fix the problem that is breaking the rules in the Schematron file. To do this,
you will need to find out what rules are set in the Schematron file.

Paligo Documentation

625

https://schematron.com/


You could ask whoever is responsible for uploading and maintaining the Schematron file. If that
is not possible, you can ask someone with Schematron experience to view the Schematron file
and figure out what rules are in place. The location of the Schematron file is explained in Upload
Schematron Files to Paligo [629].

• Turn Validation On or Off [629].

NOTE
It is possible to have multiple types of validation enabled at the same time,
for example, Paligo XML Schema validation and Schematron validation. In this
scenario, a topic will only save when it complies with all of the rules.

Invalid Content
Your content is validated by Paligo when you save a topic or when you Validate Content
Manually [632]. If Paligo detects that your content breaks the applied rules, it displays an error
message, adds a red highlight to the elements and a description is displayed in the Validation
panel. The most common reasons for a topic being invalid are described in this section.

An error message appears to inform about the validation errors. Paligo also adds a red highlight to the
elements that contain invalid content and a description is displayed in the Validation panel to the right.

Breaks the Paligo XML Schema Validation
Paligo XML schema validation errors are usually due to the incorrect positioning or ordering
of elements. To make your topic valid, check that the content follows the Paligo XML Schema
Validation [624] which is based on DocBook, see DocBook.

Invalid attributes and attribute values can also result in Paligo XML schema validation errors. To
check for those, see Breaks the Rules for Attribute Values [627].

Breaks the Paligo Recommended Rules
Paligo's recommended rules are an extra set of rules that are included as a Schematron file. They
are optional, and you can Turn Validation On or Off [629].

To make the topic valid so that it can be saved, edit the topic so that it complies with the Paligo
Recommended Rules [625]. Alternatively, you can turn the rules off.
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Breaks the Schematron Rules
If you have a Schematron validation error, it means that there are custom rules in place in your
Paligo instance. These rules are set in a Schematron file. To find out what rules your content is
breaking, you will need to find out what rules the Schematron defines.

You could ask whoever is responsible for uploading and maintaining the Schematron file. If that
is not possible, you can ask someone with Schematron experience to view the Schematron file
and figure out what rules are in place. The location of the Schematron file is explained in Upload
Schematron Files to Paligo [629].

Breaks the Rules for Attribute Values
A topic can be invalid because it contains attributes that have values that are not supported. This
can happen when:

• An attribute value is added in the source code editor

• Unsupported characters in your attribute values.

For example, if you have an orderedlist element, you can add a continuation attribute. In
the Paligo editor, you can only select valid values for this, either: continues or restarts. But in the
source code editor, you could set the value to "stop", which is invalid.

NOTE
Invalid attribute values are part of the Paligo XML Schema Validation [624].

To fix invalid attribute values:

1. For each attribute, use the Paligo editor to look at the values that are in place, and also the
options that can be selected for the values. These are valid values for the attribute.

2. Use the Source Code Editor [71] to look at the values that are set for your attributes.
If there are any invalid values, remove them and then use the Paligo editor to add a valid
value.
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3. Select Save. 

Custom Validation Rules with Schematron
Schematron is a language that you can use to create customized validation rules for your Paligo
topics. This is useful when you want to add extra rules, for example, you could create a rule that
each topic can only contain one procedure.

NOTE
Schematron rules are additional rules that you can apply to the Paligo XML
content model, which is based on DocBook. You cannot use it to add custom
elements that are not supported by Paligo XML/DocBook.

To use Schematron rules in Paligo:

1. Create a Schematron file named:
custom.sch

You can do this in any code editor or text editor, but you will need an understanding of how
Schematron works. You can find out more at the official Schematron website. Note that the
file must be named custom.sch or it will not work in Paligo.
When you create a "custom.sch" Schematron file, you should consider:

• The structure of your Paligo content and the patterns in that content

• The Schematron rules you create are applied to each topic individually in Paligo.

2. Upload Schematron Files to Paligo [629].

3. Turn Validation On or Off [629].

When Schematron validation is enabled, Paligo checks the content of a topic against the rules in
the Schematron file. This happens when the you attempt to save the topic. If the topic's content
breaks the rules, Paligo will display an error notification and will not save. You can then:
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• Edit your topic and fix the problem that is breaking the rules in the Schematron file. To do this,
you will need to find out what rules are set in the Schematron file.
You could ask whoever is responsible for uploading and maintaining the Schematron file. If that
is not possible, you can ask someone with Schematron experience to view the Schematron file
and figure out what rules are in place. The location of the Schematron file is explained in Upload
Schematron Files to Paligo [629].

• Turn Validation On or Off [629].

NOTE
It is possible to have multiple types of validation enabled at the same time,
for example, Paligo XML Schema validation and Schematron validation. In this
scenario, a topic will only save when it complies with all of the rules.

Upload Schematron Files to Paligo
If you have created a Schematron file, you can upload it to your Paligo instance. When it is in place,
your Paligo authors will be able to open a topic, enable Schematron validation, and Paligo will use
the custom rules from your Schematron file. If the topic's content breaks the Schematron rules, a
notification message is displayed and the topic will not save. Details about why the content breaks
the rules are shown in the Validation side panel.

To upload a Schematron file to Paligo:

1. Connect to your Paligo instance via WebDAV (see WebDAV Access to your Paligo Instance
Folders [1880]).

2. When you are connected via WebDAV, open the Schematron folder and then open the Editor
folder.

3. Upload your custom.sch Schematron file into the Editor folder.

4. Let your Paligo writers know that the Schematron file is uploaded and they can now Turn
Validation On or Off [629].

TIP
It is a good idea to document the rules of your Schematron file so that writers can
refer to it. If they create topics that break the rules, Paligo will generate an error
message. The writers will then need to correct the topic so that it complies with
the rules, but to do that, they will need to know what the rules are.

Turn Validation On or Off
Paligo can check that your content is valid either manually or before the topic is saved to the
database. But these checks will only take place if one or more of the validation features are turned
on for your topics.

If you want to enable validation (recommended), you can choose which Validation Rules [624]
Paligo should use. You can also choose when the rules are applied, either when you save a topic,
during a manual validation or both.

To turn validation on or off and choose which rules are used:
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1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select Editor settings in the toolbar. 

3. Paligo displays the Editor Settings dialog.

The editor settings are global and will apply to all the topics and publications that you work with.
The settings will only be applied to your user account.

4. Select the General tab.

5. Set your validation rules In the Documentation Validation section.
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The options are:

• Paligo XML schema validation
Complies with the validation rules, you can save the topic.

• Breaks the rules, Paligo displays an error message and also provides information in the
Validation section in the side panel. You will need to fix the errors before the topic can
be saved (or disable the validation rules that are being broken). If you have tried to save
a topic, but Paligo has detected a problem and displayed a validation error message, see
Invalid Content [626].
The content must also comply with the Paligo Recommended Rules [625].

• Schematron validation
The content must also comply with some Schematron Rules [625].

For each type of rule:

• Check the Save box to turn the type of validation on when saving a topic. Paligo will test
that your content complies with the selected rules whenever you try to save a topic. Clear
the box to turn the validation off when saving a topic.

• Check the Validate box to use that type of validation when you Validate Content
Manually [632]. Paligo will test whether your content complies with the selected rules
whenever you use the validate option in the Editor's toolbar. Clear the box to turn the
validation off.

• Clear the Save and Validate boxes to disable validation. We strongly recommend that
you have Paligo XML schema validation enabled as this will prevent you from saving invalid
content. Paligo can only publish content that has a valid structure. To learn more, see
Validation Rules [624].

NOTE
You can use any combination of these validation rules or you can disable
validation completely if you want. We recommend that you always have
Paligo XML schema validation enabled as a minimum, as this will help to
make sure your topics are valid XML at least.

6. Select Save Settings.
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Validate Content Manually
Paligo validates your content automatically when you save a topic, but you can also start the
validation process yourself, at any time. The rules that are used for the validation vary, depending
on what you have in place in the editor settings. You can use the same rules for validation on
save and manual validation, or you can apply different rules for each, see Turn Validation On or
Off [629].

The Save checkboxes are for the rules that apply when saving a topic.

NOTE
If you want to save your topic and come back to fix the problems later, you will
need to turn the validation off. You cannot save a topic that has invalid content
while the validation rules (that it has broken) are turned on.

To find out more, see Turn Validation On or Off [629].

To validate your content manually:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Select Validate the document in the Toolbar [52]. 
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Paligo will check that your content is valid based on the rules that are set for manual validation (in
the topic editor settings). These are the rules that have Validate checked.

If your content has broken any of the validation rules, Paligo displays an error message. It also
provides information about the problems in the Validation panel, so that you know what parts of
the content you need to fix. Learn more, see Invalid Content [626].
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Search and Navigate

There are many ways to search, navigate and find your content in Paligo.

For navigating your content, we recommend that you browse your folders and topics in the
Content Manager [34].

To search for content, use:

• Quick Search - Located in the top menu, see Quick Search [640].

• Advanced Search - Located in the the Quick Search. This is the most powerful search and you
can use it to search content in an even more granular way, see Advanced Search [642].

•  Taxonomies - You can find content you have tagged with taxonomy categories by clicking on
the category in Taxonomy Manager [79].

Navigate through the Publication Structure
You can navigate through a publication in the Content Manager [34] by expanding it to reveal its
contents.

Similarly, you can navigate through publications using the Structure View [75]:

1. In the Content Manager [34], select the publication that you want to view.
Paligo displays the publication's structure.

2. Select a topic name.

3. Scroll down to view the Metadata section.
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4. Find the heading Location. and select the location. Paligo will open the folder where the topic
is located.

Search for a Topic in a Publication
Each publication has its own Structure search that you can use to find topics inside a publication.
This feature is useful when you know a topic is included somewhere in a publication, but you are
not sure about its exact location.

1. In the Content Manager [34], select the publication that you want to view.
Paligo displays the publication's structure.

2. Select the search icon at the top of the structure view to display the Search in structure
search.
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3. Use the Search in structure field to search for topics inside the publication.
If there is a matching result, it is highlighted in the publication's structure.
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Filter Search in the Content Manager
At the bottom of Content Manager [34] you can access a filter search to scan the content. There
are several search options to narrow down the search.

1. Enter the text in the search field. 

2. Use the search option checkboxes to narrow down the search.
For example, if you only want to search for images, clear the other search options.
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Exact Match and Close Match Search
When you use the search features, you can perform an exact search or a close match search.

• Close match
Paligo uses a close match search by default. When you enter a term, Paligo finds any content
that contains the words in the search term. It does not matter if the words in the search term do
not appear next to each other or in a different order.
To perform a close match search, enter your term in the search field.

• Exact match
With an exact match, Paligo will only find content that has the search term. The search term has
to appear in the content in the same order as it is defined in the search term and cannot have
other words in between.
To perform an exact match, enclose your term in double-quotes. For example, "temperature
controls"

Enable Wildcard Search
By checking the box Enable wildcard search next to the search field, you can use wildcards to
find content. This option is available in all different search fields in Paligo.

Use the following symbols:

• * - An asterisk can represent one or many characters

• ? - A question mark can represent any single character

You can use these symbols anywhere in the search string. For example, automati* would
find both "automation" and "automatic", and automo?i?e would find both "automobile" and
"automotive".
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The image shows the wildcard option in the Quick Search.

NOTE
Remember to check the box Enable wildcard search next to the search field to
use wildcards.

Search and Replace with Source Code Editor
You can search and replace text in the editor by using the Source Code Editor [71]. It provides
more complex search and replace actions, such as replacing values in attributes.

1. Select Edit source code under the Edit tab in the toolbar. 

2. Place the cursor inside the Source Code Editor [71].

3. Hit Ctrl  + H  (Windows) or Cmd ⌘  + Option ⌥  + F  (Mac) to open the Search and

Replace widget.

The search field appears in the Source Code Editor.

TIP
If you hit Ctrl  + F  (Windows) or Cmd ⌘  + F  (Mac) you only open the Search

widget.

4. Use the different options to search and replace one at a time or all at once. You can
combinate several options or use them separately.
When an option is chosen, it gets a blue square around it. To deselect it, click it once more.
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•  Toogle between Next and Previous search hits. Select ALL to show all results at the
same time.

•  Use Replace to update the selected search hit or ALL to update all search hits at
once.

•  RegExp Search (regex) is used for even more powerful actions. Learn more, see regex
101.

•  Case Sensitive Search defines whether uppercase and lowercase letters are treated as
distinct or equivalent.

•  Whole Word Search looks for word boundary markers, such as ending space, beginning
space or punctuation mark for each match.

5. Select Update to save the changes or Cancel to ignore the changes.

6. Close the Source Code Editor with the X in the top right corner.

Quick Search
The Quick Search is located in the right corner of the top menu and provides a convenient way
of finding content. When you do a quick search, Paligo presents the results in a list, categorized
according to the type of content.

Quick Search also has a number of useful options, such as quickly locating a resource (topic,
image) by its ID (see Search Using ID [641]).

The image to the left shows search results in Quick Search. The image to the right shows the Quick
Search options.

Use Quick Search
The Quick Search is located in the right corner of the top menu.

1. Select Quick Search in the top menu. 

2. Enter the text in the search field.

3. Use the search option checkboxes to narrow down the search.
For example, if you only want to search for images, clear the other search options.
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4. Press Enter.

Search Using ID
Abstract

You can search for content based on its unique ID. Make sure that Enable Autolocate is selected
for quick search, and then enter id: followed by the id number to search.

You can use the Quick Search Enable Autolocate feature to search for content based on its ID.
This is useful when you have the ID and want to find the corresponding topic, image, folder, etc.

1. Select the search icon below your profile to display the Quick Search bar.

2. Select the arrow icon on the Quick Search bar and then check the box for Enable Autolocate.

3. In the Quick search field, enter the ID that you want to search for. Use this format:
id:<number>
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For example, id:1234

4. Press Enter or select the search icon at the end of the Quick Search bar to start the search.
Paligo displays the Resource View of the folder that contains the matching topic. The Resource
View shows all topics in that folder, and the name of the matching topic flashes to show it has
the id you are searching for.

Advanced Search
Use the Advanced Search to find content more easily. It provides a range of powerful search
options that you can use to find specific content, including content that contains specific XML
elements. Here, you can find out how to access the Advanced Search feature and also how to use
the various Advanced Search settings.

To find out how to search and replace content, see Global Search and Replace [650].

TIP
Here are some tips to level up your search:

• To include images with taxonomy tags in the search, remove the Language
criteria from the search settings.

• To restrict the search for topics with taxonomy tags in a particular folder, use
the In folder field.

Display Advanced Search
There are several ways to access the Advanced Search feature:

• Select the magnifier icon  for the Quick Search and then select the funnel icon for Advanced
Search.

• Select a folder in the Content Manager to display a filtered view of the folder and its contents.
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Then select the funnel icon in the top corner to display the Advanced Search settings, which are
already set to be filtered to the selected folder.

• Select a taxonomy tag in the Content Manager to display a filtered view of the taxonomy and
any sub-taxonomy classes.

Then select the funnel icon in the top corner to display the Advanced Search settings, which are
already set to be filtered to the selected taxonomy tag.
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When you have displayed the Advanced Search features, you can use them to Perform an
Advanced Search [644].

Perform an Advanced Search
To perform an Advanced Search, enter the search criteria that you want to use. You can use a
single search setting or you can a combination of search settings for more precision.

To perform an advanced search:

1. Select Quick Search in the top menu. 

2. Select Advanced Search. 

3. Select the Search tab.

4. Create the search criteria by using the search settings (as described later in this section).

5. Select Search.
Paligo will find any matching results and display them in a list below the Advanced Search
settings.

NOTE
To clear all of the search settings so that you can start again, select the Reset
button.

Define the Search Criteria
The Advanced Search settings that you can use to define your search criteria are:
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1. Keyword - Enter a keyword or term to search for. The search will find components that contain
text that matches the search term. Leave the keyword search empty if you do not want to use
the keyword search.

2. Enable Wildcard search - Use the checkbox to enable or disable wildcards for the keyword
search field. A wildcard is a character that represents a sequence of characters or any single
character. For example, if you enable wildcard search, you can search for "Top*" and the
search will return all components that contain "Top" followed by any sequence of characters.
The wildcard characters you can use are asterisk * for any sequence of characters and
question mark ? for any single character.

3. Types - Use Types to limit the search to a specific type of component, such as a publication
or a topic. For example, if you search for "Introduction" in the Keyword Search and set Types
to topic, Paligo will return all topics that are named "Introduction", but will ignore any other
components that are called "Introduction".

4. Contains (Element) - Use Contains (Element) to search for content that contains specific
types of XML elements. For example, to find topics that contain instructions, and therefore
have the procedure element in them, set Contains (Element) to procedure.
You can also use Contains (Element) to search for content that is normally not considered
plain text content, such as numbers or code snippets. Enter the following syntax, and enter
your search term inside the single quotes (for this example, we are searching for the number
52.35.19.31): //*[contains(., '52.35.19.31')]

TIP
You can use Xpath in the Contains (Element) field for more
advanced search expressions. For example, you can search for
mediaobject[ancestor::procedure] to find any topic where there is a
mediaobject inside a procedure.

To search for topics that contain specific attributes, like filter attributes, you
can do this: //*[contains(@audience, 'beginner')], which would find
any topics that have the @audience attribute set to the value beginner.

5. Editors - Use to search for content that has been edited by specific users.

6. Date - Search for content that was created or modified within a specific date range.
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7. Status - Use this field to narrow down the search to only documents in a certain workflow
stage. Search for topics or publications that are in a particular workflow stage, such as "In
review".

8. Resource ID - Search for content by its ID. Normally, if you know the ID, you would enter it
here and not include any other search criteria.

9. Languages - Search for content in specific languages only.

10. In taxonomies - Search for content that is marked up with a specific taxonomy tag.

11. In folder - Search for content that is stored in a specific folder.

12. Search in - Control where Paligo searches to find results. You can choose to search in the
title of topics, branch label of branched content, in the actual body of the content, or in
filenames (these are the names of the components, for example, topic names).

NOTE
If you search for branch label, make sure the Enable Wildcard Search option
is enabled.

Search and Open in Editor
You can use the Advanced Search to find a topic or publication and open it in the Editor. Narrow
down the search by using search options, see Advanced Search [642].

1. Select Quick Search in the top menu. 

2. Select Advanced Search. 

3. Select the Search tab.

4. Enter the keywords to search for.

5. Select Search.
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Paligo presents a detailed view of the search results.

6. Select the Dotted menu (...) to the right of the topic or publication.

7. Select Edit and choose Open in Editor. 

Paligo displays the topic or the publication topic in the Editor.

Search and Rename
To rename topics and publications, you can use the Search tab to locate it in Content
Manager [34]. Narrow down the search by using search options, see Advanced Search [642].

1. Select Quick Search in the top menu. 

2. Select Advanced Search. 

3. Select the Search tab.
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4. Enter the keywords to search for.

5. Select Search.

Paligo presents a detailed view of the search results.

6. Select the Dotted menu (...) to the right of the topic or publication.

7. Select Edit and choose Open in Editor. 

Paligo displays the topic or the publication topic in the Editor.

8. Select the Dotted menu (...) for the topic or publication in Content Manager [34] .

9. Select Rename.

10. Enter the new name and save it with the checkmark. 
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Search for Attributes
You can use the advanced search feature to search for components that contain specific attributes
and values. For example, you might want to search for all topics that contain the xinfo:product
attribute with a value set to one of your product names.

To search for attributes, use the advanced search and perform a contains search.

1. Select Quick Search in the top menu. 

2. Select Advanced Search. 

3. Select the Search tab.

4. Leave the Search field empty. It is important to have no content in the search field. If there is
content here, the attribute search will not work as expected.

5. In the Contains field, enter the search using XPath syntax:

//*[contains(@atttribute name, 'attribute value')]

Where you replace the attribute name with the name of the attribute. Similarly, replace
attribute value with the value you want to search for.
Here is an example search for the xinfo:product attribute with a value of ACME 1000.

//*[contains(@xinfo:product, 'ACME 1000')]

There are many websites that you can use to learn about using XPath syntax, for example,
www.w3schools.com.

6. Select Search.
Paligo finds any components that contain the attribute and value you specified. The results
are listed below the search settings.
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Global Search and Replace
To update content in topics and publications, you can use the Replace tab in the Advanced
Search.

WARNING
This is a very powerful feature and you should carefully check all search results
before replacing the content.

TIP
Learn more, see Search and Open in Editor [646] and Search and Rename [647].

1. Select Quick Search in the top menu. 

2. Select Advanced Search. 

3. Select the Replace tab.
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4. Enter the text string you want to search for in Find what.

5. Type the replacement text in Replace with.

TIP
You can also use the following in the replacement field:

• An XML inline element - For example, to replace the search text
string with the text bold, you enter this: <emphasis role="bold">ACME
X3000</emphasis>.

• A variable - To do so, just click the arrow on the right of the field and select
a variable.

6. Select any other search options to narrow down your search:

• Ignore case to make the search case insensitive.

• Match only whole word to avoid getting matches that are only part of other words.

• Contains also to specify other text fragments included in the phrase.

• Language to replace text in another language than the source language.

7. Select Search. 
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Paligo presents a detailed view of the search results, with the search term marked in red and the
replacement text marked in green.

NOTE
Check the results carefully, to make sure you are not replacing terms you did
not intend to.

Use the buttons Include all or Exclude all to check or uncheck all results.
Make sure only the ones you want to replace are checked before continuing.

8. If any topics are:

• In other status than Work in progress, the checkbox Auto-change workflow status
appears above the search results. Use this to change the status to Work in progress for
those topics.

• Checked out, the checkbox Automatic check-in appears above the search results. Use this
to check in those topics.

CAUTION
If you are working in a large team and reusing content across different
product owners, you should not check these boxes, but instead leave them
and first find out if these can be checked in or have the workflow status
changed.

9. Select Replace.
Paligo replaces the matching content in your topics. You can see the effect of the replacement
by looking in any of the topics (that previously contained the search term) in the editor. You
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will need to re-publish your documentation to see the effects of the replacement in your
published outputs.
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Style and Customize your Outputs

An important concept with structured authoring is the separation of content and layout. This is a
core principle, and central for getting the most out of structured authoring. If you have previously
been using an HTML-based help authoring tool, a word processing tool, or similar, it may take a
little while to get used to the concept. But you will soon see the benefits.

You create your content in topics and then you can control the appearance by using:

• Layouts
There are different Layouts [1054] for the various types of outputs you can publish, and each
Layout has settings that affect the entire publication. Some of these settings are for controlling
the appearance, for example, setting the headings on PDF outputs.

• CSS
For HTML outputs, you can associate a CSS file with the Layout. Branding your HTML Outputs
with CSS [654], for example headings and paragraphs. You can also set the HTML Layouts to
include class names.

• Attributes of the structural elements in your topics.
For some content elements, you can add attribute values [51] that affect the appearance of your
content in the output. A common example is the width attribute which you can use to control
the size of images and videos.

Styling Workflow
The workflow you need to follow for styling your content is different, depending on the type of
output you are going to create. The biggest differences are between PDF and HTML outputs, as
HTML outputs are primarily styled by using CSS stylesheets, whereas PDF outputs are styled in the
Layout Editor.

The following sections summarize the process you should follow for HTML and PDF outputs:

• HTML Styling Workflow [678]

• PDF Styling Workflow [798]

If you are using the HTML5 Help Center as your output, see HTML5 Help Center Styling [680].

Branding your HTML Outputs with CSS
When you publish to HTML, the appearance of your content is defined in a Cascading StyleSheet
(CSS). This is a list of instructions that tell the browser how to style the HTML elements on the
page. For example, the CSS tells the browser what color the heading text should be and what font
to use for the body text.

Paligo has a default CSS stylesheet that is generated automatically, but you can create your own
CSS stylesheet and use that instead. To create a valid stylesheet, you will need to know at least
the basics of CSS. For the most common types of style change, such as colors, fonts, and margins,
you will only need to make small changes. Typically, all you need to do is find out which class the
content uses and then change a value or add a new attribute and value.
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Example of a CSS stylesheet

If your organization has web designers, you may be able to leave the CSS customization to them,
as they will already have CSS knowledge.

To create your own CSS, we recommend that you:

1. Use a code editor or text editor to create the CSS file [656]. You can use any editor that can
save a file with the ".css" extension.

2. Use a sample publication [657] on your computer to test the changes you make to the CSS.
You can use the browser's inspection tool [658] to find classes and add and change attributes
and values.

3. When you have made your custom CSS, you can then Upload Customized CSS [662] that you
use for publishing to HTML.
The CSS will then be used the next time you publish your content with that layout.

NOTE
The layout that you use to publish also has settings that affect your published
HTML. To find out more about layouts, see Layouts [1054], Create a Layout [1059],
and Edit a Layout [1061].

TIP
If you want to learn about CSS, this CSS Tutorial covers the basics and has links to
more resources.
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Create a CSS Stylesheet
You can use a code editor or text editor to create a CSS stylesheet. There are many different
applications available, and you can use any that support saving with a .css file extension.

1. Use a code editor or text editor to create a CSS file. Give it a name and save it with the .css
extension.

2. Add the styling rules that you want to apply to your content.
To create your own CSS stylesheet, you need to identify the classes that you want to
change. You can do this by publishing an HTML output and then using the browser's inspect
feature [658] to view the class names of the elements. When you have the class names, you
can add them to your CSS and include attributes and values for styling.
To find out about using a publication for testing your CSS changes, see Change CSS and Test
the Results [657]
If you are completely new to CSS, you can find a simple explanation of the syntax [656]
below.

TIP
If you want to learn about CSS, this CSS Tutorial covers the basics and has
links to more resources.

3. Save your CSS file.
You can then Upload Customized CSS [662] in Paligo.

Basic CSS Syntax
A CSS stylesheet contains a list of instructions or "rules". They tell the browser how to style content
that is marked up to have a class name or id. For example, a paragraph could have the class name
"aside" and you could then use a CSS rule for "aside" to define the color, font, margins, etc., to
apply to that paragraph.
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Example of one of the default CSS stylesheets used by Paligo

For a CSS rule, you define the selector and then the attributes and values that will apply. Here is a
simple example of the styling for a class named "para-main".

.para-main {
    font-family: "Open Sans","Helvetica Neue",Helvetica,Arial,sans-serif;
    font-size: 13px;
    line-height: 1.5pt;
    color: #333;
    background-color: #f5f5f5;
}

• The rule begins by defining the class the style rules will apply to. This is the "selector" and it can
include one or more classes. Here, there is just one and it is preceded by a period ( . ) so that it
can apply to different HTML elements. For example, if there was an h1.para-main selector, the
style rules would only apply to heading 1 (h1) elements that have the class "para-main".

• An opening curly bracket begins the rules for styling.

• On each line, there is an attribute and the value(s) for that attribute. For example, font-size
is the attribute and 13px is the value. Note that the font-family attribute has several values,
each separated by a comma. In this case, the browser will use the Open Sans font. If that is
unavailable, it will use Helvetica Neue instead. If that is unavailable, it will use Helvetica, and so
on.

• A colon separates a value from its attributes.

• A semi-colon is used to mark the end of the value(s).

• A closing curly bracket ends the rule.

This is a basic example, but the main principles are the same for CSS styles. You begin with a
selector to define which class the rules apply to , then define the rules for that class as attributes
and values.

TIP
If you want to learn about CSS, this CSS Tutorial covers the basics and has links to
more resources.

Change CSS and Test the Results
If you have lots of styles to change, we recommend that you publish your content as a "test"
publication. You can then view the publication in a browser, and edit the CSS file in the output.
When you make changes to the CSS file, you can save it and refresh the browser to see how the
changes affect the content.

This is quicker than applying each change individually in the browser's inspect feature and then
copying those changes to your CSS.

1. Use a code editor or text editor to create a CSS file. It must contain at least one CSS style rule
and have a .css file extension.

2. Upload the CSS [662] file to an HTML5 or HTML layout.

Paligo Documentation

657

http://www.w3schools.com/css/


3. Choose a publication and publish it using the layout from the previous step. When your
browser downloads the output, save the output on your computer to use as a development
sample.

4. Unzip the download and open the out/css folder. You will see your custom CSS file, but it will
be renamed with a random ID name:

5. Open the index.html file in your browser.
The HTML content is shown and it uses the rules in your custom CSS and also the rules in the
default stylesheets. The rules in your custom CSS stylesheet takes priority over the default CSS
stylesheets. For example, if your custom CSS has rules for styling the h2 class, the browser will
apply those rules and not the h2 class rules in the default CSS stylesheets.

6. Use the browser's inspect feature [658] (or similar) to view the classes in the HTML. You can
make changes to the styles in the inspector panel to see what effect the changes will have.

7. When you make a change that you want to keep, add the rule to your CSS stylesheet. This will
override the default CSS rules.

8. Refresh the browser to see the changes that have been added to your CSS stylesheet.

9. When you are happy with your changes, upload your CSS file [662] to your layout in Paligo.
This will overwrite the one you uploaded previously, and it will be applied the next time you
publish.

Browser Inspection Tool for Styling CSS
Modern browsers such as Google Chrome and Mozilla FireFox have inspection features that you
can use to view the classes in your HTML content and test changes to the CSS. The inspection
features may use different terminology, but they work in a similar way. If you have never used the
inspection features before, here's a quick overview based on Google Chrome.

To use the inspection tool:

1. Open the Inspection Tool [658].

2. Find Classes in the Inspection Tool [659].

3. Change Styles in the Inspection Tool [661].

4. Add the changes to your custom CSS file and upload it to your HTML5 or HTML layout [662].

We recommend that you publish an HTML output to your computer and use it for testing. You can
use the browser inspection tool to test your changes, and then add them to your custom CSS file
before uploading it to Paligo.

Open the Inspection Tool

1. Use a browser to open the index.html file in your published HTML output.

2. Right-click on the webpage and select Inspect (or the equivalent option if you are not using
Chrome).
The browser reveals the inspection tools.
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Let's look at the various parts of the Inspection interface:

1. The viewer. This is where your webpage content is shown as it will appear to visitors.

2. The Elements tab shows the HTML of the page you are viewing.

3. The underlying HTML code for the page. This is also called the DOM Tree (Document
Object Model Tree). You can expand the elements to see the full structure of the page.
From here, you can see the class names and ids that are assigned to the various HTML
elements. You style your content by creating rules that apply to these classes and ids.

4. The Styles tab. This is where you can see the CSS that is currently applied to the selected
class. You can make changes to the CSS here to see what effect the changes will have.
For example, if you change the color value for a heading, you will see the heading change
color in the viewer. The changes you make here are only for testing as they are not stored
and will be lost when you browse away from the page or refresh it. To keep the changes,
you need to add them to your custom CSS file.

5. The selection tool. If you activate this, you can select any part of the page shown in the
viewer, and the browser will show you the HTML for that part of the page. The Styles tab
then updates to show you the various classes and styles that apply to that HTML element.

Find Classes in the Inspection Tool
Use the selection tool to find the class you will need to change if you want to restyle part of a page.

1. Select the selection tool icon.
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2. Hover the cursor over the part of the page that you want to restyle. A highlight appears and a
pop-up to show the class and the styles that are currently being used.

3. Select the part of the page that you want to restyle. When you click the button, the cursor
will change and the styles for that part of the page are shown in the Styles tab. The HTML
elements for that part of the page are also highlighted in the DOM Tree.
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Now that you have found the classes that you want to change, you can use the Styles tab to apply
different styles.

NOTE
Some HTML elements are inside "container" elements, which are at a higher level
in the DOM Tree structure. The styles you want to change may be set for the
"container" rather than the individual element.

Change Styles in the Inspection Tool
The Styles tab shows the classes, attributes, and values that the browser applies to the currently
selected HTML element. You can change the values or add extra attributes and values, and see the
results in the browser.

1. Use the selection tool [659] to select the part of the page that you want to change.

2. In the Styles tab, find the classes that you want to change. For example, if you use the default
Help Center Layout and select the "How can we help you today?" heading on the homepage,
you will see styles like this:
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The CSS shown here styles the heading. There are several different classes that are used.

1. This is a media query, which means this style only applies when the content is viewed on a
device with certain attributes, in this case, a screen that is 768px wide or more.
The class name is .portal-header h1 and it has a font-size of 36px. You can change
the font-size to make the portal heading text larger or smaller, and you can add other
attributes and values, such as color.

2. The .portal-header h1 class. These settings apply to elements that have the portal-header
h1 class, but only when the content is viewed on a device that is smaller than 768px wide.
Notice that the font-size here is crossed through. This means it does not apply as the
font-size is being set in a class that takes precedence (the media query .portal header h1
class, which is shown higher up the list).

3. These are general values that apply to heading classes such as h1, h2, h3. Again, if a value
is crossed through, it means that value has been set for another class that takes priority
over this class.

The same principles apply to all elements on a page. You can find out what classes apply and
which styles are used.

3. To make a change, select a value and replace it with the value you want. For some values, the
browser provides a list of possible values you can use.

4. If you want to add an extra attribute and value, position the cursor below the last attribute
and above the closing curly brackets, and then click. A colon appears.

Enter the name of the attribute on the left side of the colon and the value on the right side of
the colon.

5. When you are happy with the changes you have made, add them to your own CSS stylesheet.
When you are finished, upload your CSS to your HTML5 or HTML layout in Paligo [662].

Upload Customized CSS
When you have created a customized CSS file, upload it to your HTML layout in Paligo. The next
time you publish with that layout, your content will use the uploaded CSS file.
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IMPORTANT
When you upload a CSS file, it will replace any CSS file that is currently associated
with the layout.

<step>
Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

</step>
<step>
Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your Paligo
content and the layout settings.

</step>
<step>
Select CSS, JS, logos and other assets.
</step>
<step>
Upload your CSS file in the CSS section.

IMPORTANT
When you upload a CSS file, it will replace any CSS file that is currently associated
with the layout.

NOTE
If you are using an HTML layout rather than an HTML5 layout, the CSS upload
feature is in the General category.

</step>
<step>
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Select Save. 
</step>

Expand All Accordions
If you want all accordions to expand when a page in the HTML5 Helper Center output is loaded,
add the following code to your custom JavaScript:

// Expand accordions
$(document).ready(function () {
    $('.accordion .collapse').collapse('show');
    $('.accordion .panel-heading').addClass('active');

    // Uncomment below if you're using AJAX
    /* $(document).ajaxComplete(function() {
            $('.accordion .collapse').collapse('show');
            $('.accordion .panel-heading').addClass('active');
    }); */
});

NOTE
This script will apply to accordions on any page and will only work for HTML5
Helper Center output.

Vertical Alignment of Inline Images
It is highly recommended that you customize vertical alignment for inline images in your custom
CSS file according to your own use case, as the default CSS will not fit all use cases.

There are so many use cases that no CSS will fit everyone, but as an example below is CSS for
users with perfectly sized icon images without margins. This code positions the images inline with
the bottom of the text. (If you want the icon to be aligned in the middle of the text line, just change
the first vertical-align to "middle" instead of "baseline").

TIP
Read more about possible vertical alignment adjustments, see Mozilla.

1. Add the following code to your CSS file:

.inlinemediaobject img:not([height]):not([width]) {
    height: 80%;
    vertical-align: baseline;
}
.inlinemediaobject {
    vertical-align: baseline;
}

2. Upload your CSS file to your HTML layout, see Upload Customized CSS [662].
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NOTE
If you want to use the @valign attribute on the inline images in your topics
("top", "middle", "bottom"), to have individual vertical alignment for certain inline
images, you would need to either reduce the height value above, or increase
the lineheight of the enclosing block element in your CSS (such as the p tag).
Otherwise such attributes would have no effect as there would be no space for
such alignment.

Minify CSS and JavaScript
For HTML outputs, Paligo has a Minify assets feature that will remove any unnecessary characters
from Paligo's CSS and JavaScript files. The minification process makes the script files more
efficient, and can improve load times by reducing the traffic between the server and clients.

The minification process can change the names of variables used in the Paligo scripts. So if you
have created custom CSS or JS files that reference the variables in a Paligo script, you may need to
disable the Minify Assets feature.

NOTE
The minification does not apply to any custom CSS or JavaScript files that you
upload to the HTML5 layout.

The Minify assets feature is disabled by default, but you can enable it on the HTML layout.

1. In Paligo, select Layout and then select the Layout that you want to use for your HTML5
output.
Paligo displays the layout in the Layout Editor.

2. In the Layout Editor, select CSS, JS, logos and other assets.

3. Find the Minify assets setting and set it to Enabled to turn on minification or to Disable or
Default to turn it off.

4. Select Save.

Context-Sensitive Help
With context-sensitive help, your users can select a part of your product interface to display the
relevant help page. For example, with a software product, you could have an "Info" icon next to a
"Balance" option. When the user selects the "info" icon, the help page about the "Balance" feature
is opened automatically, so they are taken directly to the relevant information.

Traditionally, context-sensitive help is made by creating a mapping file. The mapping file,
sometimes known as a header file, is used to match an id in your product to the id of a page
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in your documentation. Paligo uses this type of approach for HTML5 outputs and creates the
mapping file automatically, as long as you have certain attributes in place.

To set up context-sensitive help, we recommend that you first create a mapping file [666], and
then create a fallback page [668].

NOTE
If you need to publish any other type of context-sensitive help, please contact
support for assistance.

Create a Mapping File for Context-Sensitive Help
To get Paligo to automatically create the mapping file for context-sensitive help:

1. Get the ids for the application components in your product.

2. In Paligo, edit a topic that you want to be used as context-sensitive help for one of the
components in your product.

3. Select the top section element. Paligo then shows the attributes for the section element in
the Element attributes panel.

4. Add the attribute xinfo:appid and enter the id of the relevant application component in
your product.
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If there are multiple components calling the same topic, separate them with semicolons. For
example:
imagedialog_123;imagebrowser_234

TIP
Adding the xinfo:appid attribute to the top section element is the typical
use case. It is also possible to put @xinfo:appid on a sub section inside
a topic. The only requirement is that the sub section also has an @xml:id,
which it would normally have by default.

If you mark up a sub section, the context sensitive help will open the topic
at that location on the page, rather than at the top.

5. Select Save. 

6. Publish your publication [1092]. This creates a JSON file that automatically maps any url
requests to the relevant topic.

7. In your product, your developers can call the context-sensitive help using the internal
application id's as a string parameter. For example:
www.youronlinehelp.com/en/index-en.html?contextId=imagedialog_123
where:

• www.youronlinehelp.com is the domain where you host your published documentation. In
reality, you will have something different, such as your organization's website URL.

• en/index-en.html is the folder and index file for an English version of your documentation.

• ?contextId=imagedialog_123 is the context-sensitive help reference.
The call needs to specify the language folder and the help's index file before the context-
sensitive help reference.
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NOTE
To test the context-sensitive help, either:

• Publish it to your server or a test server (local or web server). This is because
the function of fetching data from JSON requires the content to be on a server
for browser security requirements.

• Select to enable local context-sensitive help in the Layout Editor (under
General). You can enable this temporarily while testing, and then disable it
again when you are ready to publish to your server.

Create a Fallback Page for Context-Sensitive Help
We recommend that you create a fallback page, in case there is a problem with one of your
context-sensitive help links or pages. The fallback page will be shown if the target page of the
context-sensitive link cannot be found.

To create a fallback page for context-sensitive help:

1. Create or edit the topic that you want to use as the fallback page.

2. Select the top section element of the topic and choose Go to element.

3. Add the attribute xinfo:appid and set the value to not_found in Element attributes
panel.

4. Add the attribute role and set the value to notintoc.
This role will prevent the fallback page from appearing in the table of contents.

NOTE
This is an optional, but recommended step.
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5. Select Save. 

6. Publish your publication [1092].
When you publish your publication, the topic will be used as the fallback page. If the browser
cannot find the topic for a context-sensitive help link, it will display the fallback page instead.

Cross-Reference Styling (PDF and HTML5)
Below are some of the options you can use for the settings for cross-reference text in the Layout
Editor.

NOTE
For any of these values to have any effect, you also need to enable the option
Enable cross-reference auto-title customization.

You can customize the generated text by using some keywords in this option. As with all auto-text,
all strings will be automatically translated when you publish to another language.

Example 37. Quoted text with page number and label
labelname quotedtitle page

Result: Section "My Title" (page 15).

Component Keyword Example Description

number label label Table 3 Complete label name and number

labelname Table Just the label name

labelnumber 3 Just the label number

title title My Topic Title Title without quotes

quotedtitle "My Topic Title" Title in quotes

page number unspecified [12] Standard page citation if no value is
given for the page component

page (page 12) Page number in parentheses
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Component Keyword Example Description

pagecomma , page 12 Page number after a comma

NOTE
Note that
this format
is not always
suitable for all
languages, as
some languages
do not use
comma this way.

Page Page 12 Capitalized page label

pageabbrev (p. 12) Abbreviated label in parentheses

pageabbrevcomma , p. 12 Page number after a comma, and page
abbreviated.

NOTE
Not all languages
are supported for
this option, and
depends greatly
on the language
whether it can
be. Make sure
you check for
languages you
translate to.

In many cases
languages can
be added with
a request to
support.

pagenumber 12 Just the page number

nopage  Turn off the page number for the cross-
reference

TIP
You can override the format for individual cross-references by using the xrefstyle
attribute. In that case, use the same values, but start it with "select: ". For
example, select: quotedtitle nopage.

The order of the components does not matter, it will always be label, title, page
(depending on which you use).
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Exclude a Topic from Search (HTML)
You can set up topics so that they are included in your help center, but do not appear as results
in the search. For example, you could use this feature to exclude release notes from the search
results. This is a common requirement, because while the release notes are useful to have in your
documentation, they rarely provide enough detail. So you could make your search more useful by
only including those longer, more detailed topics that give your users the level of information they
need.

NOTE
You can also exclude topics from the navigation sidebar [102] (also known as the
TOC).

To exclude a topic from the search results:

1. Open the topic in the editor and select the section element in the Element Structure Menu.
Then select the Go to element option.
Alternatively, you can click at the very top of the topic, above the title, to select the section
element.

2. In the Element attributes section, add a role attribute and set its value to notinsearch.

NOTE
The role attribute is not inherited. If you have different levels of topics, you
need to add the role to all of the sections that you want to exclude from the
search, not just the section of the top-level topic.
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3. Select Save.

When you publish the topic to your help center, the search will not include the topic in its results.

HTML and XHTML Styling
If you are producing "clean" HTML or XHTML outputs, you can style and customize them in several
ways:

• Edit the settings in the HTML Layout [672].

• Create a custom CSS file and upload it to your layout [654]. It will be applied the next time you
publish with the layout.

HTML Layout Editor Options
The tree of items you can choose to style in the Layout Editor is divided into a number of sections.
Each section is described below, with the items you can style and the options available for them.

Many of the items and options are self-explanatory, and have explanations right in the Layout
Editor. So only the items that may not be immediately transparent are explained below.

NOTE
The options here are only for the clean HTML/XHTML, not for HTML5 [680].
However, it also has options that apply when you choose to create a Zendesk
layout. (Last section)

TIP
Learn how to set the footnote appearance for HTML, HTML5 and SCORM output,
see Footnote Settings [1052].

General

Category Description

CSS Upload your own CSS to modify the default layout.

Make extra clean XHTML The HTML output by default creates a clean valid XHTML.
But it can be further cleaned by using this parameter to
use e.g divs with classes instead of elements to denote
emphasis, and similar.

Default: disabled (0).

Use inline style attributes In some cases, the HTML output will include a style
attribute, such as list style type on lists. If you want to
exclude such attributes too, to only apply external CSS with
classes, using no inline CSS, disable this option.

Default: enabled (1).
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Category Description

Create single page XHTML Multipage: 0, single page: 1.

Default: multipage (0)

Create a title topic for reused publications If you reuse publications within another publication, you
can select whether that publication should be treated as a
top-level topic, or if only it's child topics should be reused.

Only create topic for reused publications if no top-level
topic

With this option enabled, you can mix reused publications
where there is a top-level topic in some (in which case no
title topic will be created for the publication), together with
publications that have no top-level topic (in which case a
title topic will be created for the publication).

Default: Disabled

Re-sort sorted tables automatically on publish Even if you have sorted a table in the editor, re-sorting
them on publish can be useful for example if you publish
to multiple languages (in which case the sort order may be
different), or if you have missed updating the sort before
you publish.

NOTE
This will only affect tables that you
have sorted with the sort commands
in the editor first. 

Default: enabled.

Exclude label for abstract If enabled, the label for an abstract is excluded from
output. This is useful if you do not need it, and if publishing
to multiple formats where hiding it with CSS does not work.

Default: disabled.

Classes and attributes

Category Description

Output taxonomies as class names If enabled, you can get your taxonomy categories into your
output as class names for further processing (e.g by css and
javascript).

Value structure for taxonomy class names You can set whether class names from taxonomies should
output the value and all its descendant values in a
taxonomy tree, just the value itself, or the value and its
parent.

Default: Value and descendants

Paligo Documentation

673



Category Description

Underscore delimiter for taxonomy class names When enabled, an underscore ('_') will be used to separate
the parts of a taxonomy value output for class names in
HTML5, instead of a dash ('-').

For most common purposes this is not necessary, but can
be useful if you need to further process the separate parts
of the value.

Default: disabled (dash is used)

Taxonomy filtering strategy You can set whether taxonomies should be used for
filtering, and whether to output the value and all its
descendant values in a taxonomy tree, or just the value
itself.

If you want to enable taxonomies for filtering, the most
recommended value is to select "Descendants" to take
advantage of the hierarchy of a taxonomy.

Default: Disabled

Output @role attribute as class names If enabled, you can get your role attributes into your output
as class names for further processing (e.g by css and
javascript).

Output profile/filtering attributes as class names If enabled, you can get your profile/filtering attributes into
your output as class names for further processing (e.g by
css and javascript), such as creating "on-the-fly" filtering.

Use @xml:lang as profiling attribute If enabled, the language attribute @xml:lang can be used
for filtering on language (natural languages like Swedish,
Japanese, etc)

Glossary popovers When enabled, glossary terms will display the definition in
a pop over in HTML5 Help Center output, when the user
hovers over it.

Note: This currently has no effect on legacy HTML5.

Default: enabled for Help Center output.

Verbatim (code and software)

Category Description

Use graphics for code callouts If you'd prefer, you can use a graphic for the code callout,
an svg image will then be used. Max 30 callouts with this
option.
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Use unicode symbol for code callouts Another option is to use a unicode symbol for callouts.
If this is set a symbol similar to the graphic and Font
Awesome version will be used. Max 20 callouts with this
option.

NOTE
If all of the above code callout
options are disabled, a simple plain
text output will be used for the
callouts. By default a number within
parentheses like this (1), but this can
be modified in your CSS.

Use Font Awesome glyphs for code callouts If you use calloutlist for annotating code samples, you can
use Font Awesome for the "callout bugs". This is the default
for HTML5.

Images

Category Description

Image Size Set the resolution of the images in your published output.
You can choose from:

• Do not include images (removes all images from your
output)

• Use original images, which keeps the original resolution
of the image file

• Fullsize (2500 x 2500px, 120 dpi)

• Large (800 x 800px, 72dpi)

• Medium (400 x 400px, 72dpi)

• Small (400 x 400px,72dpi).

To find out more, see Image Resolution [307].

Zendesk

Category Description

Fix cross links outside of publication scope When publishing to Zendesk, Paligo will try to resolve even
cross references pointing to content that is not part of the
current publication, so that you can publish to separate
categories one at a time, but have links between them
resolved.
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Create article for the section topic When publishing to Zendesk, Paligo will by default create
a Zendesk article out of the content at the top level topic,
with the same title as the Zendesk 'section' created.

If you only use the top-level topic as a title for the section,
you can disable this. Then only the section title will be
created for that topic, and only the topics below it become
articles.

WARNING

• If you disable this option, to not
have an article created for the
section, you cannot have a single
article with no sub topics in your
publication: each top-level topic
must have at least one level of sub
topics under it.
Publishing with just a single topic
will produce an error on publish.

• If disabling the section article
for existing content that you've
published to Zendesk before
(without this option disabled),
please be aware that you need to
keep the same topics ("forks") in
your publication.
I.e, you cannot rebuild the
publication by dragging the same
topics in again, you need to
rearrange them in the same
publication. Otherwise the topics
will get  new ids, and new
articles will be published instead of
updating the existing ones.
Some rearranging of articles may
also be necessary after first re-
publish.
It is strongly recommended to test
with a dummy publication with
the default (enabled), and then
re-publishing it with the option
disabled, to see the effect.

NOTE
Disabling this will not remove
previously published 'section' articles. 

Default: enabled

Use separate styling for label, number, and title in formal
elements

If enabled, each part of the title for a formal elements, like
a table, example, or figure, will get a span element with
a specific class name, so they can be styled differently or
excluded, using CSS. Default: disabled.
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Remove Header and Footer (HTML Output)
For HTML outputs (not HTML5), you have the option to suppress navigation. When enabled, this
will remove the header and footer navigation from the HTML output. This feature is useful if you
are embedding your Paligo content in a custom application that already has its own navigation
features.

NOTE
The HTML output header navigation is hidden by default via CSS:

.navheader {
    display:none;
}

To enable or disable the navigation suppression:

1. Select Layout and then edit the layout that you are going to use for publishing.
Alternatively, you can create a new HTML layout and edit that.

2. Select Toc and chunking.

3. Set Suppress navigation to:

• Enable to turn on navigation suppression so that the navigation is not shown.

• Disable to turn off navigation suppression so that the navigation is shown.
The default is Disable.
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NOTE
If you enable Suppress navigation, make sure that you provide a way for
users to access the pages in your HTML output. You could use a custom
application to provide the navigation or you can rely on the HTML output's
table of contents.

If you are going to rely on the table of contents, set the TOC section depth
to a higher value than the Chunk section depth. This will mean that all
chunked topics will appear in the table of contents, and so users can navigate
to them. (Chunked topics are topics that appear on their own page in the
HTML output).

If the Chunk section depth is higher than the TOC section depth, there may
be pages that are not shown in the table of contents, and so users cannot
navigate to them.

4. Select Save.

When you publish to HTML using this layout, the output will include or exclude the header and
footer navigation, based on the setting in the layout.

HTML Styling Workflow
To customize and style HTML outputs, use a CSS stylesheet. There are also some general settings
in the HTML layout that affect the output as a whole.

We recommend that you follow these steps to style your HTML:

1. Create your content in Paligo topics and add to a publication. Some parts of the content can
be styled by using attributes, for example, you can set image sizes. But you will apply most of
the styling in the HTML layout and in a CSS stylesheet.

2. Create an HTML5 (or plain HTML) layout or edit an existing one.

3. Use the layout settings to choose your publishing settings. These are "overall" settings that
apply to the content as a whole. You do not set styles such as headings, font sizes, font colors
etc., in the layout. For HTML, you define those in a CSS stylesheet that you can then upload to
your layout.

4. Use a code editor or text editor to create a CSS file. Give it a name and save it with the .css
extension.

5. Give your CSS a simple rule to start with, so that the file is not empty. The rule does not have
to contain any styling yet, for example, you could add:

body {
}

6. Upload your CSS file to the HTML layout.
The CSS setting for uploading your CSS file is in the CSS, JS, logos and other assets section.
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NOTE
You can also use javascript to customize your published output. You can
upload your custom javascript to the HTML layout too.

7. Select Save.

8. Publish any publication that contains a sample of the content that you want to style. When
you publish, use the HTML layout that you edited in steps 2-7.

9. When your content is published, unzip the zip file that is downloaded in your browser.

10. Open the Index.html file to display your HTML output.

11. In the unzipped files, go to the out/en/css folder, and find the custom CSS file that you
uploaded to your layout. It is called "layout-custom-style.css" if you have enabled the
Persistent CSS file name option for your layout. Otherwise, it has a random number ID as
its name.

NOTE
en is the folder for English content. For other languages, there is a different
language code.

12. Open the CSS file in a text or code editor and add rules in the CSS. Then refresh your browser
to see the effects on your help output.

TIP
Use the browser tools to inspect elements and test style changes directly in
the browser, before you add styles to your CSS file. For tips on using the
browser tools, see Branding your HTML Outputs with CSS [654].

13. When you are happy with your styling, upload your customized CSS file to your layout again.
Paligo will apply your new styles the next time you publish.

TIP
For tips on styling a HTML5 help center, see HTML5 Help Center Styling [680].
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HTML5 Help Center Styling
You can create HTML5 help center layouts that produce a stylish, modern help center. With the
default settings in place, the help center has a "hub" homepage which provides links to topics.

You can also use Multiple Publications in the Same Portal [729] which is a help center that
contains several other publications. For example, you could have a main "hub" homepage that
provides links to user guides for several different products.

To customize and style a help center, you can:

• Edit the settings in the HTML5 Layout Editor Options [680].

• Branding your HTML Outputs with CSS [654]. It will be applied the next time you publish with the
layout.

• Add a Custom JavaScript to a Layout [768]. It will be applied the next time you publish with the
layout.

HTML5 Layout Editor Options
The tree of items you can choose to style in the Layout Editor is divided into a number of sections.
Each section is described below, with the items you can style and the options available for them.

Many of the items and options are self-explanatory, and have explanations right in the Layout
Editor. So only the items that may not be immediately transparent are explained below.

TIP
Learn how to set the footnote appearance for HTML, HTML5 and SCORM output,
see Footnote Settings [1052].
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General

Category Description

SEO-friendly
Output Filenames

Enable if you want SEO-friendly link names based on the names of the topics in your output, instead
of unique ids.

The link will also stay permanent if the topic name stays the same (the topic title is irrelevant).

You can change the name of a topic without changing the filename that is produced in the output.
This is useful if you need to keep the existing URL for a page. To change the topic name but keep the
existing filename, add the xinfo:outname attribute to the section element of the topic. Set the value
of the xinfo:outname to the name of the file (not the full URL path) and do not include the .html file
extension.

If the title used to be "Introduction to ACME", the auto-generated output file name would be
"introduction-to-acme.html". If you now change the title to "Introducing ACME", that would change
the output file name to "introducing-acme.html". You can then add xinfo:outname with a value of
"introduction-to-acme" (no extension) to keep the previous output file name.

Use a short and
flat URL structure
for output files

If you have SEO-friendly Output Filenames enabled, output paths will have a nested folder structure,
by default.

Enabling this option will instead create a flat URL structure, generating shorter URL paths. (Always
enabled automatically if you select Ajax loading below)

Default: Disabled

Use output file
names made
from id and SEO
name

When flat URL structure or Ajax loading is enabled, the output file name is based on the title. If you
enable this setting, the output file name will be a combination of the topic id and the title instead, for
example, '123-my-topic.html'.

Default: Disabled

Allow reserved
characters in
output file names

Some characters, such as commas and semicolons are classed as "reserved" characters. Use this
setting to control whether reserved characters can be used in output file names. Set it to Enabled to
allow reserved characters or Disabled to prevent them being used.

Default: Disabled

Reader-friendly
fragment
identifiers (hash
links)

Enable this feature if you want links to subsections to use reader-friendly names instead of unique id
names (UUIDs). For example, www.acme.com/docs/introduction.html#getting-started. Note that you
also need to have the SEO-friendly Output File Names feature enabled.

Disable this feature if you want the output to use unique id names.

Default: Disabled

To find out more, see Reader-Friendly URLs for Subsections [174].

Preserve legacy
anchors if
using reader-
friendly fragment
identifiers

Enable this feature if you are using reader-friendly hash links and you want to support:

• Existing links to subsections, where the links use the UUID of the subsection not the new reader-
friendly URL

• New links to subsections, where the links use the new reader-friendly URL.

Disable this feature if you are using reader-friendly hash links and you do not want to support
existing links that use the UUID. If there are links that use the UUID, they will no longer work.

Default: Disabled

To find out more, see Reader-Friendly URLs for Subsections [174].
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Multiple
publication portal
prefix

Enable this setting if you:

• Publish multiple publications in one help center portal

and

• Have publications that reuse other publications (i.e. have reused subpublications).

When this setting is enabled, the output names for the sub-publications are unique, as Paligo adds
the publication id to the output file name.

Disable this setting if the two points we have described do not apply to your content.

Default: Disabled

Use resource
name instead of
title for HTML
output filename

Use to control whether Paligo uses the topic name (resource name) or the title name when it creates
the output file name for topics. Set to Enabled to use the topic name or Disabled to use the title.

Note that this setting applies to all topics. If you only want certain topics to use the topic name, you
can give those topics the xinfo:outname attribute instead. Then set the attribute value to the name of
the topic.

Default: Disabled

Keep the letter
case of the title
for the HTML
output file name

Use this setting to control whether output names are all lower case or can use upper case letters too.
By default, the output file names only use lower case letters, for example, my-topic.html.

Set to Disabled for lower case only or Enabled to allow upper case letters. We recommend that you
only set this to Enabled if you have a specific reason for using upper case letters.

Default: Disabled

Ajax load content When enabled, the HTML content will be dynamically loaded for each page, making the page
switching very fast.

Note that you have to publish the output on a server for this to work.

Default: disabled.

Enable local
context-sensitive
help

You do not have to enable this to get context-sensitive help. It is by default enabled, but the default
requires the content to be published on a web server, which is the most common.

If, however, you have a requirement to have the context-sensitivity work on a local help package
without a web server, you can enable this option.

Default: Disabled
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Category Description

Custom meta tags Enter global custom meta tags as key-value pairs (name/content) here.

E.g to add a 'noindex' tag, to exclude web site from search engine indexing, you would enter
'robots:noindex, follow;' End each key-value pair with a semi colon.

NOTE
Only for global tags. Specific meta tags can be added directly in your topic.
Meta keyword tags can be added through a keywordset element with
keyword elements in your topics. And meta description tags can be added
by using an abstract element (inside an info element after the title).

If you use the abstract to output meta description tags, you may also want to
add custom CSS to not display it, unless you want that abstract to appear also
in the content page itself. Use filtering by @outputformat if you don't want it
to appear in other output, such as PDF.

Default: Disabled

Create a title
topic for reused
publications

If you reuse publications within another publication, you can select whether that publication should
be treated as a top-level topic, or if only it's child topics should be reused.

Only create
topic for reused
publications if no
top-level topic

With this option enabled, you can mix reused publications where there is a top-level topic in some (in
which case no title topic will be created for the publication), together with publications that have no
top-level topic (in which case a title topic will be created for the publication).

Default: Disabled

Format output Usually not required, but if desired, HTML Tidy will be applied on the output to ensure strict XHTML
format.

Copy anchor URL
on click

When enabled, a link icon appears when you hover over a heading in the middle of a page. Clicking it
copies the anchor url to the clipboard for easy sharing of a section.

Default: Disabled

Update URL on
scroll

When enabled, the url in the browser address field will update as you scroll down a page to sub
sections. This makes it easy to copy the url for any part of the content and improves usability.

This is normally a good idea, and the default is only disabled for backward compatibility. Default:
disabled.

Company name Will be used for copyright label if added, e.g in the Help Center output.

Copyright year Only add this if you do not want the current year automatically used, which is the default.

Note that if you have a copyright element inside the publication, that will override this.
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Last modified
date

If you add a date format here, the last modified date for each topic will be output in the page footer.

E.g 'm/d/Y' (no quotes) for '03/25/2018', 'Y-m-d' for '2018-03-25', or 'F j, Y' for 'March 25, 2018'.

Leave empty to exclude the date.

Today's date for
publication date

If you add an empty pubdate element in your publication, and add a date format here, today's date
will be added to your output in the index-en.html file (or equivalent for other languages).

E.g 'm/d/Y' (no quotes) for '03/25/2018', 'Y-m-d' for '2018-03-25', or 'F j, Y' for 'March 25, 2018'.

Leave empty to exclude the date.

Color-mark
non-approved
translations

If the source language has changed since last translation, you can have this indicated with blue
highlighting in the output (for draft publishing).

CSS, JS, Logos and Other Assets

Category Description

Logotype Add your logotype to replace the Paligo logo in the output. Use CSS to style it.

For the Help Center output this is only used in the content pages. Set the portal page logo below.

Help Center
portal page
logotype

Set the logo to use for the portal page.

This can be different than the one used on the main content pages to match the theme.

Logo link By default, the logo in your HTML5 output will go to the main home page of the help itself. If you want
it to go somewhere else, such as to your company home page, enter a URL here.

NOTE
This option should only be used if you are not using the portal page, or have
another (customized) home link, as there will otherwise be no way to get back
to that page.

Leave empty to use the default.

Open external
logo link in the
same tab

If you have selected a logo link (see Logo link setting), the link will open in a new tab by default. But
you can change that behavior by using the Open external logo link in the same tab setting. Choose
enable to open the link in the same tab or disable or default to open the link in a new tab.

CSS Upload your own CSS to modify the default layout.

Persistent custom
CSS filename

By default, your custom CSS file will get a unique name, everytime you upload a new update. The
unique name is generated when you publish.

To keep the same CSS file name and prevent it from changing, set Persistent custom CSS filename
to Enabled. The CSS file name will then be set to 'layout-custom-style.css' and it will not change.

Default: disabled.
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Help Center
portal page
background
image

This image will be used for the header banner (or "hero") section of the portal page.

Custom javascript You can upload your own javascript to add functionality to your HTML5 output

Global custom
javascript

Use this option to add a reference to a file called 'user-custom-script.js' to every HTML file in the
output. You can then add the 'user-custom-script.js' file to the output after it is published.

In most cases, it is more convenient to upload your custom JavaScript file to the layout (using the
Custom javascript option. But if you want to use the same javascript with a number of different
layouts, you may prefer to use the Global custom javascript feature instead, so that you do not have
to upload and update it separately for every layout.

Select jQuery
version

Use to choose the version of jQuery that Paligo should use for the output.

The default is 3.4.1 but you can change to another version if you need:

• javascript plugins that need a specific version

• special browsers or browser configurations

• security features that are only available in specific versions.

Place scripts at
the end of the
body tag

Use to control where scripts are added in the HTML output. Typically, you would only change this
setting if you are using javascript that has to be run after the body of the page has loaded.

For details, see Set the Position of JavaScript References [788].

Avoid cached JS
and CSS on
republishing

Choose enabled if you have made changes to the CSS or JS for your help center and you need these
changes to apply immediately when you publish. Note that the CSS and JS files will be given different
filenames to those used previously.

Set to disabled or default if you do not want the browser to reload the assets and apply the recent
changes. For example, if you have a custom webserver configuration that handles caching.

Add a Favicon Upload an .ico or .png file here to use as your favicon. Even if you use .png, make sure to name your
file 'favicon.ico' for it to be recognized. The favicon will only be visible when published on a web
server.

Custom favicon
path

If you publish your help to a subfolder on a domain, enter the path to the folder of your help here.
Use either an absolute web URL or a slash to specify the root of the server.

Leave this field blank if you publish your help to the root of the web domain.

Add a robots.txt
file

Upload a robots.txt file here to give instructions about your published site to web robots. The file
will be placed in the root folder of your published output.

For details, see Upload a Robots.txt File [789].

Create sitemap If you want a sitemap.xml file for SEO and search engine crawling, enable this option.

Note: to use this option, you also need to provide the destination domain below. Default: disabled
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Publishing
destination path

If you want to publish a sitemap.xml file, you also need to add the final destination domain where
you will publish your content. Paligo will use this to provide the full absolute path of each topic in the
sitemap.xml file.

For example: http://www.acme.com/acme1000/onlinehelp/

Add canonical
URL link

Use this option if you need to:

• Consolidate duplicate URLs with a canonical URL link

• Drop "index.html" from the URL on the landing page (for HTML5 help centers)

For details, see Add a Canonical URL Link [785].

Help Center Theme Options

Category Description

Base theme There are a number of base themes to choose from for the Help Center output. Choose the one you
want to base your own layout on.

Content theme Besides the main base theme, you can also choose between different content themes, affecting mainly
the body content, such as the styling of admonitions, lists, etc.

Sticky header For the Help Center themes, you can enable a sticky header that is always visible when you scroll.
Default: disabled

Full width header For the Help Center themes, you can make the header in the main content pages full width. Default:
disabled

Graphical lists For the "Help Center" output only: When enabled, graphical numbers are used for procedures, etc (can
be further customized by CSS). Default: enabled

Search Engine

Category Description

Use Algolia search If you want to use the high-end Algolia search engine in your help output, enable this.
(Requires separate Algolia subscription).

Elastic Search (Swiftype) If you prefer a crawler-based indexing search engine, Elastic Search (Swiftype) is another
powerful option.

To enable Swiftype, add the key (only) from the code snippet in the Swiftype control panel.

Use fuzzy search If you do not want to use Algolia, and the default search is not your preference, the fuzzy
search is another built-in option.

Use multilingual support
for default search

If using the default search, but you need support for multiple languages, enable this.
Disabled by default since it adds unnecessary files if you don't have the need for multilingual
publishing.
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Include excerpt snippets Applies to default search or fuzzy search, if you use one of them you should normally enable
it. Disabled by default only for backward compatibility. Algolia search always has snippets by
default.

Use breadcrumbs path in
search results

If you use the snippets option (required for this option), you will also get a path for the
result topic. This can be the exact path with the HTML file name, or a more user-friendly
breadcrumbs path with the titles of the topics.

Default: Breadcrumbs made from titles enabled.

NOTE
Single page outputs do not have a search.

Feedback

Category Description

Use voting
panel NOTE

This option is currently only available for the Help Center output (Only for the
main Help Center output, not available for the 'Preloaded' variant).

If this is enabled, your users will see a panel asking if they found a help page useful or not, with a 'Yes'
and 'No' button to respond, like this:

The buttons have unique ids so you can collect the data through an analytics tool.

To track the number of clicks on Yes or No, you can use the analytics tool of your choice. As an example,
see this page for how to do this in Google Analytics Tag Manager: Google Analytics events.

Default: Disabled

Allow users to
submit
feedback
(suggest edits)

If this is enabled, your users will be allowed to submit feedback to you or suggest edits to a help page. By
default the feedback will be by email. Other types of feedback can be purchased as a customization.

Default: Disabled
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Category Description

Toggle
feedback with
voting panel

NOTE
This option is currently only available for the Help Center output (Only for the
main Help Center output, not available for the 'Preloaded' variant).

If using the voting panel, choose whether the link to provide feedback should be toggled on 'No', both
'Yes' and 'No', or always visible.

Default: Toggle on the 'No' button.

Email for
feedback

Enter an email address here if you want your users to email you feedback.

Analytics and Other Integrations

Category Description

Use cookie
consent popup

If you are using any of the integrations below you should enable this popup to comply with legal
regulations, such as the EU GDPR law.

You have the strict option where the user can opt out completely, or just the informational.

WARNING
Paligo disclaims any responsibility for your output complying with cookie
regulations, and it is up to you to ascertain that the output does not violate
any cookie regulations or similar, with or without this popup enabled.

Privacy policy
link

If you use the cookie consent popup, you must enter the URL to your privacy policy here.

Google Analytics Add your property id (or "tracking id") to connect Google Analytics to your HTML5 output. Also select
whether you want to use the analytics.js tag or the global site tag (default).

Mixpanel
tracking

If you want to integrate with Mixpanel analytics.

Disqus
comments

To get a section at the bottom of each topic with discussion threads, where users can add feedback,
enable this with your Disqus domain.

Intercom chat If you use Intercom, you can add the chat widget here to communicate live with your customers as
they browse your help site.

Use Lightbox for
images

If enabled, clicking images in the HTML5 output will enlarge them to full size. Default: disabled for
legacy HTML5, enabled for the Help Center output.
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Category Description

Use thumbnails
for all
mediaobject
(block) images

If enabled, every image in the HTML5 output will be rendered as a small thumbnail (for content where
you want to reduce the space images take up).

It may be more common to only want certain images as thumbnails. If so, just leave this option
disabled and set it individually in certain images:

• Either select the image or the mediaobject, and use the keyboard shortcut Alt Shift Q .

(The image will display in a smaller size to show it's been set as a thumbnail)

• Or set the @role attribute manually on the mediaobject element (not the imagedata) to "img-
thumbnail".

Default width for thumbnails is 200px. You can change that in your custom CSS if you want.

If you already have a @role attribute on the mediaobject, separate the values with a semi-colon.

NOTE
You must have the "Output @role attribute as class names" option enabled for
this to work.

If using thumbnails on images, you should also make sure you have the Lightbox
option enabled.

Example 38. Thumbnail with lightbox

TOC and Chunking
TOC settings are for controlling options for the Table of Contents in your output.

Chunking settings are for controlling the size of your topics in the HTML output. They define
whether a topic appears on a page on its own, or can be a subsection of another page. To find out
more about using chunking, see Use Chunking to Control Subsections [167].

Category Description

Standalone TOC If enabled, the Table of Contents will not be created inside each HTML file, but rather as a standalone
file, inserted by javascript when rendering the page. This makes HTML files smaller and so they will
load faster in the browser. Faster page loading times are better for SEO.

For details, see Include TOC in HTML or Load Standalone TOC [787].

Default: Disabled
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Category Description

TOC section
depth

Use to define the number of levels in your table of contents. For example, if you set it to 4, the table
of contents will show links for topics that are at level 1, 2, 3, and 4 in your publication. The levels are
nested in your table of contents to reflect the publication structure. Any topics that are at a lower level
than that are not shown in the table of contents, but still exist in your output.

Default: 3.

Only include
chunks in TOC

If enabled, only those topics which become chunks (according to your settings) will be included in the
TOC. Chunks are topics that are on their own web page and cannot be subsections of other topics.

If you enable this setting, any internal section elements in a topic will not be included in the TOC.

Default: Disabled

Chunk section
depth

A chunk is a topic that is always on its own web page in the output. With the Chunk section depth
setting, you can set all topics to be a chunk up to a certain level in the publication. For example, if you
set the chunk section depth to 4, all topics from level 1-4 in your publication will be on their own page.

Once the chunk section level is reached, any lower level topics will be added as subsections of their
immediate parent topic.

Each section element can have an xinfo:chunk attribute that controls whether that section is a
chunk. It can be set to yes, no, or default. This takes priority over the Chunk section depth setting in
your layout.

NOTE
If you have publications nested inside other publications (sub-publications), each
level of publication also counts as a chunking level. For example, let's say
you have a publication, a sub-publication, and four levels of topics in the sub-
publication. You want the topics to be chunked at two levels. For this, you would
set the Chunk section depth to 4 (1 for the publication, 1 for the sub-publication,
1 for the top-level topics in the sub-publication, 1 for the second-level topics).

Default: 3.

Chunk first
sections

If enabled, a chunk will be created for the first top-level section elements in each component.
Otherwise, that section will be part of the chunk for its parent.

Default: Enabled.

Use legacy
section chunking

This should in most cases be disabled. But if you want to enable legacy chunking, where any section
element, whether an internal element in a topic or not, would be treated just like a topic, you can
enable this.

Default: Disabled

Use section TOC With this enabled, you get a 'mini' TOC (Table of Contents) in each output topic. There are a few
options: legacy, which produces a list of the direct child sections and the title 'Additional links', 'After'
or 'Before', which produces a hierarchical list of the level of sub topics according to your TOC section
depth, or 'None' if you don't want one at all.

Default: legacy.
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Category Description

Focus on current
section on click

Use this setting to control the behavior of the table of contents (TOC) in the published output.

If you set this to enabled or default, and then select a sub-level topic, the TOC will collapse all "sibling"
topics (topics at the same level as the topic you have selected). For example, let's say you have a TOC
with 5 levels of topics. If you navigate down to the 5th level and select a topic, the TOC will update and
show Levels 1-4 open, but level 5 closed.

If you set Focus on current section on click to disabled, it creates a "sticky menu". This is where all
levels of the TOC, from the top level to the topic you select, are opened. The TOC does not collapse the
"sibling" topics.

NOTE
This setting requires Ajax load content to be enabled in the General settings.
Ajax loading only works on a web server. If you want to test locally, you will need
to start a local server on your computer.

Use H1 headings
for topic chunks

Use to control whether topic headings:

• Follow the structure of the publication, so most topics will start with a heading lower than H1

• Must start with an H1 heading, irrespective of the topic's position in the publication structure.

For details, see Use H1 Headings for HTML Pages [777].

Default: Publication hierarchy.

Use a separate
list of related
topics

If you want the list of separate topics to be separate from the "Section TOC" (list of child topics), this
should be enabled.

See for selecting a taxonomy to use for selecting related topics.

Default: Enabled.

Include child
topics in related
topics section

If you are categorizing topics as related, and some of these topics happen to also be child topics of a
related topic, you can choose to exclude such child topics here. Otherwise, if you also use the "Section
TOC", which by default lists all child topics, you might get duplicate topics.

See for selecting a taxonomy to use for selecting related topics.

Default: Disabled
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Category Description

Use page TOC Add a small page navigation (Table of Contents) for only the headings in the current page that
highlights when you scroll.

NOTE
If you enable this, you should normally also enable 'Only include chunks in TOC',
so headings in a single page are not displayed in the main navigation.

This is currently only available for HTML5 Help Center theme 1 and 2 (not the
"Preloaded" version).

Default: Disabled

Top navigation If you want to use a top navigation menu in your Help Center theme, enable this. You can select topics
by using role attribute set to 'top-nav-link' or a taxonomy value named top-nav-link or Top nav
link.

NOTE
You must have enabled 'Output role attribute as class names' and/or 'Output
taxonomies' for this to work. If you only want external links, you set them below.
Both types of top nav links can also be combined.

Default: Disabled

Top navigation
depth

If top navigation is enabled, and topics have been selected as top nav links, select the depth of links
here. If a topic has child topics that are chunked, the child topics will become a dropdown menu.

Default: 2

External top
navigation links

If you have enabled top navigation and want to use links to external sites, add them here in the format
text:MyLinkText, url:https://www.myurl.com;. (Make sure you don't use extra spaces, and
note the separators).

Separate text and url with a comma, and end each link with a semicolon. These characters are special
characters and must not be used in the text or url themselves.

Default: none (empty)
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Category Description

Use translation
strings for
external top
navigation link
text

For external top navigation links, it is possible to have some such strings translated automatically.

These strings need to be available in the default translation strings configuration, or added to a
customization (on applicable plans).

For example, if this option is enabled, using the string contact.support will generate the text
"Contact support" in the language currently being published. Not all languages are supported for all
available strings. Contact support to request if a string translation can be added.

Default: Disabled

Use section
numbering

If you want section numbering in your HTML5 output, enable this option.

Default: Disabled

Section
numbering max
depth

When section numbering is enabled, you can select the depth for which numbering is applied.

Default: level 8

TOC sidebar
placement
(single page
HTML5 only)

For the single page HTML5 output, the TOC sidebar is place on the right by default. Select whether to
place the Table of Contents sidebar on the left or right here.

Default: Right

NOTE
The chunking options have no effect on single-page HTML5 outputs, as the output is all one large chunk
in that case.

Classes and Attributes

Category Description

Output taxonomies When enabled, taxonomies will be part of the output, and is automatically propagated as class
names. If this option is enabled, taxonomies can also be used for filtering and more below.

Default: Disabled

Value structure for
taxonomy class
names

You can set whether class names from taxonomies should output the value and all its descendant
values in a taxonomy tree, just the value itself, or the value and its parent.

Default: Value and descendants

Underscore delimiter
for taxonomy class
names

When enabled, an underscore ('_') will be used to separate the parts of a taxonomy value output
for class names in HTML5, instead of a dash ('-').

For most common purposes this is not necessary, but can be useful if you need to further process
the separate parts of the value.

Default: Disabled
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Category Description

Taxonomy filtering
strategy

You can set whether taxonomies should be used for filtering, and whether to output the value
and all its descendant values in a taxonomy tree, or just the value itself.

If you want to enable taxonomies for filtering, the most recommended value is to select
"Descendants" to take advantage of the hierarchy of a taxonomy.

Default: Disabled

Relationship
taxonomy

Select any taxonomy to create relationship links.

Enter the exact name of the taxonomy node (usually the root of a sub tree right under
Taxonomies). Separate multiple names with a semicolon. Leave empty if you don't want to use
taxonomies for relationship links.

See TOC and Chunking [689] for options how to output the related topic links in your output.

Default: none (empty)

Create HTML meta
tags from taxonomies

Creates meta tags with the root (name) of the taxonomy tree as the name attribute, and the value
as the content attribute. Multiple values will be separated by a comma. The 'Output taxonomies'
option must also be enabled.

Default: Disabled

Output @role
attribute as class
names

If enabled, you can get your role attributes into your output as class names for further processing
(e.g by css and javascript).

Output profile/
filtering attributes as
class names

If enabled, you can get your profile/filtering attributes into your output as class names for further
processing (e.g by css and javascript), such as creating "on-the-fly" filtering.

Use @xml:lang as
profiling attribute

If enabled, the language attribute @xml:lang can be used for filtering on language (natural
languages like Swedish, Japanese, etc)

Glossary popovers When enabled, glossary terms will display the definition in a pop over in HTML5 Help Center
output, when the user hovers over it.

Note: This currently has no effect on legacy HTML5.

Default: enabled for Help Center output.

Table Styles

Category Description

Output classes for
styling of tables

It is recommended to enable this setting. The only reason it is not enabled by default is for backward
compatibility.

Enabling it will make the publish process output class names and these will be used for e.g borders,
rather than obsolete attributes for borders and rules.

Frame options For either table or informaltable, set the frame (the border around the entire table) default.

For no frame, set "void". For frame around the entire table, set "border" or "box".

See this page for more on the options: Table options
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Category Description

Rules options For either table or informaltable, set the rules (the border between cells) default.

For no border, set "none". For borders between all cells, set "all".

See this page for more on the options: Table options

Re-sort
sorted tables
automatically on
publish

Even if you have sorted a table in the editor, re-sorting them on publish can be useful for example
if you publish to multiple languages (in which case the sort order may be different), or if you have
missed updating the sort before you publish.

NOTE
This will only affect tables that you have sorted with the sort commands in the
editor first. 

Default: enabled.

Extra responsive
table features

Use to give tables extra responsive features. These include a column filter button so that readers can
control which table columns are shown and a sticky table header.

You can use the features for all tables, selected tables only, or turn the extra responsive features off.
To find out more, see Column Filter and Sticky Header for Tables [774].

Default: Disabled

Formal Elements
The term Formal elements comes from the content model. It basically is an umbrella term for
elements like lists, figures, tables, equations, examples. In this section you can make general
settings applying to all such elements consistently if desired.

Note that any settings you make on a higher level (General) can be overridden if you set another
value on a lower level (like "informalexample")

Most options are self-explanatory and not described here.

Category Description

Use separate styling for
label, number, and title in
formal elements

If enabled, each part of the title for a formal elements, like a table, example, or figure, will get
a span element with a specific class name, so they can be styled differently or excluded, using
CSS.

Default: Disabled

Restart auto-label
numbering

If enabled, tables, figures, and examples will restart their numbering for each topic, section
(including internal sections inside topics), or chunk.

Default: continuous numbering throughout the publication.

Exclude label for abstract If enabled, the label for an abstract is excluded from output. This is useful if you do not need
it, and if publishing to multiple formats where hiding it with CSS does not work.

Default: Disabled
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Images

Category Description

Image title
attribute

Use to output a title attribute on the image in your output. The title appears in a tooltip when you over
over the image (in the output).

Default: Disabled

To find out more, see Hover Text using the Image Title [359].

Use lightbox for
images

Use to enable or disable the lightbox feature for images in your output. When lightbox is enabled, you
can select an image in the published output and the image will display at full size. If lightbox is disabled,
selecting the image has no effect.

Default: Enabled for HTML5 help center. Disabled for legacy HTML layouts.

To find out more, see Lightbox for Images [360].

Use thumbnails
for all
mediaobject
(block) images

Use to control whether every image in the HTML5 output appears as a small "thumbnail" image.
Enabling this feature is useful if you want to reduce the amount of space that images use on the page.
But note that this setting applies to all images.

NOTE
If you want to use thumbnails on all images, you should also make sure you have
the Use lightbox for images option enabled.

You may find it more useful to apply thumbnails to only certain images, rather than all of them.
To do this, leave this setting disabled and then add a role attribute to the images you want to
have thumbnails. Set the role attribute on the mediaobject element and give it the value: img-
thumbnail.

Default width for thumbnails is 250px. You can change that in your custom CSS if you want.

Default: Disabled

To find out more, see Thumbnail Images [361].

Image size Set the resolution of the images in your published output. You can choose from:

• Do not include images (removes all images from your output)

• Use original images, which keeps the original resolution of the image file

• Fullsize (2500 x 2500px, 120 dpi)

• Large (800 x 800px, 72dpi)

• Medium (400 x 400px, 72dpi)

• Small (400 x 400px,72dpi).

To find out more, see Image Resolution [307].
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Cross-references

Category Description

Enable cross-reference
auto-title customization

When enabled, the cross-reference auto-title customizations below can be used. Otherwise
legacy cross-reference auto-text is used, or any stylesheet customization you may have.

Default: Disabled

Cross-reference auto-
title

Determines the format of the generated text for cross-references.

See Cross-Reference Styling (PDF and HTML5) [669] for options available.

Default: 'title page', which produces a format like 'My Topic Title (page x)'.

Cross-reference auto-
title for formal
elements

Determines the format of the generated text for cross-references for formal elements (like
tables, figures, examples).

See Cross-Reference Styling (PDF and HTML5) [669] for options available.

Default: 'default', which produces a format like 'Example 5, "My Title"'.

Cross-reference label/
title separator

Punctuation or space separating label (if used) from title in cross-references, when the auto-title
parameter above is set.

NOTE
For a space, use 's' (without the quotes).

Default: ':s', which produces a format like 'Example 5: "My Title"'.

Verbatim (code and software)

Category Description

Highlight verbatim
elements

Enable syntax highlighting for code elements.

Highlight theme Select the theme for your syntax highlighting (many different background colors and highlighting
themes)

Use Font Awesome
glyphs for code
callouts

If you use calloutlist for annotating code samples, you can use Font Awesome for the "callout
bugs". This is the default for HTML5.

Use graphics for
code callouts

If you'd prefer, you can use a graphic for the code callout, an svg image will then be used. Max 30
callouts with this option.
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Category Description

Use unicode symbol
for code callouts

Another option is to use a unicode symbol for callouts. If this is set a symbol similar to the graphic
and Font Awesome version will be used. Max 20 callouts with this option.

NOTE
If all of the above code callout options are disabled, a simple plain text
output will be used for the callouts. By default a number within parentheses
like this (1), but this can be modified in your CSS.

Use code switcher
for API style layout

Enabled by default. Only disable e.g if you need to mix programming languages in the same output
and always show all samples without the user switching.

Graphical rendering
of keycap

Use this if you want the keycap elements to render as a keyboard key, like so: Alt Shift V .

Themes for HTML5 Help Centers
Paligo provides several different themes that you can use for your HTML5 help center. Each theme
provides a different look and feel, and you can use your own custom CSS to change them to meet
your requirements. There are also themes for the content too, and these set the default styling for
the content, such as notes and other elements.

You select the themes on the layout for your HTML5 help center. They are in the Help Center
themes options category, and there is a Base theme for choosing the style of the HTML5 help
center and a Content theme for choosing the style of the content.

There are several base themes to choose from, including:

• Theme 0 - A "bare bones" theme that you can use as a template. With this theme, you will need
to use a custom CSS stylesheet to define the positioning of the various sections, color schemes,
etc.

• Theme 1 - This has a blue and orange color scheme by default (can be overridden in CSS with
any colors you choose). This theme has a typical help center look, and the inner content pages
has the search field in the navigation sidebar.
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• Theme 2 - Is similar to theme 1, but with some variations on the portal page, and the inner
content pages have the search field in the top banner instead of the navigation sidebar.

• Theme 3 - This theme has a body content panel with a box shadow look. This variant uses a pink
and blue color scheme by default (completely customizable as all themes).

• Theme 3b - The same as theme 3, with a slight color theme variation. If you like theme 3, and
intend to customize the color scheme it doesn't matter if you choose theme 3 or 3b.
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You can use themes 1, 2, 3, and 3b as they are or you can use your own custom CSS to change
them.

For the Content Themes, you can choose from Theme 1 or Theme 2.

To find out about uploading custom CSS files to your HTML5 layout, see Branding your HTML
Outputs with CSS [654].

To learn about layouts and how they are used when publishing content, see Layouts [1054].

Portal Page Styles
The HTML5 Help Center has a portal page, which is the first page you see when you launch the
index.html file for the help center. You can use CSS, javascript, and attributes in Paligo to change
the appearance of the various elements on the portal page, including the header, the category
panels, and the category list.

The HTML5 Help Center page using the default CSS stylesheets.

For many of the features of the portal page, you will use CSS to change the appearance. If you are
unfamiliar with CSS stylesheets and working with the browser's inspection tool, you can find more
information here: Branding your HTML Outputs with CSS [654].

To help you style your portal page, we have included sections that explain how to make the most
commonly requested changes. These include changing the font colors, background images, and
choosing which topics appear in the categories list.
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Portal Welcome Text
The HTML Help center's portal page has a welcome message at the top. By default, it is "How can
we help you today?", but you can use javascript to change it to any text you like.

The following code shows the javascript you can use. We have included an example of a
translation as well, in this case, Japanese, so that you can see how it can be handled for other
languages. For each language you want to use, add another language line and text.

The javascript is:

$(document).ready(function () {
    setWelcomeText();
    $(document).ajaxComplete(function () {
    setWelcomeText();
    });
});

function setWelcomeText(){
    for (var key in welcomeTextDict) {
        var element = $("header.portal-header[data-portal-
language=" + key +"] h1");
        element.text(welcomeTextDict[key])
    }
}
var welcomeTextDict = { "en" : "Text displayed in English",
                        "ja" : "Text displayed in Japanese"};

The only parts you need to change are at the end of the script:
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• The "en" : "Text displayed in English" part defines the language (en) and then the text that will
be used for that langage. So change "Text displayed in English" to the text you want your English
language version of the portal page to use, for example, "Welcome to ACME Help".

• The "ja" : "Text displayed in Japanese" is an example of the code you need for translations. For
each language, add the HTML language code and then the text you want to use. For example, if
you wanted a French version, you would add "fr" : "Bienvenue à l'aide d'acme"

Note that the }; goes after the last translation and is not needed for each line.

Use that javascript and either add it to your existing custom javascript or use a text editor or code
editor to create a new javascript file. It must have the .js filename suffix. Then upload the javascript
file to your HTML5 help center layout before publishing (for details, see Add a Custom JavaScript to
a Layout [768]).

Portal Heading Styles
You can use CSS to change the styling of the main "How can we help you today?" heading on your
HTML5 help center's portal page. For example, you can change the font, the font size, and the
color.

Heading with different font, font size, and color.

Here, we will cover some of the main attributes that you can change for the heading. But there
are many more, including margins. If you want to make changes that are not covered here, we
recommend that you use the browser's inspection tools [654] to find the heading classes and
experiment with changing the attributes and values.

Portal Heading Color
To change the portal heading color:

1. Use a code/text editor to create a custom CSS stylesheet file (or edit an existing CSS file that
you use for Paligo). Add the following to your CSS stylesheet file:

.portal-header h1 {
color: #ff8c00;
}

Where #ff8c00 is the HTML code for the color you want to use. In this example, we have used
the code for dark orange.

2. Save your CSS stylesheet file with the .css file extension, for example, mystyles.css.

3. Select the Layout tab in the top menu.
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Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

4. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

5. Select CSS, JS, logos and other assets.

6. Upload your CSS file in the CSS section.

IMPORTANT
When you upload a CSS file, it will replace any CSS file that is currently
associated with the layout.

NOTE
If you are using an HTML layout rather than an HTML5 layout, the CSS upload
feature is in the General category.

7. Select Save. 

Portal Heading Font
You can use CSS to change the font that is used for the "How can we help you today?" heading on
the help center portal page.

1. Use a code/text editor to create a custom CSS stylesheet file (or edit an existing CSS file that
you use for Paligo). Add the following to your CSS stylesheet file:

.portal-header h1 {
font-family:"Times New Roman", Times, serif;
}

Where "Times New Roman", Times, serif is the definition for the font you want to use. In
this example, we have used Times New Roman, with Times used if Times New Roman is
unavailable, and a serif font as a fallback option.
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2. Save your CSS stylesheet file with the .css file extension, for example, mystyles.css.

3. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

4. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

5. Select CSS, JS, logos and other assets.

6. Upload your CSS file in the CSS section.

IMPORTANT
When you upload a CSS file, it will replace any CSS file that is currently
associated with the layout.

NOTE
If you are using an HTML layout rather than an HTML5 layout, the CSS upload
feature is in the General category.

7. Select Save. 

Portal Heading Font Size
You can use CSS to change the size of the "How can we help you today?" heading on the help
center portal page.

1. Use a code/text editor to create a custom CSS stylesheet file (or edit an existing CSS file that
you use for Paligo). Add the following to your CSS stylesheet file:

@media (min-width: 768px).portal-header h1 {
font-size: 60px;
}

.portal-header h1 {
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font-size: 30px;
}

The first CSS class uses a media query. In this case, if the content is viewed on a display that is
768 pixels or more, the portal-header h1 will use a font size of 60px.
The second CSS class defines the size for the portal-header h1 class if the page is viewed on a
display that is less than 768 pixels. In this case, it will use a font size of 30px.
Replace the font size values with the sizes you want to use.

2. Save your CSS stylesheet file with the .css file extension, for example, mystyles.css.

3. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

4. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

5. Select CSS, JS, logos and other assets.

6. Upload your CSS file in the CSS section.

IMPORTANT
When you upload a CSS file, it will replace any CSS file that is currently
associated with the layout.

NOTE
If you are using an HTML layout rather than an HTML5 layout, the CSS upload
feature is in the General category.

7. Select Save. 

Portal Background
The HTML5 help center has a background photo with a blue overlay by default. You can use CSS to
change these by uploading a different image and applying a different overlay color.
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TIP
There are several images included in the theme and you can find them in the
css/image folder of your published output. You can upload these images to the
layout to try them out, or you can upload your own images.

You can change the image, change the overlay color, or both. If you prefer, you can remove the
background image completely.

Portal Background Image
You can use the HTML5 help center layout to change the background image that is shown in the
top section of the HTML5 help center portal page.

The default HTML5 Help Center has an image and a blue
overlay color. A customized HTML5 help center with a different image and

gray overlay color.

To change the portal background image:

1. Select Layout in the top menu and either create a new HTML5 help center layout or edit an
existing HTML5 help center layout.

2. Select CS, JS, logos and other assets.
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3. Select Upload in the Help Center Portal Background Image box. Drag the image file that
you want to use into the dialog.
Paligo will upload the image file and assign a filename.

4. Select Save.

When you use this layout to publish your content, the help center will use the image you
uploaded.

Portal Background Image Color
The HTML5 help center has a background image in the top section and there is also a semi-
transparent colored overlay. The overlay is blue by default, but you can use CSS to change it to any
color.

To change the portal overlay color:

1. Use a code/text editor to create a custom CSS stylesheet file (or edit an existing CSS file that
you use for Paligo). Add the following to your CSS stylesheet file:

.portal-header::before {
  background-color: #555; 
}

Replace #555 with the HTML code for the color you want to use.
If you want to use a gradient, that's possible too. But in that case, use "background" instead of
"background-color":

.portal-header::before {
   background: linear-gradient(to right , rgb(0, 104, 191) 8% , rgb(33, \
150, 243) 50% , rgb(100, 66, 255) 95%);
}

You can easily generate the gradient code with an online generator, for example this one.

2. Save your CSS stylesheet file with the .css file extension, for example, mystyles.css.

3. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

4. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

5. Select CSS, JS, logos and other assets.

6. Upload your CSS file in the CSS section.

IMPORTANT
When you upload a CSS file, it will replace any CSS file that is currently
associated with the layout.

NOTE
If you are using an HTML layout rather than an HTML5 layout, the CSS upload
feature is in the General category.

7. Select Save. 

Remove the Portal Background Image
If you want your help center portal to have no background image, you can remove it with CSS. The
section will then use an overlay color [707] only.

To change the portal overlay color:
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1. Use a code/text editor to create a custom CSS stylesheet file (or edit an existing CSS file that
you use for Paligo). Add the following to your CSS stylesheet file:

.portal-header::after{
  background: none;
}

2. Save your CSS stylesheet file with the .css file extension, for example, mystyles.css.

3. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

4. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

5. Select CSS, JS, logos and other assets.

6. Upload your CSS file in the CSS section.

IMPORTANT
When you upload a CSS file, it will replace any CSS file that is currently
associated with the layout.

NOTE
If you are using an HTML layout rather than an HTML5 layout, the CSS upload
feature is in the General category.

7. Select Save. 

Portal Search Box Styles
You can use CSS to change the search bar colors on the HTML5 help center's portal page. By
default, the search bar has a semi-transparent white background, with an orange search button
and white search icon. But you can change them to any colors that you want.
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1. Use a code/text editor to create a custom CSS stylesheet file (or edit an existing CSS file that
you use for Paligo). Add the following to your CSS stylesheet file:

.portal-header .search-field {
    background-color: rgba(195, 46, 46, 1);
}

.portal-header .portal-search button, .publication-contents h4 span {
    background-color: #00d3f5;
}

.portal-header .portal-search button {    
    color: #100000;
}

The .portal-header .search-field class is for the background of the search box.
The .portal-header .portal-search button, .publication-contents h4 span class is for the
background color of the search box button (at the end of the search box)
The .portal-header .portal-search button class is for the color of the icon in the search box
button.
Replace the color values with the colors you want to use.

NOTE
The background color for the search box button is also used for the number
icons next to the topics that are listed in the bottom section of the portal
page.

2. Save your CSS stylesheet file with the .css file extension, for example, mystyles.css.

3. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

4. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

5. Select CSS, JS, logos and other assets.

6. Upload your CSS file in the CSS section.

IMPORTANT
When you upload a CSS file, it will replace any CSS file that is currently
associated with the layout.

NOTE
If you are using an HTML layout rather than an HTML5 layout, the CSS upload
feature is in the General category.

7. Select Save. 

Category Panel Styles
The HTML5 help center portal page has "category panels" that link to topics or publications. By
default, each category panel links to a top-level section or "sub-publication" in your help center,
and uses an icon from Font Awesome 4.6.3.

You can change the icons, change the color of the icons, and replace the icons with your own
images. You can also choose which topics or "sub-publications" have category panels.
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NOTE
Paligo gives the first four category panels individual icons and any other panels
are given the "document" icon. You can use CSS to change any of the icons.

Font Awesome Icons for Category Panels
Paligo adds individual icons to the first four category panels and then adds a "document" icon to
any further panels. You can use CSS to change the icons to any icons in Font Awesome 4.6.3. Icons
that appear in later versions of FontAwesome may not work with Paligo content.

NOTE
If you want to change the color of the icons, see Color of Category Panels [714].

TIP
You can use javascript to replace the icons with your own images [715].

1. Use your browser's inspection tool [658] to discover the class name of the category panel that
you want to change. Each category panel has its own class name which Paligo designates
based on the order of the panels. For example, the first category panel has the class
name .cat-panel-1.

NOTE
If you are unfamiliar with CSS and using browser inspection tools, we
recommend that you first look at Branding your HTML Outputs with
CSS [654].

If you want to learn about CSS, this CSS Tutorial covers the basics and has
links to more resources.

2. Use a code/text editor to create a custom CSS stylesheet file (or edit an existing CSS file that
you use for Paligo). Add the following to your CSS stylesheet file:

.cat-panel-1:before{
    content: "\f29a"; 
}

You will need to change .cat-panel-1 to the class name you discovered in step one, for
example, .cat-panel-5:before.
The "\f29a" is the icon code from Font Awesome. Replace this code with the code for the
icon you want to use. The code must be inside double-quotation marks and you need a
semi-colon ; after the closing quotation marks.
You can get the code for all Font Awesome icons here: Font Awesome Cheat Sheet. Remember
to use a backslash as shown above.
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3. Save your CSS stylesheet file with the .css file extension, for example, mystyles.css.

4. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

5. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

6. Select CSS, JS, logos and other assets.

7. Upload your CSS file in the CSS section.

IMPORTANT
When you upload a CSS file, it will replace any CSS file that is currently
associated with the layout.

NOTE
If you are using an HTML layout rather than an HTML5 layout, the CSS upload
feature is in the General category.

8. Select Save. 

FontAwesome Icons Not Appearing in Category Panels
If your FontAwesome icons are not appearing in your Paligo output, make sure that:

• You have followed the instructions for adding the icons carefully.

• You have used icons that are included in FontAwesome 4.6.3. Icons from later versions of
FontAwesome are not supported.

If you are using icons from FontAwesome 4.6.3 and still have problems, contact customer support
for assistance.
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Color of Category Panels
By default, the background of the category panels is white, the icons are blue, and the text is dark
gray. You can use CSS to change the colors to suit your own requirements, for example, in the
image shown, the panel backgrounds are gray, with red icons and text.

1. Use a code/text editor to create a custom CSS stylesheet file (or edit an existing CSS file that
you use for Paligo). Add the following to your CSS stylesheet file:

.portal-single-publication a {    
    color: #DC143C;
    background-color: #C0C0C0;
}

.portal-single-publication .publication-icon {
    background-color: #DC143C;
}

The .portal-single-publication a class is for styling the category panel. The color applies to the
text and the background-color applies to the background of the panel. Change the #DC143C
value to the HTML code for the color you want to use.
The .portal-single-publication .publication-icon class is for styling the icon. Change the
#DC143C value to the HTML code for the color you want to use.

2. Save your CSS stylesheet file with the .css file extension, for example, mystyles.css.

3. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

4. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.
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5. Select CSS, JS, logos and other assets.

6. Upload your CSS file in the CSS section.

IMPORTANT
When you upload a CSS file, it will replace any CSS file that is currently
associated with the layout.

NOTE
If you are using an HTML layout rather than an HTML5 layout, the CSS upload
feature is in the General category.

7. Select Save. 

Replace Category Icons with Images
Paligo uses icons for each category shown in the HTML5 Help Center "portal". You can use
javascript to set your own category images, and for this, you will need to have the images available
online (or on a local network if you publish offline).

To find out which image file formats are supported, see the Mozilla website: https://
developer.mozilla.org/en-US/docs/Web/HTML/Element/img. There are no size limitations on the
images you use, but we recommend that you use images that all have the same dimensions. You
should also consider the image file sizes, as larger files may result in longer page loading times.

To replace the icons, you need to use javascript to tell the browser to insert a new image file and
to remove the existing ones. If you already use a custom .js file for your help center, you can add
the new code to that. If you do not use a custom .js file, you will need to create one. You can use
any text editor or code editor that supports saving in .js format.

1. Create a javascript file that contains the following code. If you already have a custom
javascript file that you use with your help center, you can add the code to that instead.

$(document).ready(function() {

var icon1 = "url of image 1";
var icon2 = "url of image 2";
var icon3 = "url of image 3";

$(".cat-panel-1").closest("a").prepend("<img src='" + icon1 + "'></
img>");
$(".cat-panel-2").closest("a").prepend("<img src='" + icon2 + "'></
img>");
$(".cat-panel-3").closest("a").prepend("<img src='" + icon3 + "'></
img>");
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$(".publication-icon").remove();

});

NOTE
The $(document).ready(function() {  at the start of the script and
the }); at the end mark the start and end of the function. If you are creating
a new .js file, you need to include these. If you are adding the script to an
existing .js file, it will already have the ready function start and end in place,
so do not include them. But make sure you add the rest of the code above
the closing ]); in the script file.

2. Edit the variables in the first section of the script.
The script declares variables called icon1, icon2, and icon3. Each variable is a reference to
the url of an image file. Replace the text inside the quotation marks with the url of one of your
images.
We have included variables for three images. If you want to include more, add a new line using
the same syntax. For example, if you wanted four images, you would add var icon4 = "url
of image 4"; where the url is the actual address of the image file.

3. If you have added more variables, add extra instructions for the browser. There is one
instruction for each variable, and they look like this:

 $(".cat-panel-1").closest("a").prepend("<img src='" + icon1 + "'></
img>");

In the HTML structure of the help center's "portal" page, each category image is contained in
a "cat-panel" section and these are numbered. So the line above works by telling the browser
to find the "cat-panel" for category 1, and then find the anchor that comes before it. When the
anchor is found, the browser should add an image element that references the icon1 variable.
The icon1 variable, defined earlier in the script, defines the location of the image.
For each variable that you added to the script, add a new instruction line. For example, if you
have four variables, add this line for the fourth variable:

 $(".cat-panel-4").closest("a").prepend("<img src='" + icon4 + "'></
img>");

4. Save your javascript file.

5. Add the javascript file to your HTML5 help center layout [768] and then publish.

Topics for Category Panels
By default, the HTML5 help center has category panels for all top-level topics (or sub-publications
if you publish a "super" help center). But you can choose different topics if you prefer.
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The HTML5 help center portal page can show up to 4 category panels when it first loads. There is a
"Show All" link to reveal any further category panels.

To choose your own topics for the category panels:

1. Open the topic in the editor.

2. In the Element Structure Menu, select the top section element and then select Go to
element.

3. In the Element attributes section, add the role attribute and give it the value: portal-
category.
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4. Select Save.

5. Repeat steps 1-4 inclusive for each topic that you want to be included as a category panel.

Remove the Category Panel Section
You can use CSS to remove the category section from the HTML5 help center portal page.

NOTE
This topic covers the category panel section only. For the featured content
section, see Remove the Featured Content Section [724].
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1. Use a code/text editor to create a custom CSS stylesheet file (or edit an existing CSS file that
you use for Paligo). Add the following to your CSS stylesheet file:
If you want to remove the category panels, add this:

.portal-publications .inner-row {    
    display:none;
}

.show-all-category {
    display:none;
}

The .portal-publications .inner-row is the category panels section and the .show-all-category is
the "show all" link that reveals category panels 5 and upwards.

2. Save your CSS stylesheet file with the .css file extension, for example, mystyles.css.

3. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

4. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

5. Select CSS, JS, logos and other assets.

6. Upload your CSS file in the CSS section.

IMPORTANT
When you upload a CSS file, it will replace any CSS file that is currently
associated with the layout.

NOTE
If you are using an HTML layout rather than an HTML5 layout, the CSS upload
feature is in the General category.
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7. Select Save. 

Featured Content Styles
The HTML help center has a "Featured Content" section that contains a list of links to important
topics. By default, the listed topics are top-level and second-level topics in the structure of the
publication, but if you prefer, you can control which topics are included [722].

You can customize the featured content section by changing the colors [720], the fonts, and
choosing which topics are included [722]. Or, if you prefer, you can remove it [724].

Color of Featured Content
To change the color of the "featured content" headings:

1. Use a code/text editor to create a custom CSS stylesheet file (or edit an existing CSS file that
you use for Paligo).

2. Add the code for the type(s) of color changes you want to make. Note that in each case, you
should replace the color code with the HTML code for the color you want to use. We have
used #DC143C as an example color. Also, remember to add the semi-colon after the code.
If you want to change the color of the "Featured Content" heading, add:

h5.featured-content-label {    
    color: #DC143C;
}

If you want to change the color of the numbered topic headings and the listed topics, add:

.publication-contents a {
    background-color: #DC143C;
}
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To change the color of the icon next to the listed topics, add:

.publication-contents li::before {
    color: #DC143C;
}

NOTE
You can also set an opacity to make the colors more transparent. For
example, opacity:0.15;

3. Save your CSS stylesheet file with the .css file extension, for example, mystyles.css.

4. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

5. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

6. Select CSS, JS, logos and other assets.
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7. Upload your CSS file in the CSS section.

IMPORTANT
When you upload a CSS file, it will replace any CSS file that is currently
associated with the layout.

NOTE
If you are using an HTML layout rather than an HTML5 layout, the CSS upload
feature is in the General category.

8. Select Save. 

Topics for Featured Content
The HTML5 help center portal page has a "featured content" section and you can control which
topics appear there. You do this by adding the role attribute and promoted-content value to:

• The section element for regular topics

• The article element for publication topics.
This is useful if you have set up a "super publication" and want your sub-publications to appear
in the "featured content" section.

Note that you need to have Output role attribute as class names setting enabled in your HTML5
help center layout.

1. Select Layout and then edit the layout that you are going to use for publishing.

2. Select the Classes and attributes settings and then enable Output 'role' attribute as class
names.

3. Select Save.

4. To add regular topics as featured content:

a. Open the topic in the editor.

b. In the Element Structure Menu, select the top section element and then select Go to
element.
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c. In the Element attributes panel, add the role attribute and give it the value: promoted-
content.

d. Select Save. 

e. Repeat these steps to add more topics in the featured content section.

5. To set a sub-publication as featured content:

a. Open the sub-publication's publication topic in the editor (see Display a Publication
Topic [120]).

b. In the Element Structure Menu, select the top article element and then select Go to
element.

c. In the Element attributes panel, add the role attribute and give it the value: promoted-
content.
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d. Select Save. 

e. Repeat these steps to add more sub-publications to the featured content section.

Remove the Featured Content Section
You can use CSS to remove the Featured Content section of the help center portal page.

If you want to remove the featured content heading and list:

1. Use a code editor or text editor to create a CSS file. Give it a name and save it with the .css
extension.

2. Add the following CSS:

.featured-content-label {
    display:none;
}

.portal-contents featured-content {
    display:none;
}
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.portal-contents .inner {
    display:none;
}

Where:
The .featured-content-label is the "Featured Content" heading.
The .portal-contents featured-content is the section containing the list of topics.
The .portal-contents .inner is the list of topics.

3. Save your CSS stylesheet file with the .css file extension, for example, mystyles.css.

4. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

5. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

6. Select CSS, JS, logos and other assets.

7. Upload your CSS file in the CSS section.

IMPORTANT
When you upload a CSS file, it will replace any CSS file that is currently
associated with the layout.

NOTE
If you are using an HTML layout rather than an HTML5 layout, the CSS upload
feature is in the General category.

8. Select Save. 

When you publish your help center and use this layout, the custom CSS you have added to the
layout is applied. Your help center will not have the featured content section.
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Disable Language Selection Page
For some HTML5 outputs, including classic and API, the first page users will see (the landing page)
is a language selection page. This applies even if you only publish in one language. If you prefer,
you can disable this feature so that the browser shows the documentation's "home" page instead.

To set your output to show the documentation "home" page instead of the language selection
page:

1. Select Layout and then either select an existing layout to open it in the Layout Editor or create
a new layout [1059].

2. Edit the layout and select General.

3. In the General settings, use the Skip Language selection page for Classic HTML5, Single
Page, and API style outputs setting to control the language page.

Set it to:

• Enable
To set the browser to show the documentation "home" page instead of the language
selection page.

• Disable
To set the browser to show the language selection page.

4. Select Save.

When you publish content using this layout, it is set up to use the landing page you have chosen.
Depending on your choice in the layout, the first page the user sees will be either the language
selection page or the documentation "home" page.
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Disregard Portal Category and Promoted Content
Abstract

Learn how to set Paligo to ignore topics that have the role:portal-category or role:promoted-
content when it generates the HTML5 Help portal page.

You can set up your content so that topics of your choice appear in the category panels and
Featured Content sections of the HTML5 Help Center "portal" page. You do this by using the
role attribute. But in some situations, you may find that you need the role attribute for one
publication, but not for others. For example, you might want a topic to have a category panel when
it is used in one publication, but not when it is used in another. To make this possible, Paligo has
a Disregard portal category and promoted content feature, which you can find on the HTML5
layout.

NOTE
To learn how to use the role attribute to add topics to the category panel section
and/or Featured Content section, see:

• Topics for Category Panels [716]

• Topics for Featured Content [722].

To control whether Paligo creates includes topics (with the appropriate role attribute and values)
to the portal page:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Classes and attributes.

4. Set Use the portal-category and promoted-content roles to:

• Yes
Paligo will create extra category panels for topics with the role:portal-category
attribute and value. It will also create extra links in the Featured Content section for any
topics that have the role:promoted-content attribute and value.

• No
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Paligo will ignore role: portal-category and role: promoted-content attributes
and values. When it generates a portal page, it will use the default settings for category
panels and featured content [728].

• Default

To inherit the value for this setting from the base layout. The base layout is either a built-in
layout provided with Paligo or is another custom layout.

To find out more, see Layout Relationships - Base, New, Duplicate [1055].

5. Select Save.

When you publish with this layout, Paligo will apply the settings you have chosen.

Default Settings for Category Panels and Featured Content
By default, the portal page on an HTML5 help center includes category panels (1) and a Featured
Content section (2).

Paligo generates category panels for:
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• Every top-level topic or sub-publication (publication nested inside the main publication)

• Every topic that is set to have the role:category-panel attribute and value.

Paligo generates featured content links for:

• The first 4 top-level topics

• Every topic that has the role:promoted-content attribute and value.

By using the HTML5 Help Center layout settings, you can set Paligo to ignore the topics that
have role:category-panel and/or role: promoted-content. This can be useful if you reuse
content that has these attributes, but you do not want them to be included on the portal page.

Faster Page Loading with Ajax Loading
You can significantly improve the page loading times for HTML5 help centers by enabling ajax
loading. With this feature enabled, when you open a new topic in the published output, the
browser will load only the content of the new topic, rather than every part of the web page
(header, navigation features, etc.).

Ajax loading is available for HTML5 help centers only and you can enable it on an HTML5 help
center layout. But note that if you enable Ajax loading, links in your content will not work when
you view the content locally. But they will work as expected when you host your content on a web
server.

1. Select Layout and edit the layout you are going to use for publishing.

2. In the Layout Editor, select the General category and then scroll down to the Ajax load
content box.

3. Choose Enable to activate Ajax loading. (To disable it, you can choose Disable or Default).

4. Select Save.

NOTE
There is a HTML5 Help Center Preloaded layout template that also provides fast
page loading times. This layout also uses an ajax variant, but it works offline
without publishing to a web server. This type of layout can be useful for smaller
outputs, where you provide your help center on a local computer. But it does not
support all of the help center features.

If you have larger publications, with hundreds or thousands of pages, use the
main HTML5 Help Center layout and enable ajax instead.

Multiple Publications in the Same Portal
If you have many related publications, you might want to make them all available in the same
HTML5 help center. With this approach, there is a home page (a portal) that provides links to each
of your publications.
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We call these portals "super publications" and there are two ways to do it:

• Manually create a portal page and then link your published Paligo outputs to it, with the
search provided by a third-party system, such as SwiftType. Then to update the content, you
publish each manual separately and set up the portal so that it has links going to each
publication. The way to achieve this can vary, depending on what search engine you use and
how you create the portal page. For example you can publish once, use the portal page created
and then manually modify it to fit. We also offer professional services if you need help with this,
contact support for more information.

• Create a super publication in Paligo, with the search being provided by Paligo's built-in search.
Apply the layout settings and prerequisites for super publications. Build the super publication
and then follow the steps for one of the publishing methods (Single Publish [736] or Multiple
Publish [738]) that best suits your requirements. There are pros and cons to both methods. To
decide which method is best for you, consider what you need from your content.

NOTE
The Paligo super publication work well for a small number of publications. For
more complex use cases, a manually created portal page might work better.

If you find that your use case does not fit the Paligo super publication, ask
support about professional services for a custom solution.

Prerequisites for Super Publications
When you create a super publication, you use a layout to publish to HTML5. The layout needs to
have certain settings in place, otherwise the super publication help center will not work correctly.

NOTE
Algolia faceted search is not supported by the super publication help centers.
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System Settings for Super Publications
For super publications, you need to have the Persistent image file names setting enabled in the
system settings. This setting means that the image files will use a persistent ID for the file name
which is better for consistency.

NOTE
To make changes to the system settings, use an Admin user account. Users with
an Author user account can change the layout settings and complete all of the
other steps needed to create a "super" publication.

1. Select the arrow to the right of your avatar in the top menu.

2. Select Settings. 

3. Select the System Settings tab.

4. Make sure you have Persistent image file names enabled.

Layout Settings for Super Publications
To get Paligo to publish content for super publication help portals, you need an HTML5 layout
that has certain settings enabled. Before you can adjust the layout settings, you have to Create a
Layout [1059].

IMPORTANT
If you enable the layout option Only create topic for reused
publications if no top-level topic (located under General) you must
remember to link to a topic in the subpublication, not to the subpublication itself.

Apply the following settings to the layout:
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1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select General.

4. Select Enable for SEO-friendly output filenames.

IMPORTANT
It must not be disabled.

5. Select Enable for Use a short and flat URL structure for output files (or Ajax-
enabled if you use that).

6. Select Enable for Use output filenames made from id and SEO name (a particular file
naming for the HTML files).

7. Select Enable for Multiple publication portal prefix if your subpublications contain
further nested subpublications, reusing the same sub topics.
When enabled, this setting adds the publication id to the start of the output filename. This
means that each topic has a unique filename for the different subpublications, no matter how
many levels of subpublications there are.
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NOTE
Only enable Multiple publication portal prefix if you have multiple levels of
nested subpublications.

If you only have one level of subpublications (under the super publication),
make sure the setting is disabled.

8. Select Enable for Use resource name instead of title for the HTML output file
name if you use variables in your topic titles.
This is because the super publication depends on the file names being the same when you
publish both the super publication and the subpublications. With variables in the titles, the file
names will be different, unless you enable Use resource name instead of title for the HTML
output file name. When enabled, the topic names are used for the filenames instead of the
titles.

9. Select Enable for Create a title topic for reused publications.

IMPORTANT
It must not be disabled.

10. Select Help center theme options.

11. Select Enable for Open portal category on first topic for nested publications.

12. Select Toc and Chunking.
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13. Select Disable for Standalone TOC.

14. Select Save.

Topic Requirements for Super Publications
Before you publish your content to a super publication help portal, make sure that:

• Subpublication topics do not use the element attribute role with the value portal-
category. It is incompatible with super publications that use the subpublications for
categories.

• The first topic in each subpublication does not use a variable in the title element. You can
use variables in your subpublication topics, but not in the title of the first topic. This only
applies if you are using the Multiple Publish method to create your help center portal.

Create a Super Publication
If you have a series of publications that you want to release as one output, you can create a super
publication. This means that publications are added to a main publication. The reused publications
become subpublications that appear as sections in the output (such as PDF or HTML5 help center).
For the HTML5 help center output, the super publication will become the portal that contains all
subpublications.

Before you build the super publication, you have to consider whether to use Single Publish [736]
or Multiple Publish [738].

TIP
There are layout settings that you can use to control how the top-level
of a publication is presented in HTML5 outputs, see HTML5 Layout Editor
Options [680] .

You can use filters to hide a reused publication's topics in the output. For
example, you may want to filter out introduction topics. To find out more about
filtering topics, see Filtering / Profiling [1141].

1. Make sure that the Prerequisites for Super Publications [730] are in place.
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2. Create a Publication [96] that will become the super publication

3. Select the publication in the Content Manager [34]. 

4. Drag and drop the subpublications from Content Manager [34] into the publication structure.

Reused publications get a reuse symbol. To remove a subpublication, select the X to the right of it.

5. Rearrange the topic position with the arrows or drag and drop it in the structure.

6. Select Save to confirm the publication changes. 

7. Select the Dotted menu (...) for the super publication in the Content Manager [34].

8. Select Edit and choose Open in Editor. 

9. Select the article element in the Element Structure Menu [52] and choose Go to element.

10. Add the role attribute and set its value to multi-publication-portal in the Element
Attributes Panel [55].
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IMPORTANT
You should only use the multi-publication-portal role on the the super
publication article element. Do not add it to the subpublications.

11. Select Save. 

Single Publish
The single publish method means that you publish the entire super publication with all its
subpublications at the same time. Meaning that you only publish once to create the finished help
center.

If you instead want to publish the subpublications separately, see Multiple Publish [738].

Here are the pros and cons with this method:

+ Only need to publish once to update the entire help center.

+ Can use cross-references between subpublications. Note that links between subpublications will not work if you
publish a subpublication separately to the rest of the help center.

- Cannot use different variables for each subpublication. You can only set variables for the super publication.

- Cannot use different filters for each subpublication. You can only set filters for the super publication. However, you
can use scoped filtering to apply different filter values to the subpublication content.
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- Subpublication navigation menus include all subpublications, not just the one you are viewing.

Run a Single Publish

TIP
To find out how to publish, see Publish to Your Help Desk Portal [1083].

1. Select the Dotted menu ( ... ) for the super publication in the Content Manager [34].

2. Select Publish. 

3. Select HTML5 and choose the layout that contains the appropriate settings for a help center
portal.

NOTE
If you set any variables or profiling (filters) for the publication, they will
apply to all topics in all of the subpublications. If you need to apply different
filters to the subpublications, you can use scoped filtering or use the Multiple
Publish [738] to create the super publication.

4. Select Publish document.
Your browser will download the zipped publication. It is stored in the folder your browser uses
for downloads. Typically, this is the "Downloads" folder on your computer.

5. Unzip the super publication download and store it on the server or network that will host your
help center.

6. Open the index.html file in the output to launch your super publication help center.
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Your super publication now has a "portal" page with category panels for each subpublication.
Users can select the panels to access the subpublications.

Multiple Publish
The multiple publish method means that you publish each subpublication separately once you
have published the super publication. You move the HTML files from the subpublication outputs
into the super publication output to complete your help center.

If you instead want to publish the entire super publication with all its subpublications, see Single
Publish [736].

Here are the pros and cons with this method:

+ Can use different variables for each subpublication.

+ Can use different filters for each subpublication.

+ Subpublication navigation menus only include the subpublication you are viewing.

- Cannot use cross-references between subpublications. There is a workaround that makes it possible, but it is only
suitable if you have a low amount of cross-references. The workaround is to publish the help and make a note of the
urls for the pages that will be linked to. Then, in Paligo, add external links to those urls instead of cross-references,
and then re-publish.

- Have to publish each subpublication separately.

Run a Multiple Publish

NOTE
To view the super publication help center, open the Out > Index.html file in the
super publication.

1. Select the Dotted menu ( ... ) for the super publication in the Content Manager [34].

2. Select Publish. 
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3. Select HTML5 and choose the layout that contains the appropriate settings for a help center
portal.

NOTE
Do not set any Profiling attributes (filters) or variables.

4. Select Publish document.
Your browser will download the zipped publication. It is stored in the folder your browser uses
for downloads. Typically, this is the "Downloads" folder on your computer.

5. Expand the super publication to reveal its forks in the Content Manager [34].
Forks are references between a publication and the content included in the publication.

6. Select the Dotted menu (... ) for one of the subpublication forks and choose Publish. 

7. In the publishing settings:

a. Select HTML5 and choose the same layout that you used for the super publication.

b. Apply any Profiling attributes (filters) and variables that you want the subpublication to
use.
The filters and attributes will only apply to the selected subpublication. They will not affect
the other subpublications in the help center.

c. Select Publish document.
Your browser will download the zipped publication. It is stored in the folder your browser
uses for downloads. Typically, this is the "Downloads" folder on your computer.
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8. Repeat steps 6 and 7 for each subpublication in the super publication.

9. Move the downloaded zip files for the super publication and the supublications to a folder on
the network or web server that will host your help center content. When you have moved the
files, unzip them.

10. Browse to the out > en folder in one of the subpublications output.

11. Copy the HTML files.

Copy the HTML files from the subpublication's out > en folder.

12. Paste the HTML files into the super publication's out > en folder. When prompted, choose to
overwrite the existing files.
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Paste the HTML files into the super publication's out > en folder.

NOTE
The "en" folder is for English outputs. For outputs in other languages, there
is a two character folder for that language instead, for example, "de" for
German.

13. If the subpublication uses variable images:

a. Browse to the out > en > Image folder.

b. Copy the images.

c. Paste them into the super publication's out > en > Images folder.

14. Repeat steps 10 to 13 for each subpublication.

Top-Navigation for Help Centers
You can use the top-navigation feature to add a header to the top of your HTML5 Help Center
outputs. In the header, you can add quick links to important topics in your help center, such as
"Getting Started", and you can also add links to external sites, such as your corporate website.

NOTE
The top-navigation links are only available in HTML5 Help Center outputs [1092].

To learn how to set up the top-navigation header and add links to it, see:

• Add Top-Navigation Links to External Sites [742]

• Add Top-Navigation Links to Topics [745].

You can choose to add links only to external sites, only to topics, or have a mix of both.
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Add Top-Navigation Links to External Sites
If you publish to a HTML5 Help Center, you can add links to external websites at the top of the
display. This is a good way to guide your customers to other web pages that they might need, such
as the product pages on your website or a link to open a new ticket.

In the following image, the top-navigation menu [741] has external links for "Technology Center"
and "Staff Log In".

TIP
You can add Javascript in the Layout Editor to add further functionality to the top
navigation links, such as opening a widget to open a chat. For these links, add the
link text, enter # as the URL, and then add code for opening a new ticket in your
javascript.

NOTE
You can also use the top-navigation header to show links to selected topics [745]
in your help center.

To add external links, use a HTML5 Help Center Layout:

1. Select Layout, and then choose your HTML5 Help Center Layout.

2. On the Layout Editor, select Toc and Chunking.

3. Set Top navigation to Enabled.

4. In the Toc and Chunking settings, scroll down to the External top navigation links section.
Add the links that you want to appear in the top-navigation header in your help center.
To enter the links, use this syntax:
text:link text, url: address;

Where link text is the text that will appear in the top-navigation banner and address is the web
address of the page being linked to. Use a comma to separate the text part from the url part
and end the link with a semicolon.
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To add links with different targets depending on the language, specify the language at the
start of the syntax. For this, use lang and the two-letter code for the language, for example:
lang:de, text:link text, url:acme.de;

lang:sv, text:link text, url:acme.se;

lang:fr, text:link text, url:acme.fr;

NOTE
Any links that do not have the lang attribute will appear for all languages.

5. If you publish to multiple languages, you can use a translatable string for the text of your links.
Translatable strings are text entries that Paligo translates into some supported languages
automatically.
To use a translatable string for the text of a link, set Use translation strings for external top
navigation link text to Enabled. (Set it to Disabled if you do not use translatable strings for
your top-navigation external links).

6. Add your "translatable string" links to the External top navigation links section
The following table shows examples of some of the translation strings that are supported by
Paligo and could be useful for external links.
To use these translation strings, add the translation string identifier as the value for the text:
part of the link, for example:
text:LegalNotice, url:https://yourwebsite.com;

NOTE
If a term is not translated automatically for your language, please contact
Paligo support and provide the translation. If the term is likely to be useful to
many Paligo users, we may add it to the list of supported translation strings.

Translation String Identifier Term shown in top-navigation (English).

This term is translated into supported languages automatically by Paligo.

LegalNotice Legal Notice
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Translation String Identifier Term shown in top-navigation (English).

This term is translated into supported languages automatically by Paligo.

QandASet Frequently asked questions

Qandadiv Q&A

Notice Notice

Reference Reference

featured.content Featured content

contact.support Contact support

sign.up Sign up

log.in Log in

7. Select Save.

When you next publish your help center using this Layout, the top-navigation header will be
included and it will have the external links you provided.

Example 39. Top-navigation links to external sites

Imagine that you want to add a "Contact support" link to the top-navigation header of your help
center. You publish to English and French.

1. You open your HTML5 Help Center Layout in the Layout Editor and select Toc and Chunking.

2. You set Top navigation to Enabled.

3. In the External top navigation links section, you add:
text:contact.support, url:https://yourwebsite.com/contact;
You use "contact.support" as it is one of the translation strings that are available in Paligo.

4. You set Use translation strings for external top navigation link text to Enabled.

5. You publish to English. The following link is added to your top-navigation header:

• Contact support

6. You publish to French, the following link is added to your top-navigation header:

• Contactez le support
The contact.support link is translated into French automatically, as you used a translation
string.
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Add Top-Navigation Links to Topics
If you are using an HTML5 Help Center Layout, you can enable the top-navigation header [741] and
add links to selected topics. This is a good way to direct customers to areas of your documentation
that contain important information that is used frequently, or topics that need to stand out, such
as a tutorial.

When you add a link to a topic, Paligo automatically detects if the topic has any "children" (i.e
topics that are at a lower level in your publication). If there are "child" topics, Paligo creates a
drop-down menu with links to them. In the image above, "The Mission Control Center" is the main
topic for the link, and the drop-down menu has links for topics that are at level 2 In the publication
("Command Center", "Guidance System", and "Ground Segment", see the image below).

To add top-navigation links, set up your HTML5 help center layout so that it has the appropriate
settings. Then you can add add the links to your topics. There are two ways you can add links - by
using taxonomies or by using the role attribute.

Layout Settings for Top Navigation
To add navigation links to topics, you should first enable Top-Navigation and some other settings
in your HTML5 Help Center Layout:

1. Select Layout, and then choose your HTML5 Help Center Layout.

2. On the Layout Editor, select Classes and Attributes and set Output Taxonomies to Enable.

3. Select Toc and Chunking and set Top Navigation to Enable.

4. Set the number of levels to show in the top navigation.
In the Toc and Chunking settings, find Top navigation depth and set it to 1, 2, or 3.
If you set it to 1, the top-navigation header will only include a link to one specific topic. If you
choose 2 or 3, it will include a link to the specific topic and it provides a menu with links to
"child" topics (for level 3, there is a further menu for links to "grandchild" topics").
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In this publication, "The Mission Control Center" has a link in the top-navigation header. The
Top navigation depth is set to 3, which means that there is a sub-menu for topics two levels
down from "The Mission Control Center". At level 2, there is "Command Center", "Guidance
System", and "Ground Segment". At level 3, there is "Controls System" and "Control Room".

5. In the Classes and Attributes settings, make sure Output 'role' attribute as class names is
enabled.

6. Select Save.

Use the Role Attribute to Add Top-Navigation Links
You can use the role attribute to add a link to a topic in the top-navigation header [741]. Select
the top section element of a topic and then give it the role attribute and set the value to:

top-nav-link

NOTE
You can also set the top-navigation header to include links to external sites [742].

1. Create or edit an HTML5 Help Center layout and make sure it has the appropriate settings for
top-navigation [745].

2. Open the topic that you want to add as a link in the top-navigation header.

3. Select the top section element to and then select Go to element from the menu.
Select Go to element.

4. In the Element Attributes section, select Add Attribute and add a role attribute. Set the
value of the role attribute to:
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top-nav-link

5. Select Save.

6. Repeat steps 2-5 for each topic that you want to add to the top-navigation header.

7. Publish your publication (use your edited HTML 5 Help Center Layout). (To learn how to
publish, see Publish to HTML and HTML5 [1092]).
Paligo creates your Help Center output and it includes the top-navigation header. Links to
your selected topics are shown in the top-navigation header.

NOTE
If you have set the top-navigation header to include links to topics and
external links, the topic links appear on the left side of the pipe character
| and the external links appear on the right side.

Use Taxonomies to Add Top-Navigation Links
You can use taxonomy tags to choose which topics will be included in the top-navigation header
on a HTML5 Help Center Layout [741]. This is an easy way of selecting topics for links, and is an
alternative to using the role attribute.

To set up taxonomy links:

1. Create or edit an HTML5 Help Center layout and make sure it has the appropriate settings for
top-navigation [745].

2. In the Content Manager, create a top-level taxonomy tag and give it a name. This can be any
name, but we recommend a meaningful name, such as "Top Navigation".

3. Create a second-level taxonomy tag (inside the tag you created in the previous step) and name
it: top-nav-link. This name is case-sensitive.
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IMPORTANT
Paligo will only be able to create the top-navigation links if you use a
taxonomy tag named "top-nav-link". This tag must not be a top-level tag in
the Taxonomies (which is why you have created two tags in this process).

4. Drag the top-nav-link on to the topics that you want to have links in the top-navigation header.

5. Select the top-nav-link taxonomy tag to display a list of the topics it is associated with.

Use the list to double-check that topics match those that you want in the top-navigation
header. You can remove a taxonomy by clicking on the X icon in the Taxonomies column.

6. Publish your publication (use your edited HTML 5 Help Center Layout). (To learn how to
publish, see Publish to HTML and HTML5 [1092]).
Paligo creates your Help Center output and it includes the top-navigation header. There are
links to those topics that have the "top-nav-link" taxonomy tag.

NOTE
If you have set the top-navigation header to include links to topics and
external links, the topic links appear on the left side of the pipe character
| and the external links appear on the right side.

Open Top-Navigation Links in the Same Tab
By default, top navigation links open in another browser tab or window. If you prefer to have the
links to open in the same tab instead, you can set this up by using some custom javascript.

1. Use a text editor to create a .js file.
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NOTE
If you already have a custom javascript file that you upload to your layout,
you can edit that instead.

2. Add the following javascript to the .js file:

$(document).ready(function() { 
    $('.nav-class a[target="_blank"]').attr('target', '_self');
});

NOTE
If you are adding the code to a custom javascript that you already use, you
only need to add $('.nav-class a[target="_blank"]').attr('target', '_self');. Make
sure to add it after the $(document).ready(function() { in the script and before
the end script characters });

3. Save your .js file.

4. In Paligo, select Layout and then select the Layout that you want to use for your HTML5
output.

5. In the Layout Editor, select CSS, JS, logos and other assets.

6. Use the Custom Javascript setting to upload your javascript file.

7. Select Save.

Your custom javascript is stored in the layout. When you publish using this layout, the javascript is
added to the HTML output. When you browse your help center, the top navigation links will open
in the same tab.

Applicability Panels for Topic Categories
Applicability panels are sections that appear in a topic, usually at the top, and they have a series of
categories. The categories show whether the content in the topic is applicable to those categories.
For example, in the Paligo help, we have applicability panels in some topics to show that the
information only applies to certain plans.

But you can use applicability panels for many different purposes, such as showing that a topic
applies to a particular audience or particular models of a product.

To create applicability panels for topics, there are three stages:

1. Set your HTML5 Layout to Output Taxonomies as Classes [750]

2. Add taxonomy tags for your categories [749]

3. Add custom JavaScript to your HTML5 layout [752]

4. Add custom CSS to your HTML5 layout [754].

To help you understand what a complete, working applicability panel script and CSS look like, we
have included an Example Applicability Panel Script and CSS [756].
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Set your HTML5 Layout to Output Taxonomies as Classes
Paligo can output taxonomies as classes in the HTML that is generated for your HTML5 outputs.
These classes are needed for various taxonomy-related features, including applicability panels and
taxonomy filters.

To set Paligo to output taxonomies as classes:

1. Select Layout and then edit the HTML5 layout you are going to use for publishing.
Alternatively, you can create a new HTML5 layout and edit that.

2. Select Classes and attributes.

3. Set Output Taxonomies to Enable.
This tells Paligo to include the taxonomy labels as class names in the HTML output.

4. Select Save.

Add Taxonomy Labels for Applicability Panel Categories
To mark up Paligo content to use an applicability panel, you will need to use taxonomy tags. These
need to be organized into a hierarchy, where there is a "parent" tag and then "child" tags for each
category you want to appear on your panel. For example, the availability plan panel you can see in
some Paligo help topics uses this taxonomy hierarchy:

Here, "Plan" is the parent taxonomy tags and "Business", "Enterprise" and "Professional" are the
child tags.

To create an applicability panel taxonomy and apply the tags to your content:
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1. In the Content Manager, expand the Taxonomy Manager section.

2. Select the options menu ( ... ) for the top-level Taxonomies tag.

3. Select Create taxonomy tag and then enter a name for the new tag. This is going to be the
parent tag in your applicability panel taxonomy hierarchy. For example, in the image shown,
"Plan" is the parent tag.

4. Select the options menu ( ... ) for your parent tag, and then select Create taxonomy tag.
Enter a name for a "child" taxonomy tag. This is going to represent one of the categories that
is shown on the applicability panel.

5. Repeat step 4 to add all of the "child" taxonomy tags you need for your applicability panel.
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6. Select the options menu ( ... ) for the top-level Taxonomies tag.

7. Select the Floating Content Panel option.

8. Add the "child" taxonomy tags to the relevant topics. To add the tags, find the topic in the
Content Manager and then drag and drop the tag from the floating content panel onto the
topic.

TIP
You can check to see if a taxonomy tag has been applied to a topic. Select
the folder that contains the topic to display Resource View. That has a column
that shows which taxonomy tags are in place for each topic in that folder.

When you have added the taxonomy tags, the content is ready. The next step is to create the
javascript for the accessibility panel and add it to a layout [752].

Add Applicability Panel JavaScript to your HTML5 Layout
To make the applicability panel work in your HTML5 output, you will need to add some custom
javascript to your HTML5 layout. The script will tell the browser to wait until the page has loaded,
then run a function that adds a list of categories to the page. The categories have to match the
names of the applicability panel taxonomy tags in Paligo.

The JavaScript only adds a list. You will style it at a later stage, using CSS.

To create your JavaScript:

1. Use a text editor or code editor for creating the JavaScript.

2. Use the following script as a starting point:

$(document).ready(function () {
    addFunctionName();
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    $(document).ajaxComplete(function () {
        addFunctionName();
    });
});

function addFunctionName () {
    if (! $("ul.listname").length) {
        var varforlist = '<ul class="listname">' +
        '<li class="parenttaxonomytag">Plan availability: </li>' +
        '<li class="childtaxonomytag1">Name of category 1</li>' +
        '<li class="childtaxonomytag2">Name of category 2</li>' +
        '<li class="childtaxonomytag3">Name of category 3</li>' +
        '<li class="childtaxonomytag4">Name of category 4</li>' +
        '</ul>';
        $(varforlist).insertAfter('#topic-
content > .section > .titlepage');
    }
}

3. Change addFunctionName to a function name that describes what your script is going to
add. For example, addAudienceList. You will need to change the addFunctionName in all three
places where it occurs, and it must use the same name in each place. For example, if you
change it to addAudienceName, you will have addAudienceName (); as line 2 and line 4, and
function addAudienceName at the start of the function definition (second section of script).

4. Change "ul.listname" and ul class="listname" to class names that are more descriptive of your
applicability panel list. For example, "ul.audiencelist" and ul class="audiencelist". The names
need to match.

5. Change varforlist to a variable name that is more suited to your script. For example,
audiencetypelist. The var name has to be the same in both places, so if you change varforlist
where it is declared, you also need to change it in the reference in $(varforlist).insertAfter later
in the script.

6. For the first li class, change "parenttaxonomytag" to the name of your parent taxonomy tag in
Paligo. This has to be an exact match. Enter the name for the category label after the li class
and before the closing </li>, for example:

'<li class="audience">Audience: </li>' +

7. For the next list item, change "childtaxonomytag1" to the name of the first child taxonomy tag
in Paligo. This has to be an exact match. Then, after the li but before the </li>, enter the name
for the category as it will appear in the panel, for example:

'<li class="Novice">Novice</li>' +

8. Repeat step 7 for each of the list items, matching the class name to the taxonomy tag names
in Paligo.

NOTE
To add an extra list item, copy and paste an entire list item line, from the
starting quote ' to the ending +

To remove a list item, delete an entire list item line, from the starting quote '
to the ending +
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9. Save your JavaScript file making sure it has a .js filename extension.

10. Upload your JavaScript file to your HTML5 layout.
For instructions on how to upload a JS file to a layout, see Add a Custom JavaScript to a
Layout [768].

NOTE
If your HTML5 layout already has a custom JS file in place, you should
add your script to that and upload the updated version to the layout.
Alternatively, you could add the old script to your new script.

If you only upload your new script, you will lose the functionality that was in
the old script.

The next step is to customize your CSS for the applicability panel (see Add Applicability Panel CSS
to your HTML5 Layout [754]).

TIP
To get an idea of what a working, customized script looks like, see Example
Applicability Panel Script and CSS [756].

Add Applicability Panel CSS to your HTML5 Layout
As well as custom JavaScript, the applicability panel needs some custom CSS. The CSS styles are
used to:

• Apply the checkmark when the content in a topic applies to one or more of the applicability
panel categories

• Apply different styles when the content in a topic does not apply to the panel categories

• Hide the applicability panel by default, so that it is only shown when topics have at least one of
the applicability panel taxonomy tags.

To create the custom CSS for an applicability panel:

1. Use a text editor or code editor to create a custom CSS file.

2. Define the selector and styling for the overall list.

ul.listname {
    display: none;
    list-style-type: none;
    margin: 0;
    padding: 0;
    overflow: hidden;
    /*background-color: #333333;*/
    margin-bottom: 1em;
}

Where ul.listname has to match the ul class and listname that was used in your JavaScript (in
the if statement).
Here, we have included the styling that we use for the gray applicability panel in the Paligo
help. You can change the styles to meet your own needs, but it is important that display:none;
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is included and the ul.listname matches the ul.listname in your script. This is because this part
of the script tells the applicability panel to be hidden by default.

3. Define the styles for when the applicability panel should be shown. For these, you need to
have selectors for each taxonomy tag. These use the syntax:
.taxonomy-parent taxonomy tag-child taxonomy tag ul.listname,
Where:

• .taxonomy is always included

• parent taxonomy tag is the name of the parent taxonomy tag in Paligo (for the applicability
tags)

• child taxonomy tag is the name of a child taxonomy tag in Paligo

• ul.listname has to match the ul.listname used in your JavaScript (same as in step 2)
You need a separate selector for each taxonomy tag.
After the selectors, include display: inline-block; to tell the browser to show the applicability
panel. Here, we have included border-radius to set rounded corners on the panel too.

.taxonomy-parenttaxonomytag-childtaxonomytag1 ul.listname,

.taxonomy-parenttaxonomytag-childtaxonomytag2 ul.listname,

.taxonomy-parenttaxonomytag-childtaxonomytag3 ul.listname {
    display: inline-block;
    border-radius: 8px;
}

4. Define the styles for the list items. For the selector, swap out ul.listname for the ul class name
you included in your JavaScript (same as in step 2). Keep li after it.
Here, we have included styles for the positioning, color, alignment etc. You can change these
styles to suit your own requirements.

ul.listname li {
    float: left;
    display: inline-block;
    color: #bbb;
    text-align: center;
    padding: 20px;
    background-color: #eee;
}

5. Define the styles for the label list item on the applicability panel. For the selector, replace
ul.listname with the ul class name you used in your JavaScript (same as in step 2) and replace
parenttaxonomytag with the class name that you gave to the parent tag list item in your
JavaScript.
Here, we have given the label a color and font-weight, but you can add other styles too.

ul.listname li.parenttaxonomytag {
    color: #444;
    font-weight: bold;
}

6. Define the styles for when the content does not apply to the categories.
For these styles, you need to consider the different possible combinations of tags and
include selectors for each combination. For example, here we have styles for the possible
combinations of three child taxonomy tags.
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.taxonomy-parenttaxonomytag-childtaxonomytag1 .childtaxonomytag1,

.taxonomy-parenttaxonomytag-childtaxonomytag1 .childtaxonomytag2,

.taxonomy-parenttaxonomytag-childtaxonomytag1 .childtaxonomytag3,

.taxonomy-parenttaxonomytag-childtaxonomytag2 .childtaxonomytag2,

.taxonomy-parenttaxonomytag-childtaxonomytag2 .childtaxonomytag3,

.taxonomy-parenttaxonomytag-childtaxonomytag3 .childtaxonomytag3,

 {
    color: #444;
}

We have only set a color for the category text, but you could apply other styles too if
needed. Remember that these are the styles used when the content is not applicable to these
categories.
Here, we have included selectors for three child taxonomy tags and their possible
combinations. If you have more tags, you will need to add more lines for each tag and its
combinations.

7. Define the styles for when the content does apply to the categories.
These styles work in the same way as in the previous step, where there is a selector for each
possible combination of classes. But these selectors include :before, which adds styling before
the category text. In this case, we have used CSS and a reference to FontAwesome to add a
check mark.

.taxonomy-parenttaxonomytag-childtaxonomytag1 .childtaxonomytag1:before,

.taxonomy-parenttaxonomytag-childtaxonomytag1 .childtaxonomytag2:before,

.taxonomy-parenttaxonomytag-childtaxonomytag1 .childtaxonomytag3:before,

.taxonomy-parenttaxonomytag-childtaxonomytag2 .childtaxonomytag2:before,

.taxonomy-parenttaxonomytag-childtaxonomytag2 .childtaxonomytag3:before,

.taxonomy-parenttaxonomytag-childtaxonomytag3 .childtaxonomytag3:before,{
    content: '\f00c';
    font-family: FontAwesome;
    margin-right: 0.5em;
    color: #1976d2;
}

You can apply different styling if you prefer. But you must use the taxonomy-parent-child
syntax, use selectors that match the names in your JavaScript, and include :before.

8. Save your CSS with a .css file extension and then upload it to your HTML5 layout.
To learn how to upload css files, see Branding your HTML Outputs with CSS [654].

TIP
To get an idea of what a working CSS looks like, see Example Applicability Panel
Script and CSS [756].

Example Applicability Panel Script and CSS
To show you what the script and CSS look like for a working applicability panel look like, we have
included the script and CSS that we use in the Paligo help. We use these to produce the price plan
applicability panel that is shown on certain pages.

Paligo Documentation

756



The taxonomies we use for the pricing plan applicability panel in the Paligo help are:

• Plan

• Professional

• Business

• Enterprise

The JavaScript we use for the applicability panel is:

$(document).ready(function () {
    addPricePlan();
    $(document).ajaxComplete(function () {
        addPricePlan();
    });
});

function addPricePlan () {
    if (! $("ul.priceplan").length) {
        var priceplanlist = '<ul class="priceplan">' +
        '<li class="planlabel">Plan availability: </li>' +
        '<li class="professional">Professional</li>' +
        '<li class="business">Business</li>' +
        '<li class="enterprise">Enterprise</li>' +
        '</ul>';
        $(priceplanlist).insertAfter('#topic-
content > .section > .titlepage');
    }
}

Note that where the function name is changed, it is changed everywhere in the script. The same
applies for the variable name and list name too.

The CSS we use for the applicability panel is:

ul.priceplan {
    display: none;
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    list-style-type: none;
    margin: 0;
    padding: 0;
    overflow: hidden;
    /*background-color: #333333;*/
    margin-bottom: 1em;
}

.taxonomy-plan-professional ul.priceplan,

.taxonomy-plan-business ul.priceplan,

.taxonomy-plan-enterprise ul.priceplan {
    display: inline-block;
    border-radius: 8px;
}

ul.priceplan li {
    float: left;
    display: inline-block;
    color: #bbb;
    text-align: center;
    padding: 20px;
    background-color: #eee;
}

ul.priceplan li.planlabel {
    color: #444;
    font-weight: bold;
}

.taxonomy-plan-professional .professional,

.taxonomy-plan-professional .business,

.taxonomy-plan-professional .enterprise,

.taxonomy-plan-business .business,

.taxonomy-plan-business .enterprise,

.taxonomy-plan-enterprise .enterprise {
    color: #444;
}

.taxonomy-plan-professional .professional:before,

.taxonomy-plan-professional .business:before,

.taxonomy-plan-professional .enterprise:before,

.taxonomy-plan-business .business:before,

.taxonomy-plan-business .enterprise:before,

.taxonomy-plan-enterprise .enterprise:before {
    content: '\f00c';
    font-family: FontAwesome;
    margin-right: 0.5em;
    color: #1976d2;
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}

Note how the selector names match the class names used in the JavaScript and that there are
selectors to cover every possible combination of taxonomy tags.

Use Title Abbreviations
Abstract

Use the titleabbrev element to give your topics a shorter, alternative title.

The titleabbrev element is useful if you have long titles, but would prefer a shorter title in the
table of contents (PDF), contents bar (HTML5) and for cross-references.

When you publish content with titleabbrev elements, the table of contents (PDF), contents bar
(HTML5) and cross-references will use the titleabbrev text as the title, but the main topic will
continue to use the topic's title.

Example 40. Alternative title - Title abbreviations
For example, if you have a topic called "Configure the Wifi Connections for your ACME 100". The title
is quite long and can make the HTML5 content bar appear cluttered. For a neater look, you can
use the titleabbrev element to add the alternative title "Wifi".

To add an alternative title to a topic:

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].
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2. Position the cursor between the title element and the first para element.

3. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

4. Enter titleabbrev and select it from the menu.

5. Position the cursor inside the titleabbrev element.

6. Enter the text for the alternative title.

7. Select Save. 

Admonition Styles (HTML)
Paligo has several admonitions that you can use in your content, including note, warning, danger,
important and tip. Each admonition has its own default styling, but you can customize their
appearance if needed.
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For HTML publications, use CSS to style the admonitions. You add the styling information to a
CSS file and then upload that to the HTML layout that you will use for publishing. The following
sections explain how to make some of the most common changes:

• Change the Color of Admonitions [761]

• Hide the Labels for Admonitions [763]

• Change the Symbol for Admonitions [764]

NOTE
For PDFs, use the Admonitions settings on the PDF layout [799].

Change the Color of Admonitions
You can use CSS to change the color of the admonitions for HTML outputs. For example, you could
change the default green colors and black text of a note to blue with white text.

NOTE
For PDFs, use the Admonitions settings on the PDF layout [799].

For each admonition, you can change the color of the:

• Left-margin border

• Background

• Symbol

• Label text

• Body text

To change the colors for admonitions:

1. Use a code editor or text editor to create a CSS file. Give it a name and save it with the .css
extension.

2. Add the CSS for styling the admonitions.
This example shows how to change the color of the various parts of a note:

/* This part changes the color of the left-
margin border and the background  */

.note {
border-left-color:#c5c6c8;
background-color:#0540f0;
}
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/* This part changes the color of the symbol  */

.note::before {
color:#ffffff;
}

/* This part changes the color of the label  */

.note h3 {
color:#ffffff;
}

/* This part changes the color of the body text  */

.note > p {
color:#ffffff;
}

When you add your own CSS, replace the color codes with those for the codes you want to
use.
To style the other admonitions, add extra code and replace .note with the name of the
admonition, for example, .warning.

/* This part changes the color of the left-
margin border and the background  */

.warning {
border-left-color:#c5c6c8;
background-color:#0540f0;
}

/* This part changes the color of the symbol  */

.warning::before {
color:#ffffff;
}

/* This part changes the color of the label  */

.warning h3 {
color:#ffffff;
}

/* This part changes the color of the body text  */

.warning > p {
color:#ffffff;
}

Note that the danger admonition is called .warning.danger.
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TIP
If you want to learn about CSS, this CSS Tutorial covers the basics and has
links to more resources.

3. Save your CSS file.
You can then Upload Customized CSS [662] in Paligo.
When you publish content using the HTML layout, the CSS styles you have added will be
included in the published output. Your custom styles take priority over the built in styles.

Hide the Labels for Admonitions
By default, each admonition has a text label that is shown before the admonition text. For
example, the warning admonition has a "Warning" label. For HTML outputs, you can use CSS to
hide the labels if you prefer to use admonitions that only use an icon.

Warning with "Warning" label shown.

Warning with "Warning" label hidden and extra spacing applied to warning text.

NOTE
For PDFs, use the Admonitions settings on the PDF layout [799].

To use CSS to hide or show the admonition labels:

1. Use a code editor or text editor to create a CSS file. Give it a name and save it with the .css
extension.

2. Add the CSS for styling the admonitions.
To control whether admonition labels are shown, use this CSS:

.caution h3, .important h3, .note h3, .tip h3, .warning h3{
    display: none;
}

This sets the labels for all of the admonition types (caution, important, note, tip, and warning)
to be hidden. If your labels are already hidden and you want them to be shown, change
display:none; to display:block;
If you hide the label, you may also want to add some extra spacing for the body text of the
admonition, so that it is aligned with the top of the admonition icon. To do that, add this code
to your CSS:

.warning > p, .note > p, .important > p, .caution > p, .tip > p {
    margin-top: 10px;
}

Paligo Documentation

763

http://www.w3schools.com/css/


This gives the text a 10px margin at the top, which is the same amount of spacing that is used
for the icon, by default. If you have customized the position of the icon, you will need to adjust
the text top margin to match your icon spacing.

TIP
If you want to learn about CSS, this CSS Tutorial covers the basics and has
links to more resources.

3. Save your CSS file.
You can then Upload Customized CSS [662] in Paligo.
When you publish content using the HTML layout, the CSS styles you have added will be
included in the published output. Your custom styles take priority over the built in styles.

Change the Symbol for Admonitions
For HTML outputs, the admonitions use a symbol from Font Awesome 4.6.3. This means you can
change the symbol by creating custom CSS that references a different symbol.

Warning with a different symbol to the default symbol.

NOTE
For PDFs, you can change symbols by uploading your own symbol in the
Admonitions settings on the PDF layout [799].

To use CSS to change the symbol for HTML publications:

1. Refer to the Font Awesome icon set to find the icon you want to use. You can use any icon in
version 4.6 or earlier. Make a note of its code.

2. Use a code editor or text editor to create a CSS file. Give it a name and save it with the .css
extension.

3. Add the CSS for styling the admonitions.
To change the symbol for a note, use this CSS:

.note:before {
    content: '\f12a';
    font-family: FontAwesome;
}

Here, we have used f12a as the example code for a Font Awesome symbol. You will need to
replace that with the code for your chosen icon.
When you add the icon, you may want to make other changes. For example, you might want
to adjust the spacing of the icon or its color. You can do that by setting its styles. Here is an
example of some styling for a note, where the color is set and the font size and top margin
spacing have been increased.
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.note:before {
    content: '\f12a';
    color: #2ab27b;
    font-size: 30px;
    top: 30px;
    font-family: FontAwesome;
}

To style the other admonition types, add extra code, and replace .note with the name of the
admonition, for example, .warning.

.warning:before {
    content: '\f12a';
    color: #2ab27b;
    font-size: 30px;
    top: 30px;
    font-family: FontAwesome;
}

Note that the danger admonition is called .warning.danger .

TIP
If you want to learn about CSS, this CSS Tutorial covers the basics and has
links to more resources.

4. Save your CSS file.
You can then Upload Customized CSS [662] in Paligo.
When you publish content using the HTML layout, the CSS styles you have added will be
included in the published output. Your custom styles take priority over the built in styles.

Breadcrumb Homepage Link
The HTML5 help center has a "breadcrumb" at the top of the page and it shows the path from
the home page to the currently displayed topic. Each part of the breadcrumb is a link that you can
select to go to that topic. By default, the home link is named the same as your publication and if
you select it, the default topic for the publication is shown. You can change this behavior so that
the home link displays a different page of your choice.
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To change the breadcrumb homepage link:

1. Use a text editor to create a javascript (.js) file. If you already use a custom javascript file for
your publication, you can edit that file instead.

2. Add the following code to your javascript file:

$(document).ready(function () {
    $('.breadcrumb .breadcrumb-link:first-child a').attr('href', '/
index.');
});

NOTE
if you are editing a javascript file that you already use for Paligo publications,
just add this line:

$('.breadcrumb .breadcrumb-link:first-
child a').attr('href', '/index.');

It needs to be anywhere after the opening $(document).ready(function ()
{ and before the }); in your script.

3. Change the 'index.html' part to an absolute URL for the page that you want the breadcrumb
link to go to. The URL needs to define the route from the server to the index.html file. As an
example, the Paligo help center has this:

$(document).ready(function () {
    $('.breadcrumb .breadcrumb-link:first-child a').attr('href', '/docs/
index.html');
});

4. Save your javascript file.

5. In Paligo, select Layout and then select the Layout that you want to use for your HTML5
output.
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6. In the Layout Editor, select CSS, JS, logos and other assets.

7. Use the Custom Javascript setting to upload your javascript file.

8. Select Save.

When you publish with this layout, the custom javascript is included. In the published output,
it will tell the browser to display the page you included in the javascript when the breadcrumb
homepage link is selected.

Google Fonts in HTML5 Output
If you want to use Google fonts in your HTML5 help center, you can import them by using CSS.
There's no need to add them to Paligo's HTML5 output.

To import Google fonts:

1. Browse to fonts.google.com and choose the fonts that you want to use. Depending on the
fonts, you can choose different weights and languages too.

2. Get the import url for your font selections.

NOTE
It's important that you use the import url for the font(s) and not the standard
embed url (they are different).

3. Use a CSS editor to create a CSS file.

4. Add the following code to your CSS file:

@import url('');

5. Copy the import url for your selected fonts inside the single quotation marks:

@import url('https://fonts.googleapis.com/
css?family=Open+Sans:300,300i,400,400i,600,600i,700,700i,800,800i|
Roboto&subset=cyrillic,cyrillic-ext');

6. In the CSS file, apply the fonts to the classes that you want to style. For example, to style the
body class you could use:
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body {  
font-family: 'Open Sans';  
font-size: 22px;
}

7. Save your CSS file.

8. In Paligo, select Layout and then select the Layout that you want to use for your HTML5
output.

9. In the Layout Editor, select CSS, JS, logos and other assets.

10. In the CSS field, upload your CSS file and then select Save.

When you use the Layout for publishing, the HTML5 output will include the CSS file. When a user
visits your help center, the browser will import the fonts from Google.

Add a Custom JavaScript to a Layout
You can use JavaScript to change your HTML output after they have been published. For example,
you can use JavaScript to change the icons that are shown for the categories on the help center
portal page.

To add a custom JavaScript file to a layout:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select CS, JS, logos, and other assets in the left menu.

4. Scroll down to the Custom Javascript section.

5. Select Upload and choose the custom JavaScript you want the layout to use.

6. Select Save.
When you use this layout to publish content, the JavaScript will be included in the output.
When an end-user opens the help, their browser will run the JavaScript and apply the
customizations.
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HTML Help Center without Internet Connection
The HTML help center output is designed to reference some external services via the Internet.
These services include MathJax and advanced search engines such as Algolia and Elastic/Swiftype.
But if you need to use a help center without an Internet connection, that's possible too, although
you will not be able to use the Internet-dependent services.

For an "offline" help center, you should:

• Disable the Internet-dependent services in the layout for your publication

• Store videos and other external files on a static network address that is the same for all users.

To set up an "offline" HTML help center output that calls no external resources:

1. Select Layout and edit the layout you are going to use for publishing.

2. In the layout options, select the Search engine settings.

3. Disable Use Algolia Search and make sure that the Use Elastic Site Search field is empty
(blank):

4. In the layout options, select the Analytics and other integrations settings.

5. Disable the Use cookie consent popup and Enable MathJax equation rendering features:

6. In the layout options, select the Verbatim (code and software) settings.

7. Disable the Highlight verbatim elements feature:

8. Select Save.
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When you use this layout to publish your HTML help center, the output will not use any
features that require an Internet connection. The output will use Paligo's built-in search
feature and is suitable for use offline.

9. If you want to use videos in your topics, store the video files in a folder that has a static
address on your network. It needs to be the same address for all users. Then, when you edit
a topic, insert a video and enter the address of the video on your network. The same principle
applies if you want to add links to external files - put the files in a folder with a static address
and link to them there.

Choose HTML5 Start Page
By dedicating a topic as a start page and activating the start page feature for the HTML5
configuration, you can choose a different start page for the HTML5 Help Center.

NOTE
This feature is primarily for single language publications, since the language
selection occurs on the index.html page. It can still be used for multi-language
publications, but the redirect will occur to the default output language.

Create a Start Page
To be able to choose a different start page for the HTML5 Help Center, the topic (that is to be the
start page) has to be updated with the start-page role. If there are several topics with this setting, it
will be the topic with the topmost position that will be used.

TIP
You probably want to set this on a topic that will become a page of its own. But
it will actually work on internal sections, reused components or sections that has
been chunked to internal sections as long as it is part of the TOC.

1. Create a new topic [131] or open an existing topic.

2. Select the top section in the Element Structure Menu [52] and choose Go to element.

3. Add the attribute Role in Element Attributes Panel [55].
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4. Add the value start-page.

5. Select Save. 

Activate HTML5 Start Page
The ability to choose a different start page for the HTML5 Help Center must be activated via the
Layout tab. By enabling this setting, the topic that has a start-page role will become the start page.

NOTE
If this setting is enabled and no topic is found having the start-page role, the
redirect will go to the so called "publication page". That is the en/index-en.html
for an English publication or to sv/index-sv.html for a Swedish publication.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select General.
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4. Scroll down to Choose start page by role for HTML5 Help Center.

5. Select Enabled from the menu.

6. Select Save.

Copy Code to Clipboard in HTML
Paligo has a Copy to Clipboard feature that you can use with your code samples. When the feature
is enabled, a copy button appears for each programlisting element, and your readers can use it
to copy the code sample inside the element to their computer's clipboard. This makes it easier for
your readers to use the exact code from your samples as a starting point for their own programs.

To turn the copy code feature on or off:

1. Select Layout and then edit the HTML5 layout you are going to use for publishing.
Alternatively, you can create a new HTML5 layout and edit that.

2. In the layout options, select the Verbatim (code and software) settings.
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3. Use the Add copy to clipboard button to all programlistings setting to control whether a
copy button is included:

• Set it to 1 to include the copy button for every programlisting element in your HTML5
output.

• Set it to 0 or default if you do not want the copy button to appear for your code samples.

4. Select Save.

When you publish your content using this layout, the programlistings will have a copy button if
you chose to enable the feature.

Column Filter and Sticky Header for Tables
Abstract

Learn how to add a column filter and sticky header to tables in Paligo. You can apply these
extra-responsive features to all tables or individual tables.

All tables in Paligo's HTML5 outputs are responsive by default, so will adapt to the amount of
space that is available on the reader's device. Even so, large tables can be difficult to use on
smaller screens, especially wide tables with lots of columns. To help with this, Paligo has extra
responsive table features , which you can turn on in the HTML5 layout. When enabled, the extra
responsive features add:

• Column filter
This adds a Filter button above the table. Readers can select it to display a list of the columns,
and can then choose which columns the table shows. They can make the table smaller by setting
it to only show those columns that they need at that particular time.
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• Sticky header
The header of the table will be shown at the top, even when the reader scrolls down. This is
especially useful with very long tables where the reader wants to scroll down the table, but still
needs the header visible so that they can understand the context of each column. As they scroll
down, the table header "sticks" in place at the top, so only the table rows scroll up and down.

To control these "extra responsive table" features:

1. Select Layout in the top menu and either create a new HTML5 help center layout or edit an
existing HTML5 help center layout.
For more details, see Create a Layout [1059] and Edit a Layout [1061].

2. Select Table styles.

3. Use the Extra Responsive Table Features setting to control the table column filter and the
table sticky header.
Choose:

• Disable (or Default) to turn off the table column filter and table sticky header for all tables.

• A number from 3 to 15 to turn the extra responsive features on and define when they will
appear. The numbers relate to the number of columns in tables. For example, if you set it to
5, the table column filter and table sticky header will only be used for tables that have 5 or
more columns.

• Only selected if you only want to use the table column filter and table sticky header on
certain tables. You will need to use the role attribute to specify which tables should use the
extra responsive features (see next step).

4. This step only applies if you chose Only selected in step 3.
For each table that you want to use the extra responsive features:

a. Open the topic that contains the table.

b. Select the table's table element.

c. In the Element attributes panel, select Add attribute, search for the role attribute and
add it.
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d. Set the value of the role attribute to:
extra-responsive

5. If there are images in your table, select the imagedata element for each image and make
sure that it does not have a width attribute. If there is a width attribute, delete it from the
Element attributes panel. This is because some extra-responsive table features cannot work
correctly if images have a fixed width.

6. Select Save.

Title Numbering and Auto-Labels in HTML
Some elements, such as tables and examples, can have titles. By default, these titles consist of an
auto-generated label, a number, and a number delimiter, for example, "Table 1. Specifications".
Depending on your requirements, you can set Paligo to include or exclude the title numbers and
labels.

To turn on/off the numbering on titles for HTML outputs, you need to edit your HTML layout so
that Paligo creates span classes for your titles. Then you can use CSS to control the visibility of
those span classes so that the numbering is shown or hidden.
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1. Select Layout and then edit the HTML5 layout you are going to use for publishing.
Alternatively, you can create a new HTML5 layout and edit that.

2. Select Formal Elements.

3. Set Use separate styling for label, number and title in formal elements to enabled.
When enabled, this setting adds <span> to the HTML and class names so that each part can
be styled differently using CSS.

4. Use a code editor or text editor to create a CSS file. Give it a name and save it with the .css
extension.

5. Use CSS to hide the title numbers and also the auto-generated label.
Each element that has a title has a div and a class name in the HTML. There are also spans for
each part of the title. For example, the HTML for a table title has this:

<div class="table-title">
    <span class="formal-label">
        <span class="formal-label-text">Table</span>
        <span class="formal-number"> 1</span>
        <span class="formal-label-delimiter">. </span>
    </span>
    <span class="formal-title">table title</span>
</div>

In your CSS, use selectors to choose which parts you want to include or exclude. For example,
to hide a table's label, number, and the delimiter after the number, use this CSS:

.table-title .formal-label {
    display:none;
}

If you wanted to keep the auto-text label but hide the number and delimiter, use:

.table-title .formal-number, .table-title .formal-label-delimeter {
    display: none;
}

The other elements with titles have similar classes, for example, the example element has
an .example-title class with span classes for formal-label, formal-label-text, formal-number,
and formal-label-delimeter.

TIP
If you publish your content to HTML and view it in a browser, you can use the
browser's inspect tool to view the HTML code and classes. You can also test
changes to the CSS. To find out more, see Branding your HTML Outputs with
CSS [654].

6. Save your CSS file and upload it to your HTML layout. You can upload it in the CSS, JS, logos
and other assets settings, in the CSS field.

Use H1 Headings for HTML Pages
HTML5 layouts have a Use H1 headings for topic chunks setting that you can use to control how
<h1> headings are applied to your content. Typically, you will use this feature for SEO purposes, as
it can be better to have <h1> for the main heading on each page in the output.

To change how Paligo applies <h1> headings to your HTML5 output:
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1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select TOC and chunking.

4. Set Use H1 headings for topic chunks to either:

• Publication hierarchy
Paligo will apply the heading levels based on where the topic appears in the publication
structure. This means that the top-level publication will get <h1> and your top-level topics
will get <h2> for their main headings.

• Top-level
Paligo will apply <h1> headings to the top-level publication and the top-level topics.

• Chunk
Paligo will apply <h1> headings to every topic that is a "chunk". A "chunk" is a topic that is
set to appear on its own page, for details, see Chunking [780].

• Default
To inherit the setting from the base layout. If the base layout is a "built-in" layout provided
by Paligo, the inherited setting is Publication hierarchy. If the base layout is a different
layout, it could be Top-level or Chunk, depending on what is set in the other layout.

Typically, it is better to use the Top-level or Chunk options for SEO purposes.

NOTE
To see how the Publication hierarchy, Top-level, and Chunk options affect
the output, see the examples at the end of this section.
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5. Select Save.

When you publish, Paligo will apply your choice to the output.

Example 41. H1 headings based on publication hierarchy

Let's say you have a user guide and 4 topics at the top-level inside the publication. You have set
your HTML5 layout to have Use H1 headings for topic chunks set to Publication hierarchy.
When you publish, Paligo will apply <h1> headings based on the position of each topic in the
publication structure.

The publication (1) has a topic too, so in the output, that is at the top level and it gets <h1> for its
main heading. The topics (2) will get <h2> for their main heading, as they are at the second level in
the publication structure.

Example 42. H1 headings for top-level topics

Let's say you have a user guide with 4 topics at the top-level inside it. There are also 2 topics at
the next level down. You have set your HTML5 layout to have Use H1 headings for topic chunks
set to Top-level. When you publish, Paligo will apply <h1> headings to every top-level topic in your
publication.

The publication (1) has a topic too, so in the output, that is at the top level and it gets <h1> for
its main heading. The top level of topics inside the publication (2) will also get <h1> for their main
heading. The lower-level topics (3) will get <h2> as their main heading, as Use H1 headings for
topic chunks is set to Top-level and the lower-level topics are second-level topics (third-level if
you include the publication topic).

Example 43. H1 headings for chunks

Let's say you have a user guide with 4 topics at the top-level and 2 second-level topics, like this:
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In this example, the publication "Acme User Guide" (1) is at the top. Inside the publication, the
top-level topics (2) are "Introduction", "Quick start", "Troubleshooting" and "Reference material".
The second-level topics (3) are "Cooling recommendations" and "Humidity recommendations".

Inside the "Cooling recommendations" topic, it has been set to chunk (it has an xinfo:chunk
attribute with a value of Yes). So this topic will be on its own page in the output, even though it
appears at a lower level in the publication structure.

Inside the "Humidity recommendations" topic, it has been set to not chunk (it has an xinfo: chunk
attribute with a value of No).

In your HTML5 layout, you have set Use H1 headings for topic chunks set to Chunk.

When you publish, Paligo will apply <h1> headings like this:

• Acme User Guide publication topic gets <h1> for its main heading

• Introduction gets <h1> for its main heading

• Quick start gets <h1> for its main heading

• Troubleshooting gets <h1> for its main heading

• Reference material gets <h1> for its main heading

• Cooling recommendations gets <h1> for its main heading and it appears on its own page, even
though it is a lower-level topic. It is not shown as subsection of "Reference material" as it is set to
be a chunk.

• Humidity recommendations gets <h2> for its main heading as it is set to not chunk. It appears as
a subsection on the parent "Reference material" page.

Chunking
Use chunking to control which sections will become a separate web page in an HTML / HTML5
output. The term "chunk" means that a topic has to be on its own and will always appear on a
separate web page. By using the Layout editor, you can set the:

• TOC section depth that defines the topic levels shown in the table of contents (TOC).

• Chunk section depth that defines the topic levels that will appear on a separate web page in
the HTML / HTML5 output. This is by default set to 3, which means that all sections from level 1
to 3 will appear on their own web page. Any lower level topics will appear as subsections of their
immediate parent topic. To learn more, see TOC and Chunking [689].
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TIP
You can override the Chunk section depth by adding the element attribute
xinfo:chunk to a topic. The topic will then appear on a separate web page,
even if it is on a lower level than defined in the Chunk section depth, see Use
Chunking to Control Subsections [167].

CAUTION
If you set the Chunk section depth higher than the TOC section depth, the
topics on the lowest level will not be included in the TOC and will be harder to
find.

Rules of Chunking
The following will explain the possible settings when adding the element attribute xinfo:chunk
to a section.

NOTE
Only topics are counted in the Chunk section depth. Subsections or components
(reused sections) in a topic are not counted. They are always considered as
subsections in the parent topic.

Value Description

xinfo:chunk="yes" Means that the section starts a new HTML page and merges child sections as
subsections on the same page.

xinfo:chunk="yes" If above the Chunk section depth, a page is created for the chunk section, but not for
the subsection at Chunk section depth.

xinfo:chunk="yes" If below the Chunk section depth, a page is created for the chunk section and it will not
be part of the page at Chunk section depth.

xinfo:chunk="yes" You can add it on a subsection or reused section in a topic to create a new page.
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Value Description

xinfo:chunk="no" Means that the section will be a subsection on the previous page.

xinfo:chunk="no" If above the Chunk section depth, a page will not be created and the section will be a
subsection in the parent page.

xinfo:chunk="no" is below the Chunk section depth, it will have no effect, as all sections below Chunk
section depth are already subsections of the previous page.

xinfo:chunk="default" Means that the chunking will follow the defined Chunk section depth for the HTML /
HTML5 layout. Same as for value No.

HTML5 Search Engines
HTML5 outputs, such as HTML5 help centers use a search engine. The search engine allows
readers to enter a search term and find relevant results. Depending on what search engine is used
and how it is set up, readers may also be able to apply further filters to narrow down their choice.

There are several different search engines you can use with your HTML5 output, each with
different capabilities and benefits.

Two of the search engines are built-in JavaScript-based search engines that have the benefit of
providing a relatively fast search with virtually no setup, and will work even on a local HTML
package without internet connection.

The following sections provide a basic summary of each search engine, so that you can
understand the differences and then make an appropriate choice.

NOTE
For advanced search requirements Paligo offers a number of high end search
engine options.

These options are recommended to achieve the best and fastest search, more
configuration options and / or massive content.

Fuzzy Matching Search
Fuzzy search or "fuzzy matching" is a lightweight javascript-based search. It is available as a built-in
feature of Paligo and has these characteristics:

• Can be used with a local HTML package without internet connection, because it's JavaScript-
based with a local index.

• Allows for typing mistakes. For example, if you search for "THML" the search engine will still find
matches for "HTML".

• Supports any language.

• There are options for how to produce the search results, directly on typing, or by pressing the
Enter key for example.

• "Fuzzy matching" allows for characters to be in the wrong order or missing. So if you search
for "book", you may also get results for "hook", "look", etc. This also means search results will
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be broader, and can in some cases be less exact than the "Linguistic search" option below. You
need to decide what works best for you.

• The fuzzy search option is fast on small content, but is slower than the linguistic search when
the content gets larger.

NOTE
You can enable "fuzzy matching" in your HTML layout [680].

Linguistic Search
The default "linguistic" search is a lightweight, javascript-based search. It is available as a built-in
feature of Paligo and has these characteristics:

• Can be used with a local HTML package without internet connection, because it's JavaScript-
based with a local index.

• Provides results based on an exact match for the search term. For some content, this can be
better than fuzzy matching search, as it is more precise.

• Very fast for for small-to-medium-sized content, approximately the equivalent of a 1000 page
printed document.

• Language aware, so includes different grammatical variants of words. Being language aware also
means that while it will support many languages, the number of languages is more limited than
the fuzzy search, because each language needs to be specifically supported by language parsers
included.
The languages with the following language codes are supported: "de fr es it ja du da pt fi ro hu
ru no th tr sv".

• Supports wildcards to match partial words, for example, "auto*" will match any word beginning
with auto, including "auto", "automatic", etc.

NOTE
To use default linguistic search, make sure that "Fuzzy matching" is disabled on
your HTML layout [680]. Linguistic search is used by default when fuzzy matching
is disabled.

Algolia Search
This is a high end search engine provided by an external service, Algolia. It is one of the most
powerful search engines available on the market and requires you to have an Algolia subscription.
Algolia search has these characteristics:

• Extremely fast, even on large amounts of content.

• Provides much more control over how the search works and how results are ranked.

• Supports faceted-search, where a user can filter the results after the initial search.

• Can search content published to a web server or local, standalone web content (internet
connection is required)
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• Does not need access to your help center website. With Algolia the index data is "pushed" to the
Algolia service. If you prefer a crawling service, where the index data is "pulled", see Swiftype
Search [784].

IMPORTANT
To use Algolia with Paligo, you need an Algolia account. You can set up the
connection between Paligo and Algolia in the integration settings.

Swiftype Search
Swiftype search, also known as Elastic search, is a powerful search engine provided by an external
service. It requires you to have a Swiftype subscription and has these characteristics:

• Extremely fast, even on large amounts of content.

• Provides much more control over how the search works and how results are ranked.

• Supports faceted-search, where a user can filter the results after the initial search.

• Only searches content that is published to a web server without authentication.

• Needs access to your help center website. With Swiftype the index data is "pulled".

NOTE
If you prefer a search service where the index data is "pushed", see Algolia
Search [783].

TIP
To find out how to connect Paligo and Swiftype, see Swiftype Search [1524].

Customized Search
If you are on the Business plan or higher, and you want your Paligo content to use a different
search engine, you can request a customization. For this, you should:

• Ask support to have the parameter other.custom.search enabled in your configuration.

• Provide support with details of the search engine you would like to use.

• Request an estimate for adding the custom code for your selected search engine.

We will then investigate what work is required and provide you with an estimated cost of
development. You can then decide whether you want to go ahead with the customization.

Manage Section Numbering in HTML5
You can choose to have numbered headings, such as "1.2 Power up the device" in your HTML5
output. Typically, you apply numbering to all sections (by enabling General > TOC and Chunking >
Section Numbering in the Layout Editor) or to not use numbered headings at all.
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But there may be times when you need a mix of numbered headings and headings without
numbering and for that, you can use the element attribute label.

When you publish topics that use this element attribute, Paligo will not apply numbering to its
heading, even if the publication is set to use numbered headings. The heading will appear as
text-only, both in the topic itself and in the table of contents.

To prevent a topic from being auto-numbered:

1. Select the Dotted menu (...) for the topic in the Content Manager [34].

2. Select Edit and choose Open in editor. 

3. Select the section element in the Element Structure Menu [52].

4. Choose Go to element.

5. Add the element attribute label in the Element Attributes Panel [55].

The 0 value instructs Paligo to avoid using numbering for this section.

6. Set the value to 0.

7. Select Save. 

NOTE
To enable numbering again, remove the label attribute.

Add a Canonical URL Link
Abstract

Discover how to add canonical URL links to pages in your HTML5 outputs in Paligo. The HTML5
layout has an add canonical URL link option.

Reused content can confuse search engines, as they see the same, or similar, content at different
addresses (URLs). This can have a negative effect on SEO. To solve this issue, you can set Paligo to
add a canonical URL link to each page in your HTML5 help. This tells the search engines that each
page should be indexed as a unique page, even though the content on it may be the same as on
other pages.
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NOTE
If you enable ajax loading in the layout, the canonical URL link feature may not
work. This is because ajax loading removes the <head> element from the HTML.
The canonical URL link is added to the <head> section.

To set Paligo to add a canonical URL link:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select CSS, JS, logos and other assets.

4. Set Add canonical URL link to:

• Enable
Paligo will add a canonical URL link to every HTML page in the output.
The canonical URL link uses this format:

destination.domain + lang + '/' + relative-page url

Where lang is the language and relative-page url is the relative address of the page, for
example, "en/getting-started.html"

• Enable (Promote destination path as canonical)
This works in the same way as Enable except that Paligo will also remove the index.html
part of the URL for the Help portal page (index.html)

• Disable
Paligo will not add a canonical URL link to any page.

• Default
To inherit the value for this setting from the base layout. The base layout is either a built-in
layout provided with Paligo or is another custom layout.
To find out more, see Layout Relationships - Base, New, Duplicate [1055].
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5. Select Save.

When you publish with this layout, Paligo applies the canonical URL setting to your output.

If you enabled canonical URLs, the canonical link will appear in the <head> section of the HTML.

Include TOC in HTML or Load Standalone TOC
For your HTML and HTML5 outputs, the HTML files need to reference the publication's table of
contents (TOC). There are two ways to handle this:

• Include the TOC in each HTML file
This minimizes the use of JavaScript, but results in larger HTML files.

• Have the TOC separate to the HTML files and use JavaScript to insert the TOC when each HTML
page is displayed
This is more efficient, as the HTML files are smaller and so load more quickly, which is better for
SEO.

To control how Paligo includes the TOC, use the Standalone TOC setting on HTML and HTML5
layouts:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select TOC and chunking.

4. Set Standalone TOC to either:
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• Enable
To set Paligo to use JavaScript to insert the TOC from a separate file. This is more efficient,
as the HTML files are smaller and so load more quickly, which is better for SEO.

• Disable
To set Paligo to include the TOC in each HTML in the HTML/HTML5 output. This minimizes
the use of JavaScript, but results in larger HTML files.

• Default
To inherit the setting from the base layout. If the base layout is a "built-in" layout provided
by Paligo, the inherited setting is Disable. If the base layout is a different layout, it could be
Enable or Disable, depending on what is set in the other layout.

Typically, it is better to enable the Standalone TOC feature, but in some cases, it can have
undesired results. For example, if your help portal is configured to minimize the use of
Javascript. It can also make your help port less "crawlable" by older search engine bots.

5. Select Save.

When you publish, Paligo will apply your choice to the output.

Set the Position of JavaScript References
Paligo HTML5 outputs use JavaScript to provide various features and you can also upload your
own JavaScript. To use the JavaScripts, your HTML files have to reference them. Paligo applies the
references automatically and by default they appear in the <head> element of your HTML files. If
you prefer, you can set Paligo to add the JavaScript references near the bottom, just before the
closing </body> element.

Typically, having JavaScript references at the end of your pages is better for SEO, as it means the
pages will load quicker. But for some scripts, it may be a requirement to reference them in the
<head> element.

To control where Paligo inserts the JavaScript references:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select CSS, JS, logos and other assets.

4. Set Place scripts at the end of the body tag to either:
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• Enable
To set Paligo to place JavaScript references near the end of the HTML in each page, before
the closing </body> element..

• Disable
To set Paligo to place JavaScript references near the top of the HTML in each page, in the
<head> element.

• Default
To inherit the setting from the base layout. If the base layout is a "built-in" layout provided
by Paligo, the inherited setting is Disable. If the base layout is a different layout, it could be
Enable or Disable, depending on what is set in the other layout.

5. Select Save.

When you publish, Paligo will apply your choice to the output.

Upload a Robots.txt File
Webmasters can create a robots.txt file and upload it to a Paligo HTML5 layout. When the layout is
used for publishing, Paligo will include the robots.txt file in the output. The entire output can then
be placed on a web server, so there's no need to add the robots.txt file manually after publishing.

To upload a robots.txt file:

1. Create a robots.txt file in a third-party application. You must name the file robots.txt.

NOTE
Take care when creating your robots.txt file as it is possible to hide parts of
your documentation site if you configure it incorrectly. We recommend that
robots.txt files are only created by experienced web designers or developers.

2. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

3. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

4. Select CSS, JS, logos and other assets.

5. In the Add a robots.txt file section, select Upload and then drag and drop your robots.txt file
onto the upload dialog.

6. Select Save.

When you use this layout to publish content, Paligo includes the robots.file in the output .zip file.

Add a Feedback Section for Topics
For HTML5 Help Center outputs, you can add a feedback section to the bottom of each published
topic. It is designed to encourage readers to score your content (positive or negative) and provide
constructive criticism. This is valuable information as it lets you know which topics are successful
and which ones are not meeting your users' needs.

By default, the feedback section has:

1. Voting panel text.
A text message that you can use to encourage people to respond. To change the text, see
Change the Feedback Text [792].

2. Voting panel (Yes and No voting buttons).
Each button has a unique ID that makes it possible to track votes by using a third-party
analytics application.
We recommend that you do not change the text of the buttons as they are automatically
translated into other languages. If you change the text, you will also need to provide
translations.

3. Email feedback link.
To get constructive feedback, rather than just statistics on the content's success, you can
include an email link. When a user selects the link, the browser opens an email client and can
then send a message.
To change the text for the link, see Change the Feedback Text [792].

To set up the feedback section (or turn it off if you prefer):
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1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Feedback.

4. In the Use voting panel section, choose to include or exclude the voting panel (Yes or No
vote):

• Enable
Sets Paligo to include the voting panel at the bottom of your help pages.

• Disable
Sets Paligo to create your help pages without a voting panel (or its title) at the bottom.

• Default

To inherit the value for this setting from the base layout. The base layout is either a built-in
layout provided with Paligo or is another custom layout.

To find out more, see Layout Relationships - Base, New, Duplicate [1055].

5. Choose whether you want to Allow users to submit feedback (suggest edits):

• Enable
Sets Paligo to include an email feedback link at the bottom of your help pages.
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• Disable
Sets Paligo to create your help pages without an email feedback link.

• Default

To inherit the value for this setting from the base layout. The base layout is either a built-in
layout provided with Paligo or is another custom layout.

6. Use Toggle feedback with voting panel to control when the email feedback link is shown.

• 'No' button only
The email feedback link is only shown after the reader selects the No button.

• Both 'Yes' and 'No' button
The email feedback link is shown after the reader selects the Yes or No button.

• No toggle - always visible
The email feedback link is shown and is not dependent on the user selecting the Yes or No
button.

NOTE
This setting only applies if you have set Allow users to submit feedback
(suggest edits) to Enable.

7. In the Email for feedback field, enter the email address that will receive the feedback email
from your readers.

8. Select Save.

When you publish your HTML5 help center using this layout, Paligo will apply the feedback panel
settings you have chosen.

Change the Feedback Text
You can set your HTML5 outputs to have a feedback section at the bottom of your help pages
(HTML5 Help Center). It is designed to encourage your readers to rate your content and provide
suggestions for improvements. By default, the feedback section has a voting panel with a title
("Was this helpful?") and yes and no buttons. It also has an email hyperlink with the text "Would
you like to provide feedback? Just click here to suggest edits".
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To change the text above the buttons and below the buttons, use JavaScript (see the example
scripts included in this article). We recommend that you do not change the buttons on the text as
these are translated into other languages automatically.

NOTE
To change the text above and below the buttons, add both scripts to a single
JavaScript file and upload it to your layout.

Change the Feedback Text Above the Buttons
To change the text that appears above the feedback buttons:

1. Use a third-party code editor or text editor to create a JavaScript file (with file extension .js, for
example, mycustomscript.js).

NOTE
If you already use a custom JavaScript with your layout, open that JavaScript
in a code-editor and add the code in the next step to it.

2. Enter the following JavaScript:

/* Voting comment */
$(document).ready(function () {
    var lang = $(document.documentElement).attr("lang");
    if (lang in voteDict) {
      var text = voteDict[lang];
      setVotingText(text);
      $(document).ajaxComplete(function () {
        setVotingText(text);
          });
      }
  });
  function setVotingText(text) {
    var element = $(".voting-title").text(text);
  }
  /* Change text here */
  var voteDict = {"en" : "Did you like this article?"};

3. To change the text, edit this line in the script:

var feedbackLinkDict = {"en" : "Did you like this article?"}; 

For English, replace "Did you like this article?" with the text you want. It must be enclosed in
double quotes, for example:

var feedbackLinkDict = {"en" : "Did you find this article helpful?"};
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For each additional language, add the language code and the text, for example, here we have
added "de" for German and set the text to "E-Mail-Vorschläge an Paligo?".

var feedbackLinkDict = {"en" : "Did you find this article helpful?",
                        "de" : "Fanden Sie diesen Artikel hilfreich?"};

4. Save your JavaScript file.

5. In Paligo, upload your JavaScript file to the HTML5 layout that you want to use for publishing.
For details, see Add a Custom JavaScript to a Layout [768].

When you publish with the layout from step 5, Paligo will generate an HTML5 help center that uses
your custom text for the feedback panel.

Change the Feedback Text Below the Buttons
To change the text for the email link that is below the feedback buttons:

1. Use a third-party code editor or text editor to create a JavaScript file (with file extension .js, for
example, mycustomscript.js).

NOTE
If you already use a custom JavaScript with your layout, open that JavaScript
in a code-editor and add the code in the next step to it.

2. Enter the following JavaScript:

/* FeedBack comment */

 $(document).ready(function () {
  var lang = $(document.documentElement).attr("lang");
  if (lang in feedbackLinkDict) {
    var text = feedbackLinkDict[lang];
    setLinkText(text);
    $(document).ajaxComplete(function () {
      setLinkText(text);
        });
    }
});

function setLinkText(text) {
  var element = $("div.toggle-feedback a").text(text);
}
/* Change text here */
var feedbackLinkDict = {"en" : "Email your feedback"}; 

3. To change the text that appears in the email link below the buttons, edit this line in the script:

var feedbackLinkDict = {"en" : "Email your feedback"}; 

For English, replace "Email your feedback" with the text you want. It must be enclosed in
double quotes, for example:

var feedbackLinkDict = {"en" : "Email suggestions to Paligo"};

For each additional language, add the language code and the text, for example, here we have
added "de" for German and set the text to "E-Mail-Vorschläge an Paligo?".
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var feedbackLinkDict = {"en" : "Email suggestions to Paligo",
                        "de" : "E-Mail-Vorschläge an Paligo"};

4. Save your JavaScript file.

5. In Paligo, upload your JavaScript file to the HTML5 layout that you want to use for publishing.
For details, see Add a Custom JavaScript to a Layout [768].

When you publish with the layout from step 5, Paligo will generate an HTML5 help center that uses
your custom text for the feedback panel.

NOTE
Depending on how you set up your layout, the link text may only become visible
after the reader has selected the Yes or No button (see Add a Feedback Section
for Topics [790]).

Enable WCAG Settings
Web Content Accessibility Guidelines (WCAG) are recommendations for making the web more
accessible for everyone, see WCAG. In Paligo, you can enable WCAG settings for the HTML5 output
in the Layout Editor [57].

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Universal Access from the left menu.
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4. The following WCAG settings are available:

• Include WCAG CSS file - Makes the text darker to improve the contrast. Disabled by default.

• Admonitions use strong instead of h3 - Replaces the default HTML h3 element for
admonition titles with the strong element, which is recommended for accessibility.
Disabled by default.

• Include inline styles for Skip Navigation - This option adds an inline style element for this
to reduce the Total Content Shift (any time something on the page visibly changes position
within the frame). A hidden element links to the main body content for keyboard navigation
and screen readers. Enabled by default.
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• Use class rather than ID for features - Makes elements use class instead of element IDs.
Certain IDs are duplicated in default HTML5. This option will replace those IDs with class
values to avoid validation problems affecting accessibility tools. Disabled by default.
The ID values that will be replaced by class values are:

• logotype-pageheader

• navbar

• navbar-collapse

• header-navigation-next

• header-navigation-prev

• aa-search-input

• content-wrapper

IMPORTANT
If this setting is enabled, custom CSS and / or JavaScript referencing the
removed ID values must be updated to reference class values instead.

5. Select Save.

PDF Styling
To control the look and feel of your PDF outputs, we recommend that you follow the PDF Styling
Workflow [798]. This involves creating or editing a PDF layout, which is where you define the style
settings for your PDF.
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You can use the PDF layout to control a wide range of styles for your PDF, including font styles and
colors, spacing, and page breaks, all without any programming knowledge.

NOTE
For PDF, all of the styling is done through the layout (there is no CSS involved).
When you publish, Paligo uses the underlying XSLT to take your content and
transform it into PDF, and applies your styling choices in the process.

Paligo comes with a built-in PDF layout that you can use. You can also create your own PDF
layouts [1059] and edit them to meet your own requirements.

To find out about the various PDF styling and customization settings, see PDF Layout Editor
Options [799].

To make changes beyond what the Layout Editor provides, you will need a customization. Please
contact your account manager or support for more information.

PDF Styling Workflow
The steps you should follow to style your PDF output are:

1. Create your content in Paligo topics and add to a publication. Some parts of the content can
be styled by using attributes, for example, you can set image sizes. But you will apply most of
the styling in the PDF layout.

2. Create a PDF layout [1059] or edit an existing one [1061].

3. Use the layout settings [799] to control the style of the various elements in your PDF output,
including headings, subheadings, font colors, font sizes, spacing, etc.

4. Publish your content [1090] using the PDF layout you edited.

With PDFs, the majority of the styling settings are set in the PDF layout.
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PDF Layout Editor Options
The tree of items you can choose to style in the Layout Editor is divided into a number of sections.
Each section is described below, with the items you can style and the options available for them.

NOTE
Many of the items and options are self-explanatory, and have explanations right
in the Layout Editor. So only the items that may not be immediately transparent
are explained below.

General for PDF

Category Description

Document Use to set some of the page preferences for the PDF documents that Paligo will produce when you
publish with the layout.

For details on the page settings, see Set your Page Preferences for PDF [810].

To learn about the number divisible by 4 setting, which is often needed for printing, see Troubleshoot a
PDF Booklet [844].

Languages Specify if and how you want language names for a multilingual publication to appear.

For details, see Set your Multi-Language Preferences for PDF [826].

Page Here you can set the number of columns for your output, set some page preferences such as page
numbering after the TOC, and also style header and footer rules.

For details, see:

• Multi-Columns for PDF Content [820]

• Numbering for PDFs [945]

• Control the Content on Blank Pages for PDF [818]

• Header Rule for PDFs [926]

• Footer Rule for PDFs [936]

Page margins Use to set the margins around the edge of each page and the body area of each page. Also set the start
indent for body content.

For details, see Set the Page Margins for PDF [814].

Booklet You can create multi-fold booklets for your PDF layout (3-fold, 4-fold, etc).

For details, see Booklet [836].
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Category Description

Fonts Use to set the default font settings for titles and body text. Paligo will use the default fonts unless
you specify different font settings elsewhere, for example, if you set different styles for headings in the
Section titles section.

For details, see Set up the Default Fonts for PDFs [808].

NOTE
It is possible to add additional fonts in your Paligo instance. Contact support and
send us:

• Confirmation that you have proper licensing for the font

• The font files.

Most new added fonts will work out-of-the-box. But if additional customization is
needed for it to work, there is a fee for a customization service.

Images If you set a default width for images, any images that have no specific width set on them in the topic itself
will get this width.

If you use inline images (the inlinemediaobject element), e.g for icons inline with the text, it defaults to fit
the image in the normal line height. If you want to change this, you can do so here.

You set it as a compound value: 0.25pt solid silver, e.g, setting border width, style, and color.

You can also set a border radius if you want rounded corners. Either use padding to get it as a frame, or
if you want to cut the corners of the image itself, experiment with values and a white color to match the
page color. Usually a ratio of 3 gets a good result. Eg., border = 3pt solid white and border-radius = 9pt.

You can override the default setting here on individual images by setting the role attribute to a value
like  border: 0.25pt solid silver; border-radius: 3pt; padding: 15pt;. Of course if you just want the border, just
use the first part. Each part is delimited by a semicolon.

The attribute should be set on the imagedata element.

NOTE
Note that there is one condition for this to work properly: every image that you set
borders on must have a width attribute. Otherwise the border will be as wide as the
page, which the image might not be. So if you set borders on images globally in the
Layout Editor, you need to set the image "width" attribute on all images.

TOC Use to control the styling of the table of contents for a publication. There are also options for adding a
table of contents for each language and lists of titles, such as lists of figures, tables, and examples (see
Add a Table of Contents and List of Titles for PDF [1029]).

Besides various styling options, you can also decide if a TOC should be generated at all, and if so to which
depth of nesting.

TIP
To exclude some topics from the TOC, give their sectionelement a @role attribute
with the value notintoc.

This is only for PDF. For HTML / HTML5 you can control it with Chunking [780].
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Category Description

Related
Topics
Section

Use to style the related topics section that appears if you set your PDF layout to use the Relationship
taxonomy feature.

Glossary and
index

Use to set up automatic titles and sorting for your glossary and index topics. You can also set the number
of columns and the column gap for the index.

For details, see Glossary Title [418] and Index Title [429].

Bookmarks Options for the use of bookmarks in PDF and down to which level of depth.

Misc Options for setting:

• Hyphenation and alignment of the document body

• Line breaks in URLs

• Title topics for reused publications

• Round corners on badge labels

• Tagged PDFs

• Linearized PDFs.

Filtering and
taxonomies

Options for using taxonomies for filtering.

The options available are the same as for HTML5.

To learn about taxonomy filtering, see Taxonomy Filters [1175].

Bookmarks Choose whether to generate PDF bookmarks

Prepress If you need to set crop marks, bleed, etc, sometimes required for printing purposes, you can set them
here.

Draft and
Watermark

Use these parameters to set your PDF to drafts, add watermarks, and background images so that readers
know they are looking at a draft copy. For more details, see Drafts and Watermarks in PDFs [824].

To have your regular styling, create a new layout based on your custom style, and then add these
parameters.

PDF
Properties

Use to define the metadata for the PDF document, including title, subject, keywords, display title for
accessibility, and initial settings for the PDF viewer.

For more details, see PDF Document Properties and Metadata [970].

Admonitions for PDF

Category / Element Styling parameters Description

General Graphics and font settings Select whether your admonitions (warnings and the like)
should use icons or not by setting the graphics option.
By default the standard admonition icons in Paligo will be
used, but this can be changed to use custom icons.

Customize the appearance of the admonitions, see
Admonition Styles for PDF [949].

Paligo Documentation

801



Category / Element Styling parameters Description

Graphical Various options for styling
admonitions with icons, including
the possibility to upload your
own icons to replace the default
ones.

Use the settings in the General category and the Graphical
category if you want admonitions with icons.

Which Admonition Parts Can You Style? [949].

Nongraphical Various options for admonitions
if you don't use icons.

Use the settings in the General category and the
Nongraphical category if you want admonitions without
icons.

Which Admonition Parts Can You Style? [949].

Back page

Category/Element Styling parameters Description

Back cover recto Use to style various elements and content boxes on the
"recto" side of back covers. For details, see Cover Pages and
Front Matter [846].

Back cover verso Use to style various elements and content boxes on the
"verso" side of back covers. For details, see Cover Pages and
Front Matter [846].

Cross-references for PDF

Category Description

Enable cross-reference auto-title customization When enabled, the cross-reference auto-title
customizations below can be used. Otherwise legacy cross-
reference auto-text is used, or any stylesheet customization
you may have.

Default: disabled.

Cross-reference auto-title Determines the format of the generated text for cross-
references.

See Cross-Reference Styling (PDF and HTML5) [669] for
options available.

Default: 'title page', which produces a format like 'My Topic
Title (page x)'.

Cross-reference auto-title for formal elements Determines the format of the generated text for cross-
references for formal elements (like tables, figures,
examples).

See Cross-Reference Styling (PDF and HTML5) [669] for
options available.

Default: 'default', which produces a format like 'Example 5,
"My Title"'.
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Category Description

Cross-reference label/title separator Punctuation or space separating label (if used) from title
in cross-references, when the auto-title parameter above is
set.

NOTE
For a space, use 's' (without the
quotes).

Default: ':s', which produces a format like 'Example 5: "My
Title"'.

Formal Elements for PDF
The term Formal elements comes from the content model. It basically is an umbrella term for
elements like lists, figures, tables, equations, examples. In this section you can make general
settings applying to all such elements consistently if desired.

Note that any settings you make on a higher level (General) can be overridden if you set another
value on a lower level (like "informalexample")

Most options are self-explanatory and not described here.

Category Description

Formal elements / General / Use auto-label text for formal
element titles

Formal elements like tables, figures, and examples will get
a title with a label and number, for example: 'Table 3: My
Table'.

If you only want the title, without the label and numbering,
you can disable this here.

Default: Enabled

Formal elements / General / Restart auto-label numbering If enabled, tables, figures, and examples will restart
their numbering for each topic, section (including internal
sections inside topics), or chunk.

Default: continuous numbering throughout the publication.

Exclude label for abstract If enabled, the label for an abstract is excluded from
output. This is useful if you do not need it, and if publishing
to multiple formats where hiding it with CSS does not work.

Default: disabled.

Front page

Category Description

General Set whether you want a front page generated for your PDF.

See Set Paligo to Generate a Cover [915].
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Category Description

Title block Positioning and spacing for the title block, including subtitle if used.

See Cover Title and Subtitle [889].

Title Specific styling for the title.

See Cover Title and Subtitle [889].

Subtitle Specific styling for the subtitle

See Cover Title and Subtitle [889].

Info elements Use the Info elements settings to control the styling of the info elements, including the alignment
and order.

There are various "info elements" that you can add to the publication topic for your publication.
These include pubdate, copyright, and legalnotice.

See Style the Info Elements [881].

Logotype Use to upload a logo for the front cover and set its alignment, margins, height and width.

See Logo on Cover [898].

Product image Use to upload a foreground image, also known as a product image, on a front cover.

See Cover Foreground Images [900].

Background
image

Use to upload a background image for the front cover.

See Cover Background [906].

Languages Use to control how multiple languages are shown on the front cover. You can choose to:

• Display all languages (that are being published)

• Show a language bar on the outside edge

• Set the text for the language shown on the front cover.

See Languages on Cover [896].

Front cover recto Use to style various elements and content boxes on the "recto" side of front covers. For details, see
Cover Pages and Front Matter [846].

Front cover verso Use to style various elements and content boxes on the "verso" side of front covers. For details, see
Cover Pages and Front Matter [846].
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Header and footer

Category Description

Page header Use to style the header, including:

Set the Header Table Height and Column Widths [919].

Set the Border for the Header Cells [922].

Set the Font for the Header Table Cells [920].

Set the Vertical Alignment for the Header Table Cells [921].

Add Content to the Header Table Cells [923].

Page footer Use to style the footer, including:

Set the Footer Table Height and Column Widths [928].

Set the Border for the Footer Cells [931].

Set the Font for the Footer Table Cells [929].

Set the Vertical Alignment for the Footer Table [930].

Add Content to the Footer Table Cells [933].

Inline Elements
The inline elements include: filename, guilabel, guimenus, guibutton, guiicon, glossterm,
computeroutput, productname, quote and more.

You can edit the PDF layout to define font family, font weight, font style, font size, font variant,
color, border, usage of capitalization and more. For details, see Inline Elements for PDF [962].

Keep-together options
The keep-together options provide the possibility to control how elements are kept together on
the same page or column, by default.

It is available for many of the most common elements, and each one has a dropdown where you
select one of three values:

The default values often work very well, and usually you don't have to change these default
settings, but if you do these are the options:

1. no - means the element will not be kept together by default.

2. yes - means the PDF processor will attempt to keep the element together. But the processor
may in certain cases run into cases where it is not appropriate, and will then attempt to select
the best keep option. This is usually the best choice if you want to keep a certain element
together.

3. always - means the element will be kept together no matter what. This is the strictest rule, and
may be ok, but could also cause some undesired keeps.

NOTE
Note that you can always override the default values for a particular element
in a topic, using the xinfo:keep-together and @xinfo:keep-with-next
attributes.
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Lists

Category/Element Styling parameters Description

General Margin before/after lists. Default value is used if the value here is "auto". Specify
a value such as 15p, or 2em e.g t if you want a specific
margin.

There are also options for controlling the space after block
elements inside lists and procedure steps (see Set the
Spacing for Lists in PDF [1021]).

Unordered Lists Various options for the bullet
formatting.

You can specify what symbol you want for bullets
depending on their nesting level.

Ordered Lists The width of the label (number). Set this if you want to control how much space there is
between the label and the text of the list item.

Procedures Font and color options Use these styling options to make your procedures stand
out from regular ordered lists.

Section titles

Category/Element Styling parameters Description

All sections Default font size, font weight,
section numbering, and color for
all titles.

The font size uses a reference notation so that you can set
the size relative to the body font size. This can be useful to
get a consistency in your styling. Only change the value of
the factor number if you want to do this.

If you want to hard code the value (for example 15pt) you
can do this too.

This is also the category to use if you want to set numbering
for sections (topics). For instance if you want your section
titles to have numbering like 1.2, 1.3.1 and so on. Learn
how to Style Section Titles and Subtitles (PDF) [937]

Level 1 Same parameters as all sections,
and all other levels, and in
addition background color.

Level 1 titles (topics on the highest level in a project /
publication nesting structure) normally represents chapters
or the equivalent.

In the default style for PDF top-level topic titles ("chapters")
get a blue banner background. You can change this color,
or just use white to remove the banner. Then change the
font color to fit this background.

Level 2, 3, 4, 5, 6 Same settings, but setting it
separately for all lower levels.

You can set styling for titles down to level 6. Best practice
in technical documentation is to aim for 4 levels, but that
can sometimes be hard to accomplish, so up to 6 levels can
be styled. Should you have deeper levels than 6, anything
deeper than 6 levels will get the same styling as level 6.
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Category/Element Styling parameters Description

Bridgehead Same common properties as for
section titles.

A bridgehead is an "intermediate" title that you can insert in
the middle of a topic.

NOTE
In most cases, we recommend
that you avoid using bridgehead
for headings. Use nested sections
instead and let the natural hierarchy
create subheadings. To find out
more, see Create Subsections [165].

Tables for PDF

Category Sub-category Description

Tabstyle1 -
Tablstyle5

General Use to set options for up to 5 different table styles. You can
assign each table in your content to any 1 of the 5 styles.
Tables use Tabstyle1 by default.

When you publish, Paligo will apply the styles from the
appropriate Tabstyle.

See Table Styles for PDF [976].

Header Use to set up the header for a table style.

See Style the Table Header for PDF [1002]

Footer Use to set up the footer for a table style.

See Style the Footer for Tables [1008].

Footnotes Use to style footnotes for PDF.

See Style the Table Footnotes for PDF [1014].

Verbatim (code and software)
Verbatim is a term for different kinds of elements that are to be output exactly as they
are typed, i.e preserving white space and line breaks, such as elements for code samples,
like programlisting.

Such elements can be particularly tricky in PDF output, because they can take up more space than
the page allows. This section allows you to make a number of settings to deal with that problem:

• Font-size: Set the default font-size for verbatim elements. You can override this on individual
elements by using the @role attribute, setting it to a value like font-size:8pt. You can also use the
common size designators similar to CSS: small, smaller, etc.

• Line-wrap: You can enable line wrapping by default for all verbatim elements. And if you do,
you can choose to indicate that the line is really meant to continue from the previous line, as
is a common convention when exemplifying code. You can choose which character to use as an
indicator for this ("hyphenation character"). Note that your font must support the character you

Paligo Documentation

807



choose. This default setting can also be overriden by using the attribute @role, set to a value of
either wrap-option:wrap or wrap-option:no-wrap.

• Color and border: You can also select whether you want your programlisting to have a
background color and/or border.

• Graphical rendering of keycap: Use this if you want the keycap elements to render as a

keyboard key, like so: Alt Shift V .

• Syntax highlighting: you can turn syntax highlighting on for code snippets (programlisting,
etc), choose a theme and also the default programming language. If you set the @language
attribute on a particular element, that will override the default setting here.
See this page for some samples of the styles available: Syntax highlighting styles. (Note that the
plugin used is not the same as the one used in Paligo, but the styles are the same).

NOTE
• Note that syntax highlighting for PDF and HTML uses different highlighting

mechanisms, so while both offer a number of themes, some similar, the exact
look and feel will not be quite identical for each of these outputs.

• If syntax highlighting is enabled, this option will also control the background
color of the programlisting. So even if you select a background color for
verbatim elements, the syntax highlighting background will override it.
However, if you select a syntax highlighting style with a background color
other than white, there will be no padding. So you may still want to apply a
background color (the same as the one used by the syntax highlighting), to
apply padding.

Set up the Default Fonts for PDFs
For PDF outputs, you can define the settings for the "base" fonts. These are the fonts that are used
by default, unless they are specifically overridden by other font settings.

NOTE
When you set the default fonts, you can choose the fonts from lists. The lists
contain the fonts that are available on your Paligo instance. If you want to use a
different font, contact customer support and provide the font files and the license
for the font. We will then upload the fonts to your Paligo instance.

To choose your own default fonts:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select General and choose Fonts.

4. Set the default fonts for titles:

a. Choose a Default font family for titles from the list.
Your chosen font will be the default for content inside title elements.

b. Set the Fallback font families for titles. Fallback fonts are the fonts Paligo will use if your
preferred font is unavailable.
Enter the names of each fallback font in order of preference. Use commas to separate
them. Paligo will use the fonts in the order you enter them, for example, if the fallback
fonts are:

DejaVuSans, ArialUnicodeMS

Paligo will use DejaVuSans as the first fallback font. If that is unavailable, it will use
ArialUnicodeMS.

5. Set the default fonts for document body text. Document body text is content that is below the
top title element in the main body of a topic.

a. Choose a Default font family for document body.

b. Set the Fallback font families for document body. These are the fallback fonts for
content in the body of the document. As before, use commas to separate them and add
the font names in order of preference.

c. Set the Default font weight for document body. The weight is the thickness of the font
and there are various options to choose from, including thin, medium, bold, extra bold.

d. Set the Default font size for body text. Enter the value only, not the units of
measurement. (This field is hard-coded to use points as the measurement).

e. Set the Line height for body text. This is the amount of space between lines in the same
content block, such as a paragraph. Enter the value only, not the units of measurement.
The spacing is relative to the font size.
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NOTE
The "body text" settings are defaults that will apply unless they are
overridden by font settings elsewhere. For example, the Admonitions settings
have font options that will take precedence over the "body text" font settings.

6. Set the default spacing for "normal paragraphs". A "normal paragraph" is a para element that
is not inside a complex structure such as a table, a list, or a procedure.

• Use Space-before (optimum) for normal paragraphs to define the ideal amount of space
you would like above the para element.

• Use Space-after (optimum) for normal paragraphs to define the ideal amount of space
you would like below the para element.

In both cases, enter the value only, for example, 1.0. Do not include a unit of measurement as
Paligo calculates the spacing in relation to the font size.

7. Set the default Document font color. This applies to all content in the document, unless it is
overwritten by a color setting elsewhere.
Either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).

8. Select Save.

When you publish with this layout, Paligo will produce a PDF that applies your chosen settings.

Set your Page Preferences for PDF
When you publish to PDF, Paligo uses the settings in the PDF layout to determine the page size,
orientation, and other page-related properties. You can edit the PDF layout to set your page
preferences, as explained in the following sections:

• Set the Page Size for PDF [811]

• Set the Page Orientation for PDF [811]

• Set a PDF to use Double-Sided Pages [816]

• Set a PDF to Include or Exclude Blank Pages [817]

• Control the Page Count for PDF [817]
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• Control the Content on Blank Pages for PDF [818]

• Multi-Columns for PDF Content [820]

• Drafts and Watermarks in PDFs [824].

NOTE
If you only want to rotate individual pages rather than all pages in the PDF, see
Rotate a Page for PDF [812].

Set the Page Size for PDF
To set the page size for a PDF output:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General > Document.

3. Choose the Page Size from the list, for example, US letter.

4. Select Save.

When you publish with this PDF layout, Paligo will create a PDF that uses your chosen page size.

Set the Page Orientation for PDF
By default, Paligo publishes PDFs with a portrait orientation (long edges on left and right, shorter
edges on top and bottom), but you can change it to use landscape instead.

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General > Document.

3. Set Orientation to:

• Portrait for pages with long edges on the left and right, shorter edges on the top and
bottom.
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• Landscape for pages with short edges on the left and right, longer edges on the top and
bottom.

4. Select Save.

When you publish with this PDF layout, Paligo will produce a PDF that has its pages set to your
choice of orientation.

Rotate a Page for PDF
There are two ways to rotate pages for PDF outputs:

• You can rotate all pages in a PDF (see Set the Page Orientation for PDF [811])

• You can rotate a sequence of pages in a PDF.
A sequence is all of the content inside a top-level section element (for regular topics). For
appendix topics, the sequence is all content inside the appendix element.

In the following image, page 3 of the document is set to portrait orientation (default) and page
4 is landscape. The topic that contains the content for page 4 has a role attribute on the section
element and the role value is: rotate.
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To rotate the content in a section or appendix:

1. Open a top-level topic in the Paligo editor. A top-level topic is a topic that is at the top level of
a publication's "table of contents" structure and is not a descendant of another topic.

NOTE
You can only use the rotate feature with top-level topics. If you set the role
attribute to rotate on a lower-level section element, it will have no effect.

2. Select the appropriate element:

• For regular topics and index topics, select the top-level section element in the element
structure menu and then select Go to element.

• For appendix topics, select the appendix element in the element structure menu and then
select Go to element.
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3. Use the Element attributes panel to assign a role attribute.
If you are editing a regular topic, select the top-level section element and give it the role
attribute. Set the value of the role attribute to rotate.

If you are editing an appendix topic, select the appendix element and give it the role
attribute. Set the value of the role attribute to rotate.

4. Select Save.

When you publish the topic as part of a publication, Paligo will rotate the page(s) that contain the
content of that topic.

Set the Page Margins for PDF
For PDFs, each page consists of various margins and regions that you can adjust to meet your own
requirements.

Understanding the Page Margins and Regions
Before you make changes to the page margins, make sure you understand how pages are divided
into margins and regions. The following image shows the page layout for PDFs:
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Where:

• Margin top is the space between the top of the header and the top of the physical page.

• Margin left is the space between the left edge of the page and the region start area.

• Margin right is the space between the right edge of the page and the region end area.

• Margin bottom is the space between the bottom of the physical page and the bottom of the
footer.

• Region after is an area below the body content. Paligo uses this area for the footer.

• Region body is the main central area of the page where the body text goes.

You can adjust the spacing for these margins and regions [815] by using the PDF layout editor.

NOTE
To learn more about the margins and regions, which use XSL-FO, see
w3schools.com. But note that Paligo does not use region-start or region-end.

Set the Page Margins
To change the page margins for a PDF output:

1. Learn about the page margins and regions [814] so that you know exactly which part of the
page will be affected by your changes.

2. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

3. Select General > Page Margins.
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4. Set the page margins and spacing. There are settings for each of the margins and regions
(see below). When you define a margin, enter the value and the units of measurement, for
example, 24mm:

• Page margin top
Use to set the margin for the space between the top of the physical page and the top of the
header ("region before" area).

• Page margin bottom
Use to set the margin for the space between the bottom of the physical page and the
bottom of the footer ("region after" area).

• Page margin outer
Use to set the margin on the outer edge of the page.

• Page margin inner
Use to set the margin on the inner edge of the page. This is the binding edge where the
pages would be connected to the spine of the book if they were printed as a physical
document.

• Body margin top
Use to set the distance from the top of the "region body" section to the top of the "region
before" section (the header section).

• Body margin bottom
Use to set the distance from the bottom of the "region body" section to the bottom of the
"region after" section (the footer section).

• Use The start-indent for the body text to set an additional left margin for the body
content. This has the effect of indenting your content from the start of the title, by an
amount of your choice.

5. Select Save.

When you publish with this PDF layout, Paligo applies your choices.

Set a PDF to use Double-Sided Pages
If you are going to print your content, consider using the double-sided pages feature. With this
feature enabled, Paligo applies a slightly wider margin on the binding edge of the page. It also
"mirrors" the headers and footers, for example, if you have set the page number to appear in the
left cell, it will alternate between the left cell and right cell on the left and right pages.

NOTE
If you are using Paligo's PDF booklet feature, the "mirror" applies to the pages
that are positioned inside the grid as well as the individual PDF pages.

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General > Document.

3. Set Double sided to:

• Enabled
To turn on the double-sided feature, giving pages a wider margin and mirrored headers and
footers.
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• Disabled
To turn off the double-sided feature.

4. If you have enabled double-sided pages, use the Force blank pages setting to control how
page sequences end. Choose either:

• Choose Enabled if you want Paligo to insert blank pages to "pad out" the document so that
each "chapter" of your content ends on an even-numbered page.

• Choose Disabled if you want Paligo to end each "chapter" wherever the content ends,
irrespective of whether the page is an even number or odd number.

5. Select Save.

When you publish to PDF using this layout, Paligo applies the double-sided pages and force blank
pages settings you have chosen.

Set a PDF to Include or Exclude Blank Pages
Double-sided documents are typically set up so that each "chapter" ends on an even page, and
each new "chapter" starts on an odd page. To make this possible, Paligo may need to insert blank
pages at the end of a "chapter". This is because it is unlikely that all of your "chapters" will contain
the right amount of content to end on even pages through the natural flow of the document.

By default, Paligo is set to add blank pages if needed. You may prefer to disable this feature if
blank pages are not needed, for example, if the PDF is only going to be used online.

To set a PDF to include or exclude blank pages:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General > Document.

3. Set Force blank pages to:

• Enabled to get Paligo to add blank pages where necessary.

• Disabled to prevent Paligo from adding blank pages.

4. Select Save.

When you publish with this PDF layout, Paligo applies your choices.

Control the Page Count for PDF

Abstract
Learn how to use "Set page count for print to a number divisible by 4" to manage the page count
and set up PDFs for printing services.

Professional print services may require PDFs that have a page count that is divisible by a certain
number, usually 4. This is because they print the pages on large sheets, which are then folded, cut,
and bound to make the finished book. For example, if a printer produces 4 pages per sheet, then
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the front cover, back cover, inside front cover, and inside back cover will all be printed on the same
sheet.

To make sure your content has a suitable page count, you can set Paligo to automatically add
extra "empty" pages at the end of your document:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General > Document.

3. In the Set page count for print to a number divisible by 4 field, enter the word document
followed by two values:

• <Page count divisible by>
This is a number that defines what the total page count should be divisible by. It is usually 4,
but could be 16 or 32.

• <Back cover pages>
For the page count, Paligo does not include a back cover or the inside of the back cover. So
for the second number, enter either:

• 0 if your document does not have back cover pages

• The <page count divisible by> number minus the <back cover pages> number.
For example, if your document needs a page count that is divisible by 4 and it has back
cover recto and verso components, enter:
document 4 2
This is because 4 is the "page count divisible by" number. You have 2 back cover
components (recto and verso), so 4-2=2.
Similarly, if your document needs a page count that is divisible by 16 and you have back
cover recto and verso components, enter:
document 16 14
As the page count has to be divisible by 16 and you have two back cover components, so
16-2=14.

4. Select Save.

When you publish with this PDF layout, Paligo will apply the page count control you have set.
You can use the layout preview feature to see how Paligo will rotate and organize the pages in
the document [844]. If the page organization looks incorrect in the preview, it is likely that it is
because the Set page count for print to a number divisible by 4 setting is incorrect.

Control the Content on Blank Pages for PDF
If you set your PDF to use double-sided pages [816], Paligo can add extra blank pages [817]. The
blank pages are needed to make sure that:

• New chapters start on a certain page (usually the right-hand page in a left-to-right document)

• A certain page count is reached.
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Depending on your requirements, you can set the blank pages to be completely empty or you can
set Paligo to:

• Include or Exclude the Header on Blank Pages for PDF [819] (same header as shown on pages
with content)

• Include or Exclude the Footer on Blank Pages for PDF [819] (same footer as shown on pages
with content)

• Add an Intentionally Blank Message on Blank Pages for PDF [820]. This can be a requirement in
some industries, where the user needs to be told that the page is blank by design so that they
know it is not missing any information.

Include or Exclude the Header on Blank Pages for PDF
You can choose to include or exclude the header section on any blank pages that appear in your
PDF. Traditionally, the header is shown on all pages inside the document and is only excluded
from the front and back cover, and sometimes the "front matter" pages.

To include or exclude the header on blank pages:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General and choose Page.

3. Set Headers on blank pages to:

• Yes to include the header on blank pages.

• No to exclude the header on blank pages. The top section of the page will be blank.

4. Select Save.

When you publish with this layout, Paligo will produce a PDF that applies your chosen settings.

Include or Exclude the Footer on Blank Pages for PDF
You can choose to include or exclude the footer section on any blank pages that appear in your
PDF. Traditionally, the footer is shown on all pages inside the document and is only excluded from
the front and back cover, and sometimes the "front matter" pages.

To include or exclude the footer on blank pages:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General and choose Page.

3. Set Footers on blank pages to:

• Yes to include the footer on blank pages.

• No to exclude the footer on blank pages. The bottom section of the page will be blank.
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4. Select Save.

When you publish with this layout, Paligo will produce a PDF that applies your chosen settings.

Add an Intentionally Blank Message on Blank Pages for PDF
You can add a message to blank pages to let users know that the page is empty by design. If you
enable this feature, Paligo adds the following message to blank pages:

This page is intentionally left blank.

If you publish in multiple languages, Paligo translates the message automatically.

To add or remove the message:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General and choose Page.

3. Set Display 'This page is intentionally left blank' message on blank pages to:

• Yes to include the message

• No to exclude the message.

4. Select Save.

When you publish using this layout, Paligo will create a PDF that uses the settings you have
chosen.

Multi-Columns for PDF Content
For PDF outputs, you can set your pages to have multiple columns. You can either apply the
multi-column layout to all content pages [821] or you can set up a multi-column layout for a
portion of a page (or a sequence of pages) [822].

For example, you can use multiple sidebar elements in the same topic to create a page that starts
as one column, then has three columns, then switches back to one column.
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IMPORTANT
Only use the sidebar element to create multiple columns in a topic. Do not use it
for single-column, full-width content as this structure is unnecessary.

For single-column, full-width content, you can add the elements you need without
using a sidebar.

Set up Multi-Columns for All Pages in a PDF
To set all of the pages in a PDF to use the same multi-column layout:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General and choose Page.

3. Set the number of Columns. You can choose 1, 2, 3, or 4.

4. Set the Columns gap for the document body. This is the amount of space between each
column. Make sure you include the value and the units of measurement, for example, 12pt.

5. Select Save.

When you publish with this layout, Paligo creates a PDF that uses your chosen column settings for
all of the body content.
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NOTE
To set up multi-columns for a specific page, or sequence of pages, see Set up
Multi-Columns for a Section of Content in a PDF [822].

Set up Multi-Columns for a Section of Content in a PDF
To create a multi-column section in a topic:

1. Create a new topic [131] or edit an existing one by selecting it in the Content Manager.

2. In the topic, select the location where you want the multiple columns to begin. You will use the
sidebar element for the multiple sections, so select a location where sidebar is valid. The
most common places to use a sidebar are after a paragraph, image, list, table, or admonition
(note, warning, caution, etc.).

3. Access the element context menu and select sidebar.

To access the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

Paligo adds a sidebar to your topic. It has a box around it to show that it is a sidebar rather
than the regular topic content.

4. Select inside the sidebar box.

5. In the element structure menu, select the sidebar element and then the Go to element
option.
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6. In the element attributes section, select Add attribute and choose the role attribute. Set
the value for the role attribute to define the number of columns you want and the amount of
spacing between them. Use this format:

column-count: 3; column-gap: 10pt

In this example, we have set the number of columns to 3 and the column spacing to 10pt.
If you want a different layout, change the column number and gap amount, for example,
column-count: 2; column-gap: 15pt.

NOTE
The Paligo editor does not show the multiple columns. If you want to see
them, you can preview your content [480] as PDF or publish as PDF.

7. In the sidebar, add the content that you want to appear in the columns.

You can add many types of content here, but you will need to allow enough space for scaling
the content. Text will flow into the columns automatically, but images and tables will scale to
fit as best as possible.
Images scale down proportionally, but at smaller sizes may be less useful to readers.
Tables scale down too, but can only scale down so far. If the table columns and spacing are
too large for the available space, the table will break across the columns.

NOTE
The content in a topic will flow automatically into the space available in
the columns. The flow of content has to be automatic as this is part of the
"content is separate from formatting" idea with XML. If you were able to add
a manual column break, it may look correct for one language but could be
completely inappropriate when a different language is used.

8. To add content after the sidebar columns, place the cursor after the sidebar box. You can then
add para elements and other elements and they will use the full width of the topic.
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9. Select Save.

Drafts and Watermarks in PDFs

Abstract
Learn how to add the word "draft" or a watermark or background image to PDF pages in Paligo.
There are settings on the PDF layout editor for draft, watermark, and background images.

To set a PDF output to be a draft, with the word "draft" added to the page and/or background or
watermark images, use the settings in the PDF layout:

1. Create a PDF layout [1059] or edit an existing one [1061].

2. Select General > Draft and watermark.

3. Set Draft mode to yes. This will mean that any PDFs that you publish using this layout will be
drafts and will use the draft and watermark settings you put in place. They will also have the
word "draft" in the header.
To stop this layout from using the draft and watermark settings, set Draft mode to no.

TIP
We recommend that you have a "main" layout with all features you need.
Then create a "draft" layout, based on the "main" one, and only make
changes to the draft options on the "draft" layout.

4. Use the Draft watermark setting to add the word "Draft" as a diagonal water mark across the
pages of the PDF.
Set it to yes to add the watermark or no to exclude the watermark.

5. Set Show Comments to yes if you want the PDF to include any content that has been added
in the remark element. This allows you to view comments that have been added by Paligo
authors and contributors in the PDF. Set it to no to exclude the remark element.

NOTE
Show Comments is for including or excluding the remark elements. It has no
effect on the comments that are added for reviews or contributions.

6. To add an image to the background of your PDF pages, save the image as a PDF and then
upload it to the Background PDF for all pages setting.
The image will appear in the background on all pages except the cover page.
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TIP
Try to use an image that gives good contrast with the text on the page,
otherwise the text may become difficult to read. For example, if you have
dark text, then a light-colored image will work best.

7. To add a watermark image to your PDF pages, save the image as a PDF and then upload it to
the Watermark PDF for all pages setting.
The image will appear on all pages.

TIP
This setting works best for images that only show the contours (outline) or
are partly transparent. You will need to add the translucent effect in an image
editor before saving it as a PDF.

8. Select Save.

When you publish using this PDF layout, Paligo will create a PDF that uses the draft and watermark
settings you have applied.

Example 44. Outputs with draft and watermarks

Here are some examples of outputs with draft and watermark settings in place.

Draft mode = yes, Draft watermark = no, no background or watermark images
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Draft mode = yes, Draft watermark = yes, background image = red stop sign, no watermark image

Draft mode = yes, Draft watermark = no, no background image, watermark image = contour 'internal
use only'

Set your Multi-Language Preferences for PDF
If you are going to publish content in multiple languages to PDF, you can use the PDF layout to:
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• Set the Title to Appear in One Language for PDF [827]

• Set the Subtitle to Appear in One Language for PDF [828]

• Set the Order of Languages in PDF [828]

• Set Up a Language Sidebar for PDF [829]

• Include or Exclude Missing Translations for PDF [833]

• Color Mark Unapproved Translations for PDF [834].

We also explain what it means if you have:

• Blue Text in PDF Output [836]

• Red Highlighted Text in PDF Output [836].

Set the Title to Appear in One Language for PDF
By default, when you publish a combined-language PDF, the front cover includes the title in each
language. For example, if you publish a single PDF to include English, German, and French, the title
will be shown on the front cover in all three languages. If you prefer, you can set Paligo to include
the title only once, in the first language included in the PDF.

To set the title to appear on the front cover once, in the first language of the document:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General > Languages.

3. Set the Display single language title on the front cover in combined language PDF to:

• Enabled
Sets the PDF to have one title on the front cover. It will be in the first language for the
document.

• Disabled
Sets the PDF to have multiple titles on the front cover (one for each language).

TIP
You can control the order of the languages in a PDF, see Set the Order of
Languages in PDF [828].

4. Select Save.

When you publish a multi-language document using this layout, the resulting PDF will use the title
settings you have chosen.
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NOTE
You can also Set the Subtitle to Appear in One Language for PDF [828].

Set the Subtitle to Appear in One Language for PDF
By default, when you publish a combined-language PDF, the front cover includes the subtitle in
each language. For example, if you publish a single PDF to include English, German, and French,
the subtitle will be shown on the front cover in all three languages. If you prefer, you can set Paligo
to include the subtitle only once, in the first language included in the PDF.

To set the subtitle to appear on the front cover once, in the first language of the document:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General > Languages.

3. Set the Display single language subtitle on the front cover in combined language PDF to:

• Enabled
Sets the PDF to have one subtitle on the front cover. It will be in the first language for the
document.

• Disabled
Sets the PDF to have multiple subtitles on the front cover (one for each language).

TIP
You can control the order of the languages in a PDF, see Set the Order of
Languages in PDF [828].

4. Select Save.

When you publish a multi-language document using this layout, the resulting PDF will use the
subtitle settings you have chosen.

NOTE
You can also Set the Title to Appear in One Language for PDF [827].

Set the Order of Languages in PDF
Use the PDF layout's Language order setting to control the order of languages in a PDF output.
The language order applies to:
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• The order of the languages in a multi-language PDF

• The order of the named languages and translated elements such as subtitles on the front cover.

To set the language order:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General > Languages.

3. Define the Language order. Enter the ISO code letters for each language and use spaces to
separate the languages. For example, de en es fr will result in German first, English second,
Spanish third, and French fourth.

4. Select Save.

When you publish a combined language output with this layout, the resulting PDF will have the
languages in the order you specified.

Set Up a Language Sidebar for PDF
If you are going to publish a combined language PDF, it can be a good idea to set up a language
sidebar. The sidebar is a block that appears at the side edge of the page and it shows the
name of the language used in that part of the PDF. For example, let's say you have a combined
language PDF for English, German, French, and Italian. When you publish, the English pages will
have a tab marked "English", the German pages will have a tab marked "Deutsch" and so on. The
main benefit of language sidebars is that they make it easier for users to find the section of the
document that is in their language.

NOTE
The sidebar is also referred to as the language tab.
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To set up a language sidebar:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General > Languages.

3. Use the Display language name on sidebar setting to add or remove a language sidebar.

• Select Enabled to add a language sidebar.

• Select Disabled to remove a language sidebar.

NOTE
For double-sided PDFs, you also need to add the language sidebar to the
reverse side of the pages, see step 4.

4. Use the Display language name on sidebar on verso (left) pages setting to add a language
sidebar to the reverse side of pages (left side). This applies for double-sided PDFs.

• Select Enabled to add a language sidebar.

• Select Disabled to remove a language sidebar.

5. Set the Letter case for language names. You can choose from:

• Upper case
The language name is shown in capital letters in the language sidebar, for example,
DEUTSCH.

• Lower case
The language name is shown in lower case letters in the language sidebar, for example,
deutsch.

• Capitalize first letter
The first letter of the language name is shown in capital letters and the other letters are
shown in lower case, for example, Deutsch.
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6. Use the Distance from the top of the topmost language tab to the top of the page setting
to control the vertical position of the sidebar. Enter the amount in inches and do not include
the units of measurement, for example, 1.85.

7. Set the Height of a language tab amount to define the vertical size of the language sidebar.
Enter the amount in inches and do not include the units of measurement.

8. Set the Gap between language tabs amount in inches to stagger the position of the language
sidebar for each language.

For example, let's say you have a document that contains German, English, Spanish, and
French. You set the gap to 1 inch. In the output, the German section has a German sidebar
and it appears near the top. In the English section, there is an English language sidebar and
it appears 1 inch lower than the German language sidebar. Similarly, the Spanish sidebar
appears 1 inch lower than the English sidebar, and the French sidebar is 1 inch lower than the
Spanish sidebar. In a printed version of the content, this "cascading" effect makes it easier for
users to find the language they need.
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9. Use the Width of a language tab setting to define the horizontal size of the language tabs.
Enter an amount in inches, for example, 0.45. Do not enter the units of measurement.

10. Use the Rounded corners for language tabs: radius setting to control the inner corners of
the language sidebar. By default, the inner corners are straight-edged but you can set them to
be rounded instead.

To use rounded corners, enter an amount and include the units of measurement, for
example, 10pt.
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To disable rounded corners, clear the field so that it uses the default of 0pt.

11. Use the Background color for language tabs setting to set the background color. The default
is black. To choose a different color, clear the Use default color checkbox. You can then either
enter an rgba value in the field or select the color block to display a color selector and use that
to choose the color.

TIP
The text that is shown in the language sidebar is white, so choose a darker
background color so that there is a suitable amount of contrast.

12. Select Save.

When you publish multi-language content with this PDF layout, the resulting PDF will use the
language sidebar settings you have chosen.

Include or Exclude Missing Translations for PDF
By default, if you publish a document to PDF and that document has missing translations, those
parts are included in the source language. If you prefer, you can set Paligo to exclude the missing
translations so that readers only see the content that has been translated.

For example, let's say you have a document that is written in English and translated to German.
You write the content, get it translated and then publish to both languages. Later you decide to
add a "Customer support" topic to the document, so you write that in English, and publish to both
languages, even though it has not been translated. This results in the German version containing
the "Customer support" topic in English, and the elements on that page are prefixed with [en] and
are shown in red with a pale red highlight.
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If you prefer to hide untranslated content, you can choose to exclude it in the PDF layout settings:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General > Languages.

3. Set Hide missing translations to Enabled if you want Paligo to exclude the missing translations
from the PDF. Set it to Disabled if you want Paligo to include the missing translations, so that
they appear in the source language. If you select Disabled, missing translations will have the
source language ISO code in square brackets as a prefix and the untranslated content is in red
with a light red background.

4. Select Save.

When you publish a document with this PDF layout, Paligo will include or exclude the missing
translations, depending on your choice in the layout.

Color Mark Unapproved Translations for PDF
Paligo has a color-marking feature for PDF outputs that shows unapproved translations as blue
text. This is useful for spotting unapproved translations that may be out-of-date as the source
language content has been updated.

NOTE
Typically, blue text in a translation means that the translation is out-of-date and
needs to be re-translated. But it could also be that the translation is up-to-date
but has not been approved before publishing. We recommend that you approve
translations when they are complete and then publish after they are approved
(see Workflow for Translation Service [1703]).

To set your PDFs to show unapproved translations as blue text:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.
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2. Select General > Languages.

3. If you want to color mark the non-approved translations, set Color mark non-approved
transitions to Enabled. To turn off the blue text color marking, set it to Disabled.

4. Select Save.

When you publish a document with this PDF layout, Paligo will apply the color marking, if you
enabled it in the layout.

Example 45. Mark unapproved translations

Let's say you have content that is written in English and you publish to German. For the first
release, you fully translate the content, enable color marking in the PDF layout, and then publish
the content in both languages.

After the release, you make some updates to the English content. You do not translate the
changes to German. You then publish to English and German without translating the changed
content.

Result:

• English version contains the old unchanged content + the new changed content.

• German version contains translations of the old content. There are no translations for the new
changes, so it uses the German translation for the old version of that content instead. At this
point, the information in the English version is different to the information in the German
version.
In the PDF, content that is different in the German version compared to the English version is
shown with blue text.
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So if you see blue text in a translation, it means that the translation is unapproved or is out-of-
date. You need to either approve the translation or get the content re-translated to include the
updates.

Blue Text in PDF Output
If you see blue text in your PDF output, it may be because you have the color mark non-approved
translations setting enabled in your PDF layout. This feature sets Paligo to use blue text for
translated content that has not been approved. For more details, see Color Mark Unapproved
Translations for PDF [834].

Red Highlighted Text in PDF Output
If you see red text with a pale red background in your PDF outputs, it may be due to the Hide
missing translations setting in the PDF layout. If you have it disabled, Paligo will insert the source
language content in place of any missing translations. The source language content is red with a
pale red background and has the ISO language code in square brackets as a prefix.

For more details, see Include or Exclude Missing Translations for PDF [833].

Booklet
Booklets are documents with multiple pages arranged on sheets of paper that, when folded,
present the correct page order. You create the booklet design (such as 2-fold, 3-fold, 4-fold), by
setting a grid that decides the number of columns and rows for your PDF output.
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Above a customized booklet with 4 pages (2, 3, 4, and 5) on a sheet (1) achieved by using a grid with two
columns and two rows.

Generating a booklet is a post-processing step that uses the regular PDF output file as input in the
grid cells. All manipulations are performed on PDF level using pdfjam.

The page size (inside the grid cells) is set under General → Documents → Page size in the PDF
layout. The print size is automatically adjusted to fit the grid and allow room for spacing. For
example if you use a standard 2x1 booklet and each grid cell is set to:

• A4 the print size will be A3 (without spacing added)

• US Letter (half) the print size will be US Letter (without spacing added)

You should consider the readability when designing the grid and also consider font sizes and other
appearance-related settings so that the booklet has an appealing design. Use your PDF-viewer and
printer to review the result.

Two different ways of creating a booklet in Paligo:

• Standard 2x1 Booklet gives you a fixed layout with two columns and one row on each sheet.

• Customize a Booklet offers the possibility to design your own booklet, by defining the number
of rows and columns.

TIP
To set up duplex printing needed for "mirroring" the header and footer, see Set a
PDF to use Double-Sided Pages [816].

Standard 2x1 Booklet
The Standard 2x1 Booklet uses two columns and one row on each sheet. This fixed standard does
not allow changes the number of rows and columns. By activating the setting "Make a booklet" the
pages are automatically rearranged and rotated by pdfjam as needed to create a booklet with two
columns and one row on each page.
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This image shows the rotated and rearranged pages in a Standard 2x1 Booklet.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select General and choose Booklet from the left menu.
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4. Select Yes to activate the function Make a booklet.

5. Select Yes to get a thin black line (1) around each grid cell in Combine several pages per
sheet: draw a frame (optional).
The frame is often used to verify the size and spacing of the paper printout and turned off for the
final PDF.

6. Define the horizontal space (2) between the grid cells in Combine several pages per sheet:
add horizontal space between pages (optional).
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7. Provide an extra margin (3) between the outer edges of the grid and the PDF page in Add
extra margins on page (optional).

NOTE
This can be useful when using print services, as they may require extra space
that can be cut off during the printing process.

To the left no optional settings made. To the right: 1 = Frame added, 2 = Horizontal space
added, 3 = Extra margin added

8. Select Save.

Customize a Booklet
To be able to set the grid that defines the number of rows and columns, you need to design your
own booklet. When you publish a customized PDF layout, Paligo will create a booklet that uses
your grid and spacing settings.

NOTE
The pages will not be rearranged and rotated by pdfjam.

1. Select the Layout tab in the top menu.
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Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select General and choose Booklet from the left menu.

4. Enter the number of columns to be used in Combine several pages per sheet: number of
columns.

5. Enter the number of rows to be used in Combine several pages per sheet: number of rows.
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This will define the amount of grid cells on a single sided sheet.

6. Select Yes to get a thin black line (1) around each grid cell in Combine several pages per
sheet: draw a frame (optional).
The frame is often used to verify the size and spacing of the paper printout and turned off for the
final PDF.

7. Define the horizontal space between the grid cells in Combine several pages per sheet: add
horizontal space between pages (optional).

8. Define the vertical space between the grid cells in Combine several pages per sheet: add
vertical space between pages (optional).
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The arrows show horizontal and vertical spacing.

9. Provide an extra margin between the outer edges of the grid and the PDF page in Add extra
margins on page (optional).

NOTE
This can be useful when using print services, as they may require extra space
that can be cut off during the printing process.
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The arrows show extra margin.

10. Select Save.

Troubleshoot a PDF Booklet

Abstract
Use the preview feature to see how Paligo will prepare a document for printing as a PDF booklet. It
is a good place to spot mistakes with the page count and divisible number for printing.

When you use the Booklet feature for PDFs, we recommend that you preview your booklet in the
PDF layout.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Expand the General section and then enter the Booklet settings.
To learn about the Booklet settings, see Customize a Booklet [840].

4. Select Choose document and then choose the publication you want to preview.
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Paligo loads the publication into the preview panel.
The preview shows how Paligo will rotate and organize the pages for printing as a booklet.
For example, the preview below shows there will be 4 content pages printed out on 1 piece of
paper.
There are two pages printed on each side of the paper:

• Side A has the front cover (recto) and back cover (verso). In the image, these are the top left
and top right pages.

• Side B has the front cover (verso) and back cover (recto). In the image, these are the bottom
left and bottom right pages.

This single piece of paper can be folded along the center line vertically to create the 4 cover
pages.

If your preview looks incorrect, it is likely due to an incorrect value in the Set page count for
print to a number divisible by 4 setting (in the General section, Document category. For
details, see Control the Page Count for PDF [817] ).
For example, the following preview shows a booklet with an incorrect page count. Here, Paligo
is adding a blank page next to the front cover, where the back cover should be. The back cover
is positioned incorrectly as it will be on the inside of the booklet, rather than the outside when
the page is printed. This is all because the Set page count for print to a number divisible by
4 is incorrect (it is set to document 4 1, but it should be set to document 4 2).
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Cover Pages and Front Matter
For PDF outputs, you can create front covers and back covers so that your documents can be
printed out as a complete "book".

For example, the following images show designs for the front cover of two different user guides.

To set up your covers for PDF, you can use a combination of:
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• Cover components
Cover components are special containers that you can associate with each side of a front or
back cover. You can add content to them and that content appears in a "content box" on the
relevant cover. For example, you could use cover components to add images to the inside of the
front cover and both sides of the back cover.
You can use the PDF layout settings to style the box and control its position.

• Content in the publication topic
You can add "info elements" to the publication topic and Paligo will display these on the front
cover, the reverse side of the front cover, and potentially the pages that follow it. These are
shown in addition to any content boxes from the cover components.

• PDF layout settings
The PDF layout has settings for controlling and styling the "info elements" from the publication
topic and also the cover components.

We recommend that you use cover components [860] as they allow you to add a back cover and
add extra content to any cover. But if you have set up publications without cover components
previously, they will continue to work as before.

To see examples of what type of content you can show on each cover, see Design Covers for
PDFs [848]. That article also explains where you can find information on setting up the various
parts of front covers, front matter pages, and back covers.

NOTE
You can choose to include the content from publication topics in HTML5 outputs
too. To style those, use CSS (see Branding your HTML Outputs with CSS [654]).

Covers: Recto and Verso
The terms we use to describe the different sides of the front cover and the back cover are
traditional terms used in print publishing.

• Front cover recto
This is the cover you see at the start of the document. It is the front cover, right-hand page.

• Front cover verso
This is the reverse side of the front cover. It is the front cover, left-hand page.
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• Back cover recto
This is the inner side of the back cover. It is the page you see next to the final page of your
document and is the back cover, right-hand page.

• Back cover verso
This is the outer side of the back cover. It is the back cover, left-hand page.

When you are designing your front and back covers, you will need to know which side is the
"recto" and which side is the "verso".

Design Covers for PDFs
We recommend that you use cover components to set up covers for PDF outputs (as explained in
Cover Pages and Front Matter [846]). This is because cover components allow you to add content
to back covers as well as front covers.
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NOTE
If you have set up publications without cover components previously, they will
continue to work as before. Depending on the settings you have in place in the
PDF layout, Paligo will either create no cover at all or will generate a front cover
and "front matter" pages. The front cover and front matter pages contain the
"info elements" from the publication topic.

The following sections show examples of each type of cover and explain what type of content you
can add.

• Design a Front Cover (Recto) [849]

• Design a Front Cover (Verso) [852]

• Design a Back Cover (Recto) [855]

• Design a Back Cover (Verso) [858].

It is also a good idea to read the Tips for Designing a Cover [860].

Design a Front Cover (Recto)
The front cover recto is the outside of the front cover. Traditionally, this is where you have the title
of the document and you may have images and other information too.

The front cover recto can contain text and images from a:

• PDF layout
You can add certain types of content, such as logos and background images, to the PDF layout.

• Publication topic
This is the topic that represents the publication as a whole and you can add info elements and
other content to it. Paligo displays the info elements in a publication topic on the front cover
recto or its reverse side (the front cover verso).

• Front cover recto component
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You can create and set up a cover component to represent the front cover. Any text or images
that you add to it will appear in a content box on the front cover.

NOTE
When designing a front cover recto, be aware that the front cover contains
content from the publication topic and the cover component. You will need to
allow space for them both. If there is insufficient space, their content may overlap.

The following example shows a front cover with content that comes from a PDF layout, publication
topic, and a front cover recto component.
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1. Logo
You can add a logo and position it in the PDF layout settings (see Logo on Cover [898]).
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2. Content box
This is a box that is absolutely positioned on the cover. Its content comes from a cover
component, which is a special type of "container", similar to a topic. You can add many types of
content to a cover component, including paragraphs and images.
To learn how to set up a front cover content box, see Create a Cover Component [862], Add
Content for the Cover Content Box [863], and Style a Cover Content Box [871].

3. Foreground image or "product image"
You can have one foreground image (also referred to as a "product image") on the front cover.
In the example shown, the drone image is the foreground image.
To add the foreground image, you can insert it into the publication topic or cover component
and give it a role attribute with a value of titleimage. Alternatively, you can set a product
image in the PDF layout.
To learn more, see Cover Foreground Images [900].

4. Background image or color
A background image for the page. In the example shown, the background image is A4 sized
and is a single image made up of a white band in the upper section, an image of sky, and a
white band in the lower section.
You can set the background image in a PDF layout, a publication topic, or a cover component.
You can also set a background color for the entire cover and a content box. To learn how to set
up backgrounds, see Cover Background [906].

5. Title block
The title block is a container for the title and subtitle. The subtitle is optional. You define the
content for the title and the subtitle in a publication topic. Use the PDF layout to style and
position the title block.
To learn how to set up the title block, title, and subtitle, see Cover Title and Subtitle [889].

6. Info elements from the publication topic
There are various "info elements" that you can include in a publication topic. Paligo can display
them on the front cover recto or front cover verso and you can choose which side in the
PDF layout settings. Note that if there is not enough space for the info elements to fit on the
preferred side, they will overflow on to the next page.
To learn about adding, styling and positioning info elements, see Info Elements for
Covers [881].

When you have set up your cover, make sure that Paligo is set to generate a front cover [915].
You can then publish to PDF, using the PDF layout you configured. Paligo will generate the PDF
output and it will include the covers you have set up.

If the cover does not appear as expected, see Troubleshooting PDF Covers [917].

Design a Front Cover (Verso)
We call the reverse side of a front cover "front cover verso".
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NOTE
To add a back cover to a PDF output, use cover components [860]. Paligo will
not include a back cover unless there are back cover components in place in your
publication topic.

The front cover verso can contain content that comes from a:

• PDF layout
You can add certain types of content, such as background images, to the PDF layout.

• Publication topic
This is the topic that represents the publication as a whole and you can add info elements and
other content to it. Paligo displays the info elements in a publication topic on the front cover
recto or its reverse side (the front cover verso).

• Front cover verso component
You can create and set up a cover component to represent the reverse side of the front cover.
Any text or images that you add to it will appear in a content box on the front cover verso.

NOTE
When designing a front cover verso, be aware that the front cover may contain
content from the publication topic and the cover component. You will need to
allow space for them both. If there is insufficient space, their content may overlap.

For example, the following front cover verso contains:
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1. Background image or color
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A background image for the page. In the example shown, the background image is A4 sized
and is an abstract pattern.
You can set the background image in a PDF layout, a publication topic, or a cover component.
You can also set a background color for the entire cover and a content box. To learn how to set
up backgrounds, see Cover Background [906].

2. Info elements from the publication topic
There are various "info elements" that you can include in a publication topic. Paligo can display
them on the front cover recto or front cover verso and you can choose which side in the
PDF layout settings. Note that if there is not enough space for the info elements to fit on the
preferred side, they will overflow on to the next page.
To learn about adding, styling and positioning info elements, see Info Elements for
Covers [881].

3. Content box
This is a box that is absolutely positioned on the cover. Its content comes from a cover
component, which is a special type of "container", similar to a topic. You can add many types of
content to a cover component, including paragraphs and images.
To learn how to set up a front cover content box, see Create a Cover Component [862], Add
Content for the Cover Content Box [863], and Style a Cover Content Box [871].

When you have set up your cover, make sure that Paligo is set to generate a front cover [915].
You can then publish to PDF, using the PDF layout you configured. Paligo will generate the PDF
output and it will include the covers you have set up.

If the cover does not appear as expected, see Troubleshooting PDF Covers [917].

Design a Back Cover (Recto)
The inside of the back cover - the page that faces the last page of your document - is called the
back cover recto.
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NOTE
To add a back cover to a PDF output, use cover components [860]. Paligo will
not include a back cover unless there are back cover components in place in your
publication topic.

The back cover recto can contain content from a:

• PDF layout
You can add certain types of content, such as background images, to the PDF layout.

• Back cover recto component
You can create and set up a cover component to represent the inside of the back cover. Any text
or images that you add to it will appear in a content box on the back cover recto.

For example, the following back cover recto has:
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1. Background image or color
A background image for the page. In the example shown, the background image is A4 sized
and is an abstract pattern.
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You can set the background image in a PDF layout or a cover component. You can also set a
background color for the entire cover and a content box. To learn how to set up backgrounds,
see Cover Background [906].

2. Content box
This is a box that is absolutely positioned on the cover. Its content comes from a cover
component, which is a special type of "container", similar to a topic. You can add many types of
content to a cover component, including paragraphs and images.
To learn how to set up a front cover content box, see Create a Cover Component [862], Add
Content for the Cover Content Box [863], and Style a Cover Content Box [871].

When you have set up your cover, make sure that Paligo is set to generate a front cover [915].
You can then publish to PDF, using the PDF layout you configured. Paligo will generate the PDF
output and it will include the covers you have set up.

If the cover does not appear as expected, see Troubleshooting PDF Covers [917].

Design a Back Cover (Verso)
We call the outer side of the back cover the "back cover verso".

NOTE
To add a back cover to a PDF output, use cover components [860]. Paligo will
not include a back cover unless there are back cover components in place in your
publication topic.

The back cover verso content can come from a:

• PDF layout
You can add certain types of content, such as background images, to the PDF layout.

• Back cover verso component
You can create and set up a cover component to represent the outside of the back cover. Any
text or images that you add to it will appear in a content box on the back cover verso.
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For example, the following back cover verso has:

1. Content box
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This is a box that is absolutely positioned on the cover. Its content comes from a cover
component, which is a special type of "container", similar to a topic. You can add many types of
content to a cover component, including paragraphs and images.
To learn how to set up a front cover content box, see Create a Cover Component [862], Add
Content for the Cover Content Box [863], and Style a Cover Content Box [871].

2. Background image or color
A background image for the page. In the example shown, the background image is A4 sized
and is an abstract pattern.
You can set the background image in a PDF layout or a cover component. You can also set a
background color for the entire cover and a content box. To learn how to set up backgrounds,
see Cover Background [906].

When you have set up your cover, make sure that Paligo is set to generate a front cover [915].
You can then publish to PDF, using the PDF layout you configured. Paligo will generate the PDF
output and it will include the covers you have set up.

If the cover does not appear as expected, see Troubleshooting PDF Covers [917].

Tips for Designing a Cover

• Be aware that the front cover can contain content from the publication topic, a cover
component, and the PDF layout. If there is insufficient space, some elements may overlap or
be pushed on to the next page.

• Look at the various info elements that are available and decide which ones you need and on
what side they should appear. Use the PDF layout settings to control which side of the front
cover the elements appear on (see Set an Info Element to be on the Front Side or Reverse
Side [883]).

• Use cover components [860] if you need to add any content to the back cover recto or back
cover verso.

• Allow extra space for translations. The text for titles and info elements may be longer in
different languages

• Use the PDF layout editor's preview feature to view the publication [484]. You can then see what
your cover design looks like. If you use the PDF editor settings to make changes, refresh the
preview to see the effect of those changes.

• Be aware that Paligo will only generate a front cover if you enable the Generate front cover
page for publications option in the PDF layout (see Set Paligo to Generate a Cover [915]). It is
set to enabled by default.

Cover Components
To design front and back covers for your PDFs, we recommend that you use cover components.
These are special types of "containers" designed specifically for covers and they allow you to add
content to any side of a cover. When you set up a cover component, you can add content inside it,
and then Paligo will insert that content into a box on the relevant cover.

For example, let's say you want your back cover to have your company logo and your web address.
For that, you could set up a back cover recto cover component. You then edit the component and
add the image and a paragraph for your business website address. When you publish, Paligo gets
the content from the cover component and inserts it into a box on the back cover.
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We recommend that you use cover components for your PDF publications as they give you more
control over your front and back covers. The most common way to use them is to set up four
cover components to your publication, one for each side of the front and back cover.

NOTE
It is possible to set up a front cover without using cover components. For that, you
add the content into the publication topic and Paligo inserts that into the front
cover recto. If there is too much content to fit on the front recto, the content will
overflow on to the front verso.

This is how Paligo supported front covers in earlier versions. If you have
publications set up to work in this way, they will continue to work as expected.
But we recommend that you use cover components for new publications.

To set up a cover component:

1. Read Design Covers for PDFs [848] so that you understand what Paligo can show on each
cover.

2. Create a Cover Component [862].

3. Set the cover component to represent a specific side of the cover [865] (front recto, front
verso, back recto, or back verso).

4. Add content to the cover component [863].

5. Add the cover component to a publication [869].

6. Repeat this process for each cover component.

NOTE
To control the position of a cover content box and its styling, use the PDF layout
settings (see Style a Cover Content Box [871]).
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Create a Cover Component
Cover components are special types of container, similar to a topic, that you can use to represent
each side of a front cover and back cover. For example, if you are publishing a PDF user guide, you
could have 4 cover components:

• Front cover (front recto)

• Inner side of front cover (front verso)

• Inner side of back cover (back recto)

• Back cover (back verso)

NOTE
It is possible to create a front cover without using cover components. With this
approach, you add content to a publication topic and then use the PDF layout to
set the content to appear on the front or reverse side. This is how front covers
were supported in earlier versions of Paligo. If you have set up your publications
to work this way previously, they will continue to work.

However, we now recommend that you use cover components when creating
front covers and back covers for PDF. They offer more functionality, such as the
ability to use content boxes on the covers.

To create a cover component:

1. In the Content Manager, select the options menu ( ... ) for the folder that will contain your
cover component.
If you do not have a suitable folder, you can create one. For details, see Organize Components
in the Content Manager [36].

2. Select Create Content.

3. Enter a suitable name for your new component and set the Custom element option to cover.
In the following image, we have called the cover "Front Cover Recto - Content Box".
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4. If you are going to publish the cover in multiple languages, use the Language section to add
the languages you need.

5. Select OK.
Paligo creates a new cover component.

Next, you should edit the cover component [863] so that you can add content to it. You will also
need to set it to be a front cover or back cover and recto or verso [865].

Add Content for the Cover Content Box
When you have created a cover component, you can edit it to define content that will appear in a
cover content box. The content you add or change will appear in the appropriate content box, for
example, if you edit a cover that is set to be the back verso, then the changes you make will affect
the back cover.

To add content to a cover component:

1. In the Content Manager, find the cover component you want to edit and then click on it to
open it in the editor.
The cover is different to a regular topic, as instead of having a section element at the top-level,
it has a cover element. By default, all cover components also contain one para element.
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2. To add content, position the cursor where you want to add the content, and then use the
element context menu to add an element. You can add any elements that are valid inside
a cover element, for example, para. (The element context menu only shows elements that
are valid at the currently selected position. For details of the valid elements, see the DocBook
standard).

To access the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).
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NOTE
To insert images, select the Insert menu and then one of the Image options.
Paligo will add the image structure and you can choose the image from the
Media dialog.

TIP
When you add content to a cover component, consider the amount of space
available in the content box. If you add text and images that cannot fit into
the content box, the content will overlap other content that is on the same
page. You should also allow extra space for translated versions, which may be
longer.

You can use the preview in the PDF layout to see how Paligo will render your
cover content in the content box.

3. Enter content inside the element, as required.

4. Repeat steps 2 and 3 to add the content that you want to appear in the cover's content box.

5. Select Save. 

NOTE
When you edit a cover component, the changes you make will only go into the
publication if:

• You give the cover element a role attribute set to front, front recto, front
verso, back, back recto, or back verso.
For details, see Set a Cover to be Front, Back, Recto, Verso [865].

• You add the cover component to the publication topic as a component.
For details, see Add a Cover to a Publication [869].

Set a Cover to be Front, Back, Recto, Verso
When you add cover components to your projects, it is important that you specify which side of
the cover they are for. You can set a cover to be:

• Front cover recto
This is the cover you see at the start of the document. It is the front cover, right-hand page.
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• Front cover verso
This is the reverse side of the front cover. It is the front cover, left-hand page.

• Back cover recto
This is the inner side of the back cover. It is the page you see next to the final page of your
document and is the back cover, right-hand page.

• Back cover verso
This is the outer side of the back cover. It is the back cover, left-hand page.
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To set a cover to be front recto, front verso, back recto, or back verso:

1. Select the cover component in the Content Manager.
Paligo displays the cover component in the editor.

2. Select the cover element in the Element Structure Menu and then select Go to element.

3. In the Element attributes panel, give the cover element a role attribute and set the value to
one of the following:

• front recto
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NOTE
Alternatively, you can set the value to front. The values front and front
recto both set the cover to be a front recto.

• front verso

• back recto

• back verso
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NOTE
Alternatively, you can set the value to back. The values back and back verso
both set the cover to be a back verso.

4. Select Save. 

Next, add your cover component to a publication topic [869]. Paligo will only include the cover if it
is a component in a publication topic.

Add a Cover to a Publication
To include a cover component in a PDF, you must first add it to the publication topic for your
publication.

NOTE
The cover component must also have a suitable role attribute (see Set a Cover to
be Front, Back, Recto, Verso [865]).

When you have added your covers to a publication topic, you will be able to:

• Use the PDF layout preview to see how your covers will look when published.
This is useful when you are designing the covers and using the PDF layout to change colors,
fonts, and spacing.

• Publish a PDF that includes your covers.

To add a cover to a publication:

1. Display the publication topic:

a. In the Content Manager, find the publication and select its options menu ( ... ).

b. Select Edit and then Open in editor.

NOTE
If you do not have a suitable publication yet, you can create one (see
Create a Publication [96]).

Paligo displays the publication topic in the editor.

2. Position the cursor at a valid position for an inserted component, for example, inside the info
element after the title.
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3. Select the Insert menu and then select Component.

Paligo displays the Import content dialog.

4. Find your cover component in the Import content dialog and then select it.
Paligo inserts your cover component into the publication topic. In the structure, it is an
import element.
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5. Repeat this process for the other cover components. You can add up to 4 cover components
(front recto, front verso, back recto, back verso).

6. Select Save. 

When you have added your cover components to the publication topic, use the PDF layout to
style the content boxes for the cover components [871]. You will also need to set up the "info
elements" in the publication topic (see Info Elements for Covers [881]).

Style a Cover Content Box
Use the PDF layout to control the positioning and appearance of a cover content box (and the
content inside it). There are settings for each cover (Front page or Back page) and inside those,
settings for each side of the cover (Front cover recto, Front cover verso, Back cover recto, and
Back cover verso).
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For each side of the cover, you can set the position of the content box, its size, padding, font style
and color, and alignment.

NOTE
The front cover recto, front cover verso, back cover recto and back cover verso
settings also have options that affect the entire cover page:

• Background image (see Methods for Adding a Background Image to a
Cover [907])

• Background color (see Set the Background Color of a Cover [913]).

Position a Content Box on a Cover
Use the PDF layout settings to define the absolute position of the content box on a cover.

NOTE
The position of the content box is measured from the edges of the body region of
the page. It is not measured from the edges of the page. To learn about the body
region, see Set the Page Margins for PDF [814].

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Expand the settings for the relevant cover, either Front page or Back page and then select
the settings for the relevant side (front cover recto, front cover verso, back cover recto,
back cover verso).
If you are unsure about which sides of the covers these settings relate to, see Covers: Recto
and Verso [847].

4. Use the margin settings to control the position of the text box on the page:

• Left margin for the content box
Set the distance from the left edge of the body region to the left edge of the content box.

• Right margin for the content box
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Set the distance from the right edge of the body region to the right edge of the content box.

• Top margin for the content box
Set the distance from the top edge of the body region to the top edge of the content box.

• Bottom margin for the content box
Set the distance from the bottom edge of the body region to the bottom edge of the content
box.

You must include the units of measurement, for example, 2cm, 50px, 20pt.

5. Select Save. 

6. Repeat this process for each of the covers, if required.

When you publish using this layout, Paligo will apply the margins to the content box on the
appropriate cover(s).

Set the Size of a Cover Content Box
You can use the PDF layout to define the height of a cover content box. For example, you could set
a back cover recto content box to be 5cm so that it could fit in a logo and a link to your website.

If the content in your cover component is too large for the content box, it will overspill. The text
and images will either break out beyond the edge of the box and will overlap any other content on
the cover. For this reason, you should consider the size of the content that will go into the box, and
also allow extra space for translated versions which may be longer.

NOTE
When setting the size and position of a content box, you should only use two of
the following settings:

• Top margin for the content box

• Bottom margin for the content box

• Height of the content box.

If you use all three, the bottom margin is ignored.

If you do not specify a height, Paligo calculates the height based on the space
available below the top margin and above the bottom margin.

To set the height:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Expand the settings for the relevant cover, either Front page or Back page and then select
the settings for the relevant side (front cover recto, front cover verso, back cover recto,
back cover verso).
If you are unsure about which sides of the covers these settings relate to, see Covers: Recto
and Verso [847].

4. Set the Height of the content box.

You must include the units of measurement, for example, 5cm.

5. Select Save. 

6. Repeat this process for each of the covers, if required.

Set the Padding of a Cover Content Box
Use the PDF layout settings to define the internal margins, also known as "padding", for a cover
content box. The internal margins set the amount of space between the edges of a content box
and the content inside the box.

In this diagram, the black edges are the edges of the content box. The arrows represent the inner
padding between the edges and the content.

To set the internal margins or "padding":

1. Select the Layout tab in the top menu.
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Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Expand the settings for the relevant cover, either Front page or Back page and then select
the settings for the relevant side (front cover recto, front cover verso, back cover recto,
back cover verso).
If you are unsure about which sides of the covers these settings relate to, see Covers: Recto
and Verso [847].

4. Enter the amount of spacing you want into the Padding for the content box field.
You need to include the measurement and the units of measurement, for example, 10pt.

5. Select Save. 

6. Repeat this process for each of the covers, if required.

When you preview your publication in the PDF layout, Paligo will show the borders of the content
box. If you leave the border setting in place, Paligo will also include the borders when you publish.

Set the Border for a Cover Content Box
By default, cover content boxes do not have a visible border. You can add one in the PDF layout
settings, if required. We recommend that you add visible borders when you are designing a cover,
as it makes it easier to position and size the content boxes correctly.

To set the border for a cover content box:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Expand the settings for the relevant cover, either Front page or Back page and then select
the settings for the relevant side (front cover recto, front cover verso, back cover recto,
back cover verso).
If you are unsure about which sides of the covers these settings relate to, see Covers: Recto
and Verso [847].

4. Enter the border settings in the Border for the content box field.

You can use these values:

• Line thickness:

• thin

• medium

• thick

• Exact value (also known as "length")
Enter a width measurement including the units of measurement, for example, 3pt.

• Line style:

• none - There is no border.

• hidden - There is a border but it cannot be seen.

• dotted - The border is a dotted line.

• dashed - The border is made up of short lines.

• solid - The border is a single line with no breaks.

• double - The border is two lines with no breaks.

• groove - The border has lines and shading to create a "pressed down" look.

• ridge - The border has lines and shading to create a "raised" look.

• inset - The border has lines and shading to create a "pressed down" look. It is similar to
the groove style, but uses a different line and shading pattern.

• outset - The border has lines and shading to create a "raised" look. It is similar to the
ridge style, but uses a different line and shading pattern.

• Line color:
Use any of these:

• Color name, such as silver
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• RGB value, such as rgb(255,0,0)

• Hex number, such as #ff0000

For example, if you wanted a medium thickness, dashed line border and you wanted it blue,
you would enter:

medium dashed blue

5. Select Save. 

6. Repeat this process for each of the covers, if required.

When you preview your publication in the PDF layout, Paligo will show the borders of the content
box. If you leave the border setting in place, Paligo will also include the borders when you publish.

Set the Font Styles for a Cover Content Box
Use the PDF layout settings to define the font styles for a cover content box. The font styles
include the typeface, size, and color.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Expand the settings for the relevant cover, either Front page or Back page and then select
the settings for the relevant side (front cover recto, front cover verso, back cover recto,
back cover verso).
If you are unsure about which sides of the covers these settings relate to, see Covers: Recto
and Verso [847].

4. Use the Font family for the content box setting to choose the typeface. Paligo will apply
this style of lettering to any text that is in the content box. The text comes from a cover
component.

5. Use the Font size for the content box setting to set the size of the typeface.
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You must include the units of measurement, for example, 14pt.

6. Use the Color for the content box section to choose the color of text (in the content box).
To use the default color, black, check the Use default color box.
To choose a different color, clear the Use default color box. You can then:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).

7. Select Save. 

8. Repeat this process for each of the covers, if required.

When you publish using this layout, Paligo will apply the font settings to the content box on the
appropriate cover(s).

Set the Alignment for a Cover Content Box
To control the horizontal and vertical alignment of the content in a cover content box:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Expand the settings for the relevant cover, either Front page or Back page and then select
the settings for the relevant side (front cover recto, front cover verso, back cover recto,
back cover verso).
If you are unsure about which sides of the covers these settings relate to, see Covers: Recto
and Verso [847].

4. Use the Alignment for the content box setting to control the horizontal alignment of the
content in the box.

• Start
Left-align the text (in left-to-right languages).

• End
Right-align the text (in left-to-right languages).

• Center
Align the text centrally.

• Justify
Add space between the words so that the text is spaced out to fit the full width of the
content box. The first word and last word of the text will be at the margin boundaries of the
content box.

• Inside
Align the text to the "spine". The spine is where the pages would be bound if the document
was printed out as a book. If the text is on a left page ("verso"), the text is right-aligned and if
it is on a right page ("recto") it is left-aligned.

• Outside
Align the text to the outer edge of the page. This is the opposite edge to the "spine" (see
Inside). If the text is on a left page ("verso"), the text is left-aligned and if it is on a right page
("recto") it is right-aligned.

5. Set the Vertical alignment for the content box. Choose from:

• Auto - Sets the content to have the same baseline. This looks similar to vertically aligning
content to the bottom of the cells.
Sets the content to have the same baseline. This looks similar to vertically aligning content
to the bottom of the cells.

• Before - Vertically align the content to the top.
Vertically align the content to the top.

• Center - Vertically align the content to the middle.
Vertically align the content to the middle.

• After - Vertically align the content to the bottom.
Vertically align the content to the bottom.

6. Select Save. 

7. Repeat this process for each of the covers, if required.
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Set the Background Color for a Cover Content Box
You can set a background color for a cover content box so that it stands out from the background.
For example, in the following image, the background of the page is blue and the background of the
cover content box is white.

1. Background color of content box is white.

2. Background color of page is blue (see Set the Background Color of a Cover [913]).

To set the background color of the content box:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Expand the settings for the relevant cover, either Front page or Back page and then select
the settings for the relevant side (front cover recto, front cover verso, back cover recto,
back cover verso).
If you are unsure about which sides of the covers these settings relate to, see Covers: Recto
and Verso [847].

4. Use the Background color for the content box setting to choose the color.
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To select a color of your own choice, clear the Use default color checkbox and then either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).

5. Select Save. 

Info Elements for Covers
There are many useful elements that you can add inside a publication topic, including copyright,
author, and pubdate. They are mostly designed for providing information about a document and
we call them the "info elements" as you can only add them inside an info element.

NOTE
You can also add the address element inside a cover element (in a cover
component).

To learn about adding "info elements" to publication topics, see Edit a Publication Topic [121].

To learn how to style the "info elements", see Style the Info Elements [881].

Style the Info Elements
The PDF layout has settings for styling the "info elements" that you can add to a publication
topic [121]. You can find them in the Front Page group under the Info elements category.
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Set the Order of Info Elements
In a publication topic, you can have "info" elements, such as copyright and author. By default,
Paligo displays these elements in a fixed order (see Order of Info Elements [118]). But you can use
the PDF layout settings to change the order to meet your own requirements.

To set the order of the info elements:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Front Page and then Info elements.

4. Use the The order of additional info elements setting to control the order of the info
elements in the PDF output. Choose from:

• Fixed
Paligo will present the info elements in a pre-defined order, which may not match the order
of the elements that you can see when you edit the publication topic. For more details on
the fixed order, see Order of Info Elements [118].

• Free
The info elements will be in the same order that they appear in the publication topic in the
Paligo editor.
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5. Select Save.

When you publish with this layout, the info elements will be in the order that you have chosen.

NOTE
It is possible to make changes beyond those that are supported by the PDF layout.
An XSLT developer can make changes by creating a customization. We can provide
this as a professional service. For details, please contact customer support.

Set an Info Element to be on the Front Side or Reverse Side
Publication topics contain "info" elements and by default, Paligo will try to add them to the front
side of the front cover (the front recto). If there is not enough space, Paligo will show them on the
next page (the front verso). If you prefer, you can use the PDF layout settings to control which side
of the front cover each "info" element will appear on.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Front Page and then Info elements.

4. Use the Render element on this side of the front cover settings to choose which page the
various additional info elements should appear on. There are render element on this side
of the front cover options for most of the additional info elements, including authorgroup,
author, volumenum, and pubdate.
For each info element, you can choose either recto (for the right page) or verso (for the left
page). You can also choose none to prevent an info element from being shown on the page.
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NOTE
Paligo will position the info elements on the sides you have chosen as long as
there is enough space available. For example, if you set the publication date
to appear on the front cover (recto), but there is insufficient space, it will push
the content onto the next page instead.

5. Select Save.

When you publish with this layout, the info elements will appear on the sides you have chosen, as
long as there is enough space available.

NOTE
It is possible to make changes beyond those that are supported by the PDF layout.
An XSLT developer can make changes by creating a customization. We can provide
this as a professional service. For details, please contact customer support.

Set Auto-Labels for Info Elements
Paligo can generate labels for some elements, such as pubdate, edition and abstract. The
labels are shown next to the element in the output and they give the reader extra context about
the information. For example, the label for the publication date is "Publication date". Without the
label, the date would appear on its own.

To set Paligo to use auto-labels for PDFs:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Front Page and then Info elements.

4. Set up automatic labelling for the pubdate, edition, and abstract elements (if they exist in
your publication topic). There is a separate setting for each of these elements.
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For each of these elements, enable or disable auto-labelling.

• Enabled
Adds the term "Publication date" or "Abstract" before the content or "Edition" after the
content of those elements.

• Disabled
Does not include the auto-label terms before the pubdate, edition, or abstract
elements.

5. Select Save.

When you publish with this layout, the elements will use the auto-label settings you have chosen.

NOTE
It is possible to make changes beyond those that are supported by the PDF layout.
An XSLT developer can make changes by creating a customization. We can provide
this as a professional service. For details, please contact customer support.

Set the Publication Date and Time Format
Use the PDF layout editor to control the format of the publication date. You can set the format for
the source language and also for other languages.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Front Page and then Info elements.

4. Set the date format for the pubdate element in the Today's date for publication date field.
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To define the date format, use the JAVA format or the DocBook format, depending on whether
you have the Use translatable publication date setting set to Enabled or Disabled (see next
step).

• Use the JAVA format if Use translatable publication date setting is set to Disabled.
For details of the JAVA format, see https://docs.oracle.com/javase/7/docs/api/java/text/
SimpleDateFormat.html.

• Use the DocBook format if Use translatable publication date setting is set to Enabled.
For details of the DocBook format, see http://www.sagehill.net/docbookxsl/Datetime.html.

If you add an empty pubdate element to your publication topic, Paligo will automatically
insert the date when you publish, but only if you enter a date format here. If there is no date
format, Paligo will exclude empty pubdate elements from the published output.

5. If you use a full-text format date for the pubdate element, you can set Paligo to convert it
automatically into other languages. For example, you could have 28 March 2022 in English and
Paligo would translate it to 28 mars 2022.
To turn on the auto-translation, set the Use translatable publication date setting to
Enabled. Set it to Disabled to turn this feature off.

6. Select Save.

When you publish with this layout, the title will use the publication date settings you have chosen.

NOTE
It is possible to make changes beyond those that are supported by the PDF layout.
An XSLT developer can make changes by creating a customization. We can provide
this as a professional service. For details, please contact customer support.

Set the Alignment for Additional Info Elements
Publication topics can contain info elements, such as copyright information and the name of the
author. These elements are mostly left-aligned by default, but you can use the PDF layout to
change the alignment. (For HTML, use CSS to adjust the alignment).

1. Select Layout and then either select an existing layout to open it in the Layout Editor or create
a new layout [1059].

2. Select Front Page and then Info elements.

3. Choose the alignment settings for the front page and other front matter pages:
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Use these settings to set the alignment for the front cover, the reverse, and any further pages:

• Alignment for info element group (front cover)
Use to set the alignment of info elements on the front cover page.

• Alignment for info element group (reverse side)
Use to set the alignment of info elements on the reverse side of the cover page. This will
also apply to any additional pages that appear before the table of contents, for example, if
you have a legal notice that goes over two pages, they will both use the alignment for the
reverse side.

With both of the alignment settings, you can choose from:

• Start
Left-align the text (in left-to-right languages).

• End
Right-align the text (in left-to-right languages).

• Center
Align the text centrally.

• Justify
Add space between the words so that the text is spaced out to fit the full width of the
content area. The first word and last word of the text will be at the margin boundaries of the
content area.

• Inside
Align the text to the "spine". The spine is where the pages would be bound if the document
was printed out as a book. If the text is on a left page ("verso"), the text is right-aligned and if
it is on a right page ("recto") it is left-aligned.

• Outside
Align the text to the outer edge of the page. This is the opposite edge to the "spine" (see
Inside). If the text is on a left page ("verso"), the text is left-aligned and if it is on a right page
("recto") it is right-aligned.
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4. Select Save.

When you publish with this layout, the title will use the style and positioning settings you have
chosen.

NOTE
It is possible to make changes beyond those that are supported by the PDF layout.
An XSLT developer can make changes by creating a customization. We can provide
this as a professional service. For details, please contact customer support.

Set the Color of Info Elements
To change the color of the info elements, such as copyright and the author's name, on the front
cover or "front matter" pages:

1. Select Layout and then either select an existing layout to open it in the Layout Editor or create
a new layout [1059].

2. Select Front Page and then Info elements.

3. Set the color of the info elements on the front cover and the reverse side.

• Color for additional info elements on front cover recto
Use to set the color of info elements on the front cover.

• Color for additional info elements on front cover verso
Use to set the color of info elements on the reverse side of the cover and any further pages.

For both color options, you can either use the default color (black) or clear the checkbox and
then choose a different color. You can enter rgba values or use the color selector to choose a
color.

4. Select Save.

When you publish with this layout, the info elements will use the colors you have chosen.
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NOTE
It is possible to make changes beyond those that are supported by the PDF layout.
An XSLT developer can make changes by creating a customization. We can provide
this as a professional service. For details, please contact customer support.

Cover Title and Subtitle
Paligo uses the title from the publication topic for the title on the front cover. You can also have an
optional subtitle to use as a second-level title.

For example, you could have:

• Title
ACME 100 Drone User Guide

• Subtitle
A beginner's guide to the Acme drone

Add a Title or Subtitle to a Cover
The title and subtitle for a front cover come from the title and subtitle elements in the publication
topic. Paligo adds these elements automatically when you create a publication.

A publication has to have a title, but the subtitle is optional.

If your publication has had its subtitle removed and you want to add one:

1. Select the Dotted Menu (...) for the publication in Content Manager [34].

2. Select Edit and choose Open in editor.

Paligo opens the publication topic.

3. Position the cursor where you want the subtitle to appear.

4. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].
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5. Enter subtitle and select it.

6. Enter the text for the subtitle.

7. Select Save. 

To set the position and appearance of the title and subtitle, see:

• Style the Title for a Front Cover [890]

• Style the Subtitle for a Cover [893].

NOTE
You cannot add a title or subtitle to a cover component. They are not
allowed as "children" of the cover element.

Style the Title for a Front Cover
The PDF layout editor has two groups of settings for styling the front cover title for PDF:

• Title block
Use to style the positioning of the title and the color and appearance of the line beneath the title

• Title
Use to style the appearance of the text in the title.

NOTE
We recommend that you read Understanding the Front Cover Margins [916]
before you set any title margins. There, you can learn how to calculate the
margins for your front title content, taking into consideration any page margins
and body margins that are already in place.

To style the title for a front cover:
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1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Front Page and then select Title block.

4. Choose the alignment settings for the front page and other front matter pages:

NOTE
For all settings that require a numerical value, you need to include the units
of measurement as well. For example, enter 3.5cm rather than 3.5 with no
units of measurement.

• Title block distance from top
Use to set the distance from the top of the content area to the start of the title block.

• Title block margin left
Use to set the distance from the left edge of the content area to the left edge of the title
block.

• Title block margin right
Use to set the distance from the right edge of the content area to the right edge of the title
block.

• Border for title block
Use to add a border for the title block. This can be useful when you want to see the block
so that you can judge the distances for margins. Enter the line thickness followed by the line
style and color, for example, 3pt dotted green

• Width of horizontal rule under title
If you want a horizontal line under the title, enter the line thickness, for example, 3pt.

• Color of horizontal rule under title
Set the color of the horizontal line under the title. Use the default color (gray) or clear the
checkbox and then either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).
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5. Select Front Page and then select Title.

6. Choose the settings you want for the title text:

• Font family for front cover title
Choose the style of lettering for the title text.

• Font size for front cover title
Enter the font size and measurement units, for example, 30pt or 300%. Note that
percentage values are based on the font size of the main body text (set in General > Fonts).

• Font weight for front cover title
Set the thickness of the text, for example, thin or bold.

• Font style for front cover title
Choose the style for the text. This can be normal, italic (leaning forwards), or backslant
(similar to italic, but leaning backwards).

• Font variant for front cover title
Choose:

• normal for regular text

• small-caps for small upper case letters.

• Capitalization for front cover title
Use to control the capitalization of the text. Choose from lower case (all letters lower case)
upper case (all letters upper case) or capitalize

• Lower case
All letters are lower case.

• Upper case
All letters are upper case.

• Capitalize
The first letter in each word is upper case, the other letters are lower case.

NOTE
If the Font variant for front cover title is set to small-caps, and you
choose Capitalize, the entire title will be in capital letters. The first letters
of each word will be larger.
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• Letter-spacing for front cover title
Use to set the amount of space between each letter in the text. Enter the value and the
measurement units, for example, 0.2em.

• Color for front cover title
Set the color of the text. Either use the default color (black) or clear the checkbox and then
choose a different color. You can enter rgba values or use the color selector to choose a
color.

• Alignment for front cover title
Choose the alignment for the title:

• Start
Left-align the text (in left-to-right languages).

• End
Right-align the text (in left-to-right languages).

• Center
Align the text centrally.

• Justify
Add space between the words so that the text is spaced out to fit the full width of the
content area. The first word and last word of the text will be at the margin boundaries of
the content area.

• Inside
Align the text to the "spine". The spine is where the pages would be bound if the
document was printed out as a book. If the text is on a left page ("verso"), the text is
right-aligned and if it is on a right page ("recto") it is left-aligned.

• Outside
Align the text to the outer edge of the page. This is the opposite edge to the "spine" (see
Inside). If the text is on a left page ("verso"), the text is left-aligned and if it is on a right
page ("recto") it is right-aligned.

7. Select Save.

When you publish with this layout, the title will use the style and positioning settings you have
chosen.

NOTE
It is possible to make changes beyond those that are supported by the PDF layout.
An XSLT developer can make changes by creating a customization. We can provide
this as a professional service. For details, please contact customer support.

Style the Subtitle for a Cover
By default, a publication topic contains a subtitle element that you can use to add a secondary
title for a document. When the subtitle is in place, you can style it by using the settings in a PDF
layout. There are various settings for margins, font style, size and color.
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NOTE
If your publication does not have a subtitle element, you can add one (see Add
a Title or Subtitle to a Cover [889]).

To style the subtitle for a front cover:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Front Page and then select Subtitle.

4. Choose the settings you want for the subtitle:

NOTE
For all settings that require a numerical value, you need to include the units
of measurement as well. For example, enter 3.5cm rather than 3.5 with no
units of measurement.

• Subtitle margin left
Use to set the distance from the left edge of the content area to the left edge of the subtitle.

• Subtitle margin right
Use to set the distance from the right edge of the content area to the right edge of the
subtitle.
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• Space-before front cover subtitle
Use to set the amount of space above the subtitle.

• Space-after front cover subtitle
Use to set the amount of space below the subtitle.

• Font family for front cover subtitle
Choose the style of lettering for the subtitle.

• Font size for front cover subtitle
Enter the font size and measurement units, for example, 16pt or 200%. Note that
percentage values are based on the font size of the main body text (set in General > Fonts).

• Font weight for front cover subtitle
Set the thickness of the text, for example, thin or bold.

• Font style for front cover subtitle
Choose the style for the text. This can be normal, italic (leaning forwards), or backslant
(similar to italic, but leaning backwards).

• Font variant for front cover subtitle
Choose:

• normal for regular text

• small-caps for small upper case letters.

• Capitalization for front cover subtitle
Use to control the capitalization of the text. Choose from lower case (all letters lower case)
upper case (all letters upper case) or capitalize

• Lower case
All letters are lower case.

• Upper case
All letters are upper case.

• Capitalize
The first letter in each word is upper case, the other letters are lower case.

NOTE
If the Font variant for front cover subtitle is set to small-caps, and you
choose Capitalize, the entire subtitle will be in capital letters. The first
letters of each word will be larger.

• Letter-spacing for front cover subtitle
Use to set the amount of space between each letter in the text. Enter the value and the
measurement units, for example, 0.2em.

• Color for front cover subtitle
Set the color of the text. Either use the default color (black) or clear the checkbox and then
choose a different color. You can enter rgba values or use the color selector to choose a
color.

5. Select Save.

When you publish with this layout, the subtitle will use the styling and positioning settings you
have chosen.
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Set the Languages for Title and Subtitle
By default, Paligo shows the title and subtitle in all languages that you include when publishing. If
you prefer, you can use the PDF layout to set the title and subtitle to only appear in one language.

To learn how to set the title and subtitle languages, see:

• Set the Title to Appear in One Language for PDF [827]

• Set the Subtitle to Appear in One Language for PDF [828].

Languages on Cover
If you have content in multiple languages, you can create "combined language" PDFs. A combined
language PDF has your content in multiple languages all in the same PDF file, for example, a single
PDF that includes English, German, and Spanish translations. For these combined language PDFs,
you can choose to add the names of the languages on the front cover.

If you choose to add the languages, you can get the front cover to show:

• A list of the included languages (for combined language PDFs)

• The name of the language (for single language PDFs).

TIP
Paligo also has settings that let you add the title and subtitle in multiple
languages, see Set your Multi-Language Preferences for PDF [826].

To add a language list to the front cover of a PDF:

1. Select the Layout tab in the top menu.
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Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Front Page and then select Languages.

4. Use the Display Language List setting to choose whether the languages are listed on the
front cover.

• Enabled
Adds the list of languages to the front cover. They are positioned in the top-right of the
content area.

• Disabled
The list of languages is not shown. This is the default setting.

5. Use the Language format setting to choose how the languages are presented.

• Language code
Each language is shown as the ISO 639-1 standard language code, for example, en for
English, de for German, sv for Swedish.

• Language local name
Each language is named, using the local spelling, for example, Deutsch for German and
Svenska for Swedish.

• Language name in English
Each language is named using the English spelling, for example, German, Swedish.

• Language name in English - local name
Each language is named using the English spelling first, followed by a hyphen and then the
local spelling, for example, German - Deutsch, Swedish - Svenska.

• Language local name - name in English
Each language is named using the local spelling first, followed by a hyphen and then the
English spelling, for example, Deutsch - German, Svenska - Swedish.

6. Use the Letter case for language names setting to control the capitalization on the language
names:

• Upper case
Show language name in capital letters, for example, ENGLISH

• Lower case
Show language name in lower case letters, for example, english

• Capitalize first letter
Show language name with capital first letter, lower case for other letters, for example,
English.
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7. Select Save.

When you publish, Paligo will create a PDF with the language settings applied to the front cover.

NOTE
It is possible to make changes beyond those that are supported by the PDF layout.
An XSLT developer can make changes by creating a customization. We can provide
this as a professional service. For details, please contact customer support.

Logo on Cover
For PDF outputs, you can use a PDF layout to upload a logo image for your front cover. When you
have added the image, you can choose to place it in any corner of the page, and you can also
control its margins to move it up, down, left and right as needed.

To add a logo image to the front page and define its position and appearance:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Front Page and then select Logotype.

4. Use the Logotype field to upload a logo image. You can upload an image in any of these
formats: ai, svg, pdf, png, tif, gif.

5. Set the Logo alignment to your preferred corner of the front cover.

6. Set the horizontal and vertical margins for the logo:

• Horizontal margin between logotype and page
This field contains XPATH by default:

{$page.margin.inner}

To move the logo image to the right, enter the plus symbol ( + ) and the measurement and
measurement units after the XPATH, for example:

{$page.margin.inner}+3cm

To move it to the left, add a minus value after the XPATH, for example:

{$page.margin.inner}-1cm

• Vertical margin between logotype and page
This field also contains XPATH by default:

{$page.margin.top}

After the XPATH, enter a positive measurement to move the logo down the page or enter a
minus measurement to move it up the page. For example:

{$page.margin.top}+2.5cm

7. Set the maximum dimensions of the logo image.

• Max height of the logotype

• Max width of the logotype
You must include the measurement and the measurement units, for example, 100pt, or
2.5cm.
Paligo will not allow the image to scale beyond these limits and will keep the aspect ratio of
the original image so that it is not distorted.

8. Select Save.
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TIP
To add a logo image to other covers, such as a back cover:

1. Set up cover components [860] for your publication.

2. Add the logo image as a regular image inside a cover component [863].
Paligo will include the logo image in the content box on the appropriate
cover.

3. Use a PDF layout to control the positioning of the content box [872].

Cover Foreground Images
You can add foreground images to create stylish PDF covers for your documentation.

There are two different types of image that you can add to the front cover:

• A product image. For example, in the image above, the drone is a product image with a
transparent background. The blue sky part of the image is a background image.

• Images in a content box (only if your publication uses cover components [860]).

For the product image, you can add the image:

• In the publication topic
Paligo will only use the image when you publish this particular document. To learn more, see
Add a Product Image to Cover of One Publication [901].

• In the PDF layout.
Paligo will use the image every time you publish with this PDF layout (unless the document also
has a product image in its publication topic). To learn more, see Add a Product Image to the
Cover of Many Publications [902].

For images in a content box, your publication has to be set up to use cover components. You can
then add images to each of the cover components and Paligo will show these in addition to any
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product image. So for the front cover, you could have a product image and a content box image.
You could also have images on each of the other covers by adding an image in their respective
cover components (see Add Content for the Cover Content Box [863]).

Add a Product Image to a Cover
For front covers, you can add a product image that will appear in the foreground of the cover.

Depending on your requirements, you can:

• Add a product image to a publication topic
Paligo will use the product image for this particular publication only.

• Add a product image to a PDF layout
Paligo will use the product image every time you publish with that particular PDF layout.

NOTE
To add an image to other covers, use cover components [860]. Insert the image
into a cover component and it will appear in the content box on the appropriate
cover (as long as the cover components are set up correctly). To learn how to add
an image in a cover component, see Add Content for the Cover Content Box [863].

Add a Product Image to Cover of One Publication
Every publication topic contains the structure for a foreground image (product image) by default. If
you choose an image for that structure, the image will appear on the cover page when you publish
to PDF. It will take priority over any product image that is set in the PDF layout settings.

To create publications that have different product images on their front pages, you can either:

• Add an image to the publication topic

• Create a separate PDF layout for each different publication and set the product images in the
layouts.

Typically, it is easier to have one PDF layout to manage and then set the product images
individually in each publication topic.

To add a product image in the publication topic:

1. In the Content Manager, find the publication you want to add the image to.

2. Select the publication's options menu ( ...) and then select Edit and then Open in Editor.
Paligo opens the publication topic. This is a topic at the root of the publication and you
can use it to add various "front matter" elements, such as images, cover text, copyright
information, etc.

3. By default, the publication topic contains the structure for an image. To insert an image,
right-click on the image placeholder, select Image browser, and then choose the image from
your image library. You can upload a new image if required.
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If your publication topic does not contain the structure for an image, select Insert and then
Image to add an image.

4. Select Save.

When you publish your content, the image you selected will be used as a product image on the
front cover.

Add a Product Image to the Cover of Many Publications
To create many publications with the same product image on their covers, set the image in a PDF
layout. Every time you publish with that layout, the resulting PDFs will use the product image on
their front covers.

NOTE
To produce PDFs that use different product images, you can either create
separate PDF layouts for each different document or you can add the product
image in the publication topic (see Images in a Publication Topic [125]).

To use a PDF layout to set up a product image for the front cover:

1. Use a graphics or photography application to create your product image.

2. Create [1059] or edit [1061] a PDF layout. In the Layout Editor, select Front page and then
Product image.

3. In the Product image setting, select the Upload button and then drag the image you created
into the upload box.
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4. Select Save.

NOTE
Use the PDF layout settings to control the position and size of the product image,
see Style a Product Image for a Front Cover [903].

When you publish and choose to use this layout, Paligo creates a PDF and uses the product image
that you defined in the layout. But if the publication has an image in its "publication topic", Paligo
will use that image instead and will ignore the PDF layout. You can solve this problem by deleting
the image in the publication topic.

Style a Product Image for a Front Cover
The product image is a foreground image that is shown on the front page of PDF outputs. You
can either add the image to the publication topic or to the PDF layout and you can control its
appearance and position in the layout settings.

Use the PDF layout settings to style the product image, for example, to set the product image
container height and scaling.

Set the Product Image Container Height
When you publish to PDF, Paligo positions the product image in a container, and then the
other elements on the front page are arranged above and below the container. You can set the
maximum height of the container in the PDF layout settings, so that the image fits in a certain
space.

NOTE
If the image is larger than the container, Paligo will either scale the image to fit the
container or will cut off the image at the container's boundaries.

To set the product image container height:

1. Select Layout and then either select an existing layout to open it in the Layout Editor or create
a new layout [1059].

2. Select Front Page and then Product image.

3. Set the Height of the product image container. You need to enter the new measurement
and the measurement units, for example, 8cm. The default value is 280pt.
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4. Select Save. 

When you publish using this PDF layout, Paligo will set the product image container so that it
cannot be larger than your defined maximum height.

TIP
To get a product image to scale to fit in the product image container, use the
Scale product image down to fit in both directions setting (see Set the Product
Image Scaling [904]).

Set the Product Image Positioning
When you publish to PDF, Paligo positions the product image in a container. You can control the
vertical positioning of the container to move it up or down the front page.

To control the vertical positioning of the product image:

1. Select Layout and then either select an existing layout to open it in the Layout Editor or create
a new layout [1059].

2. Select Front Page and then Product image.

3. Set the Product image distance from top of page (inside page margins). You need to enter
the new measurement and the measurement units, for example, 10pt.

4. Select Save. 

When you publish to PDF using this layout, Paligo will position the product image container so that
it is the defined amount below the top margin of the page. This is not the same as the top edge of
the page (see Understanding the Front Cover Margins [916]).

Set the Product Image Scaling
When you publish to PDF, Paligo positions the product image in a container. By default the
product image is not scaled to fit, and so you will only see the parts of the image that fit inside the
container. But you can apply scaling so that Paligo resizes the image to fit into the container.

1. Select Layout and then either select an existing layout to open it in the Layout Editor or create
a new layout [1059].

2. Select Front Page and then Product image.

3. Use the Scale product image down to fit in both directions setting to turn scaling on or off.
Select Yes for on, No for off. The default is No.
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4. Select Save. 

When you publish using this PDF layout, Paligo will apply the scaling you have selected.

Set the Product Image Borders
When you publish to PDF, Paligo positions the product image in a container. You can set the
container to have visible borders, which can be helpful when you are setting up the positioning of
the container (see Set the Product Image Positioning [904] and Set the Product Image Container
Height [903]). When you have the container positioned where you want it, you can come back and
turn off the product image borders. Or you can leave them on if you want them to be visible in
your PDF output.

1. Select Layout and then either select an existing layout to open it in the Layout Editor or create
a new layout [1059].

2. Select Front Page and then Product image.

3. In the Default border for product image field, enter the border settings.
The border settings consist of a line thickness, a line style, and a line color.
You can use these values:

• Line thickness:

• thin

• medium

• thick

• Exact value (also known as "length")
Enter a width measurement including the units of measurement, for example, 3pt.

• Line style:

• none - There is no border.

• hidden - There is a border but it cannot be seen.

• dotted - The border is a dotted line.

• dashed - The border is made up of short lines.

• solid - The border is a single line with no breaks.

• double - The border is two lines with no breaks.

• groove - The border has lines and shading to create a "pressed down" look.

• ridge - The border has lines and shading to create a "raised" look.
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• inset - The border has lines and shading to create a "pressed down" look. It is similar to
the groove style, but uses a different line and shading pattern.

• outset - The border has lines and shading to create a "raised" look. It is similar to the
ridge style, but uses a different line and shading pattern.

• Line color:
Use any of these:

• Color name, such as silver

• RGB value, such as rgb(255,0,0)

• Hex number, such as #ff0000

For example, if you wanted a medium thickness, dashed line border and you wanted it blue,
you would enter:

medium dashed blue

4. If you want the corners of the container box to appear rounded, set the Default border
radius for product image. Enter the amount of rounding and include the measurement units,
for example, 10pt.

Product image with dotted pink border and border-radius of 14pt.

5. Select Save. 

When you publish using this PDF layout, Paligo will apply the border settings you have entered.

If you later want to remove the borders, clear the fields and save. By default, Paligo does not have
visible borders around product images.

Cover Background
If you have set up your publication to use cover components, you can set up each cover to have a:

• Background image
There are different ways of adding a background image. The method you use will affect how
Paligo applies the background image to your cover.
To add a background image, first learn about the different Methods for Adding a Background
Image to a Cover [907]. You can then add a background image to a publication topic, cover
component, or PDF layout depending on your requirements.

• Background color
You can apply a color to the back layer [913], behind the content that appears on the cover.
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NOTE
If you are not using cover components for your publication, you can only set a
background image and color for the front cover recto.

Methods for Adding a Background Image to a Cover
There are three ways to add a background image to a cover. Paligo will use the image differently,
depending on where you add the image.

You can:

• Add a Background Image in a Publication Topic [907]
Paligo uses the background image from the publication topic instead of any background image
that is set in the layout.
This only applies to the front cover recto. You cannot use a background image in the publication
topic for a front cover verso or a back cover.

• Add a Background Image in a Cover Component [909]
Paligo uses the background image from the cover component instead of any background image
that is set in the layout.

• Add a Background Image in a PDF Layout [911]
With this approach, Paligo uses the same background image every time you use a particular
layout. The image is only shown if there is no background image set in the publication topic or
cover component.

Which method should you use? It depends on what you want to achieve and how you want to
manage the different images.

• Do you need to mostly publish PDFs that have the same background image? If yes, you may
find it simpler to add the background image to a PDF layout. If you later need to use a different
image, you can edit the layout or create a new layout.

• Do you have documents that need different background images in different scenarios? If yes,
then consider adding all of the images to a publication topic or cover component. By applying
filters to the images, you can control which image Paligo uses when you publish. For more
details on filtering, see Filtering / Profiling [1141].

NOTE
For helpful advice on creating a background image, see Tips for Creating a
Background Image [912] .

Add a Background Image in a Publication Topic
If you have a background image in your publication topic, Paligo will use it as the background
image for the front cover recto. It takes priority over any background image that is set in a layout
or in a cover component.

NOTE
For front verso, back recto, and back verso covers you need to use a cover
component. You cannot set their background image from a publication topic.
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To use a publication topic to set a background image for a front recto cover:

1. Select the Dotted Menu (...) for the publication in Content Manager [34].

2. Select Edit and choose Open in editor.

Paligo opens the publication topic.

3. Select the Insert tab and choose Image in the Toolbar [52].

4. Choose Image from the menu and then use the media browser to find or upload the
background image.
For details on how to insert an image, see Add an Image to a Topic [310].

5. Click on the image and select the mediaobject element in the Element Structure Menu [52]
and choose Go to element.

6. Add the role attribute in the Element Attributes Panel [55].
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7. Set the value to bg-image.

8. Select Save. 

When you publish this document to PDF, Paligo will use the image you selected as the background
image for the front cover (front recto). It will take priority over any background image that is set in
the layout or in a cover component.

Add a Background Image in a Cover Component
You can set the background image for a cover inside a cover component. This means you can have
a different background image for each of the four cover components (front recto, front verso, back
recto, and back verso).

Paligo uses the background image in a cover component in preference to a background image
set in the PDF layout. But for front covers, the background image in a publication topic will take
priority over both the layout and any image in the front cover recto component.

1. Select the options menu for the cover component.

If you do not have a cover component yet, see Create a Cover Component [862].

2. Select Edit and then Open in editor.

3. Select the Insert menu and then select Image. Choose Image from the menu and then use
the media browser to find or upload the background image.
For details on how to insert an image, see Add an Image to a Topic [310].

4. Click on the image. In the Element Structure Menu, select the mediaobject element and then
Go to element.
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5. Use the Element attributes panel to give the mediaobject element a role attribute. Set the
value of the role attribute to bg-image.
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6. Select Save. 

7. Repeat this process for background images in the other cover components, if required.

When you publish this document to PDF, Paligo will use the background image from the cover
component. If the background image is not shown, see Troubleshooting PDF Covers [917] .

Add a Background Image in a PDF Layout
To use a PDF layout to set the background image for a cover:

1. Prepare a suitable image file.
We recommend that you use an image that is the same size as your intended page size. For
example, if you are going to publish an A4 PDF, use an image that is the same size as A4 (210
x 297mm). Your image is going to cover the entire page, so add white space to the image if
needed.
In our documentation, we use an example cover featuring a white background with a band of
sky partway down the page. The entire image is A4 sized.

2. Select the Layout tab in the top menu.
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Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

3. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

4. Expand the settings for the relevant cover, either Front page or Back page and then select
the settings for the relevant side (front cover recto, front cover verso, back cover recto,
back cover verso).
If you are unsure about which sides of the covers these settings relate to, see Covers: Recto
and Verso [847].

5. Use the Background image setting to upload your image.

NOTE
If the background image is the same size as a page in your PDF output, it will
fill the page. You will not be able to see any background color.

6. Select Save. 

When you publish with this layout, Paligo will apply the background image to the cover. But if the
publication has a background image set in its publication topic or in a cover component, Paligo will
use that image instead.

Tips for Creating a Background Image
We recommend that you use a professional graphics or photography application to create your
background image. When designing your background image, make sure that it is:

• The same size as the page format you are using for your PDF layout. For example, if using the A4
format, create it 210mm x 297mm.

• 300 pixels/inch resolution.

• Designed to have space for the front cover content. For example, here we have used a black
pane at the bottom of the image:
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TIP
We recommend that you make a colored pane to take up approximately 1/3 of
the image.

Set the Background Color of a Cover
You can set the background color of a cover to compliment your brand colors. The background
color is shown behind any other elements on the cover, for example, if you have a back cover with
a content box, the color is shown behind the content box.

For example, the following image shows a back recto cover that has a blue background color.
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1. The background of the context box. Here, the background of the content box is set to white.

2. The background of the page uses the background color, in this case, a shade of blue.

Notice how only the background is blue and the content box is white (the content box has its own
color settings).

To set the background color for a cover page:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Expand the settings for the relevant cover, either Front page or Back page and then select
the settings for the relevant side (front cover recto, front cover verso, back cover recto,
back cover verso).
If you are unsure about which sides of the covers these settings relate to, see Covers: Recto
and Verso [847].

4. Use the Background color setting to choose the color.
To select a color of your own choice, clear the Use default color checkbox and then either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).

5. Select Save. 

When you publish with this layout, Paligo will apply the background color to the cover.
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If the background color is not shown, check that:

• You have added the relevant cover component to the publication topic

• The cover component has the required role attribute (with its value set to one of: front, front
recto, front verso, back, back recto or back verso).

• The cover has space for the background to be seen. For example, you could use a non-
transparent background image that is the same size as the front cover page. If you then set
a background color, the image covers the color so that you cannot see the color.

Set Paligo to Generate a Cover
For PDF outputs, you can choose whether the PDF includes a front cover.

• If you choose to include a cover, Paligo will generate a PDF with covers.
The PDF output will include any cover components [860] you have set up as well as a front cover.
The front cover will contain content from the publication topic (and potentially also a cover
component). There is only a back cover if you have used cover components.

• If you choose to have no front cover, Paligo will generate a PDF that has no front cover and the
table of contents is the first page.
If you have set up cover components for a back cover, Paligo will still include the back cover.

By default, Paligo is set to generate covers for PDF outputs.

To turn the cover feature on or off:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Front Page and then select General.

4. Set Generate front cover page for publications to Yes or No (Default is Yes).
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5. Select Save.

When you publish PDFs using this layout, Paligo will use your choice in step 3 to decide whether to
include a cover.

Understanding the Front Cover Margins
When you are designing a front cover for a PDF output, you can set the position of various
elements, including the title block. Before you make changes to the positioning, it is important that
you understand:

• What margins are in place

• How Paligo applies margins and calculates the spacing.

Knowing how the margins work will make it easier for you to position the title and subtitle more
accurately.

In the PDF output, the front cover has 3 margins, all of which you can control in the PDF layout
settings:
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1. Page margins.
Select General and then select Page Margins. The page margins define the amount of space
between the edge of the page and the content area (body).

2. Body margins.
Select General and then Page Margins. The body margins define the amount of space
between the edge of the content area (body) and where the content can be placed.

3. Content margins.
Select Front page and then Title block. The Title block settings include Title block distance
from top, Title block margin left and Title block margin right. Use these to define an extra
amount of space that Paligo calculates from the position where the content can be placed. You
can set the content margins for the title and subtitle.

Example 46. Setting page and title block margins

Let's say you have a publication that has been published before. For an update to the publication,
you want to change the front cover so that the title is 5cm from the top of the page.

To do that, you edit the PDF layout and look at the General settings and Page Margins. You see
that the page currently has a top margin of 2cm and the body has a top margin of 1cm. So the
content on the front cover already has 3cm of top spacing in place (top margin + top body margin).

To set the title at 5cm from the top, you select Front Page and then Title Block . You enter 2cm in
the Title block distance from top field and then save the layout.

When you publish, the title will be 5cm from the top of the page (2cm page margin top + 1cm body
margin top + 2cm title block distance from top).

To learn how to set the set the positioning for the title and subtitle, see Style the Title for a Front
Cover [890].

Troubleshooting PDF Covers
If you are experiencing problems when setting up covers for your PDF outputs, you may find the
answers in this article. It covers some of the most common mistakes relating to covers.

Covers are Missing
If your PDF has no covers at all, it is likely because Paligo is set to not generate covers.

To fix this, see Set Paligo to Generate a Cover [915].

Content Overlapping on Cover
If you have overlapping content on a cover (typically a front cover), it is likely because the
front cover recto (or verso) contains content from the publication topic and also from a cover
component.

Paligo adds the publication topic content to the main body area of the page. The cover component
content goes into a content box that overlays the body area.

You should redesign the page so that there is sufficient space for both sets of content. For that,
you can use the PDF layout to control the positioning of the info elements from the publication
topic and also reposition the content box.

For details, see:

• Position a Content Box on a Cover [872]

• Set the Size of a Cover Content Box [873]
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• Set an Info Element to be on the Front Side or Reverse Side [883].

Content Missing from Cover
If there is content missing from a cover, it is likely because:

• There is insufficient space to fit the content in a content box
Paligo will push any content that does not fit onto the next page (for info elements in the
publication topic).
If there is too much content to fit inside a content box, either the top part of the content will
be missing or the bottom part will be missing. This varies depending on the type of vertical
alignment that is in place for the content box.
To fix this, either change the size of the content box or reduce the amount of content inside the
relevant cover component.

• The publication topic does not contain the info elements
Info elements, such as copyright and pubdate, will only appear on the cover if you have included
them in the publication.

NOTE
For most of the info elements, if you add the structure but do not enter text,
Paligo will remove the empty structure before publishing.

• The cover components are not set up correctly
Paligo will only show the content for cover components if they are set up correctly (see Cover
Components not Working [918]).

• Other images have priority
Images in the publication topic take priority over the cover content components and PDF layout.
The priorities are:

• Publication topic image. This has top priority for the front cover recto only.

• Cover component image. Paligo uses this in preference to the layout.

• PDF layout image. Paligo uses this if there is no image set in a publication topic or a cover
component.

• The image does not have the appropriate role attribute
If you add an image in a publication topic or cover component and you want Paligo to use it as
the background image, it needs to have a role attribute. The value of the role attribute should
be bg-image.

Cover Components not Working
If you have set up cover components for your publication and they are not showing in your PDF
output, it is likely because they are set up incorrectly.

Make sure that you have:

• Created cover components and given their cover elements a role attribute with a suitable value
(see Create a Cover Component [862] and Set a Cover to be Front, Back, Recto, Verso [865]).

• Added the cover components to the publication topic ( see Add a Cover to a Publication [869]).

• Added content inside the correct cover component.

Headers for PDFs
For PDF outputs, you can use the PDF layout to control the header that appears at the top of the
page. The header consists of a three-column table that appears on every page in your output.
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Use the page header settings in the layout to style the header and add content to the header cells:

• Set the Header Table Height and Column Widths [919]

• Set the Border for the Header Cells [922]

• Set the Font for the Header Table Cells [920]

• Set the Vertical Alignment for the Header Table Cells [921]

• Add Content to the Header Table Cells [923].

Set the Header Table Height and Column Widths
You can use the PDF layout editor to change the height and widths to suit your requirements.

NOTE
The table has to have three columns. If you need more columns, it may be
possible to achieve through a customization project. Contact customer support
for more details.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Header and Footer > Page header.

4. Set the widths of the header columns in the Page header table relative column widths field.
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The total width has to total 10. By default, the three columns are set to 1 8 1, which means
that the left column is 10% of the header width, the center column is 80%, and the right
column is 10%. Change the values to the widths you need. For example, if you set the value to
3 5 2, the left column would be 30% width, the center column 50%, and the right column 20%.

5. Set the minimum height of the header table in the Page header table height field.

The default is 14pt. When you enter a value, make sure to include the units of measurement,
for example, pt.

6. Select Save.

When you publish your content using this PDF layout, Paligo will apply the settings to the header
of the PDF.

Set the Font for the Header Table Cells
Use the PDF layout to choose the font settings for your header cells. You can choose the font
family, set the color, spacing and more.

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select Header and Footer > Page header.

3. Use the following settings to define the font and text spacing settings for the header table
text:

• Page header font family
Choose the typeface for the text in the cells.

• Page header font size
Set the size of the text in the cells.
Include the units of measurement, for example, pt or mm.

• Page header font weight
Set the thickness of the text in the cells.

• Page header font style
Use to set the text in the cells to italic, backslant (leaning backwards), or normal.

• Page header font variant
Set the font to display as normal or as small caps. The small caps option turns lower case
letters into reduced height capital letters.

• Page header font color
Use to set the color of the text in the cells. You can check the box to use the default color
or you can clear the box and choose a different color. Enter an RGB value or select the color
block to display a color selector.

• Page header line height
Set the height of each line of text in the cells. You need to include the units of measurement
too, for example, px, pt, em.

• Page header capitalization
Set the text in the page header cells to be shown in all full-size capital letters, all lowercase
letters, or capitalized (first letter capital, other letters lowercase).
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NOTE
If you have set the Page header font variant to small caps:

• The capitalized option sets upper case letters to be full-size capitals. The
other letters will be shown as reduced height capital letters (small caps).

Example of capitalized and small caps used at the same time.

• The lowercase option has no effect.

• Page header letter-spacing
Define the amount of spacing between the letters of the text in the cells.
Include the units of measurement, for example, pt or mm.

4. Select Save.

When you publish content with this PDF layout, Paligo will use the font settings when it generates
the PDF.

Set the Vertical Alignment for the Header Table Cells
Use the PDF layout control the vertical alignment of the content in the header cells:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Header and Footer > Page header.

4. Set the Page header table vertical alignment to:

• Auto - Sets the content to have the same baseline. This looks similar to vertically aligning
content to the bottom of the cells.

• Before - Vertically align the content to the top.

• Center - Vertically align the content to the middle.

• After - Vertically align the content to the bottom.
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NOTE
If your alignment choices appear to have no effect, try increasing the
height of the header table (see Set the Header Table Height and Column
Widths [919]). At smaller table heights, the difference between the alignments
can be negligible.

5. Select Save.

When you publish your content using this layout, Paligo will apply the alignment settings to the
header.

Set the Border for the Header Cells
Use the Page header table cell border setting to add a visible border to the header. The borders
can be useful when you are setting up your header and you need to see the cell boundaries so
that you can better judge the cell widths.

NOTE
The header will appear on every page, but may appear as a line on the front
cover. This is because the front cover header does not show the header text and
so has a forced block height of 0.

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select Header and Footer > Page header.

3. Set the border styling in the Page header table cell border field.

You can use these values:

• Line thickness:

• thin

• medium

• thick

• Exact value (also known as "length")
Enter a width measurement including the units of measurement, for example, 3pt.

• Line style:

• none - There is no border.

• hidden - There is a border but it cannot be seen.

• dotted - The border is a dotted line.

• dashed - The border is made up of short lines.
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• solid - The border is a single line with no breaks.

• double - The border is two lines with no breaks.

• groove - The border has lines and shading to create a "pressed down" look.

• ridge - The border has lines and shading to create a "raised" look.

• inset - The border has lines and shading to create a "pressed down" look. It is similar to
the groove style, but uses a different line and shading pattern.

• outset - The border has lines and shading to create a "raised" look. It is similar to the
ridge style, but uses a different line and shading pattern.

• Line color:
Use any of these:

• Color name, such as silver

• RGB value, such as rgb(255,0,0)

• Hex number, such as #ff0000
For example, if you wanted a medium thickness, dashed line border and you wanted it blue,
you would enter:

medium dashed blue

4. Select Save.

TIP
When you have finished designing your header, you can turn the table cell border
off by entering none as the value.

Add Content to the Header Table Cells
Use the PDF layout to add content to the header table cells for PDFs.

NOTE
The header table is shown on all pages, but the header on the front cover does
not show text. As a result, the cover header has a fixed height of 0.

To add text, images, or auto-generated content such as page numbers to your header:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Header and Footer > Page header.

4. Use the Page header <column> cell content setting to choose the type of content to add to
that cell. There are separate Page header <column> cell content settings for the left, center
and right cells.
Choose from:

• None - Paligo will not include any content in the cell.

• Text - Set the cell to contain text that you will define in the Page header <column> cell
content: text field.

• Image - Set the cell to contain an image that you will choose in the Page header <column>
cell content: image field.

• Pagenumber - Adds the page number to the cell.

NOTE
The page number is only shown in the PDF output if the General > Page
> Print page numbers setting is set to Yes (or Default). For details, see
Include Page Numbers in PDFs [946].

• Page X - Adds the word "Page" followed by the page number to the cell.

• Page X of Y - Adds current page and total page number to the cell, for example, "Page 6 of
75".

• Title - Adds the first title element in your content to the cell. Depending on what you
publish, this is the title of your publication or a topic.

• Chapter title - Adds the title element of the "chapter" to the cell. The "chapter" is a top-level
topic in your publication.
For example, let's say you have a top-level topic called "Installation" and then lower-level
topics for "Install the battery" and "Install the fan unit". In this scenario, all three topics will
have "Installation" in the cell, as they are all part of the same "chapter". Topics in a different
"chapter" will have a different title in the cell.

• Section title - Adds the title element of the topic to the cell. For example, if you have an
"Install the battery" topic, it will have "Install the battery" in the cell, but other topics will
have their title in the cell instead.

5. This step only applies if you selected Text as the Page header <column> cell content.
In the Page header <column> cell content: Text field, enter:

• Plain text

• A dynamic variable to reference an element in your documentation. A popular use for a
dynamic variable here is to reference an element that appears in the publication topic, such
as copyright details. We have included an example after this procedure. To find out more,
see Dynamic Text Variables [1203].
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• A combination of plain text and dynamic variables

NOTE
There are separate Page header <column> cell content: Text settings for
the left, center, and right cells.

6. This step only applies if you selected Image as the Page header <column> cell content.
In the Page header <column> cell content: Image field, use the browse feature to select the
image you want to use. You can choose an image from the media library or you can upload a
new image.

NOTE
There are separate Page header <column> cell content: Image settings for
the left, center, and right cells.

7. Repeat steps 3 to 5 inclusive for each of the cells.

8. Select Save.

When you publish content with this PDF layout, Paligo will add the images and text you have
selected.

Example 47. Dynamic variable to insert organization name in PDF header

Let's say you have set up your publication topic to include author and orgname elements (see Edit
a Publication Topic [121]). You are going to publish to PDF and you want the left cell of your header
to contain the organization name.

You edit your PDF layout and set:

• Page header left cell content to Text

• In the Page header left cell content: text field, you enter a dynamic variable to reference the
author>orgname element. The syntax is:

${//d:article/d:info/d:author/d:orgname}$

Notice how the dynamic variable has to reference each element in the path from the top
of the publication topic to the element you want to use. So it starts with the top-level
d:article, which represents the publication topic, then the next level down is d:info for
the info element, followed by d:author for the author element, and finally d:orgname for
the orgname element.
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When you publish, Paligo:

1. Looks in the publication topic and finds the text that is inside the orgname element. It copies
that text.

2. Inserts the copy of the text into the left cell of the header table.

Header Rule for PDFs
By default, Paligo PDF outputs have a header rule at the top of each page. To style the rule, or
remove it completely, use the Page settings in the PDF layout.

To set up the header rule:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select General and choose Page.

4. Use the Header rule setting to control whether the header rule is shown.
Choose either:

• Yes

• No

5. Set the Header rule length. This is the amount of page width that the header rule will cover
and it has to be a numerical value with units of measurement. By default, it is set to 100%.

6. Use the Header rule alignment setting to control the position of the header rule. Choose
from:

• Start
The start of the line is aligned to the start of the content on the page. For example, on a
left-to-right page, the line is left-aligned.
For example, the following image shows a line that is set to 50% width and aligned to the
start of the page.
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• End
The start of the line is aligned to the end of the content on the page. For example, on a
left-to-right page, the line is right-aligned.
For example, the following image shows a line that is set to 50% width and aligned to the
end of the page.

• Center
The line is aligned in the center of the page. This is only noticeable if the header rule length
is less than 100%.
For example, the following image shows a line that is set to 50% and aligned to the center of
the page.

• Justify
If you use a line with spaces in it, such as a dashed line or dotted line, Justify sets both
ends of the line to be solid. Paligo adjusts the spacing of the gaps in the line to compensate
(spaces in the line cannot be at the start or end of the line).

• Inside
The line is aligned to the inside edge of the page (the binding edge).

• Outside
The line is aligned to the outside edge of the page.

7. Set the Header rule thickness. Enter the amount and the units of measurement (points), for
example, 0.25pt. The higher the amount, the thicker the header rule will be.

8. Choose the Header rule style. You can choose from any of the available line styles including
dotted, solid, and dashed.
For example, the following image shows a dashed header rule.

9. Set the Header rule color. By default it is set to dark gray (#555) but you can change it if you
wish.
To change the color:

a. Clear the Use default color checkbox.

b. Set the color.
Either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).
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10. Select Save.

When you publish with this PDF layout, Paligo will create a PDF that uses the header rule settings
that you have defined.

Footers for PDFs
For PDF outputs, you can use the PDF layout to control the footer that appears at the bottom of
the page. The footer consists of a three-column table that appears on every page in your output.

Use the page footer settings in the layout to style the footer and add content to the footer cells:

• Set the Footer Table Height and Column Widths [928]

• Set the Font for the Footer Table Cells [929]

• Set the Vertical Alignment for the Footer Table [930]

• Add Content to the Footer Table Cells [933].

Set the Footer Table Height and Column Widths
You can use the PDF layout editor to change the footer table height and widths to suit your
requirements.
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NOTE
The table has to have three columns. If you need more columns, it may be
possible to achieve through a customization project. Contact customer support
for more details.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Header and Footer > Page footer.

4. Set the widths of the footer columns in the Page footer table relative column widths field.

There are three values, each representing a column. The default value is 1 1 1 which produces
three columns of equal width. You can change any of the three values to allocate the available
space differently, for example, 1 3 1 produces a footer where the center column has three
times the width of the left and right columns (this is equivalent to 20% 60% and 20%).

5. Set the minimum height of the footer table in the Page footer table height field.

The default is 14pt. When you enter a value, make sure to include the units of measurement,
for example, pt.

6. Select Save.

When you publish your content using this PDF layout, Paligo will apply the settings to the footer of
the PDF.

Set the Font for the Footer Table Cells
Use the PDF layout to choose the font settings for your footer cells. You can choose the font
family, set the color, spacing and more.
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1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select Header and Footer > Page footer.

3. Use the following settings to define the font and text spacing settings for the footer table text:

• Page footer font family
Choose the typeface for the text in the cells.

• Page footer font size
Set the size of the text in the cells.

• Page footer font weight
Set the thickness of the text in the cells.

• Page footer font style
Use to set the text in the cells to italic, backslant (leaning backwards), or normal.

• Page footer font variant
Set the font to display as normal or as small caps. The small caps option turns lower case
letters into reduced height capital letters.

• Page footer font color
Use to set the color of the text in the cells. You can check the box to use the default color
or you can clear the box and choose a different color. Enter an RGB value or select the color
block to display a color selector.

• Page footer line height
Set the height of each line of text in the cells. You need to include the units of measurement
too, for example, px, pt, em.

• Page footer capitalization
Set the text in the page header cells to be shown in all full-size capital letters, all lowercase
letters, or capitalized (first letter capital, other letters lowercase).

NOTE
If you have set the Page footer font variant to small caps:

• The capitalized option sets upper case letters to be full-size capitals. The
other letters will be shown as reduced height capital letters (small caps).

Example of capitalized and small caps used at the same time.

• The lowercase option has no effect.

• Page footer letter-spacing
Define the amount of spacing between the letters of the text in the cells.

4. Select Save.

When you publish content with this PDF layout, Paligo will use the font settings when it generates
the PDF.

Set the Vertical Alignment for the Footer Table
Use the PDF layout to control the vertical alignment of the content in the footer cells:
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1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Header and Footer > Page footer.

4. Set the Page footer table vertical alignment to:

• Auto - Sets the content to have the same baseline. This looks similar to vertically aligning
content to the bottom of the cells.
Sets the content to have the same baseline. This looks similar to vertically aligning content
to the bottom of the cells.

• Before - Vertically align the content to the top.
Vertically align the content to the top.

• Center - Vertically align the content to the middle.
Vertically align the content to the middle.

• After - Vertically align the content to the bottom.
Vertically align the content to the bottom.

NOTE
If your alignment choices appear to have no effect, try increasing the height
of the footer table (see Set the Footer Table Height and Column Widths [928]).
At smaller table heights, the difference between the alignments can be
negligible.

5. Select Save.

When you publish your content using this layout, Paligo will apply the alignment settings to the
footer.

Set the Border for the Footer Cells
Use the Page footer table cell border setting to add a visible border to the footer. The borders
can be useful when you are setting up your footer and you need to see the cell boundaries so that
you can better judge the cell widths.
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NOTE
The footer is on every page, but may appear as a line on the front cover. This is
because the front cover footer does not show the footer text and so has a forced
block height of 0.

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select Header and Footer > Page footer.

3. Set the border styling in the Page footer table cell border field.

You can use these values:

• Line thickness:

• thin

• medium

• thick

• Exact value (also known as "length")
Enter a width measurement including the units of measurement, for example, 3pt.

• Line style:

• none - There is no border.

• hidden - There is a border but it cannot be seen.

• dotted - The border is a dotted line.

• dashed - The border is made up of short lines.

• solid - The border is a single line with no breaks.

• double - The border is two lines with no breaks.

• groove - The border has lines and shading to create a "pressed down" look.

• ridge - The border has lines and shading to create a "raised" look.

• inset - The border has lines and shading to create a "pressed down" look. It is similar to
the groove style, but uses a different line and shading pattern.

• outset - The border has lines and shading to create a "raised" look. It is similar to the
ridge style, but uses a different line and shading pattern.

• Line color:
Use any of these:

• Color name, such as silver

• RGB value, such as rgb(255,0,0)

• Hex number, such as #ff0000
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For example, if you wanted a medium thickness, dashed line border and you wanted it blue,
you would enter:

medium dashed blue

4. Select Save.

TIP
When you have finished designing your footer, you can turn the table cell border
off by entering none as the value.

Add Content to the Footer Table Cells
Use the PDF layout to add content to the footer table cells for PDFs.

NOTE
The footer table is shown on all pages, except the front cover. Technically, the
footer is on the front cover, but it is set to have a fixed height of 0 so any text in
the footer will not be visible.

To add text, images, or auto-generated content such as page numbers to your footer:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select Header and Footer > Page footer.

3. Use the Page footer <column> cell content setting to choose the type of content to add to
that cell. There are separate Page footer <column> cell content settings for the left, center,
and right cells.
Choose from:

• None - Paligo will not include any content in the cell.
Paligo will not include any content in the cell.

• Text - Set the cell to contain text that you will define in the Page header <column> cell
content: text field.
Set the cell to contain text that you will define in the Page footer <column> cell content:
text field.

• Image - Set the cell to contain an image that you will choose in the Page header <column>
cell content: image field.
Set the cell to contain an image that you will choose in the Page footer <column> cell
content: image field.

• Pagenumber - Adds the page number to the cell.
Adds the page number to the cell.
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NOTE
The page number is only shown in the PDF output if the General > Page
> Print page numbers setting is set to Yes (or Default). For details, see
Include Page Numbers in PDFs [946].

• Page X - Adds the word "Page" followed by the page number to the cell.
Adds the word "Page" followed by the page number to the cell.

• Page X of Y - Adds current page and total page number to the cell, for example, "Page 6 of
75".
Adds current page and total page number to the cell, for example, "Page 6 of 75".

• Title - Adds the first title element in your content to the cell. Depending on what you
publish, this is the title of your publication or a topic.
Adds the first title element in your content to the cell. Depending on what you publish, this
is the title of your publication or a topic.

• Chapter title - Adds the title element of the "chapter" to the cell. The "chapter" is a top-level
topic in your publication.
Adds the title element of the "chapter" to the cell. The "chapter" is a top-level topic in your
publication.
For example, let's say you have a top-level topic called "Installation" and then lower-level
topics for "Install the battery" and "Install the fan unit". In this scenario, all three topics will
have "Installation" in the cell, as they are all part of the same "chapter". Topics in a different
"chapter" will have a different title in the cell.

• Section title - Adds the title element of the topic to the cell. For example, if you have an
"Install the battery" topic, it will have "Install the battery" in the cell, but other topics will
have their title in the cell instead.
Adds the title element of the topic to the cell. For example, if you have an "Install the
battery" topic, it will have "Install the battery" in the cell, but other topics will have their title
in the cell instead.

4. This step only applies if you selected Text as the Page footer <column> cell content.
In the Page footer <column> cell content: Text field, enter:

• Plain text

• A dynamic variable to reference an element in your documentation. A popular use for a
dynamic variable here is to reference an element that appears in the publication topic, such
as copyright details. We have included an example after this procedure. To find out more,
see Dynamic Text Variables [1203].
A popular use for a dynamic variable here is to reference an element that appears in
the publication topic, such as copyright details. We have included an example after this
procedure.
To find out more, see Dynamic Text Variables [1203].

• A combination of plain text and dynamic variables

NOTE
There are separate Page footer <column> cell content: Text settings for the
left, center, and right cells.

5. This step only applies if you selected Image as the Page footer <column> cell content.
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In the Page footer <column> cell content: Image field, use the browse feature to select the
image you want to use. You can choose an image from the media library or you can upload a
new image.

NOTE
There are separate Page footer <column> cell content: Image settings for
the left, center, and right cells.

6. Repeat steps 3 to 5 inclusive for each of the cells.

7. Select Save.

When you publish content with this PDF layout, Paligo will add the images and text you have
selected.

Example 48. Dynamic variable to insert copyright information in PDF footer

Let's say you have set up your publication topic to include copyright elements, including year
and holder elements (see Edit a Publication Topic [121]). You are going to publish to PDF and you
want the center cell of your footer to contain the copyright details.

You edit your PDF layout and set:

• Page footer center cell content to Text

• In the Page footer center cell content: text field, you enter a dynamic variable to reference the
copyright>year and holder elements. The syntax is:

Copyright © ${//d:article/d:info/d:copyright/d:year}$ ${//d:article/
d:info/d:copyright/d:holder}$

Notice how it includes the word Copyright and the copyright symbol as plain text. It then
has two references: one to the year element and one to the holder element. It starts with
the article element (which is in the publication topic), and then each level of the structure
(info>copyright>year and info>copyright>holder).
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When you publish, Paligo:

• Adds the text copyright and the copyright symbol to the center cell of the footer

• Finds copyright > year in the publication topic and inserts the year value into the center cell,
after the text

• Finds copyright > holder in the publication topic and inserts the holder value into the center
cell, after the year.

Footer Rule for PDFs
By default, Paligo PDF outputs have a footer rule at the bottom of each page. To style the rule, or
remove it completely, use the Page settings in the PDF layout.

To set up the footer rule:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.
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2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select General and choose Page.

4. Use the Footer rule setting to control whether the footer rule is shown.
Choose either:

• Yes

• No

5. Set the Footer rule width. This is the amount of page width that the footer rule will cover and
it has to be a numerical value with units of measurement. By default, it is set to 100%.

6. Choose the Footer rule style. You can choose from any of the available line styles including
dotted, solid, and dashed.
For example, the following image shows a dashed footer rule.

7. Set the Footer rule color. By default it is set to dark gray (#555) but you can change it if you
wish.
To change the color:

a. Clear the Use default color checkbox.

b. Set the color.
Either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).

8. Select Save.

When you publish with this PDF layout, Paligo will create a PDF that uses the footer rule settings
that you have defined.

Style Section Titles and Subtitles (PDF)
It is possible to style the Section titles and Section subtitles for PDF output via the Layout tab.
You can edit the PDF layout to define font weight, font style, color, usage of capitalization and
numbering.
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If you use general settings for all sections, like font and section numbering, these can be
overridden by settings made for each section level, for example font size or color.

NOTE
These instructions show how to style the section titles. It works the same way for
section subtitles, except that you choose the Section subtitles category instead
of Section titles.

Define Section Title Alignment (PDF)
Use the Layout editor to set the alignment for Section Title elements in your PDF output.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Section titles and choose title level to be styled from the left menu.
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4. Scroll down to Alignment for the section level to be adjusted.

5. Choose an alignment option from the menu.

Choose from:

• Start - Left-align the text (in left-to-right languages).

• End - Right-align the text (in left-to-right languages).

• Center - Align the text centrally.

• Justify - Add space between the words so that the text is spaced out to fit the full width of
the content area. The first word and last word of the text will be at the margin boundaries of
the content area.

• Inside - Align the text to the "spine". The spine is where the pages would be bound if
the document was printed out as a book. If the text is on a left page ("verso"), the text is
right-aligned and if it is on a right page ("recto") it is left-aligned.

• Outside - Align the text to the outer edge of the page. This is the opposite edge to the
"spine" (see Inside). If the text is on a left page ("verso"), the text is left-aligned and if it is on
a right page ("recto") it is right-aligned.

6. Select Save.

Define Section Title Font Color (PDF)
The font color for the Section titles can be defined in the Layout editor.
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1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Section titles and choose title level to be styled from the left menu.

4. Scroll down to Set color for the title level to be updated.

5. Clear the checkbox Use default color to be able to define a new color.

6. Enter a color code.
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7. Select Save.

Page Breaks

NOTE
This section only applies to techniques used for publishing PDF/print output.
Page breaks do not apply to other outputs such as HTML or HTML5.

Paligo handles page breaks automatically during the publishing process. It uses a set of default
rules for page breaks, which make sure that certain elements are kept together. For example,
titles are always kept on the same page as the next element, which is usually the first paragraph
in a topic. 

But there may be times where you want page breaks to be handled differently, and so you will
need to use soft page breaks or hard page breaks.

• A soft page break is a break that is only used when the content is too large to fit on a single
page. During the publication process, Paligo will automatically determine whether the soft page
breaks are needed and will use them appropriately.

• A hard page break is a fixed break that is always applied, even if there is enough space on the
page for the content.

TIP
We recommend that you use soft page breaks instead of hard page breaks. This
is because soft page breaks tend to work better if content is reused or translated,
as they are only applied if content flows over a page. Hard page breaks are always
in place, so may not be in the correct place if a topic is translated into another
language or reused in another publication.

Soft Page Breaks
If you need to take manual control of your page breaks, we recommend that you use "soft" page
breaks. These allow you to define how content will flow from one page to the next.

You can add soft page breaks by setting attributes on the element that flows over a page. There
are two attributes that you can use:

• xinfo:keep-together [941]

• xinfo:keep-with-next [943]

xinfo:keep-together
You can use the xinfo:keep-together attribute to control whether an element can split across
two pages.

Example 49. Numbered list flowing over a page

Let's say you have a numbered list (orderedlist) on page 4 and it flows on to page 5.
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If you set the xinfo:keep-together attribute to yes for the orderedlist element, the list will
start on page 5 (if it is too long to fit on page 5, it will flow to page 6).

If you set the xinfo:keep-together attribute to no, the list will start on page 4 and flow to page
5.

xinfo:keep-together set to no for the orderedlist element xinfo:keep-together set to yes for the orderedlist element

If the list is too large to fit on a single page, it will flow across as many pages as needed. But
its starting position depends on whether the orderedlist element's xinfo:keep-together
attribute is set to yes or no.

NOTE
You can apply the xinfo:keep-together to the upper elements in a list, such as
the itemizedlist element or the orderedlist element. This applies the keep-
together to the list as a whole.

To change the value of the xinfo:keep-together element:

1. Select the element that you want to control.

2. Use the Element attributes to choose xinfo:keep-together and set it to yes or no.
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• Set the xinfo:keep-together attribute to yes if you want Paligo to start the element on a
new page (if the element does not fit on the current page).

• Set the xinfo:keep-together attribute to no to allow the element to break across pages.
This is the default setting.

xinfo:keep-with-next
To control whether an element stays with the next element, use the xinfo:keep-with-next
attribute.

For example,  let's say you have an image followed by another image (the images are
mediaobject elements). In the published PDF, the first image is on page 4 and the second image
is on page 5, but you want both images to display on the same page. To do this, you set the
xinfo:keep-with-next attribute for the first mediaobject element to yes. This tells Paligo to
keep the first mediaobject element with the element that follows it.

xinfo:keep-with-next attribute set to no. xinfo:keep-with-next attribute set to yes.

NOTE
If you use the xinfo:keep-with-next attribute on a paragraph element, Paligo
will keep the last two lines of the paragraph on the same page as the next
element. (This is because the default setting for orphans is 2 lines).

To change the value of the xinfo:keep-with-next element:

1. Select the element that you want to control.

NOTE
If content consists of several nested elements, you should select
the outermost element. For example, an image has mediaobject >
imageobject > imagedata and you should apply the attribute setting to the
mediaobject element.

2. Use the Element attributes to choose xinfo:keep-with-next and set it to yes or no.
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• Set the xinfo:keep-with-next attribute to yes if you want to display the element on the
same page as the next element.

• Set the xinfo:keep-with-next attribute to no if you want Paligo to display the element in
a normal flow, with no association with the next element. This is the default setting.

Hard Page Breaks
A "hard" page break is a break that always occurs at that point in the content, even if there is
enough space to allow the next elements to fit on the page.

NOTE
Hard breaks are only suitable for section elements. You can use them on the
root section element of a topic or on any internal section element in a topic. 

Usually, you should avoid using "hard" page breaks and rely on Paligo's automatic page breaking
or use "soft" page breaks instead. With soft page breaks, the break occurs in relation to the
content and so is more likely to be suitable for translated versions and where a topic is reused. 

Example 50. Hard page break in a reused topic

Imagine you have many products and you have created a publication for each product. There is
some information that is common to all products, so you create a topic for the information and
reuse it in all publications.

In one publication, you add a hard page break in the topic and it looks fine. But in one of the other
publications, the same page break is in an awkward place, resulting in a lot of white space on a
page. With a soft page break, this can be avoided, as the break occurs in relation to the content,
not at a fixed position.

However, there are situations where you might prefer to use a hard page break. For instance, you
might have a topic that should always start on a new page, no matter where it is used.

To set a hard page break:

1. Select the section element that appears immediately after the hard page break.

2. Use the Element attributes to select the xinfo:pagebreak attribute.
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3. Set the value of the attribute to before. This will add a hard page break before the element
you selected in step 1. There are other options for the attribute, but "before" is the most
commonly used.

NOTE
The @xinfo:pagebreak attribute exists on other elements, but only to allow
potential customization. We do not recommend this, as it is best practice to use
"soft" page break techniques.

Numbering for PDFs
The PDF layout has settings for controlling various types of numbering in your PDF outputs
including:

• Page numbers
You can set Paligo to show or hide page numbers that are added to the header table or footer
table.
To learn how to show/hide the page numbers, see Include Page Numbers in PDFs [946].
To learn how to add a page number to the header or footer, see:

• Add Content to the Header Table Cells [923]

• Add Content to the Footer Table Cells [933].
To set page numbering to start after the table of contents, see Start Page Numbers after the
TOC [946].

• Section numbers (heading numbers)
To learn how to set up numbered headings, see Manage Section Numbering in PDF [947].

• Title numbers, such as numbering for figure titles and table titles.
To learn how to set up numbered titles, see Title Numbering and Auto-Labels in PDF [948].
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Include Page Numbers in PDFs
To include page numbers in your PDF outputs:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select General and choose Page.

4. Set Print page numbers to:

• Yes
To include page numbers in your headers or footers in your PDFs

• No
To exclude page numbers from the headers or footers in your PDFs

5. Select Save.

6. If you want to include a page number, set a cell in the footer or header to show the page
number. For details, see:

• Add Content to the Footer Table Cells [933]

• Add Content to the Header Table Cells [923]

When you publish content with this layout, the resulting PDF will include page numbers if:

• Print page numbers is set to Yes (default is Yes)

and

• You have set the left, center, or right cells in the header or footer to show the page number.

If Print page numbers is set to No, the page number is not shown in the header or footer.
Similarly, if Print page numbers is set to Yes, but the header and footer tables do not include a
page number, then no page number is shown.

Start Page Numbers after the TOC
By default, Paligo starts the page numbering on the first page of the TOC (table of contents). The
page numbers then continue throughout the rest of the document. If you prefer, you can set
Paligo to start the page numbering after the TOC, so that only the content pages are numbered.

To set page numbering to start after the TOC:

1. Select the Layout tab in the top menu.
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Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select General and choose Page.

4. Use the Start page numbering after the TOC setting to control where the page numbering
begins.

Choose either:

• Yes
Paligo will begin the page numbers after the last page of the table of contents.

• No
Paligo will begin the page numbers on the first page of the table of contents. No is the
default setting.

5. Select Save.

Manage Section Numbering in PDF
You can choose to have numbered headings, such as "1.2 Power up the device" in your PDF
output. Typically, you apply numbering to all sections (by enabling Section Titles > All Sections >
Section Numbering in the Layout Editor) or to not use numbered headings at all.

But there may be times when you need a mix of numbered headings and headings without
numbering and for that, you can use the element attribute label.

When you publish topics that use this element attribute, Paligo will not apply numbering to its
heading, even if the publication is set to use numbered headings. The heading will appear as
text-only, both in the topic itself and in the table of contents.

To prevent a topic from being auto-numbered:

1. Select the Dotted menu (...) for the topic in the Content Manager [34].

2. Select Edit and choose Open in editor. 

3. Select the section element in the Element Structure Menu [52].
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4. Choose Go to element.

5. Add the element attribute label in the Element Attributes Panel [55].

The 0 value instructs Paligo to avoid using numbering for this section.

6. Set the value to 0.

7. Select Save. 

NOTE
To enable numbering again, remove the label attribute.

Title Numbering and Auto-Labels in PDF
Some elements, such as tables and examples, can have titles. By default, these titles consist of an
auto-generated label, a number, and a number delimiter, for example, "Table 1. Specifications".
Depending on your requirements, you can set Paligo to include or exclude the title numbers and
labels.

To turn on/off the numbering and auto-labels for PDF outputs, use the settings in the PDF layout
editor:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select Formal Elements > General.

3. Set Use auto-label for formal elements to:

• Enabled to include the title numbering and auto-labels for tables, examples, and other
elements with titles.

• Disabled to exclude the title numbering and auto-labels for titles.,
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4. Select Save.

When you publish with this PDF layout, the title elements will include or exclude the auto-label and
numbering, depending on your selection in the layout.

Admonition Styles for PDF
Use the PDF layout's admonition settings (General, Graphical, and Nongraphical) to change the
appearance of notes, warnings, cautions, and other admonitions.

Which Admonition Parts Can You Style?

Abstract
What parts of an admonition can you customize for your PDF outputs? Find out in this article.

The PDF layout has Admonitions settings for styling the notes, cautions, and other admonitions in
your PDF outputs. Use the settings to style the various parts of an admonition:

1. The spacing around the admonition [951]

2. The icon for graphical admonitions [954]

3. The title [956]

4. The body text [958]

5. The admonition box [960] (the container that the icon, title, and text are inside).

The Admonitions settings are divided into three categories:

• General
The General settings apply to all admonitions in your PDF output and they take priority over the
Graphical and Nongraphical settings.

• Graphical
The Graphical settings only apply to admonitions if the layout is set to use graphical
admonitions (which it is by default).
Graphical admonitions have a box that, by default, contains two columns. The left-side column
is narrower and contains an icon that represents the type of admonition. The right-side column
contains the title and body text.

• Nongraphical
The Nongraphical settings only apply to admonitions when you have set the layout to use
non-graphical admonitions.
Non-graphical admonitions have a single column with a title, body text and no icon.

You will need to use the settings in the General category and one of the other categories,
depending on whether you want graphical or non-graphical admonitions.
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Set Admonitions to Graphical or Non-Graphical

Abstract
Find out how to set admonitions to be graphical or nongraphical. Graphical admontions have an
icon and box, but nongraphical ones are text only.

There are two styles of admonition in Paligo: graphical (with an icon) and non-graphical (no icon).
For PDF, you can use the PDF layout to control which type of admonition your publication will use.

Example of warning admonition with icon

Example of warning admonition without icon

To set the layout to use graphical or non-graphical admonitions:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Admonitions.

4. Select General.

5. Set Use graphics in admonitions to choose the type of admonitions:

• Enabled
Paligo will publish your content with admonitions that have an icon. For styling, Paligo will
use a combination of the admonition General and admonition Graphical settings. It will
ignore the Nongraphical settings.

• Disabled
Paligo will publish your content with admonitions that have no icon, only the text.
For styling, Paligo will use a combination of the admonition General and admonition
Nongraphical settings. It will ignore the Graphical settings.

• Default

To inherit the value for this setting from the base layout. The base layout is either a built-in
layout provided with Paligo or is another custom layout.
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To find out more, see Layout Relationships - Base, New, Duplicate [1055].

6. Select Save.

To learn about using the other PDF layout settings to style admonitions, see Admonition Styles for
PDF [949].

Set the Admonition Spacing for PDF

Abstract
Learn how to control the spacing for admonitions in PDF outputs. Set the margins and the padding
to control the space inside an admonition.

To control the spacing around admonitions in PDF outputs, use the margin settings in the PDF
layout. The layout also has padding settings for controlling the spacing inside the admonition.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Admonitions.

4. Select General.

5. Use these settings to define the side margins for the text inside your admonitions:

• Margin-left for admonitions body
Use to set a left-side indent for the body text of admonitions.

• Margin-right for admonitions body
Use to set a right-side indent for the body text of admonitions.
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For both settings, enter a value and include the units of measurement, for example, 16pt.
Paligo applies the indent from the default position of the body text.

6. Use these settings to define the side margins for the titles in your admonitions:

• Margin-left for admonition title
Use to set a left-side indent for the title of admonitions.

• Margin-right for admonition title
Use to set a right-side indent for the title of admonitions.

NOTE
If you have short titles for your admonitions, you may not be able to see
the effect of the margin. This is because the title text will not extend across
the admonition box far enough to reach the margin.

For both settings, enter a value and include the units of measurement, for example, 16pt.
Paligo applies the indent from the default position of the title.

7. Select Graphical.

8. Use these settings to define the amount of space above and below graphical admonitions:

• Space-before (optimum) for graphical admonitions
Use to set a preferred amount of space above graphical admonitions.

• Space-after (optimum) for graphical admonitions
Use to set a preferred amount of space below graphical admonitions.

• Space-before (optimum) for graphical admonitions in list items and steps
Use to set a preferred amount of space above graphical admonitions that appear in a list or
procedure.

• Space-after (optimum) for graphical admonitions in list items and steps
Use to set a preferred amount of space below graphical admonitions that appear in a list or
procedure.
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For all of these settings, enter a scaling value. Paligo uses the value in relation to the size of
body text in your PDF. For example, if you enter 2.5, Paligo will add spacing that is 2.5 times
bigger than the body text size. If you enter 0.5, Paligo will add spacing that is half the size of
the body text.
Paligo will try to apply the preferred amount of space, but in some cases may need to use less.
For example, a page break might result in Paligo applying different spacing.

9. Use the following settings to define the amount of space inside the graphical admonitions.
This is the "padding".

• Padding-top for graphical admonitions
Enter the amount of space between the top of the admonition box and the top of the title
(or body text if there is no title). Enter a value and the units of measurement, for example,
2em.

• Padding-bottom for graphical admonitions
Enter the amount of space between the bottom of the admonition box and the bottom of
the body text. Enter a value and its units of measurement, for example, 2em.

10. Use these settings to set margins for graphical admonitions. The margins apply to the whole
admonition, not just the content inside it.

• Margin-left for graphical admonitions
Sets the left-side indent for all graphical admonitions.

• Margin-right for graphical admonitions
Sets the right-side indent for all graphical admonitions.

For both settings, enter a value and the units of measurement, for example, 2cm. When
setting a margin, consider the amount of space available on the page of your PDF.

11. Use the Margin-left for graphical admonition icon setting to control the position of the
admonition icons. Enter a value and the units of measurement, for example, 1.5em. Paligo
applies the margin from the default position of an icon.
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NOTE
The icon can overlap the text and title. If you change the icon margin, you
may also need to change the title and body text margins.

12. Select Nongraphical.

13. Use the spacing settings to adjust the positioning of the title and body text of your
nongraphical admonitions. The settings work in the same way as the similarly named settings
in the Graphical category, except that they apply to the nongraphical admonitions instead.

• Space-before (optimal) for nongraphical admonitions
Use to set a preferred amount of space above non-graphical admonitions.

• Space-after (optimal) for nongraphical admonitions
Use to set a preferred amount of space below non-graphical admonitions.

• Padding-top for nongraphical admonitions
Use to set the amount of space above the title of nongraphical admonitions. This space
applies to the body text if there is no title.

• Padding-bottom for nongraphical admonitions
Use to set the amount of space below the body text of nongraphical admonitions.

• Margin-left for nongraphical admonition
Use to set the left-side indent of nongraphical admonitions. This applies to the whole
admonition.

• Margin-right for nongraphical admonition
Use to set the right-side indent of nongraphical admonition. This applies to the whole
admonition.

14. Select Save.

To learn about using the other PDF layout settings to style admonitions, see Admonition Styles for
PDF [949].

Style the Admonition Icons for PDF

Abstract
Discover how to style the icons in graphical admonitions. Change the icon for each type of
admonition and set its width.

Graphical admonitions have an icon that is shown on one side of the admonitions box.
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To style the icon for PDF outputs, use the settings on the PDF layout.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Admonitions.

4. Select Graphical.

5. Use Admonition icon width to set the size of the admonition icons.
Enter a value and the units of measurement, for example, 24pt. Paligo will set the width of the
icon image container and will scale the image to fit. When it scales the image, Paligo keeps the
aspect ratio so that the image is not stretched in height or width.

6. Use the following settings to upload an icon graphic for each type of admonition. We
recommend that you use graphics that are square and the same size (or close to) that you
want them to be in your output.

• Icon for 'Note'

• Icon for 'Notice'

• Icon for 'Warning'

• Icon for 'Danger'

• Icon for 'Caution'

• Icon for 'Important'

• Icon for 'Tip'
For each setting, select the Upload button to display an image upload dialog. Drag the image
file on to the dialog.

<step>
Select Save.
</step>

NOTE
To learn how to indent an admonition icon, see Set the Admonition Spacing for
PDF [951].
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To learn about using the other PDF layout settings to style admonitions, see Admonition Styles for
PDF [949].

Style the Admonition Titles for PDF

Abstract
Learn how to style the titles in admonitions for PDF outputs. Include or exclude a title, set its font,
style, and color.

Admonitions can have a title (also referred to as a label) that is shown at the top of the
admonition, above the body text. For example, the following image shows a tip admonition and it
has "TIP" as its title.

NOTE
If you use an admonition that does not include a title inside it, Paligo will add
an auto-generated title when you publish. The auto-gerated title has text that
describes the type of admonition, either: NOTE, NOTICE, DANGER, WARNING,
CAUTION, IMPORTANT, or TIP. Paligo translates these title terms into most other
languages automatically.

If you use an admonition with a title element inside it, the editor shows its title
element and you can enter your own title text. Paligo will use this title and will not
auto-generate a title. You will need to get this translated if you publish into other
languages.

You can use the PDF layout to control whether your admonitions have a title and also to style the
title text:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.
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3. Select Admonitions.

4. Select General.

5. Set Use text label in admonitions to:

• Enabled to include an auto-generated title.
If you use an admonition that does not contain a title element, Paligo will automatically
add a title element when you publish. The auto-generated title has the text: NOTE,
NOTICE, DANGER, WARNING, CAUTION, IMPORTANT, or TIP. These are automatically
translated into other languages.
If you add your own title element to an admonition, you can enter its text in the editor.
Paligo will use your title element and will not auto-generate a title.

• Disabled to prevent Paligo from creating auto-titles.
When you publish, Paligo will only include the titles that have been added into the
admontions in the editor. It will not auto-generate any admonition titles.

6. Use the following settings to style the title text for admonitions:

• Default font family for admonition title
Choose the typeface that Paligo will use for the title of admonitions by default.

• Default font size for admonition title
Set the default size for the admonition title (if the admonition has a title element). Enter a
value and the units of measurement, for example, 12pt.

• Capitalization for admonition title
Choose from:

• None
Paligo does not change the case of the title characters.

• Capitalize
The first letter in each word is uppercase, the other letters are lower case.

• Upper case
All letters are capital letters. for example, ABC. Upper case is the default for this setting.

• Lower case
All letters are lower case, for example, abc.

7. Use the following settings to set the color for your admonition text. The color applies to the
title and the body text.

• Font color for 'Note'

• Font color for 'Notice'

• Font color for 'Warning'

• Font color for 'Danger'

• Font color for 'Caution'

• Font color for 'Tip'

• Font color for 'Important'
To choose your own color, clear the Use default color checkbox and then either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).
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<step>
Select Save.
</step>

NOTE
To learn how to indent an admonition title, see Set the Admonition Spacing for
PDF [951].

To learn about using the other PDF layout settings to style admonitions, see Admonition Styles for
PDF [949].

Style the Admonition Text for PDF

Abstract
Learn how to style the body text in admonitions for PDF outputs. Choose the font and set the size
and color.

Admonitions have body text that provides the user with information. Typically, the body text is in
para elements, but you can also include lists and other types of content. We recommend that you
keep admonitions short and concise.

To style the body text for PDF outputs, use the settings on the PDF layout:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Admonitions.

4. Select General.

5. Use the following settings to style the text for admonitions:

• Default font family for admonition text
Choose the typeface that Paligo will use for admonition text by default. Select the typeface
from the list of available fonts.

• Default font size for admonition text
Set the default size of the admonition text. Enter a value and the units of measurement, for
example, 12pt.

6. Use the following settings to set the color for your admonition text. The color applies to the
title and the body text.

• Font color for 'Note'

• Font color for 'Notice'

• Font color for 'Warning'

• Font color for 'Danger'

• Font color for 'Caution'

• Font color for 'Tip'

• Font color for 'Important'
To choose your own color, clear the Use default color checkbox and then either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).

7. Select Save.
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NOTE
To learn how to indent admonition body text, see Set the Admonition Spacing for
PDF [951].

To learn about using the other PDF layout settings to style admonitions, see Admonition Styles for
PDF [949].

Style the Admonition Box for PDF

Abstract
Learn how to style the border and background color of admonitions for PDF outputs. Set a border
style and color and change the background color of the admonition box.

Graphical admonitions have a box that acts as a container for the admonition icon, title, and text.
For PDF outputs, you can use the PDF layout to style the box, including setting a background color
and styling the box borders.

NOTE
To learn how to control the space around an admonition and inside it, see Set the
Admonition Spacing for PDF [951].

To style the admonition boxes:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Admonitions.

4. Select General.

5. Use the following settings to set the background color of the admonition box:

• Background color for 'Note'

• Background color for 'Notice'

• Background color for 'Warning'
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• Background color for 'Danger'

• Background color for 'Caution'

• Background color for 'Tip'

• Background color for 'Important'
To choose your own color, clear the Use default color checkbox and then either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).

6. Select Graphical.

7. Use Background color for graphical admonitions to choose one color for all graphical
admonitions.
Again, to set a custom color, clear the Use default color checkbox and then use the color
selector to choose a color.

NOTE
Paligo will only use the color you select here if the General category has the
background colors set to default.

For example, let's say you select the General category and set Background
color for 'Caution' to orange. You then go into the Graphical category
and set Background color for graphical admonitions to blue. When
you publish, your caution admonitions will have an orange background,
as the General category takes priority over the Graphical category and
Nongraphical category.

8. Set the Border width for graphical admonitions. This is the thickness of the border line
around the edge of the admonition box. It applies to all types of admonition, such as note,
caution, and warning.
Enter a value and the units of measurement, for example, 0.5pt.

9. Choose the Border style for graphical admonitions from the list. The options are:

• none - There is no border.

• hidden - There is a border but it cannot be seen.
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• dotted - The border is a dotted line.

• dashed - The border is made up of short lines.

• solid - The border is a single line with no breaks.

• double - The border is two lines with no breaks.

• groove - The border has lines and shading to create a "pressed down" look.

• ridge - The border has lines and shading to create a "raised" look.

• inset - The border has lines and shading to create a "pressed down" look. It is similar to the
groove style, but uses a different line and shading pattern.

• outset - The border has lines and shading to create a "raised" look. It is similar to the ridge
style, but uses a different line and shading pattern.

10. Set the Border color for graphical admonitions.
Again, to choose your own color, clear the Use default color checkbox and then use the color
selector to set the color.

11. Use the Border radius for graphical admonitions setting to set the amount of curve on
the corners of the border box. Set it to 0pt for no curves or enter a value and a unit of
measurement to add curves. For example, you could use 10pt to give the box curved corners.

<step>
Select Save.
</step>

Inline Elements for PDF
For PDF outputs, you can use the PDF layout to style various inline elements, such as guilabel,
email, and quote. There are separate sections for the commonly used inline elements and each
section has settings for choosing the font, spacing, color and other features.

Paligo Documentation

962



To learn how to apply the styling settings, see the following sections:

• Style the Font for Inline Elements [963]

• Set the Padding for Inline Elements [969]

• Control Line Breaks in Inline Elements [966]

• Set the Color for Inline Elements [964]

• Style the Border for Inline Elements [967].

NOTE
For HTML outputs, use CSS to style the classes (see Branding your HTML Outputs
with CSS [654]).

Style the Font for Inline Elements
To style the font for inline elements in PDFs, such as guilabel and guimenu, use the settings in
the PDF layout.

NOTE
For HTML outputs, use CSS to style the classes (see Branding your HTML Outputs
with CSS [654]).

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Inline elements and then the category for the type of inline element you want to style,
for example, guilabel.

4. Use the font settings to style the appearance of the text:

• Font family for <inline element>
Choose the typeface for the inline element from the available list.

• Font size for <inline element>
Enter the font size, including the units of measurement, for example, 12pt or 1.2em
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• Font weight for <inline element>
Set the thickness of the text for the inline element. Choose from the list, which includes
options for a range of widths, including thin, semi bold, and extra bold.

• Font style for <inline element>
Set the text for the inline element to italic, backslant (leaning backwards), or normal.

• Font variant for <inline element>
Set the font to display as normal or as small caps. The small caps option turns lower case
letters into reduced height capital letters.

• Capitalization for <inline element>
Set the text for the inline element to be shown as normal, all capital letters, or all lower
case.

NOTE
If you have set the Font variant to small caps, it will affect the
capitalization options too. The capitalization options will work like this:

• Upper case sets uppercase letters to appear at full height. Other letters
are shown as reduced height capital letters (small caps).

• Lower case has no effect.

• Letter-spacing for <inline element>
Define the amount of spacing between the letters of the inline element. Enter the value and
the units of measurement, for example, 0.2pt.

5. Select Save. 

When you publish using this layout, Paligo will apply the styling to the appropriate elements.

To learn about the other settings for PDF inline elements, see Inline Elements for PDF [962].

Set the Color for Inline Elements
Use a PDF layout to change the color of inline elements. You can change the color of the text, like
this:

Also, you can change the color of the inline image background, which is useful for creating a
"highlight" effect like this:

NOTE
For HTML outputs, use CSS to style the classes (see Branding your HTML Outputs
with CSS [654]).

To set the color for inline elements in PDF outputs:
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1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Inline elements and then the category for the type of inline element you want to style,
for example, guilabel.

4. Use the Color for <inline element> setting to choose the color for the inline element text.
If you do not want to use the default color, clear the Use default color checkbox. You can
then use the color selector to choose a color.
Either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).

5. Use the Background color for <inline element> setting to choose a background color. This is
the color that will appear behind the text for the inline element, similar to a highlight.
Again, clear the Use default color checkbox and then use the color selector to choose a color.

6. Select Save. 

When you publish using this layout, Paligo will apply the styling to the appropriate elements.

To learn about the other settings for PDF inline elements, see Inline Elements for PDF [962].
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Control Line Breaks in Inline Elements
Use the PDF layout to control how Paligo handles inline elements that cannot fit entirely on the
same line. Depending on your choices, Paligo will either break the inline element over two lines,
hyphenate it, or move the entire element on to the next line.

NOTE
For HTML, use CSS to control hyphenation and line breaks. To learn how to use
and upload CSS, see Branding your HTML Outputs with CSS [654].

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Inline elements and then the category for the type of inline element you want to style,
for example, guilabel.

4. Use the Allow Hyphenation for <inline element> setting to control whether Paligo
hyphenates words in the element.
Choose:

• True
Paligo will hyphenate a word, if needed. This means part of a word may appear on one line,
with the rest of the word on the next line, with a hyphen at the break point.

• False
Paligo will not hyphenate words that cannot fit on a line. It will only show complete words
on a line, and if a word does not fit, it will move to the next line. So if you have two words
inside an inline element, the first word might be on one line and the second word on the
next line.

5. Use Keep <inline element> on one line to control how Paligo positions the entire element.
Choose:

• Yes
Paligo will try to keep the entire inline element on the line where it is positioned. If it cannot
fit on one line, the entire inline element is moved to the next line. This is true in most cases,
but there are some exceptions where the inline element will break over two lines, such as if
the inline element is too long for a table cell.

• No
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Paligo will allow the inline element to break over two lines. It will either hyphenate the inline
element or split the inline element over two lines, depending on the Allow hyphenation in
<inline element> setting.

• Always
This option will set Paligo to always display the entire inline element on the line where it
is positioned. This can mean that the inline element extends beyond the body area of the
page. Typically, this option is not used, but it is included for special cases.

6. Select Save. 

When you publish using this layout, Paligo will apply the styling to the appropriate elements.

To learn about the other settings for PDF inline elements, see Inline Elements for PDF [962].

Style the Border for Inline Elements
You can use the PDF layout settings to add a border around inline elements such as guilabel
and guimenuitem. This is useful if you need to draw extra attention to the inline elements for
some reason.

Example of a blue, solid border around a guilabel element.

NOTE
For HTML outputs, use CSS to style the classes (see Branding your HTML Outputs
with CSS [654]).

To style a border for inline elements in PDF outputs:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Inline elements and then the category for the type of inline element you want to style,
for example, guilabel.

4. Use the Border width for <inline element> setting to set the thickness of the border line.
Enter a value and the units of measurement, such as, 0.5em or 1pt.

Paligo Documentation

967



5. Use the Border style for <inline element> setting to choose a type of border.

• none - There is no border.
There is no border.

• hidden - There is a border but it cannot be seen.
There is a border but it cannot be seen.

• dotted - The border is a dotted line.
The border is a dotted line.

• dashed - The border is made up of short lines.
The border is made up of short lines.

• solid - The border is a single line with no breaks.
The border is a single line with no breaks.

• double - The border is two lines with no breaks.
The border is two lines with no breaks.

• groove - The border has lines and shading to create a "pressed down" look.
The border has lines and shading to create a "pressed down" look.

• ridge - The border has lines and shading to create a "raised" look.
The border has lines and shading to create a "raised" look.

• inset - The border has lines and shading to create a "pressed down" look. It is similar to the
groove style, but uses a different line and shading pattern.
The border has lines and shading to create a "pressed down" look. It is similar to the groove
style, but uses a different line and shading pattern.

• outset - The border has lines and shading to create a "raised" look. It is similar to the ridge
style, but uses a different line and shading pattern.
The border has lines and shading to create a "raised" look. It is similar to the ridge style, but
uses a different line and shading pattern.

6. Set the Border color for <inline element>.
If you do not want to use the default color, clear the Use default color checkbox. You can
then use the color selector to choose a color.
Either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).
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7. Select Save. 

When you publish using this layout, Paligo will apply the styling to the appropriate elements.

To learn about the other settings for PDF inline elements, see Inline Elements for PDF [962].

Set the Padding for Inline Elements
You can set each type of inline element, such as guilabel and guimenuitem, to have a specific
amount of space before and after the element. For example, in the following image, there is a 2em
space before an inline element and also after it. (This is quite a large amount of space, but used
here to show where the spacing applies).

To control the amount of space before and after an inline element, use the Padding for <inline
element> setting (where <inline element> is a specific element, such as guilabel). The space can
help to make the inline element terms stand out more on a page, so that they are easy to pick out
when skimming over the page rather than reading it in depth.

NOTE
For HTML outputs, use CSS to style the classes (see Branding your HTML Outputs
with CSS [654]).

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Inline elements and then the category for the type of inline element you want to style,
for example, guilabel.

4. Use the Padding for <inline element> setting to set the amount of space before and
after every instance of the <inline element>. You need to enter a value and the units of
measurement, such as, 0.5em or 1cm.
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For example, if you want to add 0.5em padding to all guilabel elements, you would enter
0.5em in the Padding for guilabel field.

5. Select Save. 

When you publish using this layout, Paligo will apply the styling to the appropriate elements.

To learn about the other settings for PDF inline elements, see Inline Elements for PDF [962].

PDF Document Properties and Metadata
PDFs have document properties that, when viewed in Adobe® Acrobat®, are shown on the
Document Properties dialog.

To include this information in the PDFs you publish in Paligo, you will need to set up the
publication topic and make some choices in the PDF layout.

NOTE
When you publish to PDF, you choose a PDF layout to use. Paligo creates the
PDF document properties based on your choices in the PDF layout settings. But
these properties may not be used by all PDF viewers. For example, copyright
information is included in the full Adobe Acrobat, but may not appear in other
PDF viewer applications.

Set Title, Subject, Keywords, Author in the Publication Topic
PDF document properties include a title, subject, keywords, and author information. In Paligo, this
information is taken from specific elements that you can add to your publication topic. (Unlike
many of the other document properties, which you can set in the PDF layout).

NOTE
The structures for author, subject, and keywords are optional. You do not have to
include them.
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To add the appropriate elements and structure in the publication topic:

1. Select the publication's options menu ( ...) and then select Edit and then Open in Editor.
Paligo opens the publication topic. This is a topic at the root of the publication and you
can use it to add various "front matter" elements, such as images, cover text, copyright
information, etc.
The publication topic has article as its top-level element rather than section. Inside this,
there is an info element. The info element is important, as all of the elements you add for
PDF properties need to be inside the info element.

2. Define the title.
The title for your PDF properties comes from the title inside the info element, for example:

  <info>
    <title>Acme 200X User Guide</title>

Enter the text you want for the title inside the title element.

NOTE
If the document is translated into other languages, translations of the title will
also appear. They are separated by a bullet point.

3. Define the subject.
Select the position after the title but before the next element.

Use the element context menu to add the subjectset element.

To display the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

When you have added the subjectset element, select it and then use the element
context menu to add the subject element. Then select the subject element and add the
subjectterm element. Enter your subject text inside the subjectterm element.

 <subjectset>
      <subject>
        <subjectterm>User guide for the Acme 200X series</subjectterm>
      </subject>
 </subjectset>

NOTE
You can add multiple subject elements inside a subjectset, if required. The
subjects will all be shown in the PDF document properties, separated by a
comma.
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4. Define the keywords.
Select the position after the closing subjectset element. In the element structure menu, you
should see that the cursor is positioned at article > info.

Use the element context menu to add the keywordset element. Then select the keywordset
element and add the keyword element.
Enter the text for the keyword. This text should describe one of the main concepts covered in
the content.
To add more keywords, select the position below the keyword, but above the next element.
Then use the element context menu to add another keyword element.

 <keywordset>
      <keyword>Acme 200X</keyword>
      <keyword>Acme 200Xe</keyword>
      <keyword>Acme 200Xs</keyword>
    </keywordset>

5. Define the author.
Select the position after the last element, so that the element structure menu shows the
position as article > info. Then use the element context menu to add either the author
element or the editor element. Paligo will use the first one of these it finds in the publication
topic and map it to the author property of the PDF.
Select the author or editor element and then add the personname, honorific,
firstname, surname, and othernameelements.
The following examples show the correct structure and order for these elements:

 <author>
      <personname>
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        <honorific>Dr</honorific>
        <firstname>Sergio</firstname>
        <surname>Alvarez</surname>
        <othername>F</othername>
      </personname>
</author>

<editor>
      <personname>
        <honorific>Dr</honorific>
        <firstname>Sergio</firstname>
        <surname>Alvarez</surname>
        <othername>F</othername>
      </personname>
</editor>

6. Select Save.

NOTE
You can have other elements in the publication topic, such as copyright, but
these are not used for the PDF document properties. For copyright details,
use the settings in the PDF layout [973].

Set the Version of a PDF
There are different versions of PDF standards. For each PDF layout in Paligo, you can choose which
version it will produce.

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General > PDF properties.

3. Select the PDF version that you want Paligo to create.
By default, Paligo uses version 1.7. If you have a specific need for an earlier version, choose
that from the list.
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For an output that complies with accessibility standards, choose a version that ends with
UA-1:2014. You will also need to enable Generate Tagged PDF, which is in the General > Misc
settings.

4. Select Save.
When you publish using this layout, Paligo will create a PDF that uses the settings you have
chosen.

Set PDF Copyright Metadata
Use General > PDF properties to set the copyright metadata for the PDF file. This is not the same
as the copyright information that is shown inside the document, it is just the copyright information
for the file.

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General > PDF properties.

3. Set the copyright information:

• Use the Copyright Status list to choose whether the content is Copyrighted or in the
Public Domain. Select Unknown if you are unsure.

• In the Copyright Notice field, enter the full text of your copyright details.

• In the Copyright Info field, enter the URL of the organization that holds the copyright
(typically, the website of your organization).

4. Select Save.
When you publish using this layout, Paligo will create a PDF that uses the settings you have
chosen.

Set PDF Page Mode, Page Layout and UI Preferences
Use the General > PDF Properties settings to control the PDF page mode, page layout, and UI
preferences such as whether the toolbar is shown. These settings affect how the PDF is presented
in the initial view when it is first opened.

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General > PDF properties.
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3. Set the Page Mode that will be used when the document is first opened.
Choose from:

• UseNone
The document outline and thumbnail images are hidden.

• UseOutlines
The document outline is shown.

• UseThumbs
Thumbnail images are shown.

• FullScreen
The document is shown at full screen size, with no visible menu bar or window controls.

4. Set the Page Layout that will be used when the document is first opened.
Choose from:

• SinglePage
Show one page at a time.

• OneColumn
Show the pages in one column.

• TwoColumnLeft
Show the pages in two columns, with odd-numbered pages on the left

• TwoColumnRight
Show the pages in two columns, with odd-numbered pages on the right

• TwoPageLeft
Show two pages at the same time, with odd-numbered pages on the left

• TwoPageRight
Show two pages at the same time, with odd-numbered pages on the right.

5. Use Hide Toolbar to choose whether the toolbar is visible when the document is first opened.

6. Use Hide Menubar to choose whether the menu is visible when the document is first opened.

7. Use Hide window UI to choose whether the UI elements, such as the scrollbar, are visible
when the document is first opened.

8. Use Fit window to choose whether the document window is sized to fit the page size when it
is first opened.
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9. Use Center window to choose whether the document is shown in the center of the display
area when it is first opened.

10. Select Save.

Set PDF to Show Title or Filename
Use the General > PDF Properties > Display title feature to control whether the PDF view shows
the filename of the PDF or the title. By default, PDFs will show the filename but showing the title
can be better for accessibility.

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General > PDF properties.

3. Set Display title to:

• Yes to display the title instead of the filename

• No to display the filename instead of the title.

4. Select Save.

Table Styles for PDF
To style tables for PDF, you can use a combination of:

• The table editor in the main topic editor

• Attributes that you can set in the main topic editor

• The default table settings that you can set in PDF layouts.

NOTE
Paligo will only use the default settings in the PDF layouts if those settings are not
already defined in the main editor. For example, if you set the width in the main
editor, Paligo will use that width and ignore the default width settings in the PDF
layout.

The following sections explain how to use the default table settings in a PDF layout:
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• How Default Table Settings Work [977]

• Set a Table to use a Specific Table Style [978]

• Style the Table Body for PDF [980]

• Style the Table Header for PDF [1002]

• Style the Footer for Tables [1008]

• Style the Table Footnotes for PDF [1014].

How Default Table Settings Work
For PDF outputs, Paligo has table settings that you can set in the PDF layout. There are five sets of
table settings, named Tabstyle1 to Tabstyle5, so you can apply up to 5 different styles of tables to
the same document. For example, you may have some tables that you want to use settings from
Tabstyle1 and other tables that you want to use the settings from Tabstyle4.

NOTE
Paligo uses Tabstyle1 for all tables that do not have a tabstyle set already. So if
you have tables in your documents, but have not assigned them a tabstyle, then
Tabstyle1 is applied to them. To leave those tables styled as they are currently,
leave the Tabstyle1 settings in place. If you want to add any different table styles,
use Tabstyle2 to Tabstyle5 instead.

If you change Tabstyle1, it will affect all tables that do not have a tabstyle set.

Each Tabstyle has 4 categories of settings: General (for styling the table frame and body), Header,
Footer, and Footnotes. You can use these to define the default settings for each part of your
tables.
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Paligo will apply the settings in the layout to any table that:

• Is set to use the relevant tablestyle (see Set a Table to use a Specific Table Style [978]).

• Does not have the equivalent settings and attributes applied in the topic. For example, if you
open a topic and use the table editor to set a table width, Paligo will use that width. It will ignore
any width that is set in the PDF layout.
The table settings in the topic take priority over those in the PDF layout.

To learn how to style the table header, body, footer, and footnotes for each tablestyle, see:

• Style the Table Body for PDF [980]

• Style the Table Header for PDF [1002]

• Style the Footer for Tables [1008]

• Style the Table Footnotes for PDF [1014].

Set a Table to use a Specific Table Style
Paligo's PDF layouts allow you to define up to five different table styles. You can then set the tables
in your document to use any of the five styles, depending on your requirements. For example, you
could have a specifications table that uses the styles from Tabstyle1 and then set tables in your
instruction topics to use styles from Tabstyle2.

By default, all tables use the styles in Tabstyle1. But you can use the tabstyle attribute to set your
tables to use a different style.
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To set a table to use a specific style:

1. In the Content Manager, select the topic that contains the table to open it in the editor.

2. Click in the table and then select the table element in the Element Structure Menu.

3. In the Element attributes panel, give the table element the tablestyle attribute. Set the
attribute value to match the name of the table styles you want to use (tabstyle1, tabstyle2,
tabstyle3, tabstyle4, or tabstyle5).

4. Select Save. 
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NOTE
To learn how to style the table header, body, footer, and footnotes for each
tablestyle, see:

• Style the Table Body for PDF [980]

• Style the Table Header for PDF [1002]

• Style the Footer for Tables [1008]

• Style the Table Footnotes for PDF [1014].

When you publish, the table you have edited will use the settings from the table style you set as
the attribute value. Note that some table settings will only apply if the table does not already have
that attribute. For example, if your table has a width attribute in a topic, the width setting in the
layout editor is ignored.

Style the Table Body for PDF
For PDF outputs, use the PDF layout to set the default styling for tables. There are 5 Tabstyle
categories to choose from, and each of those has General settings for styling the table body. (To
learn about the different Tabstyle categories, see Set a Table to use a Specific Table Style [978]).

NOTE
The Tabstyle categories also have settings for Headers [1002], Footers [1008],
and Footnotes [1014].

Set the Default Table Width
For PDF outputs, use the Layout Editor [57] to set the default width of tables. Paligo will use the
default width for any tables that do not have a width attribute.
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The PDF layout editor has settings for up to 5 table styles, named Tabstyle1 to Tabstyle5. All
tables use the settings in Tabstyle1 by default, but you can set each table to use the styles from
Tabstyle2 to Tabstyle5 instead.

For example, the following image shows two tables. Table 1 is set to use the styles from Tabstyle1
and that has default width of tables set to 100%. Table 2 is set to use the styles from Tabstyle 2
and that has default width of tables set to 50%.

To set the default table width:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select General.

5. Set The default width of tables.

You can enter:
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• Auto
This sets Paligo to adjust the width according to the content in the table.

• A percentage.
For example, 70% will size the table at 70% of the body area of the page. 100% sets the table
at full width of the body.

6. Select Save.

NOTE
The style you have set will only apply to a table that has:

• A tabstyle attribute with a value that matches the tabstyle set, for example,
tabstyle2

• No width attribute. If there is a width attribute and value, Paligo will use that
instead of the default table width that is set in a PDF layout.

Set a Background Color for a Table
Use the PDF layout editor to set the background color for tables. Depending on your
requirements, you can set the background color for:

• The entire background of a table body

• The background of each row in tables that use alternating rows.

For example, the following image shows a table that uses alternating rows. It has a blue
background for the odd-numbered rows and a gray background for the even-numbered rows.

To set the background color for tables:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select General.

5. Use the Background color for table body setting to choose the main background color for
the table. If a table is set to use alternate table rows, this color is used for the odd numbered
rows.
To select a color of your own choice, clear the Use default color checkbox and then either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).

6. This step only applies if you have set tables to use alternate rows [985].
Use the Background color for alternate table body rows setting to choose a background
color for the even numbered rows.

7. Select Save. 

When you publish, Paligo will apply the background colors to any tables that are set to use the
table style you chose in step 2.

Control the Height of Empty Table Rows
By default, Paligo will display empty table rows as narrow (less height) rows in PDF outputs, like
this:
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If you prefer, you can set tables in PDFs to display empty rows at the same height as other rows,
like this:

NOTE
An empty row is a table row that contains no elements other than the <tr> and
<td> that define the table row and cell structure. If a table row contains a para, it
is not an empty row, even if the para contains no text.

To control the height of empty table rows:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select General.
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5. Set Ensure empty rows have normal height to:

• Enable
For empty rows that are the same height as rows that contain content.

• Disable
For empty rows that are narrower (less height) than rows that contain content.

6. Select Save. 

When you publish using this layout, Paligo will apply the empty row height setting to any tables
that are set to use the table style you chose in step 2.

Set Alternate Row Shading for a Table
You can set tables to use alternate shading for rows. By default, Paligo will set the odd numbered
rows to use a white background and the even numbered rows a gray background, like this:

But you can choose your own background colors if you prefer (see Set a Background Color for a
Table [982]).

To enable or disable alternate row shading:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select General.

5. Set Alternate table rows to:

• True
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To enable alternate table row shading.

• False
To disable alternate table row shading. The table will use the same background color for all
of the cells.

6. Select Save. 

When you publish, Paligo will apply the background colors to any tables that are set to use the
table style you chose in step 2.

Set the Background Colors for Individual Table Cells
If you are publishing to PDF and need individual table cells to have a different background color,
you can set them up as "special" cells. You can then style those cells differently, by using one of
the three "special cell" background color settings on the PDF layout.

For example, in the following image, one cell is set to have a yellow background so that it is more
prominent.

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Click in the cell that you want to style differently. Note that you need to click inside the cell, but
not on any content in the cell.

3. Check that the td element is selected (or th element if you selected a cell in a table header) in
the Element Attributes Panel [55].
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It should also be the rightmost entry on the Element Structure Menu [52]

4. In the Element Attributes Panel [55], add the style attribute to the td or th element and give it
one of these values:

• background-color:bg1

• background-color:bg2

• background-color:bg3

5. Select Save. 

6. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

7. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

8. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

9. Select General.

10. Use the Special cell background color settings to choose a background color for "special"
cells. There are three settings, one for each of the values you can enter in step 4. For example,
if you entered background-color:bg2 in step 4, then the settings in Special cell background
color 2 will affect that table cell.
To select a color of your own choice, clear the Use default color checkbox and then either:

• Enter an rgba value in the field

• Select the color box to reveal a color selector to choose a color and set the opacity.
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11. Select Save. 

When you publish with this layout, any "special" table cells in your content will use the background
color you have set.

NOTE
If the color is not showing, make sure that you have set the style value
correctly. Also, check that you have chosen the color in the matching special cell
background color setting in the PDF layout.

Set the Default Alignment for Tables
For PDF outputs, you can use the PDF layout to define the default alignment for tables. Paligo will
apply the default alignment to tables that do not already have the alignment set locally (in the
topic).

For example, you can set tables to use centered text by default.

NOTE
To learn how to set the alignment for columns for individual tables, see Edit a
Table [282].

To set the default alignment for tables:

1. Select the Layout tab in the top menu.
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Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select General.

5. Set the Default alignment for text in tables.
You can choose from:

• Start
Left-align the text (in left-to-right languages).

• End
Right-align the text (in left-to-right languages).

• Center
Align the text centrally.

• Justify
Add space between the words so that the text is spaced out to fit the full width of a table
cell. The first word and last word of the text will be at the margin boundaries inside the cell.

• Inside
Align the text to the "spine". The spine is where the pages would be bound if the document
was printed out as a book. If the text is on a left page ("verso"), the text is right-aligned and if
it is on a right page ("recto") it is left-aligned.

• Outside
Align the text to the outer edge of the page. This is the opposite edge to the "spine" (see
Inside). If the text is on a left page ("verso"), the text is left-aligned and if it is on a right page
("recto") it is right-aligned.

• From-table-column()
Tells Paligo to use the column alignment that you can set on the table in the main editor
(see Edit a Table [282]). This is the default setting. If you have a table that has no column
alignment in place, Paligo will use the Start alignment instead.

6. Select Save. 

When you publish with this PDF layout, Paligo will apply the default settings you have chosen. The
settings only apply to tables that use the tablestyle you chose in step 2.

Set the Text for a Table
For publishing to PDF, use the PDF layout to set the size, style, and typeface for the text in tables.
The settings in the General category are for styling the main body of the table.
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NOTE
There are also Header [1004], Footer [1010], and Footnotes [1016] categories for
styling the fonts in those parts of your tables.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select General.

5. Choose the default font settings:

• Default font family for text in tables
Choose the typeface that Paligo will use for tables that use this table style.

• Default font size for text in tables
Set the default typeface size. You can enter:

• Auto
Table will use same typeface size as body text in the topic.

• Percentage
Table will use a typeface size that is a percentage of the body text in the topic. For
example, 50% would be half the topic text size.

• Value and units of measurement
Any measurement with the units, for example, 12pt or 1.3em.

• Default font stretch for text in tables.
Use to choose the amount of space each character takes up. You can choose normal for
regular lettering or from a range of condensed and stretched options. The condensed
options, such as narrower and ultra-condensed make the characters smaller horizontally.
The stretched options, such as expanded and ultra-expanded make the characters wider
horizontally.
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TIP
When changing the font stretch, consider the readability of the information
in your table. The stretch features can make it more difficult to read a table,
and so should only be used in special circumstances where regular text is
inappropriate.

6. Select Save. 

When you publish with this PDF layout, Paligo will apply your changes to any tables that use the
tablestyle you selected in step 2.

Set the Default Borders for Tables
To set the default outer and inner borders for tables in your PDF outputs, use the settings on the
PDF layout. There are settings for controlling which borders are shown and what style and color
they use.

For table borders, we use the following terms:

• Frame
The frame is the outer edge of the table (top, left, right, and bottom) and also the border around
the table header.
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• Rules
These are the inner lines of the table that form the row, column, and cell borders.

To choose your preferences for the the default frame and rules:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select General.

5. Use Default frame for tables to choose which parts of the frame get a border line. Choose
from:

• void - No frame border.
No frame border.

• above - The top edge of the table frame will have a border.
The top edge of the table frame will have a border.

• below - The bottom edge of the table frame will have a border.
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The bottom edge of the table frame will have a border.

• hsides - The horizontal sides of the table frame will have a border (top/above and bottom/
below).
The horizontal sides of the table frame will have a border (top/above and bottom/below).

• vsides - The vertical sides of the table frame will have a border (left and right edges of the
table).
The vertical sides of the table frame will have a border (left and right edges of the table).

• lhs - The left edge of the table frame will have a border.
The left edge of the table frame will have a border.

• rhs - The right edge of the table frame will have a border.
The right edge of the table frame will have a border.

• box - All 4 edges of the table frame will have a border. This does the same as the border
option.
All 4 edges of the table frame will have a border. This does the same as the border option.

• border - All 4 edges of the table frame will have a border. This does the same as the box
option.
All 4 edges of the table frame will have a border. This does the same as the box option.

6. Use Default rules for tables to choose which inner lines get a border. Choose from:

• none - No inner borders.
No inner borders.

• groups - There will be a border line between each group. The groups are the table header,
the table body and the table footer.
There will be a border line between each group. The groups are the table header, the table
body, and the table footer.

• rows - There will be a border line for each row.
There will be a border line for each row.

• cols - There will be a border line for each column.
There will be a border line for each column.

• all - All groups, rows, and columns will have a border.
All groups, rows, and columns will have a border.

7. Use Table frame and rules width to set the thickness of the border lines. Enter a value and
its units of measurement, for example, 3pt.

8. Use Table frame and rules style to choose set the appearance of the border lines. Choose
from:

• none - There is no border.
There is no border.

• hidden - There is a border but it cannot be seen.
There is a border but it cannot be seen.

• dotted - The border is a dotted line.
The border is a dotted line.

• dashed - The border is made up of short lines.
The border is made up of short lines.

• solid - The border is a single line with no breaks.
The border is a single line with no breaks.
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• double - The border is two lines with no breaks.
The border is two lines with no breaks.

• groove - The border has lines and shading to create a "pressed down" look.
The border has lines and shading to create a "pressed down" look.

• ridge - The border has lines and shading to create a "raised" look.
The border has lines and shading to create a "raised" look.

• inset - The border has lines and shading to create a "pressed down" look. It is similar to the
groove style, but uses a different line and shading pattern.
The border has lines and shading to create a "pressed down" look. It is similar to the groove
style, but uses a different line and shading pattern.

• outset - The border has lines and shading to create a "raised" look. It is similar to the ridge
style, but uses a different line and shading pattern.
The border has lines and shading to create a "raised" look. It is similar to the ridge style, but
uses a different line and shading pattern.

9. Set the Table frame and rules color.
To select a color of your own choice, clear the Use default color checkbox and then either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).

10. Select Save. 

When you publish to PDF using the layout you edited, Paligo will apply the table borders. They will
apply to any tables that are set to use the table styles you changed.

Set the Padding for Table Cells
When you are setting up tables, "padding" is the amount of space between the content area of a
cell and the edges of the cell. For example, the following image shows a single cell of a table. The
outer black edges are the outer sides of the cell. The white area in the middle of the cell is the
content area (where content can go), and the shaded area is the "padding".
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In this image the light blue area represents the padding. The outer edges are the sides of the cell and the
inner rectangle is the content area.

For PDF outputs, you can set the default amount of padding in the PDF layout.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select General.

5. Use the following settings to set the amount of padding for each side of a table cell. For
each setting, enter the amount of space as a value followed by the units of measurement, for
example, 2pt.

• padding-start of table cells
Use to set the amount of space between the left-side of the content and the left edge of all
table cells.

• padding-end of table cells
Use to set the amount of space between the right-side of the content and the right edge of
all table cells.

• padding-top of table cells
Use to set the amount of space between the content and the top edge all table cells.

• padding-bottom of table cells
Use to set the amount of space between the content and the bottom edge of all table cells.

6. Select Save. 

When you publish to PDF using the layout you edited, Paligo will apply the rule and frame settings.
They will only affect tables that use the tabstyle you selected in step 2.
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Set the Spacing Between Paragraphs in Table Cells
If you are publishing to PDF, you can control the amount of spacing between the paragraphs in a
cell.

For each of the Tabstyle groups of settings (Tabstyle 1-5), you can set two different paragraph
spacing values:

• Paragraph spacing in normal tables
This spacing applies to all tables except those that are set to be "compact" tables.

• Paragraph spacing in compact tables
This spacing only applies to tables that are set to be "compact" tables (see Set Up a Compact
Table [997]).

So for each table style, you can have two different paragraph spacing rules (normal and compact).

To set the paragraph spacing for normal and compact tables, edit a PDF layout:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select General.

5. Set the Paragraph spacing in normal tables.
Enter a value and the units of measurement. For example, you could use em, point, or
centimeter measurements such as 1em, 15pt, 0.5cm.
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The default value is 1em.

6. Set the Paragraph spacing in compact tables.
Again, enter a value and the units of measurement. This setting will only apply to cells in
tables where the table element has the tabstyle attribute with a value of: compact.
The default is 0.1em.

7. Select Save. 

When you publish to PDF with this layout, Paligo will apply the paragraph spacing to your normal
tables and compact tables (if you have any).

Set Up a Compact Table
To set a table to use the 'compact' paragraph spacing instead of the normal paragraph spacing:

1. In the Content Manager, select the topic that contains the table.
Paligo opens the topic in the editor.

2. Click inside the table and then select the table element in the Element Structure Menu.
Select Go to element from the menu.

3. In the Element attributes panel, give the table element the tabstyle attribute and set its
value to compact.
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NOTE
If the table already has a tabstyle and value, add a semi-colon after the
existing value and then add the compact value.

For example, if a table has tabstyle with tabstyle2 as a value already, set the
value to:

tabstyle2; compact

4. Select Save. 

5. Edit a PDF layout and apply the paragraph spacing for the table (see Set the Spacing Between
Paragraphs in Table Cells [996]).

When you publish to PDF using the layout you edited in step 5, Paligo will apply the paragraph
spacing to your compact table.

Set the Rule Styles for Tables
You can set Paligo to show the table lines by default for PDF outputs. Each table can have lines for:

• Rules
These are the horizontal lines for rows and the vertical lines for columns.

• Frame
The frame is the outer sides of the table.

To control which lines are shown, use the table frame and rules settings in the PDF layout:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select General.

5. Use the Default rules for tables option to choose which rule lines will be shown on tables by
default.

• All
To include all of the rule lines for cells and the outer frame of the table.

• None
To exclude all of the rule lines for cells and the outer frame of the table.

• Groups
To include rule lines for each group. The groups are: the table header, the table body, and
the table footer.

• Rows
To add a horizontal rule for each row.

• Cols
To add a vertical rule for each column.

6. Set the Table frame and rules width.
Enter the line thickness as a value and units of measurement, for example, 1pt, or 1.5em.

7. Choose the Table frame and rules style:

• none - There is no border.

• hidden - There is a border but it cannot be seen.

• dotted - The border is a dotted line.

• dashed - The border is made up of short lines.

• solid - The border is a single line with no breaks.

• double - The border is two lines with no breaks.

• groove - The border has lines and shading to create a "pressed down" look.

• ridge - The border has lines and shading to create a "raised" look.

• inset - The border has lines and shading to create a "pressed down" look. It is similar to the
groove style, but uses a different line and shading pattern.

• outset - The border has lines and shading to create a "raised" look. It is similar to the ridge
style, but uses a different line and shading pattern.

8. Set the Table frame and rules color.
To select a color of your own choice, clear the Use default color checkbox and then either:

• Enter the rgba code for the color you want (1).
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• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).

9. Select Save. 

When you publish to PDF using the layout you edited, Paligo will apply the rule and frame settings.
They will only affect tables that use the tabstyle you selected in step 2.

Control Hyphenation in Tables
To control the hyphenation in tables for PDF outputs, use the Allow hyphenation in tables
setting in the PDF layout.

When hyphenation is enabled, Paligo will automatically hyphenate words that cannot fit on a line
in a table cell.

When it is disabled, Paligo will move the word to the next line.

To set the default hyphenation rules for tables in PDFs:

1. Select the Layout tab in the top menu.
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Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select General.

5. Use the Allow hyphenation in tables setting to set your preference:

• True
Paligo will use hyphenation when a word cannot fit on a line in a table cell.

• False
If a word in a table cell cannot fit on a line, Paligo will move it to the next line. It will not use
hyphenation.

6. Select Save. 

When you publish to PDF using the layout you edited, Paligo will apply the hyphenation rules. They
will apply to any tables that are set to use the table settings you changed.

Reset the Table Sorting on Publish
If you use the Sort feature when you edit your tables, Paligo reorders the table so that it is in
ascending or descending alphabetical order. By default, when you publish to PDF, Paligo applies
the sort order again as part of the processing. This is useful when:

• You publish to multiple languages (and so the order may be different in some languages)

• You have added content to a table in an update and forgotten to reapply the sort order.

You can use the PDF layout to control whether Paligo reapplies the sort order when you publish:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select General.

5. Use the Re-sort sorted tables automatically on publish setting to set your preference:

• Enable
Paligo will re-sort the tables each time you publish with this PDF layout. It will also re-sort for
each language that you publish.

• Disable
Paligo will publish to PDF without re-sorting. It will use the order that is set for the table in
the main editor (even if that order is now incorrect). It will not re-sort for each language.

6. Select Save. 

Your re-sort preference will apply whenever you publish to PDF with this layout. It will only affect
tables that are set to use the tablestyle you chose in step 2 and that also have sort orders applied
to them in the main editor.

Style the Table Header for PDF
The PDF layout has settings for styling the table header for PDFs. You can use it to change various
properties of the header, including the background color, alignment, and text color.

For example, the following image shows a table with a header that has been set to have a blue
background, white text, with a different font and font size to the rest of the table.
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NOTE
As with the table body, table footer, and table footnotes settings, there are 5
Tabstyle categories to choose from. Each of those has its own header settings.
To learn about the different Tabstyle categories, see Set a Table to use a Specific
Table Style [978]

Set a Background Color for Table Headers
For PDF outputs, you can use the PDF layout to set the default background color for table headers.
For example, in the following image, the table header has been set to have a blue background.

To set the default background color for table headers:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select Header.

5. Set the Background color for table header rows. This is the "fill" color of the header row.
To select a color of your own choice, clear the Use default color checkbox and then either:
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• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).

<step>
Select Save. 
</step>
When you publish with this PDF layout, Paligo will apply the header styles to any tables that are set
to use the tabstyle you selected in step 2.

Style the Text for Table Headers
For PDF outputs, you can use a PDF layout to set the default style of text in table headers. The
PDF layout has settings for controlling the typeface, color, and size of the text. For example, the
following image shows header text that is set to use a serif font, and the text is white and larger
than the text in the rest of the table.

To set the default style for text in table headers:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.
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2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select Header.

5. Set the Font color for table header rows. This is the color of the text in the header row.
Either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).

6. Set the Default font family for text in table header. This is the typeface for the text in the
header and you can choose any of the available fonts from the list.

7. Set the Default font size for text in table header. You can enter:

• Auto
The table header will use same typeface size as body text in the topic.

• Percentage
The table header will use a typeface size that is a percentage of the body text in the topic.
For example, 50% would be half the topic text size.

• Value and units of measurement
Any measurement with the units, for example, 12pt or 1.3em.

<step>
Select Save. 
</step>
When you publish with this PDF layout, Paligo will apply the header styles to any tables that are set
to use the tabstyle you selected in step 2.
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NOTE
To control the position of the text in the header, see Set the Alignment for Table
Headers [1006].

To control what happens if a word cannot fit on a line in the header, see Control
Hyphenation in Table Headers [1007].

Set the Alignment for Table Headers
For PDF outputs, you can use the PDF layout to set the default alignment for text in table headers.
For example, in the following image, the table header text is set to be aligned to the center.

To set the alignment for table headers:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select Header.

5. Set the Default alignment for text in table header.
You can choose from:
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• Start
Left-align the text (in left-to-right languages).

• End
Right-align the text (in left-to-right languages).

• Center
Align the text centrally.

• Justify
Add space between the words so that the text is spaced out to fit the full width of a table
cell. The first word and last word of the text will be at the margin boundaries inside the cell.

• Inside
Align the text to the "spine". The spine is where the pages would be bound if the document
was printed out as a book. If the text is on a left page ("verso"), the text is right-aligned and if
it is on a right page ("recto") it is left-aligned.

• Outside
Align the text to the outer edge of the page. This is the opposite edge to the "spine" (see
Inside). If the text is on a left page ("verso"), the text is left-aligned and if it is on a right page
("recto") it is right-aligned.

• From-table-column()
Tells Paligo to use the column alignment that you can set on the table in the main editor
(see Edit a Table [282]). This is the default setting. If you have a table that has no column
alignment in place, Paligo will use the Start alignment instead.

<step>
Select Save. 
</step>
When you publish with this PDF layout, Paligo will apply the header styles to any tables that are set
to use the tabstyle you selected in step 2.

Control Hyphenation in Table Headers
To control the hyphenation in table headers for PDF outputs, use the Allow hyphenation in table
header setting in the PDF layout.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.

Paligo Documentation

1007



There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select Header.

5. Use Allow hyphenation in table headers to control whether words are hyphenated when
they cannot fit on a line. Choose either:

• True
Paligo will use hyphenation when a word cannot fit on a line in the table header.

• False
If a word in a table header cannot fit on a line, Paligo will move it to the next line. It will not
use hyphenation.

<step>
Select Save. 
</step>
When you publish with this PDF layout, Paligo will apply the header styles to any tables that are set
to use the tabstyle you selected in step 2.

Style the Footer for Tables
The PDF layout has settings for styling the table footer for PDFs. You can use it to change various
properties of the footer, including the background color, alignment, and text color.

For example, the following image shows a table with a footer that has been set to have a blue
background, white text, and right-aligned text.

NOTE
As with the table body, table header, and table footnotes settings, there are 5
Tabstyle categories to choose from. Each of those has its own footer settings. To
learn about the different Tabstyle categories, see Set a Table to use a Specific
Table Style [978]

Set a Background Color for Table Footers
For PDF outputs, you can use the PDF layout to set the default background color for table footers.
For example, in the following image, the table footer has been set to have a blue background.
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To set the default background color for table footers:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select Footer.

5. Set the Background color for table footer rows. This is the "fill" color of the footer row.
To select a color of your own choice, clear the Use default color checkbox and then either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).
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<step>
Select Save. 
</step>
When you publish with this PDF layout, Paligo will apply the footer styles to any tables that are set
to use the tabstyle you selected in step 2.

Style the Text for Table Footers
For PDF outputs, you can use a PDF layout to set the default style of text in table footers. The
PDF layout has settings for controlling the typeface, color, and size of the text. For example, the
following image shows footer text that is set to use a different font, and the text is white and
smaller than the text in the rest of the table.

To set the default style for text in table footers:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select Footer.

5. Set the Font color for table footer rows. This is the color of the text in the footer row.
Either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).

6. Set the Default font family for text in table footer. This is the typeface for the text in the
footer and you can choose any of the available fonts from the list.

7. Set the Default font size for text in table footer. You can enter:

• Auto
The table footer will use same typeface size as body text in the topic.

• Percentage
The table footer will use a typeface size that is a percentage of the body text in the topic. For
example, 50% would be half the topic text size.

• Value and units of measurement
Any measurement with the units, for example, 12pt or 1.3em.

<step>
Select Save. 
</step>
When you publish with this PDF layout, Paligo will apply the footer styles to any tables that are set
to use the tabstyle you selected in step 2.
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NOTE
To control the position of the text in the footer, see Set the Alignment for Table
Footers [1012].

To control what happens if a word cannot fit on a line in the footer, see Control
Hyphenation in Table Footers [1013].

Set the Alignment for Table Footers
For PDF outputs, you can use the PDF layout to set the default alignment for text in table footers.
For example, in the following image, the table footer text is set to be aligned to the right.

To set the alignment for table footers:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select Footer.

5. Set the Default alignment for text in table footer.
You can choose from:

Paligo Documentation

1012



• Start
Left-align the text (in left-to-right languages).

• End
Right-align the text (in left-to-right languages).

• Center
Align the text centrally.

• Justify
Add space between the words so that the text is spaced out to fit the full width of a table
cell. The first word and last word of the text will be at the margin boundaries inside the cell.

• Inside
Align the text to the "spine". The spine is where the pages would be bound if the document
was printed out as a book. If the text is on a left page ("verso"), the text is right-aligned and if
it is on a right page ("recto") it is left-aligned.

• Outside
Align the text to the outer edge of the page. This is the opposite edge to the "spine" (see
Inside). If the text is on a left page ("verso"), the text is left-aligned and if it is on a right page
("recto") it is right-aligned.

• From-table-column()
Tells Paligo to use the column alignment that you can set on the table in the main editor
(see Edit a Table [282]). This is the default setting. If you have a table that has no column
alignment in place, Paligo will use the Start alignment instead.

<step>
Select Save. 
</step>
When you publish with this PDF layout, Paligo will apply the footer styles to any tables that are set
to use the tabstyle you selected in step 2.

Control Hyphenation in Table Footers
To control the hyphenation in table footers for PDF outputs, use the Allow hyphenation in table
footer setting in the PDF layout.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
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There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select Footer.

5. Use Allow hyphenation in table footers to control whether words are hyphenated when
they cannot fit on a line. Choose either:

• True
Paligo will use hyphenation when a word cannot fit on a line in the table footer.

• False
If a word in a table footer cannot fit on a line, Paligo will move it to the next line. It will not
use hyphenation.

<step>
Select Save. 
</step>
When you publish with this PDF layout, Paligo will apply the header styles to any tables that are set
to use the tabstyle you selected in step 2.

Style the Table Footnotes for PDF
The PDF layout has settings for styling footnotes in tables. The footnotes appear as a label in the
table cell, with the footnote text listed below the table.

NOTE
As with the table body, table header, and table footer settings, there are 5
Tabstyle categories to choose from. Each of those has its own footnotes settings.
To learn about the different Tabstyle categories, see Set a Table to use a Specific
Table Style [978]

NOTE
To learn how to add footnotes, see Footnotes [394].

Set the Format for Table Footnotes
If a table cell contains a footnote, Paligo will add a footnote label, such as a number, to the cell. It
will also add the full text of the footnote in a list after the table. For PDF outputs, you can use the
PDF layout to set the default style of the label.

Paligo Documentation

1014



1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select Footnotes.

5. Set the Number format for table footnotes. This defines the appearance of the footnote
label that appears inside the table.
Choose from:

• a
For a lower case letter, used in alphabetical order.
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• A
For an upper case letter, used in alphabetical order.

• 1
For a number, with no 0 prefix for numbers below 10.

• 01
For a number, with a 0 prefix for numbers below 10.

• i
For lower case roman numerals, for example, iii

• I
For upper case roman numerals, for example, III

<step>
Select Save. 
</step>
When you publish with this PDF layout, Paligo will apply the footnote styles to any tables that are
set to use the tabstyle you selected in step 2.

Style the Text for Table Footnotes
For PDF outputs, use the PDF layout to define the style, size, and color of the text for footnotes.
For example, in the following image, the text has been styled so that it is blue, has a thin weight,
and has a back slant.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].
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4. Select Footnotes.

5. Set the Font family for table footnotes. This is the typeface for the text in the footnotes
below the table. You can choose any of the available fonts from the list.

6. Set the Font size for table footnotes. You can enter:

• Percentage
The table footer will use a typeface size that is a percentage of the body text in the topic. For
example, 50% would be half the topic text size.

• Value and units of measurement
Any measurement with the units, for example, 12pt or 1.3em.

Or leave the field blank to reset to the default sizing.

7. Set the Font weight for table footnotes. The font weight defines the thickness of the
characters, and there are options ranging from Thin (for the narrowest lines) to Extra bold
and Black for the thickest lines.

8. Set the Font style for table footnotes. You can choose from:

• Normal
Regular text, no slant.

• Italic
Forward leaning text.

• Backslant
Backwards-leaning text.

9. Set the Color for table footnotes. This is the color of the footnote text below the table.
Either:

• Enter the rgba code for the color you want (1).

• Select the color square (2) to display the color selector.
Use the spectrum bar (3) to choose the color and use the opacity bar (4) to control the
transparency of the color. Choose the shade of color from the main color panel (5).

<step>
Select Save. 
</step>
When you publish with this PDF layout, Paligo will apply the footnote styles to any tables that are
set to use the tabstyle you selected in step 2.
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Set the Spacing for Table Footnotes
When publishing to PDF, you can use a PDF layout to control the amount of spacing above each
footnote under a table.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Tables and then select the table style that you want to change, for example Tabstyle1.
There are 5 table styles that you can use. By default, tables will use the Tabstyle1 settings, but
you can set them up to use any of the other four settings instead, see Set a Table to use a
Specific Table Style [978].

4. Select Footnotes.

5. Set the Space-before for table footnotes. This is an amount of space that Paligo will add
above each footnote that appears after the table. Enter a value and a unit of measurement,
for example, 3pt or 1.5em.

<step>
Select Save. 
</step>
When you publish with this PDF layout, Paligo will apply the footnote styles to any tables that are
set to use the tabstyle you selected in step 2.
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Rotate a Table
Paligo has an orient attribute that you can use to rotate tables for PDF outputs. Depending
on your requirements, you can rotate a table so that it is shown as landscape [1019] or
portrait [1020].

Portrait table (left) and landscape table (right).

Tables are shown as portrait by default (and are always shown as portrait in the editor, even if
they are set to be landscape when published). HTML outputs always use portrait orientation as
wide tables get a scrollbar to allow users to view all cells in the table.

Set a Table to Landscape Orientation
To set a table to landscape orientation when published to PDF:

NOTE
The landscape orientation only appears in the published output. In the Paligo
editor, the table remains in portrait orientation.

1. Open the topic that contains the table and select the table.

2. In the Element Structure Menu, select the table element or informaltable element and
then select Go to element.
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3. In the Element attributes panel, make sure that the table or informaltable element is
shown. Then add the orient attribute to it and set its value to land.

4. Select Save. 

When you publish to PDF, the table is shown in landscape orientation.

NOTE
If a landscape table is too large for the PDF page, it can extend beyond the
boundary of the page. In this situation, we recommend that you redesign the
table so that it contains less information. It may be better to create several
smaller tables to contain the data.

Set a Table to Portrait Orientation
To set a table to portrait orientation when published to PDF:

1. Open the topic that contains the table and select the table.

2. In the Element Structure Menu, select the table element or informaltable element and
then select Go to element.
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3. In the Element attributes panel, make sure that the table or informaltable element is
shown. Then change the value of the orient attribute to port. Alternatively, you could
remove the orient attribute completely, as Paligo uses portrait orientation by default.

4. Select Save. 

Set the Spacing for Lists in PDF
If you have lists in your content and you are publishing to PDF, you can control the list spacing. You
can set the list spacing on the PDF layout that you use for publishing, and there are settings for
controlling the spacing.

For some types of list spacing, you can have two different sets of spacing, depending on whether
the list is "normal" or "compact". To find out more about "normal" and "compact" lists, see Normal
Lists and Compact Lists [1021].

NOTE
To apply spacing to lists for HTML outputs, use CSS [654].

Normal Lists and Compact Lists
You to have two different classes for styling lists: "normal" and "compact". By default, all lists are
"normal". These both come from the Docbook standard that Paligo is based on.

The advantage of having two classes of list is that you can apply different spacing. For example,
you can set your "normal" lists to use 1.5em spacing between each list item and have 1em spacing
for "compact" lists.

To make a list a "compact" list:
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1. Select the parent element for the list, for example, orderedlist, and then select Go to
element.

2. In the Element attributes section, add the spacing element and set its value to compact.

3. Select Save. 

When you publish, the list will use the spacing styles that are set for "compact" lists. These are
used instead of the styles that are specifically for "normal" lists.

TIP
To find out how to set the styles for "compact" lists and "normal" lists, see Normal
Lists and Compact Lists [1021].

Spacing Above and Below Lists
Use the PDF layout settings to control the spacing above and below your lists. These settings apply
to Normal Lists and Compact Lists [1021].

1. Select the Layout tab in the top menu.
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Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Lists and choose General.

4. Use the Margin before list blocks setting to change the amount of space above each list.
Enter a value that is relative to the font size of the text. For example, enter 2 to have a space
that is double the font-size.

5. Use the Margin after list blocks setting to change the amount of space below each list.
Again, enter a value that is relative to the font size.

6. Select Save.

When you publish using this PDF layout, the spacing settings will be applied to your lists.

Spacing Above and Below List Items
Use the PDF layout settings to control the amount of space above and below each item in a list.

For this type of spacing, there are separate settings for Normal Lists and Compact Lists [1021].

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Lists and choose General.

4. To change the amount of space above or below list items in a "normal" list, use these settings:

• Space before list item in normal lists for spacing above the list item

• Space after list item in normal lists for spacing below the list item
Enter a value that is relative to the font size of the text. For example, enter 2 to have a space
that is double the font-size.

5. To change the amount of space above or below list items in a "compact" list, use these
settings:Use the Space after list item in normal lists setting to change the amount of space
below each list item. This spacing will only apply to "normal" lists. Enter a value that is relative
to the font size.

• Space before list item in compact lists for spacing above the list item

• Space after list item in compact lists for spacing below the list item
Enter a value that is relative to the font size.

6. Select Save.

When you publish using this PDF layout, the spacing settings will be applied to your lists.

Spacing After Block Elements in Lists
Use the PDF layout settings to control the amount of space that is used after paragraphs and block
items inside a list item or step.

For example, let's say you have a procedure and one of the steps contains two paragraphs as well
as the step. You can use the "space after" settings to control the amount of space that appears
after the second paragraph.

NOTE
You can control the spacing between the list items by using the space before
list items and space after list items settings, see Spacing Above and Below List
Items [1023].

To control the spacing after the last block element (for example tables, images, admonitions) in a
list item:

1. Select the Layout tab in the top menu.
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Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Lists and choose General.

4. Set Apply selected space after property for last block child elements in lists to Enabled.
This setting controls whether a "space after" value is used for spacing paragraphs when they
are inside list items.

To control the spacing after paragraphs (para) in a list item:

1. Use Space-after (optimum) for paragraphs inside list items or procedure steps to set
the amount of space. This is the "space after" value and it applies to the space after para
elements inside a list item or step.
Enter the amount of space as a value with units, for example, 0.7em.

NOTE
The "space after" amount is applied in addition to any other spacing you have
set for the list items.

2. Select Save.

When you publish using this PDF layout, the spacing settings will be applied to your lists.

Left Margin Spacing for Lists
Use the PDF layout settings to control the amount of indentation on the left of a list.
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1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Lists and choose General.

4. Use the Left margin for list blocks setting to set the amount of left margin for the list. Enter
the value and the units, for example: 2em.

5. Select Save.

When you publish using this PDF layout, the spacing settings will be applied to your lists.

Style Quote (PDF)
It is possible to customize the quotes in the Layout editor. You can edit the PDF layout to define
font family, font weight, font style, font size, font variant, color, border, usage of capitalization and
more.

Define Quote Font Family (PDF)
The font family used for Quotes can be defined in the Layout editor. The font family is inherited
from the Document body settings. Paligo uses Arial as default font family with DejaVu Sans and
Arial Unicode MS as fallback fonts.

1. Select the Layout tab in the top menu.
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Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Inline elements and choose Quote from the left menu.

4. Select the Font family to be used from the menu.

5. Select Save.
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Define Quote Font Style (PDF)
The font style used for Quotes can be defined in the Layout editor. You have the following
options:

• Normal - The text will be regular (default)

• Italic - The text is slanted to the right in the reading direction (in left-to-right languages)

• Backslant - The text is slanted to the left against the reading direction (in left-to-right
languages)

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Inline elements and choose Quote from the left menu.
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4. Select the Font style to be used from the menu.

5. Select Save.

Table of Contents for PDFs
The PDF layout has several options for managing tables of contents (TOCs) and lists of titles (LOTs)
in PDFs. To learn how to use the settings, see:

• Add a Table of Contents and List of Titles for PDF [1029]

• Add a Table of Contents at the Start of Topics in PDFs [1035]

• Use Title Abbreviations [759]

Add a Table of Contents and List of Titles for PDF
For PDF outputs, you can set Paligo to add a table of contents (ToC) at the:

• Start of a publication

• Start of each topic (that has "children" or subsections)

• Start of an appendix

For combined language documents, you can have a separate table of contents for each different
language. Combined language documents have multiple languages all compiled into a single
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document. You can set Paligo to combine languages when you publish the content — there is
an option for combining languages on the Publish Document dialog).

You also have the option to add a list of titles (LoT), such as a list of figures. You can add these at
the start of a publication or appendix.

There are several different types of LoT that you can add, including:

• List of figures

• List of tables

• List of examples

• List of procedures

In the image shown here, there is a table of contents followed by a list of figures, a list of tables,
a list of examples, and a list of procedures. These are shown for one language only, and each list
shows the title and has a link and a reference to the page number.

NOTE
The lists only include figures, tables, examples, and procedures that have a title
element.

To add a table of contents and lists of figures, tables, examples, or procedures:

1. Select Layout and then edit the PDF layout you are going to use for publishing. Alternatively,
you can create a new PDF layout and edit that.

2. Select General > TOC.
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3. Use Generate TOC and list of titles - global setting to control whether Paligo can generate a
table of contents:

• Yes - Paligo can generate one or more table of contents and lists of titles.

• No - Paligo cannot generate any table of contents or lists of titles, even if the other settings
define terms for those.

4. Use Generate publication TOC and list of titles to control the table of contents and any lists
of titles at the start of the PDF.
Enter any combination of the following terms, separated by commas. Make sure there are no
spaces.

Term Description

toc Add a table of contents

title Add a title for the table of contents

figure Add a list of figures

table Add a list of tables

example Add a list of examples

procedure Add a list of procedures

nop No table of contents or lists of titles

For example:
toc,title,figure,table,example,procedure

5. When you publish documents with multiple languages, you can choose to combine the
languages (see Publishing Process [1068]). This creates a single PDF that includes all of the
languages. The Generate separate TOCs and lists of titles in a combined language PDF
setting lets you define what table of contents and list of contents elements you want to
include at the start of each language section.
Enter the terms for the elements you want to include or enter nop to have no TOC or lists for
combined language documents. You can use any of the terms shown in the table for step 4.

NOTE
Only enter terms in this setting if you are publishing a combined language
document.

If you are not publishing a combined language document, you may get
duplicate tables of contents if there are ToC and LoT settings in both of these
fields:

• Generate publication TOC and list of titles

• Generate separate TOCs and lists of titles in a combined language PDF
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6. Use the Generate appendix TOC and list of titles setting to control the table of contents and
lists of titles at the start of an appendix topic.
Enter the terms for the elements you want to include, or enter nop to have no TOC or lists of
titles for the appendices. You can use any of the terms shown in the table for step 4.

7. Use the Generate topic TOC setting to control the table of contents inside topics. When
enabled, you will get a table of contents at the top of any topic that has "child" topics
(subsections), and it shows the hierarchy of sections in the topic.
Choose Disabled to prevent your topics from having tables of contents.
Choose one of the Levels options to add tables of contents to your topics, and to choose
how many levels of topics will have them. Note that this setting defines which topics in the
structure will get a table of contents. It does not define the depth of the entries included in the
table of contents. The depth is set to 3 by default.
The table of contents inside topics (and any lower-level topics) shows up to three levels of
headings.

Level 1 is the most commonly used setting as this adds a table of contents at the top of any
topic that has "child" topics (subsections). If you select other levels, such as Levels 1-2, you will
also get a table of contents at the top of the topic and a table of contents at the top of the
second-level "child" topics, (as long as those "child" topics also have their own "child" topics).

8. Use the other settings in the General > TOC section to define the styling of the table of
contents.

9. Select Save.

When you publish with this layout, Paligo will generate tables of contents and lists of titles for your
PDF, based on your choices.

TIP
If the PDF output produces unexpected results, go to the settings in the layout
and check that there are no spaces in the entries, for example, no spaces
between toc and title. If there are spaces, the ToC and LoT will not work.
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Example 51. Table of contents for publication, no lists of titles, no topic ToCs

Let's say you want a PDF user guide with these characteristics:

• One language

• Table of contents with the title at the start

• No lists of titles

• No table of contents inside topics

• No table of contents or lists of titles for appendices

For this, you would use these layout settings:

Setting Value

Generate TOC and lists of titles - global setting Yes

Generate publication TOC and lists of titles toc,title

Generate separate TOCs and lists of titles in a combined language PDF nop

Generate appendix TOC and lists of titles nop

Generate topic TOC Disabled

Example 52. Table of contents for publication, list of titles included

Let's say you want a PDF user guide with these characteristics:

• One language

• Table of contents with the title at the start of the publication

• Lists of titles for figures and tables at the start of the publication

• No table of contents inside topics

• No table of contents or list of titles for the appendix

For this, you would use these layout settings:

Setting Value

Generate TOC and lists of titles - global setting Yes

Generate publication TOC and lists of titles toc,title,figure,table

Generate separate TOCs and lists of titles in a combined language PDF nop

Generate appendix TOC and lists of titles nop

Generate topic TOC Disabled
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Example 53. Table of contents for publication, list of titles included, ToC and
LoT for appendix

Let's say you want a PDF user guide with these characteristics:

• One language

• Table of contents and list of titles at the start of the publication

• Table of contents and list of figures and tables at the start of the appendix

• Tables of contents at the top of top-level topics that have subsections

For this, you would use these layout settings:

Setting Value

Generate TOC and lists of titles - global setting Yes

Generate publication TOC and lists of titles toc,title,figure,table,example,procedure

Generate separate TOCs and lists of titles in a combined language PDF nop

Generate appendix TOC and lists of titles toc,title,figure,table

Generate topic TOC Level 1

Note that for Generate appendix TOC and content lists, we have only included those lists that
we want to use. We have left out example and procedure.

Example 54. Separate table of contents and list of titles for each language,
combined language PDF

Let's say you want a PDF user guide with these characteristics:

• Multiple languages all in one PDF
This is set by choosing to combine languages on the Publish Document dialog when publishing.

• Table of contents and list of figures and tables at the start of the publication (combined
language)

• Separate tables of contents and lists of figures for each different language

• Tables of contents inside top-level topics that have subsections

• Table of contents and lists of figures and tables for the appendix.

For this, you would use these layout settings:

Setting Value

Generate TOC and lists of titles - global setting Yes

Generate publication TOC and lists of titles toc,title,figure
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Setting Value

Generate separate TOCs and lists of titles in a combined language PDF toc,title,figure

Generate appendix TOC and lists of titles toc,title,figure,table

Generate topic TOC Level 1

Note that Generate separate TOCs and lists of titles in a combined language PDF is set to
toc,title,figure. This tells Paligo to create a table of contents and list of figures at the start of
each language in the PDF. There will be separate tables of contents and lists of figures for each
language, rather than having them all mixed together at the start of the publication.

Example 55. Publication has no table of contents or list of titles, but the
appendix does have them

This is an unlikely example, but we have included it to show you that it is possible to include or
exclude any table of contents or list of titles.

Let's say that you wanted a PDF with these characteristics:

• One language

• No table of contents or list of titles at the start of the publication

• No table of contents inside a topic

• Table of content and list of figures, tables, and examples for appendices.

For this, you would use these layout settings:

Setting Value

Generate TOC and lists of titles - global setting Yes

Generate publication TOC and lists of titles nop

Generate separate TOCs and lists of titles in a combined language PDF nop

Generate appendix TOC and lists of titles toc,title,figure,table,example

Generate topic TOC Disabled

Note that Generate TOC and lists of titles - global setting is set to Yes and Generate
publication TOC and lists of titles is set to nop. This allows Paligo to generate tables of contents
and content lists in general, but prevents it from creating a TOC at the start of the publication.

Add a Table of Contents at the Start of Topics in PDFs
To help your readers find the information they need, you might want to include a table of contents
inside a "parent" topic. The reader can then use the table of contents to quickly see what is
covered in that section of your PDF and to find the specific section of interest.

Paligo Documentation

1035



To add a table of contents to a "parent" topic, use the Generate topic TOC setting. This is available
in the General > TOC settings in the PDF layout.

To find out how to use this setting as well as other features for tables of contents and lists of titles,
see Add a Table of Contents and List of Titles for PDF [1029].

Use Title Abbreviations

Abstract
Use the titleabbrev element to give your topics a shorter, alternative title.

The titleabbrev element is useful if you have long titles, but would prefer a shorter title in the
table of contents (PDF), contents bar (HTML5) and for cross-references.

When you publish content with titleabbrev elements, the table of contents (PDF), contents bar
(HTML5) and cross-references will use the titleabbrev text as the title, but the main topic will
continue to use the topic's title.

Example 56. Alternative title - Title abbreviations

For example, if you have a topic called "Configure the Wifi Connections for your ACME 100". The title
is quite long and can make the HTML5 content bar appear cluttered. For a neater look, you can
use the titleabbrev element to add the alternative title "Wifi".

To add an alternative title to a topic:

1. Select a topic or component in Content Manager [34].
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Paligo opens the content in the Editor [51].

2. Position the cursor between the title element and the first para element.

3. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

4. Enter titleabbrev and select it from the menu.

5. Position the cursor inside the titleabbrev element.

6. Enter the text for the alternative title.
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7. Select Save. 

Level Text and Image
The element Sidebar has been specialized in Paligo to serve both as a separate component
(called floating sidebar) and as a general-purpose reuse wrapper element, see Create an Informal
Topic [1109]. Find out more about Common General Elements [1891].

If you divide a sidebar in two columns, it is possible to level text and image for your PDF output.
This can be used for step by step instruction, where the numbered steps needs to include an
image.

Add a Two Column Sidebar
The default setting for a sidebar is one column with gray background, black frame and the text
above the image.

By adding a role attribute that divides the sidebar in two columns, the image and text inside it, will
be leveled with one another for PDF output. The role attribute will remove the frame, background
color and divide the sidebar in two equally sized columns. There is no option to individually adjust
the column width. Therefore it is necessary to adapt the text amount with the image size. If the
text amount exceeds the image height, it will flow over to the image column. You need to add one
sidebar for each text and image pair.
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To the left the default sidebar setting. To the right a two column sidebar.

NOTE
To make this work in HTML output, you have to assign the sidebar a role, like
"sidebar-css" and target that role with your CSS. Make sure to enable the role
attribute as "class name" in the layout for the HTML / HTML5 configuration. Learn
more about Role Attribute Values [1901].

This example code will give the text 75 % of the sidebar width.

.sidebar-css {
  padding: 6pt;
  width: 75%;
  display: flex;
}

The instruction below shows how to level text and image for PDF output.

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Place the cursor where the sidebar element is to be inserted in the topic.
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3. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

4. Enter sidebar and select it from the menu.

5. Add a title (optional), a para and a mediaobject by using the Element Context Menu [54].

6. Select the sidebar in the Element Structure Menu [52] below the toolbar.

7. Select Go to element.

8. Add the attribute role to the sidebar element.

9. Enter the value column-count: 2; column-gap: 10pt.
This results in two columns with 10 pt space between them.

10. Select Save. 

NOTE
You have to publish the topic to be able to see the result.

Use Numbering in Sidebars
To level text and image in a step by step instruction, you can use sidebars with ordered lists for
your PDF output. Let each step be represented by a new sidebar, because if you have several steps
in the same sidebar, you will only be able to level one image.
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1. Add a Two Column Sidebar [1038] for each step.

2. Select the para inside the first sidebar.

3. Select Ordered list in the toolbar. 

4. Repeat for all sidebars in the step by step instruction.

5. Select the orderedlist in the Element Structure Menu [52] for the sidebars representing
step 2 and forward.

6. Add the element attribute Continuation.

7. Set the value to Continues.

This results in sidebars with a continued numbering.

8. Select Save. 

NOTE
You have to publish the topic to be able to see the correct numbering.

Flow Text Around an Image
By using sidebars in combination with images, you can get columns that adjust around an image
for your PDF output.
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To the left a three column page. To the right a one column page.

Three Column Page
This instruction shows how to achieve a three column page where the text adjust around the
image for your PDF output. By inserting a sidebar followed by an image and two more sidebars,
you get an image next to a column with the following columns positioned below the image.

TIP
You can use sidebar borders when designing the page. After that you can remove
the border setting from the role attribute.

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Place the cursor where the sidebar element is to be inserted in the topic.

3. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].
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4. Enter sidebar and select it from the menu.

5. Add a title (optional), a para and a mediaobject by using the Element Context Menu [54].

6. Select the sidebar in the Element Structure Menu [52] below the toolbar.

7. Select Go to element.

8. Add the attribute role to the sidebar element.

9. Enter the value float: start; width: 2in; padding: 2pt; border: thin solid
black.
This gives a thin black border with 2 pt space between the sidebar border and text. The border
is optional, but the spacing will be used even if the border is removed. Depending on the
image size, you might have to adjust the width for both the sidebar and the image. If the
image is large, try with 25% or 50%.
If you replace the value:

• Solid with Dotted to get a dotted border.

• Thin with Thick to get a thick border.

• 2pt with 6pt to get more space (padding) between the text and the border. The spacing will
be used even if the border is removed.

• Black with Purple to get a purple border. You can replace it with any color.

10. Fill the sidebar with text.

11. Insert an image below the sidebar.

TIP
Add the element attribute:

• align to adjust the positioning of the image.

• width to set the image size.
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12. Insert two more sidebars, with the same role as above, after each other and fill them with text.

13. To make the last sidebar end the page, change the value float: start to float: end

The result is an image next to a column with the following two columns positioned below the image.

14. Select Save. 

NOTE
You have to publish or preview the topic to be able to see the result.

One Column Page
This instruction shows how to achieve a one column page where the text adjust around the image
for your PDF output. By inserting a sidebar followed by an image and a para, you get an image
next to a column with the text in the para positioned below the image.

TIP
This can also be done by using a two column sidebar, see Level Text and
Image [1038] .

1. Select a topic or component in Content Manager [34].

Paligo opens the content in the Editor [51].

2. Place the cursor where the sidebar element is to be inserted in the topic.
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3. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

4. Enter sidebar and select it from the menu.

5. Add a title (optional), a para and a mediaobject by using the Element Context Menu [54].

6. Select the sidebar in the Element Structure Menu [52] below the toolbar.

7. Select Go to element.

8. Add the attribute role to the sidebar element.

9. Enter the value float: end; width: 250pt; padding: 2pt; border: thin solid
black.
This gives a thin black border with 2 pt space between the sidebar border and text. The border
is optional, but the spacing will be used even if the border is removed. Depending on the
image size, you might have to adjust the width for both the sidebar and the image. If the
image is large, try with 25% or 50%.
If you replace the value:

• Solid with Dotted to get a dotted border.

• Thin with Thick to get a thick border.

• 2pt with 6pt to get more space (padding) between the text and the border.

• Black with Purple to get a purple border. You can replace it with any color.

10. Fill the sidebar with text.

11. Insert an image below the sidebar.
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TIP
Add the element attribute:

• align to adjust the positioning of the image.

• width to set the image size.

12. Press Alt  + Enter ⏎  (Windows) or Command ⌘  + Enter ⏎  (Mac) to display the Element

Context Menu [54].

13. Enter para and select it from the menu.

14. Fill the para with text.

The result is an image on the left side of the column with the para text below it.

15. Select Save. 

NOTE
You have to publish or preview the topic to be able to see the result.
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MS Word Styling
To publish Paligo content to Microsoft Word, you will need to use an MS Word layout. Paligo
includes a default MS Word layout and you can also create your own [1059].

You can use the settings in the MS Word layout to:

• Manage Taxonomy Filtering for MS Word [1050]

• Manage Scoped Filtering for MS Word [1050]

• Download the MS Word template for Paligo. This is a template that contains the styles that
Paligo can publish. You can open the template and edit the properties of the styles to meet your
own requirements. When you have finished, upload the template into the MS Word layout. For
details, see Style your MS Word Documents [1047].

Style your MS Word Documents
If you use Paligo to publish to Microsoft Word, there are two different ways to style the
documents:

• Publish to Microsoft Word and then style the document in Word
If you publish and then style your documents in Word, you can use any styles you like. But you
will need to style each document individually, each time you publish. This can be inconvenient if
you need to publish many documents or have to publish to Word regularly.

• Use the Paligo MS Word template and upload it to your MS Word layout
With this approach, you download the template and edit it in Word. When you have the styling
you want, save the template and upload it to an MS Word layout in Paligo. When you publish
using that layout, Paligo will apply the styles automatically.

NOTE
Paligo is designed to apply the style names that are already in the template.
It will not apply other styles. If you need different style names, or additional
styles, we can set those up for you as a project customization. This is a service
that Paligo provides for a fee (please contact customer support for details).

To use the Paligo MS Word template:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select General and then select the Download word template link to download the built-in
template in your browser.

3. Open the template in Word and edit the styles to match your preferences. It is easier if you
display Word's Styles panel for this, as you can see the styles in the template.
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NOTE
Do not change the names of the styles. Paligo can only map content to
styles that have the specific names that are set in the built-in template. But
you can change the appearance of the styles, for example, change the color
of Heading 1, increase its spacing and other styling attributes.

NOTE
Do not include content in your Word template as Paligo will not use it. All
content must come from Paligo topics.

4. Save your Word template as a .docx file. The name of the template file is not important, so you
can change it if you want to.

5. In Paligo, upload your customized template to the Template field on the layout editor.

6. Select Save. 

When you use this layout to publish to Word, Paligo will apply the styles in the template to the
content.

NOTE
You can also use the MS Word layout settings to enable or disable certain features
for MS Word outputs. For details, see MS Word Layout Options [1048].

MS Word Layout Options
The Microsoft Word layout has a hierarchy of options that you can use to control the MS Word
output. Each category of options is described below, with references to the articles that explain
them in detail.
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NOTE
For details on how to create or access an MS Word layout, see:

• Create a Layout [1059]

• Edit a Layout [1061].

General

Setting Description For details, see

Template Use the link to download the MS Word template for Paligo.

Apply your preferred settings to the styles that exist in the template and
then upload it back into the layout.

Paligo will then use that template file for styling the MS Word outputs it
generates when you publish with this layout.

Import from
Microsoft
Word [1793]

Classes and Attributes

Setting Description For details, see

Output taxonomies Use to control whether taxonomies are included in the
output. This has to be enabled for certain features, such as
taxonomy filtering.

Set Taxonomy Filter
Strategy [1181]

Taxonomy filtering Use to enable or disable taxonomy filtering and also to
choose the taxonomy filtering strategy.

Set Taxonomy Filter
Strategy [1181]

Enable scoped
profiling/filtering

Use to set Paligo to allow or disallow the scoped filtering
feature for the MS Word outputs.

Manage Scoped Filtering for MS
Word [1050]

Scoped Filtering [1144]

Download the Paligo MS Word Template
Paligo has a template that you can use for styling your Microsoft Word outputs. For instructions
on how to download the template, set its styles, and upload it back into Paligo, see Style your MS
Word Documents [1047].

Add Styles to the Paligo MS Word Template
The Paligo MS Word template is designed to work with the styles that are included. You can edit
those styles [1047], but do not change their names. If you add styles to it, Paligo will not recognize
them.

If you need extra styles in the template or need existing styles to be renamed, please contact
customer support. We can provide alterations to the template as a professional service. There is a
fee for this service.
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Upload the Paligo MS Word Template
If you have edited the Paligo Microsoft Word template, you will need to upload it to an MS
Word layout. Paligo will then apply the template styles when you publish with that layout. For
instructions on uploading the template, see Style your MS Word Documents [1047].

Manage Taxonomy Filtering for MS Word
You can use taxonomy tags for filtering at the topic level, instead of applying filters to elements.
But taxonomy tags will only work with your Microsoft Word outputs if you have enabled a
taxonomy filtering strategy in your MS Word layout.

To learn how to enable or disable taxonomy filtering in an MS Word layout, see Set Taxonomy
Filter Strategy [1181].

Manage Scoped Filtering for MS Word
With scoped filtering you can apply different filtering to your content depending on where the
content appears in your document. To use it with your Microsoft Word outputs, you need to
enable it in your MS Word layout. Once it is enabled, you can set up the filters, as described in
Scoped Filtering [1144], and then publish with the MS Word layout.

To enable scoped filtering in a Microsoft Word layout:

1. Select Layouts and then select a Microsoft Word layout to edit it. If you do not have a
Microsoft Word layout, you can create one based on the Default Word layout included in
Paligo.
To learn how to create a Word layout, see Create a Layout [1059].

2. Select Classes and attributes.

3. Set Enable scoped profiling/filtering to:

• Yes
To use the scoped filtering feature with your MS Word outputs (when using this layout for
publishing).

• No
To turn off the scoped filtering feature for MS Word outputs (when using this layout for
publishing).

4. Select Save. 

When you publish with this layout, Paligo will apply the settings. If you have enabled scoped
filtering, Paligo will allow the content to use the scoped filtering feature. To learn how to mark up
your content to use scoped filtering, see Scoped Filtering [1144].

SCORM Layout Editor Options
To publish SCORM content, use a SCORM layout. This layout is designed specifically for creating
SCORM outputs that you can later import into a Learning Management System (LMS) that supports
SCORM.

To learn how to create a SCORM layout, see Create a Layout [1059].
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When you have created a SCORM layout, you can access it by selecting Layout in the top menu
and then selecting your layout in the list. It opens in the Layout Editor, where you can edit its
settings.

There are two categories of SCORM layout settings (TOC and chunking and Version and
namespaces), and you can access these from the panel on the left.

TIP
Learn how to set the footnote appearance for HTML, HTML5 and SCORM output,
see Footnote Settings [1052].

TOC and chunking
The TOC and chunking settings are for controlling the levels in your content and also the table of
contents.

• TOC section depth
Use to define the number of levels in your table of contents. For example, if you set it to 4, the
table of contents will show links for topics that are at level 1, 2, 3, and 4 in your publication. The
levels are nested in your table of contents to reflect the publication structure. Any topics that are
at a lower level than that are not shown in the table of contents, but still exist in your output.
Default: 4.

• Chunk section depth
A chunk is a topic that is always on its own web page in the output. With the Chunk section
depth setting, you can set all topics to be a chunk up to a certain level in the publication. For
example, if you set the chunk section depth to 4, all topics from level 1-4 in your publication will
be on their own page.
Once the chunk section level is reached, any lower level topics will be added as subsections of
their immediate parent topic.
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NOTE
Each section element can have an xinfo:chunk attribute that controls
whether that section is a chunk. It can be set to yes, no, or default. This takes
priority over the Chunk section depth setting in your layout.

NOTE
If you have publications nested inside other publications (sub-publications),
each level of publication also counts as a chunking level. For example, let's
say you have a publication, a sub-publication, and four levels of topics in the
sub-publication. You want the topics to be chunked at two levels. For this,
you would set the Chunk section depth to 4 (1 for the publication, 1 for the
sub-publication, 1 for the top-level topics in the sub-publication, 1 for the
second-level topics).

Default: 4.

If you change the settings, select Save to apply your choices.

Version and namespaces
The version and namespaces category is where you can set the SCORM version and the Uniform
Resource Identifier (URI) for the namespaces.

• Scorm version
Enter the version number of the SCORM schema that you want to use.
You can find out more about SCORM versions at scorm.com.

• Scorm namespace uri
Enter the namespace uri for the SCORM schema.
For details on where to find your namespace uri, consult your target LMS documentation.

• adlcp namespace uri
Enter the namespace uri for the adlcp schema.
For details on where to find your namespace uri, consult your target LMS documentation.

Footnote Settings
Via the Layout tab in the top menu, you can set the footnote appearance for HTML, HTML5 and
SCORM output. The instruction below shows how this is done for HTML5 output.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Footnote formatting in the left menu.

4. Choose a number format for General footnotes from the menu.
Default value is 1.

5. Choose a number format for Table footnotes from the menu.
Default value is a.

6. Select if the footnotes are to be Enclosed in square brackets.
Default value is Yes.

7. Select Save.
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Layouts
A layout is a collection of settings that you apply to your content at the time of publication. Paligo
uses the layout settings to determine how to style and process your content when creating the
published output. These settings vary depending on the type of layout, for example, the PDF
layout has options relating to page borders and page breaks and the HTML layout has options for
uploading CSS and javascript files.

To publish your content, you have to associate the publication with a layout of the appropriate
type. So if you want to publish an HTML5 help center, you will need to have a HTML5 help center
layout.

Before you use a layout or create your own layout, we strongly recommend that you learn about
Layout Relationships - Base, New, Duplicate [1055]. This is because each layout can inherit settings
from another layout, and can cause unexpected results if you are unaware of the relationships.

To find out more, see:

• Layout Relationships - Base, New, Duplicate [1055]

• Create a Layout [1059]

• Edit a Layout [1061]

• Copy a Layout (Duplicate) [1063]

• Delete a Layout [1064]

• HTML5 Layout Editor Options [680]

• PDF Layout Editor Options [799]

• HTML Layout Editor Options [672].

NOTE
To find out about the layouts for integrations, such as Zendesk, refer to the
Integrations [1380] section.
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Layout Relationships - Base, New, Duplicate
When you publish Paligo content, you need to use a layout. The layout contains settings that affect
how Paligo converts your XML content into the output you want. For example, if you are publishing
to an HTML5 help center, you need to use an HTML5 help center layout. Its settings affect how
Paligo converts your XML into the HTML pages you see in the finished help center.

For layouts, you can choose to:

• Use one of the built-in layouts that are provided with Paligo. These cannot be customized, but
will create a working publication.

• Create your own layout, which you can customize to meet your own requirements.

• Duplicate an existing layout. This creates a copy of a layout, and can save time if you have a
layout that has most of, but not all, of the settings you need for your output.

In most cases, you will want to use a custom layout, either a new one, one you created earlier, or a
duplicate.

But before you use a layout, it is important to understand the hierarchical relationship between
the "base layout" and your custom layout or duplicate layout. Because both custom layouts and
duplicate layouts can inherit settings from a base layout, and these can affect the publication that
Paligo creates.

What is a Base Layout?
A base layout, as the name suggests, is a layout that forms the basis of another layout. It contains
the configuration for a certain type of output, such as a PDF or an HTML5 help center.

When you create a new layout, you give the layout a name and choose a base layout. This is where
the hierarchical "parent-child" relationship between layouts begins. The base layout defines what:

• Type of output you can publish with the layout

• Collection of settings are available in your new layout

• Default settings will be used for your new layout.

The same principle applies with duplicate layouts. These are copies of existing layouts, and when
you create a duplicate, it has the same base layout as the original version.

The main benefit of using a base layout is that you can save considerable time and effort when
configuring your publishing settings. You can apply the typical settings in the base layout and
these are passed on to the "child" layouts. In each "child" layout, you can then choose whether to
use the inherited value for each setting (default value) or override it with a different value.

NOTE
You can find out what base layout is associated with a custom layout on the
Layout List.

Relationship between Base and New
When you create a new layout, it has to be based on an existing layout (a base layout). This can be
either one of the built-in layout types or one of your existing layouts.

The new layout and base layout have a parent-child relationship, where:
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• The new layout inherits the settings of the base layout.

• In your new layout (the "child"), any setting that is set to Default inherits its value from the
base layout. So if you change the matching value in the base layout, the change will also apply
to the "child" layout.

• Any changes that you make in a "child" layout take priority. As soon as you change a setting
from Default to another value, that setting will no longer get its value from the base layout.

The following example shows how the relationship between a new layout and its base layout
works. But be aware that it is also possible to create complex chains of relationships, as a layout
can be a "child" of one layout, but a "parent" to another layout. We recommend that you try to
keep your layout relationships as simple as possible, so that they are easier to manage. But if you
do create a complex chain of layouts, always bear in mind that a default value is inherited from its
base layout.

NOTE
To learn how to create a new layout and associate it with a base layout, see
Create a Layout [1059].

Example 57. New Layout Inherits Settings from the Base Layout

Let's say you have no layouts in your Paligo instance. You want a PDF layout, so you create a new
one. When you create a new layout, you give it a name "ACME PDF" and you have to choose a
base layout. As you don't have any existing layouts, you choose the Default PDF option, which uses
Paligo's built-in PDF layout as the base. You cannot access the default built-in layouts.

Your new "ACME PDF" layout inherits the default settings from the built-in default PDF layout. You
can use the new layout as it is, or you can make changes to its settings. All of the settings that
show "Default" are inheriting the settings from the base layout.

You decide to edit the "ACME PDF" layout so that its Display language name on sidebar option is
set to Enabled.
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As soon as you save the layout, the Display language name on sidebar setting uses Enabled.
This setting no longer has any relationship with the base layout. It will only be affected by the base
layout if you were to set it back to Default.

Now you create another new layout. This time, you name the layout "ALT STYLES PDF" and you set
the "ACME PDF" as the base layout.

You edit the "ALT STYLES PDF" layout and see that the Display language name on sidebar setting
is set to Default. This means that it is inheriting the value from its closest "parent" base layout. In
this case, it is inheriting the value from the "ACME PDF" layout (and so it is actually Enabled as that
setting is Enabled in the base layout).

You go back and edit the "ACME PDF" layout and change the Display language name on sidebar
to Disabled. This change from Enabled to Disabled applies not only to the "ACME PDF" layout, but
also to all of the layouts that are based on it and have Display language name on sidebar to
Default. So changing it to Disabled also means "ALT STYLES PDF" inherits Disabled.
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You want the "ALT STYLES PDF" to display the language on the sidebar, so you change its Display
language name on sidebar to Enabled. At this point, the "ALT STYLES PDF" stops inheriting the
value of this particular setting from its base layout. So you have:

• ACME PDF (base layout) with Display language name on sidebar set to Disabled.

• ALT STYLES PDF (based on ACME PDF) but Display language name on sidebar is set to
Enabled. Display language name on sidebar is not affected by changes to that setting in
ACME PDF. Any changes to other settings in ACME PDF will still affect the matching settings in
ALT STYLES PDF, but only if they are set to Default in the ALT STYLES PDF.
The ALT STYLES PDF will still inherit changes from the ACME PDF for all settings that are set
to Default. It only stops inheriting from ACME PDF where you specifically set the value in ALT
STYLES PDF.

NOTE
When a layout setting is set to default, it always means it is inherited from its base
layout. The text on the interface that explains what the default value is refers to
the default value in the built-in layout types provided by Paligo.

Relationship between Base and Duplicate
A duplicate layout is a copy of an existing layout. It contains all of the same settings as the
original version, including the same:

• Base layout as the original version of the layout
If you make changes to the base layout, those changes will affect your duplicate layout too. This
only applies to those settings that are set to Default in your duplicate layout.

• Settings as the original version of the layout
The settings in your duplicate layout will initially be set to the same as they were in the original
version of the layout. But the duplicate is independent and is intended to be a starting point
for a different version. Any changes you make in the original do not affect your duplicate.

The idea with duplicate layouts is that you use them when you need a new layout, but already
have one that is very similar to what you need. By creating a duplicate of it, you can save time as
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it already has most of the settings you want. In the duplicate, you can make the changes you want
and know that they will not be affected by the original layout's settings.

TIP
To learn how to create a duplicate layout, see Copy a Layout (Duplicate) [1063].

Create a Layout
Layouts contain a variety of settings that you can use to customize your output. There are
templates prepared for HTML, HTML5, FLUIDTOPICS, PDF, MSWORD, SCORM, ELEARNING and
XML. You can use Paligo's built-in layouts or you can create your own.

• PDF layouts have an editor where you select the properties you want for a range of different
content types, similar to how you create styles in Microsoft Word. To find out more about the
settings, see PDF Layout Editor Options [799]

• HTML layouts contain many publishing options for customizing your content, including a CSS
upload feature. This is where you can upload your own CSS and apply rules that will take priority
over any settings in the layout. To find out more about the settings, see HTML5 Layout Editor
Options [680].

NOTE
If you open the layout tab for the first time, the list will be empty because there
are no created layouts.

To create a layout:

1. Select the Layout tab in the top menu.
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Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select Create New Layout in the lower left corner. 

3. Enter a Layout title.

4. Select an Output format from the menu.
The output format is the base layout for your new layout that defines:

• Type of content (HTML, HTML5, FLUIDTOPICS, PDF, MSWORD, SCORM, ELEARNING, XML) that
can be created with the template.

• Where the default values are retrieved. If you set a value to Default in your new layout, it
means the value is retrieved from the chosen base layout, see Layout Relationships - Base,
New, Duplicate [1055].

NOTE
Already created layouts can also be chosen as base layout.

5. Select OK.
Paligo creates your new layout.

6. Select the new layout in the list to open it in the Layout Editor [57].

TIP
You can copy the URL from the new dialog and paste it into a browser tab.
This is sometimes easier to work with, especially if you frequently switch
between your content and the layout settings.

7. Use the Layout Editor to choose the publication settings. Paligo will apply these settings when
it converts your XML content into the output format.

• For PDF settings, see PDF Layout Editor Options [799].

• For HTML5 settings, see HTML5 Layout Editor Options [680].

• For HTML settings, see HTML Layout Editor Options [672].
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NOTE
You can apply common styling features by using the layout settings and uploading
your own CSS and javascript (for HTML outputs only).

If you want more advanced customization, including customizing the underlying
XSLT, contact Paligo customer support with details of what you want to achieve.
We can then look into what is required and provide you with an estimate for cost
and timescale.

Edit a Layout
You can use the Layout Editor to define publication-level settings that are applied when your
publish your content. The options available to you vary, depending on the type of layout.

• PDF layouts have a wide range of settings for styling and customizing your content. We have
designed them to make PDF styling simpler, so you can customize your PDF content without any
XSLT programming skills.

• HTML layouts also have settings for styling and customizing your content, and they also allow
you to upload your own CSS stylesheets and javascript files. This means you can apply powerful
styling changes using CSS or javascript, just like a website.

• Integration layouts, such as Zendesk layouts. These are HTML layouts with some added
functionality that is specific to the integration applications.

NOTE
If you need more advanced XSLT customization, you can request a customization
from Paligo. On the Business plan or higher, you also have WebDAV access,
allowing you to make simple edits to such a customization.

Note that if you want to do any XSLT customizations from scratch, you will need
an onboarding developer package. Please contact your account manager if you
are interested in that.

To edit a layout:

1. Select Layout.
Paligo displays a list of the layouts in your Paligo instance.
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2. Select the layout that you want to change. Paligo opens the layout in the Layout Editor.

The Layout Editor has three sections. On the left is a list of categories (1). When you select a
category, the settings that are available for that category appear in the middle section (2). You
can make your changes there.

• On the left is a list of categories (1). When you select a category, the settings that are
available for that category appear in the middle section (2).

• The middle section (2) shows the settings that are available for the selected category (1). You
can use these settings to make your changes.

• The preview area (3) is for PDF layouts. You can preview any publication. If you want to
preview topics that are not in a publication, you can add them to a temporary publication
and then view that.

NOTE
If your PDF preview does not display, it may be due to an issue with the
Adobe Reader plug-in. To fix the problem, access your browser's settings,
turn off the Adobe Reader plug-in and then switch back to the default PDF
preview. Firefox, Chrome, and Safari all have their own built-in PDF viewers.

3. Use the categories and settings to make your changes. When making changes it is important
to understand what happens if you set a value to Default.
Every layout that you create has a base layout. This can either be one of the built-in layouts or
a layout that's been created in your Paligo instance. The base layout provides the values that
are used when you set a value to Default.

• When you edit a layout and set a value to Default, it means "inherit this value from the base
layout".

• If you edit a layout and set a value that is not Default, it means "use this value and do not
inherit from the base layout".

To learn about the relationship between base layouts and new layouts, see Layout
Relationships - Base, New, Duplicate [1055].

4. When you have made your changes, select Save.
When you publish, you need to choose a layout for the publication. Your saved layout will be
available to choose for the relevant publication type. For example, if you edited a PDF layout,
you will be able to choose it when you publish a PDF output.
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Copy a Layout (Duplicate)
If you have an existing layout that has most of the settings you want to use for a new layout, you
can copy it. This can be quicker than creating a new layout from scratch. When you copy a layout,
you create a "duplicate" that is a completely separate layout that has all the same settings and
values as the original layout, but no ongoing relationship with it.

This means:

• Changes you make in the original layout have no effect on the duplicate

• Changes you make in the duplicate have no effect on the original

• Changes you make in the base layout of the original, can also affect the duplicate. This is
because the original layout and the duplicate both have the same base layout. And so any
settings that are set to "default" will inherit the values for those settings from the base layout. To
find out more see Layout Relationships - Base, New, Duplicate [1055].

NOTE
If you want a layout that does inherit default settings from another layout, create
a new layout [1059]rather than a duplicate.

To create a duplicate of a layout:

1. Select Layout.

2. In the list, find the layout that you want to duplicate and select its option menu ( ... ).

3. Select Duplicate.
Paligo creates a copy of the layout you selected. The copy has the same name as the original
layout, but with "copy <number of copy>" added.

Change the Base Layout
When you create a layout, you have to give it a name and set its base layout. The base layout
defines what type of content the new layout can create and it also provides the default values
for the new layout (see Layout Relationships - Base, New, Duplicate [1055]). If, for some reason,
you need one of your layouts to use a different base layout, you can rebase it. Rebasing means
associating a layout with a different base layout of the same type. For example, if you created
a PDF layout based on the built-in default PDF layout, you could rebase it on one of your own
custom PDF layouts.

NOTE
You cannot rebase a layout on a completely different type of layout. For example,
if you have a PDF layout, you can only rebase it on the various PDF layouts in your
Paligo instance. You cannot rebase it on an HTML5 layout or any other type of
layout.

To rebase a layout:

1. Select Layout.
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2. In the list, find the layout that you want to rebase and select its option menu ( ... ).

3. Select Rebase and then choose the new base layout from the dropdown list. Select OKto
confirm.
Paligo rebases the layout. Your layout will now inherit its default settings from the base layout
you have set.

Delete a Layout
If you have a custom layout that you no longer use, you can delete it from your Paligo instance.
Once it is deleted, it is unavailable to Paligo users and so you will need to publish with one of the
built-in layouts or one of your other custom layouts.

To delete a layout:

1. Select Layout.

2. In the list, find the layout that you want to delete and select its option menu ( ... ).

3. Select Delete and then if you are sure you want to remove it, select Confirm.

Cannot Delete a Layout
If Paligo will not allow you to delete a layout, it is most likely because the layout is a base layout.
This means that other layouts rely on it for their default settings.

All layouts are associated with a base layout. You cannot delete a base layout until all of those
associations are removed.

For example, let's say you have an "ACME PDF 1" layout. You then create an "ACME PDF 2" layout
and base it on "ACME PDF 1". The two layouts now have a relationship. If you try to delete "ACME
PDF 1", Paligo will reject the deletion, as "ACME PDF 2" relies on "ACME PDF 1". To delete "ACME
PDF 1" you must first delete "ACME PDF 2" so the relationship and dependency is gone.

Use a Common Image Folder
The default layout setting for how images are stored in Paligo HTML outputs, makes one separate
image folder per language. If you are using some images for all languages, it is possible to reduce
the size of the publication by using one common folder instead. This option is set in the layout
configuration for HTML or HTML5.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Images in the left menu.
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4. Scroll down to Per-language image folders.

5. Select Common from the menu.

6. Select Save.

Style a Table
In Paligo, content and structure is separate to styling, so you do not apply styling directly to your
tables. Instead, you can set the styling:

• In a PDF layout. There are several sets of table styles so that you can apply more than one style
to each publication. To find out more, see Table Styles for PDF [976].

• In a CSS file that you upload to an HTML/HTML5 layout. This applies for HTML outputs.
You can use CSS to style:

• All tables in the same way [1065], for example, you could set all tables to have dotted borders

• Individual tables [1066]. With this approach, you first need to use the tabstyle attribute to give
the table a unique class name. Then, you can set specific styles for that class name in your
custom CSS.

Apply Styles to All Tables (HTML)
To create styles that will apply to all of your tables for HTML outputs:

1. In Paligo, select Layout in the top menu and then edit the HTML layout that you are going to
use. Make sure that in Table styles, Output classes for styling of tables is set to Enable.

2. Select Save.

3. Publish your content with the default styling for tables in place, and then open the output in
your browser.

4. Use the browser's inspection tools to identify the class for the part of the table you want to
style. For example, if you want to style the header row of your tables, use the inspection tool
to find the table header cells in the underlying HTML. You will see that each header cell is
styled by .th in the CSS.
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NOTE
To find out more about using browser inspection tools, see Branding your
HTML Outputs with CSS [654].

5. Use the browser's developer tools to add new styling for the class. This will let you see what
effect your changes will have when you add them to a CSS stylesheet. For example, if you want
all table header rows to have a blue background color, you could enter:

.th { 
background-color: #557dc4;
}

6. When you are happy with the table stylings you have made, use a code editor or text program
to create a new CSS file. Then add your custom styles to that and save it with the .css file
extension.

7. When you have created a custom CSS stylesheet to style your content, upload it to an HTML
layout in Paligo. Then, when you publish with that layout, your content will use your custom
CSS rules. Your CSS stylesheet will take priority over the Paligo CSS stylesheet.

Apply Styles to Selected Tables (HTML)
To create styles that will only apply to certain tables for HTML outputs:

1. In Paligo, select Layout in the top menu and then edit the HTML layout that you are going to
use. Make sure that in Table styles, Output classes for styling of tables is set to Enable.

2. Select Save.

3. Open the topic that contains the table you want to style.

4. Select the table and then in the Element Context Menu, select the table or informaltable
element and then select Go to element.

5. In the Element attributes section, add the tabstyle attribute.

6. Enter a name for the tabstyle attribute value. This name will be used as a style name in the
HTML output and you will use it in your CSS. It is a good idea to use a name that is easily
identifiable. For example, you might use "Instruments" for tables that contain details about
technical instruments.

7. Select Save.

8. Publish your content and open it in a browser.

9. Use the browser's inspection tools to find the class for your table. This should match the name
you have given to the tabstyle attribute.
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NOTE
To find out more about using browser inspection tools, see Branding your
HTML Outputs with CSS [654].

10. Use the browser's developer tools to add new styling for the table class. For example, you
could give an "instruments" table header cells that have a yellow background, like this:

.instruments th {
background-color:#ffff00;
}

11. When you are happy with the table stylings you have made, use a code editor or text program
to create a new CSS file. Then add your custom styles to that and save it with the .css file
extension.

12. When you have created a custom CSS stylesheet to style your content, upload it to an HTML
layout in Paligo. Then, when you publish with that layout, your content will use your custom
CSS rules. Your CSS stylesheet will take priority over the Paligo CSS stylesheet.
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Publishing

Paligo makes it easy to publish your content to many different output formats, such as PDF (print),
HTML, online help, Mobile / HTML5, MS Word, help desk portals (Zendesk, Freshdesk, Salesforce
Knowledge), SCORM (for LMS eLearning systems) and so on.

More formats are available on request, such as JavaHelp, manpages, HTML5 slides.

NOTE
There are a number of templates (layouts) ready-made for each output format.
But you can customize them just as you please using the Layout Editor. If that
is not enough, you can also purchase customizations from Paligo, in which case
there are very few limitations to the output you can get.

Publishing Process
You can publish entire publications or individual topics. Whether you are publishing to PDF, HTML
or another format, the steps you need to take are the same.

IMPORTANT
Before publishing the publication, make sure to change the status for the
publication to Released. This will create a snapshot of the version that is to be
published. Read more about the Release Process [1626].

a. Select the type of output you want to publish, for example, PDF or HTML5.

b. Choose the layout that you want to use for publishing. The layout contains settings that tell
Paligo how to process and style your content for publishing. You can choose from any of the
available layouts for the selected publication type (either the built-in layouts or custom layouts
that users have created in your Paligo instance).
To learn more about layouts, see Layouts [1054].

1. Select the Dotted menu (...) for the topic or publication in Content Manager [34].

2. Select Publish. 

Paligo displays the Publish document dialog.
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3. Choose the Languages that you want to publish.

If you do not have any translations, you can only select the original language (source
language).

If you have multiple languages translated and approved, you can select which ones to include.
Paligo will publish each language as a separate output.

NOTE
For PDF output you can publish them as one multilingual publication, check
the Combine selected languages box.

4. If you have marked up your content to use filters (profiles) [1141], use the Profiling
attributes section to choose which filters to apply. If you do not want to use filters, ignore this
step and continue from the next step.

To apply filters for publishing, select Edit to display a list of the filter properties that are used.

Choose the filter values that you want to include. Leave the fields blank for the filters that you
do not want to apply.
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When you select OK, the chosen profile settings are shown in the Profiling attributes section.

NOTE
With the filter settings, you tell Paligo which content to include. For example,
if you have used an outputformat filter, you could mark up some content to
have a PDF value and other content to have an HTML value. In the publishing
settings, if you set Output Format to PDF, it will include the content that
has an outputformat:PDF filter and will exclude any content that has an
outputformat:HTML filter (or any value other than PDF).

5. If you have used variables [1186] in your content, use the Variables section to choose which
variants to use for the publication.If you do not want to use variables, ignore this step and
continue from the next step.

To choose the variants, select Edit to display a list of variable sets that are used. For each
variable set, there is a field that you can use to choose which variant to apply. If there are
variable sets that you do not want to apply to your publication, leave the fields for those
empty.
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6. Use the Upload output section to set Paligo to publish directly to an integration, such as
Github or FTP. For details on these settings, refer to the Integrations documentation [1380].

7. Use the Output filename section to control the filename.

By default, Paligo will use the filename syntax that is defined in the System Settings [32].

To change the information included in the filename, enter your preferred format in the
publishing settings. Default is: ID-Title-Format.

You can use:

• ID - The ID of the document.

• Title - The title of the publication or topic that you are publishing.

• Format - The name of the output format, for example, PDF or HTML5.

• Edit date - The date that the publication or topic was last edited.

• Branch label - The text from the branch label for the publication or topic. This only applies
if your content has been branched and it has a branch label. For details, see Add or Edit
Branch Labels [1648].

• Unique value - A random string of characters, generated by Paligo, that is added to the
filename to make it unique. This can stop the file from being overwritten by later publishes
of the same document.

TIP
If you type @ into the field, Paligo displays a list of the available values and
you can select from the list. To remove a value, click in it and use the delete
key or backspace key to remove all of its characters.
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NOTE
The filename shown in the top-right corner is a preview of the filename that
Paligo will use when you publish.

8. Set the Optional Parameters (leave unchecked if you do not want these features):

• Save the output in Paligo - Choose whether you want Paligo to add the published output
to the Resource View [68]. Check the box to save the zip file. Clear the box if you want Paligo
to only download the published output file in your browser.
If you chose to save the output in Paligo, you can download the zip file from the Resource
View. Reveal the Resource Detail Panel for the publication or topic and then download the
zip file from the Saved Outputs tab.

• Email me - Check this box if you want Paligo to send you an email when the publication
is ready. This is useful if you have very large publications that can take a longer time to
process and publish.

• Make debug build - Check this box if you want Paligo to include a log file and link report.
If there is an issue with your content, Paligo support may ask you to enable this feature so
that they can use the log files to investigate.

TIP
Every time you publish, there will also be a link in the Dashboard feed to
download the published content.

9. Select Publish Document to start publishing. Paligo will then process your content and apply
your layout and publishing settings. The time that this takes can vary depending on how much
content you are publishing (the more content there is, the longer it takes).
A progress bar shows you how much of the processing Paligo has completed and how much is
left to do. When the processing is complete, a notification is shown.

Paligo provides your published output as a zip file that downloads in the browser. You can find
it in the downloads folder on your computer (unless you have altered your browser's settings
to store downloaded files somewhere else).
To make the content available online, first unzip the file. You can then use the file locally or
you can use an FTP client, such as Filezilla, to upload the unzipped content to a web server.

TIP
You can also save your publishing settings [1076] so that you can select the saved
version instead of re-applying all the filters, variables, etc., each time. Any settings
you save can also be used for Batch Publishing [1073].
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Batch Publishing
Abstract

Batch publishing lets you publish multiple publications at the same time, with a single action. It is
more convenient than starting each publication process manually.

Batch publishing lets you publish multiple publications at the same time, with a single action. It is
more convenient than starting each publication process manually, and is especially useful when
you need to update many outputs at the same time. For example, if you publish to Zendesk and
want to update several categories at once. In this scenario, you can set up a publication for each
category and then use batch publishing to publish to them all with a single click of a button.

To use batch publishing:

1. For each publication that you want to publish:

a. Select the options menu ( ... ) for the publication.

b. On the Publish Document dialog, apply the publishing settings that you want to use.
These include the languages, filter profiles, variables, etc.

c. Select Save Settings and then give the saved publishing settings a name.

d. Close the Publish document dialog without publishing.

2. Select your profile, and then select Batch Publish from the menu. Alternatively, select the
Dashboard menu, and then select the Batch Publish icon.
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3. On the Batch Publish dialog, there is a list of all the saved publishing settings. Check the box
for the publications you want to include when you batch publish. Leave the checkbox clear for
any publications that you do not want to publish.

4. Select Publish.
Paligo will publish each publication in turn, using the saved publication settings.

Broken Links Report
Paligo keeps track of all relations between files automatically, including link references. This
prevents you from breaking links as you could on a file system by moving files around or renaming
them.

But it is still possible to get broken links in a published output if you have links that point to
content in other publications. This is because the target link is not included in the publication that
you have published and these links will be broken.

NOTE
Paligo recommends that you always check for broken links before you Release
Content [1627].

To produce a link report:

1. Select the Dotted menu (...) for the publication you want to check.

2. Select Publish. 

3. Make your publish settings.

4. Check the box Make debug build.
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5. Select Publish document.

6. In the output folder, look in the tmp folder to find an HTML file that starts with "linkreport"
and then the name of the publication.

7. Double-click to open the Link Report file in a browser. You will see something like this:

The report contains:

• The title of the topic containing the broken link(s), as well as its UUID and Resource ID.

• Buttons Edit and Find to either directly open and edit the topic or to locate it in the
Resource View [68].

• A broken link reference if the reference is to another topic and it exists, then the UUID will
be hyperlinked to locate the target topic directly.
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NOTE
The attempt to locate the target topic is based on the link reference format.
There is no guarantee it exists though. If for example the target topic has
been deleted, then the link to try to locate it will not work.

8. Resolve the broken links.

9. Republish with a new link report to verify that no broken links remain.

Publishing Settings
You can store your preferred publication settings so that you do not have to enter them manually
each time you want to publish. Once you have saved the settings, you can select them from the
Saved Settings tab, and Paligo will automatically apply them to your publication. This is much
quicker than applying each setting individually each time you publish.

TIP
Paligo also has a Copy Publishing Settings [1078] feature, which you can use to
copy the saved settings from another publication. This can also save you time
when you are publishing Paligo content.

To use saved publishing settings, you (or another user) must first enter some settings and Save
Publishing Settings [1076] . Once they are saved, they are added to the Saved Settings tab (for the
publication you are publishing, not all publications). From there, you can Apply Saved Publishing
Settings [1078] by selecting the saved settings and then publishing.

Save Publishing Settings
To create and a save publishing settings:

1. Select the options menu ( ... ) for a publication and then select Publish.
The Publish Document dialog appears.
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2. Use the Publish Document dialog to apply the publishing settings you want to use. For
example, you can choose which profiles (filters) to apply and which variables to use.

3. Select the Save Settings button and then enter a name for your collection. It is important
to give the settings a meaningful name so that other users can easily understand what the
settings are for. You can then close the Publish Document dialog.
Your choices for the publishing settings are now saved for this publication. You can Apply
Saved Publishing Settings [1078] from the Saved settings tab (when you publish this
publication).

NOTE
To use the saved settings in a different publication, Copy Publishing
Settings [1078].
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Apply Saved Publishing Settings
To save time when you publish content, you can apply saved publishing settings. These are a
collection of settings made previously by you or another Paligo user.

1. Select the options menu ( ... ) for a publication and then select Publish.
The Publish Document dialog appears.

2. Select the Saved Settings tab.

3. Check the box for the publishing settings that you want to use.
If there are no saved settings that meet your requirements, you can Copy Publishing
Settings [1078]. These are settings that have been used for publishing, but have not been
saved by a user.

4. To apply the saved settings, select Publish Document.

Copy Publishing Settings
Instead of entering the publication settings manually each time you publish, you can copy saved
settings from another publication. This can save you time and help avoid repeat work if you have
many publications that need to use the same, or similar, publication settings.

Example 58. Copy Publishing Settings from One Publication to Another

Let's say you have an "ACME 100 User Guide" and for that, you always use the same publishing
settings. You have those settings saved, but the save is only available for the "ACME 100 User
Guide".

You then create an "ACME 200 User Guide" and you want it to use the same publication settings as
the "ACME 100 User Guide".

To do this, you go to publish the "ACME 200 User Guide" and copy the saved publication settings
from the "ACME 100 User Guide".You can then apply the copied settings, rather than enter them
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all again manually. The copy settings are also added to the list of saved settings for the "ACME 200
User Guide", so you can access them from there in future.

To copy publishing settings from another publication:

1. Select the options menu ( ... ) for a publication and then select Publish.
The Publish Document dialog appears.

2. Select the Saved Settings tab.

3. Select Copy Setting.
Paligo provides you with a list of saved publication settings from other publications.
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4. Select the publication setting that you want to copy.

5. Use the Reuse the selected setting checkbox to control how the copy is used.
If you check the box, the copy will be a reused version of the original. Any changes you make
to the copy will also be made to the original.
If you clear the box, the copy will be completely separate to the original. Any changes you
make to the copy will not affect the original.

6. Select OK to make the copy. It is added to the list of Saved Settings.

TIP
The copy has an options menu ( ... ) that provides access to a menu with
options for renaming, editing, and duplicating the copy.

7. To apply the copied publication settings, select its checkbox and then select Publish
document.

Customize Output Filename
There are two ways to control the filename that Paligo generates for PDF and ZIP files:

• If you are an Admin user, you can create an output filename template in the System Settings.
Paligo will use this template by default for PDF and ZIP outputs. But users can choose a different
filename structure when they publish.
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To learn how to set up the default output filename format, see Set the Default Filename for PDF
and ZIP Files [32].

• If you are an Admin, Author, or Publisher, you can add a filename template when you publish.
You do this on the Publish document dialog, in the Output filename section. Paligo will use the
Publish document dialog settings instead of the system settings.

To learn how to set the output filename format in the publishing settings, see Publishing
Process [1068].

Publish Your Content Online
There are several ways to publish your content online:

• Use an FTP client
You can use the FTP client that is built into MacOS finder or Windows File Explorer. Alternatively,
you can use a dedicated FTP client application such as Filezilla.

• Use SCP (secure copy)
You can use SCP to send files securely. This uses the SSH protocol for authentication and data
transfer.

• Use an upload interface
Some hosting applications have an upload interface that you can use to upload the files directly.
For example, if you publish a SCORM output, you could publish it to Docebo LMS in this way.
Docebo LMS has an interface for uploading content.
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NOTE
Paligo has integrations that allow it to publish directly to other systems. For
example, the Zendesk integration allows Paligo to publish directly to Zendesk.
With these, you also get a zip file that downloads in the browser when you
publish, but you do not need to upload it.

Typically, you will need to unzip the Paligo output first and then upload the content of the "out"
folder. The files for publishing are always in the "out" folder.

In some cases, you can upload the zip file instead. This varies depending on the target
environment for your content. To find out, refer to the target environment's documentation.

Publish to a Git Pipeline or Web Server
When you publish content, by default the output is downloaded in a zip file. There are several
options for how to publish that content live to your end users.

Publish Manually to Your Web Server
The contents of the default zip download can be uploaded to any web server of your choice, for
example via an FTP client. To do so, simply upload the contents of the out folder in the zip file to
your server.

Publish to Amazon Web Services S3 (Amazon S3)

Paligo has Continuous Integration (CI) support for Amazon Web Services S3 (Amazon S3). This
means you can create content in Paligo, such as PDFs or an HTML help center, and publish it to
Amazon S3 so that it is instantly live to your end-users.

See Amazon S3 Integration [1404] for more on how to do this.

Publish to a BitBucket Pipeline

Paligo has Continuous Integration (CI) support for Bitbucket Cloud. This means you can create
content in Paligo, such as PDFs or an HTML help center, and publish it to Bitbucket Cloud. When
the content is uploaded to Bitbucket, you can unzip it (automatically if you so choose) to make it
instantly available live to your end users.

See Bitbucket Integration [1415] for more on how to do this.

Publish to a GitHub Pipeline
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Paligo has Continuous Integration (CI) support for GitHub. This means you can create content
in Paligo, such as PDFs or an HTML help center, and publish it to GitHub. When the content is
uploaded to GitHub, you can unzip it (automatically if you so choose) to make it instantly available
live to your end users.

See GitHub Integration [1447] for more on how to do this.

Publish Directly to Your Web Server Via FTP

With the FTP (File Transfer Protocol) integration, you can publish your Paligo content, such as an
HTML5 help center, directly to your web site.

See FTP Integration [1429] for more on how to do this.

Publish to Your Help Desk Portal
Paligo can publish content directly to help desk knowledge base portals, like Zendesk, Salesforce,
ServiceNow, and more. To find more information about publishing to each of these, see the
topics for each of them in the Integrations section, such as:

• Zendesk Integration [1528]

• Salesforce Knowledge Integration [1475]

• ServiceNow Integration [1490]

• Freshdesk Integration [1434]

NOTE
This feature requires that you have integrated with one of the supported help
desk portals. See Connect Integrations [1880].

Before publishing to your live help desk knowledge base, always test carefully! We
recommend testing to a test trial account, or to a category that is marked as draft,
so it's not visible to your end users until you know everything is working as you
want it to.

Paligo will create articles in your help center on initial publish, and update them
on subsequent publishing. But it will not delete any articles, should you remove
topics that are on the level that become articles.

Publish to Other Output Formats
Besides the main output formats enabled by default, it is possible to publish to even more
formats. Examples are HTML5 slide shows, JavaHelp, manpages (for command line help), etc.

If you need an additional output format, please contact support to see if it is already available and
it can be enabled for you. Some formats can also be added as customizations (paid service).

Publish to an LMS
You can create content in Paligo and publish it to a Learning Management System (LMS). For
details on how to create your course in Paligo and publish it to your LMS, see eLearning [530].
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Publish to SCORM (Basic)
You can publish Paligo content as a SCORM output. SCORM is an interchange format for importing
into Learning Management Systems (LMSs) and eLearning platforms.

Paligo's SCORM (basic) output is for publishing regular content to an LMS. It is available on all
plans, but does not support progress tracking or interactive features such as quizzes.

NOTE
Paligo also has a more powerful SCORM output that supports progress tracking,
quizzes, and more. It is currently in beta, so if you would like to use it, please
contact customer support so they can enable it on your instance. it is available on
the Enterprise plan and on trials.

The following instructions explain how to use the basic SCORM support. It covers publishing Paligo
content to SCORM and then importing that content into an LMS. We have used the free LMS
Moodle Sandbox environment as an example, but you can use a different LMS if you prefer.

1. Publish the publication you want to import into the LMS (such as Moodle).

2. Use a SCORM layout to publish a publication.
To learn how to create a SCORM layout, see Create a Layout [1059].
For details on the SCORM layout settings, see SCORM Layout Editor Options [1050].
To learn how to publish content, see Publishing Process [1068].

3. Unzip the published content.
Inside the zip file, in the out folder, there is another zip file. This is the one you will import.

4. Log into the Moodle sandbox using the supplied test login credentials "admin" / "sandbox".

5. Select Add an activity or resource. Select "SCORM package" in the dialog that pops up:

6. In the next view, Adding a new SCORM package, give it a name and description.

7. Drag and drop the zip file in the out folder of your published content. Then click Save and
display.
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NOTE

• The SCORM output contains a simple Table of Contents (TOC). In Moodle, the
TOC is auto-created, so you'll have duplicate TOCs. In such a case you would
use CSS to hide the included TOC:

div.toc{
  display: none;
}

Other LMS systems do not auto-create the TOC, which is why one is included.

NOTE
The initial styling is quite basic and is provided by Moodle and also CSS that's
included in the Paligo conversion. Whatever LMS you publish to, you will need a
customization to make it look good.

Publish to MS Word
Normally in single-sourcing environments like Paligo, you would publish to PDF if you need
documents for printing. But there may be situations where it is useful to publish to Microsoft
Word instead of PDF. For example, if you want to create draft Word documents that can then be
revised for other purposes.

NOTE
The MS Word output is designed for creating draft documents that you will
publish and then further edit in Word. It is not a primary output in Paligo.

For printed documents, we recommend that you use PDF where possible. This is
because there are more options and capabilities when publishing from Paligo to
PDF.

To publish to MS Word:

1. Prepare your content in Paligo, making sure you add your topics to a publication.

2. Create an MS Word layout or edit an existing one.
For details, see Create a Layout [1059] and Edit a Layout [1061].

3. Edit the MS Word layout.

• Make sure the layout has a suitable template in place. If you leave the template setting
empty, Paligo will use the default MS Word template. To apply your own styling, you
will need to download the template, edit it, and then upload it (see Style your MS Word
Documents [1047]).

• Use the layout settings to enable or disable taxonomy features [1050] and scoped
filtering [1050] for your MS Word output.
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4. Select Save. 

5. Select the Dotted menu (...) for the topic or publication in Content Manager [34].

6. Select Publish. 

Paligo displays the Publish document dialog.

7. Select Word.

8. Select the MS Word layout that you want to use for publishing. This could be the Default
Word layout or a custom MS layout that you have created.
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9. Choose the Languages that you want to publish.

If you do not have any translations, you can only select the original language (source
language).

If you have multiple languages translated and approved, you can select which ones to include.
Paligo will publish each language as a separate output.

NOTE
For PDF output you can publish them as one multilingual publication, check
the Combine selected languages box.

10. If you have marked up your content to use filters (profiles) [1141], use the Profiling
attributes section to choose which filters to apply. If you do not want to use filters, ignore this
step and continue from the next step.

To apply filters for publishing, select Edit to display a list of the filter properties that are used.

Choose the filter values that you want to include. Leave the fields blank for the filters that you
do not want to apply.
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When you select OK, the chosen profile settings are shown in the Profiling attributes section.

NOTE
With the filter settings, you tell Paligo which content to include. For example,
if you have used an outputformat filter, you could mark up some content to
have a PDF value and other content to have an HTML value. In the publishing
settings, if you set Output Format to PDF, it will include the content that
has an outputformat:PDF filter and will exclude any content that has an
outputformat:HTML filter (or any value other than PDF).

11. If you have used variables [1186] in your content, use the Variables section to choose which
variants to use for the publication.If you do not want to use variables, ignore this step and
continue from the next step.

To choose the variants, select Edit to display a list of variable sets that are used. For each
variable set, there is a field that you can use to choose which variant to apply. If there are
variable sets that you do not want to apply to your publication, leave the fields for those
empty.
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12. Use the Upload output section to set Paligo to publish directly to an integration, such as
Github or FTP. For details on these settings, refer to the Integrations documentation [1380].

13. Use the Output filename section to control the filename.

By default, Paligo will use the filename syntax that is defined in the System Settings [32].

To change the information included in the filename, enter your preferred format in the
publishing settings. Default is: ID-Title-Format.

You can use:

• ID - The ID of the document.

• Title - The title of the publication or topic that you are publishing.

• Format - The name of the output format, for example, PDF or HTML5.

• Edit date - The date that the publication or topic was last edited.

• Branch label - The text from the branch label for the publication or topic. This only applies
if your content has been branched and it has a branch label. For details, see Add or Edit
Branch Labels [1648].

• Unique value - A random string of characters, generated by Paligo, that is added to the
filename to make it unique. This can stop the file from being overwritten by later publishes
of the same document.

TIP
If you type @ into the field, Paligo displays a list of the available values and
you can select from the list. To remove a value, click in it and use the delete
key or backspace key to remove all of its characters.
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NOTE
The filename shown in the top-right corner is a preview of the filename that
Paligo will use when you publish.

14. Set the Optional Parameters (leave unchecked if you do not want these features):

• Save the output in Paligo - Choose whether you want Paligo to add the published output
to the Resource View [68]. Check the box to save the zip file. Clear the box if you want Paligo
to only download the published output file in your browser.
If you chose to save the output in Paligo, you can download the zip file from the Resource
View. Reveal the Resource Detail Panel for the publication or topic and then download the
zip file from the Saved Outputs tab.

• Email me - Check this box if you want Paligo to send you an email when the publication
is ready. This is useful if you have very large publications that can take a longer time to
process and publish.

• Make debug build - Check this box if you want Paligo to include a log file and link report.
If there is an issue with your content, Paligo support may ask you to enable this feature so
that they can use the log files to investigate.

TIP
Every time you publish, there will also be a link in the Dashboard feed to
download the published content.

15. Select Publish Document to start publishing. Paligo will then process your content and apply
your layout and publishing settings. The time that this takes can vary depending on how much
content you are publishing (the more content there is, the longer it takes).
When the publishing process is finished, Paligo creates a zip file that downloads in your
browser. If you are using a publishing integration, the zip file will also be sent to the relevant
service.

16. Unzip the file and open the Word document to see the output.
When you open the output, Word will ask you if you want to update the fields in the
document. Choose Yes as this updates the table of contents.

The Word document contains the content from Paligo. It uses the styles from the template
that is set in your layout (or the default template if you have not uploaded a template). To
learn how to change the styles, see Style your MS Word Documents [1047]).

Publish to PDF
The PDF publishing in Paligo uses the high-end PDF rendering engine Antenna House, for the
highest quality PDF output for print purposes.

To publish to PDF, follow the instructions in Publishing Process [1068]. You will need to:

• Choose PDF as the output format

• Choose a PDF layout (or create a new one, see  Create a Layout [1059].
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• Set the languages, variables, filters and so on.

To customize a PDF output, use the settings in the PDF layout, see PDF Layout Editor
Options [799].

NOTE
For information on how to publish a multi-language PDF as a single file that
contains all of the languages, see Publish a Combined Language PDF [1091].

Publish a Combined Language PDF
For PDF outputs, you have the option to publish:

• Each language as a separate PDF (default)

• A combination of languages in a single PDF. We call this a multi-language PDF or a combined
language PDF.

To publish a combined language PDF, follow the instructions in the Publishing Process [1068] and
use the Languages section to:

1. Choose which languages to include.

2. Check the Combine selected languages checkbox to set Paligo to create a combined
language PDF (instead of creating separate PDFs for each language).

NOTE
Use the PDF layout to control which languages are listed on the cover, set the
order of the languages, and control other language-related styling. For details,
see:

• Set the Order of Languages in PDF [828]

• Set Up a Language Sidebar for PDF [829]

• Set the Title to Appear in One Language for PDF [827]

• Set the Subtitle to Appear in One Language for PDF [828]

• Include or Exclude Missing Translations for PDF [833]

• Color Mark Unapproved Translations for PDF [834].
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Publish to HTML and HTML5
Paligo has a variety of built-in templates that you can use for publishing to HTML5 and HTML
outputs. All of the outputs apart from "clean XHTML" (as it has no styling) are responsive and
will adapt to the size of the reader's screen. You can customize the HTML and HTML5 outputs by
using Paligo's layouts and use CSS for more extensive changes. Read more about customizing your
output, see Create a Layout [1059].

• HTML5 Responsive Design: A very modern HTML5 output that adapts to any screen size, from
desktop to mobile. Plugins like bootstrap are built in allowing many possibilities for various
features.
See more about the built-in variants below.

• Clean XHTML: A very clean "plain vanilla" HTML of the structured XHTML type if you want
something that you can model as you please.
This format is also used for publishing to the various help desk knowledge bases supported by
integrations, like Zendesk, Freshdesk, Desk.com and Salesforce Knowledge (if included in your
plan). Read more here: Publish to Your Help Desk Portal [1083].

• Help desk HTML: This is the publishing of HTML adapted to help centers like Zendesk,
Freshdesk, and (Salesforce) Desk.com.
This publishing option is a direct integration to the help center, and as soon as you publish from
within Paligo it is directly available on your support portal.

The help center templates give you a stylish, modern design that works straight out of the box.
These templates are based on the latest frameworks and are compatible with the popular Material
Design framework, bootstrap and more. Below are just some examples of output themes, but
there are more, and each one can be styled any way you like with your custom CSS.

HTML5 Help Center theme 1 HTML 5 Help Center theme 2

HTML5 Help Center theme 3 HTML 5 Help Center theme 3b
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HTML5 variants
The built-in templates for HTML5 are ready-made layouts that will give you a modern design right
out of the box. Of course each one can be modified by yourself by uploading your own CSS in an
override layout that you create in the Layout Editor. The templates represent the popular layout
structures:

• HTML5 single page provides your content as one long page, with a 'sticky' table of contents that
shows where you are on the page.

• The HTML5 Multi-page is a based on the popular "tri-pane" format for online help. Each topic is
presented on its own page and there is a table of contents (TOC) for navigating between pages
as well as a search. For the multi-page HTML5 outputs, we primarily recommend using the "Help
Center" variant. The Classic variant is available for legacy reasons, but does not have all the
newer features that the Help Center themes do.

HTML5 Multi-page (Classic) HTML 5 Single page

Help Center Output Options
The Help Center output gives you a portal for your help content with lots of options for what to fill
that portal with, what content to promote and so on. The templates are completely customizable
and these are just a couple of examples. You can also choose to have a different logo on the portal
page than the main content pages, choose to make the header "sticky" (always visible when you
scroll down), and make the header full width. These options are in the "General" section of the
Layout Editor.

All templates are completely customizable. In most cases you'll be able to customize it yourself
with CSS. Ask support if you are interested in more extensive customizations, modifying the HTML
framework.

The Help Center output has several optional features, including:

1. Base themes and content themes. A very modern HTML5 design based on the latest
frameworks, compatible with for example the popular Material Design framework, bootstrap
and more. There are different themes available for the output and also content themes which
provide the base styling for the main body content, such as the style for notes, text, and other
elements.
To find out more, see Themes for HTML5 Help Centers [698].

2. Ajax or "Preloaded": For faster page loading times with content that is hosted on a web
server. There is also a "preloaded" option for faster page loading times with help centers that
are not hosted on a server.
To find out more, see Faster Page Loading with Ajax Loading [729].
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IMPORTANT
The "Preloaded" version does not support all of the help center features. It
is mainly intended for special cases, such as if you you need to provide your
help center on a local computer rather than a web server. If you can provide
your help on a web server, we recommend that you use the main HTML5 Help
Center theme instead. For advice on using the "Preloaded" variant, please
contact Paligo support.

3. Top navigation: You can add navigation links to the top of the help center. You enable this in
the Layout Editor [680], and can also select whether to link to existing topics, external content,
or both.
To find out more, see Top-Navigation for Help Centers [741].

4. "Super" help center: Create a "super" help center where the main portal page links to
different sub-publications.
There are a couple of ways to have one portal for multiple publications. You can either:

• Reuse several publications under a "super publication" and then publish it.
This creates a publication where each category panel leads to the respective publication. In
this case the Table of Contents (side navigation menu) will cover all those sub publications.

• Publish each publication separately, and then put together a "super publication" shell portal,
as described below.

To find out how to set up a "super publication", see Multiple Publications in the Same
Portal [729].
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Examples of the HTML5 Help Center output

Classic Multi-page HTML5
This is an HTML5 version of the popular "tri-pane" format for online help. Each page/help article is
presented on its own (multi-page), and you navigate them in the Table of Contents (TOC).

NOTE
The classic multi-page HTML5 layout is a legacy layout and may not support all of
the features that are available to the HTML5 help center layout.

NOTE
If using the default search with the classic multi-page HTML5 layout, there is no
message for no matching results. If there are no topics that match the search
query, the results list is empty.

Single-page HTML5 (Article style)
Another HTML5 variant that has become very popular is the long single-page article style. It is all
one long page with a very clean design, and with navigation that follows along.
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The Table of Contents is "sticky" and color bars indicate clearly where you are on the page.

API documentation style
For those that are documenting software with a lot of code or examples, there is a template we
call the API style, as it is a type of style that has become especially popular for API documentation.

HTML5 Single page API style

• Code and other examples are automatically placed in the sidebar, and the examples are in sync
with the body text.

• The content is filtered "on the fly", meaning that you can select which programming language
version you want to see examples for.
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If you click Ruby, all example code is in Ruby, if you click Javascript all sample code instantly
switches to show Javascript, etc.

• The main body content will also be filtered on the fly, based on filter attributes you use in your
Paligo content. 

• The theme can be easily customized, selecting a different code sample theme and syntax
highlighting with a parameter, and some CSS to modify the rest.

To find out more, see API Documentation Layout [565].
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Content Reuse

Abstract
Content reuse is the practice of using the same content in multiple places to save time and effort.

With Paligo's content reuse features, you can write the content once, in one place and reuse that
content in multiple topics and publications. This will save you time and effort, but also result in a
more consistent look and feel.

This means that you can reuse the same warning message, procedure steps or safety chapter. By
using Variables [1186] and Filtering / Profiling [1141] (conditional text) you can vary the content
depending on product and still use the same topics.

TIP
If you are new to content reuse, structured authoring and single-sourcing, it's
easy to be overwhelmed by the reuse features at your disposal in Paligo.

Read The 5 Principles of Single Sourcing to find the right balance for such
techniques in single-sourcing.

To the left - Reuse a topic in multiple publications. To the right - Reuse elements, such as paragraphs,
in multiple topics.

Content Reuse vs Copying
What is the difference between content reuse and copying?

With content reuse, you use the same piece of content in multiple places. There is no duplication.
You reuse the same piece of content, and so if you change it, the alterations will apply in every
topic where that content is used.
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With reuse, the same element is inserted multiple times. Here, the "Select Save." para element (1) is used
twice.

Copying is different, as you make a duplicate of the original. The copy is completely separate from
the original.

With copy, the element (or text in the element) is duplicated. The copy (2) is a separate element to the
original (1).

As a general rule, we recommend that you reuse content when you want to use the same content
in multiple places. Use copy if you want to use an existing piece of content as a starting point for a
new, customized piece of content that will be separate to the original.

TIP
Learn more about copying content, see Copy Content [158]

Types of Content Reuse
There are many ways to reuse your content in Paligo:

• Topic reuse - Reuse Topics [1100] by adding them to different publications. You can also embed
one topic inside another topic as a subsection.
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• Publication reuse - Create a Super Publication [734] by adding it to a main publication. For
example, if you have a series of user guides, you can publish them all as one combined output
by adding them to a single publication.

• Structure reuse - Reuse Forks [1108]. For example, if you have a "chapter" that consists of a
main topic and several sub-topics, you can reuse the entire "chapter".

• Text fragment reuse - Every paragraph that you create is stored in a database and is available
for reuse. This means that you can Reuse Text Fragments [1113], Reuse Items in a List [1114],
steps in procedures [1114] and other types of block element without prior planning. For
example, if you create a para element and add "Select Save" as the text, you can reuse that
same paragraph everywhere that you need the "Select Save" text to appear.

• Informal topic reuse - Informal topics are a way of grouping different types of elements as
reusable content, for example, two paragraphs and an image. To reuse a group of elements, you
can Create an Informal Topic [1109] and import it to any of your "regular" topics.

• Admonition reuse - You can Reuse Admonitions [1120] to use in your topics.

• Variables - You can reuse single words or phrases by using Variables [1186]. First, you create
variable sets that contain the words and the text that you want to use for those words. Then
you can insert these variables in your topics. Paligo has support for several types of variables,
plain text variables, image variables, XML variables, and translatable variables. There are also
Dynamic Text Variables [1203], which can output today's date and similar content.

• Filtering / Profiling - Filtering / Profiling [1141] makes it possible to make content more
reusable by applying filtering (like the element attributes xinfo:product or xinfo:market)
on parts of it, so that the topic becomes reusable in multiple context. With variable sets, it is
possible to insert a variable that changes value according to chosen market or product.
Filtering is sometimes traditionally called "conditional text", but it applies to more than just
text, it can be any kind of content, including images, videos and so on. This is often used
when information is reused between different products or markets, for example technical
specifications, to change data depending on model, change images or hide information for
certain markets or models.

NOTE
You can also reuse the images in your Paligo Media library.

Reuse Topics
When content is added to a publication, you create special links called Forks [107]. What you see
in the publication structure is actually links to the topics. This means that you can reuse each topic
in as many publications as you want. This is beneficial if you produce a range of different products
that use the same information (like an introduction, a safety or scrapping chapter). You only create
the content once and reuse it in various publications. Then, if you need to update the content, you
make the changes in one place and the update will apply wherever that topic is reused.

If you have certain parts of the content that differentiates between products (like a product name,
images or specifications) or need to be able to show or hide content (like warnings or procedure
steps), you can use Variables [1186] and Filtering / Profiling [1141].
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NOTE
To reuse a topic multiple times in the same publication, you will need to set up
the topics differently, so that the search can differentiate between each instance
of the topic, see Reuse a Topic Multiple Times in the Same Publication [1102].

TIP
You can also reuse publications, see Create a Super Publication [734].

The Safety topic is reused in the publication for both SmartPhone-A and SmartPhone-B.

To reuse topics in publications:

1. Select the publication in the Content Manager [34]. 

Paligo displays the publication's structure.

2. Drag and drop the topic you want to use into the publication structure.
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Added content will appear at the bottom of the publication structure.

3. Rearrange the topic position with the arrows or drag and drop it in the structure.

NOTE
Top-level topics (1, 2, 3) in the publication structure will be displayed as a top
sections in PDF output and as separate pages in HTML output.

Lower-level topics (1.1, 2.1, 3.1) will appear as subsections in PDF output. In
HTML outputs, you can control whether you want the subsection topics to
appear as separate pages or as subsections of a higher level "parent" page,
see Use Chunking to Control Subsections [167].

To find out about controlling how subsections are used, see Headings and
Subheadings [163].

4. Select Save to confirm the publication changes. 

5. Repeat this process for each publication that needs to reuse the topic.

Reuse a Topic Multiple Times in the Same Publication
To use a topic multiple times in the same publication, it's important that you create separate
instances of the topic. This is because cross-references and context-sensitive help requires a
unique ID to identify a topic. So each instance of the topic in the same publication needs to be
unique.

For this two separate topics are created. The content inside them is in an informal topic [1109], so
both topics contain the same inserted content. By having two "unique" topics, they can both have
unique IDs for cross references and app IDs for context-sensitive help.

The same approach applies if you want a publication to appear multiple times inside a super
publication [734]. You will need unique publications and unique topics inside those publications,
but use informal topics to reuse the topic content.
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API topic needs to be repeated in same publication. So two versions are created (1 and 2) and their
content is shared in an informal topic.

NOTE
If you reuse the same topic in several places, without setting it up as described in
this article, it may result in:

• Cross-references to the topic instances always going to the first instance

• Context-sensitive links to the topic instances always going to the last instance.

This is because when you reuse the same topic, it has the same ID in each place
it is used. This means that links and cross-references will all have the same target
and the browser will display the first matching target that it finds.

TIP
For PDF output, you can create manual fork links when topics appear multiple
times in a publication, see Manually Create a Fork Link [266].

The following steps explain how to set up your publication to reuse the same content in multiple
places:

1. Create a Publication [96] that will become the "parent" publication. This is the publication that
will contain the topics and subpublications that you publish and use as documentation.

2. Create the content that is only going to appear once in your publication and add it to the
publication structure, see Create a Topic [131] or Create a Publication [96].

3. Create the content that is going to appear multiple times in your publication. You should
create:

• New publications for each instance of a "reused" publication. For example, if you want an
"Installation" publication to appear three times in your "parent" publication, create three
"Installation" publications.

• Individual topics for each topic that is going to appear multiple times. This applies to
topics that are directly in the structure of the "parent" publication and also those that are
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in publications that appear multiple times. For example, if you have three "Installation"
publications, then you need unique topics for all three. But do not add content to them, you
just need the topics for structure.

TIP
Add or Edit Branch Labels [1648] to make it easier to differentiate between
the different instances of a topic. This will make it easier to choose the
appropriate instance of a topic, when you add cross-references.

4. Create an Informal Topic [1109] for each topic that is going to appear multiple times
("repeated" topics).
This applies to topics that are directly in the root structure of the "parent" publication"
and also those that are in publications that appear multiple times. Add your content to the
informal topics.

For example, if you want an "API" topic to appear multiple times in your "parent" publication, create
one "API" informal topic and add the content there. You will then reuse that informal topic in each
instance of the "API" topic.

5. Open each "repeated" topic in the editor and position the cursor after the title but before
the first para element. Then select Insert > Component and choose to insert the appropriate
informal topic for the topic. This will embed the informal topic (and its content) inside your
topic. So you are setting a unique topic to reuse blocks of content.

When you have finished, you should have a "parent" publication that contains:

• One instance of each topic that appears once. The content for each of these topics is
entered directly into the topic.

• One instance of each publication that appears once. If its topics only appear once in the
"parent" publication, then the content should be added directly into the topics.
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• Separate topics for each topic that appears multiple times. The content for each of these
topics is entered in an informal topic, and the informal topic is inserted into the "real" topic.

• An informal topic for the content in the repeated topics. The informal topic is going to be
reused, so you only need one per topic.

• Separate publications for each repeated publication that appears multiple times. The topics
in these publications will appear multiple times in the "parent" publication, and so should all
be unique, with informal topics used for their content.

To edit the content in one of the "repeated" topics, make the changes to its matching informal
topic. These changes will then be applied automatically wherever that informal topic appears.

6. Add content to the publication [99].

7. Select Save to confirm the publication changes. 

Example of Reusing Content Multiple Times in a Publication
The following example shows the setup for a "parent" publication that contains three instances of
an "Installation" publication. For this, there are separate "Installation" publications and individual
topics for each instance. Informal topics are used to allow the content of the topics to be reused.

Example 59. Reuse topics in multiple places in the same "parent" publication

Let's say that you have a publication that's going to provide instructions for three different
products (Acme 100, Acme 100X, and Acme 200) all in the same publication. Each product has
some unique topics that are only relevant to that product, but all three need to reuse the same
"Installation" topics. You also need to be able to publish the "Installation" topics as a guide in their
own right.

As they are three different products, you will need to link to the specific product information from
other source. For example, your context-sensitive help for Acme 100 needs to link to "Installation"
topics for Acme 100 and not the "Installation" topics for the other products.
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Where 1, 2, and 3 are the publication and its topics that you want to reuse three times in the same
"parent" publication.

To create this, you begin by making a "parent" publication.

You then create all of the individual topics that are only going to appear once. These are "regular"
topics and you add their content directly into the topics.

Finally, you create the "repeated" parts for the "Installation" topics. You need to be able to publish
the "Installation" section as an "Installation" guide too, so you set up:

• 3 x "Installation" publications

• 3 x "Prepare the installation site" topics

• 1 x Informal topic for the "Prepare the installation site" content

• 3 x "Fit the unit housing" topics
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• 1 x Informal topic for the "Fit the unit housing" content

• 3 x "Fit the power supply "topics

• 1 x Informal topic for the "Fit the power supply" content

• 3 x "Connect the power supply" topics

• 1 x Informal topic for the "Connect the power supply" topics

• 3 x "Fit the device" topics

• 1 x Informal topic for the "Fit the device" topics.

You then set up your three "Installation" publications, like this:

• Installation publication #1

• "Prepare the installation site" topic #1.
Inside this topic, you insert the "Prepare the installation site" informal topic.

• "Fit the unit housing" topic #1.
Inside this topic, you insert the "Fit the unit housing" informal topic.

• "Fit the power supply" #1 topic.
Inside this topic, you insert the "Fit the power supply" informal topic.

• "Connect the power supply" topic #1.
Inside this topic, you insert the "Connect the power supply" informal topic.

• "Fit the device" topic #1.
Inside this topic, you insert the "Fit the device" informal topic.

• Installation publication #2

• "Prepare the installation site" topic #2.
Inside this topic, you insert the "Prepare the installation site" informal topic.

• "Fit the unit housing" topic #2.
Inside this topic, you insert the "Fit the unit housing" informal topic.

• "Fit the power supply" #2 topic.
Inside this topic, you insert the "Fit the power supply" informal topic.

• "Connect the power supply" topic #2.
Inside this topic, you insert the "Connect the power supply" informal topic.

• "Fit the device" topic #2.
Inside this topic, you insert the "Fit the device" informal topic.

• Installation publication#3

• "Prepare the installation site" topic #3.
Inside this topic, you insert the "Prepare the installation site" informal topic.

• "Fit the unit housing" topic #3.
Inside this topic, you insert the "Fit the unit housing" informal topic.

• "Fit the power supply" #3 topic.
Inside this topic, you insert the "Fit the power supply" informal topic.

• "Connect the power supply" topic #3.
Inside this topic, you insert the "Connect the power supply" informal topic.

• "Fit the device" topic #3.
Inside this topic, you insert the "Fit the device" informal topic.

You then add the three publications to your "parent" publication structure.
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The end result is a "parent" publication structure where:

• Every publication and topic inside it has a unique id

• The "Installation" guides are unique publications and topics, but they share their content in
informal topics.

• You can link to any specific instance of an "Installation" topic, as they all have unique ids. The
browser will be able to find the specific instance of a topic, as it can differentiate between them.

• You can add app id attributes to each topic, including the different instances of the "Installation"
topics. This means context-sensitive help can link to the different instances as needed.

• You can change the content for the "Installation" topics in one place, by editing the relevant
informal topic. The changes you make there are applied wherever the informal topic is used.

• You can publish any of the three "Installation" publications separately to the "parent"
publication. All three "Installation" publications contain the same content (as they share the
informal topics).

Reuse Forks
You can reuse Forks [107] and its "structure" between publications. This will help you to save
time when creating new publications and reduce the amount of work needed when updating the
publication structures.

 In the target publication a reuse symbol visualizes the reused fork. The fork structure does not
show for reused forks.

You can select a topic fork (origin publication) and reuse it in a different publication (target publication).
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TIP
You can make a template to be used when creating publications, see Create a
New Publication Based on a Template [460].

To reuse topic forks:

1. Select the target publication in the Content Manager [34] to open its structure. 

2. Expand the origin publication in the Content Manager [34].

The number to the right of a fork tells the number subtopics included.

3. Hold down Shift  and then drag and drop the fork into the target publication structure.

The fork will appear at the bottom of the publication structure.

4. Rearrange the topic position with the arrows or drag and drop it in the structure.

5. Select Save to confirm the publication changes. 

Create an Informal Topic
You can use a special type of topic called an informal topic to reuse a collection of elements. For
example, if you wanted to reuse a paragraph and an image together, you could create an informal
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topic, and add the paragraph and image to that. Then, you could insert the informal topic into as
many regular topics as needed.

To find out how to create and reuse informal topics, watch the video or read the instructions
below.

https://player.vimeo.com/video/339536169

1. Select the Dotted Menu (...) for the folder where the informal topic is to be stored.

2. Select Create Content. 

3. Enter a name for the informal topic.

4. Select the checkbox for Informal topic. 

5. Choose the Language(s) to support. 

6. Select the checkbox Open in editor.

7. Select OK.

8. Add your content the same way that you add content to a regular topic.

9. Select Save. 

Insert Component
If you have created informal topics [1109] or reusable components [1110], you can insert them as
components in topics. The components will become nested content and they can be arranged in
the XML Tree View [54] just like other content.

1. Position the cursor where the component is to be inserted.

2. Select the Insert tab in the Toolbar [52].

3. Select Component. 

4. Select the component to be inserted.

5. Select OK.

6. Select Save. 

Convert to Reusable Component
You can make a reusable component of subsections or Admonitions [182]. A subsection will turn
into a standalone topic and an admonition will turn into a reusable component. This means that
you can begin creating your content in one topic and then create reusable admonitions or divide it
into separate topics.

The benefit of making the subtopics into standalone topics is that it will be easier:

• To find in the published output, because it will turn up as a standalone topic.

• To find it in the Content Manager [34].
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TIP
To reuse a paragraph, a list or steps in a procedure, see Create an Informal
Topic [1109].

1. Select the subsection or admonition in the Element Structure Menu [52].

2. Select Convert to reusable component.

3. Enter a name for the component.

4. Select where to save it. 

5. Use the checkbox Reuse the component at position to decide whether to reuse the
component at its current position or not. If you clear the box, the component is removed
from its current position in the topic.

NOTE
When reusing the component inside the original topic, it becomes a nested
component.

6. Select OK.

7. Select Save. 

Remove Inserted Component
If you want to remove an inserted component from the topic:

1. Position the cursor inside the inserted component.
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2. Select the component in the Element Structure Menu [52].

3. Choose Delete. 

4. Select Save. 

Convert to Informal Topic from Structure View
If you already have topics, it is possible to convert them into informal topics via the Structure
View [75]. This may save you time when making parts of a topic into an informal topic.

1. Make a copy of the topic [136].

2. Select the Dotted Menu (...) for the copy in the Content Manager [34].

3. Select Edit and choose Open Structure. 

4. Change the Subtype to Informal topic in the Metadata Section [77]. ⌄

5. Select Update.

6. Close the Structure View with the X in the top right corner.
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7. Select the copy in the Content Manager [34] to open it in the Editor [51].

8. Remove its title element.
Your topics will contain a title, so there is no need to have an additional title in the informal
topic.

9. Select Save. 

10. Select the origin topic Content Manager [34] .

11. Insert the created informal topic [1110].

12. Remove the part that became the informal topic.

13. Select Save. 

Reuse Text Fragments
Every paragraph (or other textual block elements, such as titles and captions) that you write in
Paligo is stored in the database and is available for reuse. Reusable paragraphs are also known
as reusable text fragments. By reusing paragraphs, you can save time with content creation and
updating and make your content more consistent.

The idea is to try and write a paragraph once, in one place, and then reuse it wherever needed. For
example, if you are documenting software and you have a 'Click Save' paragraph, you can reuse
that in all of your processes instead of writing different versions or copying and pasting. You do
not need to make special types of content or store them in selected folders - as soon as you write
a paragraph and save it, it becomes available for reuse.

TIP
Another way to create reusable components is to Create an Informal Topic [1109].

Add Reusable Text Fragments
To find out how to use the Reuse text feature, watch the video or follow the instructions below.

https://player.vimeo.com/video/339536137

1. Edit a topic and move the cursor to a position where a para element is valid. For example,
directly above or below another paragraph or inside a step element in a procedure.

2. In the Reuse text section, search for the text that you want to insert as reused content.
Paligo will find any results that are similar to your search term.

3. If you see a result that is suitable for your needs, select it and choose:

• Reuse fragment to insert the text as a reused paragraph.

• Insert as content to insert the text as a regular paragraph. This is the same as entering a
completely new paragraph as it will be saved with a unique id and is completely separate
from other text fragments.

4. Select Save. 

If you chose Reuse fragment, the reused text appears with a chain symbol. This shows it is
reused.
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Edit a Reused Text Fragment
When you add a reused text fragment to a topic, it is made unavailable for editing. This helps to
prevent people from changing the content of the text fragment to suit one specific topic without
considering the other topics where the fragment is used.

But it is possible to edit a reused text fragment. To find out how, watch the video or read the
instructions below.

https://player.vimeo.com/video/339536229

1. Select the reused text fragment (paragraph) you want to edit.

2. Select the para element in the Element Structure Menu.

3. Select the Edit reused fragment option.

You can now edit the reused fragment. Note that any changes you make will be applied wherever
the text fragment is used, and so could affect many different topics.

Disable a Reused Text Fragment
A reused text fragment gets a chain symbol in front of it. This instruction shows how to disable a
text from a reused text fragment.

1. Position the cursor inside the reused text fragment.

2. Select the para#text in the Element Structure Menu [52] and choose Disable reuse. 

The text will now be disabled from the reused text fragment and the chain symbol in front of it
disappears.

Reuse Items in a List
In technical publications, it is quite common to have list items and steps that are repeated in
various different topics. For example, if you are documenting software, it is likely that you will use
a 'Save' step in lots of different procedures.

In Paligo, there are two different ways to reuse steps. You can use:

• The reuse text feature for single list items or steps

• An informal topic to reuse a sequence of list items or steps.
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NOTE
If you want to reuse an entire list or procedure, add the list/procedure to
an informal topic. You can then add the informal topic to other topics where
appropriate.

To find out how to reuse items in lists, see the following sections.

Reuse a Single Item in a List
If you only want to reuse a single item or step in a list, you can use the Reuse text feature. This
works in the same way as reusing a text fragment.

The text in a step or list item is enclosed in a para element. For example, a step in a procedure
looks like this: <step><para>The text for the step.</para></step>. So to reuse a single step, you
should first create a new step, and then reuse a para element inside it.

To find out how to reuse a single step, watch the video or read the following instructions:

https://player.vimeo.com/video/342697413

1. Open the topic that you will insert the reused step into.

2. Add an extra step for the list or procedure. You can add an extra step by clicking at the end
of the previous step and pressing Enter. Alternatively, position the cursor at the appropriate
position and use the Element Context Menu to add a new step or listitem element.

3. Click in the para element that is created for the new step.

4. In the Reuse text section, search for the text of the step/listitem that you want to reuse.

Paligo Documentation

1115

https://player.vimeo.com/video/342697413


5. When Paligo finds the step/listitem, select it and choose the Reuse fragment option.

Paligo adds the text into the step.
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The text is a reused fragment and is locked. If you want to edit it, you will need to unlock it,
but be aware that any changes you make will apply wherever that text is used, not just in your
topic.

Reuse a Sequence of Items in a List
To reuse a sequence of items or steps in a list, add the sequence to an informal topic. You can
then insert the informal topic inside a list in a regular topic. This is useful when you have multiple
steps that are the same in many different topics.

You will also want to make sure that any numbering flows with the rest of the list. Paligo has a
role attribute called reuse-range that makes this possible.

To find out how to reuse a sequence of steps in a list, watch the video or follow the instructions:

https://player.vimeo.com/video/339536187

1. Create an informal topic.
To do this, select the options menu ( ... ) on a group folder, and select Create content. On the
Create content dialog, give the informal topic a name, select the Informal topic option. Select
the language you want to support and then select ok.
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2. Open the informal topic in the editor and add the list or procedure steps you want to reuse in
other topics. You can add a bullet list, number list, or procedure by using the toolbar icons in
the Edit menu.

3. In the Element Structure Menu, select the top-level element for the list (itemized list,
orderedlist, or procedure, depending on the type of list). Select the Go to element option.
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4. In the Element attributes section, add the role attribute and set its attribute value to
reuse-range. This allows Paligo to apply the correct sequence of numbering before and after
the informal topic.

5. Save the informal topic.

6. Open the topic that contains the list you are going to add the sequence to.

7. If the topic does not already contain the list or procedure, insert one.

8. Position the cursor at the position where you want the steps in the informal topic to appear.
The cursor position is very important, as if it is an incorrect position, the informal topic cannot
be added.
If you want the informal topic steps to appear between other steps in a list, position the
cursor between the steps. Use the Element Structure Menu to make sure that the cursor
position is at the top-level item for the list (itemized list, orderedlist, or procedure, depending
on the type of list).
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If you want the informal topic steps to appear at the start or end of an existing list, position
the cursor above the first step or below the last step. Use the Element Structure Menu to
make sure that the cursor position is at the top-level item for the list (itemized list, orderedlist,
or procedure, depending on the type of list).

9. Select Insert > Component and browse to the informal topic.
Paligo adds the informal topic at the selected position (as long as you selected a valid position
in step 8). The numbers of the steps in the informal topic adjust to fit in with the sequence of
numbers in the existing list. If you add steps before or after the informal topic, they will also
continue the correct numbering sequence.

Reuse Admonitions
You can draw the reader's attention to information by using admonitions, such as warning,
caution, danger, tip and note. These are special pieces of content that stand out from the rest
of your content and often have a special icon.

This type of content is often highly repetitive and so ideal for content reuse. In Paligo, you can
create a library of notes, warnings, and other messages and reuse them wherever they are
needed. There is no need to copy and paste or duplicate the information.
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Warning Icon

Create a Reusable Admonition
There are two ways to create admonitions. You can create them as elements in a topic, see
Admonitions [182] or you can create them as reusable pieces of content. Here, we are going to
explain how to:

• Create a reusable admonition

• Insert a reusable admonition into a topic.

The following video shows how to create a reusable warning and insert it in a topic. You can use
the same technique to create different types of admonitions, just select the appropriate option
instead of warning. Alternatively, follow the instructions below.

https://player.vimeo.com/video/339536256

1. In the Content Manager, select the options menu ( ... ) for the folder that you want to contain
your reusable admonition. If a suitable folder does not already exist, create a new one.

2. Select Create Content.

3. Enter a name for the admonition and select the appropriate type (Note, Warning, Caution,
Danger, Notice, Important, or Tip).
Paligo creates the admonition and adds it to the relevant folder.

4. Select the admonition to open it in the editor and add the text and/or images you need it to
include. Save the admonition when you have finished.

5. Find a topic that you want to add the admonition to, and then open the topic in the editor.

6. Place the cursor at a valid position for the admonition. This can be any position where text can
be added. (Paligo will display an error message if you try to add an admonition in an invalid
position).

7. Select Insert > Component.

8. Choose the reusable admonition that you want to add to the topic and select OK.
The reusable admonition is added to the topic.
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Insert a Reusable Admonition
To insert a reusable admonition, such as a warning or note, in a topic:

1. Find a topic that you want to add the admonition to, and then open the topic in the editor.

2. Place the cursor at a valid position for the admonition. This can be any position where text can
be added. (Paligo will display an error message if you try to add an admonition in an invalid
position).

3. Select Insert > Component.

4. Choose the reusable admonition that you want to add to the topic and select OK.
The reusable admonition is added to the topic. For example, in the image below, a reusable
warning admonition is added to a topic.

Convert Regular Admonitions to Reusable Admonitions
You can add "regular" admonitions by selecting Insert and choosing an admonition. Regular
admonitions are designed as "one-off" messages that will not be reused. However, it is quite
possible that you will add a regular admonition to a topic and later realise that you need to
use it again. In these situations, you can quickly convert the regular admonition into a reusable
component.

To learn how to convert a regular admonition into a reusable component, watch the video or
follow the instructions below:

https://player.vimeo.com/video/339536266

1. Open the topic that contains the regular admonition that you want to reuse, and select any
part of the admonition.

2. In the Element Structure Menu, select the top-level element of the admonition to display a
menu. For example, if you have selected a warning admonition, select the warning element.
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3. From the menu, select Convert to reusable component.

4. Give the component a suitable name and choose a folder to store it in.

5. Use Reuse the component at position option to choose whether you want to replace the
existing regular admonition with the reusable version that Paligo will create.

6. Select Ok to confirm and Paligo will create a reusable component that matches the
admonition you selected in step 1.

To add the admonition to topics, open a topic in the editor and position the cursor at a valid
position. Then select Insert > Component, and select the reusable admonition.

Content Reuse for Front Matter
If you are creating many publications, you may want to reuse some of the information in a
publication topic. For example, you may have 5 different publications, but you want them all to use
the same legal notice "info elements".

To reuse "info elements", such as copyright and legalinfo, you need to take a different
approach than you would for reusing most other elements. This is because "info elements" cannot
be reused in informal topics. Instead, you should use a publication template.
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NOTE
To find out about publication topics and the info elements that you can add to
them, see Publication Topic - "Front Matter" [109].

There are several things that you need to set up to reuse "info elements". To make the information
easier to follow, we have broken it down into these stages:

1. Create a publication template [1124] and add the info elements to that.

2. Create a variable set [1125] to define the reusable text for the info elements.

3. Add the Variables to the Publication Template [1127].

4. Create new publications based on the template [1128]. These publications will automatically
inherit the text from the variable set.

5. Choose the Variable Set when you Publish [1129] .

With the template and variable set in place, you can update the variable values by making the
changes once in the variable set. The changes you make there will be applied wherever the
variables are used.

If you are new to the concept of variables and variable sets, you can find out about them in
Variables [1186].

Create a Publication Template to Contain the Reusable Info
Elements
A publication template contains content that is inherited automatically by "real" publications that
are based on the template. So by adding "info elements" there, you can make sure those "info
elements" also appear in your publications.

1. In the Content Manager, find Templates and select its options menu ( ... ). Select the Create
Content option.

2. Enter a name for the publication template and select Publication as the type of content
you are creating. Remember that this is going to be a template publication, not a "real"
publication.
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3. Check the Open in editor box in the bottom-left corner and then select OK.
Paligo opens the publication's topic in the editor. It contains the default "info elements",
including subtitle, copyright, and abstract.

4. Edit the publication topic so that it contains the "info elements" that you want to appear in all
of the publications that are based on this template.

5. Consider what information you are going to need as the content for each of the "info
elements" in your publications.

• For content that is always going to be the same for all publications, add it directly to the
template elements.
For example, if all publications are going to have the same legal notice, you could add the
text for it in the legalnotice element on the template.

• For content that you want to reuse in some, but not all, publications based on the template,
use a variable.

At this stage, you can add the text that is always going to be the same. For variables, you will
need to create a variable set and we will explain that in the next stage of this process.

6. Select Save.

Create a Variable Set for the Reusable Info Elements
To reuse the content of "info elements", you need to add the content to the template as variables.
These are containers that can contain different content, depending on the choices you make when
you publish.

To use variables, you need a variable set:

1. In the Variable Sets section of the Content Manager, select the options menu ( ... ) and then
create a new variable set and give it a suitable name.
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2. Edit the variable set and add variables for those "info elements" that you want to reuse
in different publications. Use translatable text variables for text content and images for
images.
For example, let's say that for your publications, you want to reuse the subtitle and also the
legalinfo. So in your variable set, you add a variable for the subtitle and a variable for the
legal information.

3. Add a variant for each different publishing scenario. Each variant is shown as a column and it
is a collection of values that Paligo can insert into your publication topic.
For example, if you publish developer guides, engineer guides, and operator guides, you might
want each type of guide to have a different subtitle and legal information. So you would create
a variant for each guide, and in each variant, define the content that should be used.

When you publish, you can tell Paligo which variant to use, and then it will "push" the values of
that column into your publication topic.

TIP
To learn more about creating variable sets and variants, see Variables [1186].
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Now that you have your variable set, variants, and values, you can add the variables to your
publication template.

Add the Variables to the Publication Template
When you have a variable set, you can add its variables to your publication template:

1. In the Content Manager, select the options menu ( ... ) for your publication template, and then
select Edit > Open in editor.

2. Position the cursor inside an element that is going to contain a variable.

3. Select the Insert menu, then Variable, and choose the variable set that you created for your
reusable "info elements". Then choose the appropriate variable from the list.

4. Repeat steps 2 and 3 until you have added variables to the various elements.

The variables are shown as blue boxes, with the name of the variable set and variable shown.

5. Select Save.
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Next, you will create publications that are based on the template.

Create a New Publication from the Template
Now that your publication template is in place, you can use it to create new, "real" publications.

1. In the Content Manager, select the options menu ( ... ) for the folder that is going to contain
your new publication. Then select Create content.

2. On the Create content dialog, select From template, and then select your publication
template. Give your new publication a name, select what languages you want it to support,
and then select OK to create it.
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3. In the Content Manager, select your new publication to open its structure and then add topics
to it. Organize its structure, and edit its publication topic, just as you would for any other
publication. The only difference here is that the publication topic automatically inherits the
elements from the publication topic in your template. This inheritance from the template is
how the "info elements" are reused. The variables are also inherited and you will set the
values for these when you publish.

4. Repeat this process for as many publications as you need.

You will set the values for the variables in the publication topic when you are ready to publish.

Choose the Variable Set when you Publish
To set the values that will be used for the variables in your publication topics, choose the variable
set and variant when you publish:

1. Select the options menu ( ... ) for the publication, and then select Publish.

2. On the Publish document dialog, select the output type, language, and all the other settings
that you would normally choose when publishing.
To learn more about the publishing settings, see Publishing Process [1068].

3. In the Variables section, select the variable set that contains the "info element" variables that
you created for your publication template. Then select the variant that you want to use from
that set.
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Remember that the variant is a collection of values that will be inserted into the relevant
variables. In this case, the values from the variant set that you choose will be inserted into the
variables that are in your publication topic.

NOTE
If you have used other variables in the other topics in the publication, add
those variable sets in the publication settings too. For each of the variable
sets, choose which variant you want to use.

4. Select Publish document to publish your content.
Paligo will generate the content and it will download as a zip file in your browser. You can then
unzip the file and move its contents to a web server, so that people can access it.

Lock and Unlock Content
If you have a paragraph that you do not want other users to change, you can lock it. The lock
means that the content is more difficult to change, as if someone wants to edit it, they first have to
unlock it. You can lock and unlock any para element.

To find out how to lock and unlock content, watch the video or read the instructions below:

https://player.vimeo.com/video/339536210

TIP
Locking your content can be a good idea if you have a team of writers and some
are new to the concept of content reuse. Sometimes people do not realise that if
they change a paragraph, it changes wherever that paragraph is used.

Lock Content
To lock content so that it cannot be edited:
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1. Select any part of the paragraph.

2. Select the para element in the Element Structure Menu [52].

3. Select Lock content from the menu to lock the paragraph.

4. Select Save. 

Unlock Content
To unlock content so that it can be edited again:

1. Select any part of the paragraph.

2. Select the para element in the Element Structure Menu [52].

3. Select Unlock content from the menu to unlock the paragraph.

4. Select Save. 

Find Reusable Content
Paligo has many convenient ways to find reusable content that you can add to your topics
and publications. The features you will use vary, depending on whether you want to Find Text
Fragments to Reuse in Topics [1132] or Find Topics and Publications to Reuse [1133].

TIP
Another way of finding reusable topics and other components is to use Classify
Content with Taxonomies [1367] to categorize them.

NOTE
Paligo also has "where used" features so that you can Find Out Where Content is
Used [1136].
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Find Text Fragments to Reuse in Topics
Every paragraph that you write in Paligo is stored in the database as a "text fragment". So there's
no need to store individual paragraphs separately for reuse, as every paragraph is made available
for reuse automatically.

To find a paragraph to reuse in a topic:

1. Edit a topic and position the cursor at a valid position for a paragraph element (para).

2. In the Reuse text section on the right side of the editor, search for the text that you want to
reuse. Paligo will find any close matches that already exist in the database.

Search for the text that you want to reuse.

Paligo will find close matches to your search term.

3. Select the entry that you want to reuse and Paligo will insert it into the topic.

Paligo Documentation

1132



Find Topics and Publications to Reuse
You can reuse topics inside other topics or in many different publications. Similarly, you can reuse
a publication inside another publication. Reusing topics and publications in this way is a great way
to save time when producing similar user guides.

There are several ways to find the topics and publications you want to reuse:

• Edit the structure of a publication and then use the search bar at the bottom of the Content
Manager. Enter the name of any topic or publication in here, and Paligo will find any close
matches. You can then drag the topic or publication into the structure of the publication.

• Browse through the folders in your Content Manager to find the publication or topic, and then
drag and drop it into the structure of publication.

• If you are editing a topic and want to add another topic as a subsection, select Insert >
Component and then search or browse for the topic you want to reuse.
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• If you have added taxonomy tags to your topics, you can use the taxonomy manager to find
topics.

1. In the Taxonomy Manager, select the taxonomy tag that relates to the content you want to
reuse.

Paligo Documentation

1134



Paligo Documentation

1135



Paligo displays a list of the topics that use that taxonomy tag.

2. Select the topic from the list to open it in the editor. You can then see where the topic is
located in the Content Manager. Now that you know where the topic is located, you can
open a publication and drag the topic into it. Or you can edit a topic and use Insert >
Component and browse to the topic to insert it as a subsection inside the topic.

Find Out Where Content is Used
Paligo has several features you can use to find out where your content is used. These are
especially useful when you have reused content, as as you will need to make sure that any
changes you make are appropriate for all of the places where the content appears.

Also, being able to find topics is important when you want to delete content, as you cannot delete
topics or publications that are included in another topic or publication. Similarly, you cannot delete
topics that other topics link to. So you will need to remove those instances of reuse and the
links before you can delete a topic. (For information on how to delete reused content, see Delete
Content [469]).

What type of content are you looking for?

• Find Reusable Content [1131] like text fragments, topics and publications

• Search with Taxonomy Tags [1375]

• Search for a Topic in a Publication [635]

TIP
If you frequently reuse the same text elements, informal topics, admonitions, you
can Create an Informal Topic [1109] and insert it in as many topics as needed.

Find Out Where Topics and Publications are Reused
When you are updating and organizing your content, you may want to find out where each topic or
publication is used. You can find out this information in the structure view and also in the resource
view.

To find the reuse information in the structure view:

1. In the Content Manager, select the options menu ( ... ) for the topic or publication you are
interested in. Select Edit > Open Structure.

2. In the Metadata section, look at the following entries:
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• Used in - Shows where the selected topic or publication is used, either as a subsection
inside another topic or as part of a publication.
Entries marked "Component" are where the topic is embedded inside another topic as a
component (subsection).
Entries marked "Fork" are a reference between the selected topic/publication and a position
in another publication. For example, in the image shown, the metadata is for a topic called
"Specifications". It has been added to a publication, and the "fork" reference from the
publication goes to the "Specifications" topic.

• Uses - The selected topic or publication can contain other topics and publications. They are
listed here.

• Related publications - The selected topic or publication is reused in each publication
shown in this list.

To find the reuse information in resource view:

1. In the Content Manager, select the folder that contains the topic or publication of interest.
If the topic or publication is not in a folder, create a new folder and move the topic or
publication into it.
Paligo displays the folder's contents in the resource view. It shows each folder, publication,
and topic stored in that folder.

2. Select the arrow icon next to the topic or publication of interest. Then select the Related
Resources tab.
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The reuse information is shown in these sections:

• Related publications - The selected topic or publication is reused in each publication
shown in this list.

• Reused content - The selected topic or publication can contain other topics and
publications. They are listed here.

• Reused in - Shows where the selected topic or publication is reused. This includes
publications and topics.

• Related images - Shows any images that are used in the selected topic (this only applies to
topics and is always set to 0 for publications).

Find Out Where Text Fragments are Reused
To find out where a text fragment (paragraph) is reused in your content, you can use:

• Element context menu [1138].

• Reuse text feature [1139].

This is useful when you are considering making a change to reused text, but need to understand
how those changes will affect other topics.

NOTE
When you edit a topic that contains reused text fragments (paragraphs), each
reused text fragment is shown with a chain icon. It is also highlighted.

Access Reuse Information with the Element Structure Menu
To use the element structure menu to find out where a text fragment is reused:

1. Edit a topic and select the paragraph that you are interested in.

2. In the element structure menu, select the #text element that comes after the para element.
Then select Text> Usage information.
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Paligo displays the Text usage dialog. It lists the topics that use the selected text fragment, and
provides information about the taxonomies, status, language. It also shows the name of the
user that last edited the paragraph, and the time when that edit took place.

If you select the topic in the list, Paligo will display that topic in the editor.
At the end of each row, there is an options menu ( ... ) where you can access other features
for the topic. These include a preview, the assignments feature, the review and contributor
editors and more.

3. Select Close.

Access Reuse Information with the Reuse Text Feature
To find out which topics use a text fragment, you can use the Reuse Text feature. This is available
when you edit a topic and is shown on the right-hand side of the editor [51].

1. In the search field, enter the text for the fragment that you want to find out about. Paligo will
present you with a list of close matches.

2. Find the entry that matches your search and then select its cog icon. From the menu, choose
Usage Information.

Paligo displays the Text usage dialog. It lists the topics that use the selected text fragment, and
provides information about the taxonomies, status, language. It also shows the name of the
user that last edited the paragraph, and the time when that edit took place.
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If you select the topic in the list, Paligo will display that topic in the editor.
At the end of each row, there is an options menu ( ... ) where you can access other features
for the topic. These include a preview, the assignments feature, the review and contributor
editors and more.

Find Out Where Images are Used
To find out where images are used, access the metadata for the media file.

1. Open a topic that contains the media in the Paligo editor.

2. Right-click on the topic and select Edit Properties.

3. Look at the Reused in section on the dialog. It contains links to the topics where the media is
reused.

Alternatively:

1. In the Content Manager, expand the Media section and find the media file you are interested
in.

2. Select the options menu ( ... ) for the media file and then select Edit Image.

3. Look at the Reused in section on the dialog. It contains links to the topics where the media is
reused.
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Filtering / Profiling
Abstract

Learn how to use filtering, also known as profiling, to control which content is included in your
outputs. Find out what you can filter and how the filtering works.

Filtering is also known as "profiling" or "conditional content" and you can use it to include or
exclude content depending on certain conditions. For example, you can set a topic to be included
in your publication if the intended audience is beginners, but excluded if the audience is experts.

You can use filtering to include or exclude:

• Entire topics in a publication

• Elements in a topic, such as paragraphs, procedures, or steps in a list.

Filtering gives you more control over your content and can also give you more opportunities for
your topics. Let's say that you have a topic that could be reused, if only it did not contain a
particular paragraph. By filtering that paragraph, you can make the topic suitable for reuse, as you
can include or exclude the paragraph when needed.

How Filtering Works
Paligo has several different types of filtering, but to begin with, we recommend you learn about
"regular" filtering.

The workflow for "regular" filtering is:

1. You mark up the content that you want to filter. This tells Paligo what content can be filtered,
and what conditions apply.
To set the conditions, you choose a type of filtering to apply and you set a filter value.
Paligo does not have one generic filter for everything. Instead, it has a range of filter types,
called filter attributes. There are different filter attributes for filtering by product name, by
audience, by country, and by market, among others.
For example, to filter a paragraph so that it only appears in a user guide for a Windows
version of a product, you could set a filter attribute of os (operating system) and a filter value
of Windows.

2. You set the filters you want Paligo to apply to the published output.
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3. Paligo then:

• Includes all of the content that does not use the filters attributes you chose for publishing.

• Searches through your content to find any elements that have the filter attribute(s) that you
set for the publication. For example, if you set an os filter attribute in the publication, Paligo
will find all of the elements that are marked up to have an os filter attribute. These are the
"matching" elements.

• Searches through the "matching" elements to check the filter values. Those with the same
value that you set for the publication are included in the published output. Those that have
different values are excluded.

TIP
If you want to exclude content, create filter values for the conditions
where it should be included and also for where it should be excluded. For
examples, see Mark Up Elements for Filtering [1154] and Mark Up Topics
for Filtering [1165].
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NOTE
The process for setting up filtering is different for scoped filtering [1144],
taxonomy filtering [1175], and filtering by language [1151].

Regular Filters, Taxonomy Filters and Scoped Filters
There are several ways of applying filters to your content in Paligo. They all involve marking up
your content for filtering and then setting filters on the publication. But the process for doing this
is different depending on which method of filtering you choose to use.

The two main types of filtering are:

• "Regular" filtering, where you edit a topic and apply a filter attribute and filter value to one or
more elements. You can use "regular" filtering for filtering entire topics or individual elements in
a topic.
To get started with "regular" filtering, see:
Filter Topics in a Publication [1165]
Filter Block Elements in a Topic [1153]

• Taxonomy filtering, where you set up taxonomy tags to represent the filter attributes and
values, and you drag and drop them on to your topics. You can also set Paligo to use the
taxonomy hierarchy for more complex filters, where Paligo uses the taxonomy hierarchy to
determine which topics to include or exclude.
See taxonomy filtering [1175] for more details.

There is also scoped filtering [1144]. This is for when you want to use the same content in the
same publication, but apply different filters depending on where the content appears.

You can use a mix of the different filtering types, if needed.

Filter Attributes
When you set a filter in Paligo, there are many different types of filter you can use. Some are
defined by the DocBook standard and some are custom filters that we have created for Paligo.

The following table shows the filters you can use:

Filter attribute Source Description

arch DocBook Filter by computer or chip architecture.

audience DocBook Filter the content based on the intended users, for example, internal staff or customers.
You could use audience for the knowledge level too, such as beginner or expert. But
there is a userlevel attribute specifically for that, so can use audience or userlevel,
but it is important to be consistent.

condition DocBook This is a general purpose filter attribute. Use this filter if the other filters do not meet
your requirements.

conformance DocBook Filter by conformance standards.

os DocBook Filter by operating system, for example, Windows.
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Filter attribute Source Description

revision DocBook Filter by publication revision, for example, v.3.1.

security DocBook Filter by security level, for example, Low.

userlevel DocBook Filter by knowledge level of the intended audience, for example, expert.

vendor DocBook Filter by product provider, such as a manufacturer or seller.

outputformat DocBook Filter by the type of output, for example PDF.

xinfo:product Paligo Filter by product name or model.

xinfo:country Paligo Filter by the country that the documentation is designed for, for example, USA.

xinfo:market Paligo This is similar to xinfo:country except that it is less geographically rigid, for example, you
can filter for the Asia market or the North America market.

xinfo:version Paligo Filter by version. You can use this in combination with the version management features
of Paligo, but this is not a requirement. The usage is up to you.

xinfo:proglang Paligo Filter by programming language or to publish to API style [1092] "on-the-fly" filtering
HTML5.

NOTE
Paligo does not support using xinfo:proglang on table rows.

xml:lang DocBook Filter by natural language, for example, filter Swedish content. This filter attribute is a
special case, as there is a different process for using language filters. To find out more,
see Filter by Language [1151].

To find out how to use filters in your content, see Filter Block Elements in a Topic [1153] , Filter
Topics in a Publication [1165], and Filter by Language [1151].

Scoped Filtering
Scoped filtering is a powerful feature in Paligo that allows you even more flexibility when it
comes to profiling / filtering content. It is designed for when you want to reuse your content
in multiple places within the publication and to be able to apply different filters depending on
where it appears in the publication. Scoped Filtering can be used in combination with Taxonomy
Filters [1175].

The workflow for scoped filtering:

1. Make sure scoped filtering is enabled. It is enabled by default, but it may have been disabled
on your Paligo instance, see Enable Scoped Filtering [1148].

2. Organize your publication structure so that you have "parent" topics (high level) with the
"child" topics (lower level) as subsections.
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3. Apply filters to your "child" topic elements.

4. Apply the "scope filters" on "parent" topic elements. Typically, you should set the scope filters
on the section element.

5. Publish your content and include the filter attributes that are set on the "scope filters" and all
of the filter values that should be used.

NOTE
Scoped filtering is advanced. Make sure you understand the basic profiling/
filtering concepts before using scoped filtering, see Principles of Scoped
Filtering [1145]

Principles of Scoped Filtering
The important principles of scoped filtering are:

• Scoped filtering applies to content that is reused in the same publication.

• With scoped filtering you can reuse topics and set them to use different filter values, depending
on where the topic is positioned in the publication structure.

• You tell Paligo which filter values a "child" topic should use by setting a "scope filter" on the
"parent" topic

• When you publish, you set the filters and include all of the values that you want to use in the
publication.

To show you how scoped filtering can be used, we'll guide you through an example.

Example 60. Scoped filtering for applying different filters to reused content
Let's say you are documenting a product, for example, a fictional video conference software called
ACME VCT. The software supports MacOS and Windows, and as most of the documentation is the
same for both versions, you want to create a single user guide rather than two separate versions.
The user guide will have a MacOS section and a Windows section.

In Paligo, you create the content and organize it in a publication structure like this:

You have a "chapter" for Windows content, called "Installing on Windows", and you have "Installing
on MacOS" as a chapter about MacOS.
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You have also reused two topics. The "Prerequisites" topic and the "System Requirements" topic
are both used in the Windows and MacOS chapters. For this example, we will focus on the "System
Requirements" topic.

In the "System Requirements" topic, you have some information that is for Windows only, and
some that is for MacOS only.

In the image above:

1. This is for content that is only relevant to MacOS. You apply an os filter to this content and set
the filter value to macos.

2. This is content that is only relevant to Windows. You apply an os filter to this content and set
the filter value to windows.

If you published the content as it is, you would only be able to set the os filter to be either
Windows only, MacOS only, or include Windows and MacOS.

This is where scoped filtering comes in. You can use it to tell Paligo to use an os:windows filter in
some places, but an os:macos filter in others.

To set the scoped filtering, set a "scope filter" on the section element of a topic that is at a higher
level than the topic you want to filter. In this scenario, the higher-level topic is called a "parent"
and the lower-level topic is called a "child".

Note that the "scope filter" is not a type of filter, it is the term we use to describe the filter that is
set on the "parent" topic.

Paligo Documentation

1146



In this example, there are two "scope filters" to set (1 and 2 on the image above):

1. Set the "scope filter" for the Windows chapter on the section element of the "Installing on
Windows" topic. The "scope filter" is the os filter with the value: windows.

With this "scope filter" you are telling Paligo that if any "child" topics in this chapter contain os
filters, Paligo should include any that have the value: windows. But it should exclude any that
have different values.

2. Set the "scope filter" for the MacOS chapter on the section element of the "Installing on
MacOS" topic. The scope filter is the os filter with the value: macos.

This "scope filter" tells Paligo that if any "child" topics in this chapter contain os filters, Paligo
can include any that have the value: macos. But it should exclude any that have different
values.

You now have your content marked up for scoped filtering. The final step is to set the filter and
values when you publish.

You publish your content and you edit the Profiling attributes on the Publish document dialog.
You choose to include the os filter. Importantly, for scoped filtering, you include all of the os
values that need to appear in the published output. In this case, you want the Windows filtered
content to appear in one chapter and the MacOS content to appear in another chapter, so you
include both values.
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The published output will now have reused the same topic "System Requirements" in two parts of
the documentation, but it will appear differently in the Windows and MacOS sections respectively,
even though it is in the same output:

Windows version MacOS version

Enable Scoped Filtering
In the Layout Editor [57] it is possible to enable scoped filtering for both HTML5 and PDF output.
Make sure the option is set to Yes or Default.

NOTE
For PDF output, you find this setting under General / Filtering and taxonomies /
Enable scoped profiling / filtering.

The following instruction shows how to enable this setting for HTML5 output:

1. Select the Layout tab in the top menu.

Paligo Documentation

1148



Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Classes and attributes in the left menu.

4. Select Yes to Enable scoped profiling / filtering.

5. Select Save.

Preview Your Filters
When you mark up your content for filtering, you can use the preview feature to see the effects
of the filters. This is a good way of making sure that the filters work as expected, and is especially
useful if you have used a combination of filters.

To preview the filters:

1. Find the topic that contains the filters in the Content Manager, and open it in the editor.

2. Select Preview > Profile settings.

3. Select Profiling.
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4. For each filter attribute, select the field and choose the filter you want to apply for the
preview. If you do not want to apply a particular filter, leave its field blank.

5. Select Apply.
The filter is applied to the preview of the topic:

• Any content that is not marked up to use the types of filter you have applied is included in
the content.

• Any content that is marked up to use the filters you have applied, with the same values you
have set, is included in the content.

• Any content that is marked up to use the filters you have applied, but with different values,
is excluded.

For example, if you set the preview to show the Market filter attribute with a value of Europe,
the topic would show:

• Any content that is not marked up to use the Market filter attribute
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• Any content that is marked up to use the Market filter attribute and a value of Europe
The preview would exclude any content that has the Market filter attribute and any other
value, such as Asia, North America, Australasia, etc.

6. Repeat steps 4 and 5 to change the filters for the preview and see how they affect the content.

To stop applying the filter preview, display the Profile settings dialog select the Profiling tab, and
then select Reset.

Filter by Language
You can use the xml:lang attribute to filter content by (natural) language for HTML and PDF
outputs. This means you can mark an element as being appropriate for a language, and the
element will only be included if the content is published to that language. If you publish to
different languages, the element is excluded.

The xml:lang attribute works a little differently to the other filter attributes. Firstly, to use it, you
need to enable the feature on the layout that you will use for publishing. Then you can add it to
elements that you want to filter, and finally, you publish and choose what languages to publish to.
Paligo applies the language filters automatically, based on what languages you are publishing to.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Classes and Attributes for HTML layouts OR General > Filtering and Taxonomies for
PDF layouts.

4. Select Enable for Use xml:lang as profiling attribute.

5. In your content, select an element that you want to filter by language.

6. Use the Element Attributes Panel [55] to add the xml:lang filter attribute and set its value
to the appropriate language. For the language values, use the two-letter language codes, for
example, en for English and sv for Swedish.

IMPORTANT
Use the two-letter codes shown in the Languages section (see step 6). Only
these two-letter codes are supported. You cannot use alternative language
codes.
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7. Repeat steps 3 and 4 for other any other elements you want to filter by language.

8. Publish your content and choose the layout you edited in step 1 and the language(s) that you
want to publish to:

• If you publish to a language that matches the value of the xml:lang filtered content, that
content is included in the output.

• If you publish to a language that does not match the value of the xml:lang filtered
content, that content is excluded from the output.

9. Set any variables and other profiles as required and then publish.

Filter Inline Content
You can use the phrase element to apply filters to inline content. This is useful when you need
to filter part of a block element, for example, if you wanted to filter one sentence in a paragraph
rather than the entire paragraph.

To filter inline content:

1. Select the content you want to filter.

2. To display the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

3. Add the phrase element.
Paligo inserts your selected content into the phrase element.

4. Click in your selected content so that the phrase element is shown in the Element Structure
Menu.
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5. In the Element attributes section, add the filter condition that you want to apply to the
phrase. This works in the same way as filtering any other element, for example, you could set
an xinfo:country attribute if you wanted to be able to include/exclude the phrase based on
the country.

To find out about filter types, see Filter Attributes [1143].

6. Set the value for the filter and apply it to your phrase element.
To find out about filter values, see Filter Block Elements in a Topic [1153].

7. Select Save.

When you publish, you can choose which filters to apply to your content. As the inline content is
now wrapped in a phrase element, it can be filtered in the same way as any other element. The
settings you choose when you publish will determine whether the phrase is included or excluded
from the published content.

Filter Block Elements in a Topic
In this section, you can learn how to apply filters to block elements, such as paragraphs, lists, and
images. These filters apply to an entire block of content. If you want to filter inline content, such as
one sentence or one word in a paragraph, see Filter Inline Content [1152].

Filtering block elements is useful when you have entire elements that you want to include or
exclude, depending on certain criteria. For example, you could have a paragraph that is only
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relevant to Mac users, so you could add a filter to include or exclude it, depending on whether the
publication is for Windows or Mac.

NOTE
To apply filters to elements in a topic, use the "regular" type of filtering (you
cannot use taxonomy filters for filtering elements in a topic).

To learn how to set up filters on block elements, watch the video or read the following sections.
The video shows a list item being filtered, and you can use the same technique to filter other block
elements.

https://player.vimeo.com/video/345407893

To filter elements in a topic:

1. Mark up your content for filtering [1154]. For filtering elements in a topic, use the "regular"
type of filtering. You cannot use taxonomy filters for filtering elements in a topic.

2. Preview your content [1149] to see how the filters will affect your content (this is an optional
step).

3. Set the filters that you want your publication to use [1163] and then publish.

Mark Up Elements for Filtering
Before you can apply filtering to your publications, you need to tell Paligo what elements can be
filtered, and what filter conditions apply. You can do this by "marking up" the elements that you
want to filter.

To mark up your content, you can select an element and then apply a filter attribute and a filter
value. The filter attribute tells Paligo which type of filter to use, and the filter value sets the
condition for the filter.

Element (1), filter attribute (2), filter value (3).

Paligo does not have one generic filter for everything. Instead, it has a range of filter types, called
filter attributes. There are different filter attributes for filtering by product name, by audience, by
country, and by market, among others.

NOTE
Marking up the content tells Paligo what content can be filtered. It does not apply
the filter. You apply the filter in the publishing settings when you publish the
content.
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1. Edit the topic that contains the element you want to filter. Select any part of the element so
that it is shown in the Element Structure Menu.

2. In the Element Structure Menu, select the element you want to filter and then select Go to
element.

TIP
If you want to filter text inside a paragraph, and not the entire paragraph,
highlight the text and add the phrase element to it. You will then be able to
apply the filter attribute and value to the phrase element so that it can be
included/excluded when you publish.

3. In the Element attributes section, select Add attribute and search for the filter attribute you
want to use. Note that the Add attribute list includes all attributes, not just filters
There are many different types of profile attribute (filter) that you can use, including product
name, country, and audience. To find out about the different profile attributes, see Filter
Attributes [1143].
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4. Use the Profiling values dialog to set the filter value. Think of setting the value as a way of
telling Paligo where the content is applicable.
For example, if you have a paragraph that is only applicable to a product named "ACME 1050",
you could give it the xinfo:product filter attribute and set the filter value to ACME 1050.
You can have single values or you can add multiple values, where Paligo will include the
content if either of the values are a match.
Choose from any of the available values or use Add value to create more values if needed.

NOTE
We have included some more detailed examples of how you can use filter
conditions to include and exclude content at the end of this section.
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5. Repeat steps 2-4 inclusive to apply filters to as many elements as needed.

You have now set the profile attributes and values for the content you want to filter. We
recommend that you preview the filters to see how they work before you publish.

Example 61. Use multiple filter values to create an OR filter

Let's say you have a paragraph that is only applicable for customers in North America and the EU.
You want to include the paragraph when you are publishing to those markets, but want to exclude
it when you are publishing to the Middle East, Australia, and other markets. This is where you need
an OR filter, as you want the content to appear when the market is North America OR the EU.

To mark up the paragraph, you:

1. Select the para element.

2. Add the xinfo:market attribute

3. Set the attribute value. As the content applies to two markets, you have to set two values:
North America and EU. Another option would be to create another filter that represents North
America and the EU combined, but this could be cumbersome in this case.

When you publish the content, you can choose the filters for the publication.
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• If you set the publication's market filter to North America, EU, or both North America and EU,
the filtered paragraph is included.

• If you set the publication's market filter to another region, such as Australia, the filtered
paragraph is excluded.

• If you do not set a market filter for the publication, the filtered paragraph is included. It is only
excluded from the publication if the market filter is applied and the value for the market filter
does not match North America or EU.

Example 62. Exclude a filter value rather than include it
Paligo's filtering is inclusive, which means that when you set a filter, you are telling Paligo what
content you want to be included in the output. But there may be times where you want to exclude
certain content rather than include it. For these situations, set up filter values for:

• The conditions where you want the content to be included

• The conditions where you want the content to be excluded.

Then, when you publish, you can tell Paligo which content to include. By including one condition,
you automatically exclude the other possible conditions.
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NOTE
The "inclusive" filtering strategy may take a while to wrap your head around if you
are new to filtering or if you come from another environment where you used
filters for both including and excluding specifically. But once you get the idea, the
inclusive strategy is very powerful in that it can accomplish exactly the same, but
with a much cleaner structure, so you will have a more robust long-term solution.

Let's say you have three types of users: administrators, engineers, and operators. You have a
paragraph that you want to be included for the engineers and operators, but excluded for the
administrators. To set this up you:

1. Select the para element.

2. Add the audience attribute.

3. Select the value for the audience attribute and create these values: "administrators",
"engineers", "operators".
Note that it is important to create values for where you want the content to be included and
also for where you want it to be excluded.

4. Set the audience attribute value to "engineers" and "operators".

When you publish the content, you can choose the filters for the publication.

To publish for the administrator audience, you set the audience to "administrators".
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The published output will then include:

• Any content that has an audience filter with a value of "administrators". The paragraph that you
marked up has an audience filter with a value of "engineers" and "operators", and so it is not
included in the published output.

• All content that does not have an audience filter

To publish for the engineers or operators, you set the publication's audience filter to "Engineers"
and "Operators".
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The published output will then include:

• Any content that has an audience filter with a value of "Engineers" or "Operators". So the
paragraph that you marked up is included in the published output.

• All content that does not have an audience filter.

Preview Your Filters
When you mark up your content for filtering, you can use the preview feature to see the effects
of the filters. This is a good way of making sure that the filters work as expected, and is especially
useful if you have used a combination of filters.

To preview the filters:

1. Find the topic that contains the filters in the Content Manager, and open it in the editor.

2. Select Preview > Profile settings.

3. Select Profiling.
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4. For each filter attribute, select the field and choose the filter you want to apply for the
preview. If you do not want to apply a particular filter, leave its field blank.

5. Select Apply.
The filter is applied to the preview of the topic:

• Any content that is not marked up to use the types of filter you have applied is included in
the content.

• Any content that is marked up to use the filters you have applied, with the same values you
have set, is included in the content.

• Any content that is marked up to use the filters you have applied, but with different values,
is excluded.

For example, if you set the preview to show the Market filter attribute with a value of Europe,
the topic would show:

• Any content that is not marked up to use the Market filter attribute
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• Any content that is marked up to use the Market filter attribute and a value of Europe
The preview would exclude any content that has the Market filter attribute and any other
value, such as Asia, North America, Australasia, etc.

6. Repeat steps 4 and 5 to change the filters for the preview and see how they affect the content.

To stop applying the filter preview, display the Profile settings dialog select the Profiling tab, and
then select Reset.

Apply Filters for Publishing
When you publish your content, you can choose which filters to apply to the published output
(HTML5 help center, PDF, etc.).

1. In the Content Manager, find the topic or publication that you want to publish. Select its
options menu ( ... ) and select Publish.

2. On the Publish document dialog, select an output type (PDF, HTML5, etc.), and set the
Languages, Variables, and Optional Parameters.
These are common publishing settings. To find out more, see Publishing Process [1068].

3. Select the Edit option in the Profiling attributes section. Paligo displays the Profiling
attributes dialog.

The Profiling attributes dialog contains a list of the filter attributes that you can use. There is a
field for each attribute.

4. Select the field for a filter attribute that you want to apply to your publication. A drop-down
list of the available values appears. These are the values that have been created for the filter
when the content was marked up for filtering.
Choose the value that you want to apply.
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You would normally just choose one value for each filter attribute, the variant that you want
to publish at the moment. This is usually the recommended strategy. It's possible to choose
multiple values for a filter, however. The filter then works as an OR filter, where Paligo will
filter topics that contain any of the values you set (value 1 or value 2 or value 3, etc.).

TIP
When you choose filters, you are telling Paligo which content to include in
the published output. But sometimes, you may want to exclude content
rather than include it. For example, you might want to publish content for
all audience types except administrators. To do this, you need to mark up the
content so that:

• The content you want to include has a condition (filter attribute) and a
value

• The content you want to exclude has the same condition as those that you
want to include. But set a different value for the topics you want to exclude.

When you publish, you choose which condition value to include. Paligo will
then:

• Include any content that has the matching condition and value

• Include any content that does not use the matching condition

• Exclude any content that uses the matching condition, but has a different
value.
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5. Repeat step 4 for each attribute and value that you want to apply and then select OK.

NOTE
Only set a value for those filter attributes that you want to apply to your
publication. For any attributes that you do not want to use, leave their fields
blank. When there is no attribute set, Paligo ignores that type of filter.

6. Select Publish document to publish your content.

Filter Topics in a Publication
You can filter topics so that they are included/excluded in your published output. For example, if
you have a topic that is only relevant to Mac users, you could set an os (operating system) filter
on the topic, with a filter value of macos. Then, when you publish, you can set Paligo to include
the topic if you are publishing a Mac user guide or exclude it if you are publishing a Windows user
guide.

In this section, we explain how to filter topics using the "regular" way of filtering. But you can also
filter topics by using taxonomy filtering [1175], where you apply the filter attributes and values by
dragging and dropping taxonomy tags.

To find out about using the "regular" way of filtering topics, watch the video or read the following
instructions:

https://player.vimeo.com/video/352679360

To use the "regular" way:

1. Mark up the topics that you want to filter. Apply the filter attributes and values to the top
section element in your topic.

2. Apply the filters you want to use for publishing your output.

For more details on marking up and applying the filters, see the following sections.

Mark Up Topics for Filtering
If you want to filter entire topics, you need to mark them up so that Paligo knows which topics can
be filtered and what filter conditions apply. Marking up involves giving the top section element
(1) of a topic a filter attribute (2) and a filter value (3).
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NOTE
Marking up the content tells Paligo what content can be filtered. It does not apply
the filter. You apply the filter in the publishing settings when you publish the
content.

To mark up a topic for filtering:

1. Edit the topic that you want to filter, and then select the top section element in the Element
Structure Menu. Select Go to element.

2. In the Element attributes section, select Add attribute and search for the filter attribute you
want to use. Note that the Add attribute list includes all attributes, not just filters
There are many different types of profile attribute (filter) that you can use, including product
name, country, and audience. To find out about the different profile attributes, see Filter
Attributes [1143].
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3. Use the Profiling values dialog to set the filter value. Think of setting the value as a way of
telling Paligo where the content is applicable.
For example, if you have a topic that is only applicable to a product named "ACME 1050", you
could give it the xinfo:product filter attribute and set the filter value to ACME 1050.
Choose from any of the available values or use Add value to create more values if needed.
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You can have single values or you can add multiple values, where Paligo will include the topic
if either of the values are a match.

NOTE
We have included some more detailed examples of how you can use filter
conditions to include and exclude content at the end of this section.

4. Repeat this process to markup any other topics you want to filter.

Example 63. Use multiple filter values to create an OR filter

Let's say you have a topic that is only applicable for customers in North America and the EU. You
want to include the topic when you are publishing to those markets, but want to exclude it when
you are publishing to the Middle East, Australia, and other markets. This is where you need an OR
filter, as you want the content to appear when the market is North America or the EU.

To mark up the topic, you:

1. Select the top section element in the topic.

2. Add the xinfo:market attribute

3. Set the attribute value. As the content applies to two markets, you have to set two values:
North America and EU. Another option would be to create another filter that represents North
America and the EU combined, but this could be cumbersome in this case.

When you publish the content, you can choose the filters for the publication.
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• If you set the publication's market filter to North America, EU, or both North America and EU,
the filtered topic is included.

• If you set the publication's market filter to another region, such as Australia, the filtered topic is
excluded.

• If you do not set a market filter for the publication, the filtered topic is included. It is only
excluded from the publication if the market filter is applied and the value for the market filter
does not match North America or EU.

Example 64. Exclude a filter value rather than include it
Paligo's filtering is inclusive, which means that when you set a filter, you are telling Paligo what
content you want to be included in the output. But there may be times where you want to exclude
certain content rather than include it. For these situations, set up filter values for:

• The conditions where you want the topic to be included

• The conditions where you want the topic to be excluded.

Then, when you publish, you can tell Paligo which content to include. By including one condition,
you automatically exclude the other possible conditions.
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Let's say you have three types of users: administrators, engineers, and operators. You have a topic
that you want to be included for the engineers and operators, but excluded for the administrators.
To set this up you:

1. Select the top section element in the topic.

2. Add the audience attribute.

3. Select the value for the audience attribute and create these values: "administrators",
"engineers", "operators".
Note that it is important to create values for where you want the topic to be included and also
for where you want it to be excluded.

4. Set the audience attribute value to "engineers" and "operators".

When you publish the content, you can choose the filters for the publication.

To publish for the administrator audience, you set the audience to "administrators".
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The published output will then include:

• Any topics that have an audience filter with a value of "administrators". The topic that you
marked up has an audience filter with a value of "engineers" and "operators", and so it is not
included in the published output.

• All topics that do not have an audience filter

To publish for the engineers or operators, you set the publication's audience filter to "Engineers"
and "Operators".
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The published output will then include:

• Any topics that have an audience filter with a value of "Engineers" or "Operators". So the topic
that you marked up is included in the published output.

• All topics that do not have an audience filter.

Apply Filters for Publishing
When you publish your content, you can choose which filters to apply to the published output
(HTML5 help center, PDF, etc.).

1. In the Content Manager, find the topic or publication that you want to publish. Select its
options menu ( ... ) and select Publish.

2. On the Publish document dialog, select an output type (PDF, HTML5, etc.), and set the
Languages, Variables, and Optional Parameters.
These are common publishing settings. To find out more, see Publishing Process [1068].

3. Select the Edit option in the Profiling attributes section. Paligo displays the Profiling
attributes dialog.
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The Profiling attributes dialog contains a list of the filter attributes that you can use. There is a
field for each attribute.

4. Select the field for a filter attribute that you want to apply to your publication. A drop-down
list of the available values appears. These are the values that have been created for the filter
when the content was marked up for filtering.
Choose the value that you want to apply.
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You would normally just choose one value for each filter attribute, the variant that you want
to publish at the moment. This is usually the recommended strategy. It's possible to choose
multiple values for a filter, however. The filter then works as an OR filter, where Paligo will
filter topics that contain any of the values you set (value 1 or value 2 or value 3, etc.).

TIP
When you choose filters, you are telling Paligo which content to include in
the published output. But sometimes, you may want to exclude content
rather than include it. For example, you might want to publish content for
all audience types except administrators. To do this, you need to mark up the
content so that:

• The content you want to include has a condition (filter attribute) and a
value

• The content you want to exclude has the same condition as those that you
want to include. But set a different value for the topics you want to exclude.

When you publish, you choose which condition value to include. Paligo will
then:

• Include any content that has the matching condition and value

• Include any content that does not use the matching condition

• Exclude any content that uses the matching condition, but has a different
value.
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5. Repeat step 4 for each attribute and value that you want to apply and then select OK.

NOTE
Only set a value for those filter attributes that you want to apply to your
publication. For any attributes that you do not want to use, leave their fields
blank. When there is no attribute set, Paligo ignores that type of filter.

6. Select Publish document to publish your content.

Taxonomy Filters
You can use taxonomy filters to control whether a topic is included in a publication. For example,
you could use them on a topic so that it is included when you publish a Mac version of a user
guide, but excluded when you publish a Windows version.

Some Paligo users prefer to use taxonomy filters instead of the "regular" filters, see Filter Topics in
a Publication [1165], as they are quick and easy to use. All you need to do is create your taxonomy
tags, drag and drop them onto your topics and choose which tags to include when you publish.
Taxonomy filters can be used in combination with Scoped Filtering [1144].

Another benefit of taxonomy tags is that you can use them to create more complex filters, similar
to Scoped Filtering [1144]. For this, you organize the tags into a hierarchy. You can then set Paligo
to include all of the tags in a branch of the hierarchy, rather than one specific taxonomy tag.

For example, let's say you have set up the following taxonomy tag hierarchy:

1 is the tag that represents the type of filter you want to use, in this case, the filter is called "Market". This
is known as the filter attribute.

2 are all tags for individual filter values. Note that the value tags can be organized into a hierarchy too.
Here we have a value tag for the overall market, "USA", and then at a lower level, value tags for the
different sub-markets. In this case, the sub-markets are states of the USA.

You can then set Paligo to use the hierarchy in different ways. For example, you can set Paligo to
only include those topics that have the "Arizona" tag. Or you could set Paligo to include topics that
have the "USA" tag and/or the "Arizona" tag.

To find out about using taxonomy filters, watch the video or read the following instructions.

NOTE
You only need to Add Filter Values for Taxonomy Tags [1176] and Create Tags for
Taxonomy Filtering [1178] when you first set up taxonomy filtering or when you
want to add a new filter or filter value.
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Add Filter Values for Taxonomy Tags
Before you create taxonomy tags for filtering, you should add the filter values you need. Then,
when you create your taxonomy filter tags, you can give them the same names as the filter tags.
This is how Paligo recognizes the relationship between a taxonomy tag and a filter value - they
have to have the same name.

NOTE
If your Paligo instance already contains the filter attributes and values that you
need to use, ignore this procedure. Your next step is to Create Tags for Taxonomy
Filtering [1178].

1. Select the Publish option for any publication or topic, and then edit the Profiling attributes.

When you select Edit, Paligo displays the Profiling attributes dialog, which contains a list of the
filter attributes that are available. The filter attributes define the types of filter, for example,
there is a Market attribute for filtering by different regions.

2. Select the field for each profiling attribute to see what values are available.
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3. If you need to add values, create a new topic and select an element in it, such as a para
element. Then use the Element attributes section to add a new filter attribute, for example,
xinfo:product. Paligo displays the Profiling values dialog and you can use that to add new
values for the element.

Paligo Documentation

1177



Repeat this step for each filter attribute and value that you need for your publication.

When Paligo has all of the filter values that you need, you can Create Tags for Taxonomy
Filtering [1178].

Create Tags for Taxonomy Filtering
When you have added the filter values you need to Paligo, you can create the taxonomy tags that
you will use to mark your content for filtering.

NOTE
For this section, we assume that you already know how to create taxonomy tags.
If you need to find out more, see Create Taxonomies [1368].

You should create a taxonomy tag to represent:

• Each filter attribute that you want to use. The filter attributes define the type of filter, for
example, PRODUCT.

• Each filter value that you want to use. The filter values define the condition, for example, ACME
1050 could be a condition for a PRODUCT filter.
The filter value tags have to be at a lower-level than the filter attribute tags in the taxonomy
hierarchy.

The taxonomy tags you create need to have the same names as the filters and filter values that
they represent. For example, if you have a topic that is only relevant to an "ACME 1050" product,
you could use an xinfo:product filter. For this, you would create a tag called "product" and then
add a lower-level tag for "ACME 1050". (When setting the taxonomy tag names, do not include the
xinfo prefix).

Note that the taxonomy tags for filter attributes should be named to match the filter attribute
name
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To set up taxonomy tags for filtering:

1. Select the Taxonomy Manager in the Content Manager [34] to open the structure. 

2. Create taxonomy tags for the filter attributes and the filter values that you need.
For filter attribute tags, the tag name has to match the attribute name (but do not include
any xinfo prefix). For example, if you want a taxonomy filter for the xinfo:market filter
attribute, create a tag named: market.
To find out more about the attributes you can use, see Filter Attributes [1143].
For filter value tags, set the name to match the value. For example, if you have a market
filter with a value of "USA", the taxonomy tag for this should also be named "USA".

3. Drag and drop the taxonomy tags into a logical hierarchy. The hierarchy has to be organized
so that:

• The filter attribute tags are at the highest level (below the taxonomies tag, but above all
other tags)

• The value tags are at a lower level than the filter attribute that they relate to.
The filter attribute tags must be the "parent" and the value tags must be "children" in the
hierarchy.
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In the image "Market" (1) is the filter attribute tag. All of the other tags are filter value tags (2).
Note that you can have many levels of filter value tags, so that you can have greater control
when filtering.

TIP
When you have set up the taxonomy tags, you can Apply Taxonomy Tags to
Topics [1180].

Apply Taxonomy Tags to Topics
When you have the appropriate tags and hierarchy in place, you can apply the taxonomy filter tags
to your topics.

1. In the Content Manager, select the dotted menu ( ... ) for the Taxonomies tag, and then select
Floating content panel.

2. In the floating content panel, find the tag that you want to apply to a topic. Drag the tag onto
the topic in the Content Manager. Repeat this step for each topic that you want to filter.

Paligo Documentation

1180



When you have applied the taxonomy tags to your topics, the next step is to choose how Paligo
uses the taxonomy hierarchy when it applies the filters.

Set Taxonomy Filter Strategy
For taxonomy filters, Paligo gives you the option to choose a filter strategy. The strategy affects
how Paligo matches the filters and determines what topics should be included or excluded from
your publication.

To choose the taxonomy filter strategy:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Classes and attributes.

NOTE
For PDF layouts, they are in the General > Filtering and Taxonomies
settings.

4. Select Enable for Output taxonomies.

This setting has to be enabled for taxonomy filtering to work.

5. Select Exact Value or Descendants for Taxonomy filtering strategy.

This setting is labelled as Taxonomy filtering on some layouts.

• Exact value
If you choose Exact value, Paligo will ignore the taxonomy hierarchy. When you publish and
choose what filters to apply, Paligo will only include topics that:
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• Have a taxonomy tag that matches the filter attribute and filter value that you set for the
publication.

• Are not marked up to use the filter attribute that you set for the publication.

• Descendants
If you choose Descendants, Paligo will use the taxonomy hierarchy to determine which
topics should be included or excluded.
When you publish and choose what filters to apply, Paligo will only include:

• Topics that have a taxonomy tag that matches the filter attribute and filter value. We will
call this tag the "descendant" tag.

• Topics that have a tag that is a "parent" of the "descendant" tag in the taxonomy
hierarchy. Note that Paligo includes not only the immediate "parent" tag, but also the
"parent" of that tag and so on, until the top-level is reached.

• Topics that are not marked up to use the filter attribute that you set for the publication.

NOTE
There is also a Disabled option, which turns off the taxonomy filter feature.

6. Select Save.

When you have set a taxonomy strategy, you can publish your content and set the filters that you
want it to use.

Taxonomy Strategi Example
This example gives a detailed look at how the exact value and descendant value taxonomy
strategies affect the results of a filter.

Example 65. Taxonomy strategy

Let's say you have the following hierarchy for a Product filter, and you filter the publication to
include Product: ACME 1050. This is how the filtering strategies will work:

Exact value filter strategy applied Descendants filter strategy applied

The first image shows how the Exact value filter strategy works.

Paligo will ignore the structure of the taxonomy hierarchy. This means that the published output
will include:

• Topics that have the "ACME 1050" tag. Note that it has to be a "child" of the "Product" tag.
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• Topics that do not have any "Product" taxonomy tag

Paligo will exclude any topics that have a "Product" tag but with a different value to "ACME 1050".

The second image shows how the Descendants filter strategy works. Paligo uses the taxonomy
hierarchy and includes topics that have the matching tag ("ACME 1050") or are "parents" of the
matching tag. This means that the published output will contain:

• Topics that have the "ACME 1050" tag. Note that it has to be a "child" of the "Product" tag.

• Topics that have the "ACME 1000" tag or "ACME" tag, as these are "parent" tags of the "ACME
1050" tag in the taxonomy hierarchy.

• Topics that do not have any "Product" taxonomy tag

Paligo will exclude any topics that have a "Product" tag but with a different value to "ACME 1050".

Apply Filters for Publishing
When you publish your content, you can choose which filters to apply to the published output
(HTML5 help center, PDF, etc.).

1. In the Content Manager, find the topic or publication that you want to publish. Select its
options menu ( ... ) and select Publish.

2. On the Publish document dialog, select an output type (PDF, HTML5, etc.), and set the
Languages, Variables, and Optional Parameters.
These are common publishing settings. To find out more, see Publishing Process [1068].

3. Select the Edit option in the Profiling attributes section. Paligo displays the Profiling
attributes dialog.
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The Profiling attributes dialog contains a list of the filter attributes that you can use. There is a
field for each attribute.

4. Select the field for a filter attribute that you want to apply to your publication. A drop-down
list of the available values appears. These are the values that have been created for the filter
when the content was marked up for filtering.
Choose the value that you want to apply.

You would normally just choose one value for each filter attribute, the variant that you want
to publish at the moment. This is usually the recommended strategy. It's possible to choose
multiple values for a filter, however. The filter then works as an OR filter, where Paligo will
filter topics that contain any of the values you set (value 1 or value 2 or value 3, etc.).
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TIP
When you choose filters, you are telling Paligo which content to include in
the published output. But sometimes, you may want to exclude content
rather than include it. For example, you might want to publish content for
all audience types except administrators. To do this, you need to mark up the
content so that:

• The content you want to include has a condition (filter attribute) and a
value

• The content you want to exclude has the same condition as those that you
want to include. But set a different value for the topics you want to exclude.

When you publish, you choose which condition value to include. Paligo will
then:

• Include any content that has the matching condition and value

• Include any content that does not use the matching condition

• Exclude any content that uses the matching condition, but has a different
value.

5. Repeat step 4 for each attribute and value that you want to apply and then select OK.

NOTE
Only set a value for those filter attributes that you want to apply to your
publication. For any attributes that you do not want to use, leave their fields
blank. When there is no attribute set, Paligo ignores that type of filter.

6. Select Publish document to publish your content.

Variables
Variables allow you to swap out small parts of content for different publications. They are very
useful when you have topics that you want to reuse, but need to have parts of the text changed,
such as product names.

For example, let's say you have a topic and you insert the product name "Acme 100" as plain text.
By adding it as plain text, you have limited where the topic can be reused, as it is specific to the
"Acme 100" and so cannot be used for other products. But if you use a variable to set the product
name, you can reuse the topic and tell Paligo which product name to use each time you publish.
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Variable Types
In Paligo, there are several types of variable that you can use:

• Text: for plain text that does not need to be translated, such as product names, number values,
etc.

• Text (translatable): this variable type will let you enter translations of each variable value (for
the languages you have selected). If you use this type of variable, remember that different
languages can have very different grammars. Translated variables can read badly if the
grammar, gender, etc., of each language has not been considered.

• Image: these variables allow you to swap out images. They are useful when you have topics that
contain images that need to be changed for different variants or publications. It is often more
convenient to have a variable for the image, rather than many images with filtering.

• XML: these variables are similar to plain text variables, but allow you to add XML tags too, so
you can include inline tags if needed.

• Dynamic text variables: These are a special type of variable, and you can use them for
inserting things like today's date or for inserting the content from an element that is elsewhere
in the publication. They are different to other variable types as you do not create them in
variable sets. Read more about them in Dynamic Text Variables [1203].

Variables Workflow
To use variables in your topics and publications, follow this process:

1. Create a variable set. This is a collection of variables and the possible values that they can
contain.

• In the variable set, add variables for each type of information that needs to change in
different scenarios.

• Create variants for the variables. A variant is a collection of values that will be inserted into
the variables when you publish. For example, if you have a product name variable, you
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could have a variant where the product name is "ACME 100X" and you could have another
variant where the product name is "ACME 200X". Think of each variant as the values that will
be used in one particular scenario.

You can skip this step if you already have suitable variable sets available in Paligo.

2. Insert variables into your topics where appropriate.

3. Preview the variables to check that they are providing the correct information.

4. Publish your content and choose the variants that Paligo should use.

NOTE
The process is different for Dynamic Text Variables [1203].

Superscript Text in Variables
You can use variables for many different types of changeable content, but one of the most popular
uses is for product names and company names. With these, you may want to add superscript text
to the variable, for example, to add a trademark TM after the product name.

To add superscript text to a variable:

1. Create or edit a variable set (see Create a Variable Set [1191]).

2. In the variable set, create an XML variable and give it a name, for example, ProductNameTM.

3. Set the value for the XML variable. The value is called a variant. As this is an XML variable,
include the inline <superscript> element. For example:

ACME<superscript>TM</superscript> 1000

4. Insert the variable [1199] in your topics as needed.
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Use XML Variables for Links
Using XML variables is the only way to have links that change depending on publish settings.
Unlike text variables, they allow you to use full XML strings. A link's destination is determined by
the URL in the underlying XML, so you can use XML variables to change the link dynamically.

With XML variables, your link label can have the same name, but the destination can change
depending on your publishing settings. You can use a different label altogether or disable linking
completely in some versions of your documentation. XML variables give you more flexibility than
other types of variables.

As an example, if there is a product that has two versions for different markets (one for the US
market and one for the European market), the link label can be the same but the link destination
can point to different distribution websites. You can also change the link label to something like
"US Store" for the US version of the documentation, and "Europe Store" for the European version,
with different link destinations for each.

This instruction shows how to use different web pages depending on market.

1. Select the Dotted Menu (...) for the Variable sets in Content Manager [34].

2. Select Create variable set from the menu.

3. Enter a name for the variable set and select the check mark. 

4. Expand the Variable sets with the arrow to the left. 

5. Select the new variable set.

6. Select Add variable for each variable that is to be inserted in a topic.

7. Name it and select XML to make it a link variable. 

8. Select Add variant for each variant to publish to.
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9. Copy the XML code below:

<link xlink:href="ZZZ">XXX</link>

10. Replace ZZZ with the URL.

11. Replace XXX with the visible link label.
In the example, we used "Car window" and "Electric motor" as the visible link names. Scroll down to
see the result.

NOTE
To show the URL instead, remove the XXX.

12. Open a topic and insert the created XML link variables. 

13. Select Preview in the toolbar to be able to evaluate the result.

14. Select Profile settings. 

15. Select the Variables tab. 

16. Select the variable set and XML link variable to be used.

17. Select Apply.
Chosen XML link variable will be shown in the topic.

18. Publish the topic to see the visible link name.
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Variable Sets
With variables you can alter small pieces of content (text, images, values, links) that you want to
change for different scenarios. This makes it possible to reuse more content. The variables are
defined in a Variable Set, which is a collection of variables and their possible values.

When you publish with a variable set containing variants, you can choose which variant to be used.
The variables (like height, product name, variant image, weight and width) fetch the values
from the column that represents the chosen variant.

• The left column contains the variables, which are the placeholders that you add to your
topics. In this column, you enter the variable names.

• The second, third and fourth columns contain variants. Each variant column represents
a different scenario and contains the terms or values that will be used for the variables, for
example different weights.

TIP
Once the Variable Set is created, you can use the variables in your topics, see Use
Variables [1199].

Create a Variable Set
To create a variable set, watch the following video or read the instructions below.

https://player.vimeo.com/video/342697441

1. Scroll down to Variable sets in Content Manager [34]. 

2. Select the Dotted Menu (...) for Variable Sets.
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3. Select Create variable set.

4. Name the variable set.

5. Select the new variable set to open it in the Variable Editor.

Paligo displays it in the Variables Editor.

6. Select Add Variable .

7. Select the Variable type to create.

• Text: for plain text that does not need to be translated, such as product names, number
values.

• Text (translatable): this variable type will let you enter translations of each variable value
(for the languages you have selected). If you use this type of variable, remember that
different languages can have very different grammars. Translated variables can read badly if
the grammar, gender of each language has not been considered.

• Image: these variables allow you to swap out images. They are useful when you have topics
that contain images that need to be changed for different variants or publications. It is often
more convenient to have a variable for the image, rather than many images with filtering.
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• XML: these variables are similar to plain text variables, but allow you to add XML tags too,
so you can include inline tags if needed.

TIP
If you create a text variable and later realize that you need it to be a
translatable variable, you can convert it by using the Convert Variable Type
option [1193]. Similarly, you can convert a translatable variable into a text
variable.

8. Repeat step 4 to create as many new variable types as needed for this variable set.

9. Select Add variant and enter a name.
The variant is going to be one set of values that can be used for the variables. You might want
different values for depending on the product model you are publishing for, so add product
models as the variant columns.

10. Enter values for each variable.
These values will only be used if this particular variant is selected when publishing.

11. Repeat steps 9 and 10 to create as many variants and variant values as needed.

Convert Variables
You can convert an existing text variable into a translatable variable or vice versa by
using the Convert Variable Type option. Paligo automatically detects the type of variable you
have selected and will convert it into the other type.

TIP
If you have made a mistake, you can always do another conversion to change the
variable back to its previous type.

To convert a variable:

Paligo Documentation

1193



1. Scroll down to Variable sets in Content Manager [34]. 

2. Select the arrow in front of the Variable sets to expand it. 

3. Select the variable set that contains the variables you want to convert.

Paligo displays it in the Variables Editor.

4. Select the Dotted Menu (...) for the variable you want to convert.

5. Select Convert Variable Type.

6. Select Confirm to convert the variable.

Copy a Variable Set
You can copy an existing variable set to use as a starting point for a new set. This is sometimes
quicker than creating a new variable set from scratch.
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NOTE
For performance reasons, we recommend that your variable sets have less than
2,000 entries. For example 100 variables x 20 variants = 2,000. In most cases
it's better to divide your variables into a number of smaller sets in different
categories.

1. Scroll down to Variable sets in Content Manager [34]. 

2. Select the arrow in front of the Variable sets to expand it. 

3. Select the Dotted Menu (...) for the variable set you want to copy.

4. Select Copy.
Paligo makes a copy of the variable set and adds it to the list of variable sets. It has the same
name as the original version, but is appended with a number.

Delete a Variable Set
A variable set cannot be deleted unless all the variables from the variable sets are removed
from the instances where they are used. To see where a variable is used, see Display Usage
Information [1196].

1. Scroll down to Variable sets in Content Manager [34]. 

2. Select the arrow in front of the Variable sets to expand it. 

3. Select the Dotted Menu (...) for the variable set you want to delete.
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4. Select Delete.

Display Usage Information

1. Scroll down to Variable sets in Content Manager [34]. 

2. Select the arrow in front of the Variable sets to expand it. 

3. Select the variable set that contains the variables you want to display.

Paligo displays it in the Variables Editor.

4. Select the Dotted Menu (...) for the variable you want to display the usage information for.

5. Select Usage information.
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6. Paligo shows the usage information for the chosen variable.

Move Variables between Variable Sets
If you need to reorganize your variables, you can move them from one variable set to another.

1. Scroll down to Variable sets in Content Manager [34]. 

2. Select the arrow in front of the Variable sets to expand it. 

3. Select the variable set that contains the variable you want to move.

Paligo displays it in the Variables Editor.

4. Select the Dotted Menu (...) for the variable you want to move.

5. Select Move variable.
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6. Choose the Variable set that will receive the variable.

7. Select OK.
Paligo moves the variable to chosen variable set.

Remove Variables
A variable cannot be deleted unless it has been removed from the instances where it is used. To
see where a variable is used, see Display Usage Information [1196].

1. Scroll down to Variable sets in Content Manager [34]. 

2. Select the arrow in front of the Variable sets to expand it. 

3. Select the variable set that contains the variables you want to remove.

Paligo displays it in the Variables Editor.

4. Select the Dotted Menu (...) for the variable you want to remove.
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5. Select Remove Variable.

Use Variables
A variable is a piece of content that can have many different values, and when you publish, you
choose which value Paligo should use. For example, you can have a product name variable and
when you publish, you choose which product name should be used in the published content.

To use variables in your topics, you first need to create a variable set [1191]. In the variable set,
you define what variables you need, and the different possible values that they can have. Each set
of possible values is called a variant.

To find out how to insert variables in a topic, watch this video or read the sections that follow:

https://player.vimeo.com/video/342697399

Insert a Variable
To insert a variable in your content:

1. Open the topic you want to add a variable to.
Place the cursor in a valid position for a variable.

2. Place the cursor in a valid position for a variable. You can insert variables into most types of
text block, including para elements.

3. Select Insert > Variable in the toolbar.

A dialog opens, showing all of the variable sets you have available.

4. Select the variable set that contains the variable you want to use. Alternatively, use the Search
field to find the variable.
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5. Select the variable you want. In this case, we have selected "Product Name".

The variable is inserted at the cursor position.

After adding a variable, you can use the Preview feature to choose different variants. These allow
you to see what value Paligo will use for the variable for each different variant.

When you are ready to publish your content, you can choose which variant Paligo should use for
the published output.

Preview Variables in a Topic
You can use Preview to see what values Paligo can use for your variables. This is useful for
checking that the value you need is actually included in a variable set. If the value is not there, you
will need to edit the variable set or create a new one.

To preview variables:

1. Select Preview.

2. Select Profile settings.

3. On the Variables tab, select the variant that you want to preview in the topic. The variant is a
collection of values, as defined in a variable set.
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Paligo updates the topic so that it shows the values that will be used with the variant you have
selected.

Choose Variable Sets for Publishing
When you publish your content, you can choose which values (variants) should be used for the
variables in your content.

1. In the Content Manager, select the options menu ( ... ) for the topic or publication you want to
publish, and then select Publish.

2. On the publish dialog, choose the type of output you want Paligo to create, and set the
Languages and Profiling Attributes.

3. Select the Edit option for Variables.
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Paligo displays a list of all of the variable sets that are available.
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4. For each variable set that is used in your topic or publication, select a variant. The variant's
values will be inserted into the relevant variables in your content. Select OK to confirm.

5. Select Publish document to publish your content.

Dynamic Text Variables
Dynamic text variables are pieces of content that take their value from either the client session or
from other elements in your content. They are resolved when you publish and you can use them
to insert content such as:

• Current date and time, which is taken from your client session and so is accurate for your local
time zone.
To learn how to add these variables, see Dynamic Text Variables for Time and Date [1204].

• The content of any element in your publication. This can be elements in the publication or
elements in your topics. For example, you could have dynamic text variables for the author,
edition or releaseinfo elements.
To learn how to add these variables, see Dynamic Text Variables for Elements and
Attributes [1204].
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NOTE
If you publish to PDF in multiple languages, there is an option to Combine
selected languages in the PDF layout [799]. You can only use dynamic text
variables if Combine selected language is disabled (unchecked).

Dynamic text variables are only supported when publishing individual PDFs.

Dynamic Text Variables for Elements and Attributes
You can use dynamic text variables to insert the value of an element or an attribute from your
content into a topic. For example, you could add the value of the edition element from a
publication into the text in a topic.

To reference elements and attributes, you will need:

• A basic understanding of XPath 1.0. XPath is required for navigating the elements in the XML
output.

• Access to the XML file that contains all of your content (see Plan your References with the Debug
XML File [1206]). You can use this file to plan your XPath references. Once you know which
elements and attributes are needed, you can insert the appropriate references in your dynamic
text variables.

• To insert dynamic text variables [1205] in your topics, and add the references using the
appropriate syntax.

To learn about XPath 1.0, see https://www.w3schools.com/xml/xpath_intro.asp.

Dynamic Text Variables for Time and Date
To add automatically generated time and date information to your content, use dynamic text
variables. The time and date are inserted during the publishing process and they are taken from
your browser's client session, so the time is accurate for your location.

To insert a dynamic text variable for time and/or date:

1. Add a phrase element and give it a role attribute with the value:
dyntextvar
For more details, see Insert a Dynamic Text Variable [1205].

2. In the phrase element, enter the syntax for the time or date format. Use the Java simple date
format.
There are many different ways of displaying the time and date and we have included some
examples below.

Syntax Returns

${date:date-time()}$ The current date, time, and timezone information.

${date:format-usertime('h:m')}$ The current hour and minutes.

${date:format-usertime('EEE, MMM d, yyyy')}$ The current day, month, and year.
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To find out more about the syntax for time and date variables, see: SimpleDateFormat (Java 2
Platform SE 5.0).

NOTE
Use the date:format-usertime function for greater control over the format of the
date and time in the output. Set the arguments for the function in brackets,
where string arguments must be enclosed in single quotes (as shown in the table).

Insert a Dynamic Text Variable
When you know what elements and attributes you want to use for your dynamic text variables,
you can start adding them to your topics.

To insert a dynamic text variable:

1. Find the topic that is going to contain the dynamic text variable and open it in the editor.

2. Position the cursor at a valid position for the dynamic text variable. This can be any position
where a phrase element is valid can be added, for example, inside a para element.

3. Use the element context menu to add a phrase element.

To access the element context menu, press Alt  and Enter  (Windows) or Option ⌥  and

Enter  (Mac).

4. Select the phrase element and then in the Element attributes panel, add the role attribute.
Set its value to:
dyntextvar

This will add the minimum required syntax for the dynamic variable:

<phrase role="dyntextvar">${}$</phrase>

5. When you have added the dynamic text variable, enter the relevant XPath expression to
access the element or attribute you want to use.

NOTE
If you use an expression to access an element or attribute that does not exist, the
dynamic text variable will be empty (blank) in the output.
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When you are writing XPath expressions, there are several things you need to be aware of:

• Include the "d:" prefix for navigating the XML, for example:
${/*[1]/d:info/d:title}$

The namespace prefix d is bound to http://docbook.org/ns/docbook

• There are DocBook attributes that do not require a prefix and there are also some custom
Paligo attributes, known as extension attributes. To access the extension attributes, use the
@xinfo prefix, for example:
${@xinfo:time-modified}$

The namespace prefix xinfo is bound to http://ns.expertinfo.se/cms/xmlns/1.0.

• For PDF outputs, the top-level node that you can access is article. You cannot access the
article's parent node (part).

Plan your References with the Debug XML File
Paligo can provide you with a single XML file that contains all of the content in a publication (the
publication itself and all of the topics). You can use this XML file to get a better understanding
of the structure of your content, so that you plan the XPath expressions for your dynamic text
variables. Use XPath 1.0 expressions to access the elements and attributes in your content.

To find out how to get the XML file, watch the video or read the following instructions:

https://player.vimeo.com/video/352679343

1. In the Content Manager, find your publication, select its option ( ... ) button, and then select
Publish.

2. On the Publish document dialog, choose the type of output you want, set the Languages,
Profiling Attributes, and regular Variables, and then select the Make debug build option.
The Make debug build option tells Paligo to include the build files in the output as well as the
actual output. One of the build files is an XML file that contains your content.

3. Select Publish document to publish your content.
When it downloads, unzip it and look for the XML file that contains your content.
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For PDF outputs, the XML file has the same name as the publication and has a language suffix.
For example, "Acme_100_user_guide-en.xml".
For HTML, HTML5, XML, Word, and SCORM outputs, the XML file is named index and has a
language suffix, for example, index-en.xml.

4. Open the XML file from step 3 and use it to plan your XPath 1.0 expressions. When you have
planned the expressions, you can insert dynamic text variables into your content and add the
relevant expressions.
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Assignments

When you create, translate and publish content in Paligo, it is important that you understand
the production workflow. The workflow is the recommended order of creating, reviewing and
publishing content. To learn about the workflow, see Workflow Status [1209].

To track your content through each stage of the workflow, we recommend that you use
assignments. You can assign tasks to other users, including reviewers and contributors, see User
Types [1834]. They are designed for collaboration and you can use them to invite other users
to work on content at particular stages in the workflow. For example, you can create a review
assignment to invite subject matter experts (SMEs) to proofread content in the review stage. The
assignments are tracked by Paligo and you can monitor them from your Dashboard [42]. The
assignees work with the assignments in the Contributor Editor [41].

TIP
You do not have to use assignments for collaboration. If you prefer, you can also
Share Content (without assignments) [1347], but be aware that there is limited
tracking for shared content.

If you are a Administrator or Author and want to find out more about setting up assignments,
see:

• Working with Assignments [1212]

• Author Instructions for Review Assignments [1272]

• Author Instructions for Contribution Assignments [1300]

If you are a Reviewer and need information on working on a review assignment, see:

• Reviewer Instructions [1275]

• Working in Review View [1278]

If you are a Contributor and need information on working on a contribution assignment, see:

• Contributor Instructions [1303]

• Working in Edit View [1306]
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NOTE
For information on translation assignments, see Translation Management [1683].

Workflow Status
Every publication and topic in Paligo has a status that shows where the content is in relation to the
production workflow, see View the Status of a Publication or Topic [1210]. The image below shows
the standard 5 step process and possible statuses. They are not compulsory, if you do not translate
the content, you can skip the In Translation and In Translation Review.

You can manually Change the Status of a Publication or Topic [1210] But if you use assignments,
which Paligo recommends, you can Automatic Status Change with Assignments [1211]. To find out
about using assignments, see Working with Assignments [1212].

1. Work In Progress - For when the content is being created or edited in the source language.

2. In Review - For reviews of the source content.

3. In Translation - The content is in the process of being translated. This content should not be
edited as it is being translated, and so any further changes will be different to the translation.
(Optional)

4. In Translation Review - The content has been translated and now those translations are
under review. Again, this content should not be edited, as any changes will be different to the
translation. (Optional)

5. Released - The content has been written, reviewed, translated and published. This content is
complete and should not be edited without first changing the state.

NOTE
For more information on how these states are used for versioning, see Version
Management [1626].
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View the Status of a Publication or Topic
To view the status of your publications and topics, use the Resource view:

1. In the Content Manager, select the folder that contains the publications or topics that you
want to view. If your content is not inside a folder, select Documents instead.
When you select a folder or Documents, Paligo displays the Resource view. It shows all of the
publications and topics that are in that folder or the Documents section.

2. Look at the column between Taxonomies and Editor. It shows the current state of each
publication and topic in the folder.

To find out what each of the states means, see Workflow Status [1209].
To learn how to use the Resource view to change the status of publications and topics, see
Change the Status of a Publication or Topic [1210].

Change the Status of a Publication or Topic
At certain stages in the workflow, you need to change the state of your content. For example,
when you want to start translating a publication, you will need to switch it from In review to In
translation.

NOTE
You can get Paligo to change the state of content automatically when an
assignment starts or ends. The default settings for assignments have features for
adapting the workflow and automatically changing the status (see Default Settings
for Assignments [1216]).

To change the state of your content manually:

1. In the Content Manager, select the folder that contains the publications or topics that you
want to view. If your content is not inside a folder, select Documents instead.
When you select a folder or Documents, Paligo displays the Resource view. It shows all of the
publications and topics that are in that folder or the Documents section.

2. Look at the column between Taxonomies and Editor. It shows the current state of each
publication and topic in the folder.
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To find out what each of the states means, see Workflow Status [1209].

3. Select a status to reveal a drop-down list, then select the new state from the list.

Automatic Status Change with Assignments
Paligo can automatically change the state of your content when an assignment begins, and in the
case of review assignments, also when they finish [1222]. This saves you from having to change
the state manually to progress your content through the stages of the production workflow.

To set up automatic state changes:

• Use the default settings for assignments [1216] to set Paligo to change the state automatically.
You can tell Paligo what action to take when an assignment starts and also when it ends.
For details, see Automatic Change of Release Status [1219].

• Use assignments [1212] for your review tasks.
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NOTE
Setting up automatic state changes for the workflows can be convenient, but
should be considered carefully. In some situations, it can be preferable to change
the state manually, for example, if you have many different variants reusing the
same topics. In this scenario, changing the state manually gives you more precise
control over the stages of the variants.

See more about the effects of workflow state changes in different scenarios here:
Changing Workflow for Reused Content [1633].

Working with Assignments
Assignments are projects that allow you to request other users to work on content. Each
assignment is a request to contribute to the content in some way and there is usually a timescale
for the work to be completed. For example, you could create a review assignment and allocate it to
a group of subject matter experts (SMEs) so that they can check it for technical accuracy.

In Paligo, there are various user types (user roles) and these are assigned when an administrator
creates or edits the user accounts. Each user role has a different purpose and different levels of
access to Paligo, see User Types [1834].

We recommend that you use assignments in your content production and publication workflow, as
they offer several benefits:

• Assignments are tracked in Paligo, so there is an audit trail of who worked on them and when.

• You can view the progress of assignments in the Planner or Dashboard, see Track the
Assignment Progress [1246].

• You can set Paligo to change the status of your content automatically when a review
assignment starts and ends, see Default Settings for Assignments [1216].

To use assignments:

1. Make sure you are familiar with the Workflow Status [1209]. You will need to know this so
that you understand what type of assignment to create and where that assignment fits in the
overall production process.

2. Find out about the different Assignment Types [1212] and also the Assignment Workflow and
States [1213].

3. Create Assignments [1240].

Assignment Types
Use assignments [1212] to manage your projects and workflow. You can create assignments from
Planner [66] and Content Manager [34], see Create Assignments [1240]. The assignments are
found in the Assignment Panel on the Dashboard.
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There are several types of assignment, each with a different purpose. They are called Review,
Contribution, Translation, and Translation Review.

Review Assignment
 Use review assignments when you want someone to read your content and provide feedback as

comments. For example, you could send a review assignment to an SME (subject matter expert) to
check for technical accuracy or proofreading. To learn more, see Create Assignments [1240].

Contribution Assignment
 Use contribution assignments when you want someone to create or edit content. For example,

a project manager or team leader could assign topics or entire publications to authors to update.
The actions that are available to the assignee vary, depending on the type of license that is
allocated to their user account. To learn more, see Create Assignments [1240]

Users with an Author license can create and edit content in Paligo's full editor, but also have
access to the Contributor Editor [41] edit and review features.

Users with a Contributor license do not have access to Paligo's full editor, but they can use
theContributor Editor [41]. The Contributor editor is designed to allow non-writers to contribute to
the documentation. It has features for editing and creating content, but does not include the more
advanced authoring features of the full Paligo editor, such as content reuse.

Translation Assignment
 Use for managing translations, creating translation packages, and / or post-edit translations.

Or even translate directly in Paligo by using the translation editor. To learn more, see Create a
Translation Assignment [1689].

Translation Review Assignment
 Use translation review assignments when you want someone in your organization to proof-read

a translation and leave comments as feedback. To learn more, see Create a Translation Review
Assignment [1697].

Assignment Workflow and States
Each assignment has its own workflow and state, which begins with Draft or Started, and then
ends with Finished (needs work) or Finished (approved).

• Draft - Started - Finished
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• Started - Finished

NOTE
The assignment goes through these states wherever the assignment takes place
in the Workflow Status [1209]. For example, if you have a translation assignment,
it will take place in the "In Translation" stage of the production workflow and will
go from Started to Finished within that "In Translation" stage.

For each stage in the assignment workflow, there is a matching state. There are also response
states for each assignee. You can view these states on Planner [66] and the Dashboard [42].

In the following descriptions, we have included the assignee response states as variations on the
started and finished states, for example, there is a finished (needs work) state and a finished
(approved) state.

• Draft
The assignment has been created but its start date is in the future. It will switch to "started"
automatically on the start date and will then appear on the assignee's dashboard too.
Draft assignments appear as a transparent bar in the Planner.

• Started
The assignment has been created and the assignee has been notified.
Started assignments appear as a solid color bar in the Planner.

• Started (needs work)
The assignment is allocated to multiple people and is set to finish only when they have all
responded. Out of the users who have responded, at least one person has chosen to finish with
the "needs work" state. There are still some users who have not responded yet.

You may also see this state if the assignment is set to only finish when all users approve the
content. If one or more users finish with the "needs work" state, the assignment will not go to
the finished state, as it can only do that when all users approve the content.

• Started (approved)
The assignment is allocated to multiple people and is set to finish only when they have all
responded. Out of the users who have responded, at least one person has chosen to finish with
the "approved" state. But there are still other users who have not responded yet.

• Finished (needs work)
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The assignee has completed the assignment and they believe the content needs additional work
before it can be released. A writer, contributor, or translator should work to improve the content
and then send it for approval in a new assignment.
Finished (needs work) assignments show as semi-transparent bars with a red stop symbol next
to the assignee's avatar.

• Finished (approved)
The assignee has completed the assignment and approved the content. They are satisfied that
the content is suitable for publication.
Finished (approved) assignments are shown as semi-transparent bars with a green check
symbol next to the assignee's avatar.

The assignments are color-coded too, with purple for review assignments, gray for contribution
assignments, and blue for translation assignments. You can view these states on the Planner and
on your Dashboard (see Track the Assignment Progress [1246]).

NOTE
Finished assignments are shown as semi-transparent.

There is an avatar for each assignee, and it has an icon to show the assignee's response:

Icon Description

The assignee has not responded yet.

The assignee has finished the assignment and set the content to "approved".

The assignee has finished the assignment and has set the content to "needs work".
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NOTE
You can set Paligo to change the state of your content (in the production
workflow) automatically when a review assignment starts or finishes. For
example, you can set a publication to automatically switch from "Work in
Progress" to "In Review" when a review assignment begins. To set these automatic
changes, use the Default Settings for Assignments [1216].

Default Settings for Assignments
Paligo has default settings to control various assignment features, including what actions Paligo
should take when an assignment begins, ends and what notifications it should send to assignees.

There are two ways to access the Default Settings for assignments:

• Planner [66] - Make general assignment settings. Before you start working with assignments,
it is a good idea to review the default settings as you may be able to use them to make your
workflow more efficient.

• Create Assignments [1240] - Adjust the settings when the assignment is created.

Default Settings Tabs
The Default Settings for assignments are organized into the following tabs:
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• General - Applies to all assignments. Use the settings here to get Paligo to:

• Automatic Change of Release Status [1219]

• Automatic Document Check-In [1224]

• Automatic Email Notifications [1226]

• Automatic Reminders [1228]

• Define When Assignments End [1234].

• Review assignments - Only applies to review assignments. Use the settings here to get Paligo
to:

• Automatic Change of Release Status for Reviews [1222]

• Define When Review Assignments End [1235].

• Comments - Applies to comments that are left by assignees in your assignments. Use the
settings here to get Paligo to:

• Automatically Archive Comments [1217]

• Contributions - Only applies to contribution assignments. Use the settings here to get Paligo to:

• Automatic Snapshots [1230]

• Store Contributor Topics in a Different Location [1239]

• Contribution Settings [1232].

Automatically Archive Comments
Paligo can automatically archive any comments in the content that's used for an assignment. The
comments can be auto-archived at the start of the assignment or at the end. Alternatively, you can
set Paligo to never auto-archive the comments.

1. Display the default settings for assignments.
You can either:

• Planner [66] - Make general assignment settings. Before you start working with
assignments, it is a good idea to review the default settings as you may be able to use
them to make your workflow more efficient.
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• Create Assignments [1240] - Adjust the settings when the assignment is created.

2. On the Default Settings dialog, select the Comments tab.
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3. In the When the assignment starts section, define what Paligo should do with any existing
comments when an assignment begins.
Choose from:

• Archive comments
Paligo will automatically archive any comments that already exist (in the content for the
assignment).

• Don't archive comments
Paligo will not automatically archive any comments that already exist.

4. In the When the assignment ends section, define what Paligo should do with comments
when an assignment ends and all assignees have approved the content.
Choose from:

• Archive comments if assignment has been approved
Paligo will automatically archive comments if all assignees have approved the content.

• Don't archive comments
Paligo will not archive comments.

5. Select OK to confirm your choices.

Automatic Change of Release Status
Paligo can automatically switch the status of your content when you create a new assignment. This
is a useful time-saving measure, as it means you do not have to change the status manually. For
example, if you create a review, Paligo will automatically change the status of the selected content
to In Review.
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NOTE
Setting up automatic state changes for the workflows can be convenient, but
should be considered carefully. In some situations, it can be preferable to change
the state manually, for example, if you have many different variants reusing the
same topics. In this scenario, changing the state manually gives you more precise
control over the stages of the variants.

See more about the effects of workflow state changes in different scenarios here:
Changing Workflow for Reused Content [1633].

To set Paligo to change the status automatically when a new assignment begins:

1. Display the default settings for assignments.
You can either:

• Planner [66] - Make general assignment settings. Before you start working with
assignments, it is a good idea to review the default settings as you may be able to use
them to make your workflow more efficient.

• Create Assignments [1240] - Adjust the settings when the assignment is created.
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2. On the Default Settings dialog, select the General tab.

3. Check the Change the document release status box to set Paligo to automatically change
the workflow status when the assignment begins. Clear the checkbox if you want to change
the workflow status manually.

4. Select OK to confirm your choices.
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Automatic Change of Release Status for Reviews
Paligo can automatically change the state of your content when a review assignment finishes. By
setting this up, you can avoid having to change the status manually.

To set the automatic state changes, it is important that you understand the stages of the
production workflow. These are:

Work in progress > In Review > In Translation > In Translation Review > Released

These are the stages that your content goes through from creation to publication. Your review
assignments take place in the In Review stage.

NOTE
Setting up automatic state changes for the workflows can be convenient, but
should be considered carefully. In some situations, it can be preferable to change
the state manually, for example, if you have many different variants reusing the
same topics. In this scenario, changing the state manually gives you more precise
control over the stages of the variants.

See more about the effects of workflow state changes in different scenarios here:
Changing Workflow for Reused Content [1633].

To set Paligo to change the state of your content when a review is finished:

1. Display the default settings for assignments.
You can either:

• Planner [66] - Make general assignment settings. Before you start working with
assignments, it is a good idea to review the default settings as you may be able to use
them to make your workflow more efficient.

• Create Assignments [1240] - Adjust the settings when the assignment is created.
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2. On the Default Settings dialog, select the Review assignments tab.

3. Check the Change the document release status box.
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4. Use the drop-down to choose what should happen when the review is finished:

• My documents don't need to be translated
Choose this option if you want your content to automatically switch to "Work in Progress"
or "Released" at the end of a review (depending on whether the content "needs work" or is
"approved").
This option removes the "In Translation" and "In Translation" stages from the production
workflow.

• Assume that my documents are translated
Choose this option if you want your content to automatically switch to "Work in Progress" or
"In Translation" at the end of a review (depending on whether the content "needs work" or
is "approved").

NOTE
Use the When is the assignment finished? and Assignee groups settings
to control how Paligo recognizes a review is complete. For more details, see
Define When Review Assignments End [1235].

5. Select OK to confirm your choices.

NOTE
To find out how to get Paligo to change the state of the content at the start of a
review, see Automatic Status Change with Assignments [1211].

Automatic Document Check-In
When you create an assignment, it is possible that some of the topics needed for that assignment
will be checked out by other users. This can be a problem, as it means the assignees may not be
able to access the content they need to work on. To avoid this, you can set Paligo to automatically
check in the content that's needed for an assignment.

1. Display the default settings for assignments.
You can either:

• Planner [66] - Make general assignment settings. Before you start working with
assignments, it is a good idea to review the default settings as you may be able to use
them to make your workflow more efficient.
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• Create Assignments [1240] - Adjust the settings when the assignment is created.

2. On the Default Settings dialog, select the General tab.
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3. Check the Check in documents box to set Paligo to automatically check in all related and
reused documents when the assignment begins. Clear the checkbox if you do not want Paligo
to check in these documents, in which case, they may be checked out and unavailable to the
assignee(s).

4. Select OK to confirm your choices.

Automatic Email Notifications
Paligo can automatically send email notifications to assignees to let them know they have an
assignment. This is a good way to make assignees aware of their assignment duties, especially if
they do not use Paligo for other work.

You can also set Paligo to send an email to the creator of an assignment.

1. Display the default settings for assignments.
You can either:

• Planner [66] - Make general assignment settings. Before you start working with
assignments, it is a good idea to review the default settings as you may be able to use
them to make your workflow more efficient.
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• Create Assignments [1240] - Adjust the settings when the assignment is created.

2. On the Default Settings dialog, select the General tab.
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3. Check the Send email to all assignees box to set Paligo to send notification emails. Clear the
box to stop Paligo from sending the emails.

4. Check the Send iCal invitations box to set Paligo to send an iCal calendar invitation with the
notification email. Clear the box if you do not want calendar invitations to be included. This
option is only available if you have checked the Send email to all assignees box.

5. Check the Notify me box to set Paligo to send an email to the creator of an assignment when
the assignment begins. Clear the box if you do not want these emails.

6. Select OK to confirm your choices.

TIP
To set Paligo to send an email reminder to assignees who have not responded,
check the Send a reminder to assignees box. The reminder is sent a day before
the end assignment date.

This feature only applies for assignments that have a duration of more than 2
days.

Automatic Reminders
You can set Paligo to send reminders to unresponsive assignees. The reminder can be a useful
prompt to assignees who may have not noticed the assignment or delayed working on it for some
reason.

The reminder is sent as an email one day before the end of the assignment deadline.
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NOTE
This feature is only used for assignments with a duration of longer than two days.

1. Display the default settings for assignments.
You can either:

• Planner [66] - Make general assignment settings. Before you start working with
assignments, it is a good idea to review the default settings as you may be able to use
them to make your workflow more efficient.

• Create Assignments [1240] - Adjust the settings when the assignment is created.

2. On the Default Settings dialog, select the General tab.
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3. Check the Send a reminder to assignees box to set Paligo to send reminder emails. Clear the
box if you do not want reminder emails to be sent.

4. Select OK to confirm your choices.

Automatic Snapshots
It is possible to make Paligo automatically create a snapshot at the start of a contribution
assignment.

A snapshot is an archived version of the content at a particular point in time. During a release
a snapshot is always created but can also be created by a contributor during an assignment or
manually created at any time. The snapshots are useful when comparing the content between
different versions or for restoring lost content. By comparing a snapshot from before and after an
assignment, it is easy to visualize the changes made to the documentation.

NOTE
To find out more about contribution assignment snapshots, see Compare
Contributions [1341].

To set Paligo to create a snapshot automatically at the start of a contribution assignment:

1. Display the default settings for assignments.
You can either:

• Planner [66] - Make general assignment settings. Before you start working with
assignments, it is a good idea to review the default settings as you may be able to use
them to make your workflow more efficient.
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• Create Assignments [1240] - Adjust the settings when the assignment is created.

2. On the Default Settings dialog, select the Contributions tab.
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3. In the When the assignment starts section:

• Check the Create a snapshot box to set Paligo to make a new snapshot automatically
when the assignment begins.

• Clear the Create a snaphot box to stop Paligo from making a new snapshot at the start
of the assignment.

4. Select OK to confirm your choices.

Contribution Settings
When contributors start work on an assignment, Paligo can show them the changes that have
occurred since the last snapshot was taken. To show a preview of the changes by default:

1. Display the default settings for assignments.
You can either:

• Planner [66] - Make general assignment settings. Before you start working with
assignments, it is a good idea to review the default settings as you may be able to use
them to make your workflow more efficient.

• Create Assignments [1240] - Adjust the settings when the assignment is created.
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2. On the Default Settings dialog, select the Contributions tab.

3. In the When the assignment starts section, disable Create a snapshot.
If you have this feature enabled, it will mean Paligo creates a snapshot when the assignment is
opened. As a result, the comparison feature would compare the latest version of the content
to that snapshot, and the content would be the same.

4. In the Enable Preview section, check the Enable change preview box.
When the contributor opens the assignment, Paligo will show them a side-by-side comparison
of the latest version of the content and the most recent snapshot of the content. They can
choose to compare to different versions if they want (see Compare Contributions [1341]).
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Clear the checkbox if you want to disable the comparison.

5. Select OK to confirm your choices.

Define When Assignments End
By default, assignments are set to end on their due date, but you can change this so that
assignments only end when assignees respond to them. You will need to decide which is the
best approach for your organization.

1. Display the default settings for assignments.
You can either:

• Planner [66] - Make general assignment settings. Before you start working with
assignments, it is a good idea to review the default settings as you may be able to use
them to make your workflow more efficient.

• Create Assignments [1240] - Adjust the settings when the assignment is created.

2. On the Default Settings dialog, select the General tab.
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3. In the When is the assignment finished? section, use the Finish assignment on due date
checkbox to define when assignments end by default.

• Check the box to set assignments to end on their due date (deadline) even if assignees have
not responded.

• Clear the box to set assignments to remain open after the due date (deadline) if assignees
have not ended the assignment, either by setting it to Needs more work or Approved.

4. Select OK to confirm your choices.

Define When Review Assignments End
By default, each assignment ends on the due date that was set for that assignment. This also
applies to review assignments, but these also have extra options for controlling what happens
when assignees complete an assignment.

Depending on your choices, Paligo will recognize a review assignment has finished when:

• All assignees have approved the content

• All assignees have responded to the assignment

• All members of a user group have responded to the assignment

• At least one member of a user group has responded.

NOTE
It is possible to change the default settings so that assignments do not end
automatically when the due date is reached (see Define When Assignments
End [1234]).

To control when review assignments finish:
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1. Display the default settings for assignments.
You can either:

• Planner [66] - Make general assignment settings. Before you start working with
assignments, it is a good idea to review the default settings as you may be able to use
them to make your workflow more efficient.

• Create Assignments [1240] - Adjust the settings when the assignment is created.

2. On the Default Settings dialog, select the Review assignments tab.
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3. In the When is the assignment finished? section, define when Paligo should set an
assignment to finished:

• All assignees have approved
All assignees must have completed the assignment and set the content to "approved".

• All assignees have responded
All assignees must have completed the assignment, but they can have set the content to
"Needs Work" or "Approved"

4. In the Assignee Groups section, define what must be in place for Paligo to recognize that a
user group has finished an assignment:

• All members have responded
If an assignment is allocated to a user group, it can only be recognized as finished if all of
the members of that user group have responded. To respond, they must set the assignment
to finished with either "Needs Work" or "Approved" status for the content.

• One member has responded
If an assignment is allocated to a user group, it can only be recognized as finished one or
more members of the user group have responded.

NOTE
You can send a user two invites to the same assignment, by inviting their
user group and also inviting them as an individual user. In this scenario, they
only need to respond once. Paligo automatically detects that their response
applies to both the user's assignment and the user group's assignment.

5. Select OK to confirm your choices.

It is possible to allocate an assignment to a user group and also some individual users at the same
time. This can result in some more complex scenarios, covered in the following examples.
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Example 66. Assignment for user group and users, user group rejects content

Let's say you have the following settings for review assignments in place:

• When is assignment finished? - All assignees have approved

• Assignee groups - One member has responded

You then create a review assignment and allocate it to a user group plus two individual users who
are not part of that group.

The two individual users read the content and approve it. Their assignment work is complete, with
the content set to "approved". But the assignment is still open, as the default settings require all
assignees to approve the content and the user group is an assignee.

A member of the user group reads the content and sets it to "needs work".

The assignment remains open. This is because all assignees have responded, but one of them did
not approve the content:

• Individual user 1 approved the content

• Individual user 2 approved the content

• User group - one user from the group set the content to "needs work", and so the content
cannot have "approved" status from the user group. As a result, the "All assignees have
approved" rule is not met, and so the assignment remains open.

Example 67. Assignment for user group and users, some user group
members do not respond

Let's say you have the following settings for review assignments in place:

• When is assignment finished? - All assignees have approved

• Assignee groups - One member has responded

You then create a review assignment and allocate it to a user group plus two individual users who
are not part of that group.

The two individual users read the content and approve it. Their assignment work is complete, with
the content set to "approved". But the assignment is still open, as the default settings require all
assignees to approve the content and the user group is an assignee.

A member of the user group reads the content and sets it to "approved".

The assignment finishes as the finishing criteria has been met:

• Individual user 1 approved the content

• Individual user 2 approved the content

• User group - one user from the group set the content to "approved".

The individual users both responded with approved, and a user group member responded with
approved too. So all assignees have approved. It does not matter that the other user group
members did not look at the content, as the Assignee groups setting required only one user group
member to respond.

If any of the user group members had responded with "needs work" first, the assignment would
have remained open.
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Store Contributor Topics in a Different Location
Contributors can create new topics as part of their work on an assignment. By default, Paligo will
store these new topics in a special folder called "Contributions, <name of user>" and this is in
the root of the Documents section in the Content Manager. But you can set Paligo to store new
contribution topics elsewhere, if preferred.

To change the location for new contributor topics:

1. Display the default settings for assignments.
You can either:

• Planner [66] - Make general assignment settings. Before you start working with
assignments, it is a good idea to review the default settings as you may be able to use
them to make your workflow more efficient.

• Create Assignments [1240] - Adjust the settings when the assignment is created.
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2. On the Default Settings dialog, select the Contributions tab.

3. In the Where to save new topics section, use the browse field to choose the folder for new
contributor topics. When a contributor creates a new topic, it will be saved in a special folder
called "Contributions, <name of user>" and that will be inside your chosen folder.

4. Select OK to confirm your choices.

Create Assignments
Assignments are an important part of the workflow if you want to track your content in Paligo.
When you create an assignment, you choose what type of assignment it is, who should work on it,
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and the timescale for the work. This is all tracked by Paligo and you can view the progress of an
assignment on the Dashboard and in the Planner.

To create a new assignment, you can use both Planner [66] and Content Manager [34], there is no
difference in the end result.

Create an Assignment via the Content Manager
Use the Content Manager to create new translation, translation review, contribution, or review
assignments.

NOTE
Alternatively, use the Planner to create new assignments [1243].

To create an assignment from the Content Manager:

1. In the Content Manager, find the publication or topic that you want the assignee to work on.
Then select its options menu ( ...Create assignment

Paligo displays the Create assignment dialog.
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TIP
You can also assign only a part of a publication, like a "chapter" or any other
subsection. To do this, expand the publication and create the assignment
from the "fork" inside the publication:

2. Use the Create assignment dialog to set the options for your assignment.

• Assignment type
Choose the type of assignment. The options are review, contribution, translation, or
translation review. Review is for when you want somebody to proofread the content and
contribution is for when you want somebody to add to the content. Translation is for adding
a translation of the content and translation review is for proofreading the translation.

• Document for this assignment
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Choose the publication or topic that you want the assignee to work on.

• Language
Choose the language for the assignment. You can only choose one language per
assignment. For translations, choose the language that you want the translator to provide.

• Profiling
Use to apply a favorite profile to the publication or topic. You only see options here if you
have set up favorite profile settings for the document.

• Assignee
Choose the user or user group [1850] that will work on this assignment.

NOTE
You can choose one or more individual users, one or more user groups,
or a combination of user groups and individual users. For user groups, the
assignment is allocated to every user that is a member of the selected user
group(s).

• Assignment date
Use the calendars to set the start date (left calendar) and end date (right calendar) for the
assignment.

• Let me leave a message
Check the box if you want to leave a message for the assignee(s), and then enter the
message in the field that appears. Clear the box if you do not want to add a message.

3. Select the Default Settings button to display the Default Settings dialog. Then check that
the settings are suitable for your assignment. For information on these settings, see Default
Settings for Assignments [1216]. Close the Default Settings dialog when you are finished.

4. Select OK to create the assignment.

NOTE
You cannot give a user a contribution assignment to content that they do not
have permission to edit. Paligo will prompt you to allocate the suitable permission
to the user. This applies on instances that use Paligo's permissions [1857] feature,
which is available on the Enterprise plan.

To upgrade your plan, contact your Paligo account manager.

Create an Assignment via the Planner
Use the Planner to create new translation, translation review, contribution, or review assignments.

NOTE
Alternatively, create a new assignment from the Content Manager [1241].

To create an assignment in the Planner:
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1. Select Planner in the top menu to display the Planner.

2. Either:

• Select the Create button and then choose the type of assignment you want to create.

• Select the starting date for the assignment directly on the calendar widget.

Paligo displays the Create assignment dialog.

3. Use the Create assignment dialog to set the options for your assignment.
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• Assignment type
Choose the type of assignment. The options are review, contribution, translation, or
translation review. Review is for when you want somebody to proofread the content and
contribution is for when you want somebody to add to the content. Translation is for adding
a translation of the content and translation review is for proofreading the translation.

• Document for this assignment
Choose the publication or topic that you want the assignee to work on.

• Language
Choose the language for the assignment. You can only choose one language per
assignment. For translations, choose the language that you want the translator to provide.

• Profiling
Use to apply a favorite profile to the publication or topic. You only see options here if you
have set up favorite profile settings for the document.

• Assignee
Choose the user or user group [1850] that will work on this assignment.
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NOTE
You can choose one or more individual users, one or more user groups,
or a combination of user groups and individual users. For user groups, the
assignment is allocated to every user that is a member of the selected user
group(s).

• Assignment date
Use the calendars to set the start date (left calendar) and end date (right calendar) for the
assignment.

• Let me leave a message
Check the box if you want to leave a message for the assignee(s), and then enter the
message in the field that appears. Clear the box if you do not want to add a message.

4. Select the Default Settings button to display the Default Settings dialog. Then check that
the settings are suitable for your assignment. For information on these settings, see Default
Settings for Assignments [1216]. Close the Default Settings dialog when you are finished.

5. Select OK to create the assignment.

TIP
To change the timescale for the assignment on the Planner, drag it to another
date on the calendar.

NOTE
You cannot give a user a contribution assignment to content that they do not
have permission to edit. Paligo will prompt you to allocate the suitable permission
to the user. This applies on instances that use Paligo's permissions [1857] feature,
which is available on the Enterprise plan.

To upgrade your plan, contact your Paligo account manager.

Track the Assignment Progress
You can track the progress of an assignment both via the Planner and also on your Dashboard.
If you have enabled email notifications in the assignment default settings, you will also receive
emails when an assignment starts and / or ends. To track the progress of an assignment, you'll
need to understand the Assignment Workflow and States [1213].
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TIP
Read

Track Assignments via the Planner
The Planner is a built-in project planning tool, much like a Gantt chart for planning your technical
documentation assignments. It is a convenient view for creating assignments and monitoring
them.

To display the Planner, select the Planner tab from the top menu.

The Planner has two sections that contain information about your assignments: the Assignment
planner and the Workload summary.

The Assignment planner has:
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1. Filter for limiting the information shown. For example, you can filter the Assignment planner
by assignment type, language, and assignee.

2. Time period selector. Use to set the time range for the information shown.

3. Options to create [1240], delete, and select all assignments.

4. Options to enlarge the table view, show today in the table, and access the default settings for
assignments [1216].

5. List of publications and topics that are included in assignments.

6. Calendar/Gantt view showing the assignments, their timescales, and status.

The Workload summary shows the amount of assignments allocated to each user. They are
organized by assignment type.

Track Assignments via the Dashboard
Your dashboard is displayed when you first log in to Paligo and it contains a summary of the
activity in your Paligo instance. It also contains information about assignments.

TIP
Learn more about the

To display the Dashboard, select the Dashboard tab from the top menu.

On your dashboard, you can find information on the assignments in various places:

• In the Activity Feed
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• In the Assignments panel. It is divided in three tabs:
Assignments that you created are shown in the By You tab.

Assignments that are assigned to you are shown in the For You tab.

Assignments that have been completed are shown in the Done tab.
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All completed assignments appear here, including those that require the writer to do more work
on the content (the assignment is complete but the content is not approved).

Change Assignment Status
There are several ways to change the status of an assignment, depending on your user
permissions. It is necessary to end an assignment by changing status, otherwise the author will not
receive a notification that you are done with your assignment.

The following symbols show the assignment status:

Question mark The user has not approved or rejected the assignment content

To be able to remove a former status, choose Reset my status.

Green checkmark The user has approved the assignment content

Set the status to Update to approved.

Red Minus symbol The user has rejected the assignment content as it needs more
work before it is suitable for publishing.

Set the status to Update to needs work.

NOTE
For translation assignments, "Needs work" is replaced by "Declined".
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Change Assignment Status via the Assignments Panel
Usually, you would go into the assignment content to set the status. But you can also set the
status from the Assignments Panel on the Dashboard.

1. Select the Dashboard tab from the top menu.

2. Select the Menu icon in the bottom-right corner of the Assignments Panel [46]. 

3. Choose Update to approved, Update to needs work or Reset my status.

Change Assignment Status via the Planner
To be able to reach Planner [66], you need to have to be an author or administrator.

1. Select the Planner tab in the top menu.

2. Drag assignments in the planner to change their status:

• Draft assignments to current date or before to change it to Started.

• Started assignments into the future to change their state to Draft.

Change Assignment Status via the Assignment
When working on an assignment,

1. Display Review View [41] from the assignment link or via the Assignments Panel [46].

2. Select the Assignment button. 
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3. Select a Status for the reviewed content (Approved, Needs work or Reset status).
The assignment is finished and the author receives a notification that you are done.

View the Assignment Status
To view the current status of an assignment, select the Planner tab in the top menu. The calendar
view there shows the status of the assignments:

• Blue blocks for translation and translation review assignments that have started

• Purple blocks for review assignments that have started

• Gray blocks for contribution assignments that have started

• Semi-transparent blocks for assignments that are finished (either approved or needs more
work)

• Clear / gray outline blocks for assignments that are drafts. These are set to begin in the future
and will switch to started on the start date.

Alternatively, select the Dashboard tab in the top menu. Look in the Assignments Panel [46]. The
status of the assignments is shown on the three tabs:

• For you for assignments allocated to you

• By you for assignments you created

• Done for the assignments you created and have been completed
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Assignments that are:

• Drafts are shown as grayed out entries with the line "The assignment is still a draft and has
therefore not started yet."

• Started are shown in color and include information about when the assignment's deadline.
You can see assignments allocated to you on the For you tab and assignments you allocated to
other users on the By you tab.

• Finished are shown in the Done tab. This is where you can find assignments that are finished
and the content is approved and also assignments that are finished but the content needs
more work.

TIP
To find out about the different states and what the icons mean on the assignees'
avatars, see Assignment Workflow and States [1213].

Open an Assignment that "Needs Work"
When an assignment is finished, Paligo sends an email to notify the assignment's creator. The
assignment is updated in Planner [66] and moved to the Done tab in the Assignments Panel [46]
on the dashboard. If the assignment is finished, but the content is marked as "needs work", the
author opens the assignment and corrects the content according to the review comments.

Depending on the type of assignment and the feedback provided, this could mean adding more
content, changing the existing content, or applying the correct structure and content reuse.
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NOTE
You can open the assignment content at any time, but in the usual workflow, an
author would only open the content when the assignment is finished (or cannot
finish as there is content that has the "needs work" state).

Open Finished Assignment in Review View
Review View is the display that reviewers see when they work on review assignments. It shows
the content in the main panel and comments in a sidebar on the right. To find out about review
assignments, see Working in Review View [1278].

Once the assignee has finished the assignment, an email notification is sent to the author.

The finished assignment that needs work can be opened in two ways:

• From the link in the email notification.

• By selecting the finished Review assignment under the Done tab, in the Assignments
Panel [46].
The assignment is listed in the For You, By You, or Done tabs, depending on whether it is
allocated to you, created by you or has been completed.
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NOTE
Paligo authors can open the content in the full Paligo editor and view feedback
and changes there, see Open Assignment Content in the Full Editor [1256].

Open Finished Assignment in Contributor Editor
Initially the contributor enters Review View and has to activate Edit Mode to edit the assignment.
The Edit View Toolbar [1309] provides features for editing and adding content. Learn more, see
Working in Edit View [1306].

Once the assignee has finished the assignment, an email notification is sent to the author.

After a contribution assignment, it is a good idea to use the validation features in the full Paligo
editor to check the structure of the content is valid, see Validation [623].

The finished assignment that needs work can be opened in two ways:

• From the link in the email notification.

• By selecting the finished Contribution assignment under the Done tab, in the Assignments
Panel [46].
The assignment is listed in the For You, By You, or Done tabs, depending on whether it is
allocated to you, created by you or has been completed.
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NOTE
Paligo authors can open the content in the full Paligo editor and view feedback
and changes there, see Open Assignment Content in the Full Editor [1256].

Open Assignment Content in the Full Editor

As an Author, Admin, Publisher or Translation manager, you can access the assignments in the
full Paligo editor to view feedback comments, review, edit or translate content. To find out how to
view feedback comments, see Comments in the Full Editor [1257]. After a contribution assignment,
it is a good idea to use the validation features in the full Paligo editor to check the structure of the
content is valid, see Validation [623].

1. Select the Dotted Menu (...) for the topic in Content Manager [34]

2. Select Edit and choose Review, Contribute or Translate to open the assignment.

OR

• Open the content in Review View [41] or Edit View [42] and then select the Open topic in editor.
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Comments in the Full Editor
When reviewers and contributors add comments to content, those comments are stored in the
relevant topic. As a Paligo author, you can view the comments when you open the topics in the full
editor (or you can see them in review mode or edit mode, see Open an Assignment that "Needs
Work" [1253]).

To view the feedback comments in the full editor:

1. Select a block of highlighted content. Any content that has a comment is highlighted in yellow.

2. Select the Show comments option to open the comments dialog. It shows the comments
for the content you have selected. If you select another block of highlighted content, the
comments dialog updates to show the comments for that content instead.

Select highlighted content (2) and then select the Show comments option (1). The comments dialog
(3) is displayed.
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TIP
The number next to the comment icon shows the number of comments that
have not been dealt with.

3. Select a piece of content that is highlighted yellow (and so has comments associated with it).

4. Use the comments dialog to respond to any existing comments.
Select:

• Status to change the status of the comment to:

• Done if you have resolved the issue.

• Rejected if you disagree with the point being made and are not going to make any
changes.

• Mark as read if you want the reviewer to know you have seen the comment, but you
have not yet made changes or rejected it.

• Unset status to remove the current state.
Alternatively, select the cog icon in the bottom corner and you can set the status for all of
the comments in the conversation.

• Add to add a reply to a comment.

• Archive to remove old comments, but keep a record of them.

• Restore to recover old archived comments.

TIP
You can mention other users in your comments and Paligo will send them
a notification message. To mention them, enter @ followed by the first
characters of their name. Paligo then displays a list and you can select the
user from the list.

Alternatively, you can use Paligo's "distraction free" mode. This gives you access to all of the editor
features, but hides the Content Manager and adds a comments sidebar. So you can edit the
content and see all of the feedback comments in the sidebar at the same time.
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To use distraction free mode, open the review in the full editor and select the Distraction free
mode icon:

Respond to Feedback Comments
If an assignment has content that has been marked as "needs work", open the content and review
the feedback comments. Based on the feedback, you can then make changes to the content, if
required, respond to the comments, and set the comment status.

1. Open the content for the assignment [1253]. As an author, you can make changes to the
content in the full editor or the edit mode (contributor).

2. View the comments [1257] in the comments dialog or the side bar. The comments dialog is
only available in the full editor.

3. To reply to a comment, select Add comment and enter your message.

4. When you have taken care of an issue, you can set the status:

• To set the status of an individual comment, select the comment message to display a status
menu.

• To set the status of an entire conversation, select the  icon in the bottom corner to display
a status menu.
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Select:

• Done if you have resolved the issue.

• Rejected if you disagree with the point being made and are not going to make any changes.

• Mark as read if you want the reviewer to know you have seen the comment, but you have
not yet made changes or rejected it.

• Unset status to remove the current state.

5. When you have dealt with all of the comments, either reassign the assignment [1260], refresh
the assignment [1262], or create a new assignment [1240] to get the changes checked. You
can only reassign if you created the original assignment.

Reassign an Assignment
In certain circumstances, you may need to reassign an assignment, so that reviewers, contributors,
or translators can take another look at the content. Some common reasons for reassigning
content are:

• A reviewer completed a review assignment and set the content as "needs work". You have now
changed the content based on the feedback and need your changes to be reviewed.

• A contributor made changes and you have had to alter them and need your changes to be
approved.

• A translator declined a translation assignment as they do not have time to work on the
translation.

• An assignment ended and the assignees did not respond. This could happen if an assignee
has had other priorities or perhaps they have left the organization before they finished the
assignment.

To reassign an assignment:

1. Select the Dashboard tab in the top menu.

2. Find the assignment in the Assignments section. Then select the cog icon in the bottom
corner, and select Reassign.
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NOTE
For Paligo administrators and authors, the Assignments section has tabs. You
will find assignments that you created and need to reassign in the By You tab
or the Done tab.

3. Use the Reassign dialog to allocate the assignment to one or more users and/or user groups
and to set the timescale.
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When you reassign, the recipient will receive an email inviting them to join the assignment. They
will then provide feedback. If they reject the content, you will need to make changes and then
reassign an updated version until the reviewer accepts the content. If the content is accepted, it is
ready for translation or publication.

Refresh an Assignment for "Needs Work" Content
If an assignee finishes an assignment and sets the content to "needs work", you will need to
address the problems with the content. When you have done that, you will need to get the
changes reviewed. An easy way to do this is to "refresh" the original assignment, as this resets the
status and sends the assignee a reminder to check the content again.

NOTE
The Refresh option is only available if you set review assignments to complete
when all assignees have approved. This is an option in the Default Settings for
assignments, see Define When Review Assignments End [1235].

To refresh an assignment:

1. Select the Dashboard tab in the top menu.

2. Find the assignment in the Assignments section. Then select the cog icon in the bottom
corner, and select Refresh.
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When you refresh, Paligo clears the status for the content in the assignment. It is no longer set
as "Needs Work". Paligo also sends a reminder to those assignees who previously chose "Needs
Work". The reminder is to ask them to re-check the content, so that hopefully, they see the
content is now correct and can be set to "Approved". When the content is approved, it is ready for
translation or publication.

Favorite Profiles
When you are viewing content or sending content to reviewers or contributors, you may want
certain filters and variables to be in place. For example, if a topic contains information about
several products but your reviewer only knows about one product, you might want to filter out the
content about other products. Rather than set up the filters and variable separately each time, you
can set them up once and store them as a favorite profile. You can then apply the favorite profile
when you view the topic or send it in an assignment. .

Favorite profiles are associated with the content they were created for. You cannot create a profile
for one topic and then use the same profile on a different topic. You can create a favorite profile
from the Preview tab and also from the Review View. No matter where you create your favorite
profiles, they are visible in both views.

To be able to make Favorite Profiles, you need to:

• Be an author or administrator, see User Types [1834]

• Set up the Filtering / Profiling [1141]

• Create a Variable Set [1191]

• Insert a Variable [1199] in your content.
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NOTE
When you create an assignment, include a message to tell the assignee
which Favorite Profile to use. This makes it easier for assignees as they can choose
the favorite to display the content that is relevant to them, without having to
understand how variables and filters work, see Choose the Profile Settings [1286].

Create a Favorite Profile via Preview Tab
Instead of having to set up the profiling and variables each time, you can select the Favorites tab
and choose the profile you want, and select Apply. To stop applying a profile, select Reset.

NOTE
Favorite profiles are associated with the content they were created for. You
cannot create a profile for one topic and then use the same profile on a different
topic.

1. Open a topic in the Paligo editor.

2. Select Preview and then Profile settings to display the Profile Settings dialog.

3. On the Favorites tab, select +New to create a new favorite and give it a name.

4. Select your new favorite and then select the Variables tab. Choose the variables and variants
you want Paligo to show.
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5. Select the Profiling tab. Choose the filter types and filter values that you want Paligo to apply.
The filters you choose are included, for example, if you choose a Product filter with value
Acme 100, Paligo will show all content that has no Product filter at all and all content that has
a Product filter with value Acme 100. Any content that has a Product filter set to any other
value is excluded.
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6. Select the Favorites tab and make sure your favorite profile is still selected (its name is in bold
when selected) and then select Update.

7. Repeat this process to create other favorite profiles for the topic (and other topics as
required).
The new favorite profile can now be accessed from the Profile settings option in the Preview
in the editor toolbar and Review View [41].

Create a Favorite Profile via Review View
If your content contains filters or variables, define the profile settings before you create an
assignment and save them as a Favorite. The profile settings let you choose the variable set,
variants, and filters that will be in place when the assignees opens the content.
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NOTE
Favorite profiles are associated with the content they were created for. You
cannot create a profile for one topic and then use the same profile on a different
topic

1. In the Content Manager, select the options menu ( ... ) for the publication and select Edit >
Review. For an individual topic instead of a publication, expand the publication and select the
options menu ( ... ) for the "fork" that references the topic, then select Edit > Review.

2. Open the Profile settings.
You can access the profile settings from the cog menu in the top-right corner.

3. Select the Variables tab. There is a field for each variable set (collection of variables) that is
used in the content.
For each variable set, choose the variant that should be used. The variant is a collection of
values or terms that Paligo will use in place of the variables.

4. Select the Profiling tab. There is a field for each type of filter that is used in the content.
For each filter, choose the profile you want to apply to the content.
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5. Select the Favorites tab.

6. Select + New and then create a name for your new favorite. This will act as a shortcut that,
when selected, will apply the variables and filters settings that you have chosen in steps 3 and
4.

7. Select Apply.
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NOTE
You can set the profile that will be used by default when this content is
opened. Select the options menu ( ... ) for the profile in the Favorites list, and
then select Set as Default.

When you send the content in an assignment, include a message that tells the assignee which
favorite they should use.

Example of Favorite Profile in Use

Example 68. Favorite profile used for a review assignment

Let's say you have an introduction topic that is reused in the user guide for two different products
(we'll call them Acme 100 and Acme 200). That topic uses variables for the product names and has
a note that only applies to the Acme 200 version of the product. So that note has a filter so that it
can be excluded when it is not needed.

The topic looks like this:
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Where:

• 1 is the product variables that are used to swap out the product name, depending on whether
the content is for the Acme 100 or Acme 200

• 2 is the note that only applies to the Acme 200. This note has an xinfo:product filter with a
filter value of Acme 200.

You want to set up favorite profiles so that you can easily switch between the content for the Acme
100 and the content for the Acme 200.

You go into the profile settings and create a new favorite called Acme 100.

On the Variables tab, you set the Acme Products variable to use the Acme 100 variant.

On the Profiling tab, you set the Product filter to use a value of Acme 100.

You then go back to the Favorites tab, make sure your Acme 100 favorite is selected, and then
select Update.
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Next, you select Reset so that no profiling is applied to your content. You then select New and
create a new favorite profile for Acme 200. You repeat the steps for setting up the profile, only this
time, you set the variables and profiling to use Acme 200.

The topic now has two favorite profiles in place.

You create a new review assignment for the topic and in the assignment settings, there is a
profiling option. There, you can choose to apply any of the favorite profiles that are associated
with your content. You choose Acme 100 and send the review assignment.

When the reviewer receives the assignment, they see it with the Acme 100 profiling applied to it,
so the variables show "Acme 100" and the note is excluded from the content (as it has a filter to
only appear for the Acme 200 product).
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Review Assignment Instructions
The following sections provide an overview of the steps you should follow for review assignments,
depending on your user account:

• Author Instructions for Review Assignments [1272]
These instructions explains the steps you should follow if you are a Paligo author and want to
create a review assignment. The instructions cover how to create an assignment, how to track it,
and how to work with feedback that is provided at the end of the review.

• Reviewer Instructions [1275]
These instructions are designed for reviewers who are the assignees of a review assignment.
They explain how to open the assignment, provide feedback as comments, and set the status of
the content at the end of the assignment.

Refer to the section that is relevant to your role.

Author Instructions for Review Assignments
To send content to a reviewer, follow the process described in this article. You will need access to
the full Paligo editor, so must log in to Paligo as an administrator or author.

TIP
This is an overview of the steps you need to follow, with references to the sections
that explain the steps in more detail. If you need to refer to the more detailed
sections, it is a good idea to open them in another tab so that you can easily
switch between this process and the detailed explanations.

1. Optional: Create the profile settings for a review. This step is only needed if your content uses
variables or filters (profiles). For more information, see Favorite Profiles [1263]

2. Create a review assignment. Use it to invite users and / or user groups to review your content.
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For details, see Create Assignments [1240].

NOTE
We recommend that you also check that the Default Settings for
Assignments [1216] are suitable for your assignment.

3. Use the Planner to Track the Assignment Progress [1246]. This is an optional step.

The assignee(s) will work on the assignment and set a state that you can see on your
dashboard and on the Planner.
If they set the content to approved, it means it is ready for translation or publishing,
depending on your workflow. The assignment is finished.
Approved content is shown with a green and white check symbol.
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If they set the content to needs work, it requires your attention.
The assignee's avatar shows a red stop sign if they have set the content to needs work.

4. If the content needs work, open the document.
There are several ways to open a document, see Open an Assignment that "Needs
Work" [1253].

TIP
If you open the content in review mode, you can compare the current version
to an earlier version to see what has changed (see Compare Reviews [1283]).

5. Make the suggested changes and / or reply to the comments.
The way to add and respond to comments varies, depending on whether you open the
content in the full editor or in review mode. To find out more, see:

• Feedback in Review View [1287]

• Comments in the Full Editor [1257]
When you have made the change or replied to each comment, set the state to:

• Done if you have resolved the issue.

• Rejected if you disagree with the point being made and are not going to make any changes.

• Mark as read if you want the reviewer to know you have seen the comment, but you have
not yet made changes or rejected it.

• Unset status to remove the current state.

6. When you have dealt with all of the comments, either reassign the assignment [1260], refresh
the assignment [1262], or create a new assignment [1240] to get the changes checked. You
can only reassign if you created the original assignment.

7. When the assignment comes back with all content approved, can (optionally) send the content
for translation or set the document state to Released, and publish it.
You can see the state of your content in the overall production workflow by looking at the
Resource view (see Workflow Status [1209]).

Paligo may be set up to automatically change the state once an assignment is finished and
approved, for example, it can change approved content from In review to In translation.
If you are not using the automatic state change feature (set in the default settings for
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assignments [1216]), change the content state manually (see Change the Status of a
Publication or Topic [1210].)

Reviewer Instructions
As a reviewer, you can be invited to take part in a review assignment, where you provide feedback
on content. For example, you may be asked to check the content for technical accuracy.

To provide feedback, you will open the content and add your feedback as comments. You cannot
make changes to the content (only Paligo administrators, authors and contributors can make
changes). However, if a contributor, author or administrator is sent a review assignment, the
possibility to switch to Edit mode and to Create Snapshots [1330] is presented.

NOTE
For reviews and contributions, you should use a browser that is supported by
Paligo [22]. The review and contributor features may not respond as expected in
unsupported browsers, for example, you may be unable to add a comment.

Here's the workflow you should follow:

1. You receive an email inviting you to take part in a review assignment. Select the link in the
assignment to open the content in review mode.
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NOTE
In the email invite, look for a message from the creator of the assignment.
They may advise you to select a certain profile when you open the
assignment.

If they have not included a message, the profile may be set automatically or is
not needed.

2. To choose a profile, select the cog icon next to the Your assignment button and then select
Profile settings.

On the profile settings dialog:

a. Select the Favorites tab and then select the appropriate profile.

b. Select Apply.

c. Close the profile settings dialog.

3. Review the content and provide feedback as comments:

a. Select a paragraph or other item of content that you want to provide feedback on.

b. Add a comment in the comments sidebar on the right. Your comments are stored in the
content so that when you finish the assignment, the author and other users can see your
feedback.
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TIP
You can mention other users in your comments and Paligo will send
them a notification message. To mention them, enter @ followed by the
first characters of their name. Paligo then displays a list and you can
select the user from the list.

For information on using the features in review mode, see Working in Review View [1278].

4. If you are a contributor, author or administrator, you can Create Snapshots [1330] when you
have finished adding all of your comments.

5. End the assignment:

a. Select the Your assignment button to display the complete assignment dialog.

b. Select either:

• Done to mark the content as ready for publishing, with no further work needed

• Needs work to notify the Paligo author that changes are suggested
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• Reset status to clear the status of an assignment so that it no longer has a done or
needs work status.

Paligo sends an email to the person who invited you to the assignment. It tells them that
the assignment is complete and that is has either been approved or needs further work. If it
needs further work, they can read your comments in Paligo and make changes to the content,
ready for the next round of reviews.

Working in Review View
Paligo has a review view for providing feedback on content. Before you start reviewing content,
take some time to look at the Reviewer Instructions [1275], so that you understand the process.

Both Reviewers and Contributors can be sent Review assignments, the difference is that
Contributors can edit and add content. Authors and Administrators can also switch to Review
Mode from another mode.

TIP
Learn more about available user types in Paligo, see User Types [1834].

Display the Review View
As an assignee, you will receive an email invite to review, translate or contribute to the
documentation. This is because a Paligo author has allocated an assignment to you or Share
Content (without assignments) [1347].

NOTE
If the content uses filters and / or variables, the author should have created a
favorite profile and provided you with information about which profile to use, see
Choose the Profile Settings [1286] and Favorite Profiles [1263].
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The Assignment Types [1212] and User Types [1834] decides which view that will be opened.
Learn about the available assignment features, see Review View Features [1280], Edit View
Features [1307] and Translation View [1752]. There are two ways to reach the assignments:

• Select the link in the email to display the content in the Review View [41], Edit View [42] or
Translation View [1752].

• Log in to Paligo and select the assignment from the Assignments Panel [46], on the right side of
the Dashboard, to open the assignment.

As an Author, Admin, Publisher or Translation manager, you can access the assignments in the
full Paligo editor to view feedback comments, review, edit or translate content. To find out how to
view feedback comments, see Comments in the Full Editor [1257]. After a contribution assignment,
it is a good idea to use the validation features in the full Paligo editor to check the structure of the
content is valid, see Validation [623].

1. Select the Dotted Menu (...) for the topic in Content Manager [34]

2. Select Edit and choose Review, Contribute or Translate to open the assignment.
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Review View Features
When you open your assignment in Review View [41] the functionality is limited to entering
feedback comments. If the content contains filters and / or variables, you should Choose the
Profile Settings [1286] prepared for the assignment. It can either be preset by the author or
selected from the Favorites tab in the Settings.

1.  Use the Assignment button to end the assignment, either by approving it or suggesting
changes. The author will not be notified until you end the assignment.

2. View selector - It shows which view you have entered. If you have an author license, you can
use it to switch between the different views available in Contributor Editor.

3.  From the Settings menu you choose Profile settings and Share documents.

4. Variables are shown with dark gray highlights.

5. From the Comments menu you set your Notification preferences, Show or hide archived
comments and Archive all comments.

6. The comments sidebar is where you can see and add feedback comments. If you select a
comment, it will flash to show its location it in the topic. You can also edit and delete your own
comments if needed.

7. Content that has a feedback comment is highlighted in yellow.

NOTE
If your user account has author permissions, you can enter Paligo's full editor.

Show or Hide the Table of Contents
When you are reviewing topics, you may find it helpful to display the table of contents (TOC). The
TOC shows you the structure of the content you have been asked to review, and the topic you are
viewing is highlighted.

To show and hide the TOC, select the menu icon to the left of the topic you are reviewing. The
menu icon toggles the TOC between shown and hidden.
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The TOC is shown on the left side in review mode. A gray highlight shows the topic you are currently
viewing.

View Content in Context
When you view content in Contributor Editor [41], the table of contents (TOC) shows the changed
topics in the assignment. The topic you are working on is highlighted. This is helpful when you
need to know how a topic relates to other topics in the assignment, but sometimes you need more
context - you need to know where a topic fits into the publication as a whole. For example, if you
are sent a single topic for review, the TOC only shows that topic and so you have no idea where
that topic fits into the overall structure of the published documentation.

An assignment for a single topic means that the TOC only shows that topic, with no context.

But with the view content in context feature, you can set the TOC to load the full publication and
show where a topic is used. So even if the assignment is to edit one topic, the TOC will show the
full publication and highlight the topic's location in the structure.
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With view content in context, the TOC loads the full publication and shows the location of the currently
viewed topic.

NOTE
The view content in context feature only works if the assignment is created
from a "fork" in a publication. To find out more, see Author Instructions for Review
Assignments [1272].

To use the view content in context feature:

1. Open the assignment with the link in the assignment invitation email or via the Assignments
Panel [46] on the Dashboard.

2. Hover the cursor over any part of the content and then select the View in context icon.

When you select the icon, the page reloads.

NOTE
If the Contributor Editor toolbar is visible, you have to close the topic with the
X in the right corner of the toolbar, for the icons to appear when hovering
over the content.

3. Select Show / Hide table of contents (TOC) to the left of the content. 
The TOC highlights the publication in blue and the currently viewed topic in dark blue, with a
gold star.
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TIP
To exit the "In context" view, select Show / Hide table of contents. .

Each time you select the view in context icon, it toggles the TOC's "in context" view
on and off.

Compare Reviews
When working on a review assignment in Contributor Editor [41], you can compare the live content
to any previous made snapshot of the content.

A snapshot is an archived version of the content at a particular point in time and useful when you
compare different versions. Snapshots are made automatically at certain stages in the assignment
workflow. We also recommend that you make some snapshots manually at certain stages in your
work.

The Single Panel Comparison highlights the changes in a combination of the current version and the
snapshot. To be able to choose a snapshot, there must be snapshots automatically or manually
created from a previous version.

When comparing reviews, you can Add, Edit or Reply to Comments in Review View [1288]. To be
able to edit the live content while comparing, you need to enter Edit View [42]. Learn more about
User Types [1834].

TIP
To turn off the comparison and only see the latest version:

1. Select Settings in the top-right corner. 

2. Select Compare version and choose Show current revision.
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1. Display Review View [41] from the assignment link or via the Assignments Panel [46].

2. Select Settings in the top-right corner. 

3. Select Compare versions. 

4. Select the snapshot version that you want to compare with the latest version of the content.
The page reloads to show you a comparison of the snapshot and the latest version. It is a
combination of both revisions and highlights the changes that have taken place.
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1.  Table of Contents shows all subtopics from snapshot version and latest version.

• Blue bold topic means that the topic has been Added in the latest version.

• Italic topic means that the topic has been Deleted in the latest version.

• Bold topic means that the topic has been Changed in the latest version.

2. Text colors show changes in the topic or publication content.

• Red strikethrough is content that has been Deleted in the latest version.

• Blue text is is content that has been Added in the latest version.

3. Colored vertical change bars show if entire topics, block elements, tables or images are
different in the latest version.

• Red bar to the right of the content show that the topic has been Deleted in the latest
version.
If the red bar is positioned to the left it visualizes that a block element, table or image
has been deleted.

• Blue bar to the right of the content show that the topic has been Added in the latest
version.
If the blue bar is positioned to the left it visualizes that a block element, table or image
has been added.

• Orange bar show that the topic has Changed in the latest version.
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NOTE
If topics have been moved, but are otherwise identical, Paligo does not
include any change indicators. It recognizes that the content is the same.

Choose the Profile Settings
When someone sends content for you to work on as an assignment, they should set up any
profiles that are needed and save them as a favorite. They should also advise you which favorite to
choose. This information should be included as a comment with the assignment email.

NOTE
If you are an author and you need to set up a favorite profile, see Favorite
Profiles [1263].

If the content uses filters and / or variables, the author should have created a favorite profile
and provided you with information about which profile to use. If they have not provided this
information, it is possible that the content does not use filters or variables and you can skip this
step. You may want to double-check with the author first, as if there are profiles, they are designed
to show / hide information, so you may see content that is not intended for you.

On the profile settings dialog:
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1. Select the Favorites tab and then select the appropriate profile.
If the author has not provided information about which profile to use, contact them to find
out. The content you see in the assignment could change depending on which profile you use,
so it is important to choose correctly. If there are no profiles saved as favorites, the author has
not set up the profiling as recommended. They should refer to Author Instructions for Review
Assignments [1272].

2. Select Apply.

3. Close the profile settings dialog and start working on the content (see Working in Review
View [1278]).

NOTE
The profile settings tell Paligo which variable values to use and which filters to
apply.

Variable values are pieces of content that can show different terms in different
scenarios. For example, a product name may change depending on which product
the topic is for.

Filters are pieces of content that are included or excluded in different scenarios.
For example, a paragraph may be included if the audience is experts but excluded
if the audience is beginners.

Feedback in Review View
To provide feedback in your review or contribution, use comments. You can view any existing
comments in the comments sidebar, and you can add new comments and reply to comments.

You can also set up notifications so that Paligo emails you when new comments are made. For old
comments, there is an archiving feature, which lets you save and hide those comments that have
been dealt with.
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Add, Edit or Reply to Comments in Review View

TIP
You can use "mentions" to notify other people of your comments directly, just like
on social media. To send a mention notification to another Paligo user, use the @
symbol and then start typing their name. You can select the person you want to
notify from the dropdown menu.

To add a new comment:

1. In the main body of the topic, select the content block that you want to comment on.
Paligo adds a new comment box to the comments sidebar.

NOTE
You can add comments for most types of content. However, comments for
programlisting elements are not currently supported.

2. Add your feedback to the box and select Save.
Paligo adds a yellow highlight to the selected content, so that other users know that a
comment has been made.

If you want to change a comment you have made, you can edit it:

1. In the comments sidebar, select the comment you want to edit.
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NOTE
If the comment has been archived, you will need to restore it [1295] before
you can edit it.

2. Select the Edit option, make your changes, and then select Save.

To reply to a comment that someone else has made:

1. In the comments sidebar, select the comment that you want to reply to.

2. Select the Add option, and then enter your reply and select Save.
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Locate a Comment in your Content
To find the content that relates to a comment, select the comment speech bubble in the
Comments sidebar. Paligo then shifts the focus to show the relevant piece of content, and a
highlight on the content block flashes on and off briefly.
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Filter Comments in Review View
The comments sidebar shows all comments by default. If you prefer, you can filter the comments
sidebar so that it only shows comments that meet certain criteria based on date, user and / or the
status of the comments. For example, you could filter the comments sidebar so that it only shows
the comments from one specific reviewer, made between January and March, and with a status of
Rejected.

To filter the comments:

1. Select the filter icon at the top of the Comments sidebar.

The filter settings appear in an extra section. By default, the filter settings remain on show, so
that you can see there are filters in place.

NOTE
Use the filter icon to show and hide the filter settings. It is often better to
leave them on show so that you can see what filters are in place.

2. Enter the filter settings you want to use.

• Select the Start Date and End Date fields to display calendars. Use the calendars to set the
date of the filter.
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• Select the names of the users whose comments you want to see. Check the box next to a
user's name to see their comments or clear it to hide their comments.

• Select the Status of the comments that you want to see. Check the box next to the status
name to see comments with that status. Clear the box to hide comments with that status.

Paligo applies the filters and displays the comments that meet the filter criteria. It hides any
comments that do not meet the criteria.

Get Notifications About Comments
You can set Paligo to send you an update notification when there is a new comment or when you
are "mentioned" in a comment. The notification is sent to you via email, using the address that is
associated with your Paligo user account.

To set comment notifications:
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1. Select the menu icon in the top corner of the comments sidebar.

2. Use the Comment Notifications options to set your preference:

• Mentions only - you will only receive a notification email when your username is
mentioned in a comment.

• All comments - you will receive an email each time there is a comment on this topic.
If you choose All comments, you are "following" the comments. Paligo will send you a
notification either immediately or at a regular interval, and you can control this by setting
the notification frequency in your user profile. You can change the frequency if required,
see My Profile [1843].
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Change the Comment Status
This section only applies to authors who are responsible for addressing any issues that come up in
the reviewers' or contributors' feedback. It is important to update the status of comments that you
have dealt with, as this lets other users know which comments still need to be looked at.

When you see comments that are left by other users, you can update the comment to show that
you have:

• Read the comment

• Rejected the comment, perhaps because the comment is incorrect or irrelevant to the topic

• Made the changes that were suggested in the comment.

NOTE
Reviewers and Contributors are not supposed to change the comment status.

To change the state of a comment:

1. In the comments sidebar, select the comment that you want to change.

2. Update the status of the comment by:

• Selecting the Status option for a specific comment and do not affect the state of any other
comments in the paragraph.

• Selecting the settings icon in the bottom corner of the comment box to apply it to all of
the comments in the current paragraph. 
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To the left - change status for an individual comment. To the right - change the status for all
comments in the current paragraph.

3. Select a status:

• Done - Use if you have completed the work suggested in the comment.

• Rejected - Use if you think the comment is incorrect or is suggesting inappropriate
changes.

• Mark as read - Use if you have read the comment , but have not taken action on it.

• Unset status - Use if you want to cancel the comment's current status so that other
users know the comment needs to be looked at again.

Archived Comments
Archived comments are old comments that have been accepted or are automatically archived
when an assignment ends or begins. By default, they are not shown in the comments sidebar, but
you can choose to display them if you want, and they appear as monochrome (no color).
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Typically, you will only use the archive comments features to view or hide old archived comments.
But there may be times where you need to make a change to an archived comment or need to
revert it back to a regular comment, in which case, you will need to restore it.

If your Paligo is not set up to archive comments automatically, the comments will always be
"regular" comments. In this case, you can archive comments manually, if needed.

NOTE
To find out how to set up automatic archiving, see Automatically Archive
Comments [1217].

Show/Hide Archived Comments
Archived comments are not shown in the comments sidebar by default. But you have the option to
display them if you want.

1. In the comments sidebar, select the menu button in the top-corner to display a menu.

2. Select Show/hide archived comments to toggle the visibility of the archived comments on
and off.

Restore Archived Comments
If a topic has archived comments, you can choose to restore all of the comments within a selected
time range, such as a day. When you restore archived comments, they become regular comments
again, and so can be edited.

1. In the comments sidebar, make sure the archived comments are shown [1296].

2. Select the archived comment that you want to restore and then select the Restore option.
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3. Choose the date range. Paligo will restore all of the archived comments that were made in the
date range you specify.

4. Select Restore.
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TIP
if you want to restore all archived comments in a topic, select the menu button
in the top corner of the comments sidebar. Select the Restore all comments
option, choose the date range and then select Restore.

Archive a Comment Manually
If your Paligo assignments are not set up to archive content automatically, the comments will
remain as "regular" comments. However, you can archive comments manually if needed.

To archive a comment:

1. In the comments sidebar, select the comment that you want to archive.

2. Select the archive button and confirm that you want to archive the comment at the prompt.
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TIP
If you want to archive all comments in a topic, select the menu button in the top
corner of the comments sidebar and then select Archive all comments.

Contribution Assignment Instructions
The following sections provide an overview of the steps you should follow for contribution
assignments. The steps will vary depending on your user account:

If you are an author, see Author Instructions for Contribution Assignments [1300].

If you are a contributor, see: Contributor Instructions [1303].

Author Instructions for Contribution Assignments
To send content to a contributor, follow the process described in this article. You will need access
to the full Paligo editor, so must log in to Paligo as an administrator or author.

TIP
This is an overview of the steps you need to follow, with references to the sections
that explain the steps in more detail. If you need to refer to the more detailed
sections, it is a good idea to open them in another tab so that you can easily
switch between this process and the detailed explanations.
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1. Create the profile settings for a contribution assignment. This step is only needed if your
content uses variables or filters (profiles). For more details, see Favorite Profiles [1263].

2. Create a contribution assignment. Use it to invite users and/or user groups to edit or add to
your content.

For details, see Create Assignments [1240].

NOTE
We recommend that you also check that the Default Settings for
Assignments [1216] are suitable for your assignment.

3. Use the Planner to Track the Assignment Progress [1246]. This is an optional step.
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The assignee(s) will work on the assignment and set a state that you can see on your
dashboard and on the Planner.
If they set the content to approved, it means it is ready for translation or publishing,
depending on your workflow. The assignment is finished.
Approved content is shown with a green and white check symbol.

If they set the content to needs work, it requires your attention.
The assignee's avatar shows a red stop sign if they have set the content to needs work.

4. As contributors can add and change content, we recommend that you open the content and
check it (see Open an Assignment that "Needs Work" [1253]).
You may find that:

• Some of the content that has been added or changed has invalid structure. You will need to
fix this.
For more information, see Validation [623].

• You want to rewrite the new or changed content to make it more appropriate for the target
audience. For example, a contributor may use jargon terms or complex language that may
confuse readers.

5. As you edit the content, you may find that you need to ask the reviewer a question or explain
why you disagree with their feedback. Use comments to respond to the contributor and to
add your own comments.
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The way to add and respond to comments varies, depending on whether you open the
content in the full editor or in edit mode (contributor). To find out more, see:

• Comments in the Full Editor [1257]

• Feedback in Contributor Editor [1332]

6. When you have dealt with all of the comments, either reassign the assignment [1260], refresh
the assignment [1262], or create a new assignment [1240] to get the changes checked. You
can only reassign if you created the original assignment.

7. When the assignment comes back with all content approved, can (optionally) send the content
for translation or set the document state to Released, and publish it.
You can see the state of your content in the overall production workflow by looking at the
Resource view (see Workflow Status [1209]).

To find out how to change the content state, see Change the Status of a Publication or
Topic [1210].

Contributor Instructions
As a contributor, you can be invited to take part in a contribution assignment, where you edit
content or add content. For example, you may be asked to add a topic on a subject in your area of
expertise.

To edit, you will open the content in Paligo's editor mode, which is a specially designed interface
for contributors. There, you will be able to change content, add new content, and leave feedback
comments.
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NOTE
You cannot access advanced features such as content reuse, as these are
reserved for Paligo authors who use the full editor. The contributor editor is a
simpler editor, designed to allow non-technical writers to add content.

To contribute to the content:

1. You receive an email inviting you to take part in a contribution assignment. Select the link in
the assignment to open the content in the Contributor Editor.

NOTE
In the email invite, look for a message from the creator of the assignment.
They may advise you to select a certain profile when you open the
assignment.

If they have not included a message, the profile may be set automatically or is
not needed.

2. To choose a profile, select the cog icon next to the Your assignment button and then select
Profile settings.

On the profile settings dialog:

a. Select the Favorites tab and then select the appropriate profile.

b. Select Apply.

c. Close the profile settings dialog.

3. Use the editor's features to add content, edit the existing content, and provide feedback as
needed.
To learn how to use Edit View, see Working in Edit View [1306].

4. When you are finished editing the content, create a snapshot.
A snapshot is an archived version of the content at a particular point in time and useful when
you compare different versions.
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a. Select the cog icon and choose Create Snapshot.

b. Add a comment about the snapshot. Try to provide information about the content at this
point in time, so that other users will be able to use the snapshot and understand why it
was created.

c. Select OK to confirm the comment and create the snapshot.

5. End the assignment:

a. Select the Your assignment button to display the complete assignment dialog.

b. Select either:

• Done to mark the content as ready for publishing, with no further work needed

• Needs work to notify the Paligo author that changes are suggested

• Reset status to clear the status of an assignment so that it no longer has a done or
needs work status.

Paligo sends an email to the person who invited you to the assignment. It tells them that the
assignment is complete and that is has either been approved or needs further work. A Paligo
author will most likely review the content and use the features available in the full editor to
make sure your content has a valid structure and is consistent with other documentation.
The Paligo author may reassign the assignment to you if they have questions or feel more
work is needed.
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Working in Edit View
The Contributor Editor's Edit View has a simpler interface than the main Paligo editor. It is
designed to allow non-technical writers to add and edit content. The idea is that contributors, such
as engineers or developers will use the Contributor Editor to add or edit the text, data and images.
When the contributor is finished, Paligo authors can use the full editor to apply the more advanced
features, such as content reuse, variables and filtering. This section gives an overview of the Edit
View features. To learn more about adding or editing content, see Edit Content in Edit View [1315].

NOTE
The difference from Review View [41] is that you also can:

•  Edit live content

• Create Snapshots [1330] to save an archived version of the content during the
contribution assignment.
Learn more, see Compare Reviews [1283], Compare Contributions [1341] and
Contribution Settings [1232].

The following User Types [1834] have access to the Contributor Editor:

• Contributors who are invited to take part in Paligo contribution assignments or have content
shared with them.
If you have a Contributor user account, you can open a contribution assignment in the
Contributor Editor. It provides a variety of features for editing content and providing feedback,
see Edit Content in Edit View [1315]). Contributors can both review and edit content. Learn more
about review features, see Working in Review View [1278].

• Author or Administrator
If you are a full Paligo Author, you have access to the Contribution Editor and its features, too.
But in most cases, you will want to use the full Paligo editor for your work, as it has a wider
range of features.
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Differences to Other Editors
Paligo uses "structured content" and so works differently to other editors that you may be used to,
such as word processing applications and WYSIWYG (what you see is what you get) editors.

The main differences with the Contributor Editor are:

• Content is written in blocks
Each topic is made up of blocks, where each piece of content is a separate block. For example, a
title is a block, a paragraph is a block, an image is a block, and so on.
You cannot select two adjacent paragraphs and apply formatting to them at the same time.
Instead, you apply it to each block individually.

• The editor may adjust your content to make sure it has a valid structure
When editing, you may add content at a certain position, but the editor places it elsewhere. This
is because that type of content is not allowed at the selected position. The editor will add the
content in a valid position instead. For example, if you try to add a table inside a paragraph, the
editor will place the table before or after the paragraph, not inside it.

• The content may contain variables
Variables are words or phrases that can be swapped out for an alternative word or phrase. In
the Contributor Editor, they appear as code with a gray background or as a word shown in blue
with a blue outline.
Contributors cannot change the variables, but can set the profiling to choose which variable
terms are shown.

• The content may use filters
Filters are a way of hiding a block of content in certain scenarios. For example, a paragraph
might be shown for one version of a product, but hidden for a different version. They are set up
by Paligo authors in the main Paligo editor.
Contributors cannot create filters, but you can choose which filtered content is shown. You can
edit the filtered content too.

Edit View Features
Contributor Editor [41] is where you manage your contribution assignments. If you activate the
Edit Mode, it has a wide range of features for editing content and adding comments. If not
activated, the Contributor Editor will only work as Review View [41], which means that you can only
provide feedback comments.
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1. Switch between available interfaces - The user type determines which interfaces that are
available. To reach the Assignments Panel [46], you select Dashboard.

2.  Table of Contents (TOC) - Show and hide the navigation sidebar.

3. Contributor Editor Toolbar - You display it by selecting any part of the text, see Edit Content
in Edit View [1315].

4. Content Editor - This is where content is added and edited.

5.  Assignment button - Use it to end the contribution assignment by setting it to Done or
Needs Work.

6. View selector - It shows which view you have entered. If you have an author license, you can
use it to switch between the different views available in Contributor Editor.

7.  Settings - This is where you find the following functions: Compare versions, Create snapshot,
Profile settings, Share document and Publish document. The publishing option is only available to
Paligo authors. You can compare content to previous versions called "snapshots". To find out
more, see Compare Contributions [1341].

8.  Comments sidebar - Use to blue speech bubble show and hide the comments sidebar.
This is where you provide feedback and reply to other comments. To find out more about
using comments, see Add Comments in Contributor Editor [1332].

9.  Variables - These are words or phrases that can change in different scenarios. You cannot
edit these in the Contributor Editor, but you can use the profile settings dialog to apply their
values.

10.  Profile Settings - This is where to select favorites, variables, profiling and options. If
the content contains filters and / or variables, you should choose the profile set for the
contribution. The person who sends you the contribution assignment should tell you which
set you should use and you can select it from the Favorites tab.
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11.  Open the Content Manager [34]Only available to Paligo authors

12.  Switch to the full Paligo editorOnly available to Paligo authors

Edit View Toolbar
The Contributor Editor Toolbar is not as advanced as the one in the full Paligo Editor, but has the
necessary options for adding structure (such as sections, lists and tables), inline styling and adding
images and videos.

•  Undo or Redo Contributor Edits [1330]

•  Add Comments in Contributor Editor [1332]

•  Show or hide comments

•  Dictionary or spellchecker settings

•  Save changes

•  Full screen

•  Exit and check in the topic.
If an assignment includes several topics, you have to close the edited topic to be able to edit
another. Remember to save the changes first.

•  Add a title or Bridgehead

•  Add Subsections [1328]

•  Add inline styling

•  Add Links [1317]

•  Add Lists and Procedures [1318]

•  Add Code Blocks [1321]

•  Add Images [1322]

•  Add media URL

•  Add a table [1324]
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•  Add Admonitions [1325]

•  Remove Inline Elements [1326]

•  Edit the Source Code [1329]

Content Blocks in Edit View
Paligo uses structured content, which is a standardized approach to writing, where the content
consists of "blocks" of information. These blocks are organized into consistent structures and
can be reused in many different outputs (PDF, HTML, HTML5, mobile devices). This makes the
content more versatile as it is easier to move, reuse, update and convert into different formats - all
important factors when creating documentation.

As a contributor, you will be asked to contribute to one or more topics. Each topic consists of
content blocks, like Elements [89]. When you add content in Contributor Editor [41], the correct
block element is automatically added, ready for you to add the text. For example, if you add
a note, the editor automatically adds a note element and a para element inside it. The para
element is for the text of the note.

In the image below, we have a section that represents the entire Topic (1). Inside the section, there
is a Title (2), a Paragraph (3), an Image (4) and an Admonition (5).

Each of these are separate blocks of information. As the blocks are separate and organized into
a hierarchy, you cannot select multiple paragraphs all at once, like you could in a word processor
or blog post editor. You have to select each block separately. If you select a block, you can see its
structure and location in the topic (section) in the element structure panel at the top.

1 = Topic, 2 = Title, 3 = Paragraph, 4 = Image , 5 = Admonition

TIP
To find out about available features, see Edit View Features [1307].
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Rules for Positioning Content
To ensure consistency in the structure, there are rules for the positioning of content. These rules
are applied automatically by the Contributor Editor so that whenever you add or change content,
the structure remains valid.

If you want to add an element in a position, but the editor places it elsewhere, it is because the
element is not allowed at the position you selected. The editor will add the content in a valid
position instead and may adjust some of the nearby structure in the process.

For example, you cannot insert a table inside a paragraph. If you try to do that, the editor will place
the table before or after the paragraph, in a valid position.

Styling and Content are Separate
With structured content, styling and content are separate. The idea is that content is created as
text and images and the styling is applied during publishing, not editing. This means that the same
content can be reused in different outputs (PDF, HTML, HTML5, mobile devices) and if needed,
have different styling in each one.

But the Contributor Editor does have some styling features for inline content, such as bold, italic
and underline. These are available from the toolbar and Paligo recommends that you discuss
which ones to use with your Paligo authors.

Highlighted Content in Edit View
When you edit content in the Contribution Editor, you may notice that some of the content has a
colored highlight that is explained below.

Yellow Highlight
Content that is highlighted in yellow has a comment associated with it. Select the highlighted
content to view the comment in the Comments Sidebar to the right.

To see the comment, select the comment icon in the top-right to open the comments sidebar.

Blue Highlight
If you have a block of content with a pale blue highlight, it means it is a reused subsection inside
another topic.
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For words or phrases that are inside a paragraph and have a blue background, it means they are
variable values. These are words that are stored separately to the topic and you cannot change
them. If you think they need to be changed, add a comment and make your suggestion there.

Dark Gray Highlight
If there are words shown with a dark gray background, it means they are variables. These are
words that are stored separately to the topic and you cannot change them.

When a Paligo author invites you to contribute, they should set the content up so that the
appropriate variable values are in place. If you see the dark gray, it means the variable value
has not been set, see Choose the Profile Settings [1286].

When a variable value is in place, the variable has a blue background highlight, like this:

Red Highlight
Content that is highlighted with a red background is locked reused content. This can only be
edited (if needed) in the full Paligo Editor. Contributors cannot change reused content. If you need
to make changes to reused content, use a comment to explain what changes are needed and let
the author make the changes.

Display the Edit View
As an assignee, you will receive an email invite to review, translate or contribute to the
documentation. This is because a Paligo author has allocated an assignment to you or Share
Content (without assignments) [1347].

NOTE
If the content uses filters and / or variables, the author should have created a
favorite profile and provided you with information about which profile to use, see
Choose the Profile Settings [1286] and Favorite Profiles [1263].

The Assignment Types [1212] and User Types [1834] decides which view that will be opened.
Learn about the available assignment features, see Review View Features [1280], Edit View
Features [1307] and Translation View [1752]. There are two ways to reach the assignments:

• Select the link in the email to display the content in the Review View [41], Edit View [42] or
Translation View [1752].
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• Log in to Paligo and select the assignment from the Assignments Panel [46], on the right side of
the Dashboard, to open the assignment.

As an Author, Admin, Publisher or Translation manager, you can access the assignments in the
full Paligo editor to view feedback comments, review, edit or translate content. To find out how to
view feedback comments, see Comments in the Full Editor [1257]. After a contribution assignment,
it is a good idea to use the validation features in the full Paligo editor to check the structure of the
content is valid, see Validation [623].

1. Select the Dotted Menu (...) for the topic in Content Manager [34]

2. Select Edit and choose Review, Contribute or Translate to open the assignment.
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TIP
If you are unfamiliar with the Edit View, we recommend that you read the
following sections before using it:

• Content Blocks in Edit View [1310]

• Highlighted Content in Edit View [1311]

Tips for Working in Edit View
The Contributor Editor's Edit View has a similar design to other editors, such as those used for
creating documents and creating blog posts. But there are some differences too, as Paligo uses
structured content, which requires a slightly different approach.

If you are new to Contributor Editor [41], you will find that it feels very similar to user-friendly rich
text editors you may have used before. This section gives you some useful tips for working in the
Contributor Editor when the Edit Mode is activated.

IMPORTANT
The content may be set up to use variables and filters. For example, a paragraph
could be hidden when the content is published for the USA, but visible when
published for the EU.

Paligo recommends that the variables and filters are set up before the
contribution assignment is sent. All the contributor need to do then is to choose
the profiling that the author has added, as a favorite.

•  Press Enter  to add a new row in a code block, admonition, table cell, procedure or list.

•  Quickly hit Enter  twice to exit a code block, admonition, procedure or list.

The break exits the block element and adds a paragraph after it.

•  Use the Break widget [1320] to exit a table, image or media.
The break exits the block element and adds a paragraph after it.

• Highlight text and select a toolbar option to add an inline element, make it a link, turn it into a
procedure step / list item or to add a feedback comment.

• When there are multiple topics in the contribution assignment, you have to Close and check-
in a topic to be able to edit one of the other topics. Also remember to Save the changes before
closing it.

To the left - Save the changes, To the right - Close and check-in the topic

•  Add a comment with Edit Mode activated. You can also make a comment the same way as in
Review View [41], where you select text and then add a comment.
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Edit Content in Edit View
When you display content in the Edit View, you can see one or more topics. The Edit View
Toolbar [1309] contains a variety of options for adding and editing content.

TIP
In the Contributor Editor, you can add:

• Add Comments in Contributor Editor [1332] for giving feedback and providing
information. You can also show and hide comment highlights. If you only want
to add feedback comments, you do not need to enter the Edit Mode.

• Copy Content from other Applications [1337] into the Contributor Editor. This
includes copying from Word, Google Docs, and MarkDown editors.

Add Topics
To add a new topic or subsection in Contributor Editor [41], you need to open the content in Edit
Mode. Your new topics will appear in the location specified by the author when the assignment
is created, see Contribution Settings [1232]. You cannot change the location in edit mode. As a
contributor it is not possible to move it outside the assigned topic. Only the author is able to move
it in the publication structure.

This instruction describes how to add new topics to a contribution assignment topic.

NOTE
When there are multiple topics in the contribution assignment, you have to Close
and check-in a topic to be able to edit one of the other topics. Also remember to
Save the changes before closing it.

To the left - Save the changes, To the right - Close and check-in the topic

1. Display Edit View [42] from the assignment link or via the Assignments Panel [46].
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2. Move the cursor to the plus symbol. 

3. Enter a title.

4. Select Insert.

5. Use the Edit View Toolbar [1309] to add or edit the content.

6. Select Save. 

Add Inline Elements
There are inline elements that you can use in Contributor Editor [41], such as bold, italic and
underline. You can add them to individual letters, words or entire paragraphs. This is similar to
"formatting" in a word processing program, but with more possibilities.

TIP
To remove text formatting, see Remove Inline Elements [1326].

1. Highlight the text that you want to have the inline element.

2. Select an inline element in Edit View Toolbar [1309].
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1. Bold

2. Italic

3. Underline

4. Strikethrough

5. Superscript

6. Subscript

7. Code - Use it to mark up text as code. It will be styled differently in the output so that it is
clear that the text is code and not regular text.

NOTE
For blocks of code, if you are not adding it inline in the middle of text, use
Insert Code block in the toolbar instead. 

8. GUI label - Use it to mark up text as a user interface label. This is often used for options in
software.

9. Tag - Use it to mark up text as an HTML or XML element.
For example, if the topic was about formatting HTML headings, you might have <h1> in
the text and you could apply the tag to that. In the output, the tag content has a different
styling to regular content.

3. Select Save. 

Add Links
When you are working in Contributor Editor [41], you can add links to other topics and external
websites.

1. Display Edit View [42] from the assignment link or via the Assignments Panel [46].
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2. Position the cursor where the link is to be inserted.
Alternatively, highlight the text that you want to use as the label for the link.

3. Select Link in Edit View Toolbar [1309] and choose the appropriate type of link. 

• Cross-reference - Select a topic or other content in your Paligo database to link to.

• Link - Enter the URL to an external website and accept it with the green checkmark.

4. If necessary to edit the link or cross-reference, select it to access menu options.

•  Unlink

•  Edit link

5. Select Save. 

Add Lists and Procedures
As a contributor, you can add entire lists and procedures or individual steps to a topic. If you want
to add a paragraph or other elements after the list or procedure, you will need to Add Breaks
Between Block Elements [1320].
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TIP
To create a sub list, create a new list item after an existing one. Use the Tab  key

to indent the new list item. At the end of the sub list, if the main list is to continue,

create another sub list item and then use Shift Tab  to outdent it again.

To convert a list to a paragraph, position the cursor before the first character in

the item / step / bullet text and press backspace . It will convert into a paragraph

on the previous numbered item / step / bullet.

1. Display Edit View [42] from the assignment link or via the Assignments Panel [46].

2. Position the cursor where the new list or procedure is to be inserted.

NOTE
If you want to add a list after another "structure" such as a subsection, add a
break first. You can then add the list after the break.

3. Select a list option from the Edit View Toolbar [1309]. 

1.  Ordered list. Use this for numbered lists that are charts or rankings. Do not use the
it for step-by-step procedures (instructions/tasks). For such lists, use the procedure list
instead.

2. Unordered list. Use this for lists of items where there is no sequence to be followed
("bullet lists").

3. Procedure. Use the procedure list for step-by-step instructions / tasks.

4. Enter the text for the first step / list item.
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5. Press Enter at the end of the line to create the next step / list item.

6. Add as many steps as you need.

7. To add content, press Shift  + Enter  to move the cursor below the text.

8. Use the Edit View Toolbar [1309] to insert images, admonitions or other content.

9. Select Save. 

Add Breaks Between Block Elements
To be able to add information below a block element in Contributor Editor [41], a break must be
added. How you add a break depends on the type of block element:

• Quickly hit Enter twice to exit a Code block, Admonition, List or Procedure.

• Use the Break widget to exit a Table, Image or Media. 

The following instruction describes how the break widget is used.

1. Display Edit View [42] from the assignment link or via the Assignments Panel [46].

2. Select the Break widget that appears when hovering over a table, image or media. 
The break ends the previous structure with a paragraph.
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3. Use the Edit View Toolbar [1309] to add or edit content.

4. Select Save. 

Add Code Blocks
A code block is a section of one or more lines of code. When the content is published, the code
block is formatted with syntax highlighting, indentation. In many cases Paligo will output proper
syntax highlighting just by autodetecting the language. But in some cases the results will be better
if the language is specified.

The following instruction shows how to add a code block in Contributor Editor [41].

TIP
If you want to change the programming language for an existing code block,
position the cursor inside the code block and select a new programming language
from the toolbar.

1. Display Edit View [42] from the assignment link or via the Assignments Panel [46].
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2. Position the cursor in a new paragraph.

TIP
You can also highlight a text and then select the code block option in the
Contributor Editor [41] Toolbar to turn it into a code block.

3. Select Insert code block and choose programming language in Edit View Toolbar [1309]. 

4. Enter the code inside the code block.

5. Select Save. 

Add Images
In Contributor Editor [41] you can add both images and inline images. The instruction below shows
how to add images and available settings.

1. Display Edit View [42] from the assignment link or via the Assignments Panel [46].
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2. Position the cursor where you want to add the image.

3. Select Image and choose image type in the Edit View Toolbar [1309]. 

4. Use the Search (1) to find an existing image in the media library or Upload (2) a new image.

TIP
If you hover over an image, a magnifying glass is displayed in the top corner
of the image. Select the magnifying glass to see a large popup view of the
image.

5. Select an image from the media library.
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6. Select the added image in the topic to open the image options.

3. Replace the image

4. Switch image type (image or inline image)

5. Add or remove caption

6. Adjust image size

7. Select size unit (pixels or percent)

7. Adjust the image with the image options.

8. Select Save. 

Add Tables
In Contributor Editor [41] you can add tables and edit existing tables. The instruction below shows
how to add tables and available settings.

1. Display Edit View [42] from the assignment link or via the Assignments Panel [46].

2. Position the cursor where you want to add the table.

3. Select Insert table and choose the number of rows and columns in the Edit View
Toolbar [1309]. 
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TIP
You can add more rows and columns later if needed.

4. Select the part (or parts) of the table to be formatted (row, cell, column) to open the table
options.

1. Column - Make header column, add, delete and select column.

2. Row - Make header row, add, delete and select row.

3. Merge cells - Merge cell up, down, right and left. Split cell vertically or horizontally.

4. Adjust table width.

5. Adjust text alignment (left, center, right or justify).

6. Add or remove caption

5. To delete the table, hover over the table and select the blue square in the left corner and

press Backspace  on your keyboard.

6. Select Save. 

Add Admonitions
In Contributor Editor [41] you can add admonitions, such as warnings, notes, examples and tips.
The instruction below shows how to add admonitions, change admonition type or remove it.

1. Display Edit View [42] from the assignment link or via the Assignments Panel [46].
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2. Position the cursor where you want to add the admonition. It will be appear below the cursor
position.

NOTE
If you want to add an admonition:

• After a Code block, Admonition, List or Procedure, quickly hit Enter
twice to exit the block element.

• Inside a step or list item, position the cursor at the end of the the step or
list item.

3. Select Admonition and choose admonition type in the in the Edit View Toolbar [1309]. 

4. Add content to the admonition. By default, an admonition has a paragraph.

5. To change admonition type, position the cursor inside the admonition and select another
admonition type.

6. To remove the admonition, position the cursor inside it and and press Backspace  on your

keyboard.

7. Select Save. 

Remove Inline Elements
Removing inline elements [1316] (such as bold, italic, guilabel, tag) can be done in two ways in
Contributor Editor [41]:
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• Deselect the inline element (1) by selecting it again. An option in use is marked with a gray
background.

• Use Remove format (2). The following instruction describes how the Remove format option is
used.

1 = Bold, 2 = Remove format

WARNING
Do NOT use the Remove format option on text fragments that have a red
background. That means that the text is reused in other topics and should not
be edited. If you remove the format, it would break the reuse. Instead provide a
feedback comment [1332] on such a text fragment.

Should you happen to clear the formatting on a reused text fragment, undo the

command with Ctrl  + Z  (PC) or Cmd  + Z  (Mac).

1. Display Edit View [42] from the assignment link or via the Assignments Panel [46].

2. Select the content or position the cursor inside the text where the formatting is to be
removed.

3. Select Remove format in the Edit View Toolbar [1309]. 
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4. Select Save. 

Add Subsections
To add a new topic or subsection in Contributor Editor [41], you need to open the content in
Edit Mode. The new content will be located inside the topic that you have been assigned to. As a
contributor it is not possible to move it outside the assigned topic. Only the author is able to move
it in the publication structure.

This instruction describes how to add subsections to a contribution assignment topic.

1. Display Edit View [42] from the assignment link or via the Assignments Panel [46].

2. Place the cursor where the new subsection is to be added.

3. Select Add Section in the Edit View Toolbar [1309]. 

4. Enter a title.

5. Use the Edit View Toolbar [1309] to add or edit the content.

6. If needed, use the arrows to rearrange the order of the subsections or to delete a topic. 
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7. Select Save. 

Edit the Source Code
Paligo recommends that you use the regular features in Edit Mode to add and edit content in
Contributor Editor [41].

However, there may be times where you want to look at the source code, for example, if a
formatting element appears to be in the wrong place. The source code in the Source Editor is in
HTML, it is only transformed to XML when saved to the database. You can view it by selecting the
Source code option in the toolbar.

CAUTION
This is only for users with advanced understanding of HTML code. By editing
the source code in the Contributor Editor [41], it is easy to make mistakes and
create a corrupt topic.

If you are not sure of this, instead provide a feedback comment [1332] about the
necessary changes to the author.

1. Display Edit View [42] from the assignment link or via the Assignments Panel [46].
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2. Select Source code in the Edit View Toolbar [1309]. 

3. You can view the code or change the content in the Source Editor.

WARNING
Do not use the source editor unless you have a good understanding of HTML.

4. Select Update to save changes or Cancel to exit without saving.
You can only update the code with your changes, if the HTML structure is valid.

Undo or Redo Contributor Edits
In Contributor Editor [41] you can undo and redo all actions done since the last time you saved.
The options for Undo and Redo are found in the Edit View Toolbar [1309].

• Use the Undo option to cancel your last action. If needed, you can select the Undo option
multiple times to cancel your previous actions in order.

• Use the Redo option to restore the previous cancelled action.

To the left - Undo, To the right - Redo

TIP
You can also use the standard keyboard shortcuts:

• Undo - Ctrl  + Z  (PC) or Cmd  + Z  (Mac)

• Redo - Ctrl  + Y  (PC) or Cmd  + Shift  + Z  (Mac)

Create Snapshots
When you are working on your assignment, you can save the content as a "snapshot". A snapshot
is an archived version of the content at a particular point in time and useful when you compare
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different versions. When a user creates a snapshot, it is possible to add a comment that provides
more context about the snapshot for other users.

Some snapshots are created automatically at certain stages of the assignment process. But we
also recommend that you create a snapshot when you:

• Complete an assignment

• Share content

• Feel there are special changes that would be useful to be able to go back and compare.

IMPORTANT
Only administrators, authors and contributors can create snapshots. Learn
more about the differences between the User Types [1834].

To create a snapshot:

1. Select Settings. 

2. Select Create Snapshot. 

3. Add a comment that explains why it was created.
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NOTE
The snapshot comment can be viewed in the full Paligo Editor [51].

Select the parent folder in the Content Manager [34] to access the Resource
View [68]. Expand the topic in the list and select the Versions tab. It contains
all comments added for the snapshot versions.

4. Select OK to confirm the comment and create the snapshot.

Feedback in Contributor Editor
To provide feedback in your review or contribution, use comments. You can view any existing
comments in the comments sidebar, and you can add new comments and reply to comments.

You can also set up notifications so that Paligo emails you when new comments are made. For old
comments, there is an archiving feature, which lets you save and hide those comments that have
been dealt with.

TIP
To learn how to locate a comment, get notifications about comments, change the
status of a comment or archive comments, see Feedback in Review View [1287].
These features work the same in Contributor Editor as they do in Review Mode.

Add Comments in Contributor Editor
When providing feedback comments i Paligo, the comments will appear in the Comments sidebar.
As a contributor, you can also add replies to comments in the Comments Sidebar. Adding
comments in Contributor Editor [41]can be done in two ways:

• If not activating Edit Mode, it works the same as in Review View [41]. You add a comment by
selecting a text or phrase and then entering your feedback.

• When Edit Mode is activated, use the Comment toolbar option to add a comment to content
you are editing.

TIP
Learn more about the features, see Edit View Features [1307].
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The following instruction will show how to add comments when Edit Mode is activated.

1. Display Edit View [42] from the assignment link or via the Assignments Panel [46].

2. Select the content that you want to apply the comment to.
Alternatively, you can position the cursor anywhere inside the text fragment to comment on
the whole paragraph.

3. Select Add Comment in the Contributor Editor Toolbar. 

4. Enter your comment in the box that appears in the Comments sidebar to the right.

TIP
When you mention another Paligo user in a comment, they get a direct link
to that exact place in the publication. Use the @ symbol and then start typing
their name. Select the person you want to notify from the list.

5. Select Save below the comment box.
Paligo saves the comment. A yellow highlight is shown around the content to indicate that it
has a comment.

Edit or Reply to Comments in Contributor Editor
You can make changes to previous comments you have made and you can also reply to other
people's comments.

TIP
You can use "mentions" to notify other people of your comments directly, just like
on social media. To send a mention notification to another Paligo user, use the @
symbol and then start typing their name. You can select the person you want to
notify from the dropdown menu.
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If you want to change a comment you have made, you can edit it:

1. In the comments sidebar, select the comment you want to edit.

NOTE
If the comment has been archived, you will need to restore it [1295] before
you can edit it.

2. Select the Edit option, make your changes, and then select Save.

To reply to a comment that someone else has made:

1. In the comments sidebar, select the comment that you want to reply to.

2. Select the Add option, and then enter your reply and select Save.
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Filter Comments in Contributor Editor
The comments sidebar shows all comments by default. If you prefer, you can filter the comments
sidebar so that it only shows comments that meet certain criteria based on date, user and / or the
status of the comments. For example, you could filter the comments sidebar so that it only shows
the comments from one specific reviewer, made between January and March, and with a status of
Rejected.

To filter the comments:

1. Select the filter icon at the top of the Comments sidebar.

The filter settings appear in an extra section. By default, the filter settings remain on show, so
that you can see there are filters in place.
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NOTE
Use the filter icon to show and hide the filter settings. It is often better to
leave them on show so that you can see what filters are in place.

2. Enter the filter settings you want to use.

• Select the Start Date and End Date fields to display calendars. Use the calendars to set the
date of the filter.

• Select the names of the users whose comments you want to see. Check the box next to a
user's name to see their comments or clear it to hide their comments.

• Select the Status of the comments that you want to see. Check the box next to the status
name to see comments with that status. Clear the box to hide comments with that status.
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Paligo applies the filters and displays the comments that meet the filter criteria. It hides any
comments that do not meet the criteria.

Show or Hide Comment Highlights
By default, any content that has a comment associated with it is shown with a yellow highlight. If
you prefer to work without the comment highlights, you can turn them off by using the Show /
Hide comments option in the Edit View Toolbar [1309]. 

Toggle the highlights on and off by selecting the Show / Hide Comments option.

Copy Content from other Applications
You can copy and paste text, tables, and rendered HTML from other applications into the
Contributor Editor [41] (Edit View). You cannot copy and paste images, video, or raw code. When
you paste into the editor, it will create a valid structure for the content, such as the structure for a
table.

NOTE
The Contributor Editor creates a valid structure, but this is not always the most
appropriate structure. For example, the bridgehead element may be used for
headings. We recommend that Paligo authors check the content and use the full
editor to apply the correct structure.

To learn how to display the Contributor Editor, see Contributor Editor [41].

When you have displayed the Contributor Editor, use keyboard shortcuts to copy and paste:

• On Windows, use Ctrl  and C  to copy and Ctrl  and V  to insert.

• On Mac, use Command ⌘  and C  and Command ⌘  and V .
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TIP
Large tables can be difficult to edit in the Contributor editor and also the main
editor. We recommend that you redesign them, by breaking them up into a series
of smaller tables. This is often possible by re-categorising the information.

A series of shorter tables can be more user-friendly in general too. Long tables
can make it difficult for readers to find the information they need, due to the
amount of content being presented.

Copy Markdown into Contributor
To copy markdown content into Paligo, first convert it to rendered HTML. You can do this with
any third-party editor that has a preview, such as Mark Text. You can copy and paste from the
rendered (styled) preview into Paligo's Contributor editor. When you save the contribution, the
text is converted into Paligo XML so that authors can work with it in Paligo's full editor.

Copy the styled preview of the markdown content.

Typically, you can use keyboard shortcuts to copy and paste from the Markdown editor into
Paligo's contributor editor.

On Windows, use Ctrl  and C  to copy and Ctrl  and V  to insert.

On Mac, use Command ⌘  and C  and Command ⌘  and V .

When copying and pasting, only copy rendered markdown. If you copy raw code, the Contributor
editor will recognize it as plain text and will include the code parts, such as # and </>.

IMPORTANT
You can copy from many different markdown editors into Paligo. However,
Pandoc markdown is problematic. We recommend that you use a dedicated
markdown editor with preview instead of Pandoc.
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NOTE
For large amounts of markdown, we recommend that you convert it to DocBook
via Asciidoc. A Paligo author can then import that into the full Paligo editor.

Copy Microsoft Word into Contributor
You can copy most types of content from Microsoft Word documents into Paligo's Contributor
Editor. This includes text, headings, lists, and tables. You cannot copy images from Word.

Being able to copy from Word is really useful when contributors use Word for their own work.
Instead of writing information from scratch they can copy and paste from reports, specifications,
and other documents they already have created.

Use keyboard shortcuts to copy and paste from Word into Paligo's contributor editor.

On Windows, use Ctrl  and C  to copy and Ctrl  and V  to insert.

On Mac, use Command ⌘  and C  and Command ⌘  and V .

When you paste the content into the Contributor Editor, you may need to change some of the
formatting. For example, paragraphs may have extra spacing below them. Paligo will give the
content valid XML structure. When the contribution assignment is complete, Paligo authors should
review the structure as well as the content and correct it where needed.

NOTE
While you can copy and paste most types of content, there are some limitations.
For example, mathematic and scientific notation (formulas etc.) may not work and
and multi-column layouts will copy across as single columns.

Copy Microsoft Excel into Contributor
You can copy data from Microsoft Excel and paste it into the Contributor editor. The data will
appear as a new table.
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Use keyboard shortcuts to copy and paste:

On Windows, use Ctrl  and C  to copy and Ctrl  and V  to insert.

On Mac, use Command ⌘  and C  and Command ⌘  and V .

NOTE
When you copy and paste from Excel to Paligo's contribution editor, the copy
includes the Excel data and structure but not its formatting. So if you copy a single
row, it will paste into the Contributor Editor as a table with one row.

Copy Google Docs into Contributor
You can copy most types of content from a Google document into Paligo's contributor editor. This
includes text, headings, lists, and tables.

Use keyboard shortcuts to copy and paste:

On Windows, use Ctrl  and C  to copy and Ctrl  and V  to insert.

On Mac, use Command ⌘  and C  and Command ⌘  and V .

NOTE
While you can copy and paste most types of content, there are some limitations.
For example, mathematic and scientific notation (formulas etc.) may not work and
and multi-column layouts will copy across as single columns.

When you paste the content into the Contributor Editor, you may need to change some of the
formatting. For example, paragraphs may have extra spacing below them.

You can also copy and paste data from a Google spreadsheet. The data is pasted into Paligo as a
new table.
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When a contribution assignment is complete, Paligo authors should check the content and its
structure. They can use the Paligo editor to apply the correct structure, where needed.

Compare Contributions
When working on a contribution assignment in Contributor Editor [41], you can compare the live
content with any previous snapshot of the content.

A snapshot is an archived version of the content at a particular point in time and useful when you
compare different versions. Snapshots are made automatically at certain stages in the assignment
workflow. We also recommend that you make some snapshots manually at certain stages in your
work.

If activating Edit View [42], you have access to both the Single panel comparison (also available in
Review View [41]) and the two-panel, Side-by-side comparison. With a Side-by-side comparison,
you get the current version without any editing marks ("track changes") on the left side. The
snapshot version from a previous time is shown on the right, with editing marks to show the
differences between the snapshot version and the current version.

TIP
You can choose to only view the comparison when you need to. But you can also
keep it open while editing, if you want to see the changes in real time.

Side-by-Side Comparison
By activating Edit View [42] in Contributor Editor [41], you can view a Side-by-Side comparison of
the current version and the snapshot. This works similar to standard "track changes", but without
having to see the change markup in the same view where you are writing.

To be able to choose a snapshot, there must be snapshots automatically or manually created from
a previous version.

TIP
You can choose to only view the comparison when you need to. But you can also
keep it open while editing, if you want to see the changes in real time.

1. Display Edit View [42] from the assignment link or via the Assignments Panel [46].
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2. Select Settings in the top-right corner. 

3. Select Compare versions. 

4. Select the snapshot version that you want to compare with the latest version of the content.
The page reloads to show you a comparison of the snapshot and the latest version. It is a
combination of both revisions and highlights the changes that have taken place.
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1.  Table of Contents shows all subtopics from snapshot version and latest version.

• Blue bold topic means that the topic has been Added in the latest version.

• Italic topic means that the topic has been Deleted in the latest version.

• Bold topic means that the topic has been Changed in the latest version.

2. Text colors show changes in the topic or publication content.

• Red strikethrough is content that has been Deleted in the latest version.

• Blue text is is content that has been Added in the latest version.

3. Colored vertical change bars show if entire topics, block elements, tables or images are
different in the latest version.

• Red bar to the right of the content show that the topic has been Deleted in the latest
version.
If the red bar is positioned to the left it visualizes that a block element, table or image
has been deleted.

• Blue bar to the right of the content show that the topic has been Added in the latest
version.
If the blue bar is positioned to the left it visualizes that a block element, table or image
has been added.

• Orange bar show that the topic has Changed in the latest version.

NOTE
If topics have been moved, but are otherwise identical, Paligo does not
include any change indicators. It recognizes that the content is the same.

5. Select the topic to activate the Edit View Toolbar [1309].

6. Select Preview changes that appears in Edit View Toolbar [1309]. 

A side-by-side comparison is displayed, with the latest version to the left and the snapshot
to the right with all the changes highlighted with colors and strikethroughs, in the same way
as the Single panel preview.
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NOTE
To return to the Single Panel Comparison, select Preview changes in the Edit View
Toolbar [1309] again. 

TIP
To turn off the comparison and only see the latest version:

1. Select Settings in the top-right corner. 

2. Select Compare version and choose Show current revision

.

Single Panel Comparison
To easily spot content changes, you can compare the current content with a snapshot from the
previous review or the last major release.

Each version is called a snapshot and it is a record of the content at a specific point in
time. Snapshots are made automatically at certain stages in the assignment workflow. We also
recommend that you make some snapshots manually at certain stages in your work.

The Single Panel Comparison highlights the changes in a combination of the current version and the
snapshot. To be able to choose a snapshot, there must be snapshots automatically or manually
created from a previous version.

TIP
You can choose to only view the comparison when you need to. But you can also
keep it open while editing, if you want to see the changes in real time.

1. Display Edit View [42] from the assignment link or via the Assignments Panel [46].
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2. Select Settings in the top-right corner. 

3. Select Compare versions. 

4. Select the snapshot version that you want to compare with the latest version of the content.
The page reloads to show you a comparison of the snapshot and the latest version. It is a
combination of both revisions and highlights the changes that have taken place.
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1.  Table of Contents shows all subtopics from snapshot version and latest version.

• Blue bold topic means that the topic has been Added in the latest version.

• Italic topic means that the topic has been Deleted in the latest version.

• Bold topic means that the topic has been Changed in the latest version.

2. Text colors show changes in the topic or publication content.

• Red strikethrough is content that has been Deleted in the latest version.

• Blue text is is content that has been Added in the latest version.

3. Colored vertical change bars show if entire topics, block elements, tables or images are
different in the latest version.

• Red bar to the right of the content show that the topic has been Deleted in the latest
version.
If the red bar is positioned to the left it visualizes that a block element, table or image
has been deleted.

• Blue bar to the right of the content show that the topic has been Added in the latest
version.
If the blue bar is positioned to the left it visualizes that a block element, table or image
has been added.

• Orange bar show that the topic has Changed in the latest version.
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NOTE
If topics have been moved, but are otherwise identical, Paligo does not
include any change indicators. It recognizes that the content is the same.

TIP
To turn off the comparison and only see the latest version:

1. Select Settings in the top-right corner. 

2. Select Compare version and choose Show current revision.

Share Content (without assignments)
With the Share document feature, you can quickly and conveniently share content with other
users. This is very useful when you want quick feedback or contributions, but without needing a
formal assignment. When you use the Share document feature, there are no time frames and it is
not shown in the Planner.

NOTE
Share document is only available for sharing content in the same source
language. This is by design, as sharing content in different languages would break
the mapping between the source language and translated versions.

This is how it works:

1. You share a publication, or a part of a publication, with another user. Paligo sends an email to
let them know that a document has been shared with them.

2. The user reviews or edits the content, depending on the type of user account they have. Paligo
reviewers can provide feedback comments and contributor can add and edit the content.

3. When the user saves their work, the comments and edits are added to the relevant topics in
Paligo.

TIP
Shares are not formal assignments and so do not have a set deadline. If you
need feedback or contributions within a certain time frame, add a comment when
you share the content.

Author Sharing Content
If you are a Paligo author and you want to share a publication or topic:

Paligo Documentation

1347



1. Select the Dotted menu (...) for the topic or publication that you want to share in the Content
Manager [34].

2. Select Share Document. 

3. Choose the user(s) that you want to share the content with. You can also leave a message to
provide them with more information.

4. Select OK.
Paligo sends an email to the user(s), inviting them to work on the content. The email contains
your message and a link to the content. When the user selects the link, the content is opened
in Review Mode or Edit Mode (using the Contributor Editor), depending on the user's account
type. They can then review or edit the content.

Reviewer or Contributor Sharing Content
If you are a reviewer or contributor and you want to share content:

1. Open the content in Review View [41] or Edit View [42].

2. Position the cursor over the text so that icons appear in the top-left corner and select Share
this document. 

3. On the Share Document dialog, choose the user(s) that you want to share the content with.
You can also leave a message to provide them with more information.
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4. Select OK.
Paligo sends an email to the user(s), inviting them to work on the content. The email contains
your message and a link to the content. When the user selects the link, the content is opened
in Review Mode or Edit Mode (using the Contributor Editor), depending on the user's account
type. They can then review or edit the content.

Work on Shared Content
If you are invited to work on shared content, you will receive an email that contains a link. When
you select the link, the content will open in the view that is appropriate for your Paligo user
account.

You will also see any content that has been shared with you on the Dashboard, in the Shared
documents widget:
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• For reviewers it opens Review View [41].

• For contributors it opens Edit View [42], but you can also switch to Review View and the full
Paligo Editor [51].

1. Use Review mode or Edit mode to provide feedback or edit the content.
For more information on using the different modes and interfaces, see:
Working in Review View [1278]
Working in Edit View [1306]

2. Add a comment with a mention to the person who shared the content with you. To mention
someone in a comment, use the @ symbol and then select their name.

3. Create Snapshots [1330].
A snapshot is an archived version of the content at a particular point in time and useful when
you compare different versions. A contributor can compare a snapshot taken yesterday to a
snapshot taken today.

4. Use the arrow buttons to arrange your topics and reused publications into the order you
want. You can set them to display as a flat structure or you can "nest" topics and publications
so they have a more complex structure, with multiple levels of content. To learn more, see
Organize a Publication [100].

You can always remove documents that have been shared with you if you do not need them
anymore or if you are not the right person to work on them:

Timeline
The Timeline is a feature in the Contributor Editor [41] that provides an interface for snapshot
comparison. Available snapshots [1330] are shown in a timeline from which you choose the two
snapshots to be compared. Orange vertical change bars show which sections that have been
changed in the latest selected snapshot version. To be able to access this feature, you have to be a
reviewer or higher, see User Types [1834].

The timeline interface consists of two panels:

• Preview (to the left) shows the difference between the two compared snapshots.

• Timeline (to the right) shows the topic activities over time. This is where you choose the
snapshots to be compared.
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NOTE
The timeline differs from the comparison feature in the Review View [41] and Edit
View [42], where you can use:

• Edit View [42] to see the changes and update the live content while
comparing, see Compare Contributions [1341].

• Review View [41] to see the changes and add feedback comments while
comparing, see Compare Reviews [1283].

The difference is that instead of comparing two archived snapshot versions, you
compare the live content with a snapshot version.

Timeline Toolbar
When the Timeline is activated, a toolbar is displayed above it.

•  Filter items in timeline to narrow down the information shown in the timeline history.

•  Select the language used when viewing content.

•  Download a PDF showing the differences between the selected snapshot versions. From the
dropdown menu you can specify which PDF layout to be used.

•  Switch timeline view to swap the position of the preview and timeline panels.

•  Enlarge preview to hide the timeline and show the preview panel in fullscreen mode.

•  Reload the timeline

•  Compare generates the comparison between the two selected snapshot versions.

•  Close to exit the timeline.

Display the Timeline
To access the Timeline, the Contributor Editor [41] must be opened.
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1. Display Edit View [42] from the assignment link or via the Assignments Panel [46].

2. Select Settings in the right upper corner. 

3. Select Show timeline. 

Compare Snapshots
The Timeline is a feature in the Contributor Editor [41] that provides an interface for snapshot
comparison. A snapshot is an archived version of the content at a particular point in time and
useful when you compare different versions. This means that the content can not be edited only
viewed. To be able to choose snapshots, there must be snapshots automatically or manually
created from previous versions.

NOTE
To create snapshots in Contributor Editor [41] , you have to be a contributor,
author or administrator, see User Types [1834].
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TIP
If you need to add feedback comments or update the content while comparing,
you can use:

• Edit View [42] to see the changes and update the live content while
comparing, see Compare Contributions [1341].

• Review View [41] to see the changes and add feedback comments while
comparing, see Compare Reviews [1283].

The difference is that instead of comparing two archived snapshot versions, you
compare the live content with a snapshot version.

1. Display Edit View [42] from the assignment link or via the Assignments Panel [46].

2. Select Settings in the right upper corner. 

3. Select Show timeline. 

4. Select the checkbox for the first snapshot version you like to use in the comparison.

5. Select the checkbox for the snapshot version to compare against.

Paligo Documentation

1353



The choices made are shown below the toolbar.

NOTE
By clearing the checkboxes, you can redo the selection.

6. Select Compare in the toolbar to generate the comparison. 

7. Select Table of Contents to easily see where the changes are made. 

Orange vertical change bars show which sections that have been changed in the latest selected
version.

8. Select X to close the timeline.

Download the Comparison as PDF
You can download the snapshot comparison as a PDF.

1. With the snapshot comparison active.

2. Select a default PDF layout from the Download dropdown menu. ⌄

3. Select Download in the toolbar to generate the PDF. 
The PDF is prepared and downloaded to your computer.
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Translation and Translation Review Assignments
Translation assignments and Translation Review assignments are designed to be used when you
handle the translations within your organization and the translators do not have access to a
professional translation software and will use Translation View [79].

These assignment types are not to be used if you are using a translation service or have your
own translators who are using a professional translation software. Learn more, see Translation
Management [1683].

NOTE
Paligo recommends that you use a professional translation service.
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Taxonomies

Taxonomies are a way of categorizing your content. They provide a more flexible way of organizing
your content, making it easier to find related topics and images. Taxonomies are also used by
Paligo to provide extra functionality, such as a top-navigation menu in help centers.

For example, if your organization produces three different products called "Acme 100", "Acme
200" and "Acme 300". In this case, you could create a taxonomy based on the product name, with
three tags, one for each product and then add each tag to the relevant topics.

TIP
You can also search for content with taxonomy tags, see Search with Taxonomy
Tags [1375].

Why use Taxonomies?
There are many different ways to use taxonomies, but the main benefits of using them are:

• More flexible way to organize content
Organizing content in folders is limiting as each publication, topic, and image can only exist in
one place. Taxonomies are much more flexible as you can apply multiple tags to the same
content, and use the tags for organization. This is especially useful when you have topics
that could logically exist in multiple folders, as authors can search for content based on the
taxonomy tags instead of having to navigate a folder hierarchy.
To find out how to create taxonomy tags for organizing your content, see Classify Content with
Taxonomies [1367].
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• Easier for authors to find content
By using the search features, authors can search for content by taxonomy tag (as well as other
criteria). Or they can select a taxonomy tag and see which topics use that tag.
To learn how to locate content based on taxonomy tags, see Search with Taxonomy Tags [1375].

• Extra functionality, including:

• Taxonomy filters
You can filter your content based on taxonomy tags rather than filter attributes. Some users
find this approach easier to apply and manage. To find out more, see Taxonomy Filters [1175].

• Top-navigation links in help centers
You can use taxonomies to provide a navigation bar at the top of HTML5 help center outputs.
The navigation bar can contain external links to other relevant websites. To find out more, see
Top-Navigation for Help Centers [741].

• Custom metadata for use with other systems, such as Algolia, Google Analytics, Zoomin, and
Fluid Topics.
Taxonomies allow you to add "name and content" metadata to individual topics. These can be
used by external systems. To find out more, see HTML Meta Tags for Individual Topics [453].

• Map to labels in Zendesk
If you publish content from Paligo to Zendesk, you can set Paligo to convert its taxonomy tags
into labels in Zendesk. To find out more, see Taxonomies as Labels in Zendesk [1579].

• Map to facets for faceted search in Algolia
If you use the Algolia search engine with Paligo, you can use taxonomies as facets for faceted
search. Faceted search is where you give your website visitors the ability to apply further
filters to search results so that they can narrow their search. A common example of faceted
search is on product websites where you can narrow down your search by color, size, and
other specifications.
To find out more, see Set Up Algolia Faceted Search [1396].

• Add classes to HTML.
The classes can then be referenced in CSS for styling and JavaScript for other functionality (see
Taxonomies as HTML Classes [1359]).

• Applicability panels in HTML help center outputs.
You can use taxonomies with CSS and JavaScript to add applicability panels to the top of your
topics. The applicability panels give extra context about when the content applies. In Paligo
help, we use them to show when the content only applies to certain price plans. To find out
more, see Applicability Panels for Topic Categories [749].

The taxonomies feature requires the business plan or enterprise plan. To upgrade to either of
these plans, contact your account manager.

Taxonomies Workflow
There are many ways to use taxonomies [1356], but the general workflow for setting them up is
the same:

1. Make sure you are familiar with the Taxonomy Interfaces [1363].

2. Create your taxonomy hierarchies [1368].
This is where you define the structure of the taxonomy tags and how they relate to each
other.

Paligo Documentation

1357



TIP
You may want to Set Colors for Taxonomy Tags [1374] as a visual aid for
recognizing the different taxonomy hierarchies.

3. Associate your taxonomy tags with the appropriate publications, topics, and images [1370].
This is where you make connections between your taxonomy tags and your content. For
example, you could have an "Acme 100" tag for a product name and you would then associate
that tag with all of the topics that are about the "Acme 100" product.

4. Define the appropriate settings in the layout that you use for publishing.
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This step only applies if you are using taxonomies for features in the output that you publish,
such as taxonomy filters and top-navigation.
The settings that are needed are explained in the documentation for those features:

• Taxonomy Filters [1175]

• Taxonomies as HTML Classes [1359]

• Custom class names for images (see Set Image Class Names for Styling in CSS [352])

• Taxonomy-Based Related Topic Links (See Also Links) [259])

• Top-Navigation for Help Centers [741]

• Applicability Panels for Topic Categories [749]

• Custom metadata for individual topics in HTML outputs [453].

5. Publish your content.
When you have created your taxonomy hierarchy, associated the taxonomy tags with your
content, and set up the layout, you can publish your content [1068].

NOTE
If you are using taxonomies to categorize your content, Paligo authors can use
them to quickly find related topics [1375].

Taxonomies as HTML Classes
Many of the taxonomy features require you to enable Output taxonomies in the HTML or HTML5
layout. This sets Paligo to add a class, based on the taxonomies, to the section element in the
HTML. You can then reference the class in your CSS for styling and JavaScript for manipulating the
content.
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You should enable the Output taxonomies feature if:

• The online help for a taxonomy feature tells you it has to be enabled

• Paligo customer support advise you to enable it

• You need the taxonomy class to be included in the HTML output so that your own developers
can use it in their custom programs and scripts.

The HTML layouts also have settings for controlling the format of the class name and the
separator characters for each part of the class name.

To set Paligo to include the taxonomies as classes in HTML:

1. Create a taxonomy hierarchy [1368] for the tags that will be used for class names in the HTML.

2. Add the taxonomy tags to the topics and images [1370] that need to have the class names in
HTML.

3. Select Layout and then either select an existing layout to open it in the Layout Editor or create
a new layout [1059].

4. On the Layout Editor, select Classes and Attributes and set Output Taxonomies to Enable.

5. Use Value structure for taxonomy class names to control the naming of the class in the
HTML.

Choose from the options below (see the example at the end of this section for a sample of the
classes these options create). In these descriptions, "self" means the tag that is in the topic,
typically a child tag. The "self" is the current node.

• Descendants
The class name includes the taxonomy name of the "self" and any of its descendant tags.

• Exact Value
The class name includes the path from the root taxonomy to the "self".

• Parent
The class name includes the path from the root taxonomy to the "self" and also from the
root to the immediate parent of the "self" tag.

• Ancestors
The class name includes the path of taxonomies from the root to "self" and also from the
root to all parents of the "self" tag.

6. Use the Underscore delimiter in taxonomy class names setting to choose whether a dash
or an underscore is used to separate the parts of a taxonomy reference in a class name. By
default, class names use a dash as a separator.
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Select:

• Enable to use an underscore as a separator

• Disable to use a dash as a separator.

7. Select Save.

When you publish to HTML using the layout, Paligo will add class names to the HTML output. The
class names are based on the name of your taxonomy tags and will use the syntax you chose in
step 3 and 4.

Example 69. HTML classes based on taxonomies

Let's say you have a taxonomy hierarchy like this:

• Taxonomies

• Product Models

• Acme 100

• Acme 100a

• Acme 100x

• Acme 200

• Acme 300

You apply the model tags to various different topics. You then set up an HTML5 Help Center layout
so that it has these settings in place:

• Output taxonomies - Enable

• Underscore delimiter in taxonomy class names - Disable

You decide to experiment and publish the content four times, once for each different Value
structure for taxonomy class names setting (in the Layout). The following table shows the class
names that are generated for each of the different settings (Exact Value, Parent, Descendant, and
Ancestor):

Topic
Tag

Exact Value Class
Name

Parent Class Name Descendant Class
Name

Ancestor Class Name

Acme
100

section taxonomy-
product-models-
acme-100

section
taxonomy-product-
models-product-models
taxonomy-product-
models-acme-100

section
taxonomy-product-
models-acme-100
taxonomy-product-
models-acme-100a
taxonomy-product-
models-acme-100x

section taxonomy-product-
models-product-models
taxonomy-product-models-
acme-100
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Topic
Tag

Exact Value Class
Name

Parent Class Name Descendant Class
Name

Ancestor Class Name

Acme
100a

section taxonomy-
product-models-
acme-100a

section
taxonomy-product-
models-acme-100
taxonomy-product-
models-acme-100a

section
taxonomy-product-
models-acme-100a
taxonomy-product-
models-acme-100x

section taxonomy-product-
models-product-models
taxonomy-product-models-
acme-100 taxonomy-
product-models-acme-100a

Acme
100x

section taxonomy-
product-models-
acme-100x

section
taxonomy-product-
models-acme-100a
taxonomy-product-
models-acme-100x

section
taxonomy-product-
models-acme-100x

section taxonomy-product-
models-product-models
taxonomy-product-models-
acme-100 taxonomy-
product-models-acme-100a
taxonomy-product-models-
acme-100x

Acme
200

section taxonomy-
product-models-
acme-200

section
taxonomy-product-
models-product-models
taxonomy-product-
models-acme-200

section
taxonomy-product-
models-acme-200

section taxonomy-product-
models-product-models
taxonomy-product-models-
acme-200

Acme
300

section taxonomy-
product-models-
acme-300

section
taxonomy-product-
models-product-models
taxonomy-product-
models-acme-300

section
taxonomy-product-
models-acme-300

section taxonomy-product-
models-product-models
taxonomy-product-models-
acme-300

The class names vary, depending on the chosen setting.

With the class in place, you can use it in your CSS and JavaScript files to apply styles or other
functionality. You can upload the CSS and JS to your layout and republish to apply the styles and
script during the publishing process (see Branding your HTML Outputs with CSS [654] and Add a
Custom JavaScript to a Layout [768]).

Taxonomies as HTML Metadata
You can use taxonomies to add HTML metadata to the pages in an HTML output. This can be
useful for allowing other systems to interact with your published HTML content. To find out how
to set up Paligo to use taxonomies as name and content metadata pairs, see HTML Meta Tags for
Individual Topics [453].

Taxonomies for Applicability Panels
Applicability panels are sections that you can add to the top of topics in HTML outputs. They
contain checkboxes and are designed to show whether the content in a topic is applicable. In the
Paligo help, we use them to show when content only applies to customers on a certain plan, for
example, Zendesk content only applies to the Business plan and the Enterprise plan.

To set up these panels, you need to use taxonomies as well as some custom CSS and JavaScript.
For instructions, see Applicability Panels for Topic Categories [749].
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Taxonomies for Top-Navigation in HTML
Paligo's HTML5 help center outputs support a top-navigation menu that you can use to link to
different sections and external websites. To set one up, you can use the role attribute or you can
use taxonomies instead.

To find out how to set up a top-navigation menu, see Top-Navigation for Help Centers [741].

Taxonomy Interfaces
To work with taxonomies, you will need to use the Taxonomy Manager, which is a section in the
Content Manager. It is also a good idea to use the Floating Content Panel, which provides the same
features as the Taxonomy Manager, only in a moveable dialog.

NOTE
Taxonomy information is also available on the Resource View [68] and the
Taxonomies View [1366]. But you can only create new taxonomies and organize
the taxonomy tags by using the Taxonomy Manager or Floating Content Panel.

About Taxonomy Manager
The Taxonomy Manager is a section in the Content Manager and it is designed for creating and
managing Taxonomies [1356]. You can use it to create taxonomy tags and organize them into
hierarchies for many different purposes, including categorizing your topics, filtering, applicability
panels at the top of topics, and adding metadata.

At the top of the hierarchy is a Taxonomies tag. Any custom taxonomy tags that you create are
descendants of the Taxonomies tag.

To Add Taxonomy Tags [1370], you can drag and drop it from the Taxonomy Manager onto the
topic. But we recommend that you use the Floating Content Panel [1365] instead, as it is easier to
apply the tags using that, as you can scroll and navigate the Content Manager separately.
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The hierarchy in any Paligo taxonomy consists of "parent tags" and "child tags". The parent-child
relationship is important as Paligo uses it to understand the relationship between tags. For
example, for the Paligo online help, we have a taxonomy hierarchy that is used for a price-plan
applicability panel. For that, we have a "parent" tag called "Plan" and then each of the price plans
has a "child" tag - "Business", "Enterprise", and "Professional".

Note that there are other "parent" tags too. This is because taxonomy tags can be used for
different purposes, with a different hierarchy for each. For example, we use the "Relationship
Categories" hierarchy for setting the relationships for "see also" links in the online help.

Each taxonomy tag has an Dotted menu ( ... ) that appears when you move the cursor over the
tag. Select it to display these options:
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• Go to taxonomy - Displays the taxonomy view for the selected taxonomy tag. There, you can
see a list of which topics and publications have the selected tag.

• Create taxonomy tag - Use to create a new taxonomy tag [1368] as a descendant ("child") of
the selected tag.

• Search from here - Use to search for content that has the selected tag [1375]. When you select
Search from here, Paligo displays the search settings and the selected taxonomy is added
automatically as one of the search criteria.

• Rename - Use to change the name of a taxonomy tag.

• Move to trash - Use to move a taxonomy tag to the trash bin. It is removed from the Taxonomy
Manager but can be recovered from the trash bin if needed.

• Delete - Use to remove a taxonomy tag [1373]. Once deleted, it cannot be recovered.

• Refresh - Use to reload the taxonomies so that the Taxonomy Manager and Floating Content
Panel are updated with any changes made by other users. For example if you are working on
taxonomies and another user deletes a "child" tag, the deleted tag will still be visible in your
Taxonomy Manager. You will need to use refresh to update the taxonomies.

• Choose a color - Use to give a tag a specific color [1374]. Color-coding can be a helpful visual
tool for differentiating between different categories of taxonomy tags.

Floating Content Panel
The Floating Content Panel is a dialog that contains the taxonomy hierarchy from your Taxonomy
Manager. It is useful when adding taxonomy tags to your content, as it is separate to the Content
Manager. This means you can navigate to different folders and scroll the Content Manager, while
still having your taxonomy tags available to drag and drop from the Floating Content Panel. It is
often easier to add taxonomy tags to topics this way.

To display the Floating Content Panel:

1. In the Content Manager, expand the Taxonomy Manager section to reveal the Taxonomies
tag.

2. Select the options menu ( ... ) for the Taxonomies tag.

3. Select Floating content panel.
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The Floating Content Panel contains an exact replica of the taxonomies in the Taxonomy Manager.
You can expand and collapse the various levels of tags to browse the hierarchy and each tag has
its own options menu ( ... ). The options menus work in exactly the same way as on the Taxonomy
Manager [1363].

To associate taxonomy tags with your content, you can either:

• Drag and drop the tags onto topics in your Content Manager

• Drag and drop topics from the Content Manager onto the tag in the Floating Content Panel. This
approach is useful when you want to associate multiple topics with a tag at the same time.

To find out more about associating your tags with your publications and topics, see Add Taxonomy
Tags [1370]

Taxonomies View
The Taxonomies View is a list that shows all of the content that is associated with a particular
taxonomy tag (or any of its descendants). It is especially useful when you are trying to find out
what topics, publications and images are associated with a tag.

To access the Taxonomies View you can either:

• Select the taxonomy tag in the Taxonomy Manager or the Floating Content Panel.

• Select the taxonomy label from the Resources View or any other dialog that contains the label.
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The Taxonomies View has these features:

1. Taxonomy selector.
From here, you can navigate to any of the parent tags of the currently displayed tag. When you
select a parent tag, the Taxonomies View refreshes so that the list shows information that is
relevant to the parent tag.

2. Taxonomies column.
This shows the taxonomy tags that are associated with each topic. Topics can be associated
with the tag you selected to display the Taxonomies View and also other tags too.
The other columns show the content that is associated with the taxonomy tags and other
useful information such as the status, author, and languages.

3. List view and Grid view.
Use these to toggle the Taxonomies View between a list and a grid. They show the same
information, but use a different presentation.

4. Use to access the search feature and refresh the list.

• Search
Use to exit the Taxonomies View and perform a new search. The search results are
presented as a list, but you could select a taxonomy label in that list to display it in the
Taxonomies View.
Refresh
Use to refresh the Taxonomies View. This is only needed if other users have changed the
taxonomies while you are viewing the list and you need to update the list to show the latest
taxonomies information.

Classify Content with Taxonomies
To use taxonomies to classify your content, you will need to create a taxonomy hierarchy, add
tags and associate those tags with your content. Your Paligo authors will then be able to find
content much more easily. They can search for topics and images that have particular taxonomy
tags instead of having to rely on searching by topic name or browsing through the folders in
the Content Manager. To make taxonomies for classifying your content, follow the steps in the
Taxonomies Workflow [1357]. With the taxonomy hierarchies created, you would then add the
tags to the relevant topics and images. With those in place, your Paligo authors can now search for
content that has particular taxonomy tags (see Search with Taxonomy Tags [1375]).
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For example, let's say you want to categorize your content by product name and also by subject
matter. For that, you could create two taxonomy hierarchies, one named "Products" and one
named "Subject Matter". In the "Products" hierarchy, you would create tags for each product name
and in the "Subject Mater" taxonomy, you create tags for each subject.

Create Taxonomies
Creating a taxonomy is very much like creating a nested folder structure. Before you begin, we
recommend that you plan the taxonomy structure so that you know what tag you are going to
use as the "parent" and how you are going to name the "child" tags. You can give taxonomy tags
a color to make it easier to identify different types of taxonomies, see Set Colors for Taxonomy
Tags [1374]. We recommend that you:

• Create a "parent tag" for each purpose - If you are going to use taxonomies for multiple
different reasons, create a different parent tag for each purpose. For example, you could create
one parent tag for "filtering", another parent tag for "relationships" and a third for categorizing
by "product name". Then create the subordinate tags (child tags) that you need for each
purpose. This is important for distinguishing between the different uses for taxonomies.

• Consider where taxonomies can be used - You can apply a taxonomy to a topic, a publication
or an image. They cannot be applied to individual block elements, such as paragraphs.

• Use recognizable names - Give the tags names that are easy for people to understand, even if
they are unfamiliar with your content. When naming child tags, consider the name tags in other
parts of the taxonomy hierarchy. If you duplicate the tag names, it can be confusing for Paligo
authors.
Repeated tag names can also be a problem if you set Paligo to output the taxonomy tags as
class names in HTML outputs. This is because it would result in classes sharing the same name
too, meaning CSS styling would apply to all styles with a matching name. To avoid this, use the
Value structure for taxonomy class names setting on the HTML5 Layout. There, you can set
the class to include the parent tag's name as well, see Taxonomies as HTML Classes [1359].

Paligo Documentation

1368



TIP
It's also possible to:

• Create taxonomy tags via API. See the API documentation for information on
the endpoints.

• Get your taxonomy values output as class values in HTML5 output if you enable
this in the Layout Settings for a HTML5 layout that you have created.

To create taxonomies:

1. Select the Taxonomy Manager in the Content Manager [34] to open the structure. 

2. Select the the Dotted menu (...) for:

•  the Taxonomies to create a Parent tag for a new hierarchy.

•  an existing tag to create a Child tag.

NOTE
You can use the Floating Content Panel [1365] instead of the Taxonomy
Manager if you prefer.

3. Select Create taxonomy tag.

Paligo Documentation

1369



4. Enter a tag name and confirm it. 

5. Repeat this process until you have created all of the parent and child taxonomy tags you need.

TIP
By coloring the tags it can be easier to differentiate the taxonomies, see Set
Colors for Taxonomy Tags [1374]

NOTE
When the taxonomy tags are created, you can Add Taxonomy Tags [1370] to
content. Just drag and drop tags, from the Taxonomy Manager, to the component
you want to tag. The action is confirmed with a pop-up message: Link was
successfully created!

You can select multiple taxonomies at once and drag to a component, to tag it
with multiple tags at once. You can also do the other way around, by selecting
multiple components and drag them to a taxonomy tag.

Add Taxonomy Tags
When you have taxonomy tags in Paligo, you can add them to the appropriate topics, publications,
and images. One way to do this is to drag and drop the tags from the Taxonomy Manager section
in the Content Manager onto the files in the Content Manager. But you might prefer to use the
taxonomy floating content panel instead, as this lets you see all of the taxonomy tags and scroll up
and down the Content Manager at the same time.
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To learn how to add taxonomy tags to your content, watch the following video or complete the
steps in the procedure:

https://player.vimeo.com/video/687843774

1. Display the floating content panel.

a. In the Content Manager, expand the Taxonomy Manager section to reveal the
Taxonomies tag.

b. Select the options menu ( ... ) for the Taxonomies tag.

c. Select Floating content panel.

2. In the Content Manager, find the topic(s) that you want to give taxonomy tags.

3. Apply the taxonomy tags.
To apply a tag to a single topic, drag and drop the tag from the Floating Content Panel onto
the topic in the Content Manager.

To apply a tag to multiple topics, hold Alt  and select the topics in the Content Manager.

If the topics are all next to each other, you can hold Shift  instead. When the topics are

selected, drag and drop the topics from the Content Manager to the relevant taxonomy tag in

the Floating Content Panel.
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NOTE
If you apply a taxonomy tag to a publication, it is applied to the publication
topic. It is not applied to all topics in the publication.

Use the same techniques to apply your tags to publications and also images (your images are
in the Media section of the Content Manager).

When you have applied the taxonomy tags to your content, we recommend that you check to see
that they are in place (see Search with Taxonomy Tags [1375]).

TIP
It's also possible to add taxonomy tags via API. See the API documentation for
information.
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Remove Taxonomy Tags
When you have added taxonomy tags to your resources, there may come a time when you need
to remove some of them. For example, you may have decided on a different taxonomy strategy or
you may have tags that were accidentally assigned to the wrong topics.

To remove tags, you can either:

• Delete a tag completely, so that it is removed from all Paligo resources and will no longer exist in
Paligo

• Remove a tag from one or more resources, but still have the tag available in Paligo. With this
approach, you only remove the association between the tag and a topic, publication or image.

TIP
It's also possible to remove taxonomy tags via API. See the API documentation for
information.

Delete Taxonomy Tags
To completely remove a taxonomy tag from Paligo, so that no resources can be associated with it:

1. In the Content Manager, expand the Taxonomy Manager section and navigate to the tag that
you want to edit.

NOTE
Alternatively, you can use the Floating Content Panel [1365] to navigate to the
tag.

2. Select the options menu ( ...) for the tag and then select Delete. When Paligo asks for
confirmation, select Delete Items to remove the tag.
Paligo removes the taxonomy tag from your instance. It is automatically removed from any
topics, publications, or images that were associated with it.

Remove a Taxonomy Tag from a Topic or Publication
To remove a taxonomy tag from a topic or publication, without losing the taxonomy tag from
Paligo or affecting other resources:

1. Find the topic that uses the taxonomy tag.
There are many ways to do this, but here we will explain how to use the Resource View. To
access that, look in the Content Manager and select the folder that contains the topic. The
topic and its taxonomy tags are shown in the Resource View.

2. Select the cross icon on the taxonomy label for the topic.

Remove a Taxonomy Tag from an Image
To remove a taxonomy tag from an image:
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1. In the Content Manager, expand the Taxonomy Manager section and navigate to the tag that
you want to edit.

NOTE
Alternatively, you can use the Floating Content Panel [1365] to navigate to the
tag.

2. Select the tag to display it in the Taxonomy View.
The Taxonomy View shows a list of all the resources that use the tag, including any topics,
publications, and images.

3. Select the cross icon on the taxonomy label for the image.

Paligo removes the taxonomy tag from the image. The tag still exists in Paligo and it can be
used with any other resources or re-applied to the image later if needed.

Set Colors for Taxonomy Tags
By default, taxonomy tags are shown as white tag icons but if you prefer, you can change the
colors. For example, you might want to have a specific color for each different taxonomy hierarchy,
so that users can quickly differentiate between the tags.

There are six colors available to choose from, plus the default white color. You cannot add your
own colors.

1. In the Content Manager, expand the Taxonomy Manager section and navigate to the tag that
you want to edit.

NOTE
Alternatively, you can use the Floating Content Panel [1365] to navigate to the
tag.

2. Select the options menu ( ... ) for the taxonomy tag and then select a color from the selection
at the bottom of the menu.

Paligo Documentation

1374



To remove a colour, select the white circle with a gray cross. The tag will return to its default
white color.

TIP
It's also possible to set colors for taxonomy tags via API. See the API
documentation for information.

Move Taxonomy Tags
You can move the taxonomy tags to different locations in the taxonomy hierarchy. This is useful if
you decide to change your taxonomies strategy and so need a different structure, and also if you
accidentally add or move a tag to an incorrect location.

To move a taxonomy tag, select it in the Taxonomy Manager [1363] or Floating Content
Panel [1365] and then drag and drop it to the new position.

TIP
It's also possible to move taxonomy tags via API. See the API documentation for
more information.

Search with Taxonomy Tags
One of the benefits of using Taxonomies [1356] is that they make it easier for authors to find
related topics and other resources. Instead of having to know which folders contain the topics you
need, you can find content based on the taxonomies. This is especially useful in a team of writers,
where the organization of folders might make sense to some writers, but confuse others. With
taxonomies, folder organization is less important.

There are several ways to find out about the relationships between your resources and taxonomy
tags. To get started, see which of the following statements applies to you:

• A quick way to find out which taxonomy tags that are associated with certain topics,
publications or images, see Find Taxonomies with Resource View [1376].

• To find out which resources that are associated with certain taxonomy tags, see either Find
Content with Taxonomies View [1377] or Search via Taxonomy Tag [1378].
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TIP
To filter your content so that parts of it are hidden in certain circumstances,
you can use the profiling attributes or taxonomies.

If you decide to use taxonomies, Paligo will use the taxonomy tag hierarchy to
determine which parts of your content should be included or excluded when you
publish. For example, you could have taxonomy tags for each type of output, so
that when you publish to HTML any topics that have a PDF tag are not included.

To find out how to set up Paligo to use taxonomies for filtering, see Taxonomy
Filters [1175].

Find Taxonomies with Resource View
The Resource View provides a quick way to find out what taxonomy tags are used by the topics
and publications in a particular folder. If the selected folder contains subfolders, those are also
shown in the Resource View [68]. You can view the taxonomy tags for those subfolders by
selecting the folder in the list. The results list then refreshes so that it shows the topics in the
sub-folder.

To display the Resource View and see what taxonomies are used:

TIP
To find out which taxonomies are in place for images, select Media in the Content
Manager.

1. Select the folder containing the content in Content Manager [34]. 
If the content is not in a folder, select the top-level folder Documents. 

This will open the Resource View [68].

2. Look at the Taxonomies column. It shows which taxonomy tags are associated with the
various resources in the selected folder.
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TIP
Alternatively, you could perform a search and set the folder as one of the search
criteria, see Advanced Search [642].

Find Content with Taxonomies View
You can use the Taxonomies View to find out which resources (topics, publications, images) are
associated with taxonomy tags.

NOTE
You can use the Floating Content Panel [1365] instead of the Taxonomy Manager
if you prefer.

1. Select the Taxonomy Manager in the Content Manager [34] to open the structure. 

2. Select the taxonomy tag of interest to display the Taxonomies View.
The Taxonomies View shows all topics, publications, and images that use the selected tag. The
selected tag name is shown in the top-left corner and if you select it, a menu appears which
you can use to navigate to its parent taxonomies.
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NOTE
If you select a parent tag, the Taxonomies View shows information for the
parent tag and all of its child tags.

Search via Taxonomy Tag
One way to find out what publications, topics and images have a particular taxonomy tag is to
use the Search from here feature. This is available from the dotted menu (...) for a taxonomy tag
and it provides access to the Advanced Search [642].

The Search from here feature works in the same way as a regular search, except that it preloads
the search settings with the selected taxonomy. You could achieve the same result by using the
search feature and adding the taxonomy manually (for more details, see Advanced Search [642]).

NOTE
Alternatively, you can use the Floating Content Panel [1365] to navigate to the tag.

1. Select the Taxonomy Manager in the Content Manager [34] to open the structure. 

2. Select the Dotted menu (...) for the taxonomy tag and choose Search from here.
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TIP
You can also search for multiple taxonomy tags by pressing Command  ⌘

(Mac) or Ctrl  (Windows) and then select each tag in the Taxonomy Manager.

When you have selected multiple tags, select the Dotted menu ( ... ) for any
of them and choose Search from here.

3. You can refine the search further by using the search settings.

Paligo displays the search preloaded with the selected taxonomy in the search criteria (In
taxonomies).

TIP
Here are some tips to level up your search:

• To include images with taxonomy tags in the search, remove the
Language criteria from the search settings.

• To restrict the search for topics with taxonomy tags in a particular folder,
use the In folder field.

4. Select Search.

Paligo finds the topics, publications, and images that match the search criteria and displays them in
a list. The list's Taxonomies column shows what taxonomy tags are in place.
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Integrations

You can connect Paligo to many other applications, including Zendesk, Algolia, and Phrase. To
connect them, use the Integration settings. For details on how to set up each type of integration,
refer to the section about that application.

To access the Integration settings:

1. Log in to Paligo via a user account that has administrator permissions.

2. Select your user name in the top-right corner and select Settings.

3. In the Settings view, select the Integrations tab.
The Integrations tab has modules for connecting to various other applications. For example,
there is a module for connecting to Zendesk and another module for connecting to Freshdesk.

Algolia Search Engine Integration
Paligo's HTML5 Help Center output has a built-in search feature that is suitable for many of
our customers. But on the Business and Enterprise plans, we also have integrations with more
advanced search engine services, such as Algolia.

Algolia is a powerful site search service that requires a subscription (see algolia.com for details). It
is exceptionally fast, highly customizable, and supports advanced search features such as faceted
search. Another benefit is that it does not use a crawler, and so works even if your site has
authentication and requires users to log in.

Typically, Paligo customers use the Algolia integration to add:

• Algolia search
This enhances the search feature of your published HTML5 Help Center, giving much faster
results. You can also use Algolia's extensive customization features to control how your search
works.
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To get started, see Algolia Search [1381].

• Algolia faceted search
Faceted search allows users to search for terms and then narrow the search further by applying
filters to the search results. There are two types of faceted search you can use with Paligo -
"flat" faceted search and "hierarchical" faceted search. To learn about these, see Algolia Faceted
Search [1394].

NOTE
To use Algolia faceted search, first set up the regular Algolia search [1381].
When that is in place, you can Set Up Algolia Faceted Search [1396].

To learn how to use JavaScript to customize your Algolia search beyond what is available in the
layout settings, see Customize Algolia Search with JS [1393].

Algolia Search
You can use Algolia to enhance the search in your HTML5 Help Center outputs. When set up
correctly, Algolia search replaces Paligo's default search and gives your help center a faster, more
customizable search. It works even if your site uses authentication and you can set it up to give
results as soon as a user enters three characters of a search query.
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Algolia has many features for customizing your search and also supports faceted search, where
users can apply filters to the search results.

To use Algolia search with your HTML5 Help Center(s), you need:

• An Algolia account

• A Paligo account on the Business or Enterprise plan (you will need to log in as an administrator)

For instructions on connecting Paligo to Algolia, see Set Paligo to use Algolia Search [1382].

NOTE
When you have Algolia search working with Paligo, you can also set up Algolia
faceted search [1394]. This is a more advanced search where users can apply
filters to the search results.

If you prefer, you can use regular Algolia search without faceted search.

Set Paligo to use Algolia Search
To set Paligo to use Algolia search for your HTML5 outputs:

Connect Paligo to Algolia
To connect Paligo to Algolia:

1. If you do not already have an Algolia account, set one up at https://www.algolia.com.

2. Log in to Paligo via a user account that has administrator permissions.

3. Select the avatar in the top right corner. 

4. Select Settings from the menu. 

5. Select the Integrations tab. 

6. In the Algolia module, select the Add button (or Change if you are editing an existing Paligo-
Algolia integration).
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7. In a different browser tab or window, log in to your Algolia account and find the Application
ID and API Key (Search Only Key). For information on how to find these API Key settings, see
the official Algolia documentation.

NOTE
Do not use the Admin API Key. That key should always be kept secret.

8. In Algolia, copy the Application ID and then paste it into the Application ID field in Paligo.

9. In Algolia, copy the API Key (Search Only Key) and then paste it into the Search Only API Key
field in Paligo.
If you are not using DocSearch, continue with the next step.
If you are using DocSearch rather than the licensed Algolia search, select Save and ignore the
remaining steps in this procedure.

10. In Algolia, create a new API key. In its ACL field, add the operations addObject and
deleteObject.
For details on creating a new API key, see the official Algolia documentation.

11. In Algolia, copy the new API key and then paste it into the Index API Key field in Paligo.

12. Select Save.

Set up Algolia in your HTML5 Layout
When have connected Paligo to Algolia [1382] , the next step is to set up Algolia search in your
HTML5 layout. There are several Algolia-related settings, some of which are optional, depending
on whether you want to use Algolia's faceted search [1396] feature.

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Search Engine.

4. Choose whether the layout should Use Algolia Search:

• Enable
Sets Paligo to use the Algolia search engine for publications made using this layout.

• Disable
Sets Paligo to use its own built-in search engine. The Algolia search engine is not used.

• Default

To inherit the value for this setting from the base layout. The base layout is either a built-in
layout provided with Paligo or is another custom layout.

To find out more, see Layout Relationships - Base, New, Duplicate [1055].

5. Set the Use Algolia DocSearch option status:

• Enable
Choose this option if your organization has been accepted into the Algolia DocSearch
program. Algolia DocSearch is a special type of Algolia account that you have to apply for.

• Disable
Choose this option if your organization is not using Algolia DocSearch.

• Default
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To inherit the value for this setting from the base layout. The base layout is either a built-in
layout provided with Paligo or is another custom layout.

6. If you want the Algolia index to have a specific name, enter the name in the Use custom
index name for Algolia Search field. This only works when publishing publications in a single
language. Leave the field clear to set Paligo to create indexes based on the publication IDs.

For more details, see Custom Index Name for Algolia Search [1390].

7. Choose whether you want Paligo Create separate search page for Algolia:

• Enable
Choose Enable if you want your output to use Algolia's faceted search [1396].

• Disable
Choose Disable if you do not want your output to use Algolia's faceted search.

• Default

To inherit the value for this setting from the base layout. The base layout is either a built-in
layout provided with Paligo or is another custom layout.

8. Use Delayed search for Algolia to control what happens when a user starts typing in a search
query:

• Enable
Algolia will only start providing search results when the user has entered three characters in
the search field. If you have set your output to use a separate search page for Algolia, the
user has to press Enter to get results on that page.

• Disable
Algolia will start providing results as soon as the user enters a character in the search field.

• Default

To inherit the value for this setting from the base layout. The base layout is either a built-in
layout provided with Paligo or is another custom layout.
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For more details on this feature, see Delay Search Results as Users Type Query [1392].

9. Choose whether you want Paligo to Output taxonomies as facets for Algolia Search page:

• Enable
Choose Enable if you want your output to use Algolia's faceted search [1396].

• Disable
Choose Disable if you do not want your output to use Algolia's faceted search.

• Default

To inherit the value for this setting from the base layout. The base layout is either a built-in
layout provided with Paligo or is another custom layout.

10. If you want your output to use Algolia faceted search, you will need to set up taxonomies for
each "facet". You need to enter the taxonomy names in one of the following fields:

• Taxonomies to use for flat Algolia facets
Enter the name of each taxonomy that you want to use in a "flat" faceted search.

• Taxonomies to use for hierarchical Algolia facets
Enter the name of the taxonomy that you want to use in a "hierarchical" faceted search.

In both cases, use a semi-colon to separate each taxonomy name, for example:
brand;product;color. For details, see Set Up Algolia Faceted Search [1396].
If you do not want Paligo to use faceted search, clear the fields.

11. Select Save.

Having Use Algolia Search set to Enable is the only requirement (in the Layout) for connecting
Paligo to Algolia. If you intend to set up Algolia faceted search, you will need to change some of the
other settings too, as described in Set Up Algolia Faceted Search [1396]. The other Algolia-related
settings are optional.

Next, Configure the Index in Algolia [1386].

Configure the Index in Algolia
To perform a search, Algolia needs an index. The index contains information about the content
that Algolia should search for results.

The following steps explain how to create and edit the index. For this, we assume that you have
already set up: and an HTML5 help center layout

• The Paligo-to-Algolia integration settings [1382]

• An HTML5 help center layout [1383] so that Algolia is enabled.

1. In Paligo, use an HTML5 help center layout (that has Algolia enabled) to publish a publication
(see Publishing Process [1068]. When Paligo completes the publishing process, it uploads a
JSON file to Algolia and creates an index.
To learn how to enable Algolia in an HTML5 help center layout, see Set up Algolia in your
HTML5 Layout [1383].
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NOTE
You must use a publication that contains content. If there are topics that only
contain a title, the JSON will be incorrect. If you are testing, you could use
topics with just a title and a single paragraph that contains text.

2. In Algolia, select your application and look at the Index section. It lists each index that has
been created for your application.

By default, Paligo creates an index for each language that you publish. Each index name
consists of a language code prefix and the UUID of the publication. For example:
en-UUID-817f5a19-d0db-0059-32e9-a958b958b9f85e62

NOTE
If your HTML5 layout is set to use a text name instead of the publication ID,
the index will have that name. For details, see Custom Index Name for Algolia
Search [1390].

3. Select the link for the index for the publication you published.

TIP
To find the UUID of the publication in Paligo, select the dotted menu ( ... ) for
the publication and then select Edit and then Open Structure. The UUID is
shown in the publication's metadata.

4. Select the Configuration tab.

5. In the SEARCH BEHAVIOR section, select Deduplication and Grouping.
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6. Configure these settings:

• Distinct
Set this to True.

• Attribute for Distinct
Set this to either title or url.

7. In the RELEVANCE ESSENTIALS section, select Searchable Attributes.

8. Add searchable attributes for:

• title

• body

9. Set title and body to be ordered and then drag them into the order you want, where the top
attribute in the list is most important. Typically, users set title as the top attribute.
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10. If you published in multiple languages, repeat this procedure for the indexes Paligo created
for the other languages.

NOTE
You only need to configure an index once. When you next publish the same
publication, Paligo will update the index without changing the configuration you
have in place.

Your HTML5 help center output should now be set up to use Algolia search. To learn how to test it,
see Test your Algolia Search [1389].

Test your Algolia Search
To test that Algolia search is working with your HTML5 Help Center:

1. Make sure that you have a working Internet connection.

2. Edit the HTML5 help center layout that you set up in Set up Algolia in your HTML5
Layout [1383]:

a. In the Search Engine section, make sure that Fuzzy search is set to Disable.

b. Select Save.

3. Publish your content. In the publishing settings, choose HTML5 and select the HTML5 help
center layout you edited in the previous step. Check the Debug box at the bottom and then
select Publish.
Paligo publishes your content. A zip file downloads in the browser.

4. Unzip the downloaded file.

5. Open the unzipped file and browse to the out folder. Inside the out folder is an index.html
file.

6. Open the index.html file in a browser.

7. In the search bar, type three or more letters of a phrase that you know exists in your
help center content. If Algolia is correctly connected to your Paligo content, you will see a
suggestion box appear as you type.
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If there is no suggestion as you type, it is a sign that the Algolia search is not working correctly.
This is usually because of incorrect settings (see Troubleshooting Algolia Search [1390]).

8. If you have set up faceted search and want to test it, select "advanced settings" under the
search bar on the help portal page. The browser should show you a results page with filters
on the left.

If you do not see a filters section, or the filters section is there but has no options, there is
likely a problem in the setup (see Troubleshooting Algolia Search [1390]).

Troubleshooting Algolia Search
If you experience problems when setting up Algolia search, we recommend that you go through
the configuration steps again carefully:

• Set Paligo to use Algolia Search [1382]

• Set up Algolia in your HTML5 Layout [1383]

• Configure the Index in Algolia [1386].

Some of the most common mistakes are:

• Forgetting to enable Algolia in the layout [1383]

• Typos or copying mistakes for the API keys in the Paligo integration settings [1382]

• Configuring the wrong index in Algolia. You need to configure the index that matches your
publication [1386].

• Publishing topics that only contain the title and a default para ("Insert text").
Empty topics and topics that only contain the title and a default paragraph ("insert text") will
result in Paligo being unable to create the JSON file that Algolia needs.

Custom Index Name for Algolia Search
When you publish with Algolia enabled, Paligo creates an index in Algolia (or updates an index that
it created previously). By default, the name of the index is set to match the UUID of the publication
in Paligo. If you prefer, you can set Paligo and Algolia to use a custom index name instead. This
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only works for publications in a single language, but it means that you will get a more readable
index name in Algolia.

NOTE
If you decide to use a custom name, be aware that Paligo will use the same name
each time you publish. For this reason, do not use a custom name if you want
to publish many publications with the same layout, as each time you publish, the
same index gets replaced.

To control whether Paligo uses a custom index name:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].

TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Search Engine.

4. In the Use custom index name for Algolia Search field, enter the name for the index. Paligo
will use this index name every time you publish with this layout. If Algolia already contains an
index with this name, Paligo will overwrite that index with the new index.

NOTE
To remove a custom index name, clear the field. Paligo will then go back to
creating index names based on the UUID of the publication.

5. Select Save.

6. Publish your content using the HTML5 layout you edited in the previous steps.
Paligo will publish the content and either create an index in Algolia or update an existing one.
This index will have a name that is based on the UUID of the publication. But in the HTML of
your content pages, the code will reference the custom index name. For this reason, you will
need to rename the index in Algolia (see next step).

7. In Algolia, manually rename the index (that has is currently named to match the UUID of the
publication). You must change the index name so that it is an exact match of the name you
entered in the layout's Use custom index name for Algolia Search field.
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TIP
To find the UUID of a publication, click on the publication in Paligo's Content
Manager. Then, look in the Metadata section. The UUID is listed there.

Delay Search Results as Users Type Query
When using Paligo and Algolia search, you can control how the search field works as users type in
a search query. You can choose between:

• Search returns results as soon as user starts entering a search term

• Search returns results only after the user enters three characters of the search term*

*If your HTML5 help center is set up to use a separate search page for Algolia, results are only
returned when the user presses Enter or selects submit.

To control the responsiveness of the search:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select the configuration to be updated or Create a Layout [1059].
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TIP
You can copy the URL of the layout editor and paste it into a new tab in your
browser. This can be useful if you need to frequently switch between your
Paligo content and the layout settings.

3. Select Search Engine.

4. Use Delayed search for Algolia to control what happens when a user starts typing in a search
query:

• Enable
Algolia will only start providing search results when the user has entered three characters in
the search field. If you have set your output to use a separate search page for Algolia, the
user has to press Enter to get results on that page.

• Disable
Algolia will start providing results as soon as the user enters a character in the search field.

• Default

To inherit the value for this setting from the base layout. The base layout is either a built-in
layout provided with Paligo or is another custom layout.

TIP
You can change the character limit by using JavaScript. For example, the
following script changes the limit to 7:

var instantsearch_minlength = 7;

To add the script, use a code editor or text editor to create the script and
save the file with a .js extension. Then upload the script as a custom JS
script in your HTML5 Help Center layout (see Add a Custom JavaScript to a
Layout [768]).

5. Select Save.

NOTE
For this procedure, we assume that the other settings for Algolia search are in
place. To learn about these settings, see Connect Paligo to Algolia [1382], Set up
Algolia in your HTML5 Layout [1383], and Configure the Index in Algolia [1386].

Customize Algolia Search with JS
Algolia supports some customizations that are made by adjusting the parameters that are used
in "calls" with an API client. These customizations need to be set up differently when using Algolia
with Paligo as there is no API client involved (the Paligo integration handles the communications
between Paligo and Algolia).

When you publish Paligo content with Algolia enabled, the pages load a JavaScript file called
html5.algoliasearch.js. This file is included in the js folder of the output) and it defines the
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addSearch() function. If you look inside the addSearch() function, you can see the script we have
used for Algolia search.

To customize the search, you can write your own addSearch() function in JavaScript and
include the Algolia parameters you want to use. Upload your custom JavaScript to your
HTML5 Help Center layout in Paligo. When you publish, your custom script will override the
html5.algoliasearch.js script.

For details on uploading custom JavaScript to Paligo, see Add a Custom JavaScript to a
Layout [768].

If you need a customization that goes beyond overriding the parameters in the addSearch()
function, Paligo may be able to provide that as a professional service project. For details,
contact customer support with details of what you want to achieve. Note that there is a fee for
professional services projects.

Algolia Faceted Search
Faceted search is an advanced search feature that lets users apply further criteria to search
results. They are often used on shopping web sites, where you can search for an item and then
filter the results by size, color, style, and product type. In technical communication, they are
popular for filtering search results to only show content for specific models, versions, subject
matter, and other categorizations.
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Algolia supports faceted search and you can use it with your Paligo content (one language only).
There are two different styles of faceted search available: "flat" and "hierarchical".

Algolia "Flat" Faceted Search
With "flat" faceted search, there is a heading for each category of filter. Below the heading, there
are checkboxes for each of the filters in that category.

When you check a box, Algolia displays search results that:

• Are relevant to the search term (entered in the main search field)

• Have a taxonomy tag that matches the name of the selected filter.

You can apply multiple filters at the same time and Algolia will update the search results.

Algolia "Hierarchical" Faceted Search
With "hierarchical" faceted search, the filter categories are shown. If you select a category, it
expands to reveal the facets you can use for filtering the search results.
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When you select a facet, Algolia displays search results that:

• Are relevant to the search term (entered in the main search field)

• Have a taxonomy tag that matches the name of the selected filter.

With "hierarchical" faceted search, you can only apply one filter to the results. This is the default
"out-of-the-box" behavior, but it may be possible to change how it works with a customization (a
fee is required for professional services projects). For details, please contact customer support.

How to Set Up Algolia Faceted Search
To learn how to set up the taxonomies, layout, and Algolia indexes for faceted search, see Set Up
Algolia Faceted Search [1396].

Set Up Algolia Faceted Search
Algolia supports faceted search, which is an advanced search that allows users to filter search
results. The following images shows "flat" faceted search, where there are headings with
checkboxes for each filter. Paligo also supports "hierarchical" faceted search, where the filters
are shown in a hierarchy, without checkboxes.
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Faceted search is only available for one output language.

To set up Algolia faceted search, you must first set up the regular Algolia search (see Set Paligo to
use Algolia Search [1382]). When you have Algolia search set up and working, there are three extra
stages for flat faceted search: setting up your taxonomy, setting up your HTML5 layout for faceted
search, and finally, setting up the Algolia index.

Set Up Taxonomies for the Facets
To use Algolia's faceted search with Paligo, you need to set up taxonomies to act as your "facets".
Facets are filter categories.

1. In Paligo, create the taxonomy tags that you want to use as filter categories. You need to
create a "parent" top-level taxonomy for each category type, and then individual taxonomy
tags inside the categories. For example, to filter by model, you would create a "parent"
taxonomy tag called "model". You would then create a "child" taxonomy tag for each model,
such as "acme 100", "acme 200", "acme 300" and so on.

For additional filter categories, you add more "parent" and "child" taxonomy tags. For
example, to add a "feature" category with filter options of "camera" and "flight", you would
create a parent "feature" tag. You would then create a "camera" tag and a "flight" tag as
"children" of the "feature" tag.

To learn more about creating taxonomies, see Create Taxonomies [1368].

NOTE
Use lower case for the taxonomy tag names.

2. Apply the taxonomy tags to your topics.

Set Up Faceted Search in an HTML5 Layout
The HTML5 Help Center layout has settings for enabling faceted search and defining which
taxonomies should be used as filter categories. You need to set these up before you publish.
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1. Open the HTML5 Help Center layout that you are going to use for publishing. (Select Layouts
in the top menu and then select the layout in the list).

2. Select Classes and attributes.

3. Set Output taxonomies to Enable.
This tells Paligo to include the taxonomies in the published output.

4. Select Search Engine.

5. Make sure Use Algolia Search is set to Enable.

6. Set Create separate search page for Algolia to Enable.

This tells Paligo to create a search page specifically for Algolia search. When you publish, it is
available from an "advanced search" option that appears below the search field on the help
center "portal page".

7. Set Output taxonomies as facets for Algolia Search page to Enable.

This tells Paligo to include taxonomies as "facets" (filter categories) on the Algolia search page.

8. Tell Paligo which "parent" taxonomies to use as a filter category. For this, use the field for the
type of Algolia faceted search you want to create:

• Taxonomies to use for flat Algolia facets
Use this field if you want flat Algolia faceted search.

• Taxonomies to use for hierarchical Algolia facets
Use this field if you want hierarchical Algolia faceted search.
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Enter the name(s) of each "parent" taxonomy that you want to be a filter category. You do not
need to enter the "child" taxonomies. The names must be in lower case and use a semi-colon
to separate the taxonomies, for example:

model;feature

NOTE
Only use one of the fields. You should only set Paligo to use flat faceted
search or hierarchical faceted search, not both at the same time.

9. Select Save.

Configure Facets in the Algolia Index
To get the faceted search to work, you need to publish from Paligo so that Algolia gets an index for
your publication. Paligo will create an index for each publication (1 index per language).

When your publication has an index in Algolia, you will need to configure the index to use
facets. The facets are based on the taxonomy tags in Paligo (see Set Up Taxonomies for the
Facets [1397]).

1. Publish your publication using the HTML5 Help Center layout you set up to use Algolia. To
learn about publishing, see Publishing Process [1068].
When you publish, Paligo will send a JSON file to your Algolia instance. It will either:

• Create a new index.

• Recreate the entire index (if you have previously published this publication with Algolia
enabled)

2. In Algolia, select your application and look at the Index section. It lists each index that has
been created for your application.
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By default, Paligo creates an index for each language that you publish. Each index name
consists of a language code prefix and the UUID of the publication. For example:
en-UUID-817f5a19-d0db-0059-32e9-a958b958b9f85e62

NOTE
If your HTML5 layout is set to use a text name instead of the publication ID,
the index will have that name. For details, see Custom Index Name for Algolia
Search [1390].

3. Select the link for the index for the publication you published.

TIP
To find the UUID of the publication in Paligo, select the dotted menu ( ... ) for
the publication and then select Edit and then Open Structure. The UUID is
shown in the publication's metadata.

4. Select the Configuration tab.

5. In the FILTERING AND FACETING section, select Facets.

6. Use the Add an attribute drop-down list to add the attributes for the filter categories. If
Algolia does not include the required attributes in the list, there may be a problem with the
Paligo-to-Algolia setup, see Test your Algolia Search [1389].

• For "flat" faceted search:
Add an attribute for each of the "parent" filter categories that you want to include. The
drop-down list should include the facet names of your "parent" taxonomy tags. .
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• For "hierarchical" faceted search:
Add these attributes:

• hierarchicalCategories.lvl0

• hierarchicalCategories.lvl1

NOTE
If Algolia displays an "Unknown attribute" notification, ignore it.

7. Make sure the attributes are set to not searchable.

8. Select Review and Save settings.

9. Select the Browse tab to see a preview of the facets.
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NOTE
The preview for "hierarchical" facets shows the structure of the facets, not
how they will be presented in the output.

Your faceted search should now work with your published output. To try it out, see Test your
Algolia Faceted Search [1402].

Test your Algolia Faceted Search
When you have set published your content with an Algolia-enabled layout, test that the faceted
search is working:

1. Double-click on the zip file that downloaded in your browser when you published your
content.
Your computer unzips the file, revealing its contents.

2. Browse to the out folder and open the index.html file that is inside it.
The browser opens the Help Center "portal page".

3. On the help portal page, select the Advanced Options link below the main search field.
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Paligo displays the Algolia search page.

4. Try using the filters to the side of the search results. Each of the check boxes is a "facet" and
matches a taxonomy tag that you applied to your topics in Paligo. When you check a box,
Algolia updates the search results so that they only include topics that have the selected facet.

• For "flat" faceted search:
Enter a search term to get the results and then use the "facet" checkboxes to filter the
results. There should be a checkbox for each "facet" and when you check a box, the results
should filter so that they only include topics with that taxonomy/facet.
You can apply multiple filters at the same time, and Algolia will show the results that
have all of the selected filters. For example, in the following image, the search results
("Thermal Camera", "Auto-Tracking", "Zoom" and "Camera Angle") all have the "acme 300"
and "camera" taxonomy tags.

• For "hierarchical" faceted search:
Enter a search term to get the results. Then expand any of the "parent" categories to reveal
the "child" facets. Select a "child" facet and the results should update to show only topics
that have that facet/taxonomy (and are relevant to the search term).
For example, in the following image, we expanded "feature" and then selected "camera".
This filtered the search results so that they only show topics that have the camera facet/
taxonomy (and are relevant to the search term).

Paligo Documentation

1403



NOTE
You can only apply one facet at a time with hierarchical search.

If the faceted search is not working as expected, first check that the regular Algolia search is
working (see Test your Algolia Search [1389]). If that is working, then check the common issues
with faceted search [1404].

Troubleshooting Algolia Faceted Search
If your Algolia faceted search is not working as expected, first check that regular Algolia search is
working (see Test your Algolia Search [1389]).

When you are sure that the regular Algolia search is working, check that:

• The taxonomy tags are applied to your topics in Paligo.
If you select a taxonomy tag in the Taxonomy Manager, Paligo displays a list of the topics and
publications that have that tag.
For details, see Taxonomies View [1366].

• The taxonomy tags use lower case letters only.
This is required for the JSON file that Paligo sends to Algolia.

• You have set the layout to include the correct taxonomy names. Also check that they are spelled
correctly and that you have used the appropriate field (there are separate fields for "flat" and
"hierarchical" faceted search).
For more information, see Set Up Algolia Faceted Search [1396].

• You have configured the index in Algolia correctly, see Configure Facets in the Algolia
Index [1399].

If you complete all of the above steps and still have issues with faceted search, contact Paligo
customer support for help.

Amazon S3 Integration
Abstract

You can upload content directly from Paligo to Amazon S3. Set up the Paligo to Amazon S3
integration so that Paligo can connect to Amazon S3, and then you can publish.

Paligo has Continuous Integration (CI) support for Amazon Web Services S3 (Amazon S3). This
means you can create content in Paligo, such as PDFs or an HTML help center, and publish it to
Amazon S3 so that it is instantly live to your end-users.

When you publish to Amazon S3, your Paligo content is uploaded to an S3 bucket as a zip file. You
can use a lambda function to automatically unzip the file into another bucket, and then you can
use the unzipped content in your workflow or publish it through Amazon S3.

Before you can publish from Paligo to Amazon S3, you need:

• An Amazon S3 account

• Basic Amazon S3 knowledge and skills, including how to create an S3 bucket, set permissions.
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• A bucket in Amazon S3. Paligo will upload your published files to the bucket. The output is
uploaded as a zip file.

To set up Paligo to publish to Amazon S3:

1. Connect Paligo to Amazon S3 [1405].

2. Publish Content to Amazon S3 [1407]

This will allow Paligo to publish your output as a zip file to your chosen AWS S3 bucket. You can
also set up Amazon S3 so that it unzips the file automatically [1409].

Connect Paligo to Amazon S3
To set up the Paligo Amazon S3 integration, you need to have an:

• Amazon Web Services account with read and write access to the S3 service

• S3 bucket to receive the zipped content that Paligo will upload when you publish.
Paligo can upload content directly to the root directory of the bucket or to a folder inside it.

When you have a bucket set up, you can connect Paligo to Amazon S3:

1. Log in to Paligo via a user account that has administrator permissions.

2. Select your profile name in the upper right corner to display a menu, and then select Settings.

3. In the Settings view, select the Integrations tab.

4. Find the Amazon S3 settings and select Add.

NOTE
Add is only available the first time you set up an integration. After that, Add is
replaced by Change.

Paligo displays the Amazon S3 integration settings.
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5. Select the AWS region. This is the geographical location of the data center for your Amazon
Web Services.
To find out more, see https://docs.aws.amazon.com/general/latest/gr/rande-manage.html.
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6. Enter the AWS key and the AWS secret. These are the security access keys for your AWS
account.
For information on how to find the access key and the secret key, see https://
docs.aws.amazon.com/general/latest/gr/aws-sec-cred-types.html.

7. Enter the name of the AWS bucket that is going to receive the published Paligo content. The
content is uploaded to this bucket as a zip file.

8. In the AWS destination folder field, enter the directory path for the folder that you want
Paligo to upload the zip file to. This folder is inside the AWS bucket.
For example:
Folder 1/Folder 2/
To upload the zip file directly to the root of the bucket, leave the AWS destination field
empty.

9. Check the Use non-unique file name box if you want Paligo to use a consistent file name for
the zip file. Each time Paligo publishes content via the integration, the zip file name will be the
same.
If you want Paligo to generate different names for the zip file each time, clear the checkbox.

10. Select Save.

11. Select the Change button for the Amazon S3 integration.

12. Select Test Settings to run a connection test. If the settings are correct, Paligo will show a
green success notification.
If the connection test fails, Paligo shows a red failure notification. Check each connection
setting carefully, to make sure you have not made any mistakes and try again. If the
connection test continues to fail, contact Paligo support for assistance.

When the connection is made, you can publish content from Paligo to the Amazon S3
bucket [1407] you specified in the integration settings.

Publish Content to Amazon S3
When you have set up the Paligo Amazon S3 integration, you can publish content from Paligo to
Amazon S3. The process is very similar to "regular" publishing. You create your publication and
topics, and set up a layout for the type of output you want, such as PDF, HTML5, etc. Then you
choose the publication settings and Paligo creates a zip file that contains your output content. The
zip file is downloaded in your browser, and for Amazon S3, it is also uploaded to your chosen S3
bucket.

NOTE
You can set up a lambda function in Amazon S3 to automatically unzip the
contents to another bucket.

To publish to Amazon S3, the integration settings need to be in place so that Paligo can connect to
Amazon Web Services. When those are in place, and you have a publication and layout set up to
create the output you want, you can publish to Amazon S3:

1. In Paligo, select the options menu ( ... ) for the publication that you want to publish, and then
select Publish.
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2. On the Publish document dialog, select the type of output you want, for example, HTML5.

3. Choose the layout that you want to use for publishing. The settings in the layout are applied
when Paligo generates the output.

4. Choose the Languages to publish to. If you do not have any translations, you can only select
the original/source language.

5. If you have set filters (Profiling attributes) on topics or elements, and/or have used
variables, choose which values to use for the publication. See Filtering / Profiling [1141] and
Variables [1186] to learn how to use these features.

6. In the Upload output section, check the Upload to Amazon S3 box. By default, Paligo will
upload the output to the bucket and folder that are specified in the Paligo to Amazon S3
integration settings.
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You can publish to a different bucket and/or folder if required. Select the Edit icon next to
Upload to Amazon S3, and then select the bucket and/or folder on the Edit dialog.

The settings you choose will only be used for this individual publishing process. Any future
publishing will revert to using the repository and folder that are defined in the integration
settings.

7. Select Publish document.
Paligo generates the output, applying the settings from the layout and the Publication
document dialog in the process. When the output is ready to use, it is downloaded in your
browser as a zip file. The zip file is also uploaded to your chosen bucket and folder in Amazon
S3.

Unzip Paligo Content in Amazon S3 with Lambda Function

NOTE
This content is designed for developers who understand Amazon S3 and know
how to create lambda functions, create buckets, and set up permissions, IAM
roles etc.

When you publish from Paligo to Amazon S3, Paligo creates a zip file that contains your content.
The zip file is uploaded to a bucket in S3. You then have the choice to unzip the file manually, or
you can use a lambda function to unzip the file automatically and place the unzipped content in
another bucket. The unzipped content can then be used in your workflow or you can use AWS for
hosting, with the content publicly available through a URL.

To unzip your content automatically, set up:

• Another S3 bucket and it has to have public permissions (the default is non public).
So you now have one S3 bucket to receive the Paligo files (we will call this the "zipped" bucket)
and one S3 bucket for the unzipped files (the "unzipped" bucket).
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• A lambda function. When Paligo uploads a file to the "zipped" bucket, the lambda function
should be triggered automatically. The function unzips the file from Paligo and places resulting
files in the "unzipped" bucket.

Here is an example of a lambda function:

import json
import urllib.parse
import boto3
import zipfile
import mimetypes
import os
import re
from io import BytesIO

def unpack(event, context):    
    # debug the event    
    # print("Received event: " + json.dumps(event, indent=2))    
    
    # Get the bucket name from the event
    bucket=event['Records'][0]['s3']['bucket']['name'] 
   
    # Get the key name from the event
    key=urllib.parse.unquote_plus(event['Records'][0]['s3']['object']
['key'], encoding='utf-8')    

    try:
        # initialize s3 client, this is dependent upon your aws config \
being done
        s3=boto3.client('s3', use_ssl=False)

        # load the object
        bucketobj=s3.get_object(Bucket=bucket,Key=key)
['Body'].read()        

        # the zip function needs a file object
        Fileobj=zipfile.ZipFile(BytesIO(bucketobj), 'r')

        filecount=0

        for name in Fileobj.namelist(): 
            path=re.match('^(.*?\/)out\/(.*?)$', name)
            if (path is None):                
                continue

            outkey=path[1] + path[2]
            handle=BytesIO(Fileobj.open(name, 'r').read())
            mimetype=mimetypes.guess_type(name)

            s3.upload_fileobj(
                handle,
                Bucket=os.environ['BUCKETNAME_OUTPUT'],
                Key=outkey,
                ExtraArgs={'ContentType': str(mimetype[0])}
            )
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            filecount = filecount + 1

        return print('Uploaded {} files to {}'.format(filecount, \
os.environ['BUCKETNAME_OUTPUT']))

    except Exception as e:
        print(e)
        print('Error getting object {} from bucket {}.'.format(key, bucket))
        raise e

NOTE
Note that this lambda function looks for content in the "Out" folder in the zip file
that Paligo provides. Only files in the "Out" folder are added to the public-facing
unzipped bucket.

Azure Repos Integration
Paligo has Continuous Integration (CI) support for Microsoft® Azure Repos®. This means you can
create content in Paligo, such as PDFs or an HTML help center and publish it to Azure Repos. The
content is uploaded to your choice of Azure repo as a zipped file.

Prerequisites to be able to activate this integration:

• An Azure Repos account

• Basic Azure Repose knowledge and skills, including how to create a project, repository, and
personal access token

• A project in Azure Repos

• A repository in Azure Repos. The repository must be inside a project. Paligo will upload the zip
file for the published output to this repository.

• Integration with Azure SSO [1514]

NOTE
The Paligo to Azure upload has a limit of approximately 20 MB.

Connect Paligo to Azure Repos
Once the Azure SSO setup has been done, you need the following details from your Azure Repos
account to connect Paligo to it:

• Organization

• Username
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• Personal Access Token. You can create a Personal Access Token in the User Settings in Azure
Repos.

When the connection is made, you can Publish Content to Azure Repos [1413].

1. Log in to Paligo via a user account that has administrator permissions.

2. Select your profile name in the upper right corner to display a menu, and then select Settings.

3. In the Settings view, select the Integrations tab.

4. Find the Azure Repos settings and select Add.

NOTE
Add is only available the first time you set up an integration. After that, Add is
replaced by Change.

Paligo displays the Azure Repos integration settings:

5. Enter the Organization. Typically, this is your username but without the email address part,
for example, if your username is jsmith@gmail.com, the Organization is likely to be jsmith.

6. Enter the Username for the Azure Repos account. Paligo will use this to log in to Azure Repos.
It is important that the account has write permissions for the repository (these are set for the
account in Azure Repos).

7. Enter the Personal Access Token. You can create the Personal Access Token in Azure Repos.

8. Select the button at the end of the Project field. Paligo connects to Azure Repos and detects
the projects that you have available. Select the project that contains the repository that you
want Paligo to publish to.

Paligo Documentation

1412



9. Select the Repository that you want Paligo to publish to.

10. Choose the Branch that Paligo will upload content to. Paligo detects what branches are
available and you can choose the branch from the dropdown list.

Paligo does not automatically update the integration settings page while it is open. This means
that if you have the integration settings page open, and some new branches are added in
Azure Repos, those new branches will not appear in the Branch field. But if you select the
branch button, Paligo will update the settings page with the latest branch information.

11. In the Destination folder field, enter the directory path for the folder that you want Paligo to
upload the zip file to. This folder is inside the Azure Repos repository.
For example:
Folder 1/Folder 2/
To upload the zip file directly to the root of the repository, leave the Destination field empty.

12. Select Save.

13. Select the Change button for the Azure Repos integration.

14. Select Test Settings to run a connection test. If the settings are correct, Paligo will show a
green success notification.

NOTE
If the connection test fails, Paligo shows a red failure notification. Check each
connection setting carefully, to make sure you have not made any mistakes
and try again. If the connection test continues to fail, contact Paligo support for
assistance.

Publish Content to Azure Repos
You can publish content from Paligo to Azure Repos, and the process is very similar to "regular"
publishing. You create your publication and topics, and set up a layout for the type of output you
want, such as PDF, HTML5, etc. Then you choose the publication settings and Paligo creates a zip
file that contains your output content. The zip file is downloaded in your browser and it is also
uploaded to your chosen Azure Repos repository.

To publish from Paligo to Azure Repos, use the Upload to Azure Repose option in the publishing
settings. This option is only available if the Paligo Azure Repos integration settings are in place. You
will also need to set up a publication and layout to create the output you want, for example, an
HTML5 help center. With these in place, you can publish from Paligo to Azure Repos.
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NOTE
The Paligo to Azure upload has a limit of approximately 20 MB.

1. In Paligo, select the options menu ( ... ) for the publication that you want to publish, and then
select Publish.

2. On the Publish document dialog, select the type of output you want, for example, HTML5.

3. Choose the layout that you want to use for publishing. The settings in the layout are applied
when Paligo generates the output.

4. Choose the Languages to publish to. If you do not have any translations, you can only select
the original/source language.

5. If you have set filters (Profiling attributes) on topics or elements, and/or have used
variables, choose which values to use for the publication. See Filtering / Profiling [1141] and
Variables [1186] to learn how to use these features.

6. In the Upload output section, check the Upload to Azure Repos box. By default, Paligo will
upload the output to the repository and folder that are specified in the Paligo to Azure Repos
integration settings.

You can publish to a different branch and/or folder if required. Select the Edit icon next to
Upload to Azure Repos, and then select the branch and/or folder on the Edit dialog.
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The settings you choose will only be used for this individual publishing process. Any future
publishing will revert back to using the branch and folder that are defined in the integration
settings.

7. Select Publish document.
Paligo generates the output, applying the settings from the layout and the Publication
document dialog in the process. When the output is created, it is downloaded in your browser
as a zip file. The zip file is also uploaded to your chosen repository branch and folder in Azure
Repos.

Bitbucket Integration
Abstract

You can upload content directly from Paligo to Bitbucket Cloud. Set up the Paligo to Bitbucket
integration so that Paligo can connect to Bitbucket, and then you can publish.

Paligo has Continuous Integration (CI) support for Bitbucket Cloud. This means you can create
content in Paligo, such as PDFs or an HTML help center, and publish it to Bitbucket Cloud. When
the content is uploaded to Bitbucket, you can unzip it (automatically if you so choose) to make it
instantly available live to your end users.

NOTE
Paligo does not have a direct integration with Bitbucket server. But with our API,
your developers could set up a Bitbucket server integration themselves.

Before you can publish from Paligo to Bitbucket, you need:

• A Bitbucket Cloud account

• Basic Bitbucket knowledge and skills, including how to create a repository

• A repository in Bitbucket. Paligo will upload published output to the repository. The output is
uploaded as a zip file.

To set up Paligo to publish to Bitbucket Cloud:

1. Connect Paligo to Bitbucket Cloud [1416].

2. Publish Content to Bitbucket Cloud [1419].
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This will allow Paligo to publish your output as a zip file to your chosen repository. You can
unzip it manually or you can set up Bitbucket pipelines so that the the content file is unzipped
automatically [1421].

Connect Paligo to Bitbucket Cloud
To set up Paligo to connect to Bitbucket Cloud, you need to have:

• A Bitbucket Cloud account.

• A repository to receive the zipped content that Paligo will upload when you publish.
Paligo can upload content to the root of a repository, or to a folder inside it. It can also upload to
a specific branch.

• An app password that provides write permissions for the repository. To find out how to create
app passwords in Bitbucket, see App Passwords

When you have a repository set up, you can connect Paligo to Bitbucket Cloud:

1. Log in to Paligo via a user account that has administrator permissions.

2. Select your profile name in the upper right corner to display a menu, and then select Settings.

3. In the Settings view, select the Integrations tab.

4. Find the Bitbucket settings and select Add.

NOTE
Add is only available the first time you set up an integration. After that, Add is
replaced by Change.

Paligo displays the Bitbucket integration settings:
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5. Enter the Workspace ID. The workspace is where you create your repositories in BitBucket.
To find out more about Bitbucket workspaces, see Workspaces.

NOTE
If the Workspace ID is identical to the Username, leave the Workspace field
empty.

6. Enter the Username for the Bitbucket account. Paligo will use this to log in to BitBucket. It
is important that the account has write permissions for the repository (these are set for the
account in BitBucket).

7. Enter the App password. This is the password for accessing the app in BitBucket (and is
defined in BitBucket).

8. Enter the name of the Repository slug. This is the URL for your repository and is generated
automatically by Bitbucket.
To find out more about Bitbucket slugs, see What is a slug?

9. Choose the Branch that Paligo will upload content to. The first time you set up the integration,
select the branch button, so that Paligo can connect to Bitbucket using the settings you have
provided. It will detect what branches are available. Then you can choose the branch from the
dropdown list.

Paligo does not automatically update the integration settings page while it is open. This means
that if you have the integration settings page open, and some new branches are added in
Bitbucket, those new branches will not appear in the Branch field. But if you select the branch
button, Paligo will update the settings page with the latest branch information.

10. In the Destination folder field, enter the directory path for the folder that you want Paligo to
upload the zip file to. This folder is inside the Bitbucket repository.
For example:
Folder 1/Folder 2/
To upload the zip file directly to the root of the repository, leave the Destination field empty.

11. Check the Use non-unique file name box if you want Paligo to use a consistent file name for
the zip file. Each time Paligo publishes content via the integration, the zip file name will be the
same.
If you want Paligo to generate different names for the zip file each time, clear the checkbox.

12. Select Save.

13. Select the Change button for the Bitbucket integration.

14. Select Test Settings to run a connection test. If the settings are correct, Paligo will show a
green success notification.
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If the connection test fails, Paligo shows a red failure notification. Check each connection
setting carefully, to make sure you have not made any mistakes and try again. If the
connection test continues to fail, contact Paligo support for assistance.

When the connection is made, you can publish content from Paligo to a Bitbucket
repository [1419].

Publish Content to Bitbucket Cloud
You can publish content from Paligo to Bitbucket Cloud, and the process is very similar to "regular"
publishing. You create your publication and topics, and set up a layout for the type of output you
want, such as PDF, HTML5, etc. Then you choose the publication settings and Paligo creates a zip
file that contains your output content. The zip file is downloaded in your browser and it is also
uploaded to your chosen Bitbucket repository.

NOTE
You can use Bitbucket pipeline to automatically unzip the contents [1421].

To publish from Paligo to Bitbucket, you will use the Upload to Bitbucket option in the publishing
settings. This option is only available if the Paligo Bitbucket integration settings are in place. You
will also need to set up a publication and layout to create the output you want, for example, an
HTML5 help center. With these in place, you can publish from Paligo to Bitbucket:

1. In Paligo, select the options menu ( ... ) for the publication that you want to publish, and then
select Publish.
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2. On the Publish document dialog, select the type of output you want, for example, HTML5.

3. Choose the layout that you want to use for publishing. The settings in the layout are applied
when Paligo generates the output.

4. Choose the Languages to publish to. If you do not have any translations, you can only select
the original/source language.

5. If you have set filters (Profiling attributes) on topics or elements, and/or have used
variables, choose which values to use for the publication. See Filtering / Profiling [1141] and
Variables [1186] to learn how to use these features.

6. In the Upload output section, check the Upload to Bitbucket box. By default, Paligo will
upload the output to the repository and folder that are specified in the Paligo to Bitbucket
integration settings.
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You can publish to a different branch and/or folder if required. Select the Edit icon next to
Upload to Bitbucket, and then select the branch and/or folder on the Edit dialog.

The settings you choose will only be used for this individual publishing process. Any future
publishing will revert back to using the branch and folder that are defined in the integration
settings.

7. Select Publish document.
Paligo generates the output, applying the settings from the layout and the Publication
document dialog in the process. When the output is created, it is downloaded in your browser
as a zip file. The zip file is also uploaded to your chosen repository branch and folder in
Bitbucket. You can use a script to unzip the file automatically [1421].

Unzip Paligo Content in Bitbucket Cloud

NOTE
This content is designed for developers who understand Bitbucket and know how
to create SSH keys and Bitbucket Pipelines.

When you publish from Paligo to Bitbucket Cloud, Paligo uploads the content as a zip file. To use
the Paligo content, you will need to unzip it in Bitbucket by using Bitbucket Pipelines. This involves:

• Generating SSH keys for Bitbucket Pipelines

• Adding a bitbucket-pipelines.yml file at the root of your repository.

To do this:

1. Log in to your Bitbucket account and select the repository that you will use to publish content
from Paligo.

Paligo Documentation

1421



2. In the side menu, select Repository settings.

3. In Repository settings, scroll down to the Pipelines section and select SSH Key.

4. Select Generate Key to create a private and public key.

5. Copy the public key.

6. Select Your profile and settings .

7. From the menu, select Personal settings to display the Personal Settings window.

8. Select SSH keys.

9. Select Add key and then paste in the public key you copied in step 5.
Bitbucket will send you an email to let you know that you have added a key to your repository.

10. Create a bitbucket-pipelines.yml file at the root of your repository.

11. Edit the bitbucket-pipelines.yml file so that it unzips the content that Paligo uploads to
the repository. We have provided examples for different scenarios, which you can use as a
starting point.

NOTE
Please use the following examples at your own risk. You should be able to
understand what the example does and what the steps do. Unfortunately, we
cannot provide support if there are issues. Consider the examples as a proof of
concept.

Example 70. Unzip Paligo content to same repository and same branch

image: php:7.2

pipelines:
    default:
        - step:
            script:

                - TARGET_BRANCH=$BITBUCKET_BRANCH 

                - DESTINATION_FOLDER="." 
                - apt-get update && apt-get install -y unzip git
                - cd $DESTINATION_FOLDER
                - FILE_COUNT=$(find ./ -name "*.zip" | wc -l)
                - if [[ $FILE_COUNT -gt 0 ]]; then
                - find ./ -name "*.zip" -exec unzip -o {} \;
                - rm *.zip
                - git add .
                - git commit -
m "unzip the file from paligo and remove the zip file"
                - git push origin $TARGET_BRANCH
                - fi

TARGET_BRANCH - The branch name where unzipped content is pushed to. In this example,
we use the environmental variable $BITBUCKET_BRANCH provided by Bitbucket, which
contains the current branch name. See Variables in Pipelines for more information about
environmental variables. Note that the branch you specify here must already exist.
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DESTINATION_FOLDER - If you change the Destination Folder in Paligo's Bitbucket integration
settings, you need to specify that folder here. Note that you must specify a relative path. For
example, if you have specified paligo/output in the integration settings, you need to write
paligo/output here. That path name is relative to the current folder where the script will be
executed.

What does this script do?

1. Finds all files ending with .zip and unpacks them in the current folder.

2. Removes all .zip files and push changes back to the current branch.

Example 71. Unzip Paligo content to same repository but a different branch

image: php:7.2

pipelines:
    default:
        - step:
            script:

                - TARGET_BRANCH="paligo-output" 

                - DESTINATION_FOLDER="." 
                - apt-get update && apt-get install -y unzip git
                - cd $DESTINATION_FOLDER
                - FILE_COUNT=$(find ./ -name "*.zip" | wc -l)
                - if [[ $FILE_COUNT -gt 0 ]]; then
                - TMP_DIR=$(mktemp -d -t paligo-XXXXXXXXXX)
                - find ./ -name "*.zip" -exec unzip -d $TMP_DIR -o {} \;
                - rm *.zip
                - git add .
                - git commit -m "remove the zip file"
                - git push origin $BITBUCKET_BRANCH
                - sleep 1
                - git checkout -b $TARGET_BRANCH && git pull
                - cp --recursive --force $TMP_DIR/* ./
                - git add .
                - git commit -m "unzip the file from paligo"
                - git push -f origin $TARGET_BRANCH
                - fi

TARGET_BRANCH - The branch name where unzipped content is pushed to. In this example, we
use the branch name paligo-output.
DESTINATION_FOLDER - If you change the Destination Folder in Paligo's Bitbucket integration
settings, you need to specify that folder here. Note that you must specify a relative path. For
example, if you have specified paligo/output in the integration settings, you need to write
paligo/output here. That path name is relative to the current folder where the script will be
executed.

What does the script do?

1. Finds all files ending with .zip and unpacks them in a temporary folder.

2. Removes all .zip files and push deletions back to the current branch.

3. Changes branch.

4. Copies all files from the temporary folder in the branch folder.

5. Commits files.
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Example 72. Unzip Paligo content to a different repository in the same
project

image: php:7.2

pipelines:
    default:
        - step:
            script:
                - DESTINATION_FOLDER="."
                - TARGET_REPOSITORY="paligo-publications"
                - TARGET_BRANCH="output"
                - BITBUCKET_NAME='John Doe'
                - BITBUCKET_USERNAME='johndoe'
                - BITBUCKET_USEREMAIL='john.doe@company.com'
                - apt-get update && apt-get install -y unzip git
                - cd $DESTINATION_FOLDER
                - FILE_COUNT=$(find ./ -name "*.zip" | wc -l)
                - if [[ $FILE_COUNT -gt 0 ]]; then
                - TMP_DIR=$(mktemp -d -t paligo-XXXXXXXXXX)
                - find ./ -name "*.zip" -exec unzip -d $TMP_DIR -o {} \;
                - rm *.zip
                - git add .
                - git commit -m "remove the zip file"
                - git push origin $BITBUCKET_BRANCH
                - sleep 1
                - CLONE_DIR=$(mktemp -d -t clone-XXXXXXXXXX)
                - cd $CLONE_DIR
                - git clone git@bitbucket.org:$BITBUCKET_USERNAME/
$TARGET_REPOSITORY.git $CLONE_DIR
                - git checkout -b $TARGET_BRANCH
                - cp --recursive --force $TMP_DIR/* ./
                - git config --global user.email "$BITBUCKET_USEREMAIL"
                - git config --global user.name "$BITBUCKET_NAME"
                - git add .
                - git commit -
m "unzip the file from paligo and remove the zip file"
                - git push -f origin $TARGET_BRANCH
                - fi

What does the script do?

1. Finds all files ending with .zip and unpacks them in a temporary folder.

2. Removes all .zip files and push deletions back to the current branch.

3. Creates a new temporary folder and clones the target repository into that folder.

4. Copies all files from the temporary folder in the branch folder.

5. Commits files.

Crowdin Integration
Crowdin is a cloud-based translation and localization platform, designed for agile translations,
where content can be updated and translated frequently. It has its own app, available in the
Crowdin store, for integrating with Paligo.

Paligo Documentation

1424

https://store.crowdin.com/paligo


To find out how to use Crowdin to translate Paligo content, see Translate with Crowdin [1709].

Fluid Topics Integration
Fluid Topics is software that is designed to provide a single portal for all of your documentation,
including PDFs, Word documents, knowledge base articles and content you create in Paligo too.

To use your Paligo content in Fluid Topics, you will need:

• A Fluid Topics account with administrator permissions

• A source set up in Fluid Topics. The source is a "silo" that will receive the content from Paligo.

• An API key, generated in Fluid Topics.

NOTE
For details on how to set these up in Fluid Topics, refer to the Fluid Topics
documentation.

Connect Paligo to Fluid Topics
You can publish content directly from Paligo to your Fluid Topics instance. But to do that, you first
need to set up Paligo and Fluid Topics to connect to each other.

NOTE
If your Fluid Topics has been connected to your Paligo instance before, you may
already have a source and API key, in which case, you can use those instead of
creating new ones.

1. Log in to Fluid Topics as an administrator.

2. In Fluid Topics, create a new source and generate a new API key.
The source is the "silo" that will receive the content from Paligo. Fluid Topics uses the API key
to authenticate the connection from Paligo.
For details on how to create a source and generate an API key, see the Fluid Topics
documentation.

3. Log in to Paligo via a user account that has administrator permissions.

4. Select your user name in the top-right corner and select Settings.

5. In the Settings view, select the Integrations tab.

6. In the Fluid Topics box, select Add (or Change if an integration has been set up previously).
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7. Use the integration settings to connect Paligo to Fluid Topics:

• Upload URL: Enter the URL of the Fluid Topics portal that will receive content from Paligo.

• API Key: Enter the API key for Fluid Topics. This has to be an exact match to the API key you
created in step 2.

• Source ID: Enter the SourceID. This has to be an exact match to the Source ID you created
in step 2. Fluid Topics uses the Source ID to identify the "silo" that will receive the Paligo
content. It also uses the Source ID to identify the type of content being received.

8. Select Save.

9. Select Test settings to test the connection.
If the test is successful, Paligo can connect to your Fluid Topics. You can now publish content
from Paligo to Fluid Topics [1426].
If the test fails, check that the URL, API Key and Source ID are correct. If they are correct and
the test still fails, contact customer support for assistance.

Publish to Fluid Topics
To publish content from Paligo to Fluid Topics, you must first set up the Paligo to Fluid Topics
connection. When that is in place, you can publish content from Paligo to Fluid Topics, and unlike
some of the other integrations, there is no need for a layout.

When you publish with the Fluid Topics output, a zip file of your output is sent to Fluid Topics,
where it is processed and added to the relevant source. You specify the source in the Paligo
integration settings.

1. Make sure that you have set up the Fluid Topics integration settings correctly [1425].

2. In the Content Manager, display the options menu for the publication that you want to
publish, and select Publish.

3. Select Fluid Topics.
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NOTE
If the Fluid Topics option is not shown, check that Paligo can connect to Fluid
Topics. The Fluid Topics option only shows when the connection is set up
correctly.

4. Choose the Languages that you want to publish.
If you do not have any translations, you can only select the original language (source
language).
If you have multiple languages translated and approved, you can select which ones to include.
Paligo will publish each language as a separate output.

Fluid Topics will process and manage the translations so that they appear in the correct place
in Fluid Topics.

5. If you have marked up your content to use filters (profiles) [1141], use the Profiling
attributes section to choose which filters to apply. If you do not want to use filters, ignore this
step and continue from the next step.
To apply filters for publishing, select Edit to display a list of the filter properties that are used.
Choose the filter values that you want to include. Leave the fields blank for the filters that you
do not want to apply.
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When you select OK, the chosen profile settings are shown in the Profiling attributes section.

NOTE
With the filter settings, you tell Paligo which content to include. For example,
if you have used an outputformat filter, you could mark up some content to
have a PDF value and other content to have an HTML value. In the publishing
settings, if you set Output Format to HTML, it will include the content that
has an outputformat:HTML filter and will exclude any content that has an
outputformat:PDF filter (or any value other than HTML).

6. If you have used variables [1186] in your content, use the Variables section to choose which
variants to use for the publication.If you do not want to use variables, ignore this step and
continue from the next step.
To choose the variants, select Edit to display a list of variable sets that are used. For each
variable set, there is a field that you can use to choose which variant to apply. If there are
variable sets that you do not want to apply to your publication, leave the fields for those
empty.
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7. Use the Upload Output settings to upload the published content to other platforms as well,
such as GitHub. This is optional and the uploads will only be possible if the relevant Paligo
integration settings are in place. For example, you can only upload to GitHub if you have set
up the Paligo to GitHub integration.
To find out how to set the integrations up, see Integrations [1380].

8. Set the Optional Parameters (leave unchecked if you do not want these features):

• Save the output in Paligo - Choose whether you want Paligo to add the published output
to the Resource View [68]. Check the box to save the zip file. Clear the box if you want Paligo
to only download the published output file in your browser.

• Email me - Check this box if you want Paligo to send you an email when the publication
is ready. This is useful if you have very large publications that can take a longer time to
process and publish.

• Make debug build - Check this box if you want Paligo to include a log file and link report.
If there is an issue with your content, Paligo support may ask you to enable this feature so
that they can use the log files to investigate.

TIP
Every time you publish, there will also be a link in the Dashboard feed to
download the published content.

9. Select Publish Document to start publishing. Paligo will then process your content and apply
your publishing settings. The time that this takes can vary depending on how much content
you are publishing (the more content there is, the longer it takes).
A progress bar shows you how much of the processing Paligo has completed and how much is
left to do. When the processing is complete, Paligo "pushes" the production content into Fluid
Topics.

TIP
You can also save your publishing settings [1076] so that you can select the saved
version instead of re-applying all the filters, variables, etc., each time. Any settings
you save can also be used for Batch Publishing [1073].

FTP Integration
Abstract

You can upload content directly from Paligo to a web server via FTP (File Transfer Protocol) or FTPS
(File Transfer Protocol Secure). To publish via FTP or FTPS, you must first set up the Paligo to FTP
integration.

With the FTP (File Transfer Protocol) integration, you can publish your Paligo content, such as an
HTML5 help center, directly to your web site.
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This will allow Paligo to publish content to your web server. When you publish, the content is
uploaded as files, such as HTML or PDF. It is not zipped, so there is no need to unzip it on your
web server.

Before you can publish from Paligo to a web server via FTP or FTPS, you need:

• Web hosting space

• A URL for the domain (or its IP address)

• User account and password for access to the domain. The user account must have read/write
access to the folder that will receive the content from Paligo.

Connect Paligo via FTP
To connect Paligo to your web server via FTP (File Transfer Protocol) or FTPS (File Transfer Protocol
Secure):

1. Log in to Paligo via a user account that has administrator permissions.

2. Select the avatar in the top right corner. 

3. Select Settings from the menu. 

4. Select the Integrations tab. 

5. Find the FTP settings and select Add to display the integration settings.

NOTE
Add is only available the first time you set up an integration. After that, Add is
replaced by Change.
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6. Enter the Host details. This can be the domain URL or the IP address of the domain.

7. Enter the number of the web server Port that Paligo should attempt to connect to. The default
port is 21.

8. Check the Use secure TLS/SSL connection box for a secure, encrypted connection between
Paligo and your web server. We recommend that you use a secure connection. But if your
server is not set up for FTPS, you can clear the checkbox and Paligo will use an FTP connection
instead. FTP connections are not secure.

9. Enter the Username for the user account that will be used to access the domain.

NOTE
The user account must have read and write access to the folder that will
receive the content from Paligo.

10. Enter the Password for the user account.

11. In the Destination folder field, enter the directory path for the folder that you want Paligo to
upload content to.
To upload the content directly to the root folder of the domain, leave the Destination folder
field empty.

NOTE
Enter a path like this: "Folder 1/Folder 2/ ".

12. Use the Erase destination folder contents on publish checkbox to control what happens to
any existing content in the destination folder.
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• Check the box if you want Paligo to delete the existing content before it uploads the new
content via FTP/FTPS.

• Clear the box if you want Paligo to leave the existing content in place. When Paligo publishes
via FTP/FTPS, the destination folder will contain the existing content and the new uploaded
content.

13. If you have special characters in your filenames, select the checkbox Enable UTF-8 mode.

IMPORTANT
If you enable UTF-8 mode in Paligo, make sure that it is also enabled on your
destination server.

Do not enable this if you server does not support UTF-8.

14. Select Save.

15. Select the Change button for the FTP integration.

16. Select Test Settings to run a connection test. If the settings are correct, Paligo will show a
green success notification.
If the connection test fails, Paligo shows a red failure notification. Check each connection
setting carefully, to make sure you have not made any mistakes and try again. If the
connection test continues to fail, contact Paligo support for assistance.

Publish Content via FTP
You can publish content from Paligo to your web server via FTP or FTPS. The process is very similar
to "regular" publishing. You create your publication and topics, and set up a layout for the type of
output you want, such as PDF, HTML5, etc. Then you choose the publication settings and publish.
Paligo generates your content and uploads it to your web server.

NOTE
Your browser will also download a zip file of the content. You can keep this as a
local backup.

To publish to your web server, the FTP integration settings [1430] need to be in place. You also
need to have a publication and layout set up to create the output you want, for example, an
HTML5 help center. You can then publish from Paligo to your web server:

1. In Paligo, select the options menu ( ... ) for the publication that you want to publish, and then
select Publish.
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2. On the Publish document dialog, select the type of output you want, for example, HTML5.

3. Choose the layout that you want to use for publishing. The settings in the layout are applied
when Paligo generates the output.

4. Choose the Languages to publish to. If you do not have any translations, you can only select
the original/source language.

5. If you have set filters (Profiling attributes) on topics or elements, and/or have used
variables, choose which values to use for the publication. See Filtering / Profiling [1141] and
Variables [1186] to learn how to use these features.

6. In the Upload output section, check the Upload via FTP box. By default, Paligo will upload
the output to the folder that is specified in the Paligo FTP integration settings.
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You can publish to a different folder if required. Select the Edit icon next to Upload via FTP,
and then select the folder on the Edit dialog. The settings you choose will only be used for this
individual publishing process. Any future publishing will revert back to using the folder that IS
defined in the integration settings.

7. Select Publish document.
Paligo generates the output, applying the settings from the layout and the Publication
document dialog in the process. When the output is created, it is downloaded in your browser
as a zip file. The output contents in the zip file is also published directly to your website via FTP
or FTPS, depending on the FTP integration settings [1430].

Freshdesk Integration
Paligo can publish directly to Freshdesk, so you can use Paligo's powerful authoring features to
create content, while still using your Freshdesk help center to support customers.

Preparation for Freshdesk Integration
Before you can publish from Paligo to Freshdesk you need:

• A Freshdesk account.

• One or more categories with folders in Freshdesk. The content from Paligo will be mapped from
Paligo to a folder in a category.

• A Paligo publication with topics that are organized into a structure that will map to Freshdesk's
Category > Folder > Article structure. To find out more about the required structure, see Map
Content from Paligo to Freshdesk [1441].

TIP
We recommend that you set up a trial account or a draft category so that you can
test your Paligo-to-Freshdesk publications without making the content visible to
your customers. When you know everything is working as you want it to, you can
start publishing to your live help desk knowledge base.

How to Connect Paligo to Freshdesk
To find out how to set up Paligo to connect to Freshdesk see Paligo to Freshdesk [1435].
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Change the Publishing Settings for Freshdesk Integrations
If you want information about changing the publishing settings, see: Freshdesk Layouts [1443].

Paligo to Freshdesk
Paligo can publish directly to Freshdesk, so you can use Paligo's powerful authoring features to
create content, while still using your Freshdesk help center to support customers.

Before you can publish from Paligo to Freshdesk you need:

• A Freshdesk account.

• One or more categories with folders in Freshdesk. The content from Paligo will be mapped from
Paligo to a folder in a category.

• A Paligo publication with topics that are organized into a structure that will map to Freshdesk's
Category > Folder > Article structure. To find out more about the required structure, see Map
Content from Paligo to Freshdesk [1441].

TIP
We recommend that you set up a trial account or a draft category so that you can
test your Paligo-to-Freshdesk publications without making the content visible to
your customers. When you know everything is working as you want it to, you can
start publishing to your live help desk knowledge base.

When you set Paligo to publish to Freshdesk for the first time, there are some extra steps you
need to take, such as setting up an API key and integration. Once these are in place, any further
publications to Freshdesk will be much simpler - you will just publish and choose a Freshdesk
layout.

To set Paligo to publish to Zendesk for the first time complete steps 1-3:

Step 1: Get an API Key and Folder ID in Freshdesk
To connect to Freshdesk, Paligo needs an API key and a folder ID. You can find both of these in
your Freshdesk.

1. Log in to your Freshdesk account.

NOTE
You need to log in via a user account that has administrator permissions.

2. Select your profile to display a menu, and then select Settings.

3. On the Profile Settings page, make a note of the API Key. You will need to enter this key in
Paligo.
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4. Select Solutions, find the Category that you want Paligo to publish to, and then select the
Folder that will contain the content. In Freshdesk, you can add new categories and folders if
needed.

Select Solutions (1), find the Category (2), select a Folder (3).

NOTE
Paligo publishes topics to a folder in Freshdesk. For this reason, you need to
have a folder in place, and not just a category.

5. Select View on Portal (it is near the New Article button). The folder's page will display in the
browser.

6. Make a note of the number at the end of the address in the browser. This is the folder ID and
you will need to enter this in Paligo.
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Next, you will add the API key and folder ID to the Freshdesk integration settings in Paligo.

Step 2: Connect Paligo to Freshdesk
When you have an API key and folder ID from Freshdesk, you can set up an integration in Paligo.
The integration allows Paligo to connect to your Freshdesk and:

• Import content when you first migrate from Freshdesk to Paligo

• Publish content from Paligo to Freshdesk.

1. Log in to Paligo via a user account that has administrator permissions.

2. Select your user name in the top-right corner and select Settings.

3. In the Settings view, select the Integrations tab.

4. In the Freshdesk box, select Add (or Change if an integration has been set up previously).

5. Enter the connection details for your Freshdesk:
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• Your Freshdesk url: Enter the web address of your Freshdesk. Note that the https:// prefix
and .freshdesk.com suffix are already in place.

• API key: Enter the API key into this field. Paligo and Freshdesk use the API key to authorise
the connection.

• Folder ID: Enter the folder ID for the Freshdesk folder. Paligo will copy and transfer the
Paligo content to this folder. To find the folder ID, display the folder in Freshdesk and look at
the URL in the address bar. The URL contains two IDs, one for the category and one for the
folder. You need to use the second ID, which is the ID for the folder.
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6. Select Save and then select Test.
Paligo attempts to connect to Freshdesk. If the connection attempt fails, check the url, API key,
and folder ID carefully for errors.

You have now set Paligo to connect to your Freshdesk. The next step is to publish content to
Freshdesk.

Step 3: Publish your Paligo Content to Freshdesk
To publish your content to Freshdesk.

1. In the Content Manager, display the options menu for the publication that you want to
publish, and select Publish.
To publish to Freshdesk, you have to use a publication. You cannot publish individual topics to
Freshdesk.
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NOTE
If your publication has topics organized into different levels, the top-level
topics will map to a Freshdesk article. The lower-level topics will be
embedded inside their "parent" top-level topic.

2. On the Settings tab, select HTML.

3. Choose the Freshdesk layout that you want your publication to use.
As this is your first time connecting Paligo to Freshdesk, we recommend that you choose the
built-in Freshdesk layout.

4. Choose the Languages to publish to. If you do not have any translations, you can only select
the original/source language.

5. If you have set filters (Profiling attributes) on topics or elements, and/or have used
variables, choose which values to use for the publication. See Filtering / Profiling [1141] and
Variables [1186] to learn how to use these features.

6. Select Publish document.
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Paligo "pushes" the content in the publication to Freshdesk. Your content is mapped to the folder
that matches the Folder ID and new articles are created. Note that Paligo can create new articles,
but it does not delete articles.

NOTE
If you already had content in your Freshdesk, you may get duplicate articles the
first time you publish from Paligo. It is important that you keep the ones Paligo
created. To find out more, see Map Content from Paligo to Freshdesk [1441].

NOTE
If you publish and there are broken cross-reference links, you may be able to
solve this problem by publishing again. To find out more, see Map Content from
Paligo to Freshdesk [1441].

Map Content from Paligo to Freshdesk
When you publish from Paligo top Freshdesk, Paligo will:

• Create new articles in Freshdesk to match the topics in your publication

• Update existing articles in Freshdesk with new content from the matching topics in Paligo.

This process of matching topics to articles and creating or updating them is called "mapping".
In the following sections, you can learn how Paligo maps content to Freshdesk and how to
troubleshoot common issues.

Map to Freshdesk's Category > Folder > Article Structure
Freshdesk content has to be organized into a Category > Folder > Article structure, where the
Category is the type of information being provided, and Folder is for grouping related articles. For
example, you could have a category about "Troubleshooting" and folders for "Connection Issues"
and "Setup Issues". Paligo does not have this strict structure, but it does need to map content to it,
and this is how it is done:

• In Paligo's integration settings, there is a Folder ID. From this, Paligo can find out which
Freshdesk Category and Folder should receive the content from Paligo (see Paligo to
Freshdesk [1435]).

• In your publication structure, you have top-level topics. These are mapped to articles in
Freshdesk.

• If your publication has lower-level topics, these topics are mapped as subsections in the
articles. The heading level of the subsection corresponds to the topic-level in Paligo, so a level 2
topic in Paligo will have a higher heading level than a level 3 topic.
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In the example image shown, the entire publication is mapped to a folder in a category. The top-level
topics, "About ACME Smart Home" and "Quick Setup" are mapped to articles in Freshdesk. The second-
level "Quick Setup Instructions" topic is mapped as a subsection in the "Quick Setup" article. The
third-level "Install Smart Home Software" topic is mapped as a subsection of "Quick Setup Instructions".

When you create a publication [96] to be published to Freshdesk, consider how Paligo maps the
content into the Freshdesk structure. Organize your publication so that your content will map to
folders and articles and give you the structure you want in Freshdesk.

NOTE
You may get duplicate articles when you first publish to Freshdesk. To find out
why this happens and how to resolve it, see Duplicated Articles when you Publish
to Freshdesk [1442].

If you have broken cross-references, see Map Cross-References from Paligo to
Freshdesk [1442].

Duplicated Articles when you Publish to Freshdesk
When you publish to Freshdesk [1444] for the first time, Paligo will "push" all of the topics in a
publication into Freshdesk. There is no mapping with this first publish. Instead, Paligo creates new
articles for the topics. So if you already have those articles in Freshdesk, you will have duplicate
articles.

To solve this problem:

• Delete the articles that were originally created in Freshdesk

• Keep the articles that Paligo created automatically in Freshdesk.

This will leave only the articles that Paligo created for you. Paligo recognizes the articles it created
and so when you next publish to Freshdesk, Paligo can update those articles rather than create
new ones.

Paligo can only update articles that it created. It cannot update articles that were originally created
in Freshdesk. This is because when you publish content from Paligo to Freshdesk for the first
time, Paligo keeps a record of the topics and articles. It uses the record to track the relationships
between the topics in Paligo and the articles it creates in Freshdesk.

Map Cross-References from Paligo to Freshdesk
When you first publish from Paligo to Freshdesk [1444], you may get broken links. This is because
when Paligo creates an article in Freshdesk, if it contains a link, the link will only work if the target
article exists too. But the target article may not have been created yet in the publishing process. If
you have this problem, publishing from Paligo twice should solve it.
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• In the first publish, Paligo will create the articles, but may not be able to resolve all of the links.

• In the second publish, all of the articles will exist in Freshdesk, so Paligo can then resolve the
links.

If you still have problems with broken cross-reference links, contact Paligo support for assistance.

Freshdesk Layouts
To publish content from Paligo to Freshdesk, you will need to use a Freshdesk layout. Think of
layouts as a collection of settings that Paligo will apply to your content when you publish.

For publishing to Freshdesk, Paligo uses Freshdesk Layouts, which are special types of HTML
layout. They are based on the layouts that Paligo uses for Zendesk.

NOTE
A Freshdesk Layout is for defining how Paligo features and content are published
to Freshdesk. They are not used for styling the content in Freshdesk.

To get you started, Paligo includes a built-in Freshdesk layout and you may find that its default
settings are suitable for your requirements.

But you can also create your own Freshdesk layouts.

Create a Freshdesk Layout
Paligo has a built-in Freshdesk layout that you can use for publishing. But if you need to apply
different publishing settings, you can create your own Freshdesk layout, customize it, and use that
instead.

To create a Freshdesk layout:
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1. Select Layout.

2. Select Create New Layout.

3. In the Layout Title field, enter a name for the new layout. Set the Output Format to
Freshdesk and then select OK.

Paligo creates your new Freshdesk layout. If you select it on the Layout page, you can edit its
settings.

The Freshdesk layout has General, Toc and chunking, Classes and attributes, and Verbatim
(code and software) tabs. These settings work in a similar way to those on the HTML5 layout, see
HTML5 Layout Editor Options [680].

IMPORTANT
The Toc and chunking settings do not apply to Freshdesk. When you publish
content to Freshdesk, top-level topics are mapped to articles. Any lower-level
topics are embedded in their "parent" top-level topic.

Publish Content to Freshdesk
Before you can publish from Paligo to Freshdesk you need:

• A Freshdesk account.

• One or more categories with folders in Freshdesk. The content from Paligo will be mapped from
Paligo to a folder in a category.

• A Paligo publication with topics that are organized into a structure that will map to Freshdesk's
Category > Folder > Article structure. To find out more about the required structure, see Map
Content from Paligo to Freshdesk [1441].

TIP
We recommend that you set up a trial account or a draft category so that you can
test your Paligo-to-Freshdesk publications without making the content visible to
your customers. When you know everything is working as you want it to, you can
start publishing to your live help desk knowledge base.

To publish your content to Freshdesk.
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1. In the Content Manager, display the options menu for the publication that you want to
publish, and select Publish.
To publish to Freshdesk, you have to use a publication. You cannot publish individual topics to
Freshdesk.

NOTE
If your publication has topics organized into different levels, the top-level
topics will map to a Freshdesk article. The lower-level topics will be
embedded inside their "parent" top-level topic.

2. On the Settings tab, select HTML.
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3. Choose the Freshdesk layout that you want your publication to use.
As this is your first time connecting Paligo to Freshdesk, we recommend that you choose the
built-in Freshdesk layout.

4. Choose the Languages to publish to. If you do not have any translations, you can only select
the original/source language.

5. If you have set filters (Profiling attributes) on topics or elements, and/or have used
variables, choose which values to use for the publication. See Filtering / Profiling [1141] and
Variables [1186] to learn how to use these features.

6. Select Publish document.

Paligo "pushes" the content in the publication to Freshdesk. Your content is mapped to the folder
that matches the Folder ID and new articles are created. Note that Paligo can create new articles,
but it does not delete articles.
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NOTE
If you already had content in your Freshdesk, you may get duplicate articles the
first time you publish from Paligo. It is important that you keep the ones Paligo
created. To find out more, see Map Content from Paligo to Freshdesk [1441].

NOTE
If you publish and there are broken cross-reference links, you may be able to
solve this problem by publishing again. To find out more, see Map Content from
Paligo to Freshdesk [1441].

GitHub Integration
Abstract

You can upload content directly from Paligo to GitHub. Set up the Paligo to GitHub integration so
that Paligo can connect to GitHub, and then you can publish.

Paligo has Continuous Integration (CI) support for GitHub. This means you can create content
in Paligo, such as PDFs or an HTML help center, and publish it to GitHub. When the content is
uploaded to GitHub, you can unzip it (automatically if you so choose) to make it instantly available
live to your end users.

NOTE
GitHub has a size limit for file uploads, and so is not a good fit for larger
documentation projects, as any files above this limit are blocked. GitHub
documentation states that the limit is 100MB , but for Paligo the limit is 67MB
as the content has to be encoded and compressed. Other systems, such as
BitBucket [1415], do not have the size limit for uploads.

Before you can publish from Paligo to GitHub, you need:

• A GitHub account

• Basic GitHub knowledge and skills, including how to create a repository

• A repository in GitHub. Paligo will upload published output to the repository. The output is
uploaded as a zip file.

To set up Paligo to publish to GitHub:

1. Connect Paligo to GitHub [1448].

2. Publish Content to GitHub [1451].
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This will allow Paligo to publish your output as a zip file to your chosen repository. In GitHub, you
can use a web hook to automate the unzipping of the file, so that you can use the content.

Connect Paligo to GitHub
To set up Paligo to connect to GitHub, you need to have:

• A GitHub account.

• Access to the repository where you want to upload/publish content from Paligo.

• Repository owner username.
If there are multiple users, the repository owner may not be the same user as the GitHub
account.

• A personal access token for the repository. This can be for the user account of the owner of the
repository or a developer who has access. The token must have the following permissions:

• repo:status

• repo_deployment

• public_repo

• repo:invite

• security_events

• write:packages
To find out how to create a personal access token, see the official GitHub help page.

To connect Paligo to GitHub:

1. Log in to Paligo via a user account that has administrator permissions.

2. Select your profile name in the upper right corner to display a menu, and then select Settings.

3. In the Settings view, select the Integrations tab.

4. Find the GitHub settings and select Add.

NOTE
Add is only available the first time you set up an integration. After that, Add is
replaced by Change.

Paligo displays the GitHub integration settings.
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5. Enter the Username for an owner of the GitHub repository.

6. In Github, generate a personal access token (PAT) for your user account and then copy and
paste it into the Personal Access Token field in Paligo.
The personal access token can be for any user account that can access the repository. But it
must have the required permissions.

7. Enter the Repository Owner. Leave this empty if the owner is the same as the Username.
Typically, if there is only one user account, the repository owner is the same as the
Username. But it is possible to have multiple users (developers), in which case, the
Username and Repository Owner could be different user accounts.

8. Enter the Repository Name. This has to match the name given to the repository in GitHub.

9. Choose the Branch that Paligo will upload content to. The first time you set up the integration,
select the branch button, so that Paligo can connect to GitHub using the settings you have
provided. Paligo will detect what branches are available. Then choose the branch from the
dropdown list.

Paligo does not automatically update the integration settings page while it is open. This means
that if you have the integration settings page open, and some new branches are added in
GitHub, those new branches will not appear in the Branch field. But if you select the branch
button, Paligo will update the settings page with the latest branch information.

10. In the Destination folder field, enter the directory path for the folder that you want Paligo to
upload the zip file to. This folder is inside the repository.
For example:
Folder 1/Folder 2/
To upload the zip file directly to the root of the bucket, leave the Destination field empty.

11. Use the Use non-unique file name box to control how Paligo names the output zip file. The
name of the file affects how it is stored in the repository.
If you check the box, Paligo will use the same filename for the output zip each time you
publish. If the repository already contains a file of the same name, the new file will replace the
old one.
Clear the box and Paligo will add a number suffix to each output zip file when you publish. The
repository will contain files for each output.

12. Select Save.
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13. Select the Change button for the GitHub integration.

14. Select Test Settings to run a connection test. If the settings are correct, Paligo will show a
green success notification.
If the connection test fails, Paligo shows a red failure notification. Check each connection
setting carefully, to make sure you have not made any mistakes and try again. If the
connection test continues to fail, contact Paligo support for assistance.

When the connection is made, you can publish content from Paligo to a GitHub repository [1451].

Publish Content to GitHub
You can publish content from Paligo to GitHub, and the process is very similar to "regular"
publishing. You create your publication and topics, and set up a layout for the type of output
you want, such as PDF, HTML5, etc. Then you choose the publication settings and Paligo creates a
zip file that contains your output content. The zip file is downloaded in your browser and it is also
uploaded to your chosen GitHub repository.

NOTE
You can use a GitHub webhook to automatically unzip the contents.

To publish to GitHub, the integration settings need to be in place so that Paligo can connect
to GitHub and knows which branch and directory to publish to. You will also need to have a
publication and layout set up to create the output you want, for example, an HTML5 help center.
With these in place, you can publish from Paligo to GitHub:

1. In Paligo, select the options menu ( ... ) for the publication that you want to publish, and then
select Publish.

Paligo Documentation

1451



2. On the Publish document dialog, select the type of output you want, for example, HTML5.

3. Choose the layout that you want to use for publishing. The settings in the layout are applied
when Paligo generates the output.

4. Choose the Languages to publish to. If you do not have any translations, you can only select
the original/source language.

5. If you have set filters (Profiling attributes) on topics or elements, and/or have used
variables, choose which values to use for the publication. See Filtering / Profiling [1141] and
Variables [1186] to learn how to use these features.

6. In the Upload output section, check the Upload to GitHub box. By default, Paligo will upload
the output to the repository and folder that are specified in the Paligo to GitHub integration
settings.
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You can publish to a different branch and/or folder if required. Select the Edit icon next to
Upload to GitHub, and then select the branch and/or folder on the Edit dialog.

The settings you choose will only be used for this individual publishing process. Any future
publishing will revert back to using the branch and folder that are defined in the integration
settings.

7. Select Publish document.
Paligo generates the output, applying the settings from the layout and the Publication
document dialog in the process. When the output is created, it is downloaded in your browser
as a zip file. The zip file is also uploaded to your chosen repository branch and folder in
GitHub.
In GitHub, you can use a web hook to automate the unzipping of the file, so that it is published
live to end users.

Gitlab Integration
Abstract

You can upload content directly from Paligo to Gitlab. Set up the Paligo-to-Gitlab integration so
that Paligo can connect to Gitlab, and then you can publish to a Gitlab project.

Paligo has Continuous Integration (CI) support for Gitlab. This means you can create content in
Paligo, such as a PDF or an HTML help center, and publish it to Gitlab. The content is uploaded to
Gitlab as a zip file.
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NOTE
Paligo cannot upload files that are larger than the Max Push Size limit that is set
in Gitlab. You can find information on how to change the Max Push Size limit in
the official Gitlab documentation.

Before you can connect Paligo to Gitlab, you need:

• Basic Gitlab skills, including how to set up a project.

• A Gitlab account, set up to have a personal access token (PAT). The PAT must have the api
permission.
To learn how to create a personal access key, see the official Gitlab documentation.

• A project in your Gitlab account. The project will receive the content you publish in Paligo.
To learn how to create a project, see the official Gitlab documentation.

You can then Connect Paligo to Gitlab [1454] and Publish Content to Gitlab [1457].

Connect Paligo to Gitlab
To connect Paligo to Gitlab:

1. Log in to Paligo via a user account that has administrator permissions.

2. Select your profile name in the upper right corner to display a menu, and then select Settings.

3. In the Settings view, select the Integrations tab.

4. Find the Gitlab settings and select Add.
The Add button is only shown if there are no settings currently in place. If there are settings in
place, there is a Change button instead.
Paligo displays the Gitlab integration settings.

Paligo Documentation

1454

https://docs.gitlab.com/ee/user/admin_area/settings/account_and_limit_settings.html#max-push-size
https://docs.gitlab.com/ee/user/profile/personal_access_tokens.html#create-a-personal-access-token
https://docs.gitlab.com/ee/user/project/working_with_projects.html#create-a-project


5. Enter the Project ID.
This is a unique identifier that Gitlab assigns to your project. You can find it on the project's
page in Gitlab.

6. In Gitlab, generate a personal access token (PAT) for your user account and then copy and
paste it into the Personal Access Token field in Paligo.
To learn how to create a personal access key, see the official Gitlab documentation.

NOTE
When you create a personal access key, you can only see and copy the key
when you first create it. After that, it is unavailable, so when you create it,
copy and paste it into Paligo while you still have the settings open in Gitlab.
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NOTE
The personal access token can be for any user account that can access the
repository. But it must have the api permission.

7. Choose the Branch that Paligo will upload content to. The first time you set up the integration,
select the branch button, so that Paligo can connect to Gitlab using the settings you have
provided. Paligo will detect what branches are available. Then choose the branch from the
dropdown list.

If you have the integration settings open, and some new branches are added in Gitlab, those
new branches will not appear in the Branch field. But if you select the branch button, Paligo
will update the integration settings with the latest branch information.

8. In the Destination folder field, enter the directory path for the folder that you want Paligo to
upload the zip file to. This folder is inside the repository.
For example:
Folder 1/Folder 2/
To upload the zip file directly to the root, leave the Destination field empty.

9. Use the Use non-unique file name box to control how Paligo names the output zip file. The
name of the file affects how it is stored in the repository.
If you check the box, Paligo will use the same filename for the output zip each time you
publish. If the repository already contains a file of the same name, the new file will replace the
old one.
Clear the box and Paligo will add a number suffix to each output zip file when you publish. The
repository will contain files for each output.

10. Select Save.

11. Select the Change button for the Gitlab integration.

12. Select Test Settings to run a connection test. If the settings are correct, Paligo will show a
green success notification.
If the connection test fails, Paligo shows a red failure notification. Check each connection
setting carefully, to make sure you have not made any mistakes and try again. If the
connection test continues to fail, contact Paligo support for assistance.

When the connection is made, you can publish content from Paligo to a Gitlab repository. [1457]
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Publish Content to Gitlab
To publish from Paligo directly to Gitlab, you need:

• A publication or topic (ready to publish) in Paligo

• A suitable layout for publishing, for example, an HTML5 help center layout (see Create a
Layout [1059])

• The Paligo-to-Gitlab integration settings in place (see Connect Paligo to Gitlab [1454]).

With these in place, you can publish your content in Paligo and it will be uploaded to a Gitlab
repository automatically.

1. In Paligo, select the options menu ( ... ) for the publication that you want to publish, and then
select Publish.

2. On the Publish document dialog, select the type of output you want, for example, HTML5.

3. Choose the layout that you want to use for publishing. The settings in the layout are applied
when Paligo generates the output.

4. Choose the Languages to publish to. If you do not have any translations, you can only select
the original/source language.

5. If you have set filters (Profiling attributes) on topics or elements, and/or have used
variables, choose which values to use for the publication. See Filtering / Profiling [1141] and
Variables [1186] to learn how to use these features.

6. In the Upload output section, check the Upload to Gitlab box. By default, Paligo will upload
the output to the repository and folder that are specified in the Paligo to Gitlab integration
settings.

Paligo Documentation

1457



You can publish to a different branch and/or folder if required. Select the Edit icon next to
Upload to Gitlab, and then select the branch and/or folder in the Gitlab dialog.

The settings you choose will only be used for this individual publishing process. Any future
publishing will revert back to using the branch and folder that are defined in the integration
settings.

7. Select Publish document.
Paligo generates the output, applying the settings from the layout and the Publication
document dialog in the process. When the output is created, it is uploaded to your chosen
repository branch and folder in Gitlab.

Intercom Integration
Intercom is a third-party service that provides chat features for websites. If you have an Intercom
account, you can set up a chat widget and get it to display on your Paligo HTML5 help site. For
example, you could have a Paligo help center website and use Intercom chat to direct users.

Preparations for Intercom Integration
To set up Paligo to connect to Intercom, you need:

• Intercom account

• Intercom Application ID (refer to the official Intercom documentation for information on how to
find the app ID).

• Paligo HTML5 layout. This needs to be set up to Connect Paligo to Intercom [1458].

Connect Paligo to Intercom
To set up the Paligo-Intercom integration so that you can use Intercom chat with your HTML5
output:

1. Select Layout and then either select an existing layout to open it in the Layout Editor or create
a new layout [1059].
The Intercom integration is only available on HTML5 layouts.

2. Select Analytics and other integrations.
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3. Enable the Use cookie consent popup by setting it to Opt-out. This will help your site to
comply with regulations relating to the use of cookies, such as GDPR in the EU. The Paligo-
Intercom integration uses cookies (see the Intercom help center for details).

NOTE
You can also enable the cookie consent by setting it to Info, but this only
displays information about cookies. It does not give the user the ability to
reject cookies, which may be a regulatory requirement in some regions.

4. Enter the Intercom App ID in the Intercom chat field.

5. Select Save.

When you use this layout to publish your content, Paligo will include the Intercom chat ID in the
output. You can then host the Paligo output on a web server and use Intercom to set up the chat
features that you want to be added to the documentation site. To learn how to set up Intercom,
see the official Intercom documentation.

Mixpanel Integration
Mixpanel is a product analytics tool that can help you monitor user activity on your HTML Paligo
outputs. It provides data about visits to your documentation site and can be useful for identifying
trends, such as high numbers of customers looking for help on certain subjects.

Preparations for Mixpanel Integration
To use Mixpanel with Paligo, you need:

• A Mixpanel account

• A Mixpanel project token. This is a key that you can find in the Implementation Options section
when you first set up a Mixpanel project.
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• A Paligo HTML5 layout, such as the HTML5 help center, see Create a Layout [1059].

• To host your Paligo HTML5 on a web server so that it is available on the internet and can be
monitored by Mixpanel.

When you have these, you can Connect Paligo to Mixpanel [1460].

Connect Paligo to Mixpanel
To set up the Paligo-Mixpanel integration so that you can use Mixpanel to monitor your HTML5
output:

1. Select Layout and then either select an existing layout to open it in the Layout Editor or create
a new layout [1059].
The Mixpanel integration is only available on HTML5 layouts.

2. Select Analytics and other integrations.

3. Enable the Use cookie consent popup by setting it to Opt-out. This will help your site to
comply with regulations relating to the use of cookies, such as GDPR in the EU. The Paligo-
Mixpanel integration uses cookies.

NOTE
You can also enable the cookie consent by setting it to Info, but this only
displays information about cookies. It does not give the user the ability to
reject cookies, which may be a regulatory requirement in some regions.

4. Enter the Mixpanel project token in the Mixpanel tracking field.

5. If you want Mixpanel to track when the user scrolls down the page to read subsections, enable
the Mixpanel track hash tag in URL option. Disable it if you only want to track top-level
sections.

6. Select Save.
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7. This step only applies if you enabled the Mixpanel hash tag in URL feature in step 5.
Select General in the categories on the left and then enable the Update URL on Scroll option.
This tells Paligo to change the URL of the page when a user scrolls down to a subsection.
Mixpanel can then track the change to the URL.

8. Select Save.

When you use this layout to publish your content, Paligo will include the Mixpanel project token in
the output. This will allow Mixpanel to find and monitor your HTML5 documentation site when you
host your output on a webserver and make it available online.

NOTE
If a visitor to your documentation website opts out of tracking cookies, their visit
is not included in the unique visitors data in Mixpanel.

MS Teams Integration
Abstract

Do you use Microsoft Teams? With the Paligo-MS Teams integration, you can get your Paligo
notifications in MS Teams too. Paligo can send notifications to a Team channel of your choice.

With Paligo's Microsoft Teams integration, you can get all of your Paligo notifications to appear
in your Teams channels too. So if you use MS Teams, you can get all of your messages and
notifications in one place.

The Paligo-MS Teams integration is available on the business plan. You can use it to:

• Choose how often you receive Paligo notifications in MS Teams.

• Send Paligo event notifications to a team channel of your choice. We call these activity feed
notifications, as they are the same as the messages that appear in the activity feed on the Paligo
dashboard.
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MS Teams Activity Feed Notifications
Paligo can send activity feed notifications to a public team channel in MS Teams via a webhook
channel. These notifications can be seen by anyone who has access to the channel. This is the
same type of information that is shown in the Activity Feed on your Dashboard [42] in Paligo. To
enable this, you need to make Preparations for MS Teams Integration [1462] and Connect Paligo
to MS Teams [1463].

NOTE
You will only get activity feed notifications if your Paligo-to-MS Teams integration
has been set up to receive them. To find out more, see Connect Paligo to MS
Teams [1463].

Activity feed notifications are for system events such as:

• Document created

• Document title changed

• Assignment started

• Release status changed

• Snapshot created.

To see activity feed notifications in MS Teams, expand the Team and then select the team channel.
The activity feed notifications from Paligo should be listed. They contain information about the
event and the user responsible for the event, and also a link to take you to the appropriate place
in Paligo.

TIP
To change the channel that receives activity feed notifications or the filters that
control what activity feed notifications are sent by Paligo, see Change the Channel
and Filters for MS Teams Notifications [1465]

Preparations for MS Teams Integration
To set up Paligo to send notifications to MS Teams, you need:
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• A Paligo user account that has Administrator permissions.

• MS Teams with at least one team set up with one or more channels

• A Microsoft user account for each person who will use your MS Teams.

When you are sure you have these in place, you can Connect Paligo to MS Teams [1463].

Connect Paligo to MS Teams
MS Teams Activity Feed Notifications [1462] are system events, such as a topic being renamed. To
enable Paligo to send activity feed notifications to MS Teams, you have to establish a webhook
channel between them.

1. Make sure the prerequisites are in place [1461].

2. In Microsoft Teams, select the options menu ( ... ) for the channel that will receive
notifications from Paligo. Select the Connectors option.

NOTE
You can choose a public or private channel, as for channel notifications only,
you will use the webhook connection. It allows notifications to be sent to
private channels (but can only be used for activity feed notifications).

3. Add the Incoming Webhook connector and then give it a name and a logo (the logo is
optional). The name can be anything, for example, "Paligo".

4. Select Create to add the webhook connector. MS Teams then provides a URL.

5. Copy the URL and select Done.

6. Log in to Paligo via a user account that has admin permissions.

7. Select your profile name in the upper right corner to display a menu, and then select Settings.

8. Select the Integrations tab and then find the MS Teams section and select Add.

NOTE
If Paligo has already been set up to connect to MS Teams, you will only see a
Change option.

9. Set the Connection Type to Webhook.
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10. Check the Send activity feed notifications to a Teams channel box.

11. Use the Filters to choose which activity feed notifications Paligo will send. There are two
settings - one for choosing the users you are interested in, and one for choosing the types of
events. Check the boxes for the users and events that you want to get notifications for in MS
Teams.

If you do not want to receive MS Teams notifications about particular users or events, clear
their checkboxes.

12. Paste the URL from MS Teams into the Incoming webhook URL field.

13. Select Save.

NOTE
That's it, it is all set up and ready to go. Next, you should Test the MS Teams
Notifications [1464].

Test the MS Teams Notifications
When you have set up the Paligo to Microsoft Teams integration, you can perform a test to check
that Paligo's notifications are appearing in MS Teams.

To test that your activity feed notifications are working, do something that generates an activity
feed notification, such as create or rename a topic. Paligo should send a notification to the channel
you specified in the Paligo-MS Teams integration settings.
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The notification appears in the channel feed and comes from the webhook connector that you
set up. In the image above, it shows notifications sent to the "Documentation" channel. The
notifications come from a webhook connector called "Paligo".

If your activity feed notifications are not coming through, check that you have:

• Set up the webhook correctly in MS Teams (if using the webhook connection type in Paligo).

• The MS Teams integration settings in Paligo are correct and the Send activity feed to a Teams
channel is checked.

• The MS Teams integration settings filters allow Paligo to send a notification for the type of event
that you created.

• Performed an action that causes an activity feed notification to be created. To find out more, see
MS Teams Activity Feed Notifications [1462].

NOTE
If those are correct and you still cannot get activity feed notifications in MS Teams,
contact support for assistance.

Change the Channel and Filters for MS Teams Notifications
You can change the settings in Paligo so that it:

• Sends activity feed notifications to a different channel

• Sends activity feed notifications for different users or events

To make these changes:

1. Log in to Paligo via a user account that has administrator permissions.

2. Select your profile in the upper right corner to display a menu, and then select Settings.
Select the Integrations tab, find the MS Teams settings and select Change.
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3. Check the Send Activity Feed notifications to a Teams channel box and enter the Channel
name. This is the channel that will receive the activity feed notifications in MS Teams. It has to
be exactly the same as the channel name in MS Teams.

4. Use the Filters to choose which activity feed notifications Paligo will send. There are two
settings - one for choosing the users you are interested in, and one for choosing the types of
events. Check the boxes for the users and events that you want to get notifications for in MS
Teams.

NOTE
If you do not want to receive MS Teams notifications about particular users or
events, clear their checkboxe

5. Select Save.

6. Test the MS Teams Notifications [1464].

Netlify Integration
Abstract

You can upload content directly from Paligo to Netlify. Set up the Paligo-to-Netlify integration so
that Paligo can connect to Netlify, and then you can publish to a Netlify project

Paligo supports direct publishing to Netlify, the web hosting platform. This means you can create
HTML5 content in Paligo, such as an HTML5 help center, and publish it directly to Netlify. The
integration only supports HTML5 outputs.
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Before you can connect Paligo to Netlify, you need a Netlify account with a personal access token
(PAT). To learn how to create a personal access key, see the official Netlify documentation.

You also need a Site ID. We explain how to get the Site ID in First-Time Publish To Netlify [1467].

First-Time Publish To Netlify
To connect Paligo to Netlify, you need to have a site set up in Netlify so that you can get the Site ID.
If you are publishing to Netlify for the first time, you have three options (in Netlify):

• Import an existing project from Git

• Start from a Netlify template

• Deploy manually

We recommend that you deploy manually to create the site for your Paligo publication. To do this,
follow these instructions:

1. In Paligo, create the publication that you want to publish to Netlify.

2. Publish it as a regular output, using an appropriate layout. For example, publish it as an
HTML5 help center using an HTML5 help center layout. To find out how to publish, see
Publishing Process [1068].
When you publish, you will get a zip file that downloads in your browser.

3. In Netlify, go to your Sites and choose to Add a new site. Select the deploy manually option
and then drag-and-drop your Paligo output zip file into Netlify.
Netlify will upload and process the zip file and create a new site for you. It is given an
automatically generated name, but you can change that in Netlify if needed.

4. Select the site and view its Site Settings.

In the Site information, there is a Site ID. Copy the Site ID as you will need it when you set up
the Paligo integration.

Now that you have a site and Site ID, you can set up Paligo to connect to Netlify [1468]. When that
connection is made, you will be able to publish directly from Paligo to Netlify and will not have to
drag-and-drop zip files anymore.
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Connect Paligo to Netlify
To connect Paligo to Netlify:

1. Log in to Paligo via a user account that has administrator permissions.

2. Select your profile name in the upper right corner to display a menu, and then select Settings.

3. In the Settings view, select the Integrations tab.

4. Find the Netlify settings and select Add.
The Add button is only shown if there are no settings currently in place. If there are settings in
place, there is a Change button instead.
Paligo displays the Netlify integration settings.

5. In Netlify, generate a personal access token (PAT) for your user account and then copy and
paste it into the Personal Access Token field in Paligo.
To learn how to create a personal access key, see the official Netlify documentation.

NOTE
When you create a personal access key, you can only see and copy the key
when you first create it. After that, it is unavailable, so when you create it,
copy it, and paste into Paligo while you still have the settings open in Netlify.

6. Enter the Site ID.
The Site ID defines the location that will receive the content from Paligo. You can find it in
Sites > Site overview > Site settings in Netlify.
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NOTE
The Site ID you enter here is used as the default when publishing from Paligo
to Netlify. You can choose a different Site ID when you publish, if needed (see
Publish Content to Netlify [1469]).

7. Select Save.

8. Select the Change button for the Netlify integration.

9. Select Test Settings to run a connection test. If the settings are correct, Paligo will show a
green success notification.
If the connection test fails, Paligo shows a red failure notification. Check each connection
setting carefully, to make sure you have not made any mistakes and try again. If the
connection test continues to fail, contact Paligo support for assistance.

When the connection is made, you can Publish Content to Netlify [1469].

Publish Content to Netlify
To publish from Paligo directly to Netlify, you need:

• A publication or topic (ready to publish) in Paligo

• A suitable layout for publishing, for example, an HTML5 help center layout (see Create a
Layout [1059])

• The Paligo to Netlify integration settings in place (see First-Time Publish To Netlify [1467] and
Connect Paligo to Netlify [1468]).

With these in place, you can publish your content in Paligo and it will be uploaded to a Netlify site
automatically.

1. In Paligo, select the options menu ( ... ) for the publication that you want to publish, and then
select Publish.
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2. On the Publish document dialog, select an HTML5 output.

3. Choose the layout that you want to use for publishing. The settings in the layout are applied
when Paligo generates the output.

4. Choose the Languages to publish to. If you do not have any translations, you can only select
the original/source language.

5. If you have set filters (Profiling attributes) on topics or elements, and/or have used
variables, choose which values to use for the publication. See Filtering / Profiling [1141] and
Variables [1186] to learn how to use these features.

6. In the Upload output section, check the Upload to Netlify box. By default, Paligo will upload
the output to the site that is specified in the Paligo to Netlify integration settings.

You can publish to a different site if required. Select the Edit icon next to Upload to Netlify,
and then enter the Site ID in the Netlify dialog. You can find the Site ID in the site settings in
Netlify.

The settings you choose will only be used for this individual publishing process. Any future
publishing will revert back to using the site that is defined in the integration settings.

7. Select Publish document.
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Paligo generates the output, applying the settings from the layout and the Publication
document dialog in the process. When the output is created, it is uploaded to your chosen
site in Netlify.

Paligo REST API
Abstract

Developers can use the Paligo API to get external applications to interact with Paligo remotely. The
Paligo API allows applications to list and update content, start publishing and import processes
remotely, and more.

The Paligo API is a public interface that provides access to several of Paligo's core features.
Developers can use it to get external applications to interact with Paligo, for example, they can use
it to automatically publish an output every day.

Developers can find information on the Paligo API, including details of its endpoints etc, in the
Paligo API Documentation. It contains the information that developers need when programming
external applications to interact with Paligo.

If you need to create an API key so that Paligo can recognize an external application, see API
Keys [1472].

Main Areas Accessed through the Paligo API
The following list shows the main areas that you can access through the Paligo API and the actions
that can be performed.

• Folders

• List folders

• Create new folders

• Documents
Documents applies to topics, publications, and the "forks" in publications.

• List documents (shows metadata and XML content)

• Update a document's name

• Edit a document's XML content remotely (through the Paligo API).

• Images

• List images

• Upload new images

• Replace an existing image with a different image.

• Publishing settings

• List the existing saved publishing settings.

• Productions

• Start a new publication process (a "production")

• List the recent productions

• Download the output from a recent production.

• Imports

• List recent imports

• Start a new import.
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API Keys
Developers can use the Paligo API to allow other applications to interact with Paligo. For this to
work, you need to generate an API key for each external application that will connect with Paligo.
Paligo uses the API keys to recognize the external applications.

To Create an API Key [1472], use the API Keys settings in My Profile. You can also Remove an API
Key [1473].

NOTE
Only Paligo admin users can create or remove an API key. Also, as a Paligo admin
user, you can only access the API keys you have created. You cannot access API
keys created by other users.

Create an API Key

1. Select the avatar in the top right corner. 

2. Select My Profile. 

3. Select the API Keys tab.

4. Select Create New Key.

Paligo displays the Create API Key dialog.

5. Enter a Name for the key. We recommend that you give the key a descriptive name so that it
is easy for other users to identify what application the key is for.
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6. Select the refresh button on the Token field to generate the key token.

NOTE
This is the only time you will see the key in full.

7. Copy and paste the key somewhere that is secure. You can copy the token to your computer's
clipboard by selecting the copy icon to the left of the refresh button.

8. Select Create.

9. In your application, find the settings that allow you to connect to other applications, such as
Paligo. Set up the connection to Paligo and when you need to enter the key, copy and paste it
from the secure location in step 6.
Your app should now be able to connect to Paligo.

Remove an API Key
If you have API keys that are not needed anymore, you can remove them from Paligo. When you
remove a key, external applications will be unable to connect to Paligo using that key (as Paligo will
not recognize the key).

1. Select the avatar in the top right corner. 

2. Select My Profile. 

3. Select the API Keys tab.

4. Find the API key that you want to remove. Make sure that you have the correct API key and
then select Remove.
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API Access
Licenses share permissions between the API and UI (user interface). This means that if a license
type has access to publish, but not to edit content, it will have the same functionality access in the
API. This means that they will have access to publish through the API, but not to edit documents.

Custom licenses can be configured for Enterprise Plan and depending on what access is
configured for them, it will determine what they have access to through the API.

The following table describes what users have access to the API:

User group syntax Description API access License type

paligo.admin Use this value if the user should belong to the group of
Paligo administrators.

Administrators are top-level users that have access to all
Paligo features, including those for adding and changing
user accounts, manage languages and integrations in the
Settings page [1817].

Full authoring experience. Can use the main Paligo
Editor [51] and its advanced features that are
needed for creating, publishing and managing content,
including content reuse, filtering and variables. Create
Assignments [1240], Manual Snapshot [1631] and change
to any workflow status in the Resource View [68].

Can use both Review View [41] and Edit View [42] to
change content, add content and Create Snapshots [1330]
in Contributor Editor [41].

Can access the Translation View [79] and translation
features. These include translation assignments, translation
import and export. Also the ability to change workflow
status to In translation and In translation review in the
Resource View [68].

Full access Admin license

paligo.user Use this value if the user should belong to the group of
Paligo authors (standard users).

Authors (Standard users) are Paligo writers.

Full authoring experience. Can use the main Paligo
Editor [51] and its advanced features that are
needed for creating, publishing and managing content,
including content reuse, filtering and variables.Create
Assignments [1240], Manual Snapshot [1631] and change
to any workflow status in the Resource View [68].

Can use both Review View [41] and Edit View [42] to
change content, add content and Create Snapshots [1330]
in Contributor Editor [41].

Can access the Translation View [79] and translation
features. These include translation assignments, translation
import and export. Also the ability to change workflow
status to In translation and In translation review in the
Resource View [68].

Full access Author
license
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User group syntax Description API access License type

paligo.contributor Use this value if the user should belong to the group of
Paligo contributors.

Contributors are users who, besides reviewing content,
may also need to add or edit content, such as engineers
or subject matter experts (SME).

They can use both the Edit View [42] and Review View [41].
Both Reviewers and Contributors can be sent Review
assignments, the difference is that Contributors can switch
to Edit View [42]. That enables them to edit and add
information and also to Create Snapshots [1330].

No access Contributor
license

paligo.reviewer Use this value if the user should belong to the group of
Paligo reviewers.

Reviewers are users who need to read content and leave
feedback comments on it, but do not change the content in
anyway. They have access to Review View [41].

No access Reviewer
license

paligo.itadmin Use this value if the user should belong to the group of
Paligo IT admins.

IT managers have access to the Settings page [1817] and
can create users. Can set up integrations, languages and
the general settings of the Paligo instance.

No access IT admin
license

IMPORTANT
Custom licenses are available on the Enterprise plan. These offer some ability to configure what
features users have access to. For more information about what options are available to you, contact
your account manager.

Access to API, depends on license configuration.

Salesforce Knowledge Integration
You can use Paligo's powerful authoring features to create content that can be published directly
to Salesforce Knowledge. When you publish, the topics in your Paligo publication are mapped to
articles in Salesforce Knowledge. You can then set up a Salesforce Digital Experience, where you
can present your articles to your readers.

TIP
We recommend that you set up a generic user in Salesforce for the Paligo
integration. This user will then still be available for use if people leave your
organization.

Preparation for Salesforce Integration
Before you can publish to Salesforce Knowledge, you need:

• Paligo Enterprise plan or Business plan with Salesforce integration as an add-on
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• Salesforce Enterprise plan or above. Alternatively, a different plan with "Web services API"
purchased as an add-on from Salesforce.

To find out more on how to:

• Connect and change the publishing settings that Paligo uses for "pushing" content to Salesforce,
see Connect Paligo to Salesforce Knowledge [1476].

• Present the articles in your Salesforce Digital Experience and Help Center Theme [1488]. The
Help Center theme is a popular choice for technical publications.

NOTE
The Paligo / Salesforce integration is designed for the Salesforce "Lightning
Experience" interface.

Connect Paligo to Salesforce Knowledge
To connect Paligo to Salesforce, there are several steps you need to make. We have separated
these into stages to make it easier to follow. You should also make sure you are familiar with
theSize Limitations in Salesforce [1484].

NOTE

• Salesforce integration is available on the Enterprise plan.

• The integration is made for the Salesforce - Lightning Experience interface.

• The integration requires the Salesforce Web Services API feature. This
is included in the Salesforce Enterprise plan or above, or you can
purchase Web services API as an add-on from Salesforce.

Stage 1: Get the User Credentials and Security Token
To connect to Salesforce, Paligo needs various details, including the user credentials and a security
token. To get the credentials and security token, it can be easier to switch from Salesforce's
Lightning Experience interface to the Classic interface.

Using the Classic interface:

1. Make sure the "Permission API" is enabled in your Salesforce account. This is normally
enabled by default, but if not, you can set it under Setup at Users > Profiles.

2. Get the user credentials for Salesforce that you want to use to connect the integration.

NOTE
We recommend that you create a separate user for this purpose. This can be
especially important so that you are not dependent on a single user that may
leave your company.
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3. Get the security token. You may have received this when you created your Salesforce account.
But if you don't have it, you can generate a new one:

a. In Salesforce, select your profile in the top-right corner.

b. Choose Settings.

c. In the Quick find field, search for "token" and then select Reset Security Token. A new
security token is sent to you by email.

You will need the user credentials and security token in stage 4, when you add the integration
settings in Paligo.

Next, you need to set up the API field.

Stage 2: Get the Content API Field Name
You need to get an API field name as this is another setting that is needed for the Paligo-to-
Salesforce integration.

1. Go to Setup in Salesforce.

2. Search for Object Manager in the quick find, and select it.

3. In the Object Manager, select Knowledge.

4. Create a Rich Text Field.

a. Select Fields and Relationships.

b. Select New.

c. Select Text Area (Rich).

d. Select Next.

e. Fill out the fields:
(You can choose a different name if you want to)

f. Select Next.

g. Leave the next screen as is by default. Select Next.

h. On the next screen, uncheck all boxes. We will add this field to a new Article type/Page
layout later.

i. Select Save.

5. If you do not have an existing Page Layout you want to publish to, you can create a new one.
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6. Select Save.

7. Drag your Rich Text field to the Knowledge Detail area:

8. Create a new record type:

a. Select Record Types in the left menu of the Object Manager.

b. Select New.

c. Fill in the fields something like below, but again you can choose your name:

d. If you want to enable it for everyone, check all the boxes. You also need to make it the
default record type for Paligo to be able to publish to it.

9. Select Next.

10. Select the Page Layout you want to use.
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11. Select Save.

12. Get the API field content for the Paligo settings:

a. Select Fields & Relationships.

b. Find your Rich Text field and make a note of the field name. You will need the field name
when you add the integration settings in Paligo.

• In Salesforce, the article was removed and then restored

• The API indicates that the article has been deleted when, in fact, it is still there.

Next, you need to create a connected app in Salesforce.

Stage 3: Create a Connected App in Salesforce
To connect Paligo to Salesforce, you need to have a connected app in Salesforce.

1. Go to Setup.

2. Enter "app" in the Quick Find box and select App Manager. (In Salesforce Classic, select Apps
under Build & Create).
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3. Create a New Connected App

4. Enter a name for the app, for example, Paligo . The API name is filled in automatically.

5. Enter a contact email address.

6. Select Enable OAuth Settings.

7. In the Callback URL field, enter https://login.salesforce.com/services/oauth2/
callback.

8. In the list of Available OAuth Scopes, add Full Access (full) to the Selected OAuth Scopes

9. Select Save.

It takes up to 10 minutes before the app is ready to be used in Salesforce.

10. Make a note of the Consumer Key and Consumer Secret as you will need to add these to the
integration settings in Paligo.

Next, you can add the salesforce integration details to Paligo.

Stage 4: Add Salesforce Integration Details to Paligo
When you have completed stages 1-3 inclusive in Salesforce, you can add the integration details to
Paligo.
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The draft articles in Salesforce will appear to be very basic. To make them more visually appealing,
you can set up Salesforce to publish the articles to a Salesforce Community that uses a help center
theme.

NOTE
The " Lightning experience" view in Salesforce may be a bit inconsistent in how
draft articles show or not. If you do not see them in that view, switch to "Classic
mode" and choose to view draft articles.

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select the Integrations tab. 

4. Select Add or Change for the Salesforce integration.

5. Add the Username and Password that you got from Salesforce.
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6. Add the security Token from Salesforce.

7. Add the Consumer Key and Consumer Secret.

8. Add the rich text field name in the Content field API name field.

9. Choose whether you want Paligo to publish content as Draft or Published articles in
Salesforce.

10. Use the Custom link prefix field to customize any cross-references.

• Only use this field if your articles in Salesforce are not located directly in the root of your
instance.
For example, leave the Custom link prefix field empty if the URL for your articles is
my-instance.force.com/<name of article>. Paligo will publish your cross-references
correctly by default.

• Enter the syntax in the Custom link prefix field if the URL if your articles has one or more
extra directories between the instance and the article.
For example, if the URL for your articles is 'my-instance.force.com/sa/<name of article>, enter
my-instance.force.com/sa/ in the Custom link prefix field.
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NOTE
Paligo will use the custom link prefix automatically each time you publish
from Paligo to Salesforce. But it can be overridden by another custom link
prefix that you can enter in the publishing settings, see Publish to Salesforce
Knowledge [1484].

11. Check the SEO links box to update the URL name field in Salesforce to match the topic titles
and make them SEO friendly.

This setting controls the global default, but it is also possible to override this in the publish
dialog and in saved publish settings.

NOTE
There are certain characters that are not allowed in Salesforce URL names.
If any such characters are used, they will be filtered out when SEO links are
created. Paligo will then ignore this setting and return to using default UUID.

12. Check the Smart restore box to make Paligo automatically remap the content to the article in
Salesforce.
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IMPORTANT
Only check the box if the Salesforce publish log contains the error:

The URL Name cannot match the draft or published version \
of any other article

This error can occur if mapping between Paligo content and Salesforce
articles is broken if:

• In Salesforce, the article was removed and then restored

• The API indicates that the article has been deleted when, in fact, it is still
there.

Clear the checkbox once the link issues are solved.

13. Select Save.

14. Publish a publication to Salesforce to test the integration.

TIP
If you have access to the Salesforce sandbox environment, you can choose to
publish to your sandbox instead.

Size Limitations in Salesforce
Salesforce enforces some size limitations that it's important to be aware of.

• Images can not be larger than 1 MB. In general, it is of course good to reduce the size of images,
but in Salesforce, the publishing will not go through at all if there is an image larger than this
limit.

• Each article can not be larger than 130 KB (in terms of plain text, excluding images).
It can of course be difficult to know exactly how large your output articles will be, but as an
indication, 130 KB is quite a lot of text and would make for a very long article.

NOTE
If Salesforce displays an error relating to the article size, and your article is 130
KB or less, it is likely due to size limits that are set in Salesforce. Please refer to
Salesforce's documentation for details on how to change the limits.

Paligo content is "pushed" into a single field in Salesforce.

Publish to Salesforce Knowledge
To publish Paligo content to Salesforce, you must first Connect Paligo to Salesforce
Knowledge [1476]. When the integration settings are in place, you can publish a Paligo publication
to Salesforce. The topics in the publication become articles in Salesforce.

The publication process has two parts.
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1. Set up the mapping so that your Paligo topics become suitably sized articles in Salesforce.

2. Publish your publication to get Paligo to "push" content into Salesforce.

NOTE
Publishing to Salesforce sends Paligo content into Salesforce articles. You
will need to use Salesforce to control how the articles are presented, see
Salesforce Digital Experience and Help Center Theme [1488].

Map Paligo Topics to Salesforce Articles
Salesforce Knowledge has a flat, single-level structure. This is different to Paligo, as Paligo has
a hierarchical structure where you can have topics at multiple levels in a publication's "table of
contents".

In Paligo a publication can have topics at multiple levels, to create a hierarchical structure.

In Salesforce, articles can only be at one level. So Paligo content is mapped like this: each top-level
topic and all of its subtopics become an article. For example, using the "Mars Travel Manual"
structure shown above, the "The Mission Control Center" topic and all of its subtopics become a
single article in Salesforce.

You will need to consider the mapping before you publish to Salesforce. If you have very large
sections in your publication, with many levels of topics, it is likely that these will become very large
articles in Salesforce. Large articles are not very easy for people to use, and Salesforce also has
strict limitations on the file size of each article. To find out more about the file size restrictions, see
Connect Paligo to Salesforce Knowledge [1476].

To avoid large articles, you can rearrange the publication hierarchy. To do this, we recommend
that you first make a copy of the publication or make a branch of it. This means you can keep the
original version for use with other outputs, such as PDF or HTML5. Then you can rearrange the
copy or branch to create a version for publishing to Salesforce.

Typically, the easiest way to create suitably sized articles is to move the lower-level topics up in the
hierarchy, so that there are more top-level topics. For example, if we use the "Mars Travel Manual"
example again, you could reduce the file sizes by moving the "Controls System" and "Control
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Room" topics to the top-level. At that level, they become individual articles rather than sections in
the "The Mission Control Center" article.

Publish Paligo Content to Salesforce

NOTE
Only publications can be published to Salesforce, not individual topics.

To publish Paligo content to Salesforce:

1. Set up the integration according to Connect Paligo to Salesforce Knowledge [1476].

2. Map your publication and topics to produce appropriately sized articles in Salesforce, see Map
Paligo Topics to Salesforce Articles [1485].

3. Select the Dotted menu (...) for the topic or publication in Content Manager [34].

4. Select Publish. 

Paligo displays the Publish document dialog.
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5. Select the HTML output and choose Salesforce Knowledge.

6. Use the Salesforce link prefix field to customize any cross-references. You should only use
this field if your articles in Salesforce are not located directly in the root of your instance.
For example, if the URL for your articles is 'my-instance.force.com/<name of article>', leave
the Salesforce link prefix field empty. Paligo will publish your cross-references correctly by
default.
If the URL for your articles has one or more extra directories between the instance and the
article, enter the syntax in the Salesforce link prefix field. For example, if the URL for your
articles is 'my-instance.force.com/sa/<name of article>, enter my-instance.force.com/sa/ in the
Salesforce link prefix field.

NOTE
The Salesforce integration settings also have a link prefix setting, but the
Salesforce link prefix in the publishing settings takes priority.

The possible combinations and results are:

• Integration settings has no link entry, publishing settings has no link entry.
Result: Cross-references use the syntax <salesforce instance>/<article>

• Integration settings has link entry, publishing settings has no link entry.
Result: Cross-references use the syntax defined in the integration settings.

• Integration settings has link entry, publishing settings has link entry. Result:
Cross-references use the syntax defined in the publishing settings.

• Integration settings has no link entry, publishing settings has link entry.
Result: Cross-references use the syntax defined in the publishing settings.
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7. Select any languages, filters (profiles) and variables you want to use for your content.

8. Select Publish document to publish your content.

When the publishing is done, go to your Salesforce account and check the results.

NOTE
If Salesforce displays an error relating to the article size, and your article is 130
KB or less, it is likely due to size limits that are set in Salesforce. Please refer to
Salesforce's documentation for details on how to change the limits.

Paligo can publish topics of up to 130 KB and content is "pushed" into a single
field in Salesforce.

NOTE
You can set the look and feel of the articles in Salesforce. Typically, this is done
by setting up a Salesforce Digital Experience and Help Center Theme [1488] and
using Cascading StyleSheets (CSS) to style the content there.

TIP
It is often easiest to manage articles in the Salesforce Classic mode. You can find
the published articles by selecting to view all tabs (the plus sign at the top-right),
and then select Article Management.

Salesforce Digital Experience and Help Center Theme
When you first publish from Paligo to Salesforce [1484], the topics in your publication are mapped
to new articles in Salesforce Knowledge. The articles are drafts and are added to Salesforce's
"library" of articles. At this stage, you are not presenting the articles to your readers, you are only
creating a collection of articles. For the presentation, you should create a Digital Experience in
Salesforce. The Digital Experience is where you present your Salesforce articles to your readers.

To create a Salesforce Digital Experience and map your articles to it, you can refer to the
Salesforce documentation and support. To help you, we will explain the basic process of what
you need to do. We will also explain some of the terminology as Salesforce uses some terms that
we also use in Paligo, but in different ways.

For example, here is a Digital Experience that uses a Help Center theme to present articles.
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Example of Salesforce Digital Experience using Help Center theme.

Stage 1: Use Data Categories to Categorize your Articles
In Salesforce, every article has to be associated with one or more Data Categories. A Data Category
can represent anything, but the idea is that it categorizes a collection of articles, typically by
subject matter. The idea is that a Data Category groups together articles that are about the same
subject matter. For example, if your publication is about a product called ACME 100, you could
create a Data Category called ACME 100. If you use taxonomy tags in Paligo, the general idea of
Data Categories is similar - you are making a collection of articles about a particular subject.

Stage 2: Associate your Articles with Data Categories
Before you can display your articles in a Salesforce Digital Experience, you need to associate them
with one or more Data Categories via Article Management in Salesforce.

Stage 3: Create a Digital Experience with a Theme
In Salesforce, a Digital Experience is where you present your articles to your audience. Each Digital
Experience has a theme that defines the look and feel of your published articles, and there is a
"Help Center" theme that is especially suited for technical communication and documentation.

Stage 4: Use Topics to Organize your Articles
In Salesforce, a topic is a "container" that loosely represents a category of information. When
you add your topics to the Community, they have to be associated with a topic. For example,
the following example is a demo help center. In the bottom section, there are two subheadings
"Mars travel" and "ACME Software". These are both topics in Salesforce. Below the "Mars travel"
subheading is a list of links to articles. These are the articles that are associated with the "Mars
travel" topic. The links below the "ACME Software" subheading are for the articles that are
associated with the "ACME Software" topic.

Try not to confuse Paligo topics with Salesforce topics as they are completely different things.
Paligo topics are turned into articles in Salesforce. The topics in Salesforce are more like "Chapter"
or "Section" headings in a document.

To use topics to organize your topics, you first need to create the topics and then associate them
with Data Categories. Your help center articles will be organized like this:

• Your articles are associated with one or more Data Categories.
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• You have topics to represent each "collection" of articles. Each topic is associated with a Data
Category.

So the articles are associated with Data Categories, and the Data Categories are associated with
Topics.

On the help center portal:

• There is a heading for each topic (1).

• Below each topic heading is a list of links to articles (2). These are the articles that are associated
with the Data Category that is set for the topic.

ServiceNow Integration
With Paligo's ServiceNow integration, you can publish content you create in Paligo directly to your
ServiceNow help center. So you can use Paligo's powerful authoring features for content creation,
and use your ServiceNow help center to present that content to your customers.

Your Paligo topics are "mapped" to become articles in ServiceNow. The way this is done varies,
depending on whether you choose to publish to a category or directly to the root of a ServiceNow
knowledge base. But in both cases, Paligo will create an article for each top-level Paligo topic.

You can find out more in Publish Content to ServiceNow [1493] and there are also examples to
show you how the mapping works.

Preparation for ServiceNow Integration
To publish from Paligo to ServiceNow, you will need:

• ServiceNow account

• ServiceNow user account that has these roles:
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• knowledge

• knowledge_admin

• knowledge_manager

• content_admin (this role is needed to be able to apply Paligo CSS file to uploaded articles).

• To have set up OAuth 2.0 in ServiceNow (only if you want Paligo to log in via OAuth 2.0).

• Paligo user account with admin permissions. You need admin permissions to access the
integration settings, see User Accounts [1833].

• Paligo publication with content to be published to ServiceNow.

• ServiceNow Knowledge layout in Paligo. You can use the built-in ServiceNow Knowledge layout
or Create a Layout [1059] based on the default ServiceNow Knowledge layout..

TIP
You can find out how to create a user account, apply user roles and set up OAuth
2.0 in ServiceNow's own documentation.

Connect Paligo to ServiceNow
To connect Paligo to ServiceNow, you need to have set up a user account with the appropriate
roles in ServiceNow. For details, see the prerequisites in ServiceNow Integration [1490].

When you have a suitable ServiceNow user account, you can set up Paligo to connect to
ServiceNow.

NOTE
Paligo can log in to ServiceNow using OAuth 2.0. If you want to use this more
secure form of logging in, you must first set up OAuth 2.0 in ServiceNow. You can
find out how to do that in ServiceNow's documentation.

1. Log in to your ServiceNow. This is only required if your ServiceNow has not been used for
some time and has entered "hibernation". By logging in, you end the hibernation period.
Paligo cannot connect to ServiceNow if it is in hibernation.

2. Log in to Paligo via a user account that has administrator permissions.

3. Select your profile name in the upper right corner to display a menu, and then select Settings.

4. In the Settings view, select the Integrations tab.

5. Find the ServiceNow settings and select Add.

NOTE
Add is only available the first time you set up an integration. After that, Add is
replaced by Change.

Paligo displays the ServiceNow integration settings:
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6. Enter the URL for your ServiceNow subdomain. If you are copying and pasting the URL into the
field, note that the https:// prefix and .service-now.com suffix are already included, so you will
need to remove those from your entry.

7. Select the Authentication type. You can choose from:

• Basic
This is a simple login where Paligo logs in to ServiceNowby providing the Username and
Password for a ServiceNow user account. This is less secure than OAuth 2.0 as it requires
the user credentials to be provided each time.
If you choose Basic, continue from step 8.

• OAuth 2.0
OAuth 2.0 can improve system security by reducing the amount of times user credentials
have to be provided. To use OAuth 2.0, you will need to set it up in ServiceNow first, and
then enter a Client ID, Client secret, and an Access Token in Paligo.
If you choose OAuth 2.0, ignore step 8 and continue from step 9.

8. If you chose the Basic authentication, enter the Username and Password for a ServiceNow
user account. Paligo will use these credentials to log in to ServiceNow when publishing.

Ignore step 9 and continue from step 10.

9. If you chose the OAuth 2.0 authentication, enter the Client ID and Client secret. These are
generated in ServiceNow when you set up OAuth 2.0. You also need an Access Token, which
you can generate in Paligo.
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To generate an Access Token in Paligo, select the New button at the right of the Access
Token field. If you do not currently have an Access Token or the existing token has
expired, Paligo prompts you to enter the Basic ServiceNow login credentials (Username and
Password ). These must be for a ServiceNow user account that has the required roles.

By default, the access token expires after 30 minutes. But if you check the Remember me
box, Paligo will be able to automatically renew the token during a 100 day period. These times
can be changed in ServiceNow's OAuth 2.0 settings.
Select Get token to generate the access token.

10. Set the Default Knowledge Base. This is the ServiceNow knowledgebase that Paligo will
publish to, by default. You can choose from any of the ServiceNow knowledgebases that
Paligo has detected, and you can update the list by selecting the button at the right of the
field.

11. Set the status for articles that Paligo publishes to ServiceNow. Choose from:

• Published - The Paligo content is used as "live" published articles in ServiceNow.

• Draft - The Paligo content is stored as draft articles. These are not publicly available
in ServiceNow. They will only be shown to your readers when you change them to the
Published status (in ServiceNow).

12. Select Save.

To test your Paligo to ServiceNow connection, access the ServiceNow integration settings again
and select the Test Settings button. Paligo runs the test and displays a success or failure message.
If the connection fails, check that the information you have provided is correct and also that your
ServiceNow is not in hibernation. If you still have problems, contact Paligo support for assistance.

When the Paligo to ServiceNow connection is successful, you can Publish Content to
ServiceNow [1493].

Publish Content to ServiceNow
To publish content from Paligo to ServiceNow, you first need to set up the Paligo to ServiceNow
connection [1491]. With that in place, you can publish your Paligo content so that it appears in
your ServiceNow knowledge base.
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NOTE
ServiceNow only allows Paligo to publish categories in alphabetical order or
numerical order. This means that the order of categories is unlikely to match the
order of the top-level topics in your Paligo publication. One possible work around
is to number your top-level topics.

1. Edit the MS Word layout.

2. Select HTML as the output format.

3. Select a ServiceNow Knowledge layout. You can use the built-in ServiceNow Knowledge
layout or you can create a new one [1059] (based on the built-in one).

NOTE
ServiceNow Knowledge layouts are a type of HTML layout and may contain
settings that are not used for ServiceNow, but are relevant to other HTML
outputs, such as Zendesk.

4. Choose the ServiceNow Knowledge Base that will receive your selected Paligo content.

5. Choose the ServiceNow category that will receive your Paligo content. This is optional - you
do not have to publish to a category.
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When you publish to the selected category, Paligo will create a subcategory for each top-level
topic in the publication. Inside each subcategory, it will create articles for the topics (see
Example 73, “Publishing to a ServiceNow Category” [1496]).

NOTE
We recommend that you use categories to group your articles in ServiceNow,
and then publish to a category from Paligo. This helps to make sure your
articles are organized logically, and are easier for readers to find.

If you do not choose a category, Paligo will publish directly to the root of the selected
knowledge base. It will create a category for each top-level topic in your publication, and
then articles inside those categories (see Example 74, “Publishing to a ServiceNow Knowledge
Base (no Category selected)” [1497]). If you publish a large amount of content in this way, your
ServiceNow articles can become disorganized and more difficult to use.

6. If you want to add some basic styles to your content check the Use Paligo CSS box.

This gives each piece of content that you publish from Paligo a reference to a Paligo stylesheet
(CSS). The Paligo CSS contains styling rules to give your articles appropriate font sizes, spacing
etc.

TIP
You can set all of your ServiceNow content (including articles that were not
created in Paligo) to use the Paligo CSS. To do this, in ServiceNow, edit the
HTML of the articles and add the reference to the Paligo CSS file. Similarly,
you could also edit the articles Paligo creates and add a link to a CSS that you
already have in ServiceNow.

7. Choose the Languages to publish to. If you do not have any translations, you can only select
the original/source language.

8. If you have set filters (Profiling attributes) on topics or elements, and/or have used
variables, choose which values to use for the publication. See Filtering / Profiling [1141] and
Variables [1186] to learn how to use these features.

9. You can use the Upload output settings to upload a zip of the content you are publishing to a
repository, for example, GitHub. To find out more, see the integrations documentation for the
type of repository you want to use.

10. Use the Optional parameters to choose whether Paligo will save the output zip file in
Paligo, send you a notification when the publication is complete, and generate a log file for
debugging.

11. If you think you will need to use these same settings again, select Save Settings. Enter a name
for the saved settings and select OK. These settings are then stored in the Saved Settings tab,
so that the next time you publish, you can select the settings profile from there instead of
having to re-enter the settings again.
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12. Select Publish Document.
Paligo applies the publishing settings to your content (variables, filters, etc), generates the
HTML, and "pushes" it to ServiceNow. Your topics are now articles in ServiceNow.

NOTE
If you have cross-references between different categories, you will need
to publish your content twice. This is because when you first publish, the
topic with the link (the "source") may link to an article that has not been
published yet (the "target"). So the link does not work. Links between articles
in different categories will only work if the "target" exists in ServiceNow when
the "source" is published.

Example 73. Publishing to a ServiceNow Category

Let's say you have an "IT" knowledge base in ServiceNow. It has a Category called "Learning".

In Paligo, you have a publication with "Getting Started" as a top-level topic and "Installation",
"Backups", and "Performance Test" as second-level topics. There is a single "Engineering Test"
third-level topic, and two fourth-level topics: "Fan Speed Test" and "Cooling Test". They are
organized in a hierarchy like this:

• Getting Started (publication)

• Installation

• Backups

• Performance Test

• Engineering Test

• Fan Speed Test

• Cooling Test

You publish to ServiceNow and choose "IT" as the knowledge base and "Learning" as the category.
In ServiceNow, you will get:

• IT (knowledge base)

• Learning (category)

• Installation (subcategory)

• Installation (article)

• Backups (subcategory)

• Backups (article)

• Performance Test (subcategory)

• Performance Test (article)
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• Engineering Test (article)

The fourth-level "Fan Speed Test" and "Cooling Test" topics become subsections inside the
"Engineering Test" article.

Example 74. Publishing to a ServiceNow Knowledge Base (no Category
selected)

Let's say you have an "IT" knowledge base in ServiceNow.

In Paligo, you have a publication with "Getting Started" as a top-level topic and "Installation",
"Backups", and "Performance Test" as second-level topics. There is a single "Engineering Test"
third-level topic, and two fourth-level topics: "Fan Speed Test" and "Cooling Test". They are
organized in a hierarchy like this:

• Getting Started (publication)

• Installation

• Backups

• Performance Test

• Engineering Test

• Fan Speed Test

• Cooling Test

You publish to ServiceNow and choose "IT" as the knowledge base. You do not select a category. In
ServiceNow, you will get:

• IT (knowledge base)

• Installation (category)

• Installation (article)

• Backups (category)

• Backups (article)

• Performance Test (category)

• Performance Test (article)

• Engineering Test (article)

The fourth-level "Fan Speed Test" and "Cooling Test" topics become subsections inside the
"Engineering Test" article.

Single Sign On (SSO) and SAML Integration
If you are on the Enterprise plan, you can connect Paligo to a Single Sign On (SSO) service. It
means that you can use your SSO provider to handle all the company's user accounts (create, edit
and delete) and permissions (assign and remove) in one place and allow users to log in to several
systems with a single ID.

This has many benefits, including:

• Reduced administration time - You can manage all software-as-a-service (SaaS) user accounts
from a single SSO service. This is especially useful in larger organizations where the workforce
regularly changes due to people joining, moving departments, leaving and retiring.
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• Easier access - Users can log in to applications without entering their username and password
each time.

• Security - With centralized user accounts, you can apply security measures to all users, such as
password strength, multi-factor authentication and more.

TIP
To find out about setting your SSO service to connect to Paligo, see Set Up
Your SSO Service [1501]. That topic is a general overview of what you need to
set up for SSO. We also have more detailed instructions for Okta [1504] and
JumpCloud [1510] integrations.

How SSO Works - The Basics
To use SSO with Paligo, you first need to set up your SSO service to connect to Paligo . The key
things here are that the SSO service is able to authenticate a Paligo user's user account, password,
and user group.

When your SSO service is set up to connect to Paligo, the log-in process for users is:

1. User opens Paligo in a browser and selects a Sign in button. They do not need to enter a user
name or password.

2. Paligo redirects to the SSO service for the user's log-in details.

3. The SSO service responds to Paligo:
If the user is signed-in to the SSO service already, the SSO service provides Paligo with the
user's username, password, and user group. The user is logged in to Paligo automatically.
If the user is not signed-in to the SSO service, Paligo redirects them to the SSO service sign-in.
When they sign-in, Paligo can log them in automatically.

You can also manage your user accounts in the SSO service. If you add a new user to a Paligo
user group in the SSO service, Paligo will create these new users automatically (when a new user
attempts to log in to Paligo).

NOTE
To delete a Paligo user, log in to Paligo as an administrator user and delete the
user account manually. SSO services are not designed to delete user accounts.
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Connect Paligo to your SSO Service
Before you connect Paligo to your SSO service, you should set up your SSO service [1501] so that
it can provide user authentication data to Paligo. As part of the set up, you will export a metadata
file that you will be able to import into Paligo.

When the SSO service is set up, you can connect Paligo to it.

In Paligo:

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select the Integrations tab. 

4. Select Add in the SAML 2.0 section to expand the connection settings.

5. Enter the Provider Name, a display name for the SSO service, for example, Okta or
JumpCloud.

6. Select Upload metadata file and upload the metadata file that you exported from the SSO
service when it was set up.

7. In most cases, you should be able to ignore the Advanced Settings section. These settings
are filled automatically, as the values come from the SAML XML file you uploaded in the
previous step. If, for some reason, the settings need to be added or changed, you can make
the changes manually.
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• Entity ID - The identifier for your SAML endpoint. This is sometimes called the identity
provider issuer.

• SSL Certificate - The secure socket layer (SSL) certificate for the SSO service.

• Single Signon Service URL - The address of the single sign-on service.

• Single Signout Service URL - The address of the single sign-out service, if used. When this is
used, logging out of Paligo logs the user out of the SSO service as well, not just Paligo. This is
empty if the feature is not used.

8. Check the Enable sign-in alternative checkbox so that users can sign in to Paligo manually as
well with SSO. This is important the first time you set up SSO, as if there is an error, you will
need to be able to log in to Paligo without SSO to fix it.

9. Check the Enable SSO box to activate single-sign in.

NOTE
If you want to store the settings without activating SSO, clear this checkbox.
You can return to this page and enable SSO later if needed.

10. Select Save.

11. Log out of Paligo.

CAUTION
Do not log out of Paligo if the Enable sign-in alternative setting is not
checked and you have not yet tested SSO. Logging out could result in you
being unable to log in to Paligo.

12. Log back in again. You should now see an SSO sign in option that, when selected, logs you
into Paligo.
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NOTE
If you do not see the SSO sign in option or if the SSO sign-in attempt is
unsuccessful, log in with your username and password and check that you
have completed the steps described in this topic correctly.

Usually, failed SSO sign-ins are due to incorrect configuration in the SSO
service. Please make sure that you have entered the correct URLs and have
set the correct attributes for firstname, lastname and email.

The most common error is that the user group is incorrectly set up in the SSO
service. The SSO service has to be able to provide Paligo with the username,
email, and usergroup metadata. For more information on the SSO service
settings, see Set Up Your SSO Service [1501].

13. Once SSO works as expected, enter the SAML 2.0 settings.

14. Clear the checkbox for Enable sign-in alternative.
If this option is disabled the users can no longer use username and password to login. They
have to use SSO to log in.

15. Select Save.

Set Up Your SSO Service
To use an SSO service with Paligo, the SSO service has to be configured to communicate with
Paligo using SAML. Typically, this configuration work is performed by IT specialists who have an
in-depth understanding of the SSO service.

There are many different SSO services available and the terminology and settings they use can
vary between vendors. This means we cannot provide a detailed set of general instructions that
will work for all SSO services. But the main principles are the same, and most SSO services do
require similar types of information (see below).

NOTE
We do provide more detailed instructions for Okta [1504] and JumpCloud [1510].

Connect an SSO Service to Paligo
The general instructions for connecting an SSO service to Paligo.

In your SSO provider:

1. Create one user account for each Paligo user account.

2. Create a custom SAML 2.0 application.

3. Configure the SAML 2.0 application. The terminology used for the settings can vary, but you
will need to:

a. Set the Assertion Consumer Service (ACS) URL for Paligo, the endpoint where the SSO
service provider connects to Paligo.
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Use this URL: https://your.paligoapp.com/saml/acs.paligoapp.com/saml/acs.
Replace your with the domain name of your Paligo instance, for example: https://
acme.paligoapp.com/saml/acs

b. Set the Service Provider (SP) URL for Paligo.
Use this URL: https://your.paligoapp.com/saml/metadata. Replace
your.paligoapp.com with the domain name of your Paligo instance.

c. Set the application user name or ID to: email

d. Create attribute mapping for Paligo's user credentials:

• user.firstname

• user.lastname

• user.email

NOTE
There may be additional settings required, depending on your SSO
Service.

e. Map them to the equivalent attributes in your SSO service. Refer to your SSO service
documentation for information on those.

4. Create a group attribute for Paligo. Depending on the SSO service you are using, this should
have the name / value paligo.usergroup or paligo_usergroup.

5. Export the SSO service's metadata file so that you can import it into Paligo.

6. Create a user group for each Paligo user group. This step is required in some SSO services,
whereas with others, you can add the user group name to the user settings.
In Paligo, every user account belongs to a user group, such as administrators, authors,
contributors, reviewers, publishers, it admins or translation managers. When users log in to Paligo
using SSO, Paligo needs the SSO service to provide the user group information (as well as the
first name, last name and email). User groups are not included in the default metadata, so you
need to add them in your SSO service.
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User group
syntax

Description API access License
type

paligo.admin Use this value if the user should belong to the group of
Paligo administrators.

Administrators are top-level users that have access
to all Paligo features, including those for adding
and changing user accounts, manage languages and
integrations in the Settings page [1817].

Full authoring experience. Can use the main Paligo
Editor [51] and its advanced features that are
needed for creating, publishing and managing content,
including content reuse, filtering and variables. Create
Assignments [1240], Manual Snapshot [1631] and
change to any workflow status in the Resource View [68].

Can use both Review View [41] and Edit View [42]
to change content, add content and Create
Snapshots [1330] in Contributor Editor [41].

Can access the Translation View [79] and translation
features. These include translation assignments,
translation import and export. Also the ability to change
workflow status to In translation and In translation review
in the Resource View [68].

Full access Admin
license

paligo.user Use this value if the user should belong to the group of
Paligo authors (standard users).

Authors (Standard users) are Paligo writers.

Full authoring experience. Can use the main Paligo
Editor [51] and its advanced features that are
needed for creating, publishing and managing content,
including content reuse, filtering and variables.Create
Assignments [1240], Manual Snapshot [1631] and
change to any workflow status in the Resource View [68].

Can use both Review View [41] and Edit View [42]
to change content, add content and Create
Snapshots [1330] in Contributor Editor [41].

Can access the Translation View [79] and translation
features. These include translation assignments,
translation import and export. Also the ability to change
workflow status to In translation and In translation review
in the Resource View [68].

Full access Author
license

paligo.contributor Use this value if the user should belong to the group of
Paligo contributors.

Contributors are users who, besides reviewing content,
may also need to add or edit content, such as engineers
or subject matter experts (SME).

They can use both the Edit View [42] and Review
View [41]. Both Reviewers and Contributors can be sent
Review assignments, the difference is that Contributors
can switch to Edit View [42]. That enables them
to edit and add information and also to Create
Snapshots [1330].

No access Contributor
license
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User group
syntax

Description API access License
type

paligo.reviewer Use this value if the user should belong to the group of
Paligo reviewers.

Reviewers are users who need to read content and
leave feedback comments on it, but do not change the
content in anyway. They have access to Review View [41].

No access Reviewer
license

paligo.itadmin Use this value if the user should belong to the group of
Paligo IT admins.

IT managers have access to the Settings page [1817]
and can create users. Can set up integrations, languages
and the general settings of the Paligo instance.

No access IT admin
license

IMPORTANT
Custom licenses are available on the Enterprise plan. These offer some ability to configure what
features users have access to. For more information about what options are available to you,
contact your account manager.

Access to API, depends on license configuration.

7. Associate each user account with the appropriate user group.

8. Associate each user group with the SAML 2.0 application that you have created to represent
Paligo.

9. In Paligo, use the SSO integration settings to Connect Paligo to your SSO Service [1499].

Integration with Okta
You can connect Paligo to Okta for single sign on (SSO). This is only available on the Enterprise
plan.

To use Okta with Paligo, you need to set up Okta to provide metadata to Paligo. The metadata
includes the name of the user, the user's email address, and the user group that the user belongs
to.

NOTE
The metadata describing the user group is not part of the standard metadata. You
must add this metadata to the SAML response.

To be able to Connect Paligo to your SSO Service [1499] you need to set up Okta to integrate with
Paligo.

NOTE
For this section, we assume that you have already created your user accounts in
Okta.
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Create a New Application Connector for Paligo in Okta
The first stage of setting up Okta to communicate with Paligo is to create a new application
connector.

In Okta:

1. Locate your applications and select Add application and then Create New App.

2. Apply the following settings for your new application:

• Platform - set to Web

• Sign on method - set to SAML 2.0

3. Select Create.

4. In the General settings, enter Paligo as the App name and then select Next.

5. Define the SAML settings.
In the General section, enter the following (replace my.paligoapp.com with your Paligo
instance name, for example: acme.paligoapp.com).

Setting Value

Single sign on URL https://my.paligoapp.com/saml/acs

Audience URL https://my.paligoapp.com/saml/metadata

Default RelayState https://my.paligoapp.com

Application username Choose email

6. In the Attribute statements section, add the following attributes:

Name Name format Value

user.firstname Basic user.firstName

user.lastname Basic user.lastName
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Name Name format Value

user.email Basic user.email

paligo.usergroup Basic appuser.paligo_usergroup

Your settings should look like this:

7. Select Next.

The next stage in Okta is to Add the User Group to the Okta SAML Response [1506].

Add the User Group to the Okta SAML Response
When users login to Paligo via Okta, Okta sends metadata to Paligo. The metadata includes the
user's first name, last name, email address, and information about which user group they belong
to.

The user group metadata is not a standard part of the Okta default metadata. So you need to add
the user group to the metadata SAML assertion:

1. Select Directory > Profile Editor.

2. Select the Profile button for the Paligo app.

3. Select Add attribute and enter the details for the Paligo user group.
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Setting Value

Display name Paligo user group

Variable name paligo_usergroup

Description Optional. You can leave this blank or add a description to explain the purpose of the user group
attribute.

Data type string

Attribute length Between. You do not need to define a min and max value, leave those fields empty.

Attribute required Check Yes.

Scope Check the User personal box if you want to assign the user group attribute (for Paligo) to user
accounts individually.

If you clear the User personal box, the user group attribute (for Paligo) will apply to all user
accounts in the Okta user group. Please refer to Okta documentation for more information.

4. Save the attribute.

Next: Assign the Users to Paligo and a Paligo User Group [1507] .

Assign the Users to Paligo and a Paligo User Group
Each user that is going to use Okta to access Paligo needs to be assigned to the Paligo application
and a Paligo user group.

In Okta:
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1. Select Directory > People and then select a user account.

2. On the Applications tab, select Assign Applications.

3. Select Assign for the Paligo application.

4. In the Paligo user group field, enter the appropriate syntax for the user's role in Paligo. The
following table shows the possible values you can use:

User group
syntax

Description API access License
type

paligo.admin Use this value if the user should belong to the group of
Paligo administrators.

Administrators are top-level users that have access
to all Paligo features, including those for adding
and changing user accounts, manage languages and
integrations in the Settings page [1817].

Full authoring experience. Can use the main Paligo
Editor [51] and its advanced features that are
needed for creating, publishing and managing content,
including content reuse, filtering and variables. Create
Assignments [1240], Manual Snapshot [1631] and
change to any workflow status in the Resource View [68].

Can use both Review View [41] and Edit View [42]
to change content, add content and Create
Snapshots [1330] in Contributor Editor [41].

Can access the Translation View [79] and translation
features. These include translation assignments,
translation import and export. Also the ability to change
workflow status to In translation and In translation review
in the Resource View [68].

Full access Admin
license

paligo.user Use this value if the user should belong to the group of
Paligo authors (standard users).

Authors (Standard users) are Paligo writers.

Full authoring experience. Can use the main Paligo
Editor [51] and its advanced features that are
needed for creating, publishing and managing content,
including content reuse, filtering and variables.Create
Assignments [1240], Manual Snapshot [1631] and
change to any workflow status in the Resource View [68].

Can use both Review View [41] and Edit View [42]
to change content, add content and Create
Snapshots [1330] in Contributor Editor [41].

Can access the Translation View [79] and translation
features. These include translation assignments,
translation import and export. Also the ability to change
workflow status to In translation and In translation review
in the Resource View [68].

Full access Author
license
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User group
syntax

Description API access License
type

paligo.contributor Use this value if the user should belong to the group of
Paligo contributors.

Contributors are users who, besides reviewing content,
may also need to add or edit content, such as engineers
or subject matter experts (SME).

They can use both the Edit View [42] and Review
View [41]. Both Reviewers and Contributors can be sent
Review assignments, the difference is that Contributors
can switch to Edit View [42]. That enables them
to edit and add information and also to Create
Snapshots [1330].

No access Contributor
license

paligo.reviewer Use this value if the user should belong to the group of
Paligo reviewers.

Reviewers are users who need to read content and
leave feedback comments on it, but do not change the
content in anyway. They have access to Review View [41].

No access Reviewer
license

paligo.itadmin Use this value if the user should belong to the group of
Paligo IT admins.

IT managers have access to the Settings page [1817]
and can create users. Can set up integrations, languages
and the general settings of the Paligo instance.

No access IT admin
license

IMPORTANT
Custom licenses are available on the Enterprise plan. These offer some ability to configure what
features users have access to. For more information about what options are available to you,
contact your account manager.

Access to API, depends on license configuration.

5. Save the user.

6. Repeat this process for each user account that is going to have access to Paligo via Okta.

NOTE
Next: Get the Metadata from Okta [1509].

Get the Metadata from Okta
The final steps to take in Okta are to get the metadata file that is needed for the connection.

In Okta:

1. Select Applications > Applications.

2. Select Sign On.
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3. Right-click on the Identity Provider Metadata link and choose to save the link as a file. Give
the file a name and an .xml extension, for example, metadata.xml. You will need this XML
when you set up the Paligo integration.

You have now completed the configuration that is needed in Okta. The next step is to Connect
Paligo to your SSO Service [1499].

Integration with JumpCloud
You can connect Paligo to JumpCloud (https://www.jumpcloud.com) for single sign on (SSO). This is
only available on the Enterprise plan.

To use JumpCloud with Paligo, you need to set up JumpCloud to provide metadata to Paligo. The
metadata includes the name of the user, the user's email address, and the user group that the
user belongs to. The metadata describing the user group is not part of standard metadata. You
must add this metadata to the SAML response.

NOTE
For this section, we assume that you have already created your user accounts in
JumpCloud.

To be able to Connect Paligo to your SSO Service [1499] you need to set up JumpCloud to integrate
with Paligo.

Create a New Application Connector for Paligo in JumpCloud
The first stage of setting up JumpCloud to communicate with Paligo is to create a new application
connector.

In JumpCloud:

1. Go to the JumpCloud console and select SSO and then add an application.

2. Select Custom SAML App.

3. In the Settings panel, apply these values (replace the your in your.paligoapp.com with the
address of your Paligo instance, for example, acme.paligoapp.com).

Name Value

Display Label Paligo (example)

IDP Entity ID paligo/jumpcloud/sso

SP Entity ID https://your.paligoapp.com/saml/metadata

ACS URL https://your.paligoapp.com/saml/acs

Samlsubject NameID email

Samlsubject NameID Format urn:oasis:names:tc:SAML:1.1:nameid-format:emailAddress
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Name Value

Signature algorithm RSA-SHA256

Attributes

Create attributes for:

user.firstname firstname

user.lastname lastname

user.email email

Groups Attributes

Include Group Attribute Checked. This option must be checked/enabled.

Groups Attribute Name paligo.usergroup

4. Select Save.

Next, you need to Create User Groups in JumpCloud [1511] .

Create User Groups in JumpCloud
You should create one user group for each Paligo user group (administrators, authors, contributors,
reviewers, publishers, it admins or translation managers) in JumpCloud.

1. Select Groups.

2. Create a user group for each Paligo user group.
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User group
syntax

Description API access License
type

paligo.admin Use this value if the user should belong to the group of
Paligo administrators.

Administrators are top-level users that have access
to all Paligo features, including those for adding
and changing user accounts, manage languages and
integrations in the Settings page [1817].

Full authoring experience. Can use the main Paligo
Editor [51] and its advanced features that are
needed for creating, publishing and managing content,
including content reuse, filtering and variables. Create
Assignments [1240], Manual Snapshot [1631] and
change to any workflow status in the Resource View [68].

Can use both Review View [41] and Edit View [42]
to change content, add content and Create
Snapshots [1330] in Contributor Editor [41].

Can access the Translation View [79] and translation
features. These include translation assignments,
translation import and export. Also the ability to change
workflow status to In translation and In translation review
in the Resource View [68].

Full access Admin
license

paligo.user Use this value if the user should belong to the group of
Paligo authors (standard users).

Authors (Standard users) are Paligo writers.

Full authoring experience. Can use the main Paligo
Editor [51] and its advanced features that are
needed for creating, publishing and managing content,
including content reuse, filtering and variables.Create
Assignments [1240], Manual Snapshot [1631] and
change to any workflow status in the Resource View [68].

Can use both Review View [41] and Edit View [42]
to change content, add content and Create
Snapshots [1330] in Contributor Editor [41].

Can access the Translation View [79] and translation
features. These include translation assignments,
translation import and export. Also the ability to change
workflow status to In translation and In translation review
in the Resource View [68].

Full access Author
license

paligo.contributor Use this value if the user should belong to the group of
Paligo contributors.

Contributors are users who, besides reviewing content,
may also need to add or edit content, such as engineers
or subject matter experts (SME).

They can use both the Edit View [42] and Review
View [41]. Both Reviewers and Contributors can be sent
Review assignments, the difference is that Contributors
can switch to Edit View [42]. That enables them
to edit and add information and also to Create
Snapshots [1330].

No access Contributor
license
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User group
syntax

Description API access License
type

paligo.reviewer Use this value if the user should belong to the group of
Paligo reviewers.

Reviewers are users who need to read content and
leave feedback comments on it, but do not change the
content in anyway. They have access to Review View [41].

No access Reviewer
license

paligo.itadmin Use this value if the user should belong to the group of
Paligo IT admins.

IT managers have access to the Settings page [1817]
and can create users. Can set up integrations, languages
and the general settings of the Paligo instance.

No access IT admin
license

IMPORTANT
Custom licenses are available on the Enterprise plan. These offer some ability to configure what
features users have access to. For more information about what options are available to you,
contact your account manager.

Access to API, depends on license configuration.

3. Select the Applications tab.

4. Select Paligo to associate the Paligo application with the user group.

5. Select Save Group.

6. Repeat this procedure for all Paligo user groups.

NOTE
Next: Associate the JumpCloud User Accounts with the User Groups [1514].

Paligo Documentation

1513



Associate the JumpCloud User Accounts with the User Groups
In JumpCloud, you need to associate the user accounts with the user groups that you have set up
for Paligo.

1. Select Users.

2. Select the user you want to add to a Paligo user group.

3. Select the User Groups tab.

4. Select the checkbox for the Paligo user group that the user should belong to.

5. Select Save user.

6. Repeat this process for each user account that needs access to Paligo.

You can now Connect Paligo to your SSO Service [1499].

Integration with Azure SSO
Before Paligo and Azure can be connected, you need to create an enterprise app registration for
Paligo, see Quickstart: Add an enterprise application - Microsoft Entry.

After registering the App and locating the SSO settings in Enterprise Applications:

1. Select the app you registered → Single sign-on. There will be the claim settings. Some of those
are detailed in Set Up Your SSO Service [1501].

Example of a working setup

2. In the claims settings, the paligo.usergroup should have the value user.assignedroles
and be added as a regular claim (not a group claim). You can mirror the settings below:

3. You also need to create App roles in the Paligo app registration. You can find these by going
to Azure Active Directory → App registrations → Paligo (or whatever you named the app on
registration) → App roles.
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IMPORTANT
Make sure you have App roles for each Paligo user group. Below you can see
the correct configuration with the paligo.admin role as an example. Make
sure you also "enable this app role" with the checkbox at the bottom of the
Edit app role window.

4. Return to your Paligo Enterprise application and select Users and groups to add the Azure
users you created in the main Azure active directory.

5. Select ✚ Add user/group and choose the user.

6. Assign the user to one of the roles (you created in the "App roles" above).

7. Return to your enterprise app Single sign-on settings to create a certificate.

8. Download the Federation metadata XML.

9. When you upload this file to your Paligo SSO integration, make sure to skip validation if the
validation fails.

10. After your metadata uploads, expand the Advanced settings in the Paligo SSO integration
and delete the Single signout service url.

Paligo Documentation

1515



Slack Integration
Abstract

Get your Paligo notifications in Slack with the Paligo-Slack integration. With this feature, you can
set Paligo to send the activity feed notifications to a Slack channel of your choice, as well as direct
messages from the Paligo app.

If your team uses Slack for communications, it can be really useful to have Paligo's notifications
appear there too. Then all your notifications and messages are in one place. With Paligo's Slack
integration, you can set Paligo to:

• Choose how often you receive Slack notifications.

• Send activity feed notifications to a channel of your choice in a Slack workspace.

• Send personal notifications to each user. These appear as messages sent from the Paligo app.

Preparation for Slack Integration
To set up Paligo to send notifications to Slack, you need:

• A Paligo user account that has Administrator permissions.

• A Slack user account that uses the same email address as your Paligo user account. The Slack
user account needs to have permissions to install applications on the Slack workspace.

• A Slack workspace with users that also have user accounts in Paligo. Again, the email address of
each Slack user should match their email address for their Paligo user account.

When you are sure you have these in place, you can Connect Paligo to Slack [1516]. This involves
installing the Paligo application in your Slack workspace.

Connect Paligo to Slack
To set up the Paligo to Slack integration, install the Paligo application in Slack.

1. Preparation for Slack Integration [1516].

2. Select your profile name in the upper right corner to display a menu, and then select Settings.

3. Select the Integrations tab, find the Slack section and then select Add.
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NOTE
If Paligo has already been set up to connect to a workspace, you will only see
a Change option, see Connect Paligo to a Different Slack Workspace [1524].

4. Select Add Paligo app to Slack.

The Paligo to Slack connection page appears.

NOTE
Paligo detects the Slack workspaces that are available to you automatically
(based on the email address of your Paligo user account). If you are a
member of several workspaces, you can use the button in the top-right
corner to choose which Slack workspace Paligo will connect to.

5. Select Allow.

6. In Slack, select Apps (in the top section).

7. Select the Paligo app from the Apps list.

8. Paligo is added to the Apps section in the sidebar.
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You have now installed the Paligo app on the Slack workspace. Next, you can use
Paligo to recieve Slack Activity Feed Notifications [1518] and also what Slack Personal
Notifications [1521] to receive.
Each different Paligo user will need to set Slack Personal Notifications [1521], and they can do
this in My Settings. They do not need to install the Paligo app on the Slack workspace, as you
have already done that.

Slack Activity Feed Notifications
Paligo can send activity feed notifications to Slack. These are the same activity feed notifications
you can see on the dashboard in Paligo, and they include many types of "system events",
including:

• Document created

• Document title changed

• Assignment started

• Release status changed

• Snapshot created.

By default, activity feed notifications are sent to the #general channel in Slack. But you can use
the Paligo Slack integration settings to choose a different channel if you prefer. You can also use
the integration's filter settings to choose which activity feed notifications Paligo will send to Slack.

TIP
Activity feed notifications are not the only messages Paligo can send to Slack.
There are also Slack Personal Notifications [1521], such as messages to tell you
that you have been mentioned in a review comment. These personal notifications
appear in Apps > Paligo in Slack, and you can set them up in your Paligo profile.

NOTE
You can only change the Slack activity feed settings if you are logged in to
Paligo as an administrator. You should also read the Preparation for Slack
Integration [1516].

1. Select your profile in the upper right corner to display a menu, and then select Settings. Then
select the Integrations tab, find the Slack settings and select Change.
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2. Check the Send Activity Feed notifications to a Slack channel box and enter the Channel
name. For example, here we have used a channel called #documentation.

NOTE
The Channel name has to match the name of a channel in your Slack
workspace.

3. Use the Filters to choose which activity feed notifications Paligo will send. There are two
settings - one for choosing the users you are interested in, and one for choosing the types
of events. Check the boxes for the users and events that you want to get notifications for in
Slack.
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If you do not want to receive Slack notifications about particular users or events, clear their
checkboxes.

4. Select Save.

5. In Paligo, do something that will cause an activity feed notification. For example, create a new
publication or rename a topic. Then, in Slack, look at the channel that you have set up to
receive the Paligo notifications. You should see the notification message appears (there can
be a delay, depending on server connections etc., but the notification usually arrives almost
instantly).

NOTE
If the notification does not arrive, make sure that:

• You have entered the channel name correctly

• The filters actually allow that notification to be sent to Slack

• You performed an action that will get logged in the activity feed in Paligo.
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Slack Personal Notifications
Paligo can send "personal" notifications to you in Slack. These are notifications that are relevant to
you, but not all users, and they appear as direct messages from the Paligo app. You can see them
in Apps > Paligo in Slack.

The types of message that are shown as "personal" notifications are:

• @ mentions of your Paligo user name in reviews

• Reply comments in topics that you have followed

• Someone has shared a document with you

• Production notifications, including when a publication is ready for download or has failed.

• Assignment status changes, such as assignment started, assignment approved, assignment
canceled, and assignment ended.

TIP
Paligo can also send activity feed notifications to Slack. These Slack Activity Feed
Notifications [1518] are the same as those that appear in the activity feed on the
Paligo dashboard, and they are sent to a specific Slack channel.

To use "personal" notifications in Slack:

1. Connect Paligo to Slack [1516], so that Paligo can connect to your Slack workspace
successfully. Also, make sure that the email address you use for the Slack workspace is the
same as the email address you use for your Paligo user account.

2. In Paligo, select your profile in the upper-right corner to display a menu. Select My Profile.

3. Select the Notifications tab.

4. Use the Notifications tab to choose which "personal" notifications you want to receive on
Slack. For more information, see My Profile [1843].

5. Select Save.

6. Test the notifications work by doing something that will cause Paligo to create a "personal"
notification. For example, if you have chosen to receive slack notifications when someone
shares a document, ask another Paligo user to share a publication with you. When they share
the publication, look at Apps > Paligo in Slack. You should see a notification that is personal
to you. Other users in your Slack workspace will not see the notification in their Apps > Paligo
notifications.
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Change the Channel and Filters for Slack Notifications
You can change the settings in Paligo so that it:

• Sends activity feed notifications to a different channel

• Sends activity feed notifications for different users or events

To make these changes:

1. Preparation for Slack Integration [1516].

2. Select your profile in the upper right corner to display a menu, and then select Settings. Then
select the Integrations tab, find the Slack settings and select Change.

3. In the Channel name field, change the name of the channel.

4. Use the Filters to choose which activity feed notifications Paligo will send. There are two
settings - one for choosing the users you are interested in, and one for choosing the types
of events. Check the boxes for the users and events that you want to get notifications for in
Slack.
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If you do not want to receive Slack notifications about particular users or events, clear their
checkboxes.

5. Select Save.

6. In Paligo, do something that will cause an activity feed notification. For example, create a new
publication or rename a topic. Then, in Slack, look at the channel that you have set up to
receive the Paligo notifications. You should see the notification message appears (there can
be a delay, depending on server connections etc., but the notification usually arrives almost
instantly).

NOTE
If the notification does not arrive, make sure that:

• You have entered the channel name correctly

• The filters actually allow that notification to be sent to Slack

• You performed an action that will get logged in the activity feed in Paligo.
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Connect Paligo to a Different Slack Workspace
If your Paligo instance is already connected to a Slack workspace and you want to connect it to a
different one:

1. Preparation for Slack Integration [1516].

2. Select your profile in the upper right corner to display a menu, and then select Settings. Then
select the Integrations tab, find the Slack settings and select Change.

3. Select Reinstall application.
The Paligo to Slack connection page appears.

4. Use the button in the top-right corner to choose the workspace you want to connect Paligo to.

5. Select Allow.

6. In Slack, select Apps (in the top section).

7. Select the Paligo app from the Apps list.

8. Paligo is added to the Apps section in the sidebar.

You have now installed the Paligo app on the Slack workspace. Next, you can use
Paligo to recieve Slack Activity Feed Notifications [1518] and also what Slack Personal
Notifications [1521] to receive.
Each different Paligo user will need to set Slack Personal Notifications [1521], and they can do
this in My Settings. They do not need to install the Paligo app on the Slack workspace, as you
have already done that.

Swiftype Search
Abstract

Swiftype search, also known as Elastic search is a third-party search engine that you can use with
your Paligo publications. It provides a fast, highly customizable search that can find answers from
many different websites.

Swiftype search, also known as Elastic search, is a third-party search engine that you can use with
your Paligo publications. It provides a fast, highly customizable search that is designed for a wide
range of business websites, including e-commerce sites. As a dedicated search engine, it has some
benefits over Paligo's built-in search engine, but it does require a Swiftype subscription.
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The main benefits of Swiftype search are:

• Extremely fast, even on large amounts of content

• Provides more control over how the search works and how results are ranked

• Supports federated search, where the search engine can look for results in multiple locations.
Typically, you will have several different publications that you want to publish independently,
and a portal page with a search. By using Swiftype, you can set the portal search so that it looks
for content in all of the publications (and perhaps search your website and other locations too).

NOTE
Swiftype only searches content that is published to a web server without
authentication. It needs access to your web site and it "pulls" index data. If
you prefer a search service where the index data is "pushed" see Algolia Search
Engine Integration [1380].

Prerequisites for Swiftype Search
To use Swiftype search with your Paligo content, you need:

• Swiftype account

• Basic knowledge of how to use Swiftype

• HTML5 layout, such as an HTML5 Help Center layout

• Paligo content that is published to a web server, so that it has a URL that can be "crawled" by
the Swiftype search engine.

If you have these, you can Connect Swiftype and Paligo [1525].

Connect Swiftype and Paligo
To use Swiftype as the search engine for your Paligo content, you need to have the
prerequisites [1524] in place. You can then set up:

• Paligo publications to use Swiftype for the search engine

• Swiftype to index your Paligo publications and any other domains you want to include in the
search results.

To apply the settings, you will need to use both Swiftype and Paligo, so it is a good idea to have
them both open at the same time.
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NOTE
The steps described in Swiftype are accurate at the time of writing. There may be
differences if the Swiftype user interface changes.

1. In Swiftype, create a new engine.

a. Enter the URL for the new engine and then verify it. This is the URL where your main
search page will be hosted, for example, the URL of your main portal page.

b. Enter a name for the engine and choose the languages you want it to support, and then
create the engine.

2. Select Complete Setup. Swiftype will start crawling your site. You do not need to wait for it to
finish crawling.

3. Go to the <Install Search> settings and look at the script Swiftype provides. The on-screen
instructions tell you to copy the entire script to your web site, but ignore that for your Paligo
content (you will need to add the script to any other sites you include in your search though).
Instead, look for the key that is in the script. It is a series of characters in the last line of the
script (before the closing </script>). For example, in the following sample, the key is:

vb9gHTohoo7zFvm4vsSd

4. In Paligo, either create a new HTML5 layout or edit an existing one (see Layouts [1054]). In the
layout's Search Engine settings:

a. Enter your Swiftype key in the Use Elastic Site Search field. This is the key from the
Swiftype script as described in step 3. It is not the same as the API key or Engine key that
are also available in Swiftype.

b. Enable the Elastic site search, only index topic content setting. This will limit Swiftype
so that it only searches in the content of your topics, and not any other parts of the page,
such as the header or footer. If you prefer, you can disable this setting, but then you may
get results that are only matches due to terms in your header, footer, table of contents,
etc.

c. Select Save.
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5. In Swiftype, go to the <Install Search> settings and select Change Configuration and then
access the Search Field settings.

6. Select:

• Yes, my site has an input field

• I am unable to add this class

7. Set the Identifier type to class name and enter the CSS class for your portal page's search
field as the Class name. For the default HTML5 Help Center, the search field class is:

.search-field

8. Go to the Domains settings. Add a domain for each different website that you want the
search engine to use. For example, if you publish a user guide and a developer guide as
separate publications on different domains, you will need to add a domain for each guide.

9. Save your Swiftype settings.

10. In Paligo, publish your content using the layout that you edited in step 4 (see
Publishing [1068]).
When the output is created, a zip file is downloaded in your browser. Unzip the file and upload
the "out" folder and its contents to your web server and make sure it replaces the existing
content on your server. If you are unsure how to do this, please ask your web server admin.

NOTE
If you want Swiftype to return results from several publications, make
sure you publish them with layouts that all use the same Swiftype key.
For example, if you have three help center publications and an API help
publication, you could use a HTML5 help center layout and an HTML5 API
layout. Both of the layouts need to be set up to use the same Swiftype key.

For other types of content that will be included in the search, such as your
website, you need to add the Swiftype script (which includes the key) to your
website as explained in the Swiftype documentation.

11. In Swiftytpe, select <Install Search> and then Resume Configuration. At the bottom of the
Install Site Search page, select Activate Site Search. Swiftype will crawl your site. When it is
finished, the search fields in your Paligo content will use the Swiftype search. It will provide
results from every domain you have included in the Domains settings in Swiftype.
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To test it, select the search icon at the end of the search field on the portal page. It should
display a popup dialog that shows a list of results - this dialog is provided by Swiftype (and can
be styled in Swiftype).

Zendesk Integration
Paligo can publish directly to Zendesk, so you can use Paligo's powerful authoring features to
create content, while still using your Zendesk help center to support customers.

To publish from Paligo to Zendesk:

1. Make the necessary preparations, see Preparation for Zendesk Integration [1529].

2. Connect Paligo to Zendesk [1529] so that it can connect to your Zendesk.

3. Make sure you understand how the different Zendesk Layouts [1600] work. There are several
different types of Zendesk layout you can use, and each "maps" the Paligo content to
Zendesk's Category > Section > Article structure differently. So it is important that you
choose the right type of layout for your requirements.
We use the term "mapping" for the conversion of Paligo topics into sections and articles in
your Zendesk help center. For example, if you have a top-level topic in Paligo that is going to
become a section in Zendesk, the topic is "mapped" to a section. You can find out more in
Map Content from Paligo to Zendesk [1557].

4. When you publish your Paligo publication, choose HTML as the output type and select the
Zendesk layout that you want to use. You can also use the publishing settings to control
variables, filters, etc. To find out more, see Publish Content to Zendesk [1580].

5. Use JavaScript and CSS customize the appearance and functionality of your content in
Zendesk, see Customize Zendesk Articles Using Javascript [1592] and Customize Zendesk
articles using CSS [1586].

NOTE
Paligo does not support publishing to articles that use “content blocks” in
Zendesk.

NOTE
To import Zendesk content into Paligo, see Import from Zendesk [1808].
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Preparation for Zendesk Integration
Before you can publish from Paligo to Zendesk you need to have:

• A Zendesk account that has access to the "Managed By" feature, also known as user
permissions.

• One or more categories in Zendesk

• A Paligo publication that is organized so that it can be published using a Zendesk multi-section,
single-section, or enterprise layout, see Zendesk Layouts [1600].

• Connect Paligo to Zendesk [1529] so that it can connect to your Zendesk.

TIP
We recommend that you set up a trial account or a draft category so that you
can test your Paligo-to-Zendesk publications without making the content visible to
your customers. When you know everything is working as you want it to, you can
start publishing to your live help desk knowledge base.

Connect Paligo to Zendesk
Abstract

Learn how to connect Paligo to Zendesk by using the integration settings in Paligo.

Paligo can publish directly to Zendesk, so you can use Paligo's powerful authoring features to
create content, while still using your Zendesk help center to support customers.

Depending on the plans you have purchased, you can connect Paligo to Zendesk and set it up to
publish to:

• A single Zendesk domain (or brand). This article explains how to set up Paligo to connect to a
single domain Zendesk.

• Multiple brands (subdomains) on the same main domain. For information on setting up Paligo to
connect to a multi-brand Zendesk, see Connect Paligo to Zendesk Multibrand [1543].

NOTE
Paligo does not support publishing to articles that use “content blocks” in
Zendesk.

How to set Paligo to Publish to Zendesk
When you set Paligo to publish to Zendesk for the first time, there are some extra steps you
need to take, such as setting up an API key and integration. Once these are in place, any further
publications to Zendesk will be much simpler - you will choose a Zendesk Layout and then publish.
To set Paligo to publish to Zendesk for the first time complete steps 1-4.

Before you can publish from Paligo to Zendesk you need to have:

• A Zendesk account that has access to the "Managed By" feature, also known as user
permissions.
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If you have the Zendesk enterprise plan and want to

• One or more categories in Zendesk

TIP
We recommend that you set up a trial account or a draft category so that you
can test your Paligo-to-Zendesk publications without making the content visible to
your customers. When you know everything is working as you want it to, you can
start publishing to your live help desk knowledge base.

Step 1: Generate an API key in Zendesk
To connect to Zendesk, Paligo needs an API key. You can generate the API key in Zendesk and then
copy it to Paligo.

1. Log in to your Zendesk account.

NOTE
You need to log in via a user account that has administrator permissions.

2. Display the Zendesk Admin Center. (Select the Zendesk Products icon and then select
Admin Center).

3. In the Apps and Integrations section, select Zendesk API.
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4. On the Settings tab, set Token Access to Enabled. This allows you to create API tokens.

5. Select Add API Token.
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6. Enter a name for the API token in the API Token Description field.

7. Select Copy to copy the API token to your computer's clipboard.

IMPORTANT
You must copy the API token as it is not shown again after you exit the page.

Step 2: Connect Paligo to Zendesk
When you have an API token from your Zendesk account, you can set up an integration in Paligo.
The integration allows Paligo to connect to your Zendesk and:

• Import content when you first migrate from Zendesk to Paligo

• Publish content from Paligo to Zendesk.
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To connect Paligo to Zendesk:

1. Log in to Paligo via a user account that has administrator permissions.

2. Select the avatar in the top right corner. 

3. Select Settings from the menu. 

4. In the Settings view, select the Integrations tab.

5. In the Zendesk box, select Change.

If the Zendesk integration has not been set up in your Paligo instance previously, select Add
instead of Change.

6. Enter the connection details for your Zendesk:

NOTE
The user needs to have "Manager" permissions in your Zendesk Guide
account.

• Your Zendesk URL: Enter the web address of your Zendesk.

• E-mail: Enter your e-mail address.

• API key: Paste the API key into this field. Paligo and Zendesk use the API key to authorize
the connection.

7. Enter a Default Category ID. This identifies the category that Paligo will write content to, by
default. When you publish, you can choose a different category instead of the default category
if needed.

The category ID is the number in the URL of the category in Zendesk.
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TIP
We recommend that you set up a Zendesk category that is not published
to your customers. You can then set this "unseen" category as the default
category.

8. Choose a Default permission group for the content when it is published to Zendesk:

• Agents and Managers - In Zendesk, agents, and managers will be able to work on the
article.

• Managers - In Zendesk, only managers will be able to work on the article.

9. Set the Publish status for the Paligo content when it is loaded into Zendesk.

• Published: The Paligo content will be used as "live" published articles in Zendesk.

• Draft: The Paligo content will be loaded into draft articles. These articles will not be "live"
until you change their status from Draft to Published in Zendesk.

10. Use the Taxonomies settings to control how Paligo's taxonomy labels are used.

• Use the Publish taxonomies as labels box to choose whether taxonomy tags are used as
labels in Zendesk.

• Use the Preserve Zendesk labels box to choose whether taxonomy tags are added as
labels in Zendesk in addition to any existing labels.
If you check the box, Paligo will leave any existing Zendesk labels in place. It will then
create new labels to match the taxonomy tags, but will not duplicate any existing tags. For
example, if you have a "software" taxonomy tag and there is already a "software" label in
Zendesk, Paligo will not create a second "software" label.
If you clear the box, Paligo will remove all existing Zendesk labels and will create new labels
to match the taxonomy tags.

11. If you have IP restrictions enabled in Zendesk, you need to set Paligo to use a static IP address
(via a gateway). Then, in Zendesk, you can whitelist Paligo's IP address so that it can publish to
Zendesk.

In Paligo, enable the Use the Paligo provided gateway when connecting to Zendesk
option.
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You will need to whitelist the IP address 34.249.89.180 in Zendesk. Paligo can then publish to
Zendesk even when "IP restrictions" is enabled in Zendesk.

If you do not have IP restrictions enabled in Zendesk, leave the checkbox clear.

12. Use the Strict Mapping feature to control how Paligo maps content to Zendesk articles that
have since moved in Zendesk.

If you have Strict Mapping checked (on), Paligo expects to "push" its content to a matching
content structure in Zendesk. If the structure in Zendesk is different, perhaps because articles
have been moved in Zendesk, then Paligo will not publish to the moved articles. Instead,
Paligo will create new versions of the articles in the locations that match the Paligo hierarchy.

If Strict Mapping is clear (off), Paligo will detect that articles have moved. It will not enforce
the Paligo hierarchy, and so can update the moved articles.

NOTE
The Zendesk Preflight feature cannot always display the mapping accurately if
the content has been moved around in Zendesk and Strict Mapping is off.

13. Use the Overwrite article attachments setting to control how Paligo updates images in
Zendesk.

Check the box to set Paligo to replace any attachments for articles, such as images, when it
publishes to Zendesk. It only replaces attachments that have the same file name.

Clear the box to set Paligo to publish any attachments in addition to the ones that already
exist in the matching Zendesk articles. This can result in duplicate images with the same name
in Zendesk, rather than images that are reused.
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14. Select Save and then select Test.
Paligo attempts to connect to Zendesk. If the connection attempt fails, check the URL, email,
API key, and default category ID carefully for errors and make sure the API key is valid.

NOTE
If you have a multi-brand account, the connection test checks all of the
accounts provided. The test will fail if Paligo is unable to connect to any of
the accounts.

You have now set Paligo to connect to your Zendesk(s).

Step 3: Publish your Paligo Content to Zendesk
Now let's publish your content to Zendesk.

1. In the Content Manager, display the options menu for the publication that you want to
publish, and select Publish.

TIP
You do not have to publish an entire publication to Zendesk. You can also
publish part of a publication, for example, one chapter of a user guide. To
find out more, see Publish to Multiple Zendesk Categories [1583].

2. On the Settings tab, select HTML.

3. Choose the Zendesk layout that you want your publication to use.
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The different types of Zendesk layout map content to Zendesk differently, so it is important
that you choose a layout that meets your requirements. To find out how each layout maps
content to Zendesk, see Zendesk Layouts [1600].

4. Choose the Zendesk category that will receive your selected Paligo content.

5. Use the Managed by setting to choose which types of user can edit and publish the articles
that Paligo creates or updates in Zendesk. For example, you could choose Agents and
Managers. The Managed by setting is sometimes called Permission Group in Zendesk.

This setting is applied as the default for all articles that Paligo publishes to Zendesk, but you
can have different settings for individual articles as well. The individual settings take priority
over the default settings. You set Managed By for individual articles on the Zendesk Preflight
tab.

6. Use the Visible to setting to choose who can see the articles that Paligo creates or updates in
Zendesk. The Visible to group is sometimes called the User Segment Group in Zendesk.

This setting is applied as the default for all articles that Paligo publishes to Zendesk, but you can
have different settings for individual articles as well. The individual settings take priority over the
default settings. You can set Visible To for individual articles on the Zendesk Preflight tab.

7. Choose the language(s) to publish to. If you do not have any translations, you can only select
the original / source language.
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If you have more languages already translated and approved, you can select multiple
languages for this publication. Check Combine selected languages to publish them as one
multilingual publication.

8. If you have set filter metadata (attributes) on topics or elements, and/or have used variables,
you can choose to apply filter values and variable values to profile your output here. See
Filtering / Profiling [1141] and Variables [1186] to learn how to use these features.

9. Select the Zendesk Preflight tab to View the Paligo-to-Zendesk Mapping [1562].
If you are happy with the existing mapping, you can proceed to the next step.

If you want to change the mapping, you can use the various settings on the Zendesk Preflight
tab. You can map the Paligo topics to different sections and articles, change the Managed By and
Visible To status, set the topics to be draft or publish, and promote them as needed. To find out
more, see Customize Paligo-to-Zendesk Mapping [1566].

10. Select Publish document.
Paligo "pushes" the content in the publication to Zendesk. Map Content from Paligo to
Zendesk [1557] and sections and articles are created and / or updated.

When Paligo publishes to Zendesk, a compressed file downloads in your browser. The first time
you publish to Zendesk, you will need to add some of the downloaded files to your Zendesk.

Step 4: Add the CSS and JS files to Assets in Zendesk
When you publish to Zendesk, Paligo downloads a package in your web browser. The package
contains CSS and javascript files, which are used to provide certain functionality and styles
in Zendesk. You can add some or all of these assets to your Zendesk, depending on what
functionality you want to include.
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The CSS and JS files are:

• JS

• paligo-zd.js
Provides a range of functionality, including "accordion" collapsible sections, syntax highlighting
for code, and checklists.

• paligo-zd-lightbox.js and lightbox-min.js
These provide the "lightbox" feature, where you can select an image to view a larger version of
the image

• paligo-zd-glossary.js
Provides a popup on the glossary terms in your content. The popup contains the glossary
term definition.

• paligo-swagger.js
Allows swagger/Open API content to be embedded in Zendesk articles.

• paligo-stickymenu.js
Adds a sub-navigation menu in the sidebar. This contains links to the sections inside an article.
It also makes the menu "sticky" - it stays in view on the page even when you scroll down, and
will scroll separately for long articles.

• paligo-anchorlinks.js
Adds a "Click to copy" option to each heading, so that you can quickly copy the URL for that
heading.

• bootstrap-min.js
Provides the bootstrap framework that is needed for some of the javascript features, such as
the glossary popups.

• CSS

• paligo-zd.css
Includes some basic styling to improve the overall look and feel of your articles, and also
supports the functionality in the javascript files.
You can use this as a starting point for your styling. But you should check that the paligo-
zd.css styles do not clash with any base styles you already have in Zendesk. If the styles do
clash, you will need to make some overrides in your CSS or choose which styles you want to
include/exclude.

• paligo-stickymenu.css
Contains the styling for the "sticky menu" feature that's provided by paligo-stickymenu.js

• lightbox.min.css
Contains the styling for the "lightbox" feature that's provided by paligo-zd-lightbox.js and
lightbox.min.js.

You can find these files in the css and js folders in the zip file that is downloaded in your browser
when you publish to Zendesk.

Paligo Documentation

1539



The first time that Paligo publishes to your Zendesk, you should add the CS and JS files to the
Zendesk Assets :

1. Open the zip file that is downloaded when you publish.

2. Log in to your Zendesk help center.

3. Click the Guide Admin icon at the top right.

4. Select the Customize Design feature, and then choose the active theme and select Edit Code.

5. Select the Assets folder.

6. Find the JS > Zendesk folder and the CSS > Zendesk folder in the downloaded package. These
contain the CSS and javascript files you need to add to your Zendesk assets. You can ignore
the other files in the downloaded package.
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7. Decide on which JavaScript and CSS files you want to use and then add them to the Assets in
Zendesk.
We recommend that you include references to: paligo-zd.js, paligo-zd.css, and
bootstrap.min.js. You should also include a reference to the jquery.min.js script.

• paligo-zd.js

• paligo-zd.css

• bootstrap.min.js

• jquery.min.js (this is a script that is provided externally, and the details for this reference are
included in step 9).

The other references are optional. But if you decide to use a feature, remember to include all
of the files that are needed for it, for example, glossary popups require paligo.zd-glossary.js
and bootstrap.min.js, and the lightbox feature needs paligo-zd-lightbox, lightbox.min.js and
lightbox.min.css as well as the jquery reference.

8. In the Zendesk theme, open the Templates folder and then select document_head.hbs.

9. Add a reference to each file, and also to the "Font Awesome" stylesheet (it is hosted, so there
is no need to upload it to the Zendesk assets).
The following example shows the syntax for the references (and assumes that you have not
renamed the package files). We have separated the references with comments so that you can
see which references you need to include for the features you want.

<! -- reference for jquery script -->
<script src="https://ajax.googleapis.com/ajax/libs/jquery/3.5.1/
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jquery.min.js"></script>

<! -- reference for bootstrap script -->
<script src="{{asset 'bootstrap.min.js'}}"></script>

<! -- reference for fontawesome -->
<link href="https://maxcdn.bootstrapcdn.com/font-awesome/4.7.0/css/font-
awesome.min.css" rel="stylesheet"/>

<! -- reference for "copy to copy" anchorlinks -->
<script src="https://cdnjs.cloudflare.com/ajax/libs/clipboard.js/2.0.0/
clipboard.min.js"></script>

<! -- reference for paligo-zd scripts and css. 
Note that the first two references are for code syntax highlighting and \
they must come 
before the reference to the paligo-zd.js file. You can leave those out \
if you do not want to use 
syntax highlighting -->

<link rel="stylesheet" href="https://cdnjs.cloudflare.com/ajax/libs/
highlight.js/9.5.0/styles/androidstudio.min.css"/>
<script src="https://cdnjs.cloudflare.com/ajax/libs/highlight.js/9.5.0/
highlight.min.js"></script>
<script src="{{asset 'paligo-zd.js'}}"></script>
<link href="{{asset 'paligo-zd.css'}}" rel="stylesheet" type="text/
css" />

<! -- references for lightbox scripts and css --><script src="{{asset \
'lightbox.min.js'}}"></script>
<script src="{{asset 'paligo-zd-lightbox.js'}}"></script>
<link href="{{asset 'lightbox.min.css'}}" rel="stylesheet"/>

<! -- references for stickymenu scripts and css -->
<script src="{{asset 'paligo-stickymenu.js'}}"></script>
<link href="{{asset 'paligo-stickymenu.css'}}" rel="stylesheet" \
type="text/css" />

<! -- reference for glossary scripts and css -->
<script src="{{asset 'paligo-zd-glossary.js'}}"></script>

NOTE
The references use the Zendesk curly brackets syntax to refer to uploaded
assets.

NOTE
If you have included the references for code syntax highlighting (in the paligo-
zd references), you do not need to upload any files. The necessary files are
loaded from a cdn.
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10. Select Publish to save the settings in Zendesk.

You have now uploaded the relevant packaged files from Paligo into Zendesk, and set your
Zendesk article pages to reference the files.

Connect Paligo to Zendesk Multibrand
Abstract

Learn how to connect Paligo to Zendesk multibrand by using the integration settings in Paligo.

Zendesk enterprise plans have a multibrand feature where you can have a main Zendesk domain
and also subdomains for different brands. For example, you could have acme.zendesk.com as
your main domain, and then acme100.zendesk.com as a subdomain and acme200.zendesk.com as
another subdomain. Paligo can publish to the top-level categories in the main Zendesk domain or
those in a subdomain.

NOTE
Paligo can publish to top-level categories in a brand. You cannot publish Paligo
content to lower-level categories.

Before you set up Paligo to publish to multiple subdomains (brands), make sure that:

• Your Paligo plan includes multibrand support. It is included in the Paligo enterprise plan. On
other Paligo plans, you can only publish to the main domain (or you could set up a Zendesk
subdomain as the main domain in Paligo).

• You have set up the various brands you want to use (in Zendesk). They all need to have a URL for
their subdomain.

With these prerequisites in place, complete the following steps (1-4) to connect Paligo to your
Zendesk brands and publish your content.

Step 1: Generate an API key in Zendesk
To connect to Zendesk, Paligo needs an API key. You can generate the API key in Zendesk and then
copy it to Paligo.

1. Log in to your Zendesk account.

NOTE
You need to log in via a user account that has administrator permissions.

2. Display the Zendesk Admin Center. (Select the Zendesk Products icon and then select
Admin Center).

Paligo Documentation

1543



3. In the Apps and Integrations section, select Zendesk API.

4. On the Settings tab, set Token Access to Enabled. This allows you to create API tokens.
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5. Select Add API Token.

6. Enter a name for the API token in the API Token Description field.

7. Select Copy to copy the API token to your computer's clipboard.
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IMPORTANT
You must copy the API token as it is not shown again after you exit the page.

Step 2: Connect Paligo to Multiple Zendesk Brands
When you have an API token from your Zendesk account, you can set up an integration in Paligo.
The integration allows Paligo to connect to your Zendesk and:

• Import content when you first migrate from Zendesk to Paligo

• Publish content from Paligo to Zendesk.
If your Paligo plan includes multibrand support and you have Zendesk multibrand, you can
publish to a top-level category in any of your brands. You can choose which brand and category
to use for publishing in Paligo's integration settings.

TIP
To upgrade to a multi-brand account, please contact Paligo.

To connect Paligo to Zendesk:

1. Log in to Paligo via a user account that has administrator permissions.

2. Select the avatar in the top right corner. 

3. Select Settings from the menu. 

4. In the Zendesk box, select Change.
If the Zendesk integration has not been set up in your Paligo instance previously, select Add
instead of Change.

5. In the Account #1 section, enter the connection details for your main Zendesk brand:

NOTE
The user needs to have "Manager" permissions in your Zendesk Guide
account.
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• Your Zendesk url: Enter the web address of your main Zendesk brand. This is the primary
domain in your Zendesk.

• E-mail: Enter the email address of a user with "Manager" permissions for the domain in
Zendesk.

• API key: Paste the API key into this field. Paligo and Zendesk use the API key to authorize
the connection.

6. Select the Choose account drop-down and choose another account, for example, Account
#2.
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NOTE
If Paligo does not have the settings for multiple accounts, it is because your
Paligo plan does not include multi-brand. To upgrade, please contact support.

7. Enter the details for one of your Zendesk brands (subdomains):

• URL - The URL of your Zendesk brand. This is the address of the subdomain for the brand.

• E-mail - The email address of a Zendesk user who has "manager" permissions for the
brand.

NOTE
The API Key is the same as the API Key for the primary domain, by default.
For multibrand, this is usually appropriate. However, if you wanted to publish
to separate Zendesk instances, instead of brands on the same account, you
could add an account for each Zendesk instance and then set the different
API key for each instance.

8. Repeat steps 6 and 7 to add any further brands (subdomains).

9. Use the Account used for publishing setting to choose which brand account Paligo will
publish to by default.

10. Enter a Default Category ID. This identifies the category that Paligo will write content to, by
default. When you publish, you can choose a different category instead of the default category
if needed.

The category ID is the number in the URL of the category in Zendesk.

TIP
We recommend that you set up a Zendesk category that is not published
to your customers. You can then set this "unseen" category as the default
category.

11. Choose a Default permission group for the content when it is published to Zendesk:

• Agents and Managers - In Zendesk, agents, and managers will be able to work on the
article.

• Managers - In Zendesk, only managers will be able to work on the article.

12. Set the Publish status for the Paligo content when it is loaded into Zendesk.

• Published: The Paligo content will be used as "live" published articles in Zendesk.

• Draft: The Paligo content will be loaded into draft articles. These articles will not be "live"
until you change their status from Draft to Published in Zendesk.
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13. Use the Taxonomies settings to control how Paligo's taxonomy labels are used.

• Use the Publish taxonomies as labels box to choose whether taxonomy tags are used as
labels in Zendesk.

• Use the Preserve Zendesk labels box to choose whether taxonomy tags are added as
labels in Zendesk in addition to any existing labels.
If you check the box, Paligo will leave any existing Zendesk labels in place. It will then
create new labels to match the taxonomy tags, but will not duplicate any existing tags. For
example, if you have a "software" taxonomy tag and there is already a "software" label in
Zendesk, Paligo will not create a second "software" label.
If you clear the box, Paligo will remove all existing Zendesk labels and will create new labels
to match the taxonomy tags.

14. If you have IP restrictions enabled in Zendesk, you need to set Paligo to use a static IP address
(via a gateway). Then, in Zendesk, you can whitelist Paligo's IP address so that it can publish to
Zendesk.

In Paligo, enable the Use the Paligo provided gateway when connecting to Zendesk
option.

You will need to whitelist the IP address 34.249.89.180 in Zendesk. Paligo can then publish to
Zendesk even when "IP restrictions" is enabled in Zendesk.

If you do not have IP restrictions enabled in Zendesk, leave the checkbox clear.

15. Use the Strict Mapping feature to control how Paligo maps content to Zendesk articles that
have since moved in Zendesk.

If you have Strict Mapping checked (on), Paligo expects to "push" its content to a matching
content structure in Zendesk. If the structure in Zendesk is different, perhaps because articles
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have been moved in Zendesk, then Paligo will not publish to the moved articles. Instead,
Paligo will create new versions of the articles in the locations that match the Paligo hierarchy.

If Strict Mapping is clear (off), Paligo will detect that articles have moved. It will not enforce
the Paligo hierarchy, and so can update the moved articles.

NOTE
The Zendesk Preflight feature cannot always display the mapping accurately if
the content has been moved around in Zendesk and Strict Mapping is off.

16. Use the Overwrite article attachments setting to control how Paligo updates images in
Zendesk.

Check the box to set Paligo to replace any attachments for articles, such as images, when it
publishes to Zendesk. It only replaces attachments that have the same file name.

Clear the box to set Paligo to publish any attachments in addition to the ones that already
exist in the matching Zendesk articles. This can result in duplicate images with the same name
in Zendesk, rather than images that are reused.

17. Select Save and then select Test.
Paligo attempts to connect to Zendesk. If the connection attempt fails, check the URL, email,
API key, and default category ID carefully for errors and make sure the API key is valid.

NOTE
If you have a multi-brand account, the connection test checks all of the
accounts provided. The test will fail if Paligo is unable to connect to any of
the accounts.

You have now set Paligo to connect to your Zendesk(s).

Step 3: Publish your Paligo Content to Zendesk
Now let's publish your content to Zendesk.

1. In the Content Manager, display the options menu for the publication that you want to
publish, and select Publish.
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TIP
You do not have to publish an entire publication to Zendesk. You can also
publish part of a publication, for example, one chapter of a user guide. To
find out more, see Publish to Multiple Zendesk Categories [1583].

2. On the Settings tab, select HTML.

3. Choose the Zendesk layout that you want your publication to use.
The different types of Zendesk layout map content to Zendesk differently, so it is important
that you choose a layout that meets your requirements. To find out how each layout maps
content to Zendesk, see Zendesk Layouts [1600].

4. Choose the Zendesk category that will receive your selected Paligo content.
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5. Use the Managed by setting to choose which types of user can edit and publish the articles
that Paligo creates or updates in Zendesk. For example, you could choose Agents and
Managers. The Managed by setting is sometimes called Permission Group in Zendesk.

This setting is applied as the default for all articles that Paligo publishes to Zendesk, but you
can have different settings for individual articles as well. The individual settings take priority
over the default settings. You set Managed By for individual articles on the Zendesk Preflight
tab.

6. Use the Visible to setting to choose who can see the articles that Paligo creates or updates in
Zendesk. The Visible to group is sometimes called the User Segment Group in Zendesk.

This setting is applied as the default for all articles that Paligo publishes to Zendesk, but you can
have different settings for individual articles as well. The individual settings take priority over the
default settings. You can set Visible To for individual articles on the Zendesk Preflight tab.

7. Choose the language(s) to publish to. If you do not have any translations, you can only select
the original / source language.
If you have more languages already translated and approved, you can select multiple
languages for this publication. Check Combine selected languages to publish them as one
multilingual publication.

8. If you have set filter metadata (attributes) on topics or elements, and/or have used variables,
you can choose to apply filter values and variable values to profile your output here. See
Filtering / Profiling [1141] and Variables [1186] to learn how to use these features.

9. Select the Zendesk Preflight tab to View the Paligo-to-Zendesk Mapping [1562].
If you are happy with the existing mapping, you can proceed to the next step.
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If you want to change the mapping, you can use the various settings on the Zendesk Preflight
tab. You can map the Paligo topics to different sections and articles, change the Managed By and
Visible To status, set the topics to be draft or publish, and promote them as needed. To find out
more, see Customize Paligo-to-Zendesk Mapping [1566].

10. Select Publish document.
Paligo "pushes" the content in the publication to Zendesk. Map Content from Paligo to
Zendesk [1557] and sections and articles are created and / or updated.

When Paligo publishes to Zendesk, a compressed file downloads in your browser. The first time
you publish to Zendesk, you will need to add some of the downloaded files to your Zendesk.

Step 4: Add the CSS and JS files to Assets in Zendesk
When you publish to Zendesk, Paligo downloads a package in your web browser. The package
contains CSS and javascript files, which are used to provide certain functionality and styles
in Zendesk. You can add some or all of these assets to your Zendesk, depending on what
functionality you want to include.

The CSS and JS files are:

• JS

• paligo-zd.js
Provides a range of functionality, including "accordion" collapsible sections, syntax highlighting
for code, and checklists.

• paligo-zd-lightbox.js and lightbox-min.js
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These provide the "lightbox" feature, where you can select an image to view a larger version of
the image

• paligo-zd-glossary.js
Provides a popup on the glossary terms in your content. The popup contains the glossary
term definition.

• paligo-swagger.js
Allows swagger/Open API content to be embedded in Zendesk articles.

• paligo-stickymenu.js
Adds a sub-navigation menu in the sidebar. This contains links to the sections inside an article.
It also makes the menu "sticky" - it stays in view on the page even when you scroll down, and
will scroll separately for long articles.

• paligo-anchorlinks.js
Adds a "Click to copy" option to each heading, so that you can quickly copy the URL for that
heading.

• bootstrap-min.js
Provides the bootstrap framework that is needed for some of the javascript features, such as
the glossary popups.

• CSS

• paligo-zd.css
Includes some basic styling to improve the overall look and feel of your articles, and also
supports the functionality in the javascript files.
You can use this as a starting point for your styling. But you should check that the paligo-
zd.css styles do not clash with any base styles you already have in Zendesk. If the styles do
clash, you will need to make some overrides in your CSS or choose which styles you want to
include/exclude.

• paligo-stickymenu.css
Contains the styling for the "sticky menu" feature that's provided by paligo-stickymenu.js

• lightbox.min.css
Contains the styling for the "lightbox" feature that's provided by paligo-zd-lightbox.js and
lightbox.min.js.

You can find these files in the css and js folders in the zip file that is downloaded in your browser
when you publish to Zendesk.

The first time that Paligo publishes to your Zendesk, you should add the CS and JS files to the
Zendesk Assets :

1. Open the zip file that is downloaded when you publish.
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2. Log in to your Zendesk help center.

3. Click the Guide Admin icon at the top right.

4. Select the Customize Design feature, and then choose the active theme and select Edit Code.

5. Select the Assets folder.

6. Find the JS > Zendesk folder and the CSS > Zendesk folder in the downloaded package. These
contain the CSS and javascript files you need to add to your Zendesk assets. You can ignore
the other files in the downloaded package.

7. Decide on which JavaScript and CSS files you want to use and then add them to the Assets in
Zendesk.
We recommend that you include references to: paligo-zd.js, paligo-zd.css, and
bootstrap.min.js. You should also include a reference to the jquery.min.js script.

• paligo-zd.js

• paligo-zd.css

• bootstrap.min.js

• jquery.min.js (this is a script that is provided externally, and the details for this reference are
included in step 9).

The other references are optional. But if you decide to use a feature, remember to include all
of the files that are needed for it, for example, glossary popups require paligo.zd-glossary.js
and bootstrap.min.js, and the lightbox feature needs paligo-zd-lightbox, lightbox.min.js and
lightbox.min.css as well as the jquery reference.
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8. In the Zendesk theme, open the Templates folder and then select document_head.hbs.

9. Add a reference to each file, and also to the "Font Awesome" stylesheet (it is hosted, so there
is no need to upload it to the Zendesk assets).
The following example shows the syntax for the references (and assumes that you have not
renamed the package files). We have separated the references with comments so that you can
see which references you need to include for the features you want.

<! -- reference for jquery script -->
<script src="https://ajax.googleapis.com/ajax/libs/jquery/3.5.1/
jquery.min.js"></script>

<! -- reference for bootstrap script -->
<script src="{{asset 'bootstrap.min.js'}}"></script>

<! -- reference for fontawesome -->
<link href="https://maxcdn.bootstrapcdn.com/font-awesome/4.7.0/css/font-
awesome.min.css" rel="stylesheet"/>

<! -- reference for "copy to copy" anchorlinks -->
<script src="https://cdnjs.cloudflare.com/ajax/libs/clipboard.js/2.0.0/
clipboard.min.js"></script>

<! -- reference for paligo-zd scripts and css. 
Note that the first two references are for code syntax highlighting and \
they must come 
before the reference to the paligo-zd.js file. You can leave those out \
if you do not want to use 
syntax highlighting -->

<link rel="stylesheet" href="https://cdnjs.cloudflare.com/ajax/libs/
highlight.js/9.5.0/styles/androidstudio.min.css"/>
<script src="https://cdnjs.cloudflare.com/ajax/libs/highlight.js/9.5.0/
highlight.min.js"></script>
<script src="{{asset 'paligo-zd.js'}}"></script>
<link href="{{asset 'paligo-zd.css'}}" rel="stylesheet" type="text/
css" />

<! -- references for lightbox scripts and css --><script src="{{asset \
'lightbox.min.js'}}"></script>
<script src="{{asset 'paligo-zd-lightbox.js'}}"></script>
<link href="{{asset 'lightbox.min.css'}}" rel="stylesheet"/>

<! -- references for stickymenu scripts and css -->
<script src="{{asset 'paligo-stickymenu.js'}}"></script>
<link href="{{asset 'paligo-stickymenu.css'}}" rel="stylesheet" \
type="text/css" />

<! -- reference for glossary scripts and css -->
<script src="{{asset 'paligo-zd-glossary.js'}}"></script>
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NOTE
The references use the Zendesk curly brackets syntax to refer to uploaded
assets.

NOTE
If you have included the references for code syntax highlighting (in the paligo-
zd references), you do not need to upload any files. The necessary files are
loaded from a cdn.

10. Select Publish to save the settings in Zendesk.

You have now uploaded the relevant packaged files from Paligo into Zendesk, and set your
Zendesk article pages to reference the files.

Map Content from Paligo to Zendesk
When you publish content to Zendesk, Paligo has to "push" the content from your topics into
Zendesk. To do this, it "maps" topics to the Zendesk structure, which consists of categories,
sections, and articles.

The mapping that takes place varies, depending on the type of Zendesk Layouts [1600] you use,
the layout's settings, and whether you customize the mapping by using the Zendesk Preflight
feature.

To set up the mapping for your content:

1. Choose the appropriate type of layout for the mapping you want to achieve, see Zendesk
Layouts [1600]

2. Edit the layout settings to:

• Control whether Paligo Creates Articles for "Section" Topics [1607]

• Control how many levels of sections can be used in Zendesk. This is only available on
Zendesk Enterprise Layouts [1615].

3. Use Customize Paligo-to-Zendesk Mapping [1566] to sections and articles in Zendesk.

Map Links to Zendesk
When you publish to Zendesk, Paligo maps the topics in your publication to Zendesk articles (see
Map Content from Paligo to Zendesk [1557]. If there are links in your topics, Paligo can map those
to your articles too:

• Topics with internal links: These are mapped and resolved automatically when you publish to
Zendesk.

• Links to topics in the same publication: These are mapped and resolved automatically when
you publish to Zendesk.

• Links to topics in a different publication: These do not map to articles in Zendesk (by default).
But Paligo can map these links if you enable the Fix cross-links outside of publication scope
setting on the Zendesk Layout. You may also need to publish twice. For more information, see
Fix Cross-References between Zendesk Categories [1603].
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Map Branched Content to Zendesk

NOTE
In this section, we explain how branched content is mapped to Zendesk. We
assume that you already understand and use the branching feature to create
concurrent versions of your publications and topics. To learn about branching,
see Branching [1638].

When you publish to Zendesk, Paligo maps the content in your publication, including branched
topics, to articles in Zendesk. For regular, unbranched topics, Paligo will map each topic to an
existing article or will create a new article (see Map Content from Paligo to Zendesk [1557]). But if
you have branched topics, they will map to articles differently, depending on how you create the
branched topics:

• If you create branches from inside the publication, the branched topics will map directly to
corresponding articles in Zendesk. This is because branches made in the publication use the
same fork ID as the original version of the topic (see Fork IDs and Mapping [1559]).

• If you create branches of topics outside of the publication, and then add them to the
publication, the branched topics will map to new articles in Zendesk. They will not update the
existing articles.

Typically, you will want your branched versions of topics to map to Zendesk and update your
existing articles. For this type of mapping, you need to make sure you branch your topics from
inside the publication:

1. In the Content Manager, find the Publication you want to publish to Zendesk.

2. Open the publication so that you can see the links to the topics.

3. Display the options menu for the linked topic that you want to branch.
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4. Select Branching.

5. Select New Branch.
Paligo creates a new branched version of the topic, and because you created it in the
publication, the branched version will map to the same Zendesk article as the original version
of the topic.

TIP
If your branched topics are mapping to new articles instead of updating existing
articles, it is likely because they have been branched outside the publication. To
resolve this situation:

1. Create new branches inside the publication. Then In Zendesk, delete the
articles that were created for the "outside the publication" branches.

2. Copy the content from your "outside the publication" branches into your
"inside the publication" branches.

3. Remove the "outside the publication" topics from the publication and delete
them.

4. In Zendesk, delete the articles that were created for the "outside the
publication" topics.

Fork IDs and Mapping
In this section, we explain how Paligo uses the "fork ID" to map topics to Zendesk articles. It will
help you to understand why Paligo maps branched topics differently, depending on whether they
are branched inside the publication or outside of the publication.

Let's say you have a Paligo publication and you want to publish to Zendesk for the first time. There
are no articles in Zendesk at the moment.
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• unbranched topics

• topics that are branched from inside a publication

• topics that are branched outside a publication.

NOTE
If your branched topics are mapped to new articles instead of updating your
existing articles, it is probably because the branches were created outside of the
publication.

Example 75. Branching from the Publication will Update Articles in Zendesk

You can branch your content in two ways: in a publication or outside a publication. This example
shows how Paligo maps content to Zendesk when you branch from inside a publication so that the
branched versions and original topic all use the same fork ID.

Let's start with a publication and a topic. When you add a topic to a publication, Paligo creates a
fork ID. It uses the fork ID as a record of the relationship between the publication and the topic.

You decide to publish to Zendesk for the first time. Paligo checks its internal record to see if the
topic's fork ID has been used to map to any articles in Zendesk. It has not, as there are no articles
yet, and so Paligo maps the topic to a new article. It also keeps a record so that it knows the fork ID
of your topic maps to that specific article in Zendesk.

You make some changes to the topic and publish to Zendesk again. Paligo checks its internal
record and finds that the fork ID of your topic maps to the article in Zendesk. Paligo writes the
content of the topic to the article in Zendesk.

If Paligo has a record of the fork ID (1) mapping to an existing article (2), it will transfer the topic content
to the article.

The product you work on is being updated, and you need to add new content to the topic. But you
also need to have the original version available. To make this possible, you create a branch of the
topic. You make the branch in the publication, so that the branched version of the topic uses the
same fork ID as the original topic.

You write new content in the branched version of the topic. When the new product is ready, you
publish your content to Zendesk. Paligo checks its internal record and finds the fork IDs of your
original topic and branched version topic has been used to map to an article before. Paligo ignores
the original topic and maps the latest version (the branched version) of the topic to the article. So
the article in Zendesk is updated with content from your branched topic.
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The branched topic has the same fork ID (1) as the original topic and so is mapped to the same Zendesk
article (2) as the original topic.

You could also merge the branched version of the topic with the original topic. This gives you
the option to add all or some of the branched version to the original topic (you can choose
which elements are copied to the original topic, see Merge Branches [1658]). When you publish to
Zendesk, the original/merged topic is written to the article, as it is the most recent version and its
fork ID maps to the article.

When you merge a topic, the topic that receives the merged content continues to use its own fork ID.

Example 76. Branching Outside the Publication will Create New Articles in
Zendesk

This example shows how Paligo maps content to Zendesk when you branch a topic outside a
publication so that the branched version and original topic use different fork IDs.

Let's start with a publication and a topic. When you add a topic to a publication, Paligo creates a
fork ID. It uses the fork ID as a record of the relationship between the publication and the topic.

You decide to publish to Zendesk for the first time. Paligo checks its internal record to see if the
topic's fork ID has been used to map to any articles in Zendesk. It has not, as there are no articles
yet, and so Paligo maps the topic to a new article. It also keeps a record so that it knows the fork ID
of your topic maps to that specific article in Zendesk.

You make some changes to the topic and publish to Zendesk again. Paligo checks its internal
record and finds that the fork ID of your topic maps to the article in Zendesk. Paligo writes the
content of the topic to the article in Zendesk.

If Paligo has a record of the fork ID (1) mapping to an existing article (2), it will transfer the topic content
to the article.

The product you work on is being updated, and you need to add new content to the topic. But you
also need to have the original version available. To make this possible, you create a branch of the
topic. You make the branch in the publication, so that the branched version of the topic uses the
same fork ID as the original topic.
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You write new content in the branched version of the topic. When the new product is ready, you
publish your content to Zendesk. Paligo checks its internal record and finds the fork IDs of your
original topic and branched version topic has been used to map to an article before. Paligo ignores
the original topic and maps the latest version (the branched version) of the topic to the article. So
the article in Zendesk is updated with content from your branched topic.

Paligo also checks its internal record for the fork ID of your branched version. The fork ID has not
been used to map to an article before. So Paligo creates a new article in Zendesk and writes the
content of the branched topic to the new article.

The branched topic has a different fork ID (3) to the original topic (1). So the original topic maps to one
article in Zendesk (2) and the branched topic maps to a different Zendesk article (4).

View the Paligo-to-Zendesk Mapping

Abstract
Zendesk Preflight allows you to map your topics in Paligo to Zendesk Guide articles with full
control over what gets updated, deleted, or added.

When you publish from Paligo to Zendesk, you choose a Zendesk layout to use and a category to
publish to. At that stage, Paligo is able to show you how your Paligo content will be published to
Zendesk sections and articles. You can see a preview on the Zendesk Preflight tab.

The Zendesk Preflight tab can show you how Paligo is going to:
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• Create new articles in Zendesk that map to topics in Paligo.

• Update existing sections and articles in Zendesk.

• Delete articles in Zendesk.

NOTE
"Mapping" is the term we use for how Paligo matches a Paligo topic to a Zendesk
section or article.

Access the Zendesk Preflight Tab
To access the Zendesk Preflight tab:

1. In the Content Explorer, select the option menu ( ...) for your publication and then select
Publish.

2. On the Publish document dialog, select HTML. Then select the Zendesk layout you want to use
and choose the Zendesk Category you are going to publish to.
You will need a Zendesk Layouts [1600] for publishing. You can use one of the built-in Zendesk
layouts or create one of your own. They are special types of HTML layout.

3. Select the Zendesk Preflight tab to see how Paligo is going to map the topics in your
publication to your Zendesk when you publish.

NOTE
If you use saved publishing settings, there is a different way to access
the Zendesk Preflight tab (see Saved Settings and Paligo-to-Zendesk
Mapping [1565]).

Zendesk Preflight Overview
The Zendesk Preflight tab provides you with a preview of how Paligo will map your content to
Zendesk. You can also use the Zendesk Preflight to Customize Paligo-to-Zendesk Mapping [1566].

At the top of the tab, Paligo provides you with information about the number of "resources" that
are going to be created, updated, or deleted. "Resources" is the term we use for Zendesk content
and it can include sections and articles.

On the left, there is a hierarchical mapping list. This is where you can see how Paligo is going to
publish your Paligo topics to Zendesk. It matches each topic to an existing section or article or will
create a new section or article. The process of matching topics to sections and articles is called
"mapping".
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The list can show:

• Topics that are going to be mapped to new sections or articles in Zendesk. These are shown with
a plus icon.

• Topics that are going to be used to update existing sections or articles in Zendesk. These are
shown with an update icon.

• Articles that Paligo is going to delete from your Zendesk. These are shown with a cross icon.

• Articles that Paligo published to Zendesk previously, but they have since been moved in
Zendesk. These are shown with a red copy icon.

By default, Paligo will create a new article at the location that Paligo expects the article to exist.
You can control this behavior by using the Strict Mapping feature in the integration settings. For
single brand Zendesk instances, see Connect Paligo to Zendesk [1532]. For multibrand Zendesk,
see Connect Paligo to Multiple Zendesk Brands [1546].

• Articles that exist in Zendesk, but are not mapped to any topics in Paligo. These are shown as
"grayed out" entries.
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The "grayed out" articles could be articles that were created in Zendesk and have no matching
topic in Paligo.
They could also be articles that were previously mapped to Paligo topics, but the mapping has
since been broken, so now the articles are unmapped.

TIP
If you can see that Paligo is going to create a new article and there is a "grayed
out" article of the same name, it is because the "grayed out" article is no longer
mapped. So Paligo thinks the topic should become a new article.

The structure of the mapping comes from the type of Zendesk layout you are using (Multi-Section
Zendesk Layouts [1613] or Single-Section Zendesk Layouts [1612]).

Each mapped "resource" in the list has a checkbox that you can use to control whether the
resource is published to Zendesk.

On the right, there are settings for controlling the status of new articles. These apply to all new
articles, but it is also possible to change the status for individual topics. To find out more see Set
the Status of Content that is Published to Zendesk [1573].

If you are happy with the existing mapping settings, you can Publish Content to Zendesk [1580].

But you can also use the Zendesk Preflight tab to change the way content is mapped to Zendesk.
To find out how to make changes, see Customize Paligo-to-Zendesk Mapping [1566].

Saved Settings and Paligo-to-Zendesk Mapping
You can save your publishing settings so that you do not have to re-enter the same settings each
time you publish (see Publishing Settings [1076]). When you publish to Zendesk, you can select
the saved settings and then use the Zendesk Preflight tab to see how your content is going to be
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"mapped". Your topics will either be mapped to new sections or articles in Zendesk or used to
update existing sections and articles.

To use the Zendesk Preflight tab with saved settings:

1. In the Content Manager, select the options menu ( ... ) for the publication you want to publish
to Zendesk, and select Publish.

2. On the Publish Document dialog, select the Saved Settings tab.

3. Check the box next to the publishing settings you want to use. When you check the box, the
Zendesk Preflight tab appears.

4. Select the Zendesk Preflight tab to see how your Paligo content will be mapped to Zendesk.

You can use the Zendesk Preflight tab to view or change the mapping as described in:

• View the Paligo-to-Zendesk Mapping [1562]

• Customize Paligo-to-Zendesk Mapping [1566].

Customize Paligo-to-Zendesk Mapping

Abstract
Zendesk Preflight lets you control how your topics in Paligo are mapped to Zendesk Guide articles
and sectons.

With Paligo's Zendesk Preflight feature, you can control how your Paligo content is mapped
to Zendesk. It is available on Single-Section Zendesk Layouts [1612] and Multi-Section Zendesk
Layouts [1613] Zendesk layouts. For details on how to display it, see View the Paligo-to-Zendesk
Mapping [1562].
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NOTE
If you use saved publishing settings, there is a different way to access
the Zendesk Preflight tab (see Saved Settings and Paligo-to-Zendesk
Mapping [1565]).

When you display the Zendesk Preflight tab, it shows the mapping that will take place if you
publish to Zendesk. You can customize the mapping to meet your own requirements or you can
leave the existing mapping in place.

Before you make changes to the mapping, we recommend that you familiarize yourself with the
Zendesk structure [1613]. You will also need to know which type of Zendesk layout [1600] you are
going to use for publishing. There are two different types, multi-section and single-section, and
they map the top-level content differently.

NOTE
The Zendesk layout also has some settings that you can use to control certain
parts of the mapping. For example, you can control how the titles of Paligo topics
are mapped to heading levels in the Zendesk articles. To find out more, see Edit a
Zendesk Layout [1602].

Choose What Content is Published to Zendesk
The Zendesk Preflight feature gives you control over which topics are published to Zendesk. You
can choose to publish an entire publication, just a selection of its topics, or even a single topic if
you prefer.
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1. View the Paligo-to-Zendesk Mapping [1562].

2. Look at the list of categories, sections, and articles. Each of them has a checkbox.

If you want to publish the content to Zendesk, check its box.
If you want to exclude the content from publishing, so that it is not added to Zendesk or used
to update Zendesk articles, clear the box.

3. If you have made all of the mapping changes [1566] you need and have set the languages,
filters, etc. on the tab [1580], select Publish document to start the publishing process.
When you publish your content, Paligo will only publish those topics that have their boxes
checked.

Map a Topic to a Different Section or Article
You can use the Zendesk Preflight feature to change the mapping between a Paligo topic and a
Zendesk section or article. The changes you can make vary, depending on the existing mapping in
place.

If you are mapping a topic that is not currently mapped to an article or section, you can map it to:

• A new article or section. This is the default setting for a new topic.

• An existing unmapped article that is in the same section as the topic you are mapping

• An existing unmapped section that is in the same category that you are publishing to

If you are mapping a topic that is currently mapped to an article or section, you can remap it to:

• An existing unmapped article or unmapped section.

To map a topic to a different section or article:

1. View the Paligo-to-Zendesk Mapping [1562].

2. Browse the list to find the Paligo topic that you want to map, and select its cog icon to display
a dialog.

On the dialog, use the Mapping setting to choose the section or article that you want to map
to.
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3. This step only applies if you are mapping a topic to an article.
Use the other settings on the dialog to define the publishing status and promoted status to
control who can view and edit the article or section. To find out more about these settings, see
Set the Status of Content that is Published to Zendesk [1573].

4. Select Confirm.

5. If you have made all of the mapping changes [1566] you need and have set the languages,
filters, etc. on the tab [1580], select Publish document to start the publishing process.

When you publish your content to Zendesk, the Paligo topic will map to the section or article you
selected.

Replace a Mapped Topic with Another Topic
Typically, when you map a topic in Paligo to an article in Zendesk, you will want the topic and
article to keep their relationship. But it's possible that at some point, you may want to replace the
topic with a different topic, but map to the same article and URL in Zendesk. To do this, complete
the following steps:

1. In the Content Manager, find the publication that you publish to Zendesk and select it to
display it in the structure view.

2. In the publication structure, remove the topic that you want to replace.
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In the Publication structure, remove the topic that you want to replace. In this example, we are
removing "Troubleshooting".

3. Add the replacement topic to the publication structure.

Add the replacement topic to the Publication structure.

4. Use the arrow buttons to arrange your topics and reused publications into the order you
want. You can set them to display as a flat structure or you can "nest" topics and publications
so they have a more complex structure, with multiple levels of content. To learn more, see
Organize a Publication [100].
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5. In the Content Manager, find the publication and select its option menu ( ... ) and then select
Publish.

6. Set the publication to produce an HTML output and choose a Zendesk layout.

7. Select the Zendesk Preflight tab.
For multi-section Zendesk layouts, the mapping shows:

• The new topic is mapped to a new section and a new article.

• The article that was mapped to the topic you removed is now unmapped. Its section is also
unmapped. These are both shown as gray listings.

For single-section Zendesk layouts, the mapping shows:
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• The new topic is mapped to a new article.

• The article that was mapped to the removed topic is now unmapped. This is shown as a gray
listing.

The new replacement topic has a green plus icon, which shows that it is a new article that will
be created in Zendesk.

8. This step varies depending on whether you are using a multi-section or single-section Zendesk
layout.
If you are using a multi-section Zendesk layout:

1. Select the cog icon for the new section. On the dialog, use Mapping to select an
unmapped Zendesk section. Select Confirm.

2. Select the cog icon for the new article. On the dialog, use Mapping to select an unmapped
Zendesk article. Select Confirm.
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If you are using a single-section Zendesk layout:

• Select the cog icon for the new article. On the dialog, use Mapping to select an unmapped
Zendesk article. Select Confirm.

9. If you have made all of the mapping changes [1566] you need and have set the languages,
filters, etc. on the tab [1580], select Publish document to start the publishing process.

Set the Status of Content that is Published to Zendesk
In Zendesk, there are several settings that control who can see the articles and where the articles
appear:

• Draft/Publish status
If an article is in the Draft state, it exists in Zendesk but is not shown in the help center. In the
Publish state, it is "live" and appears in the help center.

• Managed by
This lets you choose which types of user can edit and publish an article, for example, Agents and
Managers. The Managed by setting is sometimes called Permission Group in Zendesk.

• Visible to
This lets you choose who can see this article when it is published in the help center. The Visible
to group is sometimes called the User Segment Group in Zendesk.

• Promoted
In Zendesk, articles can be promoted so that they appear at the top of a section and have a star
icon next to them. They can also appear on the home page, depending on what theme you are
using. You can set the promoted status in Paligo instead of having to set it in Zendesk.

When you publish content from Paligo to Zendesk, you can set the statuses of the content.

1. Display the Publish document dialog for your publication and set it to use a Zendesk layout
and choose a Zendesk category, as described in View the Paligo-to-Zendesk Mapping [1562].

2. On the Settings tab, use Managed by to define what user group can edit and publish your
articles.
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NOTE
Each article has its own Managed by setting, and if that is set, it will be used
instead of the Managed by on the Settings tab.

3. Select the Zendesk Preflight tab.

4. To set the status for all new articles, use the new article settings on the right.
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NOTE
You cannot set the promoted state for all new articles. You can only set the
promoted state for individual articles, see step Step 5.

5. To set the status for an individual article, browse to the article in the list and select its cog icon
to display a dialog.

On the dialog, you can set the draft/publish Status, Visible to, Managed by, and Promoted
statuses. Select Confirm when you have made your choices.
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TIP
You can also use this dialog to control the mapping [1568].

6. If you have made all of the mapping changes [1566] you need and have set the languages,
filters, etc. on the tab [1580], select Publish document to start the publishing process.

When you publish your content to Zendesk, the content will use the statuses that you have set.

Set Custom Labels for Mapping to Zendesk Articles
In Zendesk, each article can have labels that categorize the content, similar to how Taxonomies
work in Paligo (Business and Enterprise plans only). For example, you could have some
introductory training articles with labels for "Onboarding" and "Tutorial". When you map Paligo
topics to Zendesk, you can set the Paligo articles to have labels too.

1. Display the Publish document dialog for your publication and set it to use a Zendesk layout
and choose a Zendesk category, as described in View the Paligo-to-Zendesk Mapping [1562].

2. Select the Zendesk Preflight tab.
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3. Expand the sections to reveal the topics that will become articles in Zendesk. Select the cog
icon for the article you want to edit.

4. Use the Labels setting to define the labels for the article.

The Labels field shows the names of any labels and taxonomy tags that are already applied to
the article. Taxonomy tags are converted into labels in Zendesk.

NOTE
Existing labels are only shown (and kept) if Preserve Zendesk Labels is
enabled in the Zendesk integration settings [1532].

Taxonomies are only shown as labels if Publish taxonomies as labels is
enabled in the Zendesk integration settings [1532].

You can:

• Enter the name of a new label and press Enter. When you publish, Paligo will create that
label in Zendesk and associate it with the article.

• Enter the name of a label that already exists in your Zendesk and press Enter. Be careful
when typing as the text you enter must match the existing label name exactly. If it is
different, Paligo will create a new label with that name rather than associate the article with
the existing Zendesk label.

• Delete a label name to prevent the article from being associated with that label.

5. Select Confirm.
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6. If you have made all of the mapping changes [1566] you need and have set the languages,
filters, etc. on the tab [1580], select Publish document to start the publishing process.

Paligo will publish the content to Zendesk and apply the labels you have set.

Remotely Delete Zendesk Articles and Sections
To remotely delete sections and articles from Zendesk, use the Zendesk Preflight tab on the
Publish document dialog.

1. View the Paligo-to-Zendesk Mapping [1562].

2. Find the article that you want to remove in the list. You can delete articles and sections that
are not mapped to Paligo content.
You cannot delete new articles or sections from the list. If you do not want Paligo to create
them, clear their checkboxes or remove the matching topics from the publication instead.
If you want to remove a mapped section or article, you first need to "unmap" it. To do this,
remove the mapped topic from Paligo's publication and then publish. When the publish is
complete, the article in Zendesk becomes unmapped. You can then delete it remotely as
described in Step 3.

3. Select the delete icon next to the section or article that you want to remove.

You can cancel a deletion by selecting the restore icon (plus icon).

4. If you have made all of the mapping changes [1566] you need and have set the languages,
filters, etc. on the tab [1580], select Publish document to start the publishing process.

The deletion will take place when you publish to Zendesk.

IP Restrictions in Zendesk
If you have IP restrictions enabled in Zendesk, you need to set Paligo to use a static IP address
(via a gateway). Then, in Zendesk, you can whitelist Paligo's IP address so that it can publish to
Zendesk.

In Paligo, enable the Use the Paligo provided gateway when connecting to Zendesk option.

You will need to whitelist the IP address 34.249.89.180 in Zendesk. Paligo can then publish to
Zendesk even when "IP restrictions" is enabled in Zendesk.
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Taxonomies as Labels in Zendesk
You can set Paligo to include taxonomy tags when you publish to Zendesk. The taxonomy tags will
then appear as labels in the Zendesk articles that Paligo creates or updates.

NOTE
For the following process, we assume that you have already set up Paligo to
connect to your Zendesk instance. See Connect Paligo to Zendesk [1529] for
details.

1. If you have not already set up your taxonomies in Paligo:

a. Create a taxonomies hierarchy [1368]

b. Associate your taxonomy tags [1370] with the appropriate publications, topics, and
images

2. Select your profile in the upper right corner to display a menu, and then select Settings.

3. Select the Integrations tab, find Zendesk, and select Change.

4. Use the Taxonomies settings to control how Paligo's taxonomy labels are used.

• Use the Publish taxonomies as labels box to choose whether taxonomy tags are used as
labels in Zendesk.

• Use the Preserve Zendesk labels box to choose whether taxonomy tags are added as
labels in Zendesk in addition to any existing labels.
If you check the box, Paligo will leave any existing Zendesk labels in place. It will then
create new labels to match the taxonomy tags, but will not duplicate any existing tags. For
example, if you have a "software" taxonomy tag and there is already a "software" label in
Zendesk, Paligo will not create a second "software" label.
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If you clear the box, Paligo will remove all existing Zendesk labels and will create new labels
to match the taxonomy tags.

5. Select Save.

6. Publish your content to Zendesk.
For details, see Publish Content to Zendesk [1580].

7. In Zendesk, check that the labels have been applied to your articles.

If the taxonomy tags have not been applied to the articles as labels, check that the Paligo-to-
Zendesk connection is working. For this, you could update a topic in Paligo, publish to Zendesk
and check that the changes appear in the article.
If the article updates, but the taxonomies do not appear as labels, double-check that you have
applied the taxonomies settings in the Zendesk integration correctly. If they are in place, as
described in step 4, contact support for assistance.
If the article does not update, check that the Zendesk integrations are correct. If they are, but
you are unable to publish to Zendesk, contact support for assistance.

Publish Content to Zendesk
To publish content from Paligo to Zendesk, you need to have the following in place a:

• Valid connection from Paligo to Zendesk, see Connect Paligo to Zendesk [1529].

• Publication that contains the topics that you want to map to articles in Zendesk, see Create a
Publication [96].

NOTE
Paligo does not support publishing to articles that use “content blocks” in
Zendesk.

• Zendesk layout either use the built-in Zendesk Layouts [1600] or create your own, see Create a
Zendesk Layout [1601]).
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Publish to Zendesk

1. In the Content Manager, display the options menu for the publication that you want to
publish, and select Publish.

TIP
You do not have to publish an entire publication to Zendesk. You can also
publish part of a publication, for example, one chapter of a user guide. To
find out more, see Publish to Multiple Zendesk Categories [1583].

2. On the Settings tab, select HTML.

3. Choose the Zendesk layout that you want your publication to use.
The different types of Zendesk layout map content to Zendesk differently, so it is important
that you choose a layout that meets your requirements. To find out how each layout maps
content to Zendesk, see Zendesk Layouts [1600].

4. Choose the Zendesk category that will receive your selected Paligo content.
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5. Use the Managed by setting to choose which types of user can edit and publish the articles
that Paligo creates or updates in Zendesk. For example, you could choose Agents and
Managers. The Managed by setting is sometimes called Permission Group in Zendesk.

This setting is applied as the default for all articles that Paligo publishes to Zendesk, but you
can have different settings for individual articles as well. The individual settings take priority
over the default settings. You set Managed By for individual articles on the Zendesk Preflight
tab.

6. Use the Visible to setting to choose who can see the articles that Paligo creates or updates in
Zendesk. The Visible to group is sometimes called the User Segment Group in Zendesk.

This setting is applied as the default for all articles that Paligo publishes to Zendesk, but you can
have different settings for individual articles as well. The individual settings take priority over the
default settings. You can set Visible To for individual articles on the Zendesk Preflight tab.

7. Choose the language(s) to publish to. If you do not have any translations, you can only select
the original / source language.
If you have more languages already translated and approved, you can select multiple
languages for this publication. Check Combine selected languages to publish them as one
multilingual publication.

8. If you have set filter metadata (attributes) on topics or elements, and/or have used variables,
you can choose to apply filter values and variable values to profile your output here. See
Filtering / Profiling [1141] and Variables [1186] to learn how to use these features.

9. Select the Zendesk Preflight tab to View the Paligo-to-Zendesk Mapping [1562].
If you are happy with the existing mapping, you can proceed to the next step.
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If you want to change the mapping, you can use the various settings on the Zendesk Preflight
tab. You can map the Paligo topics to different sections and articles, change the Managed By and
Visible To status, set the topics to be draft or publish, and promote them as needed. To find out
more, see Customize Paligo-to-Zendesk Mapping [1566].

10. Select Publish document.
Paligo "pushes" the content in the publication to Zendesk. Map Content from Paligo to
Zendesk [1557] and sections and articles are created and / or updated.

Publish to Multiple Zendesk Categories
You can publish an entire publication, or parts of a publication, to different categories in Zendesk.
This is especially useful when you want sections of a publication to map to different Zendesk
categories. For example, if you had a "Mars Travel Manual" publication as shown below, you might
want to publish each "chapter" to a different Category in Zendesk (you could have a category for
"About Space Travel", a category for "Space Safety", a category for "The Mission Control Center"
and so on.
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To publish to multiple Zendesk categories:

1. In Paligo, edit your Zendesk Layout and enable the Fix cross links outside of publication
scope feature.

a. Select Layout.

b. Select the Zendesk layout that you want to edit. Paligo displays the Layout Editor.

c. Select Zendesk.

d. Select the Fix cross links outside of publication scope checkbox.

2. In the Content Manager, expand the publication that you want to publish to Zendesk.

3. Select the options menu ( ... ) for the part of the publication that you want to publish to
Zendesk. You can choose an entire publication or any "fork" in the publication. A "fork" is a
topic and its sub-topics ("child" topics).

4. Select Publish.

5. On the Settings tab, select HTML.

6. Choose the Zendesk layout that you want your publication to use.
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7. Choose the Zendesk category that will receive your selected Paligo content.

8. Choose the language(s) to publish to. If you do not have any translations, you can only select
the original / source language.
If you have more languages already translated and approved, you can select multiple
languages for this publication. Check Combine selected languages to publish them as one
multilingual publication.

9. If you have set filter metadata (attributes) on topics or elements, and/or have used variables,
you can choose to apply filter values and variable values to profile your output here. See
Filtering / Profiling [1141] and Variables [1186] to learn how to use these features.

10. Click Publish document.

Paligo "pushes" the content in the publication to Zendesk. Map Content from Paligo to
Zendesk [1557] and sections and articles are created and/or updated.

Repeat steps 2-10 of the process for each different Zendesk category.

NOTE
If you use branching to create different versions of your topics, see Map Branched
Content to Zendesk [1558] to learn how branched topics are mapped.

Re-Publish to the Same Category
When you publish content from Paligo to Zendesk, you choose a category, see Publish Content to
Zendesk [1580]. If you choose a category that Paligo has published to before, Paligo will:

1. Check the publication for new topics (topics that do not have a corresponding article in
Zendesk). For each new topic, Paligo creates a new article in Zendesk and writes the topic
content to it.
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2. Find the topics that already have a corresponding article in Zendesk. It then updates the
Zendesk articles with the latest content from the topics in the Paligo publication.

IMPORTANT
Paligo does not delete articles from Zendesk. So if you republish content to
Zendesk, you should check that the articles match the latest structure of your
Paligo publication. If any topics have been removed from the publication, you will
need to manually remove the corresponding articles in Zendesk.

NOTE
If you use branching to create different versions of your topics, see Map Branched
Content to Zendesk [1558] to learn how branched topics are mapped.

Remove articles from Zendesk
To remove articles from Zendesk, you can:

• Use Zendesk preflight to choose which articles to delete, and then publish

• Delete the articles manually in Zendesk.

To find out how to use Zendesk preflight to remove articles, see Remotely Delete Zendesk Articles
and Sections [1578].

Customize Zendesk articles using CSS
You can use a cascading style sheet (CSS) to change the appearance of the content you publish to
Zendesk. For example, if you wanted to change the appearance of notes or warnings, you could
use CSS to change the colors, sizing, spacing, etc.

As part of the publishing process, Paligo converts the Paligo content into HTML for Zendesk. The
element names in the Paligo content are transformed into divs with class names, for example, the
procedure element is converted into a div with class="procedure". In your CSS stylesheet, you can
use CSS to style the classes.

If you are new to CSS, the important thing to understand is that a CSS file does not affect your
content in Paligo. It just tells a browser how to display your published content.

TIP
If you want to learn about CSS, there are many websites that provide tutorials and
information, including www.w3schools.com. There is also an excellent example of
what you can achieve with CSS at http://www.csszengarden.com.

Use a Browser to Identify Styles
Most modern web browsers have a function that allows you to see the underlying code of a page
and also the styles that are in place. For example, Google Chrome has an Inspect feature and
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Mozilla Firefox has an Inspection feature. You can use these features to view the styles used by
your Zendesk articles and also to test out any changes you want to make.

NOTE
As part of the publishing process, Paligo converts the Paligo content into HTML
for Zendesk. The element names in the Paligo content are transformed into divs
with class names, for example, the procedure element is converted into a div with
class="procedure". In your CSS stylesheet, you can use CSS to style the classes.

For this procedure, we explain how to use Chrome's Inspect feature, but it is a similar process for
other browsers:

1. Run Chrome and go to an article in your Zendesk help center that imports content from
Paligo.

2. Right-click on the article and select Inspect.

The web browser reveals the inspection tools. They show the underlying code of the web page
and the CSS styles that are in place.

3. Select the element selector (1) and then select part of the article that you want to change, for
example, a heading.
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The inspection tool highlights the code (2) for the part of the article that you have selected and
it also shows you the styles that are in place (3).

4. You can make changes to the styles in the inspection tool to see how the changes will affect
the article. For example, you could change the color of a heading.

Now that you have identified the styles you need to alter and tested the changes, you can add
them to your CSS stylesheet [1589].
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Create your own Stylesheet
You can create your own CSS file and use that to style your Zendesk content. When creating a CSS
stylesheet, it is important that:

• The CSS is valid

• The CSS file is added to the Assets in Zendesk

• The CSS file is referenced in the document-head.hbs template in Zendesk.

Here, we assume that you have already published to Zendesk and have added the paligo-zd.css
file to your Zendesk assets and referenced it in the document-head.hbs template (as described in
Customize Zendesk articles using CSS [1586]).

1. Use your web browser's inspection tool feature to identify the styles that you want to
change [1586].

2. Use a CSS editor to create a new CSS file.

3. Make your changes to the CSS.

TIP
If you want to learn about CSS, there are many websites that provide tutorials
and information, including www.w3schools.com. There is also an excellent
example of what you can achieve with CSS at http://www.csszengarden.com.

4. Save the CSS.

5. Upload your CSS file to your Zendesk Assets.
To upload, select Customize Design > Edit theme > Edit Code and then add or drag and drop
your CSS file into the Assets folder.

6. Change the reference in the document_head.hbs template in Zendesk.
To edit the document_head.hbs template, select Customize Design > Edit theme > Edit Code
and then select the document_head.hbs template. Add the reference to your .css file at the
bottom of the list of references, for example, add:
<link href=“{{asset ‘mycustomstyles.css’}}” rel=“stylesheet” type=“text/
css” />

IMPORTANT
The order of the references to css files is important. The web browser will
apply the styles from the top reference first, then the second reference, and
so on. So if there are styles in the last referenced CSS file that conflict with
styles in the first CSS file, the browser will use the styles in the last CSS file.
The only exception is where "!important" is used in the styles (!important will
take priority, unless it conflicts with another !important, in which case, the
first-to-last cascading rule applies).

7. Publish your changes in Zendesk.

Example 77. Customising Tables with CSS

In this example, you will see how you can use your own CSS file to change the appearance of
tables. We'll start with an "About Space Travel" article that contains a table.
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The default table style in paligo-zd.css has no border or colored
background.

You can use CSS to change the appearance, such as giving the
table rows colors and changing the width.

To make the style changes, you start by using the web browser's inspection feature to look at the
styles that are currently applied to the content. The parts of the code that you need to style are the
overall table (table), table header (th), and table rows (tr).

You decide to create your own css file for styling the table.

Using a CSS editor, you create the following CSS:

   
    
        /*Set border on table head and table cells */
        table td,
        table th{
            border: 1px solid #666;
        } 
        
        /*Set width and border spacing for entire table */
        table{
            width: 98%;
            border-spacing: 0px;
        }

       /* alternating table row colors*/
       tr:nth-child(even) {background: #f8fbfd}
       tr:nth-child(odd) {background: #e8f4fb}

        /* set rounded corners to zero initially */
        th, td {
            border-radius: 0;
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        }

        /*set amount of rounding per corner */
        thead tr:first-child th:first-child, 
        table tr:first-child td:first-child,
        tbody tr:first-child th:first-child {
            border-top-left-radius: 0.6em;
        }
        thead tr:first-child th:last-child, 
        table tr:first-child td:last-child,
        tbody tr:first-child th:last-child {
            border-top-right-radius: 0.6em;
        }
        tbody tr:last-child td:first-child, 
        table tr:last-child td:first-child,
        tbody tr:last-child th:first-child {
            border-bottom-left-radius: 0.6em;
        }
        tbody tr:last-child td:last-child, 
        table tr:last-child td:last-child,
        tbody tr:last-child th:last-child {
            border-bottom-right-radius: 0.6em;
        }

        thead + tbody tr td,
        tr + tr td ,
        tr + tr th {
            border-top: 0;
        }

        tr th + th,
        tr td + td {
            border-left: 0;
        }

        /* shade table header cells */
        table th {
            background-color: #0072ef;
            color: #FFF;
        }

You save the CSS file as "custom-table.css".

Now you need to add the file to Zendesk and set it to be referenced for each Zendesk
article. In Zendesk, you browse to Customize design > Edit theme > Edit code and add the
custom.table.css as an asset.

You then open the document_head.hbs template and add the following line at the bottom of the
list of references to CSS files:

<link href=“{{asset ‘custom-table.css’}}” rel=“stylesheet” type=“text/
css” />

You publish the template to save the changes.

Now when you view the "About Space Travel" article, it uses the table styles from your custom CSS
file (with the exception of styles that are set to !important in the other CSS files).
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Customize Zendesk Articles Using Javascript
You can use JavaScript (JS) to add extra or different functionality to your Zendesk help center. We
recommend that you create your own custom JavaScript files rather than make changes to the JS
files Paligo provides.

Create your own JavaScript to Customize Zendesk
To create your own JS files to customize your Zendesk help center:

1. Publish your content to Zendesk [1580] and then decide on what extra functionality you need.

2. Create your own JavaScript (JS) files to provide the extra functionality.

3. In Zendesk, browse to Customize design > Edit theme > Edit code and then add your
JavaScript files as assets.

4. In Zendesk, open the document_head.hbs template and add the following line to the list of
references to JavaScript files:
<script src="{{asset 'yourscript.js'}}"></script>

Where yourscript.js is the name of your JavaScript file, for example, flagicons.js.

5. Publish the template to save it in Zendesk.

JavaScript Provided by Paligo for Zendesk
When Paligo publishes to Zendesk, it provides a package that downloads in your web browser. The
package contains CSS files and JavaScript files, and for the first publication to Zendesk, you need to
add some of the files to your Zendesk assets [1538].

We recommend that you create your own custom JavaScript files if you want to add or change
functionality in Zendesk. However, if you really need to change the functionality that the Paligo
JavaScript files provide, you can customize them. This does have some consequences that you
need to be aware of:

• In future, Paligo may provide updated versions of the JS files. If you copy the updated versions
into your Zendesk assets, you will lose the customizations you have made. So you will need to
make your changes again.

• If you decide to not use updated versions of the JS files, your customizations will remain in place.
But you will not have any of the extra functionality that is included in any updated versions.

The JavaScript files that Paligo provides are:

File Description

paligo-zd.js Used for resolving links between articles and embedding code.
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File Description

paligo-zd-lightbox.js Provides the lightbox functionality for images (when you select an image in an article, a larger
version of the image appears).

paligo-zd-glossary.js Provides the pop-up glossary functionality. If there is a glossary term in a Zendesk article, you can
hover the cursor over it to display the definition of that term.

paligo-stickymenu.js Provides extra menu features, including:

• Keeps the menu in place at the top when you scroll on a page

• Adds a sub menu for the currently viewed article, which is very useful if you have long sections
that become articles, as it provides internal navigation.

• Makes the menu scrollable when it is too long to fit on the page.

lightbox.min.js This script needs to be in place for the lightbox functionality. It is used in conjunction with the
paligo-zd-lightbox.js script.

bootstrap.min.js This script needs to be in place for the extra menu features. It is used in conjunction with the
paligo-stickymenu.js script.

To get the Paligo JavaScripts to work in Zendesk, add them as assets and reference them in the
document_head.hbs template. This only has to be done once, and it is usually setup when the
Paligo to Zendesk integration is set up. For details on moving and referencing the assets, which
include CSS as well as JavaScript, see Step 4: Add the CSS and JS files to Assets in Zendesk [1538].

Glossaries in Zendesk
If your Paligo publication contains a glossary, you can publish it to Zendesk along with your
content. But you may need to add it in several places, depending on whether you are publishing to
a single category or to multiple categories.

Glossary in Publication Mapped to Single Zendesk Category
If you want to publish an entire publication to a single category in Zendesk, add the Glossary topic
to your publication. It only needs to be included once as all of the publication's topics are going to
be mapped to a single category.
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Glossary in Publication Partly Mapped to Different Zendesk Categories
In Zendesk, the glossary does not work across different categories. The workaround for this is to
include the glossary in each Paligo section that you are publishing to a different category. When
the content is mapped to Zendesk, each Zendesk category will have a working version of the
glossary.

To add a glossary to multiple sections in Paligo:

1. Select the publication to view its structure.

2. Add the Glossary topic to each section that you are going to publish to a different category in
Zendesk.

3. Save the publication.

4. Publish each section to Zendesk (see Publish to Multiple Zendesk Categories [1583]).

Example 78. Glossary in Multiple Sections for Mapping to Zendesk

Let's say that you have a "Mars Travel Manual" publication and it has 4 "chapters" ("About Space
Travel", "Space Safety", "The Mission Control Center", and "Travelling to Mars"). You want to map
each chapter to a different category in Zendesk and you want to include a glossary.

As the Paligo content is going to be mapped to 4 categories, you add 4 instances of the Glossary
topic to the publication structure, one for each "chapter".
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NOTE
When you publish to Zendesk, each category in Zendesk will have a working
glossary.

Embed Swagger OpenAPI for Zendesk
If you have Swagger OpenAPI content online, you can use Paligo to present that content in
Zendesk. To make this work, you create a topic in Paligo and add a link to your Swagger OpenAPI
content. Then you publish the topic to Zendesk where the topic is presented as an article. The
article contains an embedded "live" version of your Swagger OpenAPI content.
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TIP
Paligo also supports Embed Swagger OpenAPI [527] outputs and you can also
Import Swagger OpenAPI [1806].

Set Paligo to Publish Swagger OpenAPI to Zendesk
The first part of the process is to add a link to your Swagger OpenAPI content to a topic in Paligo,
and then publish it to Zendesk. To publish to Zendesk, your Paligo instance has to be set up to
connect to your Zendesk. To find out more about setting up the Paligo-to-Zendesk connection, see
Connect Paligo to Zendesk [1529].

When your Paligo instance is set up to connect to Zendesk, you can add the link to a topic and
publish it:

1. Create a Topic [131] that will contain the embedded Swagger content.

2. In the element structure menu, select the top section element and then select Go to
element. Then, in the Element attributes section, make sure the section element is selected
and add a role attribute with the value: swagger-topic.
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3. In the topic add a para element (or use an existing empty para element).

Press Alt  and Enter  (Windows) or Option ⌥  and Enter  (Mac) to display the Element

context menu. Then search for the element you want to add or select it from the list.

4. Inside the para element, add a link element.

5. In the element structure menu, select the link element. Then add these attributes and values
in the Element attributes section:

• role and set its value to swagger-ui

• xlink:href and set its value to the URL of the JSON or YAML file of your Swagger content.

TIP
If you don't have your Swagger content available yet, but want to test the
integration, you can use the standard Swagger "Pet Store" example, using
the URL https://petstore.swagger.io/v2/swagger.json.

6. Select Save.

7. Add the topic to a publication and then publish it using a Zendesk layout. If you need
instructions on how to do this, see Publish Content to Zendesk [1580].
When you publish, the content is "pushed" to Zendesk and a zip file is downloaded in your
browser. You will need the zip file for the next part of the process, which is Set Zendesk to
Show Swagger OpenAPI Content from Paligo [1598] .
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Set Zendesk to Show Swagger OpenAPI Content from Paligo
When you have Set Paligo to Publish Swagger OpenAPI to Zendesk [1596] , you can set up Zendesk
to show the embedded content:

1. Log in to your Zendesk as an administrator.

2. Select Settings (cog icon) and then in the Guide settings category, look for the Security
section. Check the Display unsafe content box.

Zendesk provides a warning that enabling this feature means potentially malicious code could
be run when viewing articles. This is your choice to make, but the Display unsafe content
feature has to be enabled for javascript to work, and javascript is needed to embed the
Swagger / Open API content. (The feature also has to be enabled even if you just want to show
video in your Zendesk articles.)

3. Select Update at the top of the page to confirm.

4. Select Customize Design (eye icon) and then select your Zendesk theme to view the theme
settings.

5. Select Edit Code .

6. Open the Assets folder.

7. Unzip the zip file that downloaded in your browser when you published from Paligo to
Zendesk (the last step in Set Paligo to Publish Swagger OpenAPI to Zendesk [1596]).

8. Find the JS > Zendesk folder and the CSS > Zendesk folder in the downloaded package. These
contain the CSS and javascript files you need to add to your Zendesk assets. You can ignore
the other files in the downloaded package.
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9. Add or drag and drop the files from the two Zendesk folders into the Assets in Zendesk.

10. In the Zendesk theme, open the Templates folder and then select document_head.hbs.

11. The document_head.hbs should already contain references to the asset files from when you
first set up in the Paligo-to-Zendesk connection. They should look something like this (the
exact content may depend on what else you have there and if you have chosen to use all
provided Paligo assets or not):

<script src="{{asset 'bootstrap.min.js'}}"></script>
<script src="{{asset 'lightbox.min.js'}}"></script>
<script src="{{asset 'paligo-zd-lightbox.js'}}"></script>
<script src="{{asset 'paligo-stickymenu.js'}}"></script>
<script src="{{asset 'paligo-zd-glossary-3.js'}}"></script>
<script src="{{asset 'paligo-zd.js'}}"></script>
<link href="https://maxcdn.bootstrapcdn.com/font-awesome/4.7.0/css/font-
awesome.min.css" rel="stylesheet"/>
<link href="{{asset 'lightbox.min.css'}}" rel="stylesheet"/>
<link href="{{asset 'paligo-zd.css'}}" rel="stylesheet" type="text/
css" />
<link href="{{asset 'paligo-
stickymenu.css'}}" rel="stylesheet" type="text/css" />

NOTE
The references use the Zendesk curly brackets syntax to refer to uploaded
assets.

If your document_head.hbs does not contain these references, add them.
You should also add the following code, which is for the swagger content:
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<link id="swaggercss" rel="stylesheet" type="text/css" href="https://
cdnjs.cloudflare.com/ajax/libs/swagger-ui/3.24.2/swagger-ui.css" /> 

<script src="https://cdnjs.cloudflare.com/ajax/libs/js-yaml/3.13.1/js-
yaml.min.js"></script> 
<script src="{{asset 'paligo-swagger.js'}}"></script> 

12. Select Publish.
Your Zendesk is now set to show Swagger content. In Paligo, you can publish the topic with
the Swagger link and set the output to Zendesk. The topic is mapped to an article in Zendesk,
and that article shows the Swagger/Open API content that is the "target" of the link.

Zendesk Layouts
To publish content to Zendesk, Paligo uses Zendesk layouts. You can think of Zendesk layouts as
templates that define how Paligo will map your topics to sections and articles in Zendesk.

Paligo has a built-in layouts for each type, and you can publish with those. Alternatively, you can
Create a Zendesk Layout [1601]. The layouts map Paligo content to Zendesk differently, and so it is
a good idea to understand the differences before you use them.

The Zendesk layouts you can use are:

• Single-Section Zendesk Layouts [1612]
Use this layout if you want to map a Paligo publication to a section in Zendesk, with top-level
topics becoming articles. Lower-level topics become subsections in the articles. To find out
more, see Single-Section Zendesk Layouts [1612].

• Multi-Section Zendesk Layouts [1613]
Use this layout if you want to map top-level Paligo topics to top-level sections in Zendesk, with
articles inside those sections. To find out more, see Multi-Section Zendesk Layouts [1613].

• Zendesk Enterprise Layouts [1615]
This layout is only available if you have the Paligo Enterprise plan and the Zendesk Enterprise
plan. Use it to map several levels of Paligo content to multi-level sections in Zendesk, with
articles inside the sections. To find out more, see Zendesk Enterprise Layouts [1615].

In each Zendesk layout, there are settings that you can apply to all of the content that is published
with that layout. To find out about the settings, see Edit a Zendesk Layout [1602].
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NOTE
A Zendesk Layout is for defining how Paligo features and content are published
to Zendesk. They are not used for styling the content in Zendesk (see Customize
Zendesk articles using CSS [1586]).

TIP
You can also use Customize Zendesk articles using CSS [1586] and Customize
Zendesk Articles Using Javascript [1592] to change the appearance and
functionality of the content in Zendesk.

Create a Zendesk Layout
If the built-in Zendesk layouts do not meet your requirements, you can create your own. Before
you create a Zendesk layout, you should connect Paligo to Zendesk by following the instructions in
Connect Paligo to Zendesk [1529].

To create a Zendesk layout:

1. Select the Layout menu.

2. Select Create New Layout.

3. Give the layout a name in the Layout Title field.

4. Choose the Output Format.The Output Format is the base layout for your new layout.
The base layout defines:

• The type of content you can create with your new layout. For Zendesk, you need to choose a
Zendesk HTML base layout.

• Where the default values for your new layout come from. In your new layout, if you set the
value of a setting to Default, it means the value for that setting comes from the base layout.
Your new layout "inherits" the value from the base layout. To find out more, see Layout
Relationships - Base, New, Duplicate [1055]

Paligo has three types of built-in Zendesk layout that you can use as the base layout.
Alternatively, you can use one of your own Zendesk layouts, but those must have been based
on one of the built-in layouts originally. The three built-in Zendesk layouts are:
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• Zendesk Multi-Section: We recommend this option for most projects. It sets Paligo to map
the top-level topics in Paligo to sections in Zendesk. Paligo's second-level topics are then
mapped to articles, and any third-level or lower topics are subsections within the articles.
To find out more, see Multi-Section Zendesk Layouts [1613].

• Zendesk Single-Section: Use this option if you want top-level topics in Paligo to be mapped
to articles in Zendesk. All level-two and lower topics in Paligo will become sub-sections in the
articles in Zendesk. This can result in long articles.
To find out more, see Single-Section Zendesk Layouts [1612].

• Zendesk Enterprise: Use this option if you want to map topics in Paligo to multiple levels of
sections in Zendesk (sections inside other sections).
To find out more, see Zendesk Enterprise Layouts [1615].

NOTE
Your choice of layout type affects how topics are mapped to Zendesk sections
and articles. You can Customize Paligo-to-Zendesk Mapping [1566] to control
which articles and sections are mapped to, but the structure comes from the
layout.

5. Select OK to save the layout.

The default settings for the layout are designed to be suitable for most Paligo-to-Zendesk
publications. You can make changes to the layout if required (see Zendesk Layouts [1600]).

When you have connected Paligo to Zendesk and set up a Zendesk layout, you can Publish Content
to Zendesk [1580].

TIP
We recommend that you set up a category in Zendesk that will not appear to your
customers. You can then use your layout to publish to that location and test the
Paligo-to-Zendesk publication process.

Edit a Zendesk Layout
Each Zendesk layout contains settings that affect your content when you publish. By editing your
Zendesk layout, you can change:

• How cross-references between categories are handled

• Whether Paligo creates sections and articles for topics, or only articles

• Whether individual styling can be used for label, number, and title in formal elements

• The number of section levels you can map content to (Zendesk Enterprise layouts only).

Open Zendesk Layout
To edit a Zendesk layout:

NOTE
When you have connected Paligo to Zendesk and set up a Zendesk layout, you
can Publish Content to Zendesk [1580].
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1. Select Layout.

2. Select the Zendesk layout that you want to edit. Paligo displays the Layout Editor.

3. Make your changes to the layout.
The General, Classes and Attributes, and Verbatim (code and software) settings are all
common HTML Layout Editor Options [672].
Most of the Toc and chunking settings do not apply to Zendesk, however there is one
exception. If you are using a Zendesk Enterprise layout, you can use the Chunk section depth
to Set the Section Levels for Mapping to Zendesk [1611].
The Zendesk settings are specific to Zendesk layouts and you can use them to:

• Fix Cross-References between Zendesk Categories [1603]

• Control whether Paligo Creates Articles for "Section" Topics [1607]

• Use Separate Styling for Labels, Numbers, Captions and Titles [1609].

4. Select Save.

Fix Cross-References between Zendesk Categories
If your publication has topics that contain cross-references to other publications, you should
enable the Fix cross links outside of publication scope feature before you publish to
Zendesk. This setting allows Paligo to resolve links in Zendesk, so that cross-references between
publications will work in your Zendesk articles. You can find the setting on a Zendesk Layout.
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With the Fix-cross links outside of publication scope setting enabled, Paligo can automatically
resolve links between publications. But it can only resolve links that:

• Are to topics that are not reused in different contexts
If you have cross-publication links, and the target topic for the link is only used once in the
publication, Paligo will resolve the link. This is because the target topic is only used in one
context and only exists in one place in the publication.

• Are to the "fork" for topics that are reused in different contexts
You may have cross-publication links where the target of the link is a topic that is used in several
places in the publication. Obviously, Paligo cannot link to all instances of the topic at once, so
you need to choose which instance you want the link to go to. You do this by adding a link to the
"fork" for the topic in the publication, rather than linking directly to the topic.
A "fork" is the reference from the publication to the topic and you can see them by expanding
the publications in the Content Manager.

When you add links between publications, you can set the target of the link to be a fork rather
than a topic. To do this, expand the publication in the New cross-reference dialog, and then
select the fork for the topic (shown as a gray topic inside the publication's hierarchy).
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• Have been published to Zendesk before
If your publication has links to topics/articles that have not been published before, Paligo
cannot resolve the links. The problem is that the content that contains the links (the source) is
linking to content that does not exist in Zendesk. The "source" cannot link to a "target" that does
not exist. But there are two easy solutions:

• Publish the "target" content before you publish the "source" content.

• Publish the "source" content, then publish the "target" content, and then publish the "source"
content again.

To enable the Fix cross links outside of publication scope setting:

1. Select Layout.

2. Select the Zendesk Layout that you want to change.

3. Select Zendesk.

4. Check the Fix cross links outside of publication scope box to enable this feature.

5. Select Save.

6. Publish your content to Paligo using the Zendesk Layout you have edited (see Publish Content
to Zendesk [1580]).

NOTE
You may need to publish to Zendesk twice for the publication-to-publication links
to work.

Example 79. Resolving links between Zendesk categories

Let's say you have two publications in Paligo: "Category A" and "Category B".
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"Topic A" contains links to "Topic C" and "Topic E", which are topics in a different publication
("Category B").

You want to publish the "Category A" and "Category B" publications to Zendesk. In Zendesk, you
create a category for each publication. You name the Zendesk categories to match the publication
names, so the "Category A" publication will map to "Category A" in Zendesk.

1. You enable the fix cross links outside of publication range option in a custom Zendesk
Layout:

(The reason it is not enabled by default is for backwards compatibility).

2. You publish the "Category A" publication to Zendesk. You use your custom Zendesk layout for
the publication and set the destination Zendesk category to "Category A":

3. You publish "Category B" in the same way, but set the destination Zendesk category to
"Category B".

4. You check the results in Zendesk. At this point, the links from "Topic A" to "Topic C" and "Topic
E" are broken. This is because the target articles ("Topic C" and "Topic E") did not exist in
Zendesk when you published "Category A". However, Paligo has stored the ids for the target
articles.
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5. You publish both publications again, using the same custom Zendesk layout.
(In this example, it would have been enough to re-publish "Category A", as that's the only
publication that contained links to another publication. But in a real-life scenario, you might
have links back and forth between multiple publications, and so you would need to re-publish
each one again.)

The links are now fixed and work as expected. This is because Paligo had stored the
destination ids on the first publish. On the second publish, Zendesk contained the target
articles, and the links could be resolved, even though they were in separate categories.

Control whether Paligo Creates Articles for "Section" Topics
If you use a Multi-Section [1613] or Enterprise [1615] Zendesk layout, Paligo can map topics to
sections and articles. By default, any topic that maps to a section will also have an article inside
that section. The article contains any content that was inside the topic in Paligo.

For example, let's say you have a topic called "System Requirements" in your Paligo publication,
and that is going to be mapped to a section in Zendesk. When you publish, Paligo will create/
update a Zendesk section called "System Requirements" and it will create a topic inside it also
called "System Requirements". This is because in Paligo, the "System Requirements" topic can
contain content, but in Zendesk, sections cannot contain content. So rather than lose that content
completely, Paligo creates an article for it.

But if you prefer, you can set Paligo to create a section, but not a matching article. Some Paligo
users prefer this approach, as it means the structure of the Paligo publication more closely
matches the structure of the sections and articles in Zendesk. To do this, use the Create article
for the section topic setting in your Zendesk layout.

IMPORTANT
If you disable the Create article for the section topic setting, any content in the
"section" topics will be unavailable in Zendesk. For this reason, you should leave
your "section" topics empty apart from their title.
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To control whether Paligo creates articles for "section" topics:

1. Select Layout.

2. Select the Zendesk Layout that you want to change.

3. Select Zendesk.

4. Set the Create article for the section topic to:

• Enabled: Paligo will create a Zendesk section and an article for top-level topics in a
publication.

• Disabled: Paligo will create a Zendesk section for top-level topics in a publication.

5. Select Save.

Example 80. Topics mapped to Sections and Articles in Zendesk

With the default settings in place, Paligo creates a Zendesk section and an article for each top-level
topic in a publication.
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In the image, 1, 2, and 3 are all top-level topics. When they are published to Zendesk, Paligo
creates a section for each of them, and also an article inside each section. If you look at the
"Introduction" topic (2), you can see that in Zendesk, there is an "Introduction" section. Inside that
section, there is an "Introduction" article. The content that is in the "Introduction" topic in Paligo is
shown in the "Introduction" article in Zendesk.

If you change the Create article for the section topic setting to disabled, Paligo will only create
a Zendesk section for the top-level topics. Any content inside the top-level topics in Paligo is not
available in Zendesk.

Use Separate Styling for Labels, Numbers, Captions and Titles
In Paligo, some "formal" elements contain other "nested" elements that are included

automatically, such as a title or caption. For example, the example  element has a title  element

nested within it (as well as a para  element for the example text).

If you publish to Zendesk, you may want to change the appearance of the "nested" elements
in your articles. To style the "nested" elements, you first need to get Paligo to generate <span>
classes for them, and then you can style the <span> classes in a CSS stylesheet:

1. Select Layout.

2. Select the Zendesk Layout that you want to change.

3. Select Zendesk.
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4. Set the Use separate styling for label, number, and title in formal elements to:

• Enabled: To set Paligo to create a span class in the HTML output for each part of a label,
number, or title element.

• Disabled: To set Paligo to output HTML that does not use span classes for labels, numbers,
or title elements.

5. Select Save.

6. Re-publish your content to Zendesk (see Publish Content to Zendesk [1580]) and then view a
Zendesk article that contains an element that has labels, numbers, titles, or captions.

7. Use the web browser's Inspect feature (Chrome, other browsers may use different
terminology) to view the code of the article.
You should see that there is a span class for each part of the label, title, or caption. You can
style this class by using CSS.

8. Either create or edit a CSS stylesheet and add the styling changes that you want to make. Then
add your stylesheet to your Zendesk Assets and make sure to reference it at the bottom of
the list in the document_head.hbs template in Zendesk.

To learn about using CSS, see Customize Zendesk articles using CSS [1586].

Map Heading Levels to Zendesk
Paligo has unlimited levels in the publications, so you can have as many topics and subtopics
as you want. Zendesk is more restrictive, as it only has one level for articles, and this can mean
that when you publish from Paligo to Zendesk, the heading levels do not match. To handle this
difference, you can choose how the Paligo topic titles are mapped to the heading levels of Zendesk
articles.

For example, let's say you have a top-level topic in Paligo and a second-level topic below it. Paligo
could map these to Zendesk as separate articles, and the top-level topic could have an H1 heading
in Zendesk, but the second-level topic would have an H2 as it was a subtopic in Paligo. This might
seem strange in Zendesk, as you would have two articles but with different heading levels. By
using the Follow Zendesk Heading Levels setting, you can avoid this problem.

1. Select Layout and then select the layout you want to use to publish to Zendesk.

2. In the Layout Editor, select Zendesk.

3. Use the Follow Zendesk heading levels option to choose the mapping:
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• Paligo levels - The titles in Paligo topics will map to heading levels that match the
structure in Paligo. This can result in articles in Zendesk having different heading levels than
expected, for example, you may have a topic with an H4 main heading.

• Zendesk levels - The titles in Paligo topics will map to heading levels that match the
structure in Zendesk.

4. Use the arrow buttons to arrange your topics and reused publications into the order you
want. You can set them to display as a flat structure or you can "nest" topics and publications
so they have a more complex structure, with multiple levels of content. To learn more, see
Organize a Publication [100].

Set the Section Levels for Mapping to Zendesk
If you are on the Paligo Enterprise plan and have an Enterprise license for Zendesk, you can map
content to many different section levels. So instead of using the standard Zendesk structure of
Category > Section > Article, you can have lots of sections, for example, Category > Section >
Section > Section > Article.

To control the number of sections that Paligo will create:

1. Make sure that you understand how content is mapped to Zendesk Enterprise [1615].

2. Structure your Paligo publication so that your topics are organized into multiple different
levels.

3. Select Layout and then select the layout you want to use to publish to Zendesk.

4. In the Layout Editor, select Toc and chunking.

5. Use the Chunk section depth option to control how many levels of Paligo content will be
mapped to sections in Zendesk. For example, if you set it to 3, it means your top-level and
second-level topics will be mapped to sections in Zendesk. Your third-level topics will be
mapped to articles, and any lower-level topics will be subsections in those articles.
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NOTE
A topic can only be mapped to a section if the topic has lower-level topics (or
"children") in the publication structure. If it has no lower-level topics, the topic
will be mapped to an article instead.

6. Use the arrow buttons to arrange your topics and reused publications into the order you
want. You can set them to display as a flat structure or you can "nest" topics and publications
so they have a more complex structure, with multiple levels of content. To learn more, see
Organize a Publication [100].

When you publish your Paligo content to Zendesk [1580] using this layout, Paligo will map your
various levels of topics to sections and articles. It will follow the mapping rules for Zendesk
Enterprise layouts [1615], where the chunck section depth defines the section levels.

Single-Section Zendesk Layouts
Use a single-section Zendesk Layout if you want your Paligo content to map to Zendesk like this:

• The publication in Paligo becomes a section in Zendesk

• The top-level topics in the Paligo publication become articles in Zendesk

• Every second-level and lower-level topic in the Paligo publication becomes a subsection of an
article.

This means that if you have lots of second-level and lower topics in your Paligo publication, your
Zendesk articles can become very long (as a single article could contain many topics from Paligo).
For this reason, the single-section layout is only suitable for publications that have the majority of
their topics at the top level.

Paligo has a built-in single-section Zendesk layout that you can use or you can Create a Zendesk
Layout [1601].
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When you publish, select HTML as the output format and then select the Zendesk layout that you
want to use.

NOTE
You can use the Zendesk Preflight feature to Customize Paligo-to-Zendesk
Mapping [1566] to meet your needs.

Multi-Section Zendesk Layouts
Use a multi-section Zendesk layout if you want Paligo content to map to Zendesk like this:

• Each top-level topic in Paligo becomes a section in Zendesk

• Each top-level topic also becomes an article in Zendesk. The article appears in the section for the
same topic.

• Second-level topics in Paligo are mapped to articles in Zendesk. These articles appear in the
section for the "parent" top-level topic.

• Third-level and lower-level topics in Paligo become subsections in their "parent" second-level
article.

Example 81. Multi-Section Zendesk Layout Mapping

The top-level topics in Paligo (1, 2, and 3) are mapped to sections in Zendesk. Paligo also creates an
article for the content of the top-level topics. Here, the image shows Paligo has created a section and an
article for the "Introduction" topic (2).
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The second-level topics (4, 5, 6) are mapped to articles in Zendesk. Any lower-level topics in Paligo are
mapped as subsections in the articles.

If you are used to writing content in Zendesk, it may seem strange to have a topic that maps to
a section and an article. Because in Zendesk, you would not add content to a section, you would
only add it to an article. But in Paligo, it is possible to have content inside top-level articles, and
so if those are only mapped to a section, the content would be lost. For this reason, Paligo also
creates an article, and that's where the content of the "section" topic goes.

Remember, Paligo is used for publishing to many different outputs, not just Zendesk. Having
content inside a top-level topic is a common requirement for PDFs, HTML, and other outputs.

NOTE
If you prefer, you can control the mapping so that the top-level topics become
sections, but not articles. To do this, edit the Zendesk layout and use the Create
article for section topic setting (see Control whether Paligo Creates Articles for
"Section" Topics [1607]).

Paligo has a built-in multi-section Zendesk layout that you can use or you can Create a Zendesk
Layout [1601].

When you publish, select HTML as the output format and then select the Zendesk layout that you
want to use.

NOTE
You can use the Zendesk Preflight feature to Customize Paligo-to-Zendesk
Mapping [1566] to meet your needs.
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Zendesk Enterprise Layouts
You can use the Zendesk Enterprise layout to map topics in your Paligo publication to sections and
subsections (sections within sections) in Zendesk. Paligo has a built-in Zendesk Enterprise layout
that you can use or you can Create a Zendesk Layout [1601]. But please note that you can only
use this layout if you are on the enterprise plan for Paligo and also have an enterprise license for
Zendesk.

To use the Zendesk Enterprise layout, we recommend that you:

1. Learn how the Zendesk Enterprise layout mapping works.

2. Consider how Zendesk separates sections and articles.

3. Organize your Paligo content so that your publication structure will create sections and
articles in an appropriate order in Zendesk.

4. Use the built-in Zendesk Enterprise layout or Create a Zendesk Layout [1601]. You will need to
set the the Chunk section depth to define the number of section levels you want.

5. Publish your content and select HTML as the output type and then select your Zendesk
Enterprise layout. Use Zendesk Preflight to View the Paligo-to-Zendesk Mapping [1562] and
Customize Paligo-to-Zendesk Mapping [1566] if needed.

Mapping for Zendesk Enterprise Layouts
The mapping for Zendesk Enterprise layouts works like this:

• Top-level topics in Paligo are mapped to top-level sections in Zendesk.

• Second-level topics in Paligo are mapped to second-level sections in Zendesk.

• Third-level and lower-level topics are mapped to articles in Zendesk. if required. But with the
default settings in place, only the top two levels become sections, with level three and lower
becoming articles.

This is the mapping behavior with the default settings for Zendesk Enterprise layouts in place.
But you can use the Chunk section depth setting (in the layout) to control how many levels of
sections can be used. The default setting is 3, which provides the mapping listed above.

NOTE
A topic can only map to a section if the topic has lower-level topics in the
publication structure. For example, if a second-level topic does not have lower-
level topics, it will become an article, not a section.

Example 82. Zendesk Enterprise Layout Mapping

Let's say you have an "ACME 100 Series" publication and it is going to include all the content for
several products in the ACME 100 range.

At the top level, you have topics for each of the products: "ACME 100", "ACME 100X", "ACME
100XE", and "ACME 100SE".
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Inside each of those, you have topics for 4 different categories of information: "Installation",
"User", "Service", and "Maintenance".

Inside each category topic, you have a maximum of three levels of content. For example, in the
"Installation" category, you have "Safety and PPE", then a lower level of topics, and a further level
of topics inside those.

In your Zendesk Enterprise layout, you set the Chunk section depth to 4. You then go to the
publishing settings, select HTML as the output, and choose your Zendesk Enterprise layout. You
then select the Zendesk Preflight tab so that you can see a preview of how your content will be
mapped to Zendesk:
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• Top-level topics, such as "ACME 100" and "ACME 100X" become top-level sections in Zendesk.

• Second-level topics, such as "Installation" and "User" become second-level sections in Zendesk.

• Third-level topics, such as "Safety and PPE" become third-level sections in Zendesk (as the
Chunk section depth is set to 4, so at level 4 the sections stop and topics get mapped to
articles).

If you are used to writing content in Zendesk, it may seem strange to have a topic that maps to
a section and an article. Because in Zendesk, you would not add content to a section, you would
only add it to an article. But in Paligo, it is possible to have content inside top-level articles, and
so if those are only mapped to a section, the content would be lost. For this reason, Paligo also
creates an article, and that's where the content of the "section" topic goes.

Remember, Paligo is used for publishing to many different outputs, not just Zendesk. Having
content inside a top-level topic is a common requirement for PDFs, HTML, and other outputs.

NOTE
If you prefer, you can control the mapping so that the top-level topics become
sections, but not articles. To do this, edit the Zendesk layout and use the Create
article for section topic setting (see Control whether Paligo Creates Articles for
"Section" Topics [1607]).

Order of Sections in Zendesk
When you are planning the structure of your publication in Paligo, it is important to remember
that Zendesk separates sections and articles. So in Paligo, you may have a lower-level topic set to
become a section in Zendesk. But in Zendesk, that section may not appear in the same position,
as sections are shown above articles, see the Example 83, “Order of Sections and Articles in
Zendesk” [1618].

Paligo cannot change how Zendesk orders its sections and articles. If you find that the order of
sections and articles in Zendesk is confusing for your readers, we recommend that you either:

• Reduce the chunk section depth
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or

• Reorganize your Paligo publication so that it creates an order that you find more acceptable.
If you use your publication for multiple outputs (HTML, PDF, Zendesk), you can create a new
publication that uses the same topics. You can then use the new publication for Zendesk only,
and change the organization of the topics to suit your Zendesk requirements.

Example 83. Order of Sections and Articles in Zendesk
Let's say you have a publication with 5 levels of content and you want to use a section depth
(chunk section depth) of 4.

In this example, that would mean that:

• "ACME 100" becomes a section in Zendesk as it is the top-level topic and it has lower-level topics.

• "Installation" becomes a section in Zendesk as it is the second-level topic and it has lower-level
topics.

• "Safety and PPE" becomes a section in Zendesk as it is the third-level topic and it has lower-level
topics.

• "Gloves", "Boots", "Ladders" and "Power Tools" become articles in Zendesk. , Although they are
at the fourth-level and could become sections in Zendesk, they are mapped to articles as they
do not have lower-level topics.

• "Head Protection" becomes a section in Zendesk as it is a fourth-level topic and it has lower-level
topics. This is where the ordering of your content can become unusual in Zendesk, as Zendesk
will display "Head Protection" as a section above the "Gloves", "Boots", "Ladders" and "Power
Tools" articles.
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To avoid this issue, you can reduce the chunk section depth in the Zendesk Enterprise layout
to 3. This results in "Safety and PPE" being the lowest level of section, so that all of its "child"
topics appear as articles in the expected order.

Zoomin Integration
Zoomin is software that is designed to provide a single portal for all of your documentation,
including PDFs, Word documents, knowledge base articles, and content you create in Paligo too.

To use your Paligo content in Zoomin, you will need a Zoomin account and then in Paligo you will
need to set up:

• The Zoomin integration settings, see Connect Paligo to Zoomin [1619]

• A Zoomin layout [1621]

• A publication and topics in Paligo. These contain the content you will "push" to Zoomin.
There are no special requirements for your publication and topics when publishing to Zoomin.

You can then publish from Paligo to your Zoomin software [1622]. The content that you publish
is an HTML5 output that is customized to contain metadata and other details that are needed for
Zoomin.

Connect Paligo to Zoomin
You can publish content directly from Paligo to your Zoomin instance. But to do that, you first
need to set up Paligo and Zoomin to connect to each other.

1. Log in to Paligo via a user account that has administrator permissions.

2. Select the avatar in the top right corner. 

3. Select Settings from the menu. 

4. In the Settings view, select the Integrations tab.

5. In the Zoomin box, select Add (or Change if an integration has been set up previously).
Paligo displays the integration settings.
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6. Enter the Account name.
This has to match the name of the account in Zoomin.

7. Use the Choose environment option to select one of the environments. You can have up to
five environments.

8. Enter:

• An Environment name.
This can be any name you like and it is used to identify the environment in Paligo.
We recommend that you give your environments names that make it easy for users to
differentiate between your environments. This is because when you publish from Paligo,
you will need to choose the environment to publish to and these are listed by name.

• An Upload URL.
The upload path is the URL of the location (in Zoomin) that will receive the content that
Paligo publishes.
Paligo adds a default structure for the URL path. You should overwrite it with the specific
address for your Zoomin environment.

9. If you want the selected environment to be the default Zoomin environment for publishing,
check the Set as default box. Leave it clear if you want a different environment to be the
default. When you publish, you can choose a different environment if required.

10. Select Generate Key.
Paligo generates an SSH key. The key is shown in the SSH key box above the button. SSH
stands for secure shell and it is used for encrypting your connection between Paligo and
Zoomin.

11. Select Save.

12. Select Copy key to copy the SSH key. Then send the SHH key to Zoomin. Ask them to add it to
your Zoomin instance. When they have added it, you can come back to the settings in Paligo
and use the Test Settings button to see if the connection works. This button is only available
when you edit the settings and is not shown when you first set up the integration.

TIP
When the connection test is successful, you can publish from Paligo to
Zoomin [1622].

If the connection test fails, make sure that you have entered the account name
and environment details correctly, and that you have sent the SSH key to Zoomin.
Check closely for typing mistakes, such as incorrect spaces or characters.
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Zoomin Layouts
To publish Paligo content to Zoomin, you will need to use a Zoomin layout. The layout has settings
that apply when Paligo converts your XML content into HTML, such as the number of levels in the
table of contents, and whether taxonomies are included in the output.

The HTML that Paligo "pushes" to Zoomin is actually a multipage classic HTML output, but with
some additional changes in the underlying code, so that it can be recognized by Zoomin. So the
settings on the Zoomin layout work in exactly the same way as those on the multipage classic
HTML output. The only differences are:

• In the underlying code, the Zoomin layout adds some metadata to the HTML output. The
metadata is needed by Zoomin.

• Your Paligo output will include a taxonomies.xml file. Zoomin can then use any taxonomies that
you have in place in Paligo.

You can use the built-in Zoomin layout, create your own, or edit an existing one.

To learn how to create your own Zoomin layout, see Create a Zoomin Layout [1621].

To edit an existing Zoomin layout, follow the steps in Edit a Layout [1061] . You can find
information on the available settings in HTML5 Layout Editor Options [680]. But be aware that
some of the settings may not be relevant when publishing to Zoomin.

Create a Zoomin Layout
To publish content to Zoomin, you need to use a Zoomin layout. You can use the built-in Zoomin
layout or create your own. Alternatively, if your Paligo instance already contains some Zoomin
layouts, you could edit one of those and use that.

To create a Zoomin layout:

1. Select the Layout tab in the top menu.

Existing layouts are displayed in a list. The list will be empty if no layouts have been created.

2. Select Create New Layout in the lower left corner. 

3. Enter a Layout title.

4. Select an Output format from the menu.
The output format is the base layout for your new layout that defines:
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• Type of content (HTML, HTML5, FLUIDTOPICS, PDF, MSWORD, SCORM, ELEARNING, XML) that
can be created with the template.

• Where the default values are retrieved. If you set a value to Default in your new layout, it
means the value is retrieved from the chosen base layout, see Layout Relationships - Base,
New, Duplicate [1055].

NOTE
Already created layouts can also be chosen as base layout.

5. Select OK.
Paligo creates your new layout.

6. Select the new layout in the list to open it in the Layout Editor [57].

TIP
You can copy the URL from the new dialog and paste it into a browser tab.
This is sometimes easier to work with, especially if you frequently switch
between your content and the layout settings.

7. Use the Layout Editor to choose the publication settings. Paligo will apply these settings when
it converts your XML content into the output format.
Zoomin layouts have the same settings as an HTML help center [680], although be aware that
some of the settings may not be relevant when publishing to Zoomin.

8. Select Save.

Publish Content to Zoomin
To publish your Paligo content to Zoomin:

1. Make sure that you have set up the Zoomin integration settings correctly [1619]. In the
integration settings, select Test Settings. Paligo will test the connection and display a
notification that tells you if it was a success or failure.
If the test was a success, you can publish to Zoomin.
If the test was a failure, double-check that the integration settings are correct. If there is still a
failure, contact customer support for advice.

2. Make sure that you have set up a Zoomin layout [1621]. You need a Zoomin layout to publish
to Zoomin. There is a built-in Zoomin layout included in Paligo, but you may want to create
your own if you have specific requirements for how the content is transformed from Paligo
XML to HTML.

3. In the Content Manager, display the options menu for the publication that you want to
publish, and select Publish.

4. On the Settings tab, select HTML5.

5. Choose the Zoomin layout that you want your publication to use.
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6. Select the Zoomin environment that will receive the published content from Paligo.
The Select environment list contains the names of each Zoomin environment that has been
added to your Paligo-to-Zoomin integration settings [1619].
When you select an environment, the Zoomin upload path preview field updates to show
the location that will receive the published content. The URL for the location is also defined in
the Paligo-to-Zoomin integration settings.

7. Choose the Languages that you want to publish.
If you do not have any translations, you can only select the original language (source
language).
If you have multiple languages translated and approved, you can select which ones to include.
Paligo will publish each language as a separate output.

When the content is sent to Zoomin, it is processed by Zoomin. As part of the processing,
Zoomin will manage the translations so that they appear in the correct place in Zoomin.

8. If you have marked up your content to use filters (profiles) [1141], use the Profiling
attributes section to choose which filters to apply. If you do not want to use filters, ignore this
step and continue from the next step.
To apply filters for publishing, select Edit to display a list of the filter properties that are used.
Choose the filter values that you want to include. Leave the fields blank for the filters that you
do not want to apply.
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When you select OK, the chosen profile settings are shown in the Profiling attributes section.

NOTE
With the filter settings, you tell Paligo which content to include. For example,
if you have used an outputformat filter, you could mark up some content to
have a PDF value and other content to have an HTML value. In the publishing
settings, if you set Output Format to HTML, it will include the content that
has an outputformat:HTML filter and will exclude any content that has an
outputformat:PDF filter (or any value other than HTML).

9. If you have used variables [1186] in your content, use the Variables section to choose which
variants to use for the publication.If you do not want to use variables, ignore this step and
continue from the next step.
To choose the variants, select Edit to display a list of variable sets that are used. For each
variable set, there is a field that you can use to choose which variant to apply. If there are
variable sets that you do not want to apply to your publication, leave the fields for those
empty.

10. Use the Upload Output settings to upload the published content to other platforms as well,
such as GitHub. This is optional and the uploads will only be possible if the relevant Paligo
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integration settings are in place. For example, you can only upload to GitHub if you have set
up the Paligo to GitHub integration.
To find out how to set the integrations up, see Integrations [1380].

11. Set the Optional Parameters (leave unchecked if you do not want these features):

• Save the output in Paligo - Choose whether you want Paligo to add the published output
to the Resource View [68]. Check the box to save the zip file. Clear the box if you want Paligo
to only download the published output file in your browser.

• Email me - Check this box if you want Paligo to send you an email when the publication
is ready. This is useful if you have very large publications that can take a longer time to
process and publish.

• Make debug build - Check this box if you want Paligo to include a log file and link report.
If there is an issue with your content, Paligo support may ask you to enable this feature so
that they can use the log files to investigate.

TIP
Every time you publish, there will also be a link in the Dashboard feed to
download the published content.

12. Select Publish Document to start publishing. Paligo will then process your content and apply
your layout and publishing settings. The time that this takes can vary depending on how much
content you are publishing (the more content there is, the longer it takes).
A progress bar shows you how much of the processing Paligo has completed and how much
is left to do. When the processing is complete, Paligo "pushes" the production content into
Zoomin.

TIP
You can also save your publishing settings [1076] so that you can select the saved
version instead of re-applying all the filters, variables, etc., each time. Any settings
you save can also be used for Batch Publishing [1073].
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Version Management

Paligo has version control that is well adapted to the way technical writers work. Instead of having
to handle conflicts, as in some version control systems, Paligo locks a file when it is checked out by
someone.

The Version Management in Paligo consists of several parts:

1. Revision Control [1666] - This is the edit history of textual content. You can view the history
of a topic for instance, roll back to previous revisions, and compare different revisions of a
component.

2. Branching [1638] - Branches are concurrent / parallel versions of content. It means you can
create a separate branch / fork of your content, a Publication or a topic, that can live side by
side with the original.
It is similar to a copy, but with more features. A branch "knows" that it originates from another
version, and if needed, you can later merge the content of the two different versions.

3. Release Process [1626] - Release versions are linear versions in time of a component. It is tied to
the workflow: each time a component changes workflow stages, the Release version is stepped
up, either a minor or a major version, with version numbering, such as "Version 1.0.2" and so
on. 

Release Process
The release process for topics and publications is part of the Version Management in Paligo. For
more information about workflow in connection to assignments, see Assignments [1208].

Each time content is released (both major and minor), an exact copy of that version (with all
its topics and other resources), called snapshot, is saved and archived. The snapshot can be
downloaded or restored in the Resource View [68] Paligo.

A snapshot can also be created by a contributor during an assignment or manually created at any
time via Resource View [68].

The version number is shown to the left of the archived version.

• 1.0.0 - The first number is stepped up for a major release. A major release consists of new
features and / or large architectural changes.

• 1.1.0 - The second number is stepped up for a minor release. A minor release makes significant
improvements to the existing functions and smaller adjustments.

• 1.1.1 - The third number is stepped up for a review or translation stage.

The workflow in Paligo consists of 5 stages connected to the Release Management, which steps up
the version number for each stage. You change the workflow stage in the Resource View [68] for
the item:
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1. Work in progress - The initial stage of any topic or new version, for authoring and editing
content.

2. In review - For review and proofreading. When the document is in review, it is not locked, but
marked as In review.

3. In translation - For translating multilingual content. While the text is under translation, the
topic is locked for editing.

4. In translation review - For proofreading or post-editing translations in the translation editor.

5. Release - The final version of the topic is locked for further editing and archived. To create a
new version, it has to be set to Work in progress again. The archived version will remain intact
just as it was at that stage.

Release Content
Each time content is released (both major and minor), an exact copy of that version (with all its
topics and other resources), called snapshot, is saved and archived.

TIP
Learn more about the Release Process [1626].

1. Select the folder containing the content in Content Manager [34]. 
If the content is not in a folder, select the top-level folder Documents. 

This will open the Resource View [68].

2. Change the status to Released for the content.
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NOTE
The box Change status for all included components is by default checked.
If cleared, only the publication will be set to status released.

3. Leave a release comment that explains to other users what it includes.
The comment will be visible in Review View [41] under the tab Versions.

4. For a minor release, check the box Make this a minor release.

5. Select OK.
A snapshot is created and archived for this release.

Restore a Previous Version
When the state of a publication or topic is set to Released in Paligo, an archived version of the
content at that particular point in time called snapshot, is automatically created. It is possible to
add a comment that provides more context about the snapshot for other users. A snapshot can
also be created during a review assignment.

A snapshot is useful when you compare different revisions or need to restore an old version of a
publication or a topic.

The snapshot is a ZIP file consisting of several XML files (the topic, translations and variables)
and images. When a version is restored, that file is imported back into Paligo and treated like
new content, which results in topics and fragments getting new IDs. The restored version is
independent in regards of the original content. Because the restored release may have had
completely different variables and the like, such resources will be separate and possibly partially
duplicated. You may therefore want to clean such resources up after republishing your old
version.

There is no limit to how many versions Paligo stores. Restoring an old version does not affect
other archived versions and does not remove earlier versions. Archived releases (whether
restored or not) use up your storage space. If you know that you do not need old versions, you
should remove them.
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IMPORTANT
Restoring releases is not something recommended on a regular basis, but only for
exceptions when you need to republish an old version.

If you need to keep multiple release versions in parallel in your system, with
reuse between them, you should instead look into doing so with the help
of Reuse Forks [1108] and Filtering / Profiling [1141], possibly combined with
Branching [1638].

1. Select the folder containing the content in Content Manager [34]. 
If the content is not in a folder, select the top-level folder Documents. 

This will open the Resource View [68].

2. Select the blue arrow to the left of the the topic or publication. 

3. Select the Versions tab.

4. Select the blue action button to the right of the version and choose Restore version. 

5. Select in which folder to restore the released version. 

Paligo Documentation

1629



6. If necessary, make changes. Changes made to the topics in a restored release do not affect
any of the topics in your current version in Paligo. It is a completely separate copy.

7. Republish to any format you like.

Create a New Version
Once a topic or publication is released, an archived version of it called a snapshot is saved. To be
able to edit a released topic or publication, you need to create a new version, by changing the
status back to Work in progress. This will not affect the archived version.

When you open a topic used in a released publication, it will be in status Released. You can make
a new version of it by changing the status in Resource View [68], but you do not have to, when you
open it in the editor, you get the option to change the status back to Work in progress.

Should the publication (or other components where the topic is reused) not already be in Work in
progress, Paligo will allow you to change the status of them as well.

The topics that do not require change in the new version can (and will by default) remain in
Released status.
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Manual Snapshot
A snapshot is an archived version of the content at a particular point in time. During a release a
snapshot is always created, but can also be created by a contributor during an assignment [1330]
in Contributor Editor [41] or manually created at any time via Resource View [68]. To be able to
create a manual snapshot, you have to be an author or administrator, see User Types [1834].

The snapshots are useful when comparing the content between different versions or for restoring
lost content. By comparing a snapshot from before and after an assignment, makes it easy to
visualize the changes made to the documentation.

TIP
When importing content, Paligo will not automatically create a snapshot of the
imported content. Paligo recommends you to always create manual snapshots of
the imported content, to have an archived version to compare with the changes
you make.

1. Select the folder containing the content in Content Manager [34]. 
If the content is not in a folder, select the top-level folder Documents. 

This will open the Resource View [68].

2. Select the blue arrow to the left of the the topic.

3. Select the Versions tab to see existing archived versions.

4. Select the Dotted menu (...) to the right of the topic.
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5. Select Create snapshot.

6. Add a comment that explains to other users what it includes.

7. Select OK.
A new archived version is added to the versions tab.

View the Snapshot Comments
Administrators, authors and contributors can create snapshots of the content. A snapshot is
an archived version of the content at a particular point in time and useful when you compare
different versions. When a user creates a snapshot, it is possible to add a comment that provides
more context about the snapshot for other users.

Use Resource View [68] to look at the comments.

1. Select the folder containing the content in Content Manager [34]. 
If the content is not in a folder, select the top-level folder Documents. 

This will open the Resource View [68].

2. Navigate down the folder structure until you find the topic of interest. Then expand a topic to
reveal its information and select the Versions tab.
The snapshot comments are shown in the comments column.
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Changing Workflow for Reused Content
If you think about the fact that one of the main purposes of Paligo is to reuse content, what does it
mean to change the workflow or release status of a piece of content?

Obviously, because topics are reused, if you change the status of one document, it will have an
effect on others as well. This can easily get very complex if you need to keep track of it yourself.
Paligo does it for you by default though, but it's good to know how the default mechanisms work.

NOTE
Workflow changes in single-sourced content is a complicated topic, but almost
all of what is described here happens automatically, so it is enough to have a
fleeting understanding of the basics below.

Unless you want to know what goes on in detail, or you have special needs for
controlling it manually, it is not required to understand all of the complexities
behind the control of workflow status changes.

Whenever you change the workflow status of a document, there is a choice whether that should
affect any documents related to it.

Status Change Checkbox
The checkbox in the menu for changing the workflow status gives you a choice whether any
included topics should also have their status changed. This is sometimes called changing the status
recursively.

The checkbox has different default values, depending on what the current workflow status is for
the component you are changing:
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Table 2. Default values for changing status recursively

Current workflow stage Default checkbox value

Released Not checked:

The change will by default only affect the one you are making the change on.

For example, if you change a publication from Released to Work in progress, only
the publication itself will change, not its topics.

Logic: Just because you are changing e.g a publication from Released to Work in
progress, most of the topics may not need to change, and will therefore remain
released.
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Current workflow stage Default checkbox value

Any stage except released Checked:

The change will by default affect all components reused by the one being changed.

For example, if you change a publication from Work in progress to Released, then all
the topics used in it will also be released.

Logic: If you are changing any component that is not released, e.g to Released, then
normally this would mean that all included topics are also released.

You can of course change the default with the checkbox, but the default values are usually
recommended.

TIP
If you change a released publication to Work in progress, you do not have to
manually change the status of each topic you are going to work on. Paligo will give
you the option to change its status whenever you try to open a released topic.
This makes it clear what topics have actually changed during the workflow cycle.

How Changes Affect Other Components
The status change checkbox determines what happens to components reused in the one you are
changing. But what about topics and other publications that are related?

For instance, if you release one publication, and all its topics, what happens to another publication
where some of the same topics are reused?

There are many scenarios, but the ones below may help understanding the most important
effects:
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Figure 1. Work in progress → Released (changing the publication status)

If we change Publication A from Work in progress to Released, all its topics will by default also be
released. This means that the sub set of topics reused also in Publication B will of course also be
released.

The component Publication B in itself will not be affected.

Figure 2. Released → Work in progress (changing the publication status)

If we change Publication A from to Released to Work in progress, only the publication component
itself will change. This means in this scenario, Publication B will not be affected at all, neither its
topics nor the component itself.
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Figure 3. Released → Work in progress (changing the topic status)

If we change Topic A from to Released to Work in progress, we will also by default change the
publication it is reused in. Since it is reused in both Publication A and Publication B, both of these
publication components will change to Work in progress.

You can override this behaviour if you want, using the checkbox in the dialog, but it is normally not
recommended. If you are changing Topic A, you are of course effectively working on a new version
for any component where it is reused.

There can of course be exceptions for pragmatic reasons. If you have reused Topic A in 100
publications, and you need to make a minor change, and the publications do not need to be
republished. Or the change is filtered only for Publication A. Then it's completely up to you to
override the default, using the checkbox.

These are some of the common scenarios, but of course there are others. As mentioned, if the
default behaviour fits you well, you rarely need to think about it, as it all happens automatically.

But you are encouraged to try various scenarios out on sample content if you want to learn more.
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Branching
Branching is designed for creating multiple versions of related content. It is similar to copying, but
has more features and gives you more options when working with your content. With a branch,
you create a new version of a publication or topic that acts like a copy, but Paligo understands
it is related to the original version. This means that the original and the branch can be used
separately as parallel versions or be merged back into a single version later.

The most common use cases to work with branches:

• Work during a release - You are working on a version for a specific product that is still in
development and being updated. But then the next release of the product is due and you need
to start working on the documentation for that version.

• Experiment with the content - You are considering some major changes to the documentation
and its structure and you want to experiment before abandoning the old version.

• Work on major changes that will take some time - You are working on a major change for
the documentation that will take some time, but the development team is making many small
continuous updates that require updates in the live documentation. So you need to be able to
publish intermittently until the major overhaul of the documentation is done.

• Have two different versions that live concurrently and need changes to be applied easily in
both.

• Work during a translation project - Branching is necessary to be able to work on further
developments while content is being translated. Also read Update Content when Translation is
Not Finished [1727].

For example, in the following image, the "Acme HomeHub User Guide" has been branched. The
original (1) and the branched version (2) both exist as separate publications with separate topics.
You could continue to use them as separate versions or merge them together to create one
publication.

1 = Original, 2 = Branched version

NOTE
When you branch a topic, Paligo will attempt to maintain any content reuse from
the original version. It will also continue to use the same image files. For details,
see What Happens When You Create a Branch? [1640].
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CAUTION
Branching can be very powerful, if used for the right reasons and with care. It is
important to avoid overly complex scenarios.

To use branching:

1. Choose one of Paligo's two branching modes, see Select Branching Mode [1647].

2. Make branches for publications or topics, see Create Branches [1649].

3. Break the relationship between a branch and its original version, see Convert Branch to Main
Branch [1665].

4. Merge a branch into another branch, see Merge Branches [1658].

Branch Icons and Numbers
If you create a branch of your content, Paligo adds a branch symbol to those publications and /
or topics. There is also a number to show which version each branch is, for example, if you have
"Topic A" and branch it twice, the first branch that is created is numbered one and the second
branch is numbered two.

• Gray branch icons show that the content has branches.

• Blue branch icons show that the content is a branch of some other content.

• The branch numbering is handled automatically by Paligo and cannot be changed manually.

• Add branch labels if you want to give each branch a more meaningful identity.

If you have Consecutive branching mode enabled there can be additional numbering in
parenthesis, see Select Branching Mode [1647].

The numbering in parenthesis shows the version number of the main origin branch. For
example, in the following image:

• The top "Topic A" has a gray branch icon to show it is the origin branch.

• The middle "Topic A" has a blue branch icon numbered 1. This shows it is the first branch of
the main origin branch (the top "Topic A"). The middle "Topic A" also has a gray branch icon to
show that it is also the origin branch of another branch.

• The bottom "Topic A" has a blue branch icon numbered 2. This shows it is the second branch
of the main origin branch (the top "Topic A"). It also has the number 1 in parenthesis. This shows
that it is a branch of the middle "Topic A" branch (the middle "Topic A" branch is numbered
branch 1 and so 1 is shown in the parenthesis).
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What Happens When You Create a Branch?
When you create a branch in Paligo, the result varies, depending on:

• The type of content you branch

• The options you choose when branching

• Where you create the branch from.
Branching a topic from the Content Manager is different to branching a topic from a publication
structure.

We also explain how content reuse [1643], cross-references [1644], and images [1646] are handled
when branching content.

New Publication Branch
You can create a branch for a publication (see Create Branches [1649]). When you do this, Paligo
will:

• Create a branch of the publication

• Let you choose how you want reused publications to be handled.
With automatic branch creation, Paligo will create branched versions of any reused publications,
but only for those at the top-level of the original publication. If there are reused publications
that also contain lower-level reused publications, those lower-level ones will not be branched
automatically.
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If you do not use automatic branching, your branched publication will use the original versions
of any reused publications (sub-publications).

• Let you choose how you want reused topics to be handled.
If you choose to use automatic branching, Paligo will create a branched version of every topic in
the publication. Any changes you make in the branched topics will not affect any other branches
or publications.

If you do not use the automatic branching, Paligo will create a branch of the publication only,
not its topics. The branched publication will reuse the original versions of the topics.
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NOTE
Auto-branching of topics is designed for particular scenarios, and in most cases,
we recommend that you leave it disabled (clear checkbox). This is because auto-
branching can result in unnecessary branches of topics where reused topics
would be more appropriate.

New Topic Branch from a Publication Fork
If you create a new branch for a topic, and you create the branch from the "fork" in the publication
structure [1649], Paligo will:

• Create a branch of the topic

• Set the publication fork to link to the branched version of the topic instead of the original version
of the topic.

• Check the original topic for any text fragments that are reused. These text fragments will also be
reused in the branched version of the topic, so the ids will be the same. If you change them in
the branched version, those changes will also apply in all of the other topics where those text
fragments are used.

• Check the original topic for any text fragments that are not reused. These are "regular"
paragraphs and content structures and Paligo will give these new ids in the branched version. So
if you change them in the branched version, your changes will not affect the original branch.

• Check the original topic for any reused components, such as topics inserted inside other topics.
These components will also be reused in the branched version and so do not get new ids.

• Check the original topic for references to other files, such as images. The branched version
will use the same files as the original version. Paligo does not create a new, separate file. For
example, if the original topic contains an image, the branched version will contain the same
image (they both reference the same image file in the Media library). If you edit the image, those
changes will apply wherever that image is used.

New Topic Branch from a Topic
If you create a new topic branch from a topic in the Content Manager [1649] (rather than from a
fork in the publication structure), Paligo will:

• Create a branch of the topic
The branch is a stand-alone branch and is not used in any publications. Any publications that
use the topic will continue to use the original version.
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• Check the original topic for any text fragments that are reused. These text fragments will also be
reused in the branched version of the topic, so the ids will be the same. If you change them in
the branched version, those changes will also apply in all of the other topics where those text
fragments are used.

• Check the original topic for any text fragments that are not reused. These are "regular"
paragraphs and content structures and Paligo will give these new ids in the branched version. So
if you change them in the branched version, your changes will not affect the original branch.

• Check the original topic for any reused components, such as topics inserted inside other topics.
These components will also be reused in the branched version and so do not get new ids.

• Check the original topic for any reused components, such as topics inserted inside other topics.
These components will also be reused in the branched version and so do not get new ids.

• Check the original topic for references to other files, such as images. The branched version
will use the same files as the original version. Paligo does not create a new, separate file. For
example, if the original topic contains an image, the branched version will contain the same
image (they both reference the same image file in the Media library). If you edit the image, those
changes will apply wherever that image is used.

Reused Content in Branches
If you have reused content in your publications and topics, this is how Paligo will handle it when
you create a new branch [1649]:

• Text fragments
Paligo will check the original topic for any text fragments that are reused. These text fragments
will also be reused in the branched version of the topic, so the ids will be the same. If you
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change them in the branched version, those changes will also apply in all of the other topics
where those text fragments are used.
In the branched version, Paligo will only give new ids to those text fragments that were not
reused in the original version.

• Components
Paligo will check the original topic for any reused components, such as a topic that has been
inserted into another topic. These components will also be reused in the branched version. If
you change them in the branched version, those changes will also apply in all of the other topics
where those components are used.

• Reused publications inside a publication
If you branch a publication that contains reused "sub publications", you can set Paligo to
automatically create branches for the reused publications.
For example, if you have a "Documentation" publication that contains "Getting Started" as a
sub-publication, you could branch "Documentation" and set Paligo to automatically branch the
"Getting Started" sub-publication too. The resulting "Documentation" branch would contain the
branched version of the "Getting Started" sub-publication.
For more details, see Create Branches [1649].

NOTE
The auto-branching feature can only create branches for sub-publications at
the top-level of the original publication. It cannot create branches for sub-
publications inside other sub-publications. Similarly, it cannot create branches
for the topics inside those sub-publications.

Cross-References in Branches
When you create a branch of a topic [1649], Paligo recognizes that the branch has a relationship
with the original version of the topic and other branches from that topic. As a result, Paligo is able
to resolve any cross-references between the original topics even when these topics are branched
into new topics.

When you add a cross-reference to a topic, you should normally add the link to the origin topic,
not the fork (topic reference inside a publication). Paligo can then resolve the cross-references
even if topics have been branched multiple times. There is one exception to this rule, which
applies in a particular scenario when publishing to external systems such as Zendesk, SalesForce,
and ServiceNow (see the note below).

To learn how to add cross-references to topics, see Add Cross-References to Other Topics [248].

Example 84. Example of using cross-references to branched topics

Let's say you have an "Installation" topic and you branch it.

Then, in a "Getting Started" topic you need to add a cross-reference to the branched version of the
"Installation" topic.

For that, you add a link to the origin topic (component) "Installation", not its publication fork.
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When you publish, Paligo processes the cross-reference and looks for the target. It knows that
"Installation" and "Installation (branch 1)" are different versions of the same topic, so as long as
there is a branch of that topic in the publication, it can resolve the cross-reference.

Paligo Documentation

1645



Cross-references will work even if you branched topics as long as any branch of that topic exist in the
publication.

NOTE
Cross-reference a publication "fork" to the topic instead of the actual topic if both
of the following apply:

• You publish multiple publications to different categories in an external support
platform, such as Zendesk

• You have reused the same topic in multiple publications, and those are being
published to separate categories

In this specific scenario, you need to cross-reference to the fork in the publication
instead of the topic. This is needed so that Paligo can resolve the link and
maintain the mapping of the content when it is published to the external support
platform.

Images in Branches
When you create a branch of a topic [1649], Paligo checks to see if the original version of the topic
contains images. If it does, Paligo will keep the same references to the image file in the branched
version. Paligo does not create a branched version of the image file.

If you edit an image, those changes will apply wherever that image is used, and that includes other
branches.

If you want a branched version of a topic to use a different image, add the new image to the media
library and insert it in the branched topic.

To learn how to add images, see Add an Image to a Topic [310].

What Happens When You Merge a Branch?
When you merge a branched publication or branched topic, Paligo moves changes made in one
branch into another version of the content. For example, if you choose to merge a branch with the
source version, Paligo will place content from the branch inside the source.

You choose which parts of the content will be updated, added, or removed when you set up the
merge process (see Merge Branches [1658]. Paligo has a merge dialog where you can see what is
going into the publication/topic that receives the merge content.
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The dialog shows the different versions and a preview of the end result:

• The "merge from" branch contains the content that is being used to update the "merge to"
branch

• The "merge to" branch receives the changes made during the merge.

If the merge adds a new element, such as a paragraph, to the "merge to" version, the new element
uses its id from the "merge from" version. So the "merge to" content gets a new element with a
new id.

If the merge updates an element that already exists in the "merge to" version, the content keeps
its original id. The id from the "merge from" is ignored. This applies to the publication id and topic
ids as well as the individual components for paragraphs, lists etc.

As Paligo keeps the original id for content that already exists, it means merging will not disrupt any
mapping you have in place for publishing to support systems, such as Zendesk and Salesforce.

Select Branching Mode
Paligo has two different modes for branching:

• Simplified branching - With simplified branching, you can only have one main branch. All
branches must be created from that same branch. This means that you cannot create branches
from other branches.

• Consecutive branching - Consecutive branching lets you create a new branch from any
content, even from other branches.

TIP
Paligo recommends that you use Consecutive branching as it provides more
functionality and allows both simple branching and more complex branching
scenarios.
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To choose the branching mode for your Paligo instance:

1. In Paligo, select your profile in the top-right corner to display a menu.

2. Select Settings.

3. Select the System Settings tab.

4. Use the Consecutive branching setting to toggle the modes.
If you Enable advanced branching, consecutive branching mode is on. If you disable it,
simplified branching mode is on.

Add or Edit Branch Labels
When you create a branch, Paligo adds a branch symbol and a number to the publication or
topic automatically. But it is also a good idea to add a label, so that it is easier to understand
the difference between branches. For example, you could add a label for the product version, a
release date, or to show the content is part of an update.

The label is shown next to the publication or topic name in the Content Manager, Dashboard,
Resource View and other displays where the name is included.

When you create a branch for a publication, the create branch dialog has a Label field where you
can create a label (see Create Branches [1649]).

To add or edit an existing label:

1. Select the Dotted Menu (...) for the topic, component or publication in Content Manager [34].
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2. Select Branching and choose Edit Label. 

3. Enter the text for the label or change existing text.

4. Select the checkmark to save label. 

Create Branches
In Paligo, you can create branches of your publications and topics. Each branch is a copy, but can
also be merged back into earlier branches. This is useful for creating different versions of content
for similar products and also for having concurrent versions of your documentation. For more
examples of use cases for branching, see Branching [1638].

NOTE
We recommend that you branch topics from inside a publication rather than
branch topics independently.

Create a Publication Branch
To create a branch of a publication:

1. In the Content Manager, find the publication and select its options menu ( ... ), and then New
branch.
Paligo displays the Create Branch dialog.
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2. Enter a name for the Label. This will appear in a box next to the name of the publication in the
Content Manager and elsewhere. We recommend that you add a descriptive Label so that it is
easy for other users to tell the difference between different versions of the same publication.

The Label setting is optional. If you do not want to use a label, leave it blank.

3. In the Auto-branching section, choose whether Paligo should create branches for any sub-
publications as well:
Clear the Publications box if your publication:

• Contains reused publications (sub-publications), and you want to make changes to some of
them without affecting the originals.

• Contains reused publications (sub-publications) and you do not want to make changes to
them.

• Does not contain reused publications (sub-publications).
When you clear the box, Paligo reuses the sub-publications and does not branch them.
If you make changes to the sub-publications, those changes will also affect the same sub-
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publications in other branches. To make changes that do not affect other branches, create a
branch of the sub-publication first, and then work on the branched version.
Check the Publications box if your publication:

• Contains reused publications (sub-publications), and you want to make changes to all of
them without affecting the originals.

When you check the box, Paligo will create a branch for your selected publication and will
also create new branches for any sub-publications inside it. Any changes you make to the
sub-publications will not affect other branches.

4. In the Auto-branching section, choose whether Paligo should automatically create branches
for the topics.
Clear the Topics box if your publication reuses topics.

When you branch the publication, it will continue to use the same topics, so any changes you
make to those will also affect other branches. If there are topics you do need to change, you
can branch those topics from the publication forks independently.
Check the Topics box if your publication does not have much (if any) reuse of topics, and you
want to use the new branch as a "work in progress" version. When you branch the publication,
it will use entirely new branched versions of the topics, so any changes you make to them will
not affect other branches.

NOTE
Auto-branching of topics is designed for particular scenarios, and in most
cases, we recommend that you leave it disabled (clear checkbox). This is
because auto-branching can result in unnecessary branches of topics where
reused topics would be more appropriate.

5. Select Create.
Paligo creates a branched version of your publication. It is shown next to the original version
of the publication in the Content Manager.
The original version has a gray branch symbol. Branches have a blue symbol with a number.
The number represents the version. For example, in the following image, "Getting Started"
version 2.1 has a branch symbol and 1, as it is the first branch of the original "Getting Started"
topic.

For consecutive branching (set in the System Settings [1817]), the numbering will also show
the origin branch number in parentheses.
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In the example shown, the "Getting Started" with the "UPDATE" label has 2 and (1) to show it
is the second branch to stem from the main "Getting Started" topic and is a branch of the first
branch (1).

You can now work on the content in your branched version.

If your branched publication has the same topics as the original, then the changes you make will
affect those topics wherever they are used.

If you branched the publication and its topics, the branched topics will be independent of the
originals. You can make changes to the branched topics without affecting the original version or
other branches. But note that if a topic reuses a text fragment [1113], that fragment is always
reused, even in branched versions of the topic.

To find out more, see What Happens When You Create a Branch? [1640].

Create a Forked Topic Branch
We recommend that you create branches of topics from inside the publication, as described in this
section. This is because when you branch from a publication's "fork", the branch uses the same
fork ID and this is important for resolving cross-references and when mapping to external systems
such as Zendesk, SalesForce and ServiceNow.

NOTE
There are alternative ways to create a branch of a topic. You can get Paligo to
create a branch for every topic in a publication automatically, and this will keep
the same fork ids too, Create a Forked Topic Branch [1652].

You can also create a topic branch directly from the topic. This is completely
independent of any publications, see Create a Stand-Alone Topic Branch [1656].

To create a branch from inside a publication:

1. In the Content Manager, find the publication that contains the topic you want to branch.
Expand it so that you can see the topics that are included in the publication. The topics you
see here represent the "forks" in the publication - these are links from the publication to the
topics that it references.
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2. Select the options menu ( ... ) for the topic that you want to branch, then select Branching >
New branch.
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Paligo creates a branch of the selected topic. The publication is updated automatically so that
it references the branched version of the topic instead of the original version.
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Paligo stores the branched topic in the same folder that contains the original version of the
topic.
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The main original version has a gray branch symbol. Branches have a blue symbol with a
number, and the number represents the version. For example, in the image shown, "Quick Set
Up" is the main, original version, so it has a gray branch symbol. The branched version has a
blue branch symbol with the number 1, to show it is the first branch to be created from the
main original topic.
For consecutive branching (set in the System Settings [1817]), the numbering will also show
the origin branch number in parentheses.

3. Select the options menu ( ... ) for the branched topic that you have created. Then select
Branching > Edit Label and enter some text for the label. We recommend that you add a
label that makes it easy to tell the difference between this branch and the original branch.
Adding a label is optional.

You can now work on the content in your branched version.

For branched topics, you can change the content in the branched version without affecting the
original version or other branches. But note that if a topic reuses a text fragment [1113], that
fragment is always reused, even in branched versions of the topic.

To find out more, see What Happens When You Create a Branch? [1640].

Create a Stand-Alone Topic Branch
When creating a branch directly from a topic in the Content Manager, it becomes a "stand-alone"
branch that is not used in any publications. The result is that the publication will continue to use
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the original version of the topic and the branched version will exist in the Content Manager. This
makes it possible work on it, even if the publication is to be published during the update. Once
you have done the required changes, you merge it with the main branch and it will replace the old
version in the publication.

To create a stand-alone branch of a topic:

1. Find the topic in the Content Manager.
You need to find the topic, not the "fork" from a publication to a topic. A topic appears with a
white file icon and is on its own. A "fork" appears as a gray icon and is always shown as being
inside a publication.

Topics are independent and have a white file icon (left). "Forks" are inside publications and have a
gray file icon (right).

2. Select the topic's options menu ( ... ) and then select Branching > New Branch.
Paligo creates a branch of the selected topic.

3. Select the options menu ( ... ) for the branched topic that you have created. Then select
Branching > Edit Label and enter some text for the label. We recommend that you add a
label that makes it easy to tell the difference between this branch and the original branch.
Adding a label is optional.

You can now work on the content in your branched version.
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For branched topics, you can change the content in the branched version without affecting the
original version or other branches. But note that if a topic reuses a text fragment [1113], that
fragment is always reused, even in branched versions of the topic.

To find out more, see What Happens When You Create a Branch? [1640].

Merge Branches
You can merge a branch [1638] back into its original source (or any "earlier" branch from the same
source. For example, let's say you have a topic about "Temperature Sensors" and you branch it
into two different topics. You now have the original "Temperature Sensors" topic and a branched
version of it. These branches are completely separate, and you now have the choice to:

• Let the multiple branches exist concurrently in Paligo as separate, but related, publications or
topics

• Merge the branches into a single publication or topic (the result of a merge is called a "single
branch")

• Merge parts of the branches. The branches will still exist concurrently as separate publications
or topics, but some of their content will be merged so that it is identical in all versions. You can
choose which parts you want to merge and which parts you want to remain separate.

The process for managing merges is slightly different depending on whether you want to Merge a
Topic Branch [1658] or Merge a Publication Branch [1661].

NOTE
Merging branches will not affect any mapping you have in place for publishing to
other systems, such as Zendesk and Salesforce. To find out how Paligo manages
the ids of the content, see What Happens When You Merge a Branch? [1646].

Merge a Topic Branch
You can use Paligo's merge feature to combine content from two different branched topic
versions. This is useful when you have an existing "live" topic and you need to work on some
updates separately.

If you move existing content into a new section element and making it a subsection. Paligo will
recognize the moved content as deleted content in its original position and the new position as new
content.

It is important to know the difference between Merge from and Merge target:

• Merge from - Is the branch that contains the changes that you want to adopt to the Merge
target.

• Merge target - Is the receiver of the content changes from the Merge from branch.

IMPORTANT
If the content is checked out or is in any status other than Work in progress, we
recommend that you check with other users before you do the merge. To learn
more, see Check-in and Check-out [136] and Release Process [1626].
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To merge a branched topic into a "Live" version:

1. Make sure that the "Live" version and the branch are checked in and have the status Work in
progress.

2. Select the Dotted menu (...) for the "merge from" branch in Content Manager [34]

3. Select Branching and choose Merge Branch.

4. Select the Merge target from the menu. This can either be the main topic or other topics
created from the same branch.

TIP
By using the checkbox Change release status and check in, Paligo will
automatically change the release status of the topic or publication and check
it in.

5. Select Next.
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6. Paligo provides you with a preview of the changes divided in two columns. Left column shows
the Merge target and right column shows the Merge from branch.
Color highlights show the changes:

• Red - This content will be deleted from the "Merge target" and is grayed out in the "Merge
from" column.

• Green - This content is new or changed that will be added to the "Merge target". It only
exists in the "Merge from" branch at the moment.

NOTE
Use the checkbox Delete branch when done to decide whether to keep or
remove the "Merge from" branch after the merge.

• Check the box to delete the "Merge from" branch.

• Clear the box to keep the "Merge from" as a separate branch.

7. Choose what to include or exclude from the merge.

• Accept the change by leaving it highlighted.

• Reject the change by selecting the text fragment. It is possible to toggle the change on and
off.

• Do nothing if you only want to view the changes. You can close the window by selecting the
X in the top right corner.

8. Select the Preview button in the lower right corner to see how the changes affect the content.
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9. Select Close to end the preview.

10. Select Merge to complete the merge process.

Merge a Publication Branch
You can use Paligo's merge feature to combine content from two different branched versions of
a publication. This is useful in many different scenarios, but is commonly used when you have an
existing "live" publication and you need to work on some updates separately.

In this situation, you publish the "Live" publication and create the "In progress" branch, see Create
Branches [1649]. This makes it possible to work on updating the "In progress" branch. When the
update is ready to be published, you merge it with the "Live" version, to create one up-to-date
version and then publish it.

It is important to know the difference between Merge from and Merge target:

• Merge from - Is the branch that contains the changes that you want to adopt to the Merge
target.

• Merge target - Is the receiver of the content changes from the Merge from branch.

IMPORTANT
If the content is checked out or is in any status other than Work in progress, we
recommend that you check with other users before you do the merge. To learn
more, see Check-in and Check-out [136] and Release Process [1626].

1. Make sure that the "Live" version and the branch are checked in and have the status Work in
progress.
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2. Select the Dotted menu (...) for the "merge from" branch in Content Manager [34].

3. Select Branching and choose Merge Branch.

4. Select the Merge target from the menu. This can either be the main publication or other
publication created from the same branch.

TIP
By using the checkbox Change release status and check in, Paligo will
automatically change the release status of the topic or publication and check
it in.

5. Select Next.

6. Paligo displays a Preview (Simple Merge) of what the "Merge target" will look like after the
merge has taken place. Color highlights show the changes:

• Red - This content will be deleted from the "Merge target".

• Blue - This content will be updated with content from the "Merge from" branch that is
different to the content in the "Merge target".

• Green - This content will be added to the "Merge target". It only exists in the "Merge from"
branch at the moment.
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NOTE
The Preview is the same in both Simple Merge and Advanced Merge. You
can toggle between Simple Merge and Advanced Merge with the button in the
lower left corner. Depending on which view that is activated, the button name
switches between Simple Merge and Advanced Merge.

The advanced merge has three columns:

• Left column shows the content in the "Merge from" branch in its current
state.

• Middle column shows the content in the "Merge target" branch in its
current state.

• Right column (same as Simple Merge) shows a Preview of the "Merge
Target" branch if the merge is done.

7. Use the Preview column to control which changes that will be applied to the "Merge target".
When you choose which content you want to merge, the preview is instantly updated.

• Restore a deleted topic by selecting the red topic. It will be marked as "added"
(green).

• Remove an added topic by selecting the Green topic. It will be marked as
"deleted" (red).

•

• Accept topic changes by selecting the Check mark to the right of the blue topic. The
changes will be merged into the "Merge target".

• Reject topic changes by selecting the Cross to the right of blue topic. The changes will
not be merged into the "Merge target".

• View the topic changes and accept or reject them individually by selecting the Pen
to the right of the blue topic . This opens the Merge document dialog that highlights the
content changes and makes it possible to choose what to include or exclude from the
merge.
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TIP
This can also be done from the Merge to and Merge from columns in the
Advanced Merge. By hovering over content in these columns, you can Add
(+) and Remove (-) content.

8. Select the Pen to view the changes individually. 

IMPORTANT
If the Publication Topic - "Front Matter" [109] has been updated, it will be
highlighted in blue and the pen will appear to the right of the publication
icon. 

To merge these changes into the merge target, you have to select the pen
and choose merge to accept them. Otherwise these changes will not be seen
as accepted for the merge.

9. Choose what to include or exclude from the merge.
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• Accept the change by leaving it highlighted.

• Reject the change by selecting the text fragment. It is possible to toggle the change on and
off.

• Do nothing if you only want to view the changes. You can close the window by selecting the
X in the top right corner.

• Select the Preview button in the lower right corner to see how the changes affect the
content.

10. Select Merge to save the changes and return to the Preview (Simple Merge).

NOTE
It is possible to return and redo the changes again by selecting the Pen.

11. Select Settings in the top right corner. 

12. Use the checkboxes to decide what happens with the branches after the merge is done:

• Check the "From" branch box to delete the "Merge from" branch.

• Check the Unchanged inner branches box to delete any reused topics or publications that
are identical in the "Merge From" branch and the "Merge To" branch.

• Clear the boxes if you want to keep the "From" branch and / or the unchanged inner
branches.

13. Select Merge to complete the merge process.

Convert Branch to Main Branch
If you want to break the relationship between a branch and its original version, use the Convert to
Main Branch option. This removes the branching and turns your branched publication/topic into
a regular publication/topic.

For example, let's say you create some documentation for a product called "Acme 1000". A special
version of the product, called "Acme 1000X", is scheduled for release so you create a branch that
you can use to work on its documentation. Some way into the project, it is decided that the "Acme
1000X" was going to become a completely different product called "Acme SmartHub". At this point,
you decide that the documentation needs to be separate and so you want to break the "branch
relationship" between the branch and the original version. To do that, you use Convert to Main
Branch.

1. Find the branched publication or topic in the Content Manager.

2. Select its options menu ( ... ) and then select Branching > Convert to Main Branch.
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Paligo removes the connection between the branched content and the original version of the
content. Your selected content is now separate and cannot be merged back into the original
version.

Revision Control
Paligo stores a record of your content each time that you save it. Each record is a called a revision,
and Paligo keeps revisions of:

• Components, such as topics, informaltopics, and admonitions

• Text fragments, such as individual paragraphs.

With the revisions feature, you can:

• Keep an audit trail of your content, as you can see what changes have been made and who
made them [1667].

• Compare different revisions [1669] of the content, for example, comparing a previous revision of
a paragraph to the latest version.
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• Revert your current content back to an earlier state [1672], for example, reverting a paragraph
to a previous revision. This can be useful when other authors or contributors make changes to
the content that you want to "undo".

• Create new components based on the revisions of other components [1676].

• Download revisions [1677].

• Delete revisions [1678]that you no longer need.

View Revision History
When you save a topic, Paligo keeps a record of the changes made to each component and each
text fragment. The records are called revisions, and you can view them to see how content has
changed over time.

History of a text fragment

You can view the history of components, such as topics and informal topics and also the history of
individual text fragments (paragraphs).

View Revisions of a Topic
When you save a component, such as a topic or an informal topic, Paligo stores a record called a
revision. This is like a snapshot of the component at that point in time.

You can view the revisions so that you can see a history of the changes that have been made.

To view the revisions of a component:

1. In the Content Manager, locate the component and select its options menu ( ... ).

2. Select Revisions.
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A Revision Overview dialog shows the available revisions for the component. It includes the
date on which the revision was saved, the user that made the save, and the approximate
percentage of changes made since its previous revision.

You can use the Revision Overview dialog to compare revisions and to revert the current
component back to an earlier revision.

View Revisions of a Text Fragment
When you save a topic, Paligo stores a record of the changes you have made. These include the
changes to each individual paragraph (text fragment). Each record is called a revision, and they act
like a snapshot of the text fragment at that point in time.

You can view the revisions so that you can see a history of the changes that have been made.

To view the revisions of a text fragment:

1. In topic that contains the text fragment, select the text fragment and then select its para
element in the element structure menu.
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2. Select Text> Show history.

A dialog shows the history of the text fragment. It includes a list of the revisions, the time and
date on which they were saved, and the user who made the save. There is also an estimation
on the amount of changes made compared to the previous revision.

You can use the history dialog to compare revisions and to revert the current text fragment back
to an earlier revision.

Compare Revisions
You can view and compare two revisions of:

• Components such as topics and informaltopics
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• Text fragments (paragraphs).

For example, let's say that during a contribution assignment, an engineer made changes to a
paragraph. After the assignment, you can view the history of the paragraph and compare the
engineer's revision to a revision from before the contribution assignment.

When you compare revisions, Paligo highlights the differences between the two revisions. You
then have the option to keep the current version or revert to an earlier version if you prefer.

Compare Revisions of a Topic
You can compare different revisions of components, such as topics and informaltopics. You
choose which revisions you want to compare and then Paligo shows you the differences.

1. Find the component in the Content Manager. Select its options menu ( ...) and then select
Revisions.

2. In the Compare column, select the buttons for the two revisions you want to compare.

3. Select Compare versions.
The comparisons are shown side-by-side.

The differences are color-coded:

• blue means changed text

• green means added text

• red means removed text.

Paligo Documentation

1670



Compare Revisions of a Text Fragment
You can compare the different revisions of a text fragment (paragraph). When you compare, Paligo
shows you the differences between the two revisions.

1. Open the topic that contains the text fragment and then select the text fragment.

2. In the element structure menu, select the para element and then select Text > Show history.

3. In the Compare column, select the radio button for the two revisions that you want to
compare.

4. Select Compare.
Paligo shows the differences between the two revisions.
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The differences are color-coded:

• blue means changed text

• green means added text

• red means removed text.

TIP
You can use the language selector in the bottom corner to switch to translated
revisions of the text fragment. For example, if your source language is English and
you have a Swedish translation of a paragraph, you can switch to Swedish and
compare Swedish revisions of the text.

You will learn how to edit the connection settings during the tutorial.

Revert to Earlier Revisions
You can revert content back to an earlier revision. This is especially useful when you have multiple
people working on the content and somebody makes an unwanted change. For example, a
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contributor may add lots of technical detail to a paragraph that you, as the technical writer, feel
is more detail than the reader needs. So you can revert the paragraph to a previous revision to
"undo" the changes the contributor made.

You can revert:

• A publication

• Entire components, such as topics and informaltopics

• Individual text fragments (paragraphs).

Revert a Publication to a Different Revision
Each time you save changes to a publication's structure, Paligo stores a record of the publication
at that point in time. These records are the "revisions" and you can revert back to any available
revision. For example, let's say you make changes to the structure of a publication on July 1st, but
you then change your mind and want to revert back to how it used to be. By using the Revisions
feature, you can change the publication's structure back to how it was on an earlier date.

When you use the Revisions feature, it is only the structure of the publication that changes. Paligo
does not revert the content in the publication's topics.

NOTE
It is possible that you could revert back to a revision of a publication that links
to topics that no longer exist, as they have been deleted. In this scenario, Paligo
will recreate those topics, and try to add as much of the metadata as possible,
including the ID. If the metadata ID is added to the topic, you may be able to use
Revert a Topic to a Previous Revision [1674] to restore the topic's content. If not,
you will need to add the content manually.

To revert back to an earlier publication revision:

1. Select the publication in the Content Manager [34]. 

Paligo displays the publication's structure.

2. Select the Revisions button at the bottom of the Structure view. 
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3. Select the link in the date column to preview the publication structure for a certain revision in
the Preview panel.

4. Select Revert to restore a revision.
Paligo will restore the publication revision that you selected.

TIP
Two useful features in the Revisions view:

To delete a revision from the Revisions view, select Remove revision at the
bottom of the Preview panel.

To manually save the latest structure update, select Create a revision at the
bottom of the Revisions view.

Revert a Topic to a Previous Revision
You can revert a topic to a previous revision of the topic. If you decide against the change, you can
revert it back to another revision.

1. Find the component in the Content Manager. Select its options menu ( ...) and then select
Revisions.

2. Find the revision you want to revert to.

3. Select the options menu ( ... ) for the revision and then select Revert to this revision.
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The topic reverts back to the revision you selected.

TIP
You can also create a new document from an older revision if you want. It will be
placed in the same folder as the current topic. It is also possible to download an
export XML file of a revision.

Revert a Text Fragment to a Previous Revision
You can revert a text fragment, such as a paragraph, back to a previous revision. For example, if
someone has added incorrect information to a paragraph, you can change it back to the correct
content from an earlier revision.

1. Open the topic that contains the text fragment and then select the text fragment.

2. In the element structure menu, select the para element and then select Text > Show history.
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3. Select the Date link for the revision you want to revert to.
Paligo shows a preview of the revision.

4. Select Revert version.

NOTE
If your text history contains revisions that are duplicates or are no longer needed,
you can delete them.

New Topics Based on Revisions
You can create a new component, such as a topic, informaltopic, or admonition, based on the
revision of another component. This can help you save time if you need a new topic, note, etc., and
it should be the same as, or similar to, content that existed previously.

1. Find the component in the Content Manager. Select its options menu ( ...) and then select
Revisions.

2. Select the options menu for the revision that you want to use as the starting point for the new
component. Select Create new document.
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3. When Paligo displays a "Document has been reverted" dialog, select OK.
Paligo creates a new component and adds the content from the selected revision to it. The
content is given new IDs, so each piece of the content is a new database entry and not reused.
The new topic and the revision may contain the same content, but the content is completely
separate, so you can update the topic without affecting the revision.
Paligo creates the new component to match the type of component that you selected in step
1. For example, if you created a new component from a revision of an informaltopic, Paligo
creates a new informaltopic. The new component is added to the same folder as the original
component, but you can move it elsewhere if you want.

Example 85. Creating a new topic based on a revision

Let's say you need to create a new "Charging" topic for a product called "ACME 200". The ACME
200 uses a mains adaptor for charging.

In Paligo, you have documentation for a similar product, called "ACME 100". This also has a
"Charging" topic and it currently explains how to charge via USB-C. But in the past, this topic
explained how to charge via a mains adaptor.

So for the "ACME 200", instead of writing the new "Charging" topic from scratch, you can create a
new topic based on the "ACME 100"'s old revision.

1. You go to the "Charging" topic in the "ACME 100" documentation and display its revision
history.

2. You select the revision that contains the mains adaptor content and then select Create new
document. Paligo creates a new topic that contains the mains adaptor content. The content is
given new IDs.

3. You edit the new topic so that it is accurate for the "ACME 200" product. The changes you
make have no effect on the revision in the "ACME 100" history.

Download Revisions
You can download the revisions of your topics.

1. Find the component in the Content Manager. Select its options menu ( ...) and then select
Revisions.

2. Select the options menu ( ... ) for the revision you want to download and then select
Download this revision.
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Delete Revisions
You can delete revisions that are no longer needed. For example, if you have reverted back and
forth between versions of a text fragment, you may have revisions that are identical to revisions
that already exist. So you may want to delete some of the identical ones.

You can delete a revision of:

• A publication

• A component, such as a topic or informaltopic

• A text fragment, such as a paragraph.

Delete a Publication Revision
If you have a publication that has revisions that are no longer needed, you can delete them.
This can be a useful way of reducing the amount of storage space you are using on your Paligo
instance.

To delete a revision of a publication:

1. In the Content Manager, select the the folder that contains the publication. Select the
Documents folder if your publication is not in one of the blue user-created folders.
Paligo displays the Resources view for the folder.
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2. Select the options menu ( ... ) for the publication that has revisions you want to delete, and
then select Revisions.

Paligo displays the Revision Overview for the publication. It shows all of the revisions that are
available.
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3. Select the options menu ( ... ) for the revision you want to delete, and then select the Delete
option.

Delete a Topic Revision
If you have a component such as a topic or an informaltopic that has revisions that are no longer
needed, you can delete them.

1. Find the component in the Content Manager. Select its options menu ( ...) and then select
Revisions.

2. Select the options menu ( ... ) for the revision you want to remove and then select Delete.
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Delete a Text Fragment Revision
To delete a revision of a text fragment such as a paragraph:

1. Open the topic that contains the text fragment and then select the text fragment.

2. In the element structure menu, select the para element and then select Text > Show history.

3. Select the Date link for the revision you want to delete.

4. Either select the revision's X icon in the table or select Delete version.
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Translation Management

Abstract
Learn how to get your Paligo content translated into other languages. Export content to
translation services or translate it inside Paligo.

Paligo has built-in features for supporting the translation of your content. These include
integrations with professional translation software (Semantix and Phrase), built-in workflows and
a translation editor and assignments. These features are designed for managing the various
different ways of translating your content.

When your content is ready for translation, the next steps will vary depending on how
your content is being translated. While Paligo recommends that you Work with a Translation
Service [1702], in some situations, it makes sense to Working in Translation View [1752] instead.
You will also need to Prepare Content for Translation [1734].

If you need to activate more languages, see Language Management [1872].

IMPORTANT
You should avoid using both approaches together. This is because if you use
a translation service, they will most likely use software that has a translation
memory.

This is a record of the content you have sent to them and the translations they
provided. If you subsequently change the translation in Paligo, then the content
in Paligo and the translation memory will no longer be in sync. This can cause
confusion and avoidable costs, as content that is not synced may be translated
again.

NOTE
Branching is necessary to be able to work while content is being translated, see
Branching [1638] and Update Content when Translation is Not Finished [1727].

About Translation Service
Paligo recommends that you use a professional translation service for your documentation. This
could be either an external translation agency or translators in your organization, who use a
professional translation software that has a Translation memory which keeps a record of the
Paligo content and the translations provided. As long as the Paligo content and translations are in
sync, the translation service should be able to identify if the content is:

• Already translated and can be ignored.

• New and in need of translation.

• Changed and in need of re-translation.
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This should result in reduced translation costs and time, as translators only need to work on
content that is new or has changed. To find out more about the workflow and how to get started
with this approach, see Workflow for Translation Service [1703].

NOTE
If your:

• Organization is unable to use a translation service, it is possible to add
translations in Paligo, see Work with Internal Translators [1685].

• Organization translates the content inside your organization and use a
professional translation tool, follow the same instructions as for using a
translation service, see Work with a Translation Service [1702].

• Translation service is using Crowdin, the process for translating content
is different, as translation packages are not used, see Translate with
Crowdin [1709].

About Paligo's Built-in Translation Editor
Paligo has its own built-in translation editor called Translation View [79] that you can use to
perform simpler translations without translation memory. The translations are stored in the
Paligo database with the matching source content. If you have reused content, any translations for
that content are also reused.

This is a relatively simple editor with editing features and auto-translate which uses Google
Translate. Using auto-translate can be a useful starting point for your translators, but we do
not recommend that you rely on it entirely for your translations. You also have to keep track of
changes manually. So if you add new content or change existing content in the source language,
you will need to remember to update the translations too. To find out more about the workflow
and how to get started with this approach, see Workflow for Internal Translation [1686].

IMPORTANT
If you are only making minor changes to the translation, such as fixing a typo
or changing a product name, you could use both a translation service and
Translation View [79], but it is a good idea to check this with your translation
service first and you should only make minor changes that are unlikely to affect
the translation overall. Because the content in Paligo and the translation memory
will no longer be in sync. This can cause confusion and avoidable costs, as
content that is not synced may be translated again.

If you are going to use Paligo for translating content inside your organization, see
Work with Internal Translators [1685].

Use the built-in translation editor if your organization is:

• Unable to use an external translation service

• Able to translate the content internally, without access to a professional translation software.
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NOTE
For professional results and to make the translation process as efficient as
possible, Paligo recommends that you use a translation service.

Who Can Translate Content in Paligo?
If you are going to use a translation service, an author can handle the translation export, see Work
with a Translation Service [1702]. It is also possible to use a translation Integrations [1380], such as
Phrase, to export and import the content directly.

The recommendation is to use a professional translation service, however it is possible to translate
in Paligo via Translation View [79], see Work with Internal Translators [1685] and to Auto-Translate
Content [1764].

The following roles are able to handle translations:

• Administrators , Authors and Translation Managers can all access the Resource View [68] and
Translation View [79].

• Contributors can access Translation View [79], but only if they are allocated a translation
assignment or translation review assignment.

Work with Internal Translators
We recommend that you use a professional translation service for translating to other languages.
This could be either an external translation agency or translators in your organization with access
to professional translation software.

If your organization does not have access to professional translators and translation software, it is
possible to use Paligo's Built-in Translation Editor called Translation View [79]. With this approach,
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there is no translation memory so the translations need to be managed manually. Only source
language topics can and should be edited in Contributor Editor [41]. Translations should always be
edited in the Translation View [79] or exported to XLIFF for editing in external translation software.

It's also possible to translate content without using assignments, just by Working in Translation
View [1752]. But as sharing is separate to an assignment, there is no tracking of the work on the
Dashboard. For this reason, we recommend that you use the assignments instead. To find out
more, see Translation Management [1683].

If you want a Contributor / Translation Reviewer to review and edit a translation create:

• Translation Assignments [1688] to create translation jobs and assign them to the internal
translators.

• Translation Review Assignments [1696] to review the translations and accept / reject them.

CAUTION
Do not share the document or send it as a contribution assignment.
For an overview of the recommended process, see Workflow for Internal
Translation [1686].

Workflow for Internal Translation
For translations, we recommend that you use a professional translation service. This could be
an external translation agency or translators inside your organization who use professional
translation software with a translation memory. But if you do not have access to professional
translation software, it is possible to translate content directly in Paligo too. Paligo has a
translation editor, which we call the Translation View, that you can use to add and review
translations.

If you are using Paligo's Translation View to add translations, the basic workflow to follow is:

The following procedure has step-by-step instructions for translating your content in Paligo, with
links out to articles that contain more details about the Translation View and other features.

Stage 1: Add Languages
Before your content can be translated, you need to set up the translation languages in your Paligo
instance. You also need to add the languages to the topics and publications you want to translate.

For details on how to add the languages, see:

• Activate Languages [1873]

• Create Additional Languages [1874]

• Add a Language to a Publication or Topic [1877].
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Stage 2: Prepare your Content
To prepare your content for translation:

1. Create your publication and topics in the source language. When you are editing the content,
the topics should be in the Work in progress state.
To learn how to change the state of the content, see Change the Status of a Publication or
Topic [1210].

2. Get your content reviewed so that you can be confident that it is accurate and as complete as
it should be. For reviews, the topics should be in the In Review state.
To send the content for review, it is a good idea to use review assignments, as these are
tracked by Paligo. For details, see Author Instructions for Review Assignments [1272].

3. When the review is complete and the content is approved, put the content into the In
Translation state.

NOTE
If your content contains images, variables, or filters that need to be translated,
you will need to send these to the translators. These files are not included in a
translation package. To learn how to prepare these parts for translation, see:

• Translate Images [1736]

• Translate Variables [1749]

• Translate Filters [1749].

Stage 3: Set the Content to In Translation
When you have prepared your content in its source language and it is ready to be translated, set
its state to In translation.

To learn how to change the state of the content, see Change the Status of a Publication or
Topic [1210].

NOTE
Some translation software, such as Crowdin, can detect that a topic has been
changed to the In Translation state. It uses this change as a signal that the
content needs to be translated.

Stage 4: Send the Content to the Translators
When you have prepared the content for translation, you can send it to your translators. We
recommend that you use Translation Assignments [1688], as these are tracked in Paligo.

The translators can use Paligo's Translation View to add the translations for your content (see
Working in Translation View [1752]).
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Stage 5: Set to In Translation Review
When the translators have finished their work, change the content's state to In translation
review.

The translated content can then be reviewed to check that it is complete and suitable. For this, we
recommend that you use translation review assignments, see stage 6.

Stage 6: Review the Translation
To review the translation, we recommend that you use Translation Review Assignments [1696] as
they are tracked by Paligo. Whoever reviews the content can use the Translation View to make
comments, change the translated content, accept the translation or return it saying that it needs
more work.

When the translation review is finished, the content will be set to "Needs work" or "Accepted".

If the translation review is complete and set to "Needs work", Paligo puts the content back into
the In translation state. You can then create a new translation assignment and allocate it to
the translator, so that they can complete or correct the translation. They will be able to see the
comments from the reviewer in the Translation View.

If the translation was accepted in the review, the content is ready for release (see stage 7).

Stage 7: Release the Content
When the content is ready for release, publish it [1068] in the translated languages. Change the
content's state to Released.

Translation Assignments
Translation assignments are tasks for translation jobs. They are designed for use when you have
translators in your organization and they are going to add their translations directly in Paligo.
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When you create a translation assignment, you can allocate it to specific people and then track it in
Paligo. So you can see who has been assigned the work, the proposed timescale, and the current
status.

When a translation assignment is completed, the next step in the recommended workflow is to
review the translated content (see Translation Review Assignments [1696]).

NOTE
Translation assignments are designed for translators who use Paligo to add the
translation. They are not needed if you send your translation content to an
external translation service or have translators who use professional translation
software.

Create a Translation Assignment
Translation assignments are useful when you want to create a translation job that will be allocated
to a particular user and will be trackable from the Paligo dashboard.

To create a new translation assignment:

1. Display the Resource view for your content. To do this, find your content in the Content
Manager and then select the folder that contains the content.

NOTE
If your content is not in a folder, select the Documents section at the top of
the Content Manager instead. Documents is the top-level "parent" folder for
any content that is not inside another folder.

2. Use the status button to set the content state to In translation.

3. In the Content Manager, select the options menu ( ... ) for the publication or topic and then
select Create Assignment > Translation.
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Paligo displays the Translation Assignment dialog.

NOTE
Alternatively, you can select the options menu ( ... ) for the publication or
topic in the Resource View, and select Create Assignment.

4. Use the Translation Assignment dialog to define your requirements for the translation job:
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• Document - This is the name of the selected publication or topic. If you have selected
the wrong content by mistake, you can use this field's folder icon to browse to a different
publication or topic and use that instead. This is quicker than going back to the content
manager and starting all over again.

• Language - Choose the language that you want the assignee to work on. This has to be one
of the languages that have been added to the content (see Add a Language to a Publication
or Topic [1877]). You can only choose one language per assignment.

• Profiling - If the content uses profiling (filters), choose the values that should be in place
for the translation. The options available come from the Favorites that are saved for the
content, and these are set in review mode, contributor mode, or the translation view. To
learn how to create the profile settings and store them as favorites, see Working in Review
View [1278].

• Assignee - Choose the person who will work on the assignment. You can only choose
someone who has a Paligo user account in your Paligo instance.
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• Assignment date - Select the fields to access the calendars. Use the left field's calendar
to choose the start date and the right field's calendar to choose the end date for the
assignment.

• Check the Let me leave a message box if you want to provide additional instructions, and
then enter your text in the field that appears.

5. Select OK to send the assignment.
The assignee will receive an email with a link that takes them to the content. When they select
the link, the content opens in Paligo's translation view (translation editor) and they can use
that to work on the translation (see Working in Translation View [1752]).
As the person who created the assignment, you will also receive an email to confirm
that the assignment has started. You can track the progress of the assignment on your
dashboard [1692].

Track a Translation Assignment
When a translation assignment is underway, you can track its progress if:

• You are the person who created the assignment

• You are the translator who has been allocated to the assignment.

Information about translation assignments is shown on the Planner and also on the dashboard.

You can access the Planner by selecting Planner in the top menu. It is only available to Paligo
administrators and authors, and it shows a timeline with details of when the assignments are due
and who is working on them.

You can also view assignment on your dashboard. Select Dashboard in the top menu to display it,
and then look in the Assignments section.
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To find out more on tracking assignments, see Track the Assignment Progress [1246].

Declined Translation Assignments
If you allocate a translation assignment to somebody and they set it to Declined, it means they
have rejected the assignment. There are many possible reasons for this, for example, they may
not have the time to work on the assignment due to other priorities. If you created an assignment
and it was declined, Paligo will notify you via email.

If one of your assignments is declined, go to your Dashboard and look in the Assignments
section. The declined assignment is listed in the Done tab. Find it and then, if needed, you can use
the cog icon menu to Reassign an Assignment [1260].

NOTE
To learn how to decline a translation assignment that has been allocated to you,
see Translator Instructions for Translation Assignments [1694].

Reassign a Translation Assignment
You may need to reassign a translation assignment if the translator has declined the work or has
not responded in time. To reassign the translation work, select Dashboard in the top menu, then
look in the Assignments section. The translation assignment will appear either in the By You tab
or the Done tab. Select its cog icon and choose Reassign, and then use the Reassign dialog to
reallocate the work.
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For more details, see Reassign an Assignment [1260].

Translator Instructions for Translation Assignments
If you are invited to work on a translation assignment, you will receive the invite as an email and it
will also appear on your dashboard in Paligo. The following instructions explain what you need to
do to translate the content:

1. Select the link in your email to open the content in Paligo's Translation View (also known as
the translation editor). Alternatively, you can select the link in the title of the assignment on
your dashboard. You can now use the Translation View's features to work on the task.
On the left-side is the source language content and on the right-side is the translation you
need to work on.

Untranslated content has a prefix in square brackets, with the source language code, for
example, [en] for English.

2. Decide whether you are going to accept the assignment. If needed, you can decline it. For
example, you may be too busy or do not have the language skills needed to complete the
translation. To decline the assignment, open the assignment and then select the clipboard
icon and Declined. Paligo then notifies the creator of the assignment so that they can give the
translation work to somebody else.
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3. Select an element on the right-side to display a translation dialog. It shows the corresponding
text in the source language on the left.

4. Either:

• Select Copy source text to copy the original text into the editor. Use the editor to overwrite
the copied text with your translation. The copy includes any inline elements (such as the
emphasis element) and you can overwrite the text inside them too.

NOTE
You must use Copy source text option when translating footnotes.

• Enter your translation directly into the editor.
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NOTE
The translation dialog has options for accessing a dictionary, spellchecker,
adding special characters such as accented characters and trademark
symbols, and undo and redo for your changes.

Paligo also has an auto-translate feature, which uses Google Translate. For
more details, see Auto-Translate Content [1764].

For more information on the Translation View, see Working in Translation
View [1752].

5. Select Save.

6. Repeat this process for the rest of the content that you need to translate.

7. Select the clipboard icon and then select Done. This lets other people know that you have
completed the translation assignment.

Paligo notifies the person who created the assignment to let them know the assignment is
complete. If they are following the recommended workflow for internal translations, they will
either send the translation for review or they will approve the content.

Translation Review Assignments
Use translation review assignments to allocate a review of a translation to someone in your
organization. The translation review assignments are tracked by Paligo so that you can see who
has been assigned the work, the timescale for the work, and the current status.

When a translation review assignment is completed, the content is either approved or it needs
more work. If it needs more work, Reassign a Translation Review Assignment [1700] so that
they can make the changes. When they are done, create another translation review assignment
process. Repeat this until the content is approved and ready to publish.

NOTE
Translation review assignments are designed for reviewing the work of translators
who use Paligo to add translations.

If you are using a translation service, you may want to check that the translations
are complete, rather than review the content in detail. This also applies if
you have translators in your organization, but they use professional translation
software rather than Paligo. To check the completion status without using a
translation review assignment, see Check if the Translation is Completed [1722].
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Create a Translation Review Assignment
Use translation review assignments when you want someone in your organization to proofread
the translation that has been provided for some content. The translation review assignment can
then be tracked on your dashboard and in the planner.

To create a new translation review assignment:

1. Display the Resource view for your content. To do this, find your content in the Content
Manager and then select the folder that contains the content.

NOTE
If your content is not in a folder, select the Documents section at the top of
the Content Manager instead. Documents is the top-level "parent" folder for
any content that is not inside another folder.

2. Use the status button to set the topic status to In translation review.

3. In the Content Manager, select the options menu ( ... ) for the publication or topic and then
select Create Assignment > Translation review.
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Paligo displays the Translation Review Assignment dialog.

4. Use the Translation Review Assignment dialog to define your requirements for the translation
job:

• Document - This is the name of the selected publication or topic. If you have selected
the wrong content by mistake, you can use this field's folder icon to browse to a different
publication or topic and use that instead. This is quicker than going back to the content
manager and starting all over again.

• Language - Choose the language that you want the assignee to work on. This has to be one
of the languages that have been added to the content (see Add a Language to a Publication
or Topic [1877]). You can only choose one language per assignment.

• Profiling - If the content uses profiling (filters), choose the values that should be in place
for the translation. The options available come from the Favorites that are saved for the
content, and these are set in review mode, contributor mode, or the translation view. To
learn how to create the profile settings and store them as favorites, see Working in Review
View [1278].

• Assignee - Choose the person who will work on the assignment. You can only choose
someone who has a Paligo user account in your Paligo instance.

• Assignment date - Select the fields to access the calendars. Use the left field's calendar
to choose the start date and the right field's calendar to choose the end date for the
assignment.
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• Check the Let me leave a message box if you want to provide additional instructions, and
then enter your text in the field that appears.

5. Select OK to send the assignment.
The assignee will receive an email with a link that takes them to the content. When they
select the link, the content opens in Paligo's translation view (translation editor) and they
can use that to work on the translation (see Reviewer Instructions for Translation Review
Assignments [1701]).
As the person who created the assignment, you will also receive an email to confirm
that the assignment has started. You can track the progress of the assignment on your
dashboard [1699].

Track a Translation Review Assignment
When a translation review assignment is underway, you can track its progress from the dashboard
if:

• You are the person who created the assignment

• You are the person who has been allocated to the assignment.

Information about translation review assignments is shown on the Planner and also on the
dashboard.

You can access the Planner by selecting Planner in the top menu. It is only available to Paligo
administrators and authors, and it shows a timeline with details of when the assignments are due
and who is working on them.

You can also view assignment on your dashboard. Select Dashboard in the top menu to display it,
and then look in the Assignments section.
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To find out more on tracking assignments, see Track the Assignment Progress [1246].

Reassign a Translation Review Assignment
If a reviewer is unable to work on a translation review assignment, you may need to reallocate
the work. There are many reasons why this could happen, for example, if the reviewer has other
priorities or they do not have the language skills required.

To reassign the translation review work, select Dashboard in the top menu, then look in the
Assignments section. The translation review assignment will appear either in the By You tab
or the Done tab. Select its cog icon and choose Reassign, and then use the Reassign dialog to
reallocate the work.

Paligo Documentation

1700



For more details, see Reassign an Assignment [1260].

Reviewer Instructions for Translation Review Assignments
Translation review assignments are designed for use when all three of these conditions apply:

• Your organization has its own translators

• The translators are using Paligo to add the translation

• The work of the translators needs to be approved by other people (reviewers).

If you are allocated to a translation review assignment, you will receive an email containing a link
to the assignment. You can also open the assignment from your Paligo dashboard.

To accept the assignment and work on it:

1. Select the link in your email to open the content in Paligo's Translation View (also known as
the translation editor). Alternatively, you can select the link in the title of the assignment on
your dashboard. You can now use the Translation View's features to work on the task.
On the left-side is the content in the source language. The translation that you need to review
is shown on the right-side.

Untranslated content has a prefix in square brackets, with the source language code, for
example, [en] for English.

2. Use the Translation View's features to review the content.
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Position the cursor over a text fragment (paragraph) to display a pop-up toolbar.

You can use the toolbar options to:

• View a history of the changes made to a text fragment

• Compare the translations of a text fragment, so that you can see the various translations all
at once

• Add a comment. The comment can then be seen by authors and contributors, so they can
decide on what action to take.

• Mark a text fragment's translation as complete. You should do this to confirm that the text
fragment's translation is correct.

For details on how to use these features, see Working in Translation View [1752].

3. Select the clipboard icon and then select Approved or Needs work (if the translation needs
extra work). This lets other people know that you have completed the translation review
assignment.

Paligo notifies the person who created the assignment that you have completed the translation
review. If they are following the recommended workflow for translation reviews, their next step
will be to either:

• Create a new translation assignment [1689] so that any unfinished or incorrect translations can
be dealt with.

• Publish the content [1068] and put it in the Released state.

Work with a Translation Service
Paligo recommends that you use a professional translation service for your documentation. This
could be either an external translation agency or translators in your organization, who use a
professional translation software that has a Translation memory which keeps a record of the
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Paligo content and the translations provided. As long as the Paligo content and translations are in
sync, the translation service should be able to identify if the content is:

• Already translated and can be ignored.

• New and in need of translation.

• Changed and in need of re-translation.

This should result in reduced translation costs and time, as translators only need to work on
content that is new or has changed. To find out more about the workflow and how to get started
with this approach, see Workflow for Translation Service [1703].

NOTE
If your:

• Organization is unable to use a translation service, it is possible to add
translations in Paligo, see Work with Internal Translators [1685].

• Organization translates the content inside your organization and use a
professional translation tool, follow the same instructions as for using a
translation service, see Work with a Translation Service [1702].

• Translation service is using Crowdin, the process for translating content
is different, as translation packages are not used, see Translate with
Crowdin [1709].

Workflow for Translation Service
In this article, we explain what steps to take if you use a translation service. The translation service
could be either:

• An external translation agency

• Translators who work in your organization and who use professional translation software.

NOTE
This workflow does not apply if you have translators who are using Paligo to add
the translation. For details on the steps to follow in that scenario, see Workflow
for Internal Translation [1686].

The basic workflow when using a translation service or professional translation software consists
of several stages (described below and shown in the workflow diagram).
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With this workflow, the idea is that you prepare your content in the source language and then
send it for translation. While the content is being translated, you should not update the source
language content. This is because the translation needs to be in sync with the source language
version of the content. If you need to update and publish your content in the source language
while waiting for translations to be completed, see Update Content when Translation is Not
Finished [1727].

Before you start working through the stages of the workflow, make sure that you know how to
change the state [1210]. You will need to change the state of your content at various stages, so
that people know that the content is being translated.

Stage 1: Discuss Project with Translators
When you discuss your translation project with the translation service, find out:

• How the proofreading is going to be done.
This work is often completed in the translation tool by a subject matter expert (SME) who
understands the source language and the target language.

• Whether the files provided by the translators are going to be set as "confirmed and locked" in
the translation software. This will affect the state of the files when you import them into Paligo.

The translation service may ask for details about the settings they need for their software. For
these, see Translation Software Settings [1708].

If the translators are using Phrase or Semantix, use Paligo's integration settings to set up the
connection. For details, see:

• Connect Paligo to Phrase [1712]

• Connect Paligo to Semantix [1714].

Stage 2: Add Languages
Before your content can be translated, you need to set up the translation languages in your Paligo
instance. You also need to add the languages to the topics and publications you want to translate.

For details on how to add the languages, see:
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• Activate Languages [1873]

• Create Additional Languages [1874]

• Add a Language to a Publication or Topic [1877].

Stage 3: Prepare Content for Translation
To prepare your content for translation:

1. Create your publication and topics in the source language. When you are editing the content,
the topics should be in the Work in progress state.
To learn how to change the state of the content, see Change the Status of a Publication or
Topic [1210].

2. Get your content reviewed so that you can be confident that it is accurate and as complete as
it should be. For reviews, the topics should be in the In Review state.
To send the content for review, it is a good idea to use review assignments, as these are
tracked by Paligo. For details, see Author Instructions for Review Assignments [1272].

3. When the review is complete and the content is approved, put the content into the In
Translation state.

NOTE
If your content contains images, variables, or filters that need to be translated,
you will need to send these to the translators. These files are not included in a
translation package. To learn how to prepare these parts for translation, see:

• Translate Images [1736]

• Translate Variables [1749]

• Translate Filters [1749].

Stage 4: Send Content to Translators
When your content is ready for translation, you can send it to your translators. The process for this
varies depending on what software your translators use.

You will need to either:

• Export the content as a translation package and send it to the translators.
Create and send a translation package if the translators use software that does not have an
integration with Paligo. The translation package is an export file that you can email to your
translators.
To learn how to export a translation package, see Export a Translation Package [1715].

• Export the content directly to the translation software.
For more details on setting up Paligo to work with these, see Connect Paligo to Phrase [1712]
and Connect Paligo to Semantix [1714].

NOTE
Some translation software, such as Crowdin, have a different type of integration.
They detect when your topics change to the In Translation state and the content
becomes available to translators at that point.
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NOTE
If your content has images that need to be translated [1736], you will need to
export the images and send them to the translators separately. Images are not
included in translation packages.

Similarly, if you use variables, they need to be translatable variables [1749] and
you can send the variable set to your translators separately. Variable sets are not
included in translation packages.

Stage 5: Import the Translation
When the translators have completed their work, import the translation into Paligo (see Import a
Translation Package [1719]).

Your next step will vary, depending on the state of the content that the translation service
provided. Typically, it will be either "confirmed and locked" or "confirmed" (this is true for Phrase,
other vendors may use different terminology):

• Confirmed and locked files will import as 100% translated and 100% approved. The
proofreading is done, so you only have to change the state to Released in Paligo.
Ignore Stage 6 and continue with Stage 7.

• Confirmed but unlocked files will import as 100% translated, but not 100% approved. You will
need to review and approve the translation.
Proceed with Stage 9.

NOTE
Typically, Paligo updates the index for topics automatically. But for publications,
you may have to trigger the re-indexing manually. This is usually due to some of
the topics reusing external components, and the external components do not get
re-indexed automatically.

Manual re-indexing is explained as part of the procedure in Import a Translation
Package [1719].

Stage 6: Review the Translation
This stage only applies if the translation service provides a translation that is not 100% approved.

1. Change the state of the imported translation content to In translation review.

2. Review the translation. Depending on your requirements, you can either:

• Use Resource View to check that the translation is complete (see Check if the Translation is
Completed [1722]).

• Use the Translation View [1752] to review the translation text and check that the translation
is complete.
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CAUTION
If you are using a translation service, we strongly recommend that you do
not edit the translation in the Translation View. If you make changes, your
content in Paligo will no longer be in sync with the translation memory in
your translation service's software.

Stage 7: Set the Content to Released
When you are happy that the translations are complete:

1. Set the state of the content to Released.
You cannot make changes to a topic that is Released. This state is intended to show that a
topic is complete, approved, and has been published. To make changes to that topic, you will
need to switch its state to Work in progress again.

NOTE
When you change the state to Released, Paligo automatically approves
completed translations in all available languages.

For example, let's say you have a topic translated to Italian and German.

• The Italian content is 100% translated and 0% approved.

• The German is 87% translated and 23% approved.
When you change the state to Released, Paligo sets the Italian content
to 100% translated and 100% approved and the German content to 87%
translated and 87% approved.

2. Publish the translations.
To learn how to publish content, see Publishing [1068].

Start Working with a Translation Service
At the start of your translation project:

1. Find out if you need to set up Paligo's translation software integrations. These are needed if
your translators are using Phrase or Semantix.
For instructions on how to set up the integrations, see:

• Connect Paligo to Phrase [1712]

• Connect Paligo to Semantix [1714]

NOTE
If your translation service uses Crowdin, the translation process works
differently as it does not require translation packages. For details, see
Translate with Crowdin [1709].

2. Provide your translation service with the Translation Software Settings [1708].

3. Read the Workflow for Translation Service [1703]. That explains the process and has links to
the various other resources you need, including information on how to:

Paligo Documentation

1707



• Send content to a translation service, see Export a Translation Package [1715]

• Receive content that the translation service returns, see Import a Translation
Package [1719].

If you will need to update and publish the content in the source language while waiting
for translations to complete, you will need to branch your content. You can learn about
the process for updating content while waiting for translations in Update Content when
Translation is Not Finished [1727].

Translation Software Settings
Your translation provider is responsible for setting up their Translation Memory System (TMS). But
they may need some guidance on what settings are appropriate for translating Paligo content.

Here, we provide some information about what settings to use and the intended workflow. We
have used an example from the Phrase TMS, but the same approach can be used for others such
as TRADOS, MemoQ, Swordfish and so on.

Example 86. XLIFF import settings

These settings (or similar in another TMS) will work for many use cases. Please note that:

• The XLIFF is segmented according to the TMS rules (usually on sentence level)

• Linebreaks and whitespaces are ignored

• Previously translated and approved translations are imported into the translation memory.
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Example 87. Status flag rules for import and export

To get the most out of the translation, for example, to skip already translated segments, the TMS
should:

• Import approved as state=final

• Export confirmed and locked segments as state=final.

• Have non-locked content set to state=needs-review-translation, unless you do the review
and approval process directly in a TMS. This will allow you to give final approval to the
translation in Paligo.

Translate with Crowdin
Crowdin is a cloud-based translation and localization platform, designed for agile translations,
where content can be updated and translated frequently. It has its own app, available in the
Crowdin store, for integrating with Paligo.

If you are using Crowdin for translations, you need to be aware that it works differently to Paligo's
other translation integrations:
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• There are no Crowdin integration settings in Paligo. You set up the entire integration in Crowdin.

• You can use Crowdin to translate any Paligo topic that is in the "In Translation" state.

• You can manage the synchronization between Crowdin and Paligo. You choose when to "pull"
content into Crowdin and "push" the translations back into Paligo. You do not need to use
import and export translation packages.

When using Crowdin, we recommend that you:

1. Display the Resource view for your content. To do this, find your content in the Content
Manager and then select the folder that contains the content.

NOTE
If your content is not in a folder, select the Documents section at the top of
the Content Manager instead. Documents is the top-level "parent" folder for
any content that is not inside another folder.

2. Use the status button to set the content state to In translation.

3. Set up Crowdin to connect to Paligo. For this, you will need to:

• Create a project in Crowdinand add the target languages

• Create a Crowdin workflow to define and manage the translation processes in your
organization.

• Install the Paligo app (available from the Crowdin store)

• Set the Paligo app to connect to your Paligo instance.
You will need the name of your Paligo instance, an email address with access to your Paligo
instance, and the API key. For details on how to find the API key, see API Keys [1472].

• Set up some form of notification so that when the translation work is complete, you receive
a message.
In Crowdin you can set up notifications at the project level so that you receive an email
when the work is done. Alternatively, you can set up connectors with Slack, MS Teams and
similar apps to get notifications there. It is also possible to set up webhooks for Crowdin
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Enterprise (see webhooks) and set Crowdin to sync automatically with Paligo at regular
intervals.

For information on setting up Crowdin to connect to Paligo, see the official Crowdin
documentation.

4. When you have set up Crowdin to connect to Paligo, access the project. It has two columns:
Crowdin is on the left and shows the content in Crowdin and Paligo is on the right. The Paligo
column shows all content in your Paligo instance.

NOTE
Crowdin can view all topics in Paligo, but only those that are set to In
Translation can be worked on.

5. Use the checkboxes to select the topics and the Sync To buttons to push content from one
system to the other. The Sync to Crowdin button pushes "In Translation" content from
Paligo to Crowdin, so that it can be translated. When the translation work is finished, select
the Sync to Paligo button to push the translated content from Crowdin back to Paligo.
When the content has been translated, you should receive a notification.

6. In Paligo, set the content to the In Translation Review state. Use the Resource View to check
that the translation is complete (100%) . If it is complete, proceed to step 7.
If the translation is complete, you can approve the work. Select the options menu ( ... ) for
the publication or topic, and then select Approve translation. Note that if you approve the
translation of a publication, it automatically approves all of the topics inside that publication.
If the translation is incomplete, put the topic in the In Translation state and notify the
translators that it needs more work. When they translate it again, repeat step 6.

7. When the translations are complete, set the state to Released. You can then publish the
content (see Publishing [1068]).

Translate with Phrase
Paligo can connect directly to Phrase so that you can:

• Export translation packages directly to Phrase from Paligo

• Import completed translations directly from Phrase.
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NOTE
To use Paligo with Phrase, you need to set up the Paligo to Phrase integration.
You can then follow the translation service workflow. To get started, see Work
with a Translation Service [1702].

Connect Paligo to Phrase
Paligo has a Phrase integration that means translation jobs can be sent to and received from
Phrase without the need for translation packages and zip files. The workflow for using Phrase with
Paligo is similar to that used for other translation services.

Once the integration is set up, you can send content for translation directly from Paligo to Phrase,
see Export a Translation Package [1715]. Paligo recommends that you ask your translation service
to contact you when they have completed their work. Phrase is unable to provide Paligo with a
notification.

When the translation is complete, you can import the content directly from Phrase into Paligo, see
Import a Translation Package [1719]. Paligo automatically matches the translation to the content
for the source language. You can then manage the translation and release status for the content in
all languages. For details, see Workflow for Translation Service [1703].

To use the Phrase integration, the Phrase account must:

• Have the role of a Project Manager (PM) or Administrator.

• Have permission to "Modify setup's server settings". This is related to user rights and you can
set it up by editing the user profile in Phrase.

• Be on a plan that provides API access. Paligo requires API access to connect to Phrase.

To set up the integration in Paligo:

1. Make sure you have a project in Phrase. When you export content from Paligo, it will be
exported into the project in Phrase. You will need to get the project id, as you'll need it for the
Paligo settings in the next steps.

Paligo Documentation

1712

https://phrase.com


NOTE
The project id is not the main id name in Phrase, that is just a display name.
To find the project id, open the project in Phrase and look at the address field
in the browser. The last part of the address is the project id and it is a string
of characters, similar to this: jK32Nl001CtTBEwnA0QH8Q.

2. Select your user name in the top-right corner and select Settings.

3. Select the Integrations tab and then select Add or Change on the Phrase box.

4. Enter Username and Password.

5. Select the Default project used for translation export.

6. Select Save.

7. Select Test setting to verify the connection.
You should get a notification that the test was successful, which means that Paligo can
connect to Phrase.
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NOTE
If not, check that the entered credentials are correct, and pay close attention
to typographical mistakes in the entries.

If you still cannot get Paligo to connect to Phrase, contact support for help.

Translate with Semantix
Semantix is a translation provider with a portal for ordering translations. Paligo has an integration
for Semantix which you can use to send your translation projects directly to their portal.

You can export content directly to Semantix for a quote. When you accept the quote (in Semantix),
the translation service will begin work on the translations. When the translations are complete, the
translation service should notify you. You can then import the translations back into Paligo.

NOTE
To use Paligo with Semantix, you need to set up the Paligo to Semantix
integration. You can then follow the translation service workflow. To get started,
see Work with a Translation Service [1702].

Connect Paligo to Semantix
Semantix is a translation provider with a portal for ordering translations. Paligo has an integration
for Semantix which you can use to send your translation projects directly to their portal.

To set up the integration in Paligo:

1. Select your user name in the top-right corner and select Settings.

2. Select the Integrations tab and then select Add or Change on the Semantix box.

3. Enter your Semantix credentials.
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4. Select Save.

5. When you have the integration set up, you can choose to send a translation directly to
Semantix.
For details, see Export a Translation Package [1715].
When the translation is complete, you can import the translation directly into Paligo [1719].
We recommend that you ask your translation service to contact you when they have
completed their work. Semantix is unable to provide Paligo with a notification.

Export a Translation Package
To be able to send content to a translation service, it must be exported as a translation
package. Paligo creates the translation package as part of the export process. This package is
manually sent to the translation service. When the completed translation is returned, it must be
imported to Paligo.

The following is not included the translation package:

• Images must be sent separately to the translation service, see Translate Images [1736].

• Variables must be sent separately to the translation service as a Variable set [1751] . Make
sure that the variables are translatable variables [1749].

NOTE
If your Paligo instance is set up to use a translation integration, Paligo will send
the translation package automatically. You might need to notify the translation
service that you have provided a translation package.

The completed translation is returned in the same way, but Paligo will not notify
when its ready to be imported. Therefore the recommendation is to ask the
translation service to notify you when the translation is completed and ready to
be imported.

1. Select the folder containing the topic or publication to be translated in Content
Manager [34]. 
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If the content is not in a folder, select the top-level folder Documents. 

This will open the Resource View [68].

2. Change the topic or publication status to In translation.

3. Expand the entry for the publication or topic to see the details and then select the
Translations tab.

TIP
Select Show incomplete topics to see a list of topics (in a publication) that
are not fully translated.

4. Select the Dotted Menu (...) for the topic or publication.

5. If needed, select Translation and choose Add languages. 

6. Check the boxes for languages to be added to the topic.

7. Select OK.
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8. Select Translation and choose Export translation. 

9. Select the language or languages in the Translate to field.
You can only select languages that has already been added to the topic.

IMPORTANT
When using Phrase, it is important to choose languages that are available for
the target project.

If you choose unavailable languages, the export will fail and exclude the
unavailable languages from the translation package. The translation package
(with the available languages) will be exported to Phrase and Paligo will
display the following message:

Error sending to Phrase: TargetLangs must match project \
settings.

10. Choose a Document format.

• XLIFF is the most commonly used format for translations.

• A variant XLIFF format that is required by some translation tools.

• PO is a format that is often used to translate web content

• Phrase is for sending content to the integrated translation service.
To use this, the function must be activated, see Connect Paligo to Phrase [1712].

• Semantix is for sending content to the integrated translation service.
To use this, the function must be activated, see Connect Paligo to Semantix [1714].
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11. Choose a Project from the dropdown menu. This feature is optional and is only
available for the Phrase integration.

To add a new project:
Source language and target language is already set according to the template.

a. Select Create a Project.

b. Select a Template from the dropdown menu.
To create new templates, see Project Template TMS in the official Phrase documentation.

c. Name the project.

d. Add a Due date (optional).

e. Select Create.

12. Choose Export Options

• Include a due date
This feature is optional and is only available for the Phrase integration.
Check the box Due date to add a due date for the project (if not already added in the
project). Use the calender to select a date.

• Include approved translations - Recommended
Use this feature to set previously approved translations to have the the state final in
the translation package, meaning that this content is imported into the translation memory
system, but is not re-translated. However the translation service must have the Translation
Software Settings [1708] for this to work.
If this box is cleared the previously approved translations will get state needs
translation. The translation service will regard the content as new and it will be re-
translated.
It is recommended to check the box Include approved translations to avoid unnecessary
translation costs.

• Include fuzzy translations
Use this function to set unapproved translations to have state needs review
translation in the translation package. Unapproved translations are often for content
that has previously been translated and approved, but the source language content has
now changed. The changes mean the translation is no longer approved.
Clear this box to set unapproved translations to have state needs translation in the
translation package. The translation service will regard the content as new and it will be
re-translated.
In most cases, Paligo recommends to clear the box Include fuzzy translations because the
translation software will often segment content differently than Paligo.

13. Select Export.
Paligo produces the translation packages as a zip file that downloads in your browser
(even if a translation integration is used).
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14. Manually send the translation package to the translation service (if not using a translation
integration).

NOTE
In the Semantix portal, the translation project manager will receive a quote
for the translation. Once the quote is accepted the translation service will be
provided.

15. The returned translation package must be imported to Paligo (even if a translation integration
is used), see Import a Translation Package [1719] .

TIP
It is also possible to use the Translation View [79] to export translation files.

1. Select the topic or publication to be translated in Content Manager [34].

2. Select the Dotted Menu (...) for the topic or publication.

3. Select Edit and choose Translate.

This will open the Translation View [79].

4. Select the Cog. 

5. Select Export translation. 

Import a Translation Package
When your translation providers have completed their work, they will return an updated
translation package to you. You will need to upload that package back into Paligo, so that Paligo
can add the translations to the relevant topics. It is possible to upload a zip file containing multiple
files (one file per language pair) or to upload individual files.

To upload, either:

• Display the publication or topic in Resource View [68], select the Dotted menu (...) and then
choose Import Translation.
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• Open the publication or topic in Translation View [79], select the Cog and choose Import
Translation. To find out more, see Working in Translation View [1752].

If you sent images and / or variables to the translation service, these will be returned separately.
They are not included in the translation package:

• To import translated images, see Translate Images [1736].

• To import translated variables, see Import Translated Variable Sets [1752].

NOTE
If you use one of Paligo's translation integrations, such as Phrase, you will need
the translation service to notify you when the translation is complete. You can
then import the translation into Paligo.

1. Select the folder containing the topic or publication to be translated in Content
Manager [34]. 
If the content is not in a folder, select the top-level folder Documents. 

This will open the Resource View [68].

2. Select the Dotted menu (...) for the publication or topic.

3. Select Import Translation. 

4. Select an Import type:

• To manually import a zip file, choose Upload file.

• To import through a translation integration, choose Phrase or Semantix.

NOTE
This is only possible if the translation integration is set up correctly
in Paligo, see Connect Paligo to Phrase [1712] or Connect Paligo to
Semantix [1714].
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5. Select the target language of the content that you are going to import.

IMPORTANT
You can only import the translation if the language is added to the matching
publication and topic. To find out more, see Language Management [1872].

6. Select a single translation file or a zip file with multiple languages to be imported.

7. Use the Ignore current translation status checkbox to control how Paligo reacts to statuses
set by the translation service.

• Check the box to have Paligo ignore the status. The content will keep its current status in
Paligo.

• Clear the box to allow Paligo to update the status based on the status that is set by the
translation service.

8. Select Import.
Paligo will import the translation into the matching publication or topic.

IMPORTANT
If encountering problems during an import of a Phrase project, use the
checkbox Override import project . It will force Paligo to find the missing
Phrase job ID and reconnect it with the Phrase project ID.

9. This final step only applies if you imported a translated publication.

a. Return to Resource View [68].

b. Select the Dotted menu (...) for the publication.

c. Select Translation and choose Re-index translations. 
It instructs Paligo to index the translations again, including any reused content in them.
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NOTE
You might need to refresh the page to see the upload status.

TIP
It is also possible to use the Translation View [79] to import translation files.

1. Select the topic or publication to be translated in Content Manager [34].

2. Select the Dotted Menu (...) for the topic or publication.

3. Select Edit and choose Translate.

This will open the Translation View [79].

4. Select the Cog. 

5. Select Import translation.

Check if the Translation is Completed
When a translation service returns translated content to you, you can review it in Paligo. As
a minimum, you should check that the translation work is complete. If you have multi-lingual
colleagues, you may want to check the quality of the translation too, see Translation View [1752].

CAUTION
If you are using a translation service, we strongly recommend that you do not
edit the translation in the Translation View. If you make changes, your content in
Paligo will no longer be in sync with the translation memory in your translation
service's software.
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If you only want to review that the translation is complete, use the Resource View:

1. Select the folder containing the content in Content Manager [34]. 
If the content is not in a folder, select the top-level folder Documents. 

This will open the Resource View [68].

2. Change the topic or publication status [1210] to In translation review.

3. Expand the publication or topic and select the Translations tab.

1 = Hover over to the much of the translation that is translated and approved. 2 = The bar shows
how complete the translation is.

The tab has a bar for each language and its shading and color shows how complete the
translation is (2). A fully shaded green bar means the content is completely translated. A
partially shaded blue bar means the translation is incomplete, and a clear gray bar means that
there is no translation for the content.
If you hover the cursor over a bar, a popup appears, which shows you the translated and
approved content details as numerical values (1).

4. If the translation is complete, select the Dotted Menu (...) for the publication or topic and
choose Approve.
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NOTE
If you approve the translation of a publication, it automatically approves all of
the topics inside that publication.

You cannot approve content that has incomplete translations. It needs to be
returned to the translation service.

5. If your translation is incomplete for a particular language, we recommend that you change
the status of the content back to In translation and then return it to the translators.
To return the content to a translation service, create a new translation package [1715]
containing the incomplete content. Use the Show Incomplete Topics feature to
find the topics that contain unfinished translations, see Find Topics with Incomplete
Translations [1725]).

When your content is translated and the translations are approved, you can publish it [1068] and
put it in the Released state.

Review and Edit the Translation

1. Display Translation View [79] from the assignment link or via the Assignments Panel [46].

2. Review and edit the translation in the Translation View.

3. Select the Settings and choose Translation is complete or Translation is not complete. 
Alternatively, you can select individual segments and check the box Translation complete.
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NOTE
A translation needs to be marked as final and complete, to avoid a re-
translation if it is included in a translation package again.

The translator's software can only skip past content that has been marked as
final and complete.

4. If the translation was part of an assignment workflow, select Your assignments and choose
The translation is complete.

Find Topics with Incomplete Translations
To show all of the topics in a publication that still need to be translated, use the Show incomplete
topics option in the Resource View:

1. In the Content Manager, select the folder that contains the topic or publication that you want
to translate. When you select the folder, Paligo shows the Resource View.
If your content is not in a folder, select the Documents section at the top of the Content
Manager instead. Documents is the top-level "parent" folder for any content that is not inside
another folder.

2. Expand the publication and select the options menu ( ... ) for for the translation language of
interest. Then select the Show incomplete topics option.
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Paligo displays a list that shows the topics that have incomplete translations in this
publication. The list includes all topics that have no translation or unapproved translations.
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NOTE
Select a topic to display it in the Resource View. From there, you can select
the topic again to open it in the editor.

Update Content when Translation is Not Finished
The recommended translation workflow [1703] is designed for organizations that can wait for
translations to be completed before further updates are made. If you need to make frequent
updates to the source language content, you will need to take a different approach to translation,
with branches for your updates.

Here, we explain how to use branching to manage your updates and keep your translations
aligned with the correct versions of your content.

This diagram shows the typical process for using branches for updates while waiting for
translations. You start by sending your original content for translation, then you create one or
more branches for your updates. You can publish the updates in the source language but do not
merge them into the original version. When the translation of the original comes back, import
it into Paligo. At this stage, the translation is aligned with the version of the content that was
translated (the original version). You can now send the updates for translation, either individually
or by merging with the original version and then re-sending the original version for translation.

The following sections describe each stage of the process.

Stage 1: Discuss the Project with your Translation Service
When you discuss your translation project with the translation service, find out:

• How the proofreading is going to be done.
This work is often completed in the translation tool by a subject matter expert (SME) who
understands the source language and the target language.
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• Whether the files provided by the translators are going to be set as "confirmed and locked" in
the translation software. This will affect the state of the files when you import them into Paligo.

The translation service may ask for details about the settings they need for their software. For
these, see Translation Software Settings [1708].

If the translators are using Phrase or Semantix, use Paligo's integration settings to set up the
connection. For details, see:

• Connect Paligo to Phrase [1712]

• Connect Paligo to Semantix [1714].

Stage 2: Add the Languages to your Paligo Instance, Publication, and Topics
Before your content can be translated, you need to set up the translation languages in your Paligo
instance. You also need to add the languages to the topics and publications you want to translate.

For details on how to add the languages, see:

• Activate Languages [1873]

• Create Additional Languages [1874]

• Add a Language to a Publication or Topic [1877].

Stage 3: Prepare your Content for Translation
To prepare your content for translation:

1. Create your publication and topics in the source language. When you are editing the content,
the topics should be in the Work in progress state.
To learn how to change the state of the content, see Change the Status of a Publication or
Topic [1210].

2. Get your content reviewed so that you can be confident that it is accurate and as complete as
it should be. For reviews, the topics should be in the In Review state.
To send the content for review, it is a good idea to use review assignments, as these are
tracked by Paligo. For details, see Author Instructions for Review Assignments [1272].

3. When the review is complete and the content is approved, put the content into the In
Translation state.

NOTE
If your content contains images, variables, or filters that need to be translated,
you will need to send these to the translators. These files are not included in a
translation package. To learn how to prepare these parts for translation, see:

• Translate Images [1736]

• Translate Variables [1749]

• Translate Filters [1749].

Stage 4: Send your Content to the Translators
When your content is ready for translation, you can send it to your translators. The process for this
varies depending on what software your translators use.

You will need to either:
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• Export the content as a translation package and send it to the translators.
Create and send a translation package if the translators use software that does not have an
integration with Paligo. The translation package is an export file that you can email to your
translators.
To learn how to export a translation package, see Export a Translation Package [1715].

• Export the content directly to the translation software.
For more details on setting up Paligo to work with these, see Connect Paligo to Phrase [1712]
and Connect Paligo to Semantix [1714].

NOTE
Some translation software, such as Crowdin, have a different type of integration.
They detect when your topics change to the In Translation state and the content
becomes available to translators at that point.

NOTE
If your content has images that need to be translated [1736], you will need to
export the images and send them to the translators separately. Images are not
included in translation packages.

Similarly, if you use variables, they need to be translatable variables [1749] and
you can send the variable set to your translators separately. Variable sets are not
included in translation packages.

At this point, you should be:

• Waiting for the translators to return the translation for the original version

• Ready to make updates to your documentation in the source language.

Stage 5: Create a Branch of the Original Version
When you have sent content for translation, it is important that you do not make any further
changes to the source language version. If you do, then the translation will not align with the
source language, as the translation will not include the changes you have made.

To make updates to the source language content, you will need to create a branch. A branch is a
separate version of the content, with different IDs so that you can make changes without affecting
the original version.

NOTE
If the original version had reused elements in it, these will also be reused in the
branch and so will keep their existing IDs. If you change these, your changes will
apply to those elements in the original branch too (and anywhere else they are
used).
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Depending on what you need to change and how you want to manage your content, you can
create a branch of:

• A publication
You will get a new branch version of the publication but it is set to still reference the same topics
that were used in the original publication. To make an update to a topic, you should branch the
topic first, and then make the updates in the branched version.

• Individual topics
When you branch a topic, you get a new version of the topic and its elements get new IDs. As
they have new IDs, you can change their content without affecting the content in the original
version of the topic.
There are two ways to branch a topic:

• From the fork of a publication.
This creates a branch of the topic in a publication. The publication is automatically set to use
the branch topic instead of the original version.

• From a topic in the Content Manager.
This creates a branch of the topic, but it only exists in the Content Manager. To use it in a
publication, you will need to add it to the publication's structure.

To learn how to make branches of your content, see Create Branches [1649].

Stage 6: Update and Publish the Branched Topics
Make your updates in the branched version of the topics. The changes you make will only affect
the branched version (unless you make changes to reused content).

Make your changes in the branch topic. Do not make changes to the original version if its translation is
not complete.

CAUTION
Do not make changes to the original version if its translation is not complete.

If you change the original version while waiting for its translation, the translation
and source language content will not align. This will make it difficult to manage
the versions and translations in future.

When you have made the changes, you can publish the branches in the source language.

To publish a branch, select the options menu ( ... ) for the branch and then select Publish. Use
the Publish document dialog to choose the publishing settings, such as the output type and the
language.
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How you present the updated topics to your customers is up to you. You could:

• Publish a branched version of your publication, provided as a separate HTML help or PDF

• Publish the branched version and use that to replace the existing version.

To learn about publishing, see Publishing Process [1068].

Stage 7: Create More Branches for Further Updates
If you need to make further updates and are still waiting for the original translation work to be
completed, create more branches. Depending on how you want to manage your branches, you
can:

• Create another branch of the original topic.
This approach is useful if you want to have multiple branches that will be used for different
variations of the content. This is sometimes called non-sequential branching.

With the non-sequential branching shown here:

• Branch "Update A" contains the content from the original branch + update A. It does not
contain the content that was added to "Update B".

• Branch "Update B" contains the content from the original branch + update B. It does not
contain the content that was added to "Update A".

• Create a branch of an existing branch of the original topic.
This approach is better suited to sequential updates, where each update should also include the
content from the previous update.
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With the sequential branching shown here:

• Branch "Update 1" includes the original content + update 1 content

• Branch "Update 2" includes all of the content in update 1 + update 2 content

• Branch "Update 3" includes all of the content in update 2 + update 3 content.

When you have created more branches, you can edit them and publish them in the source
language as needed.

CAUTION
Do not merge the branches with the original version until the translation for the
original version is complete and imported. If you do, it will cause the translation
and content to be misaligned.

CAUTION
We recommend that you do not send a branch for translation until the original
version is translated and imported.

If you send out branches for translations and the original version is still not
translated, it could result in duplicate translation work and extra, unnecessary
costs.

It is easier to manage your content and translations if you only send one version
for translation at a time.

At this stage, you should be:

• Waiting for the original version to be translated

• Ready to send the branches for translation.

Stage 8: Import the Translation of the Original Version
When the translators have completed their work on the original version of the content, import the
translation into Paligo (see Import a Translation Package [1719]).

• Confirmed and locked files will import as 100% translated and 100% approved. The
proofreading is done, so you only have to change the state to Released in Paligo.
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Ignore Stage 9 and continue with Stage 10.

• Confirmed but unlocked files will import as 100% translated, but not 100% approved. You will
need to review and approve the translation.
Proceed with Stage 9.

Stage 9: Review the Translation
This stage only applies if the translation service provides a translation that is not 100% approved.

1. Change the state of the imported translation content to In translation review.

2. Review the translation. Depending on your requirements, you can either:

• Use Resource View to check that the translation is complete (see Check if the Translation is
Completed [1722]).

• Use the Translation View [1752] to review the translation text and check that the translation
is complete.

CAUTION
If you are using a translation service, we strongly recommend that you do
not edit the translation in the Translation View. If you make changes, your
content in Paligo will no longer be in sync with the translation memory in
your translation service's software.

Stage 10: Publish the Translations for the Original Version
When you have reviewed the translations for the original version, you can:

1. Set the state of the content to Released.
You cannot make changes to a topic that is Released. This state is intended to show that a
topic is complete, approved, and has been published. To make changes to that topic, you will
need to switch its state to Work in progress again.

NOTE
When you change the state to Released, Paligo automatically approves
completed translations in all available languages.

For example, let's say you have a topic translated to Italian and German.

• The Italian content is 100% translated and 0% approved.

• The German is 87% translated and 23% approved.
When you change the state to Released, Paligo sets the Italian content
to 100% translated and 100% approved and the German content to 87%
translated and 87% approved.

2. Publish the translations.
To learn how to publish content, see Publishing [1068].

At this stage, you should have:

• The original version of your content published in the source language and the translated
languages.
The translations will match the original version of the content.
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• Your updates in the branches, written in the source language and waiting for translation.

Stage 11: Merging and Translating the Updates
You now need to get the updates translated so put the updated topics into the In Translation
state. Depending on how you want to manage your content, there are several ways to approach
the translation.

You could:

• Continue to manage the original branch and each update branch separately. In this case, you
should send the first update branch for translation. We recommend that you wait until the
translation is completed and imported before you send the second branch for translation.

• Merge your update branches so that you have the original version and one update branch. You
can then send the update branch for translation.

• Merge your update branches into the original version. You can then send the original version for
translation again, and this time the translators will only need to translate the updated content.

CAUTION
Do not merge the branches with the original version until the translation for the
original version is complete and imported. If you do, it will cause the translation
and content to be misaligned.

To learn how to merge branches, see Merge Branches [1658].

When the translations are ready, you can import them into Paligo and review them. When you
import, Paligo matches the translation to the appropriate version. For example, if you sent an
update branch for translation, Paligo will match the translation to the IDs of the topics in the
update branch.

Stage 12: Publish the Updates
When you have imported and reviewed the translations for your updates, they are ready to
publish. Put the content into the Released state and publish it.

Depending on how you manage and present your content, this could mean:

• Publish the main branch (original + updates merged into one) in the translated languages

• Publish the individual branches in the translated languages.

Make your published content available to your audience, either as an update to the existing
content or as a new version of the content that is hosted separately to the original version.

To learn about the publishing process, see Publishing Process [1068].

Prepare Content for Translation
Whether you are working with a translation service [1702] or are going to translate your content
internally [1685], you will need to prepare your content before you send it to the translators.
Ideally, you should prepare for translation at the start of your project, so that you can consider
using translatable variables from the start. But they can be set up and applied retrospectively if
needed.

Paligo Documentation

1734



TIP
If you have content that you want exclude from the translation, see Exclude
Content from Translation [1735].

The preparation steps are:

1. Activate Languages [1873] - This makes the languages available to use.
You may also need to add any missing languages or dialects to Paligo, see Create Additional
Languages [1874].

2. Add the languages to your publications and topics, see Add a Language to a Publication or
Topic [1877].

3. Upload image variants for different languages, see Translate Images [1736]. (Optional)

4. Set up translatable variables, see Translate Variables [1749]. (Optional)

5. Consider if you need to provide your translators with information about Translate
Filters [1749]. (Optional)

NOTE
Steps 3 to 5 inclusive are optional. You only need to complete these steps if your
content contains images that need different images in other languages, variables
and filters, respectively.

Exclude Content from Translation
If you have content that you do not want to be translated, you can set it to be translation disabled.

1. Open the topic that contains the content that you do not want to be translated.

2. Select the element that contains the content and in the Element Structure Menu, select the
para element for the content.

3. Select Disable element translation.
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NOTE
The element is highlighted in yellow and is locked to prevent it from being
translated. In the underlying XML, it is given the xinfo:translate="no"
attribute and value.

Translate Images
If you translate your content, you may need different language versions of your images. For
example, you might have a screenshot of a user interface that needs to be different, depending
on whether it is in the English, French, or German version of your documentation. To do this in
Paligo, all you have to do is give the images a language suffix in their filename and then upload
them. Wherever the source image is used, Paligo will swap it out automatically for the appropriate
translated version when you publish.

1. Send the image files to your translators - This has to be done outside of Paligo, using
whatever approach works best for your organization, for example sharing folders in the cloud,
sending the images as zip files.

2. When the translators return the image files import them into Paligo. For the the importing,
you can either:
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• Import each image individually as a variant of the original image. You can do this in
the image properties settings in Paligo, see Add a Language Variant Image for a Single
Image [1737]

• Bulk import many files at once. Paligo will give the files a language code as part of the
filename and will automatically use them in place of the original images in translations, see
Batch Import of Language Variant Images [1739].

When you have language variant images set up for your content, you may later find that you need
to:

• Update a Language Variant Image [1745]

• Delete a Language Variant Image [1747]

Add a Language Variant Image for a Single Image
If you need to have small number of language variant images in your content, you can add the
language variants individually.

For example, you could have user guides in English, Swedish, and German, but most of the images
are suitable for all three. But in one topic, there is an image of the interface, and that contains text
that has to be shown in the appropriate language. For this, you could edit the topic and upload the
Swedish and German variants of the image into the topic.

NOTE
If you have many images that need to have language variants, then it will
be quicker to bulk upload them, see Batch Import of Language Variant
Images [1739]..

1. Either:

• Find the image in the Media library, select its options menu ( ... ) and then select Edit Image.

• Right-click on the image in a topic and then select Edit Properties.
Paligo displays the Image details.
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2. In the Language variant field, select the language for the variant image you are going to add.
For example, if your original image is the English language version and you are going to add a
French image variant, select French.
When you choose a language, Paligo displays a preview of the image that is currently used as
the language variant. If there is no image, a red question mark is shown.
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3. If the language variant of the image is already in your media library, select Replace with
Existing, then browse to the image and select it.
If you are going to upload the language variant image, select Upload Image and then use the
dialog to upload the image file.
The image that you select or upload should have the same filename as the source language
image, but with a suffix. The suffix has to be a hyphen followed by the HTML language
code. For example, if battery.jpg is the source language image file, use battery-fr.jpg as
the French variant of the image. For information on the HTML language codes, see https://
www.w3schools.com/tags/ref_language_codes.asp.

NOTE
Do not change the Description for each language. The description is the alt
text for the image in its source language. If you need to have translatable
versions of the description, add the alt text as an alt element, see Alt Text for
Images [341].

4. Repeat this process for each language variant that you want to add.
Paligo provides a thumbnail of each image. Select a thumbnail to view it at a larger size.

Once you have multiple language variants Paligo will automatically select the right language
variant when you publish to different languages.

Batch Import of Language Variant Images
If you need to add lots of variant images for outputs in different languages, it's better to do a batch
import (also known as a bulk import). With this approach, you can upload the images all at once,
rather than having to go through the time-consuming process of adding each one individually.

For the bulk import, it is important that:
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• The original source language images are already in your media library

• The files you upload have the same name as the original source images, but with a language
suffix.

The language suffix is a hyphen with the two-character code for the language. For example,
if you have a source language image file called "payment_details.png" then the variants for
Swedish, French, and German would be "payment_details-sv.png", "payment_details-fr.png", and
"payment_details-de.png" respectively. For information on the HTML language codes, see https://
www.w3schools.com/tags/ref_language_codes.asp.

NOTE
Do not upload the source language images and the language variant images at
the same time. The source language images must be in the media library before
you upload the language variants.

If you do upload the source language image and the language variants all at the
same time, Paligo will recognize the variant images as separate images. They will
not be language variants of the source image.

1. Upload your default language images, if they are not already uploaded (see Upload Images to
the Media Library [329]). These are the "source language" images.

2. Make sure the language variant images have the hyphen and language code as a filename
suffix.
For a list of the correct language suffixes see: ISO 639-1 Language Codes (use the ones in the
first code column).

3. In the Media section of the Content Manager, either:

• Select the options menu ( ... ) for the folder that contains the source language version of the
images, then select Upload Images

• Select the options menu ( ... ) for the Media folder and then select Upload Images.
Paligo displays the Upload Images dialog.
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TIP
If you have selected the wrong media folder, you can change the folder by
selecting the blue folder name next to "in folder" at the top of the Upload
Images dialog.

4. Drag and drop the language variant images files into the box in the top section. Alternatively,
select Add Files and add the language variant files there.
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Paligo detects that the files you are about to upload have the hyphen and language suffix and
so are language variants. This can only happen if the new files have the same name as the
source language versions, but with the hyphen and language suffix.
The Upload images dialog shows each variant image file that you are uploading, and below
that, there is a checkbox with the name of the matching source language image.

NOTE
If Paligo detects that the source language image already has language
variants, you get the option to Update each variant.

5. To upload an image as a language variants of an existing image, check the box for the source
language image.
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If you leave the checkboxes clear, the files will upload as regular images and will not be
language variant images. This is for situations where you may have used a hyphen and
language suffix for other purposes, such as a product code. In that case, the suffix is nothing
to do with a language variant, it is just a coincidence, and you want the files to keep their
names and be regular images, not language variants.

6. Use the Update existing in any folder box to tell Paligo to replace images only in the selected
folder or in all folders. to replace images that are in the Media folder and also any of the
subfolders in the Media section.

• Check the Update existing in any folder box to replace matching images in all folders in
the Media section.

• Clear the Update existing in any folder box to replace matching images only in the folder
you selected in step 3.

NOTE
If you selected the Media folder in step 3, Paligo will only replace matching
images that are directly in the Media folder and will ignore images in any
folders inside the Media section.

7. Select Upload.
Paligo will upload the images and set them as variants of the source image automatically.

Paligo Documentation

1743



NOTE
The media library does not show language variant images, and this is by
design to avoid confusion.

If you can see images with language suffixes in your media library, these
images have been uploaded but are not set to be variants. This can happen
if you upload image files with language suffixes, but there is no source image
with a matching name. For example, if you upload "battery-sv.jpg" and there
is no "battery.jpg" file in the media library, then "battery-sv.jpg" cannot be
matched to a source language image. Instead, it is treated as a regular source
language image.

We recommend that you remove or rename any source language images that
have a language suffix.

8. Check that the variants are in place. To do this, select the options menu ( ... ) for the source
language image in the media library, and then select Edit Image. On the Image Details dialog,
select the preview all variants link. The Image Details dialog should show a preview of the
source language image and every language variant image.
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Update a Language Variant Image
Over time, you may need to update your variant language images, for example, if a user interface
has changed. To update one or more variant images:

1. Either:

• Find the source language image in the Media library, select its options menu ( ... ) and then
select Edit Image.

• Right-click on the source language image in a topic and then select Edit Properties.
Paligo displays the Image details.
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2. Select the Preview all variants link to view all of the variant images.

3. Select the cog icon in the top corner of the language variant image that you want to update.
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4. Select Replace variant.

5. Use the Upload image dialog to upload the image variant file that will replace the current
image variant. The image that you select must have the same file name as the existing variant,
including the same language suffix.
Paligo replaces the existing image variant file with the new image variant file that you
uploaded.

Delete a Language Variant Image
To remove a language variant image:

1. Either:

• Find the source language image in the Media library, select its options menu ( ... ) and then
select Edit Image.

• Right-click on the source language image in a topic and then select Edit Properties.
Paligo displays the Image details.
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2. Select the Preview all variants link to view all of the variant images.

3. Select the cog icon in the top corner of the language variant image that you want to delete.
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4. Select Remove variant.

5. Select Confirm to delete the language variant image.

Translate Filters
Paligo's translation packages include any filtered content (profiling), so that it can be translated
too. If your translators are unfamiliar with the concept of filtered content, it may confuse them. So
if you use filters, we recommend that you let your translators know, and explain the concept to
them.

For example, let's say you have three versions of a paragraph in a topic, and two of those will be
excluded depending on the filters. When the translator receives that topic, it will contain all three
paragraphs, which could look strange, especially if the paragraphs are very similar. So it's a good
idea to explain that this is intentional and that they should translate them all.

To learn more about filtering, see Filtering / Profiling [1141].

Translate Variables
If you want to use variables in your content and you need them to be translated, use text
(translatable) variables. These are the only type of variable that can be exported for translation.
For example, let's say you translate your content and you use variables to swap out the term
"administrator" for "operator" in different user guides. As you are having the content translated,
you will need to use text (translatable) variables for "administrator" and "operator".

TIP
Don't worry if you have already used regular text variables, as you can convert
them into text (translatable) variables (see Convert Variables [1193]).

Create Text (Translatable) Variables
To create translatable text variables that you can insert into your topics:

1. In the Content Manager, find Variable Sets and select its options menu (... ).

2. Select Create variable set.
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3. Give your new variable set a name.

4. Expand the Variable Sets and find your new variable set. Select it to open it in the variable set
editor.

5. Select Add variable.

6. Enter a name for the variable, select Text (translatable) as the variable type, and then select
the checkmark in the bottom corner to confirm.

7. Use the Add variant button to create the variant columns for your content. Each variant
column represents a different collection of values. For example, you might have separate
variant columns for each product, "Acme 100 User Guide", "Acme 200 User Guide", "Acme 300
User Guide" and so on.

8. Repeat steps 5 and 6 to add all of the different translatable variants that you need.
You now have a row for each variable and a column for each variant. For each row, you will
need to enter the values that should be used in each variant (see next step).

9. Select a cell to display the Translatable text dialog. It shows the languages that are already in
place. By default, this is just the source language.

10. Use the Add language field to add the languages you need for translation.
You can add any language that is available in your Paligo instance. To add more languages,
see Language Management [1872].

11. Enter the value for the variable in the source language and then leave the other language
boxes empty. Your translation service will add the translations when you send the variable
set to them. If you are doing the translations internal, your own translators can add the
translation in these language boxes. Select OK when you are finished.

Add Translatable Text Variables to your Content
When you have created translatable text variables, you can add them to your topics.

NOTE
If you are translating your content internally, your translators can add the
translations directly in the variable set too.

Paligo Documentation

1750



1. Create a new topic [131] or edit an existing one by selecting it in the Content Manager [34].

2. In the content, select the position where you want to insert the translatable variable.

3. Select Insert > Variable.

4. Select the variable set that contains your translatable variables.

5. Select the specific translatable variable you want to use and then select OK to confirm.

NOTE
When you publish your content, you will choose which values will be inserted into
the variables. To find out more, see Choose Variable Sets for Publishing [1201].

With the translatable variables added to your content, the next step is to get your content
reviewed and approved (see Author Instructions for Review Assignments [1272]).

When the content has been approved in the source language, it can be sent for translation (see
Export a Translation Package [1715]). The translation package does not include the translatable
variables, so you need to send those separately (see Export a Variable Set for Translation [1751].

Export a Variable Set for Translation
When your content is ready for translation, you can send the translation package to the
translation service. The package does not include translatable variables, so you need to send those
separately.

NOTE
Only translatable variables can be translated. If you have other types of variables,
you will need to convert them into translatable text variables if you want to
have them in different languages. To learn how to convert them, see Convert
Variables [1193].

To export a variable set:

1. In the Content Manager, expand Variable sets and select the variable set that contains your
translatable variables.
Paligo opens the variable set in the variable set editor.

2. Export translation

Paligo downloads a zip file in your browser. Send this zip file to your translation service

When the translation service have finished translating the variable set, they will return it to you.
When you receive it, import it back into Paligo [1752]. Paligo will then add the translations to your
Paligo content.
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Import Translated Variable Sets
When your translation service complete their work on your variable set, they will return a files for
each language. You will need to zip each language file individually, and then import each one into
Paligo.

1. Use your computer's operating system to create a zip file for each different language returned
by the translation agency. For example, if you have Swedish, Italian, and Danish, you need to
create one zip file for Swedish, another zip file for Italian, and another zip file for Danish.
If you are unsure how to do this, you can find lots of instructions online, for example:
https://support.microsoft.com/en-us/windows/zip-and-unzip-files
https://support.apple.com/en-gb/guide/mac-help/mchlp2528/mac

2. In Paligo, expand Variable sets in the Content Manager, and then select your translatable
variable set. Paligo opens it in the variable set editor.

3. Select the cog icon in the top corner of the variable set editor, and then select Import
translation.

4. Choose a translation zip file and select Upload.
Paligo adds the translations to the appropriate language and content in the variable set.

5. Repeat steps 3 and 4 until you have uploaded all of the translation zip files.

Working in Translation View
Paligo's Translation View is a built-in editor designed for use when you are not using an
external translation service and are doing the translations internally instead. The people in your
organization who will do the translation work can use the Translation View to add translations,
make comments, compare the translations and more.
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NOTE
We recommend that you use a professional translation service for handling the
translation of your content. If you use a translation service, you may decide to
not use the Translation View at all, as you can accept the translations from the
Resource View instead, see Check if the Translation is Completed [1722].

If you are going to use Paligo's translation editor to add translations, see
Translator Instructions for Translation Assignments [1694].

Display the Translation View
You can use the Translation View to add a translation or review an existing translation.

As an assignee, you will receive an email invite to review, translate or contribute to the
documentation. This is because a Paligo author has allocated an assignment to you or Share
Content (without assignments) [1347].

NOTE
If the content uses filters and / or variables, the author should have created a
favorite profile and provided you with information about which profile to use, see
Choose the Profile Settings [1286] and Favorite Profiles [1263].

The Assignment Types [1212] and User Types [1834] decides which view that will be opened.
Learn about the available assignment features, see Review View Features [1280], Edit View
Features [1307] and Translation View [1752]. There are two ways to reach the assignments:

• Select the link in the email to display the content in the Review View [41], Edit View [42] or
Translation View [1752].

• Log in to Paligo and select the assignment from the Assignments Panel [46], on the right side of
the Dashboard, to open the assignment.

As an Author, Admin or Translation manager, you have other ways to open assignments:
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• Select the Dotted menu ( ... ) for a topic or publication in the Content Manager [34]. Select Edit
and Translate. 

• Select the folder that contains the topic or publication you want to view in the Content
Manager [34]. This displays the Resource view. Select the Dotted Menu ( ... ) for the topic or
publication and then choose Edit and Translate.

NOTE
Alternatively, you can select a language icon in the Languages column.

Change an Assignment State in Translation View
When you are working on a translation or translation review, you will need to change its state.

For translations, you can:

• Reject the invitation to work on the assignment (Declined for translation assignments only)

• Confirm that you have completed the work and the assignment is completed (Done).

For translation reviews, set the state to:

• Approved to approve all of the translations in the assignment in one action

• Needs work to let other users know that the translation is not suitable for publishing and needs
more translation work.

To change the state of the assignment, select the clipboard icon and then select the appropriate
option. Note that Reset status removes any existing state from the assignment.
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Clipboard icon and state options for a translation assignment.

To find out more, see:

Translator Instructions for Translation Assignments [1694]

Reviewer Instructions for Translation Review Assignments [1701].

Set the Translation State in Translation View
When you finish your review of translated content, you should change its state so that it is
approved or not approved. You can do this from the Translation View, which is usually the most
convenient option when working on Translation Review assignments. But it is possible to approve
a translation from the Resource View too (see Check if the Translation is Completed [1722].).

CAUTION
If you are using a translation service, we strongly recommend that you do not
edit the translation in the Translation View. If you make changes, your content in
Paligo will no longer be in sync with the translation memory in your translation
service's software.

1. Display the Translation View [1753].
There are several ways to display the Translation View, as described in the "Display the
Translation View" article. For example, you can select the options menu ( ... ) for a topic or
publication in the Content Manager, and then select Edit > Translate.

2. In Translation View, review the translations and see if they are complete and satisfactory.

3. Select the cog icon next to your profile image to display a menu.
If the translation is good and ready to publish, select Translation is Complete.
If the translation needs more work, select Translation is Not Complete.
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NOTE
The Translation is Complete option has the same effect as selecting
Approve Translation on the Resource View (see Check if the Translation is
Completed [1722]).

If the translation needs more work, return it to the translators.

• To send content back to a translation service, create a new translation package and send it
to them (see Export a Translation Package [1715]). This also applies if your organization has
translators who are using professional translation software.

• To send the content back to translators who are using Paligo to translate, reject the content and
then reassign the translation work (see Reassign an Assignment [1260]).

Change Languages in Translation View
The Translation View displays your content in two languages at once. By default, it shows the
source language and a translation, and you can choose which languages you want to view.

1. Display the Translation View [1753] of your content.

2. Use the language selectors to choose the language. You can choose any language that has
been added to your content.

You can then review and edit the content in the languages you have selected.

To learn about the various Translation View features, see Working in Translation View [1752].

Select the Profile Settings for a Translation
If your content uses profiling (filtering) and/or variables, you may want to change the profile
settings in the Translation View. For example, let's say your content uses a variable for a product
description, where different descriptions are shown, depending on which filter is used. To change
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the filters so that a different product filter is shown, use the cog menu in the top corner of the
Translation View. It has a Profile settings option for changing the filters.

NOTE
if you are working on a translation or translation review assignment, the creator
of the assignment may have already chosen specific profile settings. Check with
the assignment creator before you change the profile settings, as the change
could show or hide content that is irrelevant to your task.

1. Display the Translation View [1753].
There are several ways to display the Translation View, as described in the "Display the
Translation View" article. For example, you can select the options menu ( ... ) for a topic or
publication in the Content Manager, and then select Edit > Translate.

2. Select the cog icon to display a menu, and then select Profile settings to display the profile
settings dialog.

3. Use the profile settings dialog to choose which filters and variables you want to apply to the
content.

• On the Favorites tab, you can select any of the previously saved profile settings that have
been made for this content. Alternatively, you can use the other tabs to put some settings in
place, and then use the Favorites tab to save the settings as a New favorite.
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• On the Variables tab, choose the variable values that you want Paligo to show. You can only
choose options for variables that are actually used in the content. This dialog works in a
similar way to the Variables dialog used when publishing - there is a field for each variable
type in a variable set, and the values in those fields are variants from the variable set.

If you are unfamiliar with variables, see the following sections:

• Variables [1186]

• Translate Variables [1749].

• On the Profiling tab, choose which profiles values (filter values) to apply to your content.
There is a field for each type of filter, and you can choose which value to use for each field.
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If you are unfamiliar with profiling, see Filtering / Profiling [1141].

• On the Options tab, check the Hide Unmatched Elements box if you want Paligo to
completely hide any content that does not match the filtering you have applied in these
profile settings. Alternatively, uncheck the box to use placeholders where there is hidden
content. These make it clearer that some content has been intentionally hidden.

Remember that if you want to store these settings so that they can be applied with a single
selection next time, add them as a new favorite on the Favorites tab.

4. Select Apply.

To learn about the other features of the Translation View, see Working in Translation View [1752].
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View the History of a Translated Text Fragment
If you need to find out what changes have previously been made to a translated paragraph,
use the Translation View's Show Text History feature. Available for each paragraph, Show Text
History displays a record of the changes to that paragraph.

To display the Show Text History dialog:

1. Display the Translation View [1753].
There are several ways to display the Translation View, as described in the "Display the
Translation View" article. For example, you can select the options menu ( ... ) for a topic or
publication in the Content Manager, and then select Edit > Translate.

2. Position the cursor over the paragraph of interest. A pop-up toolbar appears.

3. Select the Show Text History option (the clock icon).

Paligo displays the history for the text.
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The table presents the history information. There is one row for each saved version of the
paragraph, and the details for each version are shown in these columns:

• Compare
Use to compare one saved version to another. When you compare, the paragraph is
displayed with both versions combined. Where there are differences, both versions are
displayed, one on the left, one on the right. In the Compare column, there are one or two
circles. The circle you select defines whether that version's changes are shown on the left
side in the comparison or the right side in the comparison.
For example, in the screenshot above, the first entry in the table has its right circle selected
and the final entry has its left circle selected. If you then selected the Compare button,
Paligo would show this:

The comparison shows one difference between the two selected versions. The word
"Internet" has been changed, and both versions are included in the comparison. The
"internet" on the right is from the first entry in the list, as it has its Compare circle is on the
right, and the "Internet" on the left is from the last entry in the list, which has its left circle
selected. The green highlight shows that the text was added and the red highlight shows
that that text was removed.

• Type
The kind of change that was made, for example, if the text was altered, the type is Update.

• Date
The date on which the changes were saved.

• Preview
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A preview of what the paragraph looked like after the changes were made.

• User
The user name of the person who made the changes.

• Changes
Shows the amount of changes made in a particular version, expressed as a percentage of
the total amount of content.

The final column allows you to delete some of the entries if you wish. Select the X to remove
an entry.
At the bottom of the History dialog, there is a language selector. You can choose to view the
history for the paragraph in any of its available languages. Or select the X at the end of the
currently selected language to view all languages.

To learn about the other features of the Translation View, see Working in Translation View [1752].

Compare Translations
The Translation View [1752] has two features for comparing translations:

• A comparison tool in the Show Text History dialog, that lets you compare different stored
versions of a translated paragraph.
For example, if a translated paragraph has been changed five times, you can compare the latest
version to the third version. To find out more about this comparison feature, see View the
History of a Translated Text Fragment [1760].

• A comparison tool that shows you all of the translations for the current version of the
paragraph.
With this feature, you can see the latest translations for the selected paragraph, in all available
languages.

To use the comparison tool that shows all translations of the current version of a paragraph:

1. Display the Translation View [1753].
There are several ways to display the Translation View, as described in the "Display the
Translation View" article. For example, you can select the options menu ( ... ) for a topic or
publication in the Content Manager, and then select Edit > Translate.

2. Position the cursor over the paragraph of interest. A pop-up toolbar appears.
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3. Select the Compare Translations option (Flag icon) to display a table. Each row in the table
represents a translation language and contains the latest translation of the paragraph.

To learn about the other features of the Translation View, see Working in Translation View [1752].

Comment on a Translation
If you are using the Translation View to review a translation, you can add comments to each
paragraph. The comments can be viewed in Paligo's main editor, in review mode, and in the
contributor. The translators in your organization can use the comments as feedback and make
changes to the translations if needed.

1. Display the Translation View [1753].
There are several ways to display the Translation View, as described in the "Display the
Translation View" article. For example, you can select the options menu ( ... ) for a topic or
publication in the Content Manager, and then select Edit > Translate.

2. Position the cursor over the paragraph of interest. A pop-up toolbar appears.

3. Select the comment icon (two speech bubbles) to display the comment dialog.
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4. Enter your comment in the box.

5. Select Save.

To learn about the other features of the Translation View, see Working in Translation View [1752].

Auto-Translate Content
Auto-translation provides a convenient and fast way to get a basic translation of topics,
publications or text fragments. The translation is provided by Google Translate.

ALWAYS MANUALLY EDIT AUTOMATIC TRANSLATIONS
Please note that the automatic / machine translation feature is for assistance with
translation, and you should never rely on the quality of machine translated text. It
can be used to speed up translation, but will almost always need to be edited to
get good end results.

Auto-Translate Publication or Topic
To auto-translate an entire publication or topic:

1. Display the Translation View [1753] for the publication or topic.

2. At the top of the translation panel (the panel on the right), select the language for the
translation.
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3. Select the cog icon to display a menu and then select Auto translation.

Paligo displays an Auto translation dialog.

4. Use the Include previously auto translated checkbox to choose whether the service will
re-translate content that has already been auto-translated. Check the box to re-translate, clear
it to ignore the existing translations.
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NOTE
If you clear the box, the translation will not re-translate any content that has
been auto-translated before. This also applies to text that has changed since
it was previously auto-translated.

5. Select Continue to auto-translate the content.

Auto-Translate a Text Fragment
To auto-translate a text fragment (paragraph):

1. Display the Translation View [1753] for the publication or topic.

2. At the top of the translation panel (the panel on the right), select the language for the
translation.

3. On the translation side (right side), select the text fragment you want to auto-translate.
When you select the text fragment, the matching fragment is highlighted on the original
language side (left side). Also, a translation dialog appears.

4. Select Copy source text to add the text, in the source language, to the translation dialog. This
also copies over the underlying XML, so will still work for content that has inline elements.
Then select the Auto-translate icon in the toolbar.
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Paligo gets the machine translation from Google Translate and gives you a preview.

5. Select Accept to use the auto-translation (or Cancel if you do not want to use it).
If you accept, Paligo shows the translation in the translation dialog.

6. Select Save.

7. Repeat this process for any other text fragments that you want to auto-translate.
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Import or Export Content

Paligo lets you import existing content in a number of formats, including: HTML, DocBook, DITA,
Microsoft Word, Paligo Export Format (XML), Atlassian Confluence, MadCap Flare, Zendesk Guide (help
center) and more. Some can be imported directly, but in other cases, you will need to first convert
the content into a different format and then import that.

There are always some limitations regarding what can be imported from one format to another
and some import formats will work better than others. In general, the more structured the legacy
format, the more complete the import will be.

When an import is too big, Paligo recommends to divide the import in smaller packages. Variable
sets that have been included in previous imports, will get duplicated, unless a variable set ID is
entered in "Match with existing variable set", see Use the Import Wizard [1771] and Find a Variable
Set ID [1777].

However, you can only match one variable set, so if there are multiple in the import, the others
will still be duplicated. Therefore it might be a good idea before exporting the content, to either:

• Merge the variable sets into one

• To use one variable set per import package

WARNING
An import is not the same as a migration, but a tool that speeds up the process
of migration significantly. But every import must always be checked manually to
make sure no content is missing or incorrect in any way.

TIP
When importing content, Paligo will not automatically create a snapshot of
the imported content. Paligo recommends you to always create a Manual
Snapshot [1631] of the imported content, to have an archived version to compare
with the changes you make.

Well-structured Legacy Content
A prerequisite for a successful import is that the legacy format is fairly well-structured. It should
also be noted that if you're moving from unstructured and non-topic-based content (such as
Word), you are likely to want to rewrite quite a bit of the content to make it topic-based, reusable,
and so on. So while the import functionality works very well, you should always consider carefully
what is the best strategy for your content.
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If your content is well-structured and divided into topic-like sections already, you may gain a lot
from an import, saving you time on migration. But if a lot of rewriting is necessary anyway, the
gains will be smaller, and importing in such a case might not even be a good idea at all.

Smart Import
"Smart Import" means that Paligo doesn't just blindly import all your content, it will create reuse
directly.

It can intelligently detect in many cases whether the same content has already been imported.
That is, it will recognize if a topic or image is identical to one previously imported. So you will not
get unnecessary duplicates, and your work on reuse may begin already during import.

For Paligo to recognize topics and images they need to be identical. But if they are, it will
automatically ignore the topic or image and instead reuse the one already in the system. 

Import Types
You can import many different types of content into Paligo. Some formats can be imported
directly, whereas others require an indirect import where you convert the content into a different
format before you import it into Paligo.

• Direct imports means that you can Use the Import Wizard [1771] without converting the files.

• Indirect imports means that you have to use an external application to convert the content to a
format that Paligo supports for direct imports before you can Use the Import Wizard [1771].

TIP
Always check the existing tool for output or conversion formats. For example, if
you want to import Adobe FrameMaker content, you could use FrameMaker to
create an XHMTL version and then import the XHTML content into Paligo.

The table below describes the different import formats. Each format has its own preparations.

TIP
It is also possible to have the import customized for your needs. Contact support
for more information.
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Import format Description

Paligo Export File (PEF) Direct import in Paligo import wizard.

This XML format is used for backups among other things, see Import Paligo Export File
(PEF) [1804].

Author-it Export to XHTML and use the Author-it format option in the Import Wizard [1771].

Prepare the content, see Import from Other Formats [1815].

Confluence Direct import in Paligo import wizard.

The import works with an HTML Confluence Space export and other XHTML imports.

Prepare the content, see Import from Confluence [1786].

DITA (ditamap) Direct import in Paligo import wizard.

Prepare the content, see Import from DITA [1787].

DocBook 4 or 5 Direct import in Paligo import wizard.

Prepare the content, see Import from DocBook [1780].

FrameMaker Export to XHTML and use the Confluence format option in the Import Wizard [1771].

Prepare the content, see Import from Other Formats [1815].

HTML Direct import in Paligo import wizard.

Prepare the content, see Import HTML (Single File) [1784] and Import HTML (Multi
File) [1781].

Help & Manual Direct import in Paligo import wizard.

Prepare the content, see Import from Help and Manual [1791].

MadCap Flare Direct import in Paligo import wizard.

Prepare the content, see Import from MadCap Flare [1792].

MS Word There are three options when preparing import from Microsoft Word, see Import
from Microsoft Word [1793].

RoboHelp Export to XHTML, HTML, DITA or MS Word and use the corresponding format option
in the Import Wizard [1771].

Prepare the content, see Import from Other Formats [1815].

Swagger OpenAPI Direct import in Paligo import wizard.

Prepare the content, see Import Swagger OpenAPI [1806].

Zendesk Guide (Help Center) Direct import in Paligo import wizard.

Prepare the content, see Import from Zendesk [1808].
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Import format Description

Other formats:

• Adobe InDesign

• Any other format exported to
one of the supported formats

Export to XHTML, HTML, DITA or MS Word and use the corresponding format option
in the Import Wizard [1771].

Prepare the content, see Import from Other Formats [1815].

Use the Import Wizard
Paligo has an import wizard that makes it easier to import content from other formats, including
DITA, MadCap Flare, Confluence and Microsoft Word. The settings are grouped in two tabs:
General options and Custom options. Some settings and preparations differ between the import
formats.

During the import, Paligo will:

• Automatically detect if several of the sections you are importing are identical. If it finds any,
it will import the topic once and will then reuse the topic rather than import the same section
several times. This is more efficient as, ideally, content should exist once in Paligo, and then that
single instance is reused wherever it is needed.

• Detect errors in the structure. If you get a warning about incorrect structure when you import
content, try checking the Ignore warnings on import validation box. It is available for all formats
apart from Paligo Export Format (PEF). When this feature is enabled, Paligo will attempt to fix
any invalid structures that it finds during the import.

• Import your content and separate it into topics. These topics are then organized into a
publication and project, with the same structure as the original version of the content.

TIP
The necessary preparations before an import differs between the import types,
see Import Types [1769].
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To import content to Paligo:

1. Prepare the content and put it in a folder and zip it.

NOTE
There must only be one main content file in the folder, such as
index.html  for HTML format. Images can be in folders or not, as long
as they are in the same zipped folder and the references to them are correct.

The preparations might differ depending on the Import type.

2. Select the Dotted menu (...) for the documents folder in the Content Manager [34]. 

3. Select Create folder. 

4. Enter a folder name and confirm it with the checkmark. 

5. Select the Dotted menu (...) for the new folder in the Content Manager [34]. 

6. Select Import content. 

7. Select the Import type [1769] from the menu.

8. Select OK.

9. Select the zip file to be uploaded. 
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10. Set your preferences for the General options tab:

• Try to match components with existing components
Check this box if you want Paligo to recognize components that are identical to components
that already exist in Paligo. When this is enabled, Paligo will not import content that already
exists and will reuse the existing content instead. We recommend that you check the
box so that your imports are more efficient and take advantage of Paligo's content reuse
capabilities.

• Import admonitions as separate components
Paligo recommends that you check this box if you know you have many identical
admonitions (notes, warnings and more). But if most are unique, leave it unchecked.

• Ignore warnings on import validation
In most cases, Paligo recommends that you check this box unless you have problems when
trying the import. Paligo will usually fix minor problems automatically during the import
process. If you disable this feature, Paligo will reject any invalid XML, display a warning
message and stop the import process.

NOTE
This option is not shown for Paligo export file (PEF) imports. This is by
design.

• Schema max depth level
Only available for Swagger OpenAPI
This number represents the level of schema objects that can be included in the code
samples in your documentation.

For example:

• Schema max depth level = 1. Paligo does not use referenced schema objects for the
samples. The name of the referenced schema is included, but its content is not shown.
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Max depth 1:
{    "company" : {}
}

• Schema max depth level = 2. Paligo shows the content of the referenced schema object.
If that referenced object includes references to other schema objects, only the names of
those objects are shown.

Max depth 2:
{    "company" : {
        "name" : "Paligo",
        "country : "Sweden,
        "address" : {}
        }
}

• Schema max depth level = 3. Paligo shows the content of two levels of referenced schema
objects. If the second level of referenced schema objects include references to other
schema objects, those references are by name only.

Max depth 3:
{    "company" : {
        "name" : "Paligo",
        "country : "Sweden,
        "address" : {
            "street" : "Street Name 123",
            "postcode" : "1234",        
            },    
        }
}

• Code snippet languages
Only available for Swagger OpenAPI
These are the languages that you want to use for code samples in the published output.
They will appear as options at the top of the sample code part of the API documentation,
if you publish using the API style layout. When a reader selects an option, the code sample
changes so that it provides the code in the selected language. For example, if the reader
selects JavaScript, the JavaScript code samples are shown.
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1 = Language buttons at the top of the API documentation (published output), 2 = The code
sample.

TIP
To choose which languages are included in your import, select an empty part
of the field to display a drop-down menu. Choose the language(s) your content
includes, for example, PHP.

If you want to remove a language, select the x icon on the blue button for that
language.

11. Set your preferences for the Custom options tab:
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• Title prefix
Use this setting if you want to mark your imported topics with a prefix. Enter the prefix in
the field. If you do not want a prefix, leave the field blank.

• Folder numbering
Enable this setting to add sequential numbering to the folders for your imported content.

• Max folder levels
Use to control the maximum number of folder levels Paligo will create for your imported
content. By default, Paligo will create a folder structure that matches the structure of your
import content down to the second level. For example, if you have a manual with chapters
and subsections, the import will create a folder for each "chapter" and the first level of
subsections.
The default value is set to 1. It means that each group of topics will be in one folder. In the
image below, the topics addPet, deletePet, findPetById and findPets are all in a single folder
named as 2. Default. If you set the value to 2, the content would be organized so that
each topic is in its own folder.
You can increase the number of folder levels to whatever number you need for your
content. Paligo will create a new folder for each level as long as there is content at that
level in the import.
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To the left the max folder level is set to 1 (default).To the right the max folder level to 2.

• Match with existing variable set:
Paligo can create variable sets from DITA, MadCap Flare, Paligo Export File (PEF) and
DocBook 5.1 imported content. This setting only applies to those.

1. First time you import the content, leave this field blank. Paligo will create a variable
set for your content.

2. Been imported before or it already exists in Paligo, enter the ID of the variable set in
Paligo. Paligo will then match the imported content to the existing variable set and will
not create a duplicate. To find a variable set ID, see Find a Variable Set ID [1777].
However, you can only match one variable set, so if there are multiple in the import,
the others will still be duplicated.

12. Select OK to upload your import zip file.
Paligo will import the content and build a structure with a publication folder and a topics
folder. Inside the publication folder there is a publication that links to the created topics.
Inside the topics folder there will be subfolders for each article and section, even for
unmapped articles and sections.

NOTE
Depending on how much big the .zip file is, the import might take anywhere
from 10 seconds to several minutes.

Find a Variable Set ID
During content import, if using the setting Match with existing variable set, a variable set ID must be
entered to avoid duplicated variable sets. However, you can only match one variable set, so if
there are multiple in the import, the others will still be duplicated.
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Paligo will collect multiple variable sets into one. After the import, you can separate them into
multiple variable sets again if required.

TIP
It is possible to configure the import to make translatable variables (the default is
plain text variables). Contact support to get the parameter variable.type set to
"translation". To learn more about variable sets in Paligo, see Variables [1186].

1. Select Variable sets in the Content Manager [34]. 

2. Select the variable set that you want to find the ID for. 

3. Look at the URL in the browser's address bar. The ID is immediately after "edit/".

Export and Backup to XML
There may be times where you want to get your content out of Paligo. For example, if you want to:

• Make your own backups that you can import back into Paligo at a later date, if necessary.
For making backups, export your content in the Export Paligo Export File (PEF) [1778].

• Migrate your Paligo content to another system or export it so that it can be converted
into DITA or some other XML. For migrating your content out of Paligo,Publish as DocBook
XML [1779].

NOTE
To manipulate the XML outside of Paligo, you can either export to PEF or publish
as DocBook 5.1. In most cases, we recommend that you publish as DocBook 5.1
as this is an open standard. PEF is more complex as it contains more information.

Do not manipulate XML outside of Paligo and then import it back into
Paligo. This can result in duplicate content. If you need to manipulate XML that
you will continue to use in Paligo, use the Oxygen plugin [59]. Open the topics in
the Content Manager widget from there.

Export Paligo Export File (PEF)
You can make a backup of your content by exporting it to Paligo Export File (PEF). You can then
import the content back into Paligo from your backup file at a later date.

The Paligo Export File (PEF) has DocBook 5.1 elements and metadata and other information about
text fragments and variables.

Paligo Documentation

1778



To export to PEF format:

1. Select the Dotted menu (...) for the topic or publication in Content Manager [34].

2. Select Export content.

Paligo generates an export file in the Paligo Export File format. It downloads in the browser
automatically.

3. Store the download in a place where you can easily retrieve it later, for example, on a shared
drive.

NOTE
You can use the Import content option to Import Paligo Export File (PEF) [1804]
backups into Paligo.

Publish as DocBook XML
You can publish content to the DocBook 5.1 XML format. This is useful if you want to use your
Paligo content in other systems or want to convert it into another type of XML, such as DITA.

When you publish to XML, Paligo produces a standard DocBook 5.1 XML output. You can use it as
it is or you could get XSLT specialists to convert it into a different type of XML. The DocBook 5.1
output does not contain any metadata or information about text fragments and variables.

<step>
Select the Dotted menu (...) for the topic or publication in Content Manager [34].
</step>
<step>
Select Publish. 

Paligo displays the Publish document dialog.
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</step>

1. Select the XML format in the Publish dialog.

2. Select Publish document.
Paligo will generate the XML output and it will download as a zip file in the browser. You can
use an XML editor or similar application to open the file.

Import from DocBook
You can import content from DocBook 4 or higher into Paligo. Once it is imported, you can use it
inside Paligo as regular Paligo XML content and publish it to various outputs, such as HTML5 help
center and PDF.

To import DocBook, you first need to Prepare the DocBook Content [1780].

Prepare the DocBook Content
To import DocBook content into Paligo, it needs to be organized in a particular way and then
converted into a .zip file.
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NOTE
It is important that the DocBook XML file contains relative references to the
images in the folder. Also, you can organize your images into multiple folders and
multi-level folders if you prefer.

1. Organize your content like this:

• Folder (contains everything)

• DocBook XML file

• Images folder

• Image file 1

• Image file 2

• Image file 3

• ... and so on

2. Use your computer's operating system to create a .zip file of the containing folder.
Alternatively, you can use a third-party application to create a .zip file of the folder.

3. Use the Import Wizard [1771] to import the .zip file. Select DocBook 4 or 5 format depending
on the content.

Import HTML (Multi File)
If you have HTML content that is in multiple files, you may be able to import it by using Paligo's
Confluence import feature. The success of the import is dependent on the structure of the HTML.

NOTE
Select the Confluence (index.html) option. Do not select the HTML import option
as that is for single-file HTML imports only.

IMPORTANT
Paligo can only import valid HTML. We recommend that you test your HTML by
using a third-party HTML validator tool such as https://validator.w3.org/.

The import will fail if the HTML is invalid (Paligo recognises the content is invalid
and reports "nothing to import").

Prepare Multi-File HTML for Import
To import multiple HTML files at once, you need to organize your HTML content in a particular
way. You also need to create or edit an "index.html" file so that it contains an unordered list that
can act as a table of contents, with links to the various HTML files you are importing.
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NOTE
Ensure that the source files are valid by using validators like Tidy or W3C.

HTML is not a structured format. The import will handle many flavors of HTML,
but because of the many proprietary variants there is no guarantee it will work for
yours. If you have problems, inquire about the possibilities to tweak the content.

This HTML format only imports one file at a time. To import multiple HTML files,
use the "Confluence" import.

If it is not an actual Confluence import, the "index.html" needs to be manually
edited to incorporate a ul class="toc" that contains the publication structure
to be imported.

1. First, organize your HTML content like this:

• Parent "container" folder

• Index.html

• Images folder

• Image files

• CSS folder

• CSS files

• Content folder

• HTML files

It is important that the "container" folder contains one Index.html file at the root level, with all
other HTML pages inside a subfolder.
For example:

Paligo Documentation

1782



NOTE
When importing HTML, the folder names are case-sensitive.

2. Now you need to edit the index.html file. Use a text editor or code editor to open the
file and add this structure to it:

<!DOCTYPE html><html>
<head>
    <title>Import</title>
</head>
<body>
    <ul class="toc">
        <li><a href="enter relative link path here">Link text</a></li>
        <li><a href="enter relative link path here">Link text</a></li>
        <li><a href="enter relative link path here">Link text</a></li>
        <li><a href="enter relative link path here">Link text</a></li>
        <li><a href="enter relative link path here">Link text</a></li>
    </ul>
</body>
</html>

Where:

• doctype, html, head, title, and body are the basic structure as used in all HTML files.

• ul defines the start of an unordered list (bullet list) and it has to have the class name "toc".
This class is important for the import process and the import will not work correctly without
it.

• li defines a list item

• a href defines a link. This index.html file needs a list item and link for every html page that
you want the import to bring into Paligo. The link needs to be a relative link and should be
to an html file that is stored in the "content folder" inside the "container" folder.
To learn more about relative links, see w3schools.com/html_filepaths.

NOTE
When adding a link, be aware that the folder names are case-sensitive.

3. When you have added the links, save the index.html file.

TIP
We recommend that you use an HTML validator to test your HTML file, such
as https://www.html-tidy.org. This will help to identify and potentially fix any
structural problems in your HTML before you attempt to import it.

4. Next, use your computer's operating system or a third-party application to make a zip file of
the "container" folder.
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NOTE
To learn how to zip a file, see the operating system's documentation:

• Zip a file in MS Windows

• Zip a file in Mac iOS

5. Use the Import Wizard [1771] to import the zip file. Select the Confluence format to be able to
import multiple files.

Troubleshooting HTML Imports
If your HTML import does not work, we recommend that you:

• Validate your HTML content. Paligo will only import correctly formed HTML content.
There are many HTML validation tools you can use, such as https://www.html-tidy.org.

• Make sure that you have organized the content as described. The arrangement of the files and
folders in the zip file that you import is vital to the success of the import.

• Check that your HTML files use relative references to images and CSS.

NOTE
If you fix these issues and the import still fails to work, contact customer support
for assistance.

Import HTML (Single File)
Paligo can import a single HTML file, as long as the file (and any file it references) is organized into
a particular folder structure. Select the HTML (index.html) option when importing to Paligo.

IMPORTANT
Paligo can only import valid HTML. We recommend that you test your HTML first
by using a third-party HTML validator tool such as https://validator.w3.org/.

The import will fail if the HTML is invalid (Paligo recognises the content is invalid
and reports "nothing to import").

Prepare an HTML file for Import
Before you can import an HTML file, you need to organize the file and any referenced files into
folders. You must also make sure that any references to other files, such as images or CSS, use
relative references.

NOTE
To learn about relative references, see www.w3schools.com.
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NOTE
Ensure that the source files are valid by using validators like Tidy or W3C.

HTML is not a structured format. The import will handle many flavors of HTML,
but because of the many proprietary variants there is no guarantee it will work for
yours. If you have problems, inquire about the possibilities to tweak the content.

1. Organize your HTML content like this:

• Parent "container" folder

• HTML file to be imported, for example, instructions.html

• Images folder

• Image files

• CSS folder

• CSS files
It is important that the "container" folder contains one HTML file at the root level, with any
referenced images or CSS files in subfolders.
For example:

TIP
We recommend that you use an HTML validator to test your HTML file, such
as https://www.html-tidy.org. This will help to identify and potentially fix any
structural problems in your HTML before you attempt to import it.

2. Next, use your computer's operating system or a third-party application to make a zip file of
the "container" folder.

NOTE
To learn how to zip a file, see the operating system's documentation:

• Zip a file in MS Windows

• Zip a file in Mac iOS

3. Use the Import Wizard [1771] to import the zip file. Select the HTML format.
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Troubleshooting HTML Imports
If your HTML import does not work, we recommend that you:

• Validate your HTML content. Paligo will only import correctly formed HTML content.
There are many HTML validation tools you can use, such as https://www.html-tidy.org.

• Make sure that you have organized the content as described. The arrangement of the files and
folders in the zip file that you import is vital to the success of the import.

• Check that your HTML files use relative references to images and CSS.

NOTE
If you fix these issues and the import still fails to work, contact customer support
for assistance.

Import from Confluence
Importing from Confluence is done directly in the Import Wizard. See Using the Import Wizard.

However, for Confluence you have a choice of multiple or single file import. It's possible to import
all the HTML files that a Confluence space consists of all at once. So the preparation of the import
zip file is slightly different.

NOTE
Note that Paligo will be able to handle most common Confluence space exports.
If you should have something particular in your content that may not be
standard, it may still be possible to customize the import to handle that. Simple
customizations may be included, depending on your plan, or can involve a cost for
the additional service.

It is also possible to have this import customized for your needs. Contact support
for more information.

For instance, if you find that the topic sizes do not come out the way you want,
this is a setting that can easily be changed for your import.

Multi-file Import
A Confluence space HTML export will contain one index.html file and a number of additional
HTML file for each space section you had in your Confluence space. Do this to prepare the package
to import them all at once:

1. Open the file index.html in any text editor.

2. Locate the element ul that comes right after the div with @class "pageSectionHeader":
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3. Add a @class attribute to it with the value "toc", like this: <ul class="toc">

This tells Paligo which unordered list (UL) to look in for the structure of the HTML files to
import. If there are lower-level unordered lists that have class names, you can leave those in
place as long as the top level of the unordered list has the class name "toc".

4. Zip the entire folder with this file and all its resource folders.

5. Use the Import Wizard [1771] to import it to Paligo.

Single-file Import
It's also possible to import just a single HTML file from a Confluence export (in case each of your
sections in Confluence have been quite long, a publication in itself). Then do this:

1. Pick the HTML file you want to import. Copy that and all resource folders. 

2. Paste these files into a new folder, name it anything you want, e.g ConfluenceImport_1 or
whatever suits you.
In this case it doesn't matter what the file is named, but it needs to be just one HTML file in
this import folder.

3. Zip that folder.

4. Use the Import Wizard [1771] to import it to Paligo.

Import from DITA
Use the Paligo Import Wizard to import DITA content directly into Paligo. During the import, Paligo
will handle most of the common DITA content elements, including conkeyrefs (partially).

If your content has DITA constructs that Paligo does not support, these may be excluded or
imported as DocBook elements that have a different purpose. It is possible that this could result in
invalid DocBook XML. These need to be corrected manually post-import.

Prepare the DITA Content
Paligo imports the content into the Content Manager. When the import is complete, check the
content as you may need to alter some of it manually (if there were DITA elements that are not
supported by the Paligo import, for example).

1. Prepare your DITA content and then zip the folder that contains it.
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NOTE
If you use variables in your DITA content and want to import them into Paligo
as variables, see Import Conkeyrefs as Variables [1788].

2. In a folder with your DITA content, make sure you have one main ditamap file. Name this
ditamap file: 
index.ditamap

If you have one ditamap for the entire publication and several "chapter" ditamaps, only
rename the main publication one. It does not matter if that's a regular ditamap or a bookmap.

3. Use the Import Wizard [1771] to import your DITA content.
Select DITA (.ditamap) as the import type and then select your DITA zip file as the "archive
file".

Import Conkeyrefs as Variables
If you have used conkeyrefs for variables in DITA, Paligo can import them as variables and
variable sets in Paligo. For this to work, you need:

NOTE
Paligo can convert DITA conkeyrefs used as variables into variables and variable
sets in Paligo. If you have used any other constructions for emulating variables in
DITA, change to using conkeyrefs before you import into Paligo. This will allow the
import to handle conversion of variables.

If you have any trouble with this, ask support for instructions about how to
prepare the content.

1. A ditamap that contains a topicref to a topic and a keydef to the variable file. For example:

<topicref href="topics/DITA-topic-w-vars.dita"/>
<keydef keys="products" href="topics/DITA-variables.dita"/>

2. The variable file, which is a topic with each variable declared with an ID. For example:

 <p>Product name: <ph id="productname">product A1</ph></p>

3. A topic that contains references to the variables, such as:

<p>This is the product name: <ph conkeyref="products/productname"/></p>

Where:

• "products" is the id of the variable file, as given in the ditamap keydef

• "productname" is the id of the variable.

4. When you have these files, add them to a folder and zip the folder.

5. Use the Import Wizard [1771] to import your content.
When the import is complete, Paligo will import the variable file as a variable set and will
import the conkeyref elements into variables.
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TIP
To learn more about variables and variable sets in Paligo, see:

• Variables [1186]

• Variable Sets [1191].

Example of DITA Import
The example below shows what happens when you import DITA content with variables into Paligo
(assuming the DITA content is set up correctly).

Example 88. DITA files for importing conkeyref as variables
The zip file contains a folder and inside the folder are:

• index.ditamap
A ditamap that contains a topicref to a topic (DITA-topic-w-vars.dita) and a keydef to the variable
file (DITA-variables.dita)

• DITA-variables.dita
This is the variable file, where each variable is declared with an ID.

• DITA-topic-w-vars.dita
This is a topic that contains conkeyref references to the variable file (DITA-variables.dita).

The content of the files is:

index.ditamap

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE map PUBLIC "-//OASIS//DTD DITA Map//EN" "map.dtd">
<map>
    <title>DITA map with variables</title>
    <topicref href="topics/DITA-topic-w-vars.dita"/>
    <keydef keys="products" href="topics/DITA-variables.dita"/>
</map>

DITA-variables.dita

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE topic PUBLIC "-//OASIS//DTD DITA Topic//EN" "topic.dtd">
<topic id="DITAvariables">
    <title>DITA_variables</title>
    <body>
        <p>This is an example of a DITA variable file</p>
        <p>Here is the variables enclosed in PH-tags with Ids:</p>
        <p>Product name: <ph id="productname">product A1</ph></p>
        <p>Product type: <ph id="producttype">produkttype A1</ph></p>
    </body>
</topic>

DITA-topic-w-vars.dita

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE concept PUBLIC "-//OASIS//DTD DITA Concept//EN" "concept.dtd">
<concept id="dita_topic_w_vars">
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    <title>DITA topic with variables</title>
    <shortdesc></shortdesc>
    <conbody>
        <p>This is an example of a topic using variables as conkeyrefs.</p>
        <p>This is the product name: <ph conkeyref="products/
productname"/></p>
        <p>This is the product type: <ph conkeyref="products/
producttype"/></p>
    </conbody>
</concept>

When you import this zip into Paligo, Paligo generates:

• A publication that contains a fork to the topic that Paligo creates for the DITA-topic-w-vars.dita
file.

• A topic with the content from the DITA-topic-w-vars.dita file, converted to Paligo XML with Paligo
variables instead of conkeyref variables.

• A variable set. Paligo creates a variable set and imports the content of the DITA.variables.dita file
into it. The imported data is converted into Paligo variables.

The values for the variables are in a "General" column. This represents the values to use for one
variant. You can add extra variants so that the variables can have different values in different
circumstances.
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Import from Help and Manual
The Help and Manual content can be imported directly into Paligo, but the project requires some
preparation. However there are some known limitations:

• Help & Manual uses a very flat structure that needs to be converted into more structured
nested XML. This is a great challenge for a conversion, and you should make sure the attempt to
fix this has not misinterpreted the intended content order.

• Variables are only partially supported, as the use of variables differs greatly from the way it is
implemented in Paligo. Non-supported variable types will be marked with a "remark" element in
the import ("UNHANDLED VARIABLE")

• Conditional filtering is completely different in Help &amp; Manual than in Paligo and most
XML-based single-sourcing, so a direct conversion of this is not possible. Instead, it is marked up
by "remark" elements to be manually fixed post-import.

NOTE
If your content contains reusable "snippets", some may appear as regular topics
in Paligo. If this happens with your content, you can easily convert each topic into
an informaltopic. An informaltopic is a group of text fragments that you can
insert into other regular topics, so works in a similar way to a snippet.

To do this, select the topic's options menu ( ... ) in the Content Manager, and
select Edit > Open Structure. Then, in the metadata section, use the subtype
setting to convert the topic from Component into InformalTopic. Select Update
to confirm.

To find out more about informal topics, see Create an Informal Topic [1109].

Prepare the Help and Manual Content
Before the Help and Manual content can be imported to Paligo it must be prepared.

1. Rename the Help and Manual project file .hmxz extension to .zip. Decompress the archive.

2. Locate the folder where you have your images. Perform a search for image files in this folder
(searching for image type files). Copy all the search results into a folder called "images" inside
the "Maps" folder so that you have all the images in one folder, no sub folders.

3. Rename all the images to lower case names, for instance by using an file renaming tool, like
Name mangler for Mac or see for example this site for tips on doing it under Windows: Is there
a way to batch rename files to lowercase?
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NOTE
This is because even if you've named your images using upper case letters,
Help and Manual will always refer to them in lower case, and for the import
the case has to match.

4. Use the Import Wizard [1771] to import the .zip file.

Import from MadCap Flare
MadCap Flare content can be imported directly in the Paligo import wizard. Variables are imported
into Paligo variable sets, Flare "snippets" are converted into either reusable components such as
informal topics, or when plain text they will turn into Reuse Text fragments. 

For more advanced import, with more support for variables and "snippets", please contact
support.

NOTE
If your content contains reusable "snippets", some may appear as regular topics
in Paligo. If this happens with your content, you can easily convert each topic into
an informaltopic. An informaltopic is a group of text fragments that you can
insert into other regular topics, so works in a similar way to a snippet.

To do this, select the topic's options menu ( ... ) in the Content Manager, and
select Edit > Open Structure. Then, in the metadata section, use the subtype
setting to convert the topic from Component into InformalTopic. Select Update
to confirm.

To find out more about informal topics, see Create an Informal Topic [1109].

Prepare the MadCap Flare Content
The MapCap Flare content must be prepared before imported to Paligo. If you want to learn more
about the custom options, see Import or Export Content [1768].

If you import multiple projects one after another, you can also specify to reuse the already existing
variables, in the options tab.

Paligo Documentation

1792



NOTE
There are some files inside a project sometimes that can cause problems for
recognizing the file as a zip file. These include [Content_Types].xml and
folder _rels. If you have them, you need to remove them before zipping the
content.

1. Move the TOC file (.fltoc) to the root folder of the project if it's not already there (the same
folder as where the Project and Content folders are). Paligo's import will automatically take
care of redirecting the links.

2. Make sure you have the .fltoc and the Project and Content folder in one enclosing folder.
Do not zip them separately.

3. Zip the folder.

NOTE
If you have more than one TOC file for multiple publications, you need to do
this one by one, and import them each one at a time. You can only have one
TOC file at the root for a given import.

If you encounter any problems with the import, it may help to remove all
unnecessary files and folders. All you need in the folder is the .fltoc file and
the Project and Content folder.

4. Use the Import Wizard [1771] to import the content.
Select Flare as the import format.

Import from Microsoft Word
Importing from Microsoft Word is complex, because it is not a structured format. So the results
will depend a lot on the input quality. The most important consideration is usually that Word styles
should have been applied consistently.

There are three options when preparing import from Microsoft Word:

• Use the Import Wizard [1771] to directly import the Ms Word content. It can handle most
well-structured Word documents.

• Convert to DocBook using the (optional) Oxygen XML editor with the Paligo plugin.

• Convert to XML with a purchased customization from support. This is used if your content is
not easily imported directly. For very large documents or many documents, the latter method is
sometimes preferable.

Prepare MS Word Document for Import
To import content from Microsoft Word into Paligo, you will need to apply certain styles to your
content and make some adjustments. This is because MS Word is unstructured content, and to
import it into Paligo, it needs to be given some form of structure.

We recommend that you save a copy of your Word file for use as a Word document. Then use
another copy for the Paligo import.

To prepare your MS Word file for import, complete the following tasks.
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Give your MS Word Document a Title
We recommend that you give your MS Word document a title.

If you try to import a Word document that does not have a title, Paligo will apply a default title,
such as "Article d3e1".

In some cases, MS Word documents that have no title may cause the import process to fail. If this
happens, you may see the following error message:

"The import file could not be created. Nothing to import. The intermediate transformation resulted in an
empty document."

Apply Styles to the MS Word Document
Paligo uses the style names from MS Word to map your Word content to the appropriate elements
in Paligo. For example, Paligo uses the Heading 1 style in Word to determine which parts of a Word
document should be a top-level topic in Paligo.

For the import and mapping to work, it is important that you use the styles for formatting your MS
Word content. You can create and apply styles from the Styles panel in Word:

To work with Paligo, the styles need to have specific names:

• Create a style called Title and apply it to the name of your document, for example, the title on
the front cover. Make sure that the title is the first text that appears in the document.

NOTE
If you do not give your document a title, the publication will fail and get a name
like "Article d4e1" when you import the document into Paligo.

• If your Word document has a subtitle, create a Subtitle style and apply it to the subtitle text.

• Make sure your headings use styles named Heading 1 through to Heading 6.

• If you have code examples, create a Source Code style and apply it to the code text.

The names of the styles are important for the Paligo import, so please make sure they match the
names given above.
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TIP
To find out how to set up styles, see the Microsoft documentation.

Use Headings Consistently in the MS Word Document
Paligo uses the hierarchy of heading styles to determine which parts of your document should be
converted into top-level topics, second-level topics, third-level topics, and so on. For this to work
correctly, it is important that you use the heading levels as intended and consistently in your MS
Word doc.

• Use Heading 1 for chapter headings

• Use Heading 2 for first-level subsections in chapters

• Use Heading 3 for second-level subsections in chapters

• Use Heading 4 for third-level subsections in chapters

Always use them in this order and do not skip a heading level, for example, do not have a Heading
1 followed by a Heading 3. The sequence of Headings should always be Heading 1, Heading 2,
Heading 3, and so on.

Typically, technical communication is organized into three or four levels of content for ease of use.
If you have more levels, you can use Heading 5 and Heading 6. But if you need to use Headings 5
and 6, it could suggest a problem with the information architecture. It may be worth reconsidering
the structure and reorganising it into 3 or 4 levels maximum.

Remove Content that is Not Used in Paligo
Your MS Word document most likely contains some features that are needed for Word, but they
are either not needed in Paligo or they cannot be imported. These include page breaks, a table of
contents, and review comments.

• Paligo cannot import text that is inside frames. If you have text in frames, you will need to
move it into the regular content or it will be lost.

• If there are any active review comments or track changes, make sure they are accepted
before you import.

• Remove the header and footer content

• Remove all page breaks and section breaks

• Remove the Word table of contents (TOC). Paligo will generate its own table of contents when
you publish in Paligo.

NOTE
In some cases, graphics on the front cover can be a problem with importing. If you
have front cover graphics, it can be a good idea to remove them and then add
them to Paligo manually after the import.
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Prepare Indented List Content for Import
In Microsoft Word, there are different ways to add content that is indented inside a list item (or is
not indented, but really should be!). This can make it difficult to import in a consistent way.

For the cleanest import, we recommend that you format your indented list item content like this in
MS Word:

1. Create a new list item for the indented content.

2. Add the text or image for the indented content in the new step.

3. Position the cursor at the start of the new list item and press backspace. The list item
formatting is removed so that the content is now indented as part of the previous step.

When you create indented content in MS Word in this way, Paligo will import the list and give it the
expected structure:

Note that each list item has a listitem element and then the text for the list item is inside a
para element. Here, we have imported a list that has an indented image for the third list item. The
image uses a mediaobject element in Paligo and you can see that it is inside the listitem.

For indented paragraphs, the paragraph is inserted in a para element inside the list item:

You could have sublists indented in the same way. The important part is that the content is nested
inside the listitem to which it relates.
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NOTE
If you have content in a list and it was indented in a different way in MS Word, it
may import as:

• Regular paragraphs that break the flow of the list.

• Literallayout elements, which are valid Paligo XML, but are not the
recommended way to structure lists. In the editor, the list item can look like
code, for example:

In both cases, you can use the Paligo editor to fix the issues. You can use the
XML tree to indent the regular paragraphs and create new listitems for the
literallayouts and move the content into those. Or you may prefer to address
the problems in the MS Word document and re-import the content, so that the
issues are fixed at the source.

Prepare the MS Word Tables for Import
Paligo can import tables from Microsoft Word, but for best results we recommend that you:

• Avoid using large tables that cover multiple pages in MS Word.
While large tables can import correctly, they may go beyond the boundaries of the Paligo editor,
making them more difficult to edit (you will need to use the source code editor). It is better to try
and break large tables down into smaller sets of tables. This makes them more usable in both
Paligo and MS Word.
When redesigning your tables, think about what information your users need from each table.
Do they need to compare items? If yes, then can those related items be organized into smaller
groups, perhaps smaller tables organized by product type or product name? If no, then think
about making smaller tables for groups of related items rather than one oversized table.

• Try to use simple tables where possible.
Tables with merged cells will sometimes import as two separate columns, depending on how
they are formatted in the background code in MS Word. The more complex the table, the
greater the chance that you will need to manually edit the table in Paligo to get the result you
want.

• Use tables appropriately.
Tables are a good option for presenting data, but are sometimes used for information that
would work better as a regular paragraph. For example, if you have a cell with many paragraphs
in it, then this could be a good candidate for being a section in its own right. The table cell would
then just need a link to the appropriate section.
If you intend on publishing to the web, it is also worth noting that tables of content can be more
difficult to use on small devices such as smartphones. This is especially true of larger tables
where vertical and horizontal scrolling is needed.

Prepare Customized Styles for Import
If you have used customized styles in your MS Word document, the styles must be renamed to
Source code, before the document is imported into Paligo. Otherwise the code listings from the
customized styles will not be imported.
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TIP
For more information about styles in MS Word, see Microsoft Support page.

In this instruction, the customized style is called "Linux Commands".

1. Open the document in MS Word.

2. Open the Styles pane.

3. Locate the customized commands style (in this example called "Linux Commands").

4. In the context menu, choose Modify Style.

5. Rename the style to "Source Code" (instead of "Linux Commands").

6. Select OK.

7. Save the document, zip it and import it to Paligo.
All content using the custom commands style should now be shown as programlisting
since the name "Source code" is the one recognized by the tool converting from Word.

Known Limitations with MS Word Links
A cross-reference points to information in the same document and a hyperlink refers to other
documents.

Links in MS Word documents that point to a heading (created with Insert → Link → Link → This
document and selecting a Heading) are converted well when imported to Paligo.

The following limitations are known with MS Word links when imported to Paligo:

• Bookmarks (created with Insert → Link → Bookmark) do convert, but are tricky as they use
arbitrary anchors, which is a problem when migrating to a structured content form as the one
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used in Paligo, as one cornerstone is that links need to point to a content element that makes
sense. They can break during import and will require manual adjustment.

• Cross references selecting an entity in the document (created with Insert → Link → Cross
reference and selecting an entity in the document) do not convert in the standard process, as they
use a linking mechanism that only exists in MS Word.

Option 1: Prepare for Direct Import
The simplest method is to import the Ms Word files directly by using the Import Wizard. Paligo can
handle most well-structured Word documents.

1. Zip each individual Word file. Do not include multiple Word files in one zip file.

TIP
To find out about zipping files in Word, refer to the Microsoft Word help.

2. Use the Import Wizard [1771] to import the zip files.
Select Word (.docx) as the type of file to import.

Option 2: Prepare by Converting to DocBook
By using Oxygen XML editor, you can convert the content to a DocBook document before
importing it.

1. In Oxygen, create a DocBook 5.1 Article, by selecting File > New, and then selecting the proper
DocBook template.

2. Remove the first "sect1" element.

3. Insert a new section element by pressing enter on your keyboard and select Section in
the element list. This will not really be used, and we'll remove it at the end. But it's needed
because of a quirk in Oxygen.

4. Place the cursor inside the section element.

5. Save the document with any name you choose.
It is however important to save it with a name, otherwise images will not be properly saved.

6. Copy the text from your Word document. You should leave out any Table of Contents or
similar, since it won't be needed.

7. Paste the content into the section element in Oxygen.
You will get a warning saying that it needs to place it inside the closest Article element. Go
ahead and accept that.
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8. When you paste the content, it will be automatically converted to the proper XML elements.

9. Remove the empty section tag. It will be at the bottom or at the top of the document.

10. Save the document again.

11. Use the Import Wizard [1771] to import the resulting DocBook document.

Option 3: Prepare by Converting to XML
The third method involves a preconversion to XML using a script package that requires a
purchased customization. It is slightly more complex, but with good results. It is especially
preferable for very large documents or many documents, as it is very fast and can be tweaked
more to adapt to your content.

NOTE
Contact Paligo support if you would like to use this method instead of the above
procedures.

Depending on the complexity of your content and mapping the structure, there
may be a charge to do this conversion.

Troubleshooting MS Word Imports
If you are experiencing problems with the MS Word import, you may find useful information about
the most common issues in the following sections.

NOTE
If you are experiencing different types of problems with your MS Word import,
please contact customer support for help.

Import Process Does Not Complete
If the import process does not complete, make sure that you have correctly prepared your MS
Word document for import [1793]. It needs to have a title and use headings correctly as a
minimum.

NOTE
If you continue to experience problems, contact customer support for help.
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Import Process Completes, But there are Missing Topics
If Paligo's Word import process completes successfully but the import folders contain no topics, or
some topics are missing, it is likely due to incorrect formatting.

Make sure that your Word document has a title and uses headings correctly, as described in
Prepare MS Word Document for Import [1793].

If you prepare your MS Word document correctly, the import should create a topic for each
section of content that has a heading. If you continue to experience problems, contact customer
support for help.

Table Too Large for Editor
If you imported a table from MS Word and the table extends beyond the boundaries of the Paligo
editor, this is due to the table being too wide. You can still edit it in Paligo - use the scroll bar at the
bottom of the Paligo editor to scroll horizontally to the additional cells.

For HTML outputs, Paligo will add a scrollbar feature to the web page so that your readers can
scroll to cells beyond the display area.

For PDF outputs, the table will go off the edge of the page. For this reason, you should consider
setting the table to display as landscape rather than portrait, see Rotate a Table [1019]. You may
also need to redesign the table if it is too large for the page size, for example, you may need to
create several smaller tables instead.

List Numbering is Incorrect
If you imported content from MS Word into Paligo and the list numbering is incorrect, the first
thing to do is publish the content. The published content may have the correct numbering. This
is because Paligo cannot use some of Word's numbering systems in the editor, but it can give a
list item an override attribute with a number. This number is only applied when the content is
published.

Another potential cause of incorrect numbering is that a list may be imported as several lists
rather than one list. This can happen if the MS Word content has text or images that break the
flow of the list and you used Word's "continue numbering" feature to make the list look correct.
For example, let's say you had this list in MS Word:

The image has been added outside of the list item for step 3. This breaks the flow of the list, and
step 4 is actually a new list. Word's "continue numbering" feature makes it look like a continuation
of the previous list.

When this is imported into Paligo, you get step 4 numbered as 1, like this:
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This is because step 4 is actually a new list and the "continue numbering" feature is not
recognised.

To solve this, you can either:

• Fix it in the MS Word file
We recommend that you insert the image (or any text between steps) as a new list item and
then use backspace to delete the numbering. This will give you an indented image (or text) that
is part of the preceding list item, which is correct formatting. Then step 4 will be a list item in the
same list rather than a new list.
For details on adding content inside a list item, see Prepare MS Word Document for
Import [1793].

• Use the XML tree in Paligo to move the image inside listitem 3. Then add list item 4 to the end
of the first list. Finally, remove the extra orderedlist element (it represents the second list).

Before (left) and after (right). The before image shows the imported structure. The after image shows
the corrected structure.

List is Using Literal Layout Elements for Block Level Content
If your lists in MS Word use a soft return (shift + enter) to place content on the next line, it will be
imported into Paligo inside a literallayout element. You can see it in the Paligo editor as there
is a shaded box around the content and, if you select it, you can see the literallayout element in
the Element Structure Menu.
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While this is valid, it is not the way text and images are usually added to a list item in Paligo.

The more commonly used structure for this content is:

<orderedlist>
    <listitem>
      <para>This is step one.</para>
      <para>In MS Word, this line was created by using a soft return at \
the end of the previous line.</para>
    </listitem>
    <listitem>
      <para>This is step two.</para>
    </listitem>
  </orderedlist>

So the difference is that the extra line of text in the step is inside an additional para element
rather than a literallayout element. If the content in the list was an image, it would be inside a
mediaobject structure instead. But in both cases, they should be inside the list item.

To correct your content you can either:

• Edit the lists in MS Word
Remove the soft returns and then add a new list item for the text or image. This will create an
extra step that you do not want, but that is intended for now. Next, position the cursor at the
start of the new list item and press backspace. This will make the text/image an indented part
of the previous list item. In this form, it will import into Paligo cleanly, with no literallayout
element.
For details on adding content inside a list item, see Prepare MS Word Document for
Import [1793]

• Edit the lists in Paligo
For text between lists, add a para element inside the listitem element and then add your
text content to that.
For images between lists, either insert an image inside the listitem element or use the XML
tree to move the mediaobject element into the listitem.

TIP
To learn how to add elements, see Add Block Elements [148].

To learn how to use the XML tree, see Move Content [153].
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List is Numbered List instead of Procedure
Paligo imports Microsoft Word number lists as ordered lists. If you want them to be imported as
procedures, it may be possible to do that as a customization project (there is usually a fee for
customization projects). Please contact customer support for details.

List is Portrait But Should Be Landscape
The Paligo editor always shows tables as portrait. For HTML outputs, wide tables are given a scroll
bar so that users can access all of the data in the table. For PDF outputs, you can set them to
display in landscape mode instead, see Rotate a Table [1019].

Import Paligo Export File (PEF)
If you have previously produced a Paligo export file, (PEF .zip file), you can Use the Import
Wizard [1771] to import it back into Paligo. On the Import Wizard, make sure you choose to import
the Paligo export file format.

NOTE
There is a limit of 1 GB on Paligo XML import files.

To learn how to create a Paligo export file, see Export Paligo Export File (PEF) [1778].

This export-and-import process can be useful if you need to transfer content from one Paligo
instance to another Paligo instance.

Import from RoboHelp 2020
Paligo can import content that is in the Adobe® RoboHelp 2020® format. Before you begin with an
import, we recommend that you read What does the RoboHelp 2020 Import Support? [1804] so
that you understand what to expect when the import is complete.

What does the RoboHelp 2020 Import Support?
The Paligo import for RoboHelp 2020 content supports:

• Regular content - Such as text, images and so on.

• Variables - Paligo converts RoboHelp variables into a Paligo variable set [1186].

NOTE
The import only includes the default variable values for the project. It does not
include the overriding variables that you can define in the output settings in
RoboHelp 2020.

• Conditions - These are imported as profiles (filters). To find out more about profiling in Paligo,
see Filtering / Profiling [1141]

• Glossary - If your project contains any glossary terms, Paligo creates a glossary topic containing
the glossary definitions, and this topic is added as the last top-level topic in a publication. The
glossary references in your topics will link to the glossary definitions in the glossary topic. To find
out more about glossaries in Paligo, see Glossary Topics and References [400].
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NOTE
Snippets are imported as regular content (text, images,etc.). You can use Paligo's
features to re-apply Content Reuse [1098] manually, as required.

Prepare your Adobe RoboHelp Content
Before you import your RoboHelp content into Paligo, create a copy of the project, organize it and
make a .zip of it:

1. Make sure your content is in the RoboHelp 2020 format.
If you have projects created with older versions of RoboHelp, you will need to convert them to
the RoboHelp 2020 format before you can import into Paligo.
To convert them, use RoboHelp 2020's Upgrade RoboHelp Classic Project feature. If you
do not have RoboHelp 2020, you can download a trial version from Adobe or purchase a
RoboHelp 2020 license.

2. Create a copy of your RoboHelp project folder.

3. In the copy of the folder, open the "toc" folder and view the .toc files. These are the table of
content files for your project.
Select a .toc file that is designed for online use (HTML). It should contain links to the topics in
your project.

NOTE
Do not select a .toc that is designed for PDF or a chatbot.

4. Move or copy the .toc file to the same level as the .rhpj project file.

.toc file is in "toc" folder in RoboHelp project
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Move the .toc file to the same level as the .rhpj project file.

NOTE
It is important that you only move one .toc file out of the "toc" folder. The .toc
file that you move has to be for HTML online content, not PDF or any other
output format.

5. Create a .zip file containing the entire copied RoboHelp folder.

6. Use the Import Wizard [1771] to import your RoboHelp 2020 import .zip file. Select Robohelp
2020 (.toc) as the import format.

Troubleshooting RoboHelp Import
Paligo imports the content from your RoboHelp 2020 .zip file. If import does not work, check that:

• You organized the project correctly when creating the .zip file.

• You have Ignore warnings on import validation checked in the General settings.

NOTE
If both of these criteria are met and your .zip file will not import, contact customer
support for assistance.

Import Swagger OpenAPI
To use Swagger Open API content in Paligo, you can either embed it or import it. The best
approach for you will depend on your requirements.

• Importing is useful if you need to be able to format the Swagger Open API content in Paligo.
With an import, you bring the Swagger Open API content into the Paligo database, where you
have more control over the formatting, just like regular Paligo content. But you will need to
import the content manually each time it is updated.

• Embedding is useful if your Swagger Open API content exists elsewhere on the internet,
external to Paligo. By embedding it, you add a "live" version of the content to a Paligo topic.
However, there are some limitations with how you can format the content, as it is not in the
Paligo database and so cannot be processed by Paligo during publishing.

In this section, we explain how to import Swagger Open API content. If you want to find out about
embedding it, see Embed Swagger OpenAPI [527].

When you import OpenAPI content into Paligo, the content exists as topics in Paligo and you can
edit them in the same way as any other Paligo topic. You can import the content and publish it
as it is, or you can import it and then add other topics to it, depending on your needs. Imported
OpenAPI content works especially well with Paligo's HTML API style layout, which provides a
navigation panel, a content panel and a sample code panel where you can switch between code
samples in different programming languages.
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Prepare Swagger OpenAPI for Import
You can import Swagger OpenAPI content as json or yaml files. Before you can import your
content to Paligo, the project requires some preparation first.

When the import is complete, the Swagger OpenAPI content appears as topics in the Content
Manager [34]. You can use Paligo to edit or add content to the topics if you wish. Note that there
is also a publication that contains links to the topics. The publication acts as the table of contents
for your OpenAPI content and it is where the structure of the documentation is set. You can
create extra topics in Paligo and add them to the content imported from your OpenAPI, as well as
integrate it with the rest of your software documentation created in Paligo.

You will probably want to use Paligo's HTML5 API layout for publishing as this layout provides the
code sample panel as well as the main content. Learn more about the Publishing Process [1068].

IMPORTANT
If your OpenAPI content has circular references, you will need to import your
content in json format. The yaml import feature does not support circular
references.

To import json or yaml content into Paligo:

1. Make a zip file containing the json or yaml file that Paligo will import.

2. Use the Import Wizard [1771] to import your content. Select Swagger OpenAPI as import
type.

TIP
If you don't have an OpenAPI project yet, you can use this sample to test the
import:  https://paligo.zendesk.com/hc/en-us/articles/360007352034-Download-
API-Sample-Content. It is to be imported as a Paligo Export File (PEF).
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Import from Zendesk
Abstract

You can import your Zendesk articles directly into Paligo. As part of the import, Paligo creates new
topics to match your articles. You can then map the topics back to the articles, so that you can
make updates in Paligo and publish the changes to Zendesk.

You can import content directly from your Zendesk Guide help center into Paligo if you have this
in your plan. When you import, Paligo will analyze the Zendesk sections and articles and create
matching versions in Paligo. Those versions are marked up to be structured content, using Paligo
XML.

But it's important to understand that when you do an import, there is no connection between
your Zendesk content and the matching content in Paligo. After the import, the Zendesk
articles and their matching Paligo topics exist as separate content. To be able to edit the Paligo
topics and get the changes to appear in the matching Zendesk articles, you need to establish
relationships between the topics and the articles. This is called "mapping" and you can set it up by
using Paligo's Zendesk Preflight feature.

NOTE
The Paligo import does not support the Zendesk enterprise multi-section
architecture. If you need to import multi-section architecture, please contact
customer support for advice.

The following video shows the process for importing from Zendesk and then setting up mapping
for the first time.

https://player.vimeo.com/video/434673101

NOTE
You cannot update topics in Zendesk and then use import to update the same
topics in Paligo. If try to do this, the import will create an entirely new publication
and topics. The import feature is only for migrating content from Zendesk to
Paligo.

Prerequisites for Importing Content from Zendesk
The prerequisites for importing from Zendesk are:

• You need to have a plan that includes Zendesk integration.

• The Zendesk integration must be set up, and the default category will be used for importing
content.
To find out about setting up the integration, see Connect Paligo to Zendesk [1529].

• If you have the Zendesk multibrand feature, put the Zendesk account you want to import from
at the top of the multibrand list. Paligo will import from the first account in the multibrand list.
To change the order in the list, see Connect Paligo to Zendesk [1529].

Paligo Documentation

1808

https://player.vimeo.com/video/434673101


Prepare Zendesk Content for Import
You can import content directly from Zendesk into Paligo. When you import, Paligo gets the
content from your articles and adds it to new, automatically generated topics. But there is no
relationship between the imported content and the articles at this stage. The import only creates a
Paligo version of your Zendesk articles.

To use the imported topics for publishing updates back into Zendesk, you need to Customize
Paligo-to-Zendesk Mapping [1566]. You do that by using the Preflight settings, which are designed
for "mapping" topics to articles. You create the relationship by Map Imported Content to Zendesk
Articles [1809].

1. Create a .zip file of the Zendesk content.

2. Use the Import Wizard [1771] to import Zendesk .zip file. Select the Zendesk format.

Map Imported Content to Zendesk Articles
When you have import content from Zendesk, Paligo creates topics to match the sections and
articles. To use these topics to update the matching articles in Zendesk, you need to set up the
topic-to-article relationships. This is called "mapping" and you set it up by using the Zendesk
Preflight feature, which is part of the publishing settings.

1. Select the options menu ( ... ) for the publication that Paligo created when you imported
content from Zendesk. Then select Publish.

2. On the Publish Document dialog, select HTML.

3. Choose a Zendesk layout from the dropdown list below the buttons for the output types.

When you select a Zendesk layout, the Publish Document dialog changes to show Zendesk-
specific settings, such as Zendesk category and Managed by. Also, the Zendesk Preflight
tab appears at the top.
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4. Apply any Languages, Profiling attributes, Variables, and Optional Parameters that you want
the publication to use.
These are common publishing settings and you can find out about them in Publishing
Process [1068], Filtering / Profiling [1141], and Variables [1186].

5. Select the Zendesk Preflight tab.
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The Zendesk Preflight tab shows you what will happen in Zendesk when you publish. There
is a hierarchical list, that shows the categories, sections, and articles that will be created,
updated, or deleted. Those that are marked with a plus icon are going to be added to your
Zendesk instance.

NOTE
In Paligo, you create different levels in a publication's structure by adding
topics and organizing them in a hierarchy. So where Zendesk has a section
and then articles in it, Paligo has a top-level topic, with other topics at a lower
level. As the top-level topic can contain content, Paligo automatically creates
an extra article for it when publishing to Zendesk. If you prefer, you can use
the Zendesk Layouts [1600] to stop Paligo from creating extra articles for
top-level topics.
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As the import topics do not have any relationship with the articles in Zendesk, Paligo sees
them as completely new content. So when you publish to Zendesk, Paligo will create new
categories, sections, and articles.
Below the new sections and articles, there are sections and articles that are gray and do not
have any icons. These represent the sections and articles that already exist in Zendesk.

There is no update icon for these, as Paligo is not going to do anything to them. It knows they
exist in Zendesk, but they are not mapped to any topics.
With a new import, you most likely do not want the import topics to create new sections and
articles. Instead, you probably want them to update the existing sections and articles instead.
So the next step is to set up that mapping.

6. Select the cog icon for a section that Paligo is going to add to Zendesk. The mapping dialog
appears.

7. Select the Mapping dropdown list.
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You now have the option to create a new section in Zendesk (the option with the plus icon).
Or you can map the section topic in Paligo to any existing, unmapped section or article (the
options with the update icons).
After an import, you will most likely want to map the section topics to existing sections in
Zendesk, and the article topics to existing articles in Zendesk.

8. Set the section to map to an existing, unmapped section in Zendesk and then select Confirm.
When you confirm, the list refreshes to show the new mapping. You should see that the
section now has an update icon instead of a plus icon, as you have set the section topic to
update an existing section in Zendesk. If you expand the section in the list, you should see that
it now contains the existing articles in that section (grayed out) and also the new articles that
Paligo will create in that section (plus icons).

You most likely do not want this mapping. Instead, you want Paligo to map the content to the
existing articles. So the next step is to map the new articles (plus icons) to the existing articles
(grayed out).

9. Select the cog icon for one of the new articles to display the mapping dialog.

10. Select the Mapping dropdown and set the article to update the existing article (update icon),
instead of creating a new article (plus icon). Select Confirm when you have set the mapping.
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You can set the article to map to any existing, unmapped article in Zendesk, but it's most likely
that you want to map to the existing article of the same name.

NOTE
You can also set the status of the article, who can manage it in Zendesk, and
who will be able to view it in Zendesk.

11. Repeat steps 6-10 inclusive for each new section and new article. As you map the new sections
and articles to the existing sections and articles, you will see that the list shows less content.
Because the topics that were generated as a result of the import are now mapped to the
existing sections and articles, rather than creating new ones in addition to the existing ones.
Typically, after an import, you will set the Paligo content to map to the existing sections and
articles, so that there are no new sections or articles being created in Zendesk.
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NOTE
Use the blue checkboxes on the left of the list to choose which categories,
sections, and articles are going to be published.

12. Select Publish document to publish your content.

Paligo will then publish your content to Zendesk. From this point on, the topics in Paligo are
mapped to the sections and articles in Zendesk. So if you make a change to a topic in Paligo, and
publish to Zendesk, the matching article will also have the change.

To find out about using Zendesk Preflight for publishing to Zendesk, see Customize Paligo-to-
Zendesk Mapping [1566].

Import from Other Formats
Paligo can also import a number of proprietary formats indirectly, such as Adobe InDesign, Adobe
FrameMaker, Adobe Robohelp, Author-it and more. This means that you convert your content to a
different format first and then import that format into Paligo.

Preprocessing may be necessary depending on the output of the export from any of these tools,
some tweaks may be necessary to get the desired results. For instance, the HTML output from
InDesign may not always be structured enough and a pre-transformation and / or some manual
tweaks may be necessary.
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If conditional filtering has been used, this is not included in the XHTML export and needs to be
applied post-import. Alternatively, you can use an external service who can prepare your content
for Paligo import. This can result in a more robust import.

TIP
If you need help with this, please contact support. We can also recommend an
external service.

1. Export your content to XHTML, HTML, DITA or MS Word.
Use XHTML for Author-it and Adobe FrameMaker. If DITA is available, it is recommended, since
you will likely get a more proper topic structure that way. If you have used metadata (for
example for filtering) they may also be included.

2. Follow the instructions for the chosen export format to prepare the import. Each format has
its own preparations:

• Import XHTML by using Import from Confluence [1786] or Author-it XHTML (this format
only works for Author-it). For single files of XHTML, you can also use Import HTML (Single
File) [1784]

• Import HTML (Multi File) [1781] or Import HTML (Single File) [1784]

• Import from DITA [1787]

• Import from Microsoft Word [1793]

3. Use the Import Wizard [1771] to import the .zip file.
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Paligo Administration

You can use the Paligo administration features to set up the system-wide settings for your Paligo
instance.

These include:

• System settings such as consecutive branching, persistent image filenames and auto-logout
times, see System Settings [1817].

• Manage User Accounts [1833], User Groups [1850], Available Licenses [1834] and Purchase or
Upgrade Paligo Licenses [1831].

• Choose supported languages, see Language Management [1872].

• Change time zone, see Set Time Zone [1848].

• Set up integrations with other systems such as Zendesk, Salesforce and Phrase, see
Integrations [1380].

System Settings
Administrators can apply system-wide settings in the System Settings.

To access the System Settings:

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select the System settings tab. 

The system settings include:

• Consecutive branching
Use to control whether users can create branches from other branches. To learn about this
setting, see Manage Consecutive Branching [28].

• Persistent image filenames
Use to control whether image file names are based on the UUID of an image. This applies to
HTML and HTML5 outputs and you can learn about it in Control the Image Filenames [29].

• Output filename template
Use to set the filename format that Paligo uses by default when it generates PDF and ZIP files.
To learn about this setting, see Set the Default Filename for PDF and ZIP Files [32].

• Auto-logout
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Use to control how long Paligo will wait before it automatically logs out an inactive session. To
learn about this setting, see Set the Automatic Logout [29].

• Source language translation import
Use to control whether users have the choice to import a translation into the source language.
In most cases, this setting should be disabled and you can learn about it in Control Importing
Translations into the Source Language [30].

• Contributor editor beta
Use to control whether your Paligo instance uses the original Contributor editor or the updated
beta. You can choose to enable the beta or disable it across your entire Paligo instance, or you
can let users choose for themselves.

• Deleting content
Use to control whether users can delete content or whether they must first move it to the trash.
To learn about this setting, see Allow Users to Delete or Force them to Send to Trash [31].

Password Policy
The Password Policy is where you manage the settings for account lock, password rotation and
authentication.

• Account Lock is where you set how many login attempts before the account is locked and how
long it will be locked before the user can try again.

• Password Rotation determines if it is possible to reuse the password and if it must be renewed
according to a certain interval.

• Authentication is where you enable the use of two-factor authentication (2FA).

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select the Users tab. 

4. Select Password Policy.

5. Set the rules for account lock, password rotation and authentication.
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TIP
To restore the default settings, select the button Reset values in the lower
left corner.

6. Select Save.

Two-Factor Authentication (2FA)
Two-factor authentication, also known as 2FA, is a type of multi-factor authentication (MFA). It is a
more secure way of confirming a user's identity when they try to log in to Paligo as they will need
to provide:

• Username and password
This is something only the user should know.

• Verification code
This code is generated by an authentication application that runs on a device that the user has
with them, typically a smartphone, but it could be a computer or tablet.

This combination of something the user knows and something the user has with them is much more
secure than only using a username and password. For example, if you have 2FA enabled and
someone gets access to your password, they will not be able to log in. Because they would also
need access to your device (smartphone, tablet, etc.) so that they could get the verification code.
The password on its own is not enough to gain access.

To use two-factor authentication in Paligo:

1. Set Up Two-Factor Authentication [1820]

2. Log In using 2FA [1822].
If you do not have the verification code for logging in, you can use a backup code [1826]
instead.
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If there is a suspicious log-in attempt on your account, you should reset your password and
remove any unusual locations from your Trusted Locations for 2FA [1827].

Set Up Two-Factor Authentication
The process for setting up two-factor authentication (2FA) in Paligo varies, depending on whether
you have the Enterprise plan or one of our other plans.

• On the Enterprise plan, administrator users can enable 2FA on all accounts at once.

• On other plans, each user has to enable 2FA on their individual user account. Administrators can
only ask users to do this, they cannot do it for them.

When you have enabled two-factor authentication in Paligo, each user can associate their user
account with an authentication app, such as Authy (https://authy.com). The app will generate the
validation code they need for logging in.

Enable 2FA for All User Accounts
If your Paligo account is on the Enterprise plan, you can:

• enable two-factor authentication (2FA) on all user accounts at once. You can also force all users
to set up 2FA for their user accounts the next time they try to log in.

• enforce a password rotation policy.

NOTE
If your Paligo account is on a different plan, see Enable 2FA on Individual User
Accounts [1822].

To set up 2FA and password rotation policy for all user accounts:

1. Log in to Paligo as an administrator.

2. Select the avatar in the top right corner. 

3. Select Settings from the menu. 

4. Select the Users tab. 

5. Paligo displays the settings page, which shows the Users tab by default. It contains a list of
your Paligo users. A shield icon shows the 2FA status of the user accounts:

• Green icon - User has enabled 2FA and associated a verification app. These users are ready
to use 2FA.
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• Gray icon - User has enabled 2FA but has not associated their Paligo account with a
verification app.

• No icon - User has not enabled 2FA or associated Paligo with a verification app.

6. Select the Password policy button to display the password settings dialog.

7. In the Authentication section:

• Check Auto-enable two factor authentication box if you want Paligo to use two-factor
authentication (2FA) for all user accounts.

• Check Enforce setup box if you want users to set up 2FA for their user account the next
time they log in. To get access to Paligo, they will need to run an authentication app on their
smartphone or another device and associate it with Paligo. They will be unable to log into
Paligo until they have set up 2FA.
If you leave the checkbox unselected, users will be able to postpone setting up 2FA for their
user accounts. Until they set up 2FA, they will be able to log in with only their username and
password, which is less secure.

NOTE
You can only enforce 2FA setup if you also check the Auto-enable two
factor authentication setting.

8. Select Save.
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When your Paligo users next log in, they will be prompted to Log In using 2FA [1822].

Enable 2FA on Individual User Accounts
There are two ways to enable two-factor authentication (2FA) on user accounts.

• If you have the Enterprise plan, an administrator can enable 2FA on all user accounts at once,
see Enable 2FA for All User Accounts [1820]. Or you can let each user enable 2FA for themselves,
see below.

• Each user can enable 2FA on their own user account independently. If you do not have the
Enterprise plan, this is the only way to enable 2FA.

To enable 2FA on your own user account:

1. Select the avatar in the top right corner. 

2. Select My Profile. 

3. On the General Options tab, use the slider button to enable 2FA for your user account (the
background of the slider is blue when 2FA is enabled and white when it is disabled).

4. Select Save.

When you next log in to Paligo via this user account, you will be asked to provide a username
and password and also to set up two-factor authentication. To find out more, see Log In using
2FA [1822].

Log In using 2FA
The process for logging in to Paligo using two-factor authentication (2FA) varies depending on
whether you are logging in:

• For the first time since 2FA was enabled

• From a location that you have already verified for 2FA. This is a "trusted location".

• From a new location. Paligo regards the new location as suspicious, so you will need to verify
your login.
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The following sections describe the steps to follow for each of these scenarios.

• First-Time Login - 2FA [1823]

• Log In from a Trusted Location - 2FA [1825]

• Log In from a New Location - 2FA [1825]

First-Time Login - 2FA
If you are logging in to Paligo for the first time since two-factor authentication has been enabled:

1. Open a browser and go to the url for your Paligo instance. Paligo displays the log-in page.
Enter your log in details and select Sign In.

2. On the the Two factor authentication setup page, there is a QR code and a secret key.
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On your phone or other device, install an authentication app, such as Authy or Google
Authenticator, and add a new device. Choose to either scan a barcode or provide a key,
depending on what the app supports and what device you have.

• If you chose to scan a barcode, use your device's camera to scan the QR code.

• If you chose to provide a key, enter the secret key numbers and letters.
The authentication application then generates a verification code.

3. Enter the verification code in the field on the two factor authentication setup page and select
Continue.
If the verification code is correct, a success message is displayed and you are provided with a
code. You should make a record of this code as you can use it to log in if you have lost your
device [1826]. (The code can only be used once).

If the verification code is wrong, an error message appears. Please check the verification code
in your authentication app and enter it again. The verification code in your authentication app
will change automatically every 30 seconds.
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IMPORTANT
Make sure that your device shows the correct time. The verification code will
only work if the time on your device is correct.

4. Press Continue to log into Paligo.

When you successfully log in from a device, your location is added to your list of trusted locations.
When you log in from a trusted location, you can use your username and password without a
verification code, as Paligo knows you have verified that location before.

If you need to log in from a different location, Paligo will ask for your username, password, and
verification code. If you do not have access to the device that runs your authentication app, you
can use the backup code to log in [1826].

Log In from a Trusted Location - 2FA
If you are logging in from a trusted location, you only need to provide your Paligo username and
password. There is no need for a verification code.

A trusted location is a place where you have previously logged in to Paligo and provided a
verification code. Your user account has a list of trusted locations, and Paligo will let you log in
to those with only a username and password, unless any of the following are different:

• IP address or location

• Browser and browser version

• Operating system

If any of the above are different, Paligo will ask you to enter a verification code. You will need to
get the verification code from the authentication app on your smartphone, tablet, etc. If you do
not have access to the authentication app, you can use your backup code instead [1826].

NOTE
When you log in from a new location, Paligo sends you an email containing
details of the log in. If this looks suspicious, you should change your password
immediately.

Log In from a New Location - 2FA
If you have two-factor authentication enabled and you want to log in to Paligo from a new location,
you will need to provide:

• username

• password

• verification code.

This is because the location has not yet been verified and so is not in your list of trusted locations.

The verification code is generated by the authentication app you used to set up two-factor
authentication for your user account. Typically, it runs on your smartphone, tablet, or similar
device.
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If you do not have access to your authentication app, you can use your backup code
instead [1826].

Log In Using Backup Code
If you have two-factor authentication set up in Paligo, you need to provide a username, password,
and verification code each time you log in from a new location. You can also use a backup code
instead of the verification code and this is useful if you have lost the device that runs your
authentication app (typically a smartphone) or it has been stolen or destroyed.

Paligo emails the backup code to you when 2FA is first set up for your user account. So if you have
access to your email, you can get the backup code and use that instead of the verification code.

NOTE
If you do not have your backup code, an administrator can reset 2FA [1829] for
your user account. This completely removes the 2FA association between your
Paligo user account and the authentication app on your smartphone, tablet, etc.
You can then start the log-in process and set up a new 2FA association if required.

It is the responsibility of the administrator to make sure that each user is who
they claim to be and is authorized to access your Paligo instance. If you need to
verify the identity of an administrator user, please contact Paligo support. When
the administrator user is verified as genuine, Paligo support can reset the 2FA
association.

To log in using the backup code:

1. Browse to your Paligo instance and enter your username and password as usual.

2. When prompted to enter a validation code, select the "I don't have my device" hyperlink to
reveal a message and checkbox.

3. Select the checkbox to switch the verification code field to a backup code field.
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4. Enter your backup code. This is the backup code that Paligo emailed to you when you first set
up 2FA for your user account or the previous time you used a backup code to log in.
When you enter the correct backup code, you are logged in to Paligo. The backup code you
used is now invalid. Paligo emails a new backup code to you.

Trusted Locations for 2FA
When you successfully log in from a device, your location is added to your list of trusted locations.
When you log in from a trusted location, you can use your username and password without a
verification code, as Paligo knows you have verified that location before.

Your "trusted locations" are listed in your user profile. You can view them there, and if necessary,
you can remove them too. For example, if you think a login looks suspicious because it is from a
location you do not recognize, you can delete the location.

To see the "trusted locations" that are associated with your user account:

1. Select the avatar in the top right corner. 

2. Select My Profile. 

3. Select the Trusted Devices tab.
The Trusted Devices tab contains a list of the "trusted devices" that are associated with your
user account. For each device, Paligo keeps a record of the IP address, Internet Service
Provider (ISP), approximate Location, Browser and version, operating system (OS) and
version, and the time and date that you Verified the device.
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4. If you see a location that looks suspicious, you can delete it by selecting the Remove button
for that location. If you remove a location it is no longer trusted, so any login attempt from
that location will need to be verified.

Lost or Stolen Phone for 2FA
If the smartphone, tablet, or computer that runs your authentication app is lost or stolen, you are
not going to be able to provide the verification code for Paligo. But there is another way to log
in. Instead of using the verification code, you can use the backup code that Paligo emailed to you
when you first set up your Paligo account. The backup code can only be used once.

When you use a backup code, Paligo generates a new backup code to replace it, and sends that to
your email address.

To find out how to use the backup code, see Log In Using Backup Code [1826].

IMPORTANT
If you have lost the device that runs your authentication app, or you think
it has been stolen, ask an administrator user to reset your MFA (multi-factor
authentication) device [1829]. This will remove the association between Paligo and
your lost/stolen device. Should someone try to use the device to log in to Paligo,
they will be unable to generate an acceptable validation code.

Lost Backup Code
When you first set up two-factor authentication, Paligo sends you a backup code via email. You can
use the backup code to log in instead of using the verification code, but you can only use it once.
When you use a backup code, Paligo sends you a new one via email, and you can use that backup
code for future log-ins if needed.

If you do not have your backup code, an administrator can reset 2FA [1829] for your user
account. This completely removes the 2FA association between your Paligo user account and the
authentication app on your smartphone, tablet, etc. You can then start the log-in process and set
up a new 2FA association if required.

To find out more about setting up a new 2FA association between Paligo and your authentication
app, see Log In using 2FA [1822].

If you have found your backup code in your emails, you can use it to log in [1826].
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Suspicious Login Attempts 2FA
With two-factor authentication (2FA), Paligo can detect the approximate location of a device that is
used for a login attempt. It this location is different to where you have previously logged in, Paligo
sends you an email.

If you receive one of these emails, check the location and if you think it looks suspicious,
change your password immediately. You can also remove the location from Trusted Locations
for 2FA [1827].

NOTE
If you are unable to change your password, contact your Paligo administrator to
assist you to Reset Password [1842].

To change your password:

1. Select the avatar in the top right corner. 

2. Select My Profile. 

3. Select Logout.

4. On the Paligo login page, select the Forgot password link.

5. On the Password recovery page, enter your email address or username.

6. Select Reset password.

7. If your email address or username is registered in your Paligo instance, Paligo will send you an
email containing a link. When you select the link, you can reset your password and then log in.

NOTE
If you do not receive an email, please check your junk and spam folders.

Reset MFA Device for a User Account
Administrators can use the Reset MFA Device feature to remove the association between a user's
Paligo account and their verification app. When this association is removed, the user will need to
set up their account for two-factor authentication again, from scratch.

The most common reasons for resetting an MFA device are that a user has:

• Lost their smartphone (or other device that runs the authentication app) and has also lost their
backup code.

• Had their device(s) stolen and you want to prevent the device(s) from being used to access
Paligo.

• Had their location removed from the list of trusted locations.

To reset the association between a user account and a verification app:
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1. Log in to Paligo as an administrator.

2. Select the avatar in the top right corner. 

3. Select Settings from the menu. 

4. Select the Users tab. 

5. Select the dotted button ( ... ) to the right of the user account you want to reset.

6. Select Edit.

7. Select General Options tab,.

8. Select the Reset MFA Device button. A message is displayed to warn you that resetting will
mean that the user will need to set up a new device for two-factor authentication.
If you accept that, select Reset MFA Device to confirm.

Storage Space
Abstract

Find out about your Paligo instance's available storage space by using the Dashboard. It lets you
know how much storage space is being used, and how, and also how much space you have
available.

You can view the amount of storage space you have used/available on the Dashboard.

Select the Dashboard menu.
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The storage space is shown as a donut chart on the Dashboard, with colored segments showing
how the storage is being used.

We calculate the storage based on:

• Version files. These are generated automatically whenever you create a new version of content.

• Saved outputs

• Images stored in Paligo

• The size of the database.

Paligo uses a database rather than a file-based system, so storage space is rarely an issue. In most
cases, it would be time to upgrade your plan long before you reach any storage limits.

But if you want to be as efficient as possible with your storage, we recommend that you:

• Do not save your outputs in Paligo

• Use smaller image files

• Delete your saved revisions [1678] from time to time, especially for your largest publications.

Purchase or Upgrade Paligo Licenses
If you want to buy Paligo licenses for the first time and your trial has expired, you will be unable
to log in. To make a purchase, contact <sales@paligo.net>, so that we can set you up with an
account manager.

If you are an existing customer and you want to upgrade to another plan or buy additional
licenses:
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1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select Your license tab. 

4. Select Upgrade License button in the lower left corner.

5. Make sure that your Personal Information is correct and choose Your Order.

For your order, select the:

• Plan what you want to order.

• The number of full author licenses you want.
Full authors have access to the main Paligo editor, which has all of the advanced authoring
features.

• Preferred currency.

• Preferred payment schedule.

NOTE
The options for adding reviewer licenses and contributor licenses are on the
next page of the order wizard.

6. In the Order Overview, make sure that the details of your order are correct. If they are
wrong, you can use the Previous button at the bottom to return to the previous display.
You can also add more Reviewer Licenses and Contributor Licenses if you need those.
Reviewers can make comments on the content, but cannot change it. Contributors can edit
the content, but do not have access to the full Paligo editor, and so have a more limited
experience than full authors. To find out more, see Working in Review View [1278] and
Working in Edit View [1306].
When your order is correct, select Next.
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7. Select Finish.
Paligo will either invoice you for the next payment or it will be charged to the credit card
associated with your account. If you need to change the credit card or your payment details,
please contact customer support.

User Accounts
If you have a Paligo administrator user account, you can add new users, and edit or remove
existing users. Each user account has a certain user type, which affects what that user can use.
For example, a reviewer user can review content that is sent to them as an assignment, but they
cannot change the content and they do not have access to the full editor in Paligo.

When adding new users, you can either:

• Add each user individually

• Bulk import a CSV file that contains many user details. With the bulk import, Paligo imports
many users at once and creates a user account for each person listed in the CSV file. Bulk
imports are a convenient way of adding multiple users.

You can also create and manage user groups, which are collections of users. With these, you can
create teams of users or any collection of users that you need, and allocate assignments to them.
This is quicker than allocating an assignment to each member of a group individually. To find out
more, see User Groups [1850].

NOTE
You can choose which users are administrators. But be aware that administrators
have permissions to make global changes such as adding users, which may affect
the cost of licensing.
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User Types
When your Paligo user account is created, an Administrator assigns a user type to your account.
There are several different user types and they each provide different levels of access to Paligo
features. The table below shows which features are available to each user type.

If your user type does not have access to a feature that you need, contact an Administrator or IT
Manager. Only these users can change the user type of your account.

TIP
Reviewers and Contributors can only work on content either sent by a formal
assignment or Share Content (without assignments) [1347].

Available Licenses
Depending on what you want the user to access, there are different licenses and user types.
The User Group Syntax is used when you connect Paligo to Single Sign On (SSO) and SAML
Integration [1497].

User group syntax Description API access License type

paligo.admin Use this value if the user should belong to the group of
Paligo administrators.

Administrators are top-level users that have access to all
Paligo features, including those for adding and changing
user accounts, manage languages and integrations in the
Settings page [1817].

Full authoring experience. Can use the main Paligo
Editor [51] and its advanced features that are
needed for creating, publishing and managing content,
including content reuse, filtering and variables. Create
Assignments [1240], Manual Snapshot [1631] and change
to any workflow status in the Resource View [68].

Can use both Review View [41] and Edit View [42] to
change content, add content and Create Snapshots [1330]
in Contributor Editor [41].

Can access the Translation View [79] and translation
features. These include translation assignments, translation
import and export. Also the ability to change workflow
status to In translation and In translation review in the
Resource View [68].

Full access Admin license
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User group syntax Description API access License type

paligo.user Use this value if the user should belong to the group of
Paligo authors (standard users).

Authors (Standard users) are Paligo writers.

Full authoring experience. Can use the main Paligo
Editor [51] and its advanced features that are
needed for creating, publishing and managing content,
including content reuse, filtering and variables.Create
Assignments [1240], Manual Snapshot [1631] and change
to any workflow status in the Resource View [68].

Can use both Review View [41] and Edit View [42] to
change content, add content and Create Snapshots [1330]
in Contributor Editor [41].

Can access the Translation View [79] and translation
features. These include translation assignments, translation
import and export. Also the ability to change workflow
status to In translation and In translation review in the
Resource View [68].

Full access Author
license

paligo.contributor Use this value if the user should belong to the group of
Paligo contributors.

Contributors are users who, besides reviewing content,
may also need to add or edit content, such as engineers
or subject matter experts (SME).

They can use both the Edit View [42] and Review View [41].
Both Reviewers and Contributors can be sent Review
assignments, the difference is that Contributors can switch
to Edit View [42]. That enables them to edit and add
information and also to Create Snapshots [1330].

No access Contributor
license

paligo.reviewer Use this value if the user should belong to the group of
Paligo reviewers.

Reviewers are users who need to read content and leave
feedback comments on it, but do not change the content in
anyway. They have access to Review View [41].

No access Reviewer
license

paligo.itadmin Use this value if the user should belong to the group of
Paligo IT admins.

IT managers have access to the Settings page [1817] and
can create users. Can set up integrations, languages and
the general settings of the Paligo instance.

No access IT admin
license

IMPORTANT
Custom licenses are available on the Enterprise plan. These offer some ability to configure what
features users have access to. For more information about what options are available to you, contact
your account manager.

Access to API, depends on license configuration.

Add Users
At the top of the Users tab, available licenses are shown for each license type. Make sure that
you have enough licenses to create more user accounts. If not, see Purchase or Upgrade Paligo
Licenses [1831]. If you are still in trial, you will be able to add teammates without adding licenses.
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Switch view with the buttons.

You have the possibility to view the existing user accounts in a list or as icons. Below the license
types, you find the buttons to switch view. The existing users are by default, grouped by user
type, but in the List View, you can sort the columns alphabetically. Each group has different access
permissions, see User Types [1834].

To the left - The Icons View show available licenses with a plus icon. If you select it you add a new user.
To the right - The columns can be sorted alphabetically in the List View.

NOTE
The Settings page has an Icons View (as shown in the image above) and a List
View. In List View, the user accounts are shown in a list rather than as user
widgets.

To add a new user account in the List View:

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select the Users tab. 
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4. Scroll down to the bottom of the page and select Create. 

5. Select an image file to be the personal avatar. Optional

The New user dialog.

6. Enter a unique User name to be used during login along with a password.

TIP
To make it easy to remember, you can use the email address as the user
name.

7. Enter a Real name that will be displayed together with the personal avatar in Paligo. 

8. Enter the Email address that Paligo will use to notify the user.

CAUTION
Once the new user account is saved, an email will immediately be sent out
from Paligo, to prompt the user to log in and change the password.

For this reason, do not change the user name and email address, before the
user has logged in for the first time.

9. Select Usergroup from the menu.

10. Select Save.
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NOTE
The user will get a link with a temporary password by email. For security reasons,
the temporary password will only provide access to a "Choose new password"
display. The user must enter a new password and confirm it in order to log in to
Paligo.

New user accounts are grayed out until the user logs in for the first time.

Bulk Import Users
As an administrator you can save you a lot of time, by using the bulk import feature when creating
many user accounts at the same time. Instead of creating each user account individually, you
can create a CSV (Comma Separated Value) file that contains the basic user information and then
import that file into Paligo. Paligo will then automatically create a user account for each user listed
in the CSV file.

You use any application that supports saving as .csv to create the CSV file. If you for example
want to create user accounts for both Authors and Contributors, you will need two CSV files, one
for each user type.

NOTE
New user accounts are grayed out until the user logs in for the first time.

To bulk import users in the Icons View:

1. Create a CSV file for each user type that you want to import.

2. Add the user details in this format: username, email address, full name in the CSV file,
like this:

jamessmith,james@smith.com,James Smith
frankjohnson,frank@johnson.com,Frank Johnson
janemurphy,jane@murphy.com,Jane Murphy

TIP
For the username you could instead use the email address there as well, as
it's a simple way to make sure the username is unique.

3. Select the avatar in the top right corner. 

4. Select Settings from the menu. 

5. Select the Users tab. 
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6. Select Bulk Import Users for the user group that you want to create new accounts for.

NOTE
In the List View, the Bulk Import Users option is located at the bottom of
the page.

7. Select User Group from the menu, to choose the user type for the import.

8. Use Select file to choose the CSV file that you want to import.

9. Select Upload.
Paligo imports the CSV file and creates a user account for each user defined in the file.

Paligo Documentation

1839



If the import is successful, a User Import Done dialog appears and you can download a log file of
the import.

10. Repeat this procedure for each user type.

TIP
When Paligo has created the user accounts, you can Edit Users [1840] and
Remove Users [1841] if needed.

Edit Users
As an administrator, you can update the user accounts by changing license type, email address,
username, real name, image and reset the password.

TIP
To reset a password, see Reset Password [1842].

To edit a user account in the Icons View:

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select the Users tab. 

4. Hover over the user you want to edit and select Edit user. 
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NOTE
In the List View, select the Dotted Menu (...) to the right of the user and
choose Edit.

5. Make the changes to the user account.

6. Select Save.

Remove Users
As an administrator, you can remove users that are no longer needed and free up the license.

To edit a user account in the Icons View:

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select the Users tab. 

4. Hover over the user you want to remove and select the Delete user. 
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The license will now be visible in the Available licenses field at the top of the Users tab.

TIP
If you are not planning to use the available license for another user:

1. Select the Your License tab. 

2. Scroll down.

3. Select the Upgrade license.

4. Reduce the number of licenses to the amount of users you need.

Reset Password
As an administrator, you can reset the password for a user that has forgotten the password or
needs to change it for some reason. The user will then receive an email that will invite them to
change their password.

To reset a user account in the Icons View:

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select the Users tab. 

4. Hover over the user you want to reset the password for and select Edit user. 
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NOTE
In the List View, select the Dotted Menu (...) to the right of the user and
choose Edit.

5. Select Reset password to send the user an email with a link to change the password.

My Profile
Each user account has an individual page, called My Profile that contains an image, contact details
used for the account, time zone information and preferences for notification updates.

The settings you make in My Profile are personal settings divided in four tabs:

• General - Settings for Avatar image, Local timezone , Interface theme and 2FA (Two factor
authentication). You can also updateName, Email and Change password. Learn more, see Two-
Factor Authentication (2FA) [1819].

• Notifications - Set how and what kind of Paligo notifications that you receive, see Set Paligo
Notifications [1845].

• Trusted locations - Shows all the locations you have accessed Paligo from, see Trusted
Locations for 2FA [1827].

• API keys - Are used to safely integrate applications with the Paligo API, see API Keys [1472].
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You can edit your profile and change the settings to meet your own requirements.

Display My Profile
To display My Profile:

1. Select the avatar in the top right corner. 

2. Select My Profile. 

Edit General Settings for My Profile
The General tab holds settings for Avatar image, Local timezone , Interface theme and 2FA (Two
factor authentication). You can also updateName, Email and Change password.

1. Select the avatar in the top right corner. 

2. Select My Profile. 

3. Select the General tab.

4. The following settings can be adjusted for your individual page:
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• Profile picture - Upload an image for your profile (avatar). You can use jpg, png, or gif
images. It is better to use a square image.

• Password - Select the Change password link and enter your Current password and the
New password in the change password dialog. You will need to enter the new password
in the Repeat password field too. If you encounter Suspicious Login Attempts 2FA [1829]
or not going to be able to provide the verification code for Paligo, see Log In Using Backup
Code [1826].

• 2 Factor Authentication - Use to enable or disable two factor authentication, which is an
extra level of security.
To find out more about this feature, see Two-Factor Authentication (2FA) [1819].

• Name - You can change the name shown together with your avatar image.

• Email - You can change the email address that is used for your Paligo user account.

• Local timezone - Choose the time zone for your Paligo instance, see Set Time Zone [1848].

• Interface theme - Select an interface theme (Ocean or Classic) from the menu, see Change
Interface Theme [1849].

5. Select Save.

Set Paligo Notifications
Paligo provides notifications about various "events" so that you can keep up-to-date with what's
happening on your Paligo instance. You can choose which notifications you will receive and
whether you will receive them via email, Slack or Microsoft Teams (or a combination of those).

NOTE
The checkboxes for Slack and other integrations are only available if those
integrations are set up on your Paligo instance.

1. Select the avatar in the top right corner. 
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2. Select My Profile. 

3. Select the Notifications tab.

4. If you have the Microsoft Teams integration set up, enter your Microsoft email address in the
Username field. This must match the email address that you use to log into your Microsoft
Teams.

5. In the Comments section, choose how you want to be notified about comments that are
made in reviews or contributions to topics.

• Comment mentions - For a notification when someone uses @ to mention you in a
comment.

• Comments on followed documents - For a notification when someone makes a comment
on a topic. This only applies when you have chosen to follow comments for a topic.
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NOTE
You "follow" comments by selecting All Comments for the Comment
Notifications in a review or contribution. To find out more, see Get
Notifications About Comments [1292].

• Notification frequency - Choose when you will be notified. Paligo can send a notification
immediately, daily, or weekly. Set the frequency to None if you do not want Paligo to
send comment notifications at all.

To receive the notifications, check the box for how you want to be notified. You can choose
Email, Slack, MS Teams, or a combination of those. Note that notifications to integrations are
are only used if you have the integration set up on your Paligo instance.
To stop receiving notifications, clear the box(es).

6. In the Followed Documents section, choose how you want to receive notifications when
another user makes changes to content that you follow. You can choose to receive an email
and/or a slack notification.

7. Choose how you want to receive Productions notifications.

Production notifications are for publishing events, for example, when content is published to
create an output, such as a PDF or HTML5 help center.
You can choose to receive notifications when a :

• Production failed

• Production published successfully (publication ready)
For each of these, you can choose whether Paligo contacts you via email, Slack, MS Teams, or
a combination of these.

8. Choose how you want to receive Document Share notifications.

You can choose to receive notifications when:

• Someone shares a document with you

• There is a reply relating to a shared document.
For each of these, you can choose whether Paligo contacts you via email, Slack, MS Teams, or
a combination of these.

9. Use the Assignments - issuer settings to control whether you are notified when assignments
that you create are started, finished, or responded to. You can also choose how Paligo should
notify you.
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10. Use the Assignments - assignee settings to control whether you are notified when another
user issues an assignment to you. You can choose to receive notifications when:

• An assignment has been allocated to you, where you are the assignee.

• A reminder has been sent to you to let you know you still have work to do on an assignment

• An assignment that you were supposed to work on has been canceled.
You can also choose how Paligo should notify you.

11. Select Save.

NOTE
To revert back to the default settings, select the Reset button at the bottom of the
tab.

Set Time Zone
You can set Paligo to use your local time zone. If you change the time zone, it only affects your
instance of Paligo. For other users, Paligo will continue to use whatever time zone settings they
have in place.

It is important that you provide the correct time zone information as the time will be used for
events in Paligo, such as the timescales for assignments.

To edit the time zone:

1. Select the avatar in the top right corner. 

2. Select My Profile. 

3. Select the General tab.

4. Select Local timezone from the menu to set the time zone you want Paligo to use.
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NOTE
To edit selected timezone, select X to the right. Select a new time zone from
the menu.

5. Select Save.

Change Interface Theme
Paligo uses themes to set the appearance of your Paligo instance, including the color scheme and
the borders. Currently, there are two themes available and you can use whichever one you prefer.

• Ocean which uses a blue color palette.

• Classic which uses a black and gray color palette.

To the left - Ocean To the right - Classic

To set your Paligo instance to use a different theme:

1. Select the avatar in the top right corner. 

2. Select My profile from the menu. 
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3. Select the General tab.

4. Choose an Interface theme from the menu.

5. Select Save.

User Groups
Abstract

What are user groups in Paligo and how can you use them to organize your users into teams?

With user groups, you can organize your Paligo users into teams, departments or any other kind of
collective that you need. The benefit of user groups is that they allow you to:

• Allocate an assignment to all members of a user group.

• Allocate permissions to all members of a user group.

This is much quicker than allocating assignments and permissions to each user individually. This
gives you more flexibility with assignments. For example, if some members are too busy or are
unavailable, other members can work on the review assignment instead. There is no need for you
to re-assign it to individual team members. You can choose whether:

• Everyone in the user group has to respond.

• Individual members of the user group can respond.

NOTE
With Paligo's permissions feature, you can set permissions on folders and
components. The permissions determine whether a user or user group can edit a
folder or component or can only view it. When permissions are assigned to a user
group, all members of that user group are given those permissions. Learn more,
see Permissions [1857].
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Group Types
Abstract

Learn about the two different types of groups in Paligo: Permission groups and Assignment
groups.

With groups, you can create collections of users. These are useful for allocating permissions and
assignments as you can assign them to a group rather than having to set them for each individual
user.

There are two different group types:Permission Groups [1851] and Assignment Groups [1851]. You
can create a group that is a permission group and an assignment group at the same time. You will
be able to use the same group to assign permissions and also to allocate assignments.

Permission Groups
Permission groups are for controlling access to a folder or component, such as a topic or
publication. By default, each new folder and component has no permission restrictions so all full
Paligo users can view and edit it. But you can set up permissions that restrict the access, so that:

• Only certain users can edit the folder or component

• Only members of a specific permission group can edit the folder or component.

For example, let's say that you have a folder named "Updates". You set permissions on it so
that only members of a permissions group called "senior tech" can edit it. When users log in to
Paligo, those that are a member of the "senior tech" group will be able to edit the content in
the "Updates" folder. Any users that are not a member of the "senior tech" group will be able to
view the content in the "Updates" folder, but will not be able to edit it. To learn how to create a
permission group, see Create a User Group [1851].

Assignment Groups
Assignment groups are for creating a collection of users so that you can allocate an assignment to
multiple users at once. This is quicker than selecting each individual assignee separately.

For example, let's say you are working on documentation that will need to be reviewed by
several developers, a product manager, and a customer success manager. You could create an
assignment group that contains all of those users. Then, when you have a topic for review, you
can create the assignment and allocate it to the assignment group. This is quicker than selecting
each recipient individually, especially if you will need to repeatedly assign different content reviews
to the same collection of people. To learn how to create an assignment group, see Create a User
Group [1851].

Create a User Group
Abstract

How to create or add a user group in Paligo

The following instruction shows how to create a user group.

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select Groups tab.
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4. Select Create.

Paligo displays the Create group dialog.

5. Enter a Name and Description for the user group. The name is required but the description is
optional.

6. Select Group type with the checkboxes:

• Assignment group - When you (or other users) create assignments, you will be able to
choose the group as an assignee. The assignment will be allocated to each member of the
group. This is a quicker and more convenient way of allocating an assignment to several
people at once.

• Permission group - Use to create a collection of users for use with the Permissions [1857]
feature. When you set permissions on folders or components (such as topics and
publications), you will be able to grant the permissions to the group. This is a quicker and
more convenient way of allocating edit permissions to several people at once.
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NOTE
You must check at least one of the boxes. It is possible to check both boxes
if the group is both types. To learn more about the assignment groups and
permission groups, see Group Types [1851].

7. Select the Users that will belong to this user group.
Either enter a user name or email address to get Paligo to find the matching person OR
select the field and choose the users from the list.

8. Select Save.

Add Users to a User Group
Abstract

How to add users to a user group that already exists in Paligo.

The following instruction show how to add users to an existing user group.

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select Groups tab.

4. Select Edit for the user group that you want to change.
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5. Select the Users that will belong to this user group.
Either enter a user name or email address to get Paligo to find the matching person OR select
the field and choose the users from the list.

6. Select Save.

Remove Users from a User Group
Abstract

How to delete a user from a user group in Paligo.

The following instruction show how to remove one or more users from a user group.

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select Groups tab.

4. Select Edit for the user group that you want to change.
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5. Select the X to remove a user from the user group.

Each user in the group has an X shown to the right of their name.

6. Select Save.

Delete a User Group
Abstract

How to delete a user group in Paligo.

The following instruction shows how to remove a user group that you no longer need. Deleting the
user group, only removes the user group from Paligo. It does not remove the users that were in
the group.

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select Groups tab.

4. Select Edit for the user group that you want to change.
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5. Select Delete in the lower left corner.

6. Select Confirm to remove the user group.

Assignments for User Groups
Abstract

Learn how to allocate assignments to a user group rather than individual users. This is how to
assign in bulk.

When you Create Assignments [1240], you can allocate it to a user group, individual users or a
combination of both. This can save you time if you need a review from:

• A group of people in the same user group, for example, all users in a product team

Paligo Documentation

1856



• Anyone from a particular group, for example, a review from any developer in the software
team.

To allocate an assignment to a user group:

1. Create Assignments [1240].

2. Select the user group from the Groups section on the Review assignment dialog.

3. Select Default settings in the lower left corner.

4. Choose when the assignment is recognized as being completed. Learn more, see Default
Settings for Assignments [1216].

5. Select OK.

Permissions
With the Permissions feature, you can restrict access to the editing features for folders and
components such as topics and publications. For example, you could set a publication and its
topics so that they can only be edited by specific users.

When permissions are in place:

• All Paligo authors can open and view a folder or component

• Only those Paligo authors with permission to edit can make changes, such as altering the text,
deleting a component, or moving it.

Typically, you would use permissions when want to prevent certain users from making changes.
For example, you could have some complex content that you only want senior, experienced
writers to work on. For that, you could give the senior writers permission to edit. Less experienced
junior writers would be able to view the content, but could not make changes to it.
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NOTE
The Permissions feature is available on the Enterprise plan.

TIP
If you are new to permissions, we recommend that you read How Permissions
Work [1866]. This explains how permissions affect folders, components, and
Paligo features such as content reuse, variables, and translations.

When you are ready to apply permissions to your own content, first consider
creating user groups [1851]. User groups can make it quicker and easier to set up
permissions for multiple users at once. Then you can Set Up Permissions [1859]
for your folders and components.

To learn how to disable permissions, see Remove Permissions [1862].

Lock Icon on Folder or Component
Abstract

What does the lock icon mean on a folder or component?

If you see the lock icon next to the name of a folder or a component (such as a topic or
publication), it means you need permission to edit.

• If you have permission to edit, you will be able to make changes to the folder/component or
delete it.

• If you do not have permissions, you will only be able to view the folder/component.

The lock icon is shown next to the name of the folder/component in the Content Manager ...

... and also next to the folder/component in the Resources view (shown when you select a folder).

Paligo will not allow you to make changes to a folder/component that you do not have permission
to edit. If you try that, Paligo presents an "Access restricted" notification advising you to request
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editing permissions from the author/owner. For example, here is the notification for a folder that a
user is unable to rename:

Message "Access Restricted"
Abstract

What does the access restricted message mean? Why is my access restricted?

If Paligo displays an "Access restricted" notification, it means you do not have the edit permission
for the folder or component that you are trying to change, move, or delete. This happens when
permissions have been set up for the folder/component, but you have not been given the
permission to edit, either as an individual user or as a member of a group.

If you think you should be able to edit the folder or component, you should contact the owner or
author and ask them to adjust the permissions.

NOTE
If the parent folder for the folder/component also has permissions, you will need
the edit permission for that folder too.

To learn more about permissions, see How Permissions Work [1866].

Set Up Permissions
Abstract

How to set up permissions in Paligo to restrict access to folders, publications, and topics.

Use the Permissions feature to control which groups and users can access the edit features for
a folder or component (topic, publication, etc.). You can access the Permissions feature from the
Content Manager.
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NOTE
To apply permissions to a group of users, you can either select each user
individually or you can choose a group. You can only choose a group if there
are user groups set up in your Paligo instance (see User Groups [1850]).

TIP
Before you set up your permissions, we recommend that you read How
Permissions Work [1866]. The information in that article explains how setting
permissions on groups will affect the components in the groups. It also explains
how permissions affect other features such as content reuse and branching.

1. In the Content Manager, find the folder or component that you want to restrict access to.
Select its options menu ( ... ) and then select Permissions.

Paligo displays the Permissions dialog.
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2. Make sure the top field is set to Everyone can view, only some can edit.

NOTE
To remove permissions from a folder/component, select the Everyone can
view and edit option.

3. In the second field, enter the name or email address of the user/group that needs access to
edit the folder/component. As you start to type, Paligo will find close matches from the Paligo
database for your instance. Select a group or user that needs to have the edit permission.

When you add users and groups, be aware that:

• Groups will give permission to every user that is a member of that group.

• Users will give permission to the selected user only.

NOTE
The person who is editing the folder/component permissions is the "owner"
and automatically has permission to edit.

4. Repeat step 3 to add more groups and users as required.

5. Select Save.

When you save, Paligo applies the permissions and a lock icon appears next to the folder/
component in the Content Manager.

The lock icon also appears in the Resource view (shown when you select a folder).
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NOTE
If you have restricted access to the edit features for a folder, those permissions
will also apply to the components inside the folder. It is possible to add further
restrictions by setting permissions on the components in the folder as well. But
any further permissions must be compliant with the permissions of the parent
folder, for example, you cannot give a user permission to edit a topic if that user
does not have permission to edit the folder that contains the topic.

To learn how the permissions work for folders and components, and also how they affect other
Paligo features, see How Permissions Work [1866].

Remove Permissions
Abstract

How to remove permissions so that users can access folders, publications, and topics again.

You can use the permissions feature to remove the edit permission from a user or group. This can
be useful if you only want a user/group to have

To remove the edit permission from a user or group:

1. In the Content Manager, find the folder or component that you want to restrict access to.
Select its options menu ( ... ) and then select Permissions.
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Paligo displays the Permissions dialog. It shows the users and groups that currently have
permission to edit the folder/component in a list at the bottom. (If the list is empty, there are
no permissions currently set).

2. Remove the permissions:
To remove all permissions, set the top field to Everyone can view and edit.
To remove edit permissions for a particular user or group, select the X icon to the right of the
user/group name in the list.

Paligo Documentation

1863



NOTE
You cannot remove the owner from the permissions.

3. Select Save.

If you removed all permissions, all Paligo authors will be able to view and edit the folder/
component.

If you removed the permissions for a group, the members of that group will be able to view the
folder/component, but not edit it.

If you removed the permissions for a user, the user will be able to view the folder/component, but
not edit it.

Restrict Folder Access
Abstract

How to restrict access to a folder so that a user or user group cannot edit the folder or its
contents.

With the permissions feature, you can restrict a user, or group of users, from being able to edit
a folder and the components inside the folder. But you cannot prevent users from being able to
view the folder or components.

To learn how to prevent users or groups from being able to edit a folder, see Set Up
Permissions [1859].

Restrict Component Access
Abstract

How to use permissions to stop a user or user group from being able to edit a topic or publication.

With the permissions feature, you can restrict a user, or group of users, from being able to edit a
component, such as a publication or topic. But you cannot prevent users from being able to view a
component.

To learn how to prevent users or groups from being able to edit a component, see Set Up
Permissions [1859].

Change Component Owner
Abstract

Learn how to change the owner of a component, such as a topic, so that a new owner can take
control of the permissions.

The user that creates a folder or component is the "owner" by default. Only owners and
administrators can control the permissions for a folder or component, so it is important that you
can change the owner if needed. For example, you may need to change the owner as the original
owner has left your organization.

To change the owner of a component, such as a publication or topic:

1. Log in as as administrator or the current owner of the component you want to change.
Only administrators and owners can change the ownership.

Paligo Documentation

1864



2. In the Content Manager, select the dotted menu ( ... ) for the component and then select Edit
and then Open structure.
Paligo displays the metadata panel for the component.

3. Use the Owner dropdown list to change the owner.

4. Select Update to apply the change.
The new owner can now change the permissions on the component.

Change Folder Owner
Abstract

Learn how to change the owner of a folder so that a new owner can take control of the
permissions.

The user that creates a folder or component is the "owner" by default. Only owners and
administrators can control the permissions for a folder or component, so it is important that you
can change the owner if needed. For example, you may need to change the owner as the original
owner has left your organization.

To change the owner of a folder:

1. Log in as as administrator or the current owner of the folder you want to change.
Only administrators and owners can change the ownership.

2. In the Content Manager, select the dotted menu ( ... ) for the folder and then select Metadata.
Paligo displays the metadata panel for the folder.
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3. Use the Owner dropdown list to change the owner.

4. Select Update to apply the change.
The new owner can now change the permissions on the folder.

How Permissions Work
Abstract

Paligo has a permissions feature for controlling access to content. Learn how it works in this
article.

With the Permissions feature, you can control which Paligo users can edit a folder, publication,
topic, or other similar component.

By default, all folders and components do not have any permissions set. This means all Paligo
authors can edit, move, and delete the folders/components.

If you apply permissions to a folder/component, you can set it so that all users can view the folder/
component, but only selected users can edit, move, and delete it. This is useful when you have
certain components that should only be worked on by particular users. For example, you might
have some topics that should only be worked on by authors with specific technical knowledge.

The following sections explain how permissions work on folders, components, and also how they
can affect various other Paligo features such as branching and translations. If you are going to use
permissions, we strongly recommend that you read these sections.

Permissions for Folders
By default, folders and components, such as topics and publications, do not have any permissions
in place. Any Paligo author can view them and edit them. By using the permissions feature, you
can restrict access to the editing features. When you restrict access to a folder, the permissions
also affect who can edit the items inside the folders.

The permissions are applied from the top down, in cascading order. When a user attempts to edit
a component, Paligo checks to see if the folder that contains the component has permissions:

• If yes, the user can only edit components inside the folder if they have both:

• Permission to edit the folder

• Permission to edit the component.

• If no, the user cannot edit the folder or the components inside it.
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The following sections explain how the permissions affect access in the various possible scenarios.

No Permissions Set
By default, when you add a new folder or a component such as a publication or topic, these items
have no permissions in place. This means that any Paligo author can edit them.

It works like this:

• Folder:
No permissions set.

• Items inside folder:
No permissions set.

Result:

Any Paligo author can edit the folder and the components inside the folder. There are no
permissions in place to restrict the folder or the components.

Permissions Set on Folder
If you apply permissions to a folder, those permissions apply to the folder and also the
components inside the folder.

To show how this works, we will use the name "Curtis" for the person who created the folder and
components (the "owner") and "Product Team" as the name of a group of users. This group has
members called "Dani", "Martin", and "Jo".

The permissions are set up like this:

• Folder:
The folder has these permissions in place:
Everyone can view, only some can edit.
Users with permission to edit: Curtis (owner), product team group.

• Components inside folder:
The components inside the folder do not have any permissions in place.

Result:

The only people that can edit the folder or any of the components inside it are Curtis (owner) and
the members of the product team. All other users will be able to view the folder and components,
but cannot edit them.
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Permissions Set on Folder and Components Inside Folder
You can apply permissions to a folder and then add additional permissions to the components
inside the folder.

But note that there is a cascading relationship between the permissions of the folder and
the permissions of the items inside it. The permissions for the items can only be a subset of
the permissions for the parent folder, you cannot apply completely different (and conflicting)
permissions.

To show how this works, we will use the name "Curtis" for the person who applies the permissions
(the "owner") and "Product Team" as the name of a group of users. This group has members called
"Dani", "Martin", and "Jo".

• Folder:
The folder has these permissions in place:
Everyone can view, only some can edit.
Users with permission to edit: Curtis (owner), product team group.

• Topic A inside folder:
Topic A has no permissions set. It inherits the permissions from the parent folder.

• Topic B inside folder:
Topic B has its own permissions set to:
Everyone can view, only some can edit.
Users with permission to edit: Curtis (owner), Dani.

• Topic C inside folder:
Topic C has no permissions set. It inherits the permissions from the parent folder.

Result:

Curtis (owner) and all of the members of the product team group can edit the folder, Topic A, and
Topic C.

Curtis (owner) and Dani can edit Topic B. The other members of the product team group cannot
edit Topic B. They have access to the folder, but are excluded from having access to Topic B by the
permissions set for Topic B.
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Notice how the restrictions are applied downwards (cascading). To edit an item in a folder, a user
must also have permission to edit the parent folder. (The only exception to this rule is if the parent
folder has no permissions set).

Permissions for Topics and Other Components
You can use permissions to restrict user access to editing features for components, such as
topics and publications. This can be useful when you have certain topics that should only be
worked on by particular people or groups of people. For example, let's say you have a topic about
thermodynamics and you have a writer named Jo who is a specialist in that subject. You could use
permissions to make sure that Jo is the only person who can edit the "thermodynamics" topic.

When you apply permissions to individual components, it is important to understand that
permissions are cascading. You can only give a component permissions that are a subset of the
permissions for the "parent" folder (the folder that contains the components).

• If the parent folder has no permissions set, you can apply any permissions to a component.

• If the parent folder has permissions in place, these affect the permissions you can use on "child"
components. You can only give users the edit permission for components if those users also
have the edit permission for the parent folder.

There is an example of how the folder and item permissions work in Permissions for
Folders [1866].

To learn how to apply permissions to a component, see Set Up Permissions [1859].

Permissions and Sub-Topics Added as Components
If you have topics that contain other topics as components, the permissions still apply. You can
only edit or delete the topics that you have permission to edit, irrespective of where those topics
are used.

For example, let's say you have a "Specifications" topic and it contains a "Battery Specifications"
topic as a component (so "Battery Specifications" is a subsection).
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Main topic "Specifications" (1) contains another topic "Battery Specifications" that is inserted as a
component (2).

You have permission to edit the "Specifications" topic, but not the "Battery Specifications" topic.
This means that you can:

• Open the "Specifications" topic and make changes to its content, but you cannot edit the
"Battery Specifications" section.

• Move the "Battery Specifications" section inside the "Specifications" topic, but you cannot delete
the "Battery Specifications" section.

• Open the "Battery Specifications" topic, but you cannot edit it.

Permissions and Reused Content
Content reuse is one of Paligo's most important features, so it is important to understand how
permissions may affect it. For the most part, you can only make changes to content that you have
permission to edit.

But there are two exceptions: reused text fragments and variables. With these, it is possible to
make changes to topics that you do not have permission to edit directly.

• Reused topics and other components
If you have permission to edit a topic, admonition, or another type of component, the changes
you make will affect that component wherever it is used.

• Reused publications
If you have permission to edit a publication, the changes you make will affect that publication
wherever it is used.

• Variables
The permissions feature is unavailable for variable sets. If you can edit a variable set, the
changes will affect the variables wherever they are used. This includes topics that you do not
have permission to edit.
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• Text fragments
If you have the edit permission for a topic that contains reused text fragments, you can make
changes to those fragments. These changes will affect the fragments wherever they are used,
including inside topics that you do not have permission to edit.
For example, let's say you edit a topic and it contains "Select Save" as a reused text fragment.
You change the fragment to "Click Store". When you save, that change will apply wherever the
fragment is used, including inside any topics that you do not have permission to edit.

To learn about the various types of content reuse, see: Content Reuse [1098].

Permissions and Branches
You can create a branch of a publication or topic even if you do not have the Edit permission. Once
you have created a branch, that branch is regarded as new content and so has no permissions in
place.

With a branch, you can edit most of the content without affecting the original version. This is
because most of the text content in a branch is given a new ID, so it is unique and separate
to the original version of the same text. But there is one exception — reused text fragments. If
the original version contained reused text fragments then the branch will also contain the same
reused text fragments. If you change those, the changes you make will affect the text fragments
wherever they are used.

To merge a branch back into the original version (the source of the branch), you need to have the
Edit permission for the original version. If you do not have the Edit permission, the merge option
is unavailable. This is to prevent users from being able to make changes to topics that they should
not be able to edit.

To learn about using branches, see Branching [1638].

Permissions and Copies
Users that do not have permission to edit a folder, topic, or publication can still view those items
and make copies of them. For each copy, Paligo will:

• Give the copied folder, topic or publication a new ID

• Give the forks in a copied publication new IDs

• Keep any reused text fragments from the original version so that they are reused in the copy as
well

• Create copies of any content that was not reused in the original. These copies will all get new IDs
so that they are unique.

The copy is completely separate to the original, with the exception of any reused content. To learn
more about copies, see Copy a Topic [136] and Copy a Publication [105].

Permissions and Workflow
The permissions feature affects your Paligo users' ability to change the workflow status of topics.

If a user has permission to edit a publication or topic, they can change the status, for example,
change a topic from "Work in Progress" to "In Review".

If a user does not have permission to edit, they cannot change the workflow status.

To learn about workflow status, see Workflow Status [1209].
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Permissions and Imports/Exports
The permissions feature can affect whether a user can export Paligo content and also import
external content into Paligo. Access to the import feature is dependent on whether you have the
edit permission:

• If a user has the edit permission for a folder, publication, topic, etc., they can use both the
export and import feature

• If a user does not have the edit permission, they can use the export feature, but they cannot
import. This is because imports could change the content in Paligo.

To learn how to apply permissions, see Set Up Permissions [1859].

To learn how to import and export content, see Use the Import Wizard [1771] and Export and
Backup to XML [1778].

Permissions and Translations
If you prevent a user or group from being able to edit a component (publication, topic,
admonition, etc.), they will still be able to access most of the translation features for that
component. For example, they will still be able to:

A user who does not have the edit permission for a publication or topic can:

• View the topic or publication

• Create an assignment, including a translation assignment, for the topic or publication

• Export the topic or publication.

But they cannot:

• Translate content (using Paligo's built-in translation editor)

• Add a language to a component.

If Paligo displays this message:

If you try to change languages or make changes to something that you do not have the permission
to edit, Paligo displays this message:

Some documents cannot be updated

Below the message, Paligo displays a list of the documents you cannot edit due to your
permissions. To change the permissions (see Set Up Permissions [1859]).

To learn more about translating Paligo content, see Translation Management [1683].

Language Management
To publish content in multiple languages, you first need to activate and enable the languages in
your Paligo instance. Once the languages are available they have to be added to your publications
and topics.

When you make a language available, it can be:

• Selected when you Create a Topic [131] or Create a Publication [96]. If you want to switch images
depending on the language used, see Translate Images [1736].

• Added to existing content, see Add a Language to a Publication or Topic [1877].

• Selected during the Publishing Process [1068].
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TIP
To use different dialects of a language, see Create Additional Languages [1874].

Activate Languages
To enable or disable a language, it must first be activated to appear in the Languages tab.
The instruction below shows how the administrator makes a language available in your Paligo
instance.

We strongly recommend that you activate each language dialect because they have different
expressions and spelling. For example, if you are going to translate to American English (en-us)
and British English (en-gb), you have to activate both dialects as these are two different versions of
the same language. Otherwise, you will only have a generic English translation of your content.

Once a language is activated, you need to add it to your publications and topics to be able to use it
with your content, see Add a Language to a Publication or Topic [1877]

TIP
If you have a requirement to use four-letter language codes from your
translation provider requires it, you can change the default language code by
clicking on the language to edit it, see Create Additional Languages [1874].

For example, you can have a Chinese (simplified) language with ZH-CHS and a
Chinese (traditional) with ZH-CHT.

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select the Languages tab. 

The languages tab shows all of the languages that are currently activated for your instance.

4. Select Activate language in the upper right corner. 

5. Select the language from the list (or type the characters in the search).
If you do find the language or dialect that you want to activate, you can create it, see Create
Additional Languages [1874].
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6. Select Activate to add it to the Languages tab.

TIP
To be able to use the new language, see Enable or Disable a Language [1876] and
Add a Language to a Publication or Topic [1877].

Create Additional Languages
Paligo has a range of available languages that you can activate as required. If you need a language
or a dialect that is not included in the menu, you can add it manually, although these would need
to comply with the ISO language codes (two-letter or four-letter codes).

To the left - a two-letter code. To the right - a four-letter code.

By default, Paligo uses a two-letter code for the language (shown in the top-right corner of the
language box). To use a four-letter code, you have to create an additional language. Four-letter
codes are used to distinguish different dialects of a language.

Four-letter codes are used to distinguish different dialects of a language. Above are two dialects of
Chinese.
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NOTE
Paligo strongly recommends that you add or activate a language for every dialect
that you need for your content.

If you are going to translate to American English and British English, then you
should create and activate English-US (en-us) and English-GB (en-gb), as these
are two different dialects of the same language. Otherwise, you will only have a
generic English with one translation for it.

To create an additional language:

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select the Languages tab.

4. Select Activate language in the upper right corner. 

5. Select Create New in the lower left corner.

6. Enter a Language name that will be visible in the Paligo interface.

7. Enter the Language name (native).
For example, if you are adding en-gb, you could enter British English.

8. Enter the Language code that matches the language code used in your Translation Memory
System.
There are many online resources for finding ISO codes, so we recommend that you use a
search engine to find the code you need or ask your translation agency.
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9. Define if the Language is right-to-left with the checkbox.

• Check the box if the new language or dialect is a right-to-left language, such as Hebrew or
Arabic.

• Clear the box if the new language or dialect is a left-to-right language, such as British
English.

10. Enter an Alternative language code if your translation provider requires the use of another
code than the entered language code.
For example, if you have entered a two-letter code, but the translation provider wants you
to use a four-letter code. Paligo does not recommend the use of alternative language codes.
Instead, use the four-letter code as language code.

11. Select Insert to add it to the Languages tab.
The next step is to enable it, see Enable or Disable a Language [1876].

Enable or Disable a Language
To control which languages are available for use, you can enable or disable each language as
required. If the language you want to enable is not available in the Languages tab, see Activate
Languages [1873].

You can deactivate any languages that are not being used in your content. This is just a matter of
preference, there is no requirement to deactivate unused languages. If you want to use it in the
future, you need to re-activate it, see Activate Languages [1873].

IMPORTANT
Paligo will not allow you to deactivate a language that is being used in your
content. If you try to do this, Paligo displays an error message.

To learn how to remove a language from your content, see Remove a Language
from a Publication or Topic [1878].

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select the Languages tab. 

The languages tab shows all of the languages that are currently activated for your instance.

4. Use the slider to activate or deactivate any of the available languages.
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NOTE
You cannot deselect your default language or any other language that has
already been used for writing content in your topics.

Add a Language to a Publication or Topic
When you first create a publication or topic, you can choose what languages it should have. If you
later decide that you need other languages too, you can add them.

When you edit a topic that has translations, there is an icon for each language in the top right
corner. Select the icon to view the translation. If there are too many languages to show, an arrow
icon is included, and you can select it to display a list of the other languages. You do not translate
the content in the different language views of a topic. Those views are just for viewing the
translations. To translate, you either send the topic to a translation agency as part of a translation
package or use Paligo's built-in translation editor, see Working in Translation View [1752].

If the content has not yet been translated, it is shown in the source language, even in the different
language versions. Once it has been translated, the translated text is shown.

TIP
You can also add a language by Working in Translation View [1752].

To add a language:

1. Select the folder containing the content in Content Manager [34]. 
If the content is not in a folder, select the top-level folder Documents. 
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This will open the Resource View [68].

2. Select the Dotted menu ( ... ) for the publication or topic that you want to have extra
languages.

3. Select Translation and choose Add Languages. 

4. Check the box for each language that you want to add any of the languages that have been
added to your Paligo instance.
If you need a language that is not shown, an administrator will need to Language
Management [1872]. You will then be able to add it to your topics and publications.

NOTE
The Add languages recursively option is checked by default. This feature
automatically adds the languages to any reused or imported content that is
inside your topic or publication. For example, if you have a topic that contains
an informal topic, extra language is also added to the informal topic.

Paligo may need to change the release state of topics, informal topics, and
other components when it adds languages to them.

5. Select OK to confirm your choices.

The languages are added to the publication or topic.

Remove a Language from a Publication or Topic
To remove a language from a publication or topic:
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1. Select the folder containing the content in Content Manager [34]. 
If the content is not in a folder, select the top-level folder Documents. 

This will open the Resource View [68].

2. Select the Dotted menu ( ... ) for the publication or topic .

3. Select Translation and choose Remove Languages. 

4. Check the box for each language that you want to remove.
If there are languages that you want to keep, leave their boxes unchecked.

5. Check the Remove translations not used by other projects box if you want Paligo to:

• Remove the language from the selected publication or topic, but only for those text
elements that are used exclusively here.

• Leave the language in place for any text elements that are reused. These text elements
may still need the translation when used in other publications and topics.

6. Check the Remove languages recursively from linked and imported components box if
you want Paligo to:

• Remove the language from the selected publication or topic

• Remove the language from all reused content inside the publication or topic, including
content that is inserted as a component.

Source Language
By default, your Paligo instance is set to use one source language and the content will be marked
up with this language. This is usually English but can be set to a different language by customer
support. This means that all topics and publications are marked up as English content.

Content in other languages is then a translation of the source language. The source language
is also used for various other parts of the content, such as labels that are auto-generated (for
example for Admonitions [182]).
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Check the Source Language
To check the source language of your Paligo instance:

1. Select the avatar in the top right corner. 

2. Select Settings from the menu. 

3. Select the Languages tab. 

The languages tab shows all of the languages that are currently activated for your instance.

4. Look for the language that has the "default" label. This is the source language for your Paligo
instance.

Change the Source Language
To change the source language:

1. Select Help in the top menu and choose Get Support.

2. Create a Zendesk account (if you do not already have one).

3. Raise a ticket to let us know what language you want as source language.

Connect Integrations
You can connect Paligo to many different third-party tools, including help desks and translation
software. For information on how to set up these connections, see Integrations [1380].

WebDAV Access to your Paligo Instance Folders
With Web Distributed Authoring and Versioning (WebDAV), you can access the folders that are
used for your Paligo instance. Access via WebDAV is only available to customers on the Enterprise
plan and should only be used by people who have skills in XSLT and/or schematron.

You can use WebDAV to modify existing XSLT customizations that were built for you by Paligo. But
before you make changes, it is important that you have some training sessions from Paligo. Please
contact customer support for information about XSLT training.

The following sections explain how to access your Paligo instance via WebDAV using the built-in
features of Windows and iOS. There are alternative ways to connect via WebDAV, for example, you
can use a third-party client such as Cyberduck.
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NOTE
No matter what method you use to connect via WebDAV, the important thing
to note is that the URL for connecting needs to include "mount" before
paligoapp.com, for example, https://acme.mount.paligoapp.com.

Access your Instance via WebDAV on Mac
To access the folders in your Paligo instance using WebDAV on an Apple Mac computer:

1. Run Apple's Finder application on your computer.

2. Select Go in the menu at the top.

3. Select Connect to Server.

4. Enter the URL for connecting via webDAV:
<your paligo domain name>.mount.paligoapp.com
For example, https://acme.mount.paligoapp.com

NOTE
You have to include .mount in the URL, between your domain name and
paligoapp.com.

5. Select Connect.

6. Select Registered user and then enter the user name and password for your Paligo user
account.
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7. Select Connect.
If your log in credentials are correct and you have Paligo on the Enterprise plan, a window
appears showing you the folders for your Paligo instance.

The only folders you should use are:

• xsl - The xsl folder contains any customizations for your instance, and it also has a custom
folder which contains your layouts.

• schematron - If you use schematron to provide your own custom rules, you will need to
upload your schematron into the edit folder inside the schematron folder.

You can download files and upload files as needed, but we strongly recommend that you do
not edit files in WebDAV as this can result in problems with permissions. Instead, you should
use WebDAV to download a file, edit the file locally, and then use WebDAV to upload the
changes.

NOTE
Paligo will only validate against the rules in your Schematron file if you enable
Schematron validation for your topics (see Turn Validation On or Off [629]).

Access your Instance via WebDAV on Windows
To access the folders in your Paligo instance using WebDAV on a Windows computer:
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1. Run Windows File Explorer.

2. Right-click on This PC and select Add a network location.

A setup wizard appears. Select Next to start.

3. Select Choose a custom network location and then Next.

4. Enter the URL for connecting via webDAV and then select Next. The URL has to include
"mount" and be in this format:
<your paligo domain name>.mount.paligoapp.com
For example, https://acme.mount.paligoapp.com

NOTE
You have to include .mount in the URL, between your domain name and
paligoapp.com.
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5. Enter the Username and Password for your Paligo user account and then select OK.

6. Give the network connection a name and choose whether you want to add a desktop shortcut
for it. Select Next and then Finish.
If your log in credentials are correct and you have Paligo on the Enterprise plan, a window
appears showing you the folders for your Paligo instance.
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The only folders you should use are:

• xsl - The xsl folder contains any customizations for your instance, and it also has a custom
folder which contains your layouts.

• schematron - If you use schematron to provide your own custom rules, you will need to
upload your schematron into the edit folder inside the schematron folder.

You can download files and upload files as needed, but we strongly recommend that you do
not edit files in WebDAV as this can result in problems with permissions. Instead, you should
use WebDAV to download a file, edit the file locally, and then use WebDAV to upload the
changes.

NOTE
Paligo will only validate against the rules in your Schematron file if you enable
Schematron validation for your topics (see Turn Validation On or Off [629]).
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Basic Element Reference

This is a reference to the most commonly used elements in Paligo. Because Paligo is quite closely
based on DocBook, that documentation is referred to at times and can certainly be useful. But this
section will describe specifically how some of the most common elements are used in Paligo.

The biggest difference between the Paligo content model and standard DocBook is that Paligo
is "topic-based", which means that publications are assembled from small chunks of content
("topics"), rather than built as long "books".

In order to do this, and still stay as close to the DocBook standard as possible, a subset has been
used that easily maps to the topic-based model. Therefore, a "publication" in Paligo is mapped
to the DocBook article element, and a "topic" in Paligo is mapped to the DocBook section
element.

Only elements in DocBook lower than article are used in Paligo, so book, part and set are not
used.

NOTE
It is usually not necessary to know all about elements to use Paligo. It is meant as
a reference and for delving deeper.

This reference is in no way meant to be comprehensive. It primarily describes
some of the most common elements, as well as some that specifically differ
from the DocBook content model, and it is meant to provide a more digestible
reference.

For more extensive descriptions and the full list of elements, see the full
reference.

Plain XML versus Paligo Editor
XML elements and attributes are what make up the structure of a document (topic). There are
block elements and inline elements. The examples below shows the same topic is visualized in
both plain XML and in the Paligo Editor. This will show how user-friendly it is to work in the Paligo
Editor compared to plain XML.

Example 89. The topic in plain XML:

<?xml version="1.0"?> 
<section>
  <title>The Engine</title>
  <figure>

    <title>Specifications</title> 
    <mediaobject>
      <imageobject>
        <imagedata fileref="UUID-905a1510-2f25-2dc4-4de0-7fc0e26087ff"/>
      </imageobject>
      <caption>
        <para>The vehicle is powered by a 3.2-litre straight-six engine \
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(X55C33). The performance figures are:</para>
        <itemizedlist>

          <listitem xinfo:product="ACME 2000;ACME 5000"> 
            <para>269 lb·ft (365 N·m) of torque at 4,900 rpm, 8,000 rpm
              redline.</para>
          </listitem>
          <listitem xinfo:product="ACME 1500">
            <para>269 lb·ft (365 N·m) of torque at 4,900 rpm, <emphasis \

role="bold">9,000 rpm redline.</emphasis> 
            </para>
          </listitem>
        </itemizedlist>
      </caption>
    </mediaobject>
  </figure>
</section>

The "root" element in a topic is called section. In Paligo, a topic is a section that is a
component of its own, not just an element in a document.

NOTE
This is one of the few components in Paligo that does not have the same
name for the element as it does in the XML structure.

title and figure are examples here of "block elements". I.e they are like blocks in a nested
structure. As the image shows, the figure encloses (nests) a lot of other elements.

TIP
Because of the nested "tree" structure of XML, one often speaks of
"parents" and "children". This can be good to know, to understand how
structured authoring works. So for instance, if a figure has a title and an
image (mediaobject). The title and mediaobject are "children" and the
figure is the "parent". 

An attribute is a marker on an element to give it additional functionality. In this case the
attribute @xinfo:product marks up the element in order to filter it, i.e to indicate that each
listitem can be published with variants for different product families.
The emphasis element is an example of an "inline element". It is just an element that only
encloses a word or phrase inline inside text.

Example 90. The topic in the Paligo Editor [51]:

Now take a look at the same topic in the Paligo editor. It shows the same structure, but here in a
more user-friendly view:
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1. The Element Structure Menu shows the nesting structure of the document. Because we
have placed the cursor in the figure element, the Structure Menu shows the nesting to be
section > figure.

2. In the Paligo editor, when you place the cursor in a block element, the editor will automatically
highlight the enclosing "box" of that element. This shows that the caption and the list are
part of (enclosed in) the figure element.

3. The inline element is shown as bold, and inserted the familiar way with the toolbar or
keyboard shortcut.

4. The filter attributes show as filter icons (the "funnel" icon). When you have the cursor inside
any element, if it has any attributes set, it will show in the Element attributes panel to the
right in the editor:

NOTE
This section provides a reference to some of the most commonly used elements.
There are many more available and you can find information about them in the
DocBook element reference. Almost all DocBook elements are available, so those
descriptions will apply as well, except for the book, part, and set that are not
used in Paligo.
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Plain XML versus Paligo Editor
XML elements and attributes are what make up the structure of a document (topic). There are
block elements and inline elements. The examples below shows the same topic is visualized in
both plain XML and in the Paligo Editor. This will show how user-friendly it is to work in the Paligo
Editor compared to plain XML.

Example 91. The topic in plain XML:

<?xml version="1.0"?> 
<section>
  <title>The Engine</title>
  <figure>

    <title>Specifications</title> 
    <mediaobject>
      <imageobject>
        <imagedata fileref="UUID-905a1510-2f25-2dc4-4de0-7fc0e26087ff"/>
      </imageobject>
      <caption>
        <para>The vehicle is powered by a 3.2-litre straight-six engine \
(X55C33). The performance figures are:</para>
        <itemizedlist>

          <listitem xinfo:product="ACME 2000;ACME 5000"> 
            <para>269 lb·ft (365 N·m) of torque at 4,900 rpm, 8,000 rpm
              redline.</para>
          </listitem>
          <listitem xinfo:product="ACME 1500">
            <para>269 lb·ft (365 N·m) of torque at 4,900 rpm, <emphasis \

role="bold">9,000 rpm redline.</emphasis> 
            </para>
          </listitem>
        </itemizedlist>
      </caption>
    </mediaobject>
  </figure>
</section>

The "root" element in a topic is called section. In Paligo, a topic is a section that is a
component of its own, not just an element in a document.

NOTE
This is one of the few components in Paligo that does not have the same
name for the element as it does in the XML structure.

title and figure are examples here of "block elements". I.e they are like blocks in a nested
structure. As the image shows, the figure encloses (nests) a lot of other elements.
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TIP
Because of the nested "tree" structure of XML, one often speaks of
"parents" and "children". This can be good to know, to understand how
structured authoring works. So for instance, if a figure has a title and an
image (mediaobject). The title and mediaobject are "children" and the
figure is the "parent". 

An attribute is a marker on an element to give it additional functionality. In this case the
attribute @xinfo:product marks up the element in order to filter it, i.e to indicate that each
listitem can be published with variants for different product families.
The emphasis element is an example of an "inline element". It is just an element that only
encloses a word or phrase inline inside text.

Example 92. The topic in the Paligo Editor [51]:

Now take a look at the same topic in the Paligo editor. It shows the same structure, but here in a
more user-friendly view:

1. The Element Structure Menu shows the nesting structure of the document. Because we
have placed the cursor in the figure element, the Structure Menu shows the nesting to be
section > figure.

2. In the Paligo editor, when you place the cursor in a block element, the editor will automatically
highlight the enclosing "box" of that element. This shows that the caption and the list are
part of (enclosed in) the figure element.

3. The inline element is shown as bold, and inserted the familiar way with the toolbar or
keyboard shortcut.

4. The filter attributes show as filter icons (the "funnel" icon). When you have the cursor inside
any element, if it has any attributes set, it will show in the Element attributes panel to the
right in the editor:
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NOTE
This section provides a reference to some of the most commonly used elements.
There are many more available and you can find information about them in the
DocBook element reference. Almost all DocBook elements are available, so those
descriptions will apply as well, except for the book, part, and set that are not
used in Paligo.

Common General Elements
The following are some common general elements and some of them have partly different usage
than in their counterparts in DocBook.

NOTE
For safety messages, see Admonitions [182].

Publication (article)
In Paligo, the article element has been adapted to be used as the Publication component. It is
meant mainly to be the structure for reusing topics.

Although slightly differently used in Paligo than in DocBook, it has not been customized to have
the name "publication" as an element, in order to stay as close to the open standard DocBook
content model as possible.

Although a publication/article can have a lot of child elements in DocBook, in Paligo there should
mainly be metadata in the publication. Usually, these metadata should be in an info element.
Note that it has no actual content as child elements. All that is handled in the Structure View in
Paligo instead.

Example 93. Publication/article

<article>
    <info>
        <title>My Publication</title>
        <author>
            <orgname>Organization Name</orgname>
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            <address>
                <city>City</city>
                <street>Street</street>
                <postcode>000000</postcode>
                <country>Country</country>
            </address>
            <email>user@example.com</email>
        </author>
    </info>
</article>

Topic (section)
In Paligo, the section element has been adapted to be used as the Topic component. It is meant
mainly to be the structure for reusing topics.

Although slightly differently used in Paligo than in DocBook, it has not been customized to have
the name "topic" as an element. So the root element in a topic is still called section, in order to
stay as close to the open standard DocBook content model as possible.

Topics (sections) are nested in a publication, and can have unbounded depth. Although nesting
topics/sections in a publication is the most common, and the recommended practice to follow the
topic-based authoring concept, it is also possible to use the section element directly inside a topic
as a child section.

Example 94. Topic/section

<section>
  <title>The Engine</title>
  <figure>
    <title>Specifications</title>
    <mediaobject>
      <imageobject>
        <imagedata fileref="UUID-f8b27f8c-70ba-83d6-9223-3c1354c98047" \
width="400" xinfo:image="UUID-f8b27f8c-70ba-83d6-9223-3c1354c98047"/>
      </imageobject>
      <caption>
        <para>The vehicle is powered by a 3.2-litre straight-six engine \
(X55C33). The performance figures are:</para>
        <itemizedlist>
          <listitem>
            <para>3,246 cc displacements</para>
          </listitem>
          <listitem>
            <para>343 horsepower (256 kW) at 7,900 rpm</para>
          </listitem>
          <listitem xinfo:product="ACME 2000;ACME 5000">
            <para>269 lb·ft (365 N·m) of torque at 4,900 rpm, 8,000 rpm
              redline.</para>
          </listitem>
          <listitem xinfo:product="ACME 1500">
            <para>269 lb·ft (365 N·m) of torque at 4,900 rpm, 9,000 rpm \
redline.</para>
          </listitem>
          <listitem>
            <para>Acceleration to 60 mph (96 km/h) comes in 4.8 seconds. \
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(0-62 mph
              / 100 km/h is 5.0) and top speed is limited electronically \
to 156 mph (251
              km/h)</para>
          </listitem>
          <listitem>
            <para>Output per litre is 95 bhp (80 kW; 108 PS), and power-to-
weight
              ratio is 9.9 lb/bhp.</para>
          </listitem>
        </itemizedlist>
      </caption>
    </mediaobject>
  </figure>
</section>

Paragraph (para)
A para is a simply a paragraph, probably one of the most used elements.

If you'd like to have a paragraph with a title, the formalpara is also available.

Paragraphs in Paligo differ from DocBook in that they may only contain inline elements. If you
add a block element inside a para, it will validate, but as soon as you save Paligo will extract the
block element from the para placing it outside the para. This is to optimize the structure for more
functionality regarding reuse relations as well as translation.

Bridgehead
A free-floating heading, such as a lower-level sub heading.

Some documents, usually legacy documents, use sub headings that are not tied to the normal
sectional hierarchy. Usually in topic-based authoring, you should not create sub headings, but
instead let these be automatically created by the nesting structure of the topics in the publication,
or simply use section elements within a topic.

If, however, in exceptional cases you need to add sub headings that break the natural heading
hierarchy nonetheless, such headings may be represented in with the bridgehead element. You
can then use the @renderas (read "render as") to set which level heading you want it to represent
(with values like "sect1", "sect2", etc).

Sidebar
The DocBook element Sidebar has been specialized in Paligo to serve both as a separate
component and as a general-purpose reuse wrapper element.

When you add a sidebar as an element in a topic, it works just like in DocBook and becomes
a floating sidebar, see Level Text and Image [1038] and Flow Text Around an Image [1041]. It is
possible to style in the Element Attributes Panel [55].

When created as an Informal Topic, it will be reusable as a component, but not possible to style,
see Create an Informal Topic [1109]. Its child elements will appear in output just as if they had
been used separately.

Image and Video Elements
There are several types of image elements in Paligo:
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• mediaobject: the most common element for images. It is both used standalone, as an
image where there is no need for a title, e.g in steps. But also for videos, then containing a
videoobject element.
The easiest way to add a video is by using the toolbar icon.

• inlinemediaobject: This must always be used inline in text. It is used mainly for small icons
and the like. If using the keyboard shortcut for images when inside text, you will automatically
get an inlinemediaobject.

• figure: If you need more infrastructure around your image, such as a title, and perhaps a list or
a table that are closely connected to the image, you can use a figure, which will then wrap the
mediaobject.

• informalfigure: This is the same as a figure, but with no title.

TIP
You can switch between these easily, by toggling the title with the Header icon

in the toolbar, or use the keyboard shortcut Alt  + Shift  + H .

Example 95. A figure in plain XML

<figure><title>The Pythagorean Theorem Illustrated</title>
<mediaobject>
  <imageobject>
    <imagedata fileref="figures/pythag.png"/>
  </imageobject>
</mediaobject>
<caption><para>An illustration of the Pythagorean Theorem</para></caption>
</figure>

TIP
For full descriptions of these elements,
see mediaobject, inlinemediaobject, figure, informalfigure.

Available Lists
There are several different types of lists in Paligo. Some of the most common are:

• itemizedlist: A list in which each entry is marked with a bullet or similar symbol. An
itemizedlist is also often called "bullet list" or "unordered list". In an itemizedlist, each
item of the list is marked with a bullet, dash, or other symbol. Can be used in most block
elements (parents). The main child element is listitem. At the top of an itemizedlist many
other elements can be used, however, as in an introduction to the itemizedlist, including an
(optional) title, para and more.

<itemizedlist>
    <para>List of tools:</para>
    <listitem>
        <para>Hammer</para>
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    </listitem>
    <listitem>
        <para>Screwdriver</para>
    </listitem>
    <listitem>
        <para>Drill</para>
    </listitem>
</itemizedlist>

• orderedlist: A numbered list. This should usually be distinguished from a procedure, which
is used for instructions / tasks. In an orderedlist, each member of the list is marked with a
numeral, letter or other sequential symbol (such as roman numerals). Can be used in most block
elements (parents). The main child element is listitem. At the top of an orderedlist many
other elements can be used, however, as in an introduction to the orderedlist, including an
(optional) title, para and more.

<orderedlist>
    <para>List of tools:</para>
    <listitem>
        <para>Hammer</para>
    </listitem>
    <listitem>
        <para>Screwdriver</para>
    </listitem>
    <listitem>
        <para>Drill</para>
    </listitem>
</orderedlist>

• procedure: A list of operations to be performed in a well-defined sequence. A procedure is
used to write an instruction or a task made up of steps (and possibly, substep)s. In most
cases it is recommended to use the procedure list type rather than a regular orderedlist for
instructions, as it provides several benefits to distinguish between them. There are no explicit
elements for pre- and post-conditions (sometimes called pre-requisites or post-requisites) in the
procedure element in Paligo, just as in DocBook.
The model is intentionally simpler, and such elements are avoided. (See this article for more
on this: There are no Prerequisites). Instead, they should be described as steps (check the
pre-conditions in the first step and the results in the last step). If still really desired, the task
element, provides some of this infrastructure, but there is little out-of-the-box styling support
for this and it may require a customization. The procedure element is most often used as
a direct child to section (i.e the root element of a topic). But it is also valid in many other
contexts, so you could for example have a procedure in a table cell, in an example, etc. See
the full list of parents here. The main child element is step. At the top of a procedure many
other elements can be used, however, as in an introduction to the procedure, including an
(optional) title, para and more.

<procedure>
    <title>An Example Procedure</title>
    <step>
        <para> A Step </para>
    </step>
    <step>
        <para> Another Step </para>
        <substeps>
            <step>
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                <para> Substeps can be nested indefinitely deep. </para>
            </step>
        </substeps>
    </step>
    <step>
        <para> A Final Step </para>
    </step>
</procedure>

• simplelist: a list without bullets or numbers. It also has some features like being able to
display it horizontally, in several columns, etc.

• variablelist: a list of terms and definitions.

• calloutlist: a list of callouts for code listings (programlisting and similar elements)

TIP
Learn more about Lists and Procedures [188].

Table and Table Attributes
The table type used in Paligo is very similar to an HTML table. You can have a table with or without
a title (caption). Without a title the element is called informaltable.

For the most part you do not have to set table attributes manually in the Element attributes
widget, as you can do it in the wizard when creating the table, or right-click on the table and
open the table properties. But when you do need to add or modify attributes, these are the most
common you should know about:

• @frame: Used to indicate whether there should be a border around the entire table. The most
common values are "void" means no border, and "border", which means border on all sides.

• @rules: Used to indicate whether there should be borders between rows and columns. The
most common values are "none" or "all".

• @tabstyle: Can be used to create several different table themes. Note that this requires a
customization of your stylesheets.

Example 96. A table in plain XML

<table width="100%">
    <caption>A table</caption>
    <thead>
      <tr>
        <th colspan="2">
          <para>Header spanning both columns</para>
        </th>
      </tr>
    </thead>
    <tbody>
      <tr>
        <td>
          <para>First cell</para>
        </td>
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        <td>
          <para>Second cell</para>
        </td>
      </tr>
    </tbody>
  </table>

TIP
For full descriptions of these elements, see table, informaltable.

Example Elements
There are two elements for inserting examples in Paligo: example and informalexample. Just
like figures and tables, the difference is in having a title or not. By default, an example will just like
a figure get a number and a label if it has a title. Example can contain most other block elements.

TIP
For more information see example and informalexample.

Software and Code Documentation Elements
Paligo inherits a very rich set of elements from DocBook for documenting software. This includes
elements for GUI components, as well as code snippets and the like. We'll describe some of the
most common here.

Code Elements
The two most commonly used are programlisting for code blocks and code for inline code
snippets inside a para or other textual element.

Code elements preserve line breaks and spacing to represent the code properly. For common
output formats like PDF, HTML/HTML5, syntax highlighting and indentation is also available, and
can be controlled in the Layout Editor. You can optionally specify the @language attribute for a
code snippet to specify the programming language represented.

Example 97. This is what the programlisting element looks like:

//This example is in itself using the programlisting element 
//to show the code below
public class Factorial
{
    public static void main(String[] args)
    {    final int NUM_FACTS = 100;
        for(int i = 0; i < NUM_FACTS; i++)
            System.out.println( i + "! is " + factorial(i));
    }
    
    public static int factorial(int n)
    {    int result = 1;
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        for(int i = 2; i <= n; i++)
            result *= i;
        return result;
    }
}

Example 98. This is what the code (inline) element looks like:

To show hidden files, type defaults write com.apple.finder AppleShowAllFiles TRUE in
the terminal.

TIP
There are several other code elements available, like screen, literallayout,
userinput and more. You can explore them in the DocBook documentation
following these links.

GUI Elements
There are many elements for describing GUI and other software related components as well.
These are just a few common examples:

• guilabel: an element generally recommended if you want to keep your markup of gui
components simple. Use this to mark up buttons, menus and the like.

• keycap: very useful for marking up keyboard shortcuts. If desired, it can also be wrapped in a
keycombo element to output the delimiter (like a "+" between keys).

• filename: for file names and paths.

• guimenu: if you want to be more granular in marking up your GUI components, you can
for example use elements like guimenu, and its sub elements. There are also more related
elements like guibutton, guiicon, etc. Using both guimenu and the other granular elements
can easily become quite complex though. So unless you have very good reason to be that
specific, the recommendation is to keep it simple and just distinguish GUI components with the
guilabel element.

TIP
There are many more similar elements available, and it's recommended you
explore the full reference if you have a need for a very detailed markup for
software documentation.

Footnote Element
The footnote element usually generates a mark (a superscript symbol or number) at the place in
the flow of the document in which it occurs. The body of the footnote is then presented elsewhere,
typically at the bottom of the page or below a table.

To reference the same footnote several times in a topic, use the footnoteref. To do this, the
original footnote needs an @xml:id attribute with a unique id. Then in the footnoteref,
reference that id with the @linkend attribute.
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Example 99. Footnote and footnoteref in plain XML

<informaltable>
    <thead>
        <tr>
            <th>Variable</th>
            <th>Value</th>
        </tr>
    </thead>
    <tbody>
        <tr>
            <td>foo<footnote xml:id="foo">
                    <para>A meaningless variable name often used in \
programming examples</para>
                </footnote></td>
            <td>5</td>
        </tr>
        <tr>
            <td>bar<footnoteref linkend="foo"/></td>
            <td>3 </td>
        </tr>
    </tbody>
</informaltable>

TIP
See also footnote and footnoteref.

Supported Element Attributes
Each element in Paligo can have one or more attributes, which are properties that Paligo can
use to apply different characteristics when publishing. A common example is using attributes
for including or excluding content (filtering). For example, you could give an element the
xinfo:product filter attribute and set its value to Acme 100 (or any other product name). When
you publish your content, you can then instruct Paligo to include or exclude any content that has
the xinfo:product attribute with Acme 100 as the value.

Filters are just one example of how you can use attributes. There are many other uses too, for
example, you can use the role attribute to set Paligo to include a class name in an HTML output.

TIP
Learn how to add an element attribute, see Add Element Attributes [144].

Supported Attributes
Paligo is based on DocBook 5.1 and supports most of the attributes that are included in that
content model. But there are some differences to consider. Paligo uses the <article> element for
publications and <section> for topics, so it is important to remember that when setting attributes
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on those elements. Also, Paligo does not support other root-level elements such as <book> and
<set>. Read more about DocBook 5.1.

The role attribute is a DocBook 5.1 attribute that allows any text as its value. In Paligo, the role
attribute is used in specific ways, and the value is an important part of the functionality. To learn
about the supported role values, see Role Attribute Values [1901].

CAUTION
Paligo also supports some "internal attributes" such as xinfo:image,
xinfo:resource, and xinfo:text. These "internal attributes" are created and
maintained automatically by Paligo and are used for allocating IDs to elements.
You should not edit them.

TIP
Learn more about different filters and how to use them in Paligo, see Filter
Attributes [1143].

You can use the following attributes in Paligo:

• depth - Use on the imagedata element to set the image depth (height) value in relation to the
viewport. The viewport is the available space for the imageobject. Learn more about Image
Sizing [345].

• contentdepth - Use on the imagedata element to set the image depth (height) value and has
no effect on the viewport. The viewport is the available space for the imageobject. Learn more
about Image Sizing [345].

• contentwidth - Use on the imagedata element to set the image width value and has no effect
on the viewport. The viewport is the available space for the imageobject. Learn more about
Image Sizing [345].

• label - Use on a topic's section element to prevent it being numbered in a PDF output (a
value of 0 means no numbering).

• role - You can use the role attribute with specific values to set Paligo to provide particular
functionality, see Role Attribute Values [1901]

• scalefit - allows an image to be scaled up or down to fit within available space. If
scalefit="1" the image is scaled (with the same factor in both dimensions) so that the graphic
will just fit within the available height or width (whichever is more constraining). If any other
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image size attribute is specified, those attributes determine the graphic size and scalefit will
be ignored.

• style - You can style the background colors for individual individual table cells (td or th) for
PDF output, see Style the Table Body for PDF [980].

• tabstyle - You can style the table element to use compact paragraph spacing, see Set the
Spacing Between Paragraphs in Table Cells [996].

• width - Use on the imagedata element to set the image width value in relation to the viewport.
The viewport is the available space for the imageobject. Learn more about Image Sizing [345].

• xinfo:appid - Use on the section element when setting up context-sensitive help, see
Context-Sensitive Help [665].

• xinfo:chunk - Use on the section element to instruct Paligo to keep a topic as a separate
page in HTML outputs, see Create Subsections [165].

• xinfo:country - Use to filter content by country, see Filtering / Profiling [1141] and Filter
Attributes [1143].

• xinfo:keep-together - Use to control the flow of elements over two pages in PDF outputs,
see Soft Page Breaks [941].

• xinfo:keep-with-next - Use to control the flow of elements over two pages in PDF outputs,
see Soft Page Breaks [941].

• xinfo:market - Use to filter content by market, see Filtering / Profiling [1141] and Filter
Attributes [1143].

• xinfo:outname - Use on the section element to control the URL for the topic when it is
converted into a page for HTML outputs. The value that you enter is used as the URL, see Topic
File Names (HTML) [140].

• xinfo:pagebreak - Use to set a hard page break in PDF outputs, see Hard Page Breaks [944].

• xinfo:product - Use to filter content by product name, see Filtering / Profiling [1141] and Filter
Attributes [1143].

• xinfo:proglang - Use to filter content by programming language, see Filtering /
Profiling [1141] and Filter Attributes [1143].

• xinfo:version - Use to filter content by version, see Filtering / Profiling [1141] and Filter
Attributes [1143].

TIP
Learn how to add an element attribute, see Add Element Attributes [144].

Role Attribute Values
You can use the role attribute with specific values to set Paligo to provide particular functionality.
There are many possibilities, including adding class names to HTML outputs, adding extra-
responsive features to HTML tables and controlling wrapping in PDF output
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The following list shows the specific role attribute values that Paligo uses for various features. We
have included cross-references to the sections that describe those features:

• column-count - Use to set the number of columns in a sidebar element in PDFs, see Multi-
Columns for PDF Content [820].

• column-gap - Use to set the amount of space between columns in a sidebar element for PDFs,
see Multi-Columns for PDF Content [820]).

• extra-responsive - Use on table elements to set them to add a sticky header and column
filter to a table for HTML5 outputs, see Column Filter and Sticky Header for Tables [774].

• font-size - Use to set the size of the lettering on a verbatim element, such as
programlisting , see Verbatim (code and software) [807].

• <free text> - Can be used on any element and you can enter any text as the value, for
example, role: online-image. The value is used as a class name in HTML outputs. This only
applies if the HTML layout is set to include the role attribute as a class name, see Classes and
Attributes [693].

• img-thumbnail - Use on mediaobject elements to set them as small "thumbnail" images in
HTML outputs, see Thumbnail Images [361].

• img-thumbnail-reset - Use on mediaobject elements to prevent them from being
presented as small "thumbnail" images in HTML outputs, see Thumbnail Images [361].

• multi-publication-portal - Use on article elements when publishing multiple
publications to the same help center, see Multiple Publications in the Same Portal [729].

• notintoc - Use on section elements to prevent a topic from appearing in the table of contents
in PDF outputs, see PDF Layout Editor Options [799].

• portal-category - Use on the section element to create category panels for topics in HTML
help center outputs, see Topics for Category Panels [716].

• promoted-content - Use on the section element to set a topic as "featured content", see
Topics for Featured Content [722].

• reuse-range - Use on procedure and orderedlist elements when you want the steps/items
to continue the numbering sequence of a previous procedure or list, see Reuse Items in a
List [1114].

• swagger-topic - Use on the section element when embedding Swagger/Open API content in
Paligo for publishing to:

• HTML help center, see Embed Swagger OpenAPI [527].

• Zendesk, see Embed Swagger OpenAPI for Zendesk [1595].

• top-nav-link - Use on the section element to add a link to a topic from the top-navigation
menu, see Add Top-Navigation Links to Topics [745].

• wrap-option - Use on verbatim elements, such as programlisting, to control line wrapping,
see Verbatim (code and software) [807].
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TIP
Learn how to add an element attribute, see Add Element Attributes [144].
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Glossary

Paligo is based on the Topic-Based Authoring paradigm. This type of authoring has its own
terminology and Paligo adds some of its own. It can therefore be useful to get familiar with some
of these concepts.

Accordion A collapsible section that is achieved by adding the element
attribute role with the value accordion.

• An accordion looks like an arrow in the output. 

• In the Paligo Editor [51] a section with the accordion attribute
gets a menu icon. 

Admonition An umbrella term for elements that are specifically made to contain
safety content or information that needs to stand out in some
way. You can choose between note, notice, caution, warning,
danger, important and tip. They can be styled in the Layout
Editor. 

An admonition with no title will by default output an automatic
label, "Note", "Warning" and so on. You therefore do not have
to enter such text manually. The label is automatically translated
when publishing to other languages. Admonitions can also be
created as separate topic types to be reused.

Appendix An appendix topic is much like a regular topic, but will behave
differently when it comes to numbering, using the established
letter numbering for appendices.

NOTE
Appendix topics should always come last in a
publication, and must always be on the top level.
If you want child topics for your appendix, use
regular topics for that.

Attribute This is a type of metadata that can be additionally set on
an element to provide more information that can be used for
processing the content. For example one attribute you may often
use on images: @width. Attributes are also used when Filtering /
Profiling [1141]. Element attributes are managed in the Element
Attributes Panel [55].

Back Recto The inner side of a back cover.

Back Verso The outer side of a back cover.

Branch With a branch, you create a new version of a publication or
topic. The new version (the branch) acts like a copy, but Paligo
understands it is related to the original version. This means that the

Paligo Documentation

1904



original and the branch can be used separately as parallel versions,
or, if needed, they can be merged back into a single version later.

• The original file gets a symbol that shows that there is a branch
available. 

• The branched file gets a green symbol that shows that it is a
branch. 

To learn more about branching, see Branching [1638].

Component An umbrella term for any type of text content resource in Paligo,
for example topics, admonitions and publications.

Element This means an XML element, sometimes also called a "tag".
Elements are highlighted like this in this help guide: procedure

To learn more about elements, see the Basic Element
Reference [1886].

Element Attributes Panel The Element Attributes Panel is located to the right in the editor. It
allows you to select and set element attributes, such as width for
images, filter attributes for conditional content and much more.

Element Context Menu The menu is displayed with Alt  + Enter , with which you can add

any element in your topics, apart from the ones available in the

toolbar or by shortcuts.

Element Structure Menu The "breadcrumbs menu" at the top of the editor below the
toolbar, allowing you to see which element is selected in the topic,
see the hierarchical structure of the elements, and to manipulate
elements in different ways.
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Fork A "fork" is a special type of link between a publication and its
content. This means that it's not the topic or subpublication itself,
but a reference (link) that is used in a publication. Learn more, see
Forks [107].

1. Fork, only a reference (link) to the actual topic

2. Actual origin topic, where you write your content

Front Recto The front side of a front cover.

Front Verso The inner side of a front cover.

Image As the name implies, an image resource. Note however, that in
the topic editing list of elements, image is called "mediaobject". So
when inserting an image, select mediaobject. This will automatically
insert the imageobject where you can import the image from the
image library. 

Informal Topic A flexible type of component that can be used as a wrapper to
reuse almost any block of content within another topic. 

Metadata The Metadata is the middle section of the Structure View and
shows information (metadata) about the publication, topic or
component. To learn more, see Structure View [75].

Nested Content A topic, informal topic or admonition that is inserted as a reusable
component inside another topic.

PEF PEF stands for Paligo Export File. It is created when information
is exported from Paligo, but also when creating a snapshot (an
archived version of the content).

Publication A Publication is like your "table of contents", a type of component
that should only hold other components, such as topics and safety
messages.
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Usually publications will form the structure of entire manuals,
knowledge bases, or the like, but can also be used for smaller
structures, like chapters or web site categories/sections.

You do not write your content in the publication itself, the content
is in the topics reused by the publication.

Snapshot When the state of a publication or topic is set to Released in Paligo,
an archived version of the content at that particular point in time,
called snapshot, is automatically created. It is possible to add a
comment that provides more context about the snapshot for other
users. A snapshot can also be created manually at any time, for
example during a review assignment or contribution assignment. It
can be used for comparing versions, but also to restore a previous
version.

Subpublication A publication added to a main publication called Super Publication.
It gets a "reuse" symbol. 

Subsection A section inside a topic, also called subtopic. If converted to a
reusable component it will become a nested topic.

Subtopic A topic inside another topic, either as a nested topic or a
subsection.

Super Publication A main publication that consists of subpublications or a mix of
topics and subpublications. This is used when wanting to have
multiple publications in the same portal.

Template Templates are components with predefined content that you first
create in the Templates library. Any topic created from a template
will have that predefined content. 

Topic The main building block, a section element, for publications. It
may be quite small, containing just a description (a title and a
paragraph or two), an instruction or it may be a bit larger. But
usually the aim is to make it a self-contained piece of content to
build larger publications. 

Variable A variable is a container for a changeable value or text. The content
for the variable is stored in a variable set, which contains all of
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the possible values. When you publish, you choose which of the
values should be used. For example, you could have a product
name variable, and then you choose a different product name,
depending on what user guide you are publishing. 
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